Symantec Data Loss Prevention Administration Guide

Documentation version: 12.5a

Legal Notice

Copyright © 2014 Symantec Corporation. All rights reserved.

Symantec, the Symantec Logo, and the Checkmark Logo are trademarks or registered trademarks of Symantec Corporation or its affiliates in the U.S. and other countries. Other names may be trademarks of their respective owners.

This Symantec product may contain third party software for which Symantec is required to provide attribution to the third party ("Third Party Programs"). Some of the Third Party Programs are available under open source or free software licenses. The License Agreement accompanying the Software does not alter any rights or obligations you may have under those open source or free software licenses. Please see the Third Party Legal Notice Appendix to this Documentation or TPIP ReadMe File accompanying this Symantec product for more information on the Third Party Programs.

The product described in this document is distributed under licenses restricting its use, copying, distribution, and decompilation/reverse engineering. No part of this document may be reproduced in any form by any means without prior written authorization of Symantec Corporation and its licensors, if any.

THE DOCUMENTATION IS PROVIDED "AS IS" AND ALL EXPRESS OR IMPLIED CONDITIONS, REPRESENTATIONS AND WARRANTIES, INCLUDING ANY IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT, ARE DISCLAIMED, EXCEPT TO THE EXTENT THAT SUCH DISCLAIMERS ARE HELD TO BE LEGALLY INVALID. SYMANTEC CORPORATION SHALL NOT BE LIABLE FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH THE FURNISHING, PERFORMANCE, OR USE OF THIS DOCUMENTATION. THE INFORMATION CONTAINED IN THIS DOCUMENTATION IS SUBJECT TO CHANGE WITHOUT NOTICE.

The Licensed Software and Documentation are deemed to be commercial computer software as defined in FAR 12.212 and subject to restricted rights as defined in FAR Section 52.227-19 "Commercial Computer Software - Restricted Rights" and DFARS 227.7202, "Rights in Commercial Computer Software or Commercial Computer Software Documentation", as applicable, and any successor regulations. Any use, modification, reproduction release, performance, display or disclosure of the Licensed Software and Documentation by the U.S. Government shall be solely in accordance with the terms of this Agreement.
Technical Support

Symantec Technical Support maintains support centers globally. Technical Support’s primary role is to respond to specific queries about product features and functionality. The Technical Support group also creates content for our online Knowledge Base. The Technical Support group works collaboratively with the other functional areas within Symantec to answer your questions in a timely fashion. For example, the Technical Support group works with Product Engineering and Symantec Security Response to provide alerting services and virus definition updates.

Symantec’s support offerings include the following:

- A range of support options that give you the flexibility to select the right amount of service for any size organization
- Telephone and/or Web-based support that provides rapid response and up-to-the-minute information
- Upgrade assurance that delivers software upgrades
- Global support purchased on a regional business hours or 24 hours a day, 7 days a week basis
- Premium service offerings that include Account Management Services

For information about Symantec’s support offerings, you can visit our website at the following URL:

www.symantec.com/business/support/

All support services will be delivered in accordance with your support agreement and the then-current enterprise technical support policy.

Contacting Technical Support

Customers with a current support agreement may access Technical Support information at the following URL:

www.symantec.com/business/support/

Before contacting Technical Support, make sure you have satisfied the system requirements that are listed in your product documentation. Also, you should be at the computer on which the problem occurred, in case it is necessary to replicate the problem.

When you contact Technical Support, please have the following information available:

- Product release level
- Hardware information
- Available memory, disk space, and NIC information
- Operating system
- Version and patch level
- Network topology
- Router, gateway, and IP address information
- Problem description:
  - Error messages and log files
  - Troubleshooting that was performed before contacting Symantec
  - Recent software configuration changes and network changes

Licensing and registration

If your Symantec product requires registration or a license key, access our technical support Web page at the following URL:

www.symantec.com/business/support/

Customer service

Customer service information is available at the following URL:

www.symantec.com/business/support/

Customer Service is available to assist with non-technical questions, such as the following types of issues:

- Questions regarding product licensing or serialization
- Product registration updates, such as address or name changes
- General product information (features, language availability, local dealers)
- Latest information about product updates and upgrades
- Information about upgrade assurance and support contracts
- Information about the Symantec Buying Programs
- Advice about Symantec's technical support options
- Nontechnical presales questions
- Issues that are related to CD-ROMs, DVDs, or manuals
Support agreement resources

If you want to contact Symantec regarding an existing support agreement, please contact the support agreement administration team for your region as follows:

<table>
<thead>
<tr>
<th>Region</th>
<th>Email</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asia-Pacific and Japan</td>
<td><a href="mailto:customercare_apac@symantec.com">customercare_apac@symantec.com</a></td>
</tr>
<tr>
<td>Europe, Middle-East, and Africa</td>
<td><a href="mailto:seMEA@symantec.com">seMEA@symantec.com</a></td>
</tr>
<tr>
<td>North America and Latin America</td>
<td><a href="mailto:supportsolutions@symantec.com">supportsolutions@symantec.com</a></td>
</tr>
</tbody>
</table>
Section 2  Managing the Enforce Server platform .............................................. 75

Chapter 4  Managing Enforce Server services and settings .............. 76
About Data Lost Prevention services ...................................................... 76
About starting and stopping services on Windows .............................. 77
  Starting an Enforce Server on Windows .................................................. 77
  Stopping an Enforce Server on Windows ................................................. 78
  Starting a Detection Server on Windows ................................................. 78
  Stopping a Detection Server on Windows ................................................. 78
  Starting services on single-tier Windows installations ....................... 79
  Stopping services on single-tier Windows installations ....................... 79
Starting and stopping services on Linux ............................................. 80
  Starting an Enforce Server on Linux ....................................................... 80
  Stopping an Enforce Server on Linux ....................................................... 81
  Stopping a detection server on Linux ...................................................... 81
  Stopping a detection server on Linux ...................................................... 82
  Starting services on single-tier Linux installations ......................... 82
  Stopping services on single-tier Linux installations ......................... 83

Chapter 5  Managing roles and users ......................................................... 84
About role-based access control .......................................................... 84
About authenticating users ................................................................. 85
About configuring roles and users ...................................................... 88
About recommended roles for your organization ................................ 88
Roles included with solution packs ..................................................... 90
Configuring roles .................................................................................. 91
Configuring user accounts ................................................................. 99
Configuring password enforcement settings ..................................... 102
Resetting the Administrator password ......................................... 103
Manage and add roles ........................................................................ 103
Manage and add users ........................................................................ 104
Integrating Active Directory for user authentication ....................... 105
  Creating the configuration file for Active Directory integration ....... 106
  Verifying the Active Directory connection ...................................... 108
  Configuring the Enforce Server for Active Directory authentication ................. 109
<table>
<thead>
<tr>
<th>Chapter 6</th>
<th>Connecting to group directories</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Creating connections to LDAP servers</td>
</tr>
<tr>
<td></td>
<td>Configuring directory server connections</td>
</tr>
<tr>
<td></td>
<td>Scheduling directory server indexing</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 7</th>
<th>Managing stored credentials</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>About the credential store</td>
</tr>
<tr>
<td></td>
<td>Adding new credentials to the credential store</td>
</tr>
<tr>
<td></td>
<td>Configuring endpoint credentials</td>
</tr>
<tr>
<td></td>
<td>Managing credentials in the credential store</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 8</th>
<th>Managing system events and messages</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>About system events</td>
</tr>
<tr>
<td></td>
<td>System events reports</td>
</tr>
<tr>
<td></td>
<td>Working with saved system reports</td>
</tr>
<tr>
<td></td>
<td>Server event detail</td>
</tr>
<tr>
<td></td>
<td>Configuring event thresholds and triggers</td>
</tr>
<tr>
<td></td>
<td>About system event responses</td>
</tr>
<tr>
<td></td>
<td>Enabling a syslog server</td>
</tr>
<tr>
<td></td>
<td>About system alerts</td>
</tr>
<tr>
<td></td>
<td>Configuring the Enforce Server to send email alerts</td>
</tr>
<tr>
<td></td>
<td>Configuring system alerts</td>
</tr>
<tr>
<td></td>
<td>About log review</td>
</tr>
<tr>
<td></td>
<td>System event codes and messages</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 9</th>
<th>Adding a new product module</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Installing a new license file</td>
</tr>
<tr>
<td></td>
<td>About system upgrades</td>
</tr>
</tbody>
</table>
Network Prevent for Email originated responses and codes .......... 271

Chapter 12 Using Symantec Data Loss Prevention utilities .......... 274
About the Symantec Data Loss Prevention utilities ....................... 274
About Endpoint utilities ............................................................... 275
About the Environment Check Utility ............................................ 276
Running the Environment Check Utility on Windows ................. 277
Running the Environment Check Utility on Linux ..................... 278
About Environment Check Utility output ..................................... 278
About DBPasswordChanger ...................................................... 279
DBPasswordChanger syntax ..................................................... 279
Example of using DBPasswordChanger ..................................... 279

Section 4 Authoring policies ...................................................... 281

Chapter 13 Introduction to policies ............................................. 283
About Data Loss Prevention policies ........................................... 283
Policy components ....................................................................... 285
Policy templates ......................................................................... 286
Solution packs ........................................................................... 287
Policy groups ............................................................................. 287
Policy deployment ........................................................................ 288
Policy severity ............................................................................ 289
Policy authoring privileges ......................................................... 290
Data Profiles ............................................................................. 291
User Groups .............................................................................. 292
Policy import and export ............................................................. 292
Workflow for implementing policies ............................................ 293
Viewing, printing, and downloading policy details ....................... 295

Chapter 14 Overview of policy detection ..................................... 296
Detecting data loss ....................................................................... 296
Content that can be detected ...................................................... 297
Files that can be detected ........................................................... 297
Protocols that can be monitored .................................................. 297
Endpoint events that can be detected ........................................... 298
Identities that can be detected ...................................................... 298
Languages that can be detected .................................................... 298
Data Loss Prevention policy detection technologies ................... 298
Policy matching conditions ........................................................ 300
Content matching conditions ...................................................... 301
Chapter 18  
Best practices for authoring policies .............................................. 357
Best practices for authoring policies .................................................. 357
Develop a policy strategy that supports your data security objectives .................................................. 359
Use a limited number of policies to get started ................................ 359
Use policy templates but modify them to meet your requirements ....... 360
Use the appropriate match condition for your data loss prevention objectives .................................................. 360
Test and tune policies to improve match accuracy ............................. 361
Start with high match thresholds to reduce false positives .............. 362
Use a limited number of exceptions to narrow detection scope ......... 363
Use compound conditions to improve match accuracy ..................... 363
Author policies to limit the potential effect of two-tier detection ......... 364
Use policy groups to manage policy lifecycle .................................... 365
Follow detection-specific best practices ........................................... 365

Chapter 19  
Detecting content using Exact Data Matching (EDM) .......................... 367
Introducing Exact Data Matching (EDM) .......................................... 367
About using EDM to protect content .............................................. 368
EDM policy features ........................................................................ 369
EDM policy templates ...................................................................... 370
About the Exact Data Profile and index .......................................... 371
About the exact data source file ...................................................... 372
About cleansing the exact data source file ...................................... 373
About using System Fields for data source validation ...................... 374
About index scheduling ................................................................. 374
About the Content Matches Exact Data From condition .................. 375
About Data Owner Exception ......................................................... 375
About profiled Directory Group Matching (DGM) ......................... 376
About two-tier detection for EDM on the endpoint ......................... 377
About upgrading EDM deployments ............................................. 377
Configuring Exact Data profiles .................................................... 378
Creating the exact data source file for EDM .................................. 379
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating the exact data source file for Data Owner</td>
<td>380</td>
</tr>
<tr>
<td>Exception</td>
<td></td>
</tr>
<tr>
<td>Creating the exact data source file for profiled DGM</td>
<td>380</td>
</tr>
<tr>
<td>Preparing the exact data source file for indexing</td>
<td>381</td>
</tr>
<tr>
<td>Uploading exact data source files to the Enforce Server</td>
<td>383</td>
</tr>
<tr>
<td>Creating and modifying Exact Data Profiles</td>
<td>385</td>
</tr>
<tr>
<td>Mapping Exact Data Profile fields</td>
<td>389</td>
</tr>
<tr>
<td>Using system-provided pattern validators for EDM profiles</td>
<td>391</td>
</tr>
<tr>
<td>Scheduling Exact Data Profile indexing</td>
<td>392</td>
</tr>
<tr>
<td>Managing and adding Exact Data Profiles</td>
<td>394</td>
</tr>
<tr>
<td>Configuring EDM policies</td>
<td>395</td>
</tr>
<tr>
<td>Configuring the Content Matches Exact Data policy condition</td>
<td>396</td>
</tr>
<tr>
<td>Configuring Data Owner Exception for EDM policy conditions</td>
<td>398</td>
</tr>
<tr>
<td>Configuring the Sender/User based on a Profiled Directory policy condition</td>
<td>399</td>
</tr>
<tr>
<td>Configuring the Recipient based on a Profiled Directory policy condition</td>
<td>399</td>
</tr>
<tr>
<td>Configuring Advanced Server Settings for EDM policies</td>
<td>400</td>
</tr>
<tr>
<td>Using multi-token matching</td>
<td>403</td>
</tr>
<tr>
<td>Characteristics of multi-token cells</td>
<td>404</td>
</tr>
<tr>
<td>Multi-token with spaces</td>
<td>404</td>
</tr>
<tr>
<td>Multi-token with stopwords</td>
<td>405</td>
</tr>
<tr>
<td>Multi-token with mixed language characters</td>
<td>405</td>
</tr>
<tr>
<td>Multi-token with punctuation</td>
<td>406</td>
</tr>
<tr>
<td>Additional examples for multi-token cells with punctuation</td>
<td>407</td>
</tr>
<tr>
<td>Some special use cases for system-recognized data patterns</td>
<td>410</td>
</tr>
<tr>
<td>Multi-token punctuation characters</td>
<td>412</td>
</tr>
<tr>
<td>Match count variant examples</td>
<td>413</td>
</tr>
<tr>
<td>Proximity matching example</td>
<td>414</td>
</tr>
<tr>
<td>Updating EDM indexes to version 12.5</td>
<td>416</td>
</tr>
<tr>
<td>Update process using the Remote EDM Indexer</td>
<td>417</td>
</tr>
<tr>
<td>Update process using the Enforce Server</td>
<td>419</td>
</tr>
<tr>
<td>EDM index out of date error codes</td>
<td>420</td>
</tr>
<tr>
<td>Memory requirements for EDM</td>
<td>421</td>
</tr>
<tr>
<td>Multi-token memory table</td>
<td>423</td>
</tr>
<tr>
<td>EDM index size table</td>
<td>424</td>
</tr>
<tr>
<td>Determining how much memory is needed to index the data source</td>
<td>424</td>
</tr>
<tr>
<td>Determining how much memory is needed to load the index into memory on the detection server</td>
<td>426</td>
</tr>
</tbody>
</table>
Use stopwords to exclude common words from detection .......... 457
Use scheduled indexing to automate profile updates .......... 457
Match on 3 columns in an EDM condition to increase detection accuracy ................................................................. 458
Leverage exception tuples to avoid false positives .......... 459
Use a WHERE clause to detect records that meet specific criteria ................................................................. 460
Use the minimum matches field to fine tune EDM rules .......... 460
Combine Data Identifiers with EDM rules to limit the impact of two-tier detection ................................................................. 460
Include an email address field in the Exact Data Profile for profiled DGM ................................................................. 461
Use profiled DGM for Network Prevent for Web identity detection ................................................................. 461

Chapter 20 Detecting content using Indexed Document Matching (IDM) ................................................................. 462

Introducing Indexed Document Matching (IDM) ................................................................. 462
About using IDM ................................................................. 462
Supported forms of matching for IDM ................................................................. 463
Types of IDM detection ................................................................. 464
About the Indexed Document Profile ................................................................. 465
About the document data source ................................................................. 466
About the indexing process ................................................................. 466
About indexing remote documents ................................................................. 467
About the server and agent index files ................................................................. 467
About index deployment and logging ................................................................. 469
Using IDM to detect exact files ................................................................. 470
Using IDM to detect exact and partial file contents ................................................................. 471
About using the Content Matches Document Signature policy condition ................................................................. 473
About using IDM for policy exceptions ................................................................. 474
About whitelisting partial file contents ................................................................. 474
Configuring IDM profiles and policy conditions ................................................................. 475
Preparing the document data source for indexing ................................................................. 475
Whitelisting file contents to exclude from partial matching ................................................................. 476
Manage and add Indexed Document Profiles ................................................................. 477
Creating and modifying Indexed Document Profiles ................................................................. 479
Uploading a document archive to the Enforce Server ................................................................. 482
Referencing a document archive on the Enforce Server ................................................................. 483
Using local path on Enforce Server ................................................................. 485
Using the remote SMB share option to index file shares ................................................................. 486
Using the remote SMB share option to index SharePoint documents ............................................................... 487
Filtering documents by file name ................................................................. 489
Filtering documents by file size ................................................................. 491
Scheduling document profile indexing ......................................................... 492
Changing the default indexer properties ......................................................... 493
Using agent IDM after upgrade to version 12.5 .................................................. 494
Enabling agent IDM ........................................................................... 495
Estimating endpoint memory use for agent IDM .............................................. 496
Configuring the Content Matches Document Signature policy condition ............................................................... 497
Best practices for using IDM ................................................................... 499
Reindex IDM profiles after major upgrade ...................................................... 500
Do not compress files in the document source ............................................... 500
Avoid using IDM solely for binary files ......................................................... 501
Do not index empty documents ................................................................. 501
Prefer exact match over two-tier detection on the endpoint ................................ 502
Understand limitations of exact matching ...................................................... 502
Use whitelisting to exclude non-sensitive content from partial matching ............................................................... 503
Filter documents from indexing to reduce false positives ................................ 504
Distinguish IDM exceptions from whitelisting and filtering ................................ 505
Create separate profiles to index large document sources .................................. 505
Use WebDAV or CIFS to index remote document data sources ............................................................... 506
Use scheduled indexing to keep profiles up to date .............................................. 506
Use parallel IDM rules to tune match thresholds .............................................. 507
Use agent IDM with VML for partial match validation ........................................ 507

Chapter 21 Detecting content using Vector Machine Learning (VML) ............................................................... 509
Introducing Vector Machine Learning (VML) .................................................. 509
About the Vector Machine Learning Profile .................................................. 510
About the content you train ....................................................................... 510
About the base accuracy from training percentage rates .................................. 511
About the Similarity Threshold and Similarity Score ........................................ 512
About using unaccepted VML profiles in policies .......................................... 513
Configuring VML profiles and policy conditions ............................................... 513
Creating new VML profiles ....................................................................... 515
Working with the Current Profile and Temporary Workspace tabs ............................................................... 515
Uploading example documents for training ...................................................... 516
Chapter 22

Detecting content using data identifiers

Introducing data identifiers
System-defined data identifiers
Extending and customizing data identifiers
About data identifier configuration
About data identifier breadths
About optional validators for data identifiers
About data identifier patterns
About pattern validators
About data normalizers
About cross-component matching
About unique match counting
Configuring data identifier policy conditions
Workflow for configuring data identifier policies
Managing and adding data identifiers
Editing data identifiers
Configuring the Content Matches data identifier condition
Using data identifier breadths
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selecting a data identifier breadth</td>
<td>555</td>
</tr>
<tr>
<td>Using optional validators</td>
<td>558</td>
</tr>
<tr>
<td>Configuring optional validators</td>
<td>559</td>
</tr>
<tr>
<td>Acceptable characters for optional validators</td>
<td>560</td>
</tr>
<tr>
<td>Using unique match counting</td>
<td>562</td>
</tr>
<tr>
<td>Configuring unique match counting</td>
<td>563</td>
</tr>
<tr>
<td>Modifying system data identifiers</td>
<td>564</td>
</tr>
<tr>
<td>Cloning a system data identifier before modifying it</td>
<td>565</td>
</tr>
<tr>
<td>Editing pattern validator input</td>
<td>566</td>
</tr>
<tr>
<td>List of pattern validators that accept input data</td>
<td>566</td>
</tr>
<tr>
<td>Editing keywords for international PII data identifiers</td>
<td>567</td>
</tr>
<tr>
<td>List of keywords for international system data identifiers</td>
<td>568</td>
</tr>
<tr>
<td>Updating policies to use the Randomized US SSN data identifier</td>
<td>569</td>
</tr>
<tr>
<td>Creating custom data identifiers</td>
<td>570</td>
</tr>
<tr>
<td>Workflow for creating custom data identifiers</td>
<td>570</td>
</tr>
<tr>
<td>Custom data identifier configuration</td>
<td>572</td>
</tr>
<tr>
<td>Using the data identifier pattern language</td>
<td>573</td>
</tr>
<tr>
<td>Writing data identifier patterns to match data</td>
<td>574</td>
</tr>
<tr>
<td>Using pattern validators</td>
<td>575</td>
</tr>
<tr>
<td>Selecting pattern validators</td>
<td>577</td>
</tr>
<tr>
<td>Selecting a data normalizer</td>
<td>578</td>
</tr>
<tr>
<td>Creating custom script validators</td>
<td>579</td>
</tr>
<tr>
<td>Best practices for using data identifiers</td>
<td>579</td>
</tr>
<tr>
<td>Use data identifiers instead of regular expressions to improve</td>
<td>580</td>
</tr>
<tr>
<td>accuracy</td>
<td></td>
</tr>
<tr>
<td>Clone system-defined data identifiers before modifying to preserve</td>
<td>581</td>
</tr>
<tr>
<td>original state</td>
<td></td>
</tr>
<tr>
<td>Modify data identifier definitions when you want tuning to apply</td>
<td>581</td>
</tr>
<tr>
<td>globally</td>
<td></td>
</tr>
<tr>
<td>Consider using multiple breadths in parallel to detect different</td>
<td>582</td>
</tr>
<tr>
<td>severities of confidential data</td>
<td></td>
</tr>
<tr>
<td>Avoid matching on the Envelope over HTTP to reduce false positives</td>
<td>582</td>
</tr>
<tr>
<td>Use the Randomized US SSN data identifier to detect SSNs</td>
<td>582</td>
</tr>
<tr>
<td>Use unique match counting to improve accuracy and ease remediation</td>
<td>583</td>
</tr>
</tbody>
</table>

**Chapter 23**

**Detecting content using keyword matching** ........................................ 584

**Introducing keyword matching** ......................................................... 584

**About keyword matching for Chinese, Japanese, and Korean (CJK) languages** ........................................ 585
Enable token validation to match Chinese, Japanese, and Korean keywords on the server ................................................................. 608

Chapter 26 Detecting file properties ................................................................. 609

Introducing file property detection ................................................................. 609
About file type matching ................................................................................. 609
About file format support for file type matching ........................................ 610
About custom file type identification ............................................................. 610
About file size matching ................................................................................. 611
About file name matching ................................................................................. 611
Configuring file property matching ............................................................... 611
Configuring the Message Attachment or File Type Match condition .................. 612
Configuring the Message Attachment or File Size Match condition .................. 613
Configuring the Message Attachment or File Name Match condition .................. 614
File name matching syntax ................................................................................. 615
File name matching examples ........................................................................... 615
Enabling the Custom File Type Signature condition in the policy console ......................................................................................... 616
Configuring the Custom File Type Signature condition .................................. 617
Best practices for using file property matching ............................................... 618
Use compound file property rules to protect design and multimedia files ................................................................. 618
Do not use file type matching to detect content .............................................. 618
Calculate file size properly to improve match accuracy .................................. 618
Use expression patterns to match file names .................................................. 618
Use scripts and plugins to detect custom file types ......................................... 619

Chapter 27 Detecting email for data classification services ......................... 620

About implementing detection for Enterprise Vault Classification ................. 620
About matching on the message Subject for Data Classification Services ................................................................. 621
Enabling classification test mode ................................................................. 621
Configuring the Message/Email Properties and Attributes condition ................................................................. 623

Chapter 28 Detecting network and mobile incidents ..................................... 626

Introducing protocol monitoring for network .................................................. 626
Introducing protocol monitoring for mobile .................................................... 627
Chapter 29 Detecting endpoint events ........................................ 632

Introducing endpoint event detection ........................................ 632
About endpoint protocol monitoring .................................... 632
About endpoint destination monitoring .................................. 633
About endpoint application monitoring .................................. 634
About endpoint location detection ....................................... 634
About endpoint device detection ........................................ 634
Configuring endpoint event detection conditions .................... 635
Configuring the Endpoint Monitoring condition ...................... 635
Configuring the Endpoint Location condition ....................... 637
Configuring the Endpoint Device Class or ID condition .......... 638
Manage and add endpoint devices ....................................... 639
Gathering endpoint device IDs .......................................... 640
Creating and modifying endpoint device configurations .......... 641

Best practices for using endpoint detection .............................. 642

Chapter 30 Detecting described identities ................................. 643

Introducing described identity matching ................................ 643
Described identity matching examples ................................... 643
Configuring described identity matching policy conditions ......... 644
About Reusable Sender/Recipient Patterns .............................. 645
Configuring the Sender/User Matches Pattern condition .......... 645
Configuring a Reusable Sender Pattern .................................. 647
Configuring the Recipient Matches Pattern condition .............. 648
Configuring a Reusable Recipient Pattern ............................. 649
Best practices for using described identity matching ................. 650
Define precise identity patterns to match users ...................... 650
Specify email addresses exactly to improve accuracy .............. 651
Match domains instead of IP addresses to improve accuracy .... 651
Chapter 31  Detecting synchronized identities ........................................ 653

Introducing synchronized Directory Group Matching (DGM) ................ 653
About two-tier detection for synchronized DGM .................................. 654
Configuring User Groups ............................................................... 654
Configuring synchronized DGM policy conditions .............................. 656
  Configuring the Sender/User based on a Directory Server Group
  condition .................................................................................. 657
  Configuring the Recipient based on a Directory Server Group
  condition .................................................................................. 658
Best practices for using synchronized DGM ........................................ 659
  Refresh the directory on initial save of the User Group .................... 659
  Distinguish synchronized DGM from other types endpoint
detection .................................................................................... 659

Chapter 32  Detecting profiled identities .............................................. 661

Introducing profiled Directory Group Matching (DGM) ......................... 661
About two-tier detection for profiled DGM .......................................... 661
Configuring Exact Data profiles for DGM ........................................ 662
Configuring profiled DGM policy conditions ....................................... 663
  Configuring the Sender/User based on a Profiled Directory
  condition .................................................................................... 663
  Configuring the Recipient based on a Profiled Directory
  condition .................................................................................... 664
Best practices for using profiled DGM ............................................... 665
  Follow EDM best practices when implementing profiled
  DGM ....................................................................................... 665
  Include an email address field in the Exact Data Profile for profiled
  DGM ....................................................................................... 665
  Use profiled DGM for Network Prevent for Web identity
detection ..................................................................................... 666

Chapter 33  Supported file formats for detection .................................. 667

Overview of detection file format support ........................................... 667
Supported formats for file type identification ...................................... 669
Supported formats for content extraction .......................................... 684
  Supported word-processing formats for content extraction ............. 685
  Supported presentation formats for content extraction .................. 686
  Supported spreadsheet formats for content extraction .................. 687
  Supported text and markup formats for content extraction .......... 688
  Supported email formats for content extraction ......................... 689
  Supported CAD formats for content extraction ......................... 690
Supported graphics formats for content extraction ....................... 690
Supported database formats for content extraction ...................... 690
Other file formats supported for content extraction ....................... 691
Supported encapsulation formats for subfile extraction ....................... 691
Supported file formats for metadata extraction .................................. 692
About document metadata detection ......................................... 693
Enabling server metadata detection .......................................... 694
Enabling endpoint metadata detection ...................................... 694
Best practices for using metadata detection ............................... 694

Chapter 34 Library of system data identifiers ................................. 700

Library of system data identifiers ................................................. 701
ABA Routing Number data identifier .............................................. 702
  ABA Routing Number wide breadth ........................................ 704
  ABA Routing Number medium breadth .................................... 705
  ABA Routing Number narrow breadth ..................................... 705
  ABA Routing Number wide breadth ........................................ 704
  ABA Routing Number medium breadth .................................... 705
  ABA Routing Number narrow breadth ..................................... 705
Australian Medicare Number data identifier ................................ 706
Australian Tax File Number data identifier .................................. 707
Burgerservicenummer data identifier ........................................... 707
Canadian Social Insurance Number data identifier .......................... 708
  Canadian Social Insurance Number wide breadth ....................... 710
  Canadian Social Insurance Number medium breadth .................... 711
  Canadian Social Insurance Number narrow breadth .................... 711
  Canadian Social Insurance Number wide breadth ....................... 710
  Canadian Social Insurance Number medium breadth .................... 711
  Canadian Social Insurance Number narrow breadth .................... 711
Codice Fiscale data identifier .................................................... 712
Credit Card Magnetic Stripe Data data identifier ................................ 713
Credit Card Number data identifier .......................................... 715
  Credit Card Number wide breadth ........................................ 720
  Credit Card Number medium breadth .................................... 721
  Credit Card Number narrow breadth ..................................... 723
  Credit Card Number wide breadth ........................................ 720
  Credit Card Number medium breadth .................................... 721
  Credit Card Number narrow breadth ..................................... 723
CUSIP Number data identifier .................................................... 726
  CUSIP Number wide breadth ............................................... 728
  CUSIP Number medium breadth .......................................... 728
  CUSIP Number narrow breadth ............................................ 729
CUSIP Number wide breadth .................................................. 728
CUSIP Number medium breadth ........................................... 728
CUSIP Number narrow breadth .......................................... 729
Drivers License Number – CA State data identifier .................... 730
Drivers License Number – CA State wide breadth ..................... 731
Drivers License Number – CA State medium breadth ................. 731
Drivers License Number – CA State wide breadth ..................... 731
Drivers License Number – CA State medium breadth ................. 731
Drivers License Number - FL, MI, MN States data identifier ............ 732
Drivers License Number- FL, MI, MN States wide breadth .......... 734
Drivers License Number- FL, MI, MN States medium breadth .......... 734
Drivers License Number- FL, MI, MN States wide breadth .......... 734
Drivers License Number- FL, MI, MN States medium breadth .......... 734
Drivers License Number - IL State data identifier ..................... 735
Drivers License Number- IL State wide breadth ....................... 736
Drivers License Number- IL State medium breadth .................... 737
Drivers License Number- IL State wide breadth ....................... 736
Drivers License Number- IL State medium breadth .................... 737
Drivers License Number - NJ State data identifier ..................... 737
Drivers License Number- NJ State wide breadth ....................... 739
Drivers License Number- NJ State medium breadth .................... 739
Drivers License Number- NJ State wide breadth ....................... 739
Drivers License Number- NJ State medium breadth .................... 739
Drivers License Number - NY State data identifier ..................... 740
Drivers License Number- NY State wide breadth ....................... 741
Drivers License Number - NY State medium breadth .................... 742
Drivers License Number - NY State wide breadth ....................... 741
Drivers License Number - NY State medium breadth .................... 742
French INSEE Code data identifier ........................................ 742
Hong Kong ID data identifier ................................................. 743
IBAN Central data identifier ............................................... 743
IBAN East data identifier .................................................... 745
IBAN West data identifier ................................................... 748
IP Address data identifier .................................................. 750
IP Address wide breadth ................................................... 752
IP Address medium breadth ............................................... 753
IP Address narrow breadth ................................................ 754
IP Address wide breadth ................................................... 752
IP Address medium breadth ............................................... 753
IP Address narrow breadth ................................................ 754
National Drug Code (NDC) data identifier ................................ 754
Chapter 35 Library of policy templates .............................................. 800

Caldicott Report policy template .................................................. 802
Canadian Social Insurance Numbers policy template .................... 804
CAN-SPAM Act policy template ................................................... 805
Common Spyware Upload Sites policy template ............................ 806
Competitor Communications policy template ............................... 806
Confidential Documents policy template .................................... 807
Credit Card Numbers policy template ........................................... 808
Customer Data Protection policy template .................................. 808
Data Protection Act 1998 (UK) policy template ............................. 810
Section 5 Configuring policy response rules ........................................... 873

Chapter 36 Responding to policy violations ........................................... 874

About response rules ........................................................................... 875
About response rule actions .................................................................. 875
Response rules for all detection servers ............................................. 876
Response rules for endpoint detection ............................................... 877
Response rules for Network and Mobile Prevent for Web detection .......... 878
Response rules for Network Protect detection ...................................... 879
Response rule for the Classification Server ........................................ 880
About response rule execution types ................................................... 880
About Automated Response rules ....................................................... 881
About Smart Response rules ............................................................... 881
About response rule conditions .......................................................... 882
About response rule action execution priority ..................................... 883
About response rule authoring privileges ........................................... 885
Implementing response rules ............................................................... 886
Response rule best practices ............................................................... 887

Chapter 37 Configuring and managing response rules ......................... 889

Manage response rules ........................................................................ 889
Adding a new response rule ............................................................... 890
Configuring response rules ............................................................... 891
Chapter 38  Response rule conditions ................................................................. 897
Configuring the Endpoint Location response condition ................................ 897
Configuring the Endpoint Device response condition ................................ 898
Configuring the Incident Type response condition ....................................... 899
Configuring the Incident Match Count response condition ......................... 900
Configuring the Protocol or Endpoint Monitoring response condition ........ 901
Configuring the Severity response condition .............................................. 903

Chapter 39  Response rule actions ................................................................. 905
Configuring the Add Note action ................................................................. 906
Configuring the Limit Incident Data Retention action ................................ 906
  Retaining data for endpoint incidents .................................................... 907
  Discarding data for network incidents .................................................. 908
Configuring the Log to a Syslog Server action .......................................... 909
Configuring the Send Email Notification action ........................................ 910
Configuring the Server FlexResponse action .......................................... 912
Configuring the Set Attribute action ....................................................... 913
Configuring the Set Status action ........................................................... 914
Configuring the Classify Enterprise Vault Content response action ............ 915
  Configuring the retention categories that are available for classification .... 917
Configuring the Endpoint: FlexResponse action .......................................... 919
Configuring the Endpoint Discover: Quarantine File action ....................... 920
Configuring the Endpoint Prevent: Block action ....................................... 922
Configuring the Endpoint Prevent: Notify action ....................................... 924
Configuring the Endpoint Prevent: User Cancel action ................................ 928
Configuring the Network and Mobile Prevent for Web: Block FTP Request action ................................................................. 931
Configuring the Network and Mobile Prevent for Web: Block HTTP/S action ................................................................. 931
Configuring the Network Prevent: Block SMTP Message action .............. 933
Configuring the Network Prevent: Modify SMTP Message action ............. 934
Configuring the Network and Mobile Prevent for Web: Remove HTTP/S Content action ................................................................. 935
Section 6 Remediating and managing incidents ................................................................. 939

Chapter 40 Remediating incidents ..................................................................................... 940

About incident remediation .................................................................................. 940
Remediating incidents ................................................................................... 943
Executing Smart response rules ...................................................................... 944
Incident remediation action commands ....................................................... 945
Response action variables ............................................................................. 946
Monitor and Prevent incident variables ....................................................... 946
Mobile incident variables .............................................................................. 947
Discover incident variables ............................................................................. 948

Chapter 41 Remediating Network incidents .................................................................. 950

Network incident list ................................................................................... 950
Network incident list—Actions ...................................................................... 953
Network incident list—Columns .................................................................... 955
Network incident snapshot ......................................................................... 956
Network incident snapshot—Heading and navigation .................................. 957
Network incident snapshot—General information ........................................ 957
Network incident snapshot—Matches ........................................................... 960
Network incident snapshot—Attributes ......................................................... 961
Network summary report ............................................................................... 961

Chapter 42 Remediating Endpoint incidents ................................................................. 964

Endpoint incident lists .................................................................................. 964
Endpoint incident snapshot ......................................................................... 967
Reporting on Endpoint Prevent response rules ......................................... 972
Endpoint incident destination or protocol-specific information ................ 974
Endpoint incident summary reports ............................................................ 975

Chapter 43 Remediating Mobile incidents .................................................................. 977

Mobile incident reports .................................................................................. 977
Mobile incident snapshot .............................................................................. 978
Mobile incident list ....................................................................................... 978
Mobile Prevent incident list—Actions ........................................................... 980
Mobile incident list—Columns .................................................................... 981
Mobile incident snapshot—Heading and navigation .................................... 983
<table>
<thead>
<tr>
<th>Chapter 44</th>
<th>Remediating Discover incidents</th>
<th>988</th>
</tr>
</thead>
<tbody>
<tr>
<td>About reports for Network Discover</td>
<td>988</td>
<td></td>
</tr>
<tr>
<td>About incident reports for Network Discover</td>
<td>989</td>
<td></td>
</tr>
<tr>
<td>Discover incident reports</td>
<td>990</td>
<td></td>
</tr>
<tr>
<td>Discover incident snapshots</td>
<td>991</td>
<td></td>
</tr>
<tr>
<td>Working around the issues with go to links in the Firefox browser</td>
<td>994</td>
<td></td>
</tr>
<tr>
<td>Discover incident lists</td>
<td>995</td>
<td></td>
</tr>
<tr>
<td>Network Discover incident actions</td>
<td>995</td>
<td></td>
</tr>
<tr>
<td>Network Discover incident entries</td>
<td>996</td>
<td></td>
</tr>
<tr>
<td>Discover summary reports</td>
<td>999</td>
<td></td>
</tr>
</tbody>
</table>

| Chapter 45 | Working with Classification incidents | 1000 |
| Classification incident list | 1000 |
| Classification incident snapshot | 1001 |

| Chapter 46 | Managing and reporting incidents | 1004 |
| About Symantec Data Loss Prevention reports | 1006 |
| About strategies for using reports | 1007 |
| Setting report preferences | 1008 |
| About incident reports | 1009 |
| About dashboard reports and executive summaries | 1011 |
| Viewing dashboards | 1012 |
| Creating dashboard reports | 1012 |
| Configuring dashboard reports | 1014 |
| Choosing reports to include in a dashboard | 1015 |
| About summary reports | 1016 |
| Viewing summary reports | 1016 |
| Creating summary reports | 1017 |
| Viewing incidents | 1018 |
| About custom reports and dashboards | 1019 |
| Using IT Analytics to manage incidents | 1021 |
| Filtering reports | 1021 |
| Saving custom incident reports | 1022 |
| Scheduling custom incident reports | 1023 |
| Delivery schedule options for incident and system reports | 1025 |
| Delivery schedule options for dashboard reports | 1027 |
Using the date widget to schedule reports ........................................ 1029
Editing custom dashboards and reports ........................................... 1029
Exporting incident reports ........................................................... 1029
Exported fields for Network Monitor .............................................. 1030
Exported fields for Network Discover ............................................ 1031
Exported fields for Mobile Prevent for Web ................................... 1032
Exported fields for Endpoint Discover .......................................... 1033
Deleting incidents ................................................................. 1034
  About the incident deletion process ........................................... 1035
  Configuring the incident deletion job schedule ........................... 1036
  Starting and stopping incident deletion jobs .............................. 1037
  Working with the deletion jobs history ..................................... 1037
Deleting custom dashboards and reports ....................................... 1038
Common incident report features ................................................. 1039
Page navigation in incident reports ............................................. 1039
Incident report filter and summary options .................................... 1040
Sending incident reports by email .............................................. 1041
Printing incident reports .......................................................... 1042
Incident snapshot history tab .................................................... 1042
Incident snapshot attributes section .......................................... 1043
Incident snapshot correlations tab ............................................. 1043
Incident snapshot policy section ............................................... 1043
Incident snapshot matches section ............................................. 1044
Incident snapshot access information section ............................ 1044
Customizing incident snapshot pages ........................................... 1045
About filters and summary options for reports ............................... 1046
General filters for reports ........................................................ 1047
Summary options for incident reports ......................................... 1051
Advanced filter options for reports ............................................. 1056

Chapter 47 Archiving incidents ................................................ 1065
  About incident archiving ....................................................... 1065
  Archiving incidents ............................................................ 1066
  Restoring archived incidents ............................................... 1066
  Preventing incidents from being archived ............................... 1067
  Deleting archived incidents .................................................. 1068

Chapter 48 Working with incident data ...................................... 1069
  About incident status attributes ............................................. 1069
  Configuring status attributes and values .................................. 1071
  Configuring status groups .................................................... 1072
  Export web archive ............................................................. 1073
Section 7  Monitoring and preventing data loss in the network ........................................ 1140

Chapter 51  Implementing Network Monitor ......................................................... 1141

Implementing Network Monitor ................................................................. 1141
About IPv6 support for Network Monitor ............................................... 1143
Choosing a network packet capture method ........................................ 1144
About packet capture software installation and configuration .............. 1145
Installing WinPcap on a Windows platform ....................................... 1146
Updating the Endace card driver ...................................................... 1146
Installing and updating the Napatech network adapter and driver software ......................................................... 1146
Configuring the Network Monitor Server ............................................ 1147
Enabling GET processing with Network Monitor .............................. 1149
Creating a policy for Network Monitor ............................................. 1150
Testing Network Monitor ................................................................ 1151

Chapter 52  Implementing Network Prevent for Email ........................................ 1152

Implementing Network Prevent for Email ........................................... 1152
About Mail Transfer Agent (MTA) integration .................................. 1154
Configuring Network Prevent for Email Server for reflecting or forwarding mode ......................................................... 1155
<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 53</td>
<td>Implementing Network Prevent for Web</td>
<td>1165</td>
</tr>
<tr>
<td></td>
<td>Implementing Network Prevent for Web</td>
<td>1165</td>
</tr>
<tr>
<td></td>
<td>Licensing Network Prevent</td>
<td>1167</td>
</tr>
<tr>
<td></td>
<td>Configuring Network Prevent for Web Server</td>
<td>1167</td>
</tr>
<tr>
<td></td>
<td>About proxy server configuration</td>
<td>1170</td>
</tr>
<tr>
<td></td>
<td>Proxy server compatibility with Network Prevent for Web</td>
<td>1171</td>
</tr>
<tr>
<td></td>
<td>Configuring request and response mode services</td>
<td>1172</td>
</tr>
<tr>
<td></td>
<td>Specifying one or more proxy servers</td>
<td>1173</td>
</tr>
<tr>
<td></td>
<td>Enabling GET processing for Network Prevent for Web</td>
<td>1174</td>
</tr>
<tr>
<td></td>
<td>Creating policies for Network Prevent for Web</td>
<td>1175</td>
</tr>
<tr>
<td></td>
<td>Testing Network Prevent for Web</td>
<td>1176</td>
</tr>
<tr>
<td></td>
<td>Troubleshooting information for Network Prevent for Web Server</td>
<td>1177</td>
</tr>
<tr>
<td>Section 8</td>
<td>Discovering where confidential data is stored</td>
<td>1178</td>
</tr>
<tr>
<td>Chapter 54</td>
<td>About Network Discover</td>
<td>1180</td>
</tr>
<tr>
<td></td>
<td>About Network Discover</td>
<td>1180</td>
</tr>
<tr>
<td></td>
<td>How Network Discover works</td>
<td>1182</td>
</tr>
<tr>
<td>Chapter 55</td>
<td>Setting up and configuring Network Discover</td>
<td>1184</td>
</tr>
<tr>
<td></td>
<td>Setting up and configuring Network Discover</td>
<td>1184</td>
</tr>
<tr>
<td></td>
<td>Modifying the Network Discover Server configuration</td>
<td>1185</td>
</tr>
<tr>
<td></td>
<td>About Linux Network Discover Servers</td>
<td>1187</td>
</tr>
<tr>
<td></td>
<td>Adding a new Network Discover target</td>
<td>1187</td>
</tr>
<tr>
<td></td>
<td>Editing an existing Network Discover target</td>
<td>1189</td>
</tr>
<tr>
<td>Chapter 56</td>
<td>Network Discover scan target configuration options</td>
<td>1191</td>
</tr>
<tr>
<td></td>
<td>Network Discover scan target configuration options</td>
<td>1191</td>
</tr>
<tr>
<td></td>
<td>Configuring the required fields for Network Discover targets</td>
<td>1193</td>
</tr>
</tbody>
</table>
Scheduling Network Discover scans ............................................. 1194
Providing the password authentication for Network Discover scanned content ............................................. 1196
Encrypting passwords in configuration files ............................................. 1197
Setting up Network Discover filters to include or exclude items from the scan ............................................. 1198
Filtering Discover targets by item size ............................................. 1201
Filtering Discover targets by date last accessed or modified ............... 1202
Optimizing resources with Network Discover scan throttling ............... 1204
Creating an inventory of the locations of unprotected sensitive data ............................................. 1206

Chapter 57 Managing Network Discover target scans .......... 1209
Managing Network Discover target scans ....................................... 1209
Managing Network Discover Targets ............................................. 1210
About the Network Discover scan target list ..................................... 1210
Working with Network Discover scan targets ..................................... 1211
Removing Network Discover scan targets ..................................... 1212
Managing Network Discover scan histories ..................................... 1212
About Network Discover scan histories ..................................... 1213
Working with Network Discover scan histories ..................................... 1214
Deleting Network Discover scans ..................................... 1215
About Network Discover scan details ..................................... 1215
Working with Network Discover scan details ..................................... 1218
Managing Network Discover Servers ............................................. 1219
Viewing Network Discover server status ..................................... 1219
About Network Discover scan optimization ..................................... 1220
About the difference between incremental scans and differential scans ..................................... 1222
About incremental scans ..................................... 1223
Scanning new or modified items with incremental scans .................... 1224
About managing incremental scans ..................................... 1225
Scanning new or modified items with differential scans .................... 1225
Configuring parallel scanning of Network Discover targets ............... 1226

Chapter 58 Using Server FlexResponse plug-ins to remediate incidents .......... 1228
About the Server FlexResponse platform ..................................... 1228
Using Server FlexResponse custom plug-ins to remediate incidents ..................................... 1230
Deploying a Server FlexResponse plug-in ..................................... 1231
Adding a Server FlexResponse plug-in to the plug-ins properties file .......................................................... 1232
Creating a properties file to configure a Server FlexResponse plug-in ...................................................... 1233
Locating incidents for manual remediation .......................................................... 1236
Using the action of a Server FlexResponse plug-in to remediate an incident manually .......................... 1237
Verifying the results of an incident response action .......................................................... 1238
Troubleshooting a Server FlexResponse plug-in .......................................................... 1239

Chapter 59 Setting up scans of file shares ................................................. 1241
Setting up server scans of file systems .......................................................... 1241
Supported file system targets .......................................................... 1242
Automatically discovering servers and shares before configuring a file system target .......................... 1243
Working with Content Root Enumeration scans .......................................................... 1243
Troubleshooting Content Root Enumeration scans .......................................................... 1247
Automatically discovering open file shares .......................................................... 1247
About automatically tracking incident remediation status .......................................................... 1248
Troubleshooting automated incident remediation tracking .......................................................... 1249
Configuration options for Automated Incident Remediation Tracking .......................................................... 1249
Excluding internal DFS folders .......................................................... 1253
Configuring scans of Microsoft Outlook Personal Folders (.pst files) .......................................................... 1253
Configuring and running scans of file systems .......................................................... 1254
Optimizing file system target scanning .......................................................... 1257
Configuring Network Protect for file shares .......................................................... 1258

Chapter 60 Setting up scans of Lotus Notes databases ................................................. 1261
Setting up server scans of Lotus Notes databases .......................................................... 1261
Supported Lotus Notes targets .......................................................... 1262
Configuring and running Lotus Notes scans .......................................................... 1262
Configuring Lotus Notes DIIOP mode configuration scan options .......................................................... 1265

Chapter 61 Setting up scans of SQL databases ................................................. 1267
Setting up server scans of SQL databases .......................................................... 1267
Supported SQL database targets .......................................................... 1268
Configuring and running SQL database scans .......................................................... 1268
Installing the JDBC driver for SQL database targets .......................................................... 1271
SQL database scan configuration properties .......................................................... 1272
Chapter 68 Setting up scanning of Livelink repositories ........................................... 1348
  Setting up remote scanning of Livelink repositories ........................................... 1348
  Supported Livelink scanner targets ....................................................................... 1349
  Creating an ODBC data source for SQL Server .................................................... 1349
  Installing Livelink scanners .................................................................................... 1350
  Starting Livelink scans ........................................................................................... 1352
  Configuration options for Livelink scanners .......................................................... 1354
  Example configuration for scanning a Livelink database ........................................ 1355

Chapter 69 Setting up Web Services for custom scan targets .................................... 1356
  Setting up Web Services for custom scan targets .................................................... 1356
  About setting up the Web Services Definition Language (WSDL) ....................... 1357
  Example of a Web Services Java client .................................................................... 1357
  Sample Java code for the Web Services example .................................................... 1359

Section 9 Discovering and preventing data loss on endpoints .................................. 1362

Chapter 70 Overview of Symantec Data Loss Prevention for endpoints ..................... 1363
  About discovering and preventing data loss on endpoints ...................................... 1363
  About policies for endpoints ..................................................................................... 1365

Chapter 71 Using Endpoint Prevent ........................................................................ 1367
  How Endpoint Prevent works .................................................................................. 1367
  About Endpoint Prevent monitoring ....................................................................... 1368
    About removable storage monitoring .................................................................... 1369
    About endpoint network monitoring .................................................................... 1369
    About CD/DVD monitoring ................................................................................. 1371
    About print/fax monitoring .................................................................................. 1372
    About network share monitoring ......................................................................... 1372
    About clipboard monitoring ................................................................................ 1373
    About application monitoring ............................................................................. 1374
    About virtual desktop support with Endpoint Prevent ......................................... 1374
  About policy creation for Endpoint Prevent ............................................................ 1375
<table>
<thead>
<tr>
<th>Chapter 72</th>
<th>Using Endpoint Discover</th>
<th>1383</th>
</tr>
</thead>
<tbody>
<tr>
<td>How Endpoint Discover works</td>
<td>1383</td>
<td></td>
</tr>
<tr>
<td>About Endpoint Discover scanning</td>
<td>1383</td>
<td></td>
</tr>
<tr>
<td>About targeted Endpoint Discover scans</td>
<td>1385</td>
<td></td>
</tr>
<tr>
<td>Preparing to set up Endpoint Discover</td>
<td>1385</td>
<td></td>
</tr>
<tr>
<td>Creating a policy group for Endpoint Discover</td>
<td>1386</td>
<td></td>
</tr>
<tr>
<td>Creating a policy for Endpoint Discover</td>
<td>1387</td>
<td></td>
</tr>
<tr>
<td>Adding a rule for Endpoint Discover</td>
<td>1387</td>
<td></td>
</tr>
<tr>
<td>Setting up and configuring Endpoint Discover</td>
<td>1389</td>
<td></td>
</tr>
<tr>
<td>Creating an Endpoint Discover scan</td>
<td>1389</td>
<td></td>
</tr>
<tr>
<td>Creating a new Endpoint Discover target</td>
<td>1390</td>
<td></td>
</tr>
<tr>
<td>About Endpoint Discover target filters</td>
<td>1392</td>
<td></td>
</tr>
<tr>
<td>Configuring Endpoint Discover scan timeout settings</td>
<td>1400</td>
<td></td>
</tr>
<tr>
<td>Managing Endpoint Discover target scans</td>
<td>1401</td>
<td></td>
</tr>
<tr>
<td>About managing Endpoint Discover scans</td>
<td>1401</td>
<td></td>
</tr>
<tr>
<td>About remediating Endpoint Discover incidents</td>
<td>1402</td>
<td></td>
</tr>
<tr>
<td>About rules results caching (RRC)</td>
<td>1403</td>
<td></td>
</tr>
<tr>
<td>About Endpoint reports</td>
<td>1403</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 73</th>
<th>Working with agent configurations</th>
<th>1405</th>
</tr>
</thead>
<tbody>
<tr>
<td>About agent configurations</td>
<td>1405</td>
<td></td>
</tr>
<tr>
<td>About cloning agent configurations</td>
<td>1406</td>
<td></td>
</tr>
<tr>
<td>Adding agent configurations</td>
<td>1406</td>
<td></td>
</tr>
<tr>
<td>Configuring file filters</td>
<td>1412</td>
<td></td>
</tr>
<tr>
<td>About the DLP Agent store</td>
<td>1414</td>
<td></td>
</tr>
<tr>
<td>Advanced agent settings</td>
<td>1414</td>
<td></td>
</tr>
<tr>
<td>Applying agent configurations to an agent group</td>
<td>1441</td>
<td></td>
</tr>
<tr>
<td>Configuring the agent connection status</td>
<td>1441</td>
<td></td>
</tr>
<tr>
<td>Enabling the communication channel for 12.0.x and earlier agents</td>
<td>1442</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 74</th>
<th>Working with Agent Groups</th>
<th>1443</th>
</tr>
</thead>
<tbody>
<tr>
<td>About agent groups</td>
<td>1443</td>
<td></td>
</tr>
<tr>
<td>Developing a strategy for deploying Agent Groups</td>
<td>1444</td>
<td></td>
</tr>
<tr>
<td>Overview of the agent group deployment process</td>
<td>1445</td>
<td></td>
</tr>
</tbody>
</table>
Getting started

- Chapter 1. Introducing Symantec Data Loss Prevention
- Chapter 2. Getting started administering Symantec Data Loss Prevention
- Chapter 3. Working with languages and locales
Introducing Symantec Data Loss Prevention

This chapter includes the following topics:

- About Symantec Data Loss Prevention
- About the Enforce platform
- About Network Monitor and Prevent
- About Network Discover
- About Network Protect
- About Mobile Prevent
- About Mobile Email Monitor
- About Endpoint Discover
- About Endpoint Prevent

About Symantec Data Loss Prevention

Symantec Data Loss Prevention enables you to:

- Discover and locate confidential information on file and Web servers, in databases, on mobile devices, and on endpoints (desk and laptop systems)
- Protect confidential information through quarantine
- Monitor network traffic for transmission of confidential data
- Monitor and prevent the transmission of confidential data on mobile devices connected to a VPN
Monitor the transmission of confidential data contained in corporate emails that are sent using Microsoft Exchange ActiveSync and downloaded to mobile devices

Monitor the use of sensitive data on endpoints

Prevent transmission of confidential data to outside locations

Automatically enforce data security and encryption policies

Symantec Data Loss Prevention includes the following components:

- **Enforce Server**
  - See “About the Enforce platform” on page 50.
  - See “About Symantec Data Loss Prevention administration” on page 55.
  - See “About the Enforce Server administration console” on page 56.

- **Network Discover**
  - See “About Network Discover” on page 51.

- **Network Protect**
  - See “About Network Protect” on page 52.

- **Network Monitor**

- **Network Prevent**

- **Mobile Email Monitor**
  - See “About Mobile Email Monitor” on page 53.

- **Mobile Prevent**
  - See “About Mobile Prevent” on page 53.

- **Endpoint Discover**
  - See “About Endpoint Discover” on page 54.

- **Endpoint Prevent**
  - See “About Endpoint Prevent” on page 54.

The Discover, Protect, Monitor, Mobile Prevent, Mobile Email Monitor, and Prevent modules can be deployed as stand-alone products or in combination. Regardless of which stand-alone products you deploy, the Enforce Server is always provided for central management. Note that the Network Protect module requires the Network Discover module.

Associated with each product module are corresponding detection servers:

- **Network Discover Server** locates the exposed confidential data on a broad range of enterprise data repositories including:
  - File servers
  - Databases
- Microsoft SharePoint
- Lotus Notes
- EMC Documentum
- Livelink
- Microsoft Exchange
- Web servers
- Other data repositories

If you are licensed for Network Protect, this server also copies and quarantines sensitive data on file servers, as specified in your policies.
See “About Network Discover” on page 51.

- Network Monitor Server monitors the traffic on your network.
  See “About Network Monitor and Prevent” on page 51.

- Network Prevent for Email Server blocks emails that contain sensitive data.
  See “About Network Monitor and Prevent” on page 51.

- Network Prevent for Web Server blocks HTTP postings and FTP transfers that contain sensitive data.
  See “About Network Monitor and Prevent” on page 51.

- Mobile Prevent for Web Server monitors and blocks HTTP/S and FTP transfers that contain sensitive data over mobile devices that are connected to a VPN.
  See “About Mobile Prevent” on page 53.

- Mobile Email Monitor Server monitors corporate emails that are sent through Microsoft Exchange ActiveSync and downloaded to mobile devices.
  See “About Mobile Email Monitor” on page 53.

- Endpoint Server monitors and prevents the misuse of confidential data on endpoints.

The distributed architecture of Symantec Data Loss Prevention allows organizations to:

- Perform centralized management and reporting.

- Centrally manage data security policies once and deploy immediately across the entire Symantec Data Loss Prevention suite.

- Scale data loss prevention according to the size of your organization.
About the Enforce platform

The Symantec Data Loss Prevention Enforce Server is the central management platform that enables you to define, deploy, and enforce data loss prevention and security policies. The Enforce Server administration console provides a centralized, Web-based interface for deploying detection servers, authoring policies, remediating incidents, and managing the system.

See “About Symantec Data Loss Prevention” on page 47.

The Enforce platform provides you with the following capabilities:

- Build and deploy accurate data loss prevention policies. You can choose among various detection technologies, define rules, and specify actions to include in your data loss prevention policies. Using provided regulatory and best-practice policy templates, you can meet your regulatory compliance, data protection and acceptable-use requirements, and address specific security threats.
  
  See “About Data Loss Prevention policies” on page 283.
  See “Detecting data loss” on page 296.

- Automatically deploy and enforce data loss prevention policies. You can automate policy enforcement options for notification, remediation workflow, blocking, and encryption.

- Measure risk reduction and demonstrate compliance. The reporting features of the Enforce Server enables you to create actionable reports identifying risk reduction trends over time. You can also create compliance reports to address conformance with regulatory requirements.
  
  See “About Symantec Data Loss Prevention reports” on page 1006.
  See “About incident reports” on page 1009.

- Empower rapid remediation. Based on incident severity, you can automate the entire remediation process using detailed incident reporting and workflow automation. Role-based access controls empower individual business units and departments to review and remediate those incidents that are relevant to their business or employees.
  
  See “About incident remediation” on page 940.
  See “Remediating incidents” on page 943.

- Safeguard employee privacy. You can use the Enforce Server to review incidents without revealing the sender identity or message content. In this way, multi-national companies can meet legal requirements on monitoring European Union employees and transferring personal data across national boundaries.
  
  See “About role-based access control” on page 84.
About Network Monitor and Prevent

The Symantec Data Loss Prevention network data monitoring and prevention products include:

- **Network Monitor**
  Network Monitor captures and analyzes traffic on your network. It detects confidential data and significant traffic metadata over the protocols that you specify. For example, SMTP, FTP, HTTP, and various IM protocols. You can configure a Network Monitor Server to monitor custom protocols and to use a variety of filters (per protocol) to filter out low-risk traffic.

- **Network Prevent for Email**
  Network Prevent for Email integrates with standard MTAs and hosted email services to provide in-line active SMTP email management. Policies that are deployed on in-line Network Prevent for Email Server direct the next-hop mail server to block, reroute, or tag email messages. These blocks are based on specific content and other message attributes. Communication between MTAs and Network Prevent for Email Server can be secured as necessary using TLS. Implement Network Monitor, review the incidents it captures, and refine your policies accordingly before you implement Network Prevent for Email.
  See the *Symantec Data Loss Prevention MTA Integration Guide for Network Prevent for Email*.

- **Network Prevent for Web**
  For in-line active Web request management, Network Prevent for Web integrates with an HTTP, HTTPS, or FTP proxy server. This integration uses the Internet Content Adaptation Protocol (ICAP). The Network Prevent for Web Server detects confidential data in HTTP, HTTPS, or FTP content. When it does, it causes the proxy to reject requests or remove HTML content as specified by the governing policies.

About Network Discover

Network Discover scans networked file shares, Web content servers, databases, document repositories, and endpoint systems at high speeds to detect exposed data and documents. Network Discover enables companies to understand exactly where confidential data is exposed and helps significantly reduce the risk of data loss.

Network Discover gives organizations the following capabilities:

- Pinpoint unprotected confidential data. Network Discover helps organizations accurately locate at risk data that is stored on their networks. You can then inform shared file server owners to protect the data.
- Reduce proliferation of confidential data. Network Discover helps organizations to detect the spread of sensitive information throughout the company and reduce the risk of data loss.

- Automate investigations and audits. Network Discover streamlines data security investigations and compliance audits. It accomplishes this task by enabling users to scan for confidential data automatically, as well as review access control and encryption policies.

- During incident remediation, Symantec Data Insight helps organizations solve the problem of identifying data owners and responsible parties for information due to incomplete or inaccurate metadata or tracking information. See the Symantec Data Loss Prevention Data Insight Implementation Guide.

- To provide additional flexibility in remediating Network Discover incidents, use the FlexResponse application programming interface (API), or the FlexResponse plug-ins that are available. See the Symantec Data Loss Prevention FlexResponse Platform Developers Guide, or contact Symantec Professional Services for a list of plug-ins.

See “About Symantec Data Loss Prevention” on page 47.

About Network Protect

Network Protect reduces your risk by removing exposed confidential data, intellectual property, and classified information from open file shares on network servers or desktop computers. Note that there is no separate Network Protect server; the Network Protect product module adds protection functionality to the Network Discover Server.

Network Protect gives organizations the following capabilities:

- Quarantine exposed files. Network Protect can automatically move those files that violate policies to a quarantine area that re-creates the source file structure for easy location. Optionally, Symantec Data Loss Prevention can place a marker text file in the original location of the offending file. The marker file can explain why and where the original file was quarantined.

- Copy exposed or suspicious files. Network Protect can automatically copy those files that violate policies to a quarantine area. The quarantine area can re-create the source file structure for easy location, and leave the original file in place.

- Quarantine file restoration. Network Protect can easily restore quarantined files to their original or a new location.

- Enforce access control and encryption policies. Network Protect proactively ensures workforce compliance with existing access control and encryption policies.
About Mobile Prevent

Mobile Prevent monitors email, Web, and application communications from mobile devices to prevent sensitive information from leaving your organization. After the connection to the corporate network is established, all network traffic is sent to the Mobile Prevent for Web Server for analysis. In this way, you can protect your organization's sensitive information while allowing mobile device users to access sites and apps such as Facebook, Dropbox, and Twitter.

With Mobile Prevent, you can perform the following activities:

- Monitor confidential information leaving a mobile device through HTTP, HTTPS, or FTP traffic.
- Prevent confidential information from leaving a mobile device through HTTP, HTTPS, or FTP traffic.
- RemEDIATE incidents originating from a mobile device.

Mobile Email Monitor and Mobile Prevent are both included in the Symantec Data Loss Prevention for Mobile license.

About Mobile Email Monitor

Mobile Email Monitor monitors corporate email that are sent through Microsoft Exchange ActiveSync and downloaded to the native email client on supported mobile devices.

With Mobile Email Monitor, you can perform the following activities:

- Monitor confidential information sent in corporate emails that are downloaded to mobile devices.
- Track what sensitive information was downloaded to monitored mobile devices that are subsequently lost or stolen.

Mobile Email Monitor and Mobile Prevent are both included in the Symantec Data Loss Prevention for Mobile license.

See "About mobile device management" on page 1541.
See "Implementing Mobile Prevent for Web" on page 1542.
See "About Symantec Data Loss Prevention" on page 47.
About Endpoint Discover

Endpoint Discover detects sensitive data on your desktop or your laptop endpoints. It consists of at least one Endpoint Server and at least one Symantec DLP Agent that runs on an endpoint. You can have many Symantec DLP Agents connected to a single Endpoint Server. Symantec DLP Agents:

- Detect sensitive data in the endpoint file system.
- Collect data on that activity.
- Send incidents to the Endpoint Server.
- Send the data to the associated Endpoint Server for analysis, if necessary.

See “About Symantec Data Loss Prevention” on page 47.

About Endpoint Prevent

Endpoint Prevent detects and prevents sensitive data from leaving from your desktop or your laptop endpoints. It consists of at least one Endpoint Server and all the Symantec DLP Agents running on the endpoint systems that are connected to it. You can have many Symantec DLP Agents connected to a single Endpoint Server. Endpoint Prevent detects on the following data transfers:

- Application monitoring
- CD/DVD
- Clipboard
- Email/SMTP
- eSATA removable drives
- FTP
- HTTP/HTTPS
- IM
- Network shares
- Print/Fax
- USB removable media devices

See “About Symantec Data Loss Prevention” on page 47.
Getting started administering Symantec Data Loss Prevention

This chapter includes the following topics:

- About Symantec Data Loss Prevention administration
- About the Enforce Server administration console
- Logging on and off the Enforce Server administration console
- About the administrator account
- Performing initial setup tasks
- Changing the administrator password
- Adding an administrator email account
- Editing a user profile
- Changing your password

About Symantec Data Loss Prevention administration

The Symantec Data Loss Prevention system consists of one Enforce Server and one or more detection servers.

The Enforce Server stores all system configuration, policies, saved reports, and other Symantec Data Loss Prevention information and manages all activities.
System administration is performed from the Enforce Server administration console, which is accessed by a Firefox or Internet Explorer Web browser. The Enforce console is displayed after you log on.

See “About the Enforce Server administration console” on page 56.

After completing the installation steps in the Symantec Data Loss Prevention Installation Guide, you must perform initial configuration tasks to get Symantec Data Loss Prevention up and running for the first time. These are essential tasks that you must perform before the system can begin monitoring data on your network. See “Performing initial setup tasks” on page 58.

### About the Enforce Server administration console

You administer the Symantec Data Loss Prevention system through the Enforce Server administration console.

The Administrator user can see and access all parts of the administration console. Other users can see only the parts to which their roles grant them access. The user account under which you are currently logged on appears at the top right of the screen.

When you first log on to the administration console, the default Home page is displayed. You and your users can change the default Home page using the Home page selection button.

See Table 2-1 on page 56.

To navigate through the system, select items from one of the four menu clusters (Home, Incidents, Policies, and System). To access the online Help, click Help at the top right of the screen.

Located in the upper-right portion of the administration console are the following navigation and operation icons:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🏡</td>
<td>Select this page as your <strong>Home</strong> page. If the current screen cannot be selected as your <strong>Home</strong> page, this icon is unavailable.</td>
</tr>
<tr>
<td>🔼</td>
<td>Back to previous screen. Symantec recommends using this <strong>Back</strong> button rather than your browser <strong>Back</strong> button. Use of your browser <strong>Back</strong> button may lead to unpredictable behavior and is not recommended.</td>
</tr>
</tbody>
</table>
Table 2-1  Administration console navigation and operation icons (continued)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>Screen refresh. Symantec recommends using this Refresh button rather than your browser Reload or Refresh button. Use of your browser buttons may lead to unpredictable behavior and is not recommended.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Icon" /></td>
<td>Print the current report. If the current screen contents cannot be sent to the printer, this icon is unavailable.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Icon" /></td>
<td>Email the current report to one or more recipients. If the current screen contents cannot be sent as an email, this icon is unavailable.</td>
</tr>
</tbody>
</table>

See “Logging on and off the Enforce Server administration console” on page 57.

Logging on and off the Enforce Server administration console

If you are assigned more than one role, you can only log on under one role at a time. You must specify the role name and user name at logon.

To log on to the Enforce Server

1  On the Enforce Server host, open a browser and point it to the URL for your server (as provided by the Symantec Data Loss Prevention administrator).

2  On the Symantec Data Loss Prevention logon screen, enter your user name in the Username field. For the administrator role, this user name is always Administrator. Users with multiple roles should specify the role name and the user name in the format role\user (for example, ReportViewer\bsmith). If they do not, Symantec Data Loss Prevention assigns the user a role upon logon.

   See “Configuring roles” on page 91.

3  In the Password field, type the password. For the administrator at first logon, this password is the password you created during the installation.

   For installation details, see the appropriate Symantec Data Loss Prevention Installation Guide.

4  Click login.

   The Enforce Server administration console appears. The administrator can access all parts of the administration console, but another user can see only those parts that are authorized for that particular role.
To log out of the Enforce Server

1. Click logout at the top right of the screen.
2. Click OK to confirm.

Symantec Data Loss Prevention displays a message confirming the logout was successful.

See “Editing a user profile” on page 60.

About the administrator account

The Symantec Data Loss Prevention system is preconfigured with a permanent administrator account. Note that the name is case sensitive and cannot be changed. You configured a password for the administrator account during installation.

Refer to the Symantec Data Loss Prevention Installation Guide for more information.

Only the administrator can see or modify the administrator account. Role options do not appear on the administrator configure screen, because the administrator always has access to every part of the system.

See “Changing the administrator password” on page 59.
See “Adding an administrator email account” on page 60.

Performing initial setup tasks

After completing the installation steps in the Symantec Data Loss Prevention Installation Guide, you must perform initial configuration tasks to get Symantec Data Loss Prevention up and running for the first time. These are essential tasks that you must perform before the system can begin monitoring data on your network.

- Change the Administrator's password to a unique password only you know, and add an email address for the Administrator user account so you can be notified of various system events.
  See “About the administrator account” on page 58.

- Add and configure your detection servers.
  See “Adding a detection server” on page 194.
  See “Server configuration—basic” on page 180.

- Add any user accounts you need in addition to those supplied by your Symantec Data Loss Prevention solution pack.

- Review the policy templates provided with your Symantec Data Loss Prevention solution pack to familiarize yourself with their content and data requirements. Revise the polices or create new ones as needed.
Add the data profiles that you plan to associate with policies. Data profiles are not always required. This step is necessary only if you are licensed for data profiles and if you intend to use them in policies.

Changing the administrator password

During installation, you created a generic administrator password. When you log on for the first time, you should change this password to a unique, secret password.

See the Symantec Data Loss Prevention Installation Guide for more information.

Passwords are case-sensitive and they must contain at least eight characters.

Note that you can configure Symantec Data Loss Prevention to require strong passwords. Strong passwords are passwords specifically designed to be difficult to break. Password policy is configured from the System > Settings > General > Configure screen.

When your password expires, Symantec Data Loss Prevention displays the Password Renewal window at the next logon. When the Password Renewal window appears, type your old password, and then type your new password and confirm it.

See “Configuring user accounts” on page 99.

To change the administrator password

1. Log on as administrator.
2. Click Profile in the upper-right corner of the administration console.
3. On the Edit Profile screen:
   - Enter your new password in the New Password field.
   - Re-enter your new password in the Re-enter New Password field. The two new passwords must be identical.
   
   Note that passwords are case-sensitive.

4. Click Save.

See “About the administrator account” on page 58.

See “About the Enforce Server administration console” on page 56.

See “About the System Overview screen” on page 198.
Adding an administrator email account

You can specify an email address to receive administrator account related messages.

To add or change an administrator email account

1. Click Profile in the upper-right corner of the administration console.
2. Type the new (or changed) administrator email address in the email Address field.
   The email addresses must include a fully qualified domain name. For example: my_name@acme.com.
3. Click Save.

See “About the administrator account” on page 58.
See “About the Enforce Server administration console” on page 56.
See “About the System Overview screen” on page 198.

Editing a user profile

System users can use the Profile screen to configure their profile passwords, email addresses, and languages.

Users can also specify their report preferences at the Profile screen.

To display the Profile screen, click Profile at the top-right of the Enforce Server administration console.

The Profile screen is divided into the following sections:

- General. Use this section to change your password, specify your email address, and choose a language preference.
- Report Preferences. Use this section to specify your preferred text encoding, CSV delimiter, and XML export preferences.
- Roles. This section displays your role. Note that this section is not displayed for the administrator because the administrator is authorized to perform all roles.

The General section:

To change your password

1. Enter your current valid password in the Old Password field.
2. Enter your new password in the New Password field.
3 Re-enter your new password in the **Re-enter New Password** field.
4 Click **Save**.

The next time you log on, you must use your new password.

See “Changing your password” on page 63.

To specify a new personal email address

1 Enter your current valid password in the **Old Password** field.
2 In the **Email Address** field enter your personal email address.
3 Click **Save**.

Individual Symantec Data Loss Prevention users can choose which of the available languages and locales they want to use.

To choose a language for individual use

1 On the Enforce Server administration console, click **Profile** at the top-right of the screen.
   
   Your profile appears.

2 In the **General** section of the screen, enter your password in the **Old Password** field.

3 Click the option next to your language choice.

4 Click **Save**.

   The Enforce Server administration console is re-displayed in the new language.

Choosing a language profile has no effect on the detection of policy violations. Detection is performed on all content that is written in any supported language regardless of the language you choose for your profile.

See “About support for character sets, languages, and locales” on page 64.

The languages available to you are determined when the product is installed and the later addition of language packs for Symantec Data Loss Prevention. The effect of choosing a different language varies as follows:

- **Locale only.** If the language you choose has the notice *Translations not available*, dates and numbers are displayed in formats appropriate for the language. Reports and lists are sorted in accordance with that language. But the administration console menus, labels, screens, and Help system are not translated and remain in English. See “About locales” on page 69.

- **Translated.** The language you choose may not display the notice *Translations not available*. In this case, in addition to the number and date format, and sort
order, the administration console menus, labels, screens, and in some cases
the Help system, are translated into the chosen language.
See “About Symantec Data Loss Prevention language packs” on page 68.

The Report Preferences section:

To select your text encoding

1. Enter your current valid password in the Old Password field.
2. Select a text encoding option:
   - **Use browser default encoding.** Check this box to specify that text files
     use the same encoding as your browser.
   - Pull down menu. Click on an encoding option in the pull down menu to
     select it.
3. Click **Save**.
   The new text encoding is applied to CSV exported files. This encoding lets you
   select a text encoding that matches the encoding that is expected by CSV
   applications.

To select a CSV delimiter

1. Enter your current valid password in the Old Password field.
2. Choose one of the delimiters from the pull-down menu.
3. Click **Save**.
   The new delimiter is applied to the next comma-separated values (CSV) list
   that you export.

See “About incident reports” on page 1009.
See “Exporting incident reports” on page 1029.

To select XML export details

1. Enter your current valid password in the Old Password field.
2. **Include Incident Violations in XML Export.** If this box is checked, reports
   exported to XML include the highlighted matches on each incident snapshot.
3. **Include Incident History in XML Export.** If this box is checked, reports
   exported to XML include the incident history data that is contained in the History
   tab of each incident snapshot.
4. Click **Save**.
   Your selections are applied to the next report you export to XML.

If neither box is checked, the exported XML report contains only the basic incident information.
Changing your password

When your password expires, the system requires you to specify a new one the next time you attempt to log on. If you are required to change your password, the Password Renewal window appears.

To change your password from the Password Renewal window

1. Enter your old password in the Old password field of the Password Renewal window.
2. Enter your new password in the New Password field of the Password Renewal window.
3. Re-enter your new password in the Re-enter New Password field of the Password Renewal window.

The next time you log on, you must use your new password.

You can also change your password at any time from the Profile screen.

See “Editing a user profile” on page 60.
See “About the administrator account” on page 58.
See “Logging on and off the Enforce Server administration console” on page 57.
Working with languages and locales

This chapter includes the following topics:

- About support for character sets, languages, and locales
- Supported languages for detection
- Working with international characters
- About Symantec Data Loss Prevention language packs
- About locales
- Using a non-English language on the Enforce Server administration console
- Using the Language Pack Utility

About support for character sets, languages, and locales

Symantec Data Loss Prevention fully supports international deployments by offering a large number of languages and localization options:

- Policy creation and violation detection across many languages. The supported languages can be used in keywords, data identifiers, regular expressions, exact data profiles (EDM) and document profiles (IDM). See “Supported languages for detection” on page 65.
- Operation on localized and Multilingual User Interface (MUI) versions of Windows operating systems.
- International character sets. To view and work with international character sets, the system on which you are viewing the Enforce Server administration console must have the appropriate capabilities. See “Working with international characters” on page 67.

- Locale-based date and number formats, as well as sort orders for lists and reports. See “About locales” on page 69.

- Localized user interface (UI) and Help system. Language packs for Symantec Data Loss Prevention provide language-specific versions of the Enforce Server administration console. They may also provide language-specific versions of the online Help system.

  **Note:** These language packs are added separately following initial product installation.

- Localized product documentation.

### Supported languages for detection

Symantec Data Loss Prevention supports a large number of languages for detection. Policies can be defined that accurately detect and report on the violations found in content in these languages.

<table>
<thead>
<tr>
<th>Language</th>
<th>Version 10.x</th>
<th>Versions 11.0, 11.1.x, 11.5, 11.6</th>
<th>Version 12.x</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arabic</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Brazilian Portuguese</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Chinese (traditional)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Chinese (simplified)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Czech</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Danish</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Dutch</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>English</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Table 3-1  Languages supported by Symantec Data Loss Prevention (continued)

<table>
<thead>
<tr>
<th>Language</th>
<th>Version 10.x</th>
<th>Versions 11.0, 11.1.x, 11.5, 11.6</th>
<th>Version 12.x</th>
</tr>
</thead>
<tbody>
<tr>
<td>Finnish</td>
<td>Yes</td>
<td>Yes, 11.0, 11.1, 11.5, 11.6</td>
<td>Yes</td>
</tr>
<tr>
<td>French</td>
<td>Yes</td>
<td>Yes, 11.0, 11.1, 11.5, 11.6</td>
<td>Yes</td>
</tr>
<tr>
<td>German</td>
<td>Yes</td>
<td>Yes, 11.0, 11.1, 11.5, 11.6</td>
<td>Yes</td>
</tr>
<tr>
<td>Greek</td>
<td>Yes</td>
<td>Yes, 11.0, 11.1, 11.5, 11.6</td>
<td>Yes</td>
</tr>
<tr>
<td>Hebrew</td>
<td>Yes</td>
<td>Yes, 11.0, 11.1, 11.5, 11.6</td>
<td>Yes</td>
</tr>
<tr>
<td>Hungarian</td>
<td>Yes</td>
<td>Yes, 11.0, 11.1, 11.5, 11.6</td>
<td>Yes</td>
</tr>
<tr>
<td>Italian</td>
<td>Yes</td>
<td>Yes, 11.0, 11.1, 11.5, 11.6</td>
<td>Yes</td>
</tr>
<tr>
<td>Japanese</td>
<td>Yes</td>
<td>Yes, 11.0, 11.1, 11.5, 11.6</td>
<td>Yes</td>
</tr>
<tr>
<td>Korean</td>
<td>Yes</td>
<td>Yes, 11.0, 11.1, 11.5, 11.6</td>
<td>Yes</td>
</tr>
<tr>
<td>Norwegian</td>
<td>Yes</td>
<td>Yes, 11.0, 11.1, 11.5, 11.6</td>
<td>Yes</td>
</tr>
<tr>
<td>Polish</td>
<td>Yes</td>
<td>Yes, 11.0, 11.1, 11.5, 11.6</td>
<td>Yes</td>
</tr>
<tr>
<td>Portuguese</td>
<td>Yes</td>
<td>Yes, 11.0, 11.1, 11.5, 11.6</td>
<td>Yes</td>
</tr>
<tr>
<td>Romanian</td>
<td>Yes</td>
<td>Yes, 11.0, 11.1, 11.5, 11.6</td>
<td>Yes</td>
</tr>
<tr>
<td>Russian</td>
<td>Yes</td>
<td>Yes, 11.0, 11.1, 11.5, 11.6</td>
<td>Yes</td>
</tr>
<tr>
<td>Spanish</td>
<td>Yes</td>
<td>Yes, 11.0, 11.1, 11.5, 11.6</td>
<td>Yes</td>
</tr>
<tr>
<td>Swedish</td>
<td>Yes</td>
<td>Yes, 11.0, 11.1, 11.5, 11.6</td>
<td>Yes</td>
</tr>
<tr>
<td>Turkish</td>
<td>Yes*</td>
<td>Yes*</td>
<td>Yes*</td>
</tr>
</tbody>
</table>

*Symantec Data Loss Prevention cannot be installed on a Windows operating system that is localized for the Turkish language, and you cannot choose Turkish as an alternate locale.

For additional information about specific languages, see the Symantec Data Loss Prevention Release Notes.

A number of capabilities are not implied by this support:

- Technical support provided in a non-English language. Because Symantec Data Loss Prevention supports a particular language does not imply that technical support is delivered in that language.
Localized administrative user interface (UI) and documentation. Support for a language does not imply that the UI or product documentation has been localized into that language. However, even without a localized UI, user-defined portions of the UI such as pop-up notification messages on the endpoint can still be localized into any language by entering the appropriate text in the UI.

Localized content. Keywords are used in a number of areas of the product, including policy templates and data identifiers. Support for a language does not imply that these keywords have been translated into that language. Users may, however, add keywords in the new language through the Enforce Server administration console.

New file types, protocols, applications, or encodings. Support for a language does not imply support for any new file types, protocols, applications, or encodings that may be prevalent in that language or region other than what is already supported in the product.

Language-specific normalization. An example of normalization is to treat accented and unaccented versions of a character as the same. The product already performs a number of normalizations, including standard Unicode normalization that should cover the vast majority of cases. However, it does not mean that all potential normalizations are included.

Region-specific normalization and validation. An example of this is the awareness the product has of the format of North American phone numbers, which allows it to treat different versions of a number as the same, and to identify invalid numbers in EDM source files. Support for a language does not imply this kind of functionality for that language or region.

Items in these excluded categories are tracked as individual product enhancements on a language- or region-specific basis. Please contact Symantec Support for additional information on language-related enhancements or plans for the languages not listed.

See “About support for character sets, languages, and locales” on page 64.

Working with international characters

You can use a variety of languages in Symantec Data Loss Prevention, based on:

- The operating system-based character set installed on the computer from which you view the Enforce Server administration console
- The capabilities of your browser

For example, an incident report on a scan of Russian-language data would contain Cyrillic characters. To view that report, the computer and browser you use to access
the Enforce Server administration console must be capable of displaying these characters. Here are some general guidelines:

- If the computer you use to access the Enforce Server administration console has an operating system localized for a particular language, you should be able to view and use a character set that supports that language.

- If the operating system of the computer you use to access the administration console is not localized for a particular language, you may need to add supplemental language support. This supplemental language support is added to the computer you use to access the administration console, not on the Enforce Server.

- On a Windows system, you add supplemental language support using the Control Panel > Regional and Language Options > Languages (tab) - Supplemental Language Support to add fonts for some character sets.

- It may also be necessary to set your browser to accommodate the characters you want to view and enter.

---

**Note:** The Enforce Server administration console supports UTF-8 encoded data.

- On a Windows system, it may also be necessary to use the Languages – Supplemental Language Support tab under Control Panel > Regional and Language Options to add fonts for some character sets.

See the Symantec Data Loss Prevention Release Notes for known issues regarding specific languages.

See “About support for character sets, languages, and locales” on page 64.

---

**About Symantec Data Loss Prevention language packs**

Language packs for Symantec Data Loss Prevention localize the product for a particular language on Windows-based systems. After a language pack has been added to Symantec Data Loss Prevention, administrators can specify it as the system-wide default. If multiple language packs have been made available by the administrator for use, individual users can choose the language they want to work in.

See “Using a non-English language on the Enforce Server administration console” on page 70.

Language pack selection results in the following:

- Its locale becomes available to administrators and end users in Enforce Server Configuration screen.
Enforce Server screens, menu items, commands, and messages appear in the language.

The Symantec Data Loss Prevention Help system may be displayed in the language.

Language packs for Symantec Data Loss Prevention are available from Symantec File Connect.

**Caution:** When you install a new version of Symantec Data Loss Prevention, any language packs you have installed are deleted. For a new, localized version of Symantec Data Loss Prevention, you must upgrade to a new version of the language pack.

About locales

A locale provides the following:

- Displays dates and numbers in formats appropriate for that locale.
- Sorts lists and reports based on text columns, such as "policy name" or "file owner," alphabetically according to the rules of the locale.

Locales are installed as part of a language pack.

An administrator can also configure an additional locale for use by individual users. This additional locale need only be supported by the required version of Java.

For a list of these locales, see http://www.oracle.com/technetwork/java/javase/javase7locales-334809.html.

The locale can be specified at product installation time, as described in the *Symantec Data Loss Prevention Installation Guide*. It can also be configured at a later time using the Language Pack Utility.

See “Using a non-English language on the Enforce Server administration console” on page 70.

See “About support for character sets, languages, and locales” on page 64.
Using a non-English language on the Enforce Server administration console

The use of locales and languages is specified through the Enforce Server administration console by the following roles:

- Symantec Data Loss Prevention administrator. Specifies that one of the available languages be the default system-wide language and sets the locale.
- Individual Symantec Data Loss Prevention user. Chooses which of the available locales to use.

**Note:** The addition of multiple language packs could slightly affect Enforce Server performance, depending on the number of languages and customizations present. This results because an additional set of indexes has to be built and maintained for each language.

**Warning:** Do not modify the Oracle database NLS_LANGUAGE and NLS_TERRITORY settings.

See “About Symantec Data Loss Prevention language packs” on page 68.

See “About locales” on page 69.

A Symantec Data Loss Prevention administrator specifies which of the available languages is the default system-wide language.

**To choose the default language for all users**

1. On the Enforce Server, go to **System > Settings > General** and click **Configure**.

   The **Edit General Settings** screen is displayed.

2. Scroll to the **Language** section of the **Edit General Settings** screen, and click the button next to the language you want to use as the system-wide default.

3. Click **Save**.

Individual Symantec Data Loss Prevention users can choose which of the available languages and locales they want to use by updating their profiles.

See “Editing a user profile” on page 60.

Administrators can use the Language Pack Utility to update the available languages.

See “Using the Language Pack Utility” on page 71.

See “About support for character sets, languages, and locales” on page 64.
Note: If the Enforce Server runs on a Linux host, you must install language fonts on the host machine using the Linux Package Manager application. Language font packages begin with fonts-<language_name>. For example, fonts-japanese-0.20061016-4.el5.noarch

Using the Language Pack Utility

To make a specific locale available for Symantec Data Loss Prevention, you add language packs through the Language Pack Utility.

You run the Language Pack Utility from the command line. Its executable, LanguagePackUtility.exe, resides in the \SymantecDLP\Protect\bin directory.

To use the Language Pack Utility, you must have Read, Write, and Execute permissions on all of the \SymantecDLP folders and subfolders.

To display help for the utility, such as the list of valid options and their flags, enter LanguagePackUtility without any flags.

Note: Running the Language Pack Utility causes the VontuManager and VontuIncidentPersister services to stop for as long as 20 seconds. Any users who are logged on to the Enforce Server administration console will be logged out automatically. When finished making its updates, the utility restarts the services automatically, and users can log back on to the administration console.

Language packs for Symantec Data Loss Prevention can be obtained from Symantec File Connect.
To add a language pack (Windows)

1. Advise other users that anyone currently using the Enforce Server administration console must save their work and log off.

2. Run the Language Pack Utility with the `-a` flag followed by the name of the ZIP file for that language pack. Enter:

   `LanguagePackUtility -a filename`

   where `filename` is the fully qualified path and name of the language pack ZIP file.

   For example, if the Japanese language pack ZIP file is stored in `c:\temp`, add it by entering:

   `LanguagePackUtility -a c:\temp\Symantec_DLP_12.5_Japanese.zip`

   To add multiple language packs during the same session, specify multiple file names, separated by spaces, for example:

   `LanguagePackUtility -a c:\temp\Symantec_DLP_12.5_Japanese.zip Symantec_DLP_12.5_Chinese.zip`

3. Log on to the Enforce Server administration console and confirm that the new language option is available on the Edit General Settings screen. To do this, go to System > Settings > General > Configure > Edit General Settings.

To add a language pack (Linux)

1. Advise other users that anyone currently using the Enforce Server administration console must save their work and log off.

2. Open a terminal session to the Enforce Server host and switch to the `DLP_system_account` by running the following command:

   `su - DLP_system_account`

3. Run the following command:

   `DLP_home/Protect/bin/LanguagePackUtility -a <path to language pack zip file>`

4. Log on to the Enforce Server administration console and confirm that the new language option is available on the Edit General Settings screen. To do this, go to System > Settings > General > Configure > Edit General Settings.
To remove a language pack

1. Advise users that anyone currently using the Enforce Server administration console must save their work and log off.

2. Run the Language Pack Utility with the `-r` flag followed by the Java locale code of the language pack you want to remove. Enter:

   LanguagePackUtility -r locale

   where `locale` is a valid Java locale code corresponding to a Symantec Data Loss Prevention language pack.

   For example, to remove the French language pack enter:

   LanguagePackUtility -r fr_FR

   To remove multiple language packs during the same session, specify multiple file names, separated by spaces.

3. Log on to the Enforce Server administration console and confirm that the language pack is no longer available on the Edit General Settings screen. To do this, go to System > Settings > General > Configure > Edit General Settings.

Removing a language pack has the following effects:

- Users can no longer select the locale of the removed language pack for individual use.

  Note: If the locale of the language pack is supported by the version of Java required for running Symantec Data Loss Prevention, the administrator can later specify it as an alternate locale for any users who need it.

  - The locale reverts to the system-wide default configured by the administrator.
  - If the removed language was the system-wide default locale, the system locale reverts to English.
To change or add a locale

1  Advise users that anyone currently using the Enforce Server administration console must save their work and log off.

2  Run the Language Pack Utility using the `-c` flag followed by the Java locale code for the locale that you want to change or add. Enter:

   `LanguagePackUtility -c locale`

   where `locale` is a valid locale code recognized by Java, such as `pt_PT` for Portuguese.

   For example, to change the locale to Brazilian Portuguese enter:

   `LanguagePackUtility -c pt_BR`

3  Log on to the Enforce Server administration console and confirm that the new alternate locale is now available on the Edit General Settings screen. To do this, go to System > Settings > General > Configure > Edit General Settings.

   If you specify a locale for which there is no language pack, "Translations not available" appears next to the locale name. This means that formatting and sort order are appropriate for the locale, but the Enforce Server administration console screens and online Help are not translated.

---

**Note:** Administrators can only make one additional locale available for users that is not based on a previously installed Symantec Data Loss Prevention language pack.

---

See “About support for character sets, languages, and locales” on page 64.
Managing the Enforce Server platform

- Chapter 4. Managing Enforce Server services and settings
- Chapter 5. Managing roles and users
- Chapter 6. Connecting to group directories
- Chapter 7. Managing stored credentials
- Chapter 8. Managing system events and messages
- Chapter 9. Adding a new product module
Managing Enforce Server services and settings

This chapter includes the following topics:

- About Data Lost Prevention services
- About starting and stopping services on Windows
- Starting and stopping services on Linux

About Data Lost Prevention services

The Symantec Data Loss Prevention services may need to be stopped and started periodically. This section provides a brief description of each service and how to start and stop the services on supported platforms.

The Symantec Data Loss Prevention services for the Enforce Server are described in the following table:

<table>
<thead>
<tr>
<th>Table 4-1</th>
<th>Symantec Data Loss Prevention services</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Service Name</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Vontu Manager</td>
<td>Provides the centralized reporting and management services for Symantec Data Loss Prevention.</td>
</tr>
<tr>
<td>Vontu Monitor Controller</td>
<td>Controls the detection servers (monitors).</td>
</tr>
<tr>
<td>Vontu Notifier</td>
<td>Provides the database notifications.</td>
</tr>
<tr>
<td>Vontu Incident Persister</td>
<td>Writes the incidents to the database.</td>
</tr>
<tr>
<td>Vontu Update</td>
<td>Installs the Symantec Data Loss Prevention system updates.</td>
</tr>
</tbody>
</table>
Starting an Enforce Server on Windows

Use the following procedure to start the Symantec Data Loss Prevention services on a Windows Enforce Server.

To start the Symantec Data Loss Prevention services on a Windows Enforce Server:

1. On the computer that hosts the Enforce Server, navigate to **Start > All Programs > Administrative Tools > Services** to open the Windows Services menu.

2. Start the Symantec Data Loss Prevention services in the following order:
   - Vontu Notifier
   - Vontu Manager
   - Vontu Incident Persister
   - Vontu Monitor Controller (if applicable)
   - Vontu Update (if necessary)

   **Note:** Start the Vontu Notifier service first before starting other services.

See “Stopping an Enforce Server on Windows” on page 78.
Stopping an Enforce Server on Windows

Use the following procedure to stop the Symantec Data Loss Prevention services on a Windows Enforce Server.

To stop the Symantec Data Loss Prevention Services on a Windows Enforce Server

1. On the computer that hosts the Enforce Server, navigate to Start > All Programs > Administrative Tools > Services to open the Windows Services menu.

2. From the Services menu, stop all running Symantec Data Loss Prevention services in the following order:
   - Vontu Monitor Controller (if applicable)
   - Vontu Incident Persister
   - Vontu Manager
   - Vontu Notifier
   - Vontu Update (if necessary)

See “Starting an Enforce Server on Windows” on page 77.

Starting a Detection Server on Windows

To start the Symantec Data Loss Prevention services on a Windows detection server

1. On the computer that hosts the detection server, navigate to Start > All Programs > Administrative Tools > Services to open the Windows Services menu.

2. Start the Symantec Data Loss Prevention services, which might include the following services:
   - Vontu Monitor
   - Vontu Update

See “Stopping a Detection Server on Windows” on page 78.

Stopping a Detection Server on Windows

Use the following procedure to stop the Symantec Data Loss Prevention services on a Windows detection server.
To stop the Symantec Data Loss Prevention Services on a Windows detection server

1. On the computer that hosts the detection server, navigate to **Start > All Programs > Administrative Tools > Services** to open the Windows Services menu.

2. From the **Services** menu, stop all running Symantec Data Loss Prevention services, which might include the following services:
   - Vontu Update
   - Vontu Monitor

See “Starting a Detection Server on Windows” on page 78.

Starting services on single-tier Windows installations

Use the following procedure to start the Symantec Data Loss Prevention services on a single-tier installation on Windows.

To start the Symantec Data Loss Prevention services on a single-tier Windows installation

1. On the computer that hosts the Symantec Data Loss Prevention server applications, navigate to **Start > All Programs > Administrative Tools > Services** to open the Windows Services menu.

2. Start the Symantec Data Loss Prevention in the following order:
   - Vontu Notifier
   - Vontu Manager
   - Vontu Incident Persister
   - Vontu Monitor Controller (if applicable)
   - Vontu Monitor
   - Vontu Update (if necessary)

   **Note:** Start the Vontu Notifier service before starting other services.

See “Stopping services on single-tier Windows installations” on page 79.

Stopping services on single-tier Windows installations

Use the following procedure to stop the Symantec Data Loss Prevention services on a single-tier installation on Windows.
To stop the Symantec Data Loss Prevention services on a single-tier Windows installation

1. On the computer that hosts the Symantec Data Loss Prevention server applications, navigate to Start > All Programs > Administrative Tools > Services to open the Windows Services menu.

2. From the Services menu, stop all running Symantec Data Loss Prevention services in the following order:
   - Vontu Monitor
   - Vontu Monitor Controller (if applicable)
   - Vontu Incident Persister
   - Vontu Manager
   - Vontu Notifier
   - Vontu Update (if necessary)

See “Starting services on single-tier Windows installations” on page 79.

Starting and stopping services on Linux

The procedures for starting and stopping services vary according to installation configurations and between Enforce and detection servers.

- See “Starting an Enforce Server on Linux” on page 80.
- See “Stopping an Enforce Server on Linux” on page 81.
- See “Starting a detection server on Linux” on page 81.
- See “Stopping a detection server on Linux” on page 82.
- See “Starting services on single-tier Linux installations” on page 82.
- See “Stopping services on single-tier Linux installations” on page 83.

Starting an Enforce Server on Linux

Use the following procedure to start the Symantec Data Loss Prevention services on a Linux Enforce Server.

To start the Symantec Data Loss Prevention services on a Linux Enforce Server

1. On the computer that hosts the Enforce Server, log on as root.
2. Change directory to /opt/SymantecDLP/Protect/bin.
Before starting other Symantec Data Loss Prevention services, to start the Vontu Notifier service, enter:

./VontuNotifier.sh start

To start the remaining Symantec Data Loss Prevention services, enter:

./VontuManager.sh start
./VontuIncidentPersister.sh start
./VontuUpdate.sh start
./VontuMonitorController.sh start

See “Stopping an Enforce Server on Linux” on page 81.

Stopping an Enforce Server on Linux

Use the following procedure to stop the Symantec Data Loss Prevention services on a Linux Enforce Server.

To stop the Symantec Data Loss Prevention services on a Linux Enforce Server

1 On the computer that hosts the Enforce Server, log on as root.
2 Change directory to /opt/SymantecDLP/Protect/bin.
3 To stop all running Symantec Data Loss Prevention services, enter:

./VontuUpdate.sh stop
./VontuIncidentPersister.sh stop
./VontuManager.sh stop
./VontuMonitorController.sh stop
./VontuNotifier.sh stop

See “Starting an Enforce Server on Linux” on page 80.

Starting a detection server on Linux

Use the following procedure to start the Symantec Data Loss Prevention services on a Linux detection server.
To start the Symantec Data Loss Prevention services on a Linux detection server

1. On the computer that hosts the detection server, log on as root.
2. Change directory to `/opt/SymantecDLP/Protect/bin`.
3. To start the Symantec Data Loss Prevention services, enter:

   ```
   ./VontuMonitor.sh start
   ./VontuUpdate.sh start
   ```

See “Stopping a detection server on Linux” on page 82.

Stopping a detection server on Linux

Use the following procedure to stop the Symantec Data Loss Prevention services on a Linux detection server.

To stop the Symantec Data Loss Prevention services on a Linux detection server

1. On the computer that hosts the detection server, log on as root.
2. Change directory to `/opt/SymantecDLP/Protect/bin`.
3. To stop all running Symantec Data Loss Prevention services, enter:

   ```
   ./VontuUpdate.sh stop
   ./VontuMonitor.sh stop
   ```

See “Starting a detection server on Linux” on page 81.

Starting services on single-tier Linux installations

Use the following procedure to start the Symantec Data Loss Prevention services on a single-tier installation on Linux.

To start the Symantec Data Loss Prevention services on a single-tier Linux installation

1. On the computer that hosts the Symantec Data Loss Prevention server applications, log on as root.
2. Change directory to `/opt/SymantecDLP/Protect/bin`.

To stop the Symantec Data Loss Prevention services on a single-tier Linux installation

1. On the computer that hosts the Symantec Data Loss Prevention server applications, log on as root.
2. Change directory to `/opt/SymantecDLP/Protect/bin`.
3. To stop the services, enter:

   ```
   ./VontuUpdate.sh stop
   ./VontuMonitor.sh stop
   ```
3 Before starting other Symantec Data Loss Prevention services, to start the Vontu Notifier service, enter:

./VontuNotifier.sh start

4 To start the remaining Symantec Data Loss Prevention services, enter:

./VontuManager.sh start
./VontuMonitor.sh start
./VontuIncidentPersister.sh start
./VontuUpdate.sh start
./VontuMonitorController.sh start

See “Stopping services on single-tier Linux installations” on page 83.

Stopping services on single-tier Linux installations

Use the following procedure to stop the Symantec Data Loss Prevention services on a single-tier installation on Linux.

To stop the Symantec Data Loss Prevention services on a single-tier Linux installation

1 On the computer that hosts the Symantec Data Loss Prevention servers, log on as root.

2 Change directory to /opt/SymantecDLP/Protect/bin.

3 To stop all running Symantec Data Loss Prevention services, enter:

./VontuUpdate.sh stop
./VontuIncidentPersister.sh stop
./VontuManager.sh stop
./VontuMonitor.sh stop
./VontuMonitorController.sh stop
./VontuNotifier.sh stop

See “Starting services on single-tier Linux installations” on page 82.
Managing roles and users

This chapter includes the following topics:

- About role-based access control
- About authenticating users
- About configuring roles and users
- About recommended roles for your organization
- Roles included with solution packs
- Configuring roles
- Configuring user accounts
- Configuring password enforcement settings
- Resetting the Administrator password
- Manage and add roles
- Manage and add users
- Integrating Active Directory for user authentication
- About configuring certificate authentication

About role-based access control

Symantec Data Loss Prevention provides role-based access control to govern how users access product features and functionality. For example, a role might let users view reports, but prevent users from creating policies or deleting incidents. Or, a role might let users author policy response rules but not detection rules.
Roles determine what a user can see and do in the Enforce Server administration console. For example, the Report role is a specific role that is included in most Symantec Data Loss Prevention solution packs. Users in the Report role can view incidents and create policies, and configure Discover targets (if you are running a Discover Server). However, users in the Report role cannot create Exact Data or Document Profiles. Also, users in the Report role cannot perform system administration tasks. When a user logs on to the system in the Report role, the Manage > Data Profiles and the System > Login Management modules in the Enforce Server administration console are not visible to this user.

You can assign a user to more than one role. Membership in multiple roles allows a user to perform different kinds of work in the system. For example, you grant the information security manager user (InfoSec Manager) membership in two roles: ISR (information security first responder) and ISM (information security manager). The InfoSec Manager can log on to the system as either a first responder (ISR) or a manager (ISM), depending on the task(s) to perform. The InfoSec Manager only sees the Enforce Server components appropriate for those tasks.

You can also combine roles and policy groups to limit the policies and detection servers that a user can configure. For example, you associate a role with the European Office policy group. This role grants access to the policies that are designed only for the European office.

See “Policy deployment” on page 288.

Users who are assigned to multiple roles must specify the desired role at log on. Consider an example where you assign the user named "User01" to two roles, "Report" and "System Admin." If "User01" wanted to log on to the system to administer the system, the user would log on with the following syntax: Login: System Admin\User01

See “Logging on and off the Enforce Server administration console” on page 57.

The Administrator user (created during installation) has access to every part of the system and therefore is not a member of any access-control role.

See “About the administrator account” on page 58.

### About authenticating users

Symantec Data Loss Prevention provides the following options for authenticating users to the Enforce Server administration console:
<table>
<thead>
<tr>
<th>Authentication mechanism</th>
<th>Sign-on mechanism</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password authentication</td>
<td>Forms-based sign-on</td>
<td>With password authentication, the Enforce Server administration console authenticates each user by determining if the supplied user name and password combination matches an active user account in the Enforce Server configuration. An active user account is authenticated if it has been assigned a valid role. When using this authentication mechanism, users enter their credentials into the Enforce Server administration console's logon page and submit them over an HTTPS connection to the Tomcat container that hosts the administration console. With password authentication, you must configure the user name and password of each user account directly in the Enforce Server administration console. You must also ensure that each user account has at least one assigned role. See “Manage and add users” on page 104.</td>
</tr>
<tr>
<td>Active Directory authentication</td>
<td>Forms-based sign-on</td>
<td>With Microsoft Active Directory authentication, the Enforce Server administration console first evaluates a supplied user name to determine if the name exists in a configured Active Directory server. If the user name exists in Active Directory, the supplied password for the user is evaluated against the Active Directory password. Any password configured in the Enforce Server configuration is ignored. With Active Directory authentication, you must configure a user account for each Active Directory user in the Enforce Server administration console. You do not have to enter a password for an Active Directory user account. You can switch to Active Directory authentication after you have already created user accounts in the system. However, only those existing user names that match Active Directory user names remain valid after the switch. <strong>Note:</strong> The Administrator user can log in to the Enforce Server administration console using the Enforce Server system account password that you created during installation. See “Verifying the Active Directory connection” on page 108.</td>
</tr>
<tr>
<td>Authentication mechanism</td>
<td>Sign-on mechanism</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Certificate authentication</td>
<td>Single sign-on from Public Key Infrastructure (PKI)</td>
<td>Certificate authentication enables a user to automatically log on to the Enforce Server administration console using an X.509 client certificate that is generated by your public key infrastructure (PKI). To use certificate-based single sign-on, you must first enable certificate authentication in the Enforce Server. See “Configuring certificate authentication for the Enforce Server administration console” on page 112. The client certificate must be delivered to the Enforce Server when a client's browser performs the SSL handshake with the Enforce Server administration console. For example, you might use a smart card reader and middleware with your browser to automatically present a certificate to the Enforce Server. Or, you might obtain an X.509 certificate from a certificate authority and upload the certificate to a browser that is configured to send the certificate to the Enforce Server. When a user accesses the Enforce Server administration console, the PKI automatically delivers the user's certificate to the Tomcat container that hosts the administration console. The Tomcat container validates the client certificate using the certificate authorities that you have configured in the Tomcat trust store. See “Adding certificate authority (CA) certificates to the Tomcat trust store” on page 114. The Enforce Server administration console uses the validated certificate to determine whether the certificate has been revoked. See “About certificate revocation checks” on page 118. If the certificate is valid and has not been revoked, then the Enforce Server uses the common name (CN) in the certificate to determine if that CN is mapped to an active user account with a role in the Enforce Server configuration. For each user that will access the Enforce Server administration console using certificate-based single sign-on, you must create a user account in the Enforce Server that defines the corresponding user's CN value. You must also assign one or more valid roles to the user account. See “Manage and add users” on page 104.</td>
</tr>
</tbody>
</table>

When you install the Enforce Server, the installer prompts you to select the authentication mechanism to use. Password authentication is the default mechanism used with Symantec Data Loss Prevention, and you can use password authentication even if you also use certificate authentication. If you use certificate authentication,
you can optionally disable password authentication to rely on your PKI for all access to the Enforce Server administration console.

If you upgrade from an earlier version of Symantec Data Loss Prevention, you can enable certificate authentication using manual procedures.

About configuring roles and users

When you install the Enforce Server, you create a default Administrator user that has access to all roles. If you import a solution pack to the Enforce Server, the solution pack includes several roles and users to get you started.

See “About the administrator account” on page 58.

You may want to add roles and users to the Enforce Server. When adding roles and users, consider the following guidelines:

- Understand the roles necessary for your business users and for the information security requirements and procedures of your organization. See “About recommended roles for your organization” on page 88.

- Review the roles that created when you installed a solution pack. You can likely use several of them (or modified versions of them) for users in your organization. See “Roles included with solution packs” on page 90.

- If necessary, modify the solution-pack roles and create any required new roles. See “Configuring roles” on page 91.

- Create users and assign each of them to one or more roles. See “Configuring user accounts” on page 99.

- Manage roles and users and remove those not being used. See “Manage and add roles” on page 103. See “Manage and add users” on page 104.

About recommended roles for your organization

To determine the most useful roles for your organization, review your business processes and security requirements.

Most businesses and organizations find the following roles fundamental when they implement the Symantec Data Loss Prevention system:

- **System Administrator**
  This role provides access to the **System** module and associated menu options in the Enforce Server administration console. Users in this role can monitor and manage the Enforce Server and detection servers(s). Users in this role can also
deploy detection servers and run Network Discover scans. However, users in this role cannot view detailed incident information or author policies. All solution packs create a "Sys Admin" role that has system administrator privileges.

- **User Administrator**
  This role grants users the right to manage users and roles. Typically this role grants no other access or privileges. Because of the potential for misuse, it is recommended that no more than two people in the organization be assigned this role (primary and backup).

- **Policy Administrator**
  This role grants users the right to manage policies and response rules. Typically this role grants no other access or privileges. Because of the potential for misuse, it is recommended that no more than two people in the organization be assigned this role (primary and backup).

- **Policy Author**
  This role provides access to the **Policies** module and associated menu options in the Enforce Server administration console. This role is suited for information security managers who track incidents and respond to risk trends. An information security manager can author new policies or modifying existing policies to prevent data loss. All solution packs create an "InfoSec Manager" (ISM) role that has policy authoring privileges.

- **Incident Responder**
  This role provides access to the **Incidents** module and associated menu options in the Enforce Server administration console. Users in this role can track and remediates incidents. Businesses often have at least two incident responder roles that provide two levels of privileges for viewing and responding to incidents. A first-level responder may view generic incident information, but cannot access incident details (such as sender or recipient identity). In addition, a first-level responder may also perform some incident remediation, such as escalating an incident or informing the violator of corporate security policies. A second-level responder might be escalation responder who has the ability to view incident details and edit custom attributes. A third-level responder might be an investigation responder who can create response rules, author policies, and create policy groups.

  All solution packs create an "InfoSec Responder" (ISR) role. This role serves as a first-level responder. You can use the ISM (InfoSec Manager) role to provide second-level responder access.

Your business probably requires variations on these roles, as well as other roles. For more ideas about these and other possible roles, see the descriptions of the roles that are imported with solution packs.

See "Roles included with solution packs" on page 90.
Roles included with solution packs

The various solution packs offered with Symantec Data Loss Prevention create roles and users when installed. For all solution packs there is a standard set of roles and users. You may see some variation in those roles and users, depending on the solution pack you import.

The following table summarizes the Financial Services Solution Pack roles. These roles are largely the same as the roles that are found in other Symantec Data Loss Prevention solution packs.

See Table 5-2 on page 90.

Table 5-2  Financial Services Solution Pack roles

<table>
<thead>
<tr>
<th>Role Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| Compliance | Compliance Officer:  
- Users in this role can view, remediate, and delete incidents; look up attributes; and edit all custom attributes.  
- This comprehensive role provides users with privileges to ensure that compliance regulations are met. It also allows users to develop strategies for risk reduction at a business unit (BU) level, and view incident trends and risk scorecards. |
| Exec | Executive:  
- Users in this role can view, remediate, and delete incidents; look up attributes; and view all custom attributes.  
- This role provides users with access privileges to prevent data loss risk at the macro level. Users in this role can review the risk trends and performance metrics, as well as incident dashboards. |
| HRM | HR Manager:  
- Users in this role can view, remediate, and delete incidents; look up attributes; and edit all custom attributes.  
- This role provides users with access privileges to respond to the security incidents that are related to employee breaches. |
| Investigator | Incident Investigator:  
- Users in this role can view, remediate, and delete incidents; look up attributes; and edit all custom attributes.  
- This role provides users with access privileges to research details of incidents, including forwarding incidents to forensics. Users in this role may also investigate specific employees. |
Table 5-2  Financial Services Solution Pack roles (continued)

<table>
<thead>
<tr>
<th>Role Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| ISM       | InfoSec Manager:  
  - Users in this role can view, remediate, and delete incidents. They can look up attributes, edit all custom attributes, author all policies and policy groups, and author response rules.  
  - This role provides users with second-level incident response privileges. Users can manage escalated incidents within information security team. |
| ISR       | InfoSec Responder:  
  - Users in this role can view, remediate, and delete incidents; look up attributes; and view or edit some custom attributes. They have no access to sender or recipient identity details.  
  - This role provides users with first-level incident response privileges. Users can view policy incidents, find broken business processes, and enlist the support of the extended remediation team to remediate incidents. |
| Report    | Reporting and Policy Authoring:  
  - Users in this role can view and remediate incidents, and author all policies and policy groups. They have no access to incident details.  
  - This role provides a single role for policy authoring and data loss risk management. |
| Sys Admin | System administrator:  
  - Users in this role can administer the system and the system users, and can view incidents. They have no access to incident details. |

Configuring roles

Each Symantec Data Loss Prevention user is assigned to one or more roles that define the privileges and rights that user has within the system. A user’s role determines system administration privileges, policy authoring rights, incident access, and more. If a user is a member of multiple roles, the user must specify the role when logging on, for example: Login: Sys Admin/sysadmin01.

See “About role-based access control” on page 84.
See “About configuring roles and users” on page 88.
To configure a role

1. Navigate to the **System > Login Management > Roles** screen.
2. Click **Add Role**.

The **Configure Role** screen appears, displaying the following tabs: **General**, **Incident Access**, **Policy Management**, and **Users**.

3. In the **General** tab:
   - Enter a unique **Name** for the role. The name field is case-sensitive and is limited to 30 characters. The name you enter should be short and self-describing. Use the **Description** field to annotate the role name and explain its purpose in more details. The role name and description appear in the **Role List** screen.
   - In the **User Privileges** section, you grant user privileges for the role.
     **System** privileges(s):

     **User Administration (Superuser)**
     - Select the **User Administration** option to enable users to create additional roles and users in the Enforce Server.

     **Server Administration**
     - Select the **Server Administration** option to enable users to perform the following functions:
       - Configure detection servers.
       - Create and manage Data Profiles for Exact Data Matching (EDM), Indexed Document Matching (IDM), and Vector Machine Learning (VML).
       - Configure and assign incident attributes.
       - Configure system settings.
       - Configure response rules.
       - Create policy groups.
       - Configure recognition protocols.
       - View system event and traffic reports.

     **People** privilege:

     **User Reporting (Risk Summary, User Snapshot)**
     - Select the **User Reporting** option to enable users to view the user risk summary.
     - **Note**: The **Incident > View** privilege is automatically enabled for all incident types for users with the **User Reporting** privilege.

   See “About user risk” on page 1081.
In the **Incidents** section, you grant users in this role the following incident privilege(s). These settings apply to all incident reports in the system, including the Executive Summary, Incident Summary, Incident List, and Incident Snapshots.

**View**

Select the **View** option to enable users in this role to view policy violation incidents.

You can customize incident viewing access by selecting various **Actions** and **Display Attribute** options as follows:

- **By default** the **View** option is enabled (selected) for all types of incidents: **Network Incidents**, **Discover Incidents**, **Endpoint Incidents**, **Mobile Incidents**, and **Classification Events**.

- **To restrict** viewing access to only certain incident types, select (highlight) the type of incident you want to authorize this role to view. (Hold down the Ctrl key to make multiple selections.) If a role does not allow a user to view part of an incident report, the option is replaced with "Not Authorized" or is blank.

**Note:** If you revoke an incident-viewing privilege for a role, the system deletes any saved reports for that role that rely on the revoked privilege. For example, if you revoke (deselect) the privilege to view network incidents, the system deletes any saved network incident reports associated with the role.
**Actions**

Select among the following *Actions* to customize the actions a user can perform when an incident occurs:

- **Remediate Incidents**
  This privilege lets users change the status or severity of an incident, set a data owner, add a comment to the incident history, set the **Do Not Archive** and **Allow Archive** options, and execute response rule actions. In addition, if you are using the Incident Reporting and Update API, select this privilege to remediate the location and status attributes.

- **Smart Response Rules to execute**
  You specify which Smart Response Rules that can be executed on a per role basis. Configured Smart Response Rules are listed in the "Available" column on the left. To expose a Smart Response Rule for execution by a user of this role, select it and click the arrow to add it to the right-side column. Use the CTRL key to select multiple rules.

- **Perform attribute lookup**
  Lets users look up incident attributes from external sources and populate their values for incident remediation.

- **Delete incidents**
  Lets users delete an incident.

- **Archive incidents**
  Lets users archive an incident.

- **Restore archived incidents**
  Lets users restore previously archived incidents.

- **Export Web archive**
  Lets users export a report that the system compiles from a Web archive of incidents.

- **Export XML**
  Lets users export a report of incidents in XML format.

- **Email incident report as CSV attachment**
  Lets users email as an attachment a report containing a comma-separated listing of incident details.
Select among the following user privileges to enable access for Web Services clients that use the Incident Reporting and Update API or the deprecated Reporting API:

- **Incident Reporting**
  Enables Web Services clients to retrieve incident details.

- **Incident Update**
  Enables Web Services clients to update incident details.
  (Does not apply to clients that use the deprecated Reporting API.)

See the *Symantec Data Loss Prevention Incident Reporting and Update API Developers Guide* for more information.
Display Attributes

Select among the following **Display Attributes** to customize what attributes appear in the Incidents view for the policy violations that users of the role can view.

**Shared** attributes are common to all types of incidents:

- **Matches**
  The highlighted text of the message that violated the policy appears on the **Matches** tab of the Incident Snapshot screen.

- **History**
  The incident history.

- **Body**
  The body of the message.

- **Attachments**
  The names of any attachments or files.

- **Sender**
  The message sender.

- **Recipients**
  The message recipients.

- **Subject**
  The subject of the message.

- **Original Message**
  Controls whether or not the original message that caused the policy violation incident can be viewed.

**Note:** To view an attachment properly, both the "Attachment" and the "Original Message" options must be checked.

**Endpoint** attributes are specific to Endpoint incidents:

- **Username**
  The name of the Endpoint user.

- **Machine name**
  The name of the computer where the Endpoint Agent is installed.

**Discover** attributes are specific to Discover incidents:

- **File Owner**
  The name of the owner of the file being scanned.

- **Location**
  The location of the file being scanned.
The Custom Attributes list includes all of the custom attributes configured by your system administrator, if any.

- Select **View All** if you want users to be able to view all custom attribute values.
- Select **Edit All** if you want users to edit all custom attribute values.
- To restrict the users to certain custom attributes, clear the **View All** and **Edit All** check boxes and individually select the **View** and/or **Edit** check box for each custom attribute you want viewable or editable.

**Note:** If you select Edit for any custom attribute, the View check box is automatically selected (indicated by being grayed out). If you want the users in this role to be able to view all custom attribute values, select **View All**.

- In the **Discover** section, you grant users in this role the following privileges:

  **Folder Risk Reporting**
  
  This privilege lets users view Folder Risk Reports. Refer to the Symantec Data Loss Prevention Data Insight Implementation Guide.
  
  **Note:** This privilege is only available for Symantec Data Loss Prevention Data Insight licenses.

  **Content Root Enumeration**
  
  This privilege lets users configure and run Content Root Enumeration scans. For more information about Content Root Enumeration scans, See “Working with Content Root Enumeration scans” on page 1243.

4 In the **Incident Access** tab, configure any conditions (filters) on the types of incidents that users in this role can view.

**Note:** You must select the **View** option on the **General** tab for settings on the **Incident Access** tab to have any effect.

To add an Incident Access condition:

- Click **Add Condition**.

- Select the type of condition and its parameters from left to right, as if writing a sentence. (Note that the first drop-down list in a condition contains the alphabetized system-provided conditions that are associated with any custom attributes.)
For example, select Policy Group from the first drop-down list, select Is Any Of from the second list, and then select Default Policy Group from the final listbox. These settings would limit users to viewing only those incidents that the default policy group detected.

5 In the Policy Management tab, select one of the following policy privileges for the role:

- **Author Policies**
  This role privilege lets users add, edit, and delete policies within the policy groups that are selected.
  It also lets users modify system data identifiers, and create custom data identifiers.
  It also lets users create and modify User Groups. This privilege does not let users create or manage Data Profiles. This activity requires Enforce Server administrator privileges.

- **Discover Scan Control**
  Lets the users in this role create Discover targets, run scans, and view Discover Servers.

- **Credential Management**
  Lets users create and modify the credentials that the system requires to access target systems and perform Discover scans.

- **Policy Groups**
  Select All Policy Groups only if users in this role need access to all existing policy groups and any that will be created in the future.
  Otherwise you can select individual policy groups or the Default Policy Group.

  **Note:** These options do not grant the right to create, modify, or delete policy groups. Only the users whose role includes the Server Administration privilege can work with policy groups.

- **Author Response Rules**
  Enables users in this role to create, edit, and delete response rules.

  **Note:** Users cannot edit or author response rules for policy remediation unless you select the Author Response Rules option.
**Note:** Preventing users from authoring response rules does not prevent them from executing response rules. For example, a user with no response-rule authoring privileges can still execute smart response rules from an incident list or incident snapshot.

6 In the **Users** tab, select any users to which to assign this role. If you have not yet configured any users, you can assign users to roles after you create the users.

7 Click **Save** to save your newly created role to the Enforce Server database.

### Configuring user accounts

User accounts are the means by which users log onto the system and perform tasks. The role that the user account belongs to limits what the user can do in the system.

**To configure a user account:**

1 In the Enforce Server Administration Console, select **System > Login Management > DLP Users** to create a new user account or to reconfigure an existing user account. Or, click **Profile** to reconfigure the user account to which you are currently logged on.

2 Click **Add User** to add a new user, or click the name of an existing user to modify that user's configuration.

3 Enter a name for a new user account in the **Name** field.
   - The user account name must be between 8 and 30 characters long, is case-sensitive, and cannot contain backslashes (\).
   - If you use certificate authentication, the **Name** field value does not have to match the user's Common Name (CN). However, you may choose to use the same value for both the **Name** and **Common Name (CN)** so that you can easily locate the configuration for a specific CN. The Enforce Server administration console shows only the **Name** field value in the list of configured users.
   - If you are using Active Directory authentication, the user account name must match the name of the Active Directory user account. Note that all Symantec Data Loss Prevention user names are case-sensitive, even though Active Directory user names are not. Active Directory users will need to enter the case-sensitive account name when logging onto the Enforce Server administration console. See “Integrating Active Directory for user authentication” on page 105.
Configure the **Authentication** section of the **Configure User** page as follows:

<table>
<thead>
<tr>
<th>Option</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Use Password authentication</strong></td>
<td>Select this option to use password authentication and allow the user to sign on using the Enforce Server administration console log on page. This option is required if the user account will be used for a Reporting API Web Service client. If you select this option, also enter the user password in the <strong>Password</strong> and the <strong>Re-enter Password</strong> fields. The password must be at least eight characters long and is case-sensitive. For security purposes, the password is obfuscated and each character appears as an asterisk. If you configure advanced password settings, the user must specify a strong password. In addition, the password may expire at a certain date and the user has to define a new one periodically. See “<strong>Configuring password enforcement settings</strong>” on page 102. You can choose password authentication even if you also use certificate authentication. If you use certificate authentication, you can optionally disable sign on from the Enforce Server administration console log on page. See “<strong>Disabling password authentication and forms-based log on</strong>” on page 125. Symantec Data Loss Prevention authenticates all Reporting API clients using password authentication. If you configure Symantec Data Loss Prevention to use certificate authentication, any user account that is used to access the Reporting API Web Service must have a valid password. See the <strong>Symantec Data Loss Prevention Reporting API Developers Guide</strong>. <strong>Note:</strong> If you configure Active Directory integration with the Enforce Server, users authenticate using their Active Directory passwords. In this case the password field does not appear on the <strong>Users</strong> screen. See “<strong>Integrating Active Directory for user authentication</strong>” on page 105.</td>
</tr>
<tr>
<td><strong>Use Certificate authentication</strong></td>
<td>Select this option to use certificate authentication and allow the user to automatically single sign-on with a certificate that is generated by a separate Private Key Infrastructure (PKI). This option is available only if you have configured certificate authentication during the Symantec Data Loss Prevention installation, or you have manually configured support for certificate authentication. See “<strong>About authenticating users</strong>” on page 85. See “<strong>About configuring certificate authentication</strong>” on page 110. If you select this option, you must specify the common name (CN) value for the user in the <strong>Common Name (CN)</strong> field. The CN value appears in the Subject field of the user’s certificate, which is generated by the PKI. Common names generally use the format, <em>first_name last_name identification_number</em>. The Enforce Server uses the CN value to map the certificate to this user account. If an authenticated certificate contains the specified CN value, all other attributes of this user account, such as the default role and reporting preferences, are applied when the user logs on. <strong>Note:</strong> You cannot specify the same <strong>Common Name (CN)</strong> value in multiple Enforce Server user accounts.</td>
</tr>
</tbody>
</table>
**Option** | **Instructions**
--- | ---
**Account Disabled** | Select this option to lock the user out of the Enforce Server administration console. This option disables access for the user account regardless of which authentication mechanism you use.

For security, after a certain number of consecutive failed logon attempts, the system automatically disables the account and locks out the user. In this case the **Account Disabled** option is checked.

To reinstate the user account and allow the user to log on to the system, clear this option by unchecking it.

5 | Optionally enter an **Email Address** and select a **Language** for the user in the **General** section of the page. The **Language** selection depends on the language pack(s) you have installed.

6 | In the **Report Preferences** section of the **Users** screen you specify the preferences for how this user is to receive incident reports, including **Text File Encoding** and **CSV Delimiter**.

If the role grants the privilege for **XML Export**, you can select to include incident violations and incident history in the XML export.

7 | In the **Roles** section, select the roles that are available to this user to assign data and incident access privileges.

You must assign the user at least one role to access the Enforce Server administration console.

See “Configuring roles” on page 91.

8 | Select the **Default Role** to assign to this user at log on.

The default role is applied if no specific role is requested when the user logs on.

For example, the Enforce Server administration console uses the default role if the user uses single sign-on with certificate authentication or uses the logon page.

---

**Note:** Individual users can change their default role by clicking **Profile** and selecting a different option from the **Default Role** menu. The new default role is applied at the next logon.

See “About authenticating users” on page 85.
9 Click **Save** to save the user configuration.

**Note:** Once you have saved a new user, you cannot edit the user name.

10 Manage users and roles as necessary.

See “Manage and add roles” on page 103.

See “Manage and add users” on page 104.

### Configuring password enforcement settings

At the **Systems > Settings > General** screen you can require users to use strong passwords. Strong passwords must contain at least eight characters, at least one number, and at least one uppercase letter. Strong passwords cannot have more than two repeated characters in a row. If you enable strong passwords, the effect is system-wide. Existing users without a strong password must update their profiles at next logon.

You can also require users to change their passwords at regular intervals. In this case at the end of the interval you specify, the system forces users to create a new password.

If you use Active Directory authentication, these password settings only apply to the Administrator password. All other user account passwords are derived from Active Directory.

See “Integrating Active Directory for user authentication” on page 105.

**To configure advanced authentication settings**

1. Go to **System > Settings > General** and click **Configure**.

2. To require strong passwords, locate the **Password Enforcement** section and select **Require Strong Passwords**.

   Symantec Data Loss Prevention prompts existing users who do not have strong passwords to create one at next logon.

3. To set the period for which passwords remain valid, type a number (representing the number of days) in the **Password Rotation Period** field.

   To let passwords remain valid forever, type 0 (the character for zero).
Resetting the Administrator password

Symantec Data Loss Prevention provides the AdminPasswordReset utility to reset the Administrator's password. There is no method to recover a lost password, but you can use this utility to assign a new password. You can also use this utility if certificate authentication mechanisms are disabled and you have not yet defined a password for the Administrator account.

To use the AdminPasswordReset utility, you must specify the password to the Enforce Server database. Use the following procedure to reset the password.

To reset the Administrator password for forms-based log on

1. Log onto the Enforce Server computer using the account that you created during Symantec Data Loss Prevention installation.

   **Note:** If you log on with a different account (such as the root or Administrator account) ensure that you do not change the permissions or ownership on any Symantec Data Loss Prevention configuration file in the steps that follow.

2. Change directory to the /opt/SymantecDLP/Protect/bin (Linux) or c:\SymantecDLP\Protect\bin (Windows) directory. If you installed Symantec Data Loss Prevention into a different directory, substitute the correct path.

3. Execute the AdminPasswordReset utility using the following syntax:

   `AdminPasswordReset -dbpass oracle_password -newpass new_administrator_password`

   Replace `oracle_password` with the password to the Enforce Server database, and replace `new_administrator_password` with the password you want to set.

Manage and add roles

The System > Login Management > Roles screen displays an alphabetical list of the roles that are defined for your organization.

Roles listed on this screen display the following information:

- **Name** – The name of the role
- **Description** – A brief description of the role

Assuming that you have the appropriate privileges, you can view, add, modify, or delete roles as follows:

- Add a new role, or modify an existing one.
  
  Click **Add Role** to begin adding a new role to the system.
Click anywhere in a row or the pencil icon (far right) to modify that role
See “Configuring roles” on page 91.

■ Click the red X icon (far right) to delete the role; a dialog box confirms the deletion.

Before editing or deleting roles, note the following guidelines:

■ If you change the privileges for a role, users in that role who are currently logged on to the system are not affected. For example, if you remove the Edit privilege for a role, users currently logged on retain permission to edit custom attributes for that session. However, the next time users log on, the changes to that role take effect, and those users can no longer edit custom attributes.

■ If you revoke an incident-viewing privilege for a role, the Enforce Server automatically deletes any saved reports that rely on the revoked privilege. For example, if you revoke the privilege to view network incidents, the system deletes any saved network incident reports associated with the newly restricted role.

■ Before you can delete a role, you must make sure there are no users associated with the role.

■ When you delete a role, you delete all shared saved reports that a user in that role saved.

See “Manage and add users” on page 104.

Manage and add users

The System > Login Management > DLP Users screen lists all the active user accounts in the system.

For each user account listed, the following information is listed:

■ User Name – The name the user enters to log on to the Enforce Server
■ Email – The email address of the user
■ Access – The role(s) in which the user is a member

Assuming that you have the appropriate privileges, you can add, edit, or delete user accounts as follows:

■ Add a new user account, or modify an existing one.
  Click Add to begin adding a new user to the system.
  Click anywhere in a row or the pencil icon (far right) to view and edit that user account.
  See “Configuring user accounts” on page 99.
Click the red X icon (far right) to delete the user account; a dialog box confirms the deletion.

**Note:** The Administrator account is created on install and cannot be removed from the system.

**Note:** When you delete a user account, you also delete all private saved reports that are associated with that user.

See “Manage and add roles” on page 103.

### Integrating Active Directory for user authentication

You can configure the Enforce Server to use Microsoft Active Directory for user authentication.

After you switch to Active Directory authentication, you must still define users in the Enforce Server administration console. If the user names you enter in the Administration Console match Active Directory users, the system associates any new user accounts with Active Directory passwords. You can switch to Active Directory authentication after you have already created user accounts in the system. Only those existing user names that match Active Directory user names remain valid after the switch.

Users must use their Active Directory passwords when they log on. Note that all Symantec Data Loss Prevention user names remain case sensitive, even though Active Directory user names are not. You can switch to Active Directory authentication after already having created user names in Symantec Data Loss Prevention. However, users still have to use the case-sensitive Symantec Data Loss Prevention user name when they log on.

#### To use Active Directory authentication

1. Verify that the Enforce Server host is time-synchronized with the Active Directory server.

   **Note:** Ensure that the clock on the Active Directory host is synched to within five minutes of the clock on the Enforce Server host.

2. (Linux only) Make sure that the following Red Hat RPMs are installed on the Enforce Server host:
3 Create the krb5.ini (or krb5.conf for Linux) configuration file that gives the Enforce Server information about your Active Directory domain structure and Active Directory server addresses.

See “Creating the configuration file for Active Directory integration” on page 106.

4 Confirm that the Enforce Server can communicate with the Active Directory server.

See “Verifying the Active Directory connection” on page 108.

5 Configure Symantec Data Loss Prevention to use Active Directory authentication.


Creating the configuration file for Active Directory integration

You must create a krb5.ini configuration file (or krb5.conf on Linux) to give Symantec Data Loss Prevention information about your Active Directory domain structure and server locations. This step is required if you have more than one Active Directory domain. However, even if your Active Directory structure includes only one domain, it is still recommended to create this file. The kinit utility uses this file to confirm that Symantec Data Loss Prevention can communicate with the Active Directory server.

Note: If you are running Symantec Data Loss Prevention on Linux, verify the Active Directory connection using the kinit utility. You must rename the krb5.ini file as krb5.conf. The kinit utility requires the file to be named krb5.conf on Linux. Symantec Data Loss Prevention assumes that you use kinit to verify the Active Directory connection, and directs you to rename the file as krb5.conf.

Symantec Data Loss Prevention provides a sample krb5.ini file that you can modify for use with your own system. The sample file is stored in SymantecDLP\Protect\config (for example, \SymantecDLP\Protect\config on Windows or /opt/Vontu/Protect/config on Linux). If you are running Symantec Data Loss Prevention on Linux, Symantec recommends renaming the file to krb5.conf. The sample file, which is divided into two sections, looks like this:
The [libdefaults] section identifies the default domain. (Note that Kerberos realms correspond to Active Directory domains.) The [realms] section defines an Active Directory server for each domain. In the previous example, the Active Directory server for ENG.COMPANY.COM is engAD.eng.company.com.

To create the krb5.ini or krb5.conf file

1. Go to SymantecDLP\Protect\config and locate the sample krb5.ini file. For example, locate the file in \SymantecDLP\Protect\config (on Windows) or /opt/Vontu/Protect/config (on Linux).

2. Copy the sample krb5.ini file to the c:\windows directory (on Windows) or the /etc directory (on Linux). If you are running Symantec Data Loss Prevention on Linux, plan to verify the Active Directory connection using the kinit command-line tool. Rename the file as krb5.conf.

   See “Verifying the Active Directory connection” on page 108.

3. Open the krb5.ini or krb5.conf file in a text editor.

4. Replace the sample default_realm value with the fully qualified name of your default domain. (The value for default_realm must be all capital letters.) For example, modify the value to look like the following:

   default_realm = MYDOMAIN.LAB

5. Replace the other sample domain names with the names of your actual domains. (Domain names must be all capital letters.) For example, replace ENG.COMPANY.COM with ADOMAIN.COMPANY.COM.

6. Replace the sample kdc values with the host names or IP addresses of your Active Directory servers. (Be sure to follow the specified format, in which opening brackets are followed immediately by line breaks.) For example, replace engAD.eng.company.com with ADserver.eng.company.com, and so on.
Remove any unused **kdc** entries from the configuration file. For example, if you have only two domains besides the default domain, delete the unused **kdc** entry.

Save the file.

### Verifying the Active Directory connection

**kinit** is a command-line tool you can use to confirm that the Active Directory server responds to requests. It also verifies that the Enforce Server has access to the Active Directory server. For Microsoft Windows installations, the utility is installed by the Symantec Data Loss Prevention installer in the `SymantecDLP\jre\bin` directory. For Linux installations, the utility is part of the Red Hat Enterprise Linux distribution, and is in the following location: `/usr/kerberos/bin/kinit`. You can also download Java SE 6 and locate the **kinit** tool in `java_home\jdk1.6.0\bin`.

If you run the Enforce Server on Linux, use the **kinit** utility to test access from the Enforce Server to the Active Directory server. Rename the `krb5.ini` file as `krb5.conf`. The **kinit** utility requires the file to be named `krb5.conf` on Linux.


**To test the connection to the Active Directory server**

1. On the Enforce Server host, go to the command line and navigate to the directory where **kinit** is located.

2. Issue a **kinit** command using a known user name and password as parameters. (Note that the password is visible in clear text when you type it on the command line.) For example, issue the following:

   ```bash
   kinit kchatterjee mypwd10#
   ```

   The first time you contact Active Directory you may receive an error that it cannot find the `krb5.ini` or `krb5.conf` file in the expected location. On Windows, the error looks similar to the following:

   ```plaintext
   krb_error 0 Could not load configuration file c:\winnt\krb5.ini (The system cannot find the file specified) No error.
   ```

   In this case, copy the `krb5.ini` or `krb5.conf` file to the expected location and then rerun the **kinit** command that is previously shown.

3. Depending on how the Active Directory server responds to the command, take one of the following actions:

   - If the Active Directory server indicates it has successfully created a Kerberos ticket, continue configuring Symantec Data Loss Prevention.
If you receive an error message, consult with your Active Directory administrator.

Configuring the Enforce Server for Active Directory authentication

Perform the procedure in this section when you first set up Active Directory authentication, and any time you want to modify existing Active Directory settings. Make sure that you have completed the prerequisite steps before you enable Active Directory authentication.

See “Integrating Active Directory for user authentication” on page 105.

To configure the Enforce Server to use Active Directory for authentication:

1. Make sure all users other than the Administrator are logged out of the system.
2. In the Enforce Server administration console, go to System > Settings > General and click Configure (at top left).
3. At the Edit General Settings screen that appears, locate the Active Directory Authentication section near the bottom and select (check) Perform Active Directory Authentication.

   The system then displays several fields to fill out.

4. In the Default Active Directory Domain field, enter the name of the default domain on your Active Directory system. This field is required. All Windows domain names must be uppercase (for example, TEST.LAB). If your setup includes a krb5.ini or krb5.conf file, the default Active Directory domain is the same as the value for default_realm in the krb5.ini or krb5.conf file.

5. In the Default Active Directory KDC field, type the IP address (or the hostname) of the Active Directory server. The KDC (Key Distribution Center) is an Active Directory service that runs on port 88 by default. If the KDC is running on a different port, specify the port using the following format:

   ipaddress_or_hostname:port_number.

   For example, if AD is running on the host Adserver.company.com and the KDC listens on port 53, type Adserver.company.com:53.

6. If you created a krb5.ini or krb5.conf file, enter the absolute path to the file in the krb5.ini File Path field. This file is required if your environment includes more than one domain, and recommended even if it does not. For example, type C:\winnit\krb5.ini (on Windows) or /opt/Vontu/Protect/config/krb5.conf (on Linux).

   See “Creating the configuration file for Active Directory integration” on page 106.
7 If your environment has more than one Active Directory domain, enter the domain names (separated by commas) in the **Active Directory Domain List** field. The system displays them in a drop-down list on the user logon page. Users then select the appropriate domain at logon. Do not list the default domain, as it already appears in the drop-down list by default.

8 Click **Save**.

9 Go to the operating system services tool and restart the Symantec Data Loss Prevention Manager service.

### About configuring certificate authentication

Certificate authentication enables a user to automatically log on to the Enforce Server administration console using a client certificate that is generated by your public key infrastructure (PKI). When a user accesses the Enforce Server administration console, the PKI automatically delivers the user’s certificate to the Tomcat container that hosts the administration console. The Tomcat container validates the client certificate using the certificate authorities that you have configured in the Tomcat trust store.

The client certificate is delivered to the Enforce Server computer when a client’s browser performs the SSL handshake with the Enforce Server. For example, some browsers might be configured to operate with a smart card reader to present the certificate. As an alternative, you may choose to upload the X.509 certificate to a browser and configure the browser to send the certificate to the Enforce Server.

If the certificate is valid, the Enforce Server administration console may also determine if the certificate was revoked.

See “**About certificate revocation checks**” on page 118.

If the certificate is valid and has not been revoked, then the Enforce Server uses the common name (CN) in the certificate to determine if that CN is mapped to an active user account with a role in the Enforce Server configuration.

---

**Note:** Some browsers cache a user’s client certificate, and will automatically log the user onto the Administration Console after the user has chosen to sign out. In this case, users must close the browser window to complete the log out process.

The following table describes the steps necessary to use certificate authentication with Symantec Data Loss Prevention.
<table>
<thead>
<tr>
<th>Phase</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| Phase 1  | Enable certificate authentication on the Enforce Server computer.      | You can enable certificate authentication when you install the Enforce Server, or you can reconfigure an existing Enforce Server to enable authentication.  
|          |                                                                        | See “Configuring certificate authentication for the Enforce Server administration console” on page 112.                                         |
| Phase 2  | Add certificate authority (CA) certificates to establish the trust chain.| You can add CA certificates to the Tomcat trust store when you install the Enforce Server. Or, you can use the Java keytool utility to manually add certificates to an existing Enforce Server.  
|          |                                                                        | See “Adding certificate authority (CA) certificates to the Tomcat trust store” on page 114.                                               |
| Phase 3  | (Optional) Change the Tomcat trust store password.                     | The Symantec Data Loss Prevention installer configures each new Enforce Server installation with a default Tomcat trust store password. Follow these instructions to configure a secure password.  
|          |                                                                        | See “Changing the Tomcat trust store password” on page 115.                                                                             |
| Phase 4  | Map certificate common name (CN) values to Enforce Server user accounts.|                                                                                                                                                   |
|          |                                                                        | See “Mapping Common Name (CN) values to Symantec Data Loss Prevention user accounts” on page 117.                                                |
| Phase 5  | Configure the Enforce Server to check for certificate revocation.      |                                                                                                                                                   |
|          |                                                                        | See “About certificate revocation checks” on page 118.                                                                                         |
| Phase 6  | Verify Enforce Server access using certificate-based single sign-on.    |                                                                                                                                                   |
|          |                                                                        | See “Troubleshooting certificate authentication” on page 124.                                                                                |
Configuring certificate authentication for the Enforce Server administration console

If you selected certificate authentication as the single sign-on option when you installed Symantec Data Loss Prevention, then the Enforce Server administration console is already configured to support certificate authentication.

Follow this procedure to manually enable certificate authentication on an upgraded Symantec Data Loss Prevention installation, or to disable or verify certificate authentication on the Enforce Server. Or, follow this procedure if you want to disable password authentication (and forms-based log on) for the Enforce Server.

**To configure certificate authentication for the Enforce Server administration console**

1. Log onto the Enforce Server computer using the account that you created during Symantec Data Loss Prevention installation.

   **Note:** If you log on with a different account (such as the root or Administrator account) ensure that you do not change the permissions or ownership on any Symantec Data Loss Prevention configuration file in the steps that follow.

2. Change directory to the `/opt/SymantecDLP/Protect/config` (Linux) or `c:\SymantecDLP\Protect\config` (Windows) directory. If you installed Symantec Data Loss Prevention into a different directory, substitute the correct path.

3. Open the `Manager.properties` file with a text editor.
4 To enable or verify certificate authentication, add or edit the following line in the file:

    com.vontu.manager.certificate_authentication = true

To disable certificate authentication, change the value to “false.” However, if you disable certificate authentication, also ensure that you have enabled password authentication to ensure that you can log into the Enforce Server administration console. To enable password authentication, add or edit the line:

    com.vontu.manager.form_authentication = true

Set this option to false (disable forms-based log on) only if you want to require a valid certificate for all Enforce Server administration console accounts, including Administrator accounts. Ensure that you have installed all necessary certificates and you have verified that users can log on using certificate authentication.

See “Adding certificate authority (CA) certificates to the Tomcat trust store” on page 114.

5 Save your changes and exit the text editor.

6 Change directory to the /opt/SymantecDLP/Protect/tomcat/conf (Linux) or c:\SymantecDLP\Protect\tomcat\conf (Windows) directory. If you installed Symantec Data Loss Prevention into a different directory, substitute the correct path.

7 Open the server.xml file with a text editor.

8 To enable or verify certificate authentication, add or edit the option clientAuth="want" as shown in the following line in the file:

    <Connector URIEncoding="UTF-8" acceptCount="100" clientAuth="want" debug="0" disableUploadTimeout="true" enableLookups="false" keystoreFile="conf/.keystore" keystorePass="protect" maxSpareThreads="75" maxThreads="150" minSpareThreads="25" port="443" scheme="https" secure="true" sslProtocol="TLS" truststoreFile="conf/truststore.jks" truststorePass="protect"/>

9 Save your changes and exit the text editor.

10 Stop and then restart the Vontu Manager service to apply your changes.

11 Configure and enable certificate revocation.

   See “About certificate revocation checks” on page 118.
Adding certificate authority (CA) certificates to the Tomcat trust store

This procedure is required only if you did not import CA certificates during the Symantec Data Loss Prevention installation, or if you upgraded an earlier Symantec Data Loss Prevention installation and you are configuring certificate authentication. This procedure is also required to add OCSP responder certificates to the truststore for some OCSP configurations.

To use certificate authentication with Symantec Data Loss Prevention, you must add to the Tomcat trust store all CA certificates that are required to authenticate users in your system. Each X.509 certificate must be provided in Distinguished Encoding Rules (DER) format in a .cer file. If multiple CAs are required to establish the certificate chain, then you must add multiple .cer files.

To add certificate CA certificates to the Tomcat trust store

1. Log onto the Enforce Server computer using the account that you created during Symantec Data Loss Prevention installation.

   **Note:** If you log on with a different account (such as the root or Administrator account) ensure that you do not change the permissions or ownership on any Tomcat configuration files in the steps that follow.

2. Change directory to the /opt/SymantecDLP/Protect/tomcat/conf (Linux) or c:\SymantecDLP\Protect\tomcat\conf (Windows) directory. If you installed Symantec Data Loss Prevention to a different directory, substitute the correct path.

3. Copy all certificate files (.cer files) that you want to import to the conf directory on the Enforce Server computer.
4 Use the `keytool` utility installed with Symantec Data Loss Prevention to add a certificate to the Tomcat truststore. For Windows systems, enter:

```
c:\SymantecDLP\jre\bin\keytool -import -trustcacerts
    -alias CA_CERT_1
    -file certificate_1.cer
    -keystore .\truststore.jks
```

For Linux systems, enter:

```
/opt/SymantecDLP/jre/bin/keytool -import -trustcacerts
    -alias CA_CERT_1
    -file certificate_1.cer
    -keystore ./truststore.jks
```

In the above commands, replace `CA_CERT_1` with a unique alias for the certificate that you are importing. Replace `certificate_1.cer` with the name of the certificate file you copied to the Enforce Server computer.

5 Enter the password to the keystore when the `keytool` utility prompts you to do so. If you did not change the default keystore password, then the password is “protect.”

6 Repeat these steps to install all the certificate files that are necessary to complete the certificate chain.

7 Stop and then restart the Vontu Manager service to apply your changes.

8 If you have not yet changed the default Tomcat keystore password, do so now. See “Changing the Tomcat trust store password” on page 115.

### Changing the Tomcat trust store password

When you install Symantec Data Loss Prevention, the Tomcat trust store uses the default password, “protect.” Follow this procedure to assign a secure password to the Tomcat trust store when using certificate authentication.
To change the Tomcat trust store password

1 Log onto the Enforce Server computer using the account that you created during Symantec Data Loss Prevention installation.

---

**Note:** If you log on with a different account (such as the root or Administrator account) ensure that you do not change the permissions or ownership on any Tomcat configuration files in the steps that follow.

---

2 Change directory to the `/opt/SymantecDLP/Protect/tomcat/conf` (Linux) or `c:\SymantecDLP\Protect\tomcat\conf` (Windows) directory. If you installed Symantec Data Loss Prevention to a different directory, substitute the correct path.

3 Use the `keytool` utility installed with Symantec Data Loss Prevention to change the Tomcat truststore password. For Windows systems, enter:

```
c:\SymantecDLP\jre\bin\keytool -storepasswd -new new_password -keystore ./truststore.jks
```

For Linux systems, enter:

```
/opt/SymantecDLP/jre/bin/keytool -storepasswd -new new_password -keystore .:/truststore.jks
```

In the above commands, replace `new_password` with a secure password.

4 Enter the current password to the keystore when the `keytool` utility prompts you to do so. If you did not change the default keystore password, then the password is “protect.”

5 Change directory to the `/opt/SymantecDLP/Protect/tomcat/conf` (Linux) or `c:\SymantecDLP\Protect\tomcat\conf` (Windows) directory. If you installed Symantec Data Loss Prevention into a different directory, substitute the correct path.

6 Open the `server.xml` file with a text editor.
In the following line in the file, edit the `truststorePass="protect"` entry to specify your new password:

```xml
<Connector URIEncoding="UTF-8" acceptCount="100" clientAuth="want" debug="0" disableUploadTimeout="true" enableLookups="false" keyStoreFile="conf/.keystore" keyStorePass="protect" maxSpareThreads="75" maxThreads="150" minSpareThreads="25" port="443" scheme="https" secure="true" ss1Protocol="TLS" trustStoreFile="conf/truststore.jks" truststorePass="protect"/>
```

Replace `protect` with the new password that you defined in the `keytool` command.

Save your changes and exit the text editor.

Change directory to the `/opt/SymantecDLP/Protect/config` (Linux) or `c:\SymantecDLP\Protect\config` (Windows) directory. If you installed Symantec Data Loss Prevention into a different directory, substitute the correct path.

Open the `Manager.properties` file with a text editor.

Add the following line in the file to specify the new password:

```properties
com.vontu.manager.tomcat.truststore.password = password
```

Replace `password` with the new password. Do not enclose the password with quotation marks.

Save your changes and exit the text editor.

Stop and then restart the Vontu Manager service to apply your changes.

Mapping Common Name (CN) values to Symantec Data Loss Prevention user accounts

Each user that will access the Enforce Server administration console using certificate-based single sign-on must have an active user account in the Enforce Server configuration. The user account associates the common name (CN) value from the user's client certificate to one or more roles in the Enforce Server administration console. You can map a CN value to only one Enforce Server user account.

The user account that you create does not require a separate Enforce Server administration console password. However, you can optionally configure a password if you want to allow the user to also log on from the Enforce Server administration console log on page. If you enable password authentication and the user does not provide a certificate when the browser asks for one, then the Enforce Server displays
the log on page. (If password authentication is disabled, a log on failure is displayed if the user does not provide a certificate.)

In order for a user to log on using single sign-on with certificate authentication, an active user account must identify the user's CN value, and it must be assigned a valid role in the Enforce Server configuration. If you want to prevent a user from accessing the Enforce Server administration console without revoking the user's client certificate, disable or delete the associated Enforce Server user account.

See “Configuring user accounts” on page 99.

About certificate revocation checks

While managing your public key infrastructure, you will periodically need to revoke a client's certificate with the CA. For example, you might revoke a certificate if an employee leaves the company, or if an employee's credentials are lost or stolen. When you revoke a certificate, the CA uses one or more Certificate Revocation Lists (CRLs) to publish those certificates that are no longer valid. Symantec Data Loss Prevention also supports the use of an Online Certificate Status Protocol (OCSP) responder, which clients can use to determine if a particular certificate has been revoked. The OCSP responder can be implemented as a service on your CA server, or as a separate OCSP server.

OCSP is the first mechanism that Symantec Data Loss Prevention uses to perform certificate revocation checks. After the Tomcat container has determined that a client certificate is valid, the Enforce Server sends an OCSP request to a designated OCSP responder to determine if the certificate was revoked. The information used to contact the OCSP responder can be provided in one of two ways:

- The Authority Information Access (AIA) field in a client certificate. The client certificate itself can include the URL of the OCSP responder in an AIA field. The following shows an example AIA field that defines an OCSP responder:

  Certificate Status Protocol (1.3.6.1.5.5.7.48.1)
  Alternative Name: URL=http://my_ocsp_responder

  This method is commonly used when you configure an internal CA to provide the OCSP responder service. If the OCSP responder specified in the AIA field is directly accessible from the Enforce Server computer, then no additional configuration is required to perform revocation checks. However, if the OCSP responder is accessible only by a proxy server, then you must configure the proxy server settings in the Symantec Data Loss Prevention configuration.

- The OCSP configuration file. As an alternative, you can manually configure OCSP responder properties using the manager-certauth.security configuration file. If you choose to use this file, the configuration in the file
overrides any information that is present in a client certificate's AIA field. This method is commonly used if you want to use a local OCSP responder instead of the one specified in the AIA field, or if your client certificates do not include an AIA field.

See “Manually configuring OCSP responder properties” on page 123.

Note: If the OCSP responder that you configure in this file does not use the CA certificate to sign its responses, then you must add the OCSP responder’s certificate to the Tomcat trust store.

See “Adding certificate authority (CA) certificates to the Tomcat trust store” on page 114.

If a certificate’s revocation status cannot be determined using OCSP, then Symantec Data Loss Prevention retrieves revocation lists from a Certificate Revocation List Distribution Point (CRLDP). To check revocation using a CRLDP, the client certificate must include a CRL distribution point field. The following shows an example CRLDP field definition:

```
[1]CRL Distribution Point
   Distribution Point Name:
       Full Name: URL=http://my_crldp
```

Note: Symantec Data Loss Prevention does not support specifying the CRLDP using an LDAP URL.

If the CRL distribution point is defined in each certificate and the Enforce Server can directly access the server, then no additional configuration is required to perform revocation checks. However, if the CRL distribution point is accessible only by a proxy server, then you must configure the proxy server settings in the Symantec Data Loss Prevention configuration.

See “Accessing the OCSP responder or CRLDP with a proxy” on page 121.

Regardless of which revocation checking method you use, you must enable certificate revocation checks on the Enforce Server computer. Certificate revocation checks are enabled by default if you select certificate installation during the Enforce Server installation. If you upgraded an existing Symantec Data Loss Prevention installation, certificate revocation is not enabled by default.

See “Configuring certificate revocation checks” on page 120.
If the Enforce Server computer must use a proxy to access either the OCSP responder service or CRLDP, then you must configure the proxy settings on the Enforce Server computer.

See “Accessing the OCSP responder or CRLDP with a proxy” on page 121.

If you are using OCSP for revocation checks but certificate client certificate AIA fields do not specify a valid OCSP responder, then you must manually configure OCSP responder properties in the manager-certauth.security configuration file.

See “Manually configuring OCSP responder properties” on page 123.

**Configuring certificate revocation checks**

When you enable certificate revocation checks, Symantec Data Loss Prevention uses OCSP to determine if each client certificate was revoked by a certificate authority. If the certificate status cannot be determined using OCSP, Symantec Data Loss Prevention uses a CRLDP to determine the revocation status.

Follow this procedure to enable certificate revocation checks.

**To configure certificate revocation checks**

1. Ensure that the OCSP responder is configured, either in the AIA field of each certificate or in the manager-certauth.security file.

   See “About certificate revocation checks” on page 118.

   See “Manually configuring OCSP responder properties” on page 123.

2. Ensure that the CRLDP is defined in the CRL distribution point field of each client certificate.

3. Log onto the Enforce Server computer using the account that you created during Symantec Data Loss Prevention installation.

   **Note:** If you log on with a different account (such as the root or Administrator account) ensure that you do not change the permissions or ownership on any Symantec Data Loss Prevention configuration file in the steps that follow.

4. Change directory to the /opt/SymantecDLP/Protect/config (Linux) or \SymantecDLP\Protect\config (Windows) directory. If you installed Symantec Data Loss Prevention into a different directory, substitute the correct path.

5. Open the VontuManager.conf file with a text editor.
6 To enable certificate revocation checks, add or edit the following line in the file:

```
wrapper.java.additional.18=-Dcom.sun.net.ssl.checkRevocation=true
```

To disable the checks, change the value to “false.”

7 If you want to configure the OCSP responder server manually, rather than using the AIA field in client certificates, edit the following line in the file:

```
wrapper.java.additional.19=-Djava.security.properties=../config/manager-certauth.security
```

Also enable this line in the file if you want to disable OCSP revocation checking. (You can then configure a property in `manager-certauth.security` to disable OCSP checks.)

Ensure that the configuration parameter points to the indicated OCSP configuration file. Always edit the existing `manager-certauth.security` file, rather than creating a new file.

See “Manually configuring OCSP responder properties” on page 123.

8 To enable revocation checking using a CRLDP, add or uncomment the following line in the file:

```
wrapper.java.additional.21=-Dcom.sun.security.enableCRLDP=true
```

This option is enabled by default for new Symantec Data Loss Prevention installations.

9 If you are using CRLDP revocation checks, optionally configure the cache lifetime using the property:

```
wrapper.java.additional.20=-Dsun.security.certpath.ldap.cache.lifetime=30
```

This parameter specifies the length of time, in seconds, to cache the revocation lists that are obtained from a CRL distribution point. After this time is reached, a lookup is performed to refresh the cache the next time there is an authentication request. 30 seconds is the default cache lifetime. Specify 0 to disable the cache, or -1 to store cache results indefinitely.

10 Stop and then restart the Vontu Manager service to apply your changes.

### Accessing the OCSP responder or CRLDP with a proxy

Symantec recommends that you allow direct access from the Enforce Server computer to all OCSP responder servers and CRLDP servers that are required to perform certificate revocation checks. However, if the OCSP responder or the CRLDP server are accessible only through a proxy, then you must configure the proxy settings on the Enforce Server computer.
When you configure a proxy, the Enforce Server uses your proxy configuration for all HTTP connections, such as those connections that are created when connecting to a Data Insight server to fetch certificates. Check with your proxy administrator before you configure these proxy settings, and consider allowing direct access to OCSP and CRDLP servers if at all possible.

To configure proxy settings for an OCSP responder or CRLDP server

1. Ensure that the OCSP responder is configured in the AIA field of each certificate.
   
   See “About certificate revocation checks” on page 118.

2. Ensure that the CRLDP is defined in the CRL distribution point field of each client certificate.

3. Log onto the Enforce Server computer using the account that you created during Symantec Data Loss Prevention installation.

   **Note:** If you log on with a different account (such as the root or Administrator account) ensure that you do not change the permissions or ownership on any Symantec Data Loss Prevention configuration file in the steps that follow.

4. Change directory to the `/opt/SymantecDLP/Protect/config` (Linux) or `c:\SymantecDLP\Protect\config` (Windows) directory. If you installed Symantec Data Loss Prevention into a different directory, substitute the correct path.

5. Open the `VontuManager.conf` file with a text editor.

6. Add or edit the following configuration properties to identify the proxy:

   ```
   wrapper.java.additional.22=-Dhttp.proxyHost=myproxy.mydomain.com
   wrapper.java.additional.23=-Dhttp.proxyPort=8080
   wrapper.java.additional.24=-Dhttp.nonProxyHosts=hosts
   ```

   Replace `myproxy.mydomain.com` and `8080` with the host name and port of your proxy server. Replace `hosts` with one or more accessible OCSP responder to use if the proxy is unavailable. You can include server host names, fully qualified domain names, or IP addresses separated with a pipe character. For example:

   ```
   wrapper.java.additional.24=-Dhttp.nonProxyHosts=ocsp-server|127.0.0.1|DataInsight_Server_Host
   ```
7. Save your changes to the configuration file.
8. Stop and then restart the Vontu Manager service to apply your changes.

Manually configuring OCSP responder properties

You can optionally edit the `manager-certauth.security` file to configure OCSP connection parameters for your system. By default, this file enables OCSP checks, but all other options are commented and inactive. If you uncomment any parameters in the file, those parameters override the OCSP configuration that is present in the AIA fields of a client certificate.

See “About certificate revocation checks” on page 118.

---

Note: If the OCSP responder that you configure in this file does not use the CA certificate to sign its responses, then you must add the OCSP responder’s certificate to the Tomcat trust store.

See “Adding certificate authority (CA) certificates to the Tomcat trust store” on page 114.

---

`manager-certauth.security` is located in the `/opt/SymantecDLP/Protect/config` (Linux) or `c:\SymantecDLP\Protect\config` (Windows) directory. Always edit the existing `manager-certauth.security` file, rather than create a new file. You may want to backup the file before making your changes to preserve the original contents. The `manager-certauth.security` contains additional information about these parameters.

The file contains the following parameters.

Table 5-4  OCSP configuration parameters

<table>
<thead>
<tr>
<th>Configuration parameter with example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>ocsp.enable=true</code></td>
<td>This parameter enables OCSP for revocation checks if certificate revocation is also enabled in the <code>VontuManager.properties</code> file. This parameter is enabled by default for all Symantec Data Loss Prevention installations. Disable the property if you want to use only CRLDP checks instead of OCSP.</td>
</tr>
<tr>
<td><code>ocsp.responderURL=http://ocsp.example.net:80</code></td>
<td>Defines the URL of OCSP responder. If you do not define this parameter, the URL is taken from the AIA field in the client certificate, if available.</td>
</tr>
</tbody>
</table>
### Table 5-4  OCSP configuration parameters (continued)

<table>
<thead>
<tr>
<th>Configuration parameter with example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ocsp.responderCertSubjectName=CN=OCSP Responder, O=XYZ Corp</td>
<td>Defines the subject name of the certificate that corresponds to the OCSP responder. By default Symantec Data Loss Prevention assumes that the certificate of the issuer of the client certificate corresponds to the OCSP responder's certificate. If you do not use this default configuration, you must identify the OCSP responder's certificate in some other way. You must also add the OCSP responder certificate to the Tomcat trust store. See “Adding certificate authority (CA) certificates to the Tomcat trust store” on page 114. If you cannot accurately identify the certificate of the OCSP responder using only the subject name, then use both the ocsp.responderCertIssuerName and ocsp.responderCertSerialNumber parameters instead of ocsp.responderCertSubjectName. (If you define ocsp.responderCertSubjectName, then the remaining two parameters in this table are ignored.)</td>
</tr>
<tr>
<td>ocsp.responderCertIssuerName=CN=Enterprise CA, O=XYZ Corp</td>
<td>Use this parameter in combination with ocsp.responderCertSerialNumber to identify the OCSP responder certificate. This parameter defines the certificate issuer of the OCSP responder's certificate. If you use this parameter, do not also use the ocsp.responderCertSubjectName parameter.</td>
</tr>
<tr>
<td>ocsp.responderCertSerialNumber=2A:FF:00</td>
<td>Use this parameter in combination with ocsp.responderCertIssuerName to identify the OCSP responder certificate. This parameter defines the serial number of the OCSP responder's certificate. If you use this parameter, do not also use the ocsp.responderCertSubjectName parameter.</td>
</tr>
</tbody>
</table>

### Troubleshooting certificate authentication

By default Symantec Data Loss Prevention logs each successful log on request to the Enforce Server administration console. Symantec Data Loss Prevention also logs an error message if a logon request is made without supplying a certificate, or if a valid certificate presents a CN that does not map to a valid user account in the Enforce Server configuration.
Note: If certificate authentication fails while the browser is establishing an HTTPS connection to the Enforce Server administration console, then Symantec Data Loss Prevention cannot log an error message.

You can optionally log additional information about certificate revocation checks by adding or uncommenting the following system property in the VontuManager.conf file:

```
wrapper.java.additional.90=-Djava.security.debug=certpath
```

VontuManager.conf is located in the `c:\SymantecDLP\Protect\config` (Windows) or `/opt/SymantecDLP/Protect/config` (Linux) directory. All debug messages are logged to `c:\SymantecDLP\Protect\logs\debug\VontuManager.log` (Windows) or `/var/log/SymantecDLP/debug/VontuManager.log` (Linux).

Disabling password authentication and forms-based log on

Forms-based log on with password authentication can be used as a fallback access mechanism while you configure and test certificate authentication. After you configure certificate authentication, you may choose to disable forms-based log on and password authentication to rely on your public key infrastructure for all log on requests. To disable forms-based log on entirely, add or edit the following value in the `Manager.properties` configuration file:

```
com.vontu.manager.form_authentication = false
```

See “Configuring certificate authentication for the Enforce Server administration console” on page 112.

You must stop and then restart the Vontu Manager service to apply your changes.

Note: Disabling forms-based log on disables the feature for all users, including those with Administrator privileges. As an alternative, you can disable forms-based log on or certificate authentication for an individual user by configuring that user's account.

See “Configuring user accounts” on page 99.

If you later turn on forms-based log on but the Administrator user account does not have a password configured, you can reset the Administrator password using the AdminPasswordReset utility.

See “Resetting the Administrator password” on page 103.
Connecting to group directories

This chapter includes the following topics:

- Creating connections to LDAP servers
- Configuring directory server connections
- Scheduling directory server indexing

Creating connections to LDAP servers

Symantec Data Loss Prevention supports directory server connections to LDAP-compliant directory servers such as Microsoft Active Directory (AD). A group directory connection specifies how the Enforce Server or Discover Server connects to the directory server.

The connection to the directory server must be established before you create any user groups in the Enforce Server. The Enforce Server or Discover Server uses the connection to obtain details about the groups. If this connection is not created, you are not able to define any User Groups. The connection is not permanent, but you can configure the connection to synchronize at a specified interval. The directory server contains all of the information that you need to create User Groups.

See “User Groups” on page 292.

Note: If you use a directory server that contains a self-signed authentication certificate, you must add the certificate to the Enforce Server or the Discover Server. If your directory server uses a pre-authorized certificate, it is automatically added to the Enforce Server or Discover Server. See “Importing SSL certificates to Enforce or Discover servers” on page 197.
To create a group directory connection

2. Click Add Connection.
3. Configure the directory connection.

See “Configuring directory server connections” on page 127.

## Configuring directory server connections

The Directory Connections page is the home page for configuring directory server connections. Once you define the directory connection, you can create one or more User Groups.

See “Configuring User Groups” on page 654.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Navigate to the Directory Connections page (if not already there).</td>
<td>This page is available at System &gt; Settings &gt; Directory Connections.</td>
</tr>
<tr>
<td>2</td>
<td>Click Create New Connection.</td>
<td>This action takes you to the Configure Directory Connection page.</td>
</tr>
<tr>
<td>3</td>
<td>Enter a Name for the directory server connection.</td>
<td>The Connection Name is the user-defined name for the connection. It appears at the Directory Connections home page once the connection is configured.</td>
</tr>
<tr>
<td>4</td>
<td>Specify the Network Parameters for the directory server connection.</td>
<td>Table 6-2 provides details on these parameters. Enter or specify the following parameters:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- The Hostname of the computer where the directory server is installed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- The Port on the directory server that supports connections.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- The Base DN (distinguished name) of the directory server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- The Encryption Method for the connection, either None or Secure.</td>
</tr>
<tr>
<td>5</td>
<td>Specify the Authentication mode for connecting to the directory server.</td>
<td>Table 6-3 provides details on configuring the authentication parameters.</td>
</tr>
<tr>
<td>6</td>
<td>Click Test Connection to verify the connection.</td>
<td>If there is anything wrong with the connection, the system displays an error message describing the problem.</td>
</tr>
</tbody>
</table>
Table 6-1  Configuring directory server connections (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>Click <strong>Save</strong> to save the direction connection configuration.</td>
<td>The system automatically indexes the directory server after you successfully create, test, and save the directory server connection.</td>
</tr>
<tr>
<td>8</td>
<td>Select the <strong>Index and Replication Status</strong> tab.</td>
<td>Verify that the directory server was indexed. After some time (depending on the size of the directory server query), you should see that the <strong>Replication Status</strong> is &quot;Completed &lt;date&gt; &lt;time&gt;&quot;. If you do not see that the status is completed, verify that you have configured and tested the directory connection properly. Contact your directory server administrator for assistance.</td>
</tr>
</tbody>
</table>
| 9    | Select the **Index Settings** tab. | You can adjust the directory server indexing schedule as necessary at the **Index Settings** tab.  
See "Scheduling directory server indexing" on page 129. |

Table 6-2  Directory connection network parameters

<table>
<thead>
<tr>
<th>Network parameters</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Hostname**       | Enter the **Hostname** of the directory server.  
**For example:** enforce.dlp.symantec.com  
You must enter the Fully Qualified Name (FQN) of the directory server. Do not use the IP address. |
| **Port**           | Enter the connection **Port** for the directory server.  
**For example:** 389  
Typically the port is 389 or 636 for secure connections. |
| **Base DN**        | Enter the **Base DN** for the directory server. This field only accepts one directory server entry.  
**For example:** dc=enforce,dc=dlp,dc=symantec,dc=com  
The **Base DN** string cannot contain any space characters.  
The **Base DN** is the base distinguished name of the directory server. Typically, this name is the domain name of the directory server. The **Base DN** parameter defines the initial depth of the directory server search. |
Table 6-2  Directory connection network parameters (continued)

<table>
<thead>
<tr>
<th>Network parameters</th>
<th>Description</th>
</tr>
</thead>
</table>
| Encryption Method  | Select the **Secure** option if you want the communication between the directory server and the Enforce Server to be encrypted using SSL.  
**Note:** If you choose to use a secure connection, you may need to import the SSL certificate for the directory server to the Enforce Server keystore. See “Importing SSL certificates to Enforce or Discover servers” on page 197. |

Table 6-3  Directory connection authentication parameters

<table>
<thead>
<tr>
<th>Authentication</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authentication</td>
<td>Select the <strong>Authentication</strong> option to connect to the directory server using authentication mode. Check <strong>Connect with Credentials</strong> to add your username and password to authenticate to the directory server.</td>
</tr>
</tbody>
</table>
| Username         | To authenticate with Active Directory, use one of the following methods:  

- Domain and user name, for example: `Domain\username`  
- User name and domain, for example: `username@domain.com`  
- Fully distinguished user name and domain (without spaces), for example: `cn=username,cn=Users,dc=domain,dc=com`  

To authenticate with another type of directory server:  

- A different syntax may be required, for example:  
  `uid=username,ou=people,o=company` |
| Password          | Enter the password for the user name that was specified in the preceding field.  
The password is obfuscated when you enter it. |

### Scheduling directory server indexing

Each directory connection is set to automatically index the configured LDAP server **once** at 12:00 AM the day after you create the initial connection. You can modify the indexing schedule to specify when and how often the index is synchronized.

Each directory server connection is set to automatically index the configured User Groups hosted in the directory server **once** at 12:00 AM the day after you create the initial connection.

After you create, test, and save the directory server connection, the system automatically indexes all of the User Groups that are hosted in the directory whose connection you have established. You can modify this setting, and schedule indexing daily, weekly, or monthly.
To schedule group directory indexing

1. Select an existing group directory server connection from the **System > Settings > Directory Connections** screen. Or, create a new connection.

   See “Configuring directory server connections” on page 127.

2. Adjust the Index Settings to the desired schedule.

   See Table 6-4 on page 130.

<table>
<thead>
<tr>
<th>Index Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index the directory server once.</td>
<td>The <strong>Once</strong> setting is selected by default and automatically indexes the director server at 12:00 AM the day after you create the initial connection.</td>
</tr>
<tr>
<td></td>
<td>You can modify the default <strong>Once</strong> indexing schedule by specifying when and how often the index is supposed to be rebuilt.</td>
</tr>
<tr>
<td>Index the directory server daily.</td>
<td>Select the <strong>Daily</strong> option to schedule the index daily. Specify the <strong>time of day</strong> and, optionally, the <strong>Until</strong> duration for this schedule.</td>
</tr>
<tr>
<td>Index the directory server weekly.</td>
<td>Select the <strong>Weekly</strong> option to schedule the index to occur once a week. Specify the <strong>day of the week</strong> to index. Specify the <strong>time</strong> to index. Optionally, specify the <strong>Until</strong> duration for this schedule.</td>
</tr>
<tr>
<td>Index the directory server monthly.</td>
<td>Specify the <strong>day of the month</strong> to index the directory and the <strong>time</strong>. Optionally, specify the <strong>Until</strong> duration for this schedule.</td>
</tr>
<tr>
<td>View the indexing and replication status.</td>
<td>Select the <strong>Index and Replication Status</strong> tab to view the status of the indexing process.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Indexing Status</strong> Displays the next scheduled index, date and time.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Detection Server Name</strong> Displays the detection server where the User Group profile is deployed.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Replication Status</strong> Displays the data and time of the most recent synchronization with the directory group server.</td>
</tr>
</tbody>
</table>
Managing stored credentials

This chapter includes the following topics:

- About the credential store
- Adding new credentials to the credential store
- Configuring endpoint credentials
- Managing credentials in the credential store

About the credential store

An authentication credential can be stored as a named credential in a central credential store. It can be defined once, and then referenced by any number of Discover targets. Passwords are encrypted before they are stored.

The credential store simplifies management of user name and password changes. You can add, delete, or edit stored credentials.

See “Adding new credentials to the credential store” on page 132.

See “Managing credentials in the credential store” on page 133.

The Credential Management screen is accessible to users with the "Credential Management" privilege.

Stored credentials can be used when you edit or create a Discover target.

See “Network Discover scan target configuration options” on page 1191.
Adding new credentials to the credential store

You can add new credentials to the credential store. These credentials can later be referenced with the credential name.

To add a stored credential

1. Click **System > Settings > Credentials**, and click **Add Credential**.
2. Enter the following information:
   - **Credential Name**: Enter your name for this stored credential. The credential name must be unique within the credential store. The name is used only to identify the credential.
   - **Access Username**: Enter the user name for authentication.
   - **Access Password**: Enter the password for authentication.
   - **Re-enter Access Password**: Re-enter the password.
3. Click **Save**.
4. You can later edit or delete credentials from the credential store.

See “Managing credentials in the credential store” on page 133.

See “Configuring endpoint credentials” on page 132.

Configuring endpoint credentials

You must add credentials to the Credential Store before you can access credentials for Endpoint FlexResponse or the Endpoint Discover Quarantine response rule. The credentials are stored in an encrypted folder on all endpoints that are connected to an Endpoint Server. Because all endpoints store the credentials, you must be careful about the type of credentials you store. Use credentials that cannot access other areas of your system. Before your endpoint credentials can be used, you must enable the Enforce Server to recognize them.

To create endpoint credentials

1. Go to: **System > Settings > General**.
2. Click **Configure**.
3. Under the **Credential Management** section, ensure that the **Allow Saved Credentials on Endpoint Agent** checkbox is selected.
Managing credentials in the credential store

You can delete or edit a stored credential.

To delete a stored credential

1. Click **System > Settings > Credentials**. Locate the name of the stored credential that you want to remove.
2. Click the delete icon to the right of the name. A credential can be deleted only if it is not currently referenced in a Discover target or indexed document profile.

To edit a stored credential

1. Click **System > Settings > Credentials**. Locate the name of the stored credential that you want to edit.
2. Click the edit icon (pencil) to the right of the name.
3. Update the user name or password.
4. Click **Save**.
5. If you change the password for a given credential, the new password is used for all subsequent Discover scans that use that credential.
Managing system events and messages

This chapter includes the following topics:

- About system events
- System events reports
- Working with saved system reports
- Server event detail
- Configuring event thresholds and triggers
- About system event responses
- Enabling a syslog server
- About system alerts
- Configuring the Enforce Server to send email alerts
- Configuring system alerts
- About log review
- System event codes and messages

About system events

System events related to your Symantec Data Loss Prevention installation are monitored, reported, and logged.

System event reports are viewed from the Enforce Server administration console:
The five most recent system events of severity Warning or Severe are listed on the Servers Overview screen (System > Servers > Overview). See “About the System Overview screen” on page 198.

Reports on all system events of any severity can be viewed by going to System > Servers > Events. See “System events reports” on page 135.

Recent system events for a particular detection server are listed on the Server Detail screen for that server. See “Server Detail screen” on page 201.

Click on any event in an event list to go to the Event Details screen for that event. The Event Details screen provides additional information about the event. See “Server event detail” on page 139.

There are three ways that system events can be brought to your attention:

- System event reports displayed on the administration console
- System alert email messages
  See “About system alerts” on page 146.
- Syslog functionality
  See “Enabling a syslog server” on page 144.

Some system events require a response. See “About system event responses” on page 142.

To narrow the focus of system event management you can:

- Use the filters in the various system event notification methods. See “System events reports” on page 135.
- Configure the system event thresholds for individual servers. See “Configuring event thresholds and triggers” on page 140.

**System events reports**

To view all system events, go to the system events report screen (System > Servers > Events). This screen lists events, one event per line. The list contains those events that match the selected data range, and any other filter options that are listed in the Applied Filters bar. For each event, the following information is displayed:
Table 8-1

<table>
<thead>
<tr>
<th>Events</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The type (severity) of the event. Type may be any one of those listed in Table 8-2.</td>
</tr>
<tr>
<td>Time</td>
<td>The date and time of the event.</td>
</tr>
<tr>
<td>Server</td>
<td>The name of the server on which the event occurred.</td>
</tr>
<tr>
<td>Host</td>
<td>The IP address or host name of the server on which the event occurred.</td>
</tr>
<tr>
<td>Code</td>
<td>A number that identifies the kind of event. See the Symantec Data Loss Prevention Administration Guide for information on event code numbers.</td>
</tr>
<tr>
<td>Summary</td>
<td>A brief description of the event. Click on the summary for more detail about the event.</td>
</tr>
</tbody>
</table>

Table 8-2

<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="System information" /></td>
<td>System information</td>
</tr>
<tr>
<td><img src="image" alt="Warning" /></td>
<td>Warning</td>
</tr>
<tr>
<td><img src="image" alt="Severe" /></td>
<td>Severe</td>
</tr>
</tbody>
</table>

You can select from several report handling options. See “Common incident report features” on page 1039.

Click any event in the list to go to the Event Details screen for that event. The Event Details screen provides additional information about the event. See “Server event detail” on page 139.

Since the list of events can be long, filters are available to help you select only the events that you are interested in. By default, only the Date filter is enabled and it is initially set to All Dates. The Date filter selects events by the dates the events occurred.

To filter the list of system events by date of occurrence

1. Go to the Filter section of the events report screen and select one of the date range options.
2. Click Apply.
3. Select Custom from the date list to specify beginning and end dates.
In addition to filtering by date range, you can also apply advanced filters. Advanced filters are cumulative with the current date filter. This means that events are only listed if they match the advanced filter and also fall within the current date range. Multiple advanced filters can be applied. If multiple filters are applied, events are only listed if they match all the filters and the date range.

To apply additional advanced filters

1. Click on **Advanced Filters and Summarization**.
2. Click on **Add Filter**.
3. Choose the filter you want to use from the left-most drop-down list. Available filters are listed in Table 8-3.
4. Choose the filter-operator from the middle drop-down list.
   For each advanced filter you can specify a filter-operator **Is Any Of** or **Is None Of**.
5. Enter the filter value, or values, in the right-hand text box, or click a value in the list to select it.
   - To select multiple values from a list, hold down the Control key and click each one.
   - To select a range of values from a list, click the first one, then hold down the Shift key and click the last value in the range you want.
6. (Optional) Specify additional advanced filters if needed.
7. When you have finished specifying a filter or set of filters, click **Apply**.
   Click the red X to delete an advanced filter.

The **Applied Filters** bar lists the filters that are used to produce the list of events that is displayed. Note that multiple filters are cumulative. For an event to appear on the list it must pass all the applied filters.

The following advanced filters are available:

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Code</td>
<td>Filter events by the code numbers that identify each kind of event. You can filter by a single code number or multiple code numbers separated by commas (2121, 1202, 1204). Filtering by code number ranges, or greater than, or less than operators is not supported.</td>
</tr>
</tbody>
</table>
Table 8-3  System events advanced filter options (continued)

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event type</td>
<td>Filter events by event severity type (Info, Warning, or Severe).</td>
</tr>
<tr>
<td>Server</td>
<td>Filter events by the server on which the event occurred.</td>
</tr>
</tbody>
</table>

**Note:** A small subset of the parameters that trigger system events have thresholds that can be configured. These parameters should only be adjusted with advice from Symantec Support. Before changing these settings, you should have a thorough understanding of the implications that are involved. The default values are appropriate for most installations.

See “Configuring event thresholds and triggers” on page 140.

See “About system events” on page 134.
See “Server event detail” on page 139.
See “Working with saved system reports” on page 138.
See “Configuring event thresholds and triggers” on page 140.
See “About system alerts” on page 146.

## Working with saved system reports

The **System Reports** screen lists system and agent-related reports that have previously been saved. To display the **System Reports** screen, click **System > System Reports**. Use this screen to work with saved system reports.

**To create a saved system report**

1. Go to one of the following screens:
   - System Events (**System > Events**)
   - Agents Overview (**System > Agents > Overview**)
   - Agents Events (**System > Agents > Events**)

   See “About the Enforce Server administration console” on page 56.

2. Select the filters and summaries for your custom report.

   See “About custom reports and dashboards” on page 1019.

3. Select **Report > Save As**.
4 Enter the saved report information.

See “Saving custom incident reports” on page 1022.

5 Click Save.

The System Reports screen is divided into two sections:

- **System Event - Saved Reports** lists saved system reports.
- **Agent Management - Saved Reports** lists saved agent reports.

For each saved report you can perform the following operations:

- Share the report. Click share to allow other Symantec Data Loss Prevention uses who have the same role as you to share the report. Sharing a report cannot be undone; after a report is shared it cannot be made private. After a report is shared, all users with whom it is shared can view, edit, or delete the report.
  See “Saving custom incident reports” on page 1022.

- Change the report name or description. Click the pencil icon to the right of the report name to edit it.

- Change the report scheduling. Click the calendar icon to the right of the report name to edit the delivery schedule of the report and to whom it is sent.
  See “Saving custom incident reports” on page 1022.
  See “Delivery schedule options for incident and system reports” on page 1025.

- Delete the report. Click the red X to the right of the report name to delete the report.

**Server event detail**

The Server Event Detail screen is reached by System > Servers > Events and then clicking on one of the listed events.

See “System events reports” on page 135.

The Server Event Detail screen displays all of the information available for the selected event. None of the information on this screen is editable.

The Server Event Detail screen is divided into two sections—General and Message.
### Table 8-4 Event detail — General

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The event is one of the following types:</td>
</tr>
<tr>
<td></td>
<td>■ Info: Information about the system.</td>
</tr>
<tr>
<td></td>
<td>■ Warning: A problem that is not severe enough to generate an error.</td>
</tr>
<tr>
<td></td>
<td>■ Severe: An error that requires immediate attention.</td>
</tr>
<tr>
<td>Time</td>
<td>The date and time of the event.</td>
</tr>
<tr>
<td>Server</td>
<td>The name of the server.</td>
</tr>
<tr>
<td>Host</td>
<td>The host name or IP address of the server.</td>
</tr>
</tbody>
</table>

### Table 8-5 Event detail — Message

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>A number that identifies the kind of event.</td>
</tr>
<tr>
<td></td>
<td>See “System event codes and messages” on page 150.</td>
</tr>
<tr>
<td>Summary</td>
<td>A brief description of the event.</td>
</tr>
<tr>
<td>Detail</td>
<td>Detailed information about the event.</td>
</tr>
</tbody>
</table>

See “About system events” on page 134.

See “Server event detail” on page 139.

See “System events reports” on page 135.

See “About system alerts” on page 146.

### Configuring event thresholds and triggers

A small subset of the parameters that trigger system events have thresholds that can be configured. These parameters are configured for each detection server separately. These parameters should only be adjusted with advice from Symantec Support. Before changing these settings, you should have a thorough understanding of the implications. The default values are appropriate for most installations.

See “About system events” on page 134.
To view and change the configurable parameters that trigger system events

1. Go to the Server Overview screen (System > Servers > Overview).
2. Click on the name of a detection server to display that server's Server Detail screen.
3. Click the Server Settings tab.
   The Advanced Server Settings screen for that server is displayed.
4. Change the configurable parameters, as needed.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>BoxMonitor.DiskUsageError</td>
<td>Indicates the amount of filled disk space (as a percentage) that triggers a severe system event. For example, a Severe event occurs if a detection server is installed on the C drive and the disk space error value is 90. The detection server creates a Severe system event when the C drive usage is 90% or greater. The default is 90.</td>
<td>Low disk space</td>
</tr>
<tr>
<td>BoxMonitor.DiskUsageWarning</td>
<td>Indicates the amount of filled disk space (as a percentage) that triggers a Warning system event. For example, a Warning event occurs if the detection server is installed on the C drive and the disk space warning value is 80. Then the detection server generates a Warning system event when the C drive usage is 80% or greater. The default is 80.</td>
<td>Low disk space</td>
</tr>
<tr>
<td>BoxMonitor.MaxRestartCount</td>
<td>Indicates the number of times that a system process can be restarted in one hour before a Severe system event is generated. The default is 3.</td>
<td>process name restarts excessively</td>
</tr>
<tr>
<td>IncidentDetection.MessageWaitSevere</td>
<td>Indicates the number of minutes messages need to wait to be processed before a Severe system event is sent about message wait times. The default is 240.</td>
<td>Long message wait time</td>
</tr>
</tbody>
</table>
### Table 8-6 Configurable parameters that trigger events (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>IncidentDetection.MessageWaitWarning</td>
<td>Indicates the number of minutes messages need to wait to be processed before sending a Severe system event about message wait times. The default is 60.</td>
<td>Long message wait time</td>
</tr>
<tr>
<td>IncidentWriter.BacklogInfo</td>
<td>Indicates the number of incidents that can be queued before an Info system event is generated. This type of backlog usually indicates that incidents are not processed or are not processed correctly because the system may have slowed down or stopped. The default is 1000.</td>
<td>N incidents in queue</td>
</tr>
<tr>
<td>IncidentWriter.BacklogWarning</td>
<td>Indicates the number of incidents that can be queued before generating a Warning system event. This type of backlog usually indicates that incidents are not processed or are not processed correctly because the system may have slowed down or stopped. The default is 3000.</td>
<td>N incidents in queue</td>
</tr>
<tr>
<td>IncidentWriter.BacklogSevere</td>
<td>Indicates the number of incidents that can be queued before a Severe system event is generated. This type of backlog usually indicates that incidents are not processed or are not processed correctly because the system may have slowed down or stopped. The default is 10000.</td>
<td>N incidents in queue</td>
</tr>
</tbody>
</table>

### About system event responses

There are three ways that system events can be brought to your attention:

- System event reports displayed on the administration console
- System alert email messages
  
  See "About system alerts" on page 146.
- Syslog functionality
  
  See "Enabling a syslog server" on page 144.
In most cases, the system event summary and detail information should provide enough information to direct investigation and remediation steps. The following table provides some general guidelines for responding to system events.

**Table 8-7  System event responses**

<table>
<thead>
<tr>
<th>System Event or Category</th>
<th>Appropriate Response</th>
</tr>
</thead>
</table>
| Low disk space           | If this event is reported on a detection server, recycle the Symantec Data Loss Prevention services on the detection server. The detection server may have lost its connection to the Enforce Server. The detection server then queues its incidents locally, and fills up the disk.  
If this event is reported on an Enforce Server, check the status of the Oracle and the Vontu Incident Persister services. Low disk space may result if incidents do not transfer properly from the file system to the database. This event may also indicate a need to add additional disk space. |
| Tablespace is almost full| Add additional data files to the database. When the hard disk is at 80% of capacity, obtain a bigger disk instead of adding additional data files.  
Refer to the Symantec Data Loss Prevention Installation Guide. |
| Licensing and versioning | Contact Symantec Support. |
| Monitor not responding   | Restart the Symantec Monitor service. If the event persists, check the network connections. Make sure the computer that hosts the detections server is turned on by connecting to it. You can connect with terminal services or another remote desktop connection method. If necessary, contact Symantec Support.  
See “About Data Lost Prevention services” on page 76. |
| Alert or scheduled report sending failed | Go to System > Settings > General and ensure that the settings in the Reports and Alerts and SMTP sections are configured correctly. Check network connectivity between the Enforce Server and the SMTP server. Contact Symantec Support. |
| Auto key ignition failed | Contact Symantec Support. |
Table 8-7  System event responses (continued)

<table>
<thead>
<tr>
<th>System Event or Category</th>
<th>Appropriate Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cryptographic keys are inconsistent</td>
<td>Contact Symantec Support.</td>
</tr>
<tr>
<td>Long message wait time</td>
<td>Increase detection server capacity by adding more CPUs or replacing the computer with a more powerful one. Decrease the load on the detection server. You can decrease the load by applying the traffic filters that have been configured to detect fewer incidents. You can also re-route portions of the traffic to other detection servers. Increase the threshold wait times if all of the following items are true:</td>
</tr>
<tr>
<td>■ This message is issued during peak hours.</td>
<td></td>
</tr>
<tr>
<td>■ The message wait time drops down to zero before the next peak.</td>
<td></td>
</tr>
<tr>
<td>■ The business is willing to have such delays in message processing.</td>
<td></td>
</tr>
<tr>
<td>process_name restarts excessively</td>
<td>Check the process by going to System &gt; Servers &gt; Overview. To see individual processes on this screen, Process Control must be enabled by going to System &gt; Settings &gt; General &gt; Configure.</td>
</tr>
<tr>
<td>N incidents in queue</td>
<td>Investigate the reason for the incidents filling up the queue. The most likely reasons are as follows:</td>
</tr>
<tr>
<td>■ Connection problems. Response: Make sure the communication link between the Endpoint Server and the detection server is stable.</td>
<td></td>
</tr>
<tr>
<td>■ Insufficient connection bandwidth for the number of generated incidents (typical for WAN connections). Response: Consider changing policies (by configuring the filters) so that they generate fewer incidents.</td>
<td></td>
</tr>
</tbody>
</table>

Enabling a syslog server

Syslog functionality sends Severe system events to a syslog server. Syslog servers allow system administrators to filter and route the system event notifications on a more granular level. System administrators who use syslog regularly for monitoring
their systems may prefer to use syslog instead of alerts. Syslog may be preferred if the volume of alerts seems unwieldy for email.

Syslog functionality is an on or off option. If syslog is turned on, all Severe events are sent to the syslog server.

To enable syslog functionality

1. Go to the \SymantecDLP\Protect\config directory on Windows or the /opt/SymantecDLP/Protect/config directory on Linux.
2. Open the Manager.properties file.
3. Uncomment the #systemevent.syslog.host= line by removing the # symbol from the beginning of the line, and enter the hostname or IP address of the syslog server.
4. Uncomment the #systemevent.syslog.port= line by removing the # symbol from the beginning of the line. Enter the port number that should accept connections from the Enforce Server server. The default is 514.
5. Uncomment the #systemevent.syslog.format= line by removing the # symbol from the beginning of the line. Then define the system event message format to be sent to the syslog server:
   
   If the line is uncommented without any changes, the notification messages are sent in the format: [server name] summary - details. The format variables are:
   
   - {0} - the name of the server on which the event occurred
   - {1} - the event summary
   - {2} - the event detail

   For example, the following configuration specifies that Severe system event notifications are sent to a syslog host named server1 which uses port 600.

   systemevent.syslog.host=server1
   systemevent.syslog.port=600
   systemevent.syslog.format= [{0}] {1} - {2}

   Using this example, a low disk space event notification from an Enforce Server on a host named dlp-1 would look like:

   dlp-1 Low disk space - Hard disk space for incident data storage server is low. Disk usage is over 82%.

   See “About system events” on page 134.
About system alerts

System alerts are email messages that are sent to designated addresses when a particular system event occurs. You define what alerts (if any) that you want to use for your installation. Alerts are specified and edited on the Configure Alert screen, which is reached by System > Servers > Alerts > Add Alert.

Alerts can be specified based on event severity, server name, or event code, or a combination of those factors. Alerts can be sent for any system event.

The email that is generated by the alert has a subject line that begins with Symantec Data Loss Prevention System Alert followed by a short event summary. The body of the email contains the same information that is displayed by the Event Detail screen to provide complete information about the event.

See “Configuring the Enforce Server to send email alerts” on page 146.

See “Configuring system alerts” on page 147.

See “Server event detail” on page 139.

Configuring the Enforce Server to send email alerts

To send out email alerts regarding specified system events, the Enforce Server has to be configured to support sending of alerts and reports. This section describes how to specify the report format and how to configure Symantec Data Loss Prevention to communicate with an SMTP server.

After completing the configuration described here, you can schedule the sending of specific reports and create specific system alerts.

To configure Symantec Data Loss Prevention to send alerts and reports

1. Go to System > Settings > General and click Configure.
   The Edit General Settings screen is displayed.
2. In the Reports and Alerts section, select one of the following distribution methods:
   
   - Send reports as links, logon is required to view. Symantec Data Loss Prevention sends email messages with links to reports. You must log on to the Enforce Server to view the reports.

     Note: Reports with incident data cannot be distributed if this option is set.

   - Send report data with emails. Symantec Data Loss Prevention sends email messages and attaches the report data.
3 Enter the Enforce Server domain name or IP address in the **Fully Qualified Manager Name** field.

If you send reports as links, Symantec Data Loss Prevention uses the domain name as the basis of the URL in the report email.

Do not specify a port number unless you have modified the Enforce Server to run on a port other than the default of 443.

4 If you want alert recipients to see any correlated incidents, check the **Correlations Enabled** box.

When correlations are enabled, users see them on the **Incident Snapshot** screen.

5 In the **SMTP** section, identify the SMTP server to use for sending out alerts and reports.

Enter the relevant information in the following fields:

- **Server**: The fully qualified hostname or IP address of the SMTP server that Symantec Data Loss Prevention uses to deliver system events and scheduled reports.
- **System email**: The email address for the alert sender. Symantec Data Loss Prevention specifies this email address as the sender of all outgoing email messages. Your IT department may require the system email to be a valid email address on your SMTP server.
- **User ID**: If your SMTP server requires it, type a valid user name for accessing the server. For example, enter `DOMAIN\bsmith`.
- **Password**: If your SMTP server requires it, enter the password for the User ID.

6 Click **Save**.

See “About system alerts” on page 146.

See “Configuring system alerts” on page 147.

See “About system events” on page 134.

---

### Configuring system alerts

You can configure Symantec Data Loss Prevention to send an email alert whenever it detects a specified system event. Alerts can be specified based on event severity, server name, or event code, or a combination of those factors. Alerts can be sent for any system event.

See “About system alerts” on page 146.
Note that the Enforce Server must first be configured to send alerts and reports.

See “Configuring the Enforce Server to send email alerts” on page 146.

Alerts are specified and edited on the Configure Alert screen, which is reached by System > Servers > Alerts and then choosing Add Alert to create a new alert, or clicking on the name of an existing alert to modify it.

To create or modify an alert

1. Go the Alerts screen (System > Servers > Alerts).
2. Click the Add Alert tab to create a new alert, or click on the name of an alert to modify it.
   The Configure Alert screen is displayed.
3. Fill in (or modify) the name of the alert. The alert name is displayed in the subject line of the email alert message.
4. Fill in (or modify) a description of the alert.
5. Click Add Condition to specify a condition that will trigger the alert.
   Each time you click Add Condition you can add another condition. If you specify multiple conditions, every one of the conditions must be met to trigger the alert.
   Click on the red X next to a condition to remove it from an existing alert.
6. Enter the email address that the alert is to be sent to. Separate multiple addresses by commas.
7. Limit the maximum number of times this alert can be sent in one hour by entering a number in the Max Per Hour box.
   If no number is entered in this box, there is no limit on the number of times this alert can be sent out. The recommended practice is to limit alerts to one or two per hour, and to substitute a larger number later if necessary. If you specify a large number, or no number at all, recipient mailboxes may be overloaded with continual alerts.
8. Click Save to finish.
   The Alerts list is displayed.

There are three kinds of conditions that you can specify to trigger an alert:

- Event type - the severity of the event.
- Server - the server associated with the event.
- Event code - a code number that identifies a particular kind of event.

For each kind of condition, you can choose one of two operators:
For each kind of condition, you can specify appropriate parameters:

- Event type. You can select one, or a combination of, Information, Warning, Severe. Click on an event type to specify it. To specify multiple types, hold down the Control key while clicking on event types. You can specify one, two, or all three types.

- Server. You can select one or more servers from the list of available servers. Click on the name of server to specify it. To specify multiple servers, hold down the Control key while clicking on server names. You can specify as many different servers as necessary.

- Event code. Enter the code number. To enter multiple code numbers, separate them with commas or use the Return key to enter each code on a separate line. See “System event codes and messages” on page 150.

By combining multiple conditions, you can define alerts that cover a wide variety of system conditions.

**Note:** If you define more than one condition, the conditions are treated as if they were connected by the Boolean "AND" operator. This means that the Enforce Server only sends the alert if all conditions are met. For example, if you define an event type condition and a server condition, the Enforce Server only sends the alert if the specified event occurs on the designated server.

See “About system alerts” on page 146.

See “Configuring the Enforce Server to send email alerts” on page 146.

See “System events reports” on page 135.

---

**About log review**

Your Symantec Data Loss Prevention installation includes a number of log files. These files provide information on server communication, Enforce Server and detection server operation, incident detection, and so on.

By default, logs for the Enforce Server and detection server are stored in the following directories:

- **Windows:** SymantecDLP\Protect\logs
- **Linux:** /var/log/SymantecDLP

See “About log files” on page 243.
See also the *Symantec Data Loss Prevention System Maintenance Guide* for additional information about working with logs.

## System event codes and messages

Symantec Data Loss Prevention system events are monitored, reported, and logged. Each event is identified by code number listed in the tables.

See “About system events” on page 134.

System event lists and reports can be filtered by event codes.

See “System events reports” on page 135.

### Table 8-8 General detection server events

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000</td>
<td>Monitor started</td>
<td>All monitor processes have been started.</td>
</tr>
<tr>
<td>1001</td>
<td>Local monitor started</td>
<td>All monitor processes have been started.</td>
</tr>
<tr>
<td>1002</td>
<td>Monitor started</td>
<td>Some monitor processes are disabled and haven't been started.</td>
</tr>
<tr>
<td>1003</td>
<td>Local monitor started</td>
<td>Some monitor processes are disabled and haven't been started.</td>
</tr>
<tr>
<td>1004</td>
<td>Monitor stopped</td>
<td>All monitor processes have been stopped.</td>
</tr>
<tr>
<td>1005</td>
<td>Local monitor stopped</td>
<td>All monitor processes have been stopped.</td>
</tr>
<tr>
<td>1006</td>
<td>{0} failed to start</td>
<td>Process {0} can't be started. See log files for more detail.</td>
</tr>
<tr>
<td>1007</td>
<td>{0} restarts excessively</td>
<td>Process {0} has restarted {1} times during last {2} minutes.</td>
</tr>
<tr>
<td>1008</td>
<td>{0} is down</td>
<td>{0} process went down before it had fully started.</td>
</tr>
<tr>
<td>1010</td>
<td>Restarted {0}</td>
<td>{0} process was restarted because it went down unexpectedly.</td>
</tr>
<tr>
<td>1011</td>
<td>Restarted {0}</td>
<td>{0} was restarted because it was not responding.</td>
</tr>
<tr>
<td>1012</td>
<td>Unable to start {0}</td>
<td>Cannot bind to the shutdown datagram socket. Will retry.</td>
</tr>
<tr>
<td>1013</td>
<td>{0} resumed starting</td>
<td>Successfully bound to the shutdown socket.</td>
</tr>
</tbody>
</table>
### Table 8-8  General detection server events (continued)

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1014 | Low disk space       | Hard disk space is low. Symantec Data Loss Prevention server disk usage is over \(0\)%.

### Table 8-9  Endpoint server events

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1100</td>
<td>Aggregator started</td>
<td>None</td>
</tr>
<tr>
<td>1101</td>
<td>Aggregator failed to start</td>
<td>Error starting Aggregator. (0) No incidents will be detected.</td>
</tr>
<tr>
<td>1102</td>
<td>Communications with non-legacy agents are disabled</td>
<td>SSL keystore and truststore are not configured for this endpoint server. Please go to configure server page to configure SSL keystore and truststore.</td>
</tr>
</tbody>
</table>

### Table 8-10  Detection configuration events

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1200</td>
<td>Loaded policy</td>
<td>&quot;(0)&quot; Policy &quot;(0)&quot; v{1} ((2)) has been successfully loaded.</td>
</tr>
<tr>
<td>1201</td>
<td>Loaded policies (0)</td>
<td>None</td>
</tr>
<tr>
<td>1202</td>
<td>No policies loaded</td>
<td>No relevant policies are found. No incidents will be detected.</td>
</tr>
<tr>
<td>1203</td>
<td>Unloaded policy &quot;(0)&quot; Policy &quot;(0)&quot; has been unloaded.</td>
<td></td>
</tr>
<tr>
<td>1204</td>
<td>Updated policy &quot;(0)&quot;</td>
<td>Policy &quot;(0)&quot; has been successfully updated. The current policy version is {1}. Active channels: {2}.</td>
</tr>
<tr>
<td>1205</td>
<td>Incident limit reached for Policy &quot;(0)&quot;</td>
<td>The policy &quot;(0)&quot; has found incidents in more than {1} messages within the last {2} hours. The policy will not be enforced until the policy is changed, or the reset period of {2} hours is reached.</td>
</tr>
<tr>
<td>1206</td>
<td>Long message wait time</td>
<td>Message wait time was (0):(1):(2):(3).</td>
</tr>
<tr>
<td>1207</td>
<td>Failed to load Vector Machine Learning profile</td>
<td>Failed to load [(0)] Vector Machine Learning profile. See server logs for more details.</td>
</tr>
<tr>
<td>1208</td>
<td>Failed to unload Vector Machine Learning profile</td>
<td>Failed to unload [(0)] Vector Machine Learning profile. See server logs for more details.</td>
</tr>
<tr>
<td>1209</td>
<td>Loaded Vector Machine Learning profile</td>
<td>Loaded [(0)] Vector Machine Learning profile.</td>
</tr>
</tbody>
</table>
### Table 8-10  Detection configuration events *(continued)*

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1210</td>
<td>Unloaded Vector Machine Learning profile</td>
<td>Unloaded [{0}] Vector Machine Learning profile.</td>
</tr>
<tr>
<td>1211</td>
<td>Vector Machine Learning training successful</td>
<td>Training succeeded for [{0}] Vector Machine Learning profile.</td>
</tr>
<tr>
<td>1212</td>
<td>Vector Machine Learning training failed</td>
<td>Training failed for [{0}] Vector Machine Learning profile.</td>
</tr>
<tr>
<td>1213</td>
<td>{0} messages timed out in Detection recently</td>
<td>{0} messages timed out in Detection in the last {1} minutes. Enable Detection execution trace logs for details.</td>
</tr>
</tbody>
</table>

### Table 8-11  File reader events

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1301</td>
<td>File Reader started</td>
<td>None</td>
</tr>
<tr>
<td>1302</td>
<td>File Reader failed to start</td>
<td>Error starting File Reader. {0} No incidents will be detected.</td>
</tr>
<tr>
<td>1303</td>
<td>Unable to delete folder</td>
<td>File Reader was unable to delete folder &quot;{0}&quot; in the file system. Please investigate, as this will cause system malfunction.</td>
</tr>
<tr>
<td>1304</td>
<td>Channel enabled</td>
<td>Monitor channel &quot;{0}&quot; has been enabled.</td>
</tr>
<tr>
<td>1305</td>
<td>Channel disabled</td>
<td>Monitor channel &quot;{0}&quot; has been disabled. 1306 License received. {0}.</td>
</tr>
<tr>
<td>1306</td>
<td>License received.</td>
<td>None</td>
</tr>
<tr>
<td>1307</td>
<td>started</td>
<td>Process is started.</td>
</tr>
<tr>
<td>1308</td>
<td>down</td>
<td>Process is down.</td>
</tr>
</tbody>
</table>

### Table 8-12  ICAP events

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1400</td>
<td>ICAP channel configured</td>
<td>The channel is in {0} mode</td>
</tr>
<tr>
<td>1401</td>
<td>Invalid license</td>
<td>The ICAP channel is not licensed or the license has expired. No incidents will be detected or prevented by the ICAP channel.</td>
</tr>
</tbody>
</table>
### Table 8-12 ICAP events (continued)

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1402</td>
<td>Content Removal Incorrect</td>
<td>Configuration rule in line {0} is outdated or not written in proper grammar format. Either remove it from the config file or update the rule.</td>
</tr>
<tr>
<td>1403</td>
<td>Out of memory Error (Web Prevent)</td>
<td>While processing request on connection ID{0}, out of memory error occurred. Please tune your setup for traffic load.</td>
</tr>
<tr>
<td>1404</td>
<td>Host restriction</td>
<td>Any host (ICAP client) can connect to ICAP Server.</td>
</tr>
<tr>
<td>1405</td>
<td>Host restriction error</td>
<td>Unable to get the IP address of host {0}.</td>
</tr>
<tr>
<td>1406</td>
<td>Host restriction error</td>
<td>Unable to get the IP address of any host in Icap.AllowHosts.</td>
</tr>
<tr>
<td>1407</td>
<td>Protocol Trace Enabled</td>
<td>Enabled Traces available at {0}.</td>
</tr>
<tr>
<td>1408</td>
<td>Invalid Load Balance Factor Icap</td>
<td>LoadBalanceFactor configured to 0. Treating it as 1.</td>
</tr>
</tbody>
</table>

### Table 8-13 MTA events

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1500</td>
<td>Invalid license</td>
<td>The SMTP Prevent channel is not licensed or the license has expired. No incidents will be detected or prevented by the SMTP Prevent channel.</td>
</tr>
<tr>
<td>1501</td>
<td>Bind address error</td>
<td>Unable to bind {0}. Please check the configured address or the RequestProcessor log for more information. 1502 MTA restriction error Unable to resolve host {0}.</td>
</tr>
<tr>
<td>1503</td>
<td>All MTAs restricted</td>
<td>Client MTAs are restricted, but no hosts were resolved. Please check the RequestProcessor log for more information and correct the RequestProcessor.AllowHosts setting for this Prevent server.</td>
</tr>
<tr>
<td>1504</td>
<td>Downstream TLS Handshake failed</td>
<td>TLS handshake with downstream MTA {0} failed. Please check SmtpPrevent and RequestProcessor logs for more information.</td>
</tr>
<tr>
<td>1505</td>
<td>Downstream TLS Handshake successful</td>
<td>TLS handshake with downstream MTA {0} was successfully completed.</td>
</tr>
</tbody>
</table>
### Table 8-14  
**File inductor events**

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1600</td>
<td>Override folder invalid</td>
<td>Monitor channel {0} has invalid source folder: {1} Using folder: {2}.</td>
</tr>
<tr>
<td>1601</td>
<td>Source folder invalid</td>
<td>Monitor channel {0} has invalid source folder: {1} The channel is disabled.</td>
</tr>
</tbody>
</table>

### Table 8-15  
**File scan events**

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1700</td>
<td>Scan start failed</td>
<td>Discover target with ID {0} does not exist. 1701 Scan terminated {0}</td>
</tr>
<tr>
<td>1702</td>
<td>Scan completed</td>
<td>Discover target &quot;{0}&quot; completed a scan successfully.</td>
</tr>
<tr>
<td>1703</td>
<td>Scan start failed</td>
<td>{0}</td>
</tr>
<tr>
<td>1704</td>
<td>Share list had errors</td>
<td>{0}</td>
</tr>
<tr>
<td>1705</td>
<td>Scheduled scan failed</td>
<td>Failed to start a scheduled scan of Discover target {0}. {1}</td>
</tr>
<tr>
<td>1706</td>
<td>Scan suspend failed</td>
<td>{0}</td>
</tr>
<tr>
<td>1707</td>
<td>Scan resume failed</td>
<td>{0}</td>
</tr>
<tr>
<td>1708</td>
<td>Scheduled scan suspension failed</td>
<td>Scheduled suspension failed for scan of Discover target {0}. {1}</td>
</tr>
<tr>
<td>1709</td>
<td>Scheduled scan resume failed</td>
<td>Scheduled suspension failed for scan of Discover target {0}. {1}</td>
</tr>
<tr>
<td>1710</td>
<td>Maximum Scan Duration Timeout Occurred</td>
<td>Discover target &quot;{0}&quot; timed out because of Maximum Scan Duration.</td>
</tr>
<tr>
<td>1711</td>
<td>Maximum Scan Duration Timeout Failed</td>
<td>Maximum scan time duration timed out for scan: {0}. However, an error occurred while trying to abort the scan.</td>
</tr>
<tr>
<td>1712</td>
<td>Scan Idle Timeout Occurred</td>
<td>Discover target &quot;{0}&quot; timed out because of Scan Idle Timeout.</td>
</tr>
<tr>
<td>1713</td>
<td>Scan Idle Timeout Failed</td>
<td>Maximum idle time duration timed out for scan: {0}. However, an error occurred while trying to abort the scan.</td>
</tr>
<tr>
<td>1714</td>
<td>Scan terminated - Invalid Server State</td>
<td>Scan of discover target &quot;{0}&quot; has been terminated from the state of &quot;{1}&quot; because the associated discover server {2} entered an unexpected state of &quot;{3}&quot;.</td>
</tr>
</tbody>
</table>
### Table 8-15  
File scan events (continued)

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1715</td>
<td>Scan terminated - Server Removed</td>
<td>Scan of discover target &quot;{0}&quot; has been terminated because the associated discover server {1} is no longer available.</td>
</tr>
<tr>
<td>1716</td>
<td>Scan terminated - Server Reassigned</td>
<td>Scan of discover target &quot;{0}&quot; has been terminated because the associated discover server {1} is already scanning discover target(s) &quot;{2}&quot;.</td>
</tr>
<tr>
<td>1717</td>
<td>Scan terminated - Transition Failed</td>
<td>Failed to handle the state change of discover server {1} while scanning discover target &quot;{0}&quot;. See log files for details.</td>
</tr>
<tr>
<td>1718</td>
<td>Scan start failed</td>
<td>Scan of discover target &quot;{0}&quot; has failed to start. See log files for detailed error description.</td>
</tr>
<tr>
<td>1719</td>
<td>Scan start failed due to unsupported target type</td>
<td>Scan of discover target &quot;{0}&quot; has failed, as its target type is no longer supported.</td>
</tr>
</tbody>
</table>

### Table 8-16  
Incident persister and incident writer events

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1800</td>
<td>Incident Persister is unable to process incident Incident</td>
<td>Persister ran out of memory processing incident {0}.</td>
</tr>
<tr>
<td>1801</td>
<td>Incident Persister failed to process incident {0}</td>
<td></td>
</tr>
<tr>
<td>1802</td>
<td>Corrupted incident received</td>
<td>A corrupted incident was received, and renamed to {0}.</td>
</tr>
<tr>
<td>1803</td>
<td>Policy misconfigured</td>
<td>Policy &quot;{0}&quot; has no associated severity.</td>
</tr>
<tr>
<td>1804</td>
<td>Incident Persister is unable to start</td>
<td>Incident Persister cannot start because it failed to access the incident folder {0}. Check folder permissions.</td>
</tr>
<tr>
<td>1805</td>
<td>Incident Persister is unable to access</td>
<td>Incidents folder The Incident Persister is unable to access the incident folder {0}. Check folder permissions.</td>
</tr>
<tr>
<td>1806</td>
<td>Response rule processing failed to start</td>
<td>Response rule processing failed to start: {0}.</td>
</tr>
<tr>
<td>1807</td>
<td>Response rule processing execution failed</td>
<td>Response rule command runtime execution failed from error: {0}.</td>
</tr>
<tr>
<td>1808</td>
<td>Unable to write incident</td>
<td>Failed to delete old temporary file {0}.</td>
</tr>
<tr>
<td>1809</td>
<td>Unable to write incident</td>
<td>Failed to rename temporary incident file {0}.</td>
</tr>
</tbody>
</table>
### Table 8-16  Incident persister and incident writer events (continued)

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1810</td>
<td>Unable to list incidents</td>
<td>Failed to list incident files in folder {0}. Check folder permissions.</td>
</tr>
<tr>
<td>1811</td>
<td>Error sending incident</td>
<td>Unexpected error occurred while sending an incident. {0} Look in the incident writer log for more information.</td>
</tr>
<tr>
<td>1812</td>
<td>Incident writer stopped</td>
<td>Failed to delete incident file {0} after it was sent. Delete the file manually, correct the problem and restart the incident writer.</td>
</tr>
<tr>
<td>1813</td>
<td>Failed to list incidents</td>
<td>Failed to list incident files in folder {0}. Check folder permissions.</td>
</tr>
<tr>
<td>1814</td>
<td>Incident queue backlogged</td>
<td>There are {0} incidents in this server's queue.</td>
</tr>
</tbody>
</table>
| 1815  | Low disk space on incident server | Hard disk space for the incident data storage server is low. Disk usage is over {0}%.
| 1816  | Failed to update policy statistics | Failed to update policy statistics for policy {0}. |
| 1817  | Daily incident maximum exceeded | The daily incident maximum for policy {0} has been exceeded.\nNo further incidents will be generated. |
| 1818  | Incident is oversized, has been persisted with a limited number of components and/or violations | Incident is oversized, has been partially persisted with messageID {0}, Incident File Name {1}. |

### Table 8-17  Install or update events

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1900</td>
<td>Failed to load update package</td>
<td>Database connection error occurred while loading the software update package {0}.</td>
</tr>
<tr>
<td>1901</td>
<td>Software update failed</td>
<td>Failed to apply software update from package {0}. Check the update service log.</td>
</tr>
</tbody>
</table>

### Table 8-18  Key ignition password events

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2000</td>
<td>Key ignition error</td>
<td>Failed to ignite keys with the new ignition password. Detection against Exact Data Profiles will be disabled.</td>
</tr>
</tbody>
</table>
### Table 8-18  Key ignition password events (continued)

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2001</td>
<td>Unable to update key ignition password</td>
<td>The key ignition password won't be updated, because the cryptographic keys aren't ignited. Exact Data Matching will be disabled.</td>
</tr>
</tbody>
</table>

### Table 8-19  Admin password reset event code

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2099</td>
<td>Administrator password reset</td>
<td>The Administrator password has been reset by the password reset tool.</td>
</tr>
</tbody>
</table>

### Table 8-20  Manager administrator and policy events

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2100</td>
<td>Administrator saved</td>
<td>The administrator settings were successfully saved.</td>
</tr>
<tr>
<td>2101</td>
<td>Data source removed</td>
<td>The data source with ID {0} was removed by {1}.</td>
</tr>
<tr>
<td>2102</td>
<td>Data source saved</td>
<td>The {0} data source was saved by {1}.</td>
</tr>
<tr>
<td>2103</td>
<td>Document source removed</td>
<td>The document source with ID {0} was removed by {1}.</td>
</tr>
<tr>
<td>2104</td>
<td>Document source saved</td>
<td>The {0} document source was saved by {1}.</td>
</tr>
<tr>
<td>2105</td>
<td>New protocol created</td>
<td>The new protocol {0} was created by {1}.</td>
</tr>
<tr>
<td>2106</td>
<td>Protocol order changed</td>
<td>The protocol {0} was moved {1} by {2}.</td>
</tr>
<tr>
<td>2107</td>
<td>Protocol removed</td>
<td>The protocol {0} was removed by {1}.</td>
</tr>
<tr>
<td>2108</td>
<td>Protocol saved</td>
<td>The protocol {0} was edited by {1}.</td>
</tr>
<tr>
<td>2109</td>
<td>User removed</td>
<td>The user with ID {0} was removed by {1}.</td>
</tr>
<tr>
<td>2110</td>
<td>User saved</td>
<td>The user {0} was saved by {1}.</td>
</tr>
<tr>
<td>2111</td>
<td>Runaway lookup detected</td>
<td>One of the attribute lookup plug-ins did not complete gracefully and left a running thread in the system. Manager restart may be required for cleanup.</td>
</tr>
<tr>
<td>2112</td>
<td>Loaded Custom</td>
<td>Attribute Lookup Plug-ins The following Custom Attribute Lookup Plug-ins were loaded: {0}.</td>
</tr>
<tr>
<td>2113</td>
<td>No Custom Attribute Lookup Plug-in was loaded</td>
<td>No Custom Attribute Lookup Plug-in was found.</td>
</tr>
<tr>
<td>Code</td>
<td>Summary</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>----------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>2114</td>
<td>Custom attribute lookup failed</td>
<td>Lookup plug-in {0} timed out. It was unloaded.</td>
</tr>
<tr>
<td>2115</td>
<td>Custom attribute lookup failed</td>
<td>Failed to instantiate lookup plug-in {0}. It was unloaded. Error message: {1}</td>
</tr>
<tr>
<td>2116</td>
<td>Policy changed</td>
<td>The {0} policy was changed by {1}.</td>
</tr>
<tr>
<td>2117</td>
<td>Policy removed</td>
<td>The {0} policy was removed by {1}.</td>
</tr>
<tr>
<td>2118</td>
<td>Alert or scheduled report sending failed. {0}</td>
<td>configured by {1} contains the following unreachable email addresses: {2}. Either the addresses are bad or your email server does not allow relay to those addresses.</td>
</tr>
<tr>
<td>2119</td>
<td>System settings changed</td>
<td>The system settings were changed by {0}.</td>
</tr>
<tr>
<td>2120</td>
<td>Endpoint Location settings changed</td>
<td>The endpoint location settings were changed by {0}.</td>
</tr>
<tr>
<td>2121</td>
<td>The account &quot;(1)&quot; has been locked out</td>
<td>The maximum consecutive failed logon number of {0} attempts has been exceeded for account &quot;(1)&quot;, consequently it has been locked out.</td>
</tr>
<tr>
<td>2122</td>
<td>Loaded FlexResponse Actions</td>
<td>The following FlexResponse Actions were loaded: {0}.</td>
</tr>
<tr>
<td>2123</td>
<td>No FlexResponse Action was loaded</td>
<td>No FlexResponse Action was found.</td>
</tr>
<tr>
<td>2124</td>
<td>A runaway FlexResponse action was detected.</td>
<td>One of the FlexResponse plug-ins did not complete gracefully and left a running thread in the system. Manager restart may be required for cleanup.</td>
</tr>
<tr>
<td>2125</td>
<td>Data Insight settings changed</td>
<td>The Data Insight settings were changed by {0}.</td>
</tr>
<tr>
<td>2126</td>
<td>Agent configuration created</td>
<td>Agent configuration {0} was created by {1}.</td>
</tr>
<tr>
<td>2127</td>
<td>Agent configuration modified</td>
<td>Agent configuration {0} was modified by {1}.</td>
</tr>
<tr>
<td>2128</td>
<td>Agent configuration removed</td>
<td>Agent configuration {0} was removed by {1}.</td>
</tr>
<tr>
<td>2129</td>
<td>Agent configuration applied</td>
<td>Agent configuration {0} was applied to endpoint server {1} by {2}.</td>
</tr>
<tr>
<td>2130</td>
<td>Directory Connection source removed</td>
<td>The directory connection source with ID {0} was removed by {1}.</td>
</tr>
<tr>
<td>2131</td>
<td>Directory Connection source saved</td>
<td>The {0} directory connection source was saved by {1}.</td>
</tr>
</tbody>
</table>
### Table 8-20  Manager administrator and policy events (continued)

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2132</td>
<td>Agent Troubleshooting Task</td>
<td>Agent Troubleshooting task of type {0} created by user {1}.</td>
</tr>
<tr>
<td>2133</td>
<td>Certificate authority file generated.</td>
<td>Certificate authority file {0} generated.</td>
</tr>
<tr>
<td>2134</td>
<td>Certificate authority file is corrupt.</td>
<td>Certificate authority file {0} is corrupt.</td>
</tr>
<tr>
<td>2135</td>
<td>Password changed for certificate authority file.</td>
<td>Password changed for certificate authority file {0}. New certificate authority file is {1}.</td>
</tr>
<tr>
<td>2136</td>
<td>Server keystore generated.</td>
<td>Server keystore {0} generated for endpoint server {1}.</td>
</tr>
<tr>
<td>2137</td>
<td>Server keystore is missing or corrupt.</td>
<td>Server keystore {0} for endpoint server {1} is missing or corrupt.</td>
</tr>
<tr>
<td>2138</td>
<td>Server truststore generated.</td>
<td>Server truststore {0} generated for endpoint server {1}.</td>
</tr>
<tr>
<td>2139</td>
<td>Server truststore is missing or corrupt.</td>
<td>Server truststore {0} for endpoint server {1} is missing or corrupt.</td>
</tr>
<tr>
<td>2140</td>
<td>Client certificates and key generated.</td>
<td>Client certificates and key generated.</td>
</tr>
<tr>
<td>2141</td>
<td>Agent installer package generated.</td>
<td>Agent installer package generated for platforms {0}.</td>
</tr>
</tbody>
</table>

### Table 8-21  Enforce licensing and key ignition events

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2200</td>
<td>End User License Agreement accepted</td>
<td>The Symantec Data Loss Prevention End User License Agreement was accepted by {0}, {1}, {2}.</td>
</tr>
<tr>
<td>2201</td>
<td>License is invalid</td>
<td>None</td>
</tr>
<tr>
<td>2202</td>
<td>License has expired</td>
<td>One or more of your product licenses has expired. Some system feature may be disabled. Check the status of your licenses on the system settings page.</td>
</tr>
<tr>
<td>2203</td>
<td>License about to expire</td>
<td>One or more of your product licenses will expire soon. Check the status of your licenses on the system settings page.</td>
</tr>
<tr>
<td>2204</td>
<td>No license</td>
<td>The license does not exist, is expired or invalid. No incidents will be detected.</td>
</tr>
<tr>
<td>2205</td>
<td>Keys ignited</td>
<td>The cryptographic keys were ignited by administrator logon.</td>
</tr>
</tbody>
</table>
Table 8-21  Enforce licensing and key ignition events (continued)

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2206</td>
<td>Key ignition failed</td>
<td>Failed to ignite the cryptographic keys manually. Please look in the Enforce Server logs for more information. It will be impossible to create new exact data profiles.</td>
</tr>
<tr>
<td>2207</td>
<td>Auto key ignition</td>
<td>The cryptographic keys were automatically ignited.</td>
</tr>
<tr>
<td>2208</td>
<td>Manual key ignition required</td>
<td>The automatic ignition of the cryptographic keys is not configured. Administrator logon is required to ignite the cryptographic keys. No new exact data profiles can be created until the administrator logs on.</td>
</tr>
</tbody>
</table>

Table 8-22  Manager major events

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
</table>
| 2300  | Low disk space        | Hard disk space is low. Symantec Data Loss Prevention Enforce Server disk usage is over {0}%.
| 2301  | Tablespace is almost full | Oracle tablespace {0} is over {1}% full.                                      |
| 2302  | {0} not responding    | Detection Server {0} did not update its heartbeat for at least 20 minutes. |
| 2303  | Monitor configuration changed | The {0} monitor configuration was changed by {1}.                               |
| 2304  | System update uploaded | A system update was uploaded that affected the following components: {0}. |
| 2305  | SMTP server is not reachable. | SMTP server is not reachable. Cannot send out alerts or schedule reports. |
| 2306  | Enforce Server started | The Enforce Server was started.                                               |
| 2307  | Enforce Server stopped | The Enforce Server was stopped.                                               |
| 2308  | Monitor status updater exception | The monitor status updater encountered a general exception. Please look at the Enforce Server logs for more information. |
| 2310  | Statistics aggregation failure | The statistics summarization task encountered a general exception. Refer to the Enforce Server logs for more information. |
### Table 8-22  Manager major events events *(continued)*

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2311</td>
<td>Version mismatch</td>
<td>Enforce version is (0), but this monitor’s version is (1).</td>
</tr>
<tr>
<td>2312</td>
<td>Incident deletion failed</td>
<td>Incident Deletion failed.</td>
</tr>
<tr>
<td>2313</td>
<td>Incident deletion completed</td>
<td>Incident deletion ran for (0) and deleted (1) incident(s).</td>
</tr>
<tr>
<td>2314</td>
<td>Endpoint data deletion failed</td>
<td>Endpoint data deletion failed.</td>
</tr>
</tbody>
</table>
| 2315  | Low disk space on incident server | Hard disk space for the incident data storage server is low. Disk usage is over \(0\)%.
| 2316  | Over \(0\) incidents currently contained in the database | Persisting over \(0\) incidents can decrease database performance.                             |

### Table 8-23  Monitor version support events

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2320</td>
<td>Version obsolete</td>
<td>Detection server is not supported when two major versions older than Enforce server version. Enforce version is (0), and this detection server’s version is (1). This detection server must be upgraded.</td>
</tr>
<tr>
<td>2321</td>
<td>Version older than Enforce version</td>
<td>Enforce will not have visibility for this detection server and will not be able to send updates to it. Detection server incidents will be received and processed normally. Enforce version is (0), and this detection server’s version is (1).</td>
</tr>
<tr>
<td>2322</td>
<td>Version older than Enforce version</td>
<td>Functionality introduced with recent versions of Enforce relevant to this type of detection server will not be supported by this detection server. Enforce version is (0), and this detection server’s version is (1).</td>
</tr>
<tr>
<td>2323</td>
<td>Minor version older than Enforce minor version</td>
<td>Functionality introduced with recent versions of Enforce relevant to this type of detection server will not be supported by this detection server and might be incompatible with this detection server. Enforce version is (0), and this detection server’s version is (1). This detection server should be upgraded.</td>
</tr>
<tr>
<td>2324</td>
<td>Version newer than Enforce version</td>
<td>Detection server is not supported when its version is newer than the Enforce server version. Enforce version is (0), and this detection server’s version is (1). Enforce must be upgraded or detection server must be downgraded.</td>
</tr>
<tr>
<td>Code</td>
<td>Summary</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>--------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>2400</td>
<td>Export web archive finished</td>
<td>Archive &quot;(0)&quot; for user {1} was created successfully.</td>
</tr>
<tr>
<td>2401</td>
<td>Export web archive canceled</td>
<td>Archive &quot;(0)&quot; for user {1} was canceled.</td>
</tr>
<tr>
<td>2402</td>
<td>Export web archive failed</td>
<td>Failed to create archive &quot;(0)&quot; for user {1}. The report specified had over {2} incidents.</td>
</tr>
<tr>
<td>2403</td>
<td>Export web archive failed</td>
<td>Failed to create archive &quot;(0)&quot; for user {1}. Failure occurred at incident {2}.</td>
</tr>
<tr>
<td>2404</td>
<td>Unable to run scheduled report</td>
<td>The scheduled report job {0} was invalid and has been removed.</td>
</tr>
<tr>
<td>2405</td>
<td>Unable to run scheduled report</td>
<td>The scheduled report {0} owned by {1} encountered an error: {2}.</td>
</tr>
<tr>
<td>2406</td>
<td>Report scheduling is disabled</td>
<td>The scheduled report {0} owned by {1} cannot be run because report scheduling is disabled.</td>
</tr>
<tr>
<td>2407</td>
<td>Report scheduling is disabled</td>
<td>The scheduled report cannot be run because report scheduling is disabled.</td>
</tr>
<tr>
<td>2408</td>
<td>Unable to run scheduled report</td>
<td>Unable to connect to mail server when delivery scheduled report {0}{1}.</td>
</tr>
<tr>
<td>2409</td>
<td>Unable to run scheduled report</td>
<td>User {0} is no longer in role {1} which scheduled report {2} belongs to. The schedule has been deleted.</td>
</tr>
<tr>
<td>2410</td>
<td>Unable to run scheduled report</td>
<td>Unable to run scheduled report {0} for user {1} because the account is currently locked.</td>
</tr>
<tr>
<td>2411</td>
<td>Scheduled report sent</td>
<td>The schedule report {0} owned by {1} was successfully sent.</td>
</tr>
<tr>
<td>2412</td>
<td>Export XML report failed</td>
<td>XML Export of report by user [{0}] failed XML Export of report by user [{0}] failed.</td>
</tr>
<tr>
<td>2420</td>
<td>Unable to run scheduled data owner report distribution</td>
<td>Unable to distribute report {0} (id={1}) by data owner because sending of report data has been disabled.</td>
</tr>
<tr>
<td>2421</td>
<td>Report distribution by data owner failed</td>
<td>Report distribution by data owner for report {0} (id={1}) failed.</td>
</tr>
<tr>
<td>2422</td>
<td>Report distribution by data owner finished</td>
<td>Report distribution by data owner for report {0} (id={1}) finished with {2} incidents for {3} data owners. {4} incidents for {5} data owners failed to be exported.</td>
</tr>
</tbody>
</table>
### Table 8-24  Manager reporting events events (continued)

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2423</td>
<td>Report distribution to data owner truncated</td>
<td>The report distribution {1} (id={2}) for the data owner &quot;{0}&quot; exceeded the maximum allowed size. Only the first {3} incidents were sent to &quot;{0}&quot;.</td>
</tr>
<tr>
<td>2424</td>
<td>A deprecated version of the Reporting API is being used.</td>
<td>A client is using a deprecated version of the Reporting API that will be disabled with version 13.0 of Data Loss Prevention. Please upgrade the client to v2011 of the API, available with Data Loss Prevention version 11.6 and later, to avoid future service disruptions.</td>
</tr>
</tbody>
</table>

### Table 8-25  Messaging events

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2500</td>
<td>Unexpected Error Processing Message</td>
<td>{0} encountered an unexpected error processing a message. See the log file for details.</td>
</tr>
<tr>
<td>2501</td>
<td>Memory Throttler disabled</td>
<td>{0} x {1} bytes need to be available for memory throttling. Only {2} bytes were available. Memory Throttler has been disabled.</td>
</tr>
</tbody>
</table>

### Table 8-26  Detection server communication events

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2600</td>
<td>Communication error</td>
<td>Unexpected error occurred while sending {1} updates to {0}. {2} Please look at the monitor controller logs for more information.</td>
</tr>
<tr>
<td>2650</td>
<td>Communication error(VML)</td>
<td>Unexpected error occurred while sending profile updates config set {0} to {1} {2}. Please look at the monitor controller logs for more information.</td>
</tr>
</tbody>
</table>

### Table 8-27  Monitor controller events

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2700</td>
<td>Monitor Controller started</td>
<td>Monitor Controller service was started.</td>
</tr>
<tr>
<td>2701</td>
<td>Monitor Controller stopped</td>
<td>Monitor Controller service was stopped.</td>
</tr>
<tr>
<td>2702</td>
<td>Update transferred to {0}</td>
<td>Successfully transferred update package {1} to detection server {0}.</td>
</tr>
</tbody>
</table>
### Table 8-27  Monitor controller events (continued)

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2703</td>
<td>Update transfer complete</td>
<td>Successfully transferred update package {0} to all detection servers.</td>
</tr>
<tr>
<td>2704</td>
<td>Update of {0} failed</td>
<td>Failed to transfer update package to detection server {0}.</td>
</tr>
<tr>
<td>2705</td>
<td>Configuration file delivery complete</td>
<td>Successfully transferred config file {0} to detection server.</td>
</tr>
<tr>
<td>2706</td>
<td>Log upload request sent.</td>
<td>Successfully sent log upload request {0}.</td>
</tr>
<tr>
<td>2707</td>
<td>Unable to send log upload request</td>
<td>Encountered a recoverable error while attempting to deliver log upload request {0}.</td>
</tr>
<tr>
<td>2708</td>
<td>Unable to send log upload request</td>
<td>Encountered an unrecoverable error while attempting to deliver log upload request {0}.</td>
</tr>
<tr>
<td>2709</td>
<td>Using built-in certificate</td>
<td>Using built-in certificate to secure the communication between Enforce and Detection Servers.</td>
</tr>
<tr>
<td>2710</td>
<td>Using user generated certificate</td>
<td>Using user generated certificate to secure the communication between Enforce and Detection Servers.</td>
</tr>
<tr>
<td>2711</td>
<td>Time mismatch between Enforce and Monitor. This may affect certain functionalities in the system.</td>
<td>Time mismatch between Enforce and Monitor. It is recommended to fix the time on the monitor through automatic time synchronization.</td>
</tr>
</tbody>
</table>

### Table 8-28  Packet capture events

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2800</td>
<td>Bad spool directory configured for Packet Capture</td>
<td>Packet Capture has been configured with a spool directory: {0}. This directory does not have write privileges. Please check the directory permissions and monitor configuration file. Then restart the monitor.</td>
</tr>
<tr>
<td>2801</td>
<td>Failed to send list of NICs. {0}</td>
<td>{0}.</td>
</tr>
</tbody>
</table>

### Table 8-29  EDM index events and messages

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2900</td>
<td>EDM profile search failed</td>
<td>{0}.</td>
</tr>
<tr>
<td>2901</td>
<td>Keys are not ignited</td>
<td>Exact Data Matching will be disabled until the cryptographic keys are ignited.</td>
</tr>
<tr>
<td>Code</td>
<td>Summary</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>2902</td>
<td>Index folder inaccessible</td>
<td>Failed to list files in the index folder {0}. Check the configuration and the folder permissions.</td>
</tr>
<tr>
<td>2903</td>
<td>Created index folder</td>
<td>The local index folder {0} specified in the configuration had not existed. It was created.</td>
</tr>
<tr>
<td>2904</td>
<td>Invalid index folder</td>
<td>The index folder {0} specified in the configuration does not exist.</td>
</tr>
<tr>
<td>2905</td>
<td>Exact data profile creation failed</td>
<td>Data file for exact data profile &quot;{0}&quot; was not created. Please look in the enforce server logs for more information.</td>
</tr>
<tr>
<td>2906</td>
<td>Indexing canceled</td>
<td>Creation of database profile &quot;{0}&quot; was canceled.</td>
</tr>
<tr>
<td>2907</td>
<td>Replication canceled</td>
<td>Canceled replication of database profile &quot;{0}&quot; version {1} to server {2}.</td>
</tr>
<tr>
<td>2908</td>
<td>Replication failed</td>
<td>Connection to database was lost while replicating database profile {0} to server {1}.</td>
</tr>
<tr>
<td>2909</td>
<td>Replication failed</td>
<td>Database error occurred while replicating database profile {0} to server {1}.</td>
</tr>
<tr>
<td>2910</td>
<td>Failed to remove index file</td>
<td>Failed to delete index file {1} of database profile {0}.</td>
</tr>
<tr>
<td>2911</td>
<td>Failed to remove index files</td>
<td>Failed to delete index files {1} of database profile {0}.</td>
</tr>
<tr>
<td>2912</td>
<td>Failed to remove orphaned file</td>
<td>Failed to remove orphaned database profile index file {0}.</td>
</tr>
<tr>
<td>2913</td>
<td>Replication failed</td>
<td>Replication of database profile {0} to server {2} failed.{1} Check the monitor controller log for more details.</td>
</tr>
<tr>
<td>2914</td>
<td>Replication completed</td>
<td>Completed replication of database profile {0} to server {2}. File {1} was transferred successfully.</td>
</tr>
<tr>
<td>2915</td>
<td>Replication completed</td>
<td>Completed replication of database profile {0} to the server {2}. Files {1} were transferred successfully.</td>
</tr>
<tr>
<td>2916</td>
<td>Database profile removed</td>
<td>Database profile {0} was removed. File {1} was deleted successfully.</td>
</tr>
<tr>
<td>2917</td>
<td>Database profile removed</td>
<td>Database profile {0} was removed. Files {1} were deleted successfully.</td>
</tr>
<tr>
<td>2918</td>
<td>Loaded database profile</td>
<td>Loaded database profile {0} from {1}.</td>
</tr>
<tr>
<td>2919</td>
<td>Unloaded database profile</td>
<td>Unloaded database profile {0}.</td>
</tr>
</tbody>
</table>
Table 8-29  EDM index events and messages (continued)

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2920</td>
<td>Failed to load database profile</td>
<td>(2) No incidents will be detected against database profile &quot;(0)&quot; version {1}.</td>
</tr>
<tr>
<td>2921</td>
<td>Failed to unload database profile</td>
<td>(2) It may not be possible to reload the database profile &quot;(0)&quot; version {1} in the future without detection server restart.</td>
</tr>
<tr>
<td>2922</td>
<td>Couldn't find registered content</td>
<td>Registered content with ID {0} wasn't found in database during indexing.</td>
</tr>
<tr>
<td>2923</td>
<td>Database error</td>
<td>Database error occurred during indexing. {0}</td>
</tr>
<tr>
<td>2924</td>
<td>Process shutdown during indexing</td>
<td>The process has been shutdown during indexing. Some registered content may have failed to create.</td>
</tr>
<tr>
<td>2925</td>
<td>Policy is inaccurate</td>
<td>Policy &quot;(0)&quot; has one or more rules with unsatisfactory detection accuracy against (1).{2}</td>
</tr>
<tr>
<td>2926</td>
<td>Created exact data profile</td>
<td>Created {0} from file &quot;(1)&quot;.\nRows processed: (2)\nInvalid rows: (3)\nThe exact data profile will now be replicated to all Symantec Data Loss Prevention Servers.</td>
</tr>
<tr>
<td>2927</td>
<td>User Group &quot;,(0)&quot; synchronization failed</td>
<td>The following User Group directories have been removed/renamed in the Directory Server and could not be synchronized: (1).Please update the &quot;(2)&quot; User Group page to reflect such changes.</td>
</tr>
<tr>
<td>2928</td>
<td>One or more EDM profiles are out of date and must be reindexed</td>
<td>Check the &quot;Manage &gt; Data Profiles &gt; Exact Data&quot; page for more details. The following EDM profiles are out of date: {0}.</td>
</tr>
</tbody>
</table>

Table 8-30  IDM index events and messages

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3000</td>
<td>{0}</td>
<td>{1} Document profile wasn't created.</td>
</tr>
<tr>
<td>3001</td>
<td>Indexing canceled</td>
<td>Creation of document profile &quot;(0)&quot; was canceled.</td>
</tr>
<tr>
<td>3002</td>
<td>Replication canceled</td>
<td>Canceled replication of document profile &quot;(0)&quot; version {1} to server {2}.</td>
</tr>
<tr>
<td>3003</td>
<td>Replication failed</td>
<td>Connection to database was lost while replicating document profile &quot;(0)&quot; version {1} to server {2}.</td>
</tr>
<tr>
<td>3004</td>
<td>Replication failed</td>
<td>Database error occurred while replicating document profile &quot;(0)&quot; version {1} to server {2}.</td>
</tr>
</tbody>
</table>
Table 8-30  IDM index events and messages (continued)

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3005</td>
<td>Failed to remove index file</td>
<td>Failed to delete index file (2) of document profile &quot;(0)&quot; version {1}.</td>
</tr>
<tr>
<td>3006</td>
<td>Failed to remove index files</td>
<td>Failed to delete index files (2) of document profile &quot;(0)&quot; version {1}.</td>
</tr>
<tr>
<td>3007</td>
<td>Failed to remove orphaned file</td>
<td>{0}</td>
</tr>
</tbody>
</table>
| 3008  | Replication failed     | Replication of document profile "(0)" version {1} to server {3} failed. (2)
Check the monitor controller log for more details. |
| 3009  | Replication completed  | Completed replication of document profile "(0)" version {1} to server {3}. File (2) was transferred successfully.                                 |
| 3010  | Replication completed  | Completed replication of document profile "(0)" version {1} to server {3}.
Files (2) were transferred successfully. |
| 3011  | Document profile removed | Document profile "(0)" version {1} was removed. File (2) was deleted successfully.                                                              |
| 3012  | Document profile removed | Document profile "(0)" version {1} was removed. Files (2) were deleted successfully.                                                              |
| 3013  | Loaded document profile | Loaded document profile "(0)" version {1} from {2}.                                                                                          |
| 3014  | Unloaded document profile | Unloaded document profile "(0)" version {1}.                                                                                                    |
| 3015  | Failed to load document profile | (2)No incidents will be detected against document profile "(0)" version {1}.                                                                     |
| 3016  | Failed to unload document profile | (2) It may not be possible to reload the document profile "(0)" version {1} in the future without monitor restart.                            |
| 3017  | Created document profile | Created "(0)" from "{1}". There are (2) accessible files in the content root.
{3} The profile contains index for {4} document(s).
{5} The document profile will now be replicated to all Symantec Data Loss Prevention Servers. |
| 3018  | Document profile       | {0} has reached maximum size. Only {1} out of {2} documents are indexed.                                                                         |
| 3019  | Nothing to index       | Document source "(0)" found no files to index.                                                                                                  |
### Table 8-31  Attribute lookup events

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3100</td>
<td>Invalid Attributes detected with Script Lookup Plugin</td>
<td>Invalid or unsafe Attributes passed from Standard In were removed during script execution. Please check the logs for more details.</td>
</tr>
<tr>
<td>3101</td>
<td>Invalid Attributes detected with Script Lookup Plugin</td>
<td>Invalid or unsafe Attributes passed to Standard Out were removed during script execution. Please check the logs for more details.</td>
</tr>
</tbody>
</table>

### Table 8-32  Monitor stub events

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3200</td>
<td>AggregatorStub started</td>
<td>None</td>
</tr>
<tr>
<td>3201</td>
<td>{0} updated</td>
<td>List of updates:{1}.</td>
</tr>
<tr>
<td>3202</td>
<td>{0} store initialized</td>
<td>Initial items:{1}.</td>
</tr>
<tr>
<td>3203</td>
<td>Received {0}</td>
<td>Size: {1} bytes.</td>
</tr>
<tr>
<td>3204</td>
<td>FileReaderStub started</td>
<td>None</td>
</tr>
<tr>
<td>3205</td>
<td>IncidentWriterStub started</td>
<td>Using test incidents folder {0}.</td>
</tr>
<tr>
<td>3206</td>
<td>Received configuration for {0}</td>
<td>{1}.</td>
</tr>
<tr>
<td>3207</td>
<td>PacketCaptureStub started</td>
<td>None</td>
</tr>
<tr>
<td>3208</td>
<td>RequestProcessorStub started</td>
<td>None</td>
</tr>
<tr>
<td>3209</td>
<td>Received advanced settings</td>
<td>None</td>
</tr>
<tr>
<td>3210</td>
<td>Updated settings</td>
<td>Updated settings:{0}.</td>
</tr>
<tr>
<td>3211</td>
<td>Loaded advanced settings</td>
<td>None</td>
</tr>
<tr>
<td>3212</td>
<td>UpdateServiceStub started</td>
<td>None</td>
</tr>
<tr>
<td>3213</td>
<td>DetectionServerDatabaseStub started</td>
<td>None</td>
</tr>
</tbody>
</table>

### Table 8-33  Packet capture events

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3300</td>
<td>Packet Capture started</td>
<td>Packet Capture has successfully started.</td>
</tr>
</tbody>
</table>
### Table 8-33  
Packet capture events (continued)

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3301</td>
<td>Capture failed to start on device {0}</td>
<td>Device {0} is configured for capture, but could not be initialized. Please see PacketCapture.log for more information.</td>
</tr>
<tr>
<td>3302</td>
<td>PacketCapture could not elevate its privilege level</td>
<td>PacketCapture could not elevate its privileges. Some initialization tasks are likely to fail. Please check ownership and permissions of the PacketCapture executable.</td>
</tr>
<tr>
<td>3303</td>
<td>PacketCapture failed to drop its privilege level</td>
<td>Root privileges are still attainable after attempting to drop them. PacketCapture will not continue</td>
</tr>
<tr>
<td>3304</td>
<td>Packet Capture started again as more disk space is available</td>
<td>Packet capture started processing again because some disk space was freed on the monitor hard drives.</td>
</tr>
<tr>
<td>3305</td>
<td>Packet Capture stopped due to disk space limit</td>
<td>Packet capture stopped processing packets because there is too little space on the monitor hard drives.</td>
</tr>
<tr>
<td>3306</td>
<td>Endace DAG driver is not available</td>
<td>Packet Capture was unable to activate Endace device support. Please see PacketCapture.log for more information.</td>
</tr>
<tr>
<td>3307</td>
<td>PF_RING driver is not available</td>
<td>Packet Capture was unable to activate devices using the PF_RING interface. Please check PacketCapture.log and your system logs for more information.</td>
</tr>
<tr>
<td>3308</td>
<td>PACKET_MMAP driver is not available</td>
<td>Packet Capture was unable to activate devices using the PACKET_MMAP interface. Please check PacketCapture.log and your system logs for more information.</td>
</tr>
<tr>
<td>3309</td>
<td>{0} is not available</td>
<td>Packet Capture was unable to load {0}. No native capture interface is available. Please see PacketCapture.log for more information.</td>
</tr>
<tr>
<td>3310</td>
<td>No {0} Traffic Captured</td>
<td>{0} traffic has not been captured in the last {1} seconds. Please check Protocol filters and the traffic sent to the monitoring NIC.</td>
</tr>
<tr>
<td>3311</td>
<td>Could not create directory</td>
<td>Could not create directory {0} : {1}.</td>
</tr>
</tbody>
</table>

### Table 8-34  
Log collection events

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3400</td>
<td>Couldn't add files to zip</td>
<td>The files requested for collection could not be written to an archive file.</td>
</tr>
<tr>
<td>3401</td>
<td>Couldn't send log collection</td>
<td>The files requested for collection could not be sent.</td>
</tr>
</tbody>
</table>
### Table 8-34  Log collection events (continued)

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3402</td>
<td>Couldn't read logging properties</td>
<td>A properties file could not be read. Logging configuration changes were not applied.</td>
</tr>
<tr>
<td>3403</td>
<td>Couldn't unzip log configuration package</td>
<td>The zip file containing logging configuration changes could not be unpacked. Configuration changes will not be applied.</td>
</tr>
<tr>
<td>3404</td>
<td>Couldn't find files to collect</td>
<td>There were no files found for the last log collection request sent to server.</td>
</tr>
<tr>
<td>3405</td>
<td>File creation failed</td>
<td>Could not create file to collect endpoint logs.</td>
</tr>
<tr>
<td>3406</td>
<td>Disk usage exceeded</td>
<td>File creation failed due to insufficient disk space.</td>
</tr>
<tr>
<td>3407</td>
<td>Max open file limit exceeded</td>
<td>File creation failed as max allowed number of files are already open.</td>
</tr>
</tbody>
</table>

### Table 8-35  Enforce SPC events

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3500</td>
<td>SPC Server successfully registered.</td>
<td>SPC Server successfully registered. Product Instance Id [{0}].</td>
</tr>
<tr>
<td>3501</td>
<td>SPC Server successfully unregistered.</td>
<td>SPC Server successfully unregistered. Product Instance Id [{0}].</td>
</tr>
<tr>
<td>3502</td>
<td>A self-signed certificate was generated.</td>
<td>A self-signed certificate was generated. Certificate alias [{0}].</td>
</tr>
</tbody>
</table>

### Table 8-36  Enforce user data sources events

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3600</td>
<td>User import completed successfully.</td>
<td>User import from source {0} completed successfully.</td>
</tr>
<tr>
<td>3601</td>
<td>User import failed.</td>
<td>User import from data source {0} has failed.</td>
</tr>
<tr>
<td>3602</td>
<td>Updated user data linked to incidents.</td>
<td>Updated user data linked to {0} existing incident events.</td>
</tr>
</tbody>
</table>

### Table 8-37  Catalog item distribution related events events

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3700</td>
<td>Unable to write catalog item</td>
<td>Failed to delete old temporary file {0}.</td>
</tr>
</tbody>
</table>
### Table 8-37  Catalog item distribution related events (continued)

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3701</td>
<td>Unable to rename catalog item</td>
<td>Failed to rename temporary catalog item file {0}.</td>
</tr>
<tr>
<td>3702</td>
<td>Unable to list catalog items</td>
<td>Failed to list catalog item files in folder {0}. Check folder permissions.</td>
</tr>
<tr>
<td>3703</td>
<td>Error sending catalog items</td>
<td>Unexpected error occurred while sending an catalog item {0}. Look in the file reader log for more information.</td>
</tr>
<tr>
<td>3704</td>
<td>File Reader failed to delete files.</td>
<td>Failed to delete catalog file {0} after it was sent. Delete the file manually, correct the problem and restart the File Reader.</td>
</tr>
<tr>
<td>3705</td>
<td>Failed to list catalog item files</td>
<td>Failed to list catalog item files in folder {0}. Check folder permissions.</td>
</tr>
<tr>
<td>3706</td>
<td>The configuration is not valid.</td>
<td>The property {0} was configured with invalid value {1}. Please make sure that this has correct value provided.</td>
</tr>
<tr>
<td>3707</td>
<td>Scan failed: Remediation detection catalog update timed out after {0} seconds for target {1}.</td>
<td>Remediation detection catalog update timed out after {0} seconds for target {1}.</td>
</tr>
</tbody>
</table>

### Table 8-38  Detection server database events

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3800</td>
<td>DetectionServerDatabase started</td>
<td>None</td>
</tr>
<tr>
<td>3801</td>
<td>DetectionServerDatabase failed to start</td>
<td>Error starting DetectionServerDatabase. Reason: {0}.</td>
</tr>
<tr>
<td>3802</td>
<td>Invalid Port for DetectionServerDatabase</td>
<td>Could not retrieve the port for DetectionServerDatabase process to listen to connection. Reason: {0}. Check if the property file setting has the valid port number.</td>
</tr>
</tbody>
</table>

### Table 8-39  Telemetry event code

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3803</td>
<td>Telemetry transmission failed.</td>
<td>Telemetry transmission failed. Transmission status : {0}</td>
</tr>
</tbody>
</table>
### Table 8-40  Endpoint communication layer events

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3900</td>
<td>Internal communications error.</td>
<td>Internal communications error. Please see {0} for errors. Search for the string {1}.</td>
</tr>
<tr>
<td>3901</td>
<td>System events have been suppressed.</td>
<td>System event throttle limit exceeded. {0} events have been suppressed. Internal error code = {1}.</td>
</tr>
</tbody>
</table>

### Table 8-41  Agent communication event code

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4000</td>
<td>Agent Handshaker error</td>
<td>Agent Handshaker error. Please see {0} for errors. Search for the string {1}.</td>
</tr>
</tbody>
</table>

### Table 8-42  Monitor controller replication communication layer application error events

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4050</td>
<td>Agent data batch persist error</td>
<td>Unexpected error occurred while agent data being persisted. {0}. Please look at the monitor controller logs for more information.</td>
</tr>
<tr>
<td>4051</td>
<td>Agent status attribute batch persist error</td>
<td>Status attribute data for {0} agent(s) could not be persisted. Please look at the monitor controller logs for more information.</td>
</tr>
<tr>
<td>4052</td>
<td>Agent event batch persist</td>
<td>Event data for {0} agent(s) could not be persisted. Please look at the monitor controller logs for more information.</td>
</tr>
</tbody>
</table>

### Table 8-43  Enforce Server web services event code

<table>
<thead>
<tr>
<th>Code</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4101</td>
<td>Response Rule Execution Service Database failure on request fetch</td>
<td>Request fetch failed even after {0} retries. Database connection still down. The service will be stopped.</td>
</tr>
</tbody>
</table>
Adding a new product module

This chapter includes the following topics:

- Installing a new license file
- About system upgrades

Installing a new license file

When you first purchase Symantec Data Loss Prevention, upgrade to a later version, or purchase additional product modules, you must install one or more Symantec Data Loss Prevention license files. License files have names in the format name.slf. You can also enter a license file for one module to start and, later on, enter license files for additional modules.

For detailed information about installing the license file for your initial purchase of Symantec Data Loss Prevention, see the Symantec Data Loss Prevention Installation Guide for your operating system.

To install a license:

1. Download the new license file. For information on downloading and extracting a license file, see the document Acquiring Symantec Data Loss Prevention Software, available at the Symantec FileConnect site.

2. Go to System > Settings > General and click Configure.

3. At the Edit General Settings screen, scroll down to the License section.
4 In the **Install License** field, browse for the new Symantec Data Loss Prevention license file you downloaded, then click **Save** to agree to the terms and conditions of the end user license agreement (EULA) for the software and to install the license.

**Note:** If you do not agree to the terms and conditions of the EULA, you cannot install the software.

5 To enable full functionality of new product license-related features, restart the Vontu Manager Service.

See “About Data Loss Prevention services” on page 76.

The **Current License** list displays the following information for each product license:

- **Product** – The individual Symantec Data Loss Prevention product name
- **Count** – The number of users licensed to use the product
- **Status** – The current state of the product
- **Expiration** – The expiration date of license for the product

A month before **Expiration** of the license, warning messages appear on the System > Servers > Overview screen. When you see a message about the expiration of your license, contact Symantec to purchase a new license key before the current license expires.

### About system upgrades

The **Upgrade** button on the **System Overview** screen initiates the loading and upgrading of your system to a newer version of Symantec Data Loss Prevention.

For information about upgrading the Symantec Data Loss Prevention software, see the Symantec Data Loss Prevention Upgrade Guide.

See “About Symantec Data Loss Prevention administration” on page 55.
Managing detection servers

- Chapter 10. Installing and managing detection servers
- Chapter 11. Managing log files
- Chapter 12. Using Symantec Data Loss Prevention utilities
Installing and managing detection servers

This chapter includes the following topics:

- About managing Symantec Data Loss Prevention servers
- Enabling Advanced Process Control
- Server controls
- Server configuration—basic
- Server configuration—advanced
- Adding a detection server
- Removing a server
- Importing SSL certificates to Enforce or Discover servers
- About the System Overview screen
- Server status overview
- Recent error and warning events list
- Server Detail screen
- Advanced server settings
- About using load balancers in an endpoint deployment
About managing Symantec Data Loss Prevention servers

Symantec Data Loss Prevention servers are managed from the System > Servers > Overview screen. This screen provides an overview of your system, including server status and recent system events. It displays summary information about all Symantec Data Loss Prevention servers, a list of recent error and warning events, and information about your license. From this screen you can add or remove detection servers.

■ Click on the name of a server to display its Server Detail screen, from which you can control and configure that server.

See “Installing a new license file” on page 173.
See “About the Enforce Server administration console” on page 56.
See “About the System Overview screen” on page 198.
See “Server Detail screen” on page 201.
See “Adding a detection server” on page 194.
See “Removing a server” on page 196.
See “Server controls” on page 178.
See “Server configuration—basic” on page 180.

Enabling Advanced Process Control

Symantec Data Loss Prevention Advanced Process Control lets you start or stop individual server processes from the Enforce Server administration console. You do not have to start or stop an entire server. This feature can be useful for debugging. When Advanced Process Control is off (the default), each Server Detail screen shows only the status of the entire server. When you turn Advanced Process Control on, the General section of the Server Detail screen displays individual processes.

See “Server Detail screen” on page 201.
To enable Advanced Process Control

1. Go to System > Settings > General and click Configure. The Edit System Settings screen is displayed.

2. Scroll down to the Process Control section and check the Advanced Process Control box.

3. Click Save.

Table 10-1 describes the individual processes and the servers on which they run once advanced process control is enabled.

Table 10-1  Advanced processes

<table>
<thead>
<tr>
<th>Process</th>
<th>Description</th>
<th>Control</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitor Controller</td>
<td>The Monitor Controller process controls detection servers.</td>
<td>The MonitorController Status is available for the Enforce Server.</td>
</tr>
<tr>
<td>File Reader</td>
<td>The File Reader process detects incidents.</td>
<td>The FileReader Status is available for all detection servers.</td>
</tr>
<tr>
<td>Incident Writer</td>
<td>The Incident Writer process sends incidents to the Enforce Server.</td>
<td>The IncidentWriter Status is available for all detection servers, unless they are part of a single-tier installation, in which case there is only one Incident Writer process.</td>
</tr>
<tr>
<td>Packet Capture</td>
<td>The Packet Capture process captures network streams.</td>
<td>The PacketCapture Status is available for Network Monitor.</td>
</tr>
<tr>
<td>Request Processor</td>
<td>The Request Processor processes SMTP requests.</td>
<td>The RequestProcessor Status is available for Network Prevent for Email.</td>
</tr>
<tr>
<td>Endpoint Server</td>
<td>The Endpoint Server process interacts with Symantec DLP Agents.</td>
<td>The EndpointServer Status is available for Endpoint Prevent.</td>
</tr>
<tr>
<td>Detection Server Database</td>
<td>The Detection Server Database process is used for automated incident remediation tracking.</td>
<td>The DetectionServerDatabase Status is available for Network Discover.</td>
</tr>
</tbody>
</table>

See “Server configuration—basic” on page 180.

Server controls

Servers and their processes are controlled from the Server Detail screen.
To reach the **Server Detail** screen for a particular server, go to the **Overview** screen (**System > Servers > Overview**) and click on the server's name in the list.

See “**Server Detail screen**” on page 201.

The status of the server and its processes appears in the **General** section of the **Server Detail** screen. The **Start**, **Recycle** and **Stop** buttons control server and process operations.

Current status of the server is displayed in the **General** section of the **Server Detail** screen. The possible values are:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="icon.png" alt="Starting" /></td>
<td>Starting - In the process of starting.</td>
</tr>
<tr>
<td><img src="icon.png" alt="Running" /></td>
<td>Running - Running without errors.</td>
</tr>
<tr>
<td><img src="icon.png" alt="Running Selected" /></td>
<td>Running Selected - Some processes on the server are stopped or have errors. To see the statuses of individual processes, you must first enable <strong>Advanced Process Control</strong> on the <strong>System Settings</strong> screen.</td>
</tr>
<tr>
<td><img src="icon.png" alt="Stopping" /></td>
<td>Stopping - In the process of stopping.</td>
</tr>
<tr>
<td><img src="icon.png" alt="Stopped" /></td>
<td>Stopped - Fully stopped.</td>
</tr>
<tr>
<td><img src="icon.png" alt="Unknown" /></td>
<td>Unknown - The Server has encountered one of the following errors:</td>
</tr>
</tbody>
</table>

- **Start.** To start a server or process, click **Start**.
- **Recycle.** To stop and restart a server, click **Recycle**.
- **Stop.** To stop a server or process, click **Stop**.
- To halt a process during its start-up procedure, click **Terminate**.

**Note:** Status and controls for individual server processes are only displayed if **Advanced Process Control** is enabled for the Enforce Server. To enable **Advanced Process Control**, go to **System > Settings > General > Configure**, check the **Advanced Process Control** box, and click **Save**.
To update the status, click the refresh icon in the upper-right portion of the screen, as needed.

See “About Symantec Data Loss Prevention administration” on page 55.
See “About the System Overview screen” on page 198.
See “Server Detail screen” on page 201.
See “Server configuration—basic” on page 180.
See “System events reports” on page 135.
See “Server event detail” on page 139.

Server configuration—basic

Enforce Servers are configured from the System > Settings menu.

Detection servers are configured from each server's individual Configure Server screen.

To configure a server

1 Go to the Overview screen (System > Servers > Overview).
2 Click on the name of the server in the list.

That server's Server Detail screen is displayed. In the upper-left portion of a Server Detail screen are the following buttons:

■ Done. Click Done to return to the previous screen.
■ Configure. Click Configure to specify a basic configuration for this server.
■ Server Settings. Click Server Settings to specify advanced configuration parameters for this server. Use caution when modifying advanced server settings. It is recommended that you check with Symantec Support before changing any of the advanced settings.

See "Server configuration—advanced" on page 193.
See Symantec Data Loss Prevention online Help for information about advanced server configuration.

3 Click Configure or Server Settings to display a configuration screen for that type of server.

4 Specify or change settings on the screen as needed, and then click Save.

Click Cancel to return to the previous screen without changing any settings.

Note: A server must be recycled before new settings take effect.
See “Server controls” on page 178.

The Configure Server screen contains a General section for all detection servers that contains the following parameters:

- **Name**. The name you choose to give the server. This name appears in the Enforce Server administration console (System > Servers > Overview). The name is limited to 255 characters.

- **Host**. The host name or IP address of the system hosting the server. Host names must be fully qualified. If the host has more than one IP address, specify the address on which the detection server listens for connections to the Enforce Server.

- **Port**. The port number used by the detection server to communicate with the Enforce Server. The default is 8100.

For Single Tier Servers, the Host field on the Configure Server page is pre-populated with the local IP address 127.0.0.1. You cannot change this value.

The remaining portions of a Configure Server screen vary according to the type of server.

See “Network Monitor Server—basic configuration” on page 181.

See “Network Discover Server and Network Protect—basic configuration” on page 190.

See “Network Prevent for Email Server—basic configuration” on page 184.

See “Network Prevent for Web Server—basic configuration” on page 187.

See “Endpoint Server—basic configuration” on page 191.

See “Server Detail screen” on page 201.

See “Classification Server—basic configuration” on page 192.

See “Server Detail screen” on page 201.

---

**Network Monitor Server—basic configuration**

Detection servers are configured from each server's individual Configure Server screen. To display the Configure Server screen, go to the Overview screen (System > Servers > Overview) and click the name of the server in the list. That server's Server Detail screen appears. Click Configure to display the Configure Server screen.

A Network Monitor Server's Configure Server screen is divided into a general section and two tabs:

- **General** section. Use this section to specify the server's name, host, and port.
See “Server configuration—basic” on page 180.

- **Packet Capture** tab. Use this tab to configure network packet capture settings.
- **SMTP Copy Rule** tab. Use this tab to modify the source folder where the server retrieves SMTP message files.

The top portion of the **Packet Capture** defines general packet capture parameters. It provides the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Source Folder Override</strong></td>
<td>The source folder is the directory the server uses to buffer network streams before it processes them. The recommended setting is to leave the <strong>Source Folder Override</strong> field blank to accept the default. If you want to specify a custom buffer directory, type the full path to the directory.</td>
</tr>
<tr>
<td><strong>Archive Folder</strong></td>
<td>If you do not want to archive data, leave the <strong>Archive Folder</strong> field blank. To archive data, enter the full path to the directory you want to use for that purpose.</td>
</tr>
<tr>
<td><strong>Network Interfaces</strong></td>
<td>Select the network interface card(s) to use for monitoring. Note that to monitor a NIC WinPcap software must be installed on the Network Monitor Server. See the Symantec Data Loss Prevention Installation Guide for more information about NICs.</td>
</tr>
</tbody>
</table>

The **Protocol** section of the **Packet Capture** specifies the types of network traffic (by protocol) to capture. It also specifies any custom parameters to apply. This section lists the standard protocols that you have licensed with Symantec, and any custom TCP protocols you have added.

To monitor a particular protocol, check its box. When you initially configure a server, the settings for each selected protocol are inherited from the system-wide protocol settings. You configure these settings by going to **System > Settings > Protocol**. System-wide default settings are listed as **Standard**.

Consult Symantec Data Loss Prevention online Help for information about working with system-wide settings.
To override the inherited filtering settings for a protocol, click the name of the protocol. The following custom settings are available (some settings may not be available for some protocols):

- IP filter
- L7 sender filter
- L7 recipient filter
- Content filter
- Search Depth (packets)
- Sampling rate
- Maximum wait until written
- Maximum wait until dropped
- Maximum stream packets
- Minimum stream size
- Maximum stream size
- Segment Interval
- No traffic notification timeout (The maximum value for this setting is 360000 seconds.)

Use the **SMTP Copy Rule** to modify the source folder where this server retrieves SMTP message files. You can modify the Source Folder by entering the full path to a folder.

See “About Symantec Data Loss Prevention administration” on page 55.

See “About the System Overview screen” on page 198.

See “Server Detail screen” on page 201.

See “Server configuration—basic” on page 180.

See “Server controls” on page 178.

In addition to the settings available through the **Configure Server** screen, you can specify advanced settings for this server. To specify advanced configuration parameters, click **Server Settings** on the server's **Overview** screen. Use caution when modifying advanced server settings. Check with Symantec Support before you change any advanced setting.

See “Advanced server settings” on page 203.

See the Symantec Data Loss Prevention online Help for information about advanced server settings.
Network Prevent for Email Server—basic configuration

Detection servers are configured from each server's individual Configure Server screen. To display the Configure Server screen, go to the Overview screen (System > Servers > Overview) and click the name of the server in the list. That server's Server Detail screen appears. Click Configure to display the Configure Server screen.

A Network Prevent for Email Server Configure Server screen is divided into a General section and an Inline SMTP tab. The General section specifies the server's name, host, and port.

See “Server configuration—basic” on page 180.

Use the Inline SMTP tab to configure different Network Prevent for Email Server features:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trial Mode</td>
<td><strong>Trial mode</strong> lets you test prevention capabilities without blocking requests. When trial mode is selected, the server detects incidents and creates incident reports, but does not block any messages. Deselect this option to block those messages that are found to violate Symantec Data Loss Prevention policies.</td>
</tr>
<tr>
<td>Keystore Password</td>
<td>If you use TLS authentication in a forwarding mode configuration, enter the correct password for the keystore file.</td>
</tr>
<tr>
<td>Next Hop Configuration</td>
<td><strong>Select</strong> Reflect to operate Network Prevent for Email Server in reflecting mode. Select Forward to operate in forwarding mode.</td>
</tr>
</tbody>
</table>

**Note:** If you select Forward you must also select Enable MX Lookup or Disable MX Lookup to configure the method that is used to determine the next-hop MTA.
Field | Description
--- | ---
Enable MX Lookup | This option applies only to forwarding mode configurations.

Select **Enable MX Lookup** to perform a DNS query on a domain name to obtain the mail exchange (MX) records for the server. Network Prevent for Email Server uses the returned MX records to select the address of the next hop mail server.

If you select **Enable MX Lookup**, also add one or more domain names in the **Enter Domains** text box. For example:

*companyname.com*

Network Prevent for Email Server performs MX record queries for the domain names that you specify.

**Note:** You must include at least one valid entry in the **Enter Domains** text box to successfully configure forwarding mode behavior.
Disable MX Lookup

This field applies only to forwarding mode configurations.

Select Disable MX Lookup if you want to specify the exact or IP address of one or more next-hop MTAs. Network Prevent for Email Server uses the hostnames or addresses that you specify and does not perform an MX record lookup.

If you select Disable MX Lookup, also add one or more hostnames or IP addresses for next-hop MTAs in the Enter Hostnames text box. You can specify multiple entries by placing each entry on a separate line. For example:

smtp1.companyname.com
smtp2.companyname.com
smtp3.companyname.com

Network Prevent for Email Server always tries to use the first MTA that you specify in the list. If that MTA is not available, Network Prevent for Email Server tries the next available entry in the list.

Note: You must include at least one valid entry in the Enter Hostnames text box to successfully configure forwarding mode behavior.

See the Symantec Data Loss Prevention MTA Integration Guide for Network Prevent for Email for additional information about configuring Network Prevent for Email Server options.

See “About Symantec Data Loss Prevention administration” on page 55.

See “About the System Overview screen” on page 198.

See “Server Detail screen” on page 201.

See “Server configuration—basic” on page 180.

See “Server controls” on page 178.

In addition to the settings available through the Configure Server screen, you can specify advanced settings for this server. To specify advanced configuration parameters, click Server Settings on the server's Overview screen. Use caution
when modifying advanced server settings. Check with Symantec Support before you change any advanced setting.

See “Advanced server settings” on page 203.

See the Symantec Data Loss Prevention online Help for information about advanced server settings.

Network Prevent for Web Server—basic configuration

Detection servers are configured from each server’s individual Configure Server screen. To display the Configure Server screen, go to the Overview screen (System > Servers > Overview) and click the name of the server in the list. That server’s Server Detail screen appears. Click Configure to display the Configure Server screen.

A Network Prevent for Web Server Configure Server screen is divided into a general section and one tab:

- **General** section. This section specifies the server's name, host, and port.
  
  See “Server configuration—basic” on page 180.

- **ICAP** tab. This tab is for configuring Internet Content Adaptation Protocol (ICAP) capture.

Use the ICAP tab to configure Web-based network traffic. The ICAP tab is divided into four sections:

- The **Trial Mode** section enables you to test prevention without blocking traffic. When trial mode is selected, the server detects incidents and creates incident reports, but it does not block any traffic. This option enables you to test your policies without blocking traffic. Check the box to enable trial mode.

- The **Request Filtering** section configures traffic filtering criteria:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ignore Requests Smaller Than</td>
<td>Specify the minimum body size of HTTP requests to inspect on this server. The default value is 4096 bytes. HTTP requests with bodies smaller than this number are not inspected.</td>
</tr>
<tr>
<td>Ignore Requests without Attachments</td>
<td>Check this box to inspect only those HTTP requests that contain attachments.</td>
</tr>
</tbody>
</table>
Field | Description
--- | ---
Ignore Requests to Hosts or Domains | Enter the host names or domains whose requests should be filtered out (ignored). Enter one host or domain name per line.

Ignore Requests from User Agents | Enter the names of user agents whose requests should be filtered out (ignored). Enter one agent per line.

- **Response Filtering** section configures the filtering criteria to manage HTTP responses:

Field | Description
--- | ---
Ignore Responses Smaller Than | Enter the minimum body size of HTTP responses to inspect on this server. The default value is 4096 bytes. HTTP responses with bodies smaller than this number are not inspected.

Inspect Content Type | Specify the MIME content types that this server is to monitor. By default, this field contains content type values for standard Microsoft Office, PDF, and plain-text formats. You can add other MIME content type values. Enter separate content types on separate lines. For example, to inspect WordPerfect 5.1 files, enter `application/wordperfect5.1`.

Ignore Responses from Hosts or Domains | Enter the host names or domains whose responses are to be ignored. Enter one host or domain name per line.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ignore Responses to User Agents</td>
<td>Enter the names of user agents whose responses are to be ignored. Enter one user agent per line.</td>
</tr>
</tbody>
</table>

The **Connection** section configures settings for the ICAP connection between an HTTP proxy server and the Network Prevent for Web Server:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCP Port</td>
<td>Specify the TCP port number that this server is to use to listen to ICAP requests. The same value must be configured on the HTTP proxy sending ICAP requests to this server. The recommended value is 1344.</td>
</tr>
<tr>
<td>Maximum Number of Requests</td>
<td>Enter the maximum number of simultaneous ICAP request connections. The default is 25.</td>
</tr>
<tr>
<td>Maximum Number of Responses</td>
<td>Enter the maximum number of simultaneous ICAP response connections from the HTTP proxy or proxies that are allowed. The default is 25.</td>
</tr>
<tr>
<td>Connection Backlog</td>
<td>Enter the maximum number of waiting connections allowed. Each waiting connection means that a user waits at their browser. The minimum value is 1.</td>
</tr>
</tbody>
</table>

See “Configuring Network Prevent for Web Server” on page 1167.

See “About Symantec Data Loss Prevention administration” on page 55.

See “About the System Overview screen” on page 198.

See “Server Detail screen” on page 201.

See “Server configuration—basic” on page 180.

See “Server controls” on page 178.
In addition to the settings available through the **Configure Server** screen, you can specify advanced settings for this server. To specify advanced configuration parameters, click **Server Settings** on the server’s **Overview** screen. Use caution when modifying advanced server settings. Check with Symantec Support before you change any advanced setting.

See “**Advanced server settings**” on page 203.

See the Symantec Data Loss Prevention online Help for information about advanced server settings.

### Network Discover Server and Network Protect—basic configuration

Detection servers are configured from each server's individual **Configure Server** screen. To display the **Configure** screen for a server, go to the **Overview** screen (**System > Servers > Overview**) and click on the name of the server in the list. That server's **Server Detail** screen is displayed. Click **Configure**. The server's **Configure Server** screen is displayed.

See “**Modifying the Network Discover Server configuration**” on page 1185.

A Network Discover Server's **Configure Server** screen is divided into a general section and one tab:

- **General** section. This section is for specifying the server's name, host, and port.  
  See “**Server configuration—basic**” on page 180.

- **Discover** tab. This tab is for modifying the number of parallel scans that run on this Discover Server.  
  The maximum count can be increased at any time. After it is increased, any queued scans that are eligible to run on the Network Discover Server are started. The count can be decreased only if the Network Discover Server has no running scans. Before you reduce the count, pause, or stop, all scans running on the server.
  
  To view the scans running on Network Discover Servers, go to **Manage > Discover Scanning > Discover Targets**.

See “**About Symantec Data Loss Prevention administration**” on page 55.

See “**Server Detail screen**” on page 201.

See “**Server configuration—basic**” on page 180.

See “**Server controls**” on page 178.

In addition to the settings available through the **Configure Server** screen, you can also specify advanced settings for this server. To specify advanced configuration parameters, click **Server Settings** on the **Server Detail** screen. Use caution when
modifying advanced server settings. It is recommended that you check with Symantec Support before changing any of the advanced settings.

See “Advanced server settings” on page 203.

## Endpoint Server—basic configuration

Detection servers are configured from each server’s individual Configure Server screen. To display the Configure screen for a server, go to the Overview screen (System > Servers > Overview) and click the name of the server. The Server Detail screen for that server is displayed. Click Configure to display the Configure Server screen for that server.

See “Adding a detection server” on page 194.

The Configure Server screen for an Endpoint Server is divided into a general section and the following tabs:

- **General.** This section is for specifying the server name, host, and port. See “Server configuration—basic” on page 180.
- **Agent.** This section is for adding agent security certificates to the Endpoint Server. See “Adding agent configurations” on page 1406.

**Agent Listener.** Use this section to configure the Endpoint Server to listen for connections from Symantec DLP Agents:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bind address</td>
<td>Enter the IP address on which the Endpoint Server listens for communications from the Symantec DLP Agents. The default IP address is 0.0.0.0 which allows the Endpoint Server to listen on all host IP addresses.</td>
</tr>
<tr>
<td>Port</td>
<td>Enter the port over which the Endpoint Server listens for communications from the Symantec DLP Agents.</td>
</tr>
</tbody>
</table>

See “Configuring Endpoint Servers for SSL certificates” on page 191.

## Configuring Endpoint Servers for SSL certificates

Table 10-3 provides steps for loading SSL certificates into an Endpoint Server.

**Note:** These steps assume that you have generated the endpoint certificates and that the server *.jks files are available to the Enforce Server.
**Table 10-3** Instructions for loading SSL certificates into an Endpoint Server

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Go to the System &gt; Servers &gt; Overview screen.</td>
<td>The screen is available to administrative users in the Enforce Server administration console.</td>
</tr>
<tr>
<td>2</td>
<td>Select the Endpoint Server you want to configure.</td>
<td>Each Endpoint Server must be configured for SSL communications separately.</td>
</tr>
<tr>
<td>3</td>
<td>Click Configure.</td>
<td>An Endpoint Server cannot communicate with DLP Agents until it is configured with SSL certificates.</td>
</tr>
<tr>
<td>4</td>
<td>Select the Agent tab.</td>
<td>The Agent tab provides the interface for passing certificates to the Endpoint Server.</td>
</tr>
<tr>
<td>5</td>
<td>Specify the Security Configuration for the Endpoint Server.</td>
<td>Load the SSL certificates as follows:</td>
</tr>
<tr>
<td></td>
<td>■ Keystore File: Browse to and select the file eps_keystore.jks,</td>
<td>which is the CA-signed private key for the Endpoint Server.</td>
</tr>
<tr>
<td></td>
<td>■ Keystore Password: enter the password for the keystore.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Truststore File: Browse to and select the file</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Truststore Password: enter the truststore password.</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Click Save.</td>
<td>If you get an error message, you need to make sure you generated the certificates properly and added the files and passwords properly.</td>
</tr>
<tr>
<td>7</td>
<td>Restart the Endpoint Server.</td>
<td>Navigate to the System &gt; Servers &gt; Overview &gt; Server Detail screen. Click Recycle.</td>
</tr>
<tr>
<td>8</td>
<td>Click Done when the server has restarted.</td>
<td>Verify that the server restarts.</td>
</tr>
<tr>
<td>9</td>
<td>Install DLP Agents.</td>
<td></td>
</tr>
</tbody>
</table>

**Classification Server—basic configuration**

Detection servers are configured from each server’s individual Configure Server screen. To display the Configure Server screen, go to the Overview screen (System > Servers > Overview) and click the name of the server in the list. The Server Detail screen for that server appears. Click Configure to display the Configure Server screen.

The Configure Server screen for a Classification Server is divided into two sections:
General section. This section specifies the server name, host, and port that is used for communicating with the Enforce Server. See “Server configuration—basic” on page 180.

Classification section. This section specifies the connection properties that the Data Classification for Enterprise Vault filter uses to communicate with the Classification Server.

Use the fields of the Classification section to configure connection properties for the server:

- **Maximum number of sessions**: Enter the maximum number of concurrent sessions that the Classification Server can accept from Data Classification for Enterprise Vault filters. The default is 12. The maximum number of sessions that a Classification Server can support depends on the CPU and memory available to the server. See the Symantec Enterprise Vault Data Classification Services Implementation Guide for more information.

- **Session Timeout (in milliseconds)**: Enter the maximum number of milliseconds that a Data Classification for Enterprise Vault filter can remain idle before the Classification Server terminates the session. The default value is 30000 milliseconds.

- **Classification Service Port**: Specify the port number on which the Classification Server accepts connections from Data Classification for Enterprise Vault filters. The default port is 10080.

---

**Note:** The Classification Server is used only with the Symantec Enterprise Vault Data Classification solution, which is licensed separately from Symantec Data Loss Prevention. You must configure the Enterprise Vault Data Classification Services filter and Classification Server to communicate with one another. See the Symantec Enterprise Vault Data Classification Services Implementation Guide for more information.

---

Server configuration—advanced

Symantec Data Loss Prevention provides advanced server configuration settings for each detection server in your system.
Note: Check with Symantec Support before changing any advanced settings. If you make a mistake when changing advanced settings, you can severely degrade performance or even disable the server entirely.

To change an advanced configuration setting for a detection server

1. Go to System > Servers > Overview and click on the name of the detection server.
   That server's Server Detail screen appears.
2. Click Server Settings.
   The Advanced Server Settings screen appears.
   See Symantec Data Loss Prevention online Help for information about advanced server configuration.
   See “Advanced server settings” on page 203.
3. With the guidance of Symantec Support, modify the appropriate setting(s).
4. Click Save.
   Changes to settings on this screen normally do not take effect until you restart the server.
   See “Server configuration—basic” on page 180.

Adding a detection server

Add the detection servers that you want to your Symantec Data Loss Prevention system from the System > Servers > Overview screen.

You can add the following types of servers:

- Network Monitor Server, which monitors network traffic.
- Network Discover Server, which inspects stored data for policy violations.
- Network Prevent for Email Server, which prevents SMTP violations.
- Network Prevent for Web Server, which prevents ICAP proxy server violations such as FTP, HTTP, and HTTPS.
- Mobile Prevent for Web Server, which monitors and prevents HTTPS, HTTP, and FTP violations over mobile devices using a VPN.
- Endpoint Prevent, which controls Symantec DLP Agents that monitor and scan endpoints.
Classification Server, which analyzes emails sent from a Symantec Enterprise Vault filter and provides a classification result that Enterprise Vault can use to perform tagging, archival, and deletion as necessary.

Mobile Email Monitor Server, which monitors corporate emails sent through Microsoft Exchange ActiveSync and downloaded to mobile devices.

Single-Tier Server: By selecting the Single-Tier Server option, the detection servers that you have licensed are installed on the same host as the Enforce Server. The single-tier server performs detection for the following products (you must have a license for each): Network Monitor, Network Discover, Network Prevent for Email, Network Prevent for Web, and Endpoint Prevent.

To add a detection server

1. Go to the System Overview screen (System > Servers > Overview).
   See “About the System Overview screen” on page 198.

2. Click Add Server.
   The Add Server screen appears.

3. Select the type of server you want to install and click Next.
   The Configure Server screen for that detection server appears.

4. To perform the basic server configuration, use the Configure Server screen, then click Save when you are finished.
   See “Network Monitor Server—basic configuration” on page 181.
   See “Network Prevent for Email Server—basic configuration” on page 184.
   See “Network Prevent for Web Server—basic configuration” on page 187.
   See “Network Discover Server and Network Protect—basic configuration” on page 190.
   See “Adding and configuring the Mobile Email Monitor Server” on page 1560.
   See “Endpoint Server—basic configuration” on page 191.
   See “Classification Server—basic configuration” on page 192.
   For Single-Tier Servers, the Configure Server page displays a configuration tab for each of your licensed detection servers. See the basic configuration topics for each detection type you want to configure.

5. To return to the System Overview screen, click Done.
   Your new server is displayed in the Servers list with a status of Unknown.

6. Click on the server to display its Server Detail screen.
   See “Server Detail screen” on page 201.
7 Click [Recycle] to restart the server.

8 Click Done to return to the System Overview screen.

When the server is finished restarting, its status displays Running.

9 If necessary, click Server Settings on the Server Detail screen to perform Advanced Server configuration.

See “Advanced server settings” on page 203.

See Symantec Data Loss Prevention online Help for information about Advanced Server configuration.

See “Server configuration—basic” on page 180.

Removing a server

See the appropriate Symantec Data Loss Prevention Installation Guide for information about uninstalling Symantec Data Loss Prevention from a server.

An Enforce Server administration console lists the detection servers registered with it on the System > Overview screen. If Symantec Data Loss Prevention is uninstalled from a detection server, or that server is stopped or disconnected from the network, its status is shown as Unknown on the console.

A detection server can be removed (de-registered) from an Enforce Server administration console. When a detection server is removed from an Enforce Server, its Symantec Data Loss Prevention services continue to operate. This means that even though a detection server is de-registered from Enforce, it continues to function unless some action is taken to halt it. In other words, even though it is removed from an Enforce Server administration console, a detection server continues to operate. Incidents it detects are stored on the detection server. If a detection server is re-registered with an Enforce Server, incidents detected and stored are then forwarded to Enforce.

To remove (de-register) a detection server from Enforce

1 Go to System > Overview.

See “About the System Overview screen” on page 198.

2 In the Servers section of the screen, click the red X on a server's status line to remove it from this Enforce Server administration console.

See “Server controls” on page 178.

3 Click OK to confirm.

The server's status line is removed from the System Overview list.
Importing SSL certificates to Enforce or Discover servers

You can import SSL certificates to the Java trusted keystore on the Enforce or Discover servers. The SSL certificate can be self-signed (server) or issued by a well-known certificate authority (CA).

You may need to import an SSL certificate to make secure connections to external servers such as Active Directory (AD). If a recognized authority has signed the certificate of the external server, the certificate is automatically added to the Enforce Server. If the server certificate is self-signed, you must manually import it to the the Enforce or Discover Servers.

**Table 10-4** Importing an SSL certificate to Enforce or Discover

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Copy the certificate file you want to import to the Enforce Server or Discover Server computer.</td>
</tr>
<tr>
<td>2</td>
<td>Change directory to <code>c:\SymantecDLP\jre\bin</code> on the Enforce Server or Discover Server computer.</td>
</tr>
</tbody>
</table>
| 3    | Execute the **keytool** utility with the `-importcert` option to import the public key certificate to the Enforce Server or Discover Server keystore:  
   ```
   keytool -importcert -alias new_endpointgroup_alias -keystore ..\lib\security\cacerts -file my-domaincontroller.crt
   ```
   In this example command, `new_endpointgroup_alias` is a new alias to assign to the imported certificate and `my-domaincontroller.crt` is the path to your certificate. |
| 4    | When you are prompted, enter the password for the keystore.  
   By default, the password is **changeit**. If you want you can change the password when prompted.  
   **To change the password,** use:  
   ```
   keytool -storepassword -alias new_endpointgroup_alias -keystore ..\lib\security\cacerts
   ``` |
| 5    | Answer **Yes** when you are asked if you trust this certificate. |
| 6    | Restart the Enforce Server or Discover Server. |

See “Configuring directory server connections” on page 127.
About the System Overview screen

The System Overview screen is reached by System > Servers > Overview. This screen provides a quick snapshot of system status. It lists information about the Enforce Server, and each registered detection server.

The System Overview screen provides the following features:

- The Add Server button is used to register a detection server. When this screen is first viewed after installation, only the Enforce Server is listed. You must register your various detection servers with the Add Server button. After you register detection servers, they are listed in the Servers section of the screen. See “Adding a detection server” on page 194.

- The Upgrade button is for upgrading Symantec Data Loss Prevention to a newer version.
  See “About system upgrades” on page 174.
  See also the appropriate Symantec Data Loss Prevention Upgrade Guide.

- The Servers section of the screen displays summary information about each server's status. It can also be use to remove (de-register) a server.
  See “Server status overview” on page 198.

- The Recent Error and Warning Events section shows the last five events of error or warning severity for any of the servers listed in the Servers section.
  See “Recent error and warning events list” on page 200.

- The License section of the screen lists the Symantec Data Loss Prevention individual products that you are licensed to use.
  See “Server configuration—basic” on page 180.
  See “About Symantec Data Loss Prevention administration” on page 55.

Server status overview

The Server section of the System Overview screen is reached by System > Servers > Overview. This section of the screen provides a quick overview of system status.

Table 10-5 Server statuses

<table>
<thead>
<tr>
<th>Icon</th>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![starting icon]</td>
<td>Starting</td>
<td>The server is starting up.</td>
</tr>
</tbody>
</table>
Table 10-5  Server statuses (continued)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Running Icon]</td>
<td>Running</td>
<td>The server is running normally without errors.</td>
</tr>
<tr>
<td>![Running Selected Icon]</td>
<td>Running Selected</td>
<td>Some Symantec Data Loss Prevention processes on the server are stopped or have errors. To see the statuses of individual processes, you must first enable <strong>Advanced Process Control</strong> on the <strong>System Settings</strong> screen. See &quot;Enabling Advanced Process Control&quot; on page 177.</td>
</tr>
<tr>
<td>![Stopping Icon]</td>
<td>Stopping</td>
<td>The server is in the process of stopping Symantec Data Loss Prevention services. See &quot;About Data Loss Prevention services&quot; on page 76.</td>
</tr>
<tr>
<td>![Stopped Icon]</td>
<td>Stopped</td>
<td>All Symantec Data Loss Prevention processes are stopped.</td>
</tr>
<tr>
<td>![Unknown Icon]</td>
<td>Unknown</td>
<td>The server is experiencing one of the following errors:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ The Enforce Server is not reachable from server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Symantec Data Loss Prevention is not installed on the server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ A license key has not been configured for the Enforce Server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ There is a problem with Symantec Data Loss Prevention account permissions in Windows.</td>
</tr>
</tbody>
</table>

For each server, the following additional information appears. You can also click on any server name to display the **Server Detail** screen for that server.

Table 10-6  Server status additional information

<table>
<thead>
<tr>
<th>Column name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Messages (Last 10 sec)</td>
<td>The number of messages processed in the last 10 seconds</td>
</tr>
<tr>
<td>Messages (Today)</td>
<td>The number of messages processed since 12 am today</td>
</tr>
<tr>
<td>Incidents (Today)</td>
<td>The number of incidents processed since 12 am today For Endpoint Servers, the Messages and Incidents are not aligned. This is because messages are being processed at the Endpoint and not the Endpoint Server. However, the incident count still increases.</td>
</tr>
</tbody>
</table>
Table 10-6  Server status additional information (continued)

<table>
<thead>
<tr>
<th>Column name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident Queue</td>
<td>For the Enforce Server, this is the number of incidents that are in the database, but do not yet have an assigned status. This number is updated whenever this screen is generated. For the other types of servers, this is the number of incidents that have not yet been written to the Enforce Server. This number is updated approximately every 30 seconds. If the server is shut down, this number is the last number updated by the server. Presumably the incidents are still in the incidents folder.</td>
</tr>
<tr>
<td>Message Wait Time</td>
<td>The amount of time it takes to process a message after it enters the system. This data applies to the last message processed. If the server that processed the last message is disconnected, this is N/A.</td>
</tr>
</tbody>
</table>

To see details about a server
- Click on any server name to see additional details regarding that server.

See “Server Detail screen” on page 201.

To remove a server from an Enforce Server
- Click the red X for that server, and then confirm your decision.

Note: Removing (de-registering) a server only disconnects it from this Enforce Server server, it does not stop the detection server from operating.

See “Removing a server” on page 196.

Recent error and warning events list

The Recent Error and Warning Events section of the System Overview screen is reached by System > Servers > Overview. This section of the screen shows the last five events of either error or warning severity for any of the servers listed in the Servers section.
Table 10-7  Recent error and warning events information

<table>
<thead>
<tr>
<th>Column name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>![Warning] (The yellow triangle indicates a warning, the red circle indicates an error.)</td>
</tr>
<tr>
<td>Time</td>
<td>The date and time when the event occurred.</td>
</tr>
<tr>
<td>Server</td>
<td>The name of the server on which the event occurred.</td>
</tr>
<tr>
<td>Host</td>
<td>The IP address or name of the machine where the server resides. The server and host names may be the same.</td>
</tr>
<tr>
<td>Code</td>
<td>The system event code. The Message column provides the code text. Event lists can be filtered by code number.</td>
</tr>
<tr>
<td>Message</td>
<td>A summary of the error or warning message that is associated with this event code.</td>
</tr>
</tbody>
</table>

- To display a list of all error and warning events, click **Show all**.
- To display the **Event Detail** screen for additional information about that particular event, click an event.

See “About the System Overview screen” on page 198.

See “System events reports” on page 135.

See “Server event detail” on page 139.

### Server Detail screen

The **Server Detail** screen (located by clicking an Endpoint Server on the **System > Servers > Overview** screen) provides detailed information about a single selected server. The **Server Detail** screen is also used to control and configure a server.

**To display the Server Detail screen for a particular server**

1. Navigate to the **System > Servers > Overview** screen.
2. Click the detection server name in the **Server Overview** list.

See “About the System Overview screen” on page 198.

The **Server Detail** screen is divided into sections. The sections listed below display all server types. The system displays sections based on the type of detection server.
### Table 10-8  Server Detail screen display information

<table>
<thead>
<tr>
<th>Server Detail display sections</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>The <strong>General</strong> section identifies the server, displays system status and statistics, and provides controls for starting and stopping the server and its processes. See “Server controls” on page 178.</td>
</tr>
<tr>
<td>Configuration</td>
<td>The <strong>Configuration</strong> section displays the Channels, Policy Groups, Agent Configuration, User Device, and Configuration Status for the detection server.</td>
</tr>
<tr>
<td>All Agents</td>
<td>The <strong>All Agents</strong> section displays a summary of all agents that are assigned to the Endpoint Server. Current agents display in the <strong>12.5 and Later</strong> column and older agents display in the <strong>12.0.x and Earlier</strong> column. Click the number next to an agent status to view agent details on the System &gt; Agents &gt; Overview &gt; Summary Reports screen. <strong>Note</strong>: The system only displays the Agent Summary section for an Endpoint Server.</td>
</tr>
<tr>
<td>Recent Error and Warning Events</td>
<td>The <strong>Recent Error and Warning Events</strong> section displays the five most recent Warning or Severe events that have occurred on this server. Click on an event to show event details. Click <strong>show all</strong> to display all error and warning events. See “About system events” on page 134.</td>
</tr>
<tr>
<td>All Recent Events</td>
<td>The <strong>All Recent Events</strong> section displays all events of all severities that have occurred on this server during the past 24 hours. Click on an event to show event details. Click <strong>show all</strong> to display all detection server events.</td>
</tr>
<tr>
<td>Deployed Data Profiles</td>
<td>The Deployed Data Profile section lists any <strong>Exact Data</strong> or <strong>Document Profiles</strong> you have deployed to the detection server. The system displays the version of the index in the profile. See “Data Profiles” on page 291.</td>
</tr>
</tbody>
</table>

See “About the System Overview screen” on page 198.

See “Server configuration—basic” on page 180.

See “Server controls” on page 178.
Advanced server settings

Use the **Server Settings** tab of a detection server’s **System > Servers > Overview > Server Detail** screen to modify the settings on that server.

Use caution when modifying these settings on a server. Contact Symantec Support before changing any of the settings on this screen. Changes to these settings normally do not take effect until after the server has been restarted.

You cannot change settings for the Enforce Server from the **Server Detail** screen. The **Server Settings** tab only displays for detection servers.

**Note:** If you change advanced server settings to Endpoint Servers in a load-balanced environment, you must apply the same changes to all Endpoint Servers in the load-balanced environment.

### Table 10-9  Detection server advanced settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>
| BoxMonitor.Channels| Varies  | The values are case-sensitive and comma-separated if multiple.  
Although any mix of them can be configured, the following are the officially supported configurations:  
- Network Monitor Server: Packet Capture, Copy Rule  
- Discover Server: Discover  
- Endpoint Server: Endpoint  
- Network Prevent for Email: Inline SMTP  
- Network Prevent for Web: ICAP  
- Mobile Email Monitor: ICAP  
- Classification Server: Classification |
<table>
<thead>
<tr>
<th>Setting</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BoxMonitor.DetectionServerDatabase</td>
<td>on</td>
<td>Enables the BoxMonitor process to start the Automated Incident Remediation Tracking database on the Detection Server. If you set this to off, you must start the remediation tracking database manually.</td>
</tr>
<tr>
<td>BoxMonitor.DetectionServerDatabaseMemory</td>
<td>-Xrs -Xms300M -Xmx1024M</td>
<td>Any combination of JVM memory flags can be used.</td>
</tr>
<tr>
<td>BoxMonitor.DiskUsageError</td>
<td>90</td>
<td>The amount of disk space filled (as a percentage) that will trigger a severe system event. For instance, if Symantec Data Loss Prevention is installed on the C drive and this value is 90, then the detection server creates a severe system event when the C drive usage is above 90%.</td>
</tr>
<tr>
<td>BoxMonitor.DiskUsageWarning</td>
<td>80</td>
<td>The amount of disk space filled (as a percentage) that will trigger a warning system event. For instance, if Symantec Data Loss Prevention is installed on the C drive and this value is 80, then the detection server generates a warning system event when the C drive usage is above 80%.</td>
</tr>
<tr>
<td>BoxMonitor.EndpointServer</td>
<td>on</td>
<td>Enables the Endpoint Server.</td>
</tr>
<tr>
<td>BoxMonitor.EndpointServerMemory</td>
<td>-Xrs -Xms300m -Xmx1024m</td>
<td>Any combination of JVM memory flags can be used. For example: -Xrs -Xms300M -Xmx1024m.</td>
</tr>
<tr>
<td>BoxMonitor.FileReader</td>
<td>on</td>
<td>If off, the BoxMonitor cannot start the FileReader, although it can still be started manually.</td>
</tr>
<tr>
<td>Setting</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>---------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>BoxMonitor.HeartbeatGapBeforeRestart</td>
<td>960000</td>
<td>The time interval (in milliseconds) that the BoxMonitor waits for a monitor process (for example, FileReader, IncidentWriter) to report the heartbeat. If the heartbeat is not received within this time interval the BoxMonitor restarts the process.</td>
</tr>
<tr>
<td>BoxMonitor.IncidentWriter</td>
<td>on</td>
<td>If off, the BoxMonitor cannot start the IncidentWriter in the two-tier mode, although it can still be started manually. This setting has no effect in the single-tier mode.</td>
</tr>
<tr>
<td>BoxMonitor.IncidentWriterMemory</td>
<td></td>
<td>IncidentWriter JVM command-line arguments. For example: <code>-Xrs</code></td>
</tr>
<tr>
<td>BoxMonitor.InitialRestartWaitTime</td>
<td>5000</td>
<td></td>
</tr>
<tr>
<td>BoxMonitor.MaxRestartCount</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>BoxMonitor.MaxRestartCountDuringStartup</td>
<td>5</td>
<td>The maximum times that the monitor server will attempt to restart on its own.</td>
</tr>
<tr>
<td>BoxMonitor.PacketCapture</td>
<td>on</td>
<td>If off, the BoxMonitor cannot start PacketCapture, although it can still be started manually. The PacketCapture channel must be enabled for this setting to work.</td>
</tr>
<tr>
<td>BoxMonitor.PacketCaptureDirectives</td>
<td></td>
<td>PacketCapture command line parameters (in Java). For example: <code>-Xrs</code></td>
</tr>
<tr>
<td>BoxMonitor.ProcessLaunchTimeout</td>
<td>30000</td>
<td>The time interval (in milliseconds) for a monitor process (e.g. FileReader) to start.</td>
</tr>
<tr>
<td>BoxMonitor.ProcessShutdownTimeout</td>
<td>45000</td>
<td>The time interval (in milliseconds) allotted to each monitor process to shut down gracefully. If the process is still running after this time the BoxMonitor attempts to kill the process.</td>
</tr>
</tbody>
</table>
### Table 10-9  Detection server advanced settings (continued)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BoxMonitor.RequestProcessor</td>
<td>on</td>
<td>If off, the BoxMonitor cannot start the RequestProcessor; although, it can still be started manually. The Inline SMTP channel must be enabled for this setting to work.</td>
</tr>
<tr>
<td>BoxMonitor.RequestProcessorMemory</td>
<td></td>
<td>Any combination of JVM memory flags can be used. For example: -Xrs -Xms300M -Xmx1300M</td>
</tr>
<tr>
<td>BoxMonitor.RmiConnectionTimeout</td>
<td>15000</td>
<td>The time interval (in milliseconds) allowed to establish connection to the RMI object.</td>
</tr>
<tr>
<td>BoxMonitor.RmiRegistryPort</td>
<td>37329</td>
<td>The TCP port on which the BoxMonitor starts the RMI registry.</td>
</tr>
<tr>
<td>BoxMonitor.StatisticsUpdatePeriod</td>
<td>10000</td>
<td>The monitor statistics are updated after this time interval (in milliseconds).</td>
</tr>
<tr>
<td>Classification.BindAddress</td>
<td>0.0.0.0</td>
<td>The IP address on which the Classification Server accepts messages for detection. By default, the Classification Server listens on all interfaces (0.0.0.0). If you have a multi-homed server computer and you want to limit classification requests to a specific network interface, enter the IP address of that interface in this field.</td>
</tr>
<tr>
<td>Classification.MaxMemory</td>
<td>120M</td>
<td>The maximum amount of memory that the Classification Server allocates. After this limit is reached, any additional requests to classify Exchange messages are spooled to disk until memory is freed.</td>
</tr>
<tr>
<td>Classification.SessionReapInterval</td>
<td>20000</td>
<td>The time interval (in milliseconds) after which the Classification Server purges stale sessions.</td>
</tr>
<tr>
<td>Setting</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>---------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Classification.WebServiceLogRententionDays</td>
<td>7</td>
<td>The number of days to retain the Classification Server web service request log. These log files are stored in c:\SymantecDLP\Protect\logs\jetty (Windows) or /var/log/SymantecDLP/logs/jetty (Linux).</td>
</tr>
<tr>
<td>ContentExtraction.EnableMetaData</td>
<td>off</td>
<td>Allows detection on file metadata. If the setting is turned on, you can detect metadata for Microsoft Office and PDF files. For Microsoft Office files, OLE metadata is supported, which includes the fields Title, Subject, Author, and Keywords. For PDF files, only Document Information Dictionary metadata is supported, which includes fields such as Author, Title, Subject, Creation, and Update dates. Extensible Metadata Platform (XMP) content is not detected. Note that enabling this metadata detection option can cause false positives.</td>
</tr>
<tr>
<td>ContentExtraction.LongContentSize</td>
<td>1M</td>
<td>If the message component exceeds this size (in bytes) then the ContentExtraction.LongTimeout is used instead of ContentExtraction.ShortTimeout.</td>
</tr>
<tr>
<td>Setting</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>---------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ContentExtraction.LongTimeout</td>
<td>Varies</td>
<td>The default value for this setting varies depending on detection server type (60,000 or 120,000). The time interval (in milliseconds) given to the ContentExtractor to process a document larger than ContentExtraction.LongContentSize. If the document cannot be processed within the specified time it's reported as unprocessed. This value should be greater than ContentExtraction.ShortTimeout and less than ContentExtraction.RunawayTimeout.</td>
</tr>
<tr>
<td>ContentExtraction.MarkupAsText</td>
<td>off</td>
<td>Bypasses Content Extraction for files that are determined to be XML or HTML. This should be used in cases such as web pages containing data in the header block or script blocks. Default is off.</td>
</tr>
<tr>
<td>ContentExtraction.MaxContentSize</td>
<td>30M</td>
<td>The maximum size (in MB) of the document that can be processed by the ContentExtractor.</td>
</tr>
<tr>
<td>ContentExtraction.RunawayTimeout</td>
<td>300,000</td>
<td>The time interval (in milliseconds) given to the ContentExtractor to finish processing of any document. If the ContentExtractor does not finish processing some document within this time it will be considered unstable and it will be restarted. This value should be significantly greater than ContentExtraction.LongTimeout.</td>
</tr>
</tbody>
</table>
### Table 10-9 \ Detection server advanced settings (continued)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ContentExtraction.ShortTimeout</td>
<td>30,000</td>
<td>The time interval (in milliseconds) given to the ContentExtractor to process a document smaller than ContentExtraction.LongContentSize. If the document cannot be processed within the specified time it is reported as unprocessed. This value should be less than ContentExtraction.LongTimeout.</td>
</tr>
</tbody>
</table>
| ContentExtraction.TrackedChanges | off     | Allows detection of content that has changed over time (Track Changes content) in Microsoft Office documents. 

**Note:** Using the foregoing option might reduce the accuracy rate for IDM and data identifiers. The default is set to off (disallow).

To index content that has changed over time, set ContentExtraction.TrackedChanges=on in file Protect\config\Indexer.properties. The default and recommended setting is ContentExtraction.TrackedChanges=off. |
<table>
<thead>
<tr>
<th>Setting</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>
| DDM.MaxBinMatchSize                    | 300,000,000 | The maximum size (in bytes) used to generate the MD5 hash for an exact binary match in an IDM. This setting should not be changed. The following conditions must be matched for IDM to work correctly:  
  ■ This setting must be exactly identical to the max_bin_match_size setting on the Enforce Server in file indexer.properties.  
  ■ This setting must be smaller or equal to the FileReader.FileMaxSize value.  
  ■ This setting must be smaller or equal to the ContentExtraction.MaxContentSize value on the Enforce Server in file indexer.properties.  
  Note: Changing the first or third item in the list requires re-indexing all IDM files. |
<p>| DDM.UseJavaMD5                         | false     | Setting this flag to true makes the indexer/detection use the default Java MD5. False uses a faster MD5 library. In general, this setting should not be changed. If it is it must match the setting in the Indexer.properties file. |
| Detection.EncodingGuessingDefaultEncoding | ISO-8859-1 | Specifies the backup encoding assumed for a byte stream.                                                                                                                                                 |
| Detection.EncodingGuessingEnabled      | on        | Designates whether the encoding of unknown byte streams should be guessed.                                                                                                                              |
| Detection.EncodingGuessingMinimumConfidence | 50         | Specifies the confidence level required for guessing the encoding of unknown byte streams.                                                                                                                |</p>
<table>
<thead>
<tr>
<th>Setting</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Detection.MessageTimeout ReportIntervalInSeconds</td>
<td>3600</td>
<td>Number of seconds between each System Event published to display the number of messages that have timed out recently. These System Events are scheduled to be published at a fixed rate, but will be skipped if no messages have timed out in that period.</td>
</tr>
<tr>
<td>DI.MaxViolations</td>
<td>100</td>
<td>Specifies the maximum number of violations allowed with data identifiers.</td>
</tr>
<tr>
<td>Discover.CountAllFilteredItems</td>
<td>false</td>
<td>Provides more accurate scan statistics by counting the items in folders skipped because of filtering. To count all items, set this setting to true.</td>
</tr>
<tr>
<td>Discover.Exchange.FollowRedirects</td>
<td>true</td>
<td>Specifies whether to follow redirects. Symantec Data Loss Prevention follows redirects only from the public root folder.</td>
</tr>
<tr>
<td>Discover.Exchange.ScanHiddenItems</td>
<td>false</td>
<td>Scan hidden items in Exchange repositories, when set to true.</td>
</tr>
<tr>
<td>Discover.Exchange.UseSecureHttpConnections</td>
<td>true</td>
<td>Specifies whether connections to Exchange repositories and Active Directory are secure when using the Exchange Web Services crawler.</td>
</tr>
<tr>
<td>Discover.IgnorePstMessageClasses</td>
<td>IPM.Appointment,IPM.Contact, IPM.Task,REPORT.IPM.Note.DR, REPORT.IPM.Note.IPNRN</td>
<td>This setting specifies a comma-separated list of .pst message classes. All items in a .pst file that have a message class in the list will be ignored (no attempt will be made to extract the .pst item). This setting is case-sensitive.</td>
</tr>
<tr>
<td>Setting</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>---------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Discover.IncludePstMessageClasses</td>
<td>IPM.Note</td>
<td>This setting specifies a comma-separated list of .pst message classes. All items in a .pst file that have a message class in the list will be included.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>When both the include setting and the ignore setting are defined, Discover.IncludePstMessageClasses takes precedence.</td>
</tr>
<tr>
<td>Discover.PollInterval</td>
<td>10000</td>
<td>Specifies the time interval (in milliseconds) at which Enforce retrieves data from the Discover monitor while scanning.</td>
</tr>
<tr>
<td>Discover.Sharepoint.FetchACL</td>
<td>true</td>
<td>Turns off ACL fetching for integrated SharePoint scans. The default value is true (on).</td>
</tr>
<tr>
<td>Discover.ValidateSSLCertificates</td>
<td>false</td>
<td>Set to true to enable validation of the SSL certificates for the HTTPS connections for SharePoint and Exchange targets. When validation is enabled, scanning SharePoint or Exchange servers using self-signed or untrusted certificates fails. If the SharePoint web application or Exchange server is signed by a certificate issued by a certificate authority (CA), then the server certificate or the server CA certificate must reside in the Java trusted keystore used by the Discover Server. If the certificate is not in the keystore, you must import it manually using the keytool utility. See “Importing SSL certificates to Enforce or Discover servers” on page 197.</td>
</tr>
<tr>
<td>Setting</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>---------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>EDM.MatchCountVariant</td>
<td>2</td>
<td>Specifies how matches are counted.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ 1 - Counts the total number of token sets matched.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ 2 - Counts the number of unique token sets matched (default).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See &quot;Configuring Advanced Server Settings for EDM policies&quot; on page 400.</td>
</tr>
<tr>
<td>EDM.MaximumNumberOfMatchesToReturn</td>
<td>100</td>
<td>Defines a top limit on the number of matches returned from each RAM index search.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See &quot;Configuring Advanced Server Settings for EDM policies&quot; on page 400.</td>
</tr>
<tr>
<td>EDM.RunProximityLogic</td>
<td>true</td>
<td>If true, runs the token proximity check.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See &quot;Configuring Advanced Server Settings for EDM policies&quot; on page 400.</td>
</tr>
<tr>
<td>EDM.SimpleTextProximityRadius</td>
<td>35</td>
<td>Number of tokens that are evaluated together when the proximity check is enabled.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See &quot;Configuring Advanced Server Settings for EDM policies&quot; on page 400.</td>
</tr>
<tr>
<td>EDM.TokenVerifierEnabled</td>
<td>false</td>
<td>Reserved for future use. Setting to true has no effect.</td>
</tr>
<tr>
<td>EndpointCommunications.</td>
<td>0</td>
<td>If enabled, limits the transfer rate of all inbound traffic in kilobits per second.</td>
</tr>
<tr>
<td>AllConnInboundDataThrottleInKBPS</td>
<td></td>
<td>Default is disabled. Changes to this setting apply to all new connections. Changes do not affect existing connections.</td>
</tr>
</tbody>
</table>


<table>
<thead>
<tr>
<th>Setting</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>
| EndpointCommunications.                      |         | **If enabled, limits the transfer rate of all inbound traffic in kilobits per second.**  
| AllConnOutboundDataThrottleInKBPS           | 0       | Default is disabled. Changes to this setting apply to all new connections. Changes do not affect existing connections.                      |
| EndpointCommunications.                      |         | **Maximum time for server to wait for each round trip during application handshake communications before closing the server-to-agent connection.**  
| ApplicationHandshakeTimeoutInSeconds         | 60      | Applies to the duration of time between when the agent accepts the TCP connection and when the agent receives the handshake message. This duration includes the SSL handshake and the agent receiving the HTTP headers. If the process exceeds the specified duration, the connection closes. Changes to this setting apply to all new connections. Changes do not affect existing connections. |
| EndpointCommunications.MaxActiveAgentsPerServer | 90000   | Sets the maximum number of agents associated with a given server at any moment in time. This setting is implemented after the next Endpoint Server restart. |
| EndpointCommunications.                      |         | **Sets the maximum number of agents that will be associated with a given group of servers behind the same local load balancer at any moment in time. Used for maximum sizes of caches for internal endpoint features.**  
<p>| MaxActiveAgentsPerServerGroup                | 150000  | This setting is implemented after the next Endpoint Server restart.                                                                        |</p>
<table>
<thead>
<tr>
<th>Setting</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EndpointCommunications.MaxConcurrentConnections</td>
<td>90000</td>
<td>Sets the maximum number of simultaneous connections to allow. Changes to this setting apply to all new connections. Changes do not affect existing connections.</td>
</tr>
<tr>
<td>EndpointCommunications.MaxConnectionLifetimeInSeconds</td>
<td>86400 (1 day)</td>
<td>Sets the maximum time to allow a connection to remain open. Do not set connections to remain open indefinitely. Connections that close ensure that SSL session keys are frequently updated to improve security. This timeout only applies during the normal operation phase of a connection, after the SSL handshake and application handshake phases of a connection. This setting is implemented immediately to all connections.</td>
</tr>
<tr>
<td>EndpointCommunications.ShutdownTimeoutInMillis</td>
<td>5000 (5 seconds)</td>
<td>Sets the maximum time to wait to gracefully close connections during shutdown before forcing connections to close. This setting is implemented immediately to all connections.</td>
</tr>
<tr>
<td>EndpointCommunications.SSLCipherSuites</td>
<td>TLS_RSA_WITH_AES_128_CBC_SHA</td>
<td>Lists the allowed SSL cipher suites. Enter multiple entries, separated by commas. Changes to this setting apply to all new connections. Changes do not affect existing connections.</td>
</tr>
<tr>
<td>EndpointCommunications.SSLSessionCacheTimeoutInSeconds</td>
<td>86400</td>
<td>Sets the maximum SSL session entry lifetime in the SSL session cache. The default settings equals one day. This setting is implemented after the next Endpoint Server restart.</td>
</tr>
<tr>
<td>Setting</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>---------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>EndpointMessageStatistics.MaxFileDetectionCount</td>
<td>100</td>
<td>The maximum number of times a valid file will be scanned. The file must not cause an incident. After exceeding this number, a system event is generated recommending that the file be filtered out.</td>
</tr>
<tr>
<td>EndpointMessageStatistics.MaxFolderDetectionCount</td>
<td>1800</td>
<td>The maximum number of times a valid folder will be scanned. The folder must not cause an incident. After exceeding this number, a system event is generated recommending that the file be filtered out.</td>
</tr>
<tr>
<td>EndpointMessageStatistics.MaxMessageCount</td>
<td>2000</td>
<td>The maximum number of times a valid message will be scanned. The message must not cause an incident. After exceeding this number, a system event is generated recommending that the file be filtered out.</td>
</tr>
<tr>
<td>EndpointMessageStatistics.MaxSetSize</td>
<td>3</td>
<td>The maximum list of hosts displayed from where valid files, folders, and messages come. When a system event for EndpointMessageStatistics.MaxFileDetectionCount, EndpointMessageStatistics.MaxFolderDetectionCount, or EndpointMessageStatistics.MaxMessageCount is generated, Symantec Data Loss Prevention lists the host machines where these system events were generated. This setting limits the number of hosts displayed in the list.</td>
</tr>
<tr>
<td>EndpointServer.Discover.ScanStatusBatchInterval</td>
<td>60000</td>
<td>The interval of time in milliseconds the Endpoint Server accumulates Endpoint Discover scan statuses before sending them to the Endpoint Server as a batch.</td>
</tr>
<tr>
<td>Setting</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------------------------</td>
<td>---------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| EndpointServer.Discover.ScanStatusBatchSize                  | 1000    | The number of scan statuses the Aggregator accumulates before sending them to the Enforce Server as a batch. The Endpoint Server forwards a batch of statuses to the Enforce Server when the status count reaches the configured value. The batch is forwarded to the Enforce Server when any of the thresholds for the following settings are met:  
  ■ EndpointServer.Discover.ScanStatusBatchInterval  
  ■ EndpointServer.Discover.ScanStatusBatchSize                                                                                   |
<p>| EndpointServer.EndpointSystemEventQueueSize                 | 20000   | The maximum number of system events that can be stored in the endpoint agent's queue to be sent to the Endpoint Server. If the database connection is lost or some other occurrence results in a massive number of system events, any additional system events that occur after this number is reached are discarded. This value can be adjusted according to memory requirements.                                                                                     |
| EndpointServer.MaxPercentageMemToStoreEndpointFiles         | 60      | The maximum amount (in percentage) of memory to use to store shadow cache files.                                                                                                                                                                                                                                                          |
| EndpointServer.MaxTimeToKeepEndpointFilesOpen               | 20000   | The time interval (in minutes) that the endpoint file is kept open or the file size can exceed the EndpointServer.MaxEndpointFileSize setting whichever occurs first.                                                                                                                                                                             |
| EndpointServer.MaxTimeToWaitForWriter                       | 1000    | The maximum time (in milliseconds) that the agent will wait to connect to the server.                                                                                                                                                                                                                                                   |
| EndpointServer.NoOfRecievers                                | 15      | The number of endpoint shadow cache file receivers.                                                                                                                                                                                                                                                                                       |</p>
<table>
<thead>
<tr>
<th>Setting</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EndpointServer.NoOfWriters</td>
<td>10</td>
<td>The number of endpoint shadow cache file writers.</td>
</tr>
<tr>
<td>FileReader.MaxFileSize</td>
<td>30M</td>
<td>The maximum size (in MB) of a message to be processed. Larger messages are truncated to this size.</td>
</tr>
<tr>
<td>FileReader.MaxFileSystemCrawlerMemory</td>
<td>30M</td>
<td>The maximum memory that is allocated for the File System Crawler. If this value is less than FileReader.MaxFileSize, then the greater of the two values is assigned.</td>
</tr>
<tr>
<td>FileReader.MaxReadGap</td>
<td>15</td>
<td>The time that a child process can have data but not have read anything before it stops sending heartbeats.</td>
</tr>
<tr>
<td>FileReader.ScheduledInterval</td>
<td>1000</td>
<td>The time interval (in milliseconds) between drop folder checks by the filereader. This affects Copy Rule, Packet Capture, and File System channels only.</td>
</tr>
<tr>
<td>FileReader.TempDirectory</td>
<td>Path to a secure directory as specified in the filereader.temp.io.dir attribute in the FileReader.properties configuration file.</td>
<td>A secure directory on the detection server in which to store temporary files for the File reader.</td>
</tr>
<tr>
<td>Setting</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Icap.AllowHosts</td>
<td>any</td>
<td>The default value of &quot;any&quot; permits all systems to make a connection to the Network Prevent for Web Server on the ICAP service port. Replacing &quot;any&quot; with the IP address or Fully-Qualified Domain Name (FQDN) of one or more systems restricts ICAP connections to just those designated systems. To designate multiple systems, separate their IP addresses of FQDNs by commas.</td>
</tr>
<tr>
<td>Icap.AllowStreaming</td>
<td>false</td>
<td>If true, ICAP output is streamed to the proxy directly without buffering the ICAP request first.</td>
</tr>
<tr>
<td>Icap.BindAddress</td>
<td>0.0.0.0</td>
<td>IP address to which a Network Prevent for Web Server listener binds. When BindAddress is configured, the server will only answer a connection to that IP address. The default value of 0.0.0.0 is a wild card that permits listening to all available addresses including 127.0.0.1.</td>
</tr>
<tr>
<td>Icap.BufferSize</td>
<td>3K</td>
<td>The size (in kilobytes) of the memory buffer used for ICAP request streaming and chunking. The streaming can happen only if the request is larger than FileReader.MaxFileSize and the request has a Content-Length header.</td>
</tr>
<tr>
<td>Icap.DisableHealthCheck</td>
<td>false</td>
<td>If true, disables the ICAP periodic self-check. If false, enables the ICAP periodic self-check. This setting is useful for debugging to remove clutter produced by self-check requests from the logs.</td>
</tr>
</tbody>
</table>
Table 10-9  Detection server advanced settings (continued)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Icap.EnableIncidentSuppression</td>
<td>true</td>
<td>If the parameter is set to true, Incident Suppression Cache for Gmail traffic on Mobile Prevent for Web is enabled. If the parameter is set to false, suppression is disabled.</td>
</tr>
<tr>
<td>Icap.EnableTrace</td>
<td>false</td>
<td>If set to true, protocol debug tracing is enabled once a folder is specified using the Icap.TraceFolder setting.</td>
</tr>
<tr>
<td>Icap.ExchangeActiveSyncCommandsToInspect</td>
<td>SendMail</td>
<td>A comma-separated, case-sensitive list of ActiveSync commands which need to be sent through Symantec Data Loss Prevention detection. If this parameter is left blank, ActiveSync support is disabled. If this parameter is set to &quot;any&quot;, all ActiveSync commands are inspected.</td>
</tr>
<tr>
<td>Icap.LoadBalanceFactor</td>
<td>1</td>
<td>The number of web proxy servers that a Network Prevent for Webserver is able to communicate with. For example, if the server is configured to communicate with 3 proxies, set the Icap.LoadBalanceFactor value to 3.</td>
</tr>
<tr>
<td>Icap.IncidentSuppressionCacheCleanupInterval</td>
<td>120000</td>
<td>The time interval in milliseconds for running the Incident Suppression cache clean-up thread.</td>
</tr>
<tr>
<td>Icap.IncidentSuppressionCacheTimeout</td>
<td>120000</td>
<td>The time in milliseconds to invalidate the Incident Suppression cache entry.</td>
</tr>
<tr>
<td>Icap.SpoolFolder</td>
<td></td>
<td>This value is needed for ICAP Spools.</td>
</tr>
<tr>
<td>Icap.TraceFolder</td>
<td></td>
<td>The fully qualified name of the folder or directory where protocol debug trace data is stored when the Icap.EnableTrace setting is true. By default, the value for this setting is left blank.</td>
</tr>
</tbody>
</table>
### Table 10-9  Detection server advanced settings (continued)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IncidentDetection.IncidentLimitResetTime</td>
<td>86400000</td>
<td>Specifies the time frame (in milliseconds) used by the IncidentDetection.MaxIncidentsPerPolicy setting. The default setting 86400000 equals one day.</td>
</tr>
<tr>
<td>IncidentDetection.MaxContentLength</td>
<td>2000000</td>
<td>Applies only to regular expression rules. On a per-component basis, only the first MaxContentLength number of characters are scanned for violations. The default (2,000,000) is equivalent to &gt; 1000 pages of typical text. The limiter exists to prevent regular expression rules from taking too long.</td>
</tr>
<tr>
<td>IncidentDetection.MaxIncidentsPerPolicy</td>
<td>10000</td>
<td>Defines the maximum number of incidents detected by a specific policy on a particular monitor within the time-frame specified in the IncidentDetection.IncidentTimeLimitResetTime. The default is 10,000 incidents per policy per time limit.</td>
</tr>
<tr>
<td>IncidentDetection.MessageWaitSevere</td>
<td>240</td>
<td>The number of minutes to wait before sending a severe system event about message wait times.</td>
</tr>
<tr>
<td>IncidentDetection.MessageWaitWarning</td>
<td>60</td>
<td>The number of minutes to wait before sending a warning system event about message wait times.</td>
</tr>
</tbody>
</table>
### Table 10-9  Detection server advanced settings (continued)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IncidentDetection.MinNormalizedSize</td>
<td>30</td>
<td>This setting applies to IDM detection. It MUST be kept in sync with the corresponding setting in the Indexer.properties file on the Enforce Server (which applies to indexing). Derivative detections only apply to messages when their normalized content is greater than this setting. If the normalized content size is less than this setting, IDM detection does a straight binary match.</td>
</tr>
<tr>
<td>IncidentDetection.patternConditionMaxViolations</td>
<td>100</td>
<td>The maximum number of pattern violations highlighted by detection. The exact number of matches may still be 'correct' but only the first ‘patternConditionMaxViolations’ are marked up in reporting. Increasing this number increases the size of incidents and potentially slows down the incident snapshot report.</td>
</tr>
<tr>
<td>IncidentDetection.StopCachingWhenMemoryLowerThan</td>
<td>400M</td>
<td>Instructs Detection to stop caching tokenized and cryptographic content between rule executions if the available JVM memory drops below this value (in megabytes). Setting this attribute to 0 enables caching regardless of the available memory and is not recommended because OutOfMemoryErrors may occur. Setting this attribute to a value close to, or larger than, the value of the -Xmx option in BoxMonitor.FileReaderMemory effectively disables the caching. Note that setting this value too low can have severe performance consequences.</td>
</tr>
</tbody>
</table>
## Table 10-9  Detection server advanced settings (continued)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IncidentDetection.TrialMode</td>
<td>false</td>
<td>Prevention trial mode setting to generate prevention incidents without having a prevention setup. If true, SMTP incidents coming from the Copy Rule and Packet Capture channels appear as if they were prevented and HTTP incidents coming from Packet Capture channel appear as if they were prevented.</td>
</tr>
<tr>
<td>IncidentWriter.BacklogInfo</td>
<td>1000</td>
<td>The number of incidents that collect in the log before an information level message about the number of messages is generated.</td>
</tr>
<tr>
<td>IncidentWriter.BacklogSevere</td>
<td>10000</td>
<td>The number of incidents that collect in the log before a severe level message about the number of messages is generated.</td>
</tr>
<tr>
<td>IncidentWriter.BacklogWarning</td>
<td>3000</td>
<td>The number of incidents that collect in the log before a warning level message about the number of messages is generated.</td>
</tr>
<tr>
<td>IncidentWriter.ResolveIncidentDNSNames</td>
<td>false</td>
<td>If true, only recipient host names are resolved from IP.</td>
</tr>
<tr>
<td>IncidentWriter.ShouldEncryptContent</td>
<td>true</td>
<td>If true, the monitor will encrypt the body of every message, message component and cracked component before writing to disk or sending to Enforce.</td>
</tr>
<tr>
<td>Keyword.TokenVerifierEnabled</td>
<td>false</td>
<td>Default is disabled (&quot;false&quot;). If enabled (&quot;true&quot;), the server validates tokens for Asian language keywords (Chinese, Japanese, and Korean). See “Enabling and using CJK token verification for server keyword matching” on page 593.</td>
</tr>
<tr>
<td>Setting</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>L7.cleanHttpBody</td>
<td>true</td>
<td>If true, the HTML entity references are replaced with spaces.</td>
</tr>
<tr>
<td>L7.DefaultBATV</td>
<td>Standard</td>
<td>This setting determines the tagging scheme that Network Prevent for Email uses to interpret Bounce Address Tag Validation (BATV) tags in the MAIL FROM header of a message. If this setting is “Standard” (the default), Network Prevent uses the tagging scheme described in the BATV specification (see <a href="http://tools.ietf.org/html/draft-levine-mass-batv-02">http://tools.ietf.org/html/draft-levine-mass-batv-02</a>). Change this setting to “Ironport” to enable compatibility with the IronPort proxy’s implementation of BATV tagging.</td>
</tr>
<tr>
<td>L7.DefaultUrlEncodedCharset</td>
<td>UTF-8</td>
<td>Defines the default character set to be used in decoding query parameters or URL-encoded body when the character set information is missing from the header.</td>
</tr>
<tr>
<td>L7.discardDuplicateMessages</td>
<td>true</td>
<td>If true, the Monitor ignores duplicate messages based on the messageID.</td>
</tr>
</tbody>
</table>
Table 10-9  Detection server advanced settings (continued)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>L7.ExtractBATV</td>
<td>true</td>
<td>If true (the default), Network Prevent for Email interprets Bounce Address Tag Validation (BATV) tags that are present in the MAIL FROM header of a message. This allows Network Prevent to include a meaningful sender address in incidents that are generated from messages having BATV tags. If this setting is false, Network Prevent for Email does not interpret BATV tags, and a message that contains BATV tags may generate an incident that has an unreadable sender address. See <a href="http://tools.ietf.org/html/draft-levine-mass-batv-02">http://tools.ietf.org/html/draft-levine-mass-batv-02</a> for more information about BATV.</td>
</tr>
<tr>
<td>L7.httpClientIdHeader</td>
<td></td>
<td>The sender identifier header name. The default setting is <strong>X-Forwarded-For</strong>.</td>
</tr>
<tr>
<td>L7.MAX_NUM_HTTP_HEADERS</td>
<td>30</td>
<td>If any HTTP message that contains more than the specified header lines, it is discarded.</td>
</tr>
<tr>
<td>L7.maxWordLength</td>
<td>30</td>
<td>The maximum word length (in characters) allowed in UTCP string extraction.</td>
</tr>
<tr>
<td>L7.messageIDCacheCleanupInterval</td>
<td>600000</td>
<td>The length of time that the messageID is cached. The system will not cache duplicate messages during this time period if the L7.discardDuplicateMessages setting is set to true.</td>
</tr>
</tbody>
</table>
### Table 10-9 Detection server advanced settings (continued)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>L7.minSizeOfGetUrl</td>
<td>100</td>
<td>The minimum size of the GET URL to process. HTTP GET actions are not inspected by Symantec Data Loss Prevention for policy violations if the number of bytes in the URL is less than the value of this setting. For example, with the default value of 100, no detection check is performed when a browser displays the Symantec web site at: <a href="http://www.symantec.com/index.jsp">http://www.symantec.com/index.jsp</a>. The reason is that the URL contains only 33 characters, which is less than the 100 minimum. <strong>Note:</strong> Other request types such as POST or PUT are not affected by L7.minSizeofGetURL. In order for Symantec Data Loss Prevention to inspect any GET actions at all, the L7.processGets setting must be set to true.</td>
</tr>
<tr>
<td>L7.processGets</td>
<td>true</td>
<td>If true, the GET requests are processed. If false, the GET requests are not processed. Note that this setting interacts with the L7.minSizeofGetURL setting.</td>
</tr>
<tr>
<td>Lexer.IncludePunctuation InWords</td>
<td>true</td>
<td>If true, punctuation characters internal to a token are considered during detection. See “Configuring Advanced Server Settings for EDM policies” on page 400.</td>
</tr>
<tr>
<td>Setting</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>---------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Lexer.MaximumNumberOfTokens</td>
<td>12000</td>
<td>Maximum number of tokens extracted from each message component for detection. Applicable to all detection technologies where tokenization is required (EDM, profiled DGM, and the system patterns supported by those technologies). Increasing the default value may cause the detection server to run out of memory and restart. See &quot;Configuring Advanced Server Settings for EDM policies&quot; on page 400.</td>
</tr>
<tr>
<td>Lexer.MaxTokensPerMultiToken</td>
<td>10</td>
<td>Maximum number of sub-tokens that a multi-token cell can contain. See &quot;Configuring Advanced Server Settings for EDM policies&quot; on page 400.</td>
</tr>
<tr>
<td>Lexer.MultiToken</td>
<td>true</td>
<td>If true cells containing spaces are treated as multi-tokens. See &quot;Configuring Advanced Server Settings for EDM policies&quot; on page 400.</td>
</tr>
<tr>
<td>Lexer.StopwordLanguages</td>
<td>en</td>
<td>Enables the elimination of stop words for the specified languages. The default is English. See &quot;Configuring Advanced Server Settings for EDM policies&quot; on page 400.</td>
</tr>
<tr>
<td>Lexer.Validate</td>
<td>true</td>
<td>If true, performs system pattern-specific validation. See &quot;Configuring Advanced Server Settings for EDM policies&quot; on page 400.</td>
</tr>
<tr>
<td>MessageChain.ArchiveTimedOutStreams</td>
<td>false</td>
<td>Specifies whether messages should be archived to the temp folder.</td>
</tr>
</tbody>
</table>
## Table 10-9 Detection server advanced settings (continued)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MessageChain.CacheSize</td>
<td>8</td>
<td>Limits the number of messages that can be queued in the message chains.</td>
</tr>
<tr>
<td>MessageChain.ContentDumpEnabled</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>MessageChain.MaximumComponentTime</td>
<td>60,000</td>
<td>The time interval (in milliseconds) allowed before any chain component is restarted.</td>
</tr>
<tr>
<td>MessageChain.MaximumFailureTime</td>
<td>360000</td>
<td>Number of milliseconds that must elapse before restarting the filereader. This is tracked after a message chain error is detected and that message chain has not been recovered.</td>
</tr>
<tr>
<td>MessageChain.MaximumMessageTime</td>
<td>Varies</td>
<td>This setting varies between is either 600,000 or 1,800,000 depending on detection server type.</td>
</tr>
<tr>
<td>MessageChain.MemoryThrottlerReservedBytes</td>
<td>200,000,000</td>
<td>Number of bytes required to be available before a message is sent through the message chain. This setting can avoid out of memory issues. The default value is 200 MB. The throttler can be disabled by setting this value to 0.</td>
</tr>
<tr>
<td>MessageChain.MinimumFailureTime</td>
<td>30000</td>
<td>Number of milliseconds that must elapse before failure of a message chain is tracked. Failure eventually leads to restarting the message chain or file reader.</td>
</tr>
<tr>
<td>Setting</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>---------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>MessageChain.NumChains</td>
<td>Varies</td>
<td>This number varies depending on detection server type. It is either 4 or 8. The number of messages, in parallel, that the filereader will process. Setting this number higher than 8 (with the other default settings) is not recommended. A higher setting does not substantially increase performance and there is a much greater risk of running out of memory. Setting this to less than 8 (in some cases 1) helps when processing big files, but it may slow down the system considerably.</td>
</tr>
<tr>
<td>MessageChain.StopProcessing WhenMemoryLowerThan</td>
<td>200M</td>
<td>Instructs Detection to stop drilling down into and processing sub-files if JVM available memory drops below this value. Setting this attribute to 0 will force sub-file processing, regardless of how little memory is available. Setting this attribute to a value close to or larger than the value of the -Xmx option in BoxMonitor.FileReaderMemory will effectively disable sub-file processing.</td>
</tr>
<tr>
<td>PacketCapture.DISCARD_HTTP_GET</td>
<td>true</td>
<td>If true, discards HTTP GET streams.</td>
</tr>
<tr>
<td>PacketCapture.DOES_DISCARD_TRIGGER_STREAM_DUMP</td>
<td>false</td>
<td>If true, a list of tcpstreams is dumped to an output file in the log directory the first time a discard message is received.</td>
</tr>
<tr>
<td>Setting</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>---------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>PacketCapture.ENDACE_BIN_PATH</td>
<td></td>
<td>To enable packet-capture using an Endace card, enter the path to the Endace /bin directory. Note that environment variables (such as %ENDACE_HOME%) cannot be used in this setting. For example: /usr/local/bin</td>
</tr>
<tr>
<td>PacketCapture.ENDACE_LIB_PATH</td>
<td></td>
<td>To enable packet-capture using an Endace card, enter the path to the Endace /lib directory. Note that environment variables (such as %ENDACE_HOME%) cannot be used in this setting. For example: /usr/local/lib</td>
</tr>
<tr>
<td>PacketCapture.ENDACE_XILINX_PATH</td>
<td></td>
<td>To enable packet-capture using an Endace card, enter the path to the Endace /xilinx directory. Note that environment variables (such as %ENDACE_HOME%) cannot be used in this setting. For example: /usr/local/dag/xilinx</td>
</tr>
<tr>
<td>PacketCapture.Filter</td>
<td></td>
<td>The default setting is tcp</td>
</tr>
<tr>
<td>PacketCapture.INPUT_SOURCE_FILE</td>
<td>/dummy.dmp</td>
<td>The full path and name of the input file.</td>
</tr>
<tr>
<td>Setting</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>PacketCapture.IS_ARCHIVING_PACKETS</td>
<td>false</td>
<td>DO NOT USE THIS FIELD. Diagnostic setting that creates dumps of packets captured in packetcapture for later reuse. This feature is unsupported and does not have normal error checking. May cause repeated restarts on pcap.</td>
</tr>
<tr>
<td>PacketCapture.IS_ENDACE_ENABLED</td>
<td>false</td>
<td>To enable packet-capture using an Endace card, set this value to true.</td>
</tr>
<tr>
<td>PacketCapture.IS_FTP_RETR_ENABLED</td>
<td>false</td>
<td>If true, FTP GETS and FTP PUTS are processed. If false, only process FTP PUTS are processed.</td>
</tr>
<tr>
<td>PacketCapture.IS_INPUT_SOURCE_FILE</td>
<td>false</td>
<td>If true, continually reads in packets from a tcpdump formatted file indicated in INPUT_SOURCE_FILE. Set to dag when an Endace card is installed.</td>
</tr>
<tr>
<td>PacketCapture.IS_NAPATECH_ENABLED</td>
<td>false</td>
<td>To enable packet-capture using a Napatech card, set this value to true. The default setting is false.</td>
</tr>
<tr>
<td>PacketCapture.KERNEL_BUFFER_SIZE_I686</td>
<td>64M</td>
<td>For 32-bit Linux platforms, this setting specifies the amount of memory allocated to buffer network packets. Specify K for kilobytes or M for megabytes. Do not specify a value larger than 128M.</td>
</tr>
<tr>
<td>PacketCapture.KERNEL_BUFFER_SIZE_Win32</td>
<td>16M</td>
<td>For 32-bit Windows platforms, this setting specifies the amount of memory allocated to buffer network packets. Specify K for kilobytes or M for megabytes.</td>
</tr>
<tr>
<td>PacketCapture.KERNEL_BUFFER_SIZE_X64</td>
<td>64M</td>
<td>For 64-bit Windows platforms, this setting specifies the amount of memory allocated to buffer network packets. Specify K for kilobytes or M for megabytes.</td>
</tr>
<tr>
<td>Setting</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>---------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>PacketCapture.KERNEL_BUFFER_SIZE_X86_64</td>
<td>64M</td>
<td>For 64-bit Linux platforms, this setting specifies the amount of memory allocated to buffer network packets. Specify K for kilobytes or M for megabytes. Do not specify a value larger than 64M.</td>
</tr>
<tr>
<td>PacketCapture.MAX_FILES_PER_DIRECTORY</td>
<td>30000</td>
<td>After the specified number of file streams are processed a new directory is created.</td>
</tr>
<tr>
<td>PacketCapture.MBYTES_LEFT_TO_DISABLE_CAPTURE</td>
<td>1000</td>
<td>If the amount of disk space (in MB) left on the drop_pcap drive falls below this specification, packet capture is suspended. For example, if this number is 100, pcap will stop writing out drop_pcap files when there is less than 100 MB on the installed drive</td>
</tr>
<tr>
<td>PacketCapture.MBYTES_REQUIRED_TO_RESTART_CAPTURE</td>
<td>1500</td>
<td>The amount of disk space (in MB) needed on the drop_pcap drive before packet capture resumes again after stopping due to lack of space. For example, if this value is 150 and packet capture is suspended, packet capture resumes when more than 150 MB is available on the drop_pcap drive.</td>
</tr>
<tr>
<td>PacketCapture.NAPATECH_TOOLS_PATH</td>
<td></td>
<td>This setting specifies the location of the Napatech Tools directory. This directory is not set by default. If packet-capture is enabled for Napatech, enter the fully qualified path to the Napatech Tools installation directory.</td>
</tr>
<tr>
<td>Setting</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>---------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>PacketCapture.NO_TRAFFIC_ALERT_PERIOD</td>
<td>86,400</td>
<td>The refresh time (in seconds), between no traffic alert messages. No traffic system events are created for a given protocol based on this time period. For instance, if this is set to 24<em>60</em>60 seconds, a new message is sent every day that there is no new traffic for a given protocol. Do not confuse with the per protocol traffic timeout, that tells us how long we initially go without traffic before sending the first alert.</td>
</tr>
<tr>
<td>PacketCapture.NUMBER_BUFFER_POOL_PACKETS</td>
<td>600000</td>
<td>The number of standard-sized preallocated packet buffers used to buffer and sort incoming traffic.</td>
</tr>
<tr>
<td>PacketCapture.NUMBER_JUMBO_POOL_PACKETS</td>
<td>1</td>
<td>The number of large-sized preallocated packet buffers that are used to buffer and sort incoming traffic.</td>
</tr>
<tr>
<td>PacketCapture.NUMBER_SMALL_POOL_PACKETS</td>
<td>200000</td>
<td>The number of small-sized preallocated packet buffers that are used to buffer and sort incoming traffic.</td>
</tr>
<tr>
<td>PacketCapture.RING_CAPTURE_LENGTH</td>
<td>1518</td>
<td>Controls the amount of packet data that is captured. The default value of 1518 is sufficient to capture typical Ethernet networks and Ethernet over 802.1Q tagged VLANs.</td>
</tr>
<tr>
<td>Setting</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>---------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>PacketCapture.RING_DEVICE_MEM</td>
<td>67108864</td>
<td>This setting is deprecated. Instead, use the PacketCapture.KERNEL_BUFFER_SIZE_I686 setting (for 32-bit Linux platforms) or the PacketCapture.KERNEL_BUFFER_SIZE_X86_64 setting (for 64-bit Linux platforms). Specifies the amount of memory (in bytes) to be allocated to buffer packets per device. (The default of 67108864 is equivalent to 64MB.)</td>
</tr>
<tr>
<td>PacketCapture.SIZE_BUFFER_POOL_PACKETS</td>
<td>1540</td>
<td>The size of standard-sized buffer pool packets.</td>
</tr>
<tr>
<td>PacketCapture.SIZE_JUMBO_POOL_PACKETS</td>
<td>10000</td>
<td>The size of jumbo-sized buffer pool packets.</td>
</tr>
<tr>
<td>PacketCapture.SIZE_SMALL_POOL_PACKETS</td>
<td>150</td>
<td>The size of small-sized buffer pool packets.</td>
</tr>
<tr>
<td>PacketCapture.SPOOL_DIRECTORY</td>
<td></td>
<td>The directory in which to spool streams with large numbers of packets. This setting is user defined.</td>
</tr>
<tr>
<td>PacketCapture.STREAM_WRITE_TIMEOUT</td>
<td>5000</td>
<td>The time (in milliseconds) between each count (StreamManager's write timeout)</td>
</tr>
<tr>
<td>ProfileIndex.CheckAvailableRAM</td>
<td>true</td>
<td>Specifies whether or not the amount of available RAM should be compared with a profile size before loading an EDM or IDM profile. See “Configuring Advanced Server Settings for EDM policies” on page 400.</td>
</tr>
</tbody>
</table>
Table 10-9  Detection server advanced settings (continued)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ProfileIndex.MaximumInProcessIndexSize</td>
<td>100M</td>
<td>Specifies an upper limit for the maximum In Process index size. Profiles that exceed this size are loaded out of process by RMI. See &quot;Configuring Advanced Server Settings for EDM policies&quot; on page 400.</td>
</tr>
<tr>
<td>ProfileIndex.MinimumMemoryReserve</td>
<td>600M</td>
<td>Specifies the memory reserved for out-of-process EDM and/or IDM algorithm execution. It is used to calculate the JVM heap size as index_size + MinimumMemoryReserve. See &quot;Configuring Advanced Server Settings for EDM policies&quot; on page 400.</td>
</tr>
<tr>
<td>ProfileIndex.ProcessTimeout</td>
<td>60000</td>
<td>The time interval (in milliseconds) for launching out of process indexing. If the process is not created within this amount of time then index loading fails. See &quot;Configuring Advanced Server Settings for EDM policies&quot; on page 400.</td>
</tr>
<tr>
<td>RequestProcessor.AddDefaultHeader</td>
<td>true</td>
<td>If true, adds a default header to every email processed (when in Inline SMTP mode). The default header is RequestProcessor.DefaultHeader. This header is added to all messages that pass through the system, i.e., if it is redirected, if another header is added, if the message has no policy violations then the header is added.</td>
</tr>
<tr>
<td>Setting</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>---------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>RequestProcessor.AllowExtensions</td>
<td></td>
<td>The default setting is: <strong>8BITMIME VRFY DSN HELP PIPELINING SIZE ENHANCEDSTATUSCODES STARTTLS</strong>&lt;br&gt;This setting lists the SMTP protocol extensions that Network Prevent for Email can use when it communicates with other MTAs.</td>
</tr>
<tr>
<td>RequestProcessor.AllowHosts</td>
<td>any</td>
<td>The default value of any permits all systems to make connections to the Network Prevent for Email Server on the SMTP service port. Replacing any with the IP address or Fully-Qualified Domain Name (FQDN) of one or more systems restricts SMTP connections to just those designated systems. To designate multiple systems, separate their addresses with commas. Use only a comma to separate addresses; do not include any spaces between the addresses.</td>
</tr>
<tr>
<td>RequestProcessor.AllowUnauthenticatedConnections</td>
<td>false</td>
<td>The default value ensures that MTAs must authenticate with Network Prevent for Email for TLS communication.</td>
</tr>
<tr>
<td>RequestProcessor.Backlog</td>
<td>12</td>
<td>The backlog that the request processor specifies for the server socket listener.</td>
</tr>
<tr>
<td>RequestProcessor.BindAddress</td>
<td>0.0.0.0</td>
<td>IP address to which a Network Prevent for Email Server listener binds. When BindAddress is configured, the server will only answer a connection to that IP address. The default value of 0.0.0.0 is a wild card that permits listening to all available addresses including 127.0.0.1.</td>
</tr>
<tr>
<td>Setting</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>---------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Requestprocessor.DefaultCommandTimeout</td>
<td>300</td>
<td>Specifies the number of seconds the Network Prevent for Email Server waits for a response to an SMTP command before closing connections to the upstream and downstream MTAs. The default is 300 seconds. This setting does not apply to the &quot;.&quot; command (the end of a DATA command). Do not modify the default without first consulting Symantec support.</td>
</tr>
<tr>
<td>Requestprocessor.DefaultPassHeader</td>
<td>See description</td>
<td>The default setting is: <strong>X-CFilter-Loop: Reflected.</strong> This is the default header that will be added if RequestProcessor.AddDefaultPassHeader is set to true, when in Inline SMTP mode. Must be in a valid header format, recommended to be an X header.</td>
</tr>
<tr>
<td>Requestprocessor.DotCommandTimeout</td>
<td>600</td>
<td>Specifies the number of seconds the Network Prevent for Email Server waits for a response to the &quot;.&quot; command (the end of a DATA command) before closing connections to the upstream and downstream MTAs. The default is 600 seconds. Do not modify the default without first consulting Symantec support.</td>
</tr>
<tr>
<td>RequestProcessor.ForwardConnectionTimeout</td>
<td>20000</td>
<td>The timeout value to use when forwarding to an MTA.</td>
</tr>
<tr>
<td>RequestProcessor.KeyManagementAlgorithm</td>
<td>SunX509</td>
<td>The key management algorithm used in TLS communication.</td>
</tr>
<tr>
<td>RequestProcessor.MaxLineSize</td>
<td>1048576</td>
<td>The maximum size (in bytes) of data lines expected from an external MTA. If the data lines are larger than they are broken down to this size.</td>
</tr>
<tr>
<td>Setting</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>---------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>RequestProcessor.Mode</td>
<td>ESMTP</td>
<td>Specifies the protocol mode to use (SMTP or ESMTP).</td>
</tr>
<tr>
<td>RequestProcessor.MTAResubmitPort</td>
<td>10026</td>
<td>This is the port number used by the request processor on the MTA to resend the SMTP message.</td>
</tr>
<tr>
<td>RequestProcessor.NumberOfDNSAttempts</td>
<td>4</td>
<td>The maximum number of DNS queries that Network Prevent for Email performs when it attempts to obtain mail exchange (MX) records for a domain. Network Prevent for Email uses this setting only if you have enabled MX record lookups.</td>
</tr>
<tr>
<td>RequestProcessor.RPLTimeout</td>
<td>360000</td>
<td>The maximum time in milliseconds allowed for email message processing by a Prevent server. Any email messages not processed during this time interval are passed on by the server.</td>
</tr>
<tr>
<td>RequestProcessor.ServerSocketPort</td>
<td>10025</td>
<td>The port number to be used by the SMTP monitor to listen for incoming connections from MTA.</td>
</tr>
<tr>
<td>RequestProcessor.TagHighestSeverity</td>
<td>false</td>
<td>When set to true, an additional email header that reports the highest severity of all the violated policies is added to the message. For example, if the email violated a policy of severity HIGH and a policy of severity LOW, it shows: X-DLP-MAX-Severity:HIGH.</td>
</tr>
<tr>
<td>RequestProcessor.TagPolicyCount</td>
<td>false</td>
<td>When set to true an additional email header reporting the total number of policies that the message violates is added to the message. For example, if the message violates 3 policies a header reading: X-DLP-Policy-Count: 3 is added.</td>
</tr>
<tr>
<td>Setting</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>---------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>RequestProcessor.TagScore</td>
<td>false</td>
<td>When set to true an additional email header reporting the total cumulative score of all the policies that the message violates is added to the message. Scores are calculated using the formula: High=4, Medium=3, Low=2, and Info=1. For example, if a message violates three policies, one with a severity of medium and two with a severity of low a header reading: X-DLP-Score: 7 is added.</td>
</tr>
<tr>
<td>RequestProcessor.TrustManagementAlgorithm</td>
<td>PKIX</td>
<td>The trust management algorithm that Network Prevent for Email uses when it validates certificates for TLS communication. You can optionally specify a built-in Java trust manager algorithm (such as SunX509 or SunPKIX) or a custom algorithm that you have developed.</td>
</tr>
<tr>
<td>RequestProcessorListener.ServerSocketPort</td>
<td>12355</td>
<td>The local TCP port that FileReader will use to listen for connections from RequestProcessor on a Network Prevent server.</td>
</tr>
<tr>
<td>SocketCommunication.BufferSize</td>
<td>8K</td>
<td>The size of the buffer that Network Prevent for Web uses to process ICAP requests. Increase the default value only if you need to process ICAP requests that are greater than 8K. Certain features, such as Active Directory authentication, may require an increment in buffer size.</td>
</tr>
<tr>
<td>UnicodeNormalizer.AsianCharRanges</td>
<td>default</td>
<td>Can be used to override the default definition of characters that are considered Asian by the detection engine. Must be either default, or a comma-separated list of ranges, for example: 11A80-11F9,3200-321E</td>
</tr>
</tbody>
</table>
You can use a load balancer to manage multiple Endpoint Servers, or a server pool. Adding Endpoint Servers to a load-balanced server pool enables Symantec Data Loss Prevention to use less bandwidth while managing more agents. When setting up a server pool to manage Endpoint Servers and agents, default Symantec Data Loss Prevention settings allow for communication between servers and agents. However, there are a number of load balancer settings that may affect how Endpoint Servers and agents communicate. You may have to make changes to advanced agent and server settings if the load balancer you use does not use default settings.

In general, load balancers should have the following settings applied to work best with Symantec Data Loss Prevention:

- 1-Gbps throughput
- SSL session server affinity
- 24 hour SSL session timeout period

The Endpoint Servers communicate most efficiently with agents when the load balancer is set up to use SSL session ID stickiness. (This protocol name may differ across load balancer brands.) Using session stickiness in a Symantec Data Loss Prevention implementation uses less bandwidth during the SSL handshake between agents and Endpoint Servers.

---

**Table 10-9** Detection server advanced settings (continued)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UnicodeNormalizer.Enabled</td>
<td>on</td>
<td>Can be used to disable Unicode normalization. Enter off to disable.</td>
</tr>
<tr>
<td>UnicodeNormalizer.NewlineEliminationEnabled</td>
<td>on</td>
<td>Can be used to disable newline elimination for Asian languages. Enter off to disable.</td>
</tr>
</tbody>
</table>

See “About Symantec Data Loss Prevention administration” on page 55.
See “Advanced agent settings” on page 1414.
See “About the System Overview screen” on page 198.
See “Server Detail screen” on page 201.
See “Server configuration—basic” on page 180.
See “Server controls” on page 178.
You review agent connection settings if the load balancer idle connection settings is not set to default. The load balancer idle connection setting can also be called connection timeout interval, clean idle connection, and so-on depending on the load balancer brand.

You can assess your Symantec Data Loss Prevention and load balancer settings by considering the following two scenarios:

- Default DLP settings
- Non-default DLP settings

**Note:** Contact Symantec Support before changing default advanced agent and advanced server settings.

### Table 10-10 Default Symantec Data Loss Prevention settings scenario

<table>
<thead>
<tr>
<th>Description</th>
<th>Resolution</th>
</tr>
</thead>
</table>
| Starting with version 12.5, Symantec Data Loss Prevention uses non-persistent connections by default. Using non-persistent connections means that Endpoint Servers close connections to agents after agents are idle for 30 seconds. | Consider how the agent idle timeout coincides with the load balancer close idle connection setting. If the load balancer is configured to close idle connections after less than 30 seconds, agents are prematurely disconnected from Endpoint Servers. To resolve the issue, complete one of the following:  
  - Change the agent idle timeout setting (EndpointCommunications.IDLE_TIMEOUT_IN_SECONDS.int) to less than the close idle connection setting on the load balancer.  
  - Increase the agent heartbeat setting (EndpointCommunications.HEARTBEAT_INTERVAL_IN_SECONDS.int) to be less than the load balancer close idle connections setting. The user must also increase the no traffic timeout setting (CommLayer.NO_TRAFFIC_TIMEOUT_IN_SECONDS.int) to a value greater than the agent heartbeat setting. |
<table>
<thead>
<tr>
<th>Description</th>
<th>Resolution</th>
</tr>
</thead>
</table>
| Consider how changes to default Symantec Data Loss Prevention settings affect how the load balancer handles idle and persistent agent connections. For example, if you change the idle timeout setting to 0 to create a persistent connection and you leave the default agent heartbeat setting (270 seconds), you must consider the idle connection setting on the load balancer. If the idle connection setting on the load balancer is less than 270 seconds, then agents are prematurely disconnected from Endpoint Servers. | To resolve the issue, complete one of the following:  
- Change the agent heartbeat (EndpointCommunications.HEARTBEAT_INTERVAL_IN SECONDS.int) and no traffic timeout settings (CommLayer.NO_TRAFFIC_TIMEOUT_IN SECONDS.int) to less than the load balancer idle connection setting.  
- Verify that the no traffic timeout setting is greater than the heartbeat setting. |

See “Advanced server settings” on page 203.

See “Advanced agent settings” on page 1414.
Managing log files

This chapter includes the following topics:

- About log files
- Log collection and configuration screen
- Configuring server logging behavior
- Collecting server logs and configuration files
- About log event codes

About log files

Symantec Data Loss Prevention provides a number of different log files that record information about the behavior of the software. Log files fall into these categories:

- Operational log files record detailed information about the tasks the software performs and any errors that occur while the software performs those tasks. You can use the contents of operational log files to verify that the software functions as you expect it to. You can also use these files to troubleshoot any problems in the way the software integrates with other components of your system.
  For example, you can use operational log files to verify that a Network Prevent for Email Server communicates with a specific MTA on your network.
  See “Operational log files” on page 244.

- Debug log files record fine-grained technical details about the individual processes or software components that comprise Symantec Data Loss Prevention. The contents of debug log files are not intended for use in diagnosing system configuration errors or in verifying expected software functionality. You do not need to examine debug log files to administer or maintain an Symantec Data Loss Prevention installation. However, Symantec Support may ask you to
provide debug log files for further analysis when you report a problem. Some debug log files are not created by default. Symantec Support can explain how to configure the software to create the file if necessary. See “Debug log files” on page 247.

- Installation log files record information about the Symantec Data Loss Prevention installation tasks that are performed on a particular computer. You can use these log files to verify an installation or troubleshoot installation errors. Installation log files reside in the following locations:
  - `installdir\SymantecDLP\install4j\installation.log` stores the installation log for Symantec Data Loss Prevention.
  - `installdir\oracle_home\admin\protect\` stores the installation log for Oracle.
  See the *Symantec Data Loss Prevention Installation Guide* for more information.

### Operational log files

The Enforce Server and the detection servers store operational log files in the `\SymantecDLP\Protect\logs\` directory on Windows installations and in the `/var/log/SymantecDLP/` directory on Linux installations. A number at the end of the log file name indicates the count (shown as 0 in Table 11-1).

Table 11-1 lists and describes the Symantec Data Loss Prevention operational log files.

<table>
<thead>
<tr>
<th>Log file name</th>
<th>Description</th>
<th>Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>agentmanagement_web services_access_0.log</td>
<td>Logs successful and failed attempts to access the Agent Management API web service.</td>
<td>Enforce Server</td>
</tr>
<tr>
<td>agentmanagement_web services_soap_0.log</td>
<td>Logs the entire SOAP request and response for most requests to the Agent Management API web Service.</td>
<td>Enforce Server</td>
</tr>
<tr>
<td>Log file name</td>
<td>Description</td>
<td>Server</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>boxmonitor_operational_0.log</td>
<td>The BoxMonitor process oversees the detection server processes that pertain to that particular server type. For example, the processes that run on Network Monitor are file reader and packet capture. The BoxMonitor log file is typically very small, and it shows how the application processes are running.</td>
<td>All detection servers</td>
</tr>
<tr>
<td>Classification_Operational_0.log</td>
<td>Logs the state of the Classification Detection Server, the web container, and requests.</td>
<td>Classification Detection Server</td>
</tr>
<tr>
<td>detection_operational_0.log</td>
<td>The detection operation log file provides details about how the detection server configuration and whether it is operating correctly.</td>
<td>All detection servers</td>
</tr>
<tr>
<td>detection_operational_trace_0.log</td>
<td>The detection trace log file provides details about each message that the detection server processes. The log file includes information such as: ■ The policies that were applied to the message ■ The policy rules that were matched in the message ■ The number of incidents the message generated.</td>
<td>All detection servers</td>
</tr>
<tr>
<td>machinelearning_training_operational_0.log</td>
<td>This log records information about the tasks, logs, and configuration files called on startup of the VML training process.</td>
<td>Enforce Server</td>
</tr>
<tr>
<td>manager_operational_0.log</td>
<td>Logs information about the Symantec Data Loss Prevention manager process, which implements the Enforce Server administration console user interface.</td>
<td>Enforce Server</td>
</tr>
</tbody>
</table>
### Table 11-1  Operational log files *(continued)*

<table>
<thead>
<tr>
<th>Log file name</th>
<th>Description</th>
<th>Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>monitorcontroller_operational_0.log</td>
<td>Records a detailed log of the connections between the Enforce Server and all detection servers. It provides details about the information that is exchanged between these servers including whether policies have been pushed to the detection servers or not.</td>
<td>Enforce Server</td>
</tr>
<tr>
<td>SmtpPrevent_operational0.log</td>
<td>This operational log file pertains to SMTP Prevent only. It is the primary log for tracking the health and activity of a Network Prevent for Email system. Examine this file for information about the communication between the MTAs and the detection server.</td>
<td>SMTP Prevent detection servers</td>
</tr>
</tbody>
</table>
| WebPrevent_Access0.log                | This access log file contains information about the requests that are processed by Network and Mobile Prevent for Web detection servers. It is similar to web access logs for a proxy server. | ■ Network Prevent for Web detection servers  
■ Mobile Prevent for Web detection servers |
| WebPrevent_Operational0.log           | This operational log file reports on the operating condition of Network and Mobile Prevent for Web, such as whether the system is up or down and connection management. | ■ Network Prevent for Web detection servers  
■ Mobile Prevent for Web detection servers |
| webservices_access_0.log              | This log file records successful and failed attempts to access the Incident Reporting and Update Web Service.                                                                                               | Enforce Server                |
Table 11-1  Operational log files (continued)

<table>
<thead>
<tr>
<th>Log file name</th>
<th>Description</th>
<th>Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>webservices_soap_0.log</td>
<td>Contains the entire SOAP request and response for most requests to the Reporting API Web Service. This log records all requests and responses except responses to incident binary requests. This log file is not created by default. See the Symantec Data Loss Prevention Incident Reporting and Update API Developers Guide for more information.</td>
<td>Enforce Server</td>
</tr>
</tbody>
</table>

See “Network and Mobile Prevent for Web operational log files and event codes” on page 262.

See “Network and Mobile Prevent for Web access log files and fields” on page 264.

See “Network Prevent for Email log levels” on page 267.

See “Network Prevent for Email operational log codes” on page 267.

See “Network Prevent for Email originated responses and codes” on page 271.

**Debug log files**

The Enforce Server and the detection servers store debug log files in the \SymantecDLP\Protect\logs\ directory on Windows installations and in the /var/log/SymantecDLP/ directory on Linux installations. A number at the end of the log file name indicates the count (shown as 0 in debug log files). The following table lists and describes the Symantec Data Loss Prevention debug log files.
### Table 11-2  Debug log files

<table>
<thead>
<tr>
<th>Log file name</th>
<th>Description</th>
<th>Server</th>
</tr>
</thead>
</table>
| Aggregator0.log                   | This file describes communications between the detection server and the agents. Look at this log to troubleshoot the following problems:  
  - Connection to the agents  
  - To find out why incidents do not appear when they should  
  - If unexpected agent events occur | Endpoint detection servers                                                |
<p>| BoxMonitor0.log                   | This file is typically very small, and it shows how the application processes are running. The BoxMonitor process oversees the detection server processes that pertain to that particular server type. For example, the processes that run on Network Monitor are file reader and packet capture. | All detection servers                                               |
| ContentExtractionAPI_FileReader.log | Logs the behavior of the Content Extraction API file reader that sends requests to the plug-in host. The default logging level is &quot;info&quot; which is configurable using \Protect\config\log4cxx_config_filereader.xml. | Detection Server                                          |
| ContentExtractionAPI_Manager.log  | Logs the behavior of the Content Extraction API manager that sends requests to the plug-in host. The default logging level is &quot;info&quot; which is configurable using \Protect\config\log4cxx_config_manager.xml. | Enforce Server                                           |
| ContentExtractionHost_FileReader.log | Logs the behavior of the Content Extraction File Reader hosts and plug-ins. The default logging level is &quot;info&quot; which is configurable using \Protect\config\log4cxx_config_filereader.xml. | Detection Server                                          |
| ContentExtractionHost_Manager.log | Logs the behavior of the Content Extraction Manager hosts and plug-ins. The default logging level is &quot;info&quot; which is configurable using \Protect\config\log4cxx_config_manager.xml. | Enforce Server                                           |
| DiscoverNative.log.0              | Contains the log statements that the Network Discover native code emits. Currently contains the information that is related to .pst scanning. This log file applies only to the Network Discover Servers that run on Windows platforms. | Discover detection servers                                       |</p>
<table>
<thead>
<tr>
<th>Log file name</th>
<th>Description</th>
<th>Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>FileReader0.log</td>
<td>This log file pertains to the file reader process and contains application-specific logging, which may be helpful in resolving issues in detection and incident creation. One symptom that shows up is content extractor timeouts.</td>
<td>All detection servers</td>
</tr>
<tr>
<td>flash_client_0.log</td>
<td>Logs messages from the Adobe Flex client used for folder risk reports by Network Discover.</td>
<td>Enforce Server</td>
</tr>
<tr>
<td>flash_server_remoting_0.log</td>
<td>Contains log messages from BlazeDS, an open-source component that responds to remote procedure calls from an Adobe Flex client. This log indicates whether the Enforce Server has received messages from the Flash client. At permissive log levels (FINE, FINER, FINEST), the BlazeDS logs contain the content of the client requests to the server and the content of the server responses to the client.</td>
<td>Enforce Server</td>
</tr>
<tr>
<td>IncidentPersister0.log</td>
<td>This log file pertains to the Incident Persister process. This process reads incidents from the incidents folder on the Enforce Server, and writes them to the database. Look at this log if the incident queue on the Enforce Server (manager) grows too large. This situation can be observed also by checking the incidents folder on the Enforce Server to see if incidents have backed up.</td>
<td>Enforce Server</td>
</tr>
<tr>
<td>Indexer0.log</td>
<td>This log file contains information when an EDM profile or IDM profile is indexed. It also includes the information that is collected when the external indexer is used. If indexing fails then this log should be consulted.</td>
<td>Enforce Server (or computer where the external indexer is running)</td>
</tr>
<tr>
<td>jdbc.log</td>
<td>This log file is a trace of JDBC calls to the database. By default, writing to this log is turned off.</td>
<td>Enforce Server</td>
</tr>
</tbody>
</table>
### Table 11-2  Debug log files (continued)

<table>
<thead>
<tr>
<th>Log file name</th>
<th>Description</th>
<th>Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>machinelearning_native_filereader.log</td>
<td>This log file records the runtime category classification (positive and negative) and associated confidence levels for each message detected by a VML profile. The default logging level is &quot;info&quot; which is configurable using \Protect\config\log4cxx_config_filereader.xml.</td>
<td>Detection</td>
</tr>
<tr>
<td>machinelearning_training_0_0.log</td>
<td>This log file records the design-time base accuracy percentages for the k-fold evaluations for all VML profiles.</td>
<td>Enforce</td>
</tr>
<tr>
<td>machinelearning_training_native_manager.log</td>
<td>This log file records the total number of features modeled at design-time for each VML profile training run. The default logging level is &quot;info&quot; which is configurable using \Protect\config\log4cxx_config_manager.xml.</td>
<td>Enforce</td>
</tr>
<tr>
<td>MonitorController0.log</td>
<td>This log file is a detailed log of the connections between the Enforce Server and the detection servers. It gives details around the information that is exchanged between these servers including whether policies have been pushed to the detection servers or not.</td>
<td>Enforce</td>
</tr>
<tr>
<td>PacketCapture.log</td>
<td>This log file pertains to the packet capture process that reassembles packets into messages and writes to the drop pcap directory. Look at this log if there is a problem with dropped packets or traffic is lower than expected. PacketCapture is not a Java process, so it does not follow the same logging rules as the other Symantec Data Loss Prevention system processes.</td>
<td>Network Monitor</td>
</tr>
<tr>
<td>PacketCapture0.log</td>
<td>This log file describes issues with PacketCapture communications.</td>
<td>Network Monitor</td>
</tr>
<tr>
<td>RequestProcessor0.log</td>
<td>This log file pertains to SMTP Prevent only. The log file is primarily for use in cases where SmtpPrevent0.log is not sufficient.</td>
<td>SMTP Prevent detection servers</td>
</tr>
</tbody>
</table>
### Table 11-2  Debug log files (continued)

<table>
<thead>
<tr>
<th>Log file name</th>
<th>Description</th>
<th>Server</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ScanDetail-target-0.log</strong></td>
<td>Where <em>target</em> is the name of the scan target. All white spaces in the target's name are replaced with hyphens. This log file pertains to Discover server scanning. It is a file by file record of what happened in the scan. If the scan of the file is successful, it reads success, and then the path, size, time, owner, and ACL information of the file scanned. If it failed, a warning appears followed by the file name.</td>
<td>Discover detection servers</td>
</tr>
<tr>
<td><strong>tomcat\localhost.date.log</strong></td>
<td>These Tomcat log files contain information for any action that involves the user interface. The logs include the user interface errors from red error message box, password failures when logging on, and Oracle errors (ORA-#).</td>
<td>Enforce Server</td>
</tr>
<tr>
<td><strong>VontuIncidentPersister.log</strong></td>
<td>This log file contains minimal information: stdout and stderr only (fatal events).</td>
<td>Enforce Server</td>
</tr>
<tr>
<td><strong>VontuManager.log</strong></td>
<td>This log file contains minimal information: stdout and stderr only (fatal events).</td>
<td>Enforce Server</td>
</tr>
<tr>
<td><strong>VontuMonitor.log</strong></td>
<td>This log file contains minimal information: stdout and stderr only (fatal events).</td>
<td>All detection servers</td>
</tr>
<tr>
<td><strong>VontuMonitorController.log</strong></td>
<td>This log file contains minimal information: stdout and stderr only (fatal events).</td>
<td>Enforce Server</td>
</tr>
<tr>
<td><strong>VontuNotifier.log</strong></td>
<td>This log file pertains to the Notifier service and its communications with the Enforce Server and the MonitorController service. Look at this file to see if the MonitorController service registered a policy change.</td>
<td>Enforce Server</td>
</tr>
<tr>
<td><strong>VontuUpdate.log</strong></td>
<td>This log file is populated when you update Symantec Data Loss Prevention.</td>
<td>Enforce Server</td>
</tr>
</tbody>
</table>

See “Network and Mobile Prevent for Web protocol debug log files” on page 266.

See “Network Prevent for Email log levels” on page 267.
Log collection and configuration screen

Use the **Logs screen** (System > Servers > Logs) to collect log files or to configure logging behavior for any Symantec Data Loss Prevention server. The **Logs** screen contains two tabs that provide the following features:

- **Collection**—Use this tab to collect log files and configuration files from one or more Symantec Data Loss Prevention servers. See “Collecting server logs and configuration files” on page 257.

- **Configuration**—Use this tab to configure basic logging behavior for a Symantec Data Loss Prevention server, or to apply a custom log configuration file to a server. See “Configuring server logging behavior” on page 252.

See “About log files” on page 243.

Configuring server logging behavior

Use the **Configuration** tab of the **Logs** screen (System > Servers > Logs) to change logging configuration parameters for any server in the Symantec Data Loss Prevention deployment. The Select a Diagnostic Log Setting menu provides preconfigured settings for Enforce Server and detection server logging parameters. You can select an available preconfigured setting to define common log levels or to enable logging for common server features. The Select a Diagnostic Log Setting menu also provides a default setting that returns logging configuration parameters to the default settings used at installation time.

Table 11-3 describes the preconfigured log settings available for the Enforce Server. Table 11-4 describes the preconfigured settings available for detection servers.

Optionally, you can upload a custom log configuration file that you have created or modified using a text editor. (Use the **Collection** tab to download a log configuration file that you want to customize.) You can upload only those configuration files that modify logging properties (file names that end with `Logging.properties`). When you upload a new log configuration file to a server, the server first backs up the existing configuration file of the same name. The new file is then copied into the configuration file directory and its properties are applied immediately.

You do not need to restart the server process for the changes to take effect, unless you are directed to do so. As of the current software release, only changes to the `PacketCaptureNativeLogging.properties` and `DiscoverNativeLogging.properties` files require you to restart the server process.

See “Server controls” on page 178.
Make sure that the configuration file that you upload contains valid property definitions that are applicable to the type of server you want to configure. If you make a mistake when uploading a log configuration file, use the preconfigured **Restore Defaults** setting to revert the log configuration to its original installed state.

The Enforce Server administration console performs only minimal validation of the log configuration files that you upload. It ensures that:

- Configuration file names correspond to actual logging configuration file names.
- Root level logging is enabled in the configuration file. This configuration ensures that some basic logging functionality is always available for a server.
- Properties in the file that define logging levels contain only valid values (such as `INFO`, `FINE`, or `WARNING`).

If the server detects a problem with any of these items, it displays an error message and cancels the file upload.

If the Enforce Server successfully uploads a log configuration file change to a detection server, the administration console reports that the configuration change was submitted. If the detection server then encounters any problems when tries to apply the configuration change, it logs a system event warning to indicate the problem.

<table>
<thead>
<tr>
<th>Select a Diagnostic Log Setting value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restore Defaults</td>
<td>Restores log file parameters to their default values.</td>
</tr>
<tr>
<td>Reporting API SOAP Logging</td>
<td>Logs the entire SOAP request and response message for most requests to the Reporting API Web Service. The logged messages are stored in the <code>webservices_soap.log</code> file, which is not created by default with new installations. You can use the contents of <code>webservices_soap.log</code> to diagnose problems when developing Reporting API Web Service clients. See the Symantec Data Loss Prevention Reporting API Developers Guide for more information.</td>
</tr>
</tbody>
</table>
### Table 11-3  Preconfigured log settings for the Enforce Server  (continued)

<table>
<thead>
<tr>
<th>Select a Diagnostic Log Setting value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom Attribute Lookup Logging</td>
<td>Logs diagnostic information each time the Enforce Server uses a lookup plug-in to populate custom attributes for an incident. Lookup plug-ins populate custom attribute data using LDAP, CSV files, or other data repositories. The diagnostic information is recorded in the Tomcat log file (c:\SymantecDLP\logs\tomcat\localhost.date.log) and the IncidentPersister_0.log file. See “About custom attributes” on page 1076. See “About using custom attributes” on page 1078.</td>
</tr>
</tbody>
</table>

### Table 11-4  Preconfigured log settings for detection servers

<table>
<thead>
<tr>
<th>Select a Diagnostic Log Setting value</th>
<th>Detection server uses</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restore Defaults</td>
<td>All detection servers</td>
<td>Restores log file parameters to their default values.</td>
</tr>
<tr>
<td>Discover Trace Logging</td>
<td>Network Discover Servers</td>
<td>Enables informational logging for Network Discover scans. These log messages are stored in FileReader0.log.</td>
</tr>
</tbody>
</table>
### Table 11-4  Preconfigured log settings for detection servers (continued)

<table>
<thead>
<tr>
<th>Select a Diagnostic Log Setting value</th>
<th>Detection server uses</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Detection Trace Logging** | All detection servers | Logs information about each message that the detection server processes. This includes information such as:
- The policies that were applied to the message
- The policy rules that were matched in the message
- The number of incidents that the message generated.

When you enable **Detection Trace Logging**, the resulting messages are stored in the `detection_operational_trace_0.log` file.

**Note:** Trace logging can produce a large amount of data, and the data is stored in clear text format. Use trace logging only when you need to debug a specific problem. |
| **Packet Capture Debug Logging** | Network Monitor Servers | Enables basic debug logging for packet capture with Network Monitor. This setting logs information in the `PacketCapture.log` file.

While this type of logging can produce a large amount of data, the **Packet Capture Debug Logging** setting limits the log file size to 50 MB and the maximum number of log files to 10.

If you apply this log configuration setting to a server, you must restart the server process to enable the change. |
### Table 11-4  Preconfigured log settings for detection servers (continued)

<table>
<thead>
<tr>
<th>Select a Diagnostic Log Setting value</th>
<th>Detection server uses</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Email Prevent Logging</strong></td>
<td>Network Prevent for Email servers</td>
<td>Enables full message logging for Network Prevent for Email servers. This setting logs the complete message content and includes execution and error tracing information. Logged information is stored in the SmtpPrevent0.log file. <strong>Note:</strong> Trace logging can produce a large amount of data, and the data is stored in clear text format. Use trace logging only when you need to debug a specific problem. See “Network Prevent for Email operational log codes” on page 267. See “Network Prevent for Email originated responses and codes” on page 271.</td>
</tr>
<tr>
<td><strong>ICAP Prevent Message Processing Logging</strong></td>
<td>Network Prevent for Web servers</td>
<td>Enables operational and access logging for Network Prevent for Web. This setting logs information in the FileReader0.log file. See “Network and Mobile Prevent for Web operational log files and event codes” on page 262. See “Network and Mobile Prevent for Web access log files and fields” on page 264.</td>
</tr>
</tbody>
</table>

Follow this procedure to change the log configuration for a Symantec Data Loss Prevention server.

**To configure logging properties for a server**

1. Click the **Configuration** tab if it is not already selected.
2. If you want to configure logging properties for a detection server, select the server name from the **Select a Detection Server** menu.
3 If you want to apply preconfigured log settings to a server, select the configuration name from the Select a Diagnostic Configuration menu next to the server you want to configure.

See Table 11-3 and Table 11-4 for a description of the diagnostic configurations.

4 If you instead want to use a customized log configuration file, click Browse... next to the server you want to configure. Then select the logging configuration file to use from the File Upload dialog, and click Open. You upload only logging configuration files, and not configuration files that affect other server features.

Note: If the Browse button is unavailable because of a previous menu selection, click Clear Form.

5 Click Configure Logs to apply the preconfigured setting or custom log configuration file to the selected server.

6 Check for any system event warnings that indicate a problem in applying configuration changes on a server.

See "Log collection and configuration screen" on page 252.

Note: The following debug log files are configured manually outside of the logging framework available through the Enforce Server administration console:
ContentExtractionAPI_FileReader.log, ContentExtractionAPI_Manager.log, ContentExtractionHost_FileReader.log, ContentExtractionHost_Manager.log, machinelearning_native_filereader.log, and machinelearning_training_native_manager.log. Refer to the entry for each of these log files in debug log file list for configuration details. See "Debug log files" on page 247.

Collecting server logs and configuration files

Use the Collection tab of the Logs screen (System > Servers > Logs) to collect log files and configuration files from one or more Symantec Data Loss Prevention servers. You can collect files from a single detection server or from all detection servers, as well as from the Enforce Server computer. You can limit the collected files to only those files that were last updated in a specified range of dates.

The Enforce Server administration console stores all log and configuration files that you collect in a single ZIP file on the Enforce Server computer. If you retrieve files from multiple Symantec Data Loss Prevention servers, each server's files are stored in a separate subdirectory of the ZIP file.
Checkboxes on the **Collection** tab enable you to collect different types of files from the selected servers. **Table 11-5** describes each type of file.

<table>
<thead>
<tr>
<th>File type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operational Logs</td>
<td>Operational log files record detailed information about the tasks the software performs and any errors that occur while the software performs those tasks. You can use the contents of operational log files to verify that the software functions as you expect it to. You can also use these files to troubleshoot any problems in the way the software integrates with other components of your system. For example, you can use operational log files to verify that a Network Prevent for Email Server communicates with a specific MTA on your network.</td>
</tr>
<tr>
<td>Debug and Trace Logs</td>
<td>Debug log files record fine-grained technical details about the individual processes or software components that comprise Symantec Data Loss Prevention. The contents of debug log files are not intended for use in diagnosing system configuration errors or in verifying expected software functionality. You do not need to examine debug log files to administer or maintain an Symantec Data Loss Prevention installation. However, Symantec Support may ask you to provide debug log files for further analysis when you report a problem. Some debug log files are not created by default. Symantec Support can explain how to configure the software to create the file if necessary.</td>
</tr>
</tbody>
</table>
Table 11-5  File types for collection (continued)

<table>
<thead>
<tr>
<th>File type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration Files</td>
<td>Use the Configuration Files option to retrieve both logging configuration files and server feature configuration files. Logging configuration files define the overall level of logging detail that is recorded in server log files. Logging configuration files also determine whether specific features or subsystem events are recorded to log files. For example, by default the Enforce console does not log SOAP messages that are generated from Reporting API Web service clients. The ManagerLogging.properties file contains a property that enables logging for SOAP messages. You can modify many common logging configuration properties by using the presets that are available on the Configuration tab. If you want to update a logging configuration file by hand, use the Configuration Files checkbox to download the configuration files for a server. You can modify individual logging properties using a text editor and then use the Configuration tab to upload the modified file to the server. See “Configuring server logging behavior” on page 252. The Configuration Files option retrieves the active logging configuration files and also any backup log configuration files that were created when you used the Configuration tab. This option also retrieves server feature configuration files. Server feature configuration files affect many different aspects of server behavior, such as the location of a syslog server or the communication settings of the server. You can collect these configuration files to help diagnose problems or verify server settings. However, you cannot use the Configuration tab to change server feature configuration files. You can only use the tab to change logging configuration files.</td>
</tr>
</tbody>
</table>
Table 11-5  File types for collection (continued)

<table>
<thead>
<tr>
<th>File type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Agent Logs</strong></td>
<td>Use the <strong>Agent Logs</strong> option to collect DLP agent service and operational log files from an Endpoint Prevent detection server. This option is available only for Endpoint Prevent servers. To collect agent logs using this option, you must have already pulled the log files from individual agents to the Endpoint Prevent detection server using a <strong>Pull Logs</strong> action. Use the <strong>Agent List</strong> screen to select individual agents and pull selected log files to the Endpoint Prevent detection server. Then use the <strong>Agent Logs</strong> option on this page to collect the log files. When the logs are pulled from the endpoint, they are stored on the Endpoint Server in an unencrypted format. After you collect the logs from the Endpoint Server, the logs are deleted from the Endpoint Server and are stored only on the Enforce Server. You can only collect logs from one endpoint at a time. See “Using the Agent List screen” on page 1460. See “12.0.x and earlier agent actions” on page 1485.</td>
</tr>
</tbody>
</table>

Operational, debug, trace log files are stored in the `server_identifier/logs` subdirectory of the ZIP file. `server_identifier` identifies the server that generated the log files, and it corresponds to one of the following values:

- If you collect log files from the Enforce Server, Symantec Data Loss Prevention replaces `server_identifier` with the string **Enforce**. Note that Symantec Data Loss Prevention does not use the localized name of the Enforce Server.
- If a detection server’s name includes only ASCII characters, Symantec Data Loss Prevention uses the detection server name for the `server_identifier` value.
- If a detection server’s name contains non-ASCII characters, Symantec Data Loss Prevention uses the string **DetectionServer-ID-id_number** for the `server_identifier` value. `id_number` is a unique identification number for the detection server.

If you collect agent service log files or operational log files from an Endpoint Prevent server, the files are placed in the `server_identifier/agentlogs` subdirectory. Each agent log file uses the individual agent name as the log file prefix.

Follow this procedure to collect log files and log configuration files from Symantec Data Loss Prevention servers.
To collect log files from one or more servers

1. Click the Collection tab if it is not already selected.

2. Use the Date Range menu to select a range of dates for the files you want to collect. Note that the collection process does not truncate downloaded log files in any way. The date range limits collected files to those files that were last updated in the specified range.

3. To collect log files from the Enforce Server, select one or more of the checkboxes next to the Enforce Server entry to indicate the type of files you want to collect.

4. To collect log files from one or all detection servers, use the Select a Detection Server menu to select either the name of a detection server or the Collect Logs from All Detection Servers option. Then select one or more of the checkboxes next to the menu to indicate the type of files you want to collect.

5. Click Collect Logs to begin the log collection process.

The administration console adds a new entry for the log collection process in the Previous Log Collections list at the bottom of the screen. If you are retrieving many log files, you may need to refresh the screen periodically to determine when the log collection process has completed.

**Note:** You can run only one log collection process at a time.

6. To cancel an active log collection process, click Cancel next to the log collection entry. You may need to cancel log collection if one or more servers are offline and the collection process cannot complete. When you cancel the log collection, the ZIP file contains only those files that were successfully collected.

7. To download collected logs to your local computer, click Download next to the log collection entry.

8. To remove ZIP files stored on the Enforce Server, click Delete next to a log collection entry.

See "Log collection and configuration screen" on page 252.

See "About log files" on page 243.

### About log event codes

Operational log file messages are formatted to closely match industry standards for the various protocols involved. These log messages contain event codes that...
describe the specific task that the software was trying to perform when the message was recorded. Log messages are generally formatted as:

Timestamp [Log Level] (Event Code) Event description [event parameters]

- See “Network and Mobile Prevent for Web operational log files and event codes” on page 262.
- See “Network Prevent for Email operational log codes” on page 267.
- See “Network Prevent for Email originated responses and codes” on page 271.

Network and Mobile Prevent for Web operational log files and event codes

Network and Mobile Prevent for Web log file names use the format of WebPrevent_OperationalX.log (where X is a number). The number of files that are stored and their sizes can be specified by changing the values in the FileReaderLogging.properties file. This file is in the SymantecDLP\Protect\config directory. By default, the values are:

- com.vontu.icap.log.IcapOperationalLogHandler.limit = 5000000
- com.vontu.icap.log.IcapOperationalLogHandler.count = 5

Table 11-6 lists the Network and Mobile Prevent for Web-defined operational logging codes by category. The italicized part of the text contains event parameters.

Table 11-6 Status codes for Network and Mobile Prevent for Web operational logs

<table>
<thead>
<tr>
<th>Code</th>
<th>Text and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1100</td>
<td>Starting Mobile Prevent for Web</td>
</tr>
<tr>
<td>1101</td>
<td>Shutting down Mobile Prevent for Web</td>
</tr>
</tbody>
</table>

Connectivity Events
# Table 11-6  
Status codes for Network and Mobile Prevent for Web operational logs (continued)

<table>
<thead>
<tr>
<th>Code</th>
<th>Text and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1200</td>
<td>Listening for incoming connections at &lt;br&gt;<code>icap_bind_address:icap_bind_port</code>&lt;br&gt;Where:&lt;br&gt;• <code>&lt;icap_bind_address&gt;</code> is the Network and Mobile Prevent for Web bind address to which the server listens. This address is specified with the Icap.BindAddress Advanced Setting.&lt;br&gt;• <code>&lt;icap_bind_port&gt;</code> is the port at which the server listens. This port is set in the <code>Server &gt; Configure</code> page.</td>
</tr>
<tr>
<td>1201</td>
<td>Connection (id=conn_id) opened from &lt;br&gt;<code>host(icap_client_ip:icap_client_port)</code>&lt;br&gt;Where:&lt;br&gt;• <code>&lt;conn_id&gt;</code> is the connection ID that is allocated to this connection. This ID can be helpful in doing correlations between multiple logs.&lt;br&gt;• <code>&lt;icap_client_ip&gt;</code> and <code>&lt;icap_client_port&gt;</code> are the proxy’s IP address and port from which the connect operation to Network and Mobile Prevent for Web was performed.</td>
</tr>
<tr>
<td>1202</td>
<td>Connection (id=conn_id) closed (close_reason) &lt;br&gt;Where:&lt;br&gt;• <code>&lt;conn_id&gt;</code> is the connection ID that is allocated to the connect operation.&lt;br&gt;• <code>&lt;close_reason&gt;</code> provides the reason for closing the connection.</td>
</tr>
<tr>
<td>1203</td>
<td>Connection states: <code>REQMOD=N</code>, <code>RESPMOD=N</code>, <code>OPTIONS=N</code>, <code>OTHERS=N</code>&lt;br&gt;Where <code>N</code> indicates the number of connections in each state, when the message was logged.&lt;br&gt;This message provides the system state in terms of connection management. It is logged whenever a connection is opened or closed.</td>
</tr>
</tbody>
</table>

Connectivity Errors
Table 11-6

Status codes for Network and Mobile Prevent for Web operational logs (continued)

<table>
<thead>
<tr>
<th>Code</th>
<th>Text and Description</th>
</tr>
</thead>
</table>
| 5200 | Failed to create listener at \texttt{icap\_bind\_address:icap\_bind\_port}  
Where:  
\begin{itemize}  
\item \texttt{icap\_bind\_address} is the Network and Mobile Prevent for Web bind address to which the server listens. This address can be specified with the Icap.BindAddress Advanced Setting.  
\item \texttt{icap\_bind\_port} is the port at which the server listens. This port is set on the \texttt{Server > Configure} page.  
\end{itemize} |
| 5201 | Connection was rejected from unauthorized host (\texttt{host\_ip:port})  
Where \texttt{host\_ip} and \texttt{port} are the proxy system IP and port address from which a connect attempt to Network and Mobile Prevent for Web was performed. If the host is not listed in the Icap.AllowHosts Advanced setting, it is unable to form a connection. |

See “About log files” on page 243.

Network and Mobile Prevent for Web access log files and fields

Network and Mobile Prevent for Web log file names use the format of \texttt{WebPrevent\_AccessX.log} (where \texttt{X} is a number). The number of files that are stored and their sizes can be specified by changing the values in the FileReaderLogging.properties file. By default, the values are:

\begin{itemize}  
\item \texttt{com.vontu.icap.log.IcapAccessLogHandler.limit = 5000000}  
\item \texttt{com.vontu.icap.log.IcapAccessLogHandler.count = 5}  
\end{itemize}

A Network and Mobile Prevent for Web access log is similar to a proxy server’s web access log. The “start” log message format is:

```
# Web Prevent starting: start_time
```

Where \texttt{start\_time} format is \texttt{date:time}, for example:

```
```

The description message format is:

```
# host_ip "auth_user" time_stamp "request_line" icap_status_code
request_size "referer" "user_agent" processing_time(ms) conn_id client_ip
client_port action_code icap_method_code traffic_source_code
```
Table 11-7 lists the fields. The values of fields that are enclosed in quotes in this example are quoted in an actual message. If field values cannot be determined, the message displays "-" or "" as a default value.

**Table 11-7  Network and Mobile Prevent for Web access log fields**

<table>
<thead>
<tr>
<th>Fields</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>host_ip</td>
<td>IP address of the host that made the request.</td>
</tr>
<tr>
<td>auth_user</td>
<td>Authorized user for this request.</td>
</tr>
<tr>
<td>time_stamp</td>
<td>Time that Network and Mobile Prevent receives the request.</td>
</tr>
<tr>
<td>request_line</td>
<td>Line that represents the request.</td>
</tr>
<tr>
<td>icap_status_code</td>
<td>ICAP response code that Network and Mobile Prevent sends by for this request.</td>
</tr>
<tr>
<td>request_size</td>
<td>Request size in bytes.</td>
</tr>
<tr>
<td>referrer</td>
<td>Header value from the request that contains the URI from which this request came.</td>
</tr>
<tr>
<td>user_agent</td>
<td>User agent that is associated with the request.</td>
</tr>
<tr>
<td>processing_time (milliseconds)</td>
<td>Request processing time in milliseconds. This value is the total of the receiving, content inspection, and sending times.</td>
</tr>
<tr>
<td>conn_id</td>
<td>Connection ID associated with the request.</td>
</tr>
<tr>
<td>client_ip</td>
<td>IP of the ICAP client (proxy).</td>
</tr>
<tr>
<td>client_port</td>
<td>Port of the ICAP client (proxy).</td>
</tr>
<tr>
<td>action_code</td>
<td>An integer representing the action that Network and Mobile Prevent for Web takes. Where the action code is one of the following:</td>
</tr>
<tr>
<td></td>
<td>■ 0 = UNKNOWN</td>
</tr>
<tr>
<td></td>
<td>■ 1 = ALLOW</td>
</tr>
<tr>
<td></td>
<td>■ 2 = BLOCK</td>
</tr>
<tr>
<td></td>
<td>■ 3 = REDACT</td>
</tr>
<tr>
<td></td>
<td>■ 4 = ERROR</td>
</tr>
<tr>
<td></td>
<td>■ 5 = ALLOW_WITHOUT_INSPECTION</td>
</tr>
<tr>
<td></td>
<td>■ 6 = OPTIONS_RESPONSE</td>
</tr>
<tr>
<td></td>
<td>■ 7 = REDIRECT</td>
</tr>
</tbody>
</table>
Table 11-7  Network and Mobile Prevent for Web access log fields (continued)

<table>
<thead>
<tr>
<th>Fields</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>icap_method_code</td>
<td>An integer representing the ICAP method that is associated with this request. Where the ICAP method code is one of the following:</td>
</tr>
<tr>
<td></td>
<td>■ -1 = ILLEGAL</td>
</tr>
<tr>
<td></td>
<td>■ 0 = OPTIONS</td>
</tr>
<tr>
<td></td>
<td>■ 1 = REQMOD</td>
</tr>
<tr>
<td></td>
<td>■ 2 = RESPMOD</td>
</tr>
<tr>
<td></td>
<td>■ 3 = LOG</td>
</tr>
<tr>
<td>traffic_source_code</td>
<td>An integer that represents the source of the network traffic. Where the traffic source code is one of the following:</td>
</tr>
<tr>
<td></td>
<td>■ 0 = MOBILE</td>
</tr>
<tr>
<td></td>
<td>■ 1 = WEB</td>
</tr>
<tr>
<td></td>
<td>■ 2 = UNKNOWN</td>
</tr>
</tbody>
</table>

See “About log files” on page 243.

Network and Mobile Prevent for Web protocol debug log files

To enable ICAP trace logging, set the Icap.EnableTrace Advanced setting to true and use the Icap.TraceFolder Advanced setting to specify a directory to receive the traces. Symantec Data Loss Prevention service must be restarted for this change to take effect.

Trace files that are placed in the specified directory have file names in the format: timestamp-conn_id. The first line of a trace file provides information about the connecting host IP and port along with a timestamp. File data that is read from the socket is displayed in the format <<timestamp number_of_bytes_read. Data that is written to the socket is displayed in the format >>timestamp number_of_bytes_written. The last line should note that the connection has been closed.

**Note:** Trace logging produces a large amount of data and therefore requires a large amount of free disk storage space. Trace logging should be used only for debugging an issue because the data that is written in the file is in clear text.

See “About log files” on page 243.
Network Prevent for Email log levels

Network Prevent for Email log file names use the format of EmailPrevent_OperationalX.log (where X is a number). The number of files that are stored and their sizes can be specified by changing the values in the FileReaderLogging.properties file. By default, the values are:

- com.vontu.mta.log.SmtpOperationalLogHandler.limit = 5000000
- com.vontu.mta.log.SmtpOperationalLogHandler.count = 5

At various log levels, components in the com.vontu.mta.rp package output varying levels of detail. The com.vontu.mta.rp.level setting specifies log levels in the RequestProcessorLogging.properties file which is stored in the SymantecDLP\Protect\config directory. For example, com.vontu.mta.rp.level = FINE specifies the FINE level of detail.

Table 11-8 describes the Network Prevent for Email log levels.

<table>
<thead>
<tr>
<th>Level</th>
<th>Guidelines</th>
</tr>
</thead>
<tbody>
<tr>
<td>INFO</td>
<td>General events: connect and disconnect notices, information on the messages that are processed per connection.</td>
</tr>
<tr>
<td>FINE</td>
<td>Some additional execution tracing information.</td>
</tr>
<tr>
<td>FINER</td>
<td>Envelope command streams, message headers, detection results.</td>
</tr>
<tr>
<td>FINEST</td>
<td>Complete message content, deepest execution tracing, and error tracing.</td>
</tr>
</tbody>
</table>

See “About log files” on page 243.

Network Prevent for Email operational log codes

Table 11-9 lists the defined Network Prevent for Email operational logging codes by category.

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1100</td>
<td>Starting Network Prevent for Email</td>
</tr>
<tr>
<td>1101</td>
<td>Shutting down Network Prevent for Email</td>
</tr>
</tbody>
</table>
Table 11-9  Status codes for Network Prevent for Email operational log (continued)

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1102 | Reconnecting to FileReader (tid=id)  
Where *id* is the thread identifier.  
The RequestProcessor attempts to re-establish its connection with the FileReader for detection. |
| 1103 | Reconnected to the FileReader successfully (tid=id)  
The RequestProcessor was able to re-establish its connection to the FileReader. |

**Core Errors**

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
</table>
| 5100 | Could not connect to the FileReader (tid=id timeout=.3s)  
An attempt to re-connect to the FileReader failed. |
| 5101 | FileReader connection lost (tid=id)  
The RequestProcessor connection to the FileReader was lost. |

**Connectivity Events**

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1200 | Listening for incoming connections (local=hostname)  
*Hostnames* is an IP address or fully-qualified domain name. |
| 1201 | Connection accepted (tid=id cid=N  
local=hostname:port  
remote=hostname:port)  
Where *N* is the connection identifier. |
| 1202 | Peer disconnected (tid=id cid=N  
local=hostname:port  
remote=hostname:port) |
| 1203 | Forward connection established (tid=id cid=N  
local=hostname:port  
remote=hostname:port) |
| 1204 | Forward connection closed (tid=id cid=N  
local=hostname:port  
remote=hostname:port) |
Table 11-9  Status codes for Network Prevent for Email operational log
(continued)

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1205</td>
<td>Service connection closed (tid=id cid=N local=hostname:port remote=hostname:port messages=1 time=0.14s)</td>
</tr>
</tbody>
</table>

Connectivity Errors

<p>| 5200 | Connection is rejected from the unauthorized host (tid=id local=hostname:port remote=hostname:port) |
| 5201 | Local connection error (tid=id cid=N local=hostname:port remote=hostname:port reason=Explanation) |
| 5202 | Sender connection error (tid=id cid=N local=hostname:port remote=hostname:port reason=Explanation) |
| 5203 | Forwarding connection error (tid=id cid=N local=hostname:port remote=hostname:port reason=Explanation) |
| 5204 | Peer disconnected unexpectedly (tid=id cid=N local=hostname:port remote=hostname:port reason=Explanation) |
| 5205 | Could not create listener (address=local=hostname:port reason=Explanation) |
| 5206 | Authorized MTAs contains invalid hosts: hostname, hostname, ... |
| 5207 | MTA restrictions are active, but no MTAs are authorized to communicate with this host |
| 5208 | TLS handshake failed (reason=Explanation tid=id cid=N local=hostname remote=hostname) |</p>
<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>5209</td>
<td>TLS handshake completed (tid=(id) cid=(N) local=hostname remote=hostname)</td>
</tr>
<tr>
<td>5210</td>
<td>All forward hosts unavailable (tid=(id) cid=(N) reason=Explanation)</td>
</tr>
<tr>
<td>5211</td>
<td>DNS lookup failure (tid=(id) cid=(N) NextHop=hostname reason=Explanation)</td>
</tr>
<tr>
<td>5303</td>
<td>Failed to encrypt incoming message (tid=(id) cid=(N) local=hostname remote=hostname)</td>
</tr>
<tr>
<td>5304</td>
<td>Failed to decrypt outgoing message (tid=(id) cid=(N) local=hostname remote=hostname)</td>
</tr>
</tbody>
</table>

**Message Events**

| 1300  | Message complete (cid=\(N\) message_id=3 dlp_id=message_identifier size=number sender=email_address recipient_count=\(N\) disposition=response estatus=statuscode rtime=\(N\) dtime=\(N\) mtime=\(N\)) |

Where:
- **Recipient_count** is the total number of addressees in the To, CC, and BCC fields.
- **Response** is the Network Prevent for Email response which can be one of: PASS, BLOCK, BLOCK_AND_REDIRECT, REDIRECT, MODIFY, or ERROR.
- The **estatus** is an Enhanced Status code.
  - See "Network Prevent for Email originated responses and codes" on page 271.
- The **rtime** is the time in seconds for Network Prevent for Email to fully receive the message from the sending MTA.
- The **dtime** is the time in seconds for Network Prevent for Email to perform detection on the message.
- The **mtime** is the total time in seconds for Network Prevent for Email to process the message.
Table 11-9  Status codes for Network Prevent for Email operational log (continued)

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>5300</td>
<td>Error while processing message (cid=N message_id=header_ID dlp_id=message_identifier size=0 sender=email_address recipient_count=N disposition=response estatus=statuscode rtime=N dtime=N mtime=N reason=Explanation)</td>
</tr>
</tbody>
</table>

Where header_ID is an RFC 822 Message-Id header if one exists.

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>5301</td>
<td>Sender rejected during re-submit</td>
</tr>
<tr>
<td>5302</td>
<td>Recipient rejected during re-submit</td>
</tr>
</tbody>
</table>

See “About log files” on page 243.

Network Prevent for Email originated responses and codes

Network Prevent for Email originates the following responses. Other protocol responses are expected as Network Prevent for Email relays command stream responses from the forwarding MTA to the sending MTA. Table 11-10 shows the responses that occur in situations where Network Prevent must override the receiving MTA. It also shows the situations where Network Prevent generates a specific response to an event that is not relayed from downstream.

“Enhanced Status” is the RFC1893 Enhanced Status Code associated with the response.

Table 11-10  Network Prevent for Email originated responses

<table>
<thead>
<tr>
<th>Code</th>
<th>Enhanced Status</th>
<th>Text</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>250</td>
<td>2.0.0</td>
<td>Ok: Carry on.</td>
<td>Success code that Network Prevent for Email uses.</td>
</tr>
<tr>
<td>221</td>
<td>2.0.0</td>
<td>Service closing.</td>
<td>The normal connection termination code that Network Prevent for Email generates if a QUIT request is received when no forward MTA connection is active.</td>
</tr>
<tr>
<td>Code</td>
<td>Enhanced Status</td>
<td>Text</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>----------------</td>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>451</td>
<td>4.3.0</td>
<td>Error: Processing error.</td>
<td>This “general, transient” error response is issued when a (potentially) recoverable error condition arises. This error response is issued when a more specific error response is not available. Forward connections are sometimes closed, and their unexpected termination is occasionally a cause of a code 451, status 4.3.0. However sending connections should remain open when such a condition arises unless the sending MTA chooses to terminate.</td>
</tr>
<tr>
<td>421</td>
<td>4.3.0</td>
<td>Fatal: Processing error. Closing connection.</td>
<td>This “general, terminal” error response is issued when a fatal, unrecoverable error condition arises. This error results in the immediate termination of any sender or receiver connections.</td>
</tr>
<tr>
<td>421</td>
<td>4.4.1</td>
<td>Fatal: Forwarding agent unavailable.</td>
<td>That an attempt to connect the forward MTA was refused or otherwise failed to establish properly.</td>
</tr>
<tr>
<td>421</td>
<td>4.4.2</td>
<td>Fatal: Connection lost to forwarding agent.</td>
<td>Closing connection. The forwarded MTA connection is lost in a state where further conversation with the sending MTA is not possible. The loss usually occurs in the middle of message header or body buffering. The connection is terminated immediately.</td>
</tr>
<tr>
<td>451</td>
<td>4.4.2</td>
<td>Error: Connection lost to forwarding agent.</td>
<td>The forward MTA connection was lost in a state that may be recoverable if the connection can be re-established. The sending MTA connection is maintained unless it chooses to terminate.</td>
</tr>
<tr>
<td>421</td>
<td>4.4.7</td>
<td>Error: Request timeout exceeded.</td>
<td>The last command issued did not receive a response within the time window that is defined in the RequestProcessor.DefaultCommandTimeout. (The time window may be from RequestProcessor.DotCommandTimeout if the command issued was the &quot;.&quot;). The connection is closed immediately.</td>
</tr>
</tbody>
</table>
Table 11-10  Network Prevent for Email originated responses (continued)

<table>
<thead>
<tr>
<th>Code</th>
<th>Enhanced Status</th>
<th>Text</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>421</td>
<td>4.4.7</td>
<td>Error: Connection timeout exceeded.</td>
<td>The connection was idle (no commands actively awaiting response) in excess of the time window that is defined in RequestProcessor.DefaultCommandTimeout.</td>
</tr>
<tr>
<td>501</td>
<td>5.5.2</td>
<td>Fatal: Invalid transmission request.</td>
<td>A fatal violation of the SMTP protocol (or the constraints that are placed on it) occurred. The violation is not expected to change on a resubmitted message attempt. This message is only issued in response to a single command or data line that exceeds the boundaries that are defined in RequestProcessor.MaxLineLength.</td>
</tr>
<tr>
<td>502</td>
<td>5.5.1</td>
<td>Error: Unrecognized command.</td>
<td>Defined but not currently used.</td>
</tr>
<tr>
<td>550</td>
<td>5.7.1</td>
<td>User Supplied.</td>
<td>This combination of code and status indicates that a Blocking response rule has been engaged. The text that is returned is supplied as part of the response rule definition.</td>
</tr>
</tbody>
</table>

Note that a 4xx code and a 4.x.x enhanced status indicate a temporary error. In such cases the MTA can resubmit the message to the Network Prevent for Email Server. A 5xx code and a 5.x.x enhanced status indicate a permanent error. In such cases the MTA should treat the message as undeliverable.

See “About log files” on page 243.
Using Symantec Data Loss Prevention utilities

This chapter includes the following topics:

- About the Symantec Data Loss Prevention utilities
- About Endpoint utilities
- About the Environment Check Utility
- About DBPasswordChanger

About the Symantec Data Loss Prevention utilities

Symantec provides a suite of utilities to help users accomplish those tasks that need to be done on an infrequent basis. The utilities are typically used to perform troubleshooting and maintenance tasks. They are also used to prepare data and files for use with the Symantec Data Loss Prevention software.

The Symantec Data Loss Prevention utilities are provided for both Windows and Linux operating systems. You use the command line to run the utilities on both operating systems. The utilities operate in a similar manner regardless of operating system.

Table 12-1 describes how and when to use each utility.
Table 12-1 Symantec Data Loss Prevention utilities

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Environment Check Utility</td>
<td>Audits the environment of a Symantec Data Loss Prevention server system and gathers information into a ZIP file. Symantec Support can use the ZIP file to troubleshoot problems. See “About the Environment Check Utility” on page 276.</td>
</tr>
<tr>
<td>DBPasswordChanger</td>
<td>Changes the encrypted password that the Enforce Server uses to connect to the Oracle database. See “About DBPasswordChanger” on page 279.</td>
</tr>
<tr>
<td>sslkeytool</td>
<td>Generates custom authentication keys to improve the security of the data that is transmitted between the Enforce Server and detection servers. The custom authentication keys must be copied to each Symantec Data Loss Prevention server. See the topic &quot;About the sslkeytool utility and server certificates&quot; in the Symantec Data Loss Prevention Installation Guide.</td>
</tr>
<tr>
<td>SQL Preindexer</td>
<td>Indexes an SQL database or runs an SQL query on specific data tables within the database. This utility is designed to pipe its output directly to the Remote EDM Indexer utility. See “About the SQL Preindexer” on page 433.</td>
</tr>
<tr>
<td>Remote EDM Indexer</td>
<td>Converts a comma-separated or tab-delimited data file into an exact data matching index. The utility can be run on a remote machine to provide the same indexing functionality that is available locally on the Enforce Server. This utility is often used with the SQL Preindexer. The SQL Preindexer can run an SQL query and pass the resulting data directly to the Remote EDM Indexer to create an EDM index. See “About the Remote EDM Indexer” on page 433.</td>
</tr>
</tbody>
</table>

About Endpoint utilities

Table 12-2 describes those utilities that apply to the Endpoint products. See “About Endpoint tools” on page 1523.
Table 12-2  Endpoint utilities

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service_Shutdown.exe</td>
<td>This utility enables an administrator to turn off both the agent and the watchdog services on an endpoint. (As a tamper-proofing measure, it is not possible for a user to stop either the agent or the watchdog service.) See “Shutting down the agent and the watchdog services” on page 1525.</td>
</tr>
<tr>
<td>Vontu_sqlite3.exe</td>
<td>This utility provides an SQL interface that enables you to view or modify the encrypted database files that the Symantec DLP Agent uses. Use this tool when you want to investigate or make changes to the Symantec Data Loss Prevention files. See “Inspecting the database files accessed by the agent” on page 1526.</td>
</tr>
<tr>
<td>Logdump.exe</td>
<td>This tool lets you view the Symantec DLP Agent extended log files, which are hidden for security reasons. See “Viewing extended log files” on page 1527.</td>
</tr>
<tr>
<td>Start_agent</td>
<td>This utility enables an administrator to start agents running on Mac endpoints that have been shut down using the shutdown task. See “Starting DLP Agents that run on Mac endpoints” on page 1531.</td>
</tr>
</tbody>
</table>

About the Environment Check Utility

The Environment Check Utility (ECU) validates the environment in which Symantec Data Loss Prevention servers operate. The ECU is a troubleshooting tool that is installed with the Enforce Server and detection servers. In most cases information is collected from both the Enforce Server and its detection servers. Certain checks are performed only when you run the utility on the Enforce Server.

See Table 12-3 for a description of which tasks are performed on Enforce Servers and detection servers.
Table 12-3  Environment Check Utility tasks

<table>
<thead>
<tr>
<th>Task</th>
<th>Server Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>■ Checks and displays the Windows or Linux operating system version.</td>
<td>Enforce Server or detection server</td>
</tr>
<tr>
<td>■ Verifies that required Symantec Data Loss Prevention services are running.</td>
<td>Enforce Server or detection server</td>
</tr>
<tr>
<td>■ Displays the full Symantec Data Loss Prevention version number.</td>
<td>Enforce Server or detection server</td>
</tr>
<tr>
<td>■ Checks the host configuration file and writes the configuration to a log file.</td>
<td>Enforce Server or detection server</td>
</tr>
<tr>
<td>■ Checks for the existence of the System Account user that was created during the Enforce Server installation.</td>
<td>Enforce Server</td>
</tr>
<tr>
<td>■ Checks the stored settings for each registered detection server and writes the information to the /SymantecDLP/Protect/ECU/eculogs/monitorSettings directory.</td>
<td>Enforce Server</td>
</tr>
<tr>
<td>■ Checks the Oracle database by exercising the Symantec Data Loss Prevention Notification and Lock Manager services.</td>
<td>Enforce Server</td>
</tr>
<tr>
<td>■ Checks the network connection from the Enforce Server to each registered detection server.</td>
<td>Enforce Server</td>
</tr>
</tbody>
</table>

If you experience problems with your installation, Symantec Support may ask you to run this utility to collect information about the system environment.

Running the Environment Check Utility on Windows

If the default installation directory was used, the Environment Check Utility is located in the `c:\SymantecDLP\Protect\ECU` directory.

To run the ECU on Windows

1. From the Windows Start menu, select Run and type `cmd` in the resulting Run dialog box to open a command prompt window.
2. Go to the ECU folder (`c:\SymantecDLP\Protect\ECU` if you installed in the default location).
3. Execute the utility:

   `EnvironmentCheckUtility.exe`

See “About Environment Check Utility output” on page 278.
Running the Environment Check Utility on Linux

If the default installation directory was used, the Environment Check Utility is located in the /opt/SymantecDLP/Protect/ECU directory.

To run the ECU on Linux

1  Log on as the protect user by typing:
   
   su protect

2  Go to the ECU directory. If you used the defaults during installation, type:
   
   cd /opt/SymantecDLP/Protect/ECU

3  Execute the utility:
   
   ./EnvironmentCheckUtility

See “About Environment Check Utility output” on page 278.

About Environment Check Utility output

When you run the Environment Check Utility, it generates an eculogs.zip file in the ECU subdirectory. This ZIP file contains several files with system information. If the utility runs on the Enforce Server computer, it also generates a subdirectory named eculogs\monitorSettings that contains information about each registered detection server.

The output files stored in eculogs.zip are as follows:

- ECUoutput.txt contains the test results (pass or fail) and possible reasons for the test failures.
- ecu_error_log.txt records any errors that occurred during the tests that the utility ran.
- ecu_HostFileLog.txt contains a dump of the contents of the host file.
- server_nameSettings.txt files record the settings of registered detection servers. These files, and eculogs/monitorSettings directory are generated only on the Enforce Server computer.

After the eculogs.zip file is created, send it to Symantec Support for further analysis.

See “About log files” on page 243.
About DBPasswordChanger

Symantec Data Loss Prevention stores encrypted passwords to the Oracle database in a file that is called `DatabasePassword.properties`, located in `c:\SymantecDLP\Protect\config` (Windows) or `/opt/SymantecDLP/Protect/config` (Linux). Because the contents of the file are encrypted, you cannot directly modify the file. The DBPasswordChanger utility changes the stored Oracle database passwords that the Enforce Server uses.

Before you can use DBPasswordChanger to change the password to the Oracle database you must:

- Shut down the Enforce Server.
- Change the Oracle database password using Oracle utilities.

See “Example of using DBPasswordChanger” on page 279.

DBPasswordChanger syntax

The DBPasswordChanger utility uses the following syntax:

```
DBPasswordChanger password_file new_oracle_password
```

All command-line parameters are required. The following table describes each command-line parameter.

See “Example of using DBPasswordChanger” on page 279.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>password_file</code></td>
<td>Specifies the file that contains the encrypted password. By default, this file is named <code>ProtectPassword.properties</code> and is stored in <code>c:\SymantecDLP\Protect\config</code> (Windows) or <code>/opt/SymantecDLP/Protect/config</code> (Linux).</td>
</tr>
<tr>
<td><code>new_oracle_password</code></td>
<td>Specifies the new Oracle password to encrypt and store.</td>
</tr>
</tbody>
</table>

Example of using DBPasswordChanger

If Symantec Data Loss Prevention was installed in the default location, then the DBPasswordChanger utility is located at `c:\Vontu\Protect\bin` (Windows) or
/opt/Vontu/Protect/bin (Linux). You must be an Administrator (or root) to run DBPasswordChanger.

For example, type:

```
DBPasswordChanger \Vontu\Protect\bin\DatabasePassword.properties
   protect_oracle
```

See "DBPasswordChanger syntax" on page 279.
Section 4

Authoring policies

- Chapter 13. Introduction to policies
- Chapter 14. Overview of policy detection
- Chapter 15. Creating policies from templates
- Chapter 16. Configuring policies
- Chapter 17. Administering policies
- Chapter 18. Best practices for authoring policies
- Chapter 19. Detecting content using Exact Data Matching (EDM)
- Chapter 20. Detecting content using Indexed Document Matching (IDM)
- Chapter 21. Detecting content using Vector Machine Learning (VML)
- Chapter 22. Detecting content using data identifiers
- Chapter 23. Detecting content using keyword matching
- Chapter 24. Detecting content using regular expressions
- Chapter 25. Detecting international language content
- Chapter 26. Detecting file properties
- Chapter 27. Detecting email for data classification services
- Chapter 28. Detecting network and mobile incidents
- Chapter 29. Detecting endpoint events
- Chapter 30. Detecting described identities
- Chapter 31. Detecting synchronized identities
- Chapter 32. Detecting profiled identities
- Chapter 33. Supported file formats for detection
- Chapter 34. Library of system data identifiers
- Chapter 35. Library of policy templates
Introduction to policies

This chapter includes the following topics:

- About Data Loss Prevention policies
- Policy components
- Policy templates
- Solution packs
- Policy groups
- Policy deployment
- Policy severity
- Policy authoring privileges
- Data Profiles
- User Groups
- Policy import and export
- Workflow for implementing policies
- Viewing, printing, and downloading policy details

About Data Loss Prevention policies

You implement policies to detect and prevent data loss. A Symantec Data Loss Prevention policy combines detection rules and response actions. If a policy rule is violated, the system generates an incident that you can report and act on. The policy rules you implement are based on your information security objectives. The actions you take in response to policy violations are based on your compliance...
requirements. The Enforce Server administration console provides an intuitive, centralized, Web-based interface for authoring policies.

See “Workflow for implementing policies” on page 293.

Table 13-1 describes the policy authoring features provided by Symantec Data Loss Prevention.

Table 13-1  Policy authoring features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intuitive policy building</td>
<td>The policy builder interface supports Boolean logic for detection configuration. You can combine different detection methods and technologies in a single policy. See “Detecting data loss” on page 296. See “Best practices for authoring policies” on page 357.</td>
</tr>
<tr>
<td>Decoupled response rules</td>
<td>The system stores response rules and policies as separate entities. You can manage and update response rules without having to change policies; you can reuse response rules across policies. See “About response rules” on page 875.</td>
</tr>
<tr>
<td>Fine-grained policy reporting</td>
<td>The system provides severity levels for policy violations. You can report the overall severity of a policy violation by the highest severity. See “Policy severity” on page 289.</td>
</tr>
<tr>
<td>Centralized data and group profiling</td>
<td>The system stores data and group profiles separate from policies. This separation enables you to manage and update profiles without changing policies. See “Data Profiles” on page 291. See “User Groups” on page 292.</td>
</tr>
<tr>
<td>Template-based policy detection</td>
<td>The system provides 65 pre-built policy templates. You can use these templates to quickly configure and deploy policies. See “Policy templates” on page 286.</td>
</tr>
<tr>
<td>Policy sharing</td>
<td>The system supports policy template import and export. You can share policy templates across environments and systems. See “Policy import and export” on page 292.</td>
</tr>
<tr>
<td>Role-based access control</td>
<td>The system provides role-based access control for various user and administrative functions. You can create roles for policy authoring, policy administration, and response rule authoring. See “Policy authoring privileges” on page 290.</td>
</tr>
</tbody>
</table>
Policy components

A valid policy has at least one detection or group rule with at least one match condition. Response rules are optional policy components. **Policy components** describes Data Loss Prevention policy components.

Table 13-2: Policy components

<table>
<thead>
<tr>
<th>Component</th>
<th>Use</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Policy group</td>
<td>Required</td>
<td>A policy must be assigned to a single Policy Group.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Policy groups” on page 287.</td>
</tr>
<tr>
<td>Policy name</td>
<td>Required</td>
<td>The policy name must be unique within the Policy Group</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Manage and add policies” on page 345.</td>
</tr>
<tr>
<td>Policy rule</td>
<td>Required</td>
<td>A valid policy must contain at least one rule that declares at least one match condition.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Policy matching conditions” on page 300.</td>
</tr>
<tr>
<td>Data Profile</td>
<td>May be required</td>
<td>A policy requires a Data Profile if a detection method in the policy requires it.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Exact Data Matching (EDM), Indexed Document Matching (IDM), and Vector Machine Learning (VML) rules require a Data Profile.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Data Profiles” on page 291.</td>
</tr>
<tr>
<td>User group</td>
<td>May be required</td>
<td>A policy requires a User Group only if a group method in the policy requires it.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Synchronized DGM rules and exceptions require a User Group.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “User Groups” on page 292.</td>
</tr>
<tr>
<td>Policy description</td>
<td>Optional</td>
<td>A policy description helps users identify the purpose of the policy.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Configuring policies” on page 326.</td>
</tr>
<tr>
<td>Policy label</td>
<td>Optional</td>
<td>A policy label helps Symantec Data Insight business users identify the purpose of the policy when using the Self-Service Portal.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Configuring policies” on page 326.</td>
</tr>
<tr>
<td>Response Rule</td>
<td>Optional</td>
<td>A policy can implement one or more response rules to report and remediate incidents.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “About response rules” on page 875.</td>
</tr>
</tbody>
</table>
### Policy components (continued)

<table>
<thead>
<tr>
<th>Component</th>
<th>Use</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Policy exception</td>
<td>Optional</td>
<td>A policy can contain one or more exceptions to exclude data from matching. See “Exception conditions” on page 307.</td>
</tr>
<tr>
<td>Compound match conditions</td>
<td>Optional</td>
<td>A policy rule or exception can implement multiple match conditions. See “Compound conditions” on page 308.</td>
</tr>
</tbody>
</table>

### Policy templates

Symantec Data Loss Prevention provides policy templates to help you quickly deploy detection policies in your enterprise. You can share policies across systems and environments by importing and exporting policy rules and exceptions as templates.

Using policy templates saves you time and helps you avoid errors and information gaps in your policies because the detection methods are predefined. You can edit a template to create a policy that precisely suits your needs. You can also export and import your own policy templates.

Some policy templates are based on well-known sets of regulations, such as the Payment Card Industry Security Standard, Gramm-Leach-Bliley, California SB1386, and HIPAA. Other policy templates are more generic, such as Customer Data Protection, Employee Data Protection, and Encrypted Data. Although the regulation-based templates can help address the requirements of the relevant regulations, consult with your legal counsel to verify compliance.

See “Creating a policy from a template” on page 312.

**Table 13-3** describes the system-defined policy templates provided by Symantec Data Loss Prevention.

<table>
<thead>
<tr>
<th>Policy template type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UK and International Regulatory Enforcement</td>
<td>See “UK and International Regulatory Enforcement policy templates” on page 317.</td>
</tr>
<tr>
<td>Customer and Employee Data Protection</td>
<td>See “Customer and Employee Data Protection policy templates” on page 317.</td>
</tr>
</tbody>
</table>
### Table 13-3  System-defined policy templates (continued)

<table>
<thead>
<tr>
<th>Policy template type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confidential or Classified Data Protection</td>
<td>See “Confidential or Classified Data Protection policy templates” on page 319.</td>
</tr>
<tr>
<td>Acceptable Use Enforcement</td>
<td>See “Acceptable Use Enforcement policy templates” on page 320.</td>
</tr>
<tr>
<td>Imported Templates</td>
<td>See “Policy import and export” on page 292.</td>
</tr>
<tr>
<td>Classification for Enterprise Vault</td>
<td>See the Enterprise Vault Data Classification Services Implementation Guide.</td>
</tr>
</tbody>
</table>

### Solution packs

Symantec Data Loss Prevention provides solution packs for several industry verticals. A solution pack contains configured policies, response rules, user roles, reports, protocols, and the incident statuses that support a particular industry or organization. For a list of available solution packs and instructions, refer to chapter 4, "Importing a solution pack" in the Symantec Data Loss Prevention Installation Guide. You can import one solution pack to the Enforce Server.

Once you have imported the solution pack, start by reviewing its policies. By default the solution pack activates the policies it provides.

See “Manage and add policies” on page 345.

### Policy groups

You deploy policies to detection servers using policy groups. Policy groups limit the policies, incidents, and detection mechanisms that are accessible to specific users.

Each policy belongs to one policy group. When you configure a policy, you assign it to a policy group. You can change the policy group assignment, but you cannot assign a policy to more than one policy group. You deploy policy groups to one or more detection servers.

The Enforce Server is configured with a single policy group called the Default Policy Group. The system deploys the default policy group to all detection servers. If you define a new policy, the system assigns the policy to the default policy group, unless you create and specify a different policy group. You can change the name
of the default policy group. A solution pack creates several policy groups and assigns policies to them.

After you create a policy group, you can link policies, Discover targets, and roles to the policy group. When you create a Discover target, you must associate it with a single policy group. When you associate a role with particular policy groups, you can restrict users in that role. Policies in that policy group detect incidents and report them to users in the role that is assigned to that policy group.

The relationship between policy groups and detection servers depends on the server type. You can deploy a policy group to one or more Network Monitor, Mobile Email Monitor, Network Prevent, Mobile Prevent, or Endpoint Servers. Policy groups that you deploy to an Endpoint Server apply to any DLP Agent that is registered with that server. The Enforce Server automatically associates all policy groups with all Network Discover Servers.

For Network Monitor and Network Prevent, each policy group is assigned to one or more Network Monitor Servers, Email Prevent Servers, or Web Prevent Servers. For Mobile Prevent, each policy group is assigned to one or more Mobile Prevent for Web Servers. For Network Discover, policy groups are assigned to individual Discover targets. A single detection server may handle as many policy groups as necessary to scan its targets. For Endpoint Monitor, policy groups are assigned to the Endpoint Server and apply to all registered DLP Agents.

See “Manage and add policy groups” on page 347.
See “Creating and modifying policy groups” on page 348.

Policy deployment

You can use policy groups to organize and deploy your policies in different ways. For example, consider a situation in which your detection servers are set up across a system that spans several countries. You can use policy groups to ensure that a detection server runs only the policies that are valid for a specific location.

You can dedicate some of your detection servers to monitor internal network traffic and dedicate others to monitor network exit points. You can use policy groups to deploy less restrictive policies to servers that monitor internal traffic. At the same time, you can deploy stricter policies to servers that monitor traffic leaving your network.

You can use policy groups to organize policies and incidents by business units, departments, geographic regions, or any other organizational unit. For example, policy groups for specific departments may be appropriate where security responsibilities are distributed among various groups. In such cases, policy groups provide for role-based access control over the viewing and editing of incidents. You
deploy policy groups according to the required division of access rights within your organization (for example, by business unit).

You can use policy groups for detection-server allocation, which may be more common where security departments are centralized. In these cases, you would carefully choose the detection server allocation for each role and reflect the server name in the policy group name. For example, you might name the groups Inbound and Outbound, United States and International, or Testing and Production.

In more complex environments, you might consider some combination of the following policy groups for deploying policies:

- Sales and Marketing - US
- Sales and Marketing - Europe
- Sales and Marketing - Asia
- Sales and Marketing - Australia, New Zealand
- Human Resources - US
- Human Resources - International
- Research and Development
- Customer service

Lastly, you can use policy groups to test policies before deploying them in production, to manage legacy policies, and to import and export policy templates.

See “Policy groups” on page 287.

See “About role-based access control” on page 84.

**Policy severity**

When you configure a detection rule, you can select a policy severity level. You can then use response rules to take action based on a severity level. For example, you can configure a response rule to take action after a specified number of "High" severity violations.

See “About response rule conditions” on page 882.

The default severity level is set to "High," unless you change it. The default severity level applies to any condition that the detection rule matches. For example, if the default severity level is set to "High," every detection rule violation is labeled with this severity level. If you do not want to tag every violation with a specific severity, you can define the criteria by which a severity level is established. In this case the default behavior is overridden. For example, you can define the "High" severity level to be applied only after a specified number of condition matches have occurred.
In addition, you can define multiple severity levels to layer severity reporting. For example, you can set the "High" severity level after 100 matches, and the medium severity level to apply after 50 matches.

### Table 13-4  Rule severity levels

<table>
<thead>
<tr>
<th>Rule severity level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>High</td>
<td>If a condition match occurs, it is labeled &quot;High&quot; severity.</td>
</tr>
<tr>
<td>Medium</td>
<td>If a condition match occurs, it is labeled &quot;Medium&quot; severity.</td>
</tr>
<tr>
<td>Low</td>
<td>If a condition match occurs, it is labeled &quot;Low&quot; severity.</td>
</tr>
<tr>
<td>Info</td>
<td>If a condition match occurs, it is labeled &quot;Info&quot; severity.</td>
</tr>
</tbody>
</table>

### Policy authoring privileges

Policy authors configure and manage policies and their rules and exceptions. To author policies, a user must be assigned to a role that grants the policy authoring privilege. This role can be expanded to include management of policy groups, scanning targets, and credentials.

Response rule authoring privileges are separate credentials from policy authoring and administration privileges. Whether or not policy authors have response rule authoring privileges is based on your enterprise needs.

### Table 13-5  Policy authoring privileges

<table>
<thead>
<tr>
<th>Role privilege</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Author Policies</td>
<td>Add, configure, and manage policies.</td>
</tr>
<tr>
<td></td>
<td>Add, configure, and manage policy rules and exceptions.</td>
</tr>
<tr>
<td></td>
<td>Import and export policy templates.</td>
</tr>
<tr>
<td></td>
<td>Modify system-defined data identifiers and create custom data identifiers.</td>
</tr>
<tr>
<td></td>
<td>Add, configure, and manage User Groups.</td>
</tr>
<tr>
<td></td>
<td>Add response rules to policies (but do not create response rules).</td>
</tr>
<tr>
<td></td>
<td>See “About role-based access control” on page 84.</td>
</tr>
</tbody>
</table>
Table 13-5  Policy authoring privileges (continued)

<table>
<thead>
<tr>
<th>Role privilege</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enforce Server Administration</td>
<td>Add, configure, and manage policy groups.</td>
</tr>
<tr>
<td></td>
<td>Add, configure, and manage Data Profiles.</td>
</tr>
<tr>
<td></td>
<td>See “Configuring roles” on page 91.</td>
</tr>
<tr>
<td>Author Response Rules</td>
<td>Add, configure, and manage response rules (but do not add them to policies).</td>
</tr>
<tr>
<td></td>
<td>See “About response rule authoring privileges” on page 885.</td>
</tr>
</tbody>
</table>

Data Profiles

Data Profiles are user-defined configurations that you create to implement Exact Data Matching (EDM), Indexed Document Matching (IDM), and Vector Machine Learning (VML) policy conditions.

See “Data Loss Prevention policy detection technologies” on page 298.

Table 13-6 describes the types of Data Profiles that the system supports.

<table>
<thead>
<tr>
<th>Data Profile type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exact Data Profile</td>
<td>An Exact Data Profile is used for Exact Data Matching (EDM) policies. The Exact Data Profile contains data that has been indexed from a structured data source, such as a database, directory server, or CSV file. The Exact Data Profile runs on the detection server. If an EDM policy is deployed to an endpoint, the DLP Agent sends the message to the detection server for evaluation (two-tier detection).</td>
</tr>
<tr>
<td></td>
<td>See “About the Exact Data Profile and index” on page 371.</td>
</tr>
<tr>
<td></td>
<td>See “Introducing profiled Directory Group Matching (DGM)” on page 661.</td>
</tr>
<tr>
<td></td>
<td>See “About two-tier detection for EDM on the endpoint” on page 377.</td>
</tr>
<tr>
<td>Indexed Document Profile</td>
<td>An Indexed Document Profile is used for Indexed Document Matching (IDM) policies. The Indexed Document Profile contains data that has been indexed from a collection of confidential documents. The Indexed Document Profile runs on the detection server. If an IDM policy is deployed to an endpoint, the DLP Agent sends the message to the detection server for evaluation (two-tier detection).</td>
</tr>
<tr>
<td></td>
<td>See “About the Indexed Document Profile” on page 465.</td>
</tr>
<tr>
<td></td>
<td>See “About the indexing process” on page 466.</td>
</tr>
</tbody>
</table>
### Table 13-6  Types of Data Profiles (continued)

<table>
<thead>
<tr>
<th>Data Profile type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vector Machine Learning Profile</td>
<td>A Vector Machine Learning Profile is used for Vector Machine Learning (VML) policies. The Vector Machine Learning Profile contains a statistical model of the features (keywords) extracted from content that you want to protect. The VML profile is loaded into memory by the detection server and DLP Agent. VML does not require two-tier detection. See “About the Vector Machine Learning Profile” on page 510. See “Configuring VML profiles and policy conditions” on page 513.</td>
</tr>
</tbody>
</table>

### User Groups

You define User Groups on the Enforce Server. User Groups contain user identity information that you populate by synchronizing the Enforce Server with a group directory server (Microsoft Active Directory).

You must have at least policy authoring or server administrator privileges to define User Groups. You must define the User Groups before you synchronize users.

Once you define a User Group, you populate it with users, groups, and business units from your directory server. After the user group is populated, you associate it with the User/Sender and Recipient detection rules or exceptions. The policy only applies to members of that User Group.

See “Introducing synchronized Directory Group Matching (DGM)” on page 653.
See “Configuring directory server connections” on page 127.
See “Configuring User Groups” on page 654.

### Policy import and export

You can export and import policy templates to and from the Enforce Server. This feature lets you share policies across environments, version existing policies, and archive legacy policies.

Consider a scenario where you author and refine a policy on a test system and then export the policy as a template. You then import this policy to a production system for deployment to one or more detection servers. Or, if you want to retire a policy, you export it as a template for archiving, then remove it from the system.

See “Importing policy templates” on page 349.
See “Exporting policy detection as a template” on page 350.
A policy template is an XML file. The template contains the policy metadata, and the detection and the group rules and exceptions. If a policy template contains more than one condition that requires a Data Profile, the system imports only one of these conditions. A policy template does not include policy response rules, or modified or custom data identifiers.

Table 13-7 describes policy template components.

<table>
<thead>
<tr>
<th>Policy component</th>
<th>Description</th>
<th>Included in Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Policy metadata (name, description, label)</td>
<td>The name of the template has to be less than 60 characters or it does not appear in the Imported Templates list.</td>
<td>YES</td>
</tr>
<tr>
<td>Described Content Matching (DCM) rules and exceptions</td>
<td>If the template contains only DCM methods, it imports as exported without changes.</td>
<td>YES</td>
</tr>
<tr>
<td>Exact Data Matching (EDM) and Indexed Document Matching (IDM) conditions</td>
<td>If the template contains multiple EDM or IDM match conditions, only one is exported. If the template contains an EDM and an IDM condition, the system drops the IDM.</td>
<td>YES</td>
</tr>
<tr>
<td>User Group</td>
<td>User group methods are maintained on import only if the user groups exist on the target before import.</td>
<td>NO</td>
</tr>
<tr>
<td>Policy Group</td>
<td>Policy groups do not export. On import you can select a local policy group, otherwise the system assigns the policy to the Default Policy group.</td>
<td>NO</td>
</tr>
<tr>
<td>Response Rules</td>
<td>You must define and add response rules to policies from the local Enforce Server instance.</td>
<td>NO</td>
</tr>
<tr>
<td>Data Profiles</td>
<td>On import you must reference a locally defined Data Profile, otherwise the system drops any methods that require a Data Profile.</td>
<td>NO</td>
</tr>
<tr>
<td>Custom data identifiers</td>
<td>Modified and custom data identifiers do not export.</td>
<td>NO</td>
</tr>
<tr>
<td>Custom protocols</td>
<td>Custom protocols do not export.</td>
<td>NO</td>
</tr>
<tr>
<td>Policy state</td>
<td>Policy state (Active/Suspended) does not export.</td>
<td>NO</td>
</tr>
</tbody>
</table>

Workflow for implementing policies

Policies define the content, event context, and identities you want to detect. Policies may also define response rule actions if a policy is violated. Successful policy
creation is a process that requires careful analysis and proper configuration to achieve optimum results.

Table 13-8 describes the typical workflow for implementing Data Loss Prevention policies.

Table 13-8   Policy implementation process

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| Familiarize yourself with the different types of detection technologies and methods that Symantec Data Loss Prevention provides, and considerations for authoring data loss prevention policies. | See “Detecting data loss” on page 296.  
See “Data Loss Prevention policy detection technologies” on page 298.  
See “Policy matching conditions” on page 300.  
See “Best practices for authoring policies” on page 357. |
| Develop a policy detection strategy that defines the type of data you want to protect from data loss. | See “Develop a policy strategy that supports your data security objectives” on page 359. |
| Review the policy templates that ship with Symantec Data Loss Prevention, and any templates that you import manually or by solution pack. | See “Policy templates” on page 286.  
See “Solution packs” on page 287. |
| Create policy groups to control how your policies are accessed, edited, and deployed. | See “Policy groups” on page 287.  
See “Policy deployment” on page 288. |
| To detect exact data or content or similar unstructured data, create one or more Data Profiles. | See “Data Profiles” on page 291. |
| To detect exact identities from a synchronized directory server (Active Directory), configure one or more User Groups. | See “User Groups” on page 292. |
| Configure conditions for detection and group rules and exceptions. | See “Creating a policy from a template” on page 312. |
| Test and tune your policies. | See “Test and tune policies to improve match accuracy” on page 361. |
| Add response rules to the policy to take action when the policy is violated. | See “About response rules” on page 875. |
| Manage the policies in your enterprise. | See “Manage and add policies” on page 345. |
Viewing, printing, and downloading policy details

You may be required to share high-level details about your policies with individuals who are not Symantec Data Loss Prevention users. For example, you might be asked to provide policy details to an information security officer in your company, or to and outside security auditor. To facilitate such an action, you can view and print policy details in an easily readable format from the Policy List screen. The policy detail view does not include any technical nomenclature or branding specific to Symantec Data Loss Prevention. It displays the policy name, description, label, group, status, version, and last modified date for the policy. It also displays the detection and the response rules for that policy.

Any user with the Author Policies privilege for a given policy or set of policies can view and print policy details.

See “Policy authoring privileges” on page 290.

Table 13-9 describes how to work with policy details.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View and print details for a single policy.</td>
<td>See “Viewing and printing policy details” on page 352.</td>
</tr>
<tr>
<td>Download details for all policies.</td>
<td>See “Downloading policy details” on page 353.</td>
</tr>
</tbody>
</table>
Overview of policy detection

This chapter includes the following topics:

- Detecting data loss
- Data Loss Prevention policy detection technologies
- Policy matching conditions
- Detection messages and message components
- Exception conditions
- Compound conditions
- Policy detection execution
- Two-tier detection for DLP Agents

Detecting data loss

Symantec Data Loss Prevention detects data from virtually any type of message or file, any user, sender, or recipient, wherever your data or endpoints exist. You can use Data Loss Prevention to detect both the content and the context of data within your enterprise. You define and manage your detection policies from the centralized, Web-based Enforce Server administration console.

See “Content that can be detected” on page 297.
See “Files that can be detected” on page 297.
See “Protocols that can be monitored” on page 297.
See “Endpoint events that can be detected” on page 298.
See “Identities that can be detected” on page 298.
See “Languages that can be detected” on page 298.
Content that can be detected

Symantec Data Loss Prevention detects data and document content, including text, markup, presentations, spreadsheets, archive files and their contents, email messages, database files, designs and graphics, multimedia files, and more. For example, the system can open a compressed file and scan a Microsoft Word document within the compressed file for the keyword "confidential." If the keyword is matched, the detection engine flags the message as an incident.

Content-based detection is based on actual content, not the file itself. A detection server can detect extracts or derivatives of protected or described content. This content may include sections of documents that have been copied and pasted to other documents or emails. A detection server can also identify sensitive data in a different file format than the source file. For example, if a confidential Word file is fingerprinted, the detection engine can match the content emailed in a PDF attachment.

See “Content matching conditions” on page 301.

Files that can be detected

Symantec Data Loss Prevention recognizes many types of files and attachments based on their context, including file type, file name, and file size. Symantec Data Loss Prevention identifies over 300 types of files, including word-processing formats, multimedia files, spreadsheets, presentations, pictures, encapsulation formats, encryption formats, and others.

For file type detection, the system does not rely on the file extension to identify the file type. For example, the system recognizes a Microsoft Word file even if a user changes the file extension to .txt. In this case the detection engine checks the binary signature of the file to match its type.

See “File property matching conditions” on page 302.

Protocols that can be monitored

Symantec Data Loss Prevention detects messages on the network by identifying the protocol signature: email (SMTP), Web (HTTP), file transfer (FTP), newsgroups (NNTP), TCP, Telnet, and SSL.

You can configure a detection server to listen on non-default ports for data loss violations. For example, if your network transmits Web traffic on port 81 instead of port 80, the system still recognizes the transmitted content as HTTP.

See “Protocol matching condition for network and mobile” on page 303.
Endpoint events that can be detected
Symantec Data Loss Prevention lets you detect data loss violations at several endpoint destinations. These destinations include the local drive, CD/DVD drive, removable storage devices, network file shares, Windows Clipboard, printers and faxes, and application files. You can also detect protocol events on the endpoint for email (SMTP), Web (HTTP), and file transfer (FTP) traffic.

For example, the DLP Agent (installed on each endpoint computer) can detect the copying of a confidential file to a USB device. Or, the DLP Agent can allow the copying of files only to a specific class of USB device that meets corporate encryption requirements.

See “Endpoint matching conditions” on page 304.

Identities that can be detected
Symantec Data Loss Prevention lets you detect the identity of data users, message senders, and message recipients using a variety of methods. These methods include described identity patterns and exact identities matched from a directory server or a corporate database.

For example, you can detect email messages sent by a specific user, or allow email messages sent to or from a specific group of users as defined in your Microsoft Active Directory server.

See “Groups (identity) matching conditions” on page 304.

Languages that can be detected
Symantec Data Loss Prevention provides broad international support for detecting data loss in many languages. Supported languages include most Western and Central European languages, Hebrew, Arabic, Chinese (simplified and traditional), Japanese, Korean, and more.

The detection engine uses Unicode internally. You can build localized policy rules and exceptions using any detection technology in any supported language.

See “Supported languages for detection” on page 65.
See “Detecting non-English language content” on page 604.

Data Loss Prevention policy detection technologies
Symantec Data Loss Prevention provides several types of detection technologies to help you author policies to detect data loss. Each type of detection technology provides unique capabilities. Often you combine technologies in policies to achieve
precise detection results. In addition, Symantec Data Loss Prevention provides you with several ways to extend policy detection and match any type of data, content, or files you want.

See “About Data Loss Prevention policies” on page 283.

See “Best practices for authoring policies” on page 357.

Table 14-1 lists the various types of the detection technologies and customizations provided by Data Loss Prevention.

Table 14-1 | Data Loss Prevention detection technologies
---|---
**Technology** | **Description**
Exact Data Matching (EDM) | Use EDM to detect personally identifiable information. See “Introducing Exact Data Matching (EDM)” on page 367.
Described Content Matching (DCM) | Use DCM to detect message content and context, including:
  - Data Identifiers to match content using precise patterns and data validators. See “Introducing data identifiers” on page 541.
  - Keywords to detect content using key words, key phrases, and keyword dictionaries. See “Introducing keyword matching” on page 584.
  - Regular Expressions to detect characters, patterns, and strings. See “Introducing regular expression matching” on page 598.
  - File properties to detect files by type, name, size, and custom type. See “Introducing file property detection” on page 609.
  - User, sender, and recipient patterns to detect described identities. See “Introducing described identity matching” on page 643.
  - Protocol signatures to detect network and mobile traffic. See “Introducing protocol monitoring for network” on page 626. See “Introducing protocol monitoring for mobile” on page 627.
  - Destinations, devices, and protocols to detect endpoint events. See “Introducing endpoint event detection” on page 632.
Table 14-1  Data Loss Prevention detection technologies (continued)

<table>
<thead>
<tr>
<th>Technology</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom policy detection methods</td>
<td>Data Loss Prevention provides methods for customizing and extending detection, including:</td>
</tr>
<tr>
<td></td>
<td>■ Custom Data Identifiers</td>
</tr>
<tr>
<td></td>
<td>Implement your own data identifier patterns and system-defined validators.</td>
</tr>
<tr>
<td></td>
<td>See “Introducing data identifiers” on page 541.</td>
</tr>
<tr>
<td></td>
<td>■ Custom script validators for Data Identifiers</td>
</tr>
<tr>
<td></td>
<td>Use the Symantec Data Loss Prevention Scripting Language to validate custom data types.</td>
</tr>
<tr>
<td></td>
<td>See “Workflow for creating custom data identifiers” on page 570.</td>
</tr>
<tr>
<td></td>
<td>■ Custom file type identification</td>
</tr>
<tr>
<td></td>
<td>Use the Symantec Data Loss Prevention Scripting Language to detect custom file types.</td>
</tr>
<tr>
<td></td>
<td>See “About custom file type identification” on page 610.</td>
</tr>
<tr>
<td></td>
<td>■ Custom endpoint device detection</td>
</tr>
<tr>
<td></td>
<td>Detect or allow any endpoint device using regular expressions.</td>
</tr>
<tr>
<td></td>
<td>See “About endpoint device detection” on page 634.</td>
</tr>
<tr>
<td></td>
<td>■ Custom network protocol detection</td>
</tr>
<tr>
<td></td>
<td>Define custom TCP ports to tap.</td>
</tr>
<tr>
<td></td>
<td>See “Introducing protocol monitoring for network” on page 626.</td>
</tr>
<tr>
<td></td>
<td>■ Custom content extraction</td>
</tr>
<tr>
<td></td>
<td>Use a plug-in to identify custom file formats and extract file contents for analysis by the detection server.</td>
</tr>
<tr>
<td></td>
<td>See “Overview of detection file format support” on page 667.</td>
</tr>
</tbody>
</table>

Policy matching conditions

Symantec Data Loss Prevention provides several types of match conditions, each offering unique detection capabilities. You implement match conditions in policies as rules or exceptions. Detection rules use conditions to match message content or context. Group rules use conditions to match identities. You can also use conditions as detection and group policy exceptions.

See “Exception conditions” on page 307.

Table 14-2 lists the various types of policy matching conditions provided by Data Loss Prevention.
<table>
<thead>
<tr>
<th>Table 14-2</th>
<th>Policy match condition types</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Condition type</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Content</td>
<td>See “Content matching conditions” on page 301.</td>
</tr>
<tr>
<td>File property</td>
<td>See “File property matching conditions” on page 302.</td>
</tr>
<tr>
<td>Protocol</td>
<td>See “Protocol matching condition for network and mobile” on page 303.</td>
</tr>
<tr>
<td>Endpoint</td>
<td>See “Endpoint matching conditions” on page 304.</td>
</tr>
<tr>
<td>Groups (identity)</td>
<td>See “Groups (identity) matching conditions” on page 304.</td>
</tr>
</tbody>
</table>

**Content matching conditions**

Symantec Data Loss Prevention provides several conditions to match message content. Certain content conditions require an associated Data Profile and index. For content detection, you can match on individual message components, including header, body, attachments, and subject for some conditions.

See “Detection messages and message components” on page 305.

See “Content that can be detected” on page 297.

Table 14-3 lists the content matching conditions that you can use without a Data Profile and index.

**Table 14-3** | Content matching conditions |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Content rule type</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Content Matches Regular Expression</td>
<td>Match described content using regular expressions. See “Introducing regular expression matching” on page 598. See “Configuring the Content Matches Regular Expression condition” on page 600.</td>
</tr>
<tr>
<td>Content Matches Keyword</td>
<td>Match described content using keywords, key phrases, and keyword dictionaries. See “Introducing keyword matching” on page 584. See “Configuring the Content Matches Keyword condition” on page 591.</td>
</tr>
<tr>
<td>Content Matches Data Identifier</td>
<td>Match described content using Data Identifier patterns and validators. See “Introducing data identifiers” on page 541. See “Configuring the Content Matches data identifier condition” on page 552.</td>
</tr>
</tbody>
</table>

Table 14-4 lists the content matching conditions that require a Data Profile and index.
See “Data Profiles” on page 291.
See “Two-tier detection for DLP Agents” on page 309.

### Table 14-4  Index-based content matching conditions

<table>
<thead>
<tr>
<th>Content rule type</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Content Matches Exact Data From an Exact Data Profile** (EDM) | Match exact data profiled from a structured data source such as a database or CSV file.  
See “Introducing Exact Data Matching (EDM)” on page 367.  
See “Configuring the Content Matches Exact Data policy condition” on page 396.  
**Note:** This condition requires two-tier detection on the endpoint. See “About two-tier detection for EDM on the endpoint” on page 377. |
| **Content Matches Document Signature From an Indexed Document Profile** (IDM) | Match files and file contents exactly or partially using fingerprinting  
See “Introducing Indexed Document Matching (IDM)” on page 462.  
See “Configuring the Content Matches Document Signature policy condition” on page 497.  
**Note:** This condition requires two-tier detection on the endpoint. See “About the Indexed Document Profile” on page 465. |
| **Detect using Vector Machine Learning profile** (VML) | Match file contents with features similar to example content you have trained.  
See “Introducing Vector Machine Learning (VML)” on page 509.  
See “Configuring the Detect using Vector Machine Learning Profile condition” on page 525. |

### File property matching conditions

Symantec Data Loss Prevention provides several conditions to match file properties, including file type, file size, and file name.

See “Files that can be detected” on page 297.

### Table 14-5  File property match conditions

<table>
<thead>
<tr>
<th>Condition type</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Message Attachment or File Type Match** | Match specific file formats and document attachments.  
See “About file type matching” on page 609.  
See “Configuring the Message Attachment or File Type Match condition” on page 612. |
### Table 14-5  File property match conditions (continued)

<table>
<thead>
<tr>
<th>Condition type</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Message Attachment or File Size Match** | Match files or attachments over or under a specified size.  
See “About file size matching” on page 611.  
See “Configuring the Message Attachment or File Size Match condition” on page 613. |
| **Message Attachment or File Name Match** | Match files or attachments that have a specific name or match wildcards.  
See “About file name matching” on page 611.  
See “Configuring the Message Attachment or File Name Match condition” on page 614. |
| **Message/Email Properties and Attributes** | Classify Microsoft Exchange email messages based on specific message attributes (MAPI attributes).  
See “Configuring the Message/Email Properties and Attributes condition” on page 623.  
**Note:** This condition is available for use with Data Classification for Enterprise Vault.  
See the *Enterprise Vault Data Classification Services Implementation Guide*. |
| **Custom File Type Signature** | Match custom file types based on their binary signature using scripting.  
See “About custom file type identification” on page 610.  
See “Enabling the Custom File Type Signature condition in the policy console” on page 616. |

### Protocol matching condition for network and mobile

Symantec Data Loss Prevention provides the single **Protocol Monitoring** condition to match network and mobile traffic for policy detection rules and exceptions.

See “Protocols that can be monitored” on page 297.

### Table 14-6  Protocol matching condition for network and mobile monitoring

<table>
<thead>
<tr>
<th>Match condition</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Protocol Monitoring** | Match incidents on the network transmitted using a specified protocol, including SMTP, FTP, HTTP/S, IM, and NNTP.  
See “Introducing protocol monitoring for network” on page 626.  
See “Configuring the Protocol Monitoring condition for network detection” on page 628. |
|                 | Match incidents sent to and from mobile devices over the HTTP/S and FTP protocols.  
See “Introducing protocol monitoring for mobile” on page 627.  
See “Configuring the Protocol Monitoring condition for mobile detection” on page 629. |
Endpoint matching conditions

Symantec Data Loss Prevention provides several conditions for matching endpoint events.

See "Endpoint events that can be detected" on page 298.

**Table 14-7**  Endpoint matching conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Protocol or Endpoint Monitoring</strong></td>
<td>Match endpoint messages transmitted using a specified transport protocol or when data is moved or copied to a particular destination.</td>
</tr>
<tr>
<td></td>
<td>See &quot;Introducing endpoint event detection&quot; on page 632.</td>
</tr>
<tr>
<td></td>
<td>See &quot;Configuring the Endpoint Monitoring condition&quot; on page 635.</td>
</tr>
<tr>
<td><strong>Endpoint Device Class or ID</strong></td>
<td>Match endpoint events occurring on specified hardware devices.</td>
</tr>
<tr>
<td></td>
<td>See &quot;Introducing endpoint event detection&quot; on page 632.</td>
</tr>
<tr>
<td></td>
<td>See &quot;Configuring the Endpoint Device Class or ID condition&quot; on page 638.</td>
</tr>
<tr>
<td><strong>Endpoint Location</strong></td>
<td>Match endpoint events depending if the DLP Agent is on or off the corporate network.</td>
</tr>
<tr>
<td></td>
<td>See &quot;Introducing endpoint event detection&quot; on page 632.</td>
</tr>
<tr>
<td></td>
<td>See &quot;Configuring the Endpoint Location condition&quot; on page 637.</td>
</tr>
</tbody>
</table>

Groups (identity) matching conditions

Symantec Data Loss Prevention provides several conditions for matching the identity of users and groups, and message senders and recipients.

The sender and recipient pattern rules are reusable across policies. The Directory Group Matching (DGM) rules let you match on sender and recipients derived from Active Directory (synchronized DGM) or from an Exact Data Profile (profiled DGM).

See "Identities that can be detected" on page 298.

See “Two-tier detection for DLP Agents” on page 309.

**Table 14-8**  Available group rules for identity matching

<table>
<thead>
<tr>
<th>Group rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Sender/User Matches Pattern</strong></td>
<td>Match message senders and users by email address, user ID, IM screen name, and IP address.</td>
</tr>
<tr>
<td></td>
<td>See &quot;Introducing described identity matching&quot; on page 643.</td>
</tr>
<tr>
<td></td>
<td>See “Configuring the Sender/User Matches Pattern condition” on page 645.</td>
</tr>
</tbody>
</table>
Table 14-8  Available group rules for identity matching (continued)

<table>
<thead>
<tr>
<th>Group rule</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Recipient Matches Pattern** | Match message recipients by email or IP address, or Web domain.  
See “Introducing described identity matching” on page 643.  
See “Configuring the Recipient Matches Pattern condition” on page 648. |
| **Sender/User based on a Directory Server Group** | Match message senders and users from a synchronized directory server.  
See “Introducing synchronized Directory Group Matching (DGM)” on page 653.  
See “Configuring the Sender/User based on a Directory Server Group condition” on page 657. |
| **Sender/User based on a Directory from: an Exact Data Profile** | Match message senders and users from a profiled directory server.  
See “Introducing profiled Directory Group Matching (DGM)” on page 661.  
See “Configuring the Sender/User based on a Profiled Directory condition” on page 663.  
**Note:** This condition requires two-tier detection on the endpoint. See “About two-tier detection for profiled DGM” on page 661. |
| **Recipient based on a Directory Server Group** | Match message recipients from a synchronized directory server.  
See “Introducing synchronized Directory Group Matching (DGM)” on page 653.  
See “Configuring the Recipient based on a Directory Server Group condition” on page 658.  
**Note:** This condition requires two-tier detection on the endpoint. See “About two-tier detection for synchronized DGM” on page 654. |
| **Recipient based on a Directory from: an Exact Data Profile** | Match message recipients from a profiled directory server.  
See “Configuring Exact Data profiles for DGM” on page 662.  
See “Configuring the Recipient based on a Profiled Directory condition” on page 664.  
**Note:** This condition requires two-tier detection on the endpoint. See “About two-tier detection for profiled DGM” on page 661. |

Detection messages and message components

Data Loss Prevention detection servers and DLP Agents receive input data for analysis in the form of messages. The system determines the message type; for example, an email or a Word document. Depending on the message type, the system either parses the message content into components (header, subject, body, attachments), or it leaves the message intact. The system evaluates the message
or message components to see if any policy match conditions apply. If a condition applies and it supports component matching, the system evaluates the content against each selected message component. If the condition does not support component matching, the system evaluates the entire message against the match condition.

See “Selecting components to match on” on page 336.

The content-based conditions support cross-component matching. You can configure the DCM content conditions to match across all message components. The EDM condition matches on message envelope, body, and attachments. The document conditions match on the message body and attachments, except File Type and Name which only match on the attachment. Protocol, endpoint, and identity conditions match on the entire message, as does any condition evaluated by the DLP Agent. The subject component only applies to SMTP email or NNTP messages, and Data Classification.

See “About matching on the message Subject for Data Classification Services” on page 621.

Table 14-9 summarizes the component matching supported by each match condition type.

<table>
<thead>
<tr>
<th>Condition type</th>
<th>Envelope</th>
<th>Subject</th>
<th>Body</th>
<th>Attachment(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Described content (DCM) conditions for content detection:</td>
<td>match</td>
<td>match</td>
<td>match</td>
<td>match</td>
</tr>
<tr>
<td>Keyword, Data Identifier, Regular Expression</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Exact Data Matching (EDM)</td>
<td>match</td>
<td></td>
<td>match</td>
<td>match</td>
</tr>
<tr>
<td>Indexed Document Matching (IDM)</td>
<td></td>
<td></td>
<td>match</td>
<td>match</td>
</tr>
<tr>
<td>Vector Machine Learning (VML)</td>
<td></td>
<td>match</td>
<td></td>
<td>match</td>
</tr>
<tr>
<td>File Size (DCM)</td>
<td>match</td>
<td></td>
<td></td>
<td>match</td>
</tr>
<tr>
<td>File Type and File Name (DCM)</td>
<td></td>
<td></td>
<td></td>
<td>match</td>
</tr>
<tr>
<td>Protocol (DCM)</td>
<td></td>
<td></td>
<td>match (entire message)</td>
<td></td>
</tr>
<tr>
<td>Endpoint (DCM)</td>
<td></td>
<td></td>
<td>match (entire message)</td>
<td></td>
</tr>
<tr>
<td>Identity (DCM and DGM)</td>
<td></td>
<td></td>
<td>match (entire message)</td>
<td></td>
</tr>
</tbody>
</table>
Table 14-9  Message components to match on (continued)

<table>
<thead>
<tr>
<th>Condition type</th>
<th>Envelope</th>
<th>Subject</th>
<th>Body</th>
<th>Attachment(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any condition evaluated by the DLP Agent</td>
<td></td>
<td></td>
<td>match (entire message)</td>
<td></td>
</tr>
</tbody>
</table>

**Exception conditions**

Symantec Data Loss Prevention provides policy exceptions to exclude messages and message components from matching. You can use exception conditions to refine the scope of your detection and group rules.

See “Use a limited number of exceptions to narrow detection scope” on page 363.

**Warning:** Do not use multiple compound exceptions in a single policy. Doing so can cause detection to run out of memory. If you find that the policy needs multiple compound exceptions to produce matches, you should reconsider the design of the matching conditions.

The system evaluates an inbound message or message component against policy exceptions before policy rules. If the exception supports cross-component matching (content-based exceptions), the exception can be configured to match on individual message components. Otherwise, the exception matches on the entire message.

If an exception is met, the system ejects the entire message or message component containing the content that triggered the exception. The ejected message or message component is no longer available for evaluation against policy rules. The system does not discard only the matched content or data item; it discards the entire message or message component that contained the excepted item.

**Note:** Symantec Data Loss Prevention does not support match-level exceptions, only component or message-level exceptions.

For example, consider a policy that has a detection rule with one condition and an exception with one condition. The rule matches messages containing Microsoft Word attachments and generates an incident for each match. The exception excludes from matching messages from ceo@company.com. An email from ceo@company.com that contains a Word attachment is excepted from matching and does not trigger an incident. The detection exception condition excluding ceo@company.com messages takes precedence over the detection rule match condition that would otherwise match on the message.
Compound conditions

A valid policy must declare at least one rule that defines at least one match condition. The condition matches input data to detect data loss. A rule with a single condition is a simple rule. Optionally, you can declare multiple conditions within a single detection or group rule. A rule with multiple conditions is a compound condition.

For compound conditions, each condition in the rule must match to trigger a violation. Thus, for a single policy that declares one rule with two conditions, if one condition matches but the other does not, detection does not report a match. If both conditions match, detection reports a match, assuming that the rule is set to count all matches. In programmatic terms, two or more conditions in the same rule are ANDed together.

Like rules, you can declare multiple conditions within a single exception. In this case, all conditions in the exception must match for the exception to apply.

Policy detection execution

You can include any combination of detection rules, group rules, and exceptions in a single policy. A detection server evaluates policy exceptions first. If any exception is met, the entire message or message component matching the exception is ejected and is no longer available for policy matching.

The detection server evaluates the detection and group rules in the policy on a per-rule basis. In programmatic terms, where you have a single policy definition, the connection between conditions in the same rule or exception is AND (compound conditions). The connection between two or more rules of the same type is OR (for
example, 2 detection rules). But, if you combine rules of different type in a single policy (for example, 1 detection rule and 1 group rule), the connection between the rules is AND. In this configuration both rules must match to trigger an incident. However, exception conditions created across the "Detection" and "Groups" tabs are connected by an implicit OR.

See “Compound conditions” on page 308.

See “Exception conditions” on page 307.

Table 14-10 summarizes the policy condition execution logic for the detection server for various policy configurations.

**Table 14-10** Policy condition execution logic

<table>
<thead>
<tr>
<th>Policy configuration</th>
<th>Logic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compound conditions</td>
<td>AND</td>
<td>If a single rule or exception in a policy contains two or more match conditions, all conditions must match.</td>
</tr>
<tr>
<td>Rules or exceptions of same type</td>
<td>OR</td>
<td>If there are two detection rules in a single policy, or two group rules in a single policy, or two exceptions of the same type (detection or group), the rules or exceptions are independent of each other.</td>
</tr>
<tr>
<td>Rules of different type</td>
<td>AND</td>
<td>If one or more detection rules is combined with one or more group rules in a single policy, the rules are dependent.</td>
</tr>
<tr>
<td>Exceptions of different type</td>
<td>OR</td>
<td>If one or more detection exceptions is combined with one or more group exceptions in a single policy, the exceptions are independent.</td>
</tr>
</tbody>
</table>

**Two-tier detection for DLP Agents**

Symantec Data Loss Prevention uses a two-tier detection architecture to analyze activity on endpoints for some index-based match conditions.

Two-tier detection requires communication and data transfer between the DLP Agent and the Endpoint Server to detect incidents. If a match condition requires two-tier detection, the condition is not evaluated locally on the endpoint by the DLP Agent. Instead, the DLP Agent sends the data to the Endpoint Server for policy evaluation.

See “About policies for endpoints” on page 1365.

The effect of two-tier detection is that policy evaluation is delayed for the time it takes the data to be sent to and evaluated by the Endpoint Server. If the DLP Agent is not connected to the network or cannot communicate with the Endpoint Server,
the condition requiring two-tier detection is not evaluated until the DLP Agent connects. This delay can impact performance of the DLP Agent if the message is a large file or attachment.

See “Troubleshooting policies” on page 353.

Two-tier detection has implications for the kinds of policies you author for endpoints. You can reduce the potential bottleneck of two-tier detection by being aware of the detection conditions that require two-tier detection and author your endpoint policies in such a way to eliminate or reduce the need for two-tier detection.

See “Author policies to limit the potential effect of two-tier detection” on page 364. 

Table 14-11 lists the detection conditions that require two-tier detection on the endpoint.

<table>
<thead>
<tr>
<th>Detection technology</th>
<th>Match condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exact Data Matching (EDM)</td>
<td><strong>Content Matches Exact Data from</strong> an Exact Data Profile</td>
<td>See “Introducing Exact Data Matching (EDM)” on page 367.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “About two-tier detection for EDM on the endpoint” on page 377.</td>
</tr>
<tr>
<td>Profiled Directory Group Matching (DGM)</td>
<td><strong>Sender/User based on a Directory from</strong> an Exact Data Profile</td>
<td>See “Introducing profiled Directory Group Matching (DGM)” on page 661.</td>
</tr>
<tr>
<td></td>
<td><strong>Recipient based on a Directory from</strong> an Exact Data Profile</td>
<td>See “About two-tier detection for profiled DGM” on page 661.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “About two-tier detection for synchronized DGM” on page 654.</td>
</tr>
</tbody>
</table>

**Note:** You cannot combine an Endpoint Prevent: Notify or Block response rule with two-tier match conditions, including Exact Data Matching (EDM), Directory Group Matching (DGM), and Indexed Document Matching (IDM) when two-tier detection is enabled. If you do, the system displays a warning for both the detection condition and the response rule.
### Table 14-11  
Policy matching conditions requiring two-tier detection (continued)

<table>
<thead>
<tr>
<th>Detection technology</th>
<th>Match condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indexed Document Matching (IDM)</td>
<td><strong>Content Matches Document Signature from</strong> an Indexed Document Profile</td>
<td>See “Introducing Indexed Document Matching (IDM)” on page 462.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Two-tier IDM detection” on page 465.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> Two-tier detection for IDM only applies if it is enabled on the Endpoint Server (two_tier_idm = on). If Endpoint IDM is enabled (two_tier_idm = off), two-tier detection is not used.</td>
</tr>
</tbody>
</table>
Creating policies from templates

This chapter includes the following topics:

- Creating a policy from a template
- US Regulatory Enforcement policy templates
- UK and International Regulatory Enforcement policy templates
- Customer and Employee Data Protection policy templates
- Confidential or Classified Data Protection policy templates
- Network Security Enforcement policy templates
- Acceptable Use Enforcement policy templates
- Choosing an Exact Data Profile
- Choosing an Indexed Document Profile

Creating a policy from a template

You can create a policy from a system-provided template or from a template you import to the Enforce Server.

See “Policy templates” on page 286.

See “Policy import and export” on page 292.
<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a policy from a template.</td>
<td>See “Adding a new policy or policy template” on page 325.</td>
</tr>
<tr>
<td>Click Next to configure the policy.</td>
<td>For example, select the Webmail policy template and click Next. See “Configuring policies” on page 326.</td>
</tr>
<tr>
<td>Choose a Data Profile (if prompted).</td>
<td>If the template relies on one or more Data Profiles, the system prompts you to select each: ■ Exact Data Profile See “Choosing an Exact Data Profile” on page 322. ■ Indexed Document Profile See “Choosing an Indexed Document Profile” on page 323. If you do not have a Data Profile, you can either: ■ Cancel the policy definition process, define the profile, and resume creating the policy from the template. ■ Click Next to configure the policy. On creation of the policy, the system drops any rules or exceptions that rely on the Data Profile. Note: You should use a profile if a template calls for it.</td>
</tr>
</tbody>
</table>
Table 15-1  Create a policy from a template (continued)

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit the policy name or description (optional).</td>
<td>If you intend to modify a system-defined template, you may want to change the name so you can distinguish it from the original. See “Configuring policies” on page 326. <strong>Note:</strong> If you want to export the policy as a template, the policy name must be less than 60 characters. If it is more, the template does not appear in the <strong>Imported Templates</strong> section of the <strong>Template List</strong> screen. <strong>Note:</strong> The <strong>Policy Label</strong> field is reserved for the Symantec Data Insight Self-Service Portal.</td>
</tr>
<tr>
<td>Select a policy group (if necessary).</td>
<td>If you have defined a policy group, select it from the <strong>Policy Group</strong> list. See “Creating and modifying policy groups” on page 348. If you have not defined a policy group, the system deploys the policy to the <strong>Default Policy Group</strong>.</td>
</tr>
<tr>
<td>Edit the policy rules or exceptions (if necessary).</td>
<td>The <strong>Configure Policy</strong> screen displays the rules and exceptions (if any) provided by the policy. You can modify, add, and remove policy rules and exceptions to meet your requirements. See “Configuring policy rules” on page 330. See “Configuring policy exceptions” on page 340.</td>
</tr>
<tr>
<td>Save the policy and export it (optional).</td>
<td>Click <strong>Save</strong> to save the policy. You can export policy detection as a template for sharing or archiving. See &quot;Exporting policy detection as a template&quot; on page 350. For example, if you changed the configuration of a system-defined policy template, you may want to export it for sharing across environments.</td>
</tr>
<tr>
<td>Test and tune the policy (recommended).</td>
<td>Test and tune the policy using data the policy should and should not detect. Review the incidents that the policy generates. Refine the policy rules and exceptions as necessary to reduce false positives and false negatives.</td>
</tr>
<tr>
<td>Add response rules (optional).</td>
<td>Add response rules to the policy to report and remediate violations. See “Implementing response rules” on page 886. <strong>Note:</strong> Response rules are not included in policy templates.</td>
</tr>
</tbody>
</table>
US Regulatory Enforcement policy templates

Symantec Data Loss Prevention provides several policy templates supporting US Regulatory Enforcement guidelines.

See “Creating a policy from a template” on page 312.

<table>
<thead>
<tr>
<th>Policy template</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAN-SPAM Act</td>
<td>Establishes requirements for sending commercial email.</td>
</tr>
<tr>
<td></td>
<td>See “CAN-SPAM Act policy template” on page 805.</td>
</tr>
<tr>
<td>Defense Message System (DMS) GENSER Classification</td>
<td>Detects information classified as confidential.</td>
</tr>
<tr>
<td></td>
<td>See “Defense Message System (DMS) GENSER Classification policy template” on page 813.</td>
</tr>
<tr>
<td>Export Administration Regulations (EAR)</td>
<td>Enforces the U.S. Department of Commerce Export Administration Regulations (EAR).</td>
</tr>
<tr>
<td></td>
<td>See “Export Administration Regulations (EAR) policy template” on page 817.</td>
</tr>
<tr>
<td></td>
<td>See “FACTA 2003 (Red Flag Rules) policy template” on page 818.</td>
</tr>
<tr>
<td>Gramm-Leach-Bliley</td>
<td>This policy limits sharing of consumer information by financial institutions.</td>
</tr>
<tr>
<td></td>
<td>See “Gramm-Leach-Bliley policy template” on page 824.</td>
</tr>
<tr>
<td>HIPAA and HITECH (including PHI)</td>
<td>This policy enforces the US Health Insurance Portability and Accountability Act (HIPAA).</td>
</tr>
<tr>
<td></td>
<td>See “HIPAA and HITECH (including PHI) policy template” on page 826.</td>
</tr>
<tr>
<td>International Traffic in Arms Regulations (ITAR)</td>
<td>This policy enforces the US Department of State ITAR provisions.</td>
</tr>
<tr>
<td></td>
<td>See “International Traffic in Arms Regulations (ITAR) policy template” on page 832.</td>
</tr>
<tr>
<td>NASD Rule 2711 and NYSE Rules 351 and 472</td>
<td>This policy protects the name(s) of any companies that are involved in an upcoming stock offering.</td>
</tr>
<tr>
<td></td>
<td>See “NASD Rule 2711 and NYSE Rules 351 and 472 policy template” on page 835.</td>
</tr>
<tr>
<td>Policy template</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>NASD Rule 3010 and NYSE Rule 342</td>
<td>This policy monitors brokers-dealers communications. See “NASD Rule 3010 and NYSE Rule 342 policy template” on page 837.</td>
</tr>
<tr>
<td>NERC Security Guidelines for Electric Utilities</td>
<td>This policy detects the information that is outlined in the North American Electric Reliability Council (NERC) security guidelines for the electricity sector. See “NERC Security Guidelines for Electric Utilities policy template” on page 838.</td>
</tr>
<tr>
<td>Office of Foreign Assets Control (OFAC)</td>
<td>This template detects communications involving targeted OFAC groups. See “Office of Foreign Assets Control (OFAC) policy template” on page 841.</td>
</tr>
<tr>
<td>OMB Memo 06-16 and FIPS 199 Regulations</td>
<td>This template detects information that is classified as confidential. See “OMB Memo 06-16 and FIPS 199 Regulations policy template” on page 841.</td>
</tr>
<tr>
<td>Payment Card Industry Data Security Standard</td>
<td>This template detects Visa and MasterCard credit card number data. See “Payment Card Industry (PCI) Data Security Standard policy template” on page 845.</td>
</tr>
<tr>
<td>Sarbanes-Oxley</td>
<td>This template detects sensitive financial data. See “Sarbanes-Oxley policy template” on page 853.</td>
</tr>
<tr>
<td>SEC Fair Disclosure Regulation</td>
<td>This template detects data disclosure of material financial information. See “SEC Fair Disclosure Regulation policy template” on page 855.</td>
</tr>
<tr>
<td>State Data Privacy</td>
<td>This template detects breaches of state-mandated confidentiality. See “State Data Privacy policy template” on page 859.</td>
</tr>
<tr>
<td>US Intelligence Control Markings (CAPCO) and DCID 1/7</td>
<td>This template detects authorized terms to identify classified information in the US Federal Intelligence community. See “US Intelligence Control Markings (CAPCO) and DCID 1/7 policy template” on page 866.</td>
</tr>
</tbody>
</table>
UK and International Regulatory Enforcement policy templates

Symantec Data Loss Prevention provides several policy templates for UK and International Regulatory Enforcement.

See “Creating a policy from a template” on page 312.

Table 15-3  UK and International Regulatory Enforcement policy templates

<table>
<thead>
<tr>
<th>Policy template</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Caldicott Report</td>
<td>This policy protects UK patient information.</td>
</tr>
<tr>
<td></td>
<td>See “Caldicott Report policy template” on page 802.</td>
</tr>
<tr>
<td>UK Data Protection Act 1998</td>
<td>This policy protects personal identifiable information.</td>
</tr>
<tr>
<td></td>
<td>See “Data Protection Act 1998 (UK) policy template” on page 810.</td>
</tr>
<tr>
<td>EU Data Protection Directives</td>
<td>This policy detects personal data specific to the EU directives.</td>
</tr>
<tr>
<td></td>
<td>See “Data Protection Directives (EU) policy template” on page 811.</td>
</tr>
<tr>
<td>Human Rights Act 1998</td>
<td>This policy enforces Article 8 of the act for UK citizens.</td>
</tr>
<tr>
<td>PIPEDA</td>
<td>This policy detects Canadian citizen customer data.</td>
</tr>
<tr>
<td></td>
<td>See “PIPEDA policy template” on page 846.</td>
</tr>
</tbody>
</table>

Customer and Employee Data Protection policy templates

Symantec Data Loss Prevention provides several policy templates for Customer and Employee Data Protection.

See “Creating a policy from a template” on page 312.

Table 15-4  Customer and Employee Data Protection policy templates

<table>
<thead>
<tr>
<th>Policy template</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Canadian Social Insurance Numbers</td>
<td>This policy detects patterns indicating Canadian social insurance numbers.</td>
</tr>
<tr>
<td></td>
<td>See “Canadian Social Insurance Numbers policy template” on page 804.</td>
</tr>
<tr>
<td>Policy template</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Credit Card Numbers</td>
<td>This policy detects patterns indicating credit card numbers. See “Credit Card Numbers policy template” on page 808.</td>
</tr>
<tr>
<td>Customer Data Protection</td>
<td>This policy detects customer data. See “Customer Data Protection policy template” on page 808.</td>
</tr>
<tr>
<td>Employee Data Protection</td>
<td>This policy detects employee data. See “Employee Data Protection policy template” on page 815.</td>
</tr>
<tr>
<td>Individual Taxpayer Identification Numbers (ITIN)</td>
<td>This policy detects IRS-issued tax processing numbers. See “Individual Taxpayer Identification Numbers (ITIN) policy template” on page 831.</td>
</tr>
<tr>
<td>SWIFT Codes</td>
<td>This policy detects codes banks use to transfer money across international borders. See “SWIFT Codes policy template” on page 862.</td>
</tr>
<tr>
<td>UK Drivers License Numbers</td>
<td>This policy detects UK Drivers License Numbers. See &quot;UK Drivers License Numbers policy template&quot; on page 863.</td>
</tr>
<tr>
<td>UK Electoral Roll Numbers</td>
<td>This policy detects UK Electoral Roll Numbers. See “UK Electoral Roll Numbers policy template” on page 864.</td>
</tr>
<tr>
<td>UK National Insurance Numbers</td>
<td>This policy detects UK National Insurance Numbers. See &quot;UK National Insurance Numbers policy template” on page 864.</td>
</tr>
<tr>
<td>UK National Health Service Number</td>
<td>This policy detects personal identification numbers issued by the NHS. See &quot;UK National Health Service (NHS) Number policy template” on page 864.</td>
</tr>
<tr>
<td>UK Passport Numbers</td>
<td>This policy detects valid UK passports. See “UK Passport Numbers policy template” on page 865.</td>
</tr>
<tr>
<td>UK Tax ID Numbers</td>
<td>This policy detects UK Tax ID Numbers. See “UK Tax ID Numbers policy template” on page 865.</td>
</tr>
</tbody>
</table>
Confidential or Classified Data Protection policy templates

Symantec Data Loss Prevention provides several policy templates for Confidential or Classified Data Protection.

See “Creating a policy from a template” on page 312.

<table>
<thead>
<tr>
<th>Policy template</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confidential Documents</td>
<td>This policy detects company-confidential documents.</td>
</tr>
<tr>
<td></td>
<td>See “Confidential Documents policy template” on page 807.</td>
</tr>
<tr>
<td>Design Documents</td>
<td>This policy detects various types of design documents.</td>
</tr>
<tr>
<td></td>
<td>See “Design Documents policy template” on page 814.</td>
</tr>
<tr>
<td>Encrypted Data</td>
<td>This policy detects the use of encryption by a variety of methods.</td>
</tr>
<tr>
<td></td>
<td>See “Encrypted Data policy template” on page 817.</td>
</tr>
<tr>
<td>Financial Information</td>
<td>This policy detects financial data and information.</td>
</tr>
<tr>
<td></td>
<td>See “Financial Information policy template” on page 822.</td>
</tr>
<tr>
<td>Merger and Acquisition Agreements</td>
<td>This policy detects information and communications about upcoming merger and acquisition activity.</td>
</tr>
<tr>
<td></td>
<td>See “Merger and Acquisition Agreements policy template” on page 834.</td>
</tr>
<tr>
<td>Price Information</td>
<td>This policy detects specific SKU or pricing information.</td>
</tr>
<tr>
<td></td>
<td>See “Price Information policy template” on page 848.</td>
</tr>
<tr>
<td>Project Data</td>
<td>This policy detects discussions of sensitive projects.</td>
</tr>
<tr>
<td></td>
<td>See “Project Data policy template” on page 849.</td>
</tr>
<tr>
<td>Proprietary Media Files</td>
<td>This policy detects various types of video and audio files.</td>
</tr>
<tr>
<td></td>
<td>See “Proprietary Media Files policy template” on page 849.</td>
</tr>
<tr>
<td>Publishing Documents</td>
<td>This policy detects various types of publishing documents.</td>
</tr>
<tr>
<td></td>
<td>See “Publishing Documents policy template” on page 850.</td>
</tr>
<tr>
<td>Resumes</td>
<td>This policy detects active job searches.</td>
</tr>
<tr>
<td></td>
<td>See “Resumes policy template” on page 852.</td>
</tr>
</tbody>
</table>
Table 15-5  Confidential or Classified Data Protection policy templates  
(continued)

<table>
<thead>
<tr>
<th>Policy template</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Code</td>
<td>This policy detects various types of source code. See “Source Code policy template” on page 858.</td>
</tr>
<tr>
<td>Symantec DLP Awareness and Avoidance</td>
<td>This policy detects any communications that refer to Symantec DLP or other data loss prevention systems and possible avoidance of detection. See “Symantec DLP Awareness and Avoidance policy template” on page 863.</td>
</tr>
</tbody>
</table>

Network Security Enforcement policy templates

Symantec Data Loss Prevention provides several policy templates for Network Security Enforcement.

See “Creating a policy from a template” on page 312.

Table 15-6  Network Security Enforcement policy templates

<table>
<thead>
<tr>
<th>Policy template</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Common Spyware Upload Sites</td>
<td>This policy detects access to common spyware upload Web sites. See “Common Spyware Upload Sites policy template” on page 806.</td>
</tr>
<tr>
<td>Network Diagrams</td>
<td>This policy detects computer network diagrams. See “Network Diagrams policy template” on page 839.</td>
</tr>
<tr>
<td>Network Security</td>
<td>This policy detects evidence of hacking tools and attack planning. See “Network Security policy template” on page 840.</td>
</tr>
<tr>
<td>Password Files</td>
<td>This policy detects password file formats. See “Password Files policy template” on page 844.</td>
</tr>
</tbody>
</table>

Acceptable Use Enforcement policy templates

Symantec Data Loss Prevention provides several policy templates for allowing acceptable uses of information.

See “Creating a policy from a template” on page 312.
<table>
<thead>
<tr>
<th>Policy template</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Competitor Communications</td>
<td>This policy detects forbidden communications with competitors. See “Competitor Communications policy template” on page 806.</td>
</tr>
<tr>
<td>Forbidden Websites</td>
<td>This policy detects access to specified Web sites. See “Forbidden Websites policy template” on page 823.</td>
</tr>
<tr>
<td>Gambling</td>
<td>This policy detects any reference to gambling. See “Gambling policy template” on page 824.</td>
</tr>
<tr>
<td>Illegal Drugs</td>
<td>This policy detects conversations about illegal drugs and controlled substances. See “Illegal Drugs policy template” on page 831.</td>
</tr>
<tr>
<td>Media Files</td>
<td>This policy detects various types of video and audio files. See “Media Files policy template” on page 833.</td>
</tr>
<tr>
<td>Offensive Language</td>
<td>This policy detects the use of offensive language. See “Offensive Language policy template” on page 840.</td>
</tr>
<tr>
<td>Racist Language</td>
<td>This policy detects the use of racist language. See “Racist Language policy template” on page 851.</td>
</tr>
<tr>
<td>Restricted Files</td>
<td>This policy detects various file types that are generally inappropriate to send out of the company. See “Restricted Files policy template” on page 851.</td>
</tr>
<tr>
<td>Restricted Recipients</td>
<td>This policy detects communications with specified recipients. See “Restricted Recipients policy template” on page 851.</td>
</tr>
<tr>
<td>Sexually Explicit Language</td>
<td>This policy detects sexually explicit content. See “Sexually Explicit Language policy template” on page 857.</td>
</tr>
<tr>
<td>Violence and Weapons</td>
<td>This policy detects violent language and discussions about weapons. See “Violence and Weapons policy template” on page 867.</td>
</tr>
<tr>
<td>Webmail</td>
<td>This policy detects the use of a variety of Webmail services. See “Webmail policy template” on page 868.</td>
</tr>
<tr>
<td>Yahoo Message Board Activity</td>
<td>This policy detects Yahoo message board activity. See “Yahoo Message Board Activity policy template” on page 869.</td>
</tr>
</tbody>
</table>
Table 15-7  Acceptable Use Enforcement policy templates (continued)

<table>
<thead>
<tr>
<th>Policy template</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yahoo and MSN Messengers on Port 80</td>
<td>This policy detects Yahoo IM and MSN Messenger activity.</td>
</tr>
<tr>
<td></td>
<td>See “Yahoo and MSN Messengers on Port 80 policy template” on page 870.</td>
</tr>
</tbody>
</table>

Choosing an Exact Data Profile

If the policy template you select implements Exact Data Matching (EDM), the system prompts you to choose an Exact Data Profile. Table 15-8 lists the policy templates that are based on Exact Data Profiles.

If you do not have an Exact Data Profile, you can cancel policy creation and define a profile. Or, you can choose not to use an Exact Data Profile. In this case the system disables the associated EDM detection rules in the policy template. You can use any DCM rules or exceptions the policy template provides.

See “Introducing Exact Data Matching (EDM)” on page 367.

See “About the Exact Data Profile and index” on page 371.

To choose an Exact Data Profile

1. Select an **Exact Data Profile** from the list of available profiles.
2. Click **Next** to continue with creating the policy from the template.

   Click **Previous** to return to the list of policy templates.

   See “Creating a policy from a template” on page 312.

**Note:** When the system prompts you to select an Exact Data Profile, the display lists the data columns to include in the profile to provide the highest level of accuracy. If data fields in your Exact Data Profile are not represented in the selected policy template, the system displays those fields for content matching when you define the detection rule

Table 15-8  Policy templates that implement Exact Data Matching (EDM)

<table>
<thead>
<tr>
<th>Policy template</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Data Protection</td>
<td>See “Customer Data Protection policy template” on page 808.</td>
</tr>
</tbody>
</table>
Table 15-8  Policy templates that implement Exact Data Matching (EDM) (continued)

<table>
<thead>
<tr>
<th>Policy template</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee Data Protection</td>
<td>See &quot;Employee Data Protection policy template&quot; on page 815.</td>
</tr>
<tr>
<td>EU Data Protection Directives</td>
<td>See &quot;Data Protection Directives (EU) policy template&quot; on page 811.</td>
</tr>
<tr>
<td>Export Administration Regulations (EAR)</td>
<td>See &quot;Export Administration Regulations (EAR) policy template&quot; on page 817.</td>
</tr>
<tr>
<td>Gramm-Leach-Bliley</td>
<td>See &quot;Gramm-Leach-Bliley policy template&quot; on page 824.</td>
</tr>
<tr>
<td>HIPAA and HITECK (including PHI)</td>
<td>See &quot;HIPAA and HITECH (including PHI) policy template&quot; on page 826.</td>
</tr>
<tr>
<td>International Traffic in Arms Regulations (ITAR)</td>
<td>See &quot;International Traffic in Arms Regulations (ITAR) policy template&quot; on page 832.</td>
</tr>
<tr>
<td>PIPEDA</td>
<td>See &quot;PIPEDA policy template&quot; on page 846.</td>
</tr>
<tr>
<td>Price Information</td>
<td>See &quot;Price Information policy template&quot; on page 848.</td>
</tr>
<tr>
<td>Resumes</td>
<td>See &quot;Resumes policy template&quot; on page 852.</td>
</tr>
<tr>
<td>State Data Privacy</td>
<td>See &quot;SEC Fair Disclosure Regulation policy template&quot; on page 855.</td>
</tr>
</tbody>
</table>

Choosing an Indexed Document Profile

If the policy template you chose uses Indexed Document Matching (IDM) detection, the system prompts you to select the Document Profile.

See “Introducing Indexed Document Matching (IDM)” on page 462.

To use a Document Profile

1. Select the Document Profile from the list of available profiles.
2. Click Next to create the policy from the template.

See “Creating a policy from a template” on page 312.

If you do not have a Document Profile, you can cancel policy creation and define the Document Profile. Or, you can choose to not use a Document Profile. In this
case the system disables any IDM rules or exceptions for the policy instance. If the policy template contains DCM rules or exceptions, you may use them. See “About the Indexed Document Profile” on page 465.

<table>
<thead>
<tr>
<th>Policy template</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAN-SPAM Act (IDM exception)</td>
<td>See “CAN-SPAM Act policy template” on page 805.</td>
</tr>
<tr>
<td>NASD Rule 2711 and NYSE Rules 351 and 472</td>
<td>See “NASD Rule 2711 and NYSE Rules 351 and 472 policy template” on page 835.</td>
</tr>
<tr>
<td>Sarbanes-Oxley</td>
<td>See “Sarbanes-Oxley policy template” on page 853.</td>
</tr>
<tr>
<td>Confidential Documents</td>
<td>See “Confidential Documents policy template” on page 807.</td>
</tr>
<tr>
<td>Financial Information</td>
<td>See “Financial Information policy template” on page 822.</td>
</tr>
<tr>
<td>Project Data</td>
<td>See “Project Data policy template” on page 849.</td>
</tr>
<tr>
<td>Proprietary Media Files</td>
<td>See “Proprietary Media Files policy template” on page 849.</td>
</tr>
<tr>
<td>Publishing Documents</td>
<td>See “Publishing Documents policy template” on page 850.</td>
</tr>
<tr>
<td>Source Code</td>
<td>See “Source Code policy template” on page 858.</td>
</tr>
<tr>
<td>Network Diagrams</td>
<td>See “Network Diagrams policy template” on page 839.</td>
</tr>
</tbody>
</table>
Adding a new policy or policy template

As a policy author you can define a new policy from scratch or from a template. See "Workflow for implementing policies" on page 293.
To add a new policy or a policy template

1. Click Add Policy at the Manage > Polices > Policy List screen.
   See “Manage and add policies” on page 345.

2. Choose the type of policy you want to add at the New Policy screen.
   Select Add a blank policy to add a new empty policy.
   See “Policy components” on page 285.
   Select Add a policy from a template to add a policy from a template.
   See “Policy templates” on page 286.

3. Click Next to configure the policy or the policy template.
   See “Configuring policies” on page 326.
   See “Creating a policy from a template” on page 312.
   Click Cancel to not add a policy and return to the Policy List screen.

Configuring policies

The Manage > Policies > Policy List > Configure Policy screen is the home page for configuring policies.

Table 16-1 describes the workflow for configuring policies.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define a new policy, or edit an existing policy.</td>
<td>Add a new blank policy.</td>
</tr>
<tr>
<td></td>
<td>See “Adding a new policy or policy template” on page 325.</td>
</tr>
<tr>
<td></td>
<td>Create a policy from a template.</td>
</tr>
<tr>
<td></td>
<td>See “Creating a policy from a template” on page 312.</td>
</tr>
<tr>
<td></td>
<td>Select an existing policy at the Manage &gt; Policies &gt; Policy List screen to edit it.</td>
</tr>
<tr>
<td></td>
<td>See “Manage and add policies” on page 345.</td>
</tr>
</tbody>
</table>

Enter a policy Name and Description. | The policy name must be unique in the policy group you deploy the policy to. |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>See “Input character limits for policy configuration” on page 344.</td>
</tr>
<tr>
<td></td>
<td>Note: The Policy Label field is reserved for the Symantec Data Insight Self-Service Portal.</td>
</tr>
</tbody>
</table>
### Table 16-1 Configuring policies (continued)

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the <strong>Policy Group</strong> from the list where the policy is to be deployed.</td>
<td>The <strong>Default Policy Group</strong> is selected if there is no policy group configured.  &lt;br&gt;See “Creating and modifying policy groups” on page 348.</td>
</tr>
<tr>
<td>Set the <strong>Status</strong> for the policy.</td>
<td>You can enable (default setting) or disable a policy. A disabled policy is deployed but is not loaded into memory to detect incidents.  &lt;br&gt;See “Manage and add policies” on page 345.  &lt;br&gt;<strong>Note:</strong> The <strong>Policy Actions</strong> setting only applies to Classification policies. See the Enterprise Vault Data Classification Services Implementation Guide.</td>
</tr>
<tr>
<td>Add a rule to the policy, or edit an existing rule.</td>
<td>Click <strong>Add Rule</strong> to add a rule.  &lt;br&gt;See “Adding a rule to a policy” on page 328.  &lt;br&gt;Select an existing rule to edit it.</td>
</tr>
<tr>
<td>Configure the rule with one or more conditions.</td>
<td>For a valid policy, you must configure at least one rule that declares at least one condition. Compound conditions and exceptions are optional.  &lt;br&gt;See “Configuring policy rules” on page 330.</td>
</tr>
<tr>
<td>Optionally, add one or more policy exceptions, or edit an existing exception.</td>
<td>Click <strong>Add Exception</strong> to add it.  &lt;br&gt;See “Adding an exception to a policy” on page 337.  &lt;br&gt;Select an existing exception to edit it.</td>
</tr>
<tr>
<td>Configure any exception(s).</td>
<td>See “Configuring policy exceptions” on page 340.</td>
</tr>
<tr>
<td>Save the policy configuration.</td>
<td>Click <strong>Save</strong> to save the policy configuration to the Enforce Server database.  &lt;br&gt;See “Policy components” on page 285.</td>
</tr>
<tr>
<td>Export the policy as a template.</td>
<td>Optionally, you can export the policy rules and exceptions as a template.  &lt;br&gt;See “Exporting policy detection as a template” on page 350.</td>
</tr>
<tr>
<td>Add one or more response rules to the policy.</td>
<td>You configure response rules independent of policies.  &lt;br&gt;See “Configuring response rules” on page 891.  &lt;br&gt;See “Adding an automated response rule to a policy” on page 350.</td>
</tr>
</tbody>
</table>
Adding a rule to a policy

At the Manage > Policies > Policy List > Configure Policy – Add Rule screen you add one or more rules to a policy.

You can add two types of rules to a policy: detection and group. If two or more rules in a policy are the same type, the system connects them by OR. If two or more rules in the same policy are different types, the system connects them by AND.

See “Policy detection execution” on page 308.

**Note:** Exceptions are added separate from rules. See “Adding an exception to a policy” on page 337.

To add one or more rules to a policy

1. Choose the type of rule (detection or group) to add to the policy.
   
   To add a detection rule, select the Detection tab and click Add Rule.
   
   To add a group (identity) rule, select the Groups tab and click Add Rule.
   
   See “Policy matching conditions” on page 300.

2. Select the detection or the group rule you want to implement from the list of rules.
   
   See Table 16-2 on page 328.

3. Select the prerequisite component, if required.
   
   If the policy rule requires a Data Profile, Data Identifier, or User Group select it from the list.

4. Click Next to configure the policy rule.
   
   See “Configuring policy rules” on page 330.

<table>
<thead>
<tr>
<th>Rule</th>
<th>Prerequisite</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Content match conditions</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Content Matches Regular Expression</td>
<td></td>
<td>See “Introducing regular expression matching” on page 598.</td>
</tr>
<tr>
<td>Content Matches Exact Data</td>
<td>Exact Data Profile</td>
<td>See “About the Exact Data Profile and index” on page 371.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Choosing an Exact Data Profile” on page 322.</td>
</tr>
</tbody>
</table>
### Table 16-2  Adding policy rules (continued)

<table>
<thead>
<tr>
<th>Rule</th>
<th>Prerequisite</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content Matches Keyword</td>
<td></td>
<td>See “Introducing keyword matching” on page 584.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Choosing an Indexed Document Profile” on page 323.</td>
</tr>
<tr>
<td>Content Matches Data Identifier</td>
<td>Data Identifier</td>
<td>See “Introducing data identifiers” on page 541.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Selecting a data identifier breadth” on page 555.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Configuring VML profiles and policy conditions” on page 513.</td>
</tr>
</tbody>
</table>

**File Properties** match conditions

| Message Attachment or File Type Match     |                                       | See “About file type matching” on page 609.                                |
| Message Attachment or File Size Match    |                                       | See “About file size matching” on page 611.                                |
| Message Attachment or File Name Match    |                                       | See “About file name matching” on page 611.                                |
| Message/Email Properties and Attributes  | Enterprise Vault integration          | See “About implementing detection for Enterprise Vault Classification” on page 620. |
|                                           |                                       | See the *Enterprise Vault Data Classification Services Implementation Guide*.|
| Custom File Type Signature               | Rule enabled                          | See “About custom file type identification” on page 610.                   |
|                                           | Custom script                         | See “Enabling the Custom File Type Signature condition in the policy console” on page 616. |

**Protocol and Endpoint** match conditions

| Protocol Monitoring                       | Custom protocols (if any)            | See “Introducing protocol monitoring for network” on page 626.             |
|                                           |                                       | See “Introducing protocol monitoring for mobile” on page 627.              |
| Endpoint Monitoring                       |                                       | See “About endpoint protocol monitoring” on page 632.                      |
### Configuring policy rules

At the Manage > Policies > Policy List > Configure Policy – Edit Rule screen, you configure a policy rule with one or more match conditions. The configuration of each rule condition depends on its type.

See Table 16-4 on page 331.

#### Table 16-2  Adding policy rules (continued)

<table>
<thead>
<tr>
<th>Rule</th>
<th>Prerequisite</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Endpoint Device Class or ID</td>
<td>Custom device(s)</td>
<td>See “About endpoint device detection” on page 634.</td>
</tr>
<tr>
<td>Endpoint Location</td>
<td></td>
<td>See “About endpoint location detection” on page 634.</td>
</tr>
<tr>
<td><strong>Groups</strong> (Identities) match conditions</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sender/User Matches Pattern</td>
<td></td>
<td>See &quot;Introducing described identity matching&quot; on page 643.</td>
</tr>
<tr>
<td>Recipient Matches Pattern</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Recipient based on a Directory</td>
<td>Exact Data Profile</td>
<td>See &quot;Introducing profiled Directory Group Matching (DGM)&quot; on page 661.</td>
</tr>
<tr>
<td>Server Group</td>
<td></td>
<td>See “Configuring Exact Data profiles for DGM” on page 662.</td>
</tr>
</tbody>
</table>

#### Configuring policy rules

At the Manage > Policies > Policy List > Configure Policy – Edit Rule screen, you configure a policy rule with one or more match conditions. The configuration of each rule condition depends on its type.

See Table 16-4 on page 331.

#### Table 16-3  Configuring policy rules

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Add a rule to a policy, or modify a rule.</td>
<td>See “Adding a rule to a policy” on page 328. To modify an existing rule, select the rule in the policy builder interface at the Configure Policy – Edit Rule screen.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Name the rule, or modify a name.</td>
<td>In the General section of the rule, enter a name in the Rule Name field, or modify the name of an existing rule.</td>
</tr>
</tbody>
</table>
### Table 16-3 Configuring policy rules (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 3</strong></td>
<td>Set the rule severity.</td>
<td>In the <strong>Severity</strong> section of the rule, select or modify a &quot;Default&quot; severity level. In addition to the default severity, you can add multiple severity levels to a rule. See “Defining rule severity” on page 333.</td>
</tr>
<tr>
<td><strong>Step 4</strong></td>
<td>Configure the match condition.</td>
<td>In the <strong>Conditions</strong> section of the rule, you configure one or more match conditions for the rule. The configuration of a condition depends on its type. See Table 16-4 on page 331.</td>
</tr>
<tr>
<td><strong>Step 5</strong></td>
<td>Configure match counting (if required).</td>
<td>If the rule calls for it, configure how you want to count matches. See “Configuring match counting” on page 334.</td>
</tr>
<tr>
<td><strong>Step 6</strong></td>
<td>Select components to match on (if available).</td>
<td>If the rule is content-based, select one or more available content rules to match on. See “Selecting components to match on” on page 336.</td>
</tr>
<tr>
<td><strong>Step 7</strong></td>
<td>Add and configure one or more additional match conditions (optional).</td>
<td>To define a compound rule, <strong>Add</strong> another match condition from the <strong>Also Match</strong> list. Configure the additional condition according to its type (Step 4). See “Configuring compound match conditions” on page 342. <strong>Note:</strong> All conditions in a single rule must match to trigger an incident. See “Policy detection execution” on page 308.</td>
</tr>
<tr>
<td><strong>Step 8</strong></td>
<td>Save the policy configuration.</td>
<td>When you are done configuring the rule, click <strong>OK</strong>. This action returns you to the <strong>Configure Policy</strong> screen where you can <strong>Save</strong> the policy. See “Manage and add policies” on page 345.</td>
</tr>
</tbody>
</table>

Table 16-4 lists each of the available match conditions and provides links to topics for configuring each condition.

### Table 16-4 Configuring policy match conditions

<table>
<thead>
<tr>
<th>Rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Content</strong></td>
<td>match conditions</td>
</tr>
</tbody>
</table>
### Table 16-4
Configuring policy match conditions (continued)

<table>
<thead>
<tr>
<th>Rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content Matches Regular Expression</td>
<td>See “Configuring the Content Matches Regular Expression condition” on page 600.</td>
</tr>
<tr>
<td>Content Matches Exact Data from an Exact Data Profile</td>
<td>See “Configuring the Content Matches Exact Data policy condition” on page 396.</td>
</tr>
<tr>
<td>Content Matches Keyword</td>
<td>See “Configuring the Content Matches Keyword condition” on page 591.</td>
</tr>
<tr>
<td>Content Matches Document Signature</td>
<td>See “Configuring the Content Matches Document Signature policy condition” on page 497.</td>
</tr>
<tr>
<td>Content Matches Data Identifier</td>
<td>See “Configuring the Content Matches data identifier condition” on page 552.</td>
</tr>
</tbody>
</table>

**File Properties** match conditions

<table>
<thead>
<tr>
<th>Message Attachment or File Type Match</th>
<th>See “Configuring the Message Attachment or File Type Match condition” on page 612.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message Attachment or File Size Match</td>
<td>See “Configuring the Message Attachment or File Size Match condition” on page 613.</td>
</tr>
<tr>
<td>Message Attachment or File Name Match</td>
<td>See “Configuring the Message Attachment or File Name Match condition” on page 614.</td>
</tr>
<tr>
<td>Message/Email Properties and Attributes</td>
<td>See “Configuring the Message/Email Properties and Attributes condition” on page 623.</td>
</tr>
<tr>
<td></td>
<td>See the <em>Enterprise Vault Data Classification Services Implementation Guide</em>.</td>
</tr>
<tr>
<td>Custom File Type Signature</td>
<td>See “Configuring the Custom File Type Signature condition” on page 617.</td>
</tr>
</tbody>
</table>

**Protocol** match conditions

| Network or Mobile Monitoring | See “Configuring the Protocol Monitoring condition for network detection” on page 628. |
|                            | See “Configuring the Protocol Monitoring condition for mobile detection” on page 629. |
| Endpoint Monitoring         | See “Configuring the Endpoint Monitoring condition” on page 635.                   |
| Endpoint Device Class or ID | See “Configuring the Endpoint Device Class or ID condition” on page 638.           |
| Endpoint Location           | See “Configuring the Endpoint Location condition” on page 637.                     |
Table 16-4  Configuring policy match conditions (continued)

<table>
<thead>
<tr>
<th>Rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Groups match conditions</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Sender/User Matches Pattern</strong></td>
<td>See “Configuring the Sender/User Matches Pattern condition” on page 645.</td>
</tr>
<tr>
<td><strong>Recipient Matches Pattern</strong></td>
<td>See “Configuring the Recipient Matches Pattern condition” on page 648.</td>
</tr>
<tr>
<td><strong>Sender/User based on a Directory Server Group</strong></td>
<td>See “Configuring the Sender/User based on a Directory Server Group condition” on page 657.</td>
</tr>
<tr>
<td><strong>Sender/User based on a Directory from an Exact Data Profile</strong></td>
<td>See “Configuring the Sender/User based on a Profiled Directory condition” on page 663.</td>
</tr>
<tr>
<td><strong>Recipient based on a Directory Server Group</strong></td>
<td>See “Configuring the Recipient based on a Directory Server Group condition” on page 658.</td>
</tr>
<tr>
<td><strong>Recipient based on a Directory from an Exact Data Profile</strong></td>
<td>See “Configuring the Recipient based on a Profiled Directory condition” on page 664.</td>
</tr>
</tbody>
</table>

Defining rule severity

The system assigns a severity level to a policy rule violation. The default setting is "High." You can configure the default, and add one or more additional severity levels.

See “Policy severity” on page 289.

Policy rule severity works with the **Severity** response rule condition. If you set the default policy rule severity level to "High" and define additional severity levels, the system does not assign the additional severity to the incident based on match count. The result is that if you have a response rule set to a match count severity level that is less than the default "High" severity, the response rule does not execute.

See “Configuring the Severity response condition” on page 903.

To define policy rule severity

1. Configure a policy rule.
   
   See “Configuring policy rules” on page 330.

2. Select a **Default** level from the **Severity** list.
   
   The default severity level is the baseline level that the system reports. The system applies the default severity level to any rule match, unless additional severity levels override the default setting.
3 Click **Add Severity** to define additional severity levels for the rule.
   If you add a severity level it is based on the match count.

4 Select the desired severity level, choose the match count range, and enter the match count.
   For example, you can set a Medium severity with X range to match after 100 matches have been counted.

5 If you add an additional severity level, you can select it to be the default severity.

6 To remove a defined severity level, click the X icon beside the severity definition.

## Configuring match counting

Some conditions let you specify how you want to count matches. Count all matches is the default behavior. You can configure the minimum number of matches required to cause an incident. Or, you can count all matches as one incident. If a condition supports match counting, you can configure this setting for both policy rules and exceptions.

See Table 16-6 on page 335.

### Table 16-5 Configuring match counting

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Condition type</th>
<th>Incident description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check for existence</td>
<td>Simple</td>
<td>This configuration reports a match count of 1 if there are one or more matches; it does not count multiple matches. For example, 10 matches are one incident.</td>
</tr>
<tr>
<td></td>
<td>Compound</td>
<td>This configuration reports a match count of 1 if there are one or more matches and ALL conditions in the rule or exception are set to check for existence.</td>
</tr>
</tbody>
</table>
Table 16-5  Configuring match counting (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Condition type</th>
<th>Incident description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Count all matches</td>
<td>Simple</td>
<td>This configuration reports a match count of the exact number of matches detected by the condition. For example, 10 matches count as 10 incidents.</td>
</tr>
<tr>
<td></td>
<td>Compound</td>
<td>This configuration reports a match count of the sum of all condition matches in the rule or exception. The default is one incident per condition match and applies if any condition in the rule or exception is set to count all matches. For example, if a rule has two conditions and one is set to count all matches and detects four matches, and the other condition is set to check for existence and detects six matches, the reported match count is 10. If a third condition in the rule detects a match, the match count is 11.</td>
</tr>
<tr>
<td>Only report incidents with at least _ matches</td>
<td>Simple</td>
<td>You can change the default one incident per match count by specifying the minimum number of matches required to report an incident. For example, in a rule with two conditions, if you configure one condition to count all matches and specify five as the minimum number of matches for each condition, a sum of 10 matches reported by the two conditions generates two incidents. You must be consistent and select this option for each condition in the rule or exception to achieve this behavior. <strong>Note:</strong> The count all matches setting applies to each message component you match on. For example, consider a policy where you specify a match count of 3 and configure a keyword rule that matches on all four message components (default setting for this condition). If a message is received with two instances of the keyword in the body and one instance of the keyword in the envelope, the system does not report this as a match. However, if three instances of the keyword appear in an attachment (or any other single message component), the system would report it as a match.</td>
</tr>
<tr>
<td>Count all unique matches</td>
<td>Only count unique matches</td>
<td>Unique match counting is new for Symantec Data Loss Prevention version 11.6 and is only available for Data Identifiers. See “About unique match counting” on page 549.</td>
</tr>
</tbody>
</table>

Table 16-6  Conditions that support match counting

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content Matches Regular Expression</td>
<td>See “Introducing regular expression matching” on page 598.</td>
</tr>
<tr>
<td></td>
<td>See “Configuring the Content Matches Regular Expression condition” on page 600.</td>
</tr>
<tr>
<td>Content Matches Keyword</td>
<td>See “Introducing keyword matching” on page 584.</td>
</tr>
<tr>
<td></td>
<td>See “Configuring the Content Matches Keyword condition” on page 591.</td>
</tr>
</tbody>
</table>
### Table 16-6  Conditions that support match counting (continued)

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content Matches Document Signature (IDM)</td>
<td>See “Configuring the Content Matches Document Signature policy condition” on page 497.</td>
</tr>
<tr>
<td>Content Matches Data Identifier</td>
<td>See “Introducing data identifiers” on page 541.</td>
</tr>
<tr>
<td></td>
<td>See “Configuring the Content Matches data identifier condition” on page 552.</td>
</tr>
<tr>
<td></td>
<td>See “Configuring unique match counting” on page 563.</td>
</tr>
<tr>
<td>Recipient Matches Pattern</td>
<td>See “Introducing described identity matching” on page 643.</td>
</tr>
<tr>
<td></td>
<td>See “Configuring the Recipient Matches Pattern condition” on page 648.</td>
</tr>
</tbody>
</table>

### Selecting components to match on

The availability of one or more message components to match on depends on the type of rule or exception condition you implement.

See “Detection messages and message components” on page 305.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Envelope</td>
<td>If the condition supports matching on the <strong>Envelope</strong> component, select it to match on the message metadata. The envelope contains the header, transport information, and the subject if the message is an SMTP email.</td>
</tr>
<tr>
<td></td>
<td>If the condition does not support matching on the <strong>Envelope</strong> component, this option is grayed out.</td>
</tr>
<tr>
<td></td>
<td>If the condition matches on the entire message, the <strong>Envelope</strong> is selected and cannot be deselected, and the other components cannot be selected.</td>
</tr>
</tbody>
</table>
Table 16-7  Match on components (continued)

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
</table>
| Subject       | Certain detection conditions match on the **Subject** component for some types of messages.  
See “Detection messages and message components” on page 305.  
For the detection conditions that support subject component matching, you can match on the **Subject** for the following types of messages:  
  ■ SMTP (email) messages from Network Monitor or Network Prevent for Email.  
  ■ NNTP messages from Network Monitor.  
  ■ Exchange email messages delivered by the Classification Server.  
  See the *Enterprise Vault Data Classification Services Implementation Guide*.  
To match on the **Subject** component, you must select (check) the **Subject** component and uncheck (deselect) the **Envelope** component for the policy rule. If you select both components, the system matches the subject twice because the message subject is included in the envelope as part of the header. |
| Body          | If the condition matches on the **Body** message component, select it to match on the text or content of the message.                           |
| Attachment(s) | If the condition matches on the **Attachment(s)** message component, select it to detect content in files sent by, downloaded with, or attached to the message. |

**Adding an exception to a policy**

At the **Manage > Policies > Policy List > Configure Policy – Add Exception** screen you add one or more exception conditions to a policy. Policy exceptions are executed before policy rules. If there is an exception match, the entire message is discarded.

See “Exception conditions” on page 307.

*Note:* You can create exceptions for all policy conditions, except the EDM condition **Content Matches Exact Data From**. In addition, Network Prevent for Web does not support synchronized DGM exceptions.
To add an exception to a policy

1. Add an exception to a policy.
   
   To add a detection rule exception, select the Detection tab and click Add Exception.
   
   To add a group rule exception, select the Groups tab and click Add Exception.

2. Select the policy exception to implement.
   
   The Add Detection Exception screen lists all available detection exceptions that you can add to a policy.
   
   The Add Group Exception screen lists all available group exceptions that you can add to a policy.

   See Table 16-8 on page 338.

3. If necessary, choose the profile, data identifier, or user group.

4. Click Next to configure the exception.

   See “Configuring policy exceptions” on page 340.

Table 16-8  Selecting a policy exception

<table>
<thead>
<tr>
<th>Exception</th>
<th>Prerequisite</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Content</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Content Matches Regular Expression</td>
<td></td>
<td>See “Introducing regular expression matching” on page 598.</td>
</tr>
<tr>
<td>Content Matches Keyword</td>
<td></td>
<td>See “Introducing keyword matching” on page 584.</td>
</tr>
<tr>
<td>Content Matches Document Signature</td>
<td>Indexed Document Profile</td>
<td>See “Choosing an Indexed Document Profile” on page 323.</td>
</tr>
<tr>
<td>Content Matches Data Identifier</td>
<td>Data Identifier</td>
<td>See “Introducing data identifiers” on page 541. See “Selecting a data identifier breadth” on page 555.</td>
</tr>
</tbody>
</table>

**File Properties**

| Message Attachment or File Type Match |              | See “About file type matching” on page 609.           |
### Table 16-8  Selecting a policy exception (continued)

<table>
<thead>
<tr>
<th>Exception</th>
<th>Prerequisite</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message Attachment or File Size Match</td>
<td></td>
<td>See “About file size matching” on page 611.</td>
</tr>
<tr>
<td>Message Attachment or File Name Match</td>
<td></td>
<td>See “About file name matching” on page 611.</td>
</tr>
<tr>
<td>Message/Email Properties and Attributes</td>
<td>Enterprise Vault integration</td>
<td>See “About implementing detection for Enterprise Vault Classification” on page 620.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See the Enterprise Vault Data Classification Services Implementation Guide.</td>
</tr>
<tr>
<td>Custom File Type Signature</td>
<td>Condition enabled</td>
<td>See “About custom file type identification” on page 610.</td>
</tr>
<tr>
<td></td>
<td>Custom script added</td>
<td></td>
</tr>
<tr>
<td>Protocol and Endpoint</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Network or Mobile Protocol</td>
<td></td>
<td>See “Introducing protocol monitoring for network” on page 626.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Introducing protocol monitoring for mobile” on page 627.</td>
</tr>
<tr>
<td>Endpoint Protocol, Destination, Application</td>
<td></td>
<td>See “About endpoint protocol monitoring” on page 632.</td>
</tr>
<tr>
<td>Endpoint Device Class or ID</td>
<td></td>
<td>See “About endpoint device detection” on page 634.</td>
</tr>
<tr>
<td>Endpoint Location</td>
<td></td>
<td>See “About endpoint location detection” on page 634.</td>
</tr>
<tr>
<td>Group (identity)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sender/Recipient Matches Pattern</td>
<td></td>
<td>See “Introducing described identity matching” on page 643.</td>
</tr>
<tr>
<td>Recipient/Recipient Matches Pattern</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> Network Prevent for Web does not support this type of exception.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Use profiled DGM instead.</td>
</tr>
<tr>
<td>Recipient based on a Directory from:</td>
<td></td>
<td>See “Configuring Exact Data profiles for DGM” on page 662.</td>
</tr>
</tbody>
</table>
Configuring policy exceptions

At the Manage > Policies > Policy List > Configure Policy – Edit Exception screen you configure one or more conditions for a policy exception.

See Table 16-10 on page 341.

If an exception condition matches, the system discards the matched component from the system. This component is no longer available for evaluation.

See “Exception conditions” on page 307.

Table 16-9 Configure policy exceptions

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Add a new policy exception, or edit an existing exception.</td>
<td>See “Adding an exception to a policy” on page 337. Select an existing policy exception to modify it.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Name the exception, or edit an existing name or description.</td>
<td>In the General section, enter a unique name for the exception, or modify the name of an existing exception. Note: The exception name is limited to 60 characters.</td>
</tr>
</tbody>
</table>
| Step 3| Select the components to apply the exception to (if available). | If the exception is content-based, you can match on the entire message or on individual message components. See “Detection messages and message components” on page 305. Select one of the Apply Exception to options:  
  ■ Entire Message  
   This option applies the exception to the entire message.  
  ■ Matched Components Only  
   This option applies the exception to each message component you select from the Match On options in the Conditions section of the exception. |
| Step 4| Configure the exception condition. | In the Conditions section of the Configure Policy - Edit Exception screen, define the condition for the policy exception. The configuration of a condition depends on the exception type. See Table 16-10 on page 341. |
| Step 5| Add one or more additional conditions to the exception (optional). | You can add conditions until the exception is structured as desired. See “Configuring compound match conditions” on page 342. To add another condition to an exception, select the condition from the Also Match list. Click Add and configure the condition. |
Table 16-9  Configure policy exceptions (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 6</td>
<td>Save and manage the policy.</td>
<td>Click <strong>OK</strong> to complete the exception definition process. Click <strong>Save</strong> to save the policy. See “Manage and add policies” on page 345.</td>
</tr>
</tbody>
</table>

Table 16-10 lists the exception conditions that you can configure, with links to configuration details.

Table 16-10  Policy exception conditions available for configuration

<table>
<thead>
<tr>
<th>Exception</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Content</strong></td>
<td></td>
</tr>
<tr>
<td>Content Matches Regular Expression</td>
<td>See “Configuring the Content Matches Regular Expression condition” on page 600.</td>
</tr>
<tr>
<td>Content Matches Keyword</td>
<td>See &quot;Configuring the Content Matches Keyword condition&quot; on page 591.</td>
</tr>
<tr>
<td>Content Matches Document Signature</td>
<td>See “Configuring the Content Matches Document Signature policy condition” on page 497.</td>
</tr>
<tr>
<td>Content Matches Data Identifier</td>
<td>See “Configuring the Content Matches data identifier condition” on page 552.</td>
</tr>
<tr>
<td>Detect using Vector Machine Learning Profile</td>
<td>See “Configuring VML policy exceptions” on page 526.</td>
</tr>
<tr>
<td><strong>File Properties</strong></td>
<td></td>
</tr>
<tr>
<td>Message Attachment or File Type Match</td>
<td>See “Configuring the Message Attachment or File Type Match condition” on page 612.</td>
</tr>
<tr>
<td>Message Attachment or File Size Match</td>
<td>See “Configuring the Message Attachment or File Size Match condition” on page 613.</td>
</tr>
<tr>
<td>Message Attachment or File Name Match</td>
<td>See “Configuring the Message Attachment or File Name Match condition” on page 614.</td>
</tr>
<tr>
<td>Email/MAPI Attributes</td>
<td>See “Configuring the Message/Email Properties and Attributes condition” on page 623.</td>
</tr>
<tr>
<td></td>
<td>See the Enterprise Vault Data Classification Services Implementation Guide.</td>
</tr>
<tr>
<td>Custom File Type Signature</td>
<td>See “Configuring the Custom File Type Signature condition” on page 617.</td>
</tr>
<tr>
<td><strong>Protocol and Endpoint</strong></td>
<td></td>
</tr>
</tbody>
</table>
### Table 16-10  Policy exception conditions available for configuration (continued)

<table>
<thead>
<tr>
<th>Exception</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network or Mobile Protocol</td>
<td>See “Configuring the Protocol Monitoring condition for network detection” on page 628.</td>
</tr>
<tr>
<td>Endpoint Protocol or Destination</td>
<td>See “Configuring the Endpoint Monitoring condition” on page 635.</td>
</tr>
<tr>
<td>Endpoint Device Class or ID</td>
<td>See “Configuring the Endpoint Device Class or ID condition” on page 638.</td>
</tr>
<tr>
<td>Endpoint Location</td>
<td>See “Configuring the Endpoint Location condition” on page 637.</td>
</tr>
<tr>
<td><strong>Group (identity)</strong></td>
<td></td>
</tr>
<tr>
<td>Sender/User Matches Pattern</td>
<td>See “Configuring the Sender/User Matches Pattern condition” on page 645.</td>
</tr>
<tr>
<td>Recipient Matches Pattern</td>
<td>See “Configuring the Recipient Matches Pattern condition” on page 648.</td>
</tr>
<tr>
<td>Sender/User based on a Directory from an EDM Profile</td>
<td>See “Configuring the Sender/User based on a Profiled Directory condition” on page 663.</td>
</tr>
<tr>
<td>Recipient based on a Directory from and EDM Profile</td>
<td>See “Configuring the Recipient based on a Profiled Directory condition” on page 664.</td>
</tr>
</tbody>
</table>

### Configuring compound match conditions

You can create compound match conditions for policy rules and exceptions. See “Configuring compound match conditions” on page 342.

The detection engine connects compound conditions with an AND. All conditions in the rule or exception must be met to trigger or except an incident. See “Policy detection execution” on page 308.

You are not limited to the number of match conditions you can include in a rule or exception. However, the multiple conditions you declare in a single rule or exception should be logically associated. Do not mistake compound rules or exceptions with multiple rules or exceptions in a policy. See “Use compound conditions to improve match accuracy” on page 363.
### Table 16-11 Configure a compound policy rule or exception

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| Step 1 | Modify or configure an existing policy rule or exception.              | You can add one or more additional match conditions to a policy rule at the **Configure Policy – Edit Rule** screen.  
You can add one or more additional match conditions to a rule or exception at the **Configure Policy – Edit Rule** or **Configure Policy – Edit Exception** screen. |
| Step 2 | Select an additional match condition.                                  | Select the additional match condition from the **Also Match** list.  
This list appears at the bottom of the **Conditions** section for an existing rule or exception. |
| Step 3 | Review the available conditions.                                       | The system lists all available additional conditions you can add to a policy rule or exception.  
See “Adding a rule to a policy” on page 328.  
See “Adding an exception to a policy” on page 337. |
| Step 4 | Add the additional condition.                                          | Click **Add** to add the additional match condition to the policy rule or exception.  
Once added, you can collapse and expand each condition in a rule or exception. |
When configuring a policy, consider the following input character limits for policy configuration components.

### Table 16-12  
Input character limits for policy configuration

<table>
<thead>
<tr>
<th>Configuration element</th>
<th>Input character limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name of a policy component, including:</td>
<td></td>
</tr>
<tr>
<td>■ Policy</td>
<td>60 characters</td>
</tr>
<tr>
<td>■ Rule</td>
<td></td>
</tr>
<tr>
<td>■ Exception</td>
<td></td>
</tr>
<tr>
<td>■ Group</td>
<td></td>
</tr>
<tr>
<td>■ Condition</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** To import a policy as a template, the policy name must be less than 60 characters, otherwise it does not appear in the *Imported Templates* list.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Description of policy component.</td>
<td>255 characters</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Name of Data Profile, including:</th>
<th>255 characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>■ Exact Data</td>
<td></td>
</tr>
<tr>
<td>■ Indexed Document</td>
<td></td>
</tr>
<tr>
<td>■ Vector Machine Learning</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Data Identifier pattern limits</th>
<th>100 characters per line</th>
</tr>
</thead>
</table>

See “Using the data identifier pattern language” on page 573.
Administering policies

This chapter includes the following topics:

- Manage and add policies
- Manage and add policy groups
- Creating and modifying policy groups
- Importing policy templates
- Exporting policy detection as a template
- Adding an automated response rule to a policy
- Removing policies and policy groups
- Viewing and printing policy details
- Downloading policy details
- Troubleshooting policies
- Updating EDM and IDM profiles to the latest version
- Updating policies after upgrading to the latest version

Manage and add policies

The Manage > Policies > Policy List screen is the home page for adding and managing policies. You implement policies to detect and report data loss.

See “Workflow for implementing policies” on page 293.

Table 17-1 lists and describes the actions you can take at the Policy List screen.
### Table 17-1  
Policy List screen actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Policy</td>
<td>Click <strong>Add Policy</strong> to create a new policy. See &quot;Adding a new policy or policy template&quot; on page 325.</td>
</tr>
<tr>
<td>Modify Policy</td>
<td>Click anywhere in the policy row to modify an existing policy. See &quot;Configuring policies&quot; on page 326.</td>
</tr>
<tr>
<td>Activate Policy</td>
<td>Click the red circle icon by the policy name to activate the policy. Note: By default, all solution pack policies are activated on installation of the solution pack.</td>
</tr>
<tr>
<td>Suspend Policy</td>
<td>Click the green circle icon by the policy name. Note: By default, all solution pack policies are activated on installation of the solution pack.</td>
</tr>
<tr>
<td>Sort Policies</td>
<td>Click any <strong>column header</strong> to sort the policy list.</td>
</tr>
<tr>
<td>Remove Policy</td>
<td>Click the red X icon at the end of the policy row. On confirmation the system deletes the policy. Note: You cannot remove a policy that has active incidents. See &quot;Removing policies and policy groups&quot; on page 351.</td>
</tr>
<tr>
<td>Export and Import Policy Templates</td>
<td>See &quot;Importing policy templates&quot; on page 349. See &quot;Exporting policy detection as a template&quot; on page 350.</td>
</tr>
<tr>
<td>Download Policy Details</td>
<td>Click <strong>Download Policy Details</strong> to download details for all policies in the <strong>Policy List</strong>. Symantec Data Loss Prevention exports the policy details as HTML files in a ZIP archive. Open the archive to view and print individual policy details. See &quot;Downloading policy details&quot; on page 353.</td>
</tr>
<tr>
<td>View and print policy details</td>
<td>To view policy details for a single policy, click the printer icon at the end of the policy row. To print the policy details, use the print feature of your web browser. See &quot;Viewing and printing policy details&quot; on page 352.</td>
</tr>
</tbody>
</table>

**Table 17-2** lists and describes the display fields at the **Policy List** screen.

### Table 17-2  
Policy List screen display fields

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>View and sort by the name of the policy. See &quot;About Data Loss Prevention policies&quot; on page 283.</td>
</tr>
</tbody>
</table>
Table 17-2  Policy List screen display fields (continued)

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
</table>
| Description     | View the description of the policy.  
|                 | See “Policy templates” on page 286. |
| Policy Group    | View and sort by the policy group to which the policy is deployed.  
|                 | See “Policy groups” on page 287. |
| Last Modified   | View and sort by the date the policy was last updated.  
|                 | See “Policy authoring privileges” on page 290. |
| Misconfigured Policy | The policy icon is a yellow caution sign.  
|                 | See “Policy components” on page 285. |
| Active Policy   | The policy icon is green. An active policy can detect incidents. |
| Suspended Policy| The policy icon is red. A suspended policy is deployed but does not detect incidents. |

Manage and add policy groups

The System > Servers > Policy Groups screen lists the configured policy groups in the system.

From the Policy Groups screen you manage existing policy groups and add new ones.

Table 17-3  Policy Groups screen actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| Add Policy Group     | Click Add Policy Group to define a new policy group.  
|                      | See “Policy groups” on page 287. |
| Modify Policy Group  | To modify an existing policy group, click the name of the group, or click the pencil icon to the far right of the row.  
|                      | See “Creating and modifying policy groups” on page 348. |
| Remove Policy Group  | Click the red X icon to the far right of the row to delete that policy group from the system.  
|                      | A dialog box confirms the deletion.  
| Note: If you delete a policy group, you delete any policies that are assigned to that group.  
|                      | See “Removing policies and policy groups” on page 351. |
To view the policies deployed to an existing policy group, navigate to the System > Servers > Policy Groups > Configure Policy Group screen.

See “Creating and modifying policy groups” on page 348.

Creating and modifying policy groups

At the System > Servers > Policy Groups screen you configure a new policy group or modify an existing one.

See “Policy groups” on page 287.

To configure a policy group

1. Add a new policy group, or modify an existing one.

   See “Manage and add policy groups” on page 347.

2. Enter the Name of the policy group, or modify an existing name.

   Use an informative name. Policy authors and Enforce Server administrators rely on the policy group name when they associate the policy group with policies, roles, targets.

   The name value is limited to 256 characters.

3. Enter a Description of the policy group, or modify an existing description of an existing policy group.

4. Select one or more Servers to assign the policy group to.

   The system displays a check box for each detection server currently configured and registered with the Enforce Server.
Select (check) the All Servers option to assign the policy group to all detection servers in your system. If you leave this checkbox unselected, you can assign the policy group to individual servers. The All Discover Servers entry is not configurable because the system automatically assigns all policy groups to all Network Discover Servers. This feature lets you assign policy groups to individual Discover targets. See “Configuring the required fields for Network Discover targets” on page 1193.

Deselect (uncheck) the All Servers option to assign the policy group to individual detection servers. The system displays a check box for each server currently configured and registered with the Enforce Server. Select each individual detection server to assign the policy group.

5 Click Save to save the policy group configuration.

Note: The Policies in this Group section of the Policies Group screen lists all the policies in the policy group. You cannot edit these entries. When you create a new policy group, this section is blank. After you deploy one or more policies to a policy group (during policy configuration), the Policies in this Group section displays each policy in the policy group.

See “Configuring policies” on page 326.
See “Policy deployment” on page 288.

Importing policy templates

You can import one or more policy templates to the Enforce Server. You must have policy system privileges to import policy templates.

See “Policy import and export” on page 292.
See “Exporting policy detection as a template” on page 350.

To import one or more policy templates to the Enforce Server

1 Place one or more policy templates XML file(s) in the \SymantecDLP\Protect\config\templates directory on the Enforce Server host.
You can import multiple policies by placing them all in the templates directory.

2 Make sure that the directory and file(s) are readable by the "protect" system user.
Log on to the Enforce Server Administration Console with policy authoring privileges.

Navigate to Manage > Policies > Policy List and click Add Policy.

Choose the option Add a policy from a template and click Next.

Scroll down to the bottom of the template list to the Imported Templates section.

You should see an entry for each XML file you placed in the templates directory.

Select the imported policy template and click Next to configure it.

See “Configuring policies” on page 326.

Exporting policy detection as a template

You can export policy detection rules and exceptions in a template (XML file). You cannot export policy response rules. You can only export one policy template at a time.

See “Policy import and export” on page 292.

To export a policy as a template

1. Log on to the Enforce Server administration console with administrator privileges.
2. Navigate to the Manage > Policies > Policy List > Configure Policy screen for the policy you want to export.
3. At the bottom of the Configure Policy screen, click the Export this policy as a template link.
4. Save the policy to a local or network destination of your choice.

For example, the system exports a policy named Webmail to the policy template file Webmail.xml which you can save to your local drive.

See “Importing policy templates” on page 349.

Adding an automated response rule to a policy

You can add one or more automated response rules to a policy to take action when that policy is violated.

See “About response rules” on page 875.
To add an automated response rule to a policy

1. Log on to the Enforce Server administration console with policy authoring privileges.
   
   See “Policy authoring privileges” on page 290.

2. Navigate to the Manage > Policies > Policy List > Configure Policy screen for the policy you want to add a response rule to.

3. Select the response rule you want to add from those available in the drop-down menu.
   
   Policies and response rules are configured separately. To add a response rule to a policy, the response rule must first be defined and saved independently.
   
   See “Implementing response rules” on page 886.

4. Click Add Response Rule to add the response rule to the policy.

5. Repeat the process to add additional response rules to the policy.

6. Save the policy when you are done adding response rules.

7. Verify that the policy status is green after adding the response rule to the policy.
   
   See “Manage and add policies” on page 345.

---

Note: If the policy status is a yellow caution sign, the policy is misconfigured. The system does not support certain pairings of detection rules and automated response rule actions. See Table 70-2 on page 1366.

---

Removing policies and policy groups

Consider the following guidelines before you delete a policy or a policy group from the Enforce Server.
Table 17-5  Guidelines for removing policies and policy groups

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
<th>Guideline</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove a policy</td>
<td>If you attempt to delete a policy that has associated incidents, the system</td>
<td>If you want to delete a policy, you must first delete all incidents that are associated with that policy from the Enforce Server.</td>
</tr>
<tr>
<td></td>
<td>does not let you remove the policy.</td>
<td>See “Manage and add policies” on page 345. An alternative is to create an undeployed policy group (one that is not assigned to any detection servers). This method is useful to maintain legacy policies and incidents for review without keeping these policies in a deployed policy group. See “Policy import and export” on page 292.</td>
</tr>
<tr>
<td>Remove a policy group</td>
<td>If you attempt to delete a policy group that contains one or more policies,</td>
<td>Before you delete a policy group, remove any policies from that group by either deleting them or assigning them to different policy groups.</td>
</tr>
<tr>
<td></td>
<td>the system displays an error message. And, the policy group is not deleted.</td>
<td>See “Manage and add policy groups” on page 347. If you want to remove a policy group, create a maintenance policy group and move the policies you want to remove to the maintenance group. See “Creating and modifying policy groups” on page 348.</td>
</tr>
</tbody>
</table>

See “About Data Loss Prevention policies” on page 283.
See “Policy groups” on page 287.

Viewing and printing policy details

You can view and print policy details from the Policy List screen.
You must have the Author Policies privilege for the policies you want to view and print.
See “Policy authoring privileges” on page 290.
See “Viewing, printing, and downloading policy details” on page 295.
To view and print policy details

1. Navigate to Manage > Policies > Policy List and click the printer icon at the end of the policy row.

   The Policy Snapshot screen appears.


3. To print the policy details, use the Print command in your web browser from the Policy Snapshot screen.

Downloading policy details

You can download a ZIP archive of details for all policies in the Policy List. The ZIP archive contains HTML documents with details for each policy on the Policy List, as well as an index file to make it easier to find the policy details you want. The files are titled using the policy ID, such as 123.html. The index file is titled downloaded_policies_DATE.html, and it contains the policy name, description, status, policy group, and last modified date of all policies in the download, as well as links to the policy details.

You must have the Author Policies privilege for the policies you want to download.

See “Policy authoring privileges” on page 290.

See “Viewing, printing, and downloading policy details” on page 295.

To download policy details

1. Navigate to Manage > Policies > Policy List and click Download Policy Details.

2. In the Open File dialog box, click select Save File, then click OK.

3. To view details for a policy, extract the files from the ZIP archive, then open the file you want to view. Use the index file to search through the downloaded policies by policy name, description, status, policy group, or last modified date.

   The Policy Snapshot screen appears.

4. To print the policy details, use the Print command in your web browser from the Policy Snapshot screen.

Troubleshooting policies

Table 17-6 lists log files to consult for troubleshooting policies.
Table 17-6 Log files for troubleshooting policies

<table>
<thead>
<tr>
<th>Log file</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VontuMonitor.log</td>
<td>Logs when policies and profiles are sent from the Enforce Server to</td>
</tr>
<tr>
<td></td>
<td>detection servers and endpoint servers. Displays JRE errors.</td>
</tr>
<tr>
<td></td>
<td>See “Debug log files” on page 247.</td>
</tr>
<tr>
<td>detection_operational.log</td>
<td>Log the loading of policies and detection execution.</td>
</tr>
<tr>
<td>detection_operational_trace.log</td>
<td>See “Operational log files” on page 244.</td>
</tr>
<tr>
<td>FileReader.log</td>
<td>Logs when an index file is loaded into memory. For EDM, look for the</td>
</tr>
<tr>
<td></td>
<td>line &quot;loaded database profile.&quot; For IDM look for the line: &quot;loaded</td>
</tr>
<tr>
<td></td>
<td>document profile.&quot;</td>
</tr>
<tr>
<td></td>
<td>See “Debug log files” on page 247.</td>
</tr>
<tr>
<td>Indexer.log</td>
<td>Logs the operations of the Indexer process to generate EDM and IDM</td>
</tr>
<tr>
<td></td>
<td>indexes.</td>
</tr>
<tr>
<td></td>
<td>See “Debug log files” on page 247.</td>
</tr>
</tbody>
</table>

See “About log files” on page 243.
See “Log collection and configuration screen” on page 252.
See “Configuring server logging behavior” on page 252.
See “Collecting server logs and configuration files” on page 257.
See “Log files for troubleshooting VML training and policy detection” on page 531.
See “Advanced server settings” on page 203.
See “Advanced agent settings” on page 1414.

Updating EDM and IDM profiles to the latest version

Symantec Data Loss Prevention version 12.5 provides several significant updates to Exact Data Matching (EDM) and Indexed Document Matching (IDM) technologies. See the Symantec Data Loss Prevention What's New and What's Changed Guide for more information.

To use these new features on an upgraded system, you must reindex your data and document sources. Before deploying an index into production, you should test the updated profile and policies based on it to ensure that they detect data loss as expected on the upgraded system.

Table 17-7 lists the reindexing requirements for updating your EDM and IDM profiles to version 12.5 and provides links for more information.
Table 17-7  Reindexing requirements for EDM and IDM data profiles

<table>
<thead>
<tr>
<th>Technology and features</th>
<th>Required action(s)</th>
<th>More information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exact Data Matching (EDM)</td>
<td>If you have existing Exact Data profiles supporting EDM policies and you want to use new EDM features, before upgrading the detection server(s) you must:</td>
<td>See “Updating EDM indexes to version 12.5” on page 416. In addition, refer to the chapter “Updating EDM indexes to version 12.5” in the Symantec Data Loss Prevention Administration Guide and the online Help.</td>
</tr>
<tr>
<td>■ Multi-token matching</td>
<td>■ Reindex each structured data source using a 12.5-compatible EDM indexer, and</td>
<td></td>
</tr>
<tr>
<td>■ Proportional proximity range</td>
<td>■ Load each index into a 12.5-generated Exact Data profile.</td>
<td></td>
</tr>
<tr>
<td>Indexed Document Matching (IDM)</td>
<td>If you have existing Indexed Document profiles supporting IDM policies and you want to use Agent IDM, after upgrading to 12.5 you must:</td>
<td>See “Using agent IDM after upgrade to version 12.5” on page 494. Or, refer to the topic &quot;Using Agent IDM after upgrade to version 12.5&quot; in the Symantec Data Loss Prevention Administration Guide and the online Help.</td>
</tr>
<tr>
<td>■ Exact match IDM on the endpoint (Agent IDM)</td>
<td>■ Disable two-tier detection on the Endpoint Server, and</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Reindex each document data source so that the endpoint index is generated and deployed to the Endpoint Server for download by the DLP Agent.</td>
<td></td>
</tr>
</tbody>
</table>

Updating policies after upgrading to the latest version

Symantec Data Loss Prevention provides several updates to policy templates. On upgrade the system updates the system-defined policy templates. Policies you have created based on an upgraded policy template are not changed so that configurations you have made are not overwritten. If you have created policies based on one or more of the updated policy templates, you should update your policies so that they are current.

The HIPAA and HITECH (including PHI) and the Caldicott Report policy templates are updated with recent Drug, Disease, and Treatment keyword list terminology based on information from the U.S. Federal Drug Administration (FDA) and other sources. Symantec recommends that you update policies derived from these templates with the updated Drug, Disease, and Treatment keyword lists.

See “Updating the Drug, Disease, and Treatment keyword lists for your HIPAA and Caldicott policies” on page 594.

In addition, policy templates that use data identifier patterns to detect Social Security Numbers (SSNs) are updated to use the Randomized US SSN data identifier, which detects both traditional and randomized SSNs. Symantec recommends that you update your SSN policies to use the Randomized US SSN data identifier.
Table 17-8 lists the policy templates updated for this release of Symantec Data Loss Prevention.

<table>
<thead>
<tr>
<th>Updated template</th>
<th>Updated component(s)</th>
<th>Policy description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Data Protection</td>
<td>Randomized US SSN data identifier</td>
<td>See “Customer Data Protection policy template” on page 808.</td>
</tr>
<tr>
<td>Employee Data Protection</td>
<td>Randomized US SSN data identifier</td>
<td>See “Employee Data Protection policy template” on page 815.</td>
</tr>
<tr>
<td>Gramm-Leach-Bliley</td>
<td>Randomized US SSN data identifier</td>
<td>See “Gramm-Leach-Bliley policy template” on page 824.</td>
</tr>
<tr>
<td>HIPAA and HITECH (including PHI)</td>
<td>Drug, Disease, and Treatment keyword lists</td>
<td>See “HIPAA and HITECH (including PHI) policy template” on page 826.</td>
</tr>
<tr>
<td>State Data Privacy</td>
<td>Randomized US SSN data identifier</td>
<td>See “State Data Privacy policy template” on page 859.</td>
</tr>
</tbody>
</table>
Best practices for authoring policies

This chapter includes the following topics:

- Best practices for authoring policies
- Develop a policy strategy that supports your data security objectives
- Use a limited number of policies to get started
- Use policy templates but modify them to meet your requirements
- Use the appropriate match condition for your data loss prevention objectives
- Test and tune policies to improve match accuracy
- Start with high match thresholds to reduce false positives
- Use a limited number of exceptions to narrow detection scope
- Use compound conditions to improve match accuracy
- Author policies to limit the potential effect of two-tier detection
- Use policy groups to manage policy lifecycle
- Follow detection-specific best practices

Best practices for authoring policies

This section provides general policy authoring best practices for Symantec Data Loss Prevention. This section assumes that the reader has general familiarity with policy authoring, including the configuration, testing, and deployment of policies, detection rules, match conditions, and policy exceptions.
Best practices are not intended to provide detailed troubleshooting guidance. Rather, it is goal of this section to provide best practices that, when followed, will proactively help to reduce the need for policy troubleshooting and support.

Table 18-1 Summary of policy authoring best practices

<table>
<thead>
<tr>
<th>Best practice</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Develop a policy strategy that supports your data security objectives.</td>
<td>See “Develop a policy strategy that supports your data security objectives” on page 359.</td>
</tr>
<tr>
<td>Use a limited number of policies to get started.</td>
<td>See “Use a limited number of policies to get started” on page 359.</td>
</tr>
<tr>
<td>Use policy templates but modify them to meet your requirements.</td>
<td>See “Use policy templates but modify them to meet your requirements” on page 360.</td>
</tr>
<tr>
<td>Use policy groups to manage policy lifecycle.</td>
<td>See “Use policy groups to manage policy lifecycle” on page 365.</td>
</tr>
<tr>
<td>Use the appropriate match condition for your data loss prevention objectives.</td>
<td>See “Use the appropriate match condition for your data loss prevention objectives” on page 360.</td>
</tr>
<tr>
<td>Test and tune policies to improve match accuracy.</td>
<td>See “Test and tune policies to improve match accuracy” on page 361.</td>
</tr>
<tr>
<td>Start with high match thresholds to reduce false positives.</td>
<td>See “Start with high match thresholds to reduce false positives” on page 362.</td>
</tr>
<tr>
<td>Use a limited number of exceptions to narrow detection scope.</td>
<td>See “Use a limited number of exceptions to narrow detection scope” on page 363.</td>
</tr>
<tr>
<td>Use compound conditions to improve match accuracy.</td>
<td>See “Use compound conditions to improve match accuracy” on page 363.</td>
</tr>
<tr>
<td>Author policies to limit the potential effect of two-tier detection.</td>
<td>See “Author policies to limit the potential effect of two-tier detection” on page 364.</td>
</tr>
</tbody>
</table>
Develop a policy strategy that supports your data security objectives

The goal of detection is to achieve accurate results based on true policy matches. Well-authored policies should accurately detect the data you want to protect with minimal false positives. Through the use of well-defined policies that implement the right type and combination of rules, conditions, and exceptions, you can achieve accurate detection results and prevent the loss of the most critical data in your enterprise.

There are two general approaches to developing a data loss prevention policy strategy:

- Information-driven—Identify sensitive data and author policies to prevent it from being lost.
- Regulation-driven—Review government and industry regulations and author policies to comply with them.

Table 18-2 describes these two approaches in more detail.

<table>
<thead>
<tr>
<th>Approach</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information-driven</td>
<td>With this approach you start by identifying specific data items and data combinations you want to protect. Examples of such data may include fields profiled from a database, a list of keywords, a set of users, or a combination of these elements. You then group similar data items together and create policies to identify and protect them. This approach works best when you have limited access to the data or no particular concerns about a given regulation.</td>
</tr>
<tr>
<td>Regulation-driven</td>
<td>With this approach you begin with a policy template based on the regulations with which you must comply. Examples of such templates may include HIPAA or FACTA. Also, begin with a large set of data (such as customer or employee data). Use the high-level requirements stipulated by the regulations as the basis for this approach. Then, decide what sensitive data items and documents in your enterprise meet these requirements. These data items become the conditions for the detection rules and exceptions in your policies.</td>
</tr>
</tbody>
</table>

Use a limited number of policies to get started

The policy detection rules you implement are based on your organization’s information security objectives. The actions you take in response to policy violations are based on your organization’s compliance requirements. In general you should start small with policy detection. Enable one or two policy templates, or a few simple conditions, such as keyword matching. Review the incidents each policy detects. Tune the results before you implement response rules to take action.
Generally it is better to have fewer policies that are configured to address specific data loss prevention objectives rather than many policies that attempt to address all of your security requirements. Having too many policies can impact the performance of the system and can lead to too many false positives.

See “Test and tune policies to improve match accuracy” on page 361.

Use policy templates but modify them to meet your requirements

Policy templates provide an excellent starting point for authoring policies. Symantec Data Loss Prevention provides 65 pre-built policy templates that contain detection rules and conditions for many different types of use cases, including regulatory compliance, data protection, security enforcement, and acceptable use scenarios.

You should use the system-provided policy templates as starting points for your policies. Doing so will save time and help you avoid errors and information gaps in your policies since the detection methods are predefined. However, for most situations you will want to modify the policy template and tailor it for your specific environment. Deploying a policy template out-of-the-box without configuring it for your environment is not recommended.

See “Creating a policy from a template” on page 312.

Use the appropriate match condition for your data loss prevention objectives

To prevent data loss, it is necessary to accurately detect all types of confidential data wherever that data is stored, copied, or transmitted. To meet your data security objectives, you need to implement the appropriate detection methods for the type of data you want to protect. The recommendation is to determine the detection methods that work best for you, and tune the policies as necessary based on the results of your detection testing.

Table 18-3 describes the primary use case for each type of policy match condition provided by Data Loss Prevention.

Table 18-3 Match conditions compared

<table>
<thead>
<tr>
<th>Type of data you want to protect</th>
<th>Condition</th>
<th>Matching</th>
</tr>
</thead>
<tbody>
<tr>
<td>Personally Identifiable Information (PII), such as SSNs, CCNs, and Driver's License numbers</td>
<td>EDM</td>
<td>Exact profiled data</td>
</tr>
<tr>
<td></td>
<td>Data Identifiers</td>
<td>Described, validated data patterns</td>
</tr>
</tbody>
</table>
Table 18-3  Match conditions compared (continued)

<table>
<thead>
<tr>
<th>Type of data you want to protect</th>
<th>Condition</th>
<th>Matching</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confidential documents, such as Microsoft Word, PowerPoint, PDF, etc.</td>
<td>IDM</td>
<td>Exact file contents</td>
</tr>
<tr>
<td>Conf</td>
<td>Parti</td>
<td>Similar file contents</td>
</tr>
<tr>
<td>Confidential files and images, such as CAD drawings</td>
<td>IDM</td>
<td>Exact file context (type, name, size)</td>
</tr>
<tr>
<td>Words and phrases, such as &quot;Confidential&quot; or &quot;Proprietary&quot;</td>
<td>Keywords</td>
<td>Exact words, phrases, proximity</td>
</tr>
<tr>
<td>Characters, strings, text</td>
<td>Regular Expressions</td>
<td>Described text</td>
</tr>
<tr>
<td>Network and endpoint communications</td>
<td>Protocol and Endpoint</td>
<td>Protocols, destinations, monitoring</td>
</tr>
<tr>
<td>Determined by the identity of the user, sender, recipient</td>
<td>Synchronized DGM</td>
<td>Exact identity from LDAP server</td>
</tr>
<tr>
<td>Describes a document, such as author, title, date, etc.</td>
<td>Content-based conditions</td>
<td>File type metadata</td>
</tr>
</tbody>
</table>

Test and tune policies to improve match accuracy

When you create detection policies, there are two common detection problems to avoid. If you create a policy that is too general or too broad, it generates incidents when no real match has occurred (false positive). On the other hand, if a policy has rules that are too specific or narrow about the data it detects, the policy may miss some of the matches you intend to catch (false negatives). Table 18-4 describes these common problems in more detail.

To reduce false positives and negatives, you need to tune your policies. The best way to tune detection is to identify a single, specific use case that is a priority, such as protecting source code for a particular product. You then create a single policy—either from scratch or based on a template, depending on your DLP strategy—containing one or two detection rules and test the policy to see how many (quantity) and the types (quality) of incidents the policy generates. Based on these initial results, you adjust the detection rule(s) as needed. If the policy generates more false positives than you want, make the detection rule(s) more specific by fine-tuning the existing match conditions, adding additional match conditions, and
creating policy exceptions. If the policy does not detect some incidents, make the
detection condition(s) less specific.

As your policies mature, it is important to continuously test and tune them to ensure
ongoing accuracy.

See “Follow detection-specific best practices” on page 365.

Table 18-4 Common detection problems to avoid

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>False positives</td>
<td>Policy rules too general or broad</td>
<td>False positives create high costs in time and resources that are required to investigate and resolve apparent incidents that are not actual incidents. Since many organizations do not have the capacity to manage excess false positives, it is important that your policies define contextual rules to improve accuracy. For example, a policy is designed to protect customer names and generates an incident for anything that contains a first and last name. Since most messages contain a name—in many cases both first and last names—this policy is too broad and general. Although it may catch all instances of customer names being sent outside the network, this policy will return too many false positives by detecting email messages that do not divulge protected information. First and last names require a much greater understanding of context to determine if the data is confidential</td>
</tr>
<tr>
<td>False negatives</td>
<td>Policy rules too tight or narrow</td>
<td>False negatives obscure gaps in security by allowing data loss, the potential for financial losses, legal exposure, and damage to the reputation of an organization. False negatives are especially dangerous because you do not know you have lost sensitive data. For example, a policy that contains a keyword match on the word &quot;confidential&quot; but also contains a condition that excludes all Microsoft Word documents would be too narrow and be suspect to false negatives because it would likely miss detecting many actual incidents contained in such documents</td>
</tr>
</tbody>
</table>

See “Start with high match thresholds to reduce false positives” on page 362.
See “Use a limited number of exceptions to narrow detection scope” on page 363.
See “Use compound conditions to improve match accuracy” on page 363.

Start with high match thresholds to reduce false positives

For content-based detection rules, there is a configuration setting that lets you "count all matches" but only report an incident after a threshold number of matches has been reached. The general recommendation is to start with high match
thresholds for your content-based detection policies. As you tune your policies you can reduce the match thresholds to be more precise.

See “Configuring match counting” on page 334.

Use a limited number of exceptions to narrow detection scope

You can implement exception conditions for any detection rule, except EDM rules. The limited use of exception conditions can help to reduce false positives by narrowing the scope of policy detection. However, if you need to use several exceptions in a single policy to achieve the desired detection results, reconsider the design of the policy. Make sure the policy is well-defined and uses the proper match conditions.

Caution: Too many compound exceptions in a policy can cause system performance issues. You should avoid the use of compound exceptions as much as possible.

It is important to understand how exception conditions work so you can use them properly. Exception conditions disqualify messages from creating incidents. Exception conditions are checked first by the detection server before match conditions. If the exception condition matches, the system immediately discards the entire message or message component that met the exception. There is no support for match-level exceptions. Once the message or message component is discarded by meeting an exception, the data is no longer available for policy evaluation.

See “Exception conditions” on page 307.

See “Use compound conditions to improve match accuracy” on page 363.

Use compound conditions to improve match accuracy

Compound conditions can help you improve the match accuracy of your policies. Suppose you are concerned about Microsoft Word documents leaving the network. Initially, you add a policy that uses an attachment type condition to catch all Word files. You quickly discover that too many messages contain Word file attachments that do not divulge protected information. When you examine the incidents more closely, you realize that you are more concerned with Word files that contain the word CONFIDENTIAL. In this case you can convert the attachment type condition to a compound rule by adding a keyword rule for the word CONFIDENTIAL. Such a configuration would achieve more accurate detection results.
Author policies to limit the potential effect of two-tier detection

The Exact Data Matching (EDM) and profiled Directory Group Matching (DGM) conditions require two-tier detection. For these conditions, the DLP Agent must send the data to the Endpoint Server for evaluation. Indexed Document Matching (IDM) uses two-tier detection if it is enabled.

See “Two-tier detection for DLP Agents” on page 309.

On the endpoint the DLP Agent executes the least expensive rules first. If you are deploying a policy to the endpoint that requires two-tier detection, you can author the policy in such a way to limit the potential effect of two-tier detection.

Table 18-5 provides some considerations for authoring policies to limit the potential effect of two-tier detection.

See “Detection messages and message components” on page 305.

Table 18-5 Policy configurations for two-tier detection rules

<table>
<thead>
<tr>
<th>Two-tier match condition</th>
<th>Policy configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exact Data Matching (EDM)</td>
<td>For EDM policies, consider including Data Identifier rules OR'd with EDM rules. For example, for a policy that uses an EDM condition to match social security numbers, you could add a second rule that uses the SSN Data Identifier condition. The Data Identifier does not require two-tier detection and is evaluated locally by the DLP Agent. If the DLP Agent is not connected to the Endpoint Server when the DLP Agent receives the data, the DLP Agent can still perform SSN pattern matching based on the Data Identifier condition. See “Combine Data Identifiers with EDM rules to limit the impact of two-tier detection” on page 460. For example policy configurations, each of the policy templates that provide EDM conditions also provide corresponding Data Identifier conditions. See “Choosing an Exact Data Profile” on page 322.</td>
</tr>
</tbody>
</table>
Table 18-5  Policy configurations for two-tier detection rules (continued)

<table>
<thead>
<tr>
<th>Two-tier match condition</th>
<th>Policy configuration</th>
</tr>
</thead>
</table>
| Indexed Document Matching (IDM) | For IDM policies that match file contents, consider using VML rules OR’d with IDM rules. VML rules do not require two-tier detection and are executed locally by the DLP Agent. If you do not need to match file contents exactly, you may want to use VML instead of IDM.  

See “Use the appropriate match condition for your data loss prevention objectives” on page 360.  

If you are only concerned with file matching, not file contents, consider using compound file property rules instead of IDM. File property rules do not require two-tier detection.  

See “Use compound file property rules to protect design and multimedia files” on page 618. |
| Directory Group Matching (DGM) | For the synchronized DGM Recipient condition, consider including a Recipient Matches Pattern condition OR’d with the DGM condition. The pattern condition does not require two-tier detection and is evaluated locally by the DLP Agent.  

See “About two-tier detection for synchronized DGM” on page 654. |

Use policy groups to manage policy lifecycle

Use policy groups to test policies before using them in production. Create a test policy group to which only you have access. Then, create policies and add them to the test policy group. Review the incidents your test policies capture. After you tune the policies and confirm that they capture the expected incidents, you can rename the policy group and grant the appropriate roles access to it. You can also use policy groups to manage legacy policies, as well as policies you want to import or export.

See “Policy groups” on page 287.

See “Removing policies and policy groups” on page 351.

Follow detection-specific best practices

In addition to these general policy authoring considerations, you should be aware of and keep in mind policy tuning considerations specific to each type of match condition.

Table 18-6 lists detection specific considerations, with links to topics for more information.
### Table 18-6  Best practices for specific detection methods

<table>
<thead>
<tr>
<th>Detection method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EDM</td>
<td>See “Best practices for using EDM” on page 451.</td>
</tr>
<tr>
<td>IDM</td>
<td>See “Best practices for using IDM” on page 499.</td>
</tr>
<tr>
<td>VML</td>
<td>See “Best practices for using VML” on page 532.</td>
</tr>
<tr>
<td>Data identifiers</td>
<td>See “Best practices for using data identifiers” on page 579.</td>
</tr>
<tr>
<td>Keywords</td>
<td>See “Best practices for using keyword matching” on page 595.</td>
</tr>
<tr>
<td>Regular expressions</td>
<td>See “Best practices for using regular expression matching” on page 601.</td>
</tr>
<tr>
<td>Non-English language detection</td>
<td>See “Best practices for detecting non-English language content” on page 605.</td>
</tr>
<tr>
<td>File properties</td>
<td>See “Best practices for using file property matching” on page 618.</td>
</tr>
<tr>
<td>Network protocols</td>
<td>See “Best practices for using network protocol matching” on page 630.</td>
</tr>
<tr>
<td>Endpoint events</td>
<td>See “Best practices for using endpoint detection” on page 642.</td>
</tr>
<tr>
<td>Described identities</td>
<td>See “Best practices for using described identity matching” on page 650.</td>
</tr>
<tr>
<td>Synchronized DGM</td>
<td>See “Best practices for using synchronized DGM” on page 659.</td>
</tr>
<tr>
<td>Profiled DGM</td>
<td>See “Best practices for using profiled DGM” on page 665.</td>
</tr>
<tr>
<td>Metadata detection</td>
<td>See “Best practices for using metadata detection” on page 694.</td>
</tr>
</tbody>
</table>
Detecting content using Exact Data Matching (EDM)

This chapter includes the following topics:

- Introducing Exact Data Matching (EDM)
- Configuring Exact Data profiles
- Configuring EDM policies
- Using multi-token matching
- Updating EDM indexes to version 12.5
- Memory requirements for EDM
- Remote EDM indexing
- Best practices for using EDM

Introducing Exact Data Matching (EDM)

Exact Data Matching (EDM) is designed to protect your most sensitive content. You can use EDM to detect personally identifiable information (PII)—such as social security numbers, bank account numbers, credit card numbers—confidential customer and employee records, and other confidential data stored in a structured data source, such as a database, directory server, or a structured data file such as CSV or spreadsheet.

To implement EDM policies, you identify and prepare the data you want to protect. You create an **Exact Data Profile** and index the structured data source using the Enforce Server administration console, or remotely using the Remote EDM Indexer. During the indexing process, the system fingerprints the data by accessing and
extracting the text-based content, normalizing it, and securing it using a nonreversible hash. You can schedule indexing on a regular basis so the data is current.

Once you have profiled the data, you configure the **Content Matches Exact Data** condition to match individual pieces of the indexed data. For increased accuracy you can configure the condition to match combinations of data fields from a particular record. The EDM policy condition matches on data coming from the same row or record of data. For example, you can configure the EDM policy condition to look for any three of First Name, Last Name, SSN, Account Number, or Phone Number occurring together in a message and corresponding to a record from your customer database.

Once the policy is deployed to one or more detection servers, the system can detect the data you have profiled in either structured or unstructured format. For example, you could deploy the EDM policy to a Network Discover Server and scan data repositories for confidential data matching data records in the index. Or, you could deploy the EDM policy to a Network Prevent for Email Server to detect records in email communications and attachments, such as Microsoft Word files. If the attachment is a spreadsheet, such as Microsoft Excel, the EDM policy can detect the presence of confidential records there as well.

See “About the Exact Data Profile and index” on page 371.

### About using EDM to protect content

To understand how EDM works, consider the following example. Your company maintains an employee database that contains the following column fields:

- First Name
- Last Name
- SSN
- Date of Hire
- Salary

In a structured data format such as a database, each row represents one record, with each record containing values for each column data field. In this example, each row in the database contains information for one employee, and you can use EDM to protect each record. For example, one row in the data source file contains the following pipe (|) delimited record:

```
First Name | Last Name | SSN | Date of hire | Salary
----------|-----------|-----|--------------|--------
Bob       | Smith     | 123-45-6789 | 05/26/99 | $42500
```

You create an Exact Data Profile and index the data source file. When you configure the profile, you map the data field columns to system-defined patterns and validate
the data. You then configure the EDM policy condition that references the Exact Data Profile. In this example, the condition matches if a message contains all five data fields.

The detection server reports a match if it detects the following in any inbound message:

**Bob Smith 123-45-6789 05/26/99 $42500**

But, a message containing the following does not match because that record is not in the index:

**Betty Smith 000-00-0000 05/26/99 $42500**

If you limited the condition to matching only the Last Name, SSN, and Salary column fields, the following message is a match because it meets the criteria:

**Robert, Smith, 123-45-6789, 05/29/99, $42500**

Finally, the following message contents do not match because the value for the SSN is not present in the profile:

**Bob, Smith, 415-789-0000, 05/26/99, $42500**

See “Configuring Exact Data profiles” on page 378.

**EDM policy features**

EDM policy matching involves searching for indexed content in a given message and generating an incident if a match is found within the defined proximity range.

Policy matching features of EDM include the following:

- You can select any number of columns to be matched from a given data source.

- You can define exclude combinations so that matches against those combinations are not reported.

- When creating the index, the system provides pattern validation for social security numbers, credit card numbers, U.S. and Canada phone numbers and ZIP codes, email and IP addresses, numbers and percents.

- There is an editable stop word dictionary you can use to prevent single token stopwords from matching.

- The system provides match highlighting at the incident snapshot screen.

- You can use a where clause in the EDM rule and matches that do not satisfy the where clause are ignored.

- You can use Data Owner Exception to ignore detection based on the sender or recipient's email address or domain.
You can use profiled Directory Group Matching (DGM) to match on senders or recipients of data based on email address, IM handle, or Windows user name.

Proximity matching range that is proportional to the number of required matches set in the policy condition.

Full support for single- and multi-token cell indexing and matching. A multi-token is a cell that his indexed that contains two or more words.

See “EDM policy templates” on page 370.

See “EDM policy templates” on page 370.

See “EDM policy templates” on page 370.

## EDM policy templates

Symantec Data Loss Prevention provides several policy templates that feature EDM. If you use one of these templates, the system lets you validate your Exact Data Profile against the template when you are configuring the profile.

- **Caldicott Report**
  See “Caldicott Report policy template” on page 802.

- **Customer Data Protection**
  See “Customer Data Protection policy template” on page 808.

- **Data Protection Act 1988**
  See “Data Protection Act 1998 (UK) policy template” on page 810.

- **Employee Data Protection**
  See “Employee Data Protection policy template” on page 815.

- **EU Data Protection Directives**
  See “Data Protection Directives (EU) policy template” on page 811.

- **Export Administration Regulations (EAR)**
  See “Export Administration Regulations (EAR) policy template” on page 817.

- **FACTA 2003 (Red Flag Rules)**
  See “FACTA 2003 (Red Flag Rules) policy template” on page 818.

- **Gramm-Leach-Bliley**
  See “Gramm-Leach-Bliley policy template” on page 824.

- **HIPAA and HITECH (including PHI)**
  See “HIPAA and HITECH (including PHI) policy template” on page 826.

- **Human Rights Act 1998**

- **International Traffic in Arms Regulations (ITAR)**
The **Exact Data Profile** is the user-defined configuration you create to index the data source and map the data. The index is a secure file (or set of files) that contains hashes of the exact data values from each field in your data source, along with information about those data values. The index does not contain the data values themselves.

The index that is generated consists of one or more binary `DataSource.rdx` files, each with space to fit into random access memory (RAM) on the detection server(s). For a large data source file, the system may break the data into several `*.rdx` files. By default, Symantec Data Loss Prevention stores index files in `\SymantecDLP\Protect\index` (on Windows) or in `/var/SymantecDLP/index` (on Linux) on the Enforce Server.

Symantec Data Loss Prevention automatically deploys EDM indexes (`*.rdx` files) to the `index` directory on all detection servers. When an active policy that references an EDM profile is deployed to a detection server, the detection server loads the corresponding EDM index into RAM. If a new detection server is added after an index has been created, the `*.rdx` files in the `index` folder on the Enforce Server are deployed to the `index` folder on the new detection server. You cannot manually deploy index files to detection servers.

At run-time during detection, the system converts input content into hashed data values using the same algorithm it employs for indexes. It then compares data
values from input content to those in the appropriate index file(s), identifying matches.
See “Creating and modifying Exact Data Profiles” on page 385.
See “Memory requirements for EDM” on page 421.

About the exact data source file

The data source file is a flat file containing data in a standard delimited format (pipe or tab) that has been extracted from a database, spreadsheet, or other structured data source, and cleansed for profiling. You upload the data source file to the Enforce Server when you are defining the Exact Data Profile. For example, by exporting data from a database (performing a "data dump"), the resulting *.dat file can be used as the data source for your EDM profile.

See “Creating the exact data source file for EDM” on page 379.

You can use the SQL pre-indexer to index the data source directly. However, this approach has limitations because in most cases the data must first be cleansed before it is indexed.

See “Remote EDM indexing” on page 432.

The data source file must contain at least one unique column field. Some examples of unique column fields include social security number, drivers license number, and credit card number.

See “Best practices for using EDM” on page 451.

The maximum number of columns that a single data source file can have is 32. If the data source file has more than 32 columns, the Enforce Server administration console produces an error message at the profile screen, and the data source file is not indexed. There is no maximum number of rows, but the total number of cells in a single data source file should not exceed 2.1 billion cells. If your data source file is larger than this, split it into multiple files and index each separately.

Table 19-1 summarizes size limitations for EDM data source files.

---

Note: The format for the data source file should be a text-based format containing pipe- or tab-delimited contents. In general you should avoid using a spreadsheet format for the data source file (such as XLS or XLSX) because such programs use scientific notation to render numbers.
Table 19-1  EDM data source file size limitations

<table>
<thead>
<tr>
<th>Data source file</th>
<th>Limit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Columns</td>
<td>32</td>
<td>The data source file cannot have more than 32 columns. If it does, the system does not index it.</td>
</tr>
<tr>
<td>Cells</td>
<td>2.1 billion</td>
<td>The data source file cannot have more than 2.1 billion data cells. If it does, the system does not index it.</td>
</tr>
<tr>
<td>Rows</td>
<td>None</td>
<td>There is no limit to the number of rows that the data source file can have as long as the column and cell limitations are adhered to.</td>
</tr>
</tbody>
</table>

About cleansing the exact data source file

Once you have created the data source file, you must prepare the data for indexing by cleansing it. It is critical that you cleanse the data source file to ensure that your EDM policies are as accurate as possible. You can use tools such as Stream Editor (sed) and AWK to cleanse the data source file. Melissa Data provides good tools for normalizing data in the data source, such as addresses.

See Table 19-2 on page 373 provides the workflow for cleansing the data source file for indexing.

Table 19-2  Workflow for cleansing the data source file

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Prepare the data source file for indexing.</td>
<td>See “Preparing the exact data source file for indexing” on page 381.</td>
</tr>
<tr>
<td>2</td>
<td>Ensure that the data source has at least one column that is unique data.</td>
<td>See “Ensure data source has at least one column of unique data” on page 452.</td>
</tr>
<tr>
<td>3</td>
<td>Remove incomplete and duplicate records. Do not fill empty cells with bogus data.</td>
<td>See “Cleanse the data source file of blank columns and duplicate rows” on page 453.</td>
</tr>
<tr>
<td>4</td>
<td>Remove improper characters.</td>
<td>See “Remove ambiguous character types from the data source file” on page 454.</td>
</tr>
<tr>
<td>5</td>
<td>Verify that the data source file is below the error threshold.</td>
<td></td>
</tr>
</tbody>
</table>
About using System Fields for data source validation

Column headings in your data source are useful for visual reference. However, they do not tell Symantec Data Loss Prevention what kind of data the columns contain. To do this, you use the Field Mappings section of the Exact Data Profile to specify mappings between fields in your data source. You can also use field mappings to specify fields that the system recognizes in the system-provided policy templates. The Field Mappings section also gives you advanced options for specifying custom fields and validating the data in those fields.

See “Mapping Exact Data Profile fields” on page 389.

Consider the following example use of field mappings. Your company wants to protect employee data, including employee social security numbers. You create a Data Loss Prevention policy based on the Employee Data Protection template. The policy requires an exact data index with fields for social security numbers and other employee data. You prepare your data source and then create the Exact Data Profile. To validate the data in the social security number field, you map this column field in your index to the "Social Security Number" system field pattern. The system will then validate all data in that field using the Social Security Number validator to ensure that each data item is a social security number.

Using the system-defined field patterns to validate your data is critical to the accuracy of your EDM policies. If there is no system-defined field pattern that corresponds to one or more data fields in your index, you can define custom fields and choose the appropriate validator to validate the data.

See “Map data source column to system fields to leverage validation” on page 455.

About index scheduling

After you have indexed an exact data source extract, its schema cannot be changed because the *.rdx index file is binary. If the data source changes, or the number of columns or data mapping of the exact data source file changes, you must create a new EDM index and update the policies that reference the changed data. In this case you can schedule the indexing to keep the index in sync with the data source.

The typical use case is as follows. You extract data from a database to a file and cleanse it. This is your data source file. Using the Enforce Server administration console you define an Exact Data Profile and index the data source file. The system generates the *.rdx index file and deploys it to one or more detection servers. However, you know that the data changes frequently and you will need to generate a new data source file weekly or monthly to keep up with the changes to the database. In this case you can use index scheduling so that you can automate the indexing of the data source file so you do not have to return to the Enforce Server administration console and reindex the updated data source. Your only task is to
drop an updated and cleansed data source file to the Enforce Server for scheduled indexing.

See “Configuring Exact Data profiles” on page 378.

See “Scheduling Exact Data Profile indexing” on page 392.

See “Use scheduled indexing to automate profile updates” on page 457.

About the Content Matches Exact Data From condition

The **Content Matches Exact Data From an Exact Data Profile** condition is the detection component you use to implement EDM policies. When you define this condition, you select the EDM profile on which the condition is based. You also select the rows you want to use in your condition, as well as any WHERE clause limitations.

**Note:** You cannot use the **Content Matches Exact Data From an Exact Data Profile** condition as a policy exception. Data Loss Prevention does not support the use of the EDM condition as a policy exception.

See “Configuring the Content Matches Exact Data policy condition” on page 396.

About Data Owner Exception

Although EDM does not support the explicit use of match exceptions in policies, EDM does support criteria-based matching exceptions. This feature of EDM is known as **Data Owner Exception**. Data owner exception lets you tag or authorize a specific field in an Exact Data Profile as the data owner. At run-time if the sender or recipient of the data is authorized as a data owner, the condition does not trigger a match and the data is allowed to be sent or received by the data owner.

You implement data owner exception by including either the email address field or domain address field in your **Exact Data Profile**. In the EDM policy condition, you specify the field as either the sender or recipient data owner. An authorized data owner, identified by his or her email address or a domain address, who is a sender can send his or her own confidential information without triggering an EDM match or incident. This means that the sender can send any information that is contained in the row where his or her email address or domain is specified. Authorized data owner recipients can be specified individually or all recipients in the list can be allowed to receive the data without triggering a match.

As a policy author, data owner exception gives you the flexibility to allow data owners to use their own data legitimately. For example, if data owner exception is enabled, an employee can send an email containing his or her own confidential information...
(such as an account number) without triggering a match or an incident. Similarly, if data owner exception is configured for a recipient, the system does not trigger an EDM match or incident if the data owner is receiving his or her own information, such as someone outside the company is sending an email to the data owner containing his or her account number.

See “About upgrading EDM deployments” on page 377.

See “Creating the exact data source file for Data Owner Exception” on page 380.

See “Configuring Data Owner Exception for EDM policy conditions” on page 398.

About profiled Directory Group Matching (DGM)

Profiled Directory Group Matching (DGM) is a specialized implementation of EDM that is used to detect the exact identity of a message user, sender, or recipient that has been profiled from a directory server or database.

Profiled DGM leverages EDM technology to detect identities that you have indexed from your database or directory server using an Exact Data Profile. For example, you can use profiled DGM to identify network user activity or to analyze content associated with particular users, senders, or recipients. Or, you can exclude certain email addresses from analysis. Or, you might want to prevent certain people from sending confidential information by email.

To implement profiled DGM, your exact data source file must contain one or more of the following fields:

- Email address
- IP address
- Windows user name
- IM name (AOL, Yahoo, MSN)

If you include the email address field in the DGM profile, the field will appear in the Directory EDM drop-down list at the incident snapshot screen in the Enforce Server administration console, which facilitates remediation.

See “Creating the exact data source file for profiled DGM” on page 380.

See “Include an email address field in the Exact Data Profile for profiled DGM” on page 461.

See “Use profiled DGM for Network Prevent for Web identity detection” on page 461.
About two-tier detection for EDM on the endpoint

The EDM index is server-based. If you deploy a policy containing an EDM condition to the DLP Agent on the endpoint, the system uses two-tier detection to evaluate data for matching. In this case the EDM detection condition is not evaluated locally by the DLP Agent. Instead, the DLP Agent sends the data to the Endpoint Server for evaluation against the index. If the endpoint is offline, the message cannot be sent until the server is available, which can affect endpoint performance.

See “Two-tier detection for DLP Agents” on page 309.

To check if two-tier detection is being used, check the \SymantecDLP\Protect\logs\debug\FileReader.log on the Endpoint Server to see if any EDM indexes are being loaded. Look for the line "loaded database profile."

See “Troubleshooting policies” on page 353.

About upgrading EDM deployments

Symantec Data Loss Prevention version 12.5 provides several enhancements to EDM, including support for multi-token cell indexing and proportional proximity range checking. Refer to the following document for an overview of these enhancements: What's New and What's Changed in Symantec Data Loss Prevention Version 12.5.

To take advantage of these EDM enhancements, you must upgrade your servers to Symantec Data Loss Prevention version 12.5 and you must reindex your EDM data sources using the 12.5 EDM Indexer. Although legacy EDM indexes will run on 12.5 detection servers, such indexes do support new features. In addition, you must calculate the memory required to index the data source and load and process each EDM index at run-time.

In addition, if you have previously implemented data owner exceptions manually using configuration files, you must reconfigure these exceptions using the Enforce Server administration console. Refer to the following article at the DLP Knowledgebase for instructions on migrating legacy DOE configurations to the Enforce Server 12.x platform: https://kb-vontu.altiris.com/article.asp?article=56307.

See “About Data Owner Exception” on page 375.

See “Updating EDM indexes to version 12.5” on page 416.

See “Memory requirements for EDM” on page 421.

See “EDM index out of date error codes” on page 420.
Configuring Exact Data profiles

To implement EDM, you create the **Exact Data Profile**, index the data source, and define one or more EDM detection conditions to match profiled data exactly.

See “About the Exact Data Profile and index” on page 371.

### Table 19-3 Implementing Exact Data Matching

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1    | Create the data source file. | Export the source data from the database (or other data repository) to a tabular text file.  
If you want to except data owners from matching, you need to include specific data items in the data source file.  
See "About the exact data source file" on page 372.  
If you want to match identities for profiled Directory Group Matching (DGM), you need to include specific data items in the data source files.  
See "Creating the exact data source file for EDM" on page 379. |
| 2    | Prepare the data source file for indexing. | Remove irregularities from the data source file.  
See “Preparing the exact data source file for indexing” on page 381. |
| 3    | Upload the data source file to the Enforce Server. | You can copy or upload the data source file to the Enforce Server, or access it remotely.  
See “Uploading exact data source files to the Enforce Server” on page 383. |
| 4    | Create an Exact Data Profile. | An Exact Data Profile is required to implement Exact Data Matching (EDM) policies. The Exact Data Profile specifies the data source, data field types, and the indexing schedule.  
See “Creating and modifying Exact Data Profiles” on page 385. |
| 5    | Map and validate the data fields. | You map the source data fields to system or custom data types that the system validates. For example, a social security number data field needs to be nine digits.  
See “About using System Fields for data source validation” on page 374.  
See “Mapping Exact Data Profile fields” on page 389. |
| 6    | Index the data source, or schedule indexing. | See “About index scheduling” on page 374.  
See “Scheduling Exact Data Profile indexing” on page 392. |
Table 19-3  Implementing Exact Data Matching (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| 7    | Configure and tune one or more EDM detection conditions. | See “Configuring the Content Matches Exact Data policy condition” on page 396.  
See “Configuring the Content Matches Exact Data policy condition” on page 396. |

Creating the exact data source file for EDM

The first step in the EDM indexing process is to create the data source. A data source is a flat file containing data in a standard delimited format.

If you plan to use a policy template, review it before creating the data source file to see which data fields the policy uses. For relatively small data sources, include as many suggested fields in your data source as possible. However, note that the more fields you include, the more memory the resulting index requires. This consideration is important if you have a large data source. When you create the data profile, you can confirm how well the fields in your data source match against the suggested fields for the template.

See Table 19-4 on page 379.

Table 19-4  Create the exact data source file

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1    | Export the data you want to protect from a database or other tabular data format, such as an Excel spreadsheet, to a flat file. The data source file you create must be a tabular text file that contains rows of data from the original source. Each row from the original source is included as a row in the data source file. Delimit columns using a tab, a comma, or a pipe. Pipe is preferred. Comma should not be used if your data source fields contain numbers.  
See “About the exact data source file” on page 372.  
You must maintain all the structured data that you exported from the source database table or table-like format in one data source file. You cannot split the data source across multiple files.  
The data source file cannot exceed 32 columns or 2.1 billion cells. The size of a data source file is otherwise limited only by the available disk space of the Enforce Server host. If you plan to upload the data source file to the Enforce Server, browser capacity limits the data source size to 2 GB. For file sizes larger than this size you can copy the file to the Enforce Server using FTP/S. |
Table 19-4  Create the exact data source file (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Include required data fields for specific EDM implementations:</td>
</tr>
<tr>
<td></td>
<td>■ Unique data</td>
</tr>
<tr>
<td></td>
<td>For all EDM implementations, make sure the data source contains at least one column of unique data</td>
</tr>
<tr>
<td></td>
<td>See “Ensure data source has at least one column of unique data” on page 452.</td>
</tr>
<tr>
<td></td>
<td>■ Data Owner Exception</td>
</tr>
<tr>
<td></td>
<td>Make sure the data source contains the email address field or domain field, if you plan to use data owner exceptions.</td>
</tr>
<tr>
<td></td>
<td>See “Creating the exact data source file for Data Owner Exception” on page 380.</td>
</tr>
<tr>
<td></td>
<td>■ Directory Group Matching</td>
</tr>
<tr>
<td></td>
<td>Make sure the data source includes one or more sender/recipient identifying fields.</td>
</tr>
<tr>
<td></td>
<td>See “Creating the exact data source file for profiled DGM” on page 380.</td>
</tr>
<tr>
<td>3</td>
<td>Prepare the data source file for indexing.</td>
</tr>
<tr>
<td></td>
<td>See “Preparing the exact data source file for indexing” on page 381.</td>
</tr>
</tbody>
</table>

Creating the exact data source file for Data Owner Exception

To implement Data Owner Exception and ignore data owners from detection, you must explicitly include each user's email address or domain address in the Exact Data Profile. Each expected domain (for example, symantec.com) must be explicitly added to the Exact Data Profile. The system does not automatically match on subdomains (for example, fileconnect.symantec.com). Each subdomain must be explicitly added to the Exact Data Profile.

To implement the data owner exception feature, you must include either or both of the following fields in your data source file:

■ Email address
■ Domain address

See “About Data Owner Exception” on page 375.
See “Configuring Data Owner Exception for EDM policy conditions” on page 398.

Creating the exact data source file for profiled DGM

Profiled DGM leverages Exact Data Matching (EDM) technology to precisely detect identities. Identity-related attributes may include an IP address, email address, user name, business unit, department, manager, title, or employment status. Other attributes may be whether that employee has provided consent to be monitored,
or whether the employee has access to sensitive information. To implement profiled DGM, you must include at least one required data field in your data source.

See “About the Exact Data Profile and index” on page 371.

Table 19-5 lists the required fields for profiled DGM. The data source file must contain at least one of these fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email address</td>
<td>If you use an email address column filed in the data source file, the email address appears in the Directory EDM drop-down list at the incident snapshot screen.</td>
</tr>
<tr>
<td>IP address</td>
<td>For example: 172.24.56.33</td>
</tr>
<tr>
<td>Windows user name</td>
<td>If you use a Windows user name field in your data source, the data must be in the following format: domain\user; for example: ACME\john_smith.</td>
</tr>
<tr>
<td>AOL IM name</td>
<td>IM screen name / handle</td>
</tr>
<tr>
<td>Yahoo! IM name</td>
<td>For example: myhandle123</td>
</tr>
<tr>
<td>MSN IM name</td>
<td></td>
</tr>
</tbody>
</table>

Preparing the exact data source file for indexing

Once you create the exact data source file, you must prepare it so that you can efficiently index the data you want to protect.

When you index an exact data profile, the Enforce Server keeps track of empty cells and any misplaced data which count as errors. For example, an error may be a name that appears in a column for phone numbers. Errors can constitute a certain percentage of the data in the profile (five percent, by default). If this default error threshold is met, Symantec Data Loss Prevention stops indexing. It then displays an error to warn you that your data may be unorganized or corrupt. Symantec Data Loss Prevention checks for errors only if the data source has at least a thousand rows.

To prepare the exact data source for EDM indexing

1. Make sure that the data source file is formatted as follows:
   - If the data source has more than 200,000 rows, verify that it has at least two columns of data. One of the columns should contain unique values. For example, credit card numbers, driver’s license numbers, or account numbers (as opposed to first and last names, which are generic).
See “Ensure data source has at least one column of unique data” on page 452.

- Verify that you have delimited the data source using pipes ( | ) or tabs. If the data source file uses commas as delimiters, remove any commas that do not serve as delimiters.
  See “Do not use the comma delimiter if the data source has number fields” on page 455.

- Verify that data values are not enclosed in quotes.

- Remove single-character and abbreviated data values from the data source. For example, remove the column name and all values for a column in which the possible values are Y and N. Optionally, remove any columns that contain numeric values with less than five digits, as these can cause false positives in production.
  See “Remove ambiguous character types from the data source file” on page 454.

- Verify that numbers, such as credit card or social security, are delimited internally by dashes, or spaces, or none at all. Make sure that you do not use a data-field delimiter such as a comma as an internal delimiter in any such numbers. For example: 123-45-6789, or 123 45 6789, or 123456789 are valid, but not 123,45,6789.
  See “Do not use the comma delimiter if the data source has number fields” on page 455.

- Eliminate duplicate records, which can cause duplicate incidents in production.
  See “Cleanse the data source file of blank columns and duplicate rows” on page 453.

- Do not index common values. EDM works best with values that are unique. Think about the data you want to index (and thus protect). Is this data truly valuable? If the value is something common, it is not useful as an EDM value. For example, suppose you want to look for "US states." Since there are only 50 states, if your exact data profile has 300,000 rows, the result is a lot of duplicates of common values. Symantec Data Loss Prevention indexes all values in the exact data profile, regardless of if the data is used in a policy or not. It is good practice to use values that are less common and preferably unique to get the best results with EDM.
See “Ensure data source has at least one column of unique data” on page 452.

2 Once you have prepared the exact data source file, proceed with the next step in the EDM process: upload the exact data source file to the Enforce Server for profiling the data you want to protect.

See “Uploading exact data source files to the Enforce Server” on page 383.

Uploading exact data source files to the Enforce Server

After you have prepared the data source file for indexing, load it to the Enforce Server so the data source can be indexed.

See “Creating and modifying Exact Data Profiles” on page 385.

Listed here are the options you have for making the data source file available to the Enforce Server. Consult with your database administrator to determine the best method for your needs.

<table>
<thead>
<tr>
<th>Table 19-6</th>
<th>Uploading the data source file to the Enforce Server for indexing</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Upload option(s)</strong></td>
<td><strong>Use case</strong></td>
</tr>
</tbody>
</table>
| Upload Data Source to Server Now | Data source file is less than 50 MB | If you have a smaller data source file (less than 50 MB), upload the data source file to the Enforce Server using the Enforce Server administration console (web interface). When creating the Exact Data Profile, you can specify the file path or browse to the directory and upload the data source file.  
**Note:** Due to browser capacity limits, the maximum file size that you can upload is 2 GB. However, uploading any file over 50 MB is not recommended since files over this size can take a long time to upload. If your data source file is over 50 MB, consider copying the data source file to the datafiles directory using the next option. |
Table 19-6  Uploading the data source file to the Enforce Server for indexing (continued)

<table>
<thead>
<tr>
<th>Upload option(s)</th>
<th>Use case</th>
<th>Description</th>
</tr>
</thead>
</table>
| Reference Data Source on Manager Host | Data source file is over 50 MB | If you have a large data source file (over 50 MB), copy it to the `datafiles` directory on the host where Enforce is installed.  
  - On Windows this directory is located at `\SymantecDLP\Protect\datafiles`.  
  - On Linux this directory is located at `/var/SymantecDLP/datafiles`.  
  This option is convenient because it makes the data file available by reference by a drop-down list during configuration of the Exact Data Profile. If it is a large file, use a third-party solution (such as Secure FTP) to transfer the data source file to the Enforce Server.  
  **Note:** Ensure that the Enforce user (usually called "protect") has modify permissions (on Windows) or rw permissions (on Linux) for all files in the `datafiles` directory. |
| Use This File Name            | Data source file is not yet created | In some cases you may want to create an EDM profile before you have created the data source file. In this case you can create a profile template and specify the name of the data source file you plan to create. This option lets you define EDM policies using the EDM profile template before you index the data source. The policies do not operate until the data source is indexed. When you have created the data source file you place it in the `\SymantecDLP\Protect\datafiles` directory and index the data source immediately on save or schedule indexing.  
  See "Creating and modifying Exact Data Profiles" on page 385. |
Table 19-6  Uploading the data source file to the Enforce Server for indexing (continued)

<table>
<thead>
<tr>
<th>Upload option(s)</th>
<th>Use case</th>
<th>Description</th>
</tr>
</thead>
</table>
| Use This File Name and Load Externally Generated Index | Data source is to be indexed remotely and copied to the Enforce Server | In some environments it may not be secure or feasible to copy or upload the data source file to the Enforce Server. In this situation you can index the data source remotely using Remote EDM Indexer.  
See “Remote EDM indexing” on page 432.  
This utility lets you index an exact data source on a computer other than the Enforce Server host. This feature is useful when you do not want to copy the data source file to the same computer as the Enforce Server. As an example, consider a situation where the originating department wants to avoid the security risk of copying the data to an extra-departmental host. In this case you can use the Remote EDM Indexer.  
First you create an EDM profile template where you choose the Use this FileName and the Number of Columns options. You must specify the name of the data source file and the number of columns it contains.  
See “Creating an EDM profile template for remote indexing” on page 436.  
You then use the Remote EDM Indexer to remotely index the data source and copy the index files to the Enforce Server host and load the externally generated index. The Load Externally Generated Index option is only available after you have defined and saved the profile. Remote indexes are loaded from the /SymantecDLP/Protect/Index directory on the Enforce Server host.  
See “Copying and loading remote index files to the Enforce Server” on page 442. |

Creating and modifying Exact Data Profiles

The Manage > Data Profiles > Exact Data > Add Exact Data Profile screen is the home page for managing and adding Exact Data Profiles. An Exact Data Profile is required to implement an instance of the Content Matches Exact Data detection rule. An Exact Data Profile specifies the data source, the indexing parameters, and the indexing schedule. Once you have created the EDM profile, you index the data source and configure one or more detection rules to use the profile and detect exact content matches.  
See “Configuring Exact Data profiles” on page 378.  

Note: If you are using the Remote EDM Indexer to generate the Exact Data Profile, refer to the following topic.
To create or modify an Exact Data Profile

1. Make sure that you have created the data source file.
   See “Creating the exact data source file for EDM” on page 379.

2. Make sure that you have prepared the data source file for indexing.
   See “Preparing the exact data source file for indexing” on page 381.

3. Make sure the data source contains the email address field or domain field, if you plan to use data owner exceptions.
   See “About Data Owner Exception” on page 375.

4. In the Enforce Server administration console, navigate to Manage > Data Profiles > Exact Data.

5. Click Add Exact Data Profile.

6. Enter a unique, descriptive Name for the profile (limited to 256 characters).
   For easy reference, choose a name that describes the data content and the index type (for example, Employee Data EDM).
   If you modify an existing Exact Data Profile you can change the profile name.

7. Select one of the following Data Source options to make the data source file available to the Enforce Server:
   - **Upload Data Source to Server Now**
     If you are creating a new profile, click Browse and select the data source file, or enter the full path to the data source file.
     If you are modifying an existing profile, select Upload Now.
     See “Uploading exact data source files to the Enforce Server” on page 383.
   - **Reference Data Source on Manager Host**
     If you copied the data source file to the "datafiles" directory on the Enforce Server, it appears in the drop-down list for selection.
     See “Uploading exact data source files to the Enforce Server” on page 383.
   - **Use This File Name**
     Select this option if you have not yet created the data source file but want to configure EDM policies using a placeholder EDM profile. Enter the file name of the data source you plan to create, including the Number of Columns it is to have. When you do create the data source, you must copy it to the "datafiles" directory.
     See “Uploading exact data source files to the Enforce Server” on page 383.
Note: Use this option with caution. Be sure to remember to create the data source file and copy it to the "datafiles" directory. Name the data source file exactly the same as the name you enter here and include the exact number of columns you specify here.

- LoadExternallyGeneratedIndex
  Select this option if you have created an index on a remote computer using the Remote EDM Indexer. This option is only available after you have defined and saved the profile. Profiles are loaded from the `/SymantecDLP/Protect/Index` directory on the Enforce Server host.
  See “Uploading exact data source files to the Enforce Server” on page 383.

8 If the first row of your data source contains Column Names, select the "Read first row as column names" check box.

9 Specify the Error Threshold, which is the maximum percentage of rows that contain errors before indexing stops.

A data source error is either an empty cell, a cell with the wrong type of data, or extra cells in the data source. For example, a name in a column for phone numbers is an error. If errors exceed a certain percentage of the overall data source (by default, 5%), the system quits indexing and displays an indexing error message. The index is not created if the data source has more invalid records than the error threshold value allows. Although you can change the threshold value, more than a small percentage of errors in the data source can indicate that the data source is corrupt, is in an incorrect format, or cannot be read. If you have a significant percentage of errors (10% or more), stop indexing and cleanse the data source.

See “Preparing the exact data source file for indexing” on page 381.

10 Select the Column Separator Char (delimiter) that you have used to separate the values in the data source file. The delimiters you can use are tabs, commas, or pipes.

11 Select one of the following encoding values for the content to analyze, which must match the encoding of your data source:

- ISO-8859-1 (Latin-1) (default value)
  Standard 8-bit encoding for Western European languages using the Latin alphabet.

- UTF-8
  Use this encoding for all languages that use the Unicode 4.0 standard (all single- and double-byte characters), including those in East Asian languages.
Use this encoding for all languages that use the Unicode 4.0 standard (all single- and double-byte characters), including those in East Asian languages.

**Note:** Make sure that you select the correct encoding. The system does not prevent you from creating an EDM profile using the wrong encoding. The system only reports an error at run-time when the EDM policy attempts to match inbound data. To make sure that you select the correct encoding, after you click **Next**, verify that the column names appear correctly. If the column names do not look correct, you chose the wrong encoding.

12 Click **Next** to go to the second **Add Exact Data Profile** screen.

13 The **Field Mappings** section displays the columns in the data source and the field to which each column is mapped in the Exact Data Profile. Field mappings in existing Exact Data Profiles are fixed and, therefore, are not editable.

See "About using System Fields for data source validation" on page 374.

See "Mapping Exact Data Profile fields" on page 389.

Confirm that the column names in your data source are accurately represented in the **Data Source Field** column. If you selected the **Column Names** option, the Data Source Field column lists the names in the first row of your data source. If you did not select the Column Names option, the column lists Col 1, Col 2, and so on.

14 In the **System Field** column, select a field from the drop-down list for each data source field. (This step is required if you use a policy template, or if you want to check for errors in the data source.)

For example, for a data source field that is called SOCIAL_SECURITY_NUMBER, select **Social Security Number** from the corresponding drop-down list. The values in the **System Field** drop-down lists include all suggested fields for all policy templates.

15 Optionally, specify and name any custom fields (that is, the fields that are not pre-populated in the **System Field** drop-down lists). To do so, perform these steps in the following order:

- Click **Advanced View** to the right of the Field Mappings heading. This screen displays two additional columns (**Custom Name** and **Type**).

- To add a custom system field name, go to the appropriate System Field drop-down list. Select **Custom**, and type the name in the corresponding Custom Name text field.
To specify a pattern type (for purposes of error checking), go to the appropriate Type drop-down list and select the wanted pattern. (To see descriptions of all available pattern types, click Description at the top of the column.)

16 Check your field mappings against the suggested fields for the policy template you plan to use. To do so, go to the Check Mappings Against drop-down list, select a template, and click Check now on the right.

The system displays a list of all template fields that you have not mapped. You can go back and map these fields now. Alternatively, you may want to expand your data source to include as many expected fields as possible, and then re-create the exact data profile. Symantec recommends that you include as many expected data fields as possible.

17 In the Indexing section of the screen, select one of the following options:

- **Submit Indexing Job on Save**
  Select this option to begin indexing the data source when you save the exact data profile.

- **Submit Indexing Job on Schedule**
  Select this option to index the data source according to a specific schedule. Make a selection from the Schedule drop-down list and specify days, dates, and times as required.

  See “About index scheduling” on page 374.

  See “Scheduling Exact Data Profile indexing” on page 392.

18 Click Finish.

After Symantec Data Loss Prevention finishes indexing, it deletes the original data source from the Enforce Server. After you index a data source, you cannot change its schema. If you change column mappings for a data source after you index it, you must create a new exact data profile.

After the indexing process is complete you can create new EDM rules for your policies that reference the Exact Data Profile you have created.

See “Configuring the Content Matches Exact Data policy condition” on page 396.

### Mapping Exact Data Profile fields

After you have added and configured the data source file and settings, the Manage > Data Profiles > Exact Data > Add Exact Data Profile screen lets you map the fields from the data source file to the Exact Data Profile you configure.

To enable error checking on a field in a data source or to use the index with a policy template that uses a system field, you must map the field in the data source to the
system field. The Field Mappings section lets you map the columns in the original data source to system fields in the Exact Data Profile.

Table 19-7  Field mapping options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Source Field</td>
<td>If you selected the Column Names option at the Add Exact Data Profile screen, this column lists the values that are found in the first row from the data source. If you did not select this option, this column lists the columns by generic names (such as Col 1, Col 2, and so on).</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you are implementing data owner exception, you must map either or both the email address and domain fields.</td>
</tr>
<tr>
<td></td>
<td>See “Configuring the Content Matches Exact Data policy condition” on page 396.</td>
</tr>
<tr>
<td>System Field</td>
<td>Select the system field for each column.</td>
</tr>
<tr>
<td></td>
<td>A system field value (except <strong>None Selected</strong>) cannot be mapped to more than one column.</td>
</tr>
<tr>
<td></td>
<td>Some system fields have system patterns associated with them (such as social security number) and some do not (such as last name).</td>
</tr>
<tr>
<td></td>
<td>See “Using system-provided pattern validators for EDM profiles” on page 391.</td>
</tr>
<tr>
<td>Check mappings against policy</td>
<td>Select a policy template from the drop-down list to compare the field mappings against and then click <strong>Check now</strong>.</td>
</tr>
<tr>
<td>template</td>
<td>All policy templates that implement EDM appear in the drop-down menu, including any you have imported.</td>
</tr>
<tr>
<td></td>
<td>See “Choosing an Exact Data Profile” on page 322.</td>
</tr>
<tr>
<td></td>
<td>If you plan to use more than one policy template, select one and check it, and then select another and check it, and so on.</td>
</tr>
<tr>
<td></td>
<td>If there are any fields in the policy template for which no data exists in the data source, a message appears listing the missing fields. You can save the profile anyway or use a different Exact Data Profile.</td>
</tr>
<tr>
<td>Advanced View</td>
<td>If you want to customize the schema for the exact data profile, click <strong>Advanced View</strong> to display the advanced field mapping options.</td>
</tr>
<tr>
<td></td>
<td><strong>Table 19-8</strong> lists and describes the additional columns you can specify in the <strong>Advanced View</strong> screen.</td>
</tr>
<tr>
<td>Indexing</td>
<td>Select one of the indexing options.</td>
</tr>
<tr>
<td></td>
<td>See “Scheduling Exact Data Profile indexing” on page 392.</td>
</tr>
<tr>
<td>Finish</td>
<td>Click <strong>Finish</strong> when you are done configuring the Exact Data Profile.</td>
</tr>
</tbody>
</table>
From the **Advanced View** you map the system and data source fields to system patterns. System patterns map the specified structure to the data in the Exact Data Profile and enable efficient error checking and hints for the indexer.

**Table 19-8**  
**Advanced View options**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom Name</td>
<td>If you select Custom Name for a System Field, enter a unique name for it and then select a value for Type. The name is limited to 60 characters.</td>
</tr>
<tr>
<td>Type</td>
<td>If you select a value other than Custom for a System Field, some data types automatically select a value for Type. For example, if you select <strong>Birth Date</strong> for the System Field, <strong>Date</strong> is automatically selected as the Type. You can accept it or change it. Some data types do not automatically select a value for Type. For example, if you select <strong>Account Number</strong> for the System Field, the Type remains unselected. You can specify the data type of your particular account numbers. See “Using system-provided pattern validators for EDM profiles” on page 391.</td>
</tr>
<tr>
<td>Description</td>
<td>Click the link (description) beside the <strong>Type</strong> column header to display a pop-up window containing the available system data types. See also the topic link below.</td>
</tr>
<tr>
<td>Simple View</td>
<td>Click <strong>Simple View</strong> to return to the Simple View (with the Custom Name and Type columns hidden).</td>
</tr>
</tbody>
</table>

See “Creating and modifying Exact Data Profiles” on page 385.

**Using system-provided pattern validators for EDM profiles**

**Table 19-9** lists and describes the system-provided data validators for EDM profiles.

**Table 19-9**  
**System-provided data validators for EDM profiles**

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Credit Card Number</td>
<td>The Credit Card pattern is built around knowledge about various internationally recognized credit cards, their registered prefixes, and number of digits in account numbers. The following types of Credit Cards patterns are validated: MasterCard, Visa, America Express, Diners Club, Discover, Enroute, and JCB. Optional spaces in designated areas within credit cards numbers are recognized. Note that only spaces in generally accepted locations (for example, after every 4th digit in MC/Visa) are recognized. Note that the possible location of spaces differs for different card types. Credit card numbers are validated using checksum algorithm. If a number looks like a credit card number (that is, it has correct number of digits and correct prefix), but does not pass checksum algorithm, it is not considered to be a credit card, but just a number.</td>
</tr>
</tbody>
</table>
### Table 19-9  System-provided data validators for EDM profiles (continued)

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email</td>
<td>Email is a sequence of characters that looks like the following: <code>string@string.tld</code>, where string may contain letters, digits, underscore, dash, and dot, and 'tld' is one of the approved DNS top level generic domains, or any two letters (for country domains).</td>
</tr>
<tr>
<td>IP Address</td>
<td>IP Address is a collection of 4 sequences of between 1 and 3 digits, separated by dots.</td>
</tr>
<tr>
<td>Number</td>
<td>Number is either float or integer, either by itself or in round brackets (parenthesis).</td>
</tr>
<tr>
<td>Percent</td>
<td>Percent is a number immediately followed by the percent sign (&quot;%&quot;). No space is allowed between a number and a percent sign.</td>
</tr>
</tbody>
</table>
| Phone       | Only US and Canadian telephone numbers are recognized. The phone number must start with any digit but 1, with the exception of numbers that include a country code. Phone number can be one of the following formats:  
  - 7 digits (no spaces or dashes)  
  - Same as above, preceded by 3 digits, or by 3 digits in round brackets, followed by spaces or dashes  
  - 3 digits, followed by optional spaces/dashes, followed by 4 digits  
  - Same as above, preceded by the number 1, followed by spaces or dashes  

All cases above can be optionally followed by an extension number, preceded by spaces or dashes. The extension number is 2 to 5 digits preceded by any of the following (case insensitive): 'x' 'ex' 'ext' 'exten' 'extens' 'extensions' optionally followed by a dot and spaces.  
**Note:** The system does not recognize the pattern XXX-XXX-XXXX as a valid phone number format because this format is frequently used in other forms of identification. If your data source contains a column of phone numbers in that format, select **None Selected** to avoid confusion between phone numbers and other data. |
| Postal Code | Only US ZIP codes and Canadian Postal Codes are recognized. The US ZIP code is a sequence of 5 digits, optionally followed by dash, followed by another 4 digits. The Canadian Postal Code is a sequence like K2B 8C8, that is, "letter-digit-letter-space-digit-letter-digit" where space(s) in the middle is optional.                                                                                                                   |
| Social Security Number | Only US TAX IDs are recognized. The TAX ID is a 3 digits, optionally followed by spaces or dashes, followed by 2 digits, optionally followed by spaces or dashes, followed by 4 digits.  

### Scheduling Exact Data Profile indexing

When you configure an Exact Data Profile, you can set a schedule for indexing the data source (**Submit Indexing on Job Schedule**).

See “About index scheduling” on page 374.

Before you set up a schedule, consider the following recommendations:
If you update your data sources occasionally (for example, less than once a month), there is no need to create a schedule. Index the data each time you update the data source.

Schedule indexing for times of minimal system use. Indexing affects performance throughout the Symantec Data Loss Prevention system, and large data sources can take time to index.

Index a data source as soon as you add or modify the corresponding exact data profile, and re-index the data source whenever you update it. For example, consider a scenario whereby every Wednesday at 2:00 A.M. you update the data source. In this case you should schedule indexing every Wednesday at 3:00 A.M. Do not index data sources daily as this can degrade performance.

Monitor results and modify your indexing schedule accordingly. If performance is good and you want more timely updates, for example, schedule more frequent data updates and indexing.

The Indexing section lets you index the Exact Data Profile as soon as you save it (recommended) or on a regular schedule as follows:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Submit Indexing Job on Save</td>
<td>Select this option to index the Exact Data Profile when you click Save.</td>
</tr>
<tr>
<td>Submit Indexing Job on Schedule</td>
<td>Select this option to schedule an indexing job. The default option is No Regular Schedule. If you want to index according to a schedule, select a desired schedule period, as described.</td>
</tr>
</tbody>
</table>
| Index Once                     | On – Enter the date to index the document profile in the format MM/DD/YY. You can also click the date widget and select a date.  
At – Select the hour to start indexing. |
| Index Daily                    | At – Select the hour to start indexing.  
Until – Select this check box to specify a date in the format MM/DD/YY when the indexing should stop. You can also click the date widget and select a date. |
| Index Weekly                   | Day of the week – Select the day(s) to index the document profile.  
At – Select the hour to start indexing.  
Until – Select this check box to specify a date in the format MM/DD/YY when the indexing should stop. You can also click the date widget and select a date. |
Table 19-10  Scheduling indexing for Exact Data Profiles (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index Monthly</td>
<td><strong>Day</strong> – Enter the number of the day of each month you want the indexing to occur. The number must be 1 through 28.</td>
</tr>
<tr>
<td></td>
<td><strong>At</strong> – Select the hour to start indexing.</td>
</tr>
<tr>
<td></td>
<td><strong>Until</strong> – Select this check box to specify a date in the format MM/DD/YY when the indexing should stop. You can also click the date widget and select a date.</td>
</tr>
</tbody>
</table>

See “Mapping Exact Data Profile fields” on page 389.

See “Creating and modifying Exact Data Profiles” on page 385.

Managing and adding Exact Data Profiles

You manage and create **Exact Data Profiles** for EDM at the **Manage > Data Profiles > Exact Data** screen. Once a profile has been created, the **Exact Data** screen lists all Exact Data Profiles configured in the system.

See “About the Exact Data Profile and index” on page 371.

Table 19-11  Exact Data screen actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add EDM profile</td>
<td>Click <strong>Add Exact Data Profile</strong> to define a new Exact Data Profile.</td>
</tr>
<tr>
<td></td>
<td>See “Configuring Exact Data profiles” on page 378.</td>
</tr>
<tr>
<td>Edit EDM profile</td>
<td>To modify an existing <strong>Exact Data Profile</strong>, click the name of the profile, or click the pencil icon at the far right of the profile row.</td>
</tr>
<tr>
<td></td>
<td>See “Creating and modifying Exact Data Profiles” on page 385.</td>
</tr>
<tr>
<td>Remove EDM profile</td>
<td>Click the red X icon at the far right of the profile row to delete the Exact Data Profile from the system. A dialog box confirms the deletion.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: You cannot edit or remove a profile if another user currently modifies that profile, or if a policy exists that depends on that profile.</td>
</tr>
<tr>
<td>Download EDM profile</td>
<td>Click the <strong>download profile</strong> link to download and save the Exact Data Profile.</td>
</tr>
<tr>
<td></td>
<td>This is useful for archiving and sharing profiles across environments. The file is in the binary *<strong>.edm</strong> format.</td>
</tr>
</tbody>
</table>
Table 19-11  Exact Data screen actions (continued)

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refresh EDM profile status</td>
<td>Click the refresh arrow icon at the upper right of the <em>Exact Data</em> screen to fetch the latest status of the indexing process. If you are in the process of indexing, the system displays the message “Indexing is starting.” The system does not automatically refresh the screen when the indexing process completes.</td>
</tr>
</tbody>
</table>

Table 19-12  Exact Data screen details

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exact Data Profile</td>
<td>The name of the exact data profile.</td>
</tr>
<tr>
<td>Last Active Version</td>
<td>The version of the exact data profile and the name of the detection server that runs the profile.</td>
</tr>
<tr>
<td>Status</td>
<td>The current status of the exact data profile, which can be any of the following:</td>
</tr>
<tr>
<td></td>
<td>■ Next scheduled indexing (if it is not currently indexing)</td>
</tr>
<tr>
<td></td>
<td>■ Sending an index to a detection server</td>
</tr>
<tr>
<td></td>
<td>■ Indexing</td>
</tr>
<tr>
<td></td>
<td>■ Deploying to servers</td>
</tr>
<tr>
<td></td>
<td>In addition, the current status of the indexing process for each detection server, which can be any of the following:</td>
</tr>
<tr>
<td></td>
<td>■ Completed, including a completion date</td>
</tr>
<tr>
<td></td>
<td>■ Pending index completion (waiting for the Enforce Server to finish indexing the exact data source file)</td>
</tr>
<tr>
<td></td>
<td>■ Replicating indexing</td>
</tr>
<tr>
<td></td>
<td>■ Creating index (internally)</td>
</tr>
<tr>
<td></td>
<td>■ Building caches</td>
</tr>
<tr>
<td>Error messages</td>
<td>The <em>Exact Data</em> screen displays any error messages in red. For example, if the Exact Data Profile is corrupt or does not exist, the system displays an error message.</td>
</tr>
</tbody>
</table>

Configuring EDM policies

This section describes how to configure EDM policy conditions.

See “Configuring the Content Matches Exact Data policy condition” on page 396.

See “Configuring Data Owner Exception for EDM policy conditions” on page 398.
Configuring the Content Matches Exact Data policy condition

Once you have defined the Exact Data Profile and indexed the data source, you configure one or more Content Matches Exact Data conditions in policy rules.

See “About the Content Matches Exact Data From condition” on page 375.

Table 19-13  Configure the Content Matches Exact Data policy condition

<table>
<thead>
<tr>
<th>Steps</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1     | Configure an EDM policy detection rule.  | Create a new EDM detection rule in a policy, or modify an existing EDM rule.  
See “Configuring policies” on page 326.  
See “Configuring policy rules” on page 330. |
| 2     | Select the fields to match.  | The first thing you do when configuring the EDM condition is select each data field that you want the condition to match. You can select all or deselect all fields at once. The system displays all the fields or columns that were included in the index. You do not have to select all the fields, but you should select at least 2 or 3, one of which must be unique, such as social security number, credit card number, and so forth.  
See “Best practices for using EDM” on page 451. |
| 3     | Choose the number of selected fields to match.  | Choose the number of the selected fields to match from the drop down menu. This number represents the number of fields of those selected that must be present in a message to trigger a match. You must select at least as many fields to match as the number of data fields you check. For example, if you choose 2 of the selected fields from the menu, you must have checked at least two fields present in a message for detection.  
See “Ensure data source has at least one column of unique data” on page 452. |
### Table 19-13  
Configure the Content Matches Exact Data policy condition  
*(continued)*

<table>
<thead>
<tr>
<th>Steps</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| 4     | Select the WHERE clause to enter specific field values to match (optional). | The **WHERE** clause option matches on the specified field value. You specify a **WHERE** clause value by selecting an exact data field from the menu and by entering a value for that field in the adjacent text box. If you enter more than one value, separate the values with commas.  
See "Use a **WHERE** clause to detect records that meet specific criteria" on page 460.  
For example, consider an Exact Data Profile for "Employees" with a "State" field containing state abbreviations. In this example, to implement the **WHERE** clause, you select (check) **WHERE**, choose "State" from the drop-down list, and enter **CA,NV** in the text box. This **WHERE** clause then limits the detection server to matching messages that contain either **CA** or **NV** as the value for the State field.  
**Note:** You cannot specify a field for **WHERE** that is the same as one of the selected matched fields. |
| 5     | Ignore data owners (optional). | Selecting this option implements Data Owner Exception.  
See “Configuring Data Owner Exception for EDM policy conditions” on page 398. |
| 6     | Exclude data field combinations (optional). | You can use the exclude data field combinations to specify combinations of data values that are exempted from detection. If the data appears in exempted pairs or groups, it does not cause a match. Excluded combinations are only available when matching 2 or 3 fields. To enable this option, you must select 2 or 3 fields to match from the **_ of the selected fields** menu at the top of the condition configuration.  
See "Leverage exception tuples to avoid false positives" on page 459.  
To implement excluded combinations, select an option from each **Field N** column that appears. Then click the right-arrow icon to add the field combination to the **Excluded Combinations** list. To remove a field from the list, select it and click the left-arrow icon.  
**Note:** Hold down the **Ctrl** key to select more than one field in the right-most column. |
| 7     | Select an incident minimum. | Enter or modify the minimum number of matches required for the condition to report an incident.  
For example, consider a scenario where you specify **1 of the selected fields** for a social security number field and an incident minimum of **5**. In this situation the engine must detect at least five matching social security numbers in a single message to trigger an incident.  
See “Match count variant examples” on page 413. |
### Table 19-13
Configure the Content Matches Exact Data policy condition (continued)

<table>
<thead>
<tr>
<th>Steps</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| 8     | Select components to match on. | Select one or more message components to match on:  
- **Envelope** – The header of the message.  
- **Subject** – (Not available for EDM.)  
- **Body** – The content of the message.  
- **Attachments** – The content of any files attached to or transported by the message.  
See “Selecting components to match on” on page 336. |
| 9     | Select one or more conditions to also match. | Select this option to create a compound condition. All conditions must match for the rule to trigger an incident.  
You can **Add** any available condition from the list.  
See “Configuring compound match conditions” on page 342. |
| 10    | Test and troubleshoot the policy. | See “Test and tune policies to improve match accuracy” on page 361.  
See “Troubleshooting policies” on page 353. |

### Configuring Data Owner Exception for EDM policy conditions

To except data owners from detection, you must include in your Exact Data Profile either an email address or a domain address field (for example, symantec.com). Once Data Owner Exception (DOE) is enabled, if the sender or recipient of confidential information is the data owner (by email address or domain), the detection server allows the data to be sent or received without generating an incident.

**To configure DOE for an EDM policy condition**

1. When you are configuring the Content Matches Exact Data condition, select the **Ignore data owners** option.
2. Select one of the following options:
   - **Sender matches** — Select this option to EXCLUDE the data sender from detection.
   - **Any or All Recipient matches** — Select one of these options to EXCLUDE any or all data recipient(s) from detection.

**Note:** When you configure DOE for the EDM condition, you cannot select a value for Ignore Sender/Recipient that is the same as one of the matched fields.

See “About Data Owner Exception” on page 375.
Configuring the Sender/User based on a Profiled Directory policy condition

The **Sender/User based on a Directory from** detection rule lets you create detection rules based on sender identity or (for endpoint incidents) user identity. This condition requires an Exact Data Profile.

See “Creating the exact data source file for profiled DGM” on page 380.

After you select the Exact Data Profile, when you configure the rule, the directory you selected and the sender identifier(s) appear at the top of the page.

Table 19-14 describes the parameters for configuring the **Sender/User based on a Directory from an EDM Profile** condition.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Where</strong></td>
<td>Select this option to have the system match on the specified field values. Specify the values by selecting a field from the drop-down list and typing the values for that field in the adjacent text box. If you enter more than one value, separate the values with commas. For example, for an Employees directory group profile that includes a <strong>Department</strong> field, you would select <strong>Where</strong>, select <strong>Department</strong> from the drop-down list, and enter <strong>Marketing, Sales</strong> in the text box. If the condition is implemented as a rule, in this example a match occurs only if the sender or user works in Marketing or Sales (as long as the other input content meets all other detection criteria). If the condition is implemented as an exception, in this example the system ignores from matching messages from a sender or user who works in Marketing or Sales.</td>
</tr>
<tr>
<td><strong>Is Any Of</strong></td>
<td>Enter or modify the information you want to match. For example, if you want to match any sender in the Sales department, select <strong>Department</strong> from the drop-down list, and then enter <strong>Sales</strong> in this field (assuming that your data includes a Department column). Use a comma-separated list if you want to specify more than one value.</td>
</tr>
</tbody>
</table>

Configuring the Recipient based on a Profiled Directory policy condition

The **Recipient based on a Directory from** condition lets you create detection methods based on the identity of the recipient. This method requires an Exact Data Profile.

See “Creating the exact data source file for profiled DGM” on page 380.
After you select the Exact Data Profile, when you configure the rule, the directory you selected and the recipient identifier(s) appear at the top of the page.

Table 19-15 describes the parameters for configuring Recipient based on a Directory from an EDM profile condition.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Where</td>
<td>Select this option to have the system match on the specified field values. Specify the values by selecting a field from the drop-down list and typing the values for that field in the adjacent text box. If you enter more than one value, separate the values with commas. For example, for an Employees directory group profile that includes a Department field, you would select Where, select Department from the drop-down list, and enter Marketing, Sales in the text box. For a detection rule, this example causes the system to capture an incident only if at least one recipient works in Marketing or Sales (as long as the input content meets all other detection criteria). For an exception, this example prevents the system from capturing an incident if at least one recipient works in Marketing or Sales.</td>
</tr>
<tr>
<td>Is Any Of</td>
<td>Enter or modify the information you want to match. For example, if you want to match any recipient in the Sales department, select Department from the drop-down list, and then enter Sales in this field (assuming that your data includes a Department column). Use a comma-separated list if you want to specify more than one value.</td>
</tr>
</tbody>
</table>

Configuring Advanced Server Settings for EDM policies

EDM has various advanced settings available at the System > Servers > Overview > Server Detail - Advanced Server Settings screen for the chosen detection server. Use caution when modifying these settings on a server. It is recommended that you check with Symantec Data Loss Prevention Support before changing any of the settings on this screen. Changes to these settings do not take effect until after the server is restarted.

See “Advanced server settings” on page 203.

Table 19-16 Advanced Server Settings for EDM indexing and detection

<table>
<thead>
<tr>
<th>EDM parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EDM.MatchCountVariant</td>
<td>2</td>
<td>This setting specifies how matches are counted.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ 1 - Counts the number of token sets matched regardless of use of the same tokens across several matches.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ 2 - Counts the number of unique token sets (default).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Match count variant examples” on page 413.</td>
</tr>
</tbody>
</table>
Table 19-16  Advanced Server Settings for EDM indexing and detection (continued)

<table>
<thead>
<tr>
<th>EDM parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EDM.MaximumNumberOfMatchesToReturn</td>
<td>100</td>
<td>Defines a top limit on the number of matches returned from each RAM index search. For multi-file indices, this limit is applied to each sub-index search independently before the search results are combined. As a result the number of actual matches can exceed this limit for multiple file indices.</td>
</tr>
<tr>
<td>EDM.RunProximityLogic</td>
<td>true</td>
<td>If true (default), this setting runs the token proximity check. The free-form text proximity is defined by the setting EDM.SimpleTextProximityRadius. The tabular text proximity is defined by belonging to the same table row. Note: Disabling proximity is not recommended because it can negatively impact the performance of the system.</td>
</tr>
<tr>
<td>EDM.SimpleTextProximityRadius</td>
<td>35</td>
<td>Provides the baseline range for proximity checking a matched token. This value is multiplied by the number of required matches to equal the complete proximity check range. To keep the same “required match density,” the proximity check range behaves like a moving window in a text page. D is defined as the proportionality factor for the window and is set in the policy condition by choosing how many fields to match on for the EDM condition. N is the SimpleTextProximityRadius value. A number of tokens are in the proximity range if the first token in is within N x D words from the last token. The proximity check range is directly proportional to the number of matches by a factor of D. See &quot;Proximity matching example&quot; on page 414. Note: Increasing the radius value higher than the default can negatively impact system performance and is not recommended.</td>
</tr>
<tr>
<td>EDM.TokenVerifierEnabled</td>
<td>false</td>
<td>Reserved for future use.</td>
</tr>
<tr>
<td>Lexer.IncludePunctuationInWords</td>
<td>true</td>
<td>If true, during detection punctuation characters are considered as part of a token. If false, during detection punctuation within a token or multi-token is treated as white space. See &quot;Multi-token with punctuation&quot; on page 406. Note: This setting applies to detection content, not to indexed content.</td>
</tr>
</tbody>
</table>
### Table 19-16  Advanced Server Settings for EDM indexing and detection (continued)

<table>
<thead>
<tr>
<th>EDM parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>
| Lexer.MaximumNumberOfTokens       | 12000   | Maximum number of tokens extracted from each message component for detection. Applicable to all detection technologies where tokenization is required (EDM, profiled DGM, and the system patterns supported by those technologies). Increasing the default value may cause the detection server to run out of memory and restart.  
**Note:** In Data Loss Prevention version 12.5 the default value is changed from 30,000 to 12,000. Previously, all tokens up to the limit, including stopwords and single letter words, were sent to detection. In version 12.5, the tokens sent for detection do not include stopwords or single words. The number of meaningful tokens sent to detection is approximately the same as previous versions. |
| Lexer.MaxTokensPerMultiToken      | 10      | Maximum number of sub-tokens that a multi-token cell can contain. You can set this amount to as many sub-tokens as you need, but the total number of characters in a multi-token cell cannot exceed 200.  
See “Characteristics of multi-token cells” on page 404. |
| Lexer.MultiToken                  | true    | If true cells containing spaces or punctuation are treated as multi-token cells and multi-token rules are obeyed. Multi-token matching is enabled by default.  
See “Using multi-token matching” on page 403. |
| Lexer.StopwordLanguages           | en      | Enables the elimination of stop words for the specified languages. The default is English.  |
| Lexer.Validate                    | true    | If true, performs system pattern-specific validation during indexing. Setting this to false is not recommended.  
See “Using system-provided pattern validators for EDM profiles” on page 391. |
| ProfileIndex.CheckAvailableRAM    | true    | Specifies whether or not the amount of available RAM should be compared with a profile size before loading an EDM profile.  |
| ProfileIndex.MaximumInProcessIndexSize | 100M  | Specifies an upper limit for the maximum In Process index size. Profiles that exceed this size are loaded out of process.  
See “Memory requirements for EDM” on page 421. |
Table 19-16  Advanced Server Settings for EDM indexing and detection (continued)

<table>
<thead>
<tr>
<th>EDM parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ProfileIndex.MinimumMemoryReserve</td>
<td>600M</td>
<td>Specifies the memory reserved for out-of-process EDM algorithm execution. It is used to calculate the JVM heap size as index_size + MinumumMemoryReserve.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong>: If you see poor performance on the detection server host and CPU usage is above 60%, increase to 1000M (1 GB).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Memory requirements for EDM” on page 421.</td>
</tr>
<tr>
<td>ProfileIndex.ProcessTimeout</td>
<td>60000</td>
<td>The time interval (in milliseconds) for launching out of process indexing. If the process is not created within this amount of time then index loading fails.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong>: In Data Loss Prevention version 12.5 the default value is changed from 10,000 to 60,000.</td>
</tr>
</tbody>
</table>

Using multi-token matching

EDM policy matching is based on tokens in the index. For languages based on the Latin alphabet, a token is a word or string of alphanumeric characters delimited by spaces. For Chinese, Japanese, and Korean languages, a token is determined by other means. Tokens are normalized so that formatting and case are ignored. At run-time the server performs a full-text search against an inbound message, checking each word against the index for potential matches. The matching algorithm compares each word in the message with the contents of each token in the index.

A multi-token cell is a cell in the index that contains multiple words separated by spaces, leading or trailing punctuation, or alternative Latin and Chinese, Japanese, or Korean language characters. The sub-token parts of a multi-token cell obey the same rules as single-token cells: they are normalized according to their pattern where normalization can apply. Inbound message data must match a multi-token cell exactly, including whitespace, punctuation, and stopwords (assuming the default settings).

For example, an indexed cell containing the string "Bank of America" is a multi-token comprising 3 sub-token parts. During detection, the inbound message "bank of america" (normalized) matches the multi-token cell, but "bank americ" does not.

Multi-token matching is enabled by default. Multi-token cells are more computationally expensive than single-token cells. If the index includes multi-token cells, you must verify that you have enough memory to index, load, and process the EDM profile.
Characteristics of multi-token cells

Table 19-17 lists and describes characteristics of multi-token matching.
See “Using multi-token matching” on page 403.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multi-token matching is configurable; by default it is enabled.</td>
<td>Lexer.MultiToken = true</td>
</tr>
<tr>
<td></td>
<td>See “Configuring Advanced Server Settings for EDM policies” on page 400.</td>
</tr>
<tr>
<td>A multi-token cell is limited to 200 total characters, including whitespace,</td>
<td>Lexer.MaxTokensPerMultiToken = 10</td>
</tr>
<tr>
<td>punctuation, letters, numbers, and symbols. You cannot increase this amount,</td>
<td>See “Configuring Advanced Server Settings for EDM policies” on page 400.</td>
</tr>
<tr>
<td>but you can configure how many sub-tokens a multi-token can contain.</td>
<td></td>
</tr>
<tr>
<td>Whitespace in multi-token cells is considered, but multiple whitespaces are</td>
<td>See “Multi-token with spaces” on page 404.</td>
</tr>
<tr>
<td>normalized to 1.</td>
<td></td>
</tr>
<tr>
<td>Punctuation immediately preceding and following a token or sub-token is</td>
<td>See “Multi-token with punctuation” on page 406.</td>
</tr>
<tr>
<td>always ignored.</td>
<td>See “Additional examples for multi-token cells with punctuation” on page 407.</td>
</tr>
<tr>
<td>You can configure how punctuation within a token or multi-token is treated</td>
<td>Lexer.IncludePunctuationInWords = true</td>
</tr>
<tr>
<td>during detection. For most cases the default setting (“true”) is appropriate.</td>
<td>See “Configuring Advanced Server Settings for EDM policies” on page 400.</td>
</tr>
<tr>
<td>If set to “false,” punctuation is treated as whitespace.</td>
<td></td>
</tr>
<tr>
<td>For proximity range checking the sub-token parts of a multi-token are</td>
<td>See “Proximity matching example” on page 414.</td>
</tr>
<tr>
<td>counted as single tokens.</td>
<td></td>
</tr>
<tr>
<td>The system does not consider stopwords when matching multi-tokens. In other</td>
<td>See “Multi-token with stopwords” on page 405.</td>
</tr>
<tr>
<td>words, stopwords are not excluded.</td>
<td></td>
</tr>
<tr>
<td>Multi-tokens are more computationally expensive than single tokens and</td>
<td>See “Memory requirements for EDM” on page 421.</td>
</tr>
<tr>
<td>require additional memory for indexing, loading, and processing.</td>
<td></td>
</tr>
</tbody>
</table>

Multi-token with spaces

Table 19-18 shows examples of multi-tokens with spaces.
Table 19-18  Multi-token cell with spaces examples

<table>
<thead>
<tr>
<th>Description</th>
<th>Indexed content</th>
<th>Detected content</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cell contains space</td>
<td>Bank of America</td>
<td>Bank of America</td>
<td>Cell with spaces is multi-token. Multi-token must match exactly.</td>
</tr>
<tr>
<td>Cells contains multiple spaces</td>
<td>Bank of America</td>
<td>Bank of America</td>
<td>Multiple spaces are normalized to one.</td>
</tr>
</tbody>
</table>

Multi-token with stopwords

Stopwords are common words, such as articles and prepositions. When creating single-tokens, the EDM indexing process ignores words found in the EDM stopword list (`\SymantecDLP\Protect\config\stopwords`), as well as single letters. However, when creating multi-tokens, stopwords and single letters are not ignored. Instead, they are part of the multi-token.

Table 19-19 shows multi-token matches with stopwords, single letters, and single digits.

Table 19-19  Cell contains stopwords or single letter or single digit

<table>
<thead>
<tr>
<th>Description</th>
<th>Cell content</th>
<th>Should match</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cell contains stopword.</td>
<td>throw other ball</td>
<td>throw other ball</td>
<td>Common word (&quot;other&quot;) is filtered out during detection but not when it is part of a multi-token.</td>
</tr>
<tr>
<td>Cell contains single letter.</td>
<td>throw a ball</td>
<td>throw a ball</td>
<td>Single letter (&quot;a&quot;) is filtered out, but not when it is part of a multi-token.</td>
</tr>
<tr>
<td>Cell contains single digit.</td>
<td>throw 1 ball</td>
<td>throw 1 ball</td>
<td>Unlike single-letter words that are stopwords, single digits are never ignored.</td>
</tr>
</tbody>
</table>

Multi-token with mixed language characters

Table 19-20 shows examples of multi-tokens with mixed Latin and CJK characters.
### Table 19-20  
Multi-token cell with Latin and CJK characters examples

<table>
<thead>
<tr>
<th>Description</th>
<th>Cell content</th>
<th>Should match</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cell includes Latin and CJK characters with no spaces.</td>
<td>ABC傠佪 佪佪ABC</td>
<td>ABC佪佪 佪佪ABC</td>
<td>Mixed Latin-CJK cell is multi-token. Must match exactly.</td>
</tr>
<tr>
<td>Cell includes Latin and CJK with one or more spaces.</td>
<td>ABC 佪佪 佪佪 ABC</td>
<td>ABC 佪佪 佪佪 ABC</td>
<td>Multiple spaces are reduced to one.</td>
</tr>
<tr>
<td>Cell contains Latin or CJK with numbers.</td>
<td>什仁 仂仃 仄仅 仇仈仉 147(什仈仉 51-1)</td>
<td>什仁 仂仃 仄仅 仇仈仉 147(什仈仉 51-1)</td>
<td>Single-token cell.</td>
</tr>
</tbody>
</table>

### Multi-token with punctuation

Punctuation is always ignored if it comes at the beginning (leading) or end (trailing) of a token or multi-token. Whether punctuation included in a token or multi-token is required for matching depends on the Advanced Server Setting `Lexer.IncludePunctuationInWords`, which by default is set to `true` (enabled).

See “Multi-token punctuation characters” on page 412.

---

**Note:** For convenience purposes the `Lexer.IncludePunctuationInWords` parameter is referred to by the three-letter acronym "WIP" throughout this section.

The WIP setting operates at detection-time to alter how matches are reported. For most EDM policies you should not change the WIP setting. For a few limited situations, such as account numbers or addresses, you may need to set `IncludePunctuationInWords = false` depending on your detection requirements.

See “Multi-token punctuation characters” on page 412.

Table 19-21 lists and explains how multi-token matching works with punctuation.

### Table 19-21  
Multi-token punctuation table

<table>
<thead>
<tr>
<th>Indexed content</th>
<th>Detected content</th>
<th>WIP setting</th>
<th>Match</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>a.b</td>
<td>a.b</td>
<td>TRUE</td>
<td>Yes</td>
<td>The indexed content and the detected content are exactly the same.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FALSE</td>
<td>No</td>
<td>The detected content is treated as &quot;a b&quot; and is therefore not a match.</td>
</tr>
</tbody>
</table>
Table 19-21  Multi-token punctuation table (continued)

<table>
<thead>
<tr>
<th>Indexed content</th>
<th>Detected content</th>
<th>WIP setting</th>
<th>Match</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>a.b</td>
<td>a b</td>
<td>TRUE</td>
<td>No</td>
<td>The indexed content and the detected content are different.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FALSE</td>
<td>No</td>
<td>The indexed content and the detected content are different.</td>
</tr>
<tr>
<td>a b</td>
<td>a.b</td>
<td>TRUE</td>
<td>No</td>
<td>The indexed content and the detected content are different.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FALSE</td>
<td>Yes</td>
<td>The detected content is treated as &quot;a b&quot; and is therefore a match.</td>
</tr>
<tr>
<td>a b</td>
<td>a b</td>
<td>TRUE</td>
<td>Yes</td>
<td>The indexed content and the detected content are exactly the same</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FALSE</td>
<td>Yes</td>
<td>The indexed content and the detected content are exactly the same</td>
</tr>
</tbody>
</table>

Additional examples for multi-token cells with punctuation

Table 19-22 lists and describes some additional examples for multi-token cells with punctuation. In these examples, the main thing to keep in mind is that during indexing, if a token includes punctuation marks between characters the punctuation is always retained. This means that EDM cannot detect that cell if the WIP setting is false. In other words, if indexed data has cell which has a token with internal punctuation, the WIP setting should be set to true.

Table 19-22  Additional use cases for multi-token cells with punctuation

<table>
<thead>
<tr>
<th>Description</th>
<th>Indexed content</th>
<th>Detected content</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cell contains a physical address with punctuation.</td>
<td>346 Guerrero St., Apt. #2</td>
<td>346 Guerrero St., Apt. #2</td>
<td>The indexed content is a multi-token cell.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>346 Guerrero St Apt 2</td>
<td>Both match because the punctuation comes at the beginning or end of the sub-token parts and is therefore ignored.</td>
</tr>
<tr>
<td>Description</td>
<td>Indexed content</td>
<td>Detected content</td>
<td>Explanation</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------------</td>
<td>-----------------</td>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Cell contains internal punctuation with no space before or after.</td>
<td>O’NEAL ST.</td>
<td>O’NEAL ST</td>
<td>The indexed content is a multi-token cell. Internal punctuation is included (assuming WIP is true), and leading or trailing punctuation is ignored (assuming there is a space delimiter after the punctuation).</td>
</tr>
<tr>
<td>Cell contains Asian language characters (CJK) with indexed internal punctuation.</td>
<td>傠傫;;偉僱</td>
<td>傠僱;;偉僱 (if WIP true)</td>
<td>The indexed content is a single token cell. During detection, Asian language characters (CJK) with internal punctuation is affected by the WIP setting. Thus, in this example 傠僱;;偉僱 matches only if the WIP setting is true. If the WIP setting is false, 傠僱;;偉僱 is considered a multi-token because the internal punctuation is treated as whitespace. Thus, no content can match.</td>
</tr>
<tr>
<td>Cell contains Asian language characters (CJK) without indexed internal punctuation.</td>
<td>傠僱 傠僱</td>
<td>傠僱 傠僱 (if WIP false)</td>
<td>The indexed content is a multi-token cell. The detected content matches as indexed. If the WIP setting is false, the detected content matches 傠僱;;偉僱 because internal punctuation is ignored.</td>
</tr>
</tbody>
</table>
Table 19-22  Additional use cases for multi-token cells with punctuation (continued)

<table>
<thead>
<tr>
<th>Description</th>
<th>Indexed content</th>
<th>Detected content</th>
<th>Explanation</th>
</tr>
</thead>
</table>
| Cell contains mix of Latin and CJK characters with punctuation separating the Latin and Asian characters. | EDM;;;償傫      | EDM 償僸     | The indexed content is a multi-token cell.  
A cell with alternate Latin and CJK characters is always a multi-token and punctuation between Latin and Asian characters is always treated as a single white space regardless of the WIP setting. |
| Cell contains mix of Latin and CJK characters with internal punctuation.    | DLP;;;EDM 償僸;;;償 傫 | DLP;;;EDM 償僸;;;償 傫 (if WIP true)  
DLP;;;EDM 償僸;;;償 傫 (if WIP true) | The indexed content is a multi-token cell.  
During detection, punctuation between the Latin and Asian characters is treated as a single whitespace and leading and trailing punctuation is ignored.  
If the WIP setting is true the punctuation internal to the Latin characters and internal to the Asian character is retained.  
If the WIP setting is false, no content can match because internal punctuation is ignored. |
Table 19-22  Additional use cases for multi-token cells with punctuation
(continued)

<table>
<thead>
<tr>
<th>Description</th>
<th>Indexed content</th>
<th>Detected content</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cell contains mix of Latin and CJK characters with internal punctuation.</td>
<td>DLP EDM 帚傫 帚傫</td>
<td>DLP EDM 帚傫 帚傫</td>
<td>The indexed content is a multi-token cell. During detection, punctuation between the Latin and Asian characters is treated as a single whitespace and leading and trailing punctuation is ignored. Thus, it matches as indexed. If the WIP setting is false, it matches DLP;EDM;.;;因为因为 because internal punctuation is ignored.</td>
</tr>
</tbody>
</table>

Some special use cases for system-recognized data patterns

EDM provides validation for and recognition of the following special data patterns:

- Credit card number
- Email address
- IP address
- Number
- Percent
- Phone number (US, Canada)
- Postal code (US, Canada)
- Social security number (US SSN)

See “Using system-provided pattern validators for EDM profiles” on page 391.

Note: It is a best practice to always validate your index against the recognized system patterns when the data source includes one or more such column fields. See “Map data source column to system fields to leverage validation” on page 455.

The general rule for system-recognized patterns is that the WIP setting does not apply during detection. Instead, the rules for that particular pattern apply. In other
words, if the pattern is recognized during detection, the WIP setting is not checked. This is always true if the pattern is a string of characters such as an email address, and if the cell contains a number that conforms to one of the recognized number patterns (such as CCN or SSN).

In addition, even if the pattern is a generic number such as account number that does not conform to one of the recognized number patterns, the WIP setting may still not apply. To ensure accurate matching for generic numbers that do not conform to one of the system-recognized patterns, you should not include punctuation in these number cells. If the cell contents conforms to one of the system-recognized patterns, the punctuation rules for that pattern apply and the WIP setting does not.

See “Do not use the comma delimiter if the data source has number fields” on page 455.

See Table 19-23 on page 411. lists and describes examples for detecting system-recognized data patterns.

**Caution:** This list is not exhaustive. It is provided for informational purposes only to ensure that you are aware that data that matches system-defined patterns takes precedence and the WIP setting is ignored. Before deploying your EDM policies into production, you must test detection accuracy and adjust the index accordingly to ensure that the data that you have indexed matches as expected during detection.

<table>
<thead>
<tr>
<th>Description</th>
<th>Indexed content</th>
<th>Detected content</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cell contains an email address.</td>
<td><a href="mailto:person@example.com">person@example.com</a></td>
<td><a href="mailto:person@example.com">person@example.com</a></td>
<td>An email address is indexed and detected as a single-token regardless of the WIP setting. It must match exactly as indexed. If you were to set WIP to false, &quot;person example com&quot; would not match as a multi-token and does not match the indexed single-token.</td>
</tr>
</tbody>
</table>
### Some special use cases for system-recognized data patterns (continued)

<table>
<thead>
<tr>
<th>Description</th>
<th>Indexed content</th>
<th>Detected content</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cells contains a 10-digit account number.</td>
<td>#######</td>
<td>#######</td>
<td>The WIP setting is ignored because the number conforms to the phone number pattern and its rules take precedence.</td>
</tr>
<tr>
<td></td>
<td>(###) ###-####</td>
<td>(###) ###-####</td>
<td></td>
</tr>
<tr>
<td></td>
<td>### ###### ####</td>
<td>### ###### ####</td>
<td>Must match exactly. The pattern ###-####-### does not match even if WIP is set to false.</td>
</tr>
<tr>
<td></td>
<td>### #### ######</td>
<td>### #### ######</td>
<td>Must match exactly. The pattern ###-####-### does not match even if WIP is set to false.</td>
</tr>
</tbody>
</table>

### Multi-token punctuation characters

In EDM, a multi-token cell is any cell that has been indexed that contains punctuation (as well as spaces or alternative Latin words and CJK characters).

See Table 19-24 on page 412.

Using multi-token matching lists the symbols that are identified and treated as punctuation during EDM indexing.

<table>
<thead>
<tr>
<th>Punctuation name</th>
<th>Character representation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apostrophe</td>
<td>'</td>
</tr>
<tr>
<td>Tilde</td>
<td>~</td>
</tr>
<tr>
<td>Exclamation point</td>
<td>!</td>
</tr>
<tr>
<td>Ampersand</td>
<td>&amp;</td>
</tr>
<tr>
<td>Dash</td>
<td>-</td>
</tr>
<tr>
<td>Single quotation mark</td>
<td>'</td>
</tr>
<tr>
<td>Double quotation mark</td>
<td>&quot;</td>
</tr>
<tr>
<td>Period (dot)</td>
<td>.</td>
</tr>
</tbody>
</table>
### Match count variant examples

The default value for the Advanced Server setting `EDM.MatchCountVariant` eliminates matches that consists of the same set of tokens from some other match. Rarely is there a need to change the default value, but if necessary you can configure how EDM matches are counted using this parameter.

See “Advanced server settings” on page 203.
Table 19-25 provides examples for match counting. All examples assume that the policy is set to match 3 of 4 column fields and that the profile index contains the following cell contents:

Kathy | Stevens | 123-45-6789 | 1111-1111-1111-1111
Kathy | Stevens | 123-45-6789 | 2222-2222-2222-2222
Kathy | Stevens | 123-45-6789 | 3333-3333-3333-3333

<table>
<thead>
<tr>
<th>Inbound message contents</th>
<th>Match count variant</th>
<th>Number of matches</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Kathy Stevens 123-45-6789</td>
<td>1</td>
<td>3</td>
<td>Records matched in the profile: first name, last name, SSN.</td>
</tr>
<tr>
<td></td>
<td>2 (default)</td>
<td>1</td>
<td>Number of unique token sets matched.</td>
</tr>
<tr>
<td>Kathy Stevens 123-45-6789</td>
<td>1</td>
<td>3</td>
<td>Records matched in the profile (up to the required number of matches [3]).</td>
</tr>
<tr>
<td>1111-1111-1111-1111</td>
<td></td>
<td></td>
<td>EDM matches the left-most tokens for each profile data row. Thus, the token set for each row is as follows:</td>
</tr>
<tr>
<td>Kathy Stevens 123-45-6789</td>
<td>2</td>
<td>1</td>
<td>Row # 1: Kathy Stevens 123-45-6789</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Row # 2: Kathy Stevens 123-45-6789</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Row # 3: Kathy Stevens 123-45-6789</td>
</tr>
<tr>
<td>1111-1111-1111-1111 Kathy Stevens 123-45-6789</td>
<td>2</td>
<td>2</td>
<td>The token set for each row is as follows:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Row # 1: 1111-1111-1111-1111 Kathy Stevens</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Row # 2: Kathy Stevens 123-45-6789</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Row # 3: Kathy Stevens 123-45-6789</td>
</tr>
</tbody>
</table>

Proximity matching example

EDM protects confidential data by correlating uniquely identifiable information, such as SSN, with data that is not unique, such as last name. When correlating data, it is important to ensure that terms are related. In natural languages, it is more likely that when two words appear close together they are being used in the same context and are therefore related.

Based on the premise that word proximity indicates relatedness, EDM employs a proximity-matching radius or range to limit how much freeform content the system
will examine when searching for matches. EDM proximity matching is designed to reduce false positives by ensuring that matched terms are proximate.

The proximity range is proportional to the policy definition. The proximity range is determined by the proximity radius multiplied by the number of matches required by the EDM policy condition. The radius is set by the Advanced Server Setting parameter `EDM.SimpleTextProximityRadius`. The default value is 35. In addition, proximity matching applies to both free-form text and tabular data. There is no distinction at run-time between the two. Thus, tabular data is treated the same as free text data and the proximity check is performed beyond the scope of the length of the row contents.

For example, assuming the default radius of 35 and a policy set to match 3 out of 4 column fields, the proximity range is 105 tokens (3 x 35). If the policy matches 2 out of 3 the proximity range is 70 tokens (35 x 2).

**Warning:** While you can decrease the value of the proximity radius, Symantec does not recommend increasing this value beyond the default (35). Doing so may cause performance issues. See “Configuring Advanced Server Settings for EDM policies” on page 400.

Table 19-26 shows a proximity matching example based on the default proximity radius setting. In this example, the detected content produces 1 unique token set match, described as follows:

- The proximity range window is 105 tokens (35 x 3).
- The proximity range window starts at the leftmost match (“Stevens”) and ends at the rightmost match (“123-45-6789”).
- The total number of tokens from “Stevens” to the SSN (including both) is 105 tokens.
- The stopwords "other" and "a" are counted for proximity range purposes.
- "Bank of America" is a multi-token. Each sub-token part of a multi-token is counted as a single token for proximity purposes.
### Table 19-26: Proximity example

<table>
<thead>
<tr>
<th>Indexed data</th>
<th>Policy</th>
<th>Proximity</th>
<th>Detected content</th>
</tr>
</thead>
</table>
| Stevens | Bank of America | 123-45-6789                           |                                                                                   |}

### Updating EDM indexes to version 12.5

If you are upgrading to Symantec Data Loss Prevention 12.5 and want to take advantage of new features, including multi-token cell matching and proportional proximity matching, you must update each **Exact Data** profile by reindexing the data source using the 12.5 EDM Indexer. While legacy EDM indexes will run on 12.5 detection servers, you will not be able to use a legacy EDM index with the new features. In addition, you need to verify the amount of memory required for indexing the data source, and loading and processing the index at run-time on the detection server.

See “About upgrading EDM deployments” on page 377.

See "Memory requirements for EDM" on page 421.

If you do not reindex the data source file, the system presents error messages indicating that the **Exact Data** profile is out of date and must be reindexed, and that you need to calculate memory requirements.

See “EDM index out of date error codes” on page 420.

There are two primary 12.5 upgrade scenarios for EDM:

- You use the Remote EDM Indexer to create 12.5-compliant indexes remotely and copy them to the Enforce Server. See “Update process using the Remote EDM Indexer” on page 417.
You already have a data source file that is current and cleansed that you can copy to the upgraded 12.5 Enforce Server for indexing. See “Update process using the Enforce Server” on page 419.

Update process using the Remote EDM Indexer

Consider the following procedure for upgrading your EDM deployments to Symantec Data Loss Prevention 12.5. This procedure assumes that you can remotely index the data source and copy the index file to the Enforce Server.

See “Remote EDM indexing” on page 432.

If remote indexing is not possible, the other option for upgrade is to copy the data source file to the 12.5 Enforce Server. See “Update process using the Enforce Server” on page 419.

Table 19-27  Update process using the Remote EDM Indexer

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Upgrade the Enforce Server to 12.5.</td>
<td>Refer to the Symantec Data Loss Prevention 12.5 Upgrade Guide for details. Do not upgrade the EDM detection server(s) at this point. The 12.5 Enforce Server can continue to receive incidents from non-12.5 detection servers during the upgrade process. Policies and other data cannot be pushed out to non-12.5 detection servers (one-way communication only between Enforce 12.5 and non-12.5 detection servers).</td>
</tr>
<tr>
<td>2</td>
<td>Create a 12.5-compatible remote EDM profile template.</td>
<td>Using the 12.5 Enforce Server administration console, create a new EDM profile template for remote EDM indexing. See “Creating an EDM profile template for remote indexing” on page 436. Download the *.edm profile template and copy it to the remote data source host system. See “Downloading and copying the EDM profile file to a remote system” on page 439.</td>
</tr>
<tr>
<td>3</td>
<td>Install the 12.5 Remote EDM Indexer on the remote data source host.</td>
<td>Install the Symantec Data Loss Prevention 12.5 Remote EDM Indexer on the remote data source host and index the data source. See “Remote EDM indexing” on page 432.</td>
</tr>
<tr>
<td>4</td>
<td>Calculate the memory required to index the data source and adjust the indexer memory setting.</td>
<td>Calculate the memory required for indexing before you attempt to index the data source. Although the Remote EDM Indexer is allocated sufficient memory to index most data sources, if you have a very large index you may have to allocate more memory. See “Memory requirements for EDM” on page 421.</td>
</tr>
</tbody>
</table>
## Table 19-27  
**Update process using the Remote EDM Indexer (continued)**

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| 4    | Index the data source using the 12.5 Remote EDM Indexer. | The result of this process is 1 or more *_.rdx files that are 12.5 compatible that you can load into a 12.5 Enforce Server system.  
If you have a data source file prepared, run the Remote EDM Indexer and index it.  
See “Remote indexing examples using data source file” on page 440.  
If the data source is an Oracle database and the data is clean, use the SQL Preindexer to pipe the data to the Remote EDM Indexer.  
See “Remote indexing examples using SQL Preindexer” on page 441. |
| 5    | Calculate the memory required to load and process the index and adjust the detection server memory setting for each EDM detection server host. | You need to calculate how much RAM the detection server requires to load and process the index and run-time. These calculations are required for each EDM index you want to deploy and the memory adjustments are cumulative.  
See “Memory requirements for EDM” on page 421. |
| 6    | Update the EDM profile by loading the 12.5 index. | Copy the *_.pdx and one or more *_.rdx files from the remote host to the 12.5 Enforce Server host file system.  
Load the index into the EDM profile you created in Step 2.  
See “Copying and loading remote index files to the Enforce Server” on page 442. |
| 7    | Upgrade one or more EDM detection server to 12.5. | Once you have created the 12.5 compliant EDM profiles and upgraded the Enforce Server, you can then upgrade the detection server(s).  
Refer to the Symantec Data Loss Prevention 12.5 Upgrade Guide for details.  
Make sure you have calculated and verified the memory requirements for loading and processing multi-token indexes on the detection server.  
See “Memory requirements for EDM” on page 421. |
| 8    | Test and verify the updated index. | Legacy EDM indexes and policies will run on 12.5 detection servers but will not make use of 12.5 features. To test the upgraded system and updated index, you can create a new policy that references the updated index.  
Meanwhile, the legacy index and policy remains deployed and running. |
| 9    | Remove out-of-date EDM indexes. | Once you have verified the new EDM index and policy, you can retire the legacy EDM index and policy. |
Update process using the Enforce Server

Consider the following index update procedure if remote indexing is not possible and you have a current data source file that you can copy to the Enforce Server.

Table 19-28  Update process using the Enforce Server

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Upgrade the Enforce Server to 12.5.</td>
<td>Refer to the Symantec Data Loss Prevention 12.5 Upgrade Guide for details. Do not upgrade the EDM detection server(s) at this point. The 12.5 Enforce Server can continue to receive incidents from non-12.5 detection servers during the upgrade process. Policies and other data cannot be pushed out to non-12.5 detection servers (one-way communication only between Enforce 12.5 and non-12.5 detection servers).</td>
</tr>
<tr>
<td>2</td>
<td>Create, prepare, and copy the data source file to the 12.5 Enforce Server host.</td>
<td>Copy the data source file to the /SymantecDLP/Protect/datafiles directory on the upgraded 12.5 Enforce Server host file system. See “Creating the exact data source file for EDM” on page 379. See “Preparing the exact data source file for indexing” on page 381. See “Uploading exact data source files to the Enforce Server” on page 383.</td>
</tr>
<tr>
<td>3</td>
<td>Calculate memory the memory required to index the data source and update the indexer memory setting.</td>
<td>Calculate the memory required for indexing before you attempt to index the data source. See “Memory requirements for EDM” on page 421.</td>
</tr>
<tr>
<td>4</td>
<td>Create a new 12.5 compliant EDM profile and index the data source file.</td>
<td>Create a new EDM profile using the 12.5 Enforce Server administration console. Choose the option Reference Data Source on Manager Host for uploading the data source file (assuming you copied it to the /datafiles directory). Index the data source file on save of the profile. See “Creating and modifying Exact Data Profiles” on page 385.</td>
</tr>
<tr>
<td>5</td>
<td>Calculate memory the memory required to load and process the index at run-time and adjust the memory settings for each EDM detection server host.</td>
<td>You need to calculate how much RAM the detection server requires to load and process the index and run-time. These calculations are required for each EDM index you want to deploy and the memory adjustments are cumulative. See “Memory requirements for EDM” on page 421.</td>
</tr>
</tbody>
</table>
### Table 19-28  
Update process using the Enforce Server (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| 6    | Upgrade the EDM detection server(s) to 12.5. | Once you have created the 12.5-compliant EDM profile you can then upgrade the detection server(s).  
Refer to the *Symantec Data Loss Prevention 12.5 Upgrade Guide* for details.  
Make sure you have calculated and verified the memory requirements for loading and processing multi-token indexes on the detection server.  
See “Memory requirements for EDM” on page 421. |
| 7    | Test and verify the updated index. | Legacy EDM indexes and policies will run on 12.5 detection servers but will not make use of 12.5 features. To test the upgraded system and updated index, you can create a new policy that references the updated index.  
Meanwhile, the legacy index and policy remains deployed and running. |
| 8    | Remove out-of-date EDM indexes. | Once you have verified the new EDM index and policy, you can retire the legacy EDM index and policy.  
See “Remote EDM indexing” on page 432. |

### EDM index out of date error codes

Symantec Data Loss Prevention version 12.5 provides several enhancements for EDM. To take advantage of these enhancements, you must reindex the data source for each *Exact Data* profile using the 12.5 EDM Indexer. Although legacy EDM indexes will run on 12.5 detection servers, such indexes do support 12.5 features.

If your EDM index is not 12.5-compliant, the system informs you with error messages. *Table 19-29* lists the error codes that the system displays if the EDM index is out of date and not compatible with the current Symantec Data Loss Prevention version.

<table>
<thead>
<tr>
<th>Error message type</th>
<th>Error code</th>
<th>Error message</th>
</tr>
</thead>
</table>
| Enforce Server error event | 2928 | One or more profiles are out of date and must be reindexed. Please refer to the "Memory requirements for EDM" section in the Symantec DLP Administration Guide for additional information.  
See “Updating EDM indexes to version 12.5” on page 416.  
See “Memory requirements for EDM” on page 421. |
| Enforce Server error event detail | 2928 | Check the Manage > Data Profiles > Exact Data page for more details.  
The following EDM profiles are out of date: Profile X, Profile XY, and so forth. |
### Table 19-29

<table>
<thead>
<tr>
<th>Error message type</th>
<th>Error code</th>
<th>Error message</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Event error</td>
<td>2928</td>
<td>One or more profiles are out of date and must be reindexed.</td>
</tr>
<tr>
<td>Exact Data Profile error</td>
<td>N/A</td>
<td>This profile is out of date, and must be reindexed.</td>
</tr>
</tbody>
</table>

---

## Memory requirements for EDM

Symantec Data Loss Prevention version 12.5 supports multi-token matching. Multi-token matching is enabled by default.

See "Using multi-token matching" on page 403.

A multi-token is more computationally expensive than a single-token. If you are using multi-token matching, you need to verify that the amount of memory allocated to the indexer and to the detection server(s) is sufficient for each EDM index. You may need to increase the memory allocated to the indexer and for the detection server(s).

Memory requirements cannot be generalized because each index is unique. Determining the memory requirements for a multi-token index is a three-step process in which you calculate the memory required for indexing, loading, and processing.

---

**Note:** You must perform the memory calculations if you are using multi-token matching. This means that your index contains multi-token cells and multi-token matching is enabled. If your index does not contain multi-token cells, or you have disabled multi-token matching, you only need to perform Step 2 of the memory calculations.

---

*Table 19-30* describes the process for calculating and adjusting the memory requirements for the indexer and the detection server(s) when you are using multi-token matching.
### Table 19-30  Workflow for determining memory requirements for EDM multi-token indexes

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1    | Determine the memory required to index the data source. | This calculation is based on the number of multi-token cells in the index and the memory requirements for multi-tokens.  
See “Determining how much memory is needed to index the data source” on page 424.  
See “Multi-token memory table” on page 423.  
You ADD the result of this calculation to the existing RAM allocated to the indexer. Restart the Vontu Manager service after updating the memory setting.  
See “Increasing the memory for the Enforce Server EDM indexer” on page 429.  
**Note:** If you are using the Remote EDM indexer, you do not have to allocate more RAM for indexing unless the index has an extremely large number of multi-token cells. See “Increasing the memory for the Remote EDM indexer” on page 429. |
| 2    | Determine the memory required to load the index into memory on the detection server. | This calculation is roughly 2 GB x the number of *.rdx files comprising the index, if 2 or more. If the index comprises 1 *.rdx file, the file size on disc is the factor.  
You use the result of this calculation establish the minimum amount of memory needed to load the index into RAM on the detection server host.  
See “Determining how much memory is needed to load the index into memory on the detection server” on page 426.  
**Note:** This step is required even if the index is not a multi-token index. |
Workflow for determining memory requirements for EDM multi-token indexes (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| 3    | Determine additional memory required to process the index during detection. | To get this calculation you double the result of the first calculation you made in Step 1 and add this sum to the memory load calculation. Update the File Reader memory setting with the result and restart the detection server.  
See “Determining and setting the memory for the detection server” on page 427.  
See “Increasing the memory for the detection server (File Reader)” on page 430.  
**Note:** The detection server memory requirements are cumulative for each EDM index. In other words, for each index you determine the amount of memory required to load and process it, and **ADD** this amount to the existing amount of RAM that is allocated to that server. |
| 4    | Repeat for each EDM index you want to deploy. | The three-step calculation process is required for each multi-token index you plan to deploy. Keep in mind that you only adjust the detection server memory settings for the server where the index will be loaded and processed at run-time.  
See “Additional example memory requirement calculations” on page 431. |

Multi-token memory table

Table 19-31 lists and describes the amount of additional memory (in bytes) that are required for multi-token indexes. You use these numbers to calculate memory requirements for EDM indexing and processing.

Note that the first 16 million multi-token cells require 32 bytes per cell while additional multi-token cells require 8 bytes per cell. Note also that the memory requirements for loading and processing are double the requirements for indexing.

<table>
<thead>
<tr>
<th>Number of multi-token cells</th>
<th>Indexer memory requirements</th>
<th>Detection server memory requirements to load and process the index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up to 16 million</td>
<td>32 bytes per multi-token cell</td>
<td>64 bytes per multi-token cell</td>
</tr>
<tr>
<td>Above 16 million</td>
<td>8 bytes per multi-token cell</td>
<td>16 bytes per multi-token cell</td>
</tr>
</tbody>
</table>
EDM index size table

Table 19-32 provides the default size thresholds for small, medium, and large indexes. If you have a small or medium size index, the index comprises a single *.rdx file. If you have a large EDM index, the index spans multiple *.rdx files.

<table>
<thead>
<tr>
<th>Size of index on disk</th>
<th>Identifier</th>
<th># of RDX files</th>
<th>Description</th>
</tr>
</thead>
</table>
| 100 MB or less         | Small      | 1              | Indexing is performed in process.  
ProfileIndex.MaximumInProcessIndexSize = 100 MB (default) |
| More than 100 MB       | Medium     | 1              | Indexing is performed out of process.  
ProfileIndex.MaximumInProcessIndexSize = 100 MB (default) |
| 1.3 GB or more         | Large      | 2 or more      | Index spans multiple *.rdx files.  
max_loaded_index_memory = 1378 MB (default) |

Determining how much memory is needed to index the data source

Table 19-33 provides the steps for determining how much memory is needed to index the data source.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1    | Estimate the number of multi-tokens in the index. | Multiply the total number of rows or records in the data source by the number of multi-token columns.  
For example, if your index has 100 million rows and 3 of the 5 columns in the index contain multi-token values, the estimated number of multi-token cells is 300 million. |
<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Perform the calculation.</td>
<td>Refer to the memory table to perform the following calculation. See Table 19-31 on page 423. First you determine the amount of additional memory needed for the first 16 million multi-tokens. For example, if your index has an estimated 300 million multi-token cells, the additional memory required to index the first 16 million rows in the data source is calculated as follows: 16 million multi-token cells * 32 bytes = 512 million bytes of additional memory. Next you determine the additional memory required for the remaining multi-token cells. For example: 284 million multi-token cells * 8 bytes = 2.272 million bytes of additional memory. Finally, to get the total additional RAM required to index the data source you add the results: 512 million bytes + 2.272 million bytes = 2.784 million bytes = 2.6 GB (rounded).</td>
</tr>
<tr>
<td>3</td>
<td>Increase the indexer memory.</td>
<td>The next step is to increase the memory allocated to the indexer. The procedure for increasing the indexer memory differs depending on whether you are using the EDM indexer local to the Enforce Server or the Remote EDM Indexer. <strong>Note:</strong> Whichever indexer you use, make sure you ADD the calculation to the existing or default memory allocation and that you do not replace the existing or default setting with the calculation. See “Increasing the memory for the Enforce Server EDM indexer” on page 429. See “Increasing the memory for the Remote EDM indexer” on page 429.</td>
</tr>
<tr>
<td>4</td>
<td>Restart the Vontu Manager service.</td>
<td>You must restart this service after you have changed the memory allocation.</td>
</tr>
<tr>
<td>5</td>
<td>Index the data source.</td>
<td>The last step is to index the data source. You need to do this before you calculate remaining memory requirements. See “Creating and modifying Exact Data Profiles” on page 385.</td>
</tr>
</tbody>
</table>
Determining how much memory is needed to load the index into memory on the detection server

The next step in the workflow is to determine the amount of memory required to load the index into memory on the detection server. This calculation depends on the size of the index on disc.

Table 19-34 provides the steps for performing the calculation to determine the baseline memory that you must allocate to the detection server to load the index into RAM.

Table 19-34 Determine memory requirements for indexing

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Count the number of indexes deployed to a detection server.</td>
<td>If you have a small or medium size index, you will have only one *.rdx file. If you have a large index, you will have multiple *.rdx files. See &quot;Multi-token memory table&quot; on page 423.</td>
</tr>
</tbody>
</table>
Table 19-34  Determine memory requirements for indexing (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| 2    | Perform the calculation. | If the index comprises only 1 file (small or medium index), get the size of the index on disc. For example, if the size of the index on disc is 500MB, this is the baseline amount of memory you need to load the index. You then proceed to the next step to determine additional memory to process the index.  
See “Determining and setting the memory for the detection server” on page 427.  
If the index is large and comprises multiple *.rdx files, you add the number of *.rdx files comprising the index and multiply that number by 1.9 GB.  
For example, if the index comprises 3 *.rdx files, the calculation is 3 * 1.9 = 5.7 GB. This is the baseline amount of memory you need to load the index into RAM on the detection server.  
The 1.9 GB factor is derived from the following two settings and their default values:
  Indexer.properties: max_loaded_index_memory = 1378M (1.3 GB rounded)  
  Advanced Server Setting:  
  ProfileIndex.MinimumMemoryReserve 600M (600 MB)  
If you have changed either of these settings you will need to adjust the factor accordingly. For example, if for performance reasons you change the value of the ProfileIndex.MinimumMemoryReserve parameter from 600M to 1000M (1 GB), the factor is 2.3 GB.  
See “Configuring Advanced Server Settings for EDM policies” on page 400. |
| 3    | Perform another calculation to determine additional memory. | See “Determining and setting the memory for the detection server” on page 427. |

Determining and setting the memory for the detection server

The last step in the workflow is to determine the amount of memory required to process the index at run-time. The easiest way to perform this calculation is simply to double the calculation you performed to determine how much memory is required to index the data source. You add the result to the amount of memory required to load the index. You then use this figure to adjust the memory for the File Reader on the detection server.
Table 19-35 describes the process for calculating the additional memory required on the detection server to process the index.

**Table 19-35** Determine memory requirements for indexing

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1    | Count the number of multi-token cells in the index. | Multiply the total number of rows or records in the data source by the number of multi-token columns.  
For example, if your index has 100 million rows and 3 of the 5 columns in the index contain multi-token values, the estimated number of multi-token cells is 300 million. |
| 2    | Perform the calculation. | Use the memory table to perform the calculation.  
See Table 19-31 on page 423.  
For example, if your index has an estimated 300 million multi-token cells, the additional memory required to index the data source is calculated as follows:  
16 million multi-token cells * 64 bytes = 1.024 million bytes of additional memory  
Next you determine the additional memory required for the remaining multi-token cells.  
284 million multi-token cells * 16 bytes = 4.544 million bytes of additional memory  
To get the total additional RAM required to index the data source you add the results:  
1.024 million bytes + 4.544 million bytes = 5.568 million bytes = 5.2 GB (rounded) |
| 3    | Add the amounts. | Add the amount you calculated above to the amount you calculated for the initial loading of the index.  
See "Determining how much memory is needed to load the index into memory on the detection server" on page 426.  
For example, if the index comprises 3 *.rdx files:  
1.9 GB * 3 = 5.7 GB + 5.2 GB = 10.9 GB required to load the index and run the index on the detection server.  
Or, if the index comprises 1 *.rdx file with a size of 100 MB:  
100 MB + 5.2 GB = 5.3 GB required to load and process the index at run-time. |
| 4    | Increase the File Reader memory. | See "Increasing the memory for the detection server (File Reader)" on page 430. |
Increasing the memory for the Enforce Server EDM indexer

Complete the following steps to increase the memory for the Enforce Server indexer. These steps assume you have performed the indexer calculations.

**To increase the memory for the Enforce Server indexer**

1. Open the file \SymantecDLP\protect\config\VontuManager.conf
2. Locate the following "Initial Java Heap Size (in MB)" parameter
   
   `wrapper.java.maxmemory = 2048` (the default value is 2048 MB (2 GB); your value may be different if you changed it)
3. ADD the value of your calculation to the `maxmemory` setting.
   
   For example, if by your calculation you determine that you need an additional 2.6 GB of RAM, you would increase the value by an additional 2662 MB

   __Note: This result is ADDED to the existing memory setting; it is not used to replace the existing memory setting.__

   `wrapper.java.maxmemory = 4710` (the default value 2048 plus the additional calculation of 2662)
4. Save the `VontuManager.conf` file.
5. Restart the Vontu Manager service.

Increasing the memory for the Remote EDM indexer

The Remote EDM Indexer runs with the default JMV settings. This means that the Remote EDM Indexer is allocated approximately 25% of the total RAM that the computer has installed. (Consult the JVM documentation for precise details.)

For most data sources, the default memory settings are sufficient for remote indexing. However, if you have a very large multi-token index, you may need to increase the amount of RAM allocated to the Remote EDM Indexer. In Symantec Data Loss Prevention testing, multi-token indexes over 20 GB in size required additional memory allocated for the Remote EDM Indexer. However, smaller indexes may require additional memory for remote indexing depending on the nature of the index or the size of the host hardware.

You set the JVM heap size for the Remote EDM Indexer process by creating a `*.vmoptions` file and deploying it to the Remote EDM Indexer host.

The `*.vmoptions` file accepts one JVM option per line. For example, you can specify the following options in a file you save as `RemoteEDMIndexer.vmoptions`:
In this example, the initial memory allocation size (-Xms1378M) is the same amount that is allocated to the indexer that is local to the Enforce Server. See the wrapper.java.initmemory parameter in the VontuManager.conf file. The maximum size (-Xmx11G) is based on your multi-token calculations.

See “Determining how much memory is needed to index the data source” on page 424.

To deploy the *.vmoptions file, copy it to the following locations:

For Linux: /opt/SymantecDLP/Protect/bin/RemoteEDMIndexer.vmoptions
For Windows: \SymantecDLP\Protect\bin\RemoteEDMIndexer.exe.vmoptions

See “Generating remote index files” on page 439.

Increasing the memory for the detection server (File Reader)

This topic provides instructions for increasing the File Reader memory allocation for a detection server.

These instructions assume you have performed the necessary calculations.

See “Determining how much memory is needed to load the index into memory on the detection server” on page 426.

See “Determining and setting the memory for the detection server” on page 427.

To increase the memory for detection server processing

1. In the Enforce Server administration console, navigate to the Server Detail - Advanced Server Settings screen for the detection server where the EDM index is deployed or to be deployed.

2. Locate the following setting: BoxMonitor.FileReaderMemory.

3. Change the -Xmx4G value in the following string to match the calculations you have made.

   -Xrs -Xms1200M -Xmx4G -XX:PermSize=128M -XX:MaxPermSize=256M

   For example: -Xrs -Xms1200M -Xmx11G -XX:PermSize=128M -XX:MaxPermSize=256M

4. Save the configuration and recycle the detection server.
Additional example memory requirement calculations

This section provides additional examples of EDM memory calculations for multi-token and single-token indexes. If you have enough memory to forgo precise calculations or need a quick estimate, you can perform these short-cut example calculations.

Table 19-36 provides an example calculation if the index contains multi-token cells and it comprises 2 or more *.rdx files. In this case you multiply the number of *.rdx files by 2 GB to get the amount of memory required to load the index.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Perform the indexing calculation as described and index the data source.</td>
<td>If the data source has approximately 300 million multi-token cells: 16 million * 32 bytes + 284 million * 8 bytes = 2.6 GB required to index the data source. You then add 2.6 GB to the existing amount of RAM allocated to the indexer process.</td>
</tr>
<tr>
<td>2</td>
<td>Perform the load calculation by multiplying the number of *.rdx files by 2 GB (rounding up 1.9 to 2).</td>
<td>If the index comprises 3 files, then: 3 *.rdx files * 2 GB each = 6 GB required to load the index on the detection server.</td>
</tr>
<tr>
<td>3</td>
<td>Perform the run-time processing calculation by doubling the result of the index calculation (Step 1) and adding it to the result of the load calculation (Step 2).</td>
<td>2.6 GB * 2 = 5.2 GB + 6 GB = 11.2 GB This is the total memory required for the detection server to load and process THIS index.</td>
</tr>
</tbody>
</table>

Table 19-37 provides an example calculation if the index only comprises 1 *.rdx file. In this case you use the size of the file on disk to get the amount of memory required to load the index.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Perform the indexing calculation as described and index the data source.</td>
<td>Multiply the first 16 million multi-token cells in the index by 32 bytes. Multiple the remaining multi-token cells in the index by 8 bytes. Add the results.</td>
</tr>
</tbody>
</table>
Table 19-37 Example memory calculation for a multi-token index comprising a single *.rdx file (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Perform the load calculation by checking the size of the *.rdx file on disk.</td>
<td>If the size of the *.rdx file on disk is 500 MB, then this is the amount of RAM required by the detection server to load the index.</td>
</tr>
</tbody>
</table>
| 3    | Perform the run-time processing calculation by doubling the result of the index calculation (Step 1) and adding it to the result of the load calculation (Step 2). | If the amount of memory required to index the data source is 1.25 GB, then:  
\[ 1.25 \text{ GB} \times 2 + 500 \text{ MB} = 3 \text{ GB} \]  
This the total memory required for the detection server to load and process the index. |

Table 19-38 provides an example calculation if the index does not include multi-tokens. In this case you only need to determine how much memory is required to load the index.

Table 19-38 Example memory calculation for a single-token index

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Example</th>
</tr>
</thead>
</table>
| 1    | Multiply the number of *.rdx files by 2 GB (rounding up 1.9 to 2).     | If the index comprises 3 files, then:  
\[ 3 \times .rdx \text{ files} \times 2 \text{ GB each} = 6 \text{ GB} \] required to load the index on the detection server. |

Remote EDM indexing

An EDM index maps the data you want to protect to the Exact Data profile. The typical EDM workflow for creating the EDM index is to upload the data source file to the Enforce Server, create the Exact Data profile, and index the data source. Instead of uploading the data source file to the Enforce Server for indexing, you can index the data source locally and securely using the Remote EDM Indexer.

See “About the Exact Data Profile and index” on page 371.

For example, if copying the confidential data source file to the Enforce Server presents a potential security or logistical issue, you can use the Remote EDM Indexer to create the cryptographic index directly on the data source host before moving the index to the Enforce Server. If you are upgrading to the latest Symantec Data Loss Prevention version you may want to use the Remote EDM Indexer to update your existing EDM indexes.

See “About the Remote EDM Indexer” on page 433.
See “About the SQL Preindexer” on page 433.

The Remote EDM Indexer is a standalone tool that lets you index the data source file directly on the data source host.

See “System requirements for remote EDM indexing” on page 434.

About the Remote EDM Indexer

The Remote EDM Indexer utility converts a data source file to an EDM index. The utility is similar to the local EDM Indexer used by the Enforce Server. However, the Remote EDM Indexer is designed for use on a computer that is not part of the Symantec Data Loss Prevention server configuration.

Using the Remote EDM Indexer to index a data source on a remote machine has the following advantages over using the EDM Indexer on the Enforce Server:

■ It enables the owner of the data, rather than the Symantec Data Loss Prevention administrator, to index the data.
■ It shifts the system load that is required for indexing onto another computer. The CPU and RAM on the Enforce Server is reserved for other tasks.

See “About the SQL Preindexer” on page 433.
See “Workflow for remote EDM indexing” on page 434.

About the SQL Preindexer

You use the SQL Preindexer utility with the Remote EDM Indexer to run SQL queries against Oracle databases and pipe the resulting data to the Remote EDM Indexer for indexing.

See “System requirements for remote EDM indexing” on page 434.

The SQL Preindexer utility is installed in the \SymantecDLP\Protect\bin directory during installation of the Remote EDM Indexer. The SQL Preindexer utility generates an index directly from an Oracle SQL database. The SQL Preindexer processes the database query and passes it to the standard input of the Remote EDM Indexer utility.

To use the SQL Preindexer the data source must be relatively clean since the query result data is piped directly to the Remote EDM Indexer.

See “About the Remote EDM Indexer” on page 433.
System requirements for remote EDM indexing

The Remote EDM Indexer runs on the Windows and Linux operating system versions that are supported for Symantec Data Loss Prevention servers. See the Symantec Data Loss Prevention System Requirements and Compatibility Guide for more information about operating system support.

The SQL Preindexer supports Oracle databases and requires a relatively clean data source.

See “About the SQL Preindexer” on page 433.

The RAM requirements for using the Remote EDM Indexer vary according to the size of the data source being indexed and the number of multi-token columns in the data source.

See “Memory requirements for EDM” on page 421.

Workflow for remote EDM indexing

This section summarizes the steps to index a data file on a remote machine and then use the index in Symantec Data Loss Prevention.

See “About the Exact Data Profile and index” on page 371.

<table>
<thead>
<tr>
<th>Table 19-39</th>
<th>Steps to use the Remote EDM Indexer</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step</strong></td>
<td><strong>Action</strong></td>
</tr>
<tr>
<td>Step 1</td>
<td>Install the Remote EDM Indexer on a computer that is not part of the Symantec Data Loss Prevention system.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Create an Exact Data Profile on the Enforce Server to use with the Remote EDM Indexer.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Copy the Exact Data Profile file to the computer where the Remote EDM Indexer resides.</td>
</tr>
</tbody>
</table>
Table 19-39  Steps to use the Remote EDM Indexer (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 4</td>
<td>Run the Remote EDM Indexer and create the index files.</td>
<td>If you have a cleansed data source file, use the RemoteEDMIndexer with the -data, -profile and -result options. If the data source is an Oracle database, use the SqlPreindexer and the RemoteEDMIndexer to index the data source directly with the -alias (oracle DB host), -username and -password credentials, and the -query string or -query_path. See “Generating remote index files” on page 439.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Copy the index files from the remote machine to the Enforce Server.</td>
<td>Copy the resulting *.pdx and *.rdx files from the remote machine to the Enforce Server host at C:\SymantecDLP\Protect\index. See “Copying and loading remote index files to the Enforce Server” on page 442.</td>
</tr>
<tr>
<td>Step 6</td>
<td>Load the index files into the Enforce Server.</td>
<td>Update the EDM profile by loading the externally generated index. Submit the profile for indexing. See “Copying and loading remote index files to the Enforce Server” on page 442.</td>
</tr>
<tr>
<td>Step 7</td>
<td>Troubleshoot any problems that occur during the indexing process.</td>
<td>Verify that indexing is started and completes. Check the system events for Code 2926 (&quot;Created Exact Data Profile&quot; and &quot;Data source saved&quot;). The ExternalDataSource.&lt;name&gt;.rdx and *.pdx files are removed from the index directory and replaced by the file DataSource.51.1.rdx. See “Troubleshooting remote indexing errors” on page 447.</td>
</tr>
<tr>
<td>Step 8</td>
<td>Create policy with EDM condition.</td>
<td>You should see the column data for defining the EDM condition. See “Configuring the Content Matches Exact Data policy condition” on page 396.</td>
</tr>
</tbody>
</table>

About installing and running the Remote EDM Indexer and SQL Preindexer utilities

The Remote EDM Indexer is installed from the same installation program as the other Symantec Data Loss Prevention components. The SQL Preindexer is installed automatically when you install the Remote EDM Indexer. Both utilities are run from the command line and are stored at /SymantecDLP/Protect/bin.

See “Generating remote index files” on page 439.

To install the Remote EDM Indexer, copy the ProtectInstaller.exe (Windows) or the ProtectInstaller.sh (Linux) file to the remote computer where the data to be indexed resides. When running the installer, choose to install the "Indexer"
only and no other components. The Linux installer for the Remote EDM Indexer is a program that you run from the command console.

See “Installing the Remote EDM Indexer (Windows)” on page 448.

See “Installing the Remote EDM Indexer (Linux)” on page 449.

Both the Remote EDM Indexer and the SQL Preindexer run from the command line. If you are on a Linux system, change users to the “protect” user before running the SQL Preindexer. (The installation program creates the “protect” user.)

See “Generating remote index files” on page 439.

---

**Note:** For two- and three-tier Data Loss Prevention installations, you should not install the Remote EDM Indexer on the same system that hosts a detection server. Refer to the *Symantec Data Loss Prevention Installation Guide* for more information.

---

### Creating an EDM profile template for remote indexing

The EDM Indexer uses an Exact Data Profile when it runs to ensure that the data is correctly formatted. You must create the Exact Data Profile before you use the Remote EDM Indexer. The profile is a template that describes the columns that are used to organize the data. The profile does not need to contain any data. After creating the profile, copy it to the computer that runs the Remote EDM Indexer.

See “About the Exact Data Profile and index” on page 371.

To create an EDM profile for remote indexing

1. From the Enforce Server administration console, navigate to the **Manage > Data Profiles > Exact Data** screen.

2. Click **Add Exact Data Profile**.

3. In the **Name** field, enter a name for the profile.
4 In the **DataSource** field, select **Use This File Name**, and enter the name of the index file to create with the `*.edm` extension.

You must select this option since you are only creating the profile template at this point. Later you will then index the profile with data source using the Remote EDM Indexer. Enter the file name of the data source you plan to create for remote EDM indexing. Be sure to name the data source file exactly the same as the name you enter here.

See “Uploading exact data source files to the Enforce Server” on page 383.

Once you have copied the generated remote index back to the Enforce Server, you use the **LoadExternallyGeneratedIndex** option to load the remote index into the profile template.

See “Copying and loading remote index files to the Enforce Server” on page 442.

5 In the **Number of Columns** text box, specify the number of columns in the data source to be indexed.

For remote EDM indexing purposes you must specify the exact **Number of Columns** the index is to have. Be sure to include the exact number of columns you specify here in the data source file.

See “Uploading exact data source files to the Enforce Server” on page 383.

6 If the first row of the data source contains the column names, select the option **Read first row as column names**.

7 In the **Error Threshold** text box, enter the maximum percentage of rows that can contain errors.

If, during indexing of the data source, the number of rows with errors exceeds the percentage that you specify here, the indexing operation fails.

8 In the **ColumnSeparatorChar** field, select the type of character that is used in your data source to separate the columns of data.

9 In the **FileEncoding** field, select the character encoding that is used in your data source.

If Latin characters are used, select the ISO-8859-1 option. For East Asian languages, use either the UTF-8 or UTF-16 options.

10 Click **Next** to map the column headings from the data source to the profile.
In the Field Mappings section, map the Data Source Field to the System Field for each column by selecting the column name from the System Field drop-down list.

The Data Source Field lists the number of columns you specified at the previous screen. The System Field contains a list of standard column headings. If any of the column headings in your data source match the choices available in the System Field list, map each accordingly. Be sure that you match the selection in the System Field column to its corresponding numbered column in the Data Source Field.

For example, for a data source that you have specified in the profile as having three columns, the mapping configuration may be:

<table>
<thead>
<tr>
<th>Data Source Field</th>
<th>System Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Col 1</td>
<td>First Name</td>
</tr>
<tr>
<td>Col 2</td>
<td>Last Name</td>
</tr>
<tr>
<td>Col 3</td>
<td>Social Security Number</td>
</tr>
</tbody>
</table>

If a Data Source Field does not map to a heading value in the options available from the System Field column, click the Advanced View link.

In the Advanced View the system displays a Custom Name column beside the System Field column.

Enter the correct column name in the text box that corresponds to the appropriate column in the data source.

Optionally, you can specify the data type for the Custom Name you entered by selecting the data type from the Type drop-down list. These data types are system-defined. Click the description link beside the Type name for details on each system-defined data type.

If you intend to use the Exact Data Profile to implement a policy template that contains one or more EDM rules, you can validate your profile mappings for the template. To do this, select the template from the Check mappings against policy template drop-down list and click Check now. The system indicates any unmapped fields that the template requires.

Do not select any Indexing option available at this screen, since you intend to index remotely.

Click Finish to complete the profile creation process.
Downloading and copying the EDM profile file to a remote system

1. Configure an Exact Data Profile.
   
   See “Creating an EDM profile template for remote indexing” on page 436.

2. Download the EDM profile by selecting the download profile link at the Manage > Data Profiles > Exact Data screen.

   The system prompts you to save the EDM profile as a file. The file extension is *.edm.

3. Save the file.

   If the data source host computer where you intend to run the Remote EDM Indexer is available on the same subnet as the Enforce Server you can browse to that computer and select it as the destination. Otherwise, manually copy the profile to the remote system.

4. Use the profile to index the data source using the Remote EDM Indexer.

   See “Generating remote index files” on page 439.

Generating remote index files

You use the command-line Remote EDM Indexer utility to generate an EDM index for importing to the Enforce Server. You can use the Remote EDM Indexer to index data source file that you have generated and cleansed. Or you can pipe the output from the SQL Preindexer to the standard input of the Remote EDM Indexer. The SQL Preindexer requires an Oracle DB data source and clean data.

When the indexing process completes, the Remote EDM Indexer generates several files in the specified result directory. These files are named after the data file that was indexed, with one file having the .pdx extension and another file with the .rdx extension. Note that indexing a large data file may generate multiple .rdx files with numbered extensions. For example: my_edm.rdx.1, my_edm.rdx.2 and so forth.

<table>
<thead>
<tr>
<th>Use case</th>
<th>Description</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote EDM Indexer with data source file.</td>
<td>Specify data source file, EDM profile, output directory.</td>
<td>Use when you have a cleansed data source file; use for upgrading to DLP 12.5. See “Remote indexing examples using data source file” on page 440.</td>
</tr>
</tbody>
</table>
Remote indexing examples using data source file

To use the Remote EDM Indexer to index a flat data source file you have generated and cleansed, you specify the local data source file name and path (-data), the local EDM profile file name and path (-profile), and the output directory for the generated index files (-result).

The syntax for using the Remote EDM Indexer to generate an index from a cleansed data source flat file is as follows:

```
RemoteEDMIndexer -data=<local data source filename and path>
-profile=<local *.edm profile file name and path>
-result=<local output directory for *.rdx and *pdx index files>
```

For example:

```
RemoteEDMIndexer -data=C:\EDMIndexDirectory\CustomerData.dat
-profile=C:\EDMIndexDirectory\RemoteEDMProfile.edm
-result=C:\EDMIndexDirectory\n```

This command generates an EDM index using the local data source flat file `CustomerData.dat` and the local `RemoteEDMProfile.edm` file that you generated and copied from the Enforce Server to the remote host, where `\EDMIndexDirectory` is the directory for placing the generated index files.

When the generation of the indexes is successful, the utility displays the message "Successfully created index" as the last line of output.

In addition, the following index files are created and placed in the -result directory:

- `ExternalDataSource.CustomerData.pdx`
- `ExternalDataSource.CustomerData.rdx`

If the index is large there may be more than one *.rdx file. You copy these files to the Enforce Server and update the EDM profile using the remote index.

See “Remote EDM Indexer command options” on page 445.
Remote indexing examples using SQL Preindexer

If your data source is an Oracle DB and has clean data you can index the data source directly using the SQL Preindexer with the Remote EDM Indexer.

The syntax is as follows:

```
SqlPreindexer -alias=<oracle connect string: //host:port/SID>
-username=<DB user> -password=<DB password> -query=<sql to run> |
RemoteEDMIndexer -profile=<*.edm profile file name and path>
-result=<output directory for index files>
```

For example:

```
SqlPreindexer -alias=@//myhost:1521/orcl -username=scott -password=tiger
-query="SELECT name, salary FROM employee" |
RemoteEDMIndexer -profile=C:\ExportEDMProfile.edm -result=C:\EDMIndexDirectory\
```

With this command the SQL Preindexer utility connects to the Oracle database and runs the SQL query to retrieve name and salary data from the employee table. The SQL Preindexer returns the result of the query to stdout (the command console). The SQL query must be in quotes. The Remote EDM Indexer command runs the utility and reads the query result from the stdin console. The Remote EDM Indexer indexes the data using the `ExportEDMProfile.edm` profile as specified by the profile file name and local file path.

When the generation of the indexes is successful, the utility displays the message "Successfully created index" as the last line of output.

In addition, the utility places the following generated index files in the `EDMIndexDirectory` -result directory:

- `ExternalDataSource.CustomerData.pdx`
- `ExternalDataSource.CustomerData.rdx`

Here is another example using SQL Preindexer and Remote EDM Indexer commands:

```
SqlPreindexer -alias=@//localhost:1521/CUST -username=cust_user -password=cust_pword
-query="SELECT account_id, amount_owed, available_credit FROM customer_account" -verbose |
RemoteEDMIndexer -profile=C:\EDMIndexDirectory\CustomerData.edm -result=C:\EDMIndexDirectory\ -verbose
```

Here the SQL Preindexer command queries the CUST.customer_account table in the database for the account_id, amount_owed, and available_credit records. The result is piped to the Remote EDM Indexer which generates the index files based on the CustomerData.edm profile. The -verbose option is used for troubleshooting.
As an alternative to the -query SQL string you can use the -query_path option and specify the file path and name for the SQL query (*.sql). If you do not specify a query or query path the entire DB is queried.

```
SqlPreindexer -alias=@//localhost:1521/cust -username=cust_user -password=cust_pwrd -query_path=C:\EDMIndexDirectory\QueryCust.sql -verbose |
RemoteEDMIndexer -profile=C:\EDMIndexDirectory\CustomerData.edm -result=C:\EDMIndexDirectory\ -verbose
```

See “SQL Preindexer command options” on page 443.

**Copying and loading remote index files to the Enforce Server**

The following files are created in the -result directory when you remotely index a data source:

- ExternalDataSource.<DataSourceName>.pdx
- ExternalDataSource.<DataSourceName>.rdx (there may be more than 1 if the index is large)

After you create the index files on a remote machine, the files must be copied to the Enforce Server, loaded into the previously created remote EDM profile, and indexed.

See “Creating an EDM profile template for remote indexing” on page 436.

**To copy and load the files on the Enforce Server**

1. Go to the directory where the index files were generated. (This directory is the one specified in the -result option.)

2. Copy all of the index files with .pdx and .rdx extensions to the index directory on the Enforce Server. This directory is located at \SymantecDLP\Protect\Index (Windows) or /var/SyantecDLP/index (Linux).

3. From the Enforce Server administration console, navigate to the **Manage > Policies > Exact Data** screen.

   This screen lists all the Exact Data Profiles in the system.

4. Click the name of the Exact Data Profile you used with the Remote EDM Indexer.

5. To load the new index files, go to the Data Source section of the Exact Data Profile and select **Load Externally Generated Index**.
6 In the Indexing section, select **Submit Indexing Job on Save**.

As an alternative to indexing immediately on save, consider scheduling a job on the remote machine to run the Remote EDM Indexer on a regular basis. The job should also copy the generated files to the index directory on the Enforce Server. You can then schedule loading the updated index files on the Enforce Server from the profile by selecting **Load Externally Generated Index** and **Submit Indexing Job on Schedule** and configuring an indexing schedule.

See “Use scheduled indexing to automate profile updates” on page 457.

7 Click **Save**.

**SQL Preindexer command options**

On install the SQL Preindexer utility is available at `\SymantecDLP\Protect\bin` (Windows) and `/SymantecDLP/Protect/bin` (Linux).

The SQL Preindexer provides a command-line interface. The syntax for running the utility is as follows:

```
SqlPreindexer -alias=<@//oracle_host:port/SID> -username=<DB_user> [options]
```

Note the following about the arguments:

- The SQL Preindexer requires the `-alias` and `-username` arguments.
- If you omit the `-password` option, the user is prompted to enter it.
- If you use the `-query` option, the SQL query string must be in quotes.
- If you omit the `-query` option, the utility indexes the entire database.
- To query using wildcards, use the `-query_path` option. The SQL Preindexer does not support the use of wildcards from the command line using the `-query` option. For example: "select * from CUST_DATA" does not work with `-query`; you must query each individual column field: "select cust_ID, cust_Name, cust_SSN from CUST_DATE." The query "select * from CUST_DATA" works using the `-query_path` command.

See “Remote indexing examples using SQL Preindexer” on page 441.

**Table 19-41** lists the command options for the SQL Preindexer.
<table>
<thead>
<tr>
<th>Option</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-alias</td>
<td>Oracle DB connect string</td>
<td>Specifies the database alias that is used to connect to the database in the following format:</td>
</tr>
<tr>
<td></td>
<td>Required</td>
<td>@//oracle_DB_host:port/SID</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-driver</td>
<td>Oracle JDBC driver class</td>
<td>Specifies the JDBC driver class, for example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>oracle.jdbc.driver.OracleDriver.</td>
</tr>
<tr>
<td>-encoding</td>
<td>Character encoding</td>
<td>Specifies the character encoding of the data to index. The default is iso-8859-1.</td>
</tr>
<tr>
<td></td>
<td>(iso-8859-1)</td>
<td>Data with non-English characters should use UTF-8 or UTF-16.</td>
</tr>
<tr>
<td>-password</td>
<td>Oracle DB password</td>
<td>Specifies the password to the database.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If this option is not specified, the password is read from stdin.</td>
</tr>
<tr>
<td>-query</td>
<td>SQL query</td>
<td>This option specifies the SQL query to perform. The statement must be enclosed in quotes.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If you omit the -query option the utility indexes the entire database.</td>
</tr>
<tr>
<td>-query_path</td>
<td>SQL script</td>
<td>Specifies the file name and local path that contains a SQL query to run. Must be full path.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This option can be used as an alternative to the -query option when the query is a long SQL statement.</td>
</tr>
<tr>
<td>-separator</td>
<td>Output column separator</td>
<td>Specifies whether the output column separator is a comma, pipe, or tab. The default separator is a tab.</td>
</tr>
<tr>
<td></td>
<td>(tab)</td>
<td>To specify a comma separator or pipe separator, enclose the separator character in quotation marks: &quot;,&quot;, &quot;</td>
</tr>
<tr>
<td>-subprotocol</td>
<td>Oracle thin driver</td>
<td>Specifies the JDBC connect string subprotocol (for example, oracle:thin).</td>
</tr>
<tr>
<td>-username</td>
<td>Oracle DB user</td>
<td>Specifies the name of the database user.</td>
</tr>
<tr>
<td>-verbose</td>
<td></td>
<td>Displays a statistical summation of the operation when it is complete.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Troubleshooting preindexing errors” on page 446.</td>
</tr>
</tbody>
</table>
Remote EDM Indexer command options

On install, the Remote EDM Indexer utility is available at
\SymantecDLP\Protect\bin (Windows) and /SymantecDLP/Protect/bin (Linux).

If you are on Linux, change users to the “protect” user before running the Remote EDM Indexer. (The installation program creates the “protect” user.)

The Remote EDM Indexer provides a command line interface. The syntax for running the utility is as follows:

```
RemoteEDMIndexer -profile=<file *.edm> -result=<out_dir> [options]
```

Note the following about the syntax:

- The Remote EDM Indexer requires the `-profile` and `-result` arguments.
- If you use a flat data source file as input, you must specify the file name and local path using the `-data` option.
- The `-data` option is omitted when you use the SQL Preindexer to pipe the data to the Remote EDM Indexer.

See “Remote indexing examples using data source file” on page 440.

Table 19-42 describes the command options for the Remote EDM Indexer.

<table>
<thead>
<tr>
<th>Option</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-data</code></td>
<td>Data source to be indexed (stdin)</td>
<td>Specifies the data source to be indexed. If this option is not specified, the utility reads data from stdin. Required if you use a flat file</td>
</tr>
<tr>
<td></td>
<td>Required if you use a flat file</td>
<td>Required if using data source file and not the SQL Preindexer.</td>
</tr>
<tr>
<td><code>-encoding</code></td>
<td>Character encoding of data to be indexed (ISO-8859-1)</td>
<td>Specifies the character encoding of the data to index. The default is ISO-8859-1. Use UTF-8 or UTF-16 if the data contains non-English characters.</td>
</tr>
<tr>
<td><code>-ignore_date</code></td>
<td>Ignore expiration date of the EDM profile</td>
<td>Overrides the expiration date of the Exact Data Profile if the profile has expired. (By default, an Exact Data Profile expires after 30 days.)</td>
</tr>
<tr>
<td><code>-profile</code></td>
<td>File containing the EDM profile</td>
<td>Specifies the Exact Data Profile to be used. This profile is the one that is selected by clicking the “download link” on the Exact Data screen in the Enforce Server management console</td>
</tr>
</tbody>
</table>
### Table 19-42  Remote EDM Indexer command options (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-result</td>
<td>Directory to place the resulting indexes</td>
<td>Specifies the directory where the index files are generated.</td>
</tr>
<tr>
<td></td>
<td>Required</td>
<td></td>
</tr>
<tr>
<td>-verbose</td>
<td>Display verbose output</td>
<td>Displays a statistical summation of the indexing operation when the index is complete. See “Troubleshooting preindexing errors” on page 446.</td>
</tr>
</tbody>
</table>

#### Troubleshooting preindexing errors

If you receive an error that the SQL Preindexer was unable to perform query or failed to prepare for indexing, verify that the -query string is in quotes. You can test your -query string by running only the SQL Preindexer command. If the command is correct the data queried from the database is displayed to the console as stdout.

You may encounter errors when you index large amounts of data. Often the set of data contains a data record that is incomplete, inconsistent, or inaccurate. Data rows that contain more columns than expected or incorrect column data types often cannot be properly indexed and are unrecognized.

The SQL Preindexer can be configured to provide a summary of information about the indexing operation when it completes. To do so, specify the verbose option when running the SQL Preindexer.

To see the rows of data that the Remote EDM Indexer did not index, adjust the configuration in the `Indexer.properties` file using the following procedure.

**To record those data rows that were not indexed**

1. Locate the `Indexer.properties` file at
   
   `\SymantecDLP\Protect\config\Indexer.properties` (Windows) or
   
   `/SymantecDLP/Protect/config/Indexer.properties` (Linux).
2. Open the file in a text editor.
3. Locate the `create_error_file` property and change the “false” setting to “true.”
4. Save and close the `Indexer.properties` file.

The Remote EDM Indexer logs errors in a file with the same name as the data file being indexed and the `.err` suffix.

The rows of data that are listed in the error file are not encrypted. Safeguard the error file to minimize any security risk from data exposure.
Troubleshooting remote indexing errors

The Remote EDM Indexer displays a message that indicates whether the indexing operation was successful or not. If the Remote EDM Indexer successfully creates the index, the console displays the message "Successfully created index" as the last line of output. In addition, *.pdx and one or more *.rdx files are created in the -result directory.

The result depends on the error threshold that you specify in the EDM profile. Any error percentage under the threshold completes successfully. Detailed information about the indexing operation is available with the -verbose option.

See "Remote EDM Indexer command options" on page 445.

If the index generation is not successful, try these troubleshooting tips:

Table 19-43  Remote Indexer troubleshooting tips

<table>
<thead>
<tr>
<th>Error</th>
<th>Symptom</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index files not generated</td>
<td>Use the -verbose option in the command to reveal error message.</td>
<td>Specifying the verbose option when running the Remote EDM Indexer provides a statistical summary of information about the indexing operation after it completes. This information includes the number of errors and where the errors occurred.</td>
</tr>
<tr>
<td>&quot;Failed to create index&quot;</td>
<td>Verify file and path names.</td>
<td>Verify that you included the full path and proper file name for the -data file and the -profile file (*.edm). The paths must be local to the host.</td>
</tr>
<tr>
<td>&quot;Cannot compute index&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot;Unable to generate index&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot;Destination is not a directory&quot;</td>
<td>Directory path not correct.</td>
<td>Verify that you properly entered the full path to the destination directory for the required -result argument.</td>
</tr>
<tr>
<td>*.idx file instead of *.rdx file</td>
<td>Did not use -data argument</td>
<td>The -data option is required if you are using a data source file and not the SQL Preindexer. In other words, the only time you don't use the -data argument is when you are using the SQL Preindexer. If you run the Remote EDM Indexer without the -data option and no SQL Preindexer query, you get an *.idx and *.rdx file that cannot be used as for the EDM index. Rerun the index using the -data option or a SQL Preindexer -query or -query-path.</td>
</tr>
</tbody>
</table>

See “About the SQL Preindexer” on page 433.
In addition, you may encounter errors when you index large amounts of data. Often the set of data contains a data record that is incomplete, inconsistent, or incorrectly formatted. Data rows that contain more columns than expected or incorrect data types often cannot be properly indexed and are unrecognized during indexing. The rows of data with errors cannot be indexed until those errors are corrected and the Remote EDM Indexer rerun. Symantec provides a couple of ways to get information about any errors and the ultimate success of the indexing operation.

To see the actual rows of data that the Remote EDM Indexer failed to index, modify the `Indexer.properties` file.

**To modify the Indexer.properties file and view remote indexing errors**

1. Locate the `Indexer.properties` file at `\SymantecDLP\Protect\config\Indexer.properties` (Windows) or `/opt/SymantecDLP/Protect/config/Indexer.properties` (Linux).

2. To edit the file, open it in a text editor.

3. Locate the `create_error_file` property parameter and change the "false" value to "true."

4. Save and close the `Indexer.properties` file.

   The Remote EDM Indexer logs errors in a file with the same name as the indexed data file and with an `.err` extension. This error file is created in the logs directory.

   The rows of data that are listed in the error file are not encrypted. Encrypt the error file to minimize any security risk from data exposure.

**Installing the Remote EDM Indexer (Windows)**

The Remote EDM Indexer (Windows) is installed from the same installation program as the other Symantec Data Loss Prevention components.

See “About the Remote EDM Indexer” on page 433.

See “Installing the Remote EDM Indexer (Linux)” on page 449.

**To install the Remote EDM Indexer on Windows**

1. Copy the `ProtectInstaller_12.5.exe` file to the remote machine where the data to be indexed resides.

2. Go to the directory where you copied the `ProtectInstaller_12.5.exe` installer.

   You may need to change the file permissions to access the file.
3 Run the installation program by double-clicking the file

ProtectInstaller_12.5.exe.

The installer files unpack and the Welcome screen displays.

4 Click Next and then accept the Symantec Software License Agreement to continue.

5 Select Indexer from the list of components that appears and click Next.

6 On the Select Destination Directory screen, click Next to accept the default installation location (recommended).

Alternately, click Browse to navigate to a different installation location, then click Next.

7 Choose a Start Menu folder and then click Next.

The Installing screen appears and displays an installation progress bar.

8 Click Finish to complete the installation.

The files to uninstall the Remote EDM Indexer are located in the root level of the Symantec Data Loss Prevention installation directory. Follow this procedure to uninstall the utility on Windows.

To uninstall Remote EDM Indexer from a Windows system

1 On the computer where the Remote EDM Indexer is installed, locate and run (double-click) the \SymantecDLP\uninstall.exe program.

The uninstallation program begins and the Uninstall screen is displayed.

2 Click Next. When the uninstallation process is complete, the Uninstall Complete screen is displayed.

3 Click Finish to close the program.

Installing the Remote EDM Indexer (Linux)

The Linux version of the Remote EDM Indexer provides a text-based command console option to install the product. The following procedure describes how to install the Remote EDM Indexer for Linux from the command line.

See “About the Remote EDM Indexer” on page 433.
See “Installing the Remote EDM Indexer (Windows)” on page 448.

To install the Remote EDM Indexer on Linux

1 Log on to the Linux system as the root user.

2 Copy the ProtectInstaller_12.5.sh file to the /tmp directory on the computer.
3 Using a terminal session, change the directory to `/tmp` by typing:

    cd /tmp

4 You may need to change permissions on the file before you can run the file. If so, type:

    chmod 775 ProtectInstaller_12.5.sh

5 Once the file permissions have been changed you can run the `ProtectInstaller_12.5.sh` file, by typing:

    ./ProtectInstaller_12.5.sh -i console

Once the console mode installation launches, the Introduction step is displayed. For most circumstances, it is recommended to use the defaults during installation whenever possible. Press **Enter** to proceed to the next step.

6 At the **Choose Install Set** step, specify the component to install. To install the Remote EDM Indexer, type the number beside the option and press **Enter**.

7 At the **Install Folder** step, type the absolute path to the directory where you want to install the files. The default location can be selected by pressing **Enter**.

8 At the **Pre-Installation Summary** step, review the installation configuration that you have selected. If you are satisfied with the selections, press **Enter** to begin the installation. Or, type **back** and press **Enter** until you reach the step you want to change.

9 When the installation completes, press **Enter** to close the installer.

The files to uninstall the Remote EDM Indexer are located in the root level of the Symantec Data Loss Prevention installation directory. Follow this procedure to uninstall the utility on Linux.

**To remove a Remote EDM Indexer from the command line**

1 Log on as root and change to the Uninstall directory by typing:

    cd /opt/SymantecDLP/Uninstall

2 Run the Uninstall program by typing:

    ./Uninstall -i console

3 Follow any on-screen instructions.
Best practices for using EDM

EDM is the most accurate form of detection. It is also the most complex to set up and maintain. To ensure that your EDM policies are as accurate as possible, consider the recommendations in this section when you are implementing your EDM profiles and policies.

The following table provides a summary of the EDM policy considerations discussed in this chapter, with links to individual topics for more details.

Table 19-44  Summary of EDM best practices

<table>
<thead>
<tr>
<th>Best practice</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ensure that the data source file contains at least one column of unique data.</td>
<td>See “Ensure data source has at least one column of unique data” on page 452.</td>
</tr>
<tr>
<td>Eliminate duplicate rows and blank columns before indexing.</td>
<td>See “Cleanse the data source file of blank columns and duplicate rows” on page 453.</td>
</tr>
<tr>
<td>To reduce false positives, avoid single characters, quotes, abbreviations,</td>
<td>See “Remove ambiguous character types from the data source file” on page 454.</td>
</tr>
<tr>
<td>numeric fields with less than 5 digits, and dates.</td>
<td></td>
</tr>
<tr>
<td>Understand multi-token indexing and clean up as necessary.</td>
<td>See “Understand how multi-token cell matching functions” on page 454.</td>
</tr>
<tr>
<td>Use the pipe (</td>
<td>) character to delimit columns in your data source.</td>
</tr>
<tr>
<td>Review an example cleansed data source file.</td>
<td>See “Ensure that the data source is clean for indexing” on page 456.</td>
</tr>
<tr>
<td>Map data source column to system fields to leverage validation during indexing.</td>
<td>See “Map data source column to system fields to leverage validation” on page 455.</td>
</tr>
<tr>
<td>Leverage EDM policy templates whenever possible.</td>
<td>See “Leverage EDM policy templates when possible” on page 456.</td>
</tr>
<tr>
<td>Include the column headers as the first row of the data source file.</td>
<td>See “Include column headers as the first row of the data source file” on page 456.</td>
</tr>
<tr>
<td>Check the system alerts to tune Exact Data Profiles.</td>
<td>See “Check the system alerts to tune profile accuracy” on page 457.</td>
</tr>
<tr>
<td>Use stopwords to exclude common words from matching.</td>
<td>See “Use stopwords to exclude common words from detection” on page 457.</td>
</tr>
<tr>
<td>Automate profile updates with scheduled indexing.</td>
<td>See “Use scheduled indexing to automate profile updates” on page 457.</td>
</tr>
</tbody>
</table>
### Table 19-44  Summary of EDM best practices (continued)

<table>
<thead>
<tr>
<th>Best practice</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Match on two or three columns in an EDM rule.</td>
<td>See “Match on 3 columns in an EDM condition to increase detection accuracy” on page 458.</td>
</tr>
<tr>
<td>Leverage exception tuples to avoid false positives.</td>
<td>See “Leverage exception tuples to avoid false positives” on page 459.</td>
</tr>
<tr>
<td>Use a where clause to detect records that meet a specific criteria.</td>
<td>See “Use a WHERE clause to detect records that meet specific criteria” on page 460.</td>
</tr>
<tr>
<td>Use the minimum matches field to fine tune EDM rules.</td>
<td>See “Use the minimum matches field to fine tune EDM rules” on page 460.</td>
</tr>
<tr>
<td>Consider using Data Identifiers in combination with EDM rules.</td>
<td>See “Combine Data Identifiers with EDM rules to limit the impact of two-tier detection” on page 460.</td>
</tr>
<tr>
<td>Include an email address field in the Exact Data Profile for profiled DGM.</td>
<td>See “Include an email address field in the Exact Data Profile for profiled DGM” on page 461.</td>
</tr>
</tbody>
</table>

### Ensure data source has at least one column of unique data

EDM is designed to detect combinations of data fields that are globally unique. At a minimum, your EDM index must include at least one column of data that contains a unique value for each record in the row. Column data such as account number, social security number, and credit card number are inherently unique, whereas state or zip code are not unique, nor are names. If you do not include at least one column of unique data in your index, your EDM profile will not accurately detect the data you want to protect.

**Table 19-45** describes the various types of unique data to include in your EDM indexes, as well as fields that are not unique. You can include the non-unique fields in your EDM indexes as long as you have at least one column field that is unique.
Table 19-45  Examples of unique data for EDM policies

<table>
<thead>
<tr>
<th>Unique data for EDM</th>
<th>Non-unique data</th>
</tr>
</thead>
<tbody>
<tr>
<td>The following data fields are usually unique:</td>
<td>The following data fields are not unique:</td>
</tr>
<tr>
<td>■ Account number</td>
<td>■ First name</td>
</tr>
<tr>
<td>■ Bank Card number</td>
<td>■ Last name</td>
</tr>
<tr>
<td>■ Phone number</td>
<td>■ City</td>
</tr>
<tr>
<td>■ Email address</td>
<td>■ State</td>
</tr>
<tr>
<td>■ Social security number</td>
<td>■ Zip code</td>
</tr>
<tr>
<td>■ Tax ID number</td>
<td>■ Password</td>
</tr>
<tr>
<td>■ Drivers license number</td>
<td>■ PIN number</td>
</tr>
<tr>
<td>■ Employee number</td>
<td></td>
</tr>
<tr>
<td>■ Insurance number</td>
<td></td>
</tr>
</tbody>
</table>

Cleanse the data source file of blank columns and duplicate rows

The data source file should be as clean as possible before you create the EDM index, otherwise the resulting profile may create false positives.

When you create the data source file, avoid including empty cells or blank columns. Blank columns or fields count as “errors” when you generate the EDM profile. A data source error is either an empty cell or a cell with the wrong type of data (a name appearing in a phone number column). If the errors exceed the error threshold percentage for the profile (by default, 5%), the system stops indexing and displays an indexing error message.

The best practice is to remove blank columns and empty cells from the data source file, rather than increasing the error threshold. Keep in mind that if you have many empty cells, it may require a 100% error threshold for the system to create the profile. If you specify 100% as the error threshold, the system indexes the data source without checking for errors.

In addition, do not fill empty cells or blank fields with bogus data so that the error threshold is met. Adding fictitious or “null” data to the data source file will reduce the accuracy of the EDM profile and is strongly discouraged. Content you want to monitor should be legitimate and not null.

See “About cleansing the exact data source file” on page 373.

See “Preparing the exact data source file for indexing” on page 381.

See “Ensure that the data source is clean for indexing” on page 456.
Remove ambiguous character types from the data source file

You cannot have extraneous spaces, punctuation, and inconsistently populated fields in the data source file. You can use tools such as Stream Editor (sed) and AWK to remove these items from your data source file or files before indexing them.

<table>
<thead>
<tr>
<th>Characters to avoid</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single characters</td>
<td>Single character fields should be eliminated from the data source file. These are more likely to cause false positives, since a single character is going to appear frequently in normal communications.</td>
</tr>
<tr>
<td>Abbreviations</td>
<td>Abbreviated fields should be eliminated from the data source file for the same reason as single characters.</td>
</tr>
<tr>
<td>Quotes</td>
<td>Text fields should not be enclosed in quotes.</td>
</tr>
<tr>
<td>Small numbers</td>
<td>Indexing numeric fields that contain less than 5 digits is not recommended because it will likely yield many false positives.</td>
</tr>
<tr>
<td>Dates</td>
<td>Date fields are also not recommended. Dates are treated like a string, so if you are indexing a date, such as 12/6/2007, the string will have to match exactly. The indexer will only match 12/6/2007, and not any other date formats, such as Dec 6, 2007, 12-6-2007, or 6 Dec 2007. It must be an exact match.</td>
</tr>
</tbody>
</table>

Understand how multi-token cell matching functions

An EDM rule performs a full-text search against the message, checking each word (except those that are excluded by way of the columns you choose to match in the policy) for potential matches. The matching algorithm compares each individual word in the message with the contents of each token in the data profile.

If a cell in the data profile contains multiple words separated by spaces, punctuation, or alternative Latin and Chinese, Japanese, and Korean (CJK) language characters, the cell is a multi-token cell. The sub-token parts of a multi-token cell obey the same rules as single-token cells: they are normalized according to their pattern where normalization can apply.

If a cell contains a multi-token, the multi-token must match exactly. For example, a column field with the value “Joe Brown” is a multi-token cell (assuming multi-token matching is enabled). At run-time the processor looks to match the exact string “Joe Brown,” including the space (multiple spaces are normalized to one). The system does not match on “Joe” and “Brown” if they are detected as single tokens.
In addition, multi-token cells are more computationally expensive than single-token cells. If the index includes multi-token cells, you must verify that you have enough memory to index, load, and process the EDM profile.

If multi-token matching is enabled, any punctuation that is next to a space is ignored. Therefore, punctuation before and after a space is ignored.

Lastly, do not change the WIP setting from "true" to "false" unless you are sure that is the result you want to achieve. You should only set WIP = false when you need to loosen the matching criteria, such as account numbers where formatting may change across messages. Make sure you test detection results to ensure you are getting the matches you expect.

See “Memory requirements for EDM” on page 421.

Do not use the comma delimiter if the data source has number fields

Of the three types of column delimiters that you can choose from for separating the fields in the data source file (pipe, tab, or comma), the pipe or tab (default) is recommended. The comma delimiter is ambiguous and should not be used, especially if one or more fields in your data source contain numbers. If you use a comma-delimited data source file, make sure there are no commas in the data set other than those used as column delimiters.

Note: Although the system also treats the pound sign, equals sign, plus sign, semicolon, and colon characters as separators, you should not use these because like the comma their meaning is ambiguous.

Map data source column to system fields to leverage validation

When you create the Exact Data Profile, you can validate how well the fields in your data source match against system-defined patterns for that field. For example, if you map a field to the credit card system pattern, the system will validate that the data matches the credit card system pattern. If it does not, the system will create an error for every record that contains an invalid credit card number. Mapping data source fields in your index to system-defined field patterns helps you ensure that the fields in your index meet the data type criteria.

If there is no corresponding system field to map to a data source column, consider creating a custom field to map data source column data. You can use the description field to annotate both system and custom fields.

See “Mapping Exact Data Profile fields” on page 389.
See “Creating and modifying Exact Data Profiles” on page 385.
Ensure that the data source is clean for indexing

The following list summarizes a cleansed data source that is ready for indexing:

■ It contains at least one unique column field.
■ It is not a single-column data source; it has two or more columns.
■ Empty cells and rows and blank columns are removed.
■ Incomplete and duplicate records are removed.
■ The number of faulty cells is below the default error rate (5%) for indexing.
■ Bogus data is not used to fill in blank cells or rows.
■ Improper and ambiguous characters are removed.
■ Multi-tokens comply with space and memory requirements.
■ Column fields are validated against the system-defined patterns that are available.
■ Mappings are validate against policy templates where applicable.

See “Ensure data source has at least one column of unique data” on page 452.
See “Cleansethe data source file of blank columns and duplicate rows” on page 453.
See “Remove ambiguous character types from the data source file” on page 454.
See “Understand how multi-token cell matching functions” on page 454.
See “Map data source column to system fields to leverage validation” on page 455.

Leverage EDM policy templates when possible

Symantec Data Loss Prevention provides several policy templates that implement EDM rules. The general recommendation is to use policy templates whenever possible when implementing EDM. If you do use a policy template for EDM, you should validate the index against the template when you configure the Exact Data Profile.

See “EDM policy templates” on page 370.

See “Creating and modifying Exact Data Profiles” on page 385.

Include column headers as the first row of the data source file

When you extract the source data to the data source file, you should include the column headers as the first row in the data source file. Including the column headers will make it easier for you to identify the data you want to use in your policies.
The column names reflect the column mappings that were created when the exact data profile was added. If there is an unmapped column, it is called Col X, where X is the column number (starting with 1) in the original data profile.

If the Exact Data Profile is to be used for DGM, the file must have a column with a heading of email, or the DGM will not appear in the Directory EDM drop-down list (at the remediation page).

### Check the system alerts to tune profile accuracy

You should always review the system alerts after creating the Exact Data Profile. The system alerts provide very specific information about problems encountered when creating the profile, such as a SSN in an address field, which will affect accuracy.

### Use stopwords to exclude common words from detection

During detection the EDM process ignores words found in the stopwords file. Stopwords are common words that are excluding from matching. For example, the stopwords file contains common words such as articles, prepositions, and so forth. You can adjust the stopwords file by adding to or removing words from the file. It is recommended that you back up the original before changing it.

Stopword files are located at the following directory where the detection server running the index is installed: `\SymantecDLP\Protect\config\stopwords`. By default the system uses the `stopwords_en.txt` file, which is the English language version. Other language stopwords files are also located in this same directory. You can change the default stopword language file by updating the `Lexer.StopwordLanguages` property in the Advanced Server Settings screen of the Enforce Server.

See “Configuring Advanced Server Settings for EDM policies” on page 400.

### Use scheduled indexing to automate profile updates

When you configure an Exact Data Profile, you can set a schedule for indexing the data source file. Index scheduling lets you decide when you want to index the data source file. For example, instead of indexing the data source at the same time that you define the profile, you can schedule it for a later date. Alternatively, if you need to reindex the data source on a regular basis, you can schedule indexing to occur on a regular basis.

Before you set up an index schedule, consider the following:
- If you update your data sources occasionally (for example, less than once a month), generally there is no need to create a schedule. Index the data each time you update the data source.
- Schedule indexing for times of minimal system use. Indexing affects performance throughout the Symantec Data Loss Prevention system, and large data sources can take time to index.
- Index a data source as soon as you add or modify the corresponding exact data profile, and re-index the data source whenever you update it. For example, consider a scenario whereby every Wednesday at 2:00 P.M. you generate an updated data source file. In this case you could schedule indexing every Wednesday at 3:00 P.M., giving you enough time to cleanse the data source file and copy it to the Enforce Server.
- Do not index data sources daily as this can degrade performance.
- Monitor results and modify your indexing schedule accordingly. If performance is good and you want more timely updates, for example, schedule more frequent data updates and indexing.

Consider using scheduled indexing with remote EDM indexing to keep an EDM profile up to date. For example, you can schedule a cron job on the remote machine to run the Remote EDM Indexer on a regular basis. The job can also copy the generated index files to the index directory on the Enforce Server. You can then configure the Enforce Server to load the externally generated index and submit it for indexing on a scheduled basis.

See “About index scheduling” on page 374.

See “Scheduling Exact Data Profile indexing” on page 392.

See “Copying and loading remote index files to the Enforce Server” on page 442.

**Match on 3 columns in an EDM condition to increase detection accuracy**

In a structured data format such as a database, each row represents one record, with each record containing related values for each column data field. Thus, for an EDM policy rule condition to match, all the data must come from the same row or record of data. When you define an EDM rule, you must select the fields that must be present to be a match. Although there is no limit to the number of columns you can select to match in a row (up to the total number of columns in the index, which is a maximum of 32), it is recommended that you match on at least 2 or 3 columns, one of which must be unique. Generally matching on 3 fields is preferred, but if one of the columns contains a unique value such as SSN or Credit Card number, 2 columns may be used.
Consider the following example. You want to create an EDM policy condition based on an Exact Data Profile that contains the following 5 columns of indexed data:

- First Name
- Last Name
- Social security number (SSN)
- Phone Number
- Email Address

If you select all 5 columns to be included in the policy, consider the possible results based on the number of fields you require for each match.

If you choose "1 of the selected fields" to match, the policy will undoubtedly generate a large number of false positives because the record will not be unique enough. (Even if the condition only matches the SSN field, there may still be false positives because there are other types of nine-digit numbers that may trigger a match.).

If you choose "2 of the selected fields" to match, the policy will still produce false positives because there are potential worthless combinations of data: First Name + Last Name, Phone Number + Email Address, or First Name + Phone Number.

If you choose to match on 4 or all 5 of the column fields, you will not be able to exclude certain data field combinations because that option is only available for matches on 2 or 3 fields.

See “Leverage exception tuples to avoid false positives” on page 459.

In this example, to ensure that you generate the most accurate match, the recommendation is that you choose "3 of the selected fields to match." In this way you can reduce the number of false positives while using one or more exceptions to exclude the combinations that do not present a concern, such as First Name + Last Name + Phone Number.

Whatever number of fields you choose to match, ensure that you are including the column with the most unique data, and that you are matching at least 2-column fields.

Leverage exception tuples to avoid false positives

The EDM policy condition lets you define exception tuples to exclude combinations on data. You must select 2 or 3 columns to match to leverage exception tuples.

EDM allows detection based on any combination of columns in a given row of data (that is, N of M fields from a given record). It can trigger on "tuples," or specified sets of data types. For example, a combination of the first name and SSN fields could be acceptable, but a combination of the last name and SSN fields would not.
EDM also allows more complex rules such as looking for N of M fields, but excluding specified tuples. For example, this type of rule definition is required to identify incidents in violation of state data privacy laws, such as California SB 1386, which requires a first name and last name in combination with any of the following: SSN, bank account number, credit card number, or driver’s license number.

While exception tuples can help you reduce false positives, if you are using several exception tuples, it may be a sign your index is flawed. In this case, consider redoing your index so you do not have to use so many excluded combinations to achieve the desired matches.

Use a WHERE clause to detect records that meet specific criteria

Another configuration parameter of the EDM policy condition is the "Where" clause option. This option matches on the exact value you specify for the field you select. You can enter multiple values by separating each with commas. Using a WHERE clause to detect records that meet specific criteria helps you improve the accuracy of your EDM policies.

For example, if you wanted to match only on an Exact Data Profile for "Employees" with a "State" field containing certain states, you could configure the match where "State" equals "CA,NV". This rule then causes the detection engine to match a message that contains either CA or NV as content.

Use the minimum matches field to fine tune EDM rules

The minimum matches field is useful for fine-tuning the sensitivity of an EDM rule. For example, one employee's first and last name in an outgoing email may be acceptable. However, 100 employees' first and last names is a serious breach. Another example might be a last name and social security number policy. The policy might allow an employee to send information to a doctor, but the sending of two last names and social security numbers is suspicious.

Combine Data Identifiers with EDM rules to limit the impact of two-tier detection

When implementing EDM policies, it is recommended that you combine Data Identifiers (DIs) rules with the EDM condition to form compound policies. As reference, note that all system-provided policy templates that implement EDM rules also implement Data Identifier rules in the same policy.

Data Identifiers and EDM are both designed to protect personally identifiable information (PII). Including Data Identifiers with your EDM rules make your policies more robust and reusable across detection servers because unlike EDM rules Data Identifiers are executed on the endpoint and do not require two-tier detection. Thus,
if an endpoint is off the network, the Data Identifier rules can protect PII such as SSNs.

Data Identifier rules are also useful to use in your EDM policies while you are gathering and preparing your confidential data for EDM indexing. For example, a policy might contain the US SSN Data Identifier and an EDM rule for as yet unindexed or unknown SSNs.

Include an email address field in the Exact Data Profile for profiled DGM

You must include the appropriate fields in the Exact Data Profile to implement profiled DGM.

See “Creating the exact data source file for profiled DGM” on page 380.

If you include the email address field in the Exact Data Profile for profiled DGM and map it to the email data validator, email address will appear in the Directory EDM drop-down list (at the remediation page).

Use profiled DGM for Network Prevent for Web identity detection

If you want to implement DGM for Network Prevent for Web, use one of the profiled DGM conditions to implement identity matching. For example, you may want to use identity matching to block all web traffic for a specific users. For Network Prevent for Web, you cannot use synchronized DGM conditions for this use case.

See “Creating the exact data source file for profiled DGM” on page 380.

See “Configuring the Sender/User based on a Profiled Directory condition” on page 663.
Detecting content using Indexed Document Matching (IDM)

This chapter includes the following topics:

■ Introducing Indexed Document Matching (IDM)
■ Configuring IDM profiles and policy conditions
■ Best practices for using IDM

Introducing Indexed Document Matching (IDM)

You use Indexed Document Matching (IDM) to protect confidential information that is stored as unstructured data in documents and files. For example, you can use IDM to detect financial report data stored in Microsoft Office documents, merger and acquisition information stored in PDF files, and source code stored in text files. You can also use IDM to detect binary files, such as JPEG images, CAD designs, and multimedia files. In addition, you can use IDM to detect derived content such as text that has been copied from a source document to another file.

See “Supported forms of matching for IDM” on page 463.

See “About the Indexed Document Profile” on page 465.

About using IDM

To use IDM you collect the documents and files that you want to protect and index them using the Enforce Server. During the indexing process the system uses an algorithm to fingerprint each file or file contents. You then create a policy that
contains one or more IDM conditions that reference the index. In production the system uses the same algorithm to fingerprint inbound files and file content. The system then compares the fingerprints against the index for matches.

For example, consider a document source you have collected that includes several confidential Microsoft Office documents (Word, Excel, PowerPoint) and image files (JPEG, BMP). You create an Indexed Document Profile and index the documents and files. You then configure the Content Matches Document Signature policy condition with a Minimum Document Exposure setting of 50%. The IDM policy and index are deployed to a detection server.

In production the detection server checks inbound files against the index for matches. In this case if an inbound text-based file that the system can crack contains 50% or more of content indexed from one of the source documents, the system records a match. And, if an inbound image file has the same binary signature as one of the files that has been indexed, the system records a match. The server performs exact file matching automatically even though the policy condition is configured for partial matching.

See “Types of IDM detection” on page 464.
See “About the Indexed Document Profile” on page 465.

**Supported forms of matching for IDM**

IDM supports three forms of matching: exact file, exact file contents, and partial file contents. Detection servers support all three forms of matching. The DLP Agent for Windows supports exact file and exact file contents matching locally on the endpoint.

Table 20-1 summarizes the forms of matching by platform that IDM supports.

<table>
<thead>
<tr>
<th>Type of matching</th>
<th>Description</th>
<th>Platform</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exact file</td>
<td>Match is based on the binary signature of the file. See “Using IDM to detect exact files” on page 470.</td>
<td>Detection server</td>
</tr>
<tr>
<td></td>
<td></td>
<td>DLP Agent for Windows</td>
</tr>
<tr>
<td>Exact file contents</td>
<td>Match is a 100% match of the extracted and normalized file contents. See “Using IDM to detect exact and partial file contents” on page 471.</td>
<td>Detection server</td>
</tr>
<tr>
<td></td>
<td></td>
<td>DLP Agent for Windows</td>
</tr>
</tbody>
</table>
Types of IDM detection

There are three types of IDM detection implementations: agent, server, and two-tier. The type you choose is based on your data loss prevention requirements. Table 20-2 summarizes the three types of IDM detection.

Table 20-2 Types of IDM detection

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent IDM</td>
<td>The DLP Agent for Windows performs exact file and file contents matching locally on the endpoint.</td>
<td>See “Agent IDM detection” on page 464.</td>
</tr>
<tr>
<td>Server IDM</td>
<td>The detection server performs exact file matching, exact file contents matching, and partial file contents matching.</td>
<td>See “Server IDM detection” on page 465.</td>
</tr>
<tr>
<td>Two-tier IDM</td>
<td>The DLP Agent sends the data to the detection server for policy evaluation.</td>
<td>See “Two-tier IDM detection” on page 465.</td>
</tr>
</tbody>
</table>

Agent IDM detection

With Agent IDM detection the DLP Agent for Windows evaluates documents locally in real time for exact file and exact file contents matches. Agent IDM lets you use the block, notify, and user cancel response rules on the endpoint with IDM policies.

See “Supported forms of matching for IDM” on page 463.

Agent IDM does not support partial file contents matching. If you want to use partial file contents matching on the endpoint, you must use two-tier detection.

See “Two-tier IDM detection” on page 465.

Agent IDM is enabled by default for a newly installed Endpoint Server. If you have upgraded, agent IDM is disabled. In this case, if you want to use agent IDM you must enable it and reindex your IDM profiles so that the endpoint index is generated and made available for download by DLP Agents.

See “Using agent IDM after upgrade to version 12.5” on page 494.
Server IDM detection
With server IDM detection the IDM index is deployed to one or more detection servers and all detection processing occurs on the server or servers. You can use server IDM to perform exact file matching and file contents matching. For file contents matching, you can choose to match file contents exactly (100%) or partially (10% to 90%) according to the Minimum Document Exposure set for the IDM condition.

See “Supported forms of matching for IDM” on page 463.

Two-tier IDM detection
If the server index is deployed to an Endpoint Server, the system uses two-tier detection to perform matching (assuming that two-tier detection is enabled). With two-tier IDM the DLP Agent sends the data to the Endpoint Server for matching against the server index. If two-tier detection is enabled for IDM, the server supports all forms of matching, including exact file, exact file contents, and partial file contents.

If you use two-tier detection for IDM on the endpoint, make sure you understand the performance implications of two-tier detection.

See “Two-tier detection for DLP Agents” on page 309.

About the Indexed Document Profile
The Indexed Document Profile is the user-defined configuration for creating and generating IDM indexes. You define an Indexed Document Profile using the Enforce Server administration console. You reference the profile in one or more IDM policy rules or exceptions. The profile is reusable across policies: you can create one document profile and reference it in multiple policies. When you create the Indexed Document Profile, you have the option of indexing the document source immediately on save of the profile or at a scheduled time. However, you must index the document source before you can detect policy violations.

See “Creating and modifying Indexed Document Profiles” on page 479.

For example, consider a scenario where you want to create an IDM index to detect when exact versions of certain financial documents are found, or when passages or sections of the documents are exposed. When you define the Indexed Document Profile, you can upload the documents to the Enforce Server, or you can index the documents on a network file share. You can also use file name and file size filters in the document profile to include or ignore certain files during indexing.

See “About the indexing process” on page 466.
About the document data source

The document data source is the collection of documents you want to index and detect using IDM. The maximum size of the document data source that you can index is 2 GB, which translates to approximately 300,000 or 400,000 documents. The exact number of documents the system permits depends on the average extracted text size (per document source).

See “Preparing the document data source for indexing” on page 475.

For smaller document sets (50 MB or less), you can upload the source files to the Enforce Server using a ZIP file. For larger document sets (up to 2 GB), you can copy the source files to the host file system where the Enforce Server is installed, either encapsulated within a single ZIP file or as individual files. You can use FTP/S to transfer the files to the Enforce Server. Alternatively, you can use the Remote SMB Share feature to remotely index documents that are stored on a CIFS file share or WebDAV-enabled server that is accessible to the Enforce Server.

See “About indexing remote documents” on page 467.

The document data source can contain any file type and any combination of files. If the system can crack the file, IDM detects file contents, either exactly or partially depending on the platform and the policy configuration. If the system cannot crack the file, IDM detects the exact file.

See “Supported forms of matching for IDM” on page 463.

About the indexing process

The IDM indexer is a separate process that installs with and runs on the Enforce Server.

During indexing the system stores the document source at
\SymantecDLP\Protect\documentprofiles (on Windows) or
/var/SymantecDLP/documentprofiles (on Linux). After indexing, for security purposes the system deletes the document source files that you have uploaded to the Enforce Server.

The result of the indexing process is two separate indexes: one for detection servers (the server index) and one for DLP Agents (the endpoint index). Both indexes are generated regardless of whether or not you are licensed for Endpoint Prevent or Endpoint Discover. On the Enforce Server, the system stores both indexes in
\SymantecDLP\Protect\index (on Windows) or /var/SymantecDLP/index (on Linux).

See “About the server and agent index files” on page 467.
Detecting content using Indexed Document Matching (IDM)  
Introducing Indexed Document Matching (IDM)  

For most IDM deployments there is no need to configure the indexer. If necessary you can configure key settings for the indexer using the file 
\SymantecDLP\Protect\config\Indexer.properties.

About indexing remote documents

Although the IDM indexing process is local to the Enforce Server, you can index documents that are remote to the Enforce Server using the Common Internet File System (CIFS) protocol or the Web-based Distributed Authoring and Versioning (WebDAV) protocol. To index documents remotely you use the Use Remote SMB Share option when you configure the Indexed Document Profile.

See “Creating and modifying Indexed Document Profiles” on page 479.

Using the CIFS protocol you can remotely index documents stored on one or more file shares in a Microsoft Windows-networked environment. To do this you provide the Universal Naming Convention (UNC) path to a shared network folder resource and index the documents stored in that folder or subfolders depending on the level of permission granted

See “Using the remote SMB share option to index file shares” on page 486.

WebDAV provides extensions to the HTTP 1.1 protocol that enable collaborative editing and management of files stored on remote web servers. You can index such documents remotely by exposing them to the Enforce Server using WebDAV. For example, you can use the remote SMB option with a UNC address and a WebDAV client to index Microsoft SharePoint or OpenText Livelink documents.

See “Using the remote SMB share option to index SharePoint documents” on page 487.

About the server and agent index files

When you create an Indexed Document Profile and index a document data source, the system generates two index files, one for server and one for endpoint. Both indexes are generated regardless of whether or not you are licensed for a particular detection server or the DLP Agent.

See “About index deployment and logging” on page 469.

The server index is a binary file named DocSource.rdx. The server index supports exact file, exact file contents, and partial file contents matching. If the document data source is large, the server index may span multiple *.* files.

The endpoint index is a secure, binary file named EndpointDocSource.rdx. The endpoint index supports exact file and exact file contents matching. The endpoint index is always one file.
See “Supported forms of matching for IDM” on page 463.

To create the index entries for exact file and exact file contents matching, the system uses the MD5 message-digest algorithm. This algorithm is a one-way hash function that takes as input a message of arbitrary length and produces as output a 128-bit message-digest or "fingerprint" of the input. If the message input is a text-based document that the system can crack, such as a Microsoft Word file, the system extracts 100% of the file contents, normalizes it by removing whitespaces, punctuation, and formatting, and creates an MD5 hash. Otherwise, if the message input is a file that the system cannot crack, such as an image file, small file, or unsupported file type, the system creates an MD5 hash based on the binary signature of the file.

See “Using IDM to detect exact files” on page 470.

See “Using IDM to detect exact and partial file contents” on page 471.

In addition, for file formats the system can crack, the indexer creates hashes for discrete sections of content or text passages. These hashes are used for partial matching and are exclusive to the server index. The system uses a statistical sampling method to store hashed sections of partial content so that not all extractable text is indexed. The hash function ensures that the server index does not contain actual document content. To keep the size of the endpoint index file small, partial file contents hashes are not included in the endpoint index.

Table 20-3 summarizes the types of matching supported by the endpoint and server indexes.

<table>
<thead>
<tr>
<th>Message input</th>
<th>Output</th>
<th>Matches</th>
<th>Included in index file</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text-based file that the system can crack</td>
<td>A single MD5 hash derived from 100% of the extracted and normalized file contents</td>
<td>Exact file contents (100%)</td>
<td>DocSource.rdx&lt;br&gt;EndpointDocSource.rdx</td>
</tr>
<tr>
<td></td>
<td>One or more rolling hashes based on discrete passages of extracted and normalized content using a statistical sampling method of selection</td>
<td>Partial file contents (10% to 90%)</td>
<td>DocSource.rdx</td>
</tr>
<tr>
<td>Binary file, custom file, small file, encapsulated file</td>
<td>A single MD5 hash based on the binary signature of the file</td>
<td>Exact file binary</td>
<td>DocSource.rdx&lt;br&gt;EndpointDocSource.rdx</td>
</tr>
</tbody>
</table>
About index deployment and logging

The Enforce Server is responsible for deploying the IDM server and endpoint indexes to the detection and Endpoint Servers. You cannot manually deploy the indexes.

The system deploys the server index to each designated detection server in the folder \SymantecDLP\Protect\index (on Windows) or /var/SymantecDLP/index (on Linux). At run-time, the detection server loads the server index into random access memory (RAM) when an active IDM policy that references that index is deployed to that detection server.

The system deploys the endpoint index to each designated Endpoint Server. When a DLP Agent connects to the Endpoint Server, the DLP Agent downloads the endpoint index. Assuming agent IDM is enabled, the DLP Agent loads the endpoint index into memory when the index is required by an active local policy. The endpoint index is much smaller in size than the server index so there is no degradation in endpoint performance.

See “Estimating endpoint memory use for agent IDM” on page 496.

You cannot manually deploy either the server or endpoint index files by copying the *.rdx file or files from the Enforce Server to a detection server. The detection server does not monitor the index destination folder for new index files; the detection server must be notified by the Enforce Server that an index has been deployed. If a detection server is offline during the index deployment process, the Enforce Server will cease trying to deploy the index. When the detection server comes back online the Enforce Server will deploy the index to the detection server. The same is true for DLP Agents. There is now way to manually copy the endpoint index to the endpoint host and have the DLP Agent recognize the index.

Table 20-4 summarizes how IDM indexes are deployed and the logs files to check to troubleshoot index deployment.

<table>
<thead>
<tr>
<th>Platform</th>
<th>Index file</th>
<th>Deployment</th>
<th>Logged</th>
</tr>
</thead>
</table>
| Server   | DocSource.rdx | Sent automatically by the Enforce Server to each designated detection server after the index is generated. Loaded by the detection server into RAM at run-time. | detection_operational.log
Use to identify if the index profile was deployed to the detection server. FileReader.log
Use to see if the index profile is loaded into memory. |

Table 20-4 IDM index deployment and logging
Table 20-4  IDM index deployment and logging (continued)

| Platform | Index file         | Deployment                                                                 | Logged                                                        |
|----------|--------------------|---------------------------------------------------------------------------|                                                              |
| Agent    | EndpointDocSource.rdx | Sent by the Enforce Server to each designated Endpoint Server.            | endpoint_server_operational.log                                |
|          |                    | Downloaded by the DLP Agent based on the agent connection interval.         | Pull the agent logs to see if the index profile is loaded into memory. |
|          |                    | Loaded into RAM at run-time when a local, active policy requires the index. |                                                              |

Using IDM to detect exact files

The system performs exact file matching automatically on all binary files. In addition, if the file format is text-based but the system is unable to crack the file and extract file contents, the system performs exact file matching. This behavior is true even if you select a Minimum Document Exposure percentage for the IDM condition that is less than Exact.

See “About the server and agent index files” on page 467.

For example, an IDM rule with a minimum document exposure set to 50% automatically attempts to match a binary file exactly because the Minimum Document Exposure setting only applies to crackable files. In addition, the system performs exact file matching for files containing a very small amount of text, as well as files that were encapsulated when indexed, even if text-based.

As an optimization, for exact file type matching, the system checks the byte size of the file before computing the run-time hash for comparison against the index. If the byte size does not match size of the indexed file there is no need to compute the exact file hash. The system does not consider the file format when creating the exact file fingerprint.

Table 20-5 summarizes exact file type matching behavior.

Table 20-5  Requirements for using IDM to detect files

<table>
<thead>
<tr>
<th>File format</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text-based file format the system cannot crack</td>
<td>Proprietary or non-supported document format</td>
<td>If the system cannot crack the file format, you can use IDM to detect that specific file using exact binary matching.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Do not compress files in the document source” on page 500.</td>
</tr>
</tbody>
</table>
Table 20-5 Requirements for using IDM to detect files (continued)

<table>
<thead>
<tr>
<th>File format</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Binary file</td>
<td>GIF, MPG, AVI, CAD design, JPEG files, audio/video files</td>
<td>You can use IDM to detect binary file types that cannot be cracked, such as images, graphics, JPEGs, etc. See “Avoid using IDM solely for binary files” on page 501.</td>
</tr>
<tr>
<td>File containing a small amount of text</td>
<td>CAD files, Visio diagrams, and so on</td>
<td>A file containing a small amount of text will be treated as a binary file even if the contents are text-based and crackable. See “Using IDM to detect exact and partial file contents” on page 471.</td>
</tr>
<tr>
<td>Encapsulated file</td>
<td>Any file that is encapsulated when indexed (even if text-based and crackable); for example, Microsoft Word file archived in a ZIP file</td>
<td>If a document data source file is encapsulated in an archive file, the file contents of the subfile cannot be extracted and only the binary signature of the file can be fingerprinted. This does not apply to the main document archive that contains all documents to be indexed. See “About the document data source” on page 466.</td>
</tr>
</tbody>
</table>

Using IDM to detect exact and partial file contents

The primary use case for IDM is to detect file contents (as distinguished from binary files, such as audio or video files, for example). On the server you can use IDM to match file contents exactly (100%) or partially (10% to 90%). On the endpoint you can use IDM to match file contents exactly. File contents include text-based content of any document type the system can crack, such as Microsoft Office documents (Word, Excel, PowerPoint), PDF, and many more.

See “Supported formats for content extraction” on page 684.

An exact file contents match means that 100% of the inbound file contents matches exactly the content of a file that has been indexed. The system does not consider the file format or file size when creating the MD5 hash for the index or when checking for an exact file contents match against the index. A document might contain much more content, but the system detects only the file contents that are indexed as part of the Indexed Document Profile. For example, consider a situation where you index a one-page document, and that one-page document is included as part of a 100-page document. The 100-page document is considered a 100% match because its content matches the one-page document exactly.

See “About the server and agent index files” on page 467.
Partial file contents matching only applies to server-based IDM indexes. For text-based files that are crackable, in addition to creating the MD5 fingerprint for exact file contents matching, the system uses a rolling hash algorithm to register discrete sections or passages of content. In this case the system uses a statistical sampling method to store hashed sections of content; not all text is hashed in the index. The index does not contain actual document content.

Table 20-6 lists the requirements to match file contents using IDM.

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crackable file format</td>
<td>The system must be able to crack the file format and extract file content. Data Loss Prevention supports context extraction for over 100 file types. See “Supported formats for content extraction” on page 684.</td>
</tr>
<tr>
<td>Natural file state</td>
<td>To match file contents, the source file cannot be encapsulated in an archive file when the source file is indexed. If a file in the document source is encapsulated in an archive file, the system does not index the file contents of the encapsulated file. Any encapsulated file is considered for exact matches only, like image files and other unsupported file formats. See “Do not compress files in the document source” on page 500. Note: The exception to this is the main ZIP file that contains the document data source, for those upload methods that use an archive file. See “Creating and modifying Indexed Document Profiles” on page 479.</td>
</tr>
<tr>
<td>Minimum amount of text</td>
<td>For exact file contents matching, the source file must contain at a minimum 30 characters of normalized text before the cracked content is indexed. Normalization involves the removal of punctuation and whitespaces. A normalized character therefore is either a number or a letter. This size is set by the min_normalized_size=30 parameter in the file \SymantecDLP\Protect\config\Indexer.properties. If file contents is less than 30 normalized characters, the system performs an exact file match against the file binary. For partial file contents matching, there must be at least 130 normalized characters. However, the exact length is variable depending on the file contents and encoding. See “Do not index empty documents” on page 501.</td>
</tr>
<tr>
<td>Maximum amount of text</td>
<td>The maximum size of the document that can be processed for content extraction at run-time is 30 MB. If a file is larger than this, only the first 30 MB of content is extracted for indexing. For example, consider a file that is 50 MB. During indexing an MD5 will be created for the entire 50 MB. During detection, the file would be truncated to 30 MB. Further, the text would still be extracted, assuming it can be. The result would be no match since the index only has an MD5 for the 50 MB and detection would generate fingerprints on the text and an MD5 for the first 30 MB See “Advanced server settings” on page 203.</td>
</tr>
</tbody>
</table>
About using the Content Matches Document Signature policy condition

You use the IDM condition **Content Matches Document Signature From** to implement IDM detection rules and exceptions in your policies.

See “Configuring the Content Matches Document Signature policy condition” on page 497.

When you configure this condition, you specify the IDM index to use and how the condition should match against the index using the **Minimum Document Exposure** setting. You can select either **Exact** or partial between 10% to 90%. For example, if you select 70% for the **Minimum Document Exposure**, a match occurs only if 70% or more of the hashed file contents is detected.

See “Use parallel IDM rules to tune match thresholds” on page 507.

If a file is not text-based, is not crackable, is very small, or is encapsulated in an archive file, the file is matched exactly based on its binary signature. This form of matching is performed automatically by the system, regardless of what configuration option you choose for the **Minimum Document Exposure** setting. This setting only applies to partial file contents matching.

See “Using IDM to detect exact files” on page 470.

**Table 20-7** describes the matching supported by the **Content Matches Document Signature From** policy condition.

**Table 20-7** Minimum document exposure settings for the IDM condition

<table>
<thead>
<tr>
<th>Configuration setting</th>
<th>File type</th>
<th>Match</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Exact</strong> matching</td>
<td>File contents</td>
<td>100% of the extracted and normalized file contents, if the file is text-based and crackable</td>
<td>Microsoft Word</td>
</tr>
<tr>
<td></td>
<td>S. “Using IDM to detect exact and partial file contents” on page 471.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Partial</strong> (10% to 90%)</td>
<td>File contents</td>
<td>Discrete passages of text</td>
<td>Microsoft Word</td>
</tr>
<tr>
<td></td>
<td>S. “Using IDM to detect exact and partial file contents” on page 471.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Automatic</strong></td>
<td>File</td>
<td>Binary signature of the file, if the file is not text-based or is not crackable</td>
<td>JPEG, small file, custom file, archived subfile</td>
</tr>
<tr>
<td></td>
<td>S. “Using IDM to detect exact files” on page 470.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
About using IDM for policy exceptions

You can use the IDM policy condition **Content Matches Document Signature From** as an exception to exclude specific documents from exact matching. You cannot use the IDM policy condition to except content from matching. To exclude content in documents from matching, you need to “whitelist” it.

See “About whitelisting partial file contents” on page 474.

As an example of using the IDM condition for policy exceptions, consider a data source that you index which contains JPEG files. You create a policy that contains two conditions: one rule implements a file type match condition on the JPEG file format; and an exception implements the IDM condition that references the IDM index containing JPEG files. At run-time any JPEG file detected triggers an incident, except one that matches an MD5 fingerprint in the index.

For an additional example on how to implement IDM as a policy exception, refer to the CAN-SPAM Act policy template that is included with installation of Data Loss Prevention.

See “CAN-SPAM Act policy template” on page 805.

About whitelisting partial file contents

Often sensitive documents contain standard boilerplate text that that does not require protection, including front matter, headers, and footers. Information contained in document headers and footers is likely to cause false positives. Likewise, boilerplate text, such as standard language and non-proprietary corporate content that is repeated across confidential documents, can cause false positives.

See “Whitelisting file contents to exclude from partial matching” on page 476.

Removing non-sensitive boilerplate or header/footer content before indexing is usually not feasible, especially if you have a large document data set. In this case you can configure the system to exclude (“whitelist”) non-sensitive text. You do this by adding the text to ignore to the whitelist file. During indexing, any whitelisted content found in the source files is ignored. At run-time the content will not cause false positives because it has been excluded.

See “Use whitelisting to exclude non-sensitive content from partial matching” on page 503.

**Note:** Whitelisting only applies to partial file contents matching; it does not apply to exact file contents matching. The whitelisting file is not checked at run-time when the system computes the MD5 hashes for exact file contents matching.
### Configuring IDM profiles and policy conditions

Table 20-8 provides the workflow for creating IDM profiles and configuring IDM policies. Complete the steps to ensure that your IDM rules are properly implemented and are as accurate and efficient as possible.

**Table 20-8**  Implementing IDM

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Identify the content you want to protect and collect the documents that contain this content.</td>
<td>See “Using IDM to detect exact and partial file contents” on page 471. See “Using IDM to detect exact files” on page 470.</td>
</tr>
<tr>
<td>2</td>
<td>Prepare the documents for indexing.</td>
<td>See “Preparing the document data source for indexing” on page 475.</td>
</tr>
<tr>
<td>3</td>
<td>Whitelist headers, footers, and boilerplate text.</td>
<td>See “Whitelisting file contents to exclude from partial matching” on page 476.</td>
</tr>
<tr>
<td>4</td>
<td>Create an Indexed Document Profile and specify the document source.</td>
<td>See “Creating and modifying Indexed Document Profiles” on page 479.</td>
</tr>
<tr>
<td>5</td>
<td>Configure any document source filters.</td>
<td>See “Filtering documents by file name” on page 489.</td>
</tr>
<tr>
<td>6</td>
<td>Schedule indexing as necessary.</td>
<td>See “Scheduling document profile indexing” on page 492.</td>
</tr>
<tr>
<td>7</td>
<td>Configure one ore more IDM policy conditions or exceptions.</td>
<td>See “Configuring the Content Matches Document Signature policy condition” on page 497.</td>
</tr>
<tr>
<td>8</td>
<td>Test and troubleshoot your IDM implementation.</td>
<td>See “Troubleshooting policies” on page 353.</td>
</tr>
</tbody>
</table>

### Preparing the document data source for indexing

You must collect and prepare the documents you want to index. These documents are known as the document data source.

See “About the document data source” on page 466.

A document data source is a ZIP archive file that contains the documents to index. It can also be the files stored in a file share on a local or remote computer. If you have a file share that already contains the documents you want to protect, you can reference this share in the document profile.

A document data source is a ZIP archive file that contains the documents to index. It can also be the files stored in a file share on a local or remote computer. A document data source ZIP file can contain any file type and any combination of
files. If you have a file share that already contains the documents you want to protect, you can reference this share in the document profile.

Table 20-9  Preparing the document source for indexing

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Collect all of the documents you want to protect.</td>
<td>Collect all of the documents you want to index and put them in a folder. See “About the document data source” on page 466.</td>
</tr>
<tr>
<td>2</td>
<td>Uncompress all the files you want to index.</td>
<td>The files you index should be in their natural, uncompressed state. Check the document collection to make sure none of the files are encapsulated in an archive file, such as ZIP, TAR, or RAR. If a file is embedded in an archive file, extract the source file from the archive file and remove the archive file. See “Using IDM to detect exact and partial file contents” on page 471.</td>
</tr>
<tr>
<td>3</td>
<td>Separate the documents if you have more than 2 GB to index.</td>
<td>To protect a large amount of content and files, create separate collections for each set of documents over 2 GB in size, with all files in their natural, uncompressed state. For example, if you have 3 GB of documents you want to index, separate the files by folders, one folder containing 2 GB of data, and another folder containing the remaining 1 GB of data. See “Create separate profiles to index large document sources” on page 505.</td>
</tr>
<tr>
<td>4</td>
<td>Decide how you are going to make the document source files available to the Enforce Server.</td>
<td>The indexing process is a separate process that runs on the Enforce Server. To index the document source you must make the files accessible to the Enforce Server. You have several options. Decide which one works best for your needs and proceeding accordingly. See “Uploading a document archive to the Enforce Server” on page 482. See “Referencing a document archive on the Enforce Server” on page 483. See “Using local path on Enforce Server” on page 485. See “Using the remote SMB share option to index file shares” on page 486.</td>
</tr>
<tr>
<td>5</td>
<td>Configure the document profile.</td>
<td>The next step is to configure the document profile, or, alternatively, if you want to exclude specific document content from detection, whitelist it. See “Creating and modifying Indexed Document Profiles” on page 479. See “Whitelisting file contents to exclude from partial matching” on page 476.</td>
</tr>
</tbody>
</table>

Whitelisting file contents to exclude from partial matching

You use whitelisting to exclude unimportant or noncritical content, such as standard boilerplate text, document headers and footers, from the IDM index. Whitelisting such content helps to reduce false positives.

See “About whitelisting partial file contents” on page 474.
See “Use whitelisting to exclude non-sensitive content from partial matching” on page 503.

To exclude content from matching, you copy the content you want to exclude to a text file and save the file as Whitelisted.txt. By default, the file must contain at least 130 non-whitespace characters to have its content fingerprinted for whitelisting purposes. When you index the document source, the Enforce Server looks for the Whitelisted.txt file.

See “Use whitelisting to exclude non-sensitive content from partial matching” on page 503.

Table 20-10 describes the process for excluding document content using whitelisting.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Copy the content you want to exclude from matching into a text file.</td>
<td>Copy only noncritical content you want to exclude, such as standard boilerplate text and document headers and footers, to the text file. By default, for file contents matching the file to be indexed must contain at least 130 characters. This default setting applies to the Whitelisted.txt file as well. For whitelisted text you can change this default setting. See “Changing the default indexer properties” on page 493.</td>
</tr>
<tr>
<td>2</td>
<td>Save the text file as Whitelisted.txt.</td>
<td>The Whitelisted.txt file is the source file for storing content you want to exclude from matching.</td>
</tr>
<tr>
<td>3</td>
<td>Save the file to the whitelisted directory on the Enforce Server host file system.</td>
<td>Save the file to \SymantecDLP\Protect\documentprofiles\whitelisted (on Windows) or /var/SymantecDLP/documentprofiles/whitelisted (on Linux).</td>
</tr>
<tr>
<td>4</td>
<td>Configure the Indexed Document Profile and generate the index.</td>
<td>When you index the document data source, the Enforce Server looks for the Whitelisted.txt file. If the file exists, the Enforce Server copies it to Whitelisted.x.txt, where x is a unique identification number corresponding to the Indexed Document Profile. Future indexing of the profile uses the profile-specific Whitelisted.x.txt file, not the generic Whitelisted.txt file. See “Creating and modifying Indexed Document Profiles” on page 479.</td>
</tr>
</tbody>
</table>

Manage and add Indexed Document Profiles

The Manage > Data Profiles > Indexed Documents screen lists all configured Indexed Document Profiles in the system. From this screen you can manage existing profiles and add new ones.
### Table 20-11  Indexed Documents screen actions

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add IDM profile</td>
<td>Click <strong>Add Document Profile</strong> to create a new Indexed Document Profile.</td>
</tr>
<tr>
<td></td>
<td>See &quot;Configuring IDM profiles and policy conditions&quot; on page 475.</td>
</tr>
<tr>
<td>Edit IDM profile</td>
<td>Click the name of the Document Profile, or click the pencil icon to the far right of the profile, to modify an existing Document Profile.</td>
</tr>
<tr>
<td></td>
<td>See “Creating and modifying Indexed Document Profiles” on page 479.</td>
</tr>
<tr>
<td>Remove IDM profile</td>
<td>Click the red X icon next to the far right of the document profile row to delete that profile from the system. A dialog box confirms the deletion.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You cannot edit or remove a profile if another user currently modifies that profile, or if a policy exists that depends on that profile.</td>
</tr>
<tr>
<td>Refresh IDM profile status</td>
<td>Click the refresh arrow icon at the upper right of the Indexed Documents screen to fetch the latest status of the indexing process. If you are in the process of indexing, the system displays the message &quot;Indexing is starting.&quot; The system does not automatically update the screen when the indexing process is complete.</td>
</tr>
</tbody>
</table>

### Table 20-12  Indexed Documents screen details

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document Profile</td>
<td>The name of the Indexed Document Profile.</td>
</tr>
<tr>
<td>Detection server</td>
<td>The name of the detection server that indexes the Document Profile and the Document Profile version.</td>
</tr>
<tr>
<td>Location</td>
<td>The location of the file(s) on the Enforce Server that the system has profiled and indexed.</td>
</tr>
<tr>
<td>Documents</td>
<td>The number of documents that the system has indexed for the document profile.</td>
</tr>
</tbody>
</table>
### Table 20-12  Indexed Documents screen details (continued)

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>The current status of the document indexing process, which can be any of the following:</td>
</tr>
<tr>
<td></td>
<td>■ Next scheduled indexing (if it is not currently indexing)</td>
</tr>
<tr>
<td></td>
<td>■ Sending an index to a detection server</td>
</tr>
<tr>
<td></td>
<td>■ Indexing</td>
</tr>
<tr>
<td></td>
<td>■ Deploying to a detection server</td>
</tr>
<tr>
<td></td>
<td>In addition, beneath the status of the indexing process, the system displays the status of each detection server, which can be any of the following:</td>
</tr>
<tr>
<td></td>
<td>■ Completed, including a completion date</td>
</tr>
<tr>
<td></td>
<td>■ Pending index completion (that is, waiting for the Enforce Server to finish indexing a file)</td>
</tr>
<tr>
<td></td>
<td>■ Replicating indexing</td>
</tr>
<tr>
<td></td>
<td>■ Creating index (internally)</td>
</tr>
<tr>
<td></td>
<td>■ Building caches</td>
</tr>
<tr>
<td>Error messages</td>
<td>The Indexed Document screen also displays any error messages in red (for example, if the document profile is corrupted or does not exist).</td>
</tr>
</tbody>
</table>

See “Data Profiles” on page 291.

See “Scheduling document profile indexing” on page 492.

See “Configuring the Content Matches Document Signature policy condition” on page 497.

### Creating and modifying Indexed Document Profiles

You define and configure an Indexed Document Profile at the screen Manage > Data Profiles > Indexed Documents > Configure Document Profile. The document profile specifies the document data source, the indexing parameters, and the indexing schedule. You must define a document profile to implement IDM detection.

See “About the Indexed Document Profile” on page 465.

Table 20-13 describes the steps for creating and modifying IDM profiles.
<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1 | Navigate to the screen **Manage > Data Profiles > Indexed Documents**. | You must be logged on to the Enforce Server administration console as an administrator or policy author.  
See “Policy authoring privileges” on page 290. |
| 2 | Click **Add Document Profile**. | Select an existing **Indexed Document Profile** to edit it.  
See “Manage and add Indexed Document Profiles” on page 477. |
| 3 | Enter a **Name** for the Document Profile. | Choose a name that describes the data content and the index type (for example, "Research Docs IDM"). The name is limited to 255 characters.  
See “Input character limits for policy configuration” on page 344. |
### Table 20-13  Configuring a document profile (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| 4    | Select the **Document Source** method for indexing. | Select one of the four options for indexing the document data source, depending on how large your data source is and how you have packaged it.  

See “About the document data source” on page 466.  

Options for making the data source available to the Enforce Server.  

- **Upload Document Archive to Server Now**  
  To use this method, you **Browse** and select a ZIP file containing the documents to be indexed. The maximum size of the ZIP file is 50 MB.  
  See “Uploading a document archive to the Enforce Server” on page 482.  

- **Reference Archive on Enforce Server**  
  Use this method if you have copied the ZIP file to the file system host where the Enforce Server is installed. The maximum size of the ZIP file is 2 GB. This ZIP file is available for selection in the drop-down field.  
  See “Referencing a document archive on the Enforce Server” on page 483.  

- **Use Local Path on Enforce Server**  
  This method lets you index individual files that are local to the Enforce Server. With this method the files to be indexed cannot be archived in a ZIP file. The maximum size of the documents that can be indexed is 2 GB.  
  See “Using local path on Enforce Server” on page 485.  

- **Use Remote SMB Share**  
  See “About indexing remote documents” on page 467.  
  See “Using the remote SMB share option to index file shares” on page 486.  
  See “Using the remote SMB share option to index SharePoint documents” on page 487.
Table 20-13  Configuring a document profile (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| 5    | Optionally, configure any Filters. | You can specify file name and file size filters in the document profile. The filters tell the system which files to include or ignore during indexing.  
See “Filter documents from indexing to reduce false positives” on page 504.  
Enter files to include in the File Name Include Filters field, or enter files to exclude in the File Name Exclude Filters field.  
See “Filtering documents by file name” on page 489.  
Select file sizes to ignore, either Ignore Files Smaller Than or Ignore Files Larger Than.  
See “Filtering documents by file size” on page 491. |
| 6    | Select one of the Indexing options. | As part of creating a document profile, you can set up a schedule for indexing the document source.  
You do not have to select an indexing option to create a profile that you can reference in a policy, but you must select an indexing option to generate the index and actually detect matches using an IDM policy.  
Select Submit Indexing Job on Save to index the document source immediately on save of the Document Profile.  
Select Submit Indexing Job on Schedule to display schedule options so that you can schedule indexing at a later time.  
See “Scheduling document profile indexing” on page 492. |
| 7    | Click Save. | You must save the document profile. |

Uploading a document archive to the Enforce Server

The Upload Document Archive to Server Now option lets you upload a ZIP file with a maximum size of 50 MB to the Enforce Server and index its contents. To use this method of indexing, the document source must meet the requirements described in the table Table 20-14.

To upload the document archive to Enforce Server describes the process for using the Upload Document Archive to Server Now method of indexing.
To upload the document archive to Enforce Server

1. Navigate to the screen Manage > Data Profiles > Indexed Documents > Configure Document Profile.

2. Select the option **Upload Document Archive to Server Now**.
   
   Click **Browse** and select the ZIP file. The ZIP file can be anywhere on the same network as the Enforce Server.

   Optionally, you can type the full path and the file name if the ZIP file is local to the Enforce Server, for example: `c:\Documents\Research.zip`.

3. Specify one or more file name or file size filters (optional).
   
   See “Filtering documents by file name” on page 489.

4. Select one of the indexing options (optional).
   
   See “Scheduling document profile indexing” on page 492.

5. Click **Save**.

**Table 20-14** Requirements for using the Upload Document Archive to Server Now option

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ZIP file only</td>
<td>The document archive must be a ZIP file; no other encapsulation formats are supported for this option.</td>
</tr>
<tr>
<td>50 MB or less</td>
<td>You cannot use this option if the document archive ZIP file is more than 50 MB because files exceeding that size limit can take too long to upload and slow the performance of the Enforce Server. If the document archive ZIP file is over 50 MB, use the <strong>Reference Archive on Enforce Server</strong> method instead.</td>
</tr>
</tbody>
</table>
| UTF-8 file names only        | The IDM indexing process fails (and presents you with an "unexpected error") if the document archive (ZIP file) contains non-ASCII file names in encodings other that UTF-8. If the ZIP file contains files with non-ASCII file names, use either of the following options instead to make the files available to the Enforce Server for indexing:  
  - Use Local Path on Enforce Server  
  - Use Remote SMB Share |

**Referencing a document archive on the Enforce Server**

You use the **Reference Archive on Enforce Server** option to create an IDM index based on a ZIP file that is local to the Enforce Server. You use this option to index source documents that are archived in a ZIP file that is larger than 50 MB.

See “About the document data source” on page 466.
Note: If the ZIP file is less than 50 MB, you can use the **Upload Document Archive to Server Now** option instead. See "Uploading a document archive to the Enforce Server" on page 482.

To use the **Reference Archive on Enforce Server** option, you copy the ZIP file to the `\SymantecDLP\Protect\documentprofiles` folder on the Enforce Server file system host. Once you have copied the ZIP file to the Enforce Server, you can select the document source from the pull-down menu at the **Add Document Profile** screen. See “Creating and modifying Indexed Document Profiles” on page 479.

**To reference the document archive on the Enforce Server** describes the procedure for using the **Reference Archive on Enforce Server** option.

**To reference the document archive on the Enforce Server**

1. Copy the ZIP file to the Enforce Server.
   - On Windows, copy the ZIP file to directory `\SymantecDLP\Protect\documentprofiles`
   - On Linux, copy the ZIP file to directory `/var/SymatnecDLP/documentprofiles`

   See Table 20-15 on page 485.

   **Note:** The system deletes the document data source file after the indexing process completes.

2. Log on to the Enforce Server administration console.
3. Navigate to the screen **Manage > Data Profiles > Indexed Documents > Configure Document Profile**.
4. Select the file from the **Reference Archive on Enforce Server** pull-down menu.

   **Note:** A document source currently referenced by another **Indexed Document Profile** does not appear in the list.

5. Specify one or more file name or file size filters (optional).

   See "Filtering documents by file name" on page 489.
6 Select one of the indexing options (optional).

See “Scheduling document profile indexing” on page 492.

7 Click Save to save the document profile.

Table 20-15 Requirements to use the option Reference Archive on Enforce Server

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ZIP file only</td>
<td>The document archive must be a ZIP file; no other encapsulation formats are supported for this option.</td>
</tr>
<tr>
<td>2 GB or less</td>
<td>2 GB is the maximum file size of the IDM profile. Consider using a third-party solution (such as Secure FTP), to copy the ZIP file securely to the Enforce Server. See “About the document data source” on page 466.</td>
</tr>
<tr>
<td>Subfiles not archived</td>
<td>Make sure the subfiles are proper and not encapsulated in an archive (other than the top-level profile archive). See “Do not compress files in the document source” on page 500. See “Do not index empty documents” on page 501.</td>
</tr>
</tbody>
</table>
| UTF-8 file names only    | Do not use this method if any of the names of the files you are indexing contain non-ASCII file names. Use either of the following options instead:  
  ■ Use Local Path on Enforce Server  
    See “Using local path on Enforce Server” on page 485.  
  ■ Use Remote SMB Share  
    See “Using the remote SMB share option to index file shares” on page 486. |

Using local path on Enforce Server

The Use Local Path on Enforce Server method lets you index individual files that are local to the Enforce Server. With this method the files to be indexed cannot be archived in a ZIP file. The system deletes the documents after the indexing process completes.

See “Creating and modifying Indexed Document Profiles” on page 479.

To use the Use Local Path on Enforce Server method of making the document source available to the Enforce Server for indexing, you enter the local path to the directory that contains the documents to index. For example, if you copied the files to the file system at directory C:\Documents, you would enter C:\Documents in the field for the Use Local Path on Enforce Server option. You must specify the exact path, not a relative path. Do not include the actual file names in the path.
Using the remote SMB share option to index file shares

The **Use Remote SMB Share** method lets you index documents remotely using the Common Internet File System (CIFS) protocol. To use this method of making the document source available to the Enforce Server, you enter the Universal Naming Convention (UNC) path for the Server Message Block (SMB) share that contains the documents to index.

See “About indexing remote documents” on page 467.

See “To index remote documents on file shares using CIFS” on page 486. provides the steps for using CIFS to index remote documents.

Note: Symantec Data Loss Prevention does not delete documents after indexing when you use the **Use Remote SMB Share** option.

To index remote documents on file shares using CIFS

1. Log on to the Enforce Server administration console.
2. Navigate to the screen **Manage > Data Profiles > Indexed Documents > Configure Document Profile**.
3. Select the option **Use Remote SMB Share**.
4. Enter the **UNC Path** for the SMB share that contains the documents to index.
   
   A UNC path consists of a server name, a share name, and an optional file path, for example: `\server\share\file_path`.
5. Enter a valid user name and password for the share, and then re-enter the password. The user you specify must have general access to the shared drive and read permissions for the constituent files.

   Optionally, you can **Use Saved Credentials**, in which case the credentials are available from the pull-down menu.

   See “About the credential store” on page 131.
6. Complete the configuration of the **Indexed Document Profile**.

   See “Creating and modifying Indexed Document Profiles” on page 479.
Using the remote SMB share option to index SharePoint documents

To remotely index files on SharePoint, you expose the remote file share using WebDAV. Once you have enabled WebDAV for SharePoint, you use the Use Remote SMB Share option and enter the UNC path to index the remote documents. Symantec Data Loss Prevention supports remote IDM indexing using WebDAV for SharePoint 2007 and SharePoint 2010 instances.

See “About indexing remote documents” on page 467.

Table 20-16 provides the procedure for remotely indexing SharePoint documents using WebDAV

<table>
<thead>
<tr>
<th>Step</th>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Enable WebDAV for SharePoint.</td>
<td>See “Enabling WebDAV for Microsoft IIS” on page 488.</td>
</tr>
<tr>
<td>2</td>
<td>Start the WebClient service.</td>
<td>From the computer where the Enforce Server is installed, start the WebClient service using the &quot;Services&quot; console. If this service is &quot;disabled,&quot; right-click it and select Properties. Enable the service, set it to Manual, then Start it. Note: You must have administrative privileges to enable this service.</td>
</tr>
<tr>
<td>3</td>
<td>Access the SharePoint instance.</td>
<td>From the computer where your Enforce Server is installed, access SharePoint using your browser and the following address format: http://&lt;server_name&gt;:port For example: <a href="http://protect-x64:80">http://protect-x64:80</a></td>
</tr>
<tr>
<td>4</td>
<td>Log on to SharePoint as an authorized user.</td>
<td>You do not need to have SharePoint administrative privileges.</td>
</tr>
<tr>
<td>5</td>
<td>Locate the documents to scan.</td>
<td>In SharePoint, navigate to the documents you want to scan. Often SharePoint documents are stored at the Home &gt; Shared Documents screen. Your documents may be stored in a different location.</td>
</tr>
<tr>
<td>6</td>
<td>Find the UNC path for the documents.</td>
<td>In SharePoint for the documents you want to scan, select the option Library &gt; Open with Explorer. Windows Explorer should open a window and display the documents. Look in the Address field for the path to the documents. This address is the UNC path you need to scan the documents remotely. For example: \protect-x64\Shared Documents. Copy this path to the Clipboard or a text file.</td>
</tr>
<tr>
<td>7</td>
<td>Create the IDM Index.</td>
<td>See “Creating and modifying Indexed Document Profiles” on page 479.</td>
</tr>
</tbody>
</table>
Table 20-16  Remote IDM Indexing of SharePoint documents (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
</table>
| 8    | Configure the SharePoint remote indexing source. | To configure the remote indexing source:  
- For the **Document Source** field, select the **Use Remote SMB Share** option.  
- For the **UNC Path**, paste (or enter) the address you copied from the previous step. For example: `\protect-x64\Shared Documents`.  
- For the **User Credentials**, enter your SharePoint user name and password, or select the same from the **Saved Credentials** drop-down list.  
- Select the option **Submit Indexing on Save** and click **Save**. |
| 9    | Verify success.                          | At the **Manage > Data Profiles > Indexed Documents** screen you should see that the index was successfully created. Check the "Status" and the number of documents indexed. If the index was successfully created you can now use it to create IDM policies. See “Troubleshooting SharePoint document indexing” on page 489. |

**Enabling WebDAV for Microsoft IIS**

There are various methods for enabling WebDAV for IIS. The following steps provide one approach, in this case for a Windows Server 2008 R2. This approach is provided as an example only. Your approach and environment may differ.

Microsoft IIS deployments that host SharePoint instances can be enabled to accept WebDAV connections from web clients.

See “Using the remote SMB share option to index SharePoint documents” on page 487.

**Enable WebDAV for SharePoint**

1. Log on to the SharePoint system where you want to enable WebDAV.
2. Open the Internet Information Services (IIS) Manager console.
3. Select the server name in the IIS tree.
4. Expand the tree, click the **Web Sites** folder and expand it.
5. Select the SharePoint instance from the list.
6. Right-click the SharePoint instance and select **New > Virtual Directory**.
7. The Virtual Directory Creation Wizard will appear. Click **Next**.
8. Enter a name in the **Alias** field (such as "WebDAV") and click **Next**.
9. Enter a directory path in the **Web Site Content Directory** field. It can be any directory path as long as it exists. Click **Next**.
Select **Read access** and click **Next**.

Click **Finish**.

Right-click the virtual directory that you created and select **Properties**.

In the **Virtual Directory** tab, select the option "A redirection to a URL" and click **Create**. The alias name is populated in the **Application Name** field.

Enter the SharePoint site URL in the "Redirect to" field and click **OK**. WebDAV is now enabled for this SharePoint instance.

**Troubleshooting SharePoint document indexing**

If you cannot connect the Enforce Server computer to the SharePoint Server computer after enabling WebDAV, make sure that you have started the WebClient service on the Enforce Server computer. You must start this service and test the WebDAV connection before you configure IDM indexing.

See "Using the remote SMB share option to index SharePoint documents" on page 487.

If you plan to re-index SharePoint documents periodically as they are updated, it may be useful to map the remote network resource to the local computer where the Enforce Server is installed. You can use the "net use" MS-DOS command to map SharePoint using the UNC path. For example:

- **net use**
  This command without parameters retrieves and displays a list of network connections.

- **net use s: \sharepoint_server\Shared Documents**
  This command assigns (maps) the SharePoint server to the local "S" drive.

- **net use * \sharepoint_server\Shared Documents**
  This command assigns (maps) the SharePoint server to the next available letter drive.

- **net use s: /delete**
  This command removes the network mapping to the specified drive.

**Filtering documents by file name**

When you configure an Indexed Document Profile, you have the option of using filters to include or exclude documents in your data source from being indexed. There are two types of file name filters: File Name Include Filters and File Name Exclude Filters. Symantec recommends that if you choose to use file name filters you select either inclusion filters or exclusion filters, but not both.
See “Filter documents from indexing to reduce false positives” on page 504. Table 20-17 describes the differences between the include and exclude filters for file names.

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File Name Include Filters</strong></td>
<td>If the File Name Include Filters field is empty, matching is performed on all documents in the document profile. If you enter anything in the File Name Include Filters field, it is treated as an inclusion filter. In this case the document is indexed only if it matches the filter you specify. For example, if you enter *.docx in the File Name Include Filters field, the system will index only the *.docx files in the document source.</td>
</tr>
<tr>
<td><strong>File Name Exclude Filters</strong></td>
<td>The Exclude Filters field lets you specify the documents to exclude in the matching process. If you leave the Exclude Filters field empty, the system performs matching on all documents in the ZIP file or file share. If you enter any values in the field, the system scans only those documents that do not match the filter.</td>
</tr>
</tbody>
</table>

The system treats forward slashes (/) and backslashes (\) as equivalent. The system ignores whitespace at the beginning or end of the pattern. File name filtering does not support escape characters, so you cannot match on literal question marks, commas, or asterisks. Table 20-18 describes the syntax accepted by the **File Name Filters** feature. The syntax for the Include and Exclude filters is the same.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asterisk (*)</td>
<td>Represents any number of characters.</td>
</tr>
<tr>
<td>Question mark (?)</td>
<td>Represents a single character.</td>
</tr>
<tr>
<td>Comma (,) and newline</td>
<td>Represents a logical OR.</td>
</tr>
</tbody>
</table>

Table 20-19 provides sample filters and descriptions of behavior if you enter them in the **File Name Include Filters** field:
### File name filter examples

<table>
<thead>
<tr>
<th>Filter string</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>.txt,</em>.*docx</td>
<td>The system indexes only .txt and .docx files in the ZIP file or file share, ignoring everything else.</td>
</tr>
<tr>
<td>??????.docx</td>
<td>The system indexes files with the .docx extension and files with five-character names, such as hello.docx and stats.docx, but not good.docx or marketing.docx.</td>
</tr>
<tr>
<td><em>/documentation/</em>,<em>/specs/</em></td>
<td>The system indexes only files in two subdirectories below the root directory, one called &quot;documentation&quot; and the other called &quot;specs.&quot;</td>
</tr>
</tbody>
</table>

**Example with wildcards and sub-directories:**

*\scan_dir\l*.txt

IDM indexing fails or ignores the filter setting if the File Name Includes / Excludes filter string starts with an alphanumeric character and includes a wildcard, for example: l*.txt. The workaround is to configure the include/exclude filter with the filter string as indicated in this example, that is, *\scan_dir\l*.txt.

For example, the filter l*.txt does not work for a file path \dlp.symantec.com\scan_dir\lincoln-LyceumAddress.txt. However, if the filter is configured as *\scan_dir\l*.txt, the indexer will acknowledge the filter and index the file.

## Filtering documents by file size

Filters let you specify documents to include or exclude from indexing. The types of filters include File Name Include Filters, File Name Exclude Filters, and File Size Filters. You use file size filters to exclude files from the matching process based on their size. Any files that match the size filters are ignored.

See “Filtering documents by file name” on page 489.

In the **Size Filters** fields, specify any restrictions on the size of files the system should index. In general you should use only one type of file size filter.

See “Filter documents from indexing to reduce false positives” on page 504.

Table 20-20 describes the file size filter options.
Table 20-20 File size filter configuration options

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ignore Files Smaller Than</td>
<td>To exclude files smaller than a particular size:</td>
</tr>
<tr>
<td></td>
<td>- Enter a number in the field for Ignore Files Smaller Than.</td>
</tr>
<tr>
<td></td>
<td>- Select the appropriate unit of measure Bytes, KB (kilobytes), or MB (megabytes) from the drop-down list.</td>
</tr>
<tr>
<td></td>
<td>For example, to prevent indexing of files smaller than one kilobyte (1 KB), enter 1 in the field and select KB from the corresponding drop-down list.</td>
</tr>
<tr>
<td>Ignore Files Larger Than</td>
<td>To exclude files larger than a particular size:</td>
</tr>
<tr>
<td></td>
<td>- Enter a number in the field for Ignore Files Larger Than.</td>
</tr>
<tr>
<td></td>
<td>- Select the appropriate unit of measure (Bytes, KB, or MB) from the drop-down list.</td>
</tr>
<tr>
<td></td>
<td>For example, to prevent indexing of files larger than two megabytes (2 MB), enter 2 in the field and select MB from the corresponding drop-down list.</td>
</tr>
</tbody>
</table>

Scheduling document profile indexing

When you configure a document profile, select Submit Indexing Job on Save to index the document profile as soon as you save it. Alternatively, you can set up a schedule for indexing the document source.

To schedule document indexing, select Submit Indexing Job on Schedule and select a schedule from the drop-down list as described in Table 20-21.

Note: The Enforce Server can index only one document profile at a time. If one indexing process is scheduled to start while another indexing process is running, the new process does not begin until the first process completes.

Table 20-21 Options for scheduling Document Profile indexing

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index Once</td>
<td>On – Enter the date to index the document profile in the format MM/DD/YY. You can also click the date widget and select a date.</td>
</tr>
<tr>
<td></td>
<td>At – Select the hour to start indexing.</td>
</tr>
<tr>
<td>Index Daily</td>
<td>At – Select the hour to start indexing.</td>
</tr>
<tr>
<td></td>
<td>Until – Select this check box to specify a date in the format MM/DD/YY when the indexing should stop. You can also click the date widget and select a date.</td>
</tr>
</tbody>
</table>
### Table 20-21 Options for scheduling Document Profile indexing (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Index Weekly</strong></td>
<td><strong>Day of the week</strong> – Select the day(s) to index the document.</td>
</tr>
<tr>
<td></td>
<td><strong>At</strong> – Select the hour to start indexing.</td>
</tr>
<tr>
<td></td>
<td><strong>Until</strong> – Select this check box to specify a date in the format MM/DD/YY when the indexing should stop. You can also click the date widget and select a date.</td>
</tr>
<tr>
<td><strong>Index Monthly</strong></td>
<td><strong>Day</strong> – Enter the number of the day of each month you want the indexing to occur. The number must be 1 through 28.</td>
</tr>
<tr>
<td></td>
<td><strong>At</strong> – Select the hour to start indexing.</td>
</tr>
<tr>
<td></td>
<td><strong>Until</strong> – Select this check box to specify a date in the format MM/DD/YY when the indexing should stop. You can also click the date widget and select a date.</td>
</tr>
</tbody>
</table>

### Changing the default indexer properties

The server index contains the MD5 fingerprint of each file that has been indexed, either raw binary or 100% extracted content if the file can be cracked, and hashes of discrete passages of content.

See "Using IDM to detect exact and partial file contents" on page 471.

The size of the passages depends on the "k" and "t" settings in the indexer properties file (`\SymantecDLP\Protect\config\indexer.properties`). Generally, there is no need to change the default settings. When you lower the default minimum, the Enforce Server creates hashes out of smaller sections of the documents it indexes. The lower the default minimum, the greater the number of hashes that the Enforce Server requires for your documents. The greater number of hashes increases index size as well as computational load during detection.

The default settings apply to the `Whitelisted.txt` file as well. If the amount of content you need to whitelist is less than the minimum amount required for partial matching, you can adjust the default minimum setting.

**To change the default minimum for whitelisted text**

1. On the Symantec Data Loss Prevention host, navigate to directory `\SymantecDLP\Protect\config` on Windows, or `/opt/SymantecDLP/Protect/config` on Linux.

2. Use a text editor to open file `Indexer.properties`

3. Locate the parameter `Guarantee threshold t`:
   
   ```
   # Guarantee threshold t
   com.vontu.profiles.documents.t=130
   ```
4  Change the numerical portion of the parameter value to reflect the wanted minimum number of characters that are allowed in Whitelisted.txt.

For example, to change the minimum to 80 characters, modify the value to look like the following:

```
# Guarantee threshold t
com.vontu.profiles.documents.t=80
```

5  Save the file.

In addition, the maximum size that can be processed for content extraction at run-time is 30 MB and is set by the `max_bin_match_size=30000000` parameter. Increasing this number is not recommended.

Using agent IDM after upgrade to version 12.5

For upgrades to Symantec Data Loss Prevention version 12.5, exact match IDM is disabled and two-tier detection is the default setting. This means that if you take no action after upgrade your IDM policies will continue to use two-tier detection for endpoint deployments.

To use exact match IDM on the endpoint after upgrade, you must enable it and reindex the document data source. Reindexing is required even if the data source is unchanged so that the endpoint indexes are generated.

Table 20-22 describes the workflow for implementing agent IDM for customers upgrading to version 12.5.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1    | Upgrade Data Loss Prevention to version 12.5. | You must upgrade the Enforce Server and Endpoint Servers to version 12.5.  
Refer to the Symantec Data Loss Prevention Upgrade Guide. |
| 2    | Reindex existing IDM profiles. | To use agent IDM you must update each Indexed Document Profiles so that the endpoint index is generated.  
See "Reindex IDM profiles after major upgrade" on page 500.  
See "Creating and modifying Indexed Document Profiles" on page 479. |
Table 20-22 Using agent IDM after upgrade to version 12.5 (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Upgrade DLP Agent to version 12.5.</td>
<td>To use exact match IDM on the endpoint you must upgrade the DLP Agent to version 12.5. Refer to the Symantec Data Loss Prevention Upgrade Guide. <strong>Note:</strong> During the upgrade process, you may have a period where you have both 12.5 DLP Agents and 12.0.x and earlier DLP Agents. If this is the case, consider segregating 12.5 DLP Agents from 12.0.x and earlier DLP Agents using different Endpoint Servers so that you can use two-tier detection for the former and agent IDM for the latter.</td>
</tr>
<tr>
<td>4</td>
<td>Enable agent IDM.</td>
<td>Agent IDM is disabled for an Endpoint Server upgraded to version 12.5. To use agent IDM you must enable it. See “Enabling agent IDM” on page 495.</td>
</tr>
<tr>
<td>5</td>
<td>Apply the configuration to DLP Agents.</td>
<td>Apply the agent configuration settings to DLP Agents. See “Applying agent configurations to an agent group” on page 1441. Once the configuration is applied, the DLP Agent will download the endpoint index from the Endpoint Server the next time the agent connects.</td>
</tr>
<tr>
<td>5</td>
<td>Test IDM policies.</td>
<td>It is recommended that you test your IDM policies after you have upgraded the system and updated the IDM profiles.</td>
</tr>
</tbody>
</table>

Enabling agent IDM

You enable exact match IDM on the endpoint by setting the advanced agent configuration parameter Detection.TWO_TIER_IDM_ENABLED.str to OFF. Once two-tier detection is OFF, the DLP Agent performs exact file and exact file contents matching, assuming you have generated the endpoint index.

See “Creating and modifying Indexed Document Profiles” on page 479.

For new installations, exact match IDM on the endpoint is the default setting for the default endpoint agent configuration (TWO_TIER_IDM_ENABLED = OFF); you do not need to enable it.

For upgraded systems, exact match IDM on the endpoint is disabled (TWO_TIER_IDM_ENABLED = ON) so that there is no change in functionality for existing IDM policies deployed to the endpoint. If you want to use exact match IDM on the endpoint after upgrade, you need to turn off two-tier detection and reindex each document data source.

See “Using agent IDM after upgrade to version 12.5” on page 494.
See “To turn two-tier detection on or off” on page 496. provides steps for enabling and disabling exact match IDM on the endpoint.

To turn two-tier detection on or off

1. Log on to the Enforce Server administration console.
2. Navigate to **System > Agents > Agent Configuration**.
3. Select the applicable agent configuration.
4. Select the **Advanced Agent Settings** tab.
5. Locate the **Detection.TWO_TIER_IDM_ENABLED.str** parameter.
6. Change the value to either "ON" or "OFF" (case insensitive) depending on your requirements.
   See Table 20-23 on page 496.
7. Click **Save** at the top of the page to save the changes.
8. Apply the agent configuration to the agent group or groups.
   See “Applying agent configurations to an agent group” on page 1441.

<table>
<thead>
<tr>
<th>Advance Agent Setting parameter</th>
<th>Value</th>
<th>Default</th>
<th>Detection engine</th>
<th>Matching type</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Detection.TWO_TIER_IDM_ENABLED.str</strong></td>
<td><strong>OFF</strong></td>
<td><strong>New 12.5 installation</strong></td>
<td><strong>DLP Agent</strong></td>
<td>Exact file</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Exact file contents</td>
</tr>
<tr>
<td></td>
<td><strong>ON</strong></td>
<td><strong>System upgrade to 12.5</strong></td>
<td><strong>Endpoint Server</strong></td>
<td>Exact file</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Exact file contents</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Partial file contents</td>
</tr>
</tbody>
</table>

### Estimating endpoint memory use for agent IDM

The endpoint index is small because it only contains MD5 hashes of each file or exact file contents; it does not contain hashes for partial file contents matching. Nonetheless, you should be aware of estimated endpoint memory requirements for DLP Agents that will perform exact IDM locally.

See “About the server and agent index files” on page 467.

The following tables provide some guidance around memory usage on the endpoint for an IDM index deployed there.
Table 20-24  DLP Agent for Windows 32-bit

<table>
<thead>
<tr>
<th>Number of files indexed</th>
<th>Total Memory (KB)</th>
<th>Memory per file (bytes)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1503</td>
<td>172</td>
<td>117</td>
</tr>
<tr>
<td>3154</td>
<td>436</td>
<td>141</td>
</tr>
<tr>
<td>5787</td>
<td>584</td>
<td>103</td>
</tr>
<tr>
<td>10000</td>
<td>956</td>
<td>97</td>
</tr>
<tr>
<td>17621</td>
<td>1820</td>
<td>105</td>
</tr>
</tbody>
</table>

When the same number of files are indexed and the endpoint index is deployed to a 64-bit DLP Agent for Windows, there is different memory consumption on the endpoint than for 32-bit DLP Agents. This difference has to do with the way memory is used on 32-bit systems versus 64-bit systems. The memory usage on 64-bit systems is not exactly double that of 32-bit systems because of the way the index is stored.

Table 20-25  DLP Agent for Windows 64-bit

<table>
<thead>
<tr>
<th>Number of files indexed</th>
<th>Total Memory (KB)</th>
<th>Memory per file (bytes)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1503</td>
<td>244</td>
<td>166</td>
</tr>
<tr>
<td>3154</td>
<td>648</td>
<td>210</td>
</tr>
<tr>
<td>5787</td>
<td>864</td>
<td>152</td>
</tr>
<tr>
<td>10000</td>
<td>1416</td>
<td>144</td>
</tr>
<tr>
<td>17621</td>
<td>2636</td>
<td>153</td>
</tr>
</tbody>
</table>

Configuring the Content Matches Document Signature policy condition

The **Content Matches Document Signature From** matches unstructured document content based on the Indexed Document Profile. The **Content Matches Document Signature From** condition is available for detection rules and exceptions.

See "About using the Content Matches Document Signature policy condition" on page 473.
To configure the Content Matches Document Signature condition

1. Add an IDM condition to a policy rule or exception, or modify an existing one.
   See “Configuring policies” on page 326.
   See “Configuring policy rules” on page 330.
   See “Configuring policy exceptions” on page 340.

2. Configure the IDM condition parameters.
   See Table 20-26 on page 498.

3. Save the policy configuration.

### Table 20-26  Content Matches Document Signature condition parameters

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set the Minimum Document Exposure.</td>
<td>Select an option from the drop-down list.</td>
</tr>
<tr>
<td></td>
<td>Choose <strong>Exact</strong> to match document contents exactly.</td>
</tr>
<tr>
<td></td>
<td>Choose a percentage between 10% and 90% to match document contents partially.</td>
</tr>
<tr>
<td>Configure Match Counting.</td>
<td>Select how you want to count matches:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Check for existence</strong></td>
</tr>
<tr>
<td></td>
<td>Reports a match count of 1 if there are one or more condition matches.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Count all matches</strong></td>
</tr>
<tr>
<td></td>
<td>Reports a match count of the exact number of matches.</td>
</tr>
<tr>
<td></td>
<td>See “Configuring match counting” on page 334.</td>
</tr>
<tr>
<td>Select the components to Match On.</td>
<td>Select one of the available message components to match on:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Body</strong> – The content of the message.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Attachments</strong> – Any files that are attached to or transferred by the message.</td>
</tr>
<tr>
<td></td>
<td>See “Selecting components to match on” on page 336.</td>
</tr>
<tr>
<td>Configure additional conditions to Also Match.</td>
<td>Select this option to create a compound condition. All conditions must be met to trigger or exceed a match.</td>
</tr>
<tr>
<td></td>
<td>You can <strong>Add</strong> any available condition from the drop-down menu.</td>
</tr>
<tr>
<td>Test and tune the policy.</td>
<td>See “Test and tune policies to improve match accuracy” on page 361.</td>
</tr>
<tr>
<td></td>
<td>See “Use parallel IDM rules to tune match thresholds” on page 507.</td>
</tr>
<tr>
<td></td>
<td>See “Troubleshooting policies” on page 353.</td>
</tr>
</tbody>
</table>
Best practices for using IDM

Indexed Document Matching (IDM) is designed to protect document content and images. IDM relies on an index of fingerprinted documents to perform partial and derivative text-based content matching. In addition, you can also use IDM to match indexed documents exactly based on their binary stamp, including not only text-based documents but also graphics and media files.

Because of the broad range of matching supported by IDM, you should consider the best practices in this section to implement IDM policies that accurately match the data you want to protect.

Table 20-27 summarizes the IDM considerations discussed in this section, with links to individual topics for each.

Table 20-27  IDM policy best practices

<table>
<thead>
<tr>
<th>Consideration</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reindex IDM profiles after upgrade.</td>
<td>See “Reindex IDM profiles after major upgrade” on page 500.</td>
</tr>
<tr>
<td>Do not compress documents whose content you want to fingerprint.</td>
<td>See “Do not compress files in the document source” on page 500.</td>
</tr>
<tr>
<td>Do not use IDM solely to protect binary files.</td>
<td>See “Avoid using IDM solely for binary files” on page 501.</td>
</tr>
<tr>
<td>Do not index text-based documents without content.</td>
<td>See “Do not index empty documents” on page 501.</td>
</tr>
<tr>
<td>Use exact matching IDM on the endpoint instead of two-tier detection wherever possible.</td>
<td>See “Prefer exact match over two-tier detection on the endpoint” on page 502.</td>
</tr>
<tr>
<td>Be aware of the limitations of exact matching.</td>
<td>See “Understand limitations of exact matching” on page 502.</td>
</tr>
<tr>
<td>Use whitelisting to exclude partial file contents from matching and reduce false positives.</td>
<td>See “Use whitelisting to exclude non-sensitive content from partial matching” on page 503.</td>
</tr>
<tr>
<td>Filter non-critical documents from indexing to reduce false positives.</td>
<td>See “Filter documents from indexing to reduce false positives” on page 504.</td>
</tr>
<tr>
<td>Use IDM as an exception to exclude files from exact matching.</td>
<td>See “Distinguish IDM exceptions from whitelisting and filtering” on page 505.</td>
</tr>
<tr>
<td>Create more than one profile to index more than 2 GB of documents.</td>
<td>See “Create separate profiles to index large document sources” on page 505.</td>
</tr>
<tr>
<td>Use remote indexing for large document sets.</td>
<td>See “Use WebDAV or CIFS to index remote document data sources” on page 506.</td>
</tr>
</tbody>
</table>
Table 20-27  IDM policy best practices (continued)

<table>
<thead>
<tr>
<th>Consideration</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use scheduled indexing to automate profile updates.</td>
<td>See “Use scheduled indexing to keep profiles up to date” on page 506.</td>
</tr>
<tr>
<td>Use multiple IDM rules in parallel to establish and tune match thresholds.</td>
<td>See “Use parallel IDM rules to tune match thresholds” on page 507.</td>
</tr>
<tr>
<td>Use VML with exact match agent IDM on the endpoint.</td>
<td>See “Use agent IDM with VML for partial match validation” on page 507.</td>
</tr>
</tbody>
</table>

Reindex IDM profiles after major upgrade

It is recommended that you update each Indexed Document Matching profile by reindexing each associated data source after performing a major upgrade of Symantec Data Loss Prevention.

If you have upgraded to Symantec Data Loss Prevention version 12.5 and you want to use exact match IDM on the endpoint for existing IDM policies, you must reindex the data source for each Indexed Document Profile so that each endpoint index is generated and deployed to DLP Agents.

If you have upgraded to Data Loss Prevention 12.5 and you are not using agent IDM, you are not required to reindex your data sources, but doing so is recommended.

See “Using agent IDM after upgrade to version 12.5” on page 494.

See “Enabling agent IDM” on page 495.

Do not compress files in the document source

For file formats whose content can be cracked, the server indexing process opens the document, extracts the text-based content, and fingerprints the data in full and in part (sections). However, the indexing process cannot recursively inspect document archives that are contained in the document set. If a document whose file contents you want to index is compressed in an archive file (such as ZIP, RAR, or TAR) within the document data source, the system cannot crack the file and index its content. In this case, the system will only take an MD5 hash of the binary file signature. The embedded file is considered for exact file matches only, like image files and other unsupported file formats.

This behavior is specific to the design-time indexing process only. At run-time the detection server does recursively inspect document archives and extract the text.
of files contained in those archives. But, to be able to evaluate such content, the IDM index must have been able to index all content files.

The best practice is not to include any files whose content you want to index in a document archive. The lone exception is the document archive ZIP file that you upload or copy to the Enforce Server that contains the entire document set. All files in that container file must be uncompressed. If the Document Archive uploaded to the Enforce Server for indexing contains one or more embedded archive files (such as a ZIP), the system performs an exact binary match on any file contained in the embedded archive file.

See “Creating and modifying Indexed Document Profiles” on page 479.

Avoid using IDM solely for binary files

Although IDM can protect any type of file, unless you must protect the exact file, the general recommendation is that if you only need to protect binary files, consider using the **File Type Match** condition instead of IDM. There is less overhead in creating file-type matching policies, and the **File Type Match** condition executes locally on the endpoint.

See “Use compound file property rules to protect design and multimedia files” on page 618.

For example, if you want to detect CAD files that contain IP diagrams, you could index these files and apply IDM rules to detect them. Alternatively, you could create a policy that contains a file type rule that detects on the CAD file format plus a file size rule that specifies a threshold size. The file property approach is preferred in this scenario because all you really care about is protecting large CAD files potentially leaving the company. You do not need to gather and index these files for IDM if you can simply create rules that will detect on the file type and the file size.

Do not index empty documents

You should be careful about the documents you index. In particular, avoid indexing blank or empty documents.

For example, indexing a PPTX file containing only photographs or other graphical content but no textual content will match other blank PPTX files exactly and produce false positives. In this case, even though a PPTX file contains no user-entered text, the file does contain header and footer placeholder text that the system extracts as file contents. Because the amount of text extracted and normalized is more than 30 non-whitespace characters, the system treats the file as not binary and creates an MD5 hash of 100% of the file contents. As a result, all other blank PPTX files
will produce exact file contents matches because the resulting MD5 of the extracted content is the same.

---

**Note:** This behavior has not been observed with XLSX files; that is, false positives do not get created if the blank files are different.

See “Using IDM to detect exact and partial file contents” on page 471.

---

### Prefer exact match over two-tier detection on the endpoint

If you are deploying IDM polices to the endpoint, in general agent IDM is recommended over two-tier IDM. The main advantage of agent IDM over two-tier IDM is that matching is faster because it is done locally by the agent instead of remotely by the server. In addition, agent IDM lets you use response rules directly on the endpoint. The disadvantage of agent IDM is that it does not support partial file contents matching.

See “Types of IDM detection” on page 464.

To overcome the limitation of the lack of support for partial file contents matching, consider using agent IDM with VML rules on the endpoint.

See “Use agent IDM with VML for partial match validation” on page 507.

---

### Understand limitations of exact matching

Exact match means just that: inbound data must match the MD5 fingerprint of either a binary file signature or 100% of extracted and normalized file contents.

See “Supported forms of matching for IDM” on page 463.

Consider the following when implementing exact match IDM:

- You cannot use whitelisting to exclude content from exact matching on the endpoint. When the system generates the endpoint index file, it ignores the whitelisted.txt file. Whitelisting only applies to server-based partial file contents matching.

- If exact match IDM on the endpoint is enabled, documents will be matched exactly by the DLP Agent regardless of the match percentage level you choose in the IDM rule.

- For binary files coming into the detection engine for exact file matching, as an optimization the system checks the byte size of the file before computing the run-time MD5 for comparison against the index. If the file byte sizes do not match there is no comparison of the MD5 hashes.
For content extracted from a text-based file coming into the detection engine for exact file contents matching, file size is not checked. If text can be extracted the system always computes and compares the MD5 for matching.

File type is never checked for exact file or exact file contents matching.

Some file formats change the byte size of a file if the file is opened by the native application and then resaved without changes, resulting in the file not matching exactly. For example, if you open a file such as a JPEG image with Windows Picture and Fax Viewer and resave the file without making changes, the binary size of the file is nonetheless changed, resulting in no exact match.

For some applications the Windows Print operation may alter the file data such that extracted file contents will not match exactly. Known file types that are affected by this include Microsoft Office documents.

Table 1 lists some known limitations with exact content matching. This list is not exhaustive and there may be other file formats that change on resave.

<table>
<thead>
<tr>
<th>File type</th>
<th>Application</th>
<th>Result on resave</th>
</tr>
</thead>
<tbody>
<tr>
<td>dwg</td>
<td>AutoCAD 2012</td>
<td>Does not match</td>
</tr>
<tr>
<td>jpeg</td>
<td>Windows Picture and Fax Viewer</td>
<td>Does not match</td>
</tr>
<tr>
<td>doc</td>
<td>Microsoft Office Word 2007</td>
<td>Does not match</td>
</tr>
<tr>
<td>xls</td>
<td>Microsoft Excel 2007</td>
<td>Does not match</td>
</tr>
<tr>
<td>ppt</td>
<td>Microsoft Presentation 2007</td>
<td>Does not match</td>
</tr>
<tr>
<td>pdf</td>
<td>Adobe Acrobat 9 Pro</td>
<td>Does not match</td>
</tr>
<tr>
<td>docx</td>
<td>Microsoft Office Word 2007</td>
<td>Match</td>
</tr>
<tr>
<td>xlsx</td>
<td>Microsoft Excel 2007</td>
<td>Match</td>
</tr>
<tr>
<td>pptx</td>
<td>Microsoft Presentation 2007</td>
<td>Match</td>
</tr>
</tbody>
</table>

**Use whitelisting to exclude non-sensitive content from partial matching**

Whitelisting is designed to let you exclude partial file contents from matching. You use whitelisting to exclude headers, footers, and boilerplate content from partial matching and reduce false positives. Information contained in document headers and footers is likely to cause false positives. Likewise boilerplate text, such as
standard language and non-proprietary corporate content that is often repeated across confidential documents can cause false positives.

Ideally, you should remove headers and footers from documents before you index them. However, this may not be feasible, especially if you have a large document set. As a best practice, you should whitelist header, footer, and boilerplate content so that this text is excluded when the server index is generated. If you use whitelisting, generally you can lower the Minimum Document Exposure setting in the policy without increasing false positives because more of the content indexed is confidential data, instead of common, repeated content.

---

**Note:** Whitelisting does not apply to exact file or exact file contents matching.

See “About whitelisting partial file contents” on page 474.
See “Whitelisting file contents to exclude from partial matching” on page 476.

---

**Filter documents from indexing to reduce false positives**

When you configure an Indexed Document Profile, you have the option of using filters to include or exclude documents in your data source for indexing. There are two types of filters: file name and file size.

See “Creating and modifying Indexed Document Profiles” on page 479.

You use filtering to filter non-critical documents from indexing and ensure that your index is protecting only confidential files and file contents. Filtering helps reduce false positives and decrease the size of the IDM index.

See “Do not index empty documents” on page 501.

The best practice is to use either an exclusion filter or an inclusion filter for each filter type, but not both. For example, you may not need to index all of the files you include in a document archive or expose to the system by file share. In this case, you can enumerate the files you want to include (inclusion filter) or list the file types you want to exclude from indexing (exclusion filter), but you should not use both. You can also use file size filters to set a threshold for the file size to include or exclude in the index.

See “Filtering documents by file name” on page 489.
See “Filtering documents by file size” on page 491.
Distinguish IDM exceptions from whitelisting and filtering

Whitelisting lets you exclude partial file contents from matching. Filtering lets you exclude specific documents from the indexing process. IDM exceptions, on the other hand, let you except indexed files from exact matching at run-time.

You use the IDM condition as policy exception to exclude files from detection. To be excepted from matching, an inbound file must be an exact match with a file in the IDM index. You cannot use IDM exceptions to exclude content from matching. To exclude content, you must whitelist it.

**Note**: Whitelisting is not available for exact file or file contents matching; it is only available for partial content matching.

<table>
<thead>
<tr>
<th>IDM Configuration</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exception</td>
<td>Except exact file from matching</td>
</tr>
<tr>
<td></td>
<td>See “About using IDM for policy exceptions” on page 474.</td>
</tr>
<tr>
<td></td>
<td>As an example, the CAN-SPAM Act policy template uses an IDM exception.</td>
</tr>
<tr>
<td></td>
<td>See “CAN-SPAM Act policy template” on page 805.</td>
</tr>
<tr>
<td>Whitelisting</td>
<td>Except file contents from matching</td>
</tr>
<tr>
<td></td>
<td>See “Use whitelisting to exclude non-sensitive content from partial matching” on page 503.</td>
</tr>
<tr>
<td>Filtering</td>
<td>Include or exclude files from being indexed</td>
</tr>
<tr>
<td></td>
<td>See “Filter documents from indexing to reduce false positives” on page 504.</td>
</tr>
</tbody>
</table>

Create separate profiles to index large document sources

IDM detection is based on an Indexed Document Profile. The maximum size of the source documents that you can index for a single IDM profile is 2 GB. This maximum size limit is based on the overall size of the documents in their natural, uncompressed state. Depending on the size of the actual source files and their extracted text size, this translates into approximately 300,000 to 400,000 files. In addition, the 2 GB maximum size may be affected by any hardware limitations imposed by the host machine where the Enforce Server is installed.

See “About the document data source” on page 466.

If you need to index a large number of files more than 2 GB in total size when uncompressed, the best practice is to organize the documents into separate ZIP
files or share directories. You then create a separate Indexed Document Profile for each individual document set. You can then define separate rules that reference each index and add the rules one or more policies.

Use WebDAV or CIFS to index remote document data sources

For smaller document sets (50 MB or less), you can upload the files to the Enforce Server. For larger document sets, consider using FTP Secure to upload the files to the Enforce Server.

Alternatively, you can use the remote IDM indexing feature to remotely index documents that are stored on a file share that supports the CIFS protocol, or on a web server that supports the WebDAV protocol, such as Microsoft SharePoint or OpenText Livelink

See “About indexing remote documents” on page 467.

Use scheduled indexing to keep profiles up to date

You can use index scheduling to keep your IDM profiles up to date. The initial index scans all the documents to be indexed. Any subsequent index only scans the differences between the two. You should schedule indexing outside of normal business hours to reduce any potential affect on the system.

See “Scheduling document profile indexing” on page 492.

Before you set up an indexing schedule, consider the following recommendations:

- If you update your document sources occasionally (for example, less than once a month), there is no need to create a schedule. Index the document each time you update it.

- Schedule indexing for times of minimal system use. Indexing affects performance throughout the Symantec Data Loss Prevention system, and large documents can take time to index.

- Index a document as soon as you add or modify the corresponding document profile, and re-index the document whenever you update it. For example, consider a situation where every Wednesday at 2:00 A.M. you update a document. In this case scheduling the index process to run every Wednesday at 3:00 A.M. is optimal. Scheduling document indexing daily is not recommended because that is too frequent and can degrade server performance.

- Monitor results and modify your indexing schedule accordingly. If performance is good and you want more timely updates, schedule more frequent document updates and indexing.
— Symantec Data Loss Prevention performs incremental indexing. When a previously indexed share or directory is indexed again, only the files that have changed or been added are indexed. Any files that are no longer in the archive are deleted during this indexing. So a reindexing operation can run significantly faster than the initial indexing operation.

**Use parallel IDM rules to tune match thresholds**

The primary use case for IDM policies is to detect unstructured document content based on a percentage match requirement called the Minimum Document Exposure. This value is a configurable parameter that specifies the minimum percentage of content in the message that must match the IDM index to produce a match. The IDM policy default is “Exact,” which means that, for text-based documents, 100% of the content of the message must match the fingerprint to create an incident. A Minimum Document Exposure setting of 10% means that, on average, one page of a 10 page document must match the IDM index to create an incident.

A document might contain much more content, but Symantec Data Loss Prevention protects only the content that is indexed as part of a document profile. For example, consider a situation where you index a one-page document, and that one-page document is included as part of a 100-page document. The 100-page document is considered a 100 percent match because its content matches the one-page document exactly. In addition, the matched document does not have to be of the same file type or format as the indexed document. For example, if you index a Word document as part of a document profile, and its contents are pasted into the body of an email message or used to create a PDF, the engine considers it a match.

A rule-of-thumb for setting the Minimum Document Exposure setting is 60%. Minimum Document Exposures set to less than 50% typically create many false positives. Starting with a rate of 60% should give you enough information to determine whether you should go to a higher or lower match percentage without creating excessive false positives.

As an alternative, consider taking a tiered approach to establishing Minimum Document Exposure settings. For example, you can create multiple IDM rules, each with a different threshold percentage, such as 80% for documents with a high match percentage, 50% for documents with a medium match percentage, and 10% with a low match percentage. Using this approach will help you filter out false positives and help you establish an accurate Minimum Document Exposure setting for each IDM index you deploy as part of your policies.

**Use agent IDM with VML for partial match validation**

The DLP Agent does not support partial file contents matching for IDM. If exact match IDM on the endpoint is enabled, the DLP Agent only matches exact files and
exact file contents. If two-tier detection for IDM is enabled, the DLP Agent sends message contents to the server for matching. If the endpoint is offline, the DLP Agent cannot send the message contents to the server for matching.

If you want to match partial file contents locally on the endpoint, consider creating a compound policy that includes IDM and VML rules. VML indexes run locally on the endpoint; they do not require two-tier detection. Using a VML rule with the IDM you can detect similar document content when the endpoint is offline. To do this you take a subset of the IDM documents you have indexed and create a VML index that is deployed to the endpoint. In a single policy you create separate IDM and VML rules so that their logical connection is an OR. With this policy configuration, if the file contents do not match exactly, they can still be matched similarly according to the VML rule configuration.

In addition, VML may be viable as an exception for IDM rules. For example, where an IDM policy is a consistent source of false positives, you can implement VML as an exception to the IDM rule. For example, a sales report may consistently produce false positives for explicit pre-release data that is not sensitive. VML may work well here because you can train against the content that causes the false positives and create an exception to ignore those features. Refer to the VML documentation for details.
Detecting content using Vector Machine Learning (VML)

This chapter includes the following topics:

- Introducing Vector Machine Learning (VML)
- Configuring VML profiles and policy conditions
- Best practices for using VML

Introducing Vector Machine Learning (VML)

Vector Machine Learning (VML) protects unstructured data by performing statistical analysis to determine if content is similar to example content you train against.

Unlike other detection technologies, with VML you do not have to locate and fingerprint all of the data you want to protect, nor do you have to describe it and risk potential inaccuracies. With VML you train the system to learn the type of content you want to protect based on example documents you provide.

VML detection is based on a VML profile. You create a VML profile by uploading a representative amount of content from a specific category of data. The system scans the content, extracts the features, and creates a statistical model based on the frequency of keywords in the example documents. At runtime the system applies the model to analyze and detect content that has features that are statistically similar to the profile.

VML simplifies the detection of unstructured, text-based content while offering the potential for high accuracy. The key to implementing VML is the example content you train the system against. You must be careful to select documents that are very
representative of the type of content you want to protect. And, you must select good examples of content you want to ignore that are closely related to the content you want to protect.

See “Configuring VML profiles and policy conditions” on page 513.

About the Vector Machine Learning Profile

The Vector Machine Learning Profile is the data profile that you define for implementing VML policies.

For example, you might create a VML profile to protect your source code. In this case you train the system using positive example documents (proprietary code that you want to protect) and negative example documents (open source code that you do not care to protect). A VML policy references the VML profile to analyze message data and recognize content that is similar to the positive features. The VML profile can be tuned, and it can be easily updated by adding or removing documents to or from the training sets.

See “Data Profiles” on page 291.

See “Creating new VML profiles” on page 515.

About the content you train

Collecting the documents for training is the most important step in the Vector Machine Learning process. Vector Machine Learning is only as accurate as the example content you train against.

See “Configuring VML profiles and policy conditions” on page 513.

A VML profile is based on a category of content representing a specific business use case. A category of content comprises two training sets: positive and negative.

The positive training set is content you want to protect. More specific categorization results in better accuracy. For example, “Customer Purchase Orders” is better than “Financial Documents” because it is more specific.

The negative training set is content you want to ignore, yet related to the positive training set. For example, if the positive training set is “Weekly Sales Reports,” the negative training set might contain “Sales Press Releases.”

You should collect an equal amount of positive and negative content that is primarily text-based. You do not have to collect all the content you want to protect, but you need to assemble training sets large enough to produce reliable statistics.

The recommended number of documents is 250 per training set. The minimum number of documents per training set is 50.
The following table summarizes the baseline requirements for the content you collect for VML profile training.

### Table 21-1  VML training set requirements

<table>
<thead>
<tr>
<th>Category of content</th>
<th>Type of data (primarily)</th>
<th>Training set</th>
<th>Quantity</th>
<th>Content</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single, specific business use case</td>
<td>Text-based</td>
<td>Positive</td>
<td>Recommended: 250 documents Minimum: 50 documents</td>
<td>Content you want to protect.</td>
<td>30 MB per upload</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Negative</td>
<td>Approximately the same amount as the positive category.</td>
<td>Content you do not want to protect yet thematically related to the positive category.</td>
<td>No size limit per category.</td>
</tr>
</tbody>
</table>

### About the base accuracy from training percentage rates

During the VML profile training process, the system extracts example document content and converts it to raw text. The system selects features (or keywords) using a proprietary algorithm and generates the VML profile. As part of the training process, the system calculates and reports base accuracy rates for false positives and false negatives. The base accuracy from training percentage rates indicate the quality of your positive and negative training sets.

While the goal is to achieve 100% accuracy (0% base false rates), obtaining this level of quality for both training sets is usually not possible. In general you should reject a training profile if either the base false positive rate or the base false negative rate is more than 5%. A relatively high base false percentage rate indicates that the training set is not well categorized. In this case you need to add documents to an underrepresented training set or remove documents from an over-represented training set, or both.

See “Managing training set documents” on page 521.

The following table describes what the base accuracy percentage rates from training mean in relation to the positive and negative training sets for a given VML profile.

### Table 21-2  Base accuracy rates from training

<table>
<thead>
<tr>
<th>Accuracy rate</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base False Positive Rate (%)</td>
<td>The percentage of the content in the negative training set that is statistically similar to the positive content.</td>
</tr>
</tbody>
</table>
Table 21-2  Base accuracy rates from training (continued)

<table>
<thead>
<tr>
<th>Accuracy rate</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base False Negative Rate (%)</td>
<td>The percentage of the content in the positive training set that is statistically similar to negative content.</td>
</tr>
</tbody>
</table>

About the Similarity Threshold and Similarity Score

Each VML profile has a setting called the **Similarity Threshold** which can be set from 0 to 10. This setting is used to make an adjustment for imperfect information within a training set to achieve the best accuracy possible. During detection, a message must have a Similarity Score greater than the Similarity Threshold for an incident to be generated. The Similarity Threshold is set at the profile level—not within a policy rule—because there is an ideal Similarity Threshold setting that is unique to your training set where the best accuracy rates can be achieved (both in terms of false positives and false negatives).

When a VML policy detects an incident, the system displays the **Similarity Score** in the match highlighting section of the **Incident Snapshot** in the Enforce Server administration console. The Similarity Score indicates how similar the detected content is to the VML profile. The higher the score the more statistically similar the message is to the positive example documents in your VML profile.

Consider an example where a Similarity Threshold is set to 4 and a message with a Similarity Score of 5 is detected. In this case the system reports the match as an incident and displays the Similarity Score during match highlighting. However, if a message is detected with a Similarity Score of 3, the system does not report a match (and no incident) because the Similarity Score is below the Similarity Threshold.

The table below describes the Similarity Threshold and Similarity Score numbers.

Table 21-3  Similarity Threshold and Similarity Score details

<table>
<thead>
<tr>
<th>Similarity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Similarity Threshold</td>
<td>The Similarity Threshold is a configurable parameter between 0 and 10 that is unique to each VML profile. The default setting is 10, which requires the most similar match between the VML profile features and the detected message content. As such, this setting is likely to produce fewer incidents. A setting of 0 produces the most number of matches, many of which are likely to be false positives.</td>
</tr>
<tr>
<td></td>
<td>See “Adjusting the Similarity Threshold” on page 527.</td>
</tr>
</tbody>
</table>
Table 21-3  Similarity Threshold and Similarity Score details (continued)

<table>
<thead>
<tr>
<th>Similarity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Similarity Score</td>
<td>The Similarity Score is a read-only runtime statistic between 0 and 10 reported by the system based on the detection results of a VML policy. To report an incident, the Similarity Score must be higher than the Similarity Threshold, otherwise the VML policy does not report a match.</td>
</tr>
</tbody>
</table>

About using unaccepted VML profiles in policies

The system lets you create a policy that is based on a VML profile that has never been accepted. However, the VML profile is not active and is not deployed to a referenced policy until the profile is initially accepted.

See “Training VML profiles” on page 518.

Where you have a VML policy that references a never-accepted VML profile, the result of this configuration depends on the type of detection server. The table below describes the behavior:

<table>
<thead>
<tr>
<th>Detection server</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discover Server</td>
<td>Discover scanning does not begin until all policy dependencies are loaded. As such, a Discover scan based on a VML policy will not start until the referenced VML profile is accepted. In this case the system displays a message in the Discover scanning interface indicating the scan is waiting on the dependency to load.</td>
</tr>
<tr>
<td>Network and Endpoint Servers</td>
<td>For a simple rule, or compound rule where the conditions are ANDed, the entire rule fails because the VML condition cannot match. If this is the only rule in the policy, the policy will not work. For a policy where there are multiple rules that are ORed, only the VML rule fails; the other rules in the policy are evaluated.</td>
</tr>
</tbody>
</table>

See “Policy detection execution” on page 308.

Configuring VML profiles and policy conditions

Vector Machine Learning (VML) protects unstructured data by performing statistical analysis to determine if content is similar to an example set of documents you train against.

See “Introducing Vector Machine Learning (VML)” on page 509.

The following table describes the process for implementing VML.
Table 21-4 Implementing VML

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Collect the example documents for training the system.</td>
<td>Collect a representative amount of example documents containing positive content you want to protect and negative content you want to ignore. See “About the content you train” on page 510.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Create a new VML profile.</td>
<td>Define a new VML profile based on the specific business category of data from which you have derived your positive and negative training sets. See “Creating new VML profiles” on page 515.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Upload the example documents.</td>
<td>Upload separately to the Enforce Server the example positive and negative training sets. See “Uploading example documents for training” on page 516.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Train the VML profile.</td>
<td>Train the system to learn the type of content you want to protect and generate the VML profile. See “Training VML profiles” on page 518.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Accept or reject the trained profile.</td>
<td>Accept the trained profile to deploy it. Or, reject the profile, update one or both of the training sets (by adding or removing example documents), and restart the training process. See “About the base accuracy from training percentage rates” on page 511. See “Managing VML profiles” on page 522.</td>
</tr>
<tr>
<td>Step 6</td>
<td>Create a VML policy and test detection.</td>
<td>Create a VML policy that references the VML profile. See “Configuring the Detect using Vector Machine Learning Profile condition” on page 525. Test and review incidents based on the Similarity Score. See “About the Similarity Threshold and Similarity Score” on page 512.</td>
</tr>
<tr>
<td>Step 7</td>
<td>Tune the VML profile.</td>
<td>Adjust the Similarity Threshold setting as necessary to optimize detection results. See “Adjusting the Similarity Threshold” on page 527.</td>
</tr>
<tr>
<td>Step 8</td>
<td>Follow VML best practices.</td>
<td>See “Best practices for using VML” on page 532.</td>
</tr>
</tbody>
</table>
Creating new VML profiles

A VML profile contains the model that is generated from the training set contents. Once you define a VML profile, you use it to create one or more VML policies. See “Configuring VML profiles and policy conditions” on page 513.

**Note:** You must have Enforce Server administrator privileges to create VML profiles.

To create a new VML profile

1. Click **New Profile** from the Manage > Data Profiles > Vector Machine Learning screen (if you have not already done so).
2. Enter a **Name** for the VML profile in the **Create New Profile** dialog.
   Use a logical name for the VML profile that corresponds to the category of data you want to protect.
   See “About the content you train” on page 510.
3. Optionally, enter a **Description** for the VML profile.
   You may want to include a description that identifies the purpose of the VML profile.
4. Click **Create** to create the new VML profile.
   Or, click **Cancel** to cancel the operation.
5. Click **Manage Profile** to upload example documents.
   See “Uploading example documents for training” on page 516.

Working with the Current Profile and Temporary Workspace tabs

For any single VML profile there are two possible versions: Current and Temporary. The Current Profile is the runtime version; the Temporary Profile is the design-time version. Typically, as you develop a VML profile, you will have a Current Profile that you have trained, accepted, and perhaps deployed to one or more policies, as well as a Temporary Profile that you actively edit and tune.

The Enforce Server administration console displays each version of the VML profile in separate tabs:

- **Current Profile**
  This version is the active instance of the VML profile. This version has been successfully trained and accepted; it is available for deployment to one or more policies.

- **Temporary Workspace**
This version is an editable version of the VML profile. This version has not been trained, or accepted, or both; it cannot be deployed to a policy.

Initially, when you create a new VML profile, the system displays only the Current Profile tab with an empty training set. After you train and accept the VML profile for the first time, the Trained Set table in the Current Profile tab becomes populated with details about the training set. The information that is displayed in this table and tab is read-only.

To edit a VML profile

◆ Click Manage Profile to the far right of the Current Profile tab.

The system displays the editable version of the profile in the Temporary Workspace tab. You can now proceed with training and managing the profile.

See “Training VML profiles” on page 518.

The Temporary Workspace tab remains present in the user interface until you train and accept a new version of the VML profile. In other words, there is no way to close the Temporary Workspace tab without training and accepting, even if you made no changes to the profile.

Once you accept a new version of the VML profile, the system overwrites the previous Current Profile with the newly accepted version. You cannot revert to a previously accepted Current Profile. However, you can revert to previous versions of the training set for a Temporary Profile.

See “Managing training set documents” on page 521.

Uploading example documents for training

The training set comprises the example positive and negative documents you want to train the system against. You upload the positive and negative documents separately.

Note: While you can upload individual documents, it is recommended that you upload a document archive (such as ZIP, RAR, or TAR) that contains the recommended (250) or minimum (50) number of example documents. The maximum upload size is 30 MB. You can partition the documents across archives if you have more than 30 MB of data to upload. See “About the content you train” on page 510.
To upload the training set

1. Click **Manage Profile** from the **Current Profile** tab (if you have not already done so).

   This action enables the VML profile for editing in the **Temporary Workspace** tab.

   See “Working with the Current Profile and Temporary Workspace tabs” on page 515.

2. Click **Upload Contents** (if you have not already done so).

   This action opens the **Upload Contents** dialog.

3. Select which category of content you are uploading:
   - Choose **Positive: match contents similar to these** to upload a positive document archive.
   - Choose **Negative: ignore contents similar to these** to upload a negative document archive.

4. Click **Browse** to select the document archive to upload.

5. Navigate the file system to where you have stored the example documents.

6. Choose the file to upload and click **Open**.

7. Verify that you have chosen the correct category of content you are uploading: Positive or Negative.

   If you mismatch the upload (select Negative but upload a Positive document archive), the resulting profile will be inaccurate.

8. Click **Submit** to upload the document archive to the Enforce Server.

   The system displays a message indicating if the file successfully uploaded. If the upload was successful, the document archive appears in the **New Documents** table. This table displays the document type, name, size, date uploaded, and the user who uploaded it. If the upload was not successful, check the error message and retry the upload. Click the X icon in the **Remove** column to delete an uploaded document or document archive from the training set.
9. Click **Upload Contents** to repeat the process for the other training set.

The profile is not complete and cannot be trained until you have uploaded the minimum number of positive and negative example documents.

See Table 21-1 on page 511.

10. Once you have successfully uploaded both training sets you are ready to train the VML profile.

See “Training VML profiles” on page 518.

### Training VML profiles

During the profile training process, the system scans the training content, extracts key features, and generates a statistical model. When the training process completes successfully, the system prompts you to accept or reject the training profile. If you accept the training results, that version of the VML profile becomes the Current Profile, meaning that it is active and available for use in one or more policies.

See “Configuring VML profiles and policy conditions” on page 513.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| Step 1 | Enable training mode. | Select the VML profile you want to train from the Manage > Data Profiles > Vector Machine Learning screen. Or, create a new VML profile.  
See “Creating new VML profiles” on page 515.  
Click Manage Profile to the far right of the Current Profile tab. The system displays the profile for training in the Temporary Workspace tab.  
See “Working with the Current Profile and Temporary Workspace tabs” on page 515. |
| Step 2 | Upload the training content. | Familiarize yourself with the training set requirements and recommendations.  
See “About the content you train” on page 510.  
Upload the positive and negative training sets in separate document archives to the Enforce Server.  
See “Uploading example documents for training” on page 516. |
Table 21-5  Training the VML profile (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| Step 3 | Adjust the memory allocation (only if necessary). | The default value is "High" which generally results in the best training set accuracy rates. Typically you do not need to change this setting. For some situations you may want to choose a "Medium" or "Low" memory setting (for example, deploying the profile to the endpoint).  
See “Adjusting memory allocation” on page 520.  
**Note:** If you change the memory setting, you must do so before you train the profile to ensure accurate training results. If you have already trained the profile, you must retrain it again after you adjust the memory allocation. |
| Step 4 | Start the training process. | Click **Start Training** to begin the profile training process.  
During the training process, the system:  
- Extracts the key features from the content;  
- Creates the model;  
- Calculates the predicted accuracy based on the averaged false positive and false negative rates for the entire training set;  
- Generates the VML profile. |
| Step 5 | Verify training completion. | When the training process completes, the system indicates if the training profile was successfully created.  
If the training process failed, the system displays an error. Check the debug log files and restart the training process.  
See “Debug log files” on page 247.  
On successful completion of the training process, the system displays the following information for the **New Profile:**  
- **Trained Example Documents**  
The number of example documents in each training set that the system trained against and profiled.  
- **Accuracy Rate From Training**  
The quality of the training set expressed as base false positive and base false negative percentage rates.  
See “About the base accuracy from training percentage rates” on page 511.  
- **Memory**  
The minimum amount of memory required to load the profile at runtime for detection.  
**Note:** If you previously accepted the profile, the system also displays the **Current Profile** statistics for side-by-side comparison. |
Table 21-5  Training the VML profile (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| Step 6| Accept or reject the training profile.     | If the training process is successful, the system prompts you to accept or reject the training profile. Your decision is based on the **Accuracy Rate from Training** percentages. See “About the base accuracy from training percentage rates” on page 511. To accept or reject the training profile:  
  ■ Click **Accept** to save the training results as the active Current Profile. Once you accept the training profile, it appears in the **Current Profile** tab and the **Temporary Workspace** tab is removed.  
  ■ Click **Reject** to discard the training results. The profile remains in the **Temporary Workspace** tab for editing. You can adjust one or both of the training sets by adding or removing documents and retraining the profile. See “Managing training set documents” on page 521.  
  **Note:** A trained VML profile is not active until you accept it. While the system lets you create a policy based on a VML profile that has not been trained or accepted, the VML profile is not deployed to that policy until the profile is accepted. See “About using unaccepted VML profiles in policies” on page 513. |
| Step 7| Test and tune the profile.                  | Once you have successfully trained and accepted the VML profile, you can now use it to define policy rules and tune the VML profile.                                                                                                                                                                                                         See “Configuring the Detect using Vector Machine Learning Profile condition” on page 525.  
  See “About the Similarity Threshold and Similarity Score” on page 512.  
  **Note:** For more information, refer to the Symantec Data Loss Prevention Vector Machine Learning Best Practices Guide, available at the DLP Knowledgebase (https://kb-vontu.altiris.com/), article number 54340. |

**Adjusting memory allocation**

The **Memory Allocation** setting determines the amount of memory required to load VML the profile at runtime for policy detection. The more memory allocated to training the larger the VML profile will be because more features will be modeled. By default this value is set to “High.” In general you should not adjust this value. However, if you intend to deploy the VML profile to the endpoint, where resources may be limited, you may want to use a lower memory setting to reduce the size of the profile.
To adjust memory allocation

1. Click **Adjust** beside the **Memory Allocation** setting.
   
   This setting is available in the **Temporary Workspace** tab. If it is not available, click **Manage Profile** from the **Current Profile** tab.
   
   See “Working with the Current Profile and Temporary Workspace tabs” on page 515.

2. Select the desired memory allocation level.
   
   The following options are available:
   
   - **High**
     
     Requires a higher amount of runtime memory; generally yields higher detection accuracy (default setting).
   
   - **Medium**
   
   - **Low**
     
     Requires less runtime memory; may result in lower detection accuracy.

3. Click **Save** to save the setting.
   
   The **Memory Setting** display should reflect the adjustment you made.

4. Click **Start Training** to start the training process.
   
   You must adjust the memory allocation before you train the VML profile. If you have already trained the profile, retrain after adjusting this setting.
   
   See “Training VML profiles” on page 518.

5. Verify the amount of memory required to run the VML profile.
   
   After you train the VML profile, the system displays the **Memory Required (KB)** value, which represents the minimum amount of memory required to load the profile at runtime.
   
   See “Managing VML profiles” on page 522.

Managing training set documents

As you train and tune a VML profile, you may need to adjust one or both of the training sets. For example, if you reject a training profile, you will need to add or remove example documents to improve the training accuracy rates.

See “About the base accuracy from training percentage rates” on page 511.
To add documents to a training set
1. Click Manage Profile for the profile you want to edit.
   The editable profile appears in the Temporary Workspace tab.
2. Click Upload Contents.
   See “Uploading example documents for training” on page 516.

To remove documents from a training set
1. Click Manage Profile for the profile you want to edit.
   The editable profile appears in the Temporary Workspace tab.
2. Click the red X in the Mark Removed column for the trained document you want to remove.
   The removed document appears in the Removed Documents table. Repeat this process as necessary to remove all unwanted documents from the training set.
3. Click Start Training to retrain the profile.
   You must retrain and accept the updated profile to complete the document removal process. If you do not accept the new profile the document you attempted to remove remains part of the profile.
   See “Training VML profiles” on page 518.

To revert removed documents
1. Click the revert icon in the Revert column for a document you have removed.
   The document is added back to the training set.
2. Click Start Training to retrain the profile.
   You must retrain the profile and reaccept it even though you reverted to the original configuration.

Managing VML profiles

The Manage > Data Profiles > Vector Machine Learning screen is the home page for managing existing VML profiles and the starting point for creating new VML profiles.

See “Configuring VML profiles and policy conditions” on page 513.

Note: You must have Enforce Server administrator privileges to manage and create VML profiles.
Creating and managing VML profiles

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create new profiles.</td>
<td>Click <strong>New Profile</strong> to create a new VML profile. See “Creating new VML profiles” on page 515.</td>
</tr>
<tr>
<td>View and sort profiles.</td>
<td>The system lists all existing VML profiles and their state at the <strong>Vector Machine Learning</strong> screen.</td>
</tr>
<tr>
<td></td>
<td>Click the column header to sort the VML profiles by name or status.</td>
</tr>
<tr>
<td>Manage and train profiles.</td>
<td>Select a VML profile from the list to display and manage it.</td>
</tr>
<tr>
<td></td>
<td>The <strong>Current Profile</strong> tab displays the active profile.</td>
</tr>
<tr>
<td></td>
<td>See “Working with the Current Profile and Temporary Workspace tabs” on page 515.</td>
</tr>
<tr>
<td></td>
<td>Click <strong>Manage Profile</strong> to edit the profile.</td>
</tr>
<tr>
<td></td>
<td>The editable profile appears in the <strong>Temporary Workspace</strong> tab. From this tab you can:</td>
</tr>
<tr>
<td></td>
<td>■ Upload training set documents.</td>
</tr>
<tr>
<td></td>
<td>■ Train the profile.</td>
</tr>
<tr>
<td></td>
<td>■ Add and remove documents from the training sets.</td>
</tr>
<tr>
<td>Monitor profiles.</td>
<td>The system lists and describes the status of all VML profiles.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Memory Required (KB)</strong></td>
</tr>
<tr>
<td></td>
<td>The minimum amount of memory required to load the profile in memory for detection.</td>
</tr>
<tr>
<td></td>
<td>See “Adjusting memory allocation” on page 520.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Status</strong></td>
</tr>
<tr>
<td></td>
<td>The present status of the profile.</td>
</tr>
<tr>
<td></td>
<td>See <strong>Table 21-7</strong> on page 524.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Deployment Status</strong></td>
</tr>
<tr>
<td></td>
<td>The historical status of the profile.</td>
</tr>
<tr>
<td></td>
<td>See <strong>Table 21-8</strong> on page 524.</td>
</tr>
<tr>
<td>Remove profiles.</td>
<td>Click the X icon at the far right to delete an existing profile.</td>
</tr>
<tr>
<td></td>
<td>If you delete an existing profile, the system removes the profile metadata and the Training Set from the Enforce Server.</td>
</tr>
<tr>
<td></td>
<td>The <strong>Status</strong> field displays the current state of each VML profile.</td>
</tr>
</tbody>
</table>
### Table 21-7 Status values for VML profiles

<table>
<thead>
<tr>
<th>Status value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accepted on &lt;date&gt;</td>
<td>The date the training profile was accepted.</td>
</tr>
<tr>
<td>Managing</td>
<td>The current profile is enabled for editing.</td>
</tr>
<tr>
<td>Empty</td>
<td>The profile is created, but no content is uploaded.</td>
</tr>
<tr>
<td>Awaiting Acceptance</td>
<td>The profile is ready to be accepted.</td>
</tr>
<tr>
<td>Canceling Training</td>
<td>The system is in the process of canceling the training.</td>
</tr>
<tr>
<td>Training Canceled</td>
<td>The training process is canceled.</td>
</tr>
<tr>
<td>Failed</td>
<td>The training process failed.</td>
</tr>
<tr>
<td>Training &lt;time&gt;</td>
<td>The training is in progress (for the time indicated).</td>
</tr>
</tbody>
</table>

The **Deployment Status** field indicates if the VML profile has ever been accepted or not.

### Table 21-8 Deployment Status values for VML profiles

<table>
<thead>
<tr>
<th>Status value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Never Accepted</td>
<td>The VML profile has never been accepted.</td>
</tr>
<tr>
<td></td>
<td>See “About using unaccepted VML profiles in policies” on page 513.</td>
</tr>
<tr>
<td>Accepted on &lt;date&gt;</td>
<td>The VML profile was accepted on the date indicated.</td>
</tr>
</tbody>
</table>

### Changing names and descriptions for VML profiles

If necessary you can change the name of a VML profile or edit its description. For example, when you are ready to deploy a VML profile to one or more policies, you may want to give the profile a more self-describing name so policy authors can easily recognize it.

**Note:** You do not have to retrain a profile if you change the name or description.
To change the VML profile name or description

1. Select the VML profile from the Manage > Data Profiles > Vector Machine Learning screen.
   See “Managing VML profiles” on page 522.

2. Click the Edit link beside the name of the VML profile.

3. Edit the name and description of the profile in the Change Name and Description dialog that appears.

4. Click OK to save the changes to the VML profile name or description.

5. Verify the changes at the home screen for the VML profile.

Configuring the Detect using Vector Machine Learning Profile condition

Once you have trained and accepted the VML profile, you configure a VML policy using the Detect using Vector Machine Learning Profile condition. This condition references the VML profile to detect content that is similar to the example content you have trained against.

See “Configuring VML profiles and policy conditions” on page 513.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| Step 1 | Create and train the VML profile. | See “Creating new VML profiles” on page 515.  
See “Training VML profiles” on page 518.  
See “About using unaccepted VML profiles in policies” on page 513. |
| Step 2 | Configure a new or an existing policy. | See “Configuring policies” on page 326. |
| Step 3 | Add the VML rule to the policy. | From the Configure Policy screen:  
- Select Add Rule.  
- Select the Detect using Vector Machine Learning profile rule from the list of content rules.  
- Select the VML profile you want to use from the drop-down menu.  
- Click Next. |
| Step 4 | Configure the VML detection rule. | Name the rule and configure the rule severity.  
See “Configuring policy rules” on page 330. |
Table 21-9 Configuring a VML policy rule (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| Step 5 | Select components to match on. | Select one or both message components to Match On:  
- Body, which is the content of the message  
- Attachments, which are any files transported by the message  
Note: On the endpoint, the Symantec DLP Agent matches on the entire message, not individual message components.  
See “Selecting components to match on” on page 336. |
| Step 6 | Configure additional conditions (optional). | Optionally, you can create a compound detection rule by adding more conditions to the rule.  
To add additional conditions, select the desired condition from the drop-down menu and click Add.  
Note: All conditions must match for the rule to trigger an incident.  
See “Configuring compound match conditions” on page 342. |
| Step 7 | Save the policy configuration. | Click OK then click Save to save the policy. |

Configuring VML policy exceptions

In some situations, you may want to implement a VML policy exception to ignore certain content.

See “Configuring VML profiles and policy conditions” on page 513.

Table 21-10 Configuring a VML policy exception

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| Step 1 | Create and train the VML profile. | See “Creating new VML profiles” on page 515.  
See “Training VML profiles” on page 518. |
| Step 2 | Configure a new or an existing policy. | See “Configuring policies” on page 326. |
| Step 3 | Add a VML exception to the policy. | From the Configure Policy screen:  
- Select Add Exception.  
- Select the Detect using Vector Machine Learning profile exception from the list of content exceptions.  
- Select the VML profile you want to use from the drop-down menu.  
- Click Next. |
Table 21-10  Configuring a VML policy exception (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| Step 4 | Configure the policy exception. | Name the exception. Select the components you want to apply the exception to:  
- Entire Message  
  Select this option to compare the exception against the entire message. If an exception is found anywhere in the message, the exception is triggered and no matching occurs.  
- Matched Components Only  
  Select this option to match the exception against the same component as the rule. For example, if the rule matches on the Body and the exception occurs in an attachment, the exception is not triggered. |
| Step 5 | Configure the condition. | Generally you can accept the default condition settings for policy exceptions. See “Configuring policy exceptions” on page 340. |
| Step 6 | Save the policy configuration. | Click OK then click Save to save the policy. |

Adjusting the Similarity Threshold

You adjust the Similarity Threshold setting to tune the VML profile. The Similarity Threshold determines how similar detected content must be to a VML profile to produce an incident.

See “About the Similarity Threshold and Similarity Score” on page 512.

**Note:** You do not have to retrain the VML profile after you adjust the Similarity Threshold, unless you modify a training set based on testing results.

To adjust the Current Value of the Similarity Threshold

1. Click **Edit** beside the **Similarity Threshold** label for the VML profile you want to tune. This action opens the **Similarity Threshold** dialog.

2. Drag the meter to the desired **Current Value** setting.

You set the Similarity Threshold to a decimal value between 0 and 10. The default value is 10, which produces fewer incidents; a setting of 0 produces more incidents.
3. Click **Save** to save the Similarity Threshold setting.

4. Test the VML profile using a VML policy.

   Compare the Similarity Scores across matches. A detected message must have a Similarity Score higher than the Similarity Threshold to produce an incident. Make further adjustments to the Similarity Threshold setting as necessary to optimize and fine-tune the VML profile.

   See “Configuring the Detect using Vector Machine Learning Profile condition” on page 525.

### Testing and tuning VML profiles

You tune a VML profile by testing it with the Similarity Threshold set to 0. Once you determine the possible range of Similarity Scores for false positives, you adjust the Similarity Threshold to be just above the highest Similarity Score reported by false positives. This is referred to as negative testing.

A good training set has a well-defined range where the Similarity Threshold is set to achieve the best accuracy rates. A poor training set yields poor accuracy results regardless of the Similarity Threshold. A Similarity Threshold that is set too high or too low can result in a large number of false positives or false negatives.

To determine the proper Similarity Threshold setting, the recommendation is to perform negative testing as described in the following steps.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Train the VML profile.</td>
<td>Follow the recommendations set forth in this guide for defining the category and uploading the training set documents. Adjust the memory allocation before you train the profile. Refer to the <em>Symantec Data Loss Prevention Administration Guide</em> for help performing the tasks involved.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Set the Similarity Threshold to 0.</td>
<td>The default Similarity Threshold is 10. At this value the system does not generate any incidents. A setting of 0 produces the most amount of incidents, many of which are likely to be false positives. The purpose of setting the value to 0 is to see the entire range of potential matches and to tune the profile to be just above the highest false positive score.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Create a VML policy.</td>
<td>Create a policy that references the VML profile you want to tune. The profile must be accepted to be deployable to a policy.</td>
</tr>
</tbody>
</table>
Table 21-11  Steps for tuning VML profiles (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 4</td>
<td>Test the policy.</td>
<td>Test the VML policy using a corpus of test data. For example, you can use the DLP_Wikipedia_sample.zip file to test your VML policies against. Create some mechanism to detect incidents, such as a Discover scan target of a local file folder where you place the test data, or a DLP Agent scan of a copy/paste operation.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Review any incidents.</td>
<td>Review any matches at the Incident Snapshot screen. Verify a relatively low Similarity Score for each match. A relatively low Similarity Score indicates a false positive. If one or more test documents produce a match with a relatively high Similarity Score, you have a training set quality issue. In this case you need to review the content and if appropriate add the document(s) to the positive training set. You then need to retrain and retune the profile. See “Log files for troubleshooting VML training and policy detection” on page 531.</td>
</tr>
<tr>
<td>Step 6</td>
<td>Adjust the Similarity Threshold.</td>
<td>By reviewing the incidents you should now be able to determine the highest Similarity Score among the detected false positives that you have tested the profile against. At this point you can adjust the Similarity Threshold for the profile to be just above the highest Similarity Score for the false positives. For example, if the highest detected false positive has a Similarity Score of 4.5, set the Similarity Threshold to 4.6. This will filter the known false positives from being reported as incidents.</td>
</tr>
</tbody>
</table>

Properties for configuring training

VML includes several property files for configuring VML training and logging. The following table lists and describes relevant VML configuration properties.

Table 21-12  Property files for VML

<table>
<thead>
<tr>
<th>Property file at \Protect\config\</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MLDTraining.properties</td>
<td>Main property file for configuring VML training settings.</td>
</tr>
<tr>
<td></td>
<td>See Table 21-13 on page 530.</td>
</tr>
<tr>
<td>Manager.properties</td>
<td>Property file for the Enforce Server; contains 1 VML setting.</td>
</tr>
<tr>
<td></td>
<td>See Table 21-14 on page 531.</td>
</tr>
<tr>
<td>MLDTrainingLogging.properties</td>
<td>Properties file for configuring VML logging.</td>
</tr>
<tr>
<td></td>
<td>See “Log files for troubleshooting VML training and policy detection” on page 531.</td>
</tr>
</tbody>
</table>
The following table lists and describes the VML training parameters available for configuration in properties file MLDTraining.properties.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>minimum_documents_per_category</td>
<td>Specifies the minimum number of documents required for each training set (positive and negative). The default setting is 50. Reducing this number below 50 is not recommended or supported.</td>
</tr>
<tr>
<td></td>
<td>See “Recommendations for training set definition” on page 535.</td>
</tr>
<tr>
<td>mld_num_folds</td>
<td>Specifies the number of folds to use for the k-fold evaluation process. The default is 10.</td>
</tr>
<tr>
<td></td>
<td>Reducing this value will speed up the time the system takes to train against the content because less folds will be evaluated, but potentially at the sacrifice of visibility into profile quality. There is no need to change this value, unless you have a large number of example documents (and thus the training sets are very large), and you know for certain that you have a well-categorized overall training set.</td>
</tr>
<tr>
<td></td>
<td>See “Recommendations for accepting or rejecting a profile” on page 538.</td>
</tr>
<tr>
<td>minimum_features_to_keep</td>
<td>Specifies the minimum number of features to keep for the profile. The default setting is 1000.</td>
</tr>
<tr>
<td></td>
<td>Lowering this value can help reduce the size of the profile. However, adjusting this setting is not recommended. Instead, use the memory allocation setting to tune the size of the profile.</td>
</tr>
<tr>
<td></td>
<td>See “Guidelines for profile sizing” on page 537.</td>
</tr>
<tr>
<td>significance_threshold</td>
<td>Specifies the minimum number of times a word must occur before it is considered a feature. The default is 2.</td>
</tr>
<tr>
<td></td>
<td>Increasing this value (to 3 or 4, for example) may help reduce the size of the profile because fewer words will qualify as features. In general you should not adjust this setting unless setting the memory allocation to “Low” does not produce a small enough profile for your deployment requirements.</td>
</tr>
<tr>
<td></td>
<td>See “Guidelines for profile sizing” on page 537.</td>
</tr>
</tbody>
</table>
## Table 21-13 Relevant configuration parameters for VML training (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>stopword_file</strong></td>
<td>Specifies the default stopword file \config\machinelearningconfig\stopwords.txt.</td>
</tr>
<tr>
<td></td>
<td>Stopwords are common words, such as articles and prepositions. During training the system ignores (does not consider for feature extraction) any word contained in the stopwords file.</td>
</tr>
<tr>
<td></td>
<td>If you add words to be ignored, you must use all lower case because VML feature extraction normalizes the content to lower case for evaluation.</td>
</tr>
<tr>
<td><strong>logging_config_file</strong></td>
<td>Specifies the configuration file for standard VML logging.</td>
</tr>
<tr>
<td></td>
<td>See “Log files for troubleshooting VML training and policy detection” on page 531.</td>
</tr>
<tr>
<td><strong>native_logging_config_file</strong></td>
<td>Specifies the configuration file for native VML logging.</td>
</tr>
<tr>
<td></td>
<td>See &quot;Log files for troubleshooting VML training and policy detection” on page 531.</td>
</tr>
</tbody>
</table>

The following parameter is available for configuration in properties file `MLDTraining.properties`.

## Table 21-14 Configuration parameter for VML profiles

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DEFAULT_SIMILARITY_THRESHOLD</strong></td>
<td>Establishes the default value for the Similarity Threshold, which is 10. Changing this value affects the default value only. You can adjust the value using the Enforce Server administration console.</td>
</tr>
<tr>
<td></td>
<td>See &quot;Testing and tuning VML profiles” on page 528.</td>
</tr>
</tbody>
</table>

## Log files for troubleshooting VML training and policy detection

The system provides debug log files for troubleshooting the VML training process and policy detection. The following table lists and describes the debug log files.

See “Troubleshooting policies” on page 353.
Table 21-15  Debug log files for VML

<table>
<thead>
<tr>
<th>Log file</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>machinelearning_training.log</td>
<td>Records the accuracy from training percentage rates for each fold of the evaluation process for each VML profile training run. This log file is useful for examining the quality of each training set at a granular, per-fold level.</td>
</tr>
<tr>
<td></td>
<td>See “Recommendations for accepting or rejecting a profile” on page 538.</td>
</tr>
<tr>
<td>machinelearning_native_filereader.log</td>
<td>Records the &quot;distance,&quot; which is expressed as a positive or negative number, and the &quot;confidence,&quot; which is a similarity percentage, for each message evaluated by a VML policy.</td>
</tr>
<tr>
<td></td>
<td>This log file is useful for examining all messages or documents evaluated by VML policies, including positive matches with similarity percentages beneath the Similarity Threshold, or messages the system has categorized as negative (expressed as a negative &quot;distance&quot; number).</td>
</tr>
<tr>
<td></td>
<td>See “Testing and tuning VML profiles” on page 528.</td>
</tr>
<tr>
<td>machinelearning_training_native_manager.log</td>
<td>Records the total number of features modeled and the number of features kept to generate the profile for each training run. The total number of features modeled versus the number of features kept for the profile depends on the memory allocation setting:</td>
</tr>
<tr>
<td></td>
<td>■ If &quot;high&quot; the system keeps 80% of the features.</td>
</tr>
<tr>
<td></td>
<td>■ If &quot;medium&quot; the system keeps 50% of the features.</td>
</tr>
<tr>
<td></td>
<td>■ If &quot;low&quot; the system keeps 30% of the features.</td>
</tr>
<tr>
<td></td>
<td>See “Guidelines for profile sizing” on page 537.</td>
</tr>
</tbody>
</table>

Best practices for using VML

This section provides best practices for implementing VML policies, including best practices for testing and tuning your VML policies.

In addition, you can download example VML training set documents from the DLP Knowledgebase ([https://kb-vontu.altiris.com](https://kb-vontu.altiris.com)), article number 54340. These documents are provided under the Creative Commons license ([http://creativecommons.org/licenses/by-sa/3.0/](http://creativecommons.org/licenses/by-sa/3.0/)).

The following table provides a summary of the VML best practices discussed in this section, with links to individual topics for more in-depth recommendations.
### Table 21-16  Summary of VML best practices

<table>
<thead>
<tr>
<th>Functional area</th>
<th>Best practice</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Recommended uses for VML</strong></td>
<td>Use VML to protect unstructured, text-based content. Do not use VML to protect graphics, binary data, or personally identifiable information (PII). See “When to use VML” on page 533.</td>
</tr>
<tr>
<td><strong>Category of content</strong></td>
<td>Define the VML profile based on a single category of content that you want to protect and that is derived from a specific business use case. Narrowly defined categories are better than broadly defined ones. See “Recommendations for training set definition” on page 535.</td>
</tr>
<tr>
<td><strong>Positive training set</strong></td>
<td>Archive and upload the recommended (250) number of example documents for the positive training set, or at least the minimum (50). See “Guidelines for training set sizing” on page 536.</td>
</tr>
<tr>
<td><strong>Negative training set</strong></td>
<td>Archive and upload the example documents for the negative training set. Ideally the negative training set contains a similar number of well-categorized documents as the positive training set. In addition, add some documents containing generic or neutral content to your negative training set. See “Guidelines for training set sizing” on page 536.</td>
</tr>
<tr>
<td><strong>Profile sizing</strong></td>
<td>Consider adjusting the memory allocation to low. Internal testing has shown that setting the memory allocation to low may improve accuracy in certain cases. See “Guidelines for profile sizing” on page 537.</td>
</tr>
<tr>
<td><strong>Training set quality</strong></td>
<td>Reject the training result and adjust the example documents if either of the base accuracy rates from training are more than 5%. See “Recommendations for accepting or rejecting a profile” on page 538.</td>
</tr>
<tr>
<td><strong>Profile tuning</strong></td>
<td>Tune the VML profile by performing negative testing using a corpus of testable data. See “Testing and tuning VML profiles” on page 528.</td>
</tr>
<tr>
<td><strong>Profile deployment</strong></td>
<td>Remove accepted profiles not in use by policies to reduce detection server load. Tune the Similarity Threshold before deploying a profile into production across all endpoints to avoid network overhead. See “Recommendations for deploying profiles” on page 540.</td>
</tr>
</tbody>
</table>

### When to use VML

VML is designed to protect unstructured content that is primarily text-based. VML is well-suited for protecting sensitive content that is highly distributed such that gathering all of it for fingerprinting is not possible or practical. VML is also well-suited
for protecting sensitive content that you cannot adequately describe and achieve high matching accuracy.

The following table summarizes the recommended uses cases for VML.

<table>
<thead>
<tr>
<th>Use VML when</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>It is not possible or practical to fingerprint all the data you want to protect.</td>
<td>Often collecting all of the content you want to protect for fingerprinting is an impossible task. This situation arises for many forms of unstructured data: marketing materials, financial documents, patient records, product formulas, source code, and so forth. VML works well for this situation because you do not have to collect all of the content you want to protect, only a smaller set of example documents.</td>
</tr>
<tr>
<td>You cannot adequately describe the data you want to protect.</td>
<td>Often describing the data you want to protect is difficult without sacrificing some accuracy. This situation may arise when you have long keyword lists that are hard to generate, tune, and maintain. VML works well in these situations because it automatically models the features (keywords) you want to protect, and lets you easily manage and update the source content.</td>
</tr>
<tr>
<td>A policy reports frequent false positives.</td>
<td>Sometimes a certain category of information is a constant source of false positives. For example, a weekly sales report may consistently produce false positives for a Data Identifier policy looking for social security numbers. VML may work well here because you can train against the content that causes the false positives and create a policy exception to ignore those features. <strong>Note:</strong> The false positive contents must belong to a well-defined category for VML to be an effective solution for this use case. See &quot;Recommendations for training set definition&quot; on page 535.</td>
</tr>
</tbody>
</table>

**When not to use VML**

VML is not designed to protect structured data, such as Personally Identifiable Information (PII), or binary content, such as documents that contain mostly graphics or image files.

The following table summarizes the non-recommended uses of VML.

<table>
<thead>
<tr>
<th>Do not use VML to</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protect personally identifiable information (PII).</td>
<td>Exact Data Matching (EDM) and Data Identifiers are the best option for protecting the common types of PII.</td>
</tr>
</tbody>
</table>
Recommendations for training set definition

A VML category is the specific business use case from which you derive your example documents for training the VML profile. The more specific the category the better the detection results. For example, the category "Financial Documents" is not recommended because it is too broad. A better category classification is "Sales Forecasts" or "Quarterly Earnings" because each is particular to a specific business use case.

A VML category contains two sets of training content: positive and negative. The positive training set contains content you want to protect; the negative training set contains content you want to ignore. You should derive both the positive and negative training sets from the same category of content such that all documents are thematically related.

While it is possible to use entirely generic content for the negative training set, this is not recommended. A completely generic negative training set may produce good design-time training accuracy rates, but it is likely that at runtime you will not be able to detect the content you want to protect with sufficient accuracy.

Note: While a completely generic negative training set is not recommended, seeding the negative training set with some neutral-content documents does have value. See “Guidelines for training set sizing” on page 536.

The following table provides some example categories and possible positive and negative training sets comprising those categories.

Table 21-19  Some example categories and training sets

<table>
<thead>
<tr>
<th>Category</th>
<th>Positive training set</th>
<th>Negative training set</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product Source Code</td>
<td>Proprietary product source code</td>
<td>Source code from open source projects</td>
</tr>
<tr>
<td>Product Formulas</td>
<td>Proprietary product formulas</td>
<td>Non-proprietary product information</td>
</tr>
<tr>
<td>Quarterly Earnings</td>
<td>Pre-release earnings; sales estimates; accounting documents</td>
<td>Details of published annual accounts</td>
</tr>
</tbody>
</table>
Table 21-19  Some example categories and training sets (continued)

<table>
<thead>
<tr>
<th>Category</th>
<th>Positive training set</th>
<th>Negative training set</th>
</tr>
</thead>
<tbody>
<tr>
<td>Marketing Plans</td>
<td>Marketing plans</td>
<td>Published marketing collateral, advertising copy</td>
</tr>
<tr>
<td>Medical Records</td>
<td>Patient medical records</td>
<td>Healthcare documents</td>
</tr>
<tr>
<td>Customer Sales</td>
<td>Customer purchasing patterns</td>
<td>Publicly available consumer data</td>
</tr>
<tr>
<td>Mergers and Acquisitions</td>
<td>Confidential legal documents; M&amp;A documents</td>
<td>Publicly available materials; press releases</td>
</tr>
<tr>
<td>Manufacturing Methods</td>
<td>Proprietary manufacturing methods and research</td>
<td>Industry standards</td>
</tr>
</tbody>
</table>

Guidelines for training set sizing

VML is only as accurate as the example content you train. Unlike other detection technologies, to use VML you do not have to locate all the data you want to protect, nor do you have to describe it. But, you must select example documents that accurately represent the type of content you want to protect, as well as content you want to ignore that is thematically related to the positive content.

The more example documents you collect for training the more accurate the VML profile will be. A well-defined category of content contains 500 example documents: 250 positive and 250 negative. The minimum number of documents per training set is 50.

Ideally you will collect for training a similar number of negative documents as positive. However, this is not always possible. Regardless of how many negative documents you collect, you should seed the negative training set with generic or neutral-content documents. The archive file DLP_Wikipedia_sample.zip that is attached to this guide at the Knowledgebase is provided for this purpose. For example, if your positive training set contains the recommended number of example documents (250), and the negative training set contains 150 documents, you could add 100 to 200 generic documents to your negative training set from the DLP_Wikipedia_sample.zip archive file. Internal testing has shown that adding generic content to complement an otherwise well-defined negative training set can improve accuracy for VML.

If you cannot collect enough positive documents to meet the minimum requirement, you can upload the under-sized training set multiple times. For example, consider a case where you have the category of content "Sales Forecasts." For this category you have collected 25 positive spreadsheets and 50 negative documents. In this case, you could upload the positive training set twice to reach the minimum
document threshold and equal the number of negative documents. Note that you should use this technique for development and testing purposes only. Production profiles should be trained against at least the minimum number of documents for both training sets.

The table below lists the optimal, recommended, and minimum number of documents to include in each training set.

Note: These training set guidelines assume an average document size of 3 KB. If you have larger-sized documents, fewer in number may be sufficient.

<table>
<thead>
<tr>
<th>Training set</th>
<th>Minimum</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>Positive example documents</td>
<td>50</td>
<td>250</td>
</tr>
<tr>
<td>Negative example documents</td>
<td>50</td>
<td>250</td>
</tr>
<tr>
<td>Total number of documents for the category</td>
<td>100</td>
<td>500</td>
</tr>
</tbody>
</table>

Recommendations for uploading documents for training

While you can upload individual documents to the Enforce Server for training, it is recommended that you upload a document archive (ZIP, RAR, TAR) that contains the example documents for each training set. The maximum upload size is 30 MB. There is no training set size limit.

To gather the documents for training, it is recommended that you create a staging area. For example, consider a category called “Sales Reports.” In this case you would create a folder called \\VML\training_stage\sales_reports that represents the category. Within this folder you would create two subfolders, one for the positive training set and the other for the negative training set (for example: \\VML\training_stage\sales_reports\positive). When you are ready to train the profile, you compress the positive subfolder and the negative subfolder into separate document archives. You can partition the training set across archives if you have more than 30 MB of data to upload for a training set. Do not embed an archive within an archive.

Guidelines for profile sizing

Before you train a VML profile, you can adjust the amount of memory allocated to the profile. The amount of memory you allocate determines how many features the system models, which in turn affects the size of the profile. The higher the memory...
allocation setting, the more in-depth the feature extraction and the plotting of the model, and the larger the profile. In general, for server-based policy detection, the recommended memory allocation setting is high, which is the default setting.

On the endpoint, the VML profile is deployed to the host computer and loaded into memory by the DLP Agent. (Unlike EDM and IDM, VML does not rely on two-tier detection for endpoint policies.) Because memory on the endpoint is limited, the recommendation is to allocate low or medium memory for endpoint policies. Internal testing has shown that reducing the memory allocation does not reduce the accuracy of the profile and may improve accuracy in certain situations.

### Table 21-21 Memory allocation recommendations

<table>
<thead>
<tr>
<th>Memory allocation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>High</td>
<td>Default setting generally appropriate for server-based detection.</td>
</tr>
<tr>
<td>Medium</td>
<td>Use this setting to reduce the size of the profile.</td>
</tr>
<tr>
<td>Low</td>
<td>Use this setting for endpoint detection.</td>
</tr>
</tbody>
</table>

**Recommendations for accepting or rejecting a profile**

When you train a VML profile against the category content, the system selects features, creates the model, and calculates the base accuracy rates for false positives and negatives. Base accuracy rates are calculated using a standard and generally accepted process called k-folds evaluation. The base accuracy rates provide you with an early indicator of the quality of your category training sets.

To illustrate how the k-folds evaluation process works, assume that you have a category with 500 total example documents: 250 positive and 250 negative. During the training run, the system divides the training set into 10 folds, each of which are distinct subsets of the overall training set and contain both positive and negative example documents. The system uses nine folds to generate a VML profile, and one fold to test the profile. Any of the folds can become the test fold for the first round of evaluation. For the next round, the next fold in the queue becomes the test fold. This process repeats for all 10 folds. The system performs a final training run called the cross-fold, averages the results of all folds, and generates the final model.

On successful completion of the training process, the system displays the averaged accuracy rates and prompts you to accept or reject the training profile. The false positive accuracy rate is the percentage of negative test documents misclassified as positive. The false negative rate is the percentage of positive test documents that are misclassified as negative. As a general guideline, you should reject the training profile if either rate is more than 5%.
Guidelines for accepting or rejecting training results

You decide to accept or reject a training profile based on the false positive and false negative percentages that the system displays to you at the end of the training process.

See “About the Similarity Threshold and Similarity Score” on page 512.

To better understand how the system calculates the Machine Learning Profile training set accuracy rates, consider the following example.

You have a training set that includes 1000 documents, 500 positive and 500 negative. When you train the profile, the system takes 90% of the documents, extracts the features, and creates a model. It takes the remaining 10% of the documents and evaluates their features against the model for similarity, producing false positive and false negative accuracy rates. This process is known as the "fold." For each training set, the system evaluates ten folds, each time comparing a different 10% of the documents against the 90%. At the end of the cycle, the system performs a cross-fold evaluation of all ten folds and produces an average accuracy percentage rate for both the positive and negative categories.

Continuing the example, assume the result of the training process yields a base false positive rate of approximately 1.2% and a base false negative rate of approximately 1%. This means that, on average, 1.2% of the negative documents in the training set are miscategorized as positive, and 1% of the documents in the training set are miscategorized as negative. While the goal is 0% for both rates, in general a percentage rate below 5% for each category is acceptable.

However, since, the percentages produced at the end of the training process are averages across the 10 folds, rather than relying on the general 5% rule of thumb, the better practice is to review the percentage rate results for each fold. To do this, examine the log file \Vontu\Protect\logs\debug\mld0.log. As shown below, the individual fold rates give a reading for each of the ten folds on which you can base your decision to accept or reject the profile.

Table 21-22  Training set accuracy evaluation process

<table>
<thead>
<tr>
<th>Fold evaluation</th>
<th>Per fold category accuracy rates and cross-fold averages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fold 0</td>
<td>false positive rate 2.013422727584839  ( 0.0 )</td>
</tr>
<tr>
<td>Fold 1</td>
<td>false positive rate 1.3513513803482056  ( 1.7857142686843872 )</td>
</tr>
</tbody>
</table>
### Table 21-22  
**Training set accuracy evaluation process (continued)**

<table>
<thead>
<tr>
<th>Fold evaluation</th>
<th>Per fold category accuracy rates and cross-fold averages</th>
</tr>
</thead>
</table>
| Fold 2          | false positive rate 1.3513513803482056  
false negative rate 0.8928571343421936|
| Fold 3          | false positive rate 1.3513513803482056  
false negative rate 1.7857142686843872|
| Fold 4          | false positive rate 1.3513513803482056  
false negative rate 0.8928571343421936|
| Fold 5          | false positive rate 1.3513513803482056  
false negative rate 2.6785714626312256|
| Fold 6          | false positive rate 0.0  
false negative rate 0.0|
| Fold 7          | false positive rate 0.6756756901741028  
false negative rate 0.0|
| Fold 8          | false positive rate 1.3513513803482056  
false negative rate 0.8928571343421936|
| Fold 9          | false positive rate 1.3513513803482056  
false negative rate 1.8018018007278442|
| Cross-fold      | Avg False Positive Rate 1.214855808019638  
Avg False Negative Rate 1.0730373203754424|

### Recommendations for deploying profiles

Accepted VML profiles are transferred to every detection server and Symantec DLP Agent even if those profiles are not required by the active policies on that server or endpoint. Detection servers load all VML profiles into memory regardless of whether or not any associated VML policies are deployed to those servers. DLP Agents only load the VML profiles that are required by an active policy. To optimize server performance, it is recommended not to deploy (accept) unnecessary VML profiles and remove any accepted (deployed) VML profiles that are not required by active policies.

In addition, when you change the Similarity Threshold, the system re-syncs the entire profile with the detection servers and DLP Agents. If you have a large VML profile and possible bandwidth limitations (for example, deployment to many endpoints), this may cause network congestion. In this case you should test and tune the profile at a select few endpoints before deploying the profile into production at every endpoint on your network.
Detecting content using data identifiers

This chapter includes the following topics:

- Introducing data identifiers
- Configuring data identifier policy conditions
- Modifying system data identifiers
- Creating custom data identifiers
- Best practices for using data identifiers

Introducing data identifiers

Symantec Data Loss Prevention provides data identifiers to detect specific instances of described content. Data identifiers let you quickly implement precise, short-form data matching with minimal effort.

Data identifiers are algorithms that combine pattern matching with data validators to detect content. Patterns are similar to regular expressions but more efficient because they are tuned to match the data precisely. Validators are accuracy checks that focus the scope of detection and ensure compliance.

For example, the "Credit Card Number" system data identifier detects numbers that match a specific pattern. The matched pattern is validated by a "Luhn check," which is an algorithm. In this case the validation is performed on the first 15 digits of the number that evaluates to equal the 16th digit.

Symantec Data Loss Prevention provides preconfigured data identifiers that you can use to detect commonly used sensitive data, such as credit card, social security, and driver’s license numbers. Data identifiers come in three breadths—wide,
medium, and narrow—so you can fine-tune your detection results. Data identifiers offer broad support for detecting international content.

If a system-defined data identifier does not meet your needs, you can modify it. You can also define your own custom data identifiers to detect any content that you can describe.

See “System-defined data identifiers” on page 542.

See “Selecting a data identifier breadth” on page 555.

System-defined data identifiers

Symantec Data Loss Prevention provides several system-defined data identifiers to help you detect and validate pattern-based sensitive data.

Table 22-1  System data identifiers

<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Personal Identity</td>
<td>Detect various types of identification numbers for the regions of North America, Europe, and Asia Pacific.</td>
</tr>
<tr>
<td></td>
<td>See Table 22-2 on page 543.</td>
</tr>
<tr>
<td></td>
<td>See Table 22-3 on page 543.</td>
</tr>
<tr>
<td></td>
<td>See Table 22-4 on page 544.</td>
</tr>
<tr>
<td></td>
<td>See Table 22-4 on page 544.</td>
</tr>
<tr>
<td>Financial</td>
<td>Detect financial identification numbers, such as credit card numbers and ABA routing numbers.</td>
</tr>
<tr>
<td></td>
<td>See Table 22-5 on page 545.</td>
</tr>
<tr>
<td>Healthcare</td>
<td>Detect U.S. and international drug codes.</td>
</tr>
<tr>
<td></td>
<td>See Table 22-6 on page 545.</td>
</tr>
<tr>
<td>Information Technology</td>
<td>Detect IP addresses.</td>
</tr>
<tr>
<td></td>
<td>See “Information technology data identifier” on page 545.</td>
</tr>
<tr>
<td>Internation keywords</td>
<td>International keywords for PII data identifiers.</td>
</tr>
<tr>
<td></td>
<td>See “International keywords for PII data identifiers” on page 545.</td>
</tr>
</tbody>
</table>

Personal identity data identifiers

Symantec Data Loss Prevention provides various data identifiers for detecting personally identifiable information (PII) for the regions of Asia Pacific, Europe, and North America.
See Table 22-2 on page 543. lists system-defined data identifiers for the Asia Pacific region.

### Table 22-2  Asia Pacific personal identity

<table>
<thead>
<tr>
<th>Data identifier</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Australian Tax File Number</td>
<td>See “Australian Tax File Number data identifier” on page 707.</td>
</tr>
<tr>
<td>People’s Republic of China ID</td>
<td>See “People’s Republic of China ID data identifier” on page 758.</td>
</tr>
<tr>
<td>Hong Kong ID</td>
<td>See “Hong Kong ID data identifier” on page 743.</td>
</tr>
<tr>
<td>Singapore NRIC</td>
<td>See “Singapore NRIC data identifier” on page 760.</td>
</tr>
<tr>
<td>South Korean Resident Registration Number</td>
<td>See “South Korea Resident Registration Number data identifier” on page 761.</td>
</tr>
<tr>
<td>Taiwan ID</td>
<td>See “Taiwan ID data identifier” on page 767.</td>
</tr>
</tbody>
</table>

See Table 22-3 on page 543. lists system-defined data identifiers for the European region.

### Table 22-3  European personal identity

<table>
<thead>
<tr>
<th>Data identifier</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Codice Fiscale</td>
<td>See “Codice Fiscale data identifier” on page 712.</td>
</tr>
<tr>
<td>Spanish DNI ID</td>
<td>See “Spanish DNI ID data identifier” on page 763.</td>
</tr>
<tr>
<td>Burgerservicenummer</td>
<td>See “Burgerservicenummer data identifier” on page 707.</td>
</tr>
<tr>
<td>UK Driver’s License Number</td>
<td>See “UK Drivers License Number data identifier” on page 768.</td>
</tr>
<tr>
<td>UK Tax ID Number</td>
<td>See “UK Tax ID Number data identifier” on page 785.</td>
</tr>
<tr>
<td>UK Passport Number</td>
<td>See “UK Passport Number data identifier” on page 781.</td>
</tr>
<tr>
<td>UK National Insurance Number</td>
<td>See “UK National Insurance Number data identifier” on page 777.</td>
</tr>
<tr>
<td>UK National Health Service (NHS) Number</td>
<td>See “UK National Health Service (NHS) Number data identifier” on page 773.</td>
</tr>
<tr>
<td>UK Electoral Roll Number</td>
<td>See “UK Electoral Roll Number data identifier” on page 772.</td>
</tr>
</tbody>
</table>
Table 22-3   European personal identity (continued)

<table>
<thead>
<tr>
<th>Data identifier</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Swiss AHV Number</td>
<td>See “Swiss AHV Number data identifier” on page 767.</td>
</tr>
</tbody>
</table>

Table 22-4 lists system-defined data identifiers for the North American region.

Table 22-4   North American personal identity

<table>
<thead>
<tr>
<th>Data identifier</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Note: This data identifier is replaced by the Randomized US SSN data identifier.</td>
</tr>
<tr>
<td>Canadian Social Insurance Number</td>
<td>See “Canadian Social Insurance Number data identifier” on page 708.</td>
</tr>
<tr>
<td>US Individual Tax ID Number (ITIN)</td>
<td>See “UK Tax ID Number data identifier” on page 785.</td>
</tr>
<tr>
<td>Driver's License Number – CA State</td>
<td>See “Drivers License Number – CA State data identifier” on page 730.</td>
</tr>
<tr>
<td>Driver's License Number – IL State</td>
<td>See “Drivers License Number - IL State data identifier” on page 735.</td>
</tr>
<tr>
<td>Driver's License Number – NJ State</td>
<td>See “Drivers License Number - NJ State data identifier” on page 737.</td>
</tr>
<tr>
<td>Driver's License Number – NY State</td>
<td>See “Drivers License Number - NY State data identifier” on page 740.</td>
</tr>
<tr>
<td>Driver's License Number – FL, MI, MN States</td>
<td>See “Drivers License Number - FL, MI, MN States data identifier” on page 732.</td>
</tr>
</tbody>
</table>

Financial data identifiers

Table 22-5 lists system-defined data identifiers for detecting financial identification numbers, such as credit card numbers and ABA routing numbers.
### Financial data identifiers

<table>
<thead>
<tr>
<th>Data identifier</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Credit Card Number</td>
<td>See “Credit Card Number data identifier” on page 715.</td>
</tr>
<tr>
<td>ABA Routing Number</td>
<td>See “ABA Routing Number data identifier” on page 702.</td>
</tr>
<tr>
<td>CUSIP Number</td>
<td>See “CUSIP Number data identifier” on page 726.</td>
</tr>
<tr>
<td>Credit Card Magnetic Stripe Data</td>
<td>See “Credit Card Magnetic Stripe Data data identifier” on page 713.</td>
</tr>
<tr>
<td>IBAN West</td>
<td>See “IBAN West data identifier” on page 748.</td>
</tr>
<tr>
<td>IBAN Central</td>
<td>See “IBAN Central data identifier” on page 743.</td>
</tr>
<tr>
<td>IBAN East</td>
<td>See “IBAN East data identifier” on page 745.</td>
</tr>
</tbody>
</table>

### Healthcare data identifiers

Table 22-6 lists system-defined data identifiers for detecting U.S. and international drug codes.

<table>
<thead>
<tr>
<th>Data identifier</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>National Drug Code</td>
<td>See “National Drug Code (NDC) data identifier” on page 754.</td>
</tr>
<tr>
<td>Australian Medicare Number</td>
<td>See “Australian Medicare Number data identifier” on page 706.</td>
</tr>
</tbody>
</table>

### Information technology data identifier

Symantec Data Loss Prevention provides the IP Address data identifier for detecting IP addresses in the IPv4 format. IPv6 formats are not supported.

See “IP Address data identifier” on page 750.

### International keywords for PII data identifiers

Symantec Data Loss Prevention lets you modify system data identifiers and customize the input keywords to detect a broad range of international content.

See “Extending and customizing data identifiers” on page 546.
Extending and customizing data identifiers

You can customize data identifiers to suit your requirements. You can extend system-defined data identifiers by modifying them. And, you can create new data identifiers for custom data matching.

The most common use case for modifying a system-defined data identifier is to edit the data input for a validator that accepts data input. For example, if the data identifier implements the "Find keywords" validator, you may want to add or remove values from the list of keywords. Another use case may involve adding or removing validators to or from the data identifier, or changing one or more of the patterns defined by the data identifier.

To create a custom data identifier, you implement one or more detection pattern(s), select one or more data validators, provide the data input if the validator requires it, and choose a data normalizer.

Policy authors can reuse modified and custom data identifiers in one or more policies.

About data identifier configuration

You can configure three types of data identifiers:

- Instance – defined at the policy level
  See “Conifuring data identifier policy conditions” on page 549.

- Modified – configured at the system-level
  See “Modifying system data identifiers” on page 564.

- Custom – created at the system-level
  See “Creating custom data identifiers” on page 570.

The type of data identifier you implement depends on your business requirements. For most use cases, configuring a policy instance using a non-modified, system-defined data identifier is sufficient to accurately detect data loss. Should you need to, you can extend a system-defined data identifier by modifying it, or you can implement one or more custom data identifiers to detect unique data.

Data identifier configuration done at the policy instance-level is specific to that policy. Modifications you make to data identifiers at the system-level apply to all data identifiers derived from the modified data identifier.
About data identifier breadths

System data identifiers are implemented by breadth. The breadth defines the scope of detection for that data identifier. Each data identifier implements at least one breadth of detection. The widest option available for the data identifier is likely to produce the most false positive matches; the narrowest option produces the least. Generally the validators and often the patterns differ among breadths.

See “Using data identifier breadths” on page 554.

For example, the Driver's License Number – CA State data identifier provides wide and medium breadths, with the medium breadth using a keyword validator.

---

Note: Not all system data identifiers provide each breadth of detection. Refer to the complete list of data identifiers and breadths to determine what is available.

See “Selecting a data identifier breadth” on page 555.

---

About optional validators for data identifiers

Optional validators help you refine the scope of detection for a data identifier. When you configure a data identifier instance, you can select among five optional validators.

See “Using optional validators” on page 558.

The type of characters accepted by each optional validator depends on the data identifier.

See “Acceptable characters for optional validators” on page 560.

---

Note: Optional validators only apply to the policy instance you are actively configuring; they do not apply system-wide.

---

About data identifier patterns

Data identifiers implement patterns to match data. The data identifier pattern syntax is similar to the regular expression language, but more limited. For example, the data identifier pattern syntax does not support some regular expression features, including grouping, lookahead and lookbehind expressions, and many special characters (notably the dot “.” character). In addition, the system only allows the use of ASCII characters for data identifier patterns.

See “Using the data identifier pattern language” on page 573.
When you edit a system data identifier, the system exposes the pattern for viewing and editing. The system-defined data identifier patterns have been tuned and optimized for precise content matching.

See “Selecting a data identifier breadth” on page 555.

In addition, you can create a custom data identifier in which case you are required to implement at least one pattern. The best way to understand how to write patterns is to examine the system-defined data identifier patterns.

See “Writing data identifier patterns to match data” on page 574.

About pattern validators

Pattern validators are validation checks applied to data matched by a data identifier pattern. Validators help refine the scope of detection and reduce false positives. Many validators allow for data input. For example, the Keyword validator lets you enter a list of keywords.

See “Using pattern validators” on page 575.

When you modify a data identifier, you can edit the input values for any validator that accepts data.

See “Editing pattern validator input” on page 566.

When you modify a data identifier, you can add and remove pattern validators. When you create custom data identifiers, you can configure one or more validators. The system also provides you with the ability to author a custom script validator to define your own validation check.

See “Selecting pattern validators” on page 577.

About data normalizers

A data normalizer reconciles the data detected by the data identifier pattern with the format expected by the normalizer. You cannot modify the normalizer of a system-defined data identifier. When you create a custom data identifier, you select a data normalizer.

See “Acceptable characters for optional validators” on page 560.

See “Selecting a data normalizer” on page 578.

About cross-component matching

Data identifiers support component matching. This means that you can configure data identifiers to match on one or more message components. However, if the data identifier implements a validator (optional or required), such as Find keywords,
the validated data and the matched data must exist in the same component to trigger or except an incident.

See “Detection messages and message components” on page 305.

For example, consider a scenario where you implement the Randomized US Social Security Number (SSN) data identifier. This data identifier detects on various 9-digits patterns and uses a keyword validator to narrow the scope of detection. (The keyword and phrases in the list are "social security number, ssn, ss#"). If the detection engine receives a message with the number pattern 123-45-6789 and the keyword "social security number" and both data items are contained in the message attachment component, the detection engine reports a match. However, if the attachment contains the number but the body contains the keyword validator, the detection engine does not consider this to be a match.

See “Configuring the Content Matches data identifier condition” on page 552.

See “Randomized US Social Security Number (SSN) data identifier” on page 759.

About unique match counting

Data identifiers support unique match counting. This feature lets you count only those pattern matches that are unique.

Unique match counting is useful when you are only concerned with detecting the presence of unique patterns and not with detecting every matched pattern. For example, you could use unique match counting to trigger an incident if a document contains 10 or more unique social security numbers. In this case, if a document contained 10 instances of the same social security number, the policy would not trigger an incident.

See “Using unique match counting” on page 562.

See “Configuring unique match counting” on page 563.

Configuring data identifier policy conditions

Table 22-7 lists and describes the configuration options for data identifier conditions.

See “Introducing data identifiers” on page 541.

See “Configuring the Content Matches data identifier condition” on page 552.
Table 22-7  Policy instance data identifier configuration

<table>
<thead>
<tr>
<th>Selectable at the policy level</th>
<th>Not configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>■ <strong>Breadth</strong>&lt;br&gt;You can implement any breadth the data identifier supports at the instance level.</td>
<td>■ <strong>Patterns</strong>&lt;br&gt;You cannot modify the match patterns at the instance level.</td>
</tr>
<tr>
<td>■ <strong>Optional Validators</strong>&lt;br&gt;You can select one or more optional validators at the instance level.</td>
<td>■ <strong>Active Validators</strong>&lt;br&gt;You cannot modify, add, or remove required validators at the instance level.</td>
</tr>
</tbody>
</table>

Workflow for configuring data identifier policies

Table 22-8 describes the workflow for implementing system-defined data identifiers.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Decide the type of data identifier you want to implement.</td>
<td>See “Introducing data identifiers” on page 541.</td>
</tr>
<tr>
<td>2</td>
<td>Decide the data identifier breadth.</td>
<td>See “About data identifier breadths” on page 547.</td>
</tr>
<tr>
<td>3</td>
<td>Configure the data identifier.</td>
<td>See “Configuring the Content Matches data identifier condition” on page 552.</td>
</tr>
<tr>
<td>4</td>
<td>Test and tune the data identifier policy.</td>
<td>See “Best practices for using data identifiers” on page 579.</td>
</tr>
</tbody>
</table>

Managing and adding data identifiers

The Manage > Policies > data identifiers screen lists all data identifiers, including system- and custom-defined. From this screen you manage and modify existing data identifiers, and add new ones.

See “Introducing data identifiers” on page 541.
Table 22-9  Manage data identifiers

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| Edit a data identifier.               | Select the data identifier from the list to modify it.  
  See “Selecting a data identifier breadth” on page 555.  
  See “Extending and customizing data identifiers” on page 546.  
  See “Editing data identifiers” on page 551. |
| Define a custom data identifier.      | Click Add data identifier to create a custom data identifier.  
  See “Custom data identifier configuration” on page 572.  
  See “Workflow for creating custom data identifiers” on page 570. |
| Sort and view data identifiers.       | The list is sorted alphabetical by Name.  
  You can also sort by the Category.  
  A pencil icon to the left means that the data identifier is modified from its original state, or is custom. |
| Remove a data identifier.             | Click the X icon on the right side to delete a data identifier.  
  The system does not let you delete system data identifiers. You can only delete custom data identifiers. |

**Editing data identifiers**

You can modify system-defined data identifiers, including the patterns, validators, and validator input. Modifications are propagated to any policy that declares the data identifier. You cannot rename a system data identifier. Consider manually creating a cloned copy before you modify a system data identifier.

See “Extending and customizing data identifiers” on page 546.

---

**Note:** The system does not export data identifiers in a policy template. The system exports a reference to the system data identifier. The target system where the policy template is imported provides the actual data identifier. If you modify a system-defined data identifier, the modifications do not export to the template.
### Table 22-10  Workflow for editing data identifiers

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| Step 1 | Clone the system data identifier you want to modify. | Clone the system data identifier before you modify it.  
See “Cloning a system data identifier before modifying it” on page 565.  
See “Clone system-defined data identifiers before modifying to preserve original state” on page 581. |
| Step 2 | Edit the cloned data identifier. | If you modify a system data identifier, click the plus sign to display the breadth and edit the data identifier.  
See “Selecting a data identifier breadth” on page 555. |
| Step 3 | Edit one or more Patterns. | You can modify any pattern that the Data Identifier provides.  
See “Writing data identifier patterns to match data” on page 574. |
| Step 4 | Edit the data input for any validator that accepts input. | See “Editing pattern validator input” on page 566.  
See “List of pattern validators that accept input data” on page 566. |
| Step 5 | Optionally, you can add or remove Validators, as necessary. | See “Selecting pattern validators” on page 577. |
| Step 6 | Save the data identifier. | Click Save to save the modifications.  
Once the data identifier is saved, the icon at the Data Identifiers screen indicates that it is modified from its original state, or is custom.  
See “Managing and adding data identifiers” on page 550.  
**Note:** Click Cancel to not save the Data Identifier. |
| Step 7 | Implement the data identifier in a policy rule or exception. | See “Configuring the Content Matches data identifier condition” on page 552. |

### Configuring the Content Matches data identifier condition

You can configure the Content Matches data identifier condition in policy detection rules and exceptions.

See "Introducing data identifiers" on page 541.
## Table 22-11  Configuring the Content Matches data identifier condition

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Add a data identifier rule or exception to a policy, or configure an existing one.</td>
<td>Select the <strong>Content Matches data identifier</strong> condition at the <strong>Add Detection Rule</strong> or <strong>Add Exception</strong> screen. See “Adding a rule to a policy” on page 328. See “Adding an exception to a policy” on page 337.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Choose a data identifier.</td>
<td>Choose a data identifier from the list and click <strong>Next</strong>. See “System-defined data identifiers” on page 542.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Select a <strong>Breadth</strong> of detection.</td>
<td>Use the breadth option to narrow the scope of detection. See “About data identifier breadths” on page 547. Wide is the default setting and detects the broadest set of matches. Medium and narrow breadths, if available, check additional criteria and detect fewer matches. See “Selecting a data identifier breadth” on page 555.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Select and configure one or more <strong>Optional Validators</strong>.</td>
<td>Optional validators restrict the match criteria and reduce false positives. See “About optional validators for data identifiers” on page 547.</td>
</tr>
</tbody>
</table>
| Step 5 | Configure **Match Counting**. | Select how you want to count matches:  
  - **Check for existence**  
    Do not count multiple matches; report a match count of 1 for one or more matches.  
  - **Count all matches**  
    Count each match; specify the minimum number of matches to report an incident. See “Configuring match counting” on page 334.  
  - **Count all unique matches**  
    This is the default setting for version 11.6 and higher. See “About unique match counting” on page 549. See “Configuring unique match counting” on page 563. |
Table 22-11  Configuring the Content Matches data identifier condition (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 6</td>
<td>Configure the message components to <strong>Match On</strong>.</td>
<td>Select one or more message components on which to match. On the endpoint, the detection engine matches the entire message, not individual components. See “Selecting components to match on” on page 336. If the data identifier uses optional or required keyword validators, the keyword must be present in the same component as the matched data identifier content. See “About cross-component matching” on page 548.</td>
</tr>
<tr>
<td>Step 7</td>
<td>Configure additional conditions to <strong>Also Match</strong>.</td>
<td>Optionally, you can <strong>Add</strong> one or more additional conditions from any available in the <strong>Also Match</strong> condition list. All conditions in a compound rule or exception must match to trigger or except an incident. See “Configuring compound match conditions” on page 342.</td>
</tr>
</tbody>
</table>

Using data identifier breadths

Each system data identifier provides one or more breadths of detection. When you configure a system data identifier instance, or when you modify a system data identifier, you select which breadth to implement. Not all breadth options are available for each data identifier.

See “About data identifier breadths” on page 547.

Table 22-12  Available rule breadths for system data identifiers

<table>
<thead>
<tr>
<th>Breadth</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wide</td>
<td>The wide breadth defines a single or multiple patterns to create the greatest number of matches. In general this breadth produces a higher rate of false positives than the medium and narrow breadths.</td>
</tr>
<tr>
<td>Medium</td>
<td>The medium breadth may refine the detection pattern(s) and/or add one or more data validators to limit the number of matches.</td>
</tr>
<tr>
<td>Narrow</td>
<td>The narrow breadth offers the tightest patterns and strictest validation to provide the most accurate positive matches. In general this option requires the presence of a keyword or other validating restriction to trigger a match.</td>
</tr>
</tbody>
</table>
Selecting a data identifier breadth

You cannot change the normalizer that a system data identifier implements. This information is useful to know when you implement one or more optional validators. See “Acceptable characters for optional validators” on page 560.

Table 22-13 System data identifier breadths and normalizers

<table>
<thead>
<tr>
<th>data identifier</th>
<th>Breadth(s)</th>
<th>Normalizer</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABA Routing Number</td>
<td>Wide</td>
<td>Digits Only</td>
</tr>
<tr>
<td>See “ABA Routing Number data identifier” on page 702.</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td>See “ABA Routing Number data identifier” on page 702.</td>
<td>Narrow</td>
<td></td>
</tr>
<tr>
<td>Australian Medicare Number</td>
<td>Wide</td>
<td>Digits Only</td>
</tr>
<tr>
<td>See “Australian Medicare Number data identifier” on page 706.</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td>Australian Tax File Number</td>
<td>Wide</td>
<td>Digits Only</td>
</tr>
<tr>
<td>See “Australian Tax File Number data identifier” on page 707.</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td>See “Australian Tax File Number data identifier” on page 707.</td>
<td>Narrow</td>
<td></td>
</tr>
<tr>
<td>Burgerservicenummer</td>
<td>Wide</td>
<td>Digits Only</td>
</tr>
<tr>
<td>See “Burgerservicenummer data identifier” on page 707.</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td>See “Burgerservicenummer data identifier” on page 707.</td>
<td>Narrow</td>
<td></td>
</tr>
<tr>
<td>Canadian Social Insurance Number</td>
<td>Wide</td>
<td>Digits Only</td>
</tr>
<tr>
<td>See “Canadian Social Insurance Number data identifier” on page 708.</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td>See “Canadian Social Insurance Number data identifier” on page 708.</td>
<td>Narrow</td>
<td></td>
</tr>
<tr>
<td>Codice Fiscale</td>
<td>Wide</td>
<td>Digits Letters Only</td>
</tr>
<tr>
<td>See “Codice Fiscale data identifier” on page 712.</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td>See “Codice Fiscale data identifier” on page 712.</td>
<td>Narrow</td>
<td></td>
</tr>
<tr>
<td>Credit Card Magnetic Stripe Data</td>
<td>Medium</td>
<td>Digits Only</td>
</tr>
<tr>
<td>See “Credit Card Magnetic Stripe Data data identifier” on page 713.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Credit Card Number</td>
<td>Wide</td>
<td>Digits Only</td>
</tr>
<tr>
<td>See “Credit Card Number data identifier” on page 715.</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td>See “Credit Card Number data identifier” on page 715.</td>
<td>Narrow</td>
<td></td>
</tr>
<tr>
<td>CUSIP Number</td>
<td>Wide</td>
<td>Lowercase</td>
</tr>
<tr>
<td>See “CUSIP Number data identifier” on page 726.</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td>See “CUSIP Number data identifier” on page 726.</td>
<td>Narrow</td>
<td></td>
</tr>
<tr>
<td>data identifier</td>
<td>Breadth(s)</td>
<td>Normalizer</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>------------</td>
<td>------------</td>
</tr>
<tr>
<td>Driver's License Number – CA State</td>
<td>Wide</td>
<td>Lowercase</td>
</tr>
<tr>
<td>See “Drivers License Number – CA State data identifier” on page 730.</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td>Driver's License Number – FL, MI, MN States</td>
<td>Wide</td>
<td>Lowercase</td>
</tr>
<tr>
<td>See “Drivers License Number - FL, MI, MN States data identifier” on page 732.</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td>Driver's License Number – IL State</td>
<td>Wide</td>
<td>Lowercase</td>
</tr>
<tr>
<td>See “Drivers License Number - IL State data identifier” on page 735.</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td>Driver's License Number – NJ State</td>
<td>Wide</td>
<td>Lowercase</td>
</tr>
<tr>
<td>See “Drivers License Number - NJ State data identifier” on page 737.</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td>Driver's License Number – NY State</td>
<td>Wide</td>
<td>Lowercase</td>
</tr>
<tr>
<td>See “Drivers License Number - NY State data identifier” on page 740.</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td>French INSEE Code</td>
<td>Wide</td>
<td>Digits Only</td>
</tr>
<tr>
<td>See “French INSEE Code data identifier” on page 742.</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td>Hong Kong ID</td>
<td>Wide</td>
<td>Lowercase</td>
</tr>
<tr>
<td>See “Hong Kong ID data identifier” on page 743.</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td>IBAN Central</td>
<td>Wide</td>
<td>None</td>
</tr>
<tr>
<td>See “IBAN Central data identifier” on page 743.</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td>IBAN East</td>
<td>Wide</td>
<td>None</td>
</tr>
<tr>
<td>See “IBAN East data identifier” on page 745.</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td>IBAN West</td>
<td>Wide</td>
<td>None</td>
</tr>
<tr>
<td>See “IBAN West data identifier” on page 748.</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td>IP Address</td>
<td>Wide</td>
<td>None</td>
</tr>
<tr>
<td>See “IP Address data identifier” on page 750.</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Narrow</td>
<td></td>
</tr>
<tr>
<td>data identifier</td>
<td>Breadth(s)</td>
<td>Normalizer</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------------</td>
<td>----------------</td>
<td>------------</td>
</tr>
<tr>
<td>National Drug Code</td>
<td>Wide, Medium, Narrow</td>
<td>None</td>
</tr>
<tr>
<td>See “National Drug Code (NDC) data identifier” on page 754.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>People's Republic of China ID</td>
<td>Wide, Narrow</td>
<td>Lowercase</td>
</tr>
<tr>
<td>See “People's Republic of China ID data identifier” on page 758.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Randomized US Social Security Number (SSN)</td>
<td>Narrow</td>
<td>Digits Only</td>
</tr>
<tr>
<td>See “Randomized US Social Security Number (SSN) data identifier” on page 759.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Singapore NRIC</td>
<td>Wide</td>
<td>Lowercase</td>
</tr>
<tr>
<td>See “Singapore NRIC data identifier” on page 760.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>South Korean Resident Registration Number</td>
<td>Wide, Medium</td>
<td>Digits Only</td>
</tr>
<tr>
<td>See “South Korea Resident Registration Number data identifier” on page 761.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Spanish DNI ID</td>
<td>Wide</td>
<td>Lowercase</td>
</tr>
<tr>
<td>See “Spanish DNI ID data identifier” on page 763.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SWIFT Code</td>
<td>Wide, Narrow</td>
<td>Swift</td>
</tr>
<tr>
<td>See “SWIFT Code data identifier” on page 764.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Swiss AHV Number</td>
<td>Wide</td>
<td>Digits Only</td>
</tr>
<tr>
<td>See “Swiss AHV Number data identifier” on page 767.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Taiwan ID</td>
<td>Wide</td>
<td>None</td>
</tr>
<tr>
<td>See “Taiwan ID data identifier” on page 767.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>UK Driver's License Number</td>
<td>Wide, Medium</td>
<td>Lowercase</td>
</tr>
<tr>
<td>See “UK Drivers License Number data identifier” on page 768.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>UK Electoral Roll Number</td>
<td>Wide</td>
<td>Lowercase</td>
</tr>
<tr>
<td>See “UK Electoral Roll Number data identifier” on page 772.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>UK National Health Service (NHS) Number</td>
<td>Medium, Narrow</td>
<td>Digits Only</td>
</tr>
<tr>
<td>See “UK National Health Service (NHS) Number data identifier” on page 773.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Table 22-13 System data identifier breadths and normalizers (continued)

<table>
<thead>
<tr>
<th>data identifier</th>
<th>Breadth(s)</th>
<th>Normalizer</th>
</tr>
</thead>
<tbody>
<tr>
<td>UK National Insurance Number</td>
<td>Wide</td>
<td>Lowercase</td>
</tr>
<tr>
<td>See “UK National Insurance Number data identifier” on page 777.</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Narrow</td>
<td></td>
</tr>
<tr>
<td>UK Passport Number</td>
<td>Wide</td>
<td>None</td>
</tr>
<tr>
<td>See “UK Passport Number data identifier” on page 781.</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Narrow</td>
<td></td>
</tr>
<tr>
<td>UK Tax ID Number</td>
<td>Wide</td>
<td>None</td>
</tr>
<tr>
<td>See “UK Tax ID Number data identifier” on page 785.</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Narrow</td>
<td></td>
</tr>
<tr>
<td>US Individual Tax ID Number (ITIN)</td>
<td>Wide</td>
<td>Digits Only</td>
</tr>
<tr>
<td>See “US Individual Tax Identification Number (ITIN) data identifier” on page 788.</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Narrow</td>
<td></td>
</tr>
<tr>
<td>US Social Security Number (SSN)</td>
<td>Wide</td>
<td>Digits Only</td>
</tr>
<tr>
<td>See “US Social Security Number (SSN) data identifier” on page 793.</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Narrow</td>
<td></td>
</tr>
</tbody>
</table>

Using optional validators

Table 22-14 lists the optional validators policy authors can configure for system data identifiers.

See “About optional validators for data identifiers” on page 547.

Table 22-14 Available optional validators for policy instances

<table>
<thead>
<tr>
<th>Optional validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Require beginning characters</td>
<td>Match the characters that begin (lead) the matched data item. For example, for the CA Drivers License data identifier, you could require the beginning character to be the letter &quot;C.&quot; In this case the engine matches a license number C6457291. See “Acceptable characters for optional validators” on page 560.</td>
</tr>
<tr>
<td>Require ending characters</td>
<td>Match the characters that end (trail) the matched data item. See “Acceptable characters for optional validators” on page 560.</td>
</tr>
</tbody>
</table>
### Configuring optional validators

You implement optional validators to refine the scope of a data identifier defined in a policy instance. System and custom data identifiers support the configuration of optional validators.

See “About optional validators for data identifiers” on page 547.

The type of input allowed by an optional validator (numbers, letters, characters) depends on the data identifier. If you enter unacceptable input characters and attempt to save the configuration, the system reports an error.

For example, the US Social Security Number (SSN) data identifier accepts numbers only. If you configure the "Require ending character" optional validator and provide input as letters, you receive the following error when you attempt to save the configuration: **Input to "Require ending characters" Validator is incorrect: List contains non-number character.**

See Table 22-15 on page 560.

---

**Table 22-14 Available optional validators for policy instances (continued)**

<table>
<thead>
<tr>
<th>Optional validator</th>
<th>Description</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exclude beginning characters</td>
<td>Exclude from matching characters that begin (lead) the matched data.</td>
<td>“Acceptable characters for optional validators” on page 560.</td>
</tr>
<tr>
<td>Exclude ending characters</td>
<td>Exclude from matching the characters that end (trail) the matched data item.</td>
<td>“Acceptable characters for optional validators” on page 560.</td>
</tr>
<tr>
<td>Find keywords</td>
<td>Match one or more keywords or key phrases in addition to the matched data item.</td>
<td>“About cross-component matching” on page 548.</td>
</tr>
<tr>
<td></td>
<td>The keyword must be detected in the same message component as the data identifier content to report a match.</td>
<td>“Acceptable characters for optional validators” on page 560.</td>
</tr>
<tr>
<td></td>
<td>This optional validator accepts any characters (numbers, letters, others).</td>
<td>“List of pattern validators that accept input data” on page 566.</td>
</tr>
</tbody>
</table>
To configure an optional validator

1. Click the plus sign beside the **Optional Validators** label for the data identifier instance you are configuring.

   See “Configuring the Content Matches data identifier condition” on page 552.

2. Select one or more optional validators.

   See “About optional validators for data identifiers” on page 547.

3. Provide the expected input for each optional validator you select.

   Each value can be of any length. Use commas to separate multiple values.

4. Click **Save** to save the configuration.

   If the system displays an error message, make sure you have entered the correct type of expected character input.

   See Table 22-15 on page 560.

### Acceptable characters for optional validators

Each optional validator requires you to enter in some data values. You must enter the appropriate type of data according for that data identifier. Table 22-15 lists the acceptable data type for each data identifier/optional validator pairing.

See “About optional validators for data identifiers” on page 547.

---

**Note:** The **Find keyword** optional validator accepts any characters as values for all data identifiers.

The type of data expected by the optional validator depends on the data identifier. Most data identifier/optional validator pairings accept numbers only; some accept alphanumeric values, and a few accept any characters. If you enter unacceptable input and attempt to save the policy, the system reports an error.

See “Configuring optional validators” on page 559.

#### Table 22-15  Acceptable characters for optional validators

<table>
<thead>
<tr>
<th>data identifier</th>
<th>Require ending characters</th>
<th>Exclude ending characters</th>
<th>Require beginning characters</th>
<th>Exclude beginning characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>US Social Security Number (SSN)</td>
<td></td>
<td></td>
<td>Numbers only</td>
<td></td>
</tr>
<tr>
<td>Canadian Social Insurance Number</td>
<td></td>
<td></td>
<td>Numbers only</td>
<td></td>
</tr>
<tr>
<td>data identifier</td>
<td>Require ending characters</td>
<td>Exclude ending characters</td>
<td>Require beginning characters</td>
<td>Exclude beginning characters</td>
</tr>
<tr>
<td>--------------------------------------------------------</td>
<td>---------------------------</td>
<td>---------------------------</td>
<td>-----------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>US Individual Tax Identification Number (ITIN)</td>
<td></td>
<td></td>
<td>Numbers only</td>
<td></td>
</tr>
<tr>
<td>Driver's License Number – CA State</td>
<td>Numbers only</td>
<td>Any characters (normalized to lowercase)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Driver's License Number – IL State</td>
<td>Numbers only</td>
<td>Any characters (normalized to lowercase)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Driver's License Number – NJ State</td>
<td>Numbers only</td>
<td>Any characters (normalized to lowercase)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Driver's License Number – NY State</td>
<td>Numbers only</td>
<td></td>
<td>Numbers only</td>
<td></td>
</tr>
<tr>
<td>Driver's License Number – FL, MI, MN States</td>
<td>Numbers only</td>
<td>Any characters (normalized to lowercase)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Credit Card Number</td>
<td>Numbers only</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ABA Routing Number</td>
<td>Numbers only</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CUSIP Number</td>
<td>Numbers only</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SWIFT Code</td>
<td>Alphanumeric (numbers or letters)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Credit Card Magnetic Stripe Data</td>
<td>Numbers only</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IBAN West</td>
<td>Alphanumeric (numbers or letters)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IBAN Central</td>
<td>Alphanumeric (numbers or letters)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IBAN East</td>
<td>Alphanumeric (numbers or letters)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>National Drug Code</td>
<td>Numbers only</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Australian Medicare Number</td>
<td>Numbers only</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IP Address</td>
<td>Any characters</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Codice Fiscale</td>
<td>Numbers only</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Spanish DNI ID</td>
<td>Numbers only</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Burgerservicenummer</td>
<td>Numbers only</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UK Driver's License Number</td>
<td>Alphanumeric (normalized to lowercase)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UK Tax ID Number</td>
<td>Numbers only</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UK Passport Number</td>
<td>Numbers only</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table 22-15  Acceptable characters for optional validators (continued)

<table>
<thead>
<tr>
<th>Data identifier</th>
<th>Require ending characters</th>
<th>Exclude ending characters</th>
<th>Require beginning characters</th>
<th>Exclude beginning characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>UK National Insurance Number</td>
<td>Alphanumeric (normalized to lowercase)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UK National Health Service (NHS) Number</td>
<td></td>
<td>Numbers only</td>
<td></td>
<td></td>
</tr>
<tr>
<td>UK Electoral Roll Number</td>
<td>Numbers only</td>
<td>Any characters (normalized to lowercase)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>French INSEE Code</td>
<td></td>
<td>Numbers only</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Swiss AHV Number</td>
<td></td>
<td>Numbers only</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Australian Tax File Number</td>
<td></td>
<td>Numbers only</td>
<td></td>
<td></td>
</tr>
<tr>
<td>People's Republic of China ID</td>
<td></td>
<td>Numbers only</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hong Kong ID</td>
<td></td>
<td>Numbers only</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Singapore NRIC</td>
<td></td>
<td>Numbers only</td>
<td></td>
<td></td>
</tr>
<tr>
<td>South Korean Resident Registration Number</td>
<td></td>
<td>Numbers only</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Taiwan ID</td>
<td></td>
<td>Numbers only</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Using unique match counting

When you define a new data identifier rule, **Count all unique matches** is the default method for counting matches. As the name indicates, the following table describes unique match counting characteristics.

<table>
<thead>
<tr>
<th>Unique match counting characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First match is unique</td>
<td>A unique match is the first match found in a message component.</td>
</tr>
<tr>
<td></td>
<td>See “Detection messages and message components” on page 305.</td>
</tr>
<tr>
<td>Match count updated for each unique</td>
<td>The match count is incremented by 1 for each unique pattern match.</td>
</tr>
<tr>
<td>match</td>
<td></td>
</tr>
</tbody>
</table>
Table 22-16  Unique match counting characteristics (continued)

<table>
<thead>
<tr>
<th>Unique match counting characteristic</th>
<th>Description</th>
</tr>
</thead>
</table>
| Only unique matches are highlighted  | Duplicate matches are neither counted nor highlighted at the Incident Snapshot screen  
See “Remediating incidents” on page 943. |
| Uniqueness does not span message components | For example, if the same SSN appears in both the message body and attachment, two unique matches will be generated, not one. This is because each instance is detected in a separate message component. |
| Compound rule with data identifier and keyword proximity conditions | In a compound rule combining a data identifier condition with a keyword condition that specifies keyword proximity logic, the reported match will not be the first match found, but the first match within the distance of the keyword proximity range. |
| No backward combatability            | Unique match counting is only available for policies configured using version 11.6 or later Enforce Server. In addition, only version 11.6 or later Detection Servers and DLP Agents can run policies containing unique match counting.  
See “Configuring unique match counting” on page 563. |

Configuring unique match counting

**Count all unique matches** is the default selection for new data identifiers you create. After upgrading Data Loss Prevention, you may need to manually configure pre-existing data identifier rules to use unique match counting, if you have not done so prior to upgrade.

See “About unique match counting” on page 549.

**To configure unique match counting**

1. Select the policy containing the data identifier rule or rules you want to update at the Manage > Policies > Policy List screen.
2. Select the data identifier rule at the Configure Policy screen.
3. Select the match counting option **Count all unique matches**.
4. Click OK to apply the unique match counting configuration change.
Click **Save** to save the policy change.

Test unique match counting.

Create an incident with multiple instances of a data identifier pattern, such as several instances of the same social security number in the same message component (for example, in an email attachment).

At the **Incident Snapshot** verify that only unique matches are highlighted and counted.

### Modifying system data identifiers

The system lets you modify system-defined data identifiers, but you cannot delete them. Any modifications you make to the configuration of a system-defined data identifier take effect system-wide. This means that the modifications apply to any policies that actively or subsequently declare the Data identifier.

There is no way to automatically revert a data identifier to its original configuration once it is modified. Before you modify a system data identifier, consider cloning it, and any custom data identifiers that you have created. Any modification you make to a Data identifier takes effect system-wide. This means the modifications apply to any policy that declares the modified Data identifier.

The system does not include modified data identifiers in policies exported as templates. Before modifying a system data identifier, export any policies that declare it.

See “**Editing data identifiers**” on page 551.

See “**Editing pattern validator input**” on page 566.

---

**Note:** The system does not export modified and custom data identifiers in a policy template. The system exports a reference to the system Data identifier. The target system where the policy template is imported provides the actual Data identifier. See “**Clone system-defined data identifiers before modifying to preserve original state**” on page 581.

See “**Editing data identifiers**” on page 551.
Table 22-17  System Data identifier modification options

<table>
<thead>
<tr>
<th>Modifiable at the system level</th>
<th>Not configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Patterns</td>
<td>Name, Description, and Category</td>
</tr>
<tr>
<td>You can edit one or more Data identifier patterns at the system level. You cannot modify the name, description, or category of a system Data identifier.</td>
<td></td>
</tr>
<tr>
<td>Active Validators</td>
<td>Breadth</td>
</tr>
<tr>
<td>You can add or remove required validators at the system level. You cannot define a new detection breadth for a system Data identifier; you can only modify an existing breadth.</td>
<td></td>
</tr>
<tr>
<td>Data Entry</td>
<td>Optional Validators</td>
</tr>
<tr>
<td>You can edit the input of an active validator for a system Data identifier. You cannot define optional validators at the system level. You can only configure optional validators at the policy level.</td>
<td></td>
</tr>
<tr>
<td>Patterns</td>
<td>Data Normalizer</td>
</tr>
<tr>
<td>You cannot modify the type of data normalizer implemented by a system Data identifier.</td>
<td></td>
</tr>
<tr>
<td>Patterns</td>
<td>Delete</td>
</tr>
<tr>
<td>You cannot delete a system Data identifier.</td>
<td></td>
</tr>
</tbody>
</table>

Cloning a system data identifier before modifying it

The Enforce Server does not provide an automated mechanism for cloning a system Data Identifier. See “Extending and customizing data identifiers” on page 546.

Before you modify a system Data Identifier, consider manually cloning it so you can revert to the original configuration, if necessary. At the least, you should export a policy as a template before you modify any system Data Identifier declared by that policy.

To manually clone a system Data Identifier

1. Review the original configuration of the Data Identifier you want to modify.
2. Create a custom Data Identifier.
   See “Workflow for creating custom data identifiers” on page 570.
3. Copy the configuration of the original Data Identifier to the custom Data Identifier.
   Add the pattern(s), validator(s), any data input, and the normalizer.
   See “Selecting a data identifier breadth” on page 555.
4. Save the custom Data Identifier.
5. Modify the custom Data Identifier to suit your needs.
Editing pattern validator input

At the system-level you can edit the data input that a required validator accepts. Not all validators accept data input.

See “About pattern validators” on page 548.

To edit required validator input

1. Edit the data identifier by selecting it from the Manage > Policies > data identifiers screen.
2. Select the Rule Breadth you want to modify.
   Generally, the medium and narrow breadth options include validators that accept data input.
3. Select the editable validator from the Active Validators list whose input you want to edit.
   For example, select Find keywords.
   See “List of pattern validators that accept input data” on page 566.
4. Edit the input for the validator in the Description and Data Entry field.
5. Click Update Validator to save the changes you have made to the validator input.
   Click Discard Changes to not save the changes.
6. Click Save to save the data identifier.

List of pattern validators that accept input data

The following table lists all available pattern validators that require data input. The input data is editable at the system-level definition of the data identifier.

<table>
<thead>
<tr>
<th>Validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exact Match</td>
<td>Enter a comma-separated list of values. If the values are numeric, do NOT enter any dashes or other separators. Each value can be of any length.</td>
</tr>
<tr>
<td>Exclude beginning characters</td>
<td>Enter a comma-separated list of values. If the values are numeric, do NOT enter any dashes or other separators. Each value can be of any length.</td>
</tr>
</tbody>
</table>

Note: Input you use for beginning and ending validators concern the text of the match itself. Input you use for prefix and suffix validators concern characters before and after matched text.
### Editing keywords for international PII data identifiers

Data identifiers offer broad support for detecting international content.

See "Introducing data identifiers" on page 541.

Some international data identifiers offer a wide breadth of detection only. In this case you can implement the Find Keywords optional validator to narrow the scope of detection. Implementing this optional validator may help you eliminate any false positives that your policy matches.

See “Selecting a data identifier breadth” on page 555.

**To use keywords for international data identifiers**

1. Create a policy using one of the system-provided international data identifiers that is listed in the table.
   
   See “List of keywords for international system data identifiers” on page 568.

2. Select the **Find Keywords** optional validator.
   
   See “Configuring the Content Matches data identifier condition” on page 552.

3. Copy and past the appropriate comma-separated keywords from the list to the **Find Keywords** optional validator field.
   
   See “Configuring optional validators” on page 559.

---

### Table 22-18  Pattern validators that accept input data (*continued*)

<table>
<thead>
<tr>
<th>Validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exclude ending characters</td>
<td>Enter a comma-separated list of values. If the values are numeric, do NOT enter any dashes or other separators. Each value can be of any length.</td>
</tr>
<tr>
<td>Exclude exact match</td>
<td>Enter a comma-separated list of values. Each value can be of any length.</td>
</tr>
<tr>
<td>Exclude prefix</td>
<td>Enter a comma-separated list of values. Each value can be of any length.</td>
</tr>
<tr>
<td>Exclude suffix</td>
<td>Enter a comma-separated list of values. Each value can be of any length.</td>
</tr>
<tr>
<td>Find keywords</td>
<td>Enter a comma-separated list of values. Each value can be of any length.</td>
</tr>
<tr>
<td>Require beginning characters</td>
<td>Enter a comma-separated list of values. If the values are numeric, do NOT enter any dashes or other separators. Each value can be of any length.</td>
</tr>
<tr>
<td>Require ending characters</td>
<td>Enter a comma-separated list of values. If the values are numeric, do NOT enter any dashes or other separators. Each value can be of any length.</td>
</tr>
</tbody>
</table>
List of keywords for international system data identifiers

See Table 22-19 on page 568. provides keywords for several system-defined international data identifiers. You can modify the specified data identifier using the corresponding keyword(s).

See “Extending and customizing data identifiers” on page 546.

See “Introducing data identifiers” on page 541.

See “Selecting a data identifier breadth” on page 555.

Table 22-19  Keyword list for international PII data identifiers

<table>
<thead>
<tr>
<th>Data identifier</th>
<th>Language</th>
<th>Keywords</th>
<th>English translation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Burgerservicenummer (BSN)</td>
<td>Dutch</td>
<td>Persoonsnummer, sofinummer, sociaal-fiscaal nummer, persoonsgebonden</td>
<td>person number, social-fiscal number (abbreviation), social-fiscal number, person-related number</td>
</tr>
<tr>
<td>Codice Fiscale</td>
<td>Italian</td>
<td>codice fiscal, dati anagrafici, partita I.V.A., p. iva</td>
<td>tax code, personal data, VAT number, VAT number</td>
</tr>
<tr>
<td>French INSEE Code</td>
<td>French</td>
<td>INSEE, numéro de sécu, code sécu</td>
<td>INSEE, social security number, social security code</td>
</tr>
<tr>
<td>Hong Kong ID</td>
<td>Chinese (Traditional)</td>
<td>身份證, 三顆星</td>
<td>Identity card, Hong Kong permanent resident ID Card</td>
</tr>
<tr>
<td>International Bank Account Number (IBAN) Central</td>
<td>French</td>
<td>Code IBAN, numéro IBAN</td>
<td>IBAN Code, IBAN number</td>
</tr>
<tr>
<td>International Bank Account Number (IBAN) East</td>
<td>French</td>
<td>Code IBAN, numéro IBAN</td>
<td>IBAN Code, IBAN number</td>
</tr>
<tr>
<td>International Bank Account Number (IBAN) West</td>
<td>French</td>
<td>Code IBAN, numéro IBAN</td>
<td>IBAN Code, IBAN number</td>
</tr>
<tr>
<td>People's Republic of China ID</td>
<td>Chinese (Simplified)</td>
<td>身份证,居民信息,居民身份信息</td>
<td>Identity Card, Information of resident, Information of resident identification</td>
</tr>
<tr>
<td>South Korea Resident Registration Number</td>
<td>Korean</td>
<td>주민등록번호, 주민번호</td>
<td>Resident Registration Number, Resident Number</td>
</tr>
<tr>
<td>Spanish DNI ID</td>
<td>Spanish</td>
<td>DNI</td>
<td>DNI</td>
</tr>
</tbody>
</table>
Updating policies to use the Randomized US SSN data identifier

The Randomized US Social Security Number (SSN) data identifier detects both traditional and randomized SSNs.

See “Use the Randomized US SSN data identifier to detect SSNs” on page 582.

All policy templates that previously used the US Social Security Number (SSN) data identifier to detect SSNs are updated to use the Randomized US Social Security Number (SSN) data identifier. In addition, the Randomized US SSN data identifier is updated for Symantec Data Loss Prevention version 12.5.

See “Updating policies after upgrading to the latest version” on page 355.

If you have existing policies that use the US SSN data identifier to detect SSNs, you should update each policy to use the Randomized US SSN data identifier. If you have created policies using the version 12.0 Randomized US SSN data identifier, you should update each to use the version 12.5 Randomized US SSN data identifier.

To update a policy to use the Randomized US SSN data identifier provides steps for updating your SSN policies.

To update a policy to use the Randomized US SSN data identifier

1. Edit the policy that implements the US SSN data identifier or the 12.0 Randomized US SSN data identifier.
   
   See “Configuring policies” on page 326.

2. Edit the rule that contains the US SSN data identifier.

   See “Configuring policy rules” on page 330.

3. Remove the US SSN data identifier.
4  Add the Randomized US SSN data identifier.  
   See “Managing and adding data identifiers” on page 550.
5  Save the policy.
6  Test policy detection for both traditional and randomized US SSNs.  
   See “Test and tune policies to improve match accuracy” on page 361.
7  Deploy the updated SSN policy into production.  
   See “Policy deployment” on page 288.

Creating custom data identifiers

You can create and delete one or more custom data identifiers. A custom data identifier may be a system data identifier that you have cloned and intend to modify, or one that you create from scratch. A custom data identifier is reusable across policies. Changes made to a custom data identifier at the system-level affect any policies that actively or subsequently declare the custom data identifier.

Table 22-20 lists the components of custom data identifiers.

See “Workflow for creating custom data identifiers” on page 570.

Table 22-20  Custom data identifier components

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
</table>
| Patterns      | Define one or more regular expression patterns, separated by line breaks.  
   See “About data identifier patterns” on page 547. |
| Validators    | Add or remove validators to perform validation checks on the data detected by the pattern(s).  
   See “About pattern validators” on page 548. |
| Data Entry    | Provide comma-separated data values for any validators that require data input.  
   See “About pattern validators” on page 548. |
| Normalizer    | Select a normalizer to standardize the data before matching against it.  
   See “Selecting a data normalizer” on page 578. |

Workflow for creating custom data identifiers

You can implement custom data identifiers to detect unique content. To implement a custom data identifier, you must define at least one pattern and select a data normalizer. Validators are optional.
See “Custom data identifier configuration” on page 572.

When you define a custom data identifier, the system assigns it to the "Wide" breadth by default. This is not a limitation, however, because the actual scope of detection is determined by the pattern(s) and validator(s) that you define.

### Table 22-21: Implementing custom data identifiers

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Select Manage &gt; Policies &gt; data identifiers.</td>
<td>The data identifiers screen lists all data identifiers available in the system.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Select Add data identifier.</td>
<td>Enter a Name for the custom data identifier. The name must be unique. Enter a Description for the custom data identifier. A custom data identifier is assigned to the Custom category by default and cannot be changed. The description field is limited to 255 characters per line.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Enter one or more Patterns to match data.</td>
<td>You must enter at least one pattern for the custom data identifier to be valid. Separate multiple patterns by line breaks. See &quot;Writing data identifier patterns to match data&quot; on page 574.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Select a Data Normalizer.</td>
<td>You must select a data normalizer. See “Selecting a data normalizer” on page 578. The following normalizers are available: ■ Digits ■ Digits and Letters ■ Lowercase ■ Swift codes ■ Do nothing Select this option if you do not want to normalize the data.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Select zero or more Validators.</td>
<td>Including a validator to check and verify pattern matching is optional. See “Selecting pattern validators” on page 577.</td>
</tr>
</tbody>
</table>
Table 22-21  Implementing custom data identifiers (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| Step 6 | **Save** the custom data identifier. | Click **Save** at the upper left of the screen.  
Once you define and save a custom data identifier, it appears alphabetically in the list of data identifiers at the **data identifiers** screen.  
To edit a custom data identifier, select it from the list.  
See "**Editing data identifiers**" on page 551.  
**Note:** Click **Cancel** to not save the custom data identifier. |
| Step 7 | Implement the custom data identifier in one or more policies. | The system lists all custom data identifiers beneath the **Custom** category for the "Content Matches data identifier" condition at the **Configure Policy - Add Rule** and the **Configure Policy - Add Exception** screens.  
See “**Configuring the Content Matches data identifier condition**” on page 552.  
You can configure optional validators at the policy instance level for custom data identifiers.  
See “**Configuring optional validators**” on page 559. |

**Custom data identifier configuration**

You can create and delete one or more custom data identifiers. A custom Data identifier can be used across policies. Changes made to a custom Data identifier at the system-level affect any policies that actively or subsequently declare the custom Data identifier.

See “**Workflow for creating custom data identifiers**” on page 570.
Table 22-22 Custom data identifier configuration

<table>
<thead>
<tr>
<th>Configurable at the custom level</th>
<th>Not configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>■ <strong>Name</strong> and <strong>Description</strong></td>
<td>■ <strong>Category</strong></td>
</tr>
<tr>
<td>You must give a custom Data identifier a unique name.</td>
<td>The system assigns a custom Data identifier to the Custom category. You cannot change this setting.</td>
</tr>
<tr>
<td>It is good practice to provide a description for the custom Data identifier.</td>
<td>■ <strong>Breadth</strong></td>
</tr>
<tr>
<td>You can change the name or description of a custom Data identifier when you modify it.</td>
<td>The system assigns a custom Data identifier to the Wide rule breadth. You cannot change this setting.</td>
</tr>
<tr>
<td>■ <strong>Patterns</strong></td>
<td>■ <strong>Optional Validators</strong></td>
</tr>
<tr>
<td>You must define at least one pattern for the custom Data identifier to be valid.</td>
<td>Custom data identifiers support all optional validators, but they are configured at the policy instance level.</td>
</tr>
<tr>
<td>■ <strong>Active Validators</strong></td>
<td>■ <strong>Patterns</strong></td>
</tr>
<tr>
<td>You can add one or more required validators to a custom Data identifier.</td>
<td>The Data identifier pattern language is a limited subset of the regular expression lexicon. The Data identifier pattern language does not support all of the regular expressions characters and constructs. A regular expression pattern converted to a Data identifier pattern will require some syntactical modifications.</td>
</tr>
<tr>
<td>■ <strong>Data Entry</strong></td>
<td>■ <strong>Patterns</strong></td>
</tr>
<tr>
<td>You can edit the input of an active validator that accepts data input.</td>
<td>Data identifier patterns are limited to 100 characters per line. The pattern itself can be more than 100 characters, but a line cannot have more than 100 character. You should split the pattern up by lines not longer than 100 characters.</td>
</tr>
<tr>
<td>■ <strong>Data Normalizer</strong></td>
<td>■ <strong>Patterns</strong></td>
</tr>
<tr>
<td>You must select a data normalizer when defining a custom Data identifier.</td>
<td>See “Input character limits for policy configuration” on page 344.</td>
</tr>
</tbody>
</table>

Using the data identifier pattern language

The Data identifier pattern language is a limited subset of the regular expression lexicon. The Data identifier pattern language does not support all of the regular expressions characters and constructs. A regular expression pattern converted to a Data identifier pattern will require some syntactical modifications.

Data identifier patterns are limited to 100 characters per line. The pattern itself can be more than 100 characters, but a line cannot have more than 100 character. You should split the pattern up by lines not longer than 100 characters.

See “Input character limits for policy configuration” on page 344.

The table below lists the known differences between regular expressions and the Data identifier pattern language.
Table 22-23  Data identifier pattern language limitations

<table>
<thead>
<tr>
<th>Character</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>*</td>
<td>The asterisk (*), pipe (</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>\w</td>
<td>The \w construct cannot be used to match the underscore character (_).</td>
</tr>
<tr>
<td>\s</td>
<td>The \s construct cannot be used to match a whitespace character; instead, use an actual whitespace.</td>
</tr>
<tr>
<td>\d</td>
<td>For digits, use the construct \d.</td>
</tr>
</tbody>
</table>

Grouping

Grouping only works at the beginning of the pattern, for example:

- \d{4} – 2049 does not work; instead use 2049 – \d{4}
- \d{2} /19 \d{2} does not work; instead use \d{2} /{[1][9]} \d{2}

Groupings are allowed at the beginning of the pattern, like in the credit card Data identifier.

Writing data identifier patterns to match data

If you modify an existing data identifier, you can edit its patterns. If you create a custom data identifier, you must implement at least one pattern. Data identifier patterns are implemented using a syntax that is similar to the regular expression language, with limitations. In addition, the system only allows the use of ASCII characters for data identifier patterns.

See “About data identifier patterns” on page 547.

To edit or implement a pattern

1. Review the patterns for the data identifier you want to modify.
   See “Selecting a data identifier breadth” on page 555.

2. Consider cloning the data identifier, if you are modifying a system data identifier.
   See “Cloning a system data identifier before modifying it” on page 565.


4. Select the data identifier you want to modify.

5. Select the breadth for the data identifier you want to modify.
   Generally, patterns vary among detection breadths.
6 In the Patterns field, modify an existing pattern, or enter one or more new patterns, separated by line breaks.

Data identifier patterns are implemented as regular expressions. However, much of the regular expression syntax is not supported.

See “Using the data identifier pattern language” on page 573.

7 Click Save to save the data identifier.

Using pattern validators

The following table lists all available pattern validators. Validators marked with an asterisk (*) beside the name in the table below require data input.

<table>
<thead>
<tr>
<th>Validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABA Checksum</td>
<td>Every ABA routing number must start with the following two digits: 00-15, 21-32, 61-72, 80 and pass an ABA specific, position-weighted check sum.</td>
</tr>
<tr>
<td>Advanced KRRN Validation</td>
<td>Validates that 3rd and 4th digit are a valid month, that 5th and 6th digit a valid day, and the checksum matches the check digit.</td>
</tr>
<tr>
<td>Advanced SSN</td>
<td>Validator checks whether SSN contains zeros in any group, the area number (first group) is less than 773 and not 666, the delimiter between the groups is the same, the number does not consist of all the same digits, and the number is not reserved for advertising (123-45-6789, 987-65-432x).</td>
</tr>
<tr>
<td>Australian Tax File validation check</td>
<td>Computes the checksum and validates the pattern against it.</td>
</tr>
<tr>
<td>Basic SSN</td>
<td>Performs minimal SSN validation.</td>
</tr>
<tr>
<td>Burgerservicenumber Check</td>
<td>Performs a check for the Burgerservicenumber.</td>
</tr>
<tr>
<td>China ID checksum validator</td>
<td>Computes the checksum and validates the pattern against it.</td>
</tr>
<tr>
<td>Codice Fiscale Control Key Check</td>
<td>Computes the control key and checks if it is valid.</td>
</tr>
<tr>
<td>Cusip Validation</td>
<td>Validator checks for invalid CUSIP ranges and computes the CUSIP checksum (Modulus 10 Double Add Double algorithm).</td>
</tr>
<tr>
<td>Custom Script*</td>
<td>Enter a custom script to validate pattern matches for this Data identifier breadth. See “Creating custom script validators” on page 579.</td>
</tr>
<tr>
<td>DNI control key check</td>
<td>Computes the control key and checks if it is valid.</td>
</tr>
<tr>
<td>Validator</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Duplicate digits</td>
<td>Ensures that a string of digits are not all the same.</td>
</tr>
<tr>
<td>Exact Match*</td>
<td>Enter a comma-separated list of values. If the values are numeric, do NOT enter any dashes or other separators. Each value can be of any length.</td>
</tr>
<tr>
<td>Exclude beginning characters*</td>
<td>Enter a comma-separated list of values. If the values are numeric, do NOT enter any dashes or other separators. Each value can be of any length.</td>
</tr>
<tr>
<td>Note: Beginning and ending validators concern the text of the match itself. Prefix and suffix validators concern characters before and after matched text.</td>
<td></td>
</tr>
<tr>
<td>Exclude ending characters*</td>
<td>Enter a comma-separated list of values. If the values are numeric, do NOT enter any dashes or other separators. Each value can be of any length.</td>
</tr>
<tr>
<td>Exclude exact match*</td>
<td>Enter a comma-separated list of values. Each value can be of any length.</td>
</tr>
<tr>
<td>Exclude prefix*</td>
<td>Enter a comma-separated list of values. Each value can be of any length.</td>
</tr>
<tr>
<td>Note: Prefix and suffix validators concern characters before and after matched text. Beginning and ending validators concern the text of the match itself.</td>
<td></td>
</tr>
<tr>
<td>Exclude suffix*</td>
<td>Enter a comma-separated list of values. Each value can be of any length.</td>
</tr>
<tr>
<td>Find keywords*</td>
<td>Enter a comma-separated list of values. Each value can be of any length.</td>
</tr>
<tr>
<td>Hong Kong ID</td>
<td>Computes the checksum and validates the pattern against it.</td>
</tr>
<tr>
<td>INSEE Control Key</td>
<td>Validator computes the INSEE control key and compares it to the last 2 digits of the pattern.</td>
</tr>
<tr>
<td>IP Basic Check</td>
<td>Every IP address must match the format x.x.x.x and every number must be less than 256.</td>
</tr>
<tr>
<td>IP Octet Check</td>
<td>Every IP address must match the format x.x.x.x, every number must be less than 256, and no IP address can contain only single-digit numbers (1.1.1.2).</td>
</tr>
<tr>
<td>IP Reserved Range Check</td>
<td>Checks whether the IP address falls into any of the “Bogons” ranges. If so the match is invalid.</td>
</tr>
<tr>
<td>Luhn check</td>
<td>Validator computes the Luhn checksum which every Canadian Insurance Number must pass.</td>
</tr>
<tr>
<td>Mod 97 Validator</td>
<td>Computes the ISO 7064 Mod 97-10 checksum of the complete match.</td>
</tr>
<tr>
<td>No Validation</td>
<td>Performs no validation.</td>
</tr>
<tr>
<td>Number Delimiter</td>
<td>Validates a match by checking the surrounding digits.</td>
</tr>
</tbody>
</table>
Table 22-24  Available validators for system and custom data identifiers (continued)

<table>
<thead>
<tr>
<th>Validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Require beginning characters*</td>
<td>Enter a comma-separated list of values. If the values are numeric, do NOT enter any dashes or other separators. Each value can be of any length.</td>
</tr>
<tr>
<td>Require ending characters*</td>
<td>Enter a comma-separated list of values. If the values are numeric, do NOT enter any dashes or other separators. Each value can be of any length.</td>
</tr>
<tr>
<td>Singapore NRIC</td>
<td>Computes the Singapore NRIC checksum and validates the pattern against it.</td>
</tr>
<tr>
<td>SSN Area-Group number</td>
<td>For a given area number (first group), not all group numbers (second group) might have been assigned by the SSA. Validator eliminates SSNs with invalid group numbers.</td>
</tr>
<tr>
<td>Swiss AHV</td>
<td>Swiss AHV Modulus 11 Checksum.</td>
</tr>
<tr>
<td>Taiwan ID</td>
<td>Taiwan ID checksum.</td>
</tr>
<tr>
<td>UK Drivers License</td>
<td>Every UK drivers license must be 16 characters and the number at the 8th and 9th position must be larger than 00 and smaller than 32.</td>
</tr>
<tr>
<td>UK NHS</td>
<td>UK NHS checksum.</td>
</tr>
</tbody>
</table>

Selecting pattern validators

Symantec Data Loss Prevention provides a comprehensive set of validators to facilitate pattern matching accuracy.

See “About pattern validators” on page 548.

When you modify a data identifier, the system exposes the active validators used by the data identifier. When you modify or create a data identifier, the system displays all system-defined data validators from which you can choose.

Note: The active validators that allow for and define input are not to be confused with the "Optional validators" that can be configured for any runtime instance of a particular data identifier. Optional validators are always configurable at the instance level. Active validators are only configurable at the system level.

Select a validator from the "Validation Checks" list on the left, then click Add Validator to the right. If the validator requires input, provide the required data using a comma-separated list and then click Add Validator.

See “Selecting pattern validators” on page 577.
To select a pattern validator

1. Create a custom data identifier.
   See “Workflow for creating custom data identifiers” on page 570.

2. In the Validators section, select the desired validator.
   See “About pattern validators” on page 548.

3. If the validator does not require data input, click Add Validator.
   The validator is added to the Active Validators list.

4. If the validator requires data input, enter the data values in the Description and Data Entry field.
   Click Add Validator when you are done entering the values.
   The validator is added to the Active Validators list.

5. To remove a validator, select it in the Active Validators list and click the red X icon.

6. Click Save to save the configuration of the data identifier.

Selecting a data normalizer

When you create a custom Data identifier, you must select a normalizer to reconcile the data detected by the pattern with the format expected by the validators.

See “Workflow for creating custom data identifiers” on page 570.
Table 22-25 lists and describes the normalizers you can implement for custom data identifiers.

<table>
<thead>
<tr>
<th>Normalizer</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digits</td>
<td>Only numeric characters are allowed.</td>
</tr>
<tr>
<td>Digits and Letters</td>
<td>Alphanumeric characters are allowed.</td>
</tr>
<tr>
<td>Lowercase</td>
<td>Only letters are allowed, normalized to lowercase.</td>
</tr>
<tr>
<td>Swift codes</td>
<td>Code must match SWIFT requirements.</td>
</tr>
<tr>
<td>Do nothing</td>
<td>The data is not normalized, evaluated as entered by the user.</td>
</tr>
</tbody>
</table>
Creating custom script validators

The custom script validation check lets you enter a custom script to validate pattern matches. To implement a custom validator, you use the Symantec Data Loss Prevention Scripting Language.

You can implement a custom script validator in a system data identifier you modify or in a custom data identifier.

Note: Refer to the Symantec Data Loss Prevention Detection Customization Guide for details on using the Symantec Data Loss Prevention Scripting Language.

To implement a custom script validator

1. Modify an existing data identifier or create a custom data identifier.
   See “Workflow for creating custom data identifiers” on page 570.
2. Select the **Custom Script** validator from the list of **Validation Checks**.
3. Enter your custom script in the **Description and Data Entry** field.
4. Click **Add Validator** to add the custom validator to the **Active Validators** list.
5. Click **Save** to save the configuration of the data identifier.

Best practices for using data identifiers

Data identifiers are algorithms that combine pattern matching with data validators to detect content. Symantec Data Loss Prevention provides a number of system-defined data identifiers for common data patterns, including SSNs, Tax IDs, and more. In addition, you can define your own custom data identifiers to match any data you can describe using the data identifier pattern language. Data identifiers are commonly used to detect personally identifiable information (PII).

This section provides best practices for implementing data identifier policies. Table 22-26 summarizes the best practices in this section.

**Table 22-26** Summary of data identifier best practices

<table>
<thead>
<tr>
<th>Best practice</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use data identifiers instead of regular expressions when possible.</td>
<td>See “Use data identifiers instead of regular expressions to improve accuracy” on page 580.</td>
</tr>
<tr>
<td>Modify data identifier definitions when you want tuning to apply globally.</td>
<td>See “Modify data identifier definitions when you want tuning to apply globally” on page 581.</td>
</tr>
</tbody>
</table>
Use data identifiers instead of regular expressions to improve accuracy

Data identifiers are designed to protect personally identifiable information (PII) with very good accuracy (<10% false positive rate). If a data identifier is available for the type of content you want to protect, you should use the data identifier instead of a regular expression because data identifiers are more efficient than regular expressions. Out-of-the-box data identifier patterns are tuned for accuracy, including region, industry, and country nuances. In addition, data identifiers include validation checks to verify the data matched by the pattern. This additional layer of intelligence screens out test data and other triggers of false positive incidents. Regular expressions, on the other hand, can be computationally expensive and can lead to increased false positives.

For example, if you want to detect social security numbers (SSN), you would use the Randomized US SSN data identifier instead of a regular expression pattern. The Randomized US SSN data identifier is more accurate than any regular expression you could write and much easier and quicker to implement.

Note: The data identifier pattern language is a limited subset of the regular expression language. Not all regular expression constructs or characters are supported for data identifier patterns. See “Using the data identifier pattern language” on page 573.
Clone system-defined data identifiers before modifying to preserve original state

Before you modify a system data identifier or create a custom data identifier, consider the following:

- If you want to modify a system data identifier, manually clone it as a custom data identifier and then modify the cloned copy. In this fashion you preserve the state of the original system-defined data identifier.

- Data identifiers do not export as part of a policy template. As such, you should add the data identifier to a policy and export the policy as a template before modifying the data identifier. An exported template contains a reference to each data identifier implemented in that policy. On import to a target system, the template uses a reference to select the local data identifier. If the system data identifier is modified, on import it cannot be recognized by the target system.

See “Cloning a system data identifier before modifying it” on page 565.

Modify data identifier definitions when you want tuning to apply globally

Data identifiers offer two levels of configuration:

- Definitions
- Instances

Data identifier definitions are configured at the system-level of the Enforce Server. At the definition level you can tune the data supplied by any required validator that the definition declares at this level, as well as what validators are used.

Data identifier instances can only be configured at the policy rule level. Any configurations made at the rule level are local in scope and applicable only to that policy. At the rule level you use optional validators, such as require or exclude beginning or ending characters, to tune the instance of the data identifier rule.

The general recommendation is to configure data identifier definitions so that the changes apply globally to any instance of that data identifier definition. Such configurations are reusable across policies. Rule-level optional validators, such as, should be used for unique policies.
Consider using multiple breadths in parallel to detect different severities of confidential data

Matching data identifiers against content often requires fine-tuning as you adjust the configuration to keep both false positives and false negatives to a minimum. After you configure an instance of the Content Matches Data Identifier condition, study the matches and adjust the configuration to ensure optimum data matching success.

Consider adjusting the data identifier breadth you are using if the data identifier is producing too many false positive or negatives. For example, if you are using a wide breadth and receiving many false positives, consider using a medium or narrow breadth.

See “About data identifier breadths” on page 547.

As an alternative approach, consider using multiple data identifier breadths in parallel in the same rule with different severity levels for each rule. For example, in a single policy designed to detect credit card numbers, you could add three rules to the policy, each using a different breadth (one wide, one medium, one narrow). You would then set the severity for the narrow to be high severity incidents, and the wide to be low severity incidents. Using this layered approach lets you survey the data flowing through the enterprise using a policy that covers both ends of spectrum. You can use this sampling-based approach to focus your remediation efforts on the highest-priority incidents while still detecting and being able to review low-severity incidents.

Avoid matching on the Envelope over HTTP to reduce false positives

Sometimes HTTP transmissions contain session IDs in the header that can trigger false positives for numeric data identifiers. For example, some social media sites such as Facebook and LinkedIn contain a session ID that may at times match the CCN and SSN data identifiers exactly, causing false positives.

To reduce false positives in connection with HTTP session IDs in the message header, the best practice is not to match on the “Envelope” message component when implementing numeric data identifiers, specifically the CCN or SSN data identifiers.

Use the Randomized US SSN data identifier to detect SSNs

In 2011, the United States Social Security Administration (SSA) began issuing randomized SSNs. Under this scheme, the high group number (second part of the SSN) no longer corresponds to the area number (first part of the SSN). Also, the range of the area number can go up to 899 instead of 773. Randomization applies
to SSNs issued on or after June 25, 2011. It does not apply to SSNs issued before that date.

To support the new randomized SSN scheme, Symantec Data Loss Prevention provides the system-defined Randomized US Social Security Number (SSN) data identifier.

See “Randomized US Social Security Number (SSN) data identifier” on page 759.

The Randomized US SSN data identifier detects both traditional and randomized SSNs. The Randomized US SSN data identifier replaces the US SSN data identifier, which only detects traditional SSNs. In addition, the patterns for the Randomized US SSN data identifier are updated for version 12.5.

Symantec recommends that you use the Randomized US SSN data identifier for all new policies that you want to use to detect SSNs, and that you update your existing SSN policies to use the Randomized US SSN data identifier. For your existing policies that already implement the traditional US SSN data identifier, you can add the Randomized US SSN data identifier as an OR’d rule so that both run in parallel as you test the policy to ensure it accurately detects both styles of SSNs.

See “Updating policies to use the Randomized US SSN data identifier” on page 569.

Use unique match counting to improve accuracy and ease remediation

The data identifier rule configuration contains an option to count only unique matches. With this option selected (as opposed to the default setting which counts all matches), only unique matches will be reported as the first match found in the message or message component. Only unique matches are counted and highlighted.

The best practice is to use unique match counting when you only care about unique matches, not duplicate matches. For example, if you are using the Credit Card Numbers data identifier to protect credit card numbers, and you only care if a document contains 25 or more unique numbers, you would use the count all unique matches option instead of the count all matches option. If you counted all matches, a document containing 25 of the same CCNs would trigger the policy, which is not the objective of your policy.

See “About unique match counting” on page 549.
Detecting content using keyword matching

This chapter includes the following topics:

- Introducing keyword matching
- Configuring keyword matching
- Best practices for using keyword matching

Introducing keyword matching

Symantec Data Loss Prevention provides the **Content Matches Keyword** policy condition for keyword detection.

To detect data loss using keyword matching, the detection engine compares inbound messages or message components against each keyword in a list of one or more keywords or keyword phrases. Keyword matching supports both whole word and partial word matching, as well as word proximity. Keyword matching is supported on the server and on the endpoint.

Table 23-1 lists typical keyword matching use cases.
Table 23-1  Keyword matching use cases

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Typical use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Whole word matching</td>
<td>Languages based on the Latin alphabet</td>
</tr>
<tr>
<td></td>
<td>UTF-8 characters</td>
</tr>
<tr>
<td></td>
<td>Chinese, Japanese, and Korean (CJK) languages with token verification enabled for the server</td>
</tr>
<tr>
<td></td>
<td>CJK keywords on the endpoint</td>
</tr>
<tr>
<td>Partial word matching</td>
<td>Languages based on the Latin alphabet</td>
</tr>
<tr>
<td></td>
<td>Mixed languages</td>
</tr>
<tr>
<td></td>
<td>See “Keyword matching examples” on page 587.</td>
</tr>
</tbody>
</table>

About keyword matching for Chinese, Japanese, and Korean (CJK) languages

Symantec Data Loss Prevention version 12.5 detection servers support natural language processing for Chinese, Japanese, and Korean (CJK) keywords. When natural language processing for CJK languages is enabled, the detection server validates CJK tokens before reporting a match. For CJK languages, a token is a single character which constitutes a word. Thus, partial word matching does not apply to CJK languages.

Token validation for CJK keywords is only supported for detection servers and is disabled by default. You must enable token validation for each detection server. In addition you must match on whole words for token validation to apply.

On the endpoint you can use whole word matching for CJK keywords.

Table 23-2 summarizes keyword matching use cases for CJK languages.

Table 23-2  Keyword matching use cases for CJK languages

<table>
<thead>
<tr>
<th>Detection component</th>
<th>Use case</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>Enable token verification on the detection server and use whole word matching</td>
</tr>
<tr>
<td></td>
<td>See “Enabling and using CJK token verification for server keyword matching” on page 593.</td>
</tr>
<tr>
<td>Endpoint</td>
<td>Use whole word matching</td>
</tr>
<tr>
<td></td>
<td>See “Keyword matching examples for CJK languages” on page 588.</td>
</tr>
</tbody>
</table>
About keyword proximity

Using keyword proximity, a policy author can define a pair of keywords and specify a word range between them. If the words occur within that range, a match is triggered. For example, an instance of the Content Matches Keyword condition might require that any instance of the words “confidential” and “information” occurring within 10 words of each other triggers a match.

Alternatively, you can use keyword proximity to exclude matching words within a specified distance by using the Content Matches Keyword condition as a detection exception. In this case any occurrence of the words “confidential” and “information” within 10 words of each is excepted from matching.

For Chinese, Japanese, and Korean (CJK) languages, a single CJK character is counted as one word.

See “Keyword matching syntax” on page 586.
See “Keyword matching examples” on page 587.
See “Configuring the Content Matches Keyword condition” on page 591.

Keyword matching syntax

When you define a keyword rule, the system evaluates every keyword in the condition list against each message component (header, subject, body, attachment).

Consider the following syntactical guidelines when creating keyword lists.

<table>
<thead>
<tr>
<th>Behavior</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Whole word matching</td>
<td>With whole word matching, keywords match at word boundaries only (\W in the regular expression lexicon). Any characters other than A-Z, a-z, and 0-9 are interpreted as word boundaries. With whole word matching, keywords must have at least one alphanumeric character (a letter or a number). A keyword consisting of only white-space characters, such as &quot;..&quot;, is ignored.</td>
</tr>
<tr>
<td>Quotation marks</td>
<td>Do not use quotation marks when you enter keywords or phrases because quotes are interpreted literally and will be required in the match.</td>
</tr>
<tr>
<td>White space</td>
<td>The systems strips out the white space before and after keywords or key phrases. Each whitespace within a keyword phrase is counted.</td>
</tr>
<tr>
<td>Case sensitivity</td>
<td>The case sensitivity option that you choose applies to all keywords in the list for that condition.</td>
</tr>
</tbody>
</table>
Table 23-3  Keyword matching syntax (continued)

<table>
<thead>
<tr>
<th>Behavior</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plurals and verb inflections</td>
<td>All plurals and verb inflections must be specifically listed. If the number of enumerations becomes complicated use the wildcard character (asterisk [*]) to detect a keyword suffix (in whole word mode only).</td>
</tr>
<tr>
<td>Keyword phrases</td>
<td>You can enter keyword phrases, such as social security number (without quotes). The system looks for the entire phrase without returning matches on individual constituent words (such as social or security).</td>
</tr>
<tr>
<td>Keyword variants</td>
<td>The system only detects the exact keyword or key phrase, not variants. For example, if you specify the key phrase social security number, detection does not match a phrase that contains two spaces between the words.</td>
</tr>
<tr>
<td>Matching multiple keywords</td>
<td>The system implies an OR between keywords. That is, a message component matches if it contains any of the keywords, not necessarily all of them. To perform an ALL (or AND) keyword match, combine multiple keyword conditions in a compound rule or exception.</td>
</tr>
</tbody>
</table>
| Alpha-numeric characters         | During keyword matching, only a letter or a digit is considered a valid keyword start position. Special characters (non-alphanumeric) are treated as delimiters (ignored). For example, the ampersand character ("&") and the underscore character ("_") are special characters and are not considered for keyword start position. For example, consider the following:  

```plaintext
_____keyword__
Keyword
&&akeyword&&
123Keyword__
```

For these examples, the valid keyword start positions are as follows: k, K, a, and 1. **Note:** This same behavior applies to keyword validators implemented in data identifiers. |
| Proximity                        | The word distance (proximity value) is exclusive of detected keywords. Thus, a word distance of 10 allows for a proximity window of 12 words. |

**Keyword matching examples**

To implement keyword matching, you can enter one or more keywords or phrases, each separated by a comma or newline character. You can match on whole or partial words, and specify case sensitivity. You can use the asterisk (*) wildcard character to detect a keyword suffix (in whole word mode only).

See "Keyword matching syntax" on page 586.
### Table 23-4  
Keyword matching examples

<table>
<thead>
<tr>
<th>Keyword type</th>
<th>Keyword(s)</th>
<th>Matches</th>
<th>Does Not Match</th>
</tr>
</thead>
<tbody>
<tr>
<td>keyword</td>
<td>confidential</td>
<td>confidential -confidential;</td>
<td>confidentially (in whole word mode only, otherwise it would match)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>®&quot;confidential&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>®Confidential</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>®CONFIDENTIAL</td>
<td></td>
</tr>
<tr>
<td>key phrase</td>
<td>internal use only</td>
<td>internal use only</td>
<td>internal use</td>
</tr>
<tr>
<td></td>
<td></td>
<td>internal use ONLY (if case insensitive is selected)</td>
<td></td>
</tr>
<tr>
<td>keyword list</td>
<td>Newline delimited:</td>
<td>Comma delimited:</td>
<td>hackers</td>
</tr>
<tr>
<td></td>
<td>hack</td>
<td>hack, hacker, hacks</td>
<td>shack</td>
</tr>
<tr>
<td></td>
<td>hacker</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>hacks</td>
<td></td>
<td></td>
</tr>
<tr>
<td>keyword with wildcard</td>
<td>priv*</td>
<td>private</td>
<td>prize</td>
</tr>
<tr>
<td>keyword dictionary</td>
<td>account number, account ps, american express, americanexpress, amex, bank card, bankcard, card num, card number, cc #, cc#, ccn, check card, checkcard, credit card, credit card #, credit card number, credit card#, debit card, debitcard, diners club, dinersclub, discover, enroute, japanese card bureau, jcb, mastercard, mc, visa, (etc....)</td>
<td>If any keyword or phrase is present, the data is matched:</td>
<td>amx creditcard master card car</td>
</tr>
</tbody>
</table>

**Keyword matching examples for CJK languages**

Table 23-5 provides keyword matching examples for Chinese, Japanese, and Korean languages. All examples assume that the keyword condition is configured to match on whole words only.
If token verification is enabled, the message size must be sufficient for the token validator to recognize the language. For example: the message “東京都市部の人口” is too small for a message for the token validation process to recognize the language of the message. The following message is a sufficient size for token validation processing:

今日のニュースによると東京都市部の人口は増加傾向にあるとのことでした。全国的な人口減少の傾向の中、東京への一極集中を表しています。


Token validation for CJK language keywords is not available on the endpoint. To match CJK on the endpoint, you configure the condition to match on whole words only.

Table 23-5  Keyword matching examples for CJK

<table>
<thead>
<tr>
<th>Language</th>
<th>Keyword</th>
<th>Matches on server with token validation ON</th>
<th>Matches on server with token validation OFF</th>
<th>Matches on endpoint</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chinese</td>
<td>通信</td>
<td>数字无线通信</td>
<td>数字无线通信 交通信息网站</td>
<td>数字无线通信 交通信息网站</td>
</tr>
<tr>
<td>Japanese</td>
<td>京都市</td>
<td>京都府京都市左京区</td>
<td>京都府京都市左京区 東京都市部の人口</td>
<td>京都府京都市左京区 東京都市部の人</td>
</tr>
<tr>
<td>Korean</td>
<td>정부</td>
<td>정부의방침</td>
<td>정부의방침 의정부 경전철</td>
<td>정부의방침 의정부 경전철</td>
</tr>
</tbody>
</table>

About updates to the Drug, Disease, and Treatment keyword lists

The Drug, Disease, and Treatment keyword lists are updated with current terminology (as of 2013-12-09) based on information from the U.S. Federal Drug Administration (FDA) and other sources. The Drug, and Disease, and Treatment keyword lists are used by the HIPAA and HITECH (including PHI) and Caldicott Report policy templates.

When you upgrade your Data Loss Prevention system, the generic, system-defined HIPAA and Caldicott policy templates are updated with the recent Drug, Disease, and Treatment keyword lists. However, policies you have created based on the HIPAA or Caldicott policy templates are not automatically updated. This behavior is expected so that any changes or customizations you have made to your HIPAA or Caldicott policy templates are not overwritten by updates to the system-defined templates. Updating the Drug, Disease, and Treatment keyword lists for your HIPAA
and Caldicott policy templates is a manual process that you should perform to ensure your HIPAA or Caldicott policies are up to date.

See “Updating the Drug, Disease, and Treatment keyword lists for your HIPAA and Caldicott policies” on page 594.

See “Keep the keyword lists for your HIPAA and Caldicott policies up to date” on page 596.

See “HIPAA and HITECH (including PHI) policy template” on page 826.

See “Caldicott Report policy template” on page 802.

### Configuring keyword matching

Table 23-6 describes the components for implementing keyword matching.

<table>
<thead>
<tr>
<th>Keyword matching feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Match on whole or partial keywords and key phrases</td>
<td>Separate each keyword or phrase by a newline or comma. See “Keyword matching examples” on page 587.</td>
</tr>
<tr>
<td>Match on the wildcard asterisk (*) character</td>
<td>Match the wildcard at the end of a keyword, in whole word mode only. See “Keyword matching examples” on page 587.</td>
</tr>
<tr>
<td>Keyword proximity matching</td>
<td>Match across a range of keywords. See “About keyword proximity” on page 586.</td>
</tr>
<tr>
<td>Find keywords</td>
<td>Implement one or more keywords in data identifiers to refine the scope of detection. See “Introducing data identifiers” on page 541.</td>
</tr>
<tr>
<td>Policy rules and exceptions</td>
<td>You can implement keyword matching conditions in policy rules and exceptions. See “Configuring the Content Matches Keyword condition” on page 591.</td>
</tr>
<tr>
<td>Cross-component matching</td>
<td>Keyword matching detects on one or more message components. See “Detection messages and message components” on page 305.</td>
</tr>
<tr>
<td>Keyword dictionary</td>
<td>If you have a large dictionary of keywords, you can index the keyword list. See “Use VML to generate and maintain large keyword dictionaries” on page 597.</td>
</tr>
<tr>
<td>CJK token verification</td>
<td>Enable on the detection server for CJK languages and match on whole words only. See Table 23-2 on page 585.</td>
</tr>
</tbody>
</table>
Configuring the Content Matches Keyword condition

The **Content Matches Keyword** condition lets you match content using keywords and key phrases.

See "Introducing keyword matching" on page 584.

You can implement keyword matching conditions in policy rules and exceptions. See “Configuring policies” on page 326.

**To configure the Content Matches Keyword condition**

1. Add a new keyword condition to a policy rule or exception, or modify an existing one.
   - See “Configuring policy rules” on page 330.
   - See “Configuring policy exceptions” on page 340.

2. Configure the keyword matching parameters.
   - See Table 23-7 on page 591.
   - See “Keyword matching syntax” on page 586.

3. Save the policy.

### Table 23-7: Configure the Content Matches Keyword condition

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter the match type.</td>
<td>Select if you want the keyword match to be: <strong>Case Sensitive</strong> or <strong>Case Insensitive</strong></td>
</tr>
<tr>
<td></td>
<td>Case insensitive is the default.</td>
</tr>
<tr>
<td>Choose the keyword separator.</td>
<td>Select the keyword separator you to delimit multiple keywords: <strong>Newline</strong> or <strong>Comma</strong>.</td>
</tr>
<tr>
<td></td>
<td>Newline is the default.</td>
</tr>
<tr>
<td>Match any keyword.</td>
<td>Enter the keyword(s) or key phrase(s) you want to match. Use the separator you have selected (newline or comma) to delimit multiple keyword or key phrase entries.</td>
</tr>
<tr>
<td></td>
<td>You can use the asterisk (*) wildcard character at the end of any keyword to match one or more suffix characters in that keyword. If you use the asterisk wildcard character, you must match on whole words only. For example, a keyword entry of <strong>confid</strong> would match on “confidential” and “confide,” but not “confine.” As long as the keyword prefix matches, the detection engine matches on the remaining characters using the wildcard.</td>
</tr>
<tr>
<td></td>
<td>See “Keyword matching syntax” on page 586.</td>
</tr>
<tr>
<td></td>
<td>See “Keyword matching examples” on page 587.</td>
</tr>
</tbody>
</table>
Table 23-7  Configure the Content Matches Keyword condition (continued)

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Configure keyword proximity matching</strong></td>
<td>Keyword proximity matching lets you specify a range of detection among keyword pairs.</td>
</tr>
<tr>
<td>(optional).</td>
<td>See “About keyword proximity” on page 586.</td>
</tr>
<tr>
<td></td>
<td>To implement keyword proximity matching:</td>
</tr>
<tr>
<td></td>
<td>■ Select (check) the <strong>Keyword Proximity matching</strong> option in the &quot;Conditions&quot; section of the rule builder interface.</td>
</tr>
<tr>
<td></td>
<td>■ Click <strong>Add Pair of Keywords</strong>.</td>
</tr>
<tr>
<td></td>
<td>■ Enter a pair of keywords.</td>
</tr>
<tr>
<td></td>
<td>■ Specify the <strong>Word distance</strong>.</td>
</tr>
<tr>
<td></td>
<td>The maximum distance between keywords is 999, as limited by the three-digit length of the “Word distance” field.</td>
</tr>
<tr>
<td></td>
<td>The word distance is exclusive of detected keywords. For example, a word distance of 10 allows for a range of 12 words, including</td>
</tr>
<tr>
<td></td>
<td>the two words comprising the keyword pair.</td>
</tr>
<tr>
<td></td>
<td>■ Repeat the process to add additional keyword pairs.</td>
</tr>
<tr>
<td></td>
<td>The system connects multiple keyword pair entries the OR Boolean operator, meaning that the detection engine evaluates each keyword</td>
</tr>
<tr>
<td></td>
<td>pair independently.</td>
</tr>
<tr>
<td><strong>Match on whole or partial keywords.</strong></td>
<td>Select the option <strong>On whole words only</strong> to match on whole keywords only (by default this option is selected).</td>
</tr>
<tr>
<td></td>
<td>You must match on whole words only if you use the asterisk (*) wildcard character in any keyword you enter in the list.</td>
</tr>
<tr>
<td></td>
<td>See “Keyword matching examples” on page 587.</td>
</tr>
<tr>
<td></td>
<td>You must match on whole words only if you have enabled token validation for the server.</td>
</tr>
<tr>
<td></td>
<td>See “Keyword matching examples for CJK languages” on page 588.</td>
</tr>
<tr>
<td><strong>Configure match conditions.</strong></td>
<td>Keyword matching lets you specify how you want to count condition matches.</td>
</tr>
<tr>
<td></td>
<td>Select one of the following options:</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Check for existence</strong></td>
</tr>
<tr>
<td></td>
<td>The system reports one incident for all matches.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Count all matches and only report incidents with at least 1 matches</strong> (default)</td>
</tr>
<tr>
<td></td>
<td>With the default setting the system reports one incident for each match. Alternatively, you can configure the match threshold by</td>
</tr>
<tr>
<td></td>
<td>changing the default value from 1 to another value.</td>
</tr>
<tr>
<td></td>
<td>See “Configuring match counting” on page 334.</td>
</tr>
</tbody>
</table>
Table 23-7 Configure the Content Matches Keyword condition (continued)

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select components to match on.</td>
<td>Keyword matching detection supports matching across message components. See “Selecting components to match on” on page 336.</td>
</tr>
<tr>
<td></td>
<td>Select one or more message components to match on:</td>
</tr>
<tr>
<td></td>
<td>- Envelope – Header metadata used to transport the message</td>
</tr>
<tr>
<td></td>
<td>- Subject – Email subject of the message (only applies to SMTP)</td>
</tr>
<tr>
<td></td>
<td>- Body – The content of the message</td>
</tr>
<tr>
<td></td>
<td>- Attachments – Any files attached to or transferred by the message</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: On the endpoint the DLP Agent matches on the entire message, not individual components. See “Detection messages and message components” on page 305.</td>
</tr>
<tr>
<td>Select components to match on.</td>
<td>Select this option to create a compound condition. All conditions must be met to report a match. You can Add any available condition from the list.</td>
</tr>
<tr>
<td></td>
<td>See “Configuring compound match conditions” on page 342.</td>
</tr>
</tbody>
</table>

Enabling and using CJK token verification for server keyword matching

To use token verification for Chinese, Japanese, and Korean (CJK) languages you must enable it on the server and you must use whole word matching for the keyword condition. In addition, there must be a sufficient amount of message text for the system to recognize the language.

See “Keyword matching examples for CJK languages” on page 588.

Table 23-8 lists and describes the detection server parameter that lets you enable token verification for CJK languages.

Table 23-8 Keyword token verification parameter

<table>
<thead>
<tr>
<th>Setting</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keyword.TokenVerifierEnabled</td>
<td>false</td>
<td>Default disabled (&quot;false&quot;). If enabled (&quot;true&quot;), the server validates tokens for Chinese, Japanese, and Korean language keywords.</td>
</tr>
</tbody>
</table>

Enable keyword token verification for CJK describes how to enable and use token verification for CJK keywords.
Enable keyword token verification for CJK

1. Log on to the Enforce Server as an administrative user.

2. Navigate to the System > Servers > Overview > Server Detail - Advanced Server Settings screen for the detection server you want to configure.
   
   See “Advanced server settings” on page 203.

3. Locate the parameter Keyword.TokenVerifierEnabled.

4. Change the value to true from false (default).
   
   Setting the server parameter Keyword.TokenVerifierEnabled = true enables token validation for CJK keyword detection.

5. Save the detection server configuration.

6. Recycle the detection server.

7. Configure a keyword condition using whole word matching.
   
   In the condition the option Match On whole word only is checked.
   
   See “Configuring the Content Matches Keyword condition” on page 591.

Updating the Drug, Disease, and Treatment keyword lists for your HIPAA and Caldicott policies

If you have created a policy derived from the HIPAA or Caldicott template and have not made any changes or customizations to the derived policy, after upgrade you can create a new policy from the appropriate template and remove the old policy from production. If you have made changes to a policy derived from either the HIPAA or Caldicott policy template and you want to preserve these changes, you can copy the updated keyword lists from either the HIPAA or Caldicott policy template and use the copied keyword lists to update your HIPAA or Caldicott policies.

See “About updates to the Drug, Disease, and Treatment keyword lists” on page 589.

See “Keep the keyword lists for your HIPAA and Caldicott policies up to date” on page 596.

To update the Drug, Disease, and Treatment keyword lists for HIPAA and Caldicott policies provides instructions for updating the keyword lists for your HIPAA and Caldicot policies.
To update the Drug, Disease, and Treatment keyword lists for HIPAA and Caldicott policies

1. Create a new policy from a template and choose either the HIPAA or Caldicott template.
   
   See “Creating a policy from a template” on page 312.

2. Edit the detection rules for the policy.
   
   See “Configuring policy rules” on page 330.

3. Select the Patient Data and Drug Keywords (Keyword Match) rule.

4. Select the Content Matches Keyword condition.

5. Select all the keywords in the Match any Keyword data field and copy them to the Clipboard.

6. Paste the copied keywords to a text file named Drug Keywords.txt.

7. Cancel the rule edit operation to return to the policy Detection tab.

8. Repeat the same process for the Patient Data and Treatment Keywords (Keyword Match) rule.

9. Copy and paste the keywords from the condition to a text file named Treatment Keywords.txt.

10. Repeat the same process for the Patient Data and Disease Keywords (Keyword Match) rule.

11. Copy and paste the keywords from the condition to a text file named Disease Keywords.txt.

12. Update your HIPAA and Caldicott policies derived from the HIPAA or Caldicott templates using the keyword *.txt files you created.

13. Test your updated HIPAA and Caldicott policies.

Best practices for using keyword matching

The Content Matches Keyword condition lets you match content using keywords, key phrases, and keyword lists or dictionaries. On the server, the keyword rule matches on the header, subject, body and attachment message components, and it supports cross-component matching. On the endpoint the keyword condition matches on the entire message.

Table 23-9 summarizes the keyword matching best practices in this section.
Table 23-9  Summary of keyword matching best practices

<table>
<thead>
<tr>
<th>Best practice</th>
<th>More information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable linguistic validation for CJK keyword detection on the server.</td>
<td>See “Enable token verification on the server to reduce false positives for CJK keyword detection” on page 596.</td>
</tr>
<tr>
<td>Update keyword lists for your Caldicott and HIPAA policies.</td>
<td>See “Keep the keyword lists for your HIPAA and Caldicott policies up to date” on page 596.</td>
</tr>
<tr>
<td>Tune keyword validators to improve data identifier accuracy.</td>
<td>See “Tune keywords lists for data identifiers to improve match accuracy” on page 597.</td>
</tr>
<tr>
<td>Use VML to profile long keyword lists and dictionaries</td>
<td>See “Use VML to generate and maintain large keyword dictionaries” on page 597.</td>
</tr>
<tr>
<td>Use keyword matching for metadata detection.</td>
<td>See “Use keyword matching to detect document metadata” on page 597.</td>
</tr>
</tbody>
</table>

Enable token verification on the server to reduce false positives for CJK keyword detection

Symantec Data Loss Prevention provides token validation for Chinese, Japanese, and Korean (CJK) languages. Token validation is supported for detection servers and must be enabled.


Token validation lets you match CJK keywords using whole word matching, and improves overall match accuracy for CJK languages. Although there may be a slight performance hit, you should enable token verification for each detection server where CJK keyword conditions are deployed. Once enabled you can use whole word matching for CJK keywords.

See “Enabling and using CJK token verification for server keyword matching” on page 593.

Keep the keyword lists for your HIPAA and Caldicott policies up to date

For each Symantec Data Loss Prevention release, the Drug, Disease, and Treatment keyword lists are updated based on information from the U.S. Federal Drug Administration (FDA) and other sources. These keyword lists are used in the HIPAA and HITECH (including PHI) and Caldicott Report policy templates.

See “About updates to the Drug, Disease, and Treatment keyword lists” on page 589.
If you have upgraded to the latest Data Loss Prevention version and you have existing policies derived from either the HIPAA or Caldicott policy template, consider updating your HIPAA and Caldicott policies to use the Drug, Disease, and Treatment keyword lists provided with this Data Loss Prevention version.

See “Updating the Drug, Disease, and Treatment keyword lists for your HIPAA and Caldicott policies” on page 594.

Tune keywords lists for data identifiers to improve match accuracy

Many data identifier definitions contain required keyword validators with prepopulated keyword lists. In addition, you can add your own list of keywords to a data identifier rule. The best practice is tune the keyword list using a keyword matching condition before you add the keyword list to the data identifier condition as a required or optional validator.

See “Using pattern validators” on page 575.

To tune the keyword list, take the keywords you want to use for the validator and put them into a separate keyword matching rule condition and policy. Then test the policy using data that should and should not match the keywords. The keyword rule will let you see match highlighting and tune the keyword list. Once tested, you can add the keywords to the data identifier and then test the data identifier policy to ensure accuracy.

Use keyword matching to detect document metadata

Symantec Data Loss Prevention supports metadata detection for certain document formats, such as DOCX and PDF. Detection servers and DLP Agents support metadata detection.

If you want to detect document metadata, the recommendation is to enable it for the server or endpoint and use the **Content Matches Keyword** condition to match metadata tags.

Use VML to generate and maintain large keyword dictionaries

Sometimes you may want to protect a long list or dictionary of keywords. An example might be a list of project code names. You can use Vector Machine Learning (VML) to automate the detection of long keyword lists that are difficult to generate, tune, and maintain. For example, you could generate a VML profile based on a collection of documents containing the keywords you want to detect. If you want to detect common words, remove them from the VML stopword file.

See "Best practices for using VML" on page 532.
Detecting content using regular expressions

This chapter includes the following topics:

- Introducing regular expression matching
- About writing regular expressions
- Configuring the Content Matches Regular Expression condition
- Best practices for using regular expression matching

Introducing regular expression matching

Data Loss Prevention provides the Content Matches Regular Expression policy match condition to match message content using the regular expression pattern language.

Regular expressions provide a mechanism for identifying strings of text, such as particular characters, words, or patterns of characters. You can use the regular expression condition is used to match (or exclude from matching) characters, patterns, and strings.

See “Configuring the Content Matches Regular Expression condition” on page 600.

See “Best practices for using regular expression matching” on page 601.

About writing regular expressions

Symantec Data Loss Prevention implements the Java regular expression syntax for policy condition matching, provides some reference constructs for writing regular expressions to match or exclude characters in messages or message components.
See “Introducing regular expression matching” on page 598.

**Note:** Data Identifier pattern matching is based on the regular expression syntax. However, not all regular expression constructs listed in the table below are supported by Data Identifier patterns. See “About data identifier patterns” on page 547.

### Table 24-1  Regular expression constructs

<table>
<thead>
<tr>
<th>Regular expression construct</th>
<th>Description</th>
</tr>
</thead>
</table>
| .                            | Any single character (except for newline characters)  
**Note:** The use of the dot (.) character is not supported for data identifier patterns. |
| \d                           | Any digit (0-9) |
| \s                           | Any white space |
| \w                           | Any word character (a-z, A-Z, 0-9, _)  
**Note:** The use of the \w construct does not match the underscore (_) character when implemented in a data identifier pattern. |
| \D                           | Anything other than a digit |
| \s                           | Anything other than white space |
| []                           | Elements inside brackets are a character class (For example, [abc] matches 1 character: a, b, or c.) |
| ^                            | At the beginning of a character class, negates it (For example, [^abc] matches anything except a, b, or c.) |
| +                            | Following a regular expression means 1 or more (For example, \d+ means 1 or more digit.) |
| ?                            | Following a regular expression means 0 or 1 (For example, \d? means 1 or no digits.) |
| *                            | Following a regular expression means any number (For example, \d* means 0, 1, or more digits.) |
| (?i)                         | At the beginning of a regular expression makes it case-insensitive (Regular expressions are case-sensitive by default.) |
| (?:)                         | Groups regular expressions together (The : is a slight performance enhancement.) |
| (?u)                         | Makes a period (.) match even newline characters |
| |                             | Means OR (For example, A | B means regular expression A or regular expression B.) |
Configuring the Content Matches Regular Expression condition

You use the **Content Matches Regular Expression** condition to match (or exclude from matching) characters, patterns, and strings using regular expressions.

See “Introducing regular expression matching” on page 598.

To configure the Content Matches Regular Expression condition

1. Add a **Content Matches Regular Expression** condition to a policy, or edit an existing one.
   
   See “Configuring policies” on page 326.
   
   See “Configuring policy rules” on page 330.
   
   See “Configuring policy exceptions” on page 340.

2. Configure the **Content Matches Regular Expression** condition parameters.
   
   See Table 24-2 on page 600.

3. Save the policy configuration.

Table 24-2  Content Matches Regular Expression parameters

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Match regex.</td>
<td>Specify a regular expression to be matched.</td>
</tr>
<tr>
<td></td>
<td>See “About writing regular expressions” on page 598.</td>
</tr>
<tr>
<td>Configure match counting.</td>
<td>Configure how you want to count matches.</td>
</tr>
<tr>
<td></td>
<td>See “Configuring match counting” on page 334.</td>
</tr>
<tr>
<td>Check for existence</td>
<td>Reports a match count of 1 if there are one or more matches. For compound</td>
</tr>
<tr>
<td></td>
<td>rules or exceptions, all conditions must be configured this way.</td>
</tr>
<tr>
<td>Count all matches</td>
<td>Reports the sum of all matches; applies if any condition uses this parameter.</td>
</tr>
</tbody>
</table>

Detecting content using regular expressions
Table 24-2  Content Matches Regular Expression parameters (continued)

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Match on one or more message components.</td>
<td>Configure cross-component matching by selecting one or more message components to match on.</td>
</tr>
<tr>
<td>■ Envelope – The header of the message,</td>
<td>transport metadata.</td>
</tr>
<tr>
<td>■ Subject – The email subject (only applies</td>
<td>The email subject (only applies to email messages).</td>
</tr>
<tr>
<td>to email messages).</td>
<td></td>
</tr>
<tr>
<td>■ Body – The content of the message.</td>
<td>The content of the message.</td>
</tr>
<tr>
<td>■ Attachments – The content of any files</td>
<td>that are attached to or transported by the message.</td>
</tr>
<tr>
<td>See “Selecting components to match on” on</td>
<td>page 336.</td>
</tr>
<tr>
<td>Note: On the endpoint the DLP Agent matches</td>
<td>the entire message regardless of any individually selected components. See “Detection messages and message components” on page 305.</td>
</tr>
<tr>
<td>Also match one or more additional conditions.</td>
<td>Select this option to create a compound condition. All conditions must match to trigger or except an incident.</td>
</tr>
<tr>
<td>You can Add any available condition from</td>
<td>the list.</td>
</tr>
<tr>
<td>See “Configuring compound match conditions”</td>
<td>on page 342.</td>
</tr>
<tr>
<td>Best practices for using regular expression matching</td>
<td></td>
</tr>
</tbody>
</table>

This section provides considerations for implementing the Content Matches Regular Expression match condition in your Data Loss Prevention policies. See “Introducing regular expression matching” on page 598.

Table 24-3 summarizes the regular expression matching best practices in this section.

Table 24-3  Regular Expressions best practices

<table>
<thead>
<tr>
<th>Best practice</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Data Identifiers instead of regular expressions where possible.</td>
<td>See “Use regular expressions sparingly to support efficient performance” on page 603.</td>
</tr>
<tr>
<td>Use regular expressions sparingly to support efficient policy performance.</td>
<td>See “Test regular expressions before deployment to improve accuracy” on page 603.</td>
</tr>
<tr>
<td>Use look ahead and behind characters to improve regex performance.</td>
<td>See “Use look ahead and look behind characters to improve regex accuracy” on page 602.</td>
</tr>
</tbody>
</table>
### Table 24-3  Regular Expressions best practices (continued)

<table>
<thead>
<tr>
<th>Best practice</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test regular expressions for accuracy and performance.</td>
<td>See “Use look ahead and look behind characters to improve regex accuracy” on page 602.</td>
</tr>
</tbody>
</table>

### When to use regular expression matching

Data Identifiers are more efficient than regular expressions because the Data Identifier patterns are tuned for accuracy and the data is validated. For example, if you want to search for social security numbers, use the US Social Security Number (SSN) Data Identifier instead of a regular expression.

The regular expression condition is useful for matching or excepting unique data types for which there are no system-provided Data Identifiers. Examples of these might include internal account numbers and data types that can vary greatly in length, such as email addresses.

### Use look ahead and look behind characters to improve regex accuracy

Symantec Data Loss Prevention implements a significant enhancement to improve the performance of regular expressions. To achieve improved regex performance, the look ahead and look behind sections must exactly match one of the supported standard sections.

**Table 24-4** lists the standard look ahead and look behinds sections that this performance improvement supports. If either section differs even slightly, that section is executed as part of the regular expression without the performance improvement.

See “About writing regular expressions” on page 598.

**Table 24-4  Look ahead and look behind standard sections**

<table>
<thead>
<tr>
<th>Operation</th>
<th>Construct</th>
</tr>
</thead>
<tbody>
<tr>
<td>Look ahead</td>
<td>`(?:[^-\w])</td>
</tr>
<tr>
<td>Look behind</td>
<td>`(?:[^-\w]+\d[^-\w]+)</td>
</tr>
<tr>
<td></td>
<td>`(?:[^-\w]+\d[^-\w]+)</td>
</tr>
<tr>
<td></td>
<td>`(?:[^-\w]+\d[^-\w]+)</td>
</tr>
</tbody>
</table>
Use regular expressions sparingly to support efficient performance

Regular expressions can be computationally expensive. If you add a regular expression condition, observe the system for one hour. Make sure that the system does not slow down and that there are no false positives.

Test regular expressions before deployment to improve accuracy

If you implement regular expression matching, consider using a third-party tool to test the regular expressions before you deployment the policy rules to production. The recommended tool is RegexBuddy. Another good tool for testing your regular expressions is RegExr.
Detecting international language content

This chapter includes the following topics:

- Detecting non-English language content
- Best practices for detecting non-English language content

Detecting non-English language content

Symantec Data Loss Prevention detection features support many localized versions of Microsoft Windows operating systems. To use international character sets, the Windows system on which you view the Enforce Server administration console must have the appropriate capabilities.

See “About support for character sets, languages, and locales” on page 64.

See “Working with international characters” on page 67.

You can create policies and detect violations using any supported language. You can use localized keywords, regular expressions, and Data Profiles to detect data loss. In addition, Symantec Data Loss Prevention offers several international data identifiers and policy templates for protecting confidential data.

See “Supported languages for detection” on page 65.

See “Use international policy templates for policy creation” on page 605.

See “Use custom keywords for system data identifiers” on page 606.
Best practices for detecting non-English language content

This section provides some best practices for implementing non-English language content detection.

Upgrade to the latest version of Data Loss Prevention

Symantec Data Loss Prevention version 12.5 includes several enhancements for Asian language detection, including multi-token EDM and linguistic validation for Chinese, Japanese, and Korean (CJK) keywords. To take advantage of these enhancements, upgrade your servers to the latest version and update your Exact Data profiles.

See “Updating EDM indexes to version 12.5” on page 416.

See “Enable token validation to match Chinese, Japanese, and Korean keywords on the server” on page 608.

Use international policy templates for policy creation

Symantec Data Loss Prevention provides several international policy templates that you can quickly deploy in your enterprise.

See “Creating a policy from a template” on page 312.

Table 25-1 International policy templates

<table>
<thead>
<tr>
<th>Policy template</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Canadian Social Insurance Numbers</td>
<td>This policy detects patterns indicating Canadian social insurance numbers.</td>
</tr>
<tr>
<td></td>
<td>See “Canadian Social Insurance Numbers policy template” on page 804.</td>
</tr>
<tr>
<td>Caldicott Report</td>
<td>This policy protects UK patient information.</td>
</tr>
<tr>
<td></td>
<td>See “Caldicott Report policy template” on page 802.</td>
</tr>
<tr>
<td>UK Data Protection Act 1998</td>
<td>This policy protects personal identifiable information.</td>
</tr>
<tr>
<td></td>
<td>See “Data Protection Act 1998 (UK) policy template” on page 810.</td>
</tr>
<tr>
<td>EU Data Protection Directives</td>
<td>This policy detects personal data specific to the EU directives.</td>
</tr>
<tr>
<td></td>
<td>See “Data Protection Directives (EU) policy template” on page 811.</td>
</tr>
<tr>
<td>UK Human Rights Act 1998</td>
<td>This policy enforces Article 8 of the act for UK citizens.</td>
</tr>
</tbody>
</table>
The following table provides keywords for several international data identifiers.

### Table 25-1  International policy templates (continued)

<table>
<thead>
<tr>
<th>Policy template</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PIPEDA (Canada)</td>
<td>This policy detects Canadian citizen customer data.</td>
</tr>
<tr>
<td>PIPEDA (Canada)</td>
<td>See “PIPEDA policy template” on page 846.</td>
</tr>
<tr>
<td>SWIFT Codes (International banking)</td>
<td>This policy detects codes that banks use to transfer money across international borders.</td>
</tr>
<tr>
<td>SWIFT Codes (International banking)</td>
<td>See “SWIFT Codes policy template” on page 862.</td>
</tr>
<tr>
<td>UK Drivers License Numbers</td>
<td>This policy detects UK Drivers License Numbers.</td>
</tr>
<tr>
<td>UK Drivers License Numbers</td>
<td>See “UK Drivers License Numbers policy template” on page 863.</td>
</tr>
<tr>
<td>UK Electoral Roll Numbers</td>
<td>This policy detects UK Electoral Roll Numbers.</td>
</tr>
<tr>
<td>UK Electoral Roll Numbers</td>
<td>See “UK Electoral Roll Numbers policy template” on page 864.</td>
</tr>
<tr>
<td>UK National Insurance Numbers</td>
<td>This policy detects UK National Insurance Numbers.</td>
</tr>
<tr>
<td>UK National Health Service Number</td>
<td>This policy detects personal identification numbers issued by the NHS.</td>
</tr>
<tr>
<td>UK National Health Service Number</td>
<td>See “UK National Health Service (NHS) Number policy template” on page 864.</td>
</tr>
<tr>
<td>UK Passport Numbers</td>
<td>This policy detects valid UK passports.</td>
</tr>
<tr>
<td>UK Passport Numbers</td>
<td>See “UK Passport Numbers policy template” on page 865.</td>
</tr>
<tr>
<td>UK Tax ID Numbers</td>
<td>This policy detects UK Tax ID Numbers.</td>
</tr>
<tr>
<td>UK Tax ID Numbers</td>
<td>See “UK Tax ID Numbers policy template” on page 865.</td>
</tr>
</tbody>
</table>

### Use custom keywords for system data identifiers

Data identifiers offer broad support for detecting international content.

See “Introducing data identifiers” on page 541.

Some international data identifiers offer a wide breadth of detection only. In this case you can implement the Find Keywords optional validator to narrow the scope of detection. Implementing this optional validator may help you eliminate any false positives that your policy matches.

See “Selecting a data identifier breadth” on page 555.

The following table provides keywords for several international data identifiers.
To use international keywords for system data identifiers

1. Create a policy using one of the system-provided international data identifiers that is listed in the table.

   Table 25-2

2. Select the **Find Keywords** optional validator.

   See “Configuring the Content Matches data identifier condition” on page 552.

3. Copy and past the appropriate comma-separated keywords from the list to the **Find Keywords** optional validator field.

   See “Configuring optional validators” on page 559.

### Table 25-2

<table>
<thead>
<tr>
<th>Data Identifier</th>
<th>Language</th>
<th>Keywords</th>
<th>English Translation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Burgerservicenummer (BSN)</td>
<td>Dutch</td>
<td>Persoonsnummer, sofinummer, sociaal-fiscaal nummer, persoonsgebonden</td>
<td>person number, social-fiscal number (abbreviation), social-fiscal number, person-related number</td>
</tr>
<tr>
<td>Codice Fiscale</td>
<td>Italian</td>
<td>codice fiscal, dati anagrafici, partita I.V.A., p. iva</td>
<td>tax code, personal data, VAT number, VAT number</td>
</tr>
<tr>
<td>French INSEE Code</td>
<td>French</td>
<td>INSEE, numéro de sécu, code sécu</td>
<td>INSEE, social security number, social security code</td>
</tr>
<tr>
<td>Hong Kong ID</td>
<td>Chinese (Traditional)</td>
<td>身份證, 三顆星</td>
<td>Identity card, Hong Kong permanent resident ID Card</td>
</tr>
<tr>
<td>International Bank Account Number (IBAN) Central</td>
<td>French</td>
<td>Code IBAN, numéro IBAN</td>
<td>IBAN Code, IBAN number</td>
</tr>
<tr>
<td>International Bank Account Number (IBAN) East</td>
<td>French</td>
<td>Code IBAN, numéro IBAN</td>
<td>IBAN Code, IBAN number</td>
</tr>
<tr>
<td>International Bank Account Number (IBAN) West</td>
<td>French</td>
<td>Code IBAN, numéro IBAN</td>
<td>IBAN Code, IBAN number</td>
</tr>
<tr>
<td>People's Republic of China ID</td>
<td>Chinese (Simplified)</td>
<td>身份证,居民信息,居民身份信息</td>
<td>Identity Card, Information of resident, Information of resident identification</td>
</tr>
<tr>
<td>South Korea Resident Registration Number</td>
<td>Korean</td>
<td>주민등록번호, 주민번호</td>
<td>Resident Registration Number, Resident Number</td>
</tr>
</tbody>
</table>
Table 25-2
International data identifiers and keyword lists (continued)

<table>
<thead>
<tr>
<th>Data Identifier</th>
<th>Language</th>
<th>Keywords</th>
<th>English Translation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spanish DNI ID</td>
<td>Spanish</td>
<td>DNI</td>
<td>DNI</td>
</tr>
<tr>
<td>Swiss AHV Number</td>
<td>French</td>
<td>Numéro AVS, numéro d'assuré, identifiant national, numéro d'assurance vieillesse, numéro de sécurité sociale, Numéro AVH</td>
<td>AVS number, insurance number, national identifier, national insurance number, social security number, AVH number</td>
</tr>
<tr>
<td>German</td>
<td></td>
<td>AHV-Nummer, Matrikelnumme, Personenidentifikationsnummer</td>
<td>AHV number, Swiss Registration number, PIN</td>
</tr>
<tr>
<td>Italian</td>
<td></td>
<td>AVS, AVH</td>
<td>AVS, AVH</td>
</tr>
<tr>
<td>Taiwan ID</td>
<td>Chinese (Traditional)</td>
<td>中華民國國民身分證</td>
<td>Taiwan ID</td>
</tr>
</tbody>
</table>

Enable token validation to match Chinese, Japanese, and Korean keywords on the server

The **Content Matches Keyword** condition supports both whole word and partial word matching.

Symantec Data Loss Prevention detection servers support natural language processing for Chinese, Japanese, and Korean (CJK) language keywords. If you want to detect CJK keywords, the recommendation is to enable token validation on the detection server and to use whole word matching for the keyword condition.

The DLP Agent does not support token validation for CJK. On the endpoint, for CJK and mixed-language keyword matching, consider using partial word matching.

With whole word matching, keywords match at word boundaries only (\W in the regular expression lexicon). Any characters other than A-Z, a-z, and 0-9 are interpreted as word boundaries. With whole word matching, keywords must have at least one alphanumeric character (a letter or a number). A keyword consisting of only white-space characters, such as "..", is ignored.

Detected file properties

This chapter includes the following topics:

- Introducing file property detection
- Configuring file property matching
- Best practices for using file property matching

Introducing file property detection

Symantec Data Loss Prevention provides various methods for detecting the context of messages, files, and attachments. You can detect the type, size, and name of files and attachments. You can also use these conditions to except files and attachments from matching.

See “About file type matching” on page 609.

See “About file size matching” on page 611.

See “About file name matching” on page 611.

See “Configuring file property matching” on page 611.

About file type matching

You use the **Message Attachment or File Type Match** condition to match the file type of a message attachment. Symantec Data Loss Prevention supports the identification of over 300 file types.

See “Supported formats for file type identification” on page 669.

Example uses of message attachment and file type matching are as follows:

- A certain type of document should never leave the organization (such as a PGP document or EXE file).
A certain type of match is likely to occur only in a document of a certain type, such as a Word document.

The detection engine does not rely on the file name extension to match file format type. For example, if a user changes the .mp3 file name extension to .doc and emails the file, the detection engine can still register a match because it checks the binary signature of the file to detect it as an MP3 file.

**Note:** File type matching does not crack the file and detect content; it only detects the file type based on the binary signature of the file. To detect content, use a content matching condition.

See “Configuring the Message Attachment or File Type Match condition” on page 612.

See “About custom file type identification” on page 610.

About file format support for file type matching

Symantec Data Loss Prevention supports over 300 file formats for file type identification using the **Message Attachment or File Type Match** policy condition.

Refer to the following link for a complete list of file formats that can be recognized by this policy condition.

See “Supported formats for file type identification” on page 669.

About custom file type identification

If the type of file you want to detect is not supported as a system default file type, Symantec Data Loss Prevention provides you with the ability to identify custom file types using scripts.

To detect a custom file type, you use the Symantec Data Loss Prevention Scripting Language to write a custom script that detects the binary signature of the file format that you want to protect. To implement this match condition you need to enable it on the Enforce Server.

See “Enabling the Custom File Type Signature condition in the policy console” on page 616.

See “Configuring the Custom File Type Signature condition” on page 617.

Refer to the **Symantec Data Loss Prevention Detection Customization Guide** for the language syntax and examples.
Note: The Symantec Data Loss Prevention Scripting Language only identifies custom file formats; it does not extract content from custom file types.

About file size matching

You use the **Message Attachment or File Size Match** condition to detect the size of the message body and attachment. Detection is based on either the body or attachment message component, or both, but not the entire message.

For example, consider a condition where you specify that an attachment size greater than 50k matches. A message with a 5k header, 10k body, and 55k attachment matches because the detected message component is the attachment, which in this case is over the 50k threshold. On the other hand, a message with a 5k header, 10k body, and 45k attachment does not match, even though the entire message is more than 50k.

See “Detection messages and message components” on page 305.

See “Configuring the Message Attachment or File Size Match condition” on page 613.

About file name matching

You use the **Message Attachment or File Name Match** condition to detect the names of files and attachments.

See “File name matching syntax” on page 615.

See “File name matching examples” on page 615.

See “Configuring the Message Attachment or File Name Match condition” on page 614.

### Configuring file property matching

**Table 26-1** lists the conditions available for implementing file property matching.

<table>
<thead>
<tr>
<th>Match condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message Attachment or File Type Match</td>
<td>Detect or except specific files and attachments by type.</td>
</tr>
<tr>
<td></td>
<td>See “About file type matching” on page 609.</td>
</tr>
<tr>
<td></td>
<td>See “Configuring the Message Attachment or File Type Match condition” on page 612.</td>
</tr>
</tbody>
</table>
Table 26-1  File Properties match conditions (continued)

<table>
<thead>
<tr>
<th>Match condition</th>
<th>Description</th>
</tr>
</thead>
</table>
| Message Attachment or File Size Match          | Detect or except specific files and attachments by size.  
  See “About file size matching” on page 611.  
  See “Configuring the Message Attachment or File Size Match condition” on page 613. |
| Message Attachment or File Name Match          | Detect or except specific files and attachments by name.  
  See “About file name matching” on page 611.  
  See “Configuring the Message Attachment or File Name Match condition” on page 614. |
| Custom File Type Signature                     | Detect or except custom file types.                                                                                                                                                               |
| Message/Email Properties and Attributes        | Detect email properties for Data Classification services.  
  See “Configuring the Classify Enterprise Vault Content response action” on page 915.  
  See the Enterprise Vault Data Classification Services Implementation Guide. |

Configuring the Message Attachment or File Type Match condition

The **Message Attachment or File Type Match** condition matches the file type of an attachment message component. You can configure an instance of this condition in policy rules and exceptions.

See “About file type matching” on page 609.

To configure the Message Attachment or File Type Match condition

1. Add a **Message Attachment or File Type Match** condition to a policy rule or exception, or edit an existing one.
   
   See “Configuring policies” on page 326.  
   See “Configuring policy rules” on page 330.  
   See “Configuring policy exceptions” on page 340.

2. Configure the **Message Attachment or File Type Match** condition parameters.
   
   See Table 26-2 on page 613.

3. Click **Save** to save the policy.
### Configuring the Message Attachment or File Size Match condition

The **Message Attachment or File Size Match** condition matches or excludes from matching files of a specified size. You can configure an instance of this condition in policy rules and exceptions.

See “About file size matching” on page 611.

**To configure the Message Attachment or File Size Match condition**

1. Add a Message Attachment or File Size Match condition to a policy, or edit an existing one.
   
   See “Configuring policies” on page 326.
   
   See “Configuring policy rules” on page 330.
   
   See “Configuring policy exceptions” on page 340.

2. Configure the **Message Attachment or File Type Match** condition parameters.
   
   See Table 26-3 on page 614.

3. Click **Save** to save the policy.

### Table 26-2

**Message Attachment or File Type Match condition parameters**

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| Select the file type or types to match. | Select all of the formats you want to match.  
See “Supported formats for file type identification” on page 669.  
Click **select all** or **deselect all** to select or deselect all formats.  
To select all formats within a certain category (for example, all word-processing formats), click the section heading.  
The system implies an OR operator among all file types you select. For example, if you select Microsoft Word and Microsoft Excel file type attachments, the system detects all messages with Word or Excel documents attached, not messages with both attachment types. |
| Match on attachments only. | This condition only matches on the **Message Attachments** component.  
See “Detection messages and message components” on page 305. |
| Also match on one or more additional conditions. | Select this option to create a compound condition. All conditions must match to trigger or except an incident.  
You can **Add** any condition available from the list.  
See “Configuring compound match conditions” on page 342. |
Table 26-3 Message Attachment or File Size Match parameters

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter the Size to match.</td>
<td>Enter a number, and select the unit of measure: bytes, kilobytes (KB), megabytes (MB), or gigabytes (GB). Select More Than to specify the minimum size of the file to match. Select Less Than to specify the maximum size of the file to match.</td>
</tr>
</tbody>
</table>
| Match on the body or attachments.           | Select one or both of the following message components on which to base the match:  
  - **Body** – The content of the message.  
  - **Attachments** – Any files that are attached to or transferred by the message.  
  See “Selecting components to match on” on page 336. |
| Also match one or more additional conditions.| Select this option to create a compound condition. All conditions must match to trigger or except an incident.  
You can Add any condition available from the list.  
See “Configuring compound match conditions” on page 342. |

Configuring the Message Attachment or File Name Match condition

The **Message Attachment or File Name Match** condition matches based on the name of a file attached to the message. You can configure an instance of this condition in policy rules and exceptions.

See “About file name matching” on page 611.

**To configure the Message Attachment or File Name Match condition**

1. Add a Message Attachment or File Name Match condition to a policy, or edit an existing one.
   - See “Configuring policies” on page 326.
   - See “Configuring policy rules” on page 330.
   - See “Configuring policy exceptions” on page 340.

2. Configure the Message Attachment or File Type Match condition parameters.
   - See Table 26-4 on page 615.

3. Click **Save** to save the policy.
Table 26-4  Message Attachment or File Name Match parameters

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify the File Name.</td>
<td>Specify the file name to match using the DOS pattern matching language to represent patterns in the file name.</td>
</tr>
<tr>
<td></td>
<td>Separate multiple matching patterns with commas or by placing them on separate lines.</td>
</tr>
<tr>
<td></td>
<td>See “File name matching syntax” on page 615.</td>
</tr>
<tr>
<td></td>
<td>See “File name matching examples” on page 615.</td>
</tr>
<tr>
<td>Match on attachments.</td>
<td>This condition only matches on the Message Attachments component.</td>
</tr>
<tr>
<td></td>
<td>See “Detection messages and message components” on page 305.</td>
</tr>
<tr>
<td>Also match one or more additional conditions.</td>
<td>Select this option to create a compound condition. All conditions must match to trigger or except an incident.</td>
</tr>
<tr>
<td></td>
<td>You can Add any condition available from the list.</td>
</tr>
<tr>
<td></td>
<td>See “Configuring compound match conditions” on page 342.</td>
</tr>
</tbody>
</table>

File name matching syntax

For file name matching, the system supports the DOS pattern matching syntax to detect file names, including wildcards.

See “About file name matching” on page 611.

Any characters you enter (other than the DOS operators) match exactly. To enter multiple file names, enter them as comma-separated values or by line space.

Table 26-5 describes the syntax for the Message Attachment or File Name Match condition.

Table 26-5  DOS Operators for file name detection

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.</td>
<td>Use a dot to separate the file name and the extension.</td>
</tr>
<tr>
<td>*</td>
<td>Use an asterisk as a wild card to match any number of characters (including none).</td>
</tr>
<tr>
<td>?</td>
<td>Use a question mark to match a single character.</td>
</tr>
</tbody>
</table>

File name matching examples

Table 26-6 lists some examples for matching file names using the Message Attachment or File Name condition.
See “About file name matching” on page 611.

Table 26-6  File name matching examples

<table>
<thead>
<tr>
<th>Match objective</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>To match a Word file name that begins with ENG- followed by any eight characters:</td>
<td>ENG-?????????.doc</td>
</tr>
<tr>
<td>If you are not sure that it is a Word document:</td>
<td>ENG-?????????.*</td>
</tr>
<tr>
<td>If you are not sure how many characters are in the name:</td>
<td>ENG-<em>.</em></td>
</tr>
<tr>
<td>To match all file names that begin with ENG- and all file names that begin with ITA-:</td>
<td>Enter as comma separated values:</td>
</tr>
<tr>
<td></td>
<td>ENG-<em>.</em>,ITA-*</td>
</tr>
<tr>
<td></td>
<td>Or separate the file names by line space:</td>
</tr>
<tr>
<td></td>
<td>ENG-<em>.</em></td>
</tr>
<tr>
<td></td>
<td>ITA-*.</td>
</tr>
</tbody>
</table>

Enabling the Custom File Type Signature condition in the policy console

By default the Custom File Type Signature policy condition is not enabled. To implement the Custom File Type Signature condition, you must first enable it.

See “About custom file type identification” on page 610.

To enable the Custom File Type Signature rule

1. Using a text editor, open the file
   \SymantecDLP\Protect\config\Manager.properties

2. Set the value of the following parameter to "true":
   com.vontu.manager.policy.showcustomscriptrule=true

3. Stop and then restart the Vontu Manager service.

4. Log back on to the Enforce Server Administration Console and add a new blank policy.

5. Add a new detection rule or exception and beneath the File Properties heading you should see the Custom File Type Signature condition.

6. Configure the condition with your custom script.

See “Configuring the Custom File Type Signature condition” on page 617.
Configuring the Custom File Type Signature condition

The **Custom File Type Signature** condition matches custom file types that you have scripted. You can implement the **Custom File Type Signature** condition in policy rules and exceptions.

See “About custom file type identification” on page 610.

See “Enabling the Custom File Type Signature condition in the policy console” on page 616.

**To configure a Custom File Type Signature condition**

1. Add a **Custom File Type Signature** condition to a policy rule or exception, or edit an existing one.
   
   See “Configuring policy rules” on page 330.
   
   See “Configuring policy exceptions” on page 340.

2. Configure the Custom File Type Signature condition parameters.
   
   See Table 26-7 on page 617.

3. Click **Save** to save the policy.

**Table 26-7**  
Custom File Type Signature parameters

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter the Script Name.</td>
<td>Specify the name of the script. The name must be unique across policies.</td>
</tr>
</tbody>
</table>
| Enter the custom file type script. | Enter the File Type Matches Signature script for detecting the binary signature of the custom file type.  
See the *Symantec Data Loss Prevention Detection Customization Guide* for details on writing custom scripts. |
| Match only on attachments. | This condition only matches on the **Message Attachments** component.  
See “Detection messages and message components” on page 305. |
| Also match one or more additional conditions. | Select this option to create a compound condition. All conditions must match to trigger or except an incident.  
You can **Add** any condition available from the list.  
See “Configuring compound match conditions” on page 342. |
**Best practices for using file property matching**

This section provides best practices for using file property matching conditions to match file formats, file size, and file name.

**Use compound file property rules to protect design and multimedia files**

You can use IDM to protect files, or you can use file property rules. Unless you must protect an exact file, the general recommendation is to use the file property rules because there is less overhead in setting up the rules.

For example, if you want to detect CAD files that contain IP diagrams, you could index these files and apply IDM rules to detect them. Alternatively, you could create a policy that contains a file type rule that detects on the CAD file format plus a file size rule that specifies a threshold size. The file property approach is preferred because in this scenario all you really care about is protecting large CAD files potentially leaving the company. There is no need to gather and index these files for IDM if you can simply create rules that will detect on the file type and the size.

**Do not use file type matching to detect content**

File type recognition does not crack the file and detect content; it only detects the file type based on the file's binary signature. To detect content, use a content detection rule such as EDM, IDM, Data Identifiers, or Keyword matching.

For custom file type detection, use the DLP Scripting Language. Refer to the *Symantec Data Loss Prevention Detection Customization Guide*.

**Calculate file size properly to improve match accuracy**

The file size method counts both the body and any attachments in the file size you specify.

**Use expression patterns to match file names**

The following DOS pattern matching expressions are provided as examples for configuring the Message Attachment or File Name condition.
Table 26-8  File name detection examples

<table>
<thead>
<tr>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any characters you enter (other than the DOS operators) match exactly.</td>
</tr>
<tr>
<td>For example, to match a Word file name that begins with ENG- followed by any eight characters, enter: ENG-?????????.doc</td>
</tr>
<tr>
<td>If you are not sure that it is a Word document, enter: ENG-?????????.*</td>
</tr>
<tr>
<td>If you are not sure how many characters follow ENG-, enter: ENG-.*</td>
</tr>
<tr>
<td>To match all file names that begin with ENG- and all file names that begin with ITA-, enter: ENG-.<em>,ITA-</em> (comma separated), or you can separate the file names by line space.</td>
</tr>
</tbody>
</table>

Use scripts and plugins to detect custom file types

Symantec Data Loss Prevention provides two mechanisms for detecting custom file types: the DLP Scripting Language and the Content Extraction SPI. If the only requirement is file type recognition, it may be easier to write a script than an SPI plugin. But, there may be occasions where using a script is inadequate.

The scripting language does not support loops; you cannot iterate over the file type bytes and do some processing. The scripting language is designed to detect a known signature at a relatively known offset. You cannot use the scripting language detect subtypes of the same document type. For example, if you wanted to detect password protected PDF files, you could not use the scripting language. Or, if you wanted to detect only Word documents with track changes enabled, you would have to write a plugin. On the other hand, you can deploy a script to the endpoint; currently plugins are server-based only.

For more information, refer to the Symantec Data Loss Prevention Content Extraction Plugin Developers Guide and the Symantec Data Loss Prevention Detection Customization Guide on writing custom plugins and scripts, respectively.
Detecting email for data classification services

This chapter includes the following topics:

- About implementing detection for Enterprise Vault Classification
- About matching on the message Subject for Data Classification Services
- Enabling classification test mode
- Configuring the Message/Email Properties and Attributes condition

About implementing detection for Enterprise Vault Classification

You can use the full policy authoring functionality of Symantec Data Loss Prevention, along with a new Message/Email Properties and Attributes detection rule, to automatically classify messages with Enterprise Vault for Microsoft Exchange. A new classification response rule produces a classification result that indicates whether a message should be archived or deleted. The Classification Server returns the classification result to the Enterprise Vault filter. Enterprise Vault can then use the result to perform archiving, delete messages, and flag messages for compliance reviews or E-Discovery searches.

Note: The Classification Server is used only with the Symantec Data Classification for Enterprise Vault solution, which is licensed separately from Symantec Data Loss Prevention. You must configure the Enterprise Vault Data Classification Services filter and Classification Server to communicate with one another. See the Symantec Enterprise Vault Data Classification Services Implementation Guide for more information.
The following table highlights the key policy configuration components that are associated with Data Classification for Enterprise Vault.

Table 27-1  Policy configuration for data classification

<table>
<thead>
<tr>
<th>Configuration type</th>
<th>Topic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Policy actions to enable classification test mode and limit generated classification results</td>
<td>See “Enabling classification test mode” on page 621.</td>
</tr>
<tr>
<td>Message/Email Properties and Attributes detection condition</td>
<td>See “Configuring the Message/Email Properties and Attributes condition” on page 623.</td>
</tr>
<tr>
<td>Classify Enterprise Vault Content response rule action</td>
<td>See “Configuring the Classify Enterprise Vault Content response action” on page 915.</td>
</tr>
</tbody>
</table>

About matching on the message Subject for Data Classification Services

Symantec Data Loss Prevention provides the ability to detect content in the **Subject** component of a message, independent of other components in the message envelope. You can use the **Subject** component to match on Exchange messages delivered from a Classification Server. The **Envelope** component is not applicable to Exchange email delivered from a Classification Server. See the *Enterprise Vault Data Classification Services Implementation Guide* for more information.

See “Detection messages and message components” on page 305.

See “Selecting components to match on” on page 336.

See “Configuring the Message/Email Properties and Attributes condition” on page 623.

Enabling classification test mode

When you create or configure any policy (Manage > Policies > Policy List), the **Configure Policy** screen contains options in the **Policy Actions** section that apply only to classification policies. You may choose to place Classification policies in test mode during the initial configuration of your Data Classification for Enterprise Vault deployment, or while tuning individual classification policies. When a classification policy runs in test mode, the Classification Server adds a test mode tag to any classification results that are returned to the Enterprise Vault Data Classification Filter for that policy. Enterprise Vault for Microsoft Exchange uses
the tag to ignore the outcome of the classification response for that policy, but still performs archiving as if no classification service is running.

When a classification policy runs in test mode, the Enforce Server creates a classification event each time a message matches the policy. You can view these classification events in the incident lists of the Enforce Server administration console (Incidents > Classification). The test mode configuration also enables you to limit the number of classification events that are recorded.

**Note:** The Enforce Server creates classification events only for those policies that run in test mode. When you disable test mode for production use, no classification incidents are recorded for that policy.

After you are confident that the classification policy works as intended, you can disable test mode so that Enterprise Vault actively classifies or deletes messages as defined in the policy.

**Note:** The parameters that are listed have no effect unless the policy uses the Classification: Classify Enterprise Vault Content response rule.

Table 27-2 Classifying policy detection matches

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Classification Test Mode</td>
<td>This setting is enabled by default and adds a test mode flag to the policy detection result for this policy. The flag indicates that Enterprise Vault should perform no action for the returned classification result. To classify Enterprise Vault content using this policy, uncheck this option.</td>
</tr>
<tr>
<td>Maximum for Classification Test Mode Events</td>
<td>This setting specifies the maximum number of classification events that Symantec Data Loss Prevention creates for this policy while in test mode. Limit the number of classification events for test mode policies, because each message that is posted to the Classification Server should generate a classification result. Specify a limit that enables you to evaluate the performance of your classification policy. You may choose to delete these classification events from the Enforce Server database after you activate the policy (disable test mode). The default setting records a maximum of 100 events. You can view recorded test-mode classification events by selecting Incidents &gt; Classification.</td>
</tr>
</tbody>
</table>
Configuring the Message/Email Properties and Attributes condition

The Message/Email Properties and Attributes detection rule enables you to classify Microsoft Exchange email messages based on specific message attributes. This detection rule is only applied to Microsoft Exchange messages that are delivered from a Data Classification for Enterprise Vault filter to a Classification Server.

**Note:** The Classification Server is used only with the Symantec Data Classification for Enterprise Vault solution, which is licensed separately from Symantec Data Loss Prevention. You must configure the Data Classification for Enterprise Vault filter and Classification Server to communicate with one another. See the *Symantec Enterprise Vault Data Classification Services Implementation Guide* for more information.

The Message/Email Properties and Attributes detection rule examines the various Messaging Application Programming Interface (MAPI) properties and attributes that Exchange has assigned to the email. Use these attributes to determine whether a message should be archived or deleted, and whether to flag the message for compliance review or E-Discovery searches.

**Table 27-3** Message/Email Properties and Attributes condition parameters

<table>
<thead>
<tr>
<th>MAPI Attribute</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Message Sensitivity** | This attribute describes the sensitivity of the message. Select **Message Sensitivity** and then select one or more of the following sensitivity levels:  
  - Normal  
  - Personal  
  - Private  
  - Confidential  
  The detection rule matches if the message contains any of the selected **Message Sensitivity** levels. |
Table 27-3  
Message/Email Properties and Attributes condition parameters (continued)

<table>
<thead>
<tr>
<th>MAPI Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Message Class</strong></td>
<td>This attribute describes the type of message, or the type of content that the message contains. Select <strong>Message Class</strong> and then select one or more classes from the Available Message Classes column. Use the arrows to move selected classes into the Selected Message Classes column. The following classes of interpersonal messages (IPM) appear in the Available Message Classes column:</td>
</tr>
<tr>
<td>■ IPM.Activity*—Journal entries, business notes, and phone logs.</td>
<td></td>
</tr>
<tr>
<td>■ IPM.Appointment*—Calendar appointments.</td>
<td></td>
</tr>
<tr>
<td>■ IPM.Contact*—Accounts and business contacts.</td>
<td></td>
</tr>
<tr>
<td>■ IPM.Document*—Document files.</td>
<td></td>
</tr>
<tr>
<td>■ IPM.Note*—Email messages that were received from a MAPI source (Exchange email).</td>
<td></td>
</tr>
<tr>
<td>■ IPM.Post*—Email messages that were received from an SMTP source, rather than a MAPI source.</td>
<td></td>
</tr>
<tr>
<td>■ IPM.StickyNote*—Notes.</td>
<td></td>
</tr>
<tr>
<td>■ IPM.Task*—Tasks, projects, and campaigns.</td>
<td></td>
</tr>
<tr>
<td>■ REPORT.IPM.*—Message delivery and non-delivery receipts, message read receipts, and message disposition notifications.</td>
<td></td>
</tr>
<tr>
<td>Certain message classes, such as IPM.Note, can be classified both when journal and mailbox archiving is enabled in Enterprise Vault for Microsoft Exchange. Other classes, such as IPM.contact, IPM.task, and IPM.Appointment are not present in the journal and are classified only when Enterprise Vault performs mailbox archiving. Use the Other field to specify message classes to examine in addition to or in place of those classes that are listed in the Available Message Classes column. Use the asterisk wildcard to specify multiple message subclasses. Ensure that any new mailbox classes that you add are also specified in the Exchange Message Classes and Exchange Mailbox Policy &gt; Message Classes tab in Enterprise Vault. (Enterprise Vault archives all journal classes that are delivered from the Classification Server; you do not have to configure individual message classes for journal archiving.)</td>
<td></td>
</tr>
</tbody>
</table>
Table 27-3  Message/Email Properties and Attributes condition parameters (continued)

<table>
<thead>
<tr>
<th>MAPI Attribute</th>
<th>Description</th>
</tr>
</thead>
</table>
| Also Match     | Select this option to create a compound rule. All conditions must match for the rule to trigger an incident. You can add any available condition from the drop-down menu.  
**Note:** Exchange messages that are delivered from a Classification Server do not include envelope information.  
See “Detection messages and message components” on page 305.  
See “Selecting components to match on” on page 336. |
Detecting network and mobile incidents

This chapter includes the following topics:

- Introducing protocol monitoring for network
- Introducing protocol monitoring for mobile
- Configuring the Protocol Monitoring condition for network detection
- Configuring the Protocol Monitoring condition for mobile detection
- Best practices for using network protocol matching

Introducing protocol monitoring for network

Symantec Data Loss Prevention provides the Protocol Monitoring condition which lets you detect network messages based on the communications transport method.

Table 28-1 lists the protocols that Data Loss Prevention supports for network detection.

Table 28-1  Supported protocols for network monitoring

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email/SMTP</td>
<td>Simple Mail Transfer Protocol (SMTP) is a protocol for sending email messages between servers.</td>
</tr>
<tr>
<td>FTP</td>
<td>The file transfer protocol (FTP) is used on the Internet for transferring files from one computer to another.</td>
</tr>
<tr>
<td>HTTP</td>
<td>The hypertext transfer protocol (HTTP) is the underlying protocol that supports the World Wide Web. HTTP defines how messages are formatted and transmitted, and what actions Web servers and browsers should take in response to various commands.</td>
</tr>
</tbody>
</table>
Table 28-1  Supported protocols for network monitoring (continued)

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTTP/SSL</td>
<td>Hypertext transfer protocol over Secure Sockets Layer (HTTPS) is a protocol for sending data securely between a client and server.</td>
</tr>
<tr>
<td>IM:MSN</td>
<td>Instant messaging is a type of communications service that enables you to create a private chat room with another individual.</td>
</tr>
</tbody>
</table>
| IM:AIM        | Data Loss Prevention supports detection on the following IM channels.:
|               | • AIM instant messaging                                                      |
|               | • MSN instant messaging                                                      |
|               | • Yahoo! Instant messaging                                                  |
| NNTP          | Network News Transport Protocol (NNTP), which is used to send, distribute, and retrieve USENET messages. |
| TCP:custom_protocol | The Transmission Control Protocol (TCP) is used to reliably exchange data between computers across the Internet. This option is only available if you have defined a custom TCP port. |

See “Configuring the Protocol Monitoring condition for network detection” on page 628.
See “Introducing protocol monitoring for mobile” on page 627.

Introducing protocol monitoring for mobile

Symantec Data Loss Prevention provides the Protocol Monitoring condition which lets you detect mobile messages based on the communications transport method.
Table 28-2 lists the protocols that Data Loss Prevention supports for mobile detection.

Table 28-2  Supported protocols for mobile monitoring

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FTP</td>
<td>File transfer protocol (FTP) is used on the Internet for transferring files from one computer to another.</td>
</tr>
<tr>
<td>HTTP</td>
<td>The hypertext transfer protocol (HTTP) is the underlying protocol that supports the World Wide Web. HTTP defines how messages are formatted and transmitted, and what actions Web servers and browsers should take in response to various commands.</td>
</tr>
<tr>
<td>HTTP/SSL</td>
<td>Hypertext transfer protocol over Secure Sockets Layer (HTTPS) is a protocol for sending data securely between a client and server.</td>
</tr>
</tbody>
</table>
See “Introducing protocol monitoring for network” on page 626.

See “Configuring the Protocol Monitoring condition for mobile detection” on page 629.

### Configuring the Protocol Monitoring condition for network detection

You use the Protocol Monitoring condition to detect network incidents. You can implement an instance of the Protocol Monitoring condition in one or more policy detection rules and exceptions.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add or modify the Protocol or Endpoint Monitoring condition.</td>
<td>Add a new Protocol or Endpoint Monitoring condition to a policy rule or exception, or modify an existing rule or exception condition. See “Configuring policies” on page 326. See “Configuring policy rules” on page 330. See “Configuring policy exceptions” on page 340.</td>
</tr>
</tbody>
</table>

Select one or more protocols to match.

To detect Network incidents, select one or more Protocols.

- Email/SMTP
- FTP
- HTTP
- HTTPS/SSL
- IM:AIM
- IM:MSN
- IM:Yahoo
- NNTP

Configure a custom network protocol.

Select one or more custom protocols: TCP:custom_protocol.

Configure endpoint monitoring.

See “Configuring the Endpoint Monitoring condition” on page 635.

Match on the entire message.

The Protocol Monitoring condition matches on the entire message, not individual message components.

The Envelope option is selected by default. You cannot select individual message components.

See “Detection messages and message components” on page 305.
Table 28-3  Protocol Monitoring condition parameters for Network (continued)

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| Also match one or more additional conditions.| Select this option to create a compound condition. All conditions must match to trigger or except an incident.  
You can **Add** any condition available from the list.  
See “Configuring compound match conditions” on page 342. |

**Configuring the Protocol Monitoring condition for mobile detection**

You use the Protocol Monitoring condition to detect mobile incidents. You can use this condition in policy detection rules and exceptions.

*Table 28-4* describes the configuration of the Protocol Monitoring condition for mobile detection.

**Table 28-4**  Protocol Monitoring condition parameters for Mobile

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| Add or modify the Protocol or Endpoint Monitoring condition. | Add a new **Protocol or Endpoint Monitoring** condition to a policy rule or exception, or modify an existing rule or exception condition.  
See “Configuring policies” on page 326.  
See “Configuring policy rules” on page 330.  
See “Configuring policy exceptions” on page 340. |
| Select one or more protocols to match.      | To detect Mobile incidents, select one or more **Protocols**:  
  ■ FTP  
  File transfer protocol is used on the Internet for transferring files from one computer to another.  
  ■ HTTP  
  The hypertext transfer protocol is the underlying protocol that supports the World Wide Web. HTTP defines how messages are formatted and transmitted, and what actions Web servers and browsers should take in response to various commands.  
  ■ HTTPS/SSL  
  Hypertext transfer protocol over Secure Sockets Layer, which is a protocol for sending data securely between a client and server. |
| Custom network protocol.                    | Mobile monitoring only supports FTP, HTTP, and HTTP/S.                         |
Table 28-4  Protocol Monitoring condition parameters for Mobile (continued)

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure endpoint monitoring.</td>
<td>See “Configuring the Endpoint Monitoring condition” on page 635.</td>
</tr>
<tr>
<td>Match on the entire message.</td>
<td>The Protocol Monitoring condition matches on the entire message, not individual message components. The Envelope option is selected by default. You cannot select individual message components. See “Detection messages and message components” on page 305.</td>
</tr>
<tr>
<td>Also match one or more additional conditions.</td>
<td>Select this option to create a compound condition. All conditions must match to trigger or except an incident. You can Add any condition available from the list. See “Configuring compound match conditions” on page 342.</td>
</tr>
</tbody>
</table>

**Best practices for using network protocol matching**

This section provides best practices for using file property matching conditions to match file formats, file size, and file name.

**Use separate policies for specific protocols**

You can use protocol matching detection to detect network traffic, such as Web mail, social networking, and specific protocols. For protocol monitoring, consider implementing different policies for each type of protocol, such as SMTP, TCP, HTTP, FTP, etc. Creating separate policies for specific protocols may ease remediation and help you tune the policies.

**Consider detection server network placement to support IP address matching**

You can detect senders/users and recipients based one or more IP addresses. However, to do so you must carefully consider the placement of the detection server on your network.

If the detection server is installed between the Web proxy and the Internet, the IP address of all Web traffic from individuals in your organization appears to come from the Web proxy. If the detection server is installed between the Web proxy and the internal corporate network, the IP address of all Web traffic from outside your organization appears to go to the Web proxy.
The best practice is to match on domain names instead of IP addresses.
Detecting endpoint events

This chapter includes the following topics:

- Introducing endpoint event detection
- Configuring endpoint event detection conditions
- Best practices for using endpoint detection

Introducing endpoint event detection

Endpoint detection matches events on endpoints where the Symantec DLP Agent is installed.

See “About Endpoint Prevent monitoring” on page 1368.

Symantec Data Loss Prevention provides several methods for detecting and excepting endpoint events, and a collection of response rules for responding to them.

See “Response rules for endpoint detection” on page 877.

About endpoint protocol monitoring

On the endpoint you can detect data loss based on the transport protocol, such as email (SMTP), Web (HTTP), and file transfer (FTP).

See “Configuring the Endpoint Monitoring condition” on page 635.

Table 29-1  Supported protocols for endpoint monitoring

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email/SMTP</td>
<td>Simple Mail Transfer Protocol (SMTP) is a protocol for sending email messages between servers.</td>
</tr>
</tbody>
</table>
Table 29-1  Supported protocols for endpoint monitoring (continued)

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FTP</td>
<td>The file transfer protocol (FTP) is used on the Internet for transferring files from one computer to another.</td>
</tr>
<tr>
<td>HTTP</td>
<td>The hypertext transfer protocol (HTTP) is the underlying protocol that supports the World Wide Web. HTTP defines how messages are formatted and transmitted, and what actions Web servers and browsers should take in response to various commands.</td>
</tr>
<tr>
<td>HTTP/SSL</td>
<td>Hypertext transfer protocol over Secure Sockets Layer (HTTPS) is a protocol for sending data securely between a client and server.</td>
</tr>
<tr>
<td>IM:MSN</td>
<td>Instant messaging is a type of communications service that enables you to create a private chat room with another individual.</td>
</tr>
</tbody>
</table>
| IM:AIM      | Data Loss Prevention supports detection on the following IM channels.:  
|             | - AIM instant messaging  
|             | - MSN instant messaging  
|             | - Yahoo! Instant messaging                                                                                                                  |

About endpoint destination monitoring

You can also detect endpoint data loss on the destination where data is copied or moved, such as CD/DVD drive, USB device, or the clipboard.

See “Configuring the Endpoint Monitoring condition” on page 635.

Table 29-2  Supported destinations for endpoint monitoring

<table>
<thead>
<tr>
<th>Destination</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local Drive</td>
<td>Monitor the local disk.</td>
</tr>
<tr>
<td>CD/DVD</td>
<td>The CD/DVD burner on the endpoint computer. This destination can be any type of third-party CD/DVD burning software.</td>
</tr>
<tr>
<td>Removable Storage Device</td>
<td>Detect data that is transferred to any eSATA, FireWire, or USB connected storage device.</td>
</tr>
<tr>
<td>Copy to Network Share</td>
<td>Detect data that is transferred to any network share or remote file access.</td>
</tr>
<tr>
<td>Printer/Fax</td>
<td>Detect data that is transferred to a printer or to a fax that is connected to the endpoint computer. This destination can also be print-to-file documents.</td>
</tr>
<tr>
<td>Clipboard</td>
<td>The Windows Clipboard used to copy and paste data between Windows applications.</td>
</tr>
</tbody>
</table>
About endpoint application monitoring

You can create exceptions for allowable use scenarios.

The DLP Agent monitors any third-party application you add and configure at the System > Agents > Application Monitoring screen.

The DLP Agent monitors applications when they access sensitive files.

See “Adding an application” on page 1506.

See “Configuring the Endpoint Monitoring condition” on page 635.

About endpoint location detection

You can detect or except events based on the location of the endpoint.

Using the Endpoint Location detection method, you can choose to detect incidents only when the endpoint is on or off the network.

For example, you might configure this condition to match only when users are off the corporate network because you have other rules in place for detecting network incidents. In this case implementing the Endpoint Location detection method would achieve this result.

See “Configuring the Endpoint Location condition” on page 637.

About endpoint device detection

Symantec Data Loss Prevention lets you detect or except specific endpoint devices based on described device metadata. You can configure a condition to allow endpoint users to copy files to a specific device class, such as USB drives from a single manufacturer.

See “Manage and add endpoint devices” on page 639.

For example, a policy author has a set of USB flash drives with serial numbers that range from 001-010. These are the only flash drives that should be allowed to access the company’s endpoints. The policy administrator adds the serial number metadata into an exception of a policy so that the policy applies to all USB flash drives except for the drives with the serial number that falls into the 001-010 metadata. In this fashion the device metadata allows for only “trusted devices” to be allowed to carry company data.

See “Creating and modifying endpoint device configurations” on page 641.

The Endpoint Device Class or ID condition detects specific removable storage devices based on their definitions. Endpoint Destination parameters in the Endpoint Monitoring condition detect any removable storage device on the endpoint,
Configuring endpoint event detection conditions

Table 29-3 describes the various methods for implementing endpoint event monitoring.

<table>
<thead>
<tr>
<th>Endpoint match conditions</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Endpoint Protocol Monitoring</td>
<td>Detect endpoint data based on the protocol.</td>
</tr>
<tr>
<td></td>
<td>See “About endpoint protocol monitoring” on page 632.</td>
</tr>
<tr>
<td></td>
<td>See “Configuring the Endpoint Monitoring condition” on page 635.</td>
</tr>
<tr>
<td>Endpoint Destination Monitoring</td>
<td>Detect endpoint data based on the destination.</td>
</tr>
<tr>
<td></td>
<td>See “About endpoint protocol monitoring” on page 632.</td>
</tr>
<tr>
<td></td>
<td>See “Configuring the Endpoint Monitoring condition” on page 635.</td>
</tr>
<tr>
<td>Endpoint Application Monitoring</td>
<td>Detect endpoint data based on the application.</td>
</tr>
<tr>
<td></td>
<td>See “About endpoint protocol monitoring” on page 632.</td>
</tr>
<tr>
<td></td>
<td>See “Configuring the Endpoint Monitoring condition” on page 635.</td>
</tr>
<tr>
<td>Endpoint Device or Class ID</td>
<td>Detect when users move endpoint data to a specific device.</td>
</tr>
<tr>
<td></td>
<td>See “About endpoint device detection” on page 634.</td>
</tr>
<tr>
<td></td>
<td>See “Configuring the Endpoint Device Class or ID condition” on page 638.</td>
</tr>
<tr>
<td>Endpoint Location</td>
<td>Detect when the endpoint is on or off the corporate network.</td>
</tr>
<tr>
<td></td>
<td>See “About endpoint location detection” on page 634.</td>
</tr>
<tr>
<td></td>
<td>See “Configuring the Endpoint Location condition” on page 637.</td>
</tr>
</tbody>
</table>

Configuring the Endpoint Monitoring condition

The Endpoint Monitoring condition matches on endpoint message protocols, destinations, and applications.

You can implement an instance of the Endpoint Monitoring condition in one or more policy detection rules and exceptions.
Note: This topic does not address network protocol monitoring configuration.

See “Configuring the Protocol Monitoring condition for network detection” on page 628.

Table 29-4  Configure the Endpoint Monitoring condition

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add or modify the Endpoint Monitoring condition.</td>
<td>Add a new <strong>Protocol or Endpoint Monitoring</strong> condition to a policy rule or exception, or modify an existing rule or exception condition.</td>
</tr>
<tr>
<td></td>
<td>See “Configuring policy rules” on page 330.</td>
</tr>
<tr>
<td></td>
<td>See “Configuring policy exceptions” on page 340.</td>
</tr>
<tr>
<td></td>
<td>See “Configuring policies” on page 326.</td>
</tr>
<tr>
<td>Select one or more endpoint protocols to match.</td>
<td>To detect Endpoint incidents, select one or more <strong>Endpoint Protocols</strong>:</td>
</tr>
<tr>
<td></td>
<td>■ Email/SMTP</td>
</tr>
<tr>
<td></td>
<td>■ HTTP</td>
</tr>
<tr>
<td></td>
<td>■ HTTPS/SSL</td>
</tr>
<tr>
<td></td>
<td>■ IM:MSN</td>
</tr>
<tr>
<td></td>
<td>■ IM:AIM</td>
</tr>
<tr>
<td></td>
<td>■ IM:Yahoo</td>
</tr>
<tr>
<td></td>
<td>■ FTP</td>
</tr>
<tr>
<td></td>
<td>See “About endpoint protocol monitoring” on page 632.</td>
</tr>
<tr>
<td>Select one or more endpoint destinations.</td>
<td>To detect when users move data on the endpoint, select one or more <strong>Endpoint Destinations</strong>:</td>
</tr>
<tr>
<td></td>
<td>■ Local Drive</td>
</tr>
<tr>
<td></td>
<td>■ CD/DVD</td>
</tr>
<tr>
<td></td>
<td>■ Removable Storage Device</td>
</tr>
<tr>
<td></td>
<td>■ Copy to Network Share</td>
</tr>
<tr>
<td></td>
<td>■ Printer/Fax</td>
</tr>
<tr>
<td></td>
<td>■ Clipboard</td>
</tr>
<tr>
<td></td>
<td>See “About endpoint protocol monitoring” on page 632.</td>
</tr>
<tr>
<td>Monitor endpoint applications.</td>
<td>To detect when endpoint applications access files, select the <strong>Application File Access</strong> option.</td>
</tr>
<tr>
<td></td>
<td>See “About monitoring applications” on page 1503.</td>
</tr>
</tbody>
</table>
Configuring the Endpoint Location condition

The Endpoint Location condition matches endpoint events based on the location of the endpoint computer where the DLP Agent is installed.

You can implement an instance of the Endpoint Location condition in one or more policy detection rules and exceptions.

See “Configuring policies” on page 326.

Table 29-5 Configure the Endpoint Location detection condition

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add or modify the Endpoint Location condition.</td>
<td>Add a new <strong>Endpoint Location</strong> detection condition to a policy rule or exception, or modify an existing policy rule or exception. See “Configuring policy rules” on page 330. See “Configuring policy exceptions” on page 340.</td>
</tr>
</tbody>
</table>
| Select the location to monitor. | Select one of the following endpoint locations to monitor:  
  ■ **Off the corporate network**  
  Select this option to detect or except events when the endpoint computer is off of the corporate network.  
  ■ **On the corporate network**  
  Select this option to detect or except events when the endpoint computer is on the corporate network.  
  This option is the default selection. See “About endpoint location detection” on page 634. |
Configure the Endpoint Location detection condition *(continued)*

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Match on the entire message.</td>
<td>The DLP Agent evaluates the entire message, not individual message components. The <strong>Envelope</strong> option is selected by default. The other message components are not selectable. See “Detection messages and message components” on page 305.</td>
</tr>
<tr>
<td>Also match one or more additional conditions.</td>
<td>Select this option to create a compound condition. All conditions must match to trigger or except an incident. You can <strong>Add</strong> any condition available from the list. See “Configuring compound match conditions” on page 342.</td>
</tr>
</tbody>
</table>

See “About endpoint location detection” on page 634.

See “Configuring the Endpoint Location condition” on page 637.

**Configuring the Endpoint Device Class or ID condition**

The Endpoint Device Class or ID condition lets you detect when users move endpoint data to specific devices.

You can implement the Endpoint Device Class or ID condition in one or more policy detection rules or exceptions.

See “Configuring policies” on page 326.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add or modify an Endpoint Device condition.</td>
<td>Add a new <strong>Endpoint Device Class or ID</strong> condition to a policy rule or exception, or modify an existing one. See “Configuring policy rules” on page 330. See “Configuring policy exceptions” on page 340.</td>
</tr>
<tr>
<td>Select one or more devices.</td>
<td>The condition matches when users move data from an endpoint computer to the selected device(s). Click <strong>Create an endpoint device</strong> to define one or more devices. See “Creating and modifying endpoint device configurations” on page 641.</td>
</tr>
</tbody>
</table>
Table 29-6 Configuring the Endpoint Device Class or ID condition (continued)

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Match on the entire message.</td>
<td>The DLP Agent matches on the entire message, not individual message components. The Envelope option is selected by default. You cannot select other components. See “Detection messages and message components” on page 305.</td>
</tr>
<tr>
<td>Also match one or more additional conditions.</td>
<td>Select this option to create a compound condition. All conditions must match to trigger or except an incident. You can Add any condition available from the drop-down menu. See “Configuring compound match conditions” on page 342.</td>
</tr>
</tbody>
</table>

See “About endpoint device detection” on page 634.
See “Manage and add endpoint devices” on page 639.

Manage and add endpoint devices

From the System > Agents > Endpoint Devices screen you manage existing endpoint devices and add new ones.

See “About endpoint device detection” on page 634.

Table 29-7 Manage endpoint devices

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add endpoint device.</td>
<td>Click Add Device to define a new endpoint device. Once defined the device is added to the list. See “Gathering endpoint device IDs” on page 640.</td>
</tr>
<tr>
<td>Modify existing endpoint device configurations.</td>
<td>To edit a device definition, select anywhere in the device row, or click the pencil icon. See “Creating and modifying endpoint device configurations” on page 641.</td>
</tr>
<tr>
<td>View configured endpoint devices.</td>
<td>The Endpoint Devices screen lists all configured endpoint devices. The columns display the following information: Device Name, Device Description, Device Definition (Regex)</td>
</tr>
</tbody>
</table>
Gathering endpoint device IDs

You add device metadata information to the Enforce Server and create one or more policy detection methods that detect or except the specific device instance or class of device. The system supports the regular expression syntax for defining the metadata. The system displays the device metadata at the **Incident Snapshot** screen during remediation.

See “Creating and modifying endpoint device configurations” on page 641.

The metadata the system requires to define the device instance or device class is the **Device Instance ID**. On Windows you can obtain the "Device Instance Id" from the Device Manager.

In addition, Symantec Data Loss Prevention provides the **DeviceID.exe** utility. You can use this utility to extract Device Instance ID strings. This utility also reports what devices the system can recognize for detection. This utility is available with the Enforce Server installation files.

See “About the Device ID utility” on page 1528.

**Note:** The Device Instance ID is also used by Symantec Endpoint Protection (SEP).

**To obtain the Device Instance ID (on Windows)**

1. Right-click **My Computer**.
2. Select **Manage**.
3. Select the **Device Manager**.
4. Click the plus sign beside any device to expand its list of device instances.
5. Double-click the device instance. Or, right-click the device instance and select **Properties**.
6. Look in the **Details** tab for the **Device Instance Id**.
7. Use the ID to create device metadata expressions.

   See “Creating and modifying endpoint device configurations” on page 641.

See “About endpoint device detection” on page 634.

---

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort endpoint devices.</td>
<td>You can sort the endpoint device list by name, description, or definition.</td>
</tr>
</tbody>
</table>
Creating and modifying endpoint device configurations

You can configure one or more devices for specific endpoint detection. Once the
device expressions are configured, you implement the Endpoint Device Class or
ID condition in one or more policy rules or exceptions to deny or allow the use of
the specific devices

See “Gathering endpoint device IDs” on page 640.

To create and modify endpoint device ID expressions

1. Click Add Device.
   Perform this action from the System > Agent > Endpoint Devices screen.
2. Enter the Device Name.
3. Enter a Device Description.
4. Enter the Device Definition expression.
   The device definition must conform to the regular expression syntax.
   See Table 29-8 on page 641.
   See “About writing regular expressions” on page 598.
5. Click Save to save the device configuration.
6. Implement the Endpoint Device Class or ID condition in a detection rule or
   exception.
   See “Configuring the Endpoint Device Class or ID condition” on page 638.

<table>
<thead>
<tr>
<th>Example device class</th>
<th>Expression example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generic USB Device</td>
<td>USBSTOR\DISK\VEN_SANDISK\PROD_ULTRA_BACKUP&amp;REV_8\32\3485731392112B52</td>
</tr>
<tr>
<td>iPod generic</td>
<td>USBSTOR\DISK\VEN_APPLE\PROD_IPOD&amp;.*</td>
</tr>
<tr>
<td>Lexar generic</td>
<td>USBSTOR\DISK\VEN_LEXAR.*</td>
</tr>
<tr>
<td>CD Drive</td>
<td>IDE\DISKST9160412ASG__________________0002SDM1\4&amp;F4ACADA&amp;0&amp;0\0\0.0</td>
</tr>
<tr>
<td>Hard drive</td>
<td>USBSTOR\DISK\VEN_MAXTOR\PROD_ONETOUCH_II&amp;REV_023D\B60899082H____&amp;0.0</td>
</tr>
<tr>
<td>Blackberry generic</td>
<td>USBSTOR\DISK\VEN_RIM\PROD_BLACKBERRY...&amp;REV.*</td>
</tr>
<tr>
<td>Cell phone</td>
<td>USBSTOR\DISK\VEN_PALM\PROD_PRE&amp;REV_000\FBB4B8FF4CAEFEC11 24DED689&amp;0</td>
</tr>
</tbody>
</table>
See “About endpoint device detection” on page 634.
See “Manage and add endpoint devices” on page 639.

**Best practices for using endpoint detection**

When implementing endpoint match conditions, keep in mind the following considerations:

- Any detection method that executes on the endpoint matches on the entire message, not individual message components.
  See “Detection messages and message components” on page 305.

- The **Endpoint Destination** and **Endpoint Location** methods are specific to the endpoint computer and are not user-based.
  See “Distinguish synchronized DGM from other types endpoint detection” on page 659.

- You might often combine group and detection methods on the endpoint. Keep in mind that the policy language ANDs detection and group methods, whereas methods of the same type, two rules for example, are ORed.
  See “Policy detection execution” on page 308.
Detecting described identities

This chapter includes the following topics:

- Introducing described identity matching
- Described identity matching examples
- Configuring described identity matching policy conditions
- Best practices for using described identity matching

Introducing described identity matching

Described identity detection matches patterns in messages from email senders and recipients, Windows users, IM users, URL domains, and IP addresses.

See “Configuring described identity matching policy conditions” on page 644.

See “Configuring the Sender/User Matches Pattern condition” on page 645.

See “Configuring the Recipient Matches Pattern condition” on page 648.

Described identity matching examples

Table 30-1 lists and describes some example described content matching examples.
Table 30-1  Pattern identity matching examples

<table>
<thead>
<tr>
<th>Example Pattern</th>
<th>Matches</th>
<th>Does Not Match</th>
</tr>
</thead>
<tbody>
<tr>
<td>fr, cu</td>
<td>All SMTP email that is addressed to a .fr (France) or .cu (Cuba) addresses.</td>
<td>Any email that is addressed to French company with the .com extension instead of .fr.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Any HTTP post to a .fr address through a Web-based mail application, such as Yahoo mail.</td>
</tr>
<tr>
<td>company.com</td>
<td>All SMTP email that is addressed to the specific domain URL, such as symantec.com.</td>
<td>Any SMTP email that is not addressed to the specific domain URL.</td>
</tr>
<tr>
<td>3rdlevel.company.com</td>
<td>All SMTP email that is addressed to the specific 3rd level domain, such as dlp.symantec.com.</td>
<td>Any SMTP email that is not addressed to the specific 3rd level domain.</td>
</tr>
<tr>
<td><a href="mailto:bob@company.com">bob@company.com</a></td>
<td>All SMTP email that is addressed to <a href="mailto:bob@company.com">bob@company.com</a>.</td>
<td>Any email not specifically addressed to <a href="mailto:bob@company.com">bob@company.com</a>, such as:</td>
</tr>
<tr>
<td></td>
<td>All SMTP email that is addressed to <a href="mailto:BOB@COMPANY.COM">BOB@COMPANY.COM</a> (the pattern is not case-sensitive).</td>
<td>- <a href="mailto:sally@company.com">sally@company.com</a></td>
</tr>
<tr>
<td>192.168.0.*</td>
<td>All email, Web, or URL traffic specifically addressed to 192.168.0.[0-255].</td>
<td></td>
</tr>
<tr>
<td></td>
<td>This result assumes that the IP address maps to the desired domain, such as web.company.com.</td>
<td>Note: If the IP address does not match, use one or more domain URLs instead.</td>
</tr>
<tr>
<td>*/local/dir1/dir2/dir3/Sym</td>
<td>These are Lotus Notes example email addresses.</td>
<td></td>
</tr>
<tr>
<td><em>/Sym</em></td>
<td></td>
<td></td>
</tr>
<tr>
<td><em>/dlp/qa/test/local/Sym</em></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Configuring described identity matching policy conditions**

Table 30-2 lists and describes the two conditions that Symantec Data Loss Prevention provides for matching described identities.

See “Described identity matching examples” on page 643.
### Table 30-2  Implementing described identity matching

<table>
<thead>
<tr>
<th>Match condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sender/User Matches Pattern</td>
<td>Matches on an email address, domain address, IP address, Windows user name, or IM screen name/handle. See “Configuring the Sender/User Matches Pattern condition” on page 645.</td>
</tr>
<tr>
<td>Recipient Matches Pattern</td>
<td>Matches on an email address, domain address, IP address, or newsgroup. See “Configuring the Recipient Matches Pattern condition” on page 648.</td>
</tr>
</tbody>
</table>

### About Reusable Sender/Recipient Patterns

You can create Reusable Sender/User and Recipient Patterns for use in your policies. Reusable Sender/Recipient Patterns make policy creation and management easier for policies using such patterns. For details about creating and using Reusable Sender/Recipient Patterns, refer to the following topics.

See “Configuring a Reusable Sender Pattern” on page 647.

See “Configuring a Reusable Recipient Pattern” on page 649.

### Configuring the Sender/User Matches Pattern condition

The **Sender/User Matches Pattern** condition matches described user and message sender identities. You can use this condition in a policy detection rule or exception.

See “Introducing described identity matching” on page 643.

See “Best practices for using described identity matching” on page 650.

**Configuring the Sender/User Matches Pattern condition** describes the process for configuring the **Sender/User Matches Pattern** condition.
<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| Enter one or more Sender Patterns to match one or more message senders. | **Email Address Pattern:**
  - To match a specific email address, enter the full email address: sales@symantec.com
  - To match multiple exact email addresses, enter a comma-separated list: john.smith@company.com, johnsmith@company.com, jsmith@company.com
  - To match partial email addresses, enter one or more domain patterns:
    - Enter one or more top-level domain extensions, for example: .fr, .cu, .in, .jp
    - Enter one or more domain names, for example: company.com, symantec.com
    - Enter one or more third-level (or lower) domain names: web.company.com, mail.yahoo.com, smtp.gmail.com, dlp.security.symantec.com
| **Windows User Names** | Enter the names of one or more Windows users, for example: john.smith, jsmith |
| **IM Screen Name** | Enter one or more IM screen names that are used in instant messaging systems, for example: john_smith, jsmith |
| **IP Address** | Enter one or more IP addresses that map to the domain you want to match, for example:
  - Exact IP address match, for example: 192.168.1.1 or for IPv6 fdda:c450:e808:3020:abcd:abcd:0000:5000
  - Wildcard match – The asterisk (*) character can substitute for one or more fields, for example: 192.168.1.* or 192.*.168.* or for IPv6 fdda:c450:e808:3:::*:::*:*
| **Select a Reusable Sender Pattern** | You can select a Sender Pattern that you have saved for reuse in your policies. Select **Reusable Sender Pattern**, then choose the pattern you want from the dropdown list. |

Note: The Pattern field allows unlimited data (only limited by the browser).
Table 30-3 Configuring the Sender/User Matches Pattern condition (continued)

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Match on the entire message.</td>
<td>This condition matches on the entire message. The <strong>Envelope</strong> option is selected by default. You cannot select any other message component.</td>
</tr>
<tr>
<td></td>
<td>See “Detection messages and message components” on page 305.</td>
</tr>
<tr>
<td></td>
<td>Also match additional conditions.</td>
</tr>
<tr>
<td></td>
<td>Select this option to create a compound condition. All conditions must match to trigger an incident.</td>
</tr>
<tr>
<td></td>
<td>You can <strong>Add</strong> any available condition from the list.</td>
</tr>
<tr>
<td></td>
<td>See “Configuring compound match conditions” on page 342.</td>
</tr>
</tbody>
</table>

Configuring a Reusable Sender Pattern

If you want to use a Sender Pattern in multiple policies, configure a Reusable Sender Pattern. Reusable Sender Patterns can be selected for use in your policies from the **Configure Policy - Edit Rule** page. You can create, edit, and manage your Reusable Sender Patterns from the **Sender/Recipient Patterns** page. For example, if you use a Sender Pattern in 50 policies, using a Reusable Sender Pattern lets you enter the Sender Pattern a single time, then select it for each policy. In addition, if you need to update the Sender Pattern for those 50 policies, you can edit it from the **Configure Reusable Sender Pattern** page and your changes will be applied automatically to each policy using that pattern.

To configure a Reusable Sender Pattern

1. Take one of the following actions:
   - If you are configuring a policy with a **Sender/User Matches Pattern** rule, from the **Manage > Policies > Policy List > Configure Policy - Edit Rule** page, click **Create Reusable Sender Pattern**.
   - In the Enforce Server administration console, navigate to **Manage > Policies > Sender/Recipient Patterns**, then click **Add > Sender Pattern**.

2. In the **General** section on the **Configure Reusable Sender Pattern** page, enter a **Name** and **Description** for your Reusable Sender Pattern.

3. In the **Sender Pattern** section, enter the **User Patterns** and **IP Addresses** as described in the "Configuring the Sender/User Matches Pattern condition table". See Table 30-3 on page 646.

4. Click **Save**.
5 To edit a saved Reusable Sender Pattern, on the Manage > Policies > Sender/Recipient Patterns page, click the dropdown arrow next to the name of the pattern you want to edit, then select Edit.

6 To delete a saved Reusable Sender Pattern, on the Manage > Policies > Sender/Recipient Patterns page, click the dropdown arrow next to the name of the pattern you want to delete, then select Delete.

Note: You cannot delete a Reusable Sender Pattern that is currently in use in any policy.

Configuring the Recipient Matches Pattern condition

The Recipient Matches Pattern condition matches the described identity of message recipients. You can use this condition in a policy detection rule or exception.

See “Introducing described identity matching” on page 643.

See “Define precise identity patterns to match users” on page 650.

Configuring the Recipient Matches Pattern condition defines the process for configuring the Recipient Matches Pattern condition.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>EmailAddress/Newsgroup Pattern</strong></td>
<td>Enter one or more email or newsgroup addresses to match the desired recipients. To match specific email addresses, enter the full address, such as <a href="mailto:sales@symantec.com">sales@symantec.com</a>. To match email addresses from a specific domain, enter the domain name only, such as symantec.com.</td>
</tr>
<tr>
<td><strong>IPAddress</strong></td>
<td>Enter one or more IP address patterns that resolve to the domain that you want to match. You can use the asterisk (*) wildcard character for one or more fields. You can enter both IPv4 and IPv6 addresses separated by commas.</td>
</tr>
<tr>
<td><strong>URL Domain</strong></td>
<td>Enter one or more URL Domains to match Web-based traffic, including Web-based email and postings to a Web site. For example, if you want to prohibit the receipt of certain types of data using Hotmail, enter hotmail.com.</td>
</tr>
</tbody>
</table>
Table 30-4  Recipient Matches Pattern condition parameters (continued)

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a Reusable Recipient Pattern</td>
<td>You can select a Recipient Pattern that you have saved for reuse in your policies. Select <strong>Reusable Recipient Pattern</strong>, then choose the pattern you want from the dropdown list.</td>
</tr>
<tr>
<td>Configure match counting.</td>
<td>Select one of the following options to specify the number of email recipients that must match:</td>
</tr>
<tr>
<td></td>
<td>• <strong>All recipients must match (Email Only)</strong> does not count a match unless ALL email message recipients match the specified pattern.</td>
</tr>
<tr>
<td></td>
<td>• <strong>At least _ recipients must match (Email Only)</strong> lets you specify the minimum number of email message recipients that must match to be counted.</td>
</tr>
<tr>
<td></td>
<td>Select one of the following options to specify how you want to count the matches:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Check for existence</strong></td>
</tr>
<tr>
<td></td>
<td>Reports a match count of 1 if there are one or more matches.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Count all matches</strong></td>
</tr>
<tr>
<td></td>
<td>Reports the sum of all matches.</td>
</tr>
<tr>
<td></td>
<td>See “Configuring match counting” on page 334.</td>
</tr>
<tr>
<td>Match on the entire message.</td>
<td>This condition matches on the entire message. The <strong>Envelope</strong> option is selected by default. You cannot select any other message component.</td>
</tr>
<tr>
<td></td>
<td>See “Detection messages and message components” on page 305.</td>
</tr>
<tr>
<td>Also match additional conditions.</td>
<td>Select this option to create a compound condition. All conditions in a rule or exception must match to trigger an incident.</td>
</tr>
<tr>
<td></td>
<td>You can <strong>Add</strong> any available condition from the list.</td>
</tr>
<tr>
<td></td>
<td>See “Configuring compound match conditions” on page 342.</td>
</tr>
</tbody>
</table>

**Configuring a Reusable Recipient Pattern**

If you want to use a Recipient Pattern in multiple policies, configure a Reusable Recipient Pattern. Reusable Recipient Patterns can be selected for use in your policies from the **Configure Policy - Edit Rule** page. You can create, edit, and manage your Reusable Recipient Patterns from the **Sender/Recipient Patterns** page. For example, if you use a Recipient Pattern in 50 policies, using a Reusable Recipient Pattern lets you enter the Recipient Pattern a single time, then select it for each policy. In addition, if you need to update the Recipient Pattern for those 50 policies, you can edit it from the **Configure Reusable Recipient Pattern** page and your changes will be applied automatically to each policy using that pattern.
To configure a Reusable Recipient Pattern

1. Take one of the following actions:
   - If you are configuring a policy with a Recipient Matches Pattern rule, from the Manage > Policies > Policy List > Configure Policy - Edit Rule page, click Create Reusable Recipient Pattern.
   - In the Enforce Server administration console, navigate to Manage > Policies > Sender/Recipient Patterns, then click Add > Recipient Pattern.

2. In the General section on the Configure Reusable Recipient Pattern page, enter a Name and Description for your Reusable Recipient Pattern.

3. In the Recipient Pattern section, enter the Email Addresses, IP Addresses, and URL Domains as described in the "Recipient Matches Pattern condition table". See Table 30-4 on page 648.

4. Click Save.

5. To edit a saved Reusable Recipient Pattern, on the Manage > Policies > Sender/Recipient Patterns page, click the dropdown arrow next to the name of the pattern you want to edit, then select Edit.

6. To delete a saved Reusable Recipient Pattern, on the Manage > Policies > Sender/Recipient Patterns page, click the dropdown arrow next to the name of the pattern you want to delete, then select Delete.

Note: You cannot delete a Reusable Recipient Pattern that is currently in use in any policy.

Best practices for using described identity matching

This section provides considerations for implementing the Sender/User or Recipient Matches Pattern conditions in policy detection rules or exceptions. Keep in mind these considerations when you implement these conditions.

Define precise identity patterns to match users

Both the Sender/User and Recipient conditions match on the entire message, not individual message components. If either condition is used as an exception, a match excludes the entire message, not only the header.

See “Policy detection execution” on page 308.
For both described identity matching rules, the system implies an OR between all comma-separated list items and between all fields. For example, if any single email address among a list of email addresses matches, the condition reports (or excepts) an incident. Or, if either an email address, a domain name, or an IP address matches, the condition reports (or excepts) an incident.

See “Detection messages and message components” on page 305.

Table 30-5 describes the types of patterns you can use for described identity matching.

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Sender/User Matches Pattern</th>
<th>Recipient Matches Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email address: full and partial</td>
<td>matches</td>
<td>matches</td>
</tr>
<tr>
<td>Domain address: top-level and subdomains</td>
<td>matches</td>
<td>matches</td>
</tr>
<tr>
<td>IP address</td>
<td>matches</td>
<td>matches</td>
</tr>
<tr>
<td>Windows user name</td>
<td>matches</td>
<td>does not match</td>
</tr>
<tr>
<td>IM screen name / handle</td>
<td>matches</td>
<td>does not match</td>
</tr>
<tr>
<td>Newsgroup patterns</td>
<td>does not match</td>
<td>matches</td>
</tr>
</tbody>
</table>

Specify email addresses exactly to improve accuracy

An email address must match exactly. For example, bob@company.com does not match bob@something.company.com. But, a domain name pattern such as company.com or something.company.com matches bob@something.company.com.

The email address field does not match the sender or recipient of a Web post. For example, the email address bob@yahoo.com does not match if Bob uses a Web browser to send or receive email. In this case, you must use the domain pattern mail.yahoo.com to match bob@yahoo.com.

Match domains instead of IP addresses to improve accuracy

The URL Domain pattern matches HTTP traffic to particular URL domains. You do not enter the entire URL. For example, you enter mail.yahoo.com not http://www.mail.yahoo.com.

The system does not resolve URL domains to IP addresses. For example, you specify an IP address of 192.168.1.1 for a specific domain. If users access the domain URL using a Web browser, the system does not match emails that are
transmitted by the IP address. In this case, use a domain pattern instead of an IP address, such as internalmemos.com.

You can detect senders/users and recipients based one or more IP addresses. However, to do so you must carefully consider the placement of the detection server on your network. If the detection server is installed between the Web proxy and the Internet, the IP address of all Web traffic from individuals in your organization appears to come from the Web proxy. If the detection server is installed between the Web proxy and the internal corporate network, the IP address of all Web traffic from outside your organization appears to go to the Web proxy. The best practice is to match on domain names instead of IP addresses.
Detecting synchronized identities

This chapter includes the following topics:

- Introducing synchronized Directory Group Matching (DGM)
- About two-tier detection for synchronized DGM
- Configuring User Groups
- Configuring synchronized DGM policy conditions
- Best practices for using synchronized DGM

Introducing synchronized Directory Group Matching (DGM)

Symantec Data Loss Prevention provides synchronized Directory Group Matching (DGM) to detect data based on the exact identities of users, senders, and recipients of that data. Using synchronized DGM, you can connect the Enforce Server to a group directory server such as Microsoft Active Directory and detect users based on their directory group affiliation. For example, you may want to apply policies to staff only in the engineering department of your company, but not to staff in the human resources department. Synchronized DGM enables you to do this.

Synchronized DGM is based on a User Group configuration that you populate with users synchronized from your directory server. When you create a synchronized DGM policy, you reference the User Group in the policy. At runtime the synchronized DGM policy only applies to identities in the User Group reference by the policy. Or, consider an example where you you want to create a policy that applies to your everyone in your organization except the CEO. In this case you can create a User
**Group** that contains the CEO's identity as a sole group member. You then define a policy exception that references the CEO **User Group**. At runtime the policy will ignore messages sent or received by the CEO.

See "User Groups" on page 292.

### About two-tier detection for synchronized DGM

On the endpoint, the **Recipient based on a Directory Server Group** condition requires two-tier detection for DLP Agents. The corresponding **Sender/User based on a Directory Server Group** condition does not require two-tier detection.

Be sure understand the implications of two-tier detection before you deploy the synchronized DGM Recipient rule to one or more endpoints.

See “Two-tier detection for DLP Agents” on page 309.

To check if two-tier detection is being used, check the \SymantecDLP\Protect\logs\debug\FileReader.log on the Endpoint Server.

See “Troubleshooting policies” on page 353.

### Configuring User Groups

The **Manage > Policies > User Groups** screen displays configured User Groups and is the starting point for creating a new User Group. User Groups are used for implementing synchronized DGM.

See “Introducing synchronized Directory Group Matching (DGM)” on page 653.

---

**Note:** User Groups can also be used with Microsoft Exchange Server Discover targets. See “Setting up scanning of Microsoft Exchange Servers ” on page 1305.

---

**To create or modify a User Group**

1. Establish a connection to the Active Directory server you want to synchronize with.

   See “Configuring directory server connections” on page 127.

2. At the **Manage > Policies > User Groups** screen, click **Create New Group**.

   Or, to edit an existing user group, select the group in the **User Groups** screen.
3 Configure the User Group parameters as required. See Table 31-1 on page 655.

**Note:** If this is the first time you are configuring the User Group, you must select the option **Refresh the group directory index on Save** to populate the User Group.

4 After you locate the users you want, use the **Add** and **Remove** options to include or exclude them in the User Group.

5 Click **Save**.

Table 31-1 Configure a User Group

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter the group name.</td>
<td>The <strong>Group Name</strong> is the name that you want to use to identify this group. Use a descriptive name so that you can easily identify it later on.</td>
</tr>
<tr>
<td>Enter the group description</td>
<td>Enter a short <strong>Description</strong> of the group.</td>
</tr>
<tr>
<td>View which policies use the group.</td>
<td>Initially, when you create a new User Group, the <strong>Used in Policy</strong> field displays <strong>None</strong>. If the User Group already exists and you modify it, the system displays a list of the policies that implement the User Group, assuming one or more group-based policies is created for this User Group.</td>
</tr>
<tr>
<td>Refresh the group directory index on Save.</td>
<td>Select (check) the <strong>Refresh the group directory index on Save</strong> option to synchronize the user group profile with the most recent directory server index immediately on <strong>Save</strong> of the profile. If you leave this box unselected (unchecked), the profile is synchronized with the directory server index based on the Directory Connection setting. See “Scheduling directory server indexing” on page 129. If this is the first time you are configuring the User Group profile, you must select the <strong>Refresh the group directory index on Save</strong> option to populate the profile with the latest directory server index replication.</td>
</tr>
</tbody>
</table>
| Select the directory server. | Select the directory server you want to use from the **Directory Server** list. You must establish a connection to the directory server before you create the User Group profile. See “Configuring directory server connections” on page 127.
Table 31-1  Configure a User Group (continued)

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| Search the directory for specific users.   | Enter the search string in the search field and click **Search** to search the directory for specific users. You can search using literal text or wildcard characters (*).  

  The search results display the Common Name (CN) and the Distinguished Name (DN) of the directory server that contains the user. These names give you the specific user identity. Results are limited to 1000 entries.  

  Click **Clear** to clear the results and begin a new search of the directory.  

  **Literal text search criteria options:**  

  - Name of individual node, such as "engineering" or "accounting"  
  - Email address, such as "goakham@symantec-dlp.com"  

  **Wildcard character search criteria options:**  

  - The supported wildcard character is an asterisk (*)  
  - Proper wildcard search examples:  
    - Gabriel *akha* returns "Gabriel Oakham"  
    - j* jop* returns "Janice Joplin"  
  - Improper wildcard search:  
    - Do not begin the search string with a wildcard; this will hinder directory server search performance.  
    - For example, the following search is not recommended: *Gabriel Oakham.

| Browse the directory for user groups.      | You can browse the directory tree for groups and users by clicking on the individual nodes and expanding them until you see the group or node that you want.  

  The browse results display the name of each node. These names give you the specific user identity.  

  The results are limited to 20 entries by default. Click **See More** to view up to 1000 results.

| Add a user group to the profile.           | To add a group or user to the User Group profile, select it from the tree and click **Add**.  

  After you select and add the node to the **Added Groups** column, the system displays the Common Name (CN) and the Distinguished Name (DN).  

| Save the user group.                      | Click **Save** to save the User Group profile you have configured.  

---

**Configuring synchronized DGM policy conditions**

To implement synchronized DGM policies, you define a **Directory Connection** using the Enforce Server administration console. The **Directory Connection** specifies the directory server you want to use as source information for defining exact identity **User Groups**. You then define one or more **User Groups** in the Enforce Server administration console and populate the group by synchronizing...
the User Group with the directory server. You then associate the User Groups with the Sender/User based on a Directory Server Group group rule or the Recipient matches User Group based on a Directory Server group rule.

See “Introducing synchronized Directory Group Matching (DGM)” on page 653. Table 31-2 describes the process for implementing synchronized DGM.

Table 31-2 Workflow for implementing synchronized DGM

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1    | Create the connection to the directory server. | Establish the connection from the Enforce Server to a directory server such as Microsoft Active Directory.  
See “Configuring directory server connections” on page 127. |
| 2    | Create the User Group. | Create one or more User Groups on the Enforce Server and populate the User Groups with the exact identities from the users, groups, and business units that are defined in the directory server  
See “Configuring User Groups” on page 654. |
| 3    | Configure a new policy or edit an existing one. | See “Configuring policies” on page 326. |
| 4    | Configure one or more group rules or exceptions. | Choose the type of synchronized DGM rule you want to implement and reference the User Group. After the policy and the group are linked, the policy applies only to those identifies in the referenced User Group.  
See “Configuring the Sender/User based on a Directory Server Group condition” on page 657.  
See “Configuring the Recipient based on a Directory Server Group condition” on page 658. |

Configuring the Sender/User based on a Directory Server Group condition

The condition Sender/User based on a Directory Server Group matches policy violations based on message senders and endpoint users synchronized from a directory group server. You can implement this condition in a policy group (identity) rule or exception.

See “Configuring policies” on page 326.

Note: If the identity being detected is a user, the user must be actively logged on to a DLP Agent-enabled system for the policy to match.
Table 31-3  Sender/User matches User Group condition parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select User Groups to include in this policy</td>
<td>Select one or more <strong>User Groups</strong> that you want this policy to detect. If you have not created a User Group, click <strong>Create a new User Group</strong>. See “Configuring User Groups” on page 654.</td>
</tr>
<tr>
<td>Match On</td>
<td>This condition matches on the entire message. The <strong>Envelope</strong> option is selected by default. You cannot select any other message component. See “Detection messages and message components” on page 305.</td>
</tr>
<tr>
<td>Also Match</td>
<td>Select this option to create a compound condition. All conditions in a rule or exception must match to trigger an incident. You can <strong>Add</strong> any available condition from the list. See “Configuring compound match conditions” on page 342.</td>
</tr>
</tbody>
</table>

See “Introducing synchronized Directory Group Matching (DGM)” on page 653.

Configuring the Recipient based on a Directory Server Group condition

The **Recipient based on a Directory Server Group** condition matches policy violations based on specific message recipients synchronized from a directory server. You can implement this condition in a policy group rule or exception. See “Introducing synchronized Directory Group Matching (DGM)” on page 653.

**Note:** The **Recipient based on a Directory Server Group** condition requires two-tier detection. See “About two-tier detection for synchronized DGM” on page 654.

Table 31-4  Configuring the Recipient based on a Directory Server Group condition

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Select User Groups to include in this policy</td>
<td>Select the User Group(s) that you want this policy to match on. If you have not created a User Group, click <strong>Create a new Endpoint User Group</strong> option. See “Configuring User Groups” on page 654.</td>
</tr>
</tbody>
</table>
### Table 31-4 Configuring the Recipient based on a Directory Server Group condition (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Match On</td>
<td>This rule detects the entire message, not individual components. The <strong>Envelope</strong> option is selected by default. You cannot select any other message component. See “Detection messages and message components” on page 305.</td>
</tr>
<tr>
<td>3</td>
<td>Also Match</td>
<td>Select this option to create a compound condition. All conditions in a rule or exception must match to trigger an incident. You can <strong>Add</strong> any available condition from the list. See “Configuring compound match conditions” on page 342.</td>
</tr>
</tbody>
</table>

### Best practices for using synchronized DGM

This section contains a few considerations to keep in mind when implementing synchronized DGM conditions in your policies.

#### Refresh the directory on initial save of the User Group

To execute a policy rule based on an Active Directory group, the index that you define on the Enforce Server must first be populated. When you first define the User Group, the recommendation is to select the option "Refresh the group directory index on Save." This ensures proper synchronization of Active Directory with the Enforce Server. Once the User Group is populated, you can then set up scheduling to keep the user group on Enforce in sync with the Active Directory server.

One use case for not indexing immediately is where you are creating multiple User Groups and you want to index after you have defined all the groups. In this case you can use scheduling, but keep in mind that any policies based on these indices will not execute until they are populated.

See "Introducing synchronized Directory Group Matching (DGM)" on page 653.

See “Configuring User Groups” on page 654.

#### Distinguish synchronized DGM from other types endpoint detection

When synchronized DGM policies are deployed to endpoint servers, identity-based detection applies to the users in a configured group of DLP Agent-based endpoints. With endpoint-based user groups, many different users can log on to the same computer depending on business practices. The response that each user sees on that endpoint varies depending on how the users are grouped. Contrast this style
of endpoint detection with the **Endpoint Protocol Destination** or **Endpinot Location** methods, which are specific to the endpoint and are not user-based. See “**Introducing synchronized Directory Group Matching (DGM)**” on page 653.
Detecting profiled identities

This chapter includes the following topics:

- Introducing profiled Directory Group Matching (DGM)
- About two-tier detection for profiled DGM
- Configuring Exact Data profiles for DGM
- Configuring profiled DGM policy conditions
- Best practices for using profiled DGM

Introducing profiled Directory Group Matching (DGM)

Profiled Directory Group Matching (DGM) leverages Exact Data Matching (EDM) technology to detect identities that you have indexed from your database or directory server using an Exact Data Profile. For example, you can use profiled DGM to identify network user activity or to analyze content associated with particular users, senders, or recipients. Or, you can exclude certain email addresses from analysis. Or, you might want to prevent certain people from sending confidential information by email.

See “Configuring Exact Data profiles for DGM” on page 662.

Profiled DGM is distinguished from synchronized DGM, which uses a connection to a directory server (such as Microsoft Active Directory) to match identities.

See “Introducing synchronized Directory Group Matching (DGM)” on page 653.

About two-tier detection for profiled DGM

Profiled DGM relies on an EDM index, which is server-based. Profiled DGM requires two-tier detection for DLP Agents on the endpoint.
See “About two-tier detection for EDM on the endpoint” on page 377.

You cannot combine either type of profiled DGM condition with an Endpoint: Block or Endpoint: Notify response rule in a policy. If you do, the system reports that the policy is misconfigured.

See “Troubleshooting policies” on page 353.

Configuring Exact Data profiles for DGM

To implement profiled DGM, you export identity records from a directory server or database, index the data, and create an Exact Data Profile. You then reference this profile in the corresponding Sender/User or Recipient condition.

See “Introducing profiled Directory Group Matching (DGM)” on page 661.

Table 32-1 describes the procedure for configuring Exact Data profiles for DGM policies.

Table 32-1  Workflow for implementing profiled DGM

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1    | Create the data source file. | Create a data source file from the directory server or database you want to profile. Make sure the data source file contains the appropriate fields. The following fields are supported for profiled DGM:  
  • Email address  
  • IP address  
  • Window user name (in the format domain\user)  
  • IM screen name  
See “Creating the exact data source file for profiled DGM” on page 380. |
| 2    | Prepare the data source file for indexing. | See “Configuring Exact Data profiles” on page 378.  
See “Preparing the exact data source file for indexing” on page 381. |
| 3    | Create the Exact Data Profile. | This includes uploading the data source file to the Enforce Server, mapping the data fields, and indexing the data source.  
See “Uploading exact data source files to the Enforce Server” on page 383.  
See “Creating and modifying Exact Data Profiles” on page 385.  
See “Mapping Exact Data Profile fields” on page 389.  
See “Scheduling Exact Data Profile indexing” on page 392. |
### Table 32-1 Workflow for implementing profiled DGM (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| 4    | Define the profiled DGM condition. | See “Configuring the Sender/User based on a Profiled Directory condition” on page 663.  
See “Configuring the Recipient based on a Profiled Directory condition” on page 664. |
| 5    | Test the profiled DGM policy. | Use a test policy group and verify that the matches the policy generates are accurate.  
See “Test and tune policies to improve match accuracy” on page 361. |

### Configuring profiled DGM policy conditions

Symantec Data Loss Prevention provides two match conditions for profiled DGM: sender/user and recipient. Both conditions can be used as policy rules or exceptions. For example, consider a scenario where you index a list of email addresses and author profiled DGM policies based on this indexed data. You could write a rule that requires the message sender to be from the indexed list to violate the policy. Or, you could write an exception that is not violated if the recipient of an email is from the indexed list.

See “Creating the exact data source file for profiled DGM” on page 380.

### Table 32-2 Profiled DGM conditions

<table>
<thead>
<tr>
<th>Group rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Sender/User based on a Directory from &lt;EDM Profile&gt;</strong></td>
<td>If this condition is implemented as a policy rule, a match occurs only if the sender or user of the data is contained in the index profile. If this condition is implemented as a policy exception, the data will be excepted from matching if it is sent by a sender/user listed in the index profile</td>
</tr>
<tr>
<td><strong>Recipient based on a Directory from &lt;EDM Profile&gt;</strong></td>
<td>If this condition is implemented as a policy rule, a match occurs only if the recipient of the data is contained in the index profile. If this condition is implemented as a policy exception, the data will be excepted from matching if it is received by a recipient listed in the index profile</td>
</tr>
</tbody>
</table>

### Configuring the Sender/User based on a Profiled Directory condition

The **Sender/User based on a Directory from** detection rule lets you create detection rules based on sender identity or (for endpoint incidents) user identity. This condition requires an Exact Data Profile.

See “Creating the exact data source file for profiled DGM” on page 380.
After you select the Exact Data Profile, when you configure the rule, the directory you selected and the sender identifier(s) appear at the top of the page.

Table 32-3 describes the parameters for configuring the **Sender/User based on a Directory from an EDM Profile** condition.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Where</td>
<td>Select this option to have the system match on the specified field values. Specify the values by selecting a field from the drop-down list and typing the values for that field in the adjacent text box. If you enter more than one value, separate the values with commas. For example, for an Employees directory group profile that includes a <strong>Department</strong> field, you would select <strong>Where</strong>, select <strong>Department</strong> from the drop-down list, and enter <strong>Marketing, Sales</strong> in the text box. If the condition is implemented as a rule, in this example a match occurs only if the sender or user works in Marketing or Sales (as long as the other input content meets all other detection criteria). If the condition is implemented as an exception, in this example the system ignores from matching messages from a sender or user who works in Marketing or Sales.</td>
</tr>
<tr>
<td>Is Any Of</td>
<td>Enter or modify the information you want to match. For example, if you want to match any sender in the Sales department, select <strong>Department</strong> from the drop-down list, and then enter <strong>Sales</strong> in this field (assuming that your data includes a Department column). Use a comma-separated list if you want to specify more than one value.</td>
</tr>
</tbody>
</table>

Configuring the Recipient based on a Profiled Directory condition

The **Recipient based on a Directory from** condition lets you create detection methods based on the identity of the recipient. This method requires an Exact Data Profile.

See “Creating the exact data source file for profiled DGM” on page 380.

After you select the Exact Data Profile, when you configure the rule, the directory you selected and the recipient identifier(s) appear at the top of the page.

Table 32-3 describes the parameters for configuring **Recipient based on a Directory from an EDM profile** condition.
### Table 32-4 Configuring the Recipient based on a Directory from an EDM profile condition

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Where</td>
<td>Select this option to have the system match on the specified field values. Specify the values by selecting a field from the drop-down list and typing the values for that field in the adjacent text box. If you enter more than one value, separate the values with commas. For example, for an Employees directory group profile that includes a <strong>Department</strong> field, you would select <strong>Where</strong>, select <strong>Department</strong> from the drop-down list, and enter <strong>Marketing, Sales</strong> in the text box. For a detection rule, this example causes the system to capture an incident only if at least one recipient works in Marketing or Sales (as long as the input content meets all other detection criteria). For an exception, this example prevents the system from capturing an incident if at least one recipient works in Marketing or Sales.</td>
</tr>
<tr>
<td>Is Any Of</td>
<td>Enter or modify the information you want to match. For example, if you want to match any recipient in the Sales department, select <strong>Department</strong> from the drop-down list, and then enter <strong>Sales</strong> in this field (assuming that your data includes a Department column). Use a comma-separated list if you want to specify more than one value.</td>
</tr>
</tbody>
</table>

### Best practices for using profiled DGM

Keep in mind the considerations in this section when implementing profiled Directory Group Matching (DGM).

Follow EDM best practices when implementing profiled DGM

Profiled DGM leverages EDM technology. Follow the EDM procedures and best practices when implementing profiled DGM.

See “About two-tier detection for profiled DGM” on page 661.

Include an email address field in the Exact Data Profile for profiled DGM

You must include the appropriate fields in the Exact Data Profile to implement profiled DGM.

See “Creating the exact data source file for profiled DGM” on page 380.

If you include the email address field in the Exact Data Profile for profiled DGM and map it to the email data validator, email address will appear in the **Directory EDM** drop-down list (at the remediation page).
Use profiled DGM for Network Prevent for Web identity detection

If you want to implement DGM for Network Prevent for Web, use one of the profiled DGM conditions to implement identity matching. For example, you may want to use identity matching to block all web traffic for a specific users. For Network Prevent for Web, you cannot use synchronized DGM conditions for this use case.

See "Creating the exact data source file for profiled DGM" on page 380.

See "Configuring the Sender/User based on a Profiled Directory condition" on page 663.
Supported file formats for detection

This chapter includes the following topics:

- Overview of detection file format support
- Supported formats for file type identification
- Supported formats for content extraction
- Supported encapsulation formats for subfile extraction
- Supported file formats for metadata extraction

Overview of detection file format support

Symantec Data Loss Prevention detection supports various file formats for performing the following operations:

- File type identification
- File contents extraction
- Subfile extraction
- Document metadata extraction

Table 33-1 summarizes the file formats that Symantec Data Loss Prevention supports for file type identification and content, subfile and metadata extraction.

You configure the system to identify individual file formats using the Message Attachment or File Type Match condition. This condition performs a context-based match that only identifies the file format type; it does not extract file contents. In addition, you must explicitly select the individual file format(s) you want to detect.
See “About file type matching” on page 609.

When you use a content-based detection condition in a policy (such as Content Matches Keyword), the system automatically extracts file contents for supported file formats (such as DOCX, PPTX, XSLX, PDF). In addition, the system automatically extracts subfiles from supported encapsulation file formats (such as ZIP, RAR, TAR).

See “Content matching conditions” on page 301.

Lastly, you can enable metadata extraction for a limited number of document formats (such as DOCX), and use keyword matching to detect document metadata.

See “About document metadata detection” on page 693.

---

**Note:** While there is some overlap among file types supported for extraction and for identification (because if the system can can crack the file it must be able to identify its type), the supported formats for each operation are distinct and implemented using different match conditions. The number of file formats supported for type identification is much broader than those supported for content extraction.

---

### Table 33-1  File format support for detection operations

<table>
<thead>
<tr>
<th>Operation type</th>
<th>Description</th>
<th>Configuration</th>
<th>Supported formats</th>
</tr>
</thead>
<tbody>
<tr>
<td>File type identification</td>
<td>Symantec Data Loss Prevention does not rely on file extensions to identify the format. File type is identified by the unique binary signature of the file format.</td>
<td>Explicitly using the Message Attachment or File Type Match file property condition.</td>
<td>See “Supported formats for file type identification” on page 669.</td>
</tr>
<tr>
<td>File contents extraction</td>
<td>File contents is any text-based content that can be viewed through the native or source application.</td>
<td>Implicitly using one or more content match conditions, including EDM, IDM, VML, data identifiers, keyword, regular expressions.</td>
<td>See “Supported formats for content extraction” on page 684.</td>
</tr>
<tr>
<td>Subfile extraction (Subfile)</td>
<td>Subfiles are files encapsulated in a parent file. Subfiles are extracted and processed individually for identification and content extraction. If the subfile format is not supported by default, a custom method can be used to detect and crack the file.</td>
<td>Implicitly using one or more content match conditions, including EDM, IDM, VML, data identifiers, keyword, regular expressions.</td>
<td>See “Supported encapsulation formats for subfile extraction” on page 691.</td>
</tr>
</tbody>
</table>
### Supported file formats for file type identification

Table 33-2 lists the file types you can identify using the **Message Attachment or File Type Match** policy condition.

See “About file type matching” on page 609.

If the file format you want to identify is not supported, you can use the Symantec Data Loss Prevention Scripting Language to identify custom file types.

See “About custom file type identification” on page 610.

---

**Note:** The **Message Attachment or File Type Match** condition is a context-based match condition that only supports file type identification. This condition does not support file contents extraction. To extract file contents for policy evaluation you must use a content-based detection rule. See “Supported formats for content extraction” on page 684.

See “Overview of detection file format support” on page 667.

---

Table 33-2 Formats supported for file type identification

<table>
<thead>
<tr>
<th>Message Attachment or File Type Match formats</th>
</tr>
</thead>
<tbody>
<tr>
<td>7-Zip Compressed File (7Z)</td>
</tr>
<tr>
<td>Ability Office (SS)</td>
</tr>
<tr>
<td>Ability Office (DB)</td>
</tr>
<tr>
<td>Ability Office (GR)</td>
</tr>
<tr>
<td>Ability Office (WP)</td>
</tr>
<tr>
<td>Ability Office (COM)</td>
</tr>
<tr>
<td>Message Attachment or File Type Match formats</td>
</tr>
<tr>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>ACT</td>
</tr>
<tr>
<td>Adobe FrameMaker</td>
</tr>
<tr>
<td>Adobe Maker Interchange Format (FrameMaker)</td>
</tr>
<tr>
<td>Adobe FrameMaker Markup Language</td>
</tr>
<tr>
<td>Adobe PDF</td>
</tr>
<tr>
<td>AES Multiplus Comm</td>
</tr>
<tr>
<td>Aldus Freehand (Macintosh)</td>
</tr>
<tr>
<td>Aldus PageMaker (DOS)</td>
</tr>
<tr>
<td>Aldus PageMaker (Macintosh)</td>
</tr>
<tr>
<td>Amiga IFF-8SVX sound</td>
</tr>
<tr>
<td>Amiga MOD sound</td>
</tr>
<tr>
<td>ANSI</td>
</tr>
<tr>
<td>Apple Double</td>
</tr>
<tr>
<td>Apple Single</td>
</tr>
<tr>
<td>Applix Alis</td>
</tr>
<tr>
<td>Applix Asterix</td>
</tr>
<tr>
<td>Applix Graphics</td>
</tr>
<tr>
<td>Applix Presents</td>
</tr>
<tr>
<td>Applix Spreadsheets</td>
</tr>
<tr>
<td>Applix Words</td>
</tr>
<tr>
<td>ARC/PAK Archive</td>
</tr>
<tr>
<td>ASCII</td>
</tr>
<tr>
<td>ASCII-armored PGP encoded</td>
</tr>
<tr>
<td>ASCII-armored PGP Public Keyring</td>
</tr>
<tr>
<td>ASCII-armored PGP signed</td>
</tr>
</tbody>
</table>
Table 33-2  Formats supported for file type identification (continued)

<table>
<thead>
<tr>
<th>Message Attachment or File Type Match formats</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio Interchange File Format</td>
</tr>
<tr>
<td>AutoCAD Drawing</td>
</tr>
<tr>
<td>AutoCAD Drawing Exchange</td>
</tr>
<tr>
<td>AutoDesk Animator FLIC Animation</td>
</tr>
<tr>
<td>AutoDesk Animator Pro FLIC Animation</td>
</tr>
<tr>
<td>AutoDesk WHIP</td>
</tr>
<tr>
<td>AutoShade Rendering</td>
</tr>
<tr>
<td>BinHex</td>
</tr>
<tr>
<td>CADAM Drawing (CDD) (server only)</td>
</tr>
<tr>
<td>CADAM Drawing Overlay</td>
</tr>
<tr>
<td>CATIA Drawing (CAT) (server only)</td>
</tr>
<tr>
<td>CCITT Group 3 1-Dimensional (G31D)</td>
</tr>
<tr>
<td>COMET TOP Word</td>
</tr>
<tr>
<td>Comma Separated Values</td>
</tr>
<tr>
<td>Compactor/Compact Pro Archive</td>
</tr>
<tr>
<td>Computer Graphics Metafile</td>
</tr>
<tr>
<td>Convergent Tech DEF Comm.</td>
</tr>
<tr>
<td>Corel Draw CMX</td>
</tr>
<tr>
<td>Corel Presentations</td>
</tr>
<tr>
<td>Corel Quattro Pro (WB2)</td>
</tr>
<tr>
<td>Corel Quattro Pro (WB3)</td>
</tr>
<tr>
<td>Corel WordPerfect Linux</td>
</tr>
<tr>
<td>Corel WordPerfect Macintosh</td>
</tr>
<tr>
<td>Corel WordPerfect Windows (WO)</td>
</tr>
<tr>
<td>Corel WordPerfect Windows (WPD)</td>
</tr>
<tr>
<td>Message Attachment or File Type Match formats</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>CorelDRAW</td>
</tr>
<tr>
<td>cpio Archive (UNIX)</td>
</tr>
<tr>
<td>cpio Archive (VAX)</td>
</tr>
<tr>
<td>cpio Archive (SUN)</td>
</tr>
<tr>
<td>CPT Communication</td>
</tr>
<tr>
<td>Creative Voice (VOC) sound</td>
</tr>
<tr>
<td>Curses Screen Image (UNIX)</td>
</tr>
<tr>
<td>Curses Screen Image (VAX)</td>
</tr>
<tr>
<td>Curses Screen Image (SUN)</td>
</tr>
<tr>
<td>Data Interchange Format</td>
</tr>
<tr>
<td>Data Point VISTAWORD</td>
</tr>
<tr>
<td>dBase Database</td>
</tr>
<tr>
<td>DCX Fax</td>
</tr>
<tr>
<td>DCX Fax System</td>
</tr>
<tr>
<td>DEC WPS PLUS</td>
</tr>
<tr>
<td>DECdx</td>
</tr>
<tr>
<td>Desktop Color Separation (DCS)</td>
</tr>
<tr>
<td>Device Independent file (DVI)</td>
</tr>
<tr>
<td>DG CEOwrite</td>
</tr>
<tr>
<td>DG Common Data Stream (CDS)</td>
</tr>
<tr>
<td>DIF Spreadsheet</td>
</tr>
<tr>
<td>Digital Document Interchange Format (DDIF)</td>
</tr>
<tr>
<td>Disk Doubler Compression</td>
</tr>
<tr>
<td>DisplayWrite</td>
</tr>
<tr>
<td>Domino XML Language</td>
</tr>
<tr>
<td>Message Attachment or File Type Match formats</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>EBCDIC Text</td>
</tr>
<tr>
<td>EMC EmailXtender Container File (EMX)</td>
</tr>
<tr>
<td>ENABLE</td>
</tr>
<tr>
<td>ENABLE Spreadsheet (SSF)</td>
</tr>
<tr>
<td>Encapsulated PostScript (raster)</td>
</tr>
<tr>
<td>Enhanced Metafile</td>
</tr>
<tr>
<td>Envoy (EVY)</td>
</tr>
<tr>
<td>Executable- Other</td>
</tr>
<tr>
<td>Executable- UNIX</td>
</tr>
<tr>
<td>Executable- VAX</td>
</tr>
<tr>
<td>Executable- SUN</td>
</tr>
<tr>
<td>FileMaker (Macintosh)</td>
</tr>
<tr>
<td>File Share Encryption</td>
</tr>
<tr>
<td>Folio Flat File</td>
</tr>
<tr>
<td>Framework</td>
</tr>
<tr>
<td>Framework II</td>
</tr>
<tr>
<td>FTP Session Data</td>
</tr>
<tr>
<td>Fujitsu Oasys</td>
</tr>
<tr>
<td>GEM Bit Image</td>
</tr>
<tr>
<td>GIF</td>
</tr>
<tr>
<td>Graphics Environment Manager (GEM VDI)</td>
</tr>
<tr>
<td>GZIP</td>
</tr>
<tr>
<td>Haansoft Hangul (Hangul 2010 SE+)</td>
</tr>
<tr>
<td>Harvard Graphics</td>
</tr>
<tr>
<td>Hewlett-Packard</td>
</tr>
</tbody>
</table>
Table 33-2  Formats supported for file type identification (continued)

<table>
<thead>
<tr>
<th>Message Attachment or File Type Match formats</th>
</tr>
</thead>
<tbody>
<tr>
<td>Honey Bull DSA101</td>
</tr>
<tr>
<td>HP Graphics Language (HPG) (server only)</td>
</tr>
<tr>
<td>HP Printer Control Language (PCL)</td>
</tr>
<tr>
<td>HTML</td>
</tr>
<tr>
<td>IBM 1403 Line Printer</td>
</tr>
<tr>
<td>IBM DCA/RFT(Revisable Form Text)</td>
</tr>
<tr>
<td>IBM DCA-FFT</td>
</tr>
<tr>
<td>IBM DCF Script</td>
</tr>
<tr>
<td>Informix SmartWare II</td>
</tr>
<tr>
<td>Informix SmartWare II Communication File</td>
</tr>
<tr>
<td>Informix SmartWare II Database</td>
</tr>
<tr>
<td>Informix SmartWare II Database</td>
</tr>
<tr>
<td>Informix SmartWare Spreadsheet</td>
</tr>
<tr>
<td>Interleaf</td>
</tr>
<tr>
<td>Java Archive</td>
</tr>
<tr>
<td>JPEG</td>
</tr>
<tr>
<td>JPEG File Interchange Format (JFIF)</td>
</tr>
<tr>
<td>JustSystems Ichitaro</td>
</tr>
<tr>
<td>KW ODA G31D (G31)</td>
</tr>
<tr>
<td>KW ODA G4 (G4)</td>
</tr>
<tr>
<td>KW ODA Internal G32D (G32)</td>
</tr>
<tr>
<td>KW ODA Internal Raw Bitmap (RBM)</td>
</tr>
<tr>
<td>Lasergraphics Language</td>
</tr>
<tr>
<td>Legato Extender</td>
</tr>
<tr>
<td>Link Library- Other</td>
</tr>
<tr>
<td>Link Library UNIX</td>
</tr>
<tr>
<td><strong>Message Attachment or File Type Match formats</strong></td>
</tr>
<tr>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Link Library VAX</td>
</tr>
<tr>
<td>Link Library SUN</td>
</tr>
<tr>
<td>Lotus 1-2-3 (123)</td>
</tr>
<tr>
<td>Lotus 1-2-3 (WK4)</td>
</tr>
<tr>
<td>Lotus 1-2-3 Charts</td>
</tr>
<tr>
<td>Lotus AMI Pro</td>
</tr>
<tr>
<td>Lotus AMI Professional Write Plus</td>
</tr>
<tr>
<td>Lotus AMIDraw Graphics</td>
</tr>
<tr>
<td>Lotus Freelance Graphics</td>
</tr>
<tr>
<td>Lotus Freelance Graphics 2</td>
</tr>
<tr>
<td>Lotus Notes Bitmap</td>
</tr>
<tr>
<td>Lotus Notes CDF</td>
</tr>
<tr>
<td>Lotus Notes database</td>
</tr>
<tr>
<td>Lotus Pic</td>
</tr>
<tr>
<td>Lotus Screen Cam</td>
</tr>
<tr>
<td>Lotus SmartMaster</td>
</tr>
<tr>
<td>Lotus Word Pro</td>
</tr>
<tr>
<td>Lyrix MacBinary</td>
</tr>
<tr>
<td>MacBinary</td>
</tr>
<tr>
<td>Macintosh Raster</td>
</tr>
<tr>
<td>MacPaint</td>
</tr>
<tr>
<td>Macromedia (Adobe) Director</td>
</tr>
<tr>
<td>Macromedia (Adobe) Flash</td>
</tr>
<tr>
<td>MacWrite</td>
</tr>
<tr>
<td>MacWrite II</td>
</tr>
</tbody>
</table>
Table 33-2  Formats supported for file type identification (continued)

<table>
<thead>
<tr>
<th>Message Attachment or File Type Match formats</th>
</tr>
</thead>
<tbody>
<tr>
<td>MASS-11</td>
</tr>
<tr>
<td>Micrografx Designer</td>
</tr>
<tr>
<td>Microsoft Access</td>
</tr>
<tr>
<td>Microsoft Advanced Systems Format (ASF)</td>
</tr>
<tr>
<td>Microsoft Compressed Folder (LZH)</td>
</tr>
<tr>
<td>Microsoft Compressed Folder (LHA)</td>
</tr>
<tr>
<td>Microsoft Device Independent Bitmap</td>
</tr>
<tr>
<td>Microsoft Excel Charts</td>
</tr>
<tr>
<td>Microsoft Excel Macintosh</td>
</tr>
<tr>
<td>Microsoft Excel Windows</td>
</tr>
<tr>
<td>Microsoft Excel Windows XML</td>
</tr>
<tr>
<td>Microsoft Office Access (ACCDB)</td>
</tr>
<tr>
<td>Microsoft Office Drawing</td>
</tr>
<tr>
<td>Microsoft OneNote</td>
</tr>
<tr>
<td>Microsoft Outlook Personal Folder</td>
</tr>
<tr>
<td>Microsoft Outlook</td>
</tr>
<tr>
<td>Microsoft Outlook Express</td>
</tr>
<tr>
<td>Microsoft PowerPoint Macintosh</td>
</tr>
<tr>
<td>Microsoft PowerPoint PC</td>
</tr>
<tr>
<td>Microsoft PowerPoint Windows</td>
</tr>
<tr>
<td>Microsoft PowerPoint Windows XML</td>
</tr>
<tr>
<td>Microsoft PowerPoint Windows Macro-Enabled XML</td>
</tr>
<tr>
<td>Microsoft PowerPoint Windows XML Template</td>
</tr>
<tr>
<td>Microsoft PowerPoint Windows Macro-Enabled XML Template</td>
</tr>
<tr>
<td>Microsoft PowerPoint Windows XML Show</td>
</tr>
</tbody>
</table>
Table 33-2  Formats supported for file type identification (continued)

<table>
<thead>
<tr>
<th>Message Attachment or File Type Match formats</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft PowerPoint Windows Macro-Enabled Show</td>
</tr>
<tr>
<td>Microsoft Project</td>
</tr>
<tr>
<td>Microsoft Publisher</td>
</tr>
<tr>
<td>Microsoft Visio</td>
</tr>
<tr>
<td>Microsoft Visio XML</td>
</tr>
<tr>
<td>Microsoft Wave Sound</td>
</tr>
<tr>
<td>Microsoft Windows Cursor (CUR) Graphics</td>
</tr>
<tr>
<td>Microsoft Windows Group File</td>
</tr>
<tr>
<td>Microsoft Windows Help File</td>
</tr>
<tr>
<td>Microsoft Windows Icon (ICO)</td>
</tr>
<tr>
<td>Microsoft Windows OLE 2 Encapsulation</td>
</tr>
<tr>
<td>Microsoft Windows Write</td>
</tr>
<tr>
<td>Microsoft Word (UNIX)</td>
</tr>
<tr>
<td>Microsoft Word Macintosh</td>
</tr>
<tr>
<td>Microsoft Word PC</td>
</tr>
<tr>
<td>Microsoft Word Windows</td>
</tr>
<tr>
<td>Microsoft Word Windows XML</td>
</tr>
<tr>
<td>Microsoft Word Windows Template XML</td>
</tr>
<tr>
<td>Microsoft Word Windows Macro-Enabled Template XML</td>
</tr>
<tr>
<td>Microsoft Works (Macintosh)</td>
</tr>
<tr>
<td>Microsoft Works</td>
</tr>
<tr>
<td>Microsoft Works Communication (Macintosh)</td>
</tr>
<tr>
<td>Microsoft Works Communication (Windows)</td>
</tr>
<tr>
<td>Microsoft Works Database (Macintosh)</td>
</tr>
<tr>
<td>Microsoft Works Database (PC)</td>
</tr>
<tr>
<td>Message Attachment or File Type Match formats</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Microsoft Works Database (Windows)</td>
</tr>
<tr>
<td>Microsoft Works Spreadsheet (S30)</td>
</tr>
<tr>
<td>Microsoft Works Spreadsheet (S40)</td>
</tr>
<tr>
<td>Microsoft Works Spreadsheet (Macintosh)</td>
</tr>
<tr>
<td>Microstation</td>
</tr>
<tr>
<td>MIDI</td>
</tr>
<tr>
<td>MORE Database Outliner (Macintosh)</td>
</tr>
<tr>
<td>MPEG-1 Audio layer 3</td>
</tr>
<tr>
<td>MPEG-1 Video</td>
</tr>
<tr>
<td>MPEG-2 Audio</td>
</tr>
<tr>
<td>MS DOS Batch File format</td>
</tr>
<tr>
<td>MS DOS Device Driver</td>
</tr>
<tr>
<td>MultiMate 4.0</td>
</tr>
<tr>
<td>Multiplan Spreadsheet</td>
</tr>
<tr>
<td>Navy DIF</td>
</tr>
<tr>
<td>NBI Async Archive Format</td>
</tr>
<tr>
<td>NBI Net Archive Format</td>
</tr>
<tr>
<td>Netscape Bookmark file</td>
</tr>
<tr>
<td>NeWS font file (SUN)</td>
</tr>
<tr>
<td>NeXT/Sun Audio</td>
</tr>
<tr>
<td>NIOS TOP</td>
</tr>
<tr>
<td>Nota Bene</td>
</tr>
<tr>
<td>Nurestor Drawing (NUR) (server only)</td>
</tr>
<tr>
<td>Oasis Open Document Format (ODT)</td>
</tr>
<tr>
<td>Oasis Open Document Format (ODS)</td>
</tr>
<tr>
<td>Message Attachment or File Type Match formats</td>
</tr>
<tr>
<td>----------------------------------------------</td>
</tr>
<tr>
<td>Oasis Open Document Format (ODP)</td>
</tr>
<tr>
<td>Object Module UNIX</td>
</tr>
<tr>
<td>Object Module VAX</td>
</tr>
<tr>
<td>Object Module SUN</td>
</tr>
<tr>
<td>ODA/ODIF</td>
</tr>
<tr>
<td>ODA/ODIF (FOD 26)</td>
</tr>
<tr>
<td>Office Writer</td>
</tr>
<tr>
<td>OLE DIB object</td>
</tr>
<tr>
<td>OLIDIF</td>
</tr>
<tr>
<td>OmniOutliner (OO3)</td>
</tr>
<tr>
<td>OpenOffice Calc (SXC)</td>
</tr>
<tr>
<td>OpenOffice Calc (ODS)</td>
</tr>
<tr>
<td>OpenOffice Impress (SXI)</td>
</tr>
<tr>
<td>OpenOffice Impress (SXP)</td>
</tr>
<tr>
<td>OpenOffice Impress (ODP)</td>
</tr>
<tr>
<td>OpenOffice Writer (SXW)</td>
</tr>
<tr>
<td>OpenOffice Writer (ODT)</td>
</tr>
<tr>
<td>Open PGP</td>
</tr>
<tr>
<td>OS/2 PM Metafile Graphics</td>
</tr>
<tr>
<td>Paradox (PC) Database</td>
</tr>
<tr>
<td>PC COM executable</td>
</tr>
<tr>
<td>PC Library Module</td>
</tr>
<tr>
<td>PC Object Module</td>
</tr>
<tr>
<td>PC PaintBrush</td>
</tr>
<tr>
<td>PC True Type Font</td>
</tr>
<tr>
<td>Formats supported for file type identification (continued)</td>
</tr>
<tr>
<td>----------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Message Attachment or File Type Match formats</strong></td>
</tr>
<tr>
<td>PCD Image</td>
</tr>
<tr>
<td>PeachCalc Spreadsheet</td>
</tr>
<tr>
<td>Persuasion Presentation</td>
</tr>
<tr>
<td>PEX Binary Archive (SUN)</td>
</tr>
<tr>
<td>PGP Compressed Data</td>
</tr>
<tr>
<td>PGP Encrypted Data</td>
</tr>
<tr>
<td>PGP Public Keyring</td>
</tr>
<tr>
<td>PGP Secret Keyring</td>
</tr>
<tr>
<td>PGP Signature Certificate</td>
</tr>
<tr>
<td>PGP Signed and Encrypted Data</td>
</tr>
<tr>
<td>PGP Signed Data</td>
</tr>
<tr>
<td>Philips Script</td>
</tr>
<tr>
<td>PKZIP</td>
</tr>
<tr>
<td>Plan Perfect</td>
</tr>
<tr>
<td>Portable Bitmap Utilities (PBM)</td>
</tr>
<tr>
<td>Portable Greymap Utilities (PGM)</td>
</tr>
<tr>
<td>Portable Network Graphics</td>
</tr>
<tr>
<td>Portable Pixmap Utilities (PPM)</td>
</tr>
<tr>
<td>PostScript File</td>
</tr>
<tr>
<td>PRIMEWORD</td>
</tr>
<tr>
<td>Program Information File</td>
</tr>
<tr>
<td>Q &amp; A for DOS</td>
</tr>
<tr>
<td>Q &amp; A for Windows</td>
</tr>
<tr>
<td>Quadratron Q-One (V1.93J)</td>
</tr>
<tr>
<td>Quadratron Q-One (V2.0)</td>
</tr>
<tr>
<td>Message Attachment or File Type Match formats</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Quark Express (Macintosh)</td>
</tr>
<tr>
<td>QuickDraw 3D Metafile (3DMF)</td>
</tr>
<tr>
<td>QuickTime Movie</td>
</tr>
<tr>
<td>RAR archive</td>
</tr>
<tr>
<td>Real Audio</td>
</tr>
<tr>
<td>Reflex Database</td>
</tr>
<tr>
<td>Rich Text Format</td>
</tr>
<tr>
<td>RIFF Device Independent Bitmap</td>
</tr>
<tr>
<td>RIFF MIDI</td>
</tr>
<tr>
<td>RIFF Multimedia Movie</td>
</tr>
<tr>
<td>SAMNA Word IV</td>
</tr>
<tr>
<td>Serialized Object Format (SOF) Encapsulation</td>
</tr>
<tr>
<td>SGI RGB Image</td>
</tr>
<tr>
<td>SGML</td>
</tr>
<tr>
<td>Simple Vector Format (SVF)</td>
</tr>
<tr>
<td>SMTP document</td>
</tr>
<tr>
<td>SolidWorks Drawing (SLDASM, SLDPR, SLDDRW)</td>
</tr>
<tr>
<td>StarOffice Calc (SXC)</td>
</tr>
<tr>
<td>StarOffice Calc (ODS)</td>
</tr>
<tr>
<td>StarOffice Impress (SXI)</td>
</tr>
<tr>
<td>StarOffice Impress (SXP)</td>
</tr>
<tr>
<td>StarOffice Impress (ODP)</td>
</tr>
<tr>
<td>StarOffice Writer (SXW)</td>
</tr>
<tr>
<td>StarOffice Writer (ODT)</td>
</tr>
<tr>
<td>Stuff It Archive (Macintosh)</td>
</tr>
<tr>
<td>Formats supported for file type identification (continued)</td>
</tr>
<tr>
<td>---------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Message Attachment or File Type Match formats</strong></td>
</tr>
<tr>
<td>Sun Raster Image</td>
</tr>
<tr>
<td>SUN vfont definition</td>
</tr>
<tr>
<td>Supercalc Spreadsheet</td>
</tr>
<tr>
<td>SYLK Spreadsheet</td>
</tr>
<tr>
<td>Symphony Spreadsheet</td>
</tr>
<tr>
<td>Tagged Image File</td>
</tr>
<tr>
<td>Tape Archive</td>
</tr>
<tr>
<td>Targon Word (V 2.0)</td>
</tr>
<tr>
<td>Text Mail (MIME)</td>
</tr>
<tr>
<td>Transmission Neutral Encapsulation Format</td>
</tr>
<tr>
<td>Truevision Targa</td>
</tr>
<tr>
<td>Ultracalc Spreadsheet</td>
</tr>
<tr>
<td>Unicode Text</td>
</tr>
<tr>
<td>Uniplex (V6.01)</td>
</tr>
<tr>
<td>Uniplex Ucalc Spreadsheet</td>
</tr>
<tr>
<td>UNIX Compress</td>
</tr>
<tr>
<td>UNIX SHAR Encapsulation</td>
</tr>
<tr>
<td>Usenet format</td>
</tr>
<tr>
<td>UUEncoding</td>
</tr>
<tr>
<td>Volkswriter</td>
</tr>
<tr>
<td>VRML</td>
</tr>
<tr>
<td>Wang Office GDL Header Encapsulation</td>
</tr>
<tr>
<td>WANG PC</td>
</tr>
<tr>
<td>Wang WITA</td>
</tr>
<tr>
<td>WANG WPS Comm.</td>
</tr>
</tbody>
</table>
Table 33-2  Formats supported for file type identification (continued)

<table>
<thead>
<tr>
<th>Message Attachment or File Type Match formats</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Animated Cursor</td>
</tr>
<tr>
<td>Windows Bitmap</td>
</tr>
<tr>
<td>Windows C++ Object Storage</td>
</tr>
<tr>
<td>Windows Icon Cursor</td>
</tr>
<tr>
<td>Windows Metafile</td>
</tr>
<tr>
<td>Windows Micrografx Draw (DRW)</td>
</tr>
<tr>
<td>Windows Palette</td>
</tr>
<tr>
<td>Windows Media Video (WMV)</td>
</tr>
<tr>
<td>Windows Media Audio (WMA)</td>
</tr>
<tr>
<td>Windows Video (AVI)</td>
</tr>
<tr>
<td>WinZip (unzip reader)</td>
</tr>
<tr>
<td>WinZip</td>
</tr>
<tr>
<td>Word Connection</td>
</tr>
<tr>
<td>WordERA (V 1.0)</td>
</tr>
<tr>
<td>WordMARC word processor</td>
</tr>
<tr>
<td>WordPad</td>
</tr>
<tr>
<td>WordPerfect General File</td>
</tr>
<tr>
<td>WordPerfect Graphics 1</td>
</tr>
<tr>
<td>WordPerfect Graphics 2</td>
</tr>
<tr>
<td>WordStar</td>
</tr>
<tr>
<td>WordStar 2000</td>
</tr>
<tr>
<td>WordStar 6.0</td>
</tr>
<tr>
<td>WriteNow</td>
</tr>
<tr>
<td>Writing Assistant word processor</td>
</tr>
<tr>
<td>X Bitmap (XBM)</td>
</tr>
</tbody>
</table>
Table 33-2 Formats supported for file type identification (continued)

Message Attachment or File Type Match formats

<table>
<thead>
<tr>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>X Image</td>
</tr>
<tr>
<td>X Pixmap (XPM)</td>
</tr>
<tr>
<td>Xerox 860 Comm.</td>
</tr>
<tr>
<td>Xerox Writer word processor</td>
</tr>
<tr>
<td>XHTML</td>
</tr>
<tr>
<td>XML (generic)</td>
</tr>
<tr>
<td>XML Paper Specification</td>
</tr>
<tr>
<td>XyWrite</td>
</tr>
</tbody>
</table>

Supported formats for content extraction

Symantec Data Loss Prevention cracks more than 100 file formats for performing content extraction. You use content-based detection conditions to crack a file and extract its contents.

See “Content matching conditions” on page 301.

Table 33-3 lists the various file format categories whose content Symantec Data Loss Prevention can extract. Refer to the associated link for the individual file formats supported for that category.

See “Overview of detection file format support” on page 667.

Table 33-3 Supported file format categories for content extraction

<table>
<thead>
<tr>
<th>File format category</th>
<th>Default support list</th>
</tr>
</thead>
<tbody>
<tr>
<td>Word-processing file formats</td>
<td>See “Supported word-processing formats for content extraction” on page 685.</td>
</tr>
<tr>
<td>Presentation file formats</td>
<td>See “Supported presentation formats for content extraction” on page 686.</td>
</tr>
<tr>
<td>Spreadsheet file formats</td>
<td>See “Supported spreadsheet formats for content extraction” on page 687.</td>
</tr>
<tr>
<td>Text and markup file formats</td>
<td>See “Supported text and markup formats for content extraction” on page 688.</td>
</tr>
<tr>
<td>Email file formats</td>
<td>See “Supported email formats for content extraction” on page 689.</td>
</tr>
<tr>
<td>CAD file formats</td>
<td>See “Supported CAD formats for content extraction” on page 690.</td>
</tr>
</tbody>
</table>
### Table 33-3  Supported file format categories for content extraction (continued)

<table>
<thead>
<tr>
<th>File format category</th>
<th>Default support list</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graphics file formats</td>
<td>See “Supported graphics formats for content extraction” on page 690.</td>
</tr>
<tr>
<td>Database file formats</td>
<td>See “Supported database formats for content extraction” on page 690.</td>
</tr>
<tr>
<td>Other file formats</td>
<td>See “Other file formats supported for content extraction” on page 691.</td>
</tr>
<tr>
<td>Encapsulation file formats</td>
<td>See “Supported encapsulation formats for subfile extraction” on page 691.</td>
</tr>
</tbody>
</table>

### Supported word-processing formats for content extraction

Table 33-4 lists the word-processing file formats whose content Symantec Data Loss Prevention can extract for policy evaluation.

<table>
<thead>
<tr>
<th>Format Name</th>
<th>Format Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adobe Maker Interchange Format (FrameMaker)</td>
<td>MIF</td>
</tr>
<tr>
<td>Apple iWork Pages</td>
<td>PAGES</td>
</tr>
<tr>
<td>ApplixWords</td>
<td>AW</td>
</tr>
<tr>
<td>Corel WordPerfect Linux</td>
<td>WPS</td>
</tr>
<tr>
<td>Corel WordPerfect Macintosh</td>
<td>WPS</td>
</tr>
<tr>
<td>Corel WordPerfect Windows</td>
<td>WO</td>
</tr>
<tr>
<td>Corel WordPerfect Windows</td>
<td>WPD</td>
</tr>
<tr>
<td>DisplayWrite</td>
<td>IP</td>
</tr>
<tr>
<td>Folio Flat file</td>
<td>FFF</td>
</tr>
<tr>
<td>Fujitsu Oasys</td>
<td>OA2</td>
</tr>
<tr>
<td>Haansoft Hangul</td>
<td>HWP</td>
</tr>
<tr>
<td>IBM DCA/RFT (Revisable Form Text)</td>
<td>DC</td>
</tr>
<tr>
<td>JustSystems Ichitaro</td>
<td>JTD</td>
</tr>
<tr>
<td>Lotus AMI Pro</td>
<td>SAM</td>
</tr>
<tr>
<td>Lotus AMI Professional Write Plus</td>
<td>AMI</td>
</tr>
</tbody>
</table>
Table 33-4  Supported word-processing file formats for content extraction (continued)

<table>
<thead>
<tr>
<th>Format Name</th>
<th>Format Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>LotusWord Pro</td>
<td>LWP</td>
</tr>
<tr>
<td>Lotus SmartMaster</td>
<td>MWP</td>
</tr>
<tr>
<td>Microsoft Word PC</td>
<td>DOC</td>
</tr>
<tr>
<td>Microsoft Word Windows</td>
<td>DOC</td>
</tr>
<tr>
<td>Microsoft Word Windows XML</td>
<td>DOCX</td>
</tr>
<tr>
<td>Microsoft Word Windows Template XML</td>
<td>DOTX</td>
</tr>
<tr>
<td>Microsoft Word Windows Macro-Enabled Template XML</td>
<td>DOTM</td>
</tr>
<tr>
<td>Microsoft Word Macintosh</td>
<td>DOC</td>
</tr>
<tr>
<td>Microsoft Works</td>
<td>WPS</td>
</tr>
<tr>
<td>Microsoft Windows Write</td>
<td>WRI</td>
</tr>
<tr>
<td>Microsoft OneNote</td>
<td>ONE</td>
</tr>
<tr>
<td>OpenOfficeWriter</td>
<td>SXW</td>
</tr>
<tr>
<td>OpenOfficeWriter</td>
<td>ODT</td>
</tr>
<tr>
<td>StarOfficeWriter</td>
<td>SXW</td>
</tr>
<tr>
<td>StarOfficeWriter</td>
<td>ODT</td>
</tr>
<tr>
<td>WordPad</td>
<td>RTF</td>
</tr>
<tr>
<td>XML Paper Specification</td>
<td>XPS</td>
</tr>
<tr>
<td>XyWrite</td>
<td>XY4</td>
</tr>
</tbody>
</table>

Supported presentation formats for content extraction

Table 33-5 lists the presentation file formats whose content Symantec Data Loss Prevention can extract for policy evaluation.

Table 33-5  Supported presentation formats for files content extraction

<table>
<thead>
<tr>
<th>Format Name</th>
<th>Format Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apple iWork Keynote</td>
<td>KEYNOTE</td>
</tr>
</tbody>
</table>
### Table 33-5: Supported presentation formats for files content extraction (continued)

<table>
<thead>
<tr>
<th>Format Name</th>
<th>Format Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applix Presents</td>
<td>AG</td>
</tr>
<tr>
<td>Corel Presentations</td>
<td>SHW</td>
</tr>
<tr>
<td>Lotus Freelance Graphics</td>
<td>PRZ</td>
</tr>
<tr>
<td>Lotus Freelance Graphics 2</td>
<td>PRE</td>
</tr>
<tr>
<td>Macromedia Flash</td>
<td>SWF</td>
</tr>
<tr>
<td>Microsoft PowerPoint Windows</td>
<td>PPT</td>
</tr>
<tr>
<td>Microsoft PowerPoint PC</td>
<td>PPT</td>
</tr>
<tr>
<td>Microsoft PowerPoint Windows XML</td>
<td>PPTX</td>
</tr>
<tr>
<td>Microsoft PowerPoint Windows Macro-Enabled XML</td>
<td>PPTM</td>
</tr>
<tr>
<td>Microsoft PowerPoint Windows XML Template</td>
<td>POTX</td>
</tr>
<tr>
<td>Microsoft PowerPoint Windows Macro-Enabled XML Template</td>
<td>POTM</td>
</tr>
<tr>
<td>Microsoft PowerPoint Windows XML Show</td>
<td>PPSX</td>
</tr>
<tr>
<td>Microsoft PowerPoint Windows Macro-Enabled Show</td>
<td>PPSM</td>
</tr>
<tr>
<td>Microsoft PowerPoint Macintosh</td>
<td>PPT</td>
</tr>
<tr>
<td>OpenOffice Impress</td>
<td>SXI</td>
</tr>
<tr>
<td>OpenOffice Impress</td>
<td>SXP</td>
</tr>
<tr>
<td>OpenOffice Impress</td>
<td>ODP</td>
</tr>
<tr>
<td>StarOffice Impress</td>
<td>SXI</td>
</tr>
<tr>
<td>StarOffice Impress</td>
<td>SXP</td>
</tr>
<tr>
<td>StarOffice Impress</td>
<td>ODP</td>
</tr>
</tbody>
</table>

**Supported spreadsheet formats for content extraction**

Table 33-6 lists the spreadsheet file formats whose content Symantec Data Loss Prevention can extract for policy evaluation.
### Table 33-6: Supported spreadsheet formats for file contents extraction

<table>
<thead>
<tr>
<th>Format Name</th>
<th>Format Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apple iWork Numbers</td>
<td>NUMBERS</td>
</tr>
<tr>
<td>Applix Spreadsheets</td>
<td>AS</td>
</tr>
<tr>
<td>Comma Separated Values</td>
<td>CSV</td>
</tr>
<tr>
<td>Corel Quattro Pro</td>
<td>WB2</td>
</tr>
<tr>
<td>Corel Quattro Pro</td>
<td>WB3</td>
</tr>
<tr>
<td>Data Interchange Format</td>
<td>DIF</td>
</tr>
<tr>
<td>Lotus 1-2-3</td>
<td>123</td>
</tr>
<tr>
<td>Lotus 1-2-3 Charts</td>
<td>123</td>
</tr>
<tr>
<td>Microsoft Excel Windows</td>
<td>XLS</td>
</tr>
<tr>
<td>Microsoft Excel Windows XML</td>
<td>XLSX</td>
</tr>
<tr>
<td>Microsoft Excel Charts</td>
<td>XLS</td>
</tr>
<tr>
<td>Microsoft Excel 2007 Binary</td>
<td>XLSB</td>
</tr>
<tr>
<td>Microsoft Excel Macintosh</td>
<td>XLS</td>
</tr>
<tr>
<td>Microsoft Works Spreadsheet</td>
<td>S30</td>
</tr>
<tr>
<td>Microsoft Works Spreadsheet</td>
<td>S40</td>
</tr>
<tr>
<td>OpenOffice Calc</td>
<td>SX</td>
</tr>
<tr>
<td>OpenOffice Calc</td>
<td>ODS</td>
</tr>
<tr>
<td>StarOffice Calc</td>
<td>SX</td>
</tr>
<tr>
<td>StarOffice Calc</td>
<td>ODS</td>
</tr>
</tbody>
</table>

---

**Supported text and markup formats for content extraction**

*Table 33-7* lists the text and markup file formats whose content Symantec Data Loss Prevention can extract for policy evaluation.
### Table 33-7
Supported text and markup file formats for content extraction

<table>
<thead>
<tr>
<th>Format Name</th>
<th>Format Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANSI</td>
<td>TXT</td>
</tr>
<tr>
<td>ASCII</td>
<td>TXT</td>
</tr>
<tr>
<td>HTML</td>
<td>HTM</td>
</tr>
<tr>
<td>Microsoft Excel Windows XML</td>
<td>XML</td>
</tr>
<tr>
<td>Microsoft Word Windows XML</td>
<td>XML</td>
</tr>
<tr>
<td>Microsoft Visio XML</td>
<td>VDX</td>
</tr>
<tr>
<td>Oasis Open Document Format</td>
<td>ODT</td>
</tr>
<tr>
<td>Oasis Open Document Format</td>
<td>ODS</td>
</tr>
<tr>
<td>Oasis Open Document Format</td>
<td>ODP</td>
</tr>
<tr>
<td>Rich Text Format</td>
<td>RTF</td>
</tr>
<tr>
<td>Unicode Text</td>
<td>TXT</td>
</tr>
<tr>
<td>XHTML</td>
<td>HTM</td>
</tr>
<tr>
<td>XML (generic)</td>
<td>XML</td>
</tr>
</tbody>
</table>

### Supported email formats for content extraction

Table 33-8 lists the email file formats whose content Symantec Data Loss Prevention can extract for evaluation.

### Table 33-8
Supported email file formats for content extraction

<table>
<thead>
<tr>
<th>Format Name</th>
<th>Format Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>Domino XML Language</td>
<td>DXL</td>
</tr>
<tr>
<td>EMC EmailXtender Native Message</td>
<td>ONM</td>
</tr>
<tr>
<td>Microsoft Outlook</td>
<td>MSG</td>
</tr>
<tr>
<td>Microsoft Outlook Express</td>
<td>EML</td>
</tr>
<tr>
<td>Text Mail (MIME)</td>
<td>various</td>
</tr>
<tr>
<td>Transfer Neutral Encapsulation Format</td>
<td>various</td>
</tr>
</tbody>
</table>
Supported CAD formats for content extraction

Table 33-9 lists the computer-aided design (CAD) file formats whose content Symantec Data Loss Prevention can extract for evaluation.

Table 33-9  Supported CAD file formats

<table>
<thead>
<tr>
<th>Format Name</th>
<th>Format Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>AutoCAD Drawing</td>
<td>DWG</td>
</tr>
<tr>
<td>AutoCAD Drawing Exchange</td>
<td>DFX</td>
</tr>
<tr>
<td>Microsoft Visio</td>
<td>VSD</td>
</tr>
<tr>
<td>Microstation</td>
<td>DGN</td>
</tr>
</tbody>
</table>

Supported graphics formats for content extraction

Table 33-10 lists the graphics file formats whose content Symantec Data Loss Prevention can extract for evaluation.

Table 33-10  Supported graphics file formats for content extraction

<table>
<thead>
<tr>
<th>Format Name</th>
<th>Format Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enhanced Metafile</td>
<td>EMF</td>
</tr>
<tr>
<td>Lotus Pic</td>
<td>PIC</td>
</tr>
<tr>
<td>Tagged Image File (metadata only)</td>
<td>TIFF</td>
</tr>
<tr>
<td>Windows Metafile</td>
<td>WMF</td>
</tr>
</tbody>
</table>

Supported database formats for content extraction

The following table lists the database file formats whose content Symantec Data Loss Prevention can extract for policy evaluation.

Table 33-11  Crackable database file formats

<table>
<thead>
<tr>
<th>Format Name</th>
<th>Format Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Access</td>
<td>MDB</td>
</tr>
<tr>
<td>Microsoft Project</td>
<td>MPP</td>
</tr>
</tbody>
</table>
Other file formats supported for content extraction

Table 33-12 lists other file formats whose content Symantec Data Loss Prevention can extract for policy evaluation.

<table>
<thead>
<tr>
<th>Format Name</th>
<th>Format Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adobe PDF</td>
<td>PDF</td>
</tr>
<tr>
<td>MPEG-1 Audio layer 3 (metadata only)</td>
<td>MP3</td>
</tr>
<tr>
<td>Microsoft Windows Backup Utility File</td>
<td>BKF</td>
</tr>
<tr>
<td>File Share Encryption (PGP Netshare)</td>
<td></td>
</tr>
</tbody>
</table>
|                                          | You can decrypt Symantec File Share encrypted files and extract file contents for policy evaluation using the File Share plugin. Refer to the Symantec Data Loss Prevention Encryption Insight Implementation Guide.  
|                                          | **Note:** Encryption Insight is only available with Network Discover. |
| Custom                                   |                  |
|                                          | You can write a plug-in to perform content, subfile, and metadata extraction operations on custom file formats. Refer to the Symantec Data Loss Prevention Content Extraction Plug-in Developers Guide.  
|                                          | **Note:** Content extraction plug-ins are limited to detection servers. |

Supported encapsulation formats for subfile extraction

Symantec Data Loss Prevention supports various encapsulation formats for subfile extraction, such as ZIP, RAR, and TAR. The system automatically performs subfile extraction for supported formats using content-based match conditions. Subfile extraction is a subset of content extraction in that, if the system is successful in extracting a subfile from a supported encapsulated file, the system automatically extracts the text-based subfile contents if the subfile format is supported for content extraction.

See “Overview of detection file format support” on page 667.

Table 33-13 lists the file formats whose content Symantec Data Loss Prevention can extract for content evaluation.
Table 33-13   Supported encapsulation formats for subfile extraction

<table>
<thead>
<tr>
<th>Format Name</th>
<th>Format Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>7-Zip</td>
<td>7Z</td>
</tr>
<tr>
<td>BinHex</td>
<td>HQX</td>
</tr>
<tr>
<td>GZIP</td>
<td>GZ</td>
</tr>
<tr>
<td>Java Archive</td>
<td>JAR</td>
</tr>
<tr>
<td>Microsoft Cabinet</td>
<td>CAB</td>
</tr>
<tr>
<td>Microsoft Compressed Folder</td>
<td>LZH</td>
</tr>
<tr>
<td>Microsoft Compressed Folder</td>
<td>LHA</td>
</tr>
<tr>
<td>PKZIP</td>
<td>ZIP</td>
</tr>
<tr>
<td>WinZip</td>
<td>ZIP</td>
</tr>
<tr>
<td>RAR archive</td>
<td>RAR</td>
</tr>
<tr>
<td>Tape Archive</td>
<td>TAR</td>
</tr>
<tr>
<td>UNIX Compress</td>
<td>Z</td>
</tr>
<tr>
<td>UUEncoding</td>
<td>UUE</td>
</tr>
<tr>
<td>YENC</td>
<td>YENC (server only)</td>
</tr>
</tbody>
</table>

Supported file formats for metadata extraction

Table 33-14 lists some of the file formats that Symantec Data Loss Prevention supports for metadata detection, and provides some example metadata fields returned for those formats.

This list is not exhaustive and is provided for quick reference only. Other file formats may be supported, and other custom fields may be returned. The best practice is to always use the filter utility to verify metadata support for each file format you want to detect.

See “Always use the filter utility to verify file format metadata support” on page 695.
Table 33-14  Supported file formats for metadata detection

<table>
<thead>
<tr>
<th>File formats</th>
<th>Metadata</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Office documents, for example:</td>
<td>For Microsoft Office documents, the system extracts Object Linking and Embedding (OLE) metadata.</td>
<td>Example fields:</td>
</tr>
<tr>
<td>■ Word (DOC, DOCX)</td>
<td></td>
<td>■ Title</td>
</tr>
<tr>
<td>■ Excel (XLS, XLSX)</td>
<td></td>
<td>■ Subject</td>
</tr>
<tr>
<td>■ PowerPoint (PPT, PPTX)</td>
<td></td>
<td>■ Author</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Keywords</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Other custom fields</td>
</tr>
<tr>
<td>Adobe PDF files</td>
<td>For Adobe PDF files, the system extracts Document Information Dictionary (DID) metadata. The system does not support Adobe Extensible Metadata Platform (XMP) metadata extraction.</td>
<td>Example fields:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Author</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Title</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Subject</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Creation</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Update dates</td>
</tr>
<tr>
<td>Other file formats (including binary and text)</td>
<td>Use the filter utility to verify metadata extraction for other file formats.</td>
<td>See “Always use the filter utility to verify file format metadata support” on page 695.</td>
</tr>
<tr>
<td>Custom file formats</td>
<td>Custom file type metadata</td>
<td>Content extraction plug-in that supports the metadata extraction operation.</td>
</tr>
</tbody>
</table>

About document metadata detection

In addition to file content and subfile extraction, Symantec Data Loss Prevention supports metadata extraction for many file formats. File format metadata is data about a file that is stored as file properties. By default metadata extraction is disabled because it can lead to false positives. Used properly, metadata detection can enhance the accuracy of your content-based policy rules.

For example, consider a business that uses Microsoft Office templates for their Word, Excel, and PowerPoint documents. The business applies Microsoft OLE metadata properties in the form of keywords to each template. The business has enabled metadata extraction and deployed keyword policies to match on metadata keywords. These policies can detect keywords in documents that are derived from the templates. The business also has the flexibility to use policy exceptions to avoid generating incidents if certain metadata keywords are present.
Enabling server metadata detection

By default metadata extraction is disabled for detection servers.

To enable server metadata extraction

1. Log on to the Enforce Server administration console as a system administrator.
2. Navigate to the System > Servers > Overview > Server Detail screen for the detection server you want to enable metadata extraction.
3. Click the Server Settings button.
4. Locate property ContentExtraction.EnableMetadata in the list.
5. Enter the value on for this property to enable metadata extraction.
6. Click Save to save the configuration.
7. Click Recycle the server at the Server Detail screen to restart the server.
8. Click Done at the Server Detail screen to complete the process.

Enabling endpoint metadata detection

By default metadata extraction is disabled for endpoints.

To enable endpoint metadata extraction

1. Log on to the Enforce Server administration console as a system administrator.
2. Navigate to the System > Agents > Agent Configuration screen for the endpoint server you want to enable metadata extraction.
3. Create a new endpoint configuration for metadata detection, or select the default configuration.
   See “Create a separate endpoint configuration for metadata detection” on page 699.
4. Select the Advanced Agent Settings tab.
5. Locate property Detection.ENABLE_METADATA.str in the list.
6. Enter the value on for this property to enable metadata extraction.
7. Click Save and Apply to save the configuration change.

Best practices for using metadata detection

Best practices for using metadata detection lists best practices for implementing metadata detection with links to corresponding topics for detailed considerations.
Table 33-15 Considerations for implementing metadata detection

<table>
<thead>
<tr>
<th>Consideration</th>
<th>Topic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Always use filter to verify file format metadata support.</td>
<td>See “Always use the filter utility to verify file format metadata support” on page 695.</td>
</tr>
<tr>
<td>Enable metadata detection only if it is necessary.</td>
<td>See “Distinguish metadata from file content and application data” on page 697.</td>
</tr>
<tr>
<td>Avoid generating false positives by selecting keywords carefully.</td>
<td>See “Use and tune keyword lists to avoid false positives on metadata” on page 699.</td>
</tr>
<tr>
<td>Understand resource implications of endpoint metadata extraction.</td>
<td>See “Understand performance implications of enabling endpoint metadata detection” on page 699.</td>
</tr>
<tr>
<td>Create a separate endpoint configuration for metadata detection.</td>
<td>See “Create a separate endpoint configuration for metadata detection” on page 699.</td>
</tr>
<tr>
<td>Use response rules to add metadata tags to incidents.</td>
<td>See “Use response rules to tag incidents with metadata” on page 699.</td>
</tr>
</tbody>
</table>

Always use the filter utility to verify file format metadata support

To help you create policies that detect file format metadata, use the filter utility that is available with any Symantec Data Loss Prevention detection or Endpoint Server installation. This utility provides an easy way to determine which metadata fields the system returns for a given file format. The utility generates output that contains the metadata the system will extract at runtime for each file format you test using filter.

To verify file format metadata extraction support using filter describes how to use the filter utility. It is recommended that you always follow this process so that you can create and tune policies that accurately detect file format metadata.

Note: The data output by the filter utility is in ASCII format. Symantec Data Loss Prevention processes data in Unicode format. Therefore, you may rely on the existence of the fields returned by the filter utility, but the metadata detected by Symantec Data Loss Prevention may not look identical to the filter output.
To verify file format metadata extraction support using filter

1. On the file system where a detection server is installed, start a command prompt session.

2. Change directory to where the filter utility is located.
   For example, on a default 64-bit Windows installation you would issue the following command:
   ```
   cd \SymantecDLP\Protect\plugins\contentextraction\Verity\x64
   ```

3. Issue the following command to run the filter program and display its syntax and optional parameters.
   ```
   filter -help
   ```
   As indicated by the help, you use the following syntax to execute the filter utility:
   ```
   filter [options] inputfile outputfile
   ```
   The inputfile is an instance of the file format you want to verify. The outputfile is a file the filter utility writes the extracted data to.

   Note the following extraction options:
   - To verify metadata extraction, use the "get doc summary info" option:
   ```
   -i
   ```
   - To verify content extraction, use no options:
   ```
   filter inputfile outputfile
   ```

4. Execute filter against an instance of the file format to verify metadata extraction.
   For example, on Windows you would issue the following command:
   ```
   filter -i \temp\myfile.doc \temp\metadata_output.txt
   ```
   Where `myfile.doc` is a file containing metadata you want to verify and have copied to the \temp directory, and `metadata_output.txt` is the name of the file you want the system to generate and write the extracted data to.

5. Review the filter output. The output data should be similar to the following:
   ```
   1 2 1252 CodePage 1 1 "S" Title 0 0 (null) 1 1 "P" Author 0 0 (null) 0 0 (null) 0 1 "" (null) 1 1 "m" LastAuthor 1 1 "1" RevNumber 1 3 6300 Minutes EditTime 1 3 Mon Aug 27 11:53:07 2007 LastPrinted
   ```

6. Refer to the following tables for an explanation of each metadata extraction field output by the filter utility.
   - Table 33-16 repeats the output from Step 5, formatted for readability.
   - Table 33-17 explains each column field.
Table 33-16  Example filter metadata output

<table>
<thead>
<tr>
<th>Column 1</th>
<th>Column 2</th>
<th>Column 3</th>
<th>Column 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
<td>1252</td>
<td>CodePage</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>&quot;S&quot;</td>
<td>Title</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>(null)</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>&quot;P&quot;</td>
<td>Author</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>(null)</td>
<td></td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>(null)</td>
<td></td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>&quot;&quot;</td>
<td>(null)</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>&quot;m&quot;</td>
<td>LastAuthor</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>&quot;1&quot;</td>
<td>RevNumber</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>6300 Minutes</td>
<td>EditTime</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>Mon Aug 27 11:53:07 2007</td>
<td>LastPrinted</td>
</tr>
</tbody>
</table>

Table 33-17  Metadata fields generated by the filter utility

<table>
<thead>
<tr>
<th>Column 1</th>
<th>Column 2</th>
<th>Column 3</th>
<th>Column 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 = valid field</td>
<td>0 = invalid field</td>
<td>The type of data:</td>
<td>The data payload for the field.</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>3</td>
<td>5</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>3</td>
<td>5</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>3</td>
<td>5</td>
</tr>
<tr>
<td>Note: You may ignore rows where the first column is 0.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Distinguish metadata from file content and application data

Do not confuse metadata extraction with content extraction or application data. Some text that may appear to be metadata is extracted as content or application data. Table 33-18 describes some types of data that is not extracted as file format metadata to help you determine if and when you need to enable metadata detection.
**Note:** This list is not exhaustive and is provided for quick reference only. There may be other types of data that are not extracted as metadata. The best practice is to use the *filter* utility to verify file format metadata support. See "Always use the filter utility to verify file format metadata support" on page 695.

<table>
<thead>
<tr>
<th>Content type</th>
<th>Extraction method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application data</td>
<td>Application data including message transport information is extracted separately from file format extraction. For all inbound messages, the system extracts message envelope (header) and subject information as text at the application layer. The type of application data that is extracted depends on the channels supported by the detection server or endpoint.</td>
</tr>
<tr>
<td>Headers and footers</td>
<td>Document header and footer text is extracted as content, not metadata. To avoid false positives, it is recommended that you remove or whitelist headers and footers from documents. See &quot;Use whitelisting to exclude non-sensitive content from partial matching&quot; on page 503. See the Indexed Document Matching (IDM) chapter in the Symantec Data Loss Prevention Administration Guide for details.</td>
</tr>
<tr>
<td>Markup text</td>
<td>Markup text is extracted as content, not metadata. Markup text extraction is supported for HTML, XML, SGML, and more. Markup text extraction is disabled by default. See “Advanced server settings” on page 203. See “Advanced agent settings” on page 1414. See the &quot;Advanced Server Settings&quot; topic in the Symantec Data Loss Prevention Administration Guide to enable it.</td>
</tr>
<tr>
<td>Hidden text</td>
<td>Hidden text is extracted as content, not metadata. Hidden text extraction in the form of tracked changes is supported for some Microsoft Office file formats. Hidden text extraction is disabled by default. See “Advanced server settings” on page 203. See “Advanced agent settings” on page 1414. See the &quot;Advanced Server Settings&quot; topic in the Symantec Data Loss Prevention Administration Guide to enable it.</td>
</tr>
<tr>
<td>Watermarks</td>
<td>Text-based watermarks are extracted as content, not metadata. Text-based watermark detection is supported for Microsoft Word documents (versions 2003 and 2007). It is not supported for other file formats.</td>
</tr>
</tbody>
</table>
Use and tune keyword lists to avoid false positives on metadata

Enabling metadata extraction can cause false positives because more text is checked for a match. For example, if you have a policy that detects keywords and metadata extraction is enabled, the policy reports a match if a keyword is present in the content or in the metadata. Once the system has extracted the content and the metadata, the text is normalized and streamed to the detection component for matching. The detection component has no knowledge of the source of the text, whether it is application data, content, or metadata.

To detect file format metadata, you define keyword conditions for rules or exceptions that contain keywords that are specific to one or more file formats. To avoid generating false positives, clearly define the keyword lists in your policies. The keywords you use to detect metadata should be unique and distinct from keywords or phrases you use to detect content. Test and tune keyword lists to improve metadata detection accuracy.

Understand performance implications of enabling endpoint metadata detection

On the endpoint, enabling metadata extraction does not add overhead if no content rules are deployed. If content rules are deployed to the endpoint, enabling metadata extraction may introduce minor overhead because there is extra data to inspect. Test and tune your endpoint policy keyword lists to ensure that metadata detection is efficient.

Create a separate endpoint configuration for metadata detection

When you enable endpoint metadata detection, consider creating a custom endpoint configuration specifically for metadata detection. By doing so you can easily revert to the default configuration if necessary.

Use response rules to tag incidents with metadata

You cannot use metadata detection to apply tags to inbound files or documents that generate incidents. If this is desired, consider using a FlexResponse plug-in. See “About response rules” on page 875. See the Symantec Data Loss Prevention Administration Guide for details.
Library of system data identifiers

This chapter includes the following topics:

- Library of system data identifiers
- ABA Routing Number data identifier
- Australian Medicare Number data identifier
- Australian Tax File Number data identifier
- Burgerservicenummer data identifier
- Canadian Social Insurance Number data identifier
- Codice Fiscale data identifier
- Credit Card Magnetic Stripe Data data identifier
- Credit Card Number data identifier
- CUSIP Number data identifier
- Drivers License Number – CA State data identifier
- Drivers License Number - FL, MI, MN States data identifier
- Drivers License Number - IL State data identifier
- Drivers License Number - NJ State data identifier
- Drivers License Number - NY State data identifier
- French INSEE Code data identifier
- Hong Kong ID data identifier
- IBAN Central data identifier
- IBAN East data identifier
- IBAN West data identifier
- IP Address data identifier
- National Drug Code (NDC) data identifier
- People’s Republic of China ID data identifier
- Randomized US Social Security Number (SSN) data identifier
- Singapore NRIC data identifier
- South Korea Resident Registration Number data identifier
- Spanish DNI ID data identifier
- SWIFT Code data identifier
- Swiss AHV Number data identifier
- Taiwan ID data identifier
- UK Drivers License Number data identifier
- UK Electoral Roll Number data identifier
- UK National Health Service (NHS) Number data identifier
- UK National Insurance Number data identifier
- UK Passport Number data identifier
- UK Tax ID Number data identifier
- US Individual Tax Identification Number (ITIN) data identifier
- US Social Security Number (SSN) data identifier

Library of system data identifiers

This section lists all data identifiers provided by the Data Loss Prevention system.
ABA Routing Number data identifier

The American Banking Association (ABA) routing number, also known as a routing transit number (RTN), is used to identify financial institutions and process transactions.

The ABA Routing Number data identifier detects 9-digit numbers and provides three breadths of detection:

- The wide breadth edition validates the detected number using the final check digit. See “ABA Routing Number wide breadth” on page 704.
- The medium breadth edition validates the detected number using the final check digit and eliminates common test numbers. See “ABA Routing Number medium breadth” on page 705.
- The narrow breadth edition validates the detected number using the final check digit, eliminates common test numbers, and requires the presence of an ABA-related keyword. See “ABA Routing Number narrow breadth” on page 705.

ABA Routing Number wide breadth

The wide breadth edition of the ABA Routing Number data identifier detects 9-digit numbers. It validates the number using the final check digit.

Table 34-1 ABA Routing Number wide breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>[0123678][d(8)]</td>
</tr>
<tr>
<td>[0123678][d(3)-\d(4)-\d]</td>
</tr>
</tbody>
</table>

Table 34-2 ABA Routing Number wide breadth validators

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABA Checksum</td>
<td>Every ABA routing number must start with the following two digits: 00-15,21-32,61-72,80 and pass an ABA specific, position-weighted check sum.</td>
</tr>
</tbody>
</table>

ABA Routing Number medium breadth

The medium breadth edition of the ABA Routing number DI detects 9-digit numbers. It validates the number using the final check digit.
It eliminates common test numbers, such as 123456789, ranges reserved for future use, and all the same digit.

**Table 34-3**  ABA Routing Number medium breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>[0123678]\d{8}</td>
</tr>
<tr>
<td>[0123678]\d{3}-\d{4}-\d</td>
</tr>
</tbody>
</table>

**Table 34-4**  ABA Routing Number medium breadth validators

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABA Checksum</td>
<td>Every ABA routing number must start with the following two digits: 00-15, 21-32, 61-72, 80 and pass an ABA specific, position-weighted check sum.</td>
</tr>
<tr>
<td>Exclude beginning characters</td>
<td>With this option selected, data beginning with any of the following list of values will not be matched. Input: 123456789</td>
</tr>
<tr>
<td>Duplicate digits</td>
<td>Ensures that a string of digits are not all the same.</td>
</tr>
<tr>
<td>Number delimiter</td>
<td>Validates a match by checking the surrounding numbers.</td>
</tr>
</tbody>
</table>

ABA Routing Number narrow breadth

The narrow breadth edition of the ABA Routing number data identifier detects 9-digit numbers and validates the number using the final check digit. It eliminates common test numbers, such as 123456789, ranges reserved for future use, and all the same digit. It also requires the presence of an ABA-related keyword.

**Table 34-5**  ABA Routing Number narrow breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>[0123678]\d{8}</td>
</tr>
<tr>
<td>[0123678]\d{3}-\d{4}-\d</td>
</tr>
</tbody>
</table>

|
### ABA Routing Number narrow breadth validators

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABA Checksum</td>
<td>Every ABA routing number must start with the following two digits: 00-15, 21-32, 61-72, 80 and pass an ABA specific, position-weighted checksum.</td>
</tr>
<tr>
<td>Exclude beginning characters</td>
<td>With this option selected, data beginning with any of the following list of values will not be matched. Input: 123456789</td>
</tr>
<tr>
<td>Duplicate digits</td>
<td>Ensures that a string of digits are not all the same.</td>
</tr>
<tr>
<td>Find keywords</td>
<td>With this option selected, at least one of the following keywords or key phrases must be present for the data to be matched. Input: aba, aba #, aba routing #, aba routing number, aba#, abarouting#, abaroutingnumber, american bank association routing #, american bank association routing number, americanbankassociationrouting#, americanbankassociationroutingnumber, bank routing #, bank routing number, bankrouting#, bankroutingnumber</td>
</tr>
<tr>
<td>Number delimiter</td>
<td>Validates a match by checking the surrounding numbers.</td>
</tr>
</tbody>
</table>

### ABA Routing Number wide breadth

The wide breadth edition of the ABA Routing Number data identifier detects 9-digit numbers. It validates the number using the final check digit.

<table>
<thead>
<tr>
<th>Pattern</th>
<th>ABA Routing Number wide breadth patterns</th>
</tr>
</thead>
<tbody>
<tr>
<td>[0123678]\d{8}</td>
<td></td>
</tr>
<tr>
<td>[0123678]\d{3}-\d{4}-\d</td>
<td></td>
</tr>
</tbody>
</table>

### ABA Routing Number wide breadth validators

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABA Checksum</td>
<td>Every ABA routing number must start with the following two digits: 00-15, 21-32, 61-72, 80 and pass an ABA specific, position-weighted check sum.</td>
</tr>
</tbody>
</table>
ABA Routing Number medium breadth

The medium breadth edition of the ABA Routing number DI detects 9-digit numbers. It validates the number using the final check digit. It eliminates common test numbers, such as 123456789, ranges reserved for future use, and all the same digit.

Table 34-9  ABA Routing Number medium breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>[0123678]d{8}</td>
</tr>
<tr>
<td>[0123678]d{3}-d{4}-d</td>
</tr>
</tbody>
</table>

Table 34-10  ABA Routing Number medium breadth validators

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABA Checksum</td>
<td>Every ABA routing number must start with the following two digits: 00-15,21-32,61-72,80 and pass an ABA specific, position-weighted check sum.</td>
</tr>
<tr>
<td>Exclude beginning characters</td>
<td>With this option selected, data beginning with any of the following list of values will not be matched.</td>
</tr>
<tr>
<td></td>
<td>Input: 123456789</td>
</tr>
<tr>
<td>Duplicate digits</td>
<td>Ensures that a string of digits are not all the same.</td>
</tr>
<tr>
<td>Number delimiter</td>
<td>Validates a match by checking the surrounding numbers.</td>
</tr>
</tbody>
</table>

ABA Routing Number narrow breadth

The narrow breadth edition of the ABA Routing number data identifier detects 9-digit numbers and validates the number using the final check digit. It eliminates common test numbers, such as 123456789, ranges reserved for future use, and all the same digit. It also requires the presence of an ABA-related keyword.

Table 34-11  ABA Routing Number narrow breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>[0123678]d{8}</td>
</tr>
<tr>
<td>[0123678]d{3}-d{4}-d</td>
</tr>
</tbody>
</table>
**Table 34-12** ABA Routing Number narrow breadth validators

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABA Checksum</td>
<td>Every ABA routing number must start with the following two digits: 00-15, 21-32, 61-72, 80 and pass an ABA specific, position-weighted checksum.</td>
</tr>
<tr>
<td>Exclude beginning characters</td>
<td>With this option selected, data beginning with any of the following list of values will not be matched. Input: 123456789</td>
</tr>
<tr>
<td>Duplicate digits</td>
<td>Ensures that a string of digits are not all the same.</td>
</tr>
<tr>
<td>Find keywords</td>
<td>With this option selected, at least one of the following keywords or key phrases must be present for the data to be matched. Input:</td>
</tr>
<tr>
<td></td>
<td>aba, aba #, aba routing #, aba routing number, aba#, abarouting#, abaroutingnumber, american bank association routing #, american bank association routing number,</td>
</tr>
<tr>
<td></td>
<td>americanbankassociationrouting#, americanbankassociationroutingnumber, bank routing #, bank routing number, bankrouting#, bankroutingnumber</td>
</tr>
<tr>
<td>Number delimiter</td>
<td>Validates a match by checking the surrounding numbers.</td>
</tr>
</tbody>
</table>

**Australian Medicare Number data identifier**

The Australian Medicare Number is a personal identifier allocated by the Australian Health Insurance Commission to eligible persons under the Medicare scheme. This number appears on the Australian Medicare card.

The Australian Medicare Number data identifier detects an 8- or 9-digit number that matches the format of the Australian Medicare Number. This data identifier does not implement any validators.

**Table 34-13** Australian Medicare Number wide breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{4} \d{5} \d \d</td>
</tr>
<tr>
<td>\d{4}-\d{5}-\d-\d</td>
</tr>
</tbody>
</table>
Australian Tax File Number data identifier

The Australian Tax File Number (TFN) is an 8- or 9-digit number issued by the Australian Taxation Office (ATO) to taxpayers (individual, company, superannuation fund, partnership or trust) to identify their Australian tax dealings.

The Australian Tax File Number data identifier detects an 8- or 9-digit number and ensures that the detected number passes checksum validation.

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{8}</td>
<td></td>
</tr>
<tr>
<td>\d{9}</td>
<td></td>
</tr>
</tbody>
</table>

Table 34-15  Australian Tax File Number wide breadth validator

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Australian Tax File validation check</td>
<td>Computes the checksum and validates the pattern against it.</td>
</tr>
</tbody>
</table>

Burgerservicenummer data identifier

In the Netherlands, the burgerservicenummer is used to uniquely identify citizens and is printed on driving licenses, passports and international ID cards under the header Personal Number.

The Burgerservicenummer data identifier detects an 8- or 9-digit number that passes checksum validation.

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{9}</td>
<td></td>
</tr>
</tbody>
</table>

Table 34-17  Burgerservicenummer wide breadth validator

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Burgerservicenummer Check</td>
<td>Burgerservicenummer Check.</td>
</tr>
</tbody>
</table>
Canadian Social Insurance Number data identifier

The Canadian Social Insurance Number (SIN) is a personal identification number issued by Human Resources and Skills Development Canada primarily for administering national pension and employment plans.

The Canadian Social Insurance Number data identifier provides three breadths of detection:

- **Wide**
  
  See “Canadian Social Insurance Number wide breadth” on page 710.

- **Medium**
  
  See “Canadian Social Insurance Number medium breadth” on page 711.

- **Narrow**
  
  See “Canadian Social Insurance Number narrow breadth” on page 711.

Canadian Social Insurance Number wide breadth

The wide breadth Canadian Social Insurance Number DI detects 9-digit numbers with the format DDD-DDD-DDD separated by dashes, spaces, periods, slashes, or without separators. Performs Luhn check validation.

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{3}\d{3}\d{3}</td>
<td>\d{9}</td>
</tr>
<tr>
<td>\d{3}/\d{3}/\d{3}</td>
<td>\d{3}.\d{3}.\d{3}</td>
</tr>
<tr>
<td>\d{3}\d{3}\d{3}</td>
<td>\d{3}.\d{3}\d{3}</td>
</tr>
<tr>
<td>\d{3}-\d{3}-\d{3}</td>
<td></td>
</tr>
</tbody>
</table>

Table 34-18  Canadian Social Insurance Number wide breadth patterns

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Luhn Check</td>
<td>Validator computes the Luhn checksum which every Canadian Insurance Number must pass.</td>
</tr>
</tbody>
</table>
Canadian Social Insurance Number medium breadth

The medium breadth Canadian Social Insurance Number DI detects 9-digit numbers with the format DDD-DDD-DDD separated by dashes, spaces, or periods. It performs Luhn check validation and eliminates non-assigned numbers and common test numbers.

Table 34-20 Canadian Social Insurance Number medium breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{3} \d{3} \d{3}</td>
</tr>
<tr>
<td>\d{3}.\d{3}.\d{3}</td>
</tr>
<tr>
<td>\d{3}-\d{3}-\d{3}</td>
</tr>
</tbody>
</table>

Table 34-21 Canadian Social Insurance Number medium breadth validators

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Luhn Check</td>
<td>Validator computes the Luhn checksum which every Canadian Insurance Number must pass.</td>
</tr>
<tr>
<td>Number delimiter</td>
<td>Validates a match by checking the surrounding numbers.</td>
</tr>
<tr>
<td>Exclude beginning characters</td>
<td>With this option selected, data beginning with any of the following list of values will not be matched.</td>
</tr>
<tr>
<td></td>
<td>Input: 8, 123456789</td>
</tr>
</tbody>
</table>

Canadian Social Insurance Number narrow breadth

The narrow breadth Canadian Social Insurance Number DI detects 9-digit numbers with the format DDD-DDD-DDD separated by dashes or spaces. Performs Luhn check validation. Eliminates non-assigned numbers, fictitiously assigned numbers, and common test numbers. Requires the presence of a Social Insurance-related keyword.

Table 34-22 Canadian Social Insurance Number narrow breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{3} \d{3} \d{3}</td>
</tr>
<tr>
<td>\d{3}-\d{3}-\d{3}</td>
</tr>
</tbody>
</table>
Canadian Social Insurance Number narrow breadth validators

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Luhn Check</td>
<td>Validator computes the Luhn checksum which every Canadian Insurance Number must pass.</td>
</tr>
<tr>
<td>Number delimiter</td>
<td>Validates a match by checking the surrounding numbers.</td>
</tr>
<tr>
<td>Exclude beginning characters</td>
<td>With this option selected, data beginning with any of the following list of values will not be matched.</td>
</tr>
<tr>
<td></td>
<td>Input: 0, 8, 123456789</td>
</tr>
<tr>
<td>Find keywords</td>
<td>With this option selected, at least one of the following keywords or key phrases must be present for the data to be matched.</td>
</tr>
<tr>
<td></td>
<td>Inputs: pension, pensions, soc ins, ins #, social ins, CSIN, SSN, social security, social insurance, Canada, Canadian</td>
</tr>
</tbody>
</table>

Canadian Social Insurance Number wide breadth

The wide breadth Canadian Social Insurance Number DI detects 9-digit numbers with the format DDD-DDD-DDD separated by dashes, spaces, periods, slashes, or without separators. Performs Luhn check validation.

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{3} \d{3} \d{3}</td>
<td></td>
</tr>
<tr>
<td>\d{9}</td>
<td></td>
</tr>
<tr>
<td>\d{3}\d{3}\d{3}</td>
<td></td>
</tr>
<tr>
<td>\d{3}.\d{3}.\d{3}</td>
<td></td>
</tr>
<tr>
<td>\d{3}-\d{3}-\d{3}</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table 34-25</th>
<th>Canadian Social Insurance Number wide breadth validator</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mandatory validator</td>
<td>Description</td>
</tr>
<tr>
<td>Luhn Check</td>
<td>Validator computes the Luhn checksum which every Canadian Insurance Number must pass.</td>
</tr>
</tbody>
</table>
Canadian Social Insurance Number medium breadth

The medium breadth Canadian Social Insurance Number DI detects 9-digit numbers with the format DDD-DDD-DDD separated by dashes, spaces, or periods. It performs Luhn check validation and eliminates non-assigned numbers and common test numbers.

<table>
<thead>
<tr>
<th>Table 34-26</th>
<th>Canadian Social Insurance Number medium breadth patterns</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pattern</strong></td>
<td></td>
</tr>
<tr>
<td>\d{3} \d{3} \d{3}</td>
<td></td>
</tr>
<tr>
<td>\d{3}.\d{3}.\d{3}</td>
<td></td>
</tr>
<tr>
<td>\d{3}-\d{3}-\d{3}</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table 34-27</th>
<th>Canadian Social Insurance Number medium breadth validators</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mandatory validator</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Luhn Check</td>
<td>Validator computes the Luhn checksum which every Canadian Insurance Number must pass.</td>
</tr>
<tr>
<td>Number delimiter</td>
<td>Validates a match by checking the surrounding numbers.</td>
</tr>
<tr>
<td>Exclude beginning characters</td>
<td>With this option selected, data beginning with any of the following list of values will not be matched.</td>
</tr>
<tr>
<td></td>
<td>Input: 8, 123456789</td>
</tr>
</tbody>
</table>

Canadian Social Insurance Number narrow breadth

The narrow breadth Canadian Social Insurance Number DI detects 9-digit numbers with the format DDD-DDD-DDD separated by dashes or spaces. Performs Luhn check validation. Eliminates non-assigned numbers, fictitiously assigned numbers, and common test numbers. Requires the presence of a Social Insurance-related keyword.

<table>
<thead>
<tr>
<th>Table 34-28</th>
<th>Canadian Social Insurance Number narrow breadth patterns</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pattern</strong></td>
<td></td>
</tr>
<tr>
<td>\d{3} \d{3} \d{3}</td>
<td></td>
</tr>
<tr>
<td>\d{3}-\d{3}-\d{3}</td>
<td></td>
</tr>
</tbody>
</table>
Table 34-29  
Canadian Social Insurance Number narrow breadth validators

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Luhn Check</td>
<td>Validator computes the Luhn checksum which every Canadian Insurance Number must pass.</td>
</tr>
<tr>
<td>Number delimiter</td>
<td>Validates a match by checking the surrounding numbers.</td>
</tr>
</tbody>
</table>
| Exclude beginning characters| With this option selected, data beginning with any of the following list of values will not be matched.  
Input: 0, 8, 123456789 |
| Find keywords               | With this option selected, at least one of the following keywords or key phrases must be present for the data to be matched.  
Inputs: pension, pensions, soc ins, ins #, social ins, CSIN, SSN, social security, social insurance, Canada, Canadian |

Codice Fiscale data identifier

In Italy the codice fiscale is issued to every Italian at birth. The codice fiscale uniquely identifies an Italian citizen or permanent resident alien and issuance of the code is centralized to the Ministry of Treasure.

The Codice Fiscale data identifier detects a 16 character identifier. The final character must match a checksum algorithm.

Table 34-30  
Codice Fiscale wide breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>[A-Z][0-9LMNPQRSTUV][2][ABCDEHLMPRST][0-9LMNPQRSTUV][2][A-Z] [0-9LMNPQRSTUV][3][A-Z]</td>
</tr>
<tr>
<td>[A-Z][3][A-Z][3][0-9LMNPQRSTUV][2][ABCDEHLMPRST][0-9LMNPQRSTUV][2][A-Z][0-9LMNPQRSTUV][3][A-Z]</td>
</tr>
</tbody>
</table>

Table 34-31  
Codice Fiscale wide breadth validator

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Codice Fiscale Control Key Check</td>
<td>Computes the control key and checks if it is valid.</td>
</tr>
</tbody>
</table>
Credit Card Magnetic Stripe Data data identifier

The magnetic stripe of a credit card contains information about the card. Storage of the complete version of this data is a violation of the Payment Card Industry (PCI) Data Security Standard.

The Credit Card Magnetic Stripe Data data identifier detects the following raw data taken from the credit card magnetic stripe:

- Data from track 1, format B, which typically contains account number, name, expiration date, and possibly Card Verification Value or Card Verification Code 1 (CVV1/CVC1).

- Data from track 2, which typically contains account number and possibly expiration date, service code and Card Verification Value or Card Verification Code 1 (CVV1/CVC1)

The Credit Card Magnetic Stripe data identifier detects the characteristic data pattern for track 2 data which contains the start sentinel, format code, primary account number, name, expiration date, service code, discretionary data, and the end sentinel. It also includes standard field separators. It validates the data using a Luhn check validator.
<table>
<thead>
<tr>
<th>Pattern</th>
<th>Pattern (continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>;1800\d{11} =</td>
<td>%B3[068]\d{12}^[A-Z][1]</td>
</tr>
<tr>
<td>;6011-\d{4}-\d{4}\d{4} =</td>
<td>%B3[068]\d{2} \d{6}\d{4}^[A-Z][1]</td>
</tr>
<tr>
<td>;6011 \d{4} \d{4}\d{4} =</td>
<td>%B3[068]\d{2}-\d{6}-\d{4}^[A-Z][1]</td>
</tr>
<tr>
<td>;6011\d{12} =</td>
<td>%B4\d{12}^[A-Z][1]</td>
</tr>
<tr>
<td>;3[068]\d{12} =</td>
<td>%B3[47]\d{2}-\d{6}-\d{5}^[A-Z][1]</td>
</tr>
<tr>
<td>;3[068]\d{2}\d{6}\d{4} =</td>
<td>%B4\d{3} \d{4}\d{4}\d{4}^[A-Z][1]</td>
</tr>
<tr>
<td>;3[068]\d{2}-\d{6}-\d{5} =</td>
<td>%B3[47]\d{2}\d{6}\d{4}\d{5}^[A-Z][1]</td>
</tr>
<tr>
<td>;4\d{12} =</td>
<td>%B4\d{15}^[A-Z]^1</td>
</tr>
<tr>
<td>;3[47]\d{2}-\d{6}-\d{5} =</td>
<td>%B3[47]\d{13}^[A-Z][1]</td>
</tr>
<tr>
<td>;4\d{3} \d{4} \d{4} \d{4} =</td>
<td>%B5[1-5]\d{2}-\d{4}\d{4}\d{4}^[A-Z][1]</td>
</tr>
<tr>
<td>;3[47]\d{2} \d{6} \d{5} =</td>
<td>%B4\d{3}-\d{4}\d{4}\d{4}^[A-Z][1]</td>
</tr>
<tr>
<td>;4\d{15} = ;3[47]\d{13} =</td>
<td>%B5[1-5]\d{2} \d{4}\d{4}\d{4}^[A-Z][1]</td>
</tr>
<tr>
<td>;5[1-5]\d{2}-\d{4}-\d{4}\d{4} =</td>
<td>%B5[1-5]\d{14}^[A-Z][1]</td>
</tr>
<tr>
<td>;4\d{3}-\d{4}\d{4}\d{4} =</td>
<td>%B2131\d{11}^[A-Z][1]</td>
</tr>
<tr>
<td>;5[1-5]\d{2} \d{4}\d{4}\d{4} =</td>
<td>%B3\d{3}-\d{4}\d{4}\d{4}^[A-Z][1]</td>
</tr>
<tr>
<td>;5[1-5]\d{14} = ;2131\d{11} =</td>
<td>%B3\d{3}\d{4}\d{4}\d{4}^[A-Z][1]</td>
</tr>
<tr>
<td>;3\d{3}-\d{4}\d{4}\d{4} =</td>
<td>%B3\d{15}^[A-Z][1]</td>
</tr>
<tr>
<td>;3\d{3}\d{4}\d{4}\d{4} =</td>
<td>%B2149\d{11}^[A-Z][1]</td>
</tr>
<tr>
<td>;3\d{15} =</td>
<td>%B2149 \d{6} \d{5}^[A-Z][1]</td>
</tr>
<tr>
<td>;2149\d{11} =</td>
<td>%B2149-\d{6}-\d{5}^[A-Z][1]</td>
</tr>
<tr>
<td>;2149 \d{6} \d{5} =</td>
<td>%B2014\d{11}^[A-Z][1]</td>
</tr>
<tr>
<td>;2149-\d{6}-\d{5} =</td>
<td>%B2014 \d{6} \d{5}^[A-Z][1]</td>
</tr>
<tr>
<td>;2014\d{11} =</td>
<td>%B2014-\d{6}-\d{5}^[A-Z][1]</td>
</tr>
<tr>
<td>;2014 \d{6} \d{5} =</td>
<td>%B2014-\d{6}-\d{5}^[A-Z][1]</td>
</tr>
<tr>
<td>;2014\d{11} =</td>
<td>%B2014-\d{6}-\d{5}^[A-Z][1]</td>
</tr>
<tr>
<td>;B1800\d{11}^[A-Z][1]</td>
<td>%B6011-\d{4}-\d{4}\d{4}^[A-Z][1]</td>
</tr>
<tr>
<td>%B6011-\d{4}-\d{4}\d{4}^[A-Z][1]</td>
<td>%B6011\d{12}^[A-Z][1]</td>
</tr>
<tr>
<td>Validator</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Luhn Check</td>
<td>Computes the Luhn checksum which every instance must pass.</td>
</tr>
</tbody>
</table>

## Credit Card Number data identifier

Account number needed to process credit card transactions. Often abbreviated as CCN. Also known as a Primary Account Number (PAN).

The Credit Card Number data identifier offers three breadths of detection:

- **Wide breadth**
  - See “Credit Card Number wide breadth” on page 720.

- **Medium breadth**
  - See “Credit Card Number medium breadth” on page 721.

- **Narrow breadth**
  - See “Credit Card Number narrow breadth” on page 723.

### Credit Card Number wide breadth

The wide breadth Credit Card Number data identifier detects valid credit card numbers that are separated by spaces, dashes, periods, or without separators.

This validator includes formats for American Express, Diner's Club, Discover, Japan Credit Bureau (JCB), MasterCard, and Visa.

This validator performs Luhn check validation.
### Credit Card Number wide breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Pattern (continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{16}</td>
<td>2149-\d(6)-\d(5)</td>
</tr>
<tr>
<td>\d{4}.\d{4}.\d{4}.\d{4}</td>
<td></td>
</tr>
<tr>
<td>\d{4} \d{4} \d{4} \d{4}</td>
<td></td>
</tr>
<tr>
<td>\d{4}-\d(4)-\d(4)-\d(4)</td>
<td></td>
</tr>
<tr>
<td>1800\d{11} 2014.\d(6).\d{5}</td>
<td>3[068]\d(2)-\d(6)-\d(4)</td>
</tr>
<tr>
<td>2014\d{11} 2014 \d(6) \d(5)</td>
<td>3[47]\d(13)</td>
</tr>
<tr>
<td>2014-\d(6)-\d(5)</td>
<td>3[47]\d(2).\d(6).\d(5)</td>
</tr>
<tr>
<td>2131\d{11}</td>
<td>3[47]\d(2) \d(6) \d(5)</td>
</tr>
<tr>
<td>2149.\d(6).\d(5)</td>
<td>3[47]\d(2)-\d(6)-\d(5)</td>
</tr>
<tr>
<td>2149\d{11}</td>
<td>4\d(12)</td>
</tr>
<tr>
<td>2149 \d(6) \d(5)</td>
<td></td>
</tr>
</tbody>
</table>

### Credit Card Number wide breadth validator

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Luhn Check</td>
<td>Computes the Luhn checksum which every Credit Card Number must pass.</td>
</tr>
</tbody>
</table>

### Credit Card Number medium breadth

The medium breadth Credit Card Number data identifier detects valid credit card numbers that are separated by spaces, dashes, periods, or without separators. This validator performs Luhn check validation. This validator includes formats for American Express, Diner's Club, Discover, Japan Credit Bureau (JCB), MasterCard, and Visa. This validator eliminates common test numbers, including those reserved for testing by credit card issuers.
### Table 34-36  Credit Card Number medium breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Pattern (continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1800\d{11}</td>
<td>3\d{3}.\d{4}.\d{4}.\d{4}</td>
</tr>
<tr>
<td>2014.\d{6}.\d{5}</td>
<td>3\d{3} \d{4} \d{4} \d{4}</td>
</tr>
<tr>
<td>2014\d{11}</td>
<td>3\d{3}-\d{4}-\d{4}-\d{4}</td>
</tr>
<tr>
<td>2014.\d{6}.\d{5}</td>
<td>4\d{12} 4\d{15}</td>
</tr>
<tr>
<td>2014-\d{6}-\d{5}</td>
<td>4\d{3}.\d{4}.\d{4}.\d{4}</td>
</tr>
<tr>
<td>2131\d{11}</td>
<td>4\d{3} \d{4} \d{4} \d{4}</td>
</tr>
<tr>
<td>2149.\d{6}.\d{5} 2149\d{11}</td>
<td>4\d{3}-\d{4}-\d{4}-\d{4}</td>
</tr>
<tr>
<td>2149.\d{6}.\d{5}</td>
<td>5[1-5]\d{14}</td>
</tr>
<tr>
<td>2149-\d{6}-\d{5}</td>
<td>5[1-5]\d{2}.\d{4}.\d{4}.\d{4}</td>
</tr>
<tr>
<td>3\d{15}</td>
<td>5[1-5]\d{2} \d{4} \d{4} \d{4}</td>
</tr>
<tr>
<td>3\d{15}</td>
<td>5[1-5]\d{2}-\d{4}-\d{4}-\d{4}</td>
</tr>
<tr>
<td>3\d{15}</td>
<td>6011.\d{4}.\d{4}.\d{4}</td>
</tr>
<tr>
<td>3\d{15}</td>
<td>6011\d{12}</td>
</tr>
<tr>
<td>3\d{15}</td>
<td>6011 \d{4} \d{4} \d{4}</td>
</tr>
<tr>
<td>3\d{15}</td>
<td>6011-\d{4}-\d{4}-\d{4}</td>
</tr>
<tr>
<td>3\d{15}</td>
<td>6011-\d{4}-\d{4}-\d{4}</td>
</tr>
</tbody>
</table>

### Table 34-37  Credit Card Number medium breadth validators

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Luhn Check</td>
<td>Validator computes the Luhn checksum which every Credit Card Number must pass.</td>
</tr>
<tr>
<td>Exclude data match</td>
<td>Excludes anything that matches the specified text.</td>
</tr>
</tbody>
</table>
Table 34-37  Credit Card Number medium breadth validators (continued)

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exclude data match inputs</td>
<td>0111111111111111, 1234567812345670, 180025848680889, 180026939516875, 20140000000000009, 201411033254438, 201431736711288, 210002956344401, 214906110040367, 300000000000004, 30175572836108, 30203642658706, 30374367304832, 30569309025904, 3088000000000000, 3088000000000009, 308827284227380, 309666928989890, 315806909195830, 340000000000009, 341019464471448, 3411111111111111, 341132368578216, 343510064010360, 344400377306201, 3530111333300000, 35660002020360500, 3700000000000002, 371449635398431, 374395534374782, 378282246310005, 378282246310005, 378282246310005, 378734493671000, 385200000023327, 4007000000027, 4012888888881880, 41111111111111110, 41111111111111111, 42222222222222, 4485249610564758, 4539399050593, 453947515833170, 4539603277651940, 4539687075612974, 4539890911376230, 4556657397647250, 4716733846619930, 47169767586661, 4916437046413, 491645136094420, 4916491104658550, 4916603544909870, 4916759155933, 5105105105105101, 5119301340696760, 5263386793750340, 5268196752489640, 5283145597742620, 5424000000000015, 5429800397359070, 5431111111111111, 545578058602610, 5472715456453270, 5500000000000004, 5539878514522540, 5547392398355060, 5555555555555440, 5555555555554440, 5556727257422205, 6011000000000000, 6011000000000004, 6011000000000012, 6011000090139420, 60111111111111110, 6011111111111117, 6011312054074430, 6011354276117410, 6011601160116611, 6011905056260500, 869908581608894, 869933317208876, 86998278167071</td>
</tr>
</tbody>
</table>

Number Delimiter | Validates a match by checking the surrounding number.

Credit Card Number narrow breadth

The narrow breadth edition of the Credit Card Number data identifier detects valid credit card numbers that are separated by spaces, dashes, periods, or without separators. It performs Luhn check validation. Includes formats for American Express, Diner's Club, Discover, Japan Credit Bureau (JCB), MasterCard, and Visa. Eliminates common test numbers, including those reserved for testing by credit card issuers. Also requires presence of a credit card-related keyword.
<table>
<thead>
<tr>
<th>Pattern</th>
<th>Pattern (continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2149 \d(6) \d(5)</td>
<td>5[1-5]\d(2)-\d(4)-\d(4)-\d(4)</td>
</tr>
<tr>
<td>2149-\d(6)-\d(5)</td>
<td>5[1-5]\d(2) \d(4) \d(4) \d(4)</td>
</tr>
<tr>
<td>2014/\d{11}</td>
<td>5[1-5]\d(14)</td>
</tr>
<tr>
<td>2014 \d(6) \d(5)</td>
<td>5[1-5]\d(2).\d(4).\d(4).\d(4)</td>
</tr>
<tr>
<td>2014-\d(6)-\d(5)</td>
<td>2131/\d{11}</td>
</tr>
<tr>
<td>6011-\d(4)-\d(4)-\d(4)</td>
<td>3/\d(3)-\d(4)-\d(4)-\d(4)</td>
</tr>
<tr>
<td>6011 \d(4) \d(4) \d(4)</td>
<td>3/\d(3) \d(4) \d(4) \d(4)</td>
</tr>
<tr>
<td>6011/\d{12}</td>
<td>3/\d{15}</td>
</tr>
<tr>
<td>3/\d{68}/\d{12}</td>
<td>2149/\d{11}</td>
</tr>
<tr>
<td>3/\d{68}/\d{2} \d(6) \d(4)</td>
<td></td>
</tr>
<tr>
<td>3/\d{68}/\d{2}-\d(6)-\d(4)</td>
<td></td>
</tr>
<tr>
<td>3/\d{47}/\d{2}-\d(6)-\d(5)</td>
<td></td>
</tr>
<tr>
<td>3/\d{47}/\d{2} \d(6) \d(5)</td>
<td></td>
</tr>
<tr>
<td>3/\d{47}/\d{13}</td>
<td></td>
</tr>
<tr>
<td>4/\d(3)-\d(4)-\d(4)-\d(4)</td>
<td></td>
</tr>
<tr>
<td>3/\d(3).\d(4).\d(4).\d(4)</td>
<td></td>
</tr>
<tr>
<td>2149.\d(6).\d(5)</td>
<td></td>
</tr>
<tr>
<td>2014.\d(6).\d(5)</td>
<td></td>
</tr>
<tr>
<td>6011.\d(4).\d(4).\d(4)</td>
<td></td>
</tr>
<tr>
<td>3/\d{68}/\d{2}.\d(6).\d(4)</td>
<td></td>
</tr>
<tr>
<td>3/\d{47}/\d{2}.\d(6).\d(5)</td>
<td></td>
</tr>
<tr>
<td>4/\d(3).\d(4).\d(4).\d(4)</td>
<td></td>
</tr>
<tr>
<td>1800/\d{11}</td>
<td></td>
</tr>
<tr>
<td>4/\d{12}</td>
<td></td>
</tr>
<tr>
<td>4/\d(3) \d(4) \d(4) \d(4)</td>
<td></td>
</tr>
<tr>
<td>4/\d{15}</td>
<td></td>
</tr>
</tbody>
</table>
### Table 34-39  
Credit Card Number narrow breadth validators

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Luhn Check</td>
<td>Validator computes the Luhn checksum which every Credit Card Number must pass.</td>
</tr>
<tr>
<td>Exclude data match</td>
<td>Excludes anything that matches the specified text.</td>
</tr>
<tr>
<td></td>
<td>0111111111111111, 1234567812345670, 180025848680889, 180026939516875, 201400000000009, 201411032364438, 201431736711288, 210002956344412, 21490611040367, 30000000000004, 30175572836108, 30203642658706, 30374367304832, 30569309025904, 308800000000000, 3088000000000009, 3088272824427380, 309666928988980, 3158060990195830, 3400000000000009, 341019464477148, 341111111111111, 341132368578216, 343510064010360, 344400377306201, 353011133330000, 3566002020360500, 3700000000000002, 371449635398431, 374295034347782, 378282246310005, 378282246310005, 378282246310005, 378282246310005, 378282246310005, 385200000023237, 4007000000027, 401288888881880, 4024007162824, 411111111111110, 411111111111111, 422222222222, 4242424242424242, 4485249610564758, 4539399050593, 4539475158333170, 4539603277651940, 4539687075612974, 4539890911376230, 4556657397647250, 4716733846619930, 4716976758661, 4916437046413, 4916451936094420, 4916491104658550, 4916603544909870, 4916759155933, 510510510510510, 5119301340696760, 5263386793750340, 5268196752489640, 5283145597742620, 542980039759070, 543111111111111, 5455780586062610, 5472715456453270, 5500000000000004, 55398758154522540, 5547392938355060, 55555555555444, 55555555555444, 5556722757422205, 6011000000000000, 6011000000000000, 6011000000000000, 6011000000000000, 6011000000000000, 6011312054074430, 6011354276117410, 601160116011661, 6011905056260500, 869908581608894, 869933317208876, 869989278167071</td>
</tr>
</tbody>
</table>

| Number Delimiter        | Validates a match by checking the surrounding number.                      |
| Find keywords           | With this option selected, at least one of the following keywords or key phrases must be present for the data to be matched. |
| Find keywords inputs    | account number, account ps, american express, americanexpress, amex, bank card, bankcard, card num, card number, cc #, cc#, cc#, check card, checkcard, credit card, credit card #, credit card number, credit card #, debit card, debitcard, diners club, dinersclub, discover, enroute, japanese card bureau, jcb, mastercard, mc, visa |

### Credit Card Number wide breadth

The wide breadth Credit Card Number data identifier detects valid credit card numbers that are separated by spaces, dashes, periods, or without separators.
This validator includes formats for American Express, Diner's Club, Discover, Japan Credit Bureau (JCB), MasterCard, and Visa.

This validator performs Luhn check validation.

### Table 34-40  Credit Card Number wide breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Pattern (continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{16}</td>
<td>2149-\d(6)-\d(5)</td>
</tr>
<tr>
<td>\d{4}.\d{4}.\d{4}.\d{4}</td>
<td>3[068]\d(12)</td>
</tr>
<tr>
<td>\d{4} \d{4} \d{4} \d{4}</td>
<td>3[068]\d(2).\d(6).\d(4)</td>
</tr>
<tr>
<td>\d{4}-\d{4}-\d{4}-\d{4}</td>
<td>3[068]\d(2) \d(6) \d(4)</td>
</tr>
<tr>
<td>1800\d{11} 2014.\d(6).\d(5)</td>
<td>3[068]\d(2)-\d(6)-\d(4)</td>
</tr>
<tr>
<td>2014\d{11} 2014 \d(6) \d(5)</td>
<td>3[47]\d(13)</td>
</tr>
<tr>
<td>2014-\d(6)-\d(5)</td>
<td>3[47]\d(2).\d(6).\d(5)</td>
</tr>
<tr>
<td>2131\d{11}</td>
<td>3[47]\d(2) \d(6) \d(5)</td>
</tr>
<tr>
<td>2149.\d{6}.\d{5}</td>
<td>3[47]\d(2)-\d(6)-\d(5)</td>
</tr>
<tr>
<td>2149\d{11}</td>
<td>4\d(12)</td>
</tr>
<tr>
<td>2149 \d{6} \d{5}</td>
<td></td>
</tr>
</tbody>
</table>

### Table 34-41  Credit Card Number wide breadth validator

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Luhn Check</td>
<td>Computes the Luhn checksum which every Credit Card Number must pass.</td>
</tr>
</tbody>
</table>

### Credit Card Number medium breadth

The medium breadth Credit Card Number data identifier detects valid credit card numbers that are separated by spaces, dashes, periods, or without separators. This validator performs Luhn check validation. This validator includes formats for American Express, Diner's Club, Discover, Japan Credit Bureau (JCB), MasterCard, and Visa. This validator eliminates common test numbers, including those reserved for testing by credit card issuers.
### Table 34-42  
**Credit Card Number medium breadth patterns**

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Pattern (continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1800\d{11}</td>
<td>3\d{3}.\d{4}.\d{4}.\d{4}</td>
</tr>
<tr>
<td>2014.\d{6}.\d{5}</td>
<td>3\d{3} \d{4} \d{4} \d{4}</td>
</tr>
<tr>
<td>2014\d{11}</td>
<td>3\d{3}-\d{4}-\d{4}-\d{4}</td>
</tr>
<tr>
<td>2014 \d{6} \d{5}</td>
<td>4\d{12} 4\d{15}</td>
</tr>
<tr>
<td>2014-\d{6}-\d{5}</td>
<td>4\d{3}.\d{4}.\d{4}.\d{4}</td>
</tr>
<tr>
<td>2131\d{11}</td>
<td>4\d{3} \d{4} \d{4} \d{4}</td>
</tr>
<tr>
<td>2149.\d{6}.\d{5} 2149\d{11}</td>
<td>4\d{3}-\d{4}-\d{4}-\d{4}</td>
</tr>
<tr>
<td>2149 \d{6} \d{5}</td>
<td>5[1-5]\d{14}</td>
</tr>
<tr>
<td>2149-\d{6}-\d{5}</td>
<td>5[1-5]\d{2}.\d{4}.\d{4}.\d{4}</td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
<tr>
<td>3\d{15}</td>
<td></td>
</tr>
</tbody>
</table>
Table 34-43  Credit Card Number medium breadth validators (continued)

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exclude data match inputs</td>
<td>011111111111111, 1234567812345670, 18002584680889, 180026939516875, 201400000000009, 20141103264438, 201431736711288, 210002956344412, 214906110040367, 300000000000004, 30175572836108, 30203642658706, 30374367304832, 30569309025904, 308800000000000, 308800000000009, 308827284227830, 30966692898980, 315806090195830, 340000000000009, 341019464471418, 341132368578216, 343510064010360, 344400377306201, 35011133300000, 3566002020360500, 3700000000000002, 371449635398431, 374395534374782, 378282246310005, 378282246310005, 378282246310005, 378734493671000, 385200000023237, 4007000000027, 40128888888818, 4024007116284, 411111111111110, 411111111111111, 42222222222222, 4242242424242422, 4485249610564758, 4539399050593, 4539475158333170, 4539603277651940, 4539687075612974, 4539890911376230, 455665797647250, 471673846619930, 4716976758661, 4916437046413, 4916451936094420, 4916491104658550, 4916603544909870, 4916759155933, 510510510510510, 5119301340696760, 5263386793750340, 5268196752489640, 5283145597742620, 54240000000000015, 5429800397359070, 543111111111111, 5455780586062610, 5472715456453270, 550000000000004, 5539878514522540, 5547392938355060, 555555555554444, 555555555554444, 5556722757422205, 60110000000000000, 6011000000000004, 6011000000000012, 6011000990139420, 6011111111111117, 6011312054074430, 6011354276117410, 601161011611661, 6011905056260500, 869908581608894, 869933317208876, 86998927816707</td>
</tr>
</tbody>
</table>

Credit Card Number narrow breadth

The narrow breadth edition of the Credit Card Number data identifier detects valid credit card numbers that are separated by spaces, dashes, periods, or without separators. It performs Luhn check validation. Includes formats for American Express, Diner’s Club, Discover, Japan Credit Bureau (JCB), MasterCard, and Visa. Eliminates common test numbers, including those reserved for testing by credit card issuers. Also requires presence of a credit card-related keyword.
<table>
<thead>
<tr>
<th>Pattern</th>
<th>Pattern (continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2149 \d(6) \d(5)</td>
<td>5[1-5]\d(2)-\d(4)-\d(4)-\d(4)</td>
</tr>
<tr>
<td>2149-\d(6)-\d(5)</td>
<td>5[1-5]\d(2) \d(4) \d(4) \d(4)</td>
</tr>
<tr>
<td>2014\d{11}</td>
<td>5[1-5]\d(14)</td>
</tr>
<tr>
<td>2014-\d(6)-\d(5)</td>
<td>5[1-5]\d(2).\d(4).\d(4).\d(4)</td>
</tr>
<tr>
<td>6011-\d(4)-\d(4)-\d(4)</td>
<td>2131\d{11}</td>
</tr>
<tr>
<td>6011 \d{4} \d{4} \d{4}</td>
<td>3\d{3}-\d(4)-\d(4)-\d(4)</td>
</tr>
<tr>
<td>6011\d{12}</td>
<td>3\d{3} \d(4) \d(4) \d(4)</td>
</tr>
<tr>
<td>3[068]\d{12}</td>
<td>3\d{15}</td>
</tr>
<tr>
<td>3[068]\d{2} \d{6} \d{4}</td>
<td>2149\d{11}</td>
</tr>
<tr>
<td>3[068]\d{2}-\d{6}-\d{4}</td>
<td></td>
</tr>
<tr>
<td>3[47]\d{2}-\d{6}-\d{5}</td>
<td></td>
</tr>
<tr>
<td>3[47]\d{2} \d{6} \d{5}</td>
<td>3\d{15}</td>
</tr>
<tr>
<td>3[47]\d{13}</td>
<td></td>
</tr>
<tr>
<td>4\d{3}-\d{4}-\d{4}-\d{4}</td>
<td></td>
</tr>
<tr>
<td>4\d{3}\d{4} \d{4} \d{4}</td>
<td></td>
</tr>
<tr>
<td>2149-\d{6}.\d{5}</td>
<td></td>
</tr>
<tr>
<td>2014-\d{6}.\d{5}</td>
<td></td>
</tr>
<tr>
<td>6011-\d{4}.\d{4}.\d{4}</td>
<td></td>
</tr>
<tr>
<td>3[068]\d{2}.\d{6}.\d{4}</td>
<td></td>
</tr>
<tr>
<td>3[47]\d{2}.\d{6}.\d{5}</td>
<td></td>
</tr>
<tr>
<td>4\d{3}.\d{4}.\d{4}.\d{4}</td>
<td></td>
</tr>
<tr>
<td>1800\d{11}</td>
<td></td>
</tr>
<tr>
<td>4\d{12}</td>
<td></td>
</tr>
<tr>
<td>4\d{3} \d{4} \d{4} \d{4}</td>
<td></td>
</tr>
<tr>
<td>4\d{15}</td>
<td></td>
</tr>
<tr>
<td>Mandatory validator</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Luhn Check</strong></td>
<td>Validator computes the Luhn checksum which every Credit Card Number must pass.</td>
</tr>
<tr>
<td><strong>Exclude data match</strong></td>
<td>Excludes anything that matches the specified text.</td>
</tr>
<tr>
<td><strong>Exclude data match inputs</strong></td>
<td>011111111111111, 1234567812345670, 180025848680889, 180026939516875, 201400000000009, 201411032364438, 201431736711288, 210002956344412, 21490611040367, 30000000000004, 30175572836108, 30203642658706, 30374367304832, 30569309025904, 308800000000000, 3088000000000009, 3088272824427380, 3096669289898980, 3158060990195830, 3400000000000009, 341019464477148, 34111111111111, 341132368578216, 343101064010360, 344400377306201, 350311133330000, 3566002020360500, 3700000000000002, 371449635398431, 374395034374782, 378282246310005, 378282246310005, 38520000023237, 40070000000027, 4012888888881880, 4024007116284, 4111111111111110, 4111111111111111, 422222222222, 42424242424242, 4485249610564758, 4539399050593, 4539475158333170, 4539603277651940, 4539687075612974, 4539890911376230, 455665797647250, 471673846619930, 4716976758661, 4916437046413, 4916451936094420, 4916491104658550, 4916603544909870, 4916759155933, 5105105105105100, 5119301340696760, 5263386793750340, 5268196752498640, 528314559742620, 5424000000000015, 5429800397359070, 54311111111111, 5455780586062610, 547271545643270, 5500000000000004, 5539878514522540, 5547392938355560, 55555555555444, 5555555555554444, 5556722757422205, 6011000000000000, 60110000000000000, 60110000000000012, 6011000090019420, 6011111111111110, 6011111111111117, 6011312050474430, 6011354276117410, 601160116011611, 6011905056260500, 869908581608894, 869933317208876, 86998278167071</td>
</tr>
<tr>
<td><strong>Number Delimiter</strong></td>
<td>Validates a match by checking the surrounding number.</td>
</tr>
<tr>
<td><strong>Find keywords</strong></td>
<td>With this option selected, at least one of the following keywords or key phrases must be present for the data to be matched.</td>
</tr>
<tr>
<td><strong>Find keywords inputs</strong></td>
<td>account number, account ps, american express, americanexpress, amex, bank card, bankcard, card num, card number, cc #, cc#, ccn, check card, checkcard, credit card, credit card #, credit card number, credit card#, debit card, debitcard, diners club, dinersclub, discover, enroute, japanese card bureau, jcb, mastercard, mc, visa</td>
</tr>
</tbody>
</table>
CUSIP Number data identifier

The CUSIP number is a unique identifier assigned to North American stock or other securities. This number is issued by the Committee on Uniform Security Identification Procedures (CUSIP) to assist in clearing and settling trades.

The CUSIP Number data identifier detects 9 character strings.

This data identifier provides three breadths of detection:

- The wide edition validates the final check digit.
  See “CUSIP Number wide breadth” on page 728.
- The medium edition validates the final check digit and requires the presence of a keyword.
  See “CUSIP Number medium breadth” on page 728.
- The narrow edition validates the final check digit and requires the presence of a keyword.
  See “CUSIP Number narrow breadth” on page 729.

CUSIP Number wide breadth

The wide breadth edition of the CUSIP Number data identifier detects 9 character strings. The 5th, 6th, 7th, and 8th character can be a letter or number, and all others are digits. Validates the final check digit.

Table 34-46 CUSIP Number wide breadth pattern

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{4}\w{4}\d</td>
</tr>
</tbody>
</table>

Table 34-47 CUSIP Number wide breadth validator

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cusip Validation</td>
<td>Validator checks for invalid CUSIP ranges and computes the CUSIP checksum</td>
</tr>
<tr>
<td></td>
<td>(Modulus 10 Double Add Double algorithm).</td>
</tr>
</tbody>
</table>

CUSIP Number medium breadth

The medium breadth edition of the CUSIP Number data identifier detects 9 character strings. The 5th, 6th, 7th, and 8th character can be a letter or number, and all others are digits.

This edition of the validator validates the final check digit and also requires the presence of a CUSIP-related keyword.
CUSIP Number medium breadth pattern

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{4}\w{4}\d</td>
</tr>
</tbody>
</table>

CUSIP Number medium breadth validator

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cusip Validation</td>
<td>Validator checks for invalid CUSIP ranges and computes the CUSIP checksum (Modulus 10 Double Add Double algorithm).</td>
</tr>
<tr>
<td>Find keywords</td>
<td>With this option selected, at least one of the following keywords or key phrases must be present for the data to be matched.</td>
</tr>
<tr>
<td>Find keywords input</td>
<td>cusip, c.u.s.i.p., Committee on Uniform Security Identification Procedures, American Bankers Association, Standard &amp; Poor's, S&amp;P, National Numbering Association, NNA, National Securities Identification Number</td>
</tr>
</tbody>
</table>

CUSIP Number narrow breadth

The narrow breadth edition of the CUSIP Number data identifier detects 9 character strings. The 5th, 6th, 7th, and 8th character can be a letter or number, and all others are digits.

This edition of the validator validates the final check digit and also requires the presence of a CUSIP-related keyword.

This edition of the data identifier is narrower than the medium breadth because it does not include the "NNA" abbreviation as a keyword.

CUSIP Number narrow breadth pattern

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{4}\w{4}\d</td>
</tr>
</tbody>
</table>

CUSIP Number narrow breadth validators

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cusip Validation</td>
<td>Validator checks for invalid CUSIP ranges and computes the CUSIP checksum (Modulus 10 Double Add Double algorithm).</td>
</tr>
<tr>
<td>Find keywords</td>
<td>With this option selected, at least one of the following keywords or key phrases must be present for the data to be matched.</td>
</tr>
</tbody>
</table>
CUSIP Number narrow breadth validators (continued)

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find keywords input</td>
<td>cusip, c.u.s.i.p., Committee on Uniform Security Identification Procedures, American Bankers Association, Standard &amp; Poor's, S&amp;P, National Numbering Association, National Securities Identification Number</td>
</tr>
</tbody>
</table>

CUSIP Number wide breadth

The wide breadth edition of the CUSIP Number data identifier detects 9 character strings. The 5th, 6th, 7th, and 8th character can be a letter or number, and all others are digits. Validates the final check digit.

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{4}\w{4}\d</td>
</tr>
</tbody>
</table>

CUSIP Number medium breadth

The medium breadth edition of the CUSIP Number data identifier detects 9 character strings. The 5th, 6th, 7th, and 8th character can be a letter or number, and all others are digits.

This edition of the validator validates the final check digit and also requires the presence of a CUSIP-related keyword.

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{4}\w{4}\d</td>
</tr>
</tbody>
</table>
CUSIP Number medium breadth validator

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cusip Validation</td>
<td>Validator checks for invalid CUSIP ranges and computes the CUSIP checksum (Modulus 10 Double Add Double algorithm).</td>
</tr>
<tr>
<td>Find keywords</td>
<td>With this option selected, at least one of the following keywords or key phrases must be present for the data to be matched.</td>
</tr>
<tr>
<td>Find keywords input</td>
<td>cusip, c.u.s.i.p., Committee on Uniform Security Identification Procedures, American Bankers Association, Standard &amp; Poor's, S&amp;P, National Numbering Association, NNA, National Securities Identification Number</td>
</tr>
</tbody>
</table>

CUSIP Number narrow breadth

The narrow breadth edition of the CUSIP Number data identifier detects 9 character strings. The 5th, 6th, 7th, and 8th character can be a letter or number, and all others are digits.

This edition of the validator validates the final check digit and also requires the presence of a CUSIP-related keyword.

This edition of the data identifier is narrower than the medium breadth because it does not include the "NNA" abbreviation as a keyword.

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{4}\w{4}\d</td>
</tr>
</tbody>
</table>

CUSIP Number narrow breadth validators

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cusip Validation</td>
<td>Validator checks for invalid CUSIP ranges and computes the CUSIP checksum (Modulus 10 Double Add Double algorithm).</td>
</tr>
<tr>
<td>Find keywords</td>
<td>With this option selected, at least one of the following keywords or key phrases must be present for the data to be matched.</td>
</tr>
<tr>
<td>Find keywords input</td>
<td>cusip, c.u.s.i.p., Committee on Uniform Security Identification Procedures, American Bankers Association, Standard &amp; Poor's, S&amp;P, National Numbering Association, National Securities Identification Number</td>
</tr>
</tbody>
</table>
Drivers License Number – CA State data identifier

This number is the identification number for an individual's driver's license issued by the US state of California.

The Drivers License Number – CA State data identifier detects the presence of a 7-digit number.

This data identifier provides two breadths of validation:

- The wide breadth edition detects any 7-digit number.
  See “Drivers License Number – CA State wide breadth” on page 731.
- The medium breadth edition validates a detected number against keywords.
  See “Drivers License Number – CA State medium breadth” on page 731.

Drivers License Number – CA State wide breadth

The wide breadth edition of the CA Driver License Number data identifier detects an 8 character string, beginning with a letter followed by a 7-digit number.

**Note:** This breadth option does not include any validators.

Table 34-58  Drivers License Number wide breadth pattern

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{7}</td>
</tr>
</tbody>
</table>

Drivers License Number – CA State medium breadth

The medium breadth edition of this data identifier detects an 8 character string, beginning with a letter followed by a 7-digit number.

It validates a detected number by requiring a driver's license keyword AND a California-related keyword.

Table 34-59  Drivers License Number – CA State medium breadth pattern

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{7}</td>
</tr>
</tbody>
</table>
Table 34-60  Drivers License Number – CA State medium breadth validators

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find keywords</td>
<td>With this option selected, at least one of the following keywords or key phrases must be present for the data to be matched.</td>
</tr>
<tr>
<td>Find keywords input</td>
<td>driver license, drivers license, driver's license, driver licenses, drivers licenses, driver's licenses, dl#, dls#, lic#, lics#</td>
</tr>
<tr>
<td>Find keywords</td>
<td>With this option selected, at least one of the following keywords or key phrases must be present for the data to be matched.</td>
</tr>
<tr>
<td>Find keywords input</td>
<td>ca, calif, california</td>
</tr>
</tbody>
</table>

Drivers License Number – CA State wide breadth

The wide breadth edition of the CA Driver License Number data identifier detects an 8 character string, beginning with a letter followed by a 7-digit number.

**Note:** This breadth option does not include any validators.

Table 34-61  Drivers License Number wide breadth pattern

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{7}</td>
</tr>
</tbody>
</table>

Drivers License Number – CA State medium breadth

The medium breadth edition of this data identifier detects an 8 character string, beginning with a letter followed by a 7-digit number.

It validates a detected number by requiring a driver's license keyword AND a California-related keyword.

Table 34-62  Drivers License Number – CA State medium breadth pattern

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{7}</td>
</tr>
</tbody>
</table>
Drivers License Number - FL, MI, MN States data identifier

These number are the identification number for an individual's driver's license issued by one of the following US states: Florida, Michigan, or Minnesota. These states are grouped together because they share a common pattern for this number.

This data identifier detects a 13 character string, beginning with a letter followed by 12 numbers.

This data identifier provides two breadths of validation:

- The wide breadth edition detects any 13 character string with a letter followed by 12 numbers.
  See “Drivers License Number- FL, MI, MN States wide breadth” on page 734.

- The medium breadth narrows the scope by requiring the presence keywords.
  See “Drivers License Number- FL, MI, MN States medium breadth” on page 734.

Drivers License Number- FL, MI, MN States wide breadth

The wide breadth edition of this data identifier detects any 13 character string with a letter followed by 12 numbers.

For the MN license number, the following format is matched: L-DDD-DDD-DDD-DDD.

Note: This breadth option does not include any validators.
Drivers License Number- FL, MI, MN States wide breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>( \backslash{d}(3) \backslash{d}(3) \backslash{d}(3) \backslash{d}(3) )</td>
</tr>
<tr>
<td>( \backslash{d}(12) )</td>
</tr>
<tr>
<td>( \backslash{d}(3)-\backslash{d}(3)-\backslash{d}(2)-\backslash{d}(3)-\backslash{d} )</td>
</tr>
<tr>
<td>( \backslash{d}(3)-\backslash{d}(3)-\backslash{d}(3)-\backslash{d}(3) )</td>
</tr>
</tbody>
</table>

Drivers License Number- FL, MI, MN States medium breadth

The medium breadth edition of this data identifier implements patterns to detect any 13 character string with a letter followed by 12 numbers. For the MN license number, the following format is matched: L-DDD-DDD-DDD-DDD.

This data identifier validates the number by requiring the presence of a drivers license keyword AND a state-related keyword.

Drivers License Number- FL, MI, MN States medium breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>( \backslash{d}(3) \backslash{d}(3) \backslash{d}(3) \backslash{d}(3) )</td>
</tr>
<tr>
<td>( \backslash{d}(12) )</td>
</tr>
<tr>
<td>( \backslash{d}(3)-\backslash{d}(3)-\backslash{d}(2)-\backslash{d}(3)-\backslash{d} )</td>
</tr>
<tr>
<td>( \backslash{d}(3)-\backslash{d}(3)-\backslash{d}(3)-\backslash{d}(3) )</td>
</tr>
</tbody>
</table>

Drivers License Number- FL, MI, MN States medium breadth validators

<table>
<thead>
<tr>
<th>Mandator validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find keywords</td>
<td>Requires at least one of the input keywords or key phrases to be present for the data to be matched.</td>
</tr>
<tr>
<td>Find keywords input</td>
<td>driver license, drivers license, driver's license, driver licenses, drivers licenses, driver's licenses, dl#, dls#, lic#, lics#</td>
</tr>
<tr>
<td>Find keywords</td>
<td>Requires at least one of the input keywords or key phrases to be present for the data to be matched.</td>
</tr>
<tr>
<td>Find keywords input</td>
<td>fla, fl, florida, michigan, mi, minnesota, mn</td>
</tr>
</tbody>
</table>
Drivers License Number- FL, MI, MN States wide breadth

The wide breadth edition of this data identifier detects any 13 character string with a letter followed by 12 numbers.

For the MN license number, the following format is matched: L-DDD-DDD-DDD-DDD.

**Note:** This breadth option does not include any validators.

**Table 34-67**  Drivers License Number- FL, MI, MN States wide breadth patterns

<table>
<thead>
<tr>
<th>Patterns</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Pattern" /></td>
</tr>
<tr>
<td><img src="image2" alt="Pattern" /></td>
</tr>
<tr>
<td><img src="image3" alt="Pattern" /></td>
</tr>
<tr>
<td><img src="image4" alt="Pattern" /></td>
</tr>
</tbody>
</table>

Drivers License Number- FL, MI, MN States medium breadth

The medium breadth edition of this data identifier implements patterns to detect any 13 character string with a letter followed by 12 numbers. For the MN license number, the following format is matched: L-DDD-DDD-DDD-DDD.

This data identifier validates the number by requiring the presence of a drivers license keyword AND a state-related keyword.

**Table 34-68**  Drivers License Number- FL, MI, MN States medium breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image5" alt="Pattern" /></td>
</tr>
<tr>
<td><img src="image6" alt="Pattern" /></td>
</tr>
<tr>
<td><img src="image7" alt="Pattern" /></td>
</tr>
<tr>
<td><img src="image8" alt="Pattern" /></td>
</tr>
</tbody>
</table>

**Table 34-69**  Drivers License Number- FL, MI, MN States medium breadth validators

<table>
<thead>
<tr>
<th>Mandator validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find keywords</td>
<td>Requires at least one of the input keywords or key phrases to be present for the data to be matched.</td>
</tr>
</tbody>
</table>
Drivers License Number - IL State data identifier

This number is the identification number for an individual's driver's license issued by the US state of Illinois.

The Drivers License Number - IL State data identifier detects the presence of an Illinois driver's license number.

This data identifier provides two breadths of validation:

- The wide breadth edition detects the presence of a 12 character string. See “Drivers License Number- IL State wide breadth” on page 736.
- The medium breadth narrows the scope by requiring the presence of keywords. See “Drivers License Number- IL State medium breadth” on page 737.

Drivers License Number- IL State wide breadth

The wide breadth edition of the Drivers License Number- IL State data identifier detects a 12 character string, beginning with a letter (the first letter of the person’s last name) followed by 11 numbers.

Note: This breadth option does not include any validators.

Table 34-70 Drivers License Number- IL State wide breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{3}-\d{4}-\d{4}</td>
<td>Drivers License Number- IL State wide breadth patterns</td>
</tr>
<tr>
<td>\d{11}</td>
<td></td>
</tr>
</tbody>
</table>

Table 34-69 Drivers License Number- FL, MI, MN States medium breadth validators (continued)

<table>
<thead>
<tr>
<th>Mandator validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find keywords input</td>
<td>driver license, drivers license, driver's license, driver licenses, drivers licenses, driver's licenses, dl#, dls#, lic#, lics#</td>
</tr>
<tr>
<td>Find keywords input</td>
<td>Requires at least one of the input keywords or key phrases to be present for the data to be matched.</td>
</tr>
<tr>
<td>Find keywords input</td>
<td>fla, fl, florida, michigan, mi, minnesota, mn</td>
</tr>
</tbody>
</table>
Drivers License Number- IL State medium breadth

The medium breadth edition of the Drivers License Number- IL State data identifier detects a 12 character string, beginning with a letter (the first letter of the person's last name) followed by 11 numbers.

This breadth also requires the presence of both a driver's license keyword AND a Illinois-related keyword.

<table>
<thead>
<tr>
<th>Table 34-71</th>
<th>Drivers License Number- IL State medium breadth patterns</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pattern</td>
<td></td>
</tr>
<tr>
<td>\d{3}-\d{4}-\d{4}</td>
<td></td>
</tr>
<tr>
<td>\d{11}</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table 34-72</th>
<th>Drivers License Number- IL State medium breadth validators</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mandator validators</td>
<td>Description</td>
</tr>
<tr>
<td>Find keywords</td>
<td>Requires at least one of the input keywords or key phrases to be present for the data to be matched.</td>
</tr>
<tr>
<td>Find keywords input</td>
<td>driver license, drivers license, driver's license, driver licenses, drivers licenses, driver's licenses, dl#, dls#, lic#, lics#</td>
</tr>
<tr>
<td>Find keywords</td>
<td>Requires at least one of the input keywords or key phrases to be present for the data to be matched.</td>
</tr>
<tr>
<td>Find keywords input</td>
<td>il, illinois</td>
</tr>
</tbody>
</table>

Drivers License Number- IL State wide breadth

The wide breadth edition of the Drivers License Number- IL State data identifier detects a 12 character string, beginning with a letter (the first letter of the person's last name) followed by 11 numbers.

Note: This breadth option does not include any validators.

<table>
<thead>
<tr>
<th>Table 34-73</th>
<th>Drivers License Number- IL State wide breadth patterns</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pattern</td>
<td></td>
</tr>
<tr>
<td>\d{3}-\d{4}-\d{4}</td>
<td></td>
</tr>
</tbody>
</table>
Drivers License Number - IL State data identifier

Drivers License Number- IL State medium breadth

The medium breadth edition of the Drivers License Number- IL State data identifier detects a 12 character string, beginning with a letter (the first letter of the person’s last name) followed by 11 numbers.

This breadth also requires the presence of both a driver’s license keyword AND a Illinois-related keyword.

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>\w{11}</td>
</tr>
</tbody>
</table>

Table 34-74 Drivers License Number- IL State medium breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>\w{3}-\w{4}-\w{4}</td>
</tr>
<tr>
<td>\w{11}</td>
</tr>
</tbody>
</table>

Table 34-75 Drivers License Number- IL State medium breadth validators

<table>
<thead>
<tr>
<th>Mandator validators</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find keywords</td>
<td>Requires at least one of the input keywords or key phrases to be present for the data to be matched.</td>
</tr>
<tr>
<td>Find keywords input</td>
<td>driver license, drivers license, driver's license, driver licenses, drivers licenses, driver's licenses, dl#, dls#, lic#, lics#</td>
</tr>
<tr>
<td>Find keywords</td>
<td>Requires at least one of the input keywords or key phrases to be present for the data to be matched.</td>
</tr>
<tr>
<td>Find keywords input</td>
<td>il, illinois</td>
</tr>
</tbody>
</table>

Drivers License Number - NJ State data identifier

This number is the identification for an individual's driver's license issued by the US state of New Jersey.

The Drivers License Number - NJ State data identifier detects the presence of a New Jersey drivers license number.

This data identifier provides two breadths of validation:
The wide breadth edition detects the presence of a 15 character string. See “Drivers License Number- NJ State wide breadth” on page 739.

The medium breadth narrows the scope by requiring the presence of keywords. See “Drivers License Number- NJ State medium breadth” on page 739.

Drivers License Number- NJ State wide breadth

The wide breadth edition of the Drivers License Number- NJ State data identifier detects a 15 character string, beginning with a letter (the first letter of the person’s last name) followed by 14 numbers.

Table 34-76  Drivers License Number- NJ State wide breadth patterns

<table>
<thead>
<tr>
<th>Patterns</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>\d{4} </code>\d{5} <code>\d{5}</code> <code>\d{14}</code></td>
</tr>
</tbody>
</table>

Note: The wide breadth option does not include any validators.

Drivers License Number- NJ State medium breadth

The medium breadth edition of the Drivers License Number- NJL State data identifier detects a 15 character string, beginning with a letter (the first letter of the person’s last name) followed by 14 numbers.

This breadth also requires the presence of both a driver’s license keyword AND a New Jersey-related keyword.

Table 34-77  Drivers License Number- NJ State medium breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>\d{3}-</code>\d{4}-<code>\d{4}</code> <code>\d{11}</code></td>
</tr>
</tbody>
</table>

Table 34-78  Drivers License Number- NJ State medium breadth validators

<table>
<thead>
<tr>
<th>Validators</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find keywords</td>
<td>Requires at least one of the input keywords or key phrases to be present for the data to be matched.</td>
</tr>
</tbody>
</table>
Drivers License Number - NJ State data identifier

Table 34-78  Drivers License Number - NJ State medium breadth validators (continued)

<table>
<thead>
<tr>
<th>Validators</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find keywords input</td>
<td>driver license, drivers license, driver's license, driver licenses, drivers licenses, driver's licenses, dl#, dls#, lic#, lics#</td>
</tr>
<tr>
<td>Find keywords</td>
<td>Requires at least one of the input keywords or key phrases to be present for the data to be matched.</td>
</tr>
<tr>
<td>Find keywords input</td>
<td>nj, new jersey, newjersey</td>
</tr>
</tbody>
</table>

Drivers License Number - NJ State wide breadth

The wide breadth edition of the Drivers License Number - NJ State data identifier detects a 15 character string, beginning with a letter (the first letter of the person’s last name) followed by 14 numbers.

Note: The wide breadth option does not include any validators.

Table 34-79  Drivers License Number - NJ State wide breadth patterns

<table>
<thead>
<tr>
<th>Patterns</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{4} \d{5} \d{5}</td>
</tr>
<tr>
<td>\d{14}</td>
</tr>
</tbody>
</table>

Drivers License Number - NJ State medium breadth

The medium breadth edition of the Drivers License Number - NJL State data identifier detects a 15 character string, beginning with a letter (the first letter of the person’s last name) followed by 14 numbers.

This breadth also requires the presence of both a driver's license keyword AND a New Jersey-related keyword.

Table 34-80  Drivers License Number - NJ State medium breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{3}-\d{4}-\d{4}</td>
</tr>
<tr>
<td>\d{11}</td>
</tr>
</tbody>
</table>
Table 34-81  Drivers License Number- NJ State medium breadth validators

<table>
<thead>
<tr>
<th>Validators</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find keywords</td>
<td>Requires at least one of the input keywords or key phrases to be present for the data to be matched.</td>
</tr>
<tr>
<td>Find keywords input</td>
<td>driver license, drivers license, driver's license, driver licenses, drivers licenses, driver's licenses, dl#, dls#, lic#, lics#</td>
</tr>
<tr>
<td>Find keywords</td>
<td>Requires at least one of the input keywords or key phrases to be present for the data to be matched.</td>
</tr>
<tr>
<td>Find keywords input</td>
<td>nj, new jersey, newjersey</td>
</tr>
</tbody>
</table>

Drivers License Number - NY State data identifier

This number is the identification for an individual's driver's license issued by the US state of New York.

The Drivers License Number - NY State data identifier detects the presence of an New York drivers license number.

This data identifier provides two breadths of validation:
- The wide breadth edition detects a string of 9 digits.
  See “Drivers License Number- NJ State wide breadth” on page 739.
- The medium breadth narrows the scope by requiring the presence of keywords.
  See “Drivers License Number- NJ State medium breadth” on page 739.

Drivers License Number- NY State wide breadth

The wide breadth edition of the Drivers License Number- NY State data identifier detects a 9-digit string.

Note: The wide breadth option does not include any validators.

Table 34-82  Drivers License Number- NY State wide breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{3} \d{3} \d{3}</td>
</tr>
<tr>
<td>\d{9}</td>
</tr>
</tbody>
</table>
Drivers License Number - NY State medium breadth

The medium breadth edition of the Drivers License Number - NY State data identifier detects a 9-digit string.

This breadth also requires the presence of both a driver’s license keyword AND a New York–related keyword.

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>\d{3}-\d{4}-\d{4}</code></td>
</tr>
<tr>
<td><code>\d{11}</code></td>
</tr>
</tbody>
</table>

**Table 34-84  Drivers License Number- NY State medium breadth validators**

<table>
<thead>
<tr>
<th>Mandatory validators</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find keywords</td>
<td>Requires at least one of the input keywords or key phrases to be present for the data to be matched.</td>
</tr>
<tr>
<td>Find keywords input</td>
<td><code>driver license, drivers license, driver's license, driver licenses, drivers licenses, driver's licenses, dl#, dls#, lic#, lics#</code></td>
</tr>
<tr>
<td>Find keywords</td>
<td>Requires at least one of the input keywords or key phrases to be present for the data to be matched.</td>
</tr>
<tr>
<td>Find keywords input</td>
<td><code>new york, ny, newyork</code></td>
</tr>
</tbody>
</table>

Drivers License Number- NY State wide breadth

The wide breadth edition of the Drivers License Number- NY State data identifier detects a 9-digit string.

**Note:** The wide breadth option does not include any validators.

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>\d{3}  \d{3}  \d{3}</code></td>
</tr>
<tr>
<td><code>\d{9}</code></td>
</tr>
</tbody>
</table>
Drivers License Number - NY State medium breadth

The medium breadth edition of the Drivers License Number - NY State data identifier detects a 9-digit string.

This breadth also requires the presence of both a driver’s license keyword AND a New York–related keyword.

<table>
<thead>
<tr>
<th>Pattern</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{3}-\d{4}-\d{4}</td>
<td></td>
</tr>
<tr>
<td>\d{11}</td>
<td></td>
</tr>
</tbody>
</table>

Table 34-87 Drivers License Number- NY State medium breadth validators

<table>
<thead>
<tr>
<th>Mandatory validators</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find keywords</td>
<td>Requires at least one of the input keywords or key phrases to be present for the data to be matched.</td>
</tr>
<tr>
<td>Find keywords input</td>
<td>driver license, drivers license, driver's license, driver licenses, drivers licenses, driver's licenses, dl#, dls#, lic#, lics#</td>
</tr>
<tr>
<td>Find keywords</td>
<td>Requires at least one of the input keywords or key phrases to be present for the data to be matched.</td>
</tr>
<tr>
<td>Find keywords input</td>
<td>new york, ny, newyork</td>
</tr>
</tbody>
</table>

French INSEE Code data identifier

The INSEE code in France is used as a social insurance number, a national identification number, and for taxation and employment purposes.

The French INSEE Code data identifier detects the presence of INSEE numbers.

The wide breadth edition of the French INSEE Code data identifier detects a 15-digit number which encodes the date of birth, department of origin, commune of origin, and an order number. A space delimiter after the first 13 digits is optional. The last two digits of the INSEE code encode a control key used to validate a checksum.

<table>
<thead>
<tr>
<th>Pattern</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{13} \d{2}</td>
<td></td>
</tr>
</tbody>
</table>
Table 34-88  French INSEE Code wide breadth patterns (continued)

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>d{15}</td>
</tr>
</tbody>
</table>

Table 34-89  French INSEE Code wide breadth validator

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>INSEE Control Key</td>
<td>This validator computes the INSEE control key and compares it to the last 2 digits of the pattern.</td>
</tr>
</tbody>
</table>

Hong Kong ID data identifier

The Hong Kong ID is the unique identifier for all residents of Hong Kong and appears on the Hong Kong Identity Card.

The Hong Kong ID data identifier detects the presence of Hong Kong IDs.

The wide breadth edition of the Hong Kong ID data identifier detects 8 characters in the form LDDDDDDD(D) or LDDDDDDD(A). The last character in the detected string is used to validate a checksum.

Table 34-90  Hong Kong ID wide breadth patterns

<table>
<thead>
<tr>
<th>Patterns</th>
</tr>
</thead>
<tbody>
<tr>
<td>\w\d(6)(d)</td>
</tr>
<tr>
<td>\w\d(6)(A)</td>
</tr>
<tr>
<td>U\w\d(6)(d)</td>
</tr>
<tr>
<td>U\w\d(6)(A)</td>
</tr>
</tbody>
</table>

Table 34-91  Hong Kong ID wide breadth validator

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hong Kong ID</td>
<td>Computes the checksum and validates the pattern against it.</td>
</tr>
</tbody>
</table>

IBAN Central data identifier

The International Bank Account Number (IBAN) is an international standard for identifying bank accounts across national borders.
The IBAN Central data identifier detects IBAN numbers for Andorra, Austria, Belgium, Germany, Italy, Liechtenstein, Luxembourg, Malta, Monaco, San Marino, and Switzerland.

The wide breadth edition of the IBAN Central data identifier detects a country-specific IBAN number that passes a checksum. IBAN numbers can include space delimiters, dash delimiters, or no delimiters.

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AD\d{2}\d{4}\w{4}\w{4}\w{4}\w{4}</td>
<td>Andorra patterns</td>
</tr>
<tr>
<td>AD\d{2}\d{4}\d{4}\w{4}\w{4}\w{4}</td>
<td></td>
</tr>
<tr>
<td>AD\d{2}-\d{4}-\d{4}-\w{4}-\w{4}-\w{4}</td>
<td></td>
</tr>
<tr>
<td>AT\d{2}\d{4}\d{4}\w{4}\w{4}\w{4}</td>
<td>Austria patterns</td>
</tr>
<tr>
<td>AT\d{2}\d{4}\d{4}\d{4}</td>
<td></td>
</tr>
<tr>
<td>AT\d{2}-\d{4}-\d{4}-\d{4}-\w{4}</td>
<td></td>
</tr>
<tr>
<td>BE\d{2}\d{4}\d{4}\w{4}\w{4}\w{4}</td>
<td>Belgium patterns</td>
</tr>
<tr>
<td>BE\d{2}\d{4}\d{4}\d{4}</td>
<td></td>
</tr>
<tr>
<td>BE\d{2}-\d{4}-\d{4}-\d{4}</td>
<td></td>
</tr>
<tr>
<td>CH\d{2}\d{4}\w{4}\w{4}\w{4}\w{4}</td>
<td>Switzerland patterns</td>
</tr>
<tr>
<td>CH\d{2}\d{4}\w{4}\w{4}\w{4}</td>
<td></td>
</tr>
<tr>
<td>CH\d{2}-\d{4}-\w{4}-\w{4}-\w{4}-\w{4}</td>
<td></td>
</tr>
<tr>
<td>DE\d{2}\d{4}\d{4}\d{4}\d{2}</td>
<td>Germany patterns</td>
</tr>
<tr>
<td>DE\d{2}\d{4}\d{4}\d{4}\d{2}</td>
<td></td>
</tr>
<tr>
<td>DE\d{2}-\d{4}-\d{4}-\d{4}-\d{4}-\d{2}</td>
<td></td>
</tr>
<tr>
<td>IT\d{2}[A-Z]\d{3}\w{4}\w{4}\w{4}</td>
<td>Italy patterns</td>
</tr>
<tr>
<td>IT\d{2}[A-Z]\d{3}\d{4}\w{4}\w{4}\w{4}</td>
<td></td>
</tr>
<tr>
<td>IT\d{2}-[A-Z]\d{3}-\d{4}-\w{4}-\w{4}-\w{4}-\w{4}-\w{3}</td>
<td></td>
</tr>
<tr>
<td>LI\d{2}\d{4}\w{4}\w{4}</td>
<td>Liechtenstein patterns</td>
</tr>
<tr>
<td>LI\d{2}\d{4}\w{4}\w{4}</td>
<td></td>
</tr>
<tr>
<td>LI\d{2}-\d{4}-\w{4}-\w{4}-\w{4}-\w{4}</td>
<td></td>
</tr>
</tbody>
</table>
### IBAN Central wide breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LU\d{2}\d{3}\w\w{4}\w{4}\w{4}</td>
<td>Luxembourg patterns</td>
</tr>
<tr>
<td>LU\d{2} \d{3} \w \w{4} \w{4} \w{4}</td>
<td></td>
</tr>
<tr>
<td>LU\d{2}-\d{3}\w-\w{4}-\w{4}-\w{4}</td>
<td></td>
</tr>
<tr>
<td>MC\d{2}\d{4}\d{4}\d{4}\d{2}\w{2}\w{4}\w{4}\w{3}</td>
<td>Monaco patterns</td>
</tr>
<tr>
<td>MC\d{2} \d{4} \d{4} \d{4} \d{2} \w{2} \w{4} \w{4} \w{3}</td>
<td></td>
</tr>
<tr>
<td>MC\d{2}-\d{4}-\d{4}-\d{4}-\w{2}-\w{4}-\w{4}-\w{3}</td>
<td></td>
</tr>
<tr>
<td>MT\d{2}[A-Z]\d\d\d\d\d\d\w\w{4}\w{4}\w{3}</td>
<td>Malta</td>
</tr>
<tr>
<td>MT\d{2} [A-Z]\d\d\d\d\d\w\d\w{4} \w{4} \w{3}</td>
<td></td>
</tr>
<tr>
<td>MT\d{2}-[A-Z]\d\d\d\d\d-\d\w\d\w{4}-\w{4}-\w{3}</td>
<td></td>
</tr>
<tr>
<td>SM\d{2}[A-Z]\d\d\d\d\d\w\d\w{4}\w{3}</td>
<td>San Marino patterns</td>
</tr>
<tr>
<td>SM\d{2} [A-Z]\d\d\d\d\d \w\d\w{4} \w{3}</td>
<td></td>
</tr>
<tr>
<td>SM\d{2}-[A-Z]\d\d\d\d\d-\w\d\w{4}-\w{3}</td>
<td></td>
</tr>
</tbody>
</table>

### IBAN Central wide breadth validator

<table>
<thead>
<tr>
<th>Validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mod 97 Validator</td>
<td>Computes the ISO 7064 Mod 97-10 checksum of the complete match.</td>
</tr>
</tbody>
</table>

### IBAN East data identifier

The International Bank Account Number (IBAN) is an international standard for identifying bank accounts across national borders.

The IBAN East data identifier detects IBAN numbers for Bosnia, Bulgaria, Croatia, Cyprus, Czech Republic, Estonia, Greece, Hungary, Israel, Latvia, Lithuania, Macedonia, Montenegro, Poland, Romania, Serbia, Slovakia, Slovenia, Turkey and Tunisia.

The wide breadth IBAN East data identifier detects a country-specific IBAN number that passes a checksum. IBAN numbers can include space delimiters, dash delimiters, or no delimiters.
<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BA([2])d{4}d{4}d{4}d{4}</td>
<td>Bosnia patterns</td>
</tr>
<tr>
<td>BA([2])d{4}d{4}d{4}d{4}</td>
<td></td>
</tr>
<tr>
<td>BA([2]-d{4}-d{4}-d{4}-d{4}</td>
<td></td>
</tr>
<tr>
<td>BG([2])d{2}A-Z{4}d{2}w{2}w{4}w{2}</td>
<td>Bulgaria patterns</td>
</tr>
<tr>
<td>BG([2])d{2} [A-Z]{4}d{2}w{2}w{4}w{2}</td>
<td></td>
</tr>
<tr>
<td>BG([2]-d{2}d{2}A-Z{4}d{2}w{2}-w{4}-w{2}</td>
<td></td>
</tr>
<tr>
<td>CY([2])d{4}d{4}w{4}w{4}w{4}w{4}</td>
<td>Cyprus patterns</td>
</tr>
<tr>
<td>CY([2])d{4}d{4}w{4}w{4}w{4}w{4}</td>
<td></td>
</tr>
<tr>
<td>CY([2]-d{4}-d{4}-w{4}-w{4}-w{4}-w{4}</td>
<td></td>
</tr>
<tr>
<td>CZ([2])d{4}d{4}d{4}d{4}d{4}</td>
<td>Czech Republic patterns</td>
</tr>
<tr>
<td>CZ([2])d{4}d{4}d{4}d{4}d{4}</td>
<td></td>
</tr>
<tr>
<td>CZ([2]-d{4}-d{4}-d{4}-d{4}-d{4}</td>
<td></td>
</tr>
<tr>
<td>EE([2])d{4}d{4}d{4}d{4}</td>
<td>Estonia patterns</td>
</tr>
<tr>
<td>EE([2])d{4}d{4}d{4}d{4}</td>
<td></td>
</tr>
<tr>
<td>EE([2]-d{4}-d{4}-d{4}-d{4}</td>
<td></td>
</tr>
<tr>
<td>GR([2])d{2}d{4}d{3}w{4}w{4}w{4}w{3}</td>
<td>Greece patterns</td>
</tr>
<tr>
<td>GR([2])d{2}d{4}d{3}w{4}w{4}w{4}w{3}</td>
<td></td>
</tr>
<tr>
<td>GR([2]-d{2}d{4}-d{3}w{4}-w{4}-w{4}-w{3}</td>
<td></td>
</tr>
<tr>
<td>HR([2])d{2}d{4}d{4}d{4}</td>
<td>Croatia patterns</td>
</tr>
<tr>
<td>HR([2])d{2}d{4}d{4}d{4}</td>
<td></td>
</tr>
<tr>
<td>HR([2]-d{2}-d{4}-d{4}-d{4}-d{4}</td>
<td></td>
</tr>
<tr>
<td>HU([2])d{2}d{4}d{4}d{4}d{4}d{4}</td>
<td>Hungary patterns</td>
</tr>
<tr>
<td>HU([2])d{2}d{4}d{4}d{4}d{4}d{4}</td>
<td></td>
</tr>
<tr>
<td>HU([2]-d{2}-d{4}-d{4}-d{4}-d{4}-d{4}</td>
<td></td>
</tr>
<tr>
<td>IL([2])d{2}d{4}d{4}d{4}d{4}d{3}</td>
<td>Israel patterns</td>
</tr>
<tr>
<td>IL([2])d{2}d{4}d{4}d{4}d{4}d{3}</td>
<td></td>
</tr>
<tr>
<td>IL([2]-d{2}-d{4}-d{4}-d{4}-d{4}-d{3}</td>
<td></td>
</tr>
<tr>
<td>Pattern</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>LT\d{2}\d{4}\d{4}\d{4}\d{4}</td>
<td>Lithuania patterns</td>
</tr>
<tr>
<td>LT\d{2} \d{4} \d{4} \d{4} \d{4}</td>
<td></td>
</tr>
<tr>
<td>LT\d{2}-\d{4}-\d{4}-\d{4}-\d{4}</td>
<td></td>
</tr>
<tr>
<td>LV\d{2}[A-Z]{4}\w{4}\w{4}\w{4}</td>
<td>Latvia patterns</td>
</tr>
<tr>
<td>LV\d{2} [A-Z]{4} \w{4} \w{4} \w{4}</td>
<td></td>
</tr>
<tr>
<td>LV\d{2}-[A-Z]{4}-\w{4}-\w{4}-\w{4}</td>
<td></td>
</tr>
<tr>
<td>ME\d{2}\d{4}\d{4}\d{4}\d{4}\d{4}</td>
<td>Montenegro patterns</td>
</tr>
<tr>
<td>ME\d{2} \d{4} \d{4} \d{4} \d{4} \d{4}</td>
<td></td>
</tr>
<tr>
<td>ME\d{2}-\d{4}-\d{4}-\d{4}-\d{4}-\d{4}</td>
<td></td>
</tr>
<tr>
<td>MK\d{2}\d{3}\w\w{4}\w{4}\w{4}\w{4}</td>
<td>Macedonia patterns</td>
</tr>
<tr>
<td>MK\d{2} \d{3}\w \w{4} \w{4} \w{4} \w{4}</td>
<td></td>
</tr>
<tr>
<td>MK\d{2}-\d{3}-\w{4}-\w{4}-\w{4}-\w{4}</td>
<td></td>
</tr>
<tr>
<td>PL\d{2}\d{4}\d{4}\d{4}\d{4}\d{4}\d{4}</td>
<td>Poland patterns</td>
</tr>
<tr>
<td>PL\d{2} \d{4} \d{4} \d{4} \d{4} \d{4} \d{4}</td>
<td></td>
</tr>
<tr>
<td>PL\d{2}-\d{4}-\d{4}-\d{4}-\d{4}-\d{4}-\d{4}</td>
<td></td>
</tr>
<tr>
<td>RO\d{2}[A-Z]{4}\w{4}\w{4}\w{4}\w{4}\w{4}</td>
<td>Romania patterns</td>
</tr>
<tr>
<td>RO\d{2} [A-Z]{4} \w{4} \w{4} \w{4} \w{4} \w{4}</td>
<td></td>
</tr>
<tr>
<td>RO\d{2}-[A-Z]{4}-\w{4}-\w{4}-\w{4}-\w{4}-\w{4}</td>
<td></td>
</tr>
<tr>
<td>RS\d{2}\d{4}\d{4}\d{4}\d{4}\d{2}</td>
<td>Serbia patterns</td>
</tr>
<tr>
<td>RS\d{2} \d{4} \d{4} \d{4} \d{4} \d{4} \d{2}</td>
<td></td>
</tr>
<tr>
<td>RS\d{2}-\d{4}-\d{4}-\d{4}-\d{4}-\d{4}-\d{2}</td>
<td></td>
</tr>
<tr>
<td>SI\d{2}\d{4}\d{4}\d{4}\d{4}\d{3}</td>
<td>Slovenia patterns</td>
</tr>
<tr>
<td>SI\d{2} \d{4} \d{4} \d{4} \d{4} \d{3}</td>
<td></td>
</tr>
<tr>
<td>SI\d{2}-\d{4}-\d{4}-\d{4}-\d{4}-\d{3}</td>
<td></td>
</tr>
<tr>
<td>SK\d{2}\d{4}\d{4}\d{4}\d{4}\d{4}\d{4}</td>
<td>Slovak Republic patterns</td>
</tr>
<tr>
<td>SK\d{2} \d{4} \d{4} \d{4} \d{4} \d{4} \d{4}</td>
<td></td>
</tr>
<tr>
<td>SK\d{2}-\d{4}-\d{4}-\d{4}-\d{4}-\d{4}-\d{4}</td>
<td></td>
</tr>
</tbody>
</table>
Table 34-94  IBAN East wide breadth patterns (continued)

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TN59\d{4}\d{4}\d{4}\d{4}\d{4}</td>
<td>Tunisia patterns</td>
</tr>
<tr>
<td>TN59 \d{4} \d{4} \d{4} \d{4} \d{4}</td>
<td></td>
</tr>
<tr>
<td>TN59-\d{4}-\d{4}-\d{4}-\d{4}-\d{4}</td>
<td></td>
</tr>
<tr>
<td>TR\d{2}\d{4}\d{4}\d{4}\w{3}\w{4}\w{4}\w{4}\w{4}\w{2}</td>
<td>Turkey patterns</td>
</tr>
<tr>
<td>TR\d{2} \d{4} \d{4}\w{3}\w{4}\w{4}\w{4}\w{4}\w{2}</td>
<td></td>
</tr>
<tr>
<td>TR\d{2}-\d{4}-\d{4}\w{3}-\w{4}-\w{4}-\w{4}-\w{2}</td>
<td></td>
</tr>
</tbody>
</table>

Table 34-95  IBAN East wide breadth validator

<table>
<thead>
<tr>
<th>Validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mod 97 Validator</td>
<td>Computes the ISO 7064 Mod 97-10 checksum of the complete match.</td>
</tr>
</tbody>
</table>

**IBAN West data identifier**

The International Bank Account Number (IBAN) is an international standard for identifying bank accounts across national borders.

The IBAN West data identifier detects IBAN numbers for Denmark, Faroe Islands, Finland, France, Gibraltar, Greenland, Iceland, Ireland, Netherlands, Norway, Portugal, Spain, Sweden, and the United Kingdom.

The wide breadth IBAN West data identifier detects a country-specific IBAN number that passes a checksum. IBAN numbers can include space delimiters, dash delimiters, or no delimiters.

Table 34-96  IBAN West wide breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DK\d{2}\d{4}\d{4}\d{4}\d{2}</td>
<td>Denmark patterns</td>
</tr>
<tr>
<td>DK\d{2} \d{4} \d{4} \d{4} \d{2}</td>
<td></td>
</tr>
<tr>
<td>DK\d{2}-\d{4}-\d{4}-\d{4}-\d{2}</td>
<td></td>
</tr>
<tr>
<td>ES\d{2}\d{4}\d{4}\d{4}\d{4}\d{4}</td>
<td>Spain patterns</td>
</tr>
<tr>
<td>ES\d{2} \d{4} \d{4} \d{4} \d{4} \d{4}</td>
<td></td>
</tr>
<tr>
<td>ES\d{2}-\d{4}-\d{4}-\d{4}-\d{4}-\d{4}</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>Pattern</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Finland patterns</td>
<td>FI\d{2}\d(4)\d(4)\d(4)\d(2)</td>
</tr>
<tr>
<td></td>
<td>FI\d{2}\ \d{4}\ \d{4}\ \d{4}\ \d{2}</td>
</tr>
<tr>
<td></td>
<td>FI\d{2}-\d{4}-\d{4}-\d{4}-\d{2}</td>
</tr>
<tr>
<td>Faroe Islands patterns</td>
<td>FO\d{2}\d{4}\d{4}\d{4}\d{2}</td>
</tr>
<tr>
<td></td>
<td>FO\d{2} \d{4} \d{4} \d{4} \d{2}</td>
</tr>
<tr>
<td></td>
<td>FO\d{2}-\d{4}-\d{4}-\d{4}-\d{2}</td>
</tr>
<tr>
<td>France patterns</td>
<td>FR\d{2}\d{4}\d{4}\d{2}\w{2}\w{4}\w{4}\w{4}\w{2}</td>
</tr>
<tr>
<td></td>
<td>FR\d{2} \d{4} \d{4} \d{2} \w{2} \w{4} \w{4} \w{4} \w{2}</td>
</tr>
<tr>
<td></td>
<td>FR\d{2}-\d{4}-\d{4}-\d{2} \w{2} \w{4} \w{4} \w{4} \w{2}</td>
</tr>
<tr>
<td>United Kingdom</td>
<td>GB\d{2}[A-Z]\d{4}\d{4}\d{4}\d{2}</td>
</tr>
<tr>
<td></td>
<td>GB\d{2} [A-Z]\d{4} \d{4} \d{4} \d{2}</td>
</tr>
<tr>
<td></td>
<td>GB\d{2}-[A-Z]\d{4}-\d{4}-\d{4}-\d{2}</td>
</tr>
<tr>
<td>Gibraltar patterns</td>
<td>GL\d{2}[A-Z]\w{4}\w{4}\w{4}\w{3}</td>
</tr>
<tr>
<td></td>
<td>GL\d{2} [A-Z]\w{4} \w{4} \w{4} \w{3}</td>
</tr>
<tr>
<td></td>
<td>GL\d{2}-[A-Z]\w{4}-\w{4}-\w{4}-\w{3}</td>
</tr>
<tr>
<td>Greenland patterns</td>
<td>GL\d{2}\d{4}\d{4}\d{4}\d{2}</td>
</tr>
<tr>
<td></td>
<td>GL\d{2} \d{4} \d{4} \d{4} \d{2}</td>
</tr>
<tr>
<td></td>
<td>GL\d{2}-\d{4}-\d{4}-\d{4}-\d{2}</td>
</tr>
<tr>
<td>Ireland patterns</td>
<td>IE\d{2}[A-Z]\d{4}\d{4}\d{4}\d{2}</td>
</tr>
<tr>
<td></td>
<td>IE\d{2} [A-Z]\d{4} \d{4} \d{4} \d{2}</td>
</tr>
<tr>
<td></td>
<td>IE\d{2}-[A-Z]\d{4}-\d{4}-\d{4}-\d{4}-\d{2}</td>
</tr>
<tr>
<td>Iceland patterns</td>
<td>IS\d{2}\d{4}\d{4}\d{4}\d{4}\d{2}</td>
</tr>
<tr>
<td></td>
<td>IS\d{2} \d{4} \d{4} \d{4} \d{4} \d{2}</td>
</tr>
<tr>
<td></td>
<td>IS\d{2}-\d{4}-\d{4}-\d{4}-\d{4}-\d{4}-\d{2}</td>
</tr>
<tr>
<td>Netherlands patterns</td>
<td>NL\d{2}[A-Z]\d{4}\d{4}\d{4}\d{2}</td>
</tr>
<tr>
<td></td>
<td>NL\d{2} [A-Z]\d{4} \d{4} \d{4} \d{2}</td>
</tr>
<tr>
<td></td>
<td>NL\d{2}-[A-Z]\d{4}-\d{4}-\d{4}-\d{4}-\d{2}</td>
</tr>
</tbody>
</table>
**Table 34-96** IBAN West wide breadth patterns (continued)

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NO\d{2}\d{4}\d{4}\d{3}</td>
<td>Montenegro patterns</td>
</tr>
<tr>
<td>NO\d{2} \d{4} \d{4} \d{3}</td>
<td></td>
</tr>
<tr>
<td>NO\d{2}-\d{4}-\d{4}-\d{3}</td>
<td></td>
</tr>
<tr>
<td>PT\d{2}\d{4}\d{4}\d{4}\d{4}\d{4}\d</td>
<td>Portugal patterns</td>
</tr>
<tr>
<td>PT\d{2} \d{4} \d{4} \d{4} \d{4} \d{4} \d</td>
<td></td>
</tr>
<tr>
<td>PT\d{2}-\d{4}-\d{4}-\d{4}-\d{4}-\d{4}-\d</td>
<td></td>
</tr>
<tr>
<td>SE\d{2}\d{4}\d{4}\d{4}\d{4}\d{4}</td>
<td>Sweden patterns</td>
</tr>
<tr>
<td>SE\d{2} \d{4} \d{4} \d{4} \d{4} \d{4} \d</td>
<td></td>
</tr>
<tr>
<td>SE\d{2}-\d{4}-\d{4}-\d{4}-\d{4}-\d{4}-\d</td>
<td></td>
</tr>
</tbody>
</table>

**Table 34-97** IBAN West wide breadth validator

<table>
<thead>
<tr>
<th>Validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mod 97 Validator</td>
<td>Computes the ISO 7064 Mod 97-10 checksum of the complete match.</td>
</tr>
</tbody>
</table>

**IP Address data identifier**

An IP address is the computer networking code that is used to identify devices and facilitate communications.

The IP Address data identifier detects IP addresses.

This data identifier offers three breadths of detection:

- **Wide**
  See “IP Address wide breadth” on page 752.

- **Medium**
  See “IP Address medium breadth” on page 753.

- **Narrow**
  See “IP Address narrow breadth” on page 754.

**Note:** The patterns for the IP Address data identifier are tuned to match IPv4 address formats. You can create a custom data identifier to detect IPv6 address formats. See “About IPv6 support for Network Monitor” on page 1143.
IP Address wide breadth

The wide breadth edition of the IP Address data identifier detects numbers in format DDD.DDD.DDD.DDD with an optional /DD. Each three digit group must be between 0 and 255 inclusive and the /DD must be between 0 and 32. Additionally, 0.0.0.0 is not allowed.

**Table 34-98**  IP Address wide breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{1,3}.\d{1,3}.\d{1,3}.\d{1,3}</td>
</tr>
<tr>
<td>\d{1,3}.\d{1,3}.\d{1,3}.\d{1,3}/[0-9]</td>
</tr>
<tr>
<td>\d{1,3}.\d{1,3}.\d{1,3}.\d{1,3}/[1-2][0-9]?</td>
</tr>
<tr>
<td>\d{1,3}.\d{1,3}.\d{1,3}.\d{1,3}/[3][0-2]?</td>
</tr>
</tbody>
</table>

**Table 34-99**  IP Address wide breadth validator

<table>
<thead>
<tr>
<th>Validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Basic Check</td>
<td>Every IP address must match the format x.x.x.x and every number must be less than 256.</td>
</tr>
</tbody>
</table>

IP Address medium breadth

The medium breadth edition of the IP Address data identifier detects numbers in format DDD.DDD.DDD.DDD with an optional /DD. Each three digit group must be between 0 and 255 inclusive and the /DD must be between 0 and 32. Additionally, 0.0.0.0 is not allowed. Also, eliminates as common fictitious examples all 1-digit match groups such as 1.1.1.2.

**Table 34-100**  IP Address medium breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{1,3}.\d{1,3}.\d{1,3}.\d{1,3}</td>
</tr>
<tr>
<td>\d{1,3}.\d{1,3}.\d{1,3}.\d{1,3}/[0-9]</td>
</tr>
<tr>
<td>\d{1,3}.\d{1,3}.\d{1,3}.\d{1,3}/[1-2][0-9]?</td>
</tr>
<tr>
<td>\d{1,3}.\d{1,3}.\d{1,3}.\d{1,3}/[3][0-2]?</td>
</tr>
</tbody>
</table>
Table 34-101  IP Address medium breadth validator

<table>
<thead>
<tr>
<th>Mandatory Validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Octet Check</td>
<td>Every IP address must match the format x.x.x.x, every number must be less than 256, and no IP address can contain only single-digit numbers (1.1.1.2).</td>
</tr>
</tbody>
</table>

IP Address narrow breadth

The narrow breadth edition of the IP Address data identifier detects numbers in format DDD.DDD.DDD.DDD with an optional /DD. Each three digit group must be between 0 and 255 inclusive and the /DD must be between 0 and 32. Additionally, 0.0.0.0 is not allowed. Also, eliminates as common fictitious examples all 1-digit match groups such as 1.1.1.2. Also eliminates unassigned IP addresses ("bogons").

Table 34-102  IP Address medium breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{1,3}.\d{1,3}.\d{1,3}.\d{1,3}</td>
</tr>
<tr>
<td>\d{1,3}.\d{1,3}.\d{1,3}.\d{1,3}/[0-9]</td>
</tr>
<tr>
<td>\d{1,3}.\d{1,3}.\d{1,3}.\d{1,3}/[1-2][0-9]?</td>
</tr>
<tr>
<td>\d{1,3}.\d{1,3}.\d{1,3}.\d{1,3}/[3][0-2]?</td>
</tr>
</tbody>
</table>

Table 34-103  IP Address wide breadth validator

<table>
<thead>
<tr>
<th>Mandatory Validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Octet Check</td>
<td>Every IP address must match the format x.x.x.x, every number must be less than 256, and no IP address can contain only single-digit numbers (1.1.1.2).</td>
</tr>
<tr>
<td>IP Octet Check</td>
<td>Checks whether the IP address falls into any of the &quot;Bogons&quot; ranges. If so the match is invalid.</td>
</tr>
</tbody>
</table>

IP Address wide breadth

The wide breadth edition of the IP Address data identifier detects numbers in format DDD.DDD.DDD.DDD with an optional /DD. Each three digit group must be between 0 and 255 inclusive and the /DD must be between 0 and 32. Additionally, 0.0.0.0 is not allowed.
### Table 34-104  IP Address wide breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{1,3}.\d{1,3}.\d{1,3}.\d{1,3}</td>
</tr>
<tr>
<td>\d{1,3}.\d{1,3}.\d{1,3}.\d{1,3}/[0-9]</td>
</tr>
<tr>
<td>\d{1,3}.\d{1,3}.\d{1,3}.\d{1,3}/[1-2][0-9]?</td>
</tr>
<tr>
<td>\d{1,3}.\d{1,3}.\d{1,3}.\d{1,3}/[3][0-2]?</td>
</tr>
</tbody>
</table>

### Table 34-105  IP Address wide breadth validator

<table>
<thead>
<tr>
<th>Validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Basic Check</td>
<td>Every IP address must match the format x.x.x.x and every number must be less than 256.</td>
</tr>
</tbody>
</table>

### IP Address medium breadth

The medium breadth edition of the IP Address data identifier detects numbers in format DDD.DDD.DDD.DDD with an optional /DD. Each three digit group must be between 0 and 255 inclusive and the /DD must be between 0 and 32. Additionally, 0.0.0.0 is not allowed. Also, eliminates as common fictitious examples all 1-digit match groups such as 1.1.1.2.

### Table 34-106  IP Address medium breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{1,3}.\d{1,3}.\d{1,3}.\d{1,3}</td>
</tr>
<tr>
<td>\d{1,3}.\d{1,3}.\d{1,3}.\d{1,3}/[0-9]</td>
</tr>
<tr>
<td>\d{1,3}.\d{1,3}.\d{1,3}.\d{1,3}/[1-2][0-9]?</td>
</tr>
<tr>
<td>\d{1,3}.\d{1,3}.\d{1,3}.\d{1,3}/[3][0-2]?</td>
</tr>
</tbody>
</table>

### Table 34-107  IP Address medium breadth validator

<table>
<thead>
<tr>
<th>Mandatory Validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Octet Check</td>
<td>Every IP address must match the format x.x.x.x, every number must be less than 256, and no IP address can contain only single-digit numbers (1.1.1.2).</td>
</tr>
</tbody>
</table>
IP Address narrow breadth

The narrow breadth edition of the IP Address data identifier detects numbers in format DDD.DDD.DDD.DDD with an optional /DD. Each three digit group must be between 0 and 255 inclusive and the /DD must be between 0 and 32. Additionally, 0.0.0.0 is not allowed. Also, eliminates as common fictitious examples all 1-digit match groups such as 1.1.1.2. Also eliminates unassigned IP addresses (“bogons”).

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>/d{1,3}\./d{1,3}\./d{1,3}\./d{1,3}</code></td>
</tr>
<tr>
<td><code>/d{1,3}\./d{1,3}\./d{1,3}\./d{1,3}/[0-9]</code></td>
</tr>
<tr>
<td><code>/d{1,3}\./d{1,3}\./d{1,3}\./d{1,3}/[1-2][0-9]?</code></td>
</tr>
<tr>
<td><code>/d{1,3}\./d{1,3}\./d{1,3}\./d{1,3}/[3][0-2]?</code></td>
</tr>
</tbody>
</table>

Table 34-108  IP Address medium breadth patterns

<table>
<thead>
<tr>
<th>Mandatory Validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Octet Check</td>
<td>Every IP address must match the format x.x.x.x, every number must be less than 256, and no IP address can contain only single-digit numbers (1.1.1.2).</td>
</tr>
<tr>
<td>IP Octet Check</td>
<td>Checks whether the IP address falls into any of the &quot;Bogons&quot; ranges. If so the match is invalid.</td>
</tr>
</tbody>
</table>

Table 34-109  IP Address wide breadth validator

National Drug Code (NDC) data identifier

The National Drug Code (NDC) is an identifier issued by the Food and Drug Administration (FDA) for an individual drug in the United States. An alternate format is defined by HIPAA regulations.

The National Drug Code data identifier detects the existence of an NDC as well as the HIPAA version.

This data identifier provides three breadths of detection:

- The wide breadth checks for the existence of an NDC number or its HIPAA version.
  See “Drivers License Number- FL, MI, MN States wide breadth” on page 734.
- The medium breadth restricts the patterns for detecting the numbers.
  See “Drivers License Number- FL, MI, MN States medium breadth” on page 734.
- The narrow breadth requires a keyword match.
See “Drivers License Number- FL, MI, MN States medium breadth” on page 734.

National Drug Code (NDC) wide breadth

The wide breadth edition of the National Drug Code (NDC) data identifier detects the standard FDA format, which is a 10-digit number in the format 4-4-2, 5-4-1 or 5-3-2, with the numbers separated by dashes or spaces.

This data identifier also detects the HIPAA format, an 11-digit number in the format 5-4-2. The HIPAA format may include a single asterisk to represent a missing digit.

<table>
<thead>
<tr>
<th>Patterns</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>*\d{4} \d{4} \d{2}</code></td>
</tr>
<tr>
<td><code>*\d{4}-\d{4}-\d{2}</code></td>
</tr>
<tr>
<td><code>\d{5} *\d{3} \d{2}</code></td>
</tr>
<tr>
<td><code>\d{5}-*\d{3}-\d{2}</code></td>
</tr>
<tr>
<td><code>\d{5} \d{4} *\d</code></td>
</tr>
<tr>
<td><code>\d{5}-\d{4}-*\d</code></td>
</tr>
<tr>
<td><code>\d{5} \d{4} \d{2}</code></td>
</tr>
<tr>
<td><code>\d{5}-\d{4}-\d{2}</code></td>
</tr>
</tbody>
</table>

National Drug Code (NDC) medium breadth

The medium breadth edition of the National Drug Code (NDC) data identifier detects the standard FDA format, which is a 10-digit number in the format 4-4-2, 5-4-1 or 5-3-2, with the numbers separated by dashes.

This data identifier also detects the HIPAA format, an 11-digit number in the format 5-4-2. The HIPAA format may include a single asterisk to represent a missing digit.

**Note:** The medium edition of this data identifier does not include any validators.

**Note:** The wide breadth edition of this data identifier allows for the NDC number to be space-delimited; the medium breadth edition does not. That is the difference between the wide and medium editions of this data identifier.
National Drug Code (NDC) narrow breadth

The narrow breadth edition of the National Drug Code (NDC) data identifier detects the standard FDA format, which is a 10-digit number in the format 4-4-2, 5-4-1 or 5-3-2, with the numbers separated by dashes.

This data identifier also detects the HIPAA format, an 11-digit number in the format 5-4-2. The HIPAA format may include a single asterisk to represent a missing digit. This data identifier also requires the presence of an NDC-related keyword.

<table>
<thead>
<tr>
<th>Table 34-112</th>
<th>National Drug Code (NDC) narrow breadth patterns</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pattern</td>
<td></td>
</tr>
<tr>
<td>*?\d{4}-\d{4}-\d{2}</td>
<td></td>
</tr>
<tr>
<td>\d{5}-*?\d{3}-\d{2}</td>
<td></td>
</tr>
<tr>
<td>\d{5}-\d{4}-*?\d</td>
<td></td>
</tr>
<tr>
<td>\d{5}-\d{4}-\d{2}</td>
<td></td>
</tr>
</tbody>
</table>

National Drug Code (NDC) wide breadth

The wide breadth edition of the National Drug Code (NDC) data identifier detects the standard FDA format, which is a 10-digit number in the format 4-4-2, 5-4-1 or 5-3-2, with the numbers separated by dashes or spaces.

<table>
<thead>
<tr>
<th>Table 34-113</th>
<th>National Drug Code (NDC) narrow breadth validators</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mandatory validator</td>
<td>Description</td>
</tr>
<tr>
<td>Find keywords</td>
<td>With this option selected, at least one of the following keywords or key phrases must be present for the data to be matched.</td>
</tr>
<tr>
<td>Find keywords input</td>
<td>ndc, national drug code</td>
</tr>
</tbody>
</table>
This data identifier also detects the HIPAA format, an 11-digit number in the format 5-4-2. The HIPAA format may include a single asterisk to represent a missing digit.

Table 34-114  National Drug Code (NDC) wide breadth patterns

<table>
<thead>
<tr>
<th>Patterns</th>
</tr>
</thead>
<tbody>
<tr>
<td>*\d{4} \d{4} \d{2}</td>
</tr>
<tr>
<td>*\d{4}-\d{4}-\d{2}</td>
</tr>
<tr>
<td>\d{5} *\d{3} \d{2}</td>
</tr>
<tr>
<td>\d{5}-*\d{3}-\d{2}</td>
</tr>
<tr>
<td>\d{5} \d{4} *?\d</td>
</tr>
<tr>
<td>\d{5}-\d{4}-*?\d</td>
</tr>
<tr>
<td>\d{5}\d{4} *?\d</td>
</tr>
<tr>
<td>\d{5}-\d{4}-\d{2}</td>
</tr>
</tbody>
</table>

National Drug Code (NDC) medium breadth

The medium breadth edition of the National Drug Code (NDC) data identifier detects the standard FDA format, which is a 10-digit number in the format 4-4-2, 5-4-1 or 5-3-2, with the numbers separated by dashes.

This data identifier also detects the HIPAA format, an 11-digit number in the format 5-4-2. The HIPAA format may include a single asterisk to represent a missing digit.

**Note:** The medium edition of this data identifier does not include any validators.

**Note:** The wide breadth edition of this data identifier allows for the NDC number to be space-delimited; the medium breadth edition does not. That is the difference between the wide and medium editions of this data identifier.

Table 34-115  National Drug Code (NDC) medium breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>*\d{4}-\d{4}-\d{2}</td>
</tr>
<tr>
<td>\d{5}-*?\d{3}-\d{2}</td>
</tr>
<tr>
<td>\d{5}-\d{4}-*?\d</td>
</tr>
</tbody>
</table>
Table 34-115  National Drug Code (NDC) medium breadth patterns (continued)

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{5}-\d{4}-\d{2}</td>
</tr>
</tbody>
</table>

National Drug Code (NDC) narrow breadth

The narrow breadth edition of the National Drug Code (NDC) data identifier detects the standard FDA format, which is a 10-digit number in the format 4-4-2, 5-4-1 or 5-3-2, with the numbers separated by dashes.

This data identifier also detects the HIPAA format, an 11-digit number in the format 5-4-2. The HIPAA format may include a single asterisk to represent a missing digit. This data identifier also requires the presence of an NDC-related keyword.

Table 34-116  National Drug Code (NDC) narrow breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>*?\d{4}-\d{4}-\d{2}</td>
</tr>
<tr>
<td>\d{5}-*?\d{3}-\d{2}</td>
</tr>
<tr>
<td>\d{5}-*?\d{4}</td>
</tr>
<tr>
<td>\d{5}-\d{4}-*?\d</td>
</tr>
<tr>
<td>\d{5}-\d{4}-\d{2}</td>
</tr>
</tbody>
</table>

Table 34-117  National Drug Code (NDC) narrow breadth validators

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find keywords</td>
<td>With this option selected, at least one of the following keywords or key phrases must be present for the data to be matched.</td>
</tr>
<tr>
<td>Find keywords input</td>
<td>ndc, national drug code</td>
</tr>
</tbody>
</table>

People's Republic of China ID data identifier

The People's Republic of China ID is used for residential registration, army enrollment registration, registration of marriage/divorce, traveling abroad, taking part in various national exams, and other social or civil matters in China.

The People's Republic of China ID data identifier detects the presence of this 18-digit number.

The wide breadth edition of the People's Republic of China ID data identifier detects an 18-digit number with the last number being used to validate a checksum.
### Table 34-118  People's Republic of China ID wide breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{17}[Xx]</td>
</tr>
<tr>
<td>\d{18}</td>
</tr>
</tbody>
</table>

### Table 34-119  People's Republic of China ID wide breadth validator

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>China ID checksum validator</td>
<td>Computes the checksum and validates the pattern against it.</td>
</tr>
</tbody>
</table>

### Randomized US Social Security Number (SSN) data identifier

The **Randomized US Social Security Number (SSN)** data identifier detects 9-digit numbers with the pattern DDD-DD-DDDD, separated with dashes or spaces or without separators. The number must be in valid assigned number ranges. Pattern validators eliminate common test numbers, such as 123456789 or all the same digit. The data identifier is narrow in breadth and requires the presence of a Social Security-related keyword.

In Symantec Data Loss Prevention version 12.5, the Randomized US SSN data identifier replaces the US Social Security Number (SSN) data identifier. All policy templates that implement the US SSN data identifier are updated to use the system-defined Randomized US SSN data identifier. In addition, in version 12.5 the patterns and validators for the Randomized US SSN data identifier are updated from the 12.0 version of the Randomized US SSN data identifier. Symantec recommends that you update your policies to use the version 12.5 Randomized US SSN data identifier.

See “Updating policies to use the Randomized US SSN data identifier” on page 569.

See “Use the Randomized US SSN data identifier to detect SSNs” on page 582.

**Table 34-120** lists the patterns and normalizer used by the Randomized US SSN data identifier.
Table 34-120 Randomized US SSN patterns and normalizer

<table>
<thead>
<tr>
<th>Component</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Patterns</td>
<td>[0-8]d(2) \ d(1) [1-9] \ d(4) \ d(2) \ d(3) [1-9] \ d(4) [0-8] \ d(2) \ d(1-9) \ d(5) \ d(2) [1-9] \ d(1-9) \ d(4) \ d(2) [1-9] \ d(1-9) \ d(4) \ d(2) [1-9] \ d(1-9) \ d(4)</td>
<td>Detects 9-digit numbers with the pattern DDD-DD-DDDD, separated with dashes, spaces, or none. The number must be in valid assigned number ranges</td>
</tr>
</tbody>
</table>

Data Normalizer | Digits | See “About data normalizers” on page 548. |

Table 34-121 lists the validators and data input used for the Randomized US SSN data identifier.

Table 34-121 Randomized US SSN validators and input

<table>
<thead>
<tr>
<th>Active Validators</th>
<th>Input (if any)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exclude beginning characters</td>
<td>666, 000, 123456789, 111111111, 222222222, 333333333, 444444444, 555555555, 666666666, 777777777, 888888888</td>
<td>See “Using pattern validators” on page 575.</td>
</tr>
<tr>
<td>Number Delimiter</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Exclude ending characters</td>
<td>0000</td>
<td></td>
</tr>
<tr>
<td>Find keywords</td>
<td>social security number, ssn, ss#</td>
<td></td>
</tr>
</tbody>
</table>

Singapore NRIC data identifier

The Singapore NRIC (National Registration Identity Card) is the identity document used in Singapore. The NRIC is a required document for some government procedures, commercial transactions such as the opening of a bank account, or to gain entry to premises by surrendering or exchanging for an entry pass.

The wide breadth edition of the Singapore NRIC data identifier detects 9 characters in the pattern LDDDDDDDDL. The last character is used to validate a checksum.
Table 34-122  Singapore NRIC wide breadth pattern

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>[SFTGsf]d{7}w</td>
</tr>
</tbody>
</table>

Table 34-123  Singapore NRIC wide breadth validator

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Singapore NRIC</td>
<td>Computes the Singapore NRIC checksum and validates the pattern against it.</td>
</tr>
</tbody>
</table>

South Korea Resident Registration Number data identifier

The South Korea Resident Registration Number is a 13-digit number issued to all residents of the Republic of Korea. Similar to national identification numbers in other countries, it is used to identify people in various private transactions such as in banking and employment. It is also used extensively for online identification purposes.

The South Korea Resident Registration Number data identifier detects the presence of this 13-digit number.

This data identifier provides two breadths of validation:

- The wide breadth edition matches numbers with dash delimiters or no delimiters. See “South Korea Resident Registration Number wide breadth” on page 762.
- The medium breadth edition matches a dash-delimited number only. See “South Korea Resident Registration Number medium breadth” on page 763.

This data identifier does not provide a narrow breadth option.

South Korea Resident Registration Number wide breadth

The wide breadth edition of the South Korea Resident Registration Number data identifier detects 13 numeric characters that contain encoded birth date, gender, and origin of birth. It matches with dash or no delimiters, and validates the pattern using a checksum.
Table 34-124 South Korea Resident Registration Number wide breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{2}[01]\d{123}\d{8}</td>
</tr>
<tr>
<td>\d{2}[01]\d{123}\d-\d{7}</td>
</tr>
</tbody>
</table>

Table 34-125 South Korea Resident Registration Number wide breadth validators

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number Delimiter</td>
<td>Validates a match by checking the surrounding numbers.</td>
</tr>
<tr>
<td>Advanced KRRN Validation</td>
<td>Validates that the 3rd and 4th digit are a valid month, that the 5th and 6th digit are a valid day, and the checksum matches the check digit.</td>
</tr>
</tbody>
</table>

South Korea Resident Registration Number medium breadth

The medium breadth edition of the South Korea Resident Registration Number data identifier detects 13 numeric characters that contain encoded birth date, gender, and origin of birth, also validates the pattern using a checksum. This pattern requires a dash delimiter.

Table 34-126 South Korea Resident Registration Number medium breadth pattern

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d\d[01]\d[0123]\d-\d{7}</td>
</tr>
</tbody>
</table>

Table 34-127 South Korea Resident Registration Number medium breadth validators

<table>
<thead>
<tr>
<th>Validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number Delimiter</td>
<td>Validates a match by checking the surrounding numbers.</td>
</tr>
<tr>
<td>Advanced KRRN Validation</td>
<td>Validates that the 3rd and 4th digit are a valid month, that the 5th and 6th digit are a valid day, and the checksum matches the check digit.</td>
</tr>
</tbody>
</table>

South Korea Resident Registration Number wide breadth

The wide breadth edition of the South Korea Resident Registration Number data identifier detects 13 numeric characters that contain encoded birth date, gender, and origin of birth. It matches with dash or no delimiters, and validates the pattern using a checksum.
Table 34-128 South Korea Resident Registration Number wide breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{2}[01]\d[0123]\d{8}</td>
</tr>
<tr>
<td>\d{2}[01]\d[0123]\d-\d{7}</td>
</tr>
</tbody>
</table>

Table 34-129 South Korea Resident Registration Number wide breadth validators

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number Delimiter</td>
<td>Validates a match by checking the surrounding numbers.</td>
</tr>
<tr>
<td>Advanced KRRN Validation</td>
<td>Validates that the 3rd and 4th digit are a valid month, that the 5th and 6th digit are a valid day, and the checksum matches the check digit.</td>
</tr>
</tbody>
</table>

South Korea Resident Registration Number medium breadth

The medium breadth edition of the South Korea Resident Registration Number data identifier detects 13 numeric characters that contain encoded birth date, gender, and origin of birth, also validates the pattern using a checksum. This pattern requires a dash delimiter.

Table 34-130 South Korea Resident Registration Number medium breadth pattern

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d\d[01]\d[0123]\d-\d{7}</td>
</tr>
</tbody>
</table>

Table 34-131 South Korea Resident Registration Number medium breadth validators

<table>
<thead>
<tr>
<th>Validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number Delimiter</td>
<td>Validates a match by checking the surrounding numbers.</td>
</tr>
<tr>
<td>Advanced KRRN Validation</td>
<td>Validates that the 3rd and 4th digit are a valid month, that the 5th and 6th digit are a valid day, and the checksum matches the check digit.</td>
</tr>
</tbody>
</table>

Spanish DNI ID data identifier

The Spanish DNI ID number appears on the Documento nacional de identidad (DNI) and is issued by the Spanish Hacienda Publica to every citizen of Spain. It is the most important unique identifier used in Spain used for opening accounts, signing contracts, taxes, and elections.
The wide breadth edition of the Spanish DNI ID data identifier detects an 8-digit number followed by a hyphen and letter. Optionally the letter X and a hyphen can appear at the beginning for foreign nationals. The last letter must match a checksum algorithm.

### Table 34-132  Spanish DNI ID wide breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{8}-\w</td>
</tr>
<tr>
<td>X-\d{8}-\w</td>
</tr>
</tbody>
</table>

### Table 34-133  Spanish DNI ID wide breadth validator

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DNI control key check</td>
<td>Computes the control key and checks if it is valid.</td>
</tr>
</tbody>
</table>

## SWIFT Code data identifier

The SWIFT Code is a unique identifier for banks and is managed by the Society for Worldwide Interbank Financial Telecommunications (SWIFT). The SWIFT Code is required for monetary transfers between financial institutions. It is also known as the Bank Identifier Code (BIC).

The SWIFT Code data identifier detects the presence of the SWIFT Code. This data identifier provides two breadths of validation:

- **Wide breadth**
  - See “SWIFT Code wide breadth” on page 766.
- **Narrow breadth**
  - See “SWIFT Code narrow breadth” on page 766.

### SWIFT Code wide breadth

The wide breadth edition of the SWIFT Code data identifier detects 8- or 11-character strings. The 5th and 6th characters are the country code. This breadth also requires presence of a SWIFT-related keyword.

### Table 34-134  SWIFT Code wide breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>[A-Z][6]\w{2}</td>
</tr>
</tbody>
</table>
Table 34-134  SWIFT Code wide breadth patterns (continued)

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>[A-Z]6w5</td>
</tr>
</tbody>
</table>

Table 34-135  SWIFT Code wide breadth validators

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Require beginning characters</td>
<td>With this option selected, any of the following list of values are required at the beginning of the matched data.</td>
</tr>
<tr>
<td>Find keywords</td>
<td>With this option selected, at least one of the following keywords or key phrases must be present for the data to be matched.</td>
</tr>
<tr>
<td>Find keywords input</td>
<td>bic, bic#, international organization for standardization 9362, iso 9362, iso9362, swift, swift#,swiftcode, swiftnumber, swiftroutingnumber.</td>
</tr>
</tbody>
</table>

SWIFT Code narrow breadth

The narrow breadth edition of the SWIFT Code data identifier detects 8- or 11-character strings. The 5th and 6th characters are letters referring to a country code. This breadth also requires presence of specific SWIFT-related keywords.

Table 34-136  SWIFT Code narrow breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>[A-Z]6w2</td>
</tr>
<tr>
<td>[A-Z]6w5</td>
</tr>
</tbody>
</table>

Table 34-137  SWIFT Code narrow breadth validators

<table>
<thead>
<tr>
<th>Validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Require beginning characters</td>
<td>With this option selected, any of the following list of values are required at the beginning of the matched data.</td>
</tr>
<tr>
<td>Find keywords</td>
<td>With this option selected, at least one of the following keywords or keyphrases must be present for the data to be matched.</td>
</tr>
<tr>
<td>Find keywords input</td>
<td>bic#, international organization for standardization 9362, iso 9362, iso9362, swift#,swiftcode, swiftnumber, swiftroutingnumber, swift code, swift number, swift routing number, bic number, bic code, bic #</td>
</tr>
</tbody>
</table>
SWIFT Code wide breadth

The wide breadth edition of the SWIFT Code data identifier detects 8- or 11-character strings. The 5th and 6th characters are the country code. This breadth also requires presence of a SWIFT-related keyword.

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>[A-Z]{6}\w{2}</td>
</tr>
<tr>
<td>[A-Z]{6}\w{5}</td>
</tr>
</tbody>
</table>

Table 34-138  SWIFT Code wide breadth patterns

Table 34-139  SWIFT Code wide breadth validators

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Require beginning characters</td>
<td>With this option selected, any of the following list of values are required at the beginning of the matched data.</td>
</tr>
<tr>
<td>Find keywords</td>
<td>With this option selected, at least one of the following keywords or key phrases must be present for the data to be matched.</td>
</tr>
<tr>
<td>Find keywords input</td>
<td>bic, bic#, international organization for standardization 9362, iso 9362, iso9362, swift, swift#, swiftcode, swiftnumber, swiftroutingnumber.</td>
</tr>
</tbody>
</table>

SWIFT Code narrow breadth

The narrow breadth edition of the SWIFT Code data identifier detects 8- or 11-character strings. The 5th and 6th characters are letters referring to a country code. This breadth also requires presence of specific SWIFT-related keywords.

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>[A-Z]{6}\w{2}</td>
</tr>
<tr>
<td>[A-Z]{6}\w{5}</td>
</tr>
</tbody>
</table>

Table 34-140  SWIFT Code narrow breadth patterns

Table 34-141  SWIFT Code narrow breadth validators

<table>
<thead>
<tr>
<th>Validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Require beginning characters</td>
<td>With this option selected, any of the following list of values are required at the beginning of the matched data.</td>
</tr>
</tbody>
</table>
Table 34-141  SWIFT Code narrow breadth validators (continued)

<table>
<thead>
<tr>
<th>Validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find keywords</td>
<td>With this option selected, at least one of the following keywords or keyphrases must be present for the data to be matched.</td>
</tr>
<tr>
<td>Find keywords input</td>
<td>bic#, international organization for standardization 9362, iso 9362, iso9362, swift#, swiftcode, swiftnumber, swiftroutingnumber, swift code, swift number, swift routing number, bic number, bic code, bic #</td>
</tr>
</tbody>
</table>

**Swiss AHV Number data identifier**

In Switzerland the Old Age and Survivors Insurance Fund number (Alters- und Hinterlassenenversicherungsnummer - AHV number) is the most important public ID number.

The Swiss AHV Number data identifier detects the 11-digit identifier with or without the standard period delimiter (DDD.DD.DDD.DDD) and is validated against a checksum algorithm.

Table 34-142  Swiss AHV Number wide breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{8}-\w</td>
</tr>
<tr>
<td>X-\d{8}-\w</td>
</tr>
</tbody>
</table>

Table 34-143  Swiss AHV Number wide breadth validators

<table>
<thead>
<tr>
<th>Validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Swiss AHV</td>
<td>Swiss AHV Modulus 11 Checksum.</td>
</tr>
<tr>
<td>Number Delimiter</td>
<td>Validates a match by checking the surrounding numbers.</td>
</tr>
</tbody>
</table>

**Taiwan ID data identifier**

In Taiwan an ID card is mandatory for all citizens who are over 14-years old. The ID card has been uniformly numbered since 1965.

The Taiwan ID data identifier detects the presence of Taiwan identification number based on two types of common ID patterns. The last character matched is used to validate a checksum.
Table 34-144  Taiwan ID wide breadth pattern

<table>
<thead>
<tr>
<th>Patterns</th>
</tr>
</thead>
<tbody>
<tr>
<td>[A-Z][12][0-3]d{7}</td>
</tr>
<tr>
<td>[A-Z][ABCD]d{8}</td>
</tr>
</tbody>
</table>

Table 34-145  Taiwan ID wide breadth validator

<table>
<thead>
<tr>
<th>Validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Taiwan ID</td>
<td>Taiwan ID checksum.</td>
</tr>
</tbody>
</table>

**UK Drivers License Number data identifier**

The UK Drivers License Number is the identification number for an individual's driver's license issued by the Driver and Vehicle Licensing Agency of the United Kingdom.

The UK Drivers License Number data identifier detects the presence of UK Drivers License numbers.

This data identifier provides three breadths of validation:

- **Wide**
  See “UK Drivers License Number wide breadth” on page 770.

- **Medium**
  See “UK Drivers License Number medium breadth” on page 770.

- **Narrow**
  See “UK Drivers License Number narrow breadth” on page 771.

**UK Drivers License Number wide breadth**

The wide breadth edition of the UK Drivers License Number data identifier detects 16 character strings of the following format: AAAAAAD[0,1,5,6]DDDDAAALL, where A is an alphanumeric character, D a digit, and L a letter.

**Note:** This breadth option does not include any validators.
UK Drivers License Number wide breadth patterns

Table 34-146

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>\w{5}\d[0156]\d{4}\w{3}\l{2}</td>
</tr>
<tr>
<td>\w{5} \d[0156]\d{4} \w{3}\l{2}</td>
</tr>
</tbody>
</table>

UK Drivers License Number medium breadth

The medium breadth edition of the UK Drivers License Number data identifier detects 16 character strings of the following format: AAAAAD[0,1,5,6]DDDDAAALL, where A is an alphanumeric character, D a digit, and L a letter.

The first digit in the numeric section is restricted to 0, 1, 5, or 6. In addition, the 4th and 5th digits in the numeric section must be between 01 and 31, inclusive.

Table 34-147

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>\w{5}\d[0156]\d{4}\w{3}\l{2}</td>
</tr>
<tr>
<td>\w{5} \d[0156]\d{4} \w{3}\l{2}</td>
</tr>
</tbody>
</table>

Table 34-148

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UK Drivers License</td>
<td>Every UK drivers license must be 16 characters and the number at the 8th and 9th position must be larger than 00 and smaller than 32.</td>
</tr>
</tbody>
</table>

UK Drivers License Number narrow breadth

The narrow breadth edition of the UK Drivers License Number data identifier detects 16 character strings of the following format: AAAAAD[0,1,5,6]DDDDAAALL, where A is an alphanumeric character, D is a digit, and L is a letter.

The first digit is restricted to 0, 1, 5, or 6. In addition, the 4th and 5th digits in the numeric section must be between 01 and 31, inclusive.

In addition, the narrow breadth edition also requires the presence of both a driver's license-related keyword AND a UK-related keyword.
Table 34-149  UK Drivers License Number narrow breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>\w{5}\d[0156]\d{4}\w{3}\l{2}</td>
</tr>
<tr>
<td>\w{5} \d[0156]\d{4} \w{3}\l{2}</td>
</tr>
</tbody>
</table>

Table 34-150  UK Drivers License Number narrow breadth validators

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UK Drivers License</td>
<td>Every UK drivers license must be 16 characters and the number at the 8th and 9th position must be larger than 00 and smaller than 32.</td>
</tr>
<tr>
<td>Find keywords: driver's license-related</td>
<td>At least one of the following keywords or key phrases must be present for the data to match: british, the united kingdom, uk, united kingdom, unitedkingdom</td>
</tr>
<tr>
<td>Find keywords: UK-related</td>
<td>At least one of the following keywords or keyphrases must be present for the data to match: british, the united kingdom, uk, united kingdom, unitedkingdom</td>
</tr>
</tbody>
</table>

UK Drivers License Number wide breadth

The wide breadth edition of the UK Drivers License Number data identifier detects 16 character strings of the following format: AAAAA\[0,1,5,6\]DDDDAAALL, where A is an alphanumeric character, D a digit, and L a letter.

**Note:** This breadth option does not include any validators.

Table 34-151  UK Drivers License Number wide breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>\w{5}\d[0156]\d{4}\w{3}\l{2}</td>
</tr>
<tr>
<td>\w{5} \d[0156]\d{4} \w{3}\l{2}</td>
</tr>
</tbody>
</table>

UK Drivers License Number medium breadth

The medium breadth edition of the UK Drivers License Number data identifier detects 16 character strings of the following format: AAAAA\[0,1,5,6\]DDDDAAALL, where A is an alphanumeric character, D a digit, and L a letter.
The first digit in the numeric section is restricted to 0, 1, 5, or 6. In addition, the 4th and 5th digits in the numeric section must be between 01 and 31, inclusive.

### Table 34-152  UK Drivers License Number medium breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>\w{5}\d[0156]\d{4}\w{3}\l{2}</td>
</tr>
<tr>
<td>\w{5} \d[0156]\d{4} \w{3}\l{2}</td>
</tr>
</tbody>
</table>

### Table 34-153  UK Drivers License Number medium breadth validator

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UK Drivers License</td>
<td>Every UK drivers license must be 16 characters and the number at the 8th and 9th position must be larger than 00 and smaller than 32.</td>
</tr>
</tbody>
</table>

### UK Drivers License Number narrow breadth

The narrow breadth edition of the UK Drivers License Number data identifier detects 16 character strings of the following format: AAAAAAD[0,1,5,6]DDDDAALL, where A is an alphanumeric character, D is a digit, and L is a letter.

The first digit is restricted to 0, 1, 5, or 6. In addition, the 4th and 5th digits in the numeric section must be between 01 and 31, inclusive.

In addition, the narrow breadth edition also requires the presence of both a driver's license-related keyword AND a UK-related keyword.

### Table 34-154  UK Drivers License Number narrow breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>\w{5}\d[0156]\d{4}\w{3}\l{2}</td>
</tr>
<tr>
<td>\w{5} \d[0156]\d{4} \w{3}\l{2}</td>
</tr>
</tbody>
</table>

### Table 34-155  UK Drivers License Number narrow breadth validators

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UK Drivers License</td>
<td>Every UK drivers license must be 16 characters and the number at the 8th and 9th position must be larger than 00 and smaller than 32.</td>
</tr>
</tbody>
</table>

Find keywords: driver's license-related

At least one of the following keywords or key phrases must be present for the data to match:

- british
- the united kingdom
- uk
- united kingdom
- unitedkingdom
UK Drivers License Number narrow breadth validators (continued)

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
</table>
| Find keywords: UK-related | At least one of the following keywords or keyphrases must be present for the data to match:  
british, the united kingdom, uk, united kingdom, unitedkingdom |

UK Electoral Roll Number data identifier

The Electoral Roll Number is the identification number issued to an individual for UK election registration. The format of this number is specified by the UK Government Standards of the UK Cabinet Office.

The UK Electoral Roll Number data identifier detects the presence of UK Electoral Roll Number. It implements a pattern to detect strings consisting of 2 to 3 letters, followed by 1 to 4 digits.

<table>
<thead>
<tr>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>\L{2,3}\d{1,4}</td>
</tr>
</tbody>
</table>

The wide breadth edition of the Electoral Roll Number data identifier implements two validators to require the presence of an electoral number-related keyword and a UK-related keyword.

<table>
<thead>
<tr>
<th>Validator</th>
<th>Description</th>
</tr>
</thead>
</table>
| Find keywords: electoral number-related | At least one of the following keywords or key phrases must be present for the data to match:  
electoral #, electoral number, electoral roll #, electoral roll no., electoral roll number, electoral roll#, electoral#, electoralnumber, electoralroll#, electoralrollno |
| Find keywords: UK-related | At least one of the following keywords or key phrases must be present for the data to match:  
british, the united kingdom, uk, united kingdom, unitedkingdom |
UK National Health Service (NHS) Number data identifier

The UK National Health Service (NHS) Number is the personal identification number issued by the U.K. National Health Service (NHS) for administration of medical care.

The UK National Health Service (NHS) Number data identifier detects the presence of the UK National Health Service (NHS) Number.

This data identifier provides two breadths of validation:

- **Medium**
  See “UK National Health Service (NHS) Number medium breadth” on page 775.

- **Narrow**
  See “UK National Health Service (NHS) Number narrow breadth” on page 776.

**Note:** This data identifier does not provide a wide breadth option.

UK National Health Service (NHS) Number medium breadth

The medium breadth edition of the UK National Health Service (NHS) Number data identifier implements patterns to detect numbers in the currently defined NHS format, DDD-DDD-DDDD (where D is a digit), with various separators.

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{3}.\d{3}.\d{4}</td>
<td>Pattern for detecting the format DDD-DDD-DDDD separated by periods.</td>
</tr>
<tr>
<td>\d{3} \d{3} \d{4}</td>
<td>Pattern for detecting the format DDD-DDD-DDDD separated by spaces.</td>
</tr>
<tr>
<td>\d{3}-\d{3}-\d{4}</td>
<td>Pattern for detecting the format DDD-DDD-DDDD separated by dashes.</td>
</tr>
</tbody>
</table>

The medium breadth edition of the UK National Health Service (NHS) Number data identifier implements three validators: one to validate the NHS checksum, another to perform numerical validation using the final digit, and a third to check for the presence of an NHS-related keyword.
Table 34-159  UK National Health Service (NHS) Number medium breadth validators

<table>
<thead>
<tr>
<th>Validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UK NHS</td>
<td>UK NHS checksum.</td>
</tr>
<tr>
<td>Number Delimiter</td>
<td>Validates a match by checking the surrounding numbers.</td>
</tr>
<tr>
<td>Find keywords: NHS-related</td>
<td>At least one of the following keywords or key phrases must be present for the data to match: national health service, NHS</td>
</tr>
</tbody>
</table>

**UK National Health Service (NHS) Number narrow breadth**

The narrow breadth edition of the UK National Health Service (NHS) Number data identifier implements patterns to detect numbers in the currently defined format: DDD-DDD-DDDD (where D is a digit), separated with dashes, spaces, or periods.

Table 34-160  UK National Health Service (NHS) Number narrow breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{3}\d{3}\d{4}</td>
<td>Pattern for detecting the format DDD-DDD-DDDD separated by periods.</td>
</tr>
<tr>
<td>\d{3} \d{3} \d{4}</td>
<td>Pattern for detecting the format DDD-DDD-DDDD separated by spaces.</td>
</tr>
<tr>
<td>\d{3}-\d{3}-\d{4}</td>
<td>Pattern for detecting the format DDD-DDD-DDDD separated by dashes.</td>
</tr>
</tbody>
</table>

The narrow breadth edition of the UK National Health Service (NHS) Number data identifier implements four validators: one to validate the NHS checksum, another to perform numerical validation using the final digit, a third to require the presence of an NHS-related keyword, and a fourth to require the presence of a UK-related keyword.

Table 34-161  UK National Health Service (NHS) Number narrow breadth validators

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UK NHS</td>
<td>UK NHS checksum.</td>
</tr>
<tr>
<td>Number Delimiter</td>
<td>Validates a match by checking the surrounding numbers.</td>
</tr>
</tbody>
</table>
Table 34-161  UK National Health Service (NHS) Number narrow breadth validators (continued)

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find keywords: NHS-related</td>
<td>At least one of the following keywords or key phrases must be present for the data to match: national health service, NHS</td>
</tr>
<tr>
<td>Find keywords: UK-related</td>
<td>At least one of the following keywords or key phrases must be present for the data to match: uk, united kingdom, britain, england, gb</td>
</tr>
</tbody>
</table>

UK National Health Service (NHS) Number medium breadth

The medium breadth edition of the UK National Health Service (NHS) Number data identifier implements patterns to detect numbers in the currently defined NHS format, DDD-DDD-DDDD (where D is a digit), with various separators.

Table 34-162  UK National Health Service (NHS) Number medium breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{3}.\d{3}.\d{4}</td>
<td>Pattern for detecting the format DDD-DDD-DDDD separated by periods.</td>
</tr>
<tr>
<td>\d{3} \d{3} \d{4}</td>
<td>Pattern for detecting the format DDD-DDD-DDDD separated by spaces.</td>
</tr>
<tr>
<td>\d{3}-\d{3}-\d{4}</td>
<td>Pattern for detecting the format DDD-DDD-DDDD separated by dashes.</td>
</tr>
</tbody>
</table>

The medium breadth edition of the UK National Health Service (NHS) Number data identifier implements three validators: one to validate the NHS checksum, another to perform numerical validation using the final digit, and a third to check for the presence of an NHS-related keyword.

Table 34-163  UK National Health Service (NHS) Number medium breadth validators

<table>
<thead>
<tr>
<th>Validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UK NHS</td>
<td>UK NHS checksum.</td>
</tr>
<tr>
<td>Number Delimiter</td>
<td>Validates a match by checking the surrounding numbers.</td>
</tr>
</tbody>
</table>
UK National Health Service (NHS) Number medium breadth validators (continued)

<table>
<thead>
<tr>
<th>Validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find keywords: NHS-related</td>
<td>At least one of the following keywords or key phrases must be present for the data to match: national health service, NHS</td>
</tr>
</tbody>
</table>

UK National Health Service (NHS) Number narrow breadth

The narrow breadth edition of the UK National Health Service (NHS) Number data identifier implements patterns to detect numbers in the currently defined format: DDD-DDD-DDDD (where D is a digit), separated with dashes, spaces, or periods.

Table 34-164  UK National Health Service (NHS) Number narrow breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{3}.\d{3}.\d{4}</td>
<td>Pattern for detecting the format DDD-DDD-DDDD separated by periods.</td>
</tr>
<tr>
<td>\d{3} \d{3} \d{4}</td>
<td>Pattern for detecting the format DDD-DDD-DDDD separated by spaces.</td>
</tr>
<tr>
<td>\d{3}-\d{3}-\d{4}</td>
<td>Pattern for detecting the format DDD-DDD-DDDD separated by dashes.</td>
</tr>
</tbody>
</table>

The narrow breadth edition of the UK National Health Service (NHS) Number data identifier implements four validators: one to validate the NHS checksum, another to perform numerical validation using the final digit, a third to require the presence of an NHS-related keyword, and a fourth to require the presence of a UK-related keyword.

Table 34-165  UK National Health Service (NHS) Number narrow breadth validators

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UK NHS</td>
<td>UK NHS checksum.</td>
</tr>
<tr>
<td>Number Delimiter</td>
<td>Validates a match by checking the surrounding numbers.</td>
</tr>
<tr>
<td>Find keywords: NHS-related</td>
<td>At least one of the following keywords or key phrases must be present for the data to match: national health service, NHS</td>
</tr>
</tbody>
</table>
UK National Insurance Number data identifier

The UK National Insurance Number is issued by the United Kingdom Department for Work and Pensions (DWP) to identify an individual for the national insurance program. It is also known as a NI number, NINO or NINo.

The UK National Insurance Number data identifier detects the presence of the UK National Insurance Number.

This data identifier provides three breadths of validation:

- **Wide**
  
  See “UK National Insurance Number wide breadth” on page 779.

- **Medium**
  
  See “UK National Insurance Number medium breadth” on page 779.

- **Narrow**
  
  See “UK National Insurance Number narrow breadth” on page 780.

UK National Insurance Number wide breadth

The wide breadth edition of the UK National Insurance Number data identifier implements patterns to detect 9-digit numbers of the format LL DD DD DD L (where L is a letter and D is a digit), separated by spaces, periods, dashes, or together in a string.

The first and second letter cannot be D, F, I, Q, U and V. The second letter also cannot be O.

Table 34-166 UK National Insurance Number wide breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
</table>
Table 34-166  UK National Insurance Number wide breadth patterns (continued)

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
</table>

UK National Insurance Number medium breadth

The medium breadth edition of the UK National Insurance Number data identifier implements patterns to detect 9-digit numbers of the format LL DD DD DD L (where L is a letter and D is a digit), separated by spaces or together in a string.

The first and second letter cannot be D, F, I, Q, U and V; the second letter cannot be O.

Table 34-167  UK National Insurance Number medium breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
</table>

UK National Insurance Number narrow breadth

The narrow breadth edition of the UK National Insurance Number data identifier implements patterns to detect 9-digit numbers of the format LL DD DD DD L (where L is a letter and D is a digit), separated by spaces or together in a string.

The first and second letter cannot be D, F, I, Q, U and V. The second letter also cannot be O.

Table 34-168  UK National Insurance Number narrow breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
</table>
The narrow breadth edition of the UK National Insurance Number data identifier implements a validator that requires the presence of a national insurance-related keyword.

Table 34-169  UK National Insurance Number narrow breadth validator

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find keywords: Insurance-related</td>
<td>At least one of the following keywords or key phrases must be present for the data to match: insurance no., insurance number, insurance#, insurancenumber, national insurance number, nationalinsurance#, nationalinsurancenumber, nin, nino</td>
</tr>
</tbody>
</table>

UK National Insurance Number wide breadth

The wide breadth edition of the UK National Insurance Number data identifier implements patterns to detect 9-digit numbers of the format LL DD DD DD L (where L is a letter and D is a digit), separated by spaces, periods, dashes, or together in a string.

The first and second letter cannot be D, F, I, Q, U and V. The second letter also cannot be O.

Table 34-170  UK National Insurance Number wide breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
</table>

UK National Insurance Number medium breadth

The medium breadth edition of the UK National Insurance Number data identifier implements patterns to detect 9-digit numbers of the format LL DD DD DD L (where L is a letter and D is a digit), separated by spaces or together in a string.

The first and second letter cannot be D, F, I, Q, U and V; the second letter also cannot be O.
UK National Insurance Number medium breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
</table>

UK National Insurance Number narrow breadth

The narrow breadth edition of the UK National Insurance Number data identifier implements patterns to detect 9-digit numbers of the format LL DD DD DD L (where L is a letter and D is a digit), separated by spaces or together in a string.

The first and second letter cannot be D, F, I, Q, U and V. The second letter also cannot be O.

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
</table>

The narrow breadth edition of the UK National Insurance Number data identifier implements a validator that requires the presence of a national insurance-related keyword.

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find keywords:</td>
<td>At least one of the following keywords or key phrases must be present for the data to match:</td>
</tr>
<tr>
<td>Insurance-related</td>
<td>insurance no., insurance number, insurance#, insurancenumber, national insurance number, nationalinsurance#, nationalinsurancenumber, nin, nino</td>
</tr>
</tbody>
</table>
UK Passport Number data identifier

The UK Passport Number identifies a United Kingdom passport using the current official specification of the UK Government Standards of the UK Cabinet Office.

The UK Passport Number data identifier detects the presence of the UK Passport Number.

This data identifier provides three breadths of validation:

- **Wide**
  See “UK Passport Number wide breadth” on page 783.

- **Medium**
  See “UK Passport Number medium breadth” on page 783.

- **Narrow**
  See “UK Passport Number narrow breadth” on page 784.

UK Passport Number wide breadth

The wide breadth edition of the UK Passport Number data identifier implements a pattern to detect 9-digit numbers.

**Note:** The wide breadth edition of the UK Passport Number data identifier does not include any validators.

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{9}</td>
<td>Pattern for detecting 9-digit numbers.</td>
</tr>
</tbody>
</table>

UK Passport Number medium breadth

The medium breadth edition of the UK Passport Number data identifier implements a pattern to detect 9-digit numbers.

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{9}</td>
<td>Pattern for detecting 9-digit numbers.</td>
</tr>
</tbody>
</table>

The medium breadth edition of the UK Passport Number data identifier implements three validators: one to eliminate common test numbers, such as 123456789;
another to eliminate numbers with all the same digits; and a third that requires the presence of a passport-related keyword.

**UK Passport Number narrow breadth**

The narrow breadth edition of the UK Passport Number data identifier implements a pattern to detect 9-digit numbers.

**Table 34-177** UK Passport Number narrow breadth pattern

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{9}</td>
<td>Pattern for detecting 9-digit numbers.</td>
</tr>
</tbody>
</table>

The narrow breadth edition of the UK Passport Number data identifier implements four validators: one to eliminate common test numbers, such as 123456789; another to eliminate numbers with all the same digits; a third that requires the presence of a passport-related keyword; and a fourth that requires the presence of a UK-related keyword.

**Table 34-178** UK Passport Number narrow breadth validators

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exclude beginning characters</td>
<td>Data beginning with any of the following list of values will not be matched: 123456789</td>
</tr>
<tr>
<td>Duplicate digits</td>
<td>Ensures that a string of digits are not all the same.</td>
</tr>
<tr>
<td>Find keywords: Passport-related</td>
<td>At least one of the following keywords or key phrases must be present for the data to match: passport, passport#, passportID, passportno, passportnumber</td>
</tr>
</tbody>
</table>
Table 34-178  UK Passport Number narrow breadth validators (continued)

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find keywords: UK-related</td>
<td>At least one of the following keywords or key phrases must be present for the data to match:</td>
</tr>
<tr>
<td></td>
<td>uk, united kingdom, britain, england, gb</td>
</tr>
</tbody>
</table>

UK Passport Number wide breadth

The wide breadth edition of the UK Passport Number data identifier implements a pattern to detect 9-digit numbers.

Note: The wide breadth edition of the UK Passport Number data identifier does not include any validators.

Table 34-179  UK Passport Number wide breadth pattern

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{9}</td>
<td>Pattern for detecting 9-digit numbers.</td>
</tr>
</tbody>
</table>

UK Passport Number medium breadth

The medium breadth edition of the UK Passport Number data identifier implements a pattern to detect 9-digit numbers.

Table 34-180  UK Passport Number medium breadth pattern

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{9}</td>
<td>Pattern for detecting 9-digit numbers.</td>
</tr>
</tbody>
</table>

The medium breadth edition of the UK Passport Number data identifier implements three validators: one to eliminate common test numbers, such as 123456789; another to eliminate numbers with all the same digits; and a third that requires the presence of a passport-related keyword.

Table 34-181  UK Passport Number medium breadth validators

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exclude beginning characters</td>
<td>Data beginning with any of the following list of values will not be matched:</td>
</tr>
<tr>
<td></td>
<td>123456789</td>
</tr>
</tbody>
</table>
Table 34-181  UK Passport Number medium breadth validators (continued)

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duplicate digits</td>
<td>Ensures that a string of digits are not all the same.</td>
</tr>
<tr>
<td>Find keywords: Passport-related</td>
<td>At least one of the following keywords or key phrases must be present for the data to match: passport, passport#, passportID, passportno, passportnumber</td>
</tr>
</tbody>
</table>

UK Passport Number narrow breadth

The narrow breadth edition of the UK Passport Number data identifier implements a pattern to detect 9-digit numbers.

Table 34-182  UK Passport Number narrow breadth pattern

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{9}</td>
<td>Pattern for detecting 9-digit numbers.</td>
</tr>
</tbody>
</table>

The narrow breadth edition of the UK Passport Number data identifier implements four validators: one to eliminate common test numbers, such as 123456789; another to eliminate numbers with all the same digits; a third that requires the presence of a passport-related keyword; and a fourth that requires the presence of a UK-related keyword.

Table 34-183  UK Passport Number narrow breadth validators

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exclude beginning characters</td>
<td>Data beginning with any of the following list of values will not be matched: 123456789</td>
</tr>
<tr>
<td>Duplicate digits</td>
<td>Ensures that a string of digits are not all the same.</td>
</tr>
<tr>
<td>Find keywords: Passport-related</td>
<td>At least one of the following keywords or key phrases must be present for the data to match: passport, passport#, passportID, passportno, passportnumber</td>
</tr>
<tr>
<td>Find keywords: UK-related</td>
<td>At least one of the following keywords or key phrases must be present for the data to match: uk, united kingdom, britain, england, gb</td>
</tr>
</tbody>
</table>
**UK Tax ID Number data identifier**

The UK Tax ID Number is a personal identification number provided by the UK Government Standards of the UK Cabinet Office.

The UK Tax ID Number data identifier detects the presence of the UK Tax ID numbers.

This data identifier provides three breadths of validation:

- **Wide**
  See “UK Tax ID Number wide breadth” on page 787.

- **Medium**
  See “UK Tax ID Number medium breadth” on page 787.

- **Narrow**
  See “UK Tax ID Number narrow breadth” on page 787.

**UK Tax ID Number wide breadth**

The wide breadth edition of the UK Tax ID Number data identifier implements a single pattern to detect 10-digit numbers.

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{10}</td>
<td>Pattern for detecting 10-digit numbers.</td>
</tr>
</tbody>
</table>

**Note:** The wide breadth edition of the UK Tax ID Number data identifier does not include any validators.

**Table 34-184**  
UK Passport Number wide breadth pattern

**UK Tax ID Number medium breadth**

The medium breadth edition of the UK Tax ID Number data identifier implements a single pattern to detect 10-digit numbers.

**Table 34-185**  
UK Tax ID Number medium breadth pattern

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{10}</td>
<td>Pattern for detecting 10-digit numbers.</td>
</tr>
</tbody>
</table>
The medium breadth edition of the UK Tax ID Number data identifier implements two validators: one to eliminate common test numbers, such as 1234567890, and another to eliminate numbers with all the same digit.

**Table 34-186**  UK Tax ID Number medium breadth validators

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duplicate digits</td>
<td>Ensures that a string of digits are not all the same.</td>
</tr>
<tr>
<td>Exclude beginning characters</td>
<td>Data beginning with any of the following list of values will not be matched:</td>
</tr>
<tr>
<td></td>
<td>0123456789, 1234567890, 9876543210, 0987654321</td>
</tr>
</tbody>
</table>

**UK Tax ID Number narrow breadth**

The narrow breadth edition of the UK Tax ID Number data identifier implements a single pattern to detect 10-digit numbers.

**Table 34-187**  UK Tax ID Number narrow breadth pattern

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{10}</td>
<td>Pattern for detecting 10-digit numbers.</td>
</tr>
</tbody>
</table>

The narrow breadth edition of the UK Tax ID Number data identifier implements three validators: one to eliminate common test numbers, such as 1234567890; another to eliminate numbers with all the same digit; and a third that requires the presence of a tax identification-related keyword.

**Table 34-188**  UK Tax ID Number narrow breadth validators

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duplicate digits</td>
<td>Ensures that a string of digits are not all the same.</td>
</tr>
<tr>
<td>Exclude beginning characters</td>
<td>Data beginning with any of the following list of values will not be matched:</td>
</tr>
<tr>
<td></td>
<td>0123456789, 1234567890, 9876543210, 0987654321</td>
</tr>
<tr>
<td>Find keywords: Tax ID-related</td>
<td>At least one of the following keywords or key phrases must be present for the data to match:</td>
</tr>
<tr>
<td></td>
<td>tax id, tax id no., tax id number, tax identification, tax identification#, tax no., tax#, taxid#</td>
</tr>
</tbody>
</table>
UK Tax ID Number wide breadth

The wide breadth edition of the UK Tax ID Number data identifier implements a single pattern to detect 10-digit numbers.

Note: The wide breadth edition of the UK Tax ID Number data identifier does not include any validators.

Table 34-189  UK Passport Number wide breadth pattern

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{10}</td>
<td>Pattern for detecting 10-digit numbers.</td>
</tr>
</tbody>
</table>

UK Tax ID Number medium breadth

The medium breadth edition of the UK Tax ID Number data identifier implements a single pattern to detect 10-digit numbers.

Table 34-190  UK Tax ID Number medium breadth pattern

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{10}</td>
<td>Pattern for detecting 10-digit numbers.</td>
</tr>
</tbody>
</table>

The medium breadth edition of the UK Tax ID Number data identifier implements two validators: one to eliminate common test numbers, such as 1234567890, and another to eliminate numbers with all the same digit.

Table 34-191  UK Tax ID Number medium breadth validators

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duplicate digits</td>
<td>Ensures that a string of digits are not all the same.</td>
</tr>
<tr>
<td>Exclude beginning characters</td>
<td>Data beginning with any of the following list of values will not be matched:</td>
</tr>
<tr>
<td></td>
<td>0123456789, 1234567890, 9876543210, 0987654321</td>
</tr>
</tbody>
</table>

UK Tax ID Number narrow breadth

The narrow breadth edition of the UK Tax ID Number data identifier implements a single pattern to detect 10-digit numbers.
Table 34-192  UK Tax ID Number narrow breadth pattern

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{10}</td>
<td>Pattern for detecting 10-digit numbers.</td>
</tr>
</tbody>
</table>

The narrow breadth edition of the UK Tax ID Number data identifier implements three validators: one to eliminates common test numbers, such as 1234567890; another to eliminate numbers with all the same digit; and a third that requires the presence of a tax identification-related keyword.

Table 34-193  UK Tax ID Number narrow breadth validators

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duplicate digits</td>
<td>Ensures that a string of digits are not all the same.</td>
</tr>
<tr>
<td>Exclude beginning characters</td>
<td>Data beginning with any of the following list of values will not be matched:</td>
</tr>
<tr>
<td></td>
<td>0123456789, 1234567890, 9876543210, 0987654321</td>
</tr>
<tr>
<td>Find keywords: Tax ID-related</td>
<td>At least one of the following keywords or key phrases must be present for the data to match:</td>
</tr>
<tr>
<td></td>
<td>tax id, tax id no., tax id number, tax identification, tax identification#, tax no., tax#, taxid#</td>
</tr>
</tbody>
</table>

US Individual Tax Identification Number (ITIN) data identifier

The US Individual Tax Identification Number (ITIN) is used for tax processing and is issued by the United States Internal Revenue Service (IRS). The IRS issues ITINs to track individuals who are not eligible to obtain Social Security Numbers (SSNs).

The US Individual Tax Identification Number (ITIN) data identifier detects the presence of US ITIN numbers.

This data identifier provides three breadths of validation:

- Wide
  See “US Individual Tax Identification Number (ITIN) wide breadth” on page 791.

- Medium
  See “US Individual Tax Identification Number (ITIN) medium breadth” on page 791.
Narrow
See “US Individual Tax Identification Number (ITIN) narrow breadth” on page 792.

US Individual Tax Identification Number (ITIN) wide breadth

The wide breadth edition of the US Individual Tax Identification Number (ITIN) data identifier implements patterns to detect 9-digit numbers with the pattern DDD-DD-DDDD separated with dashes, spaces, periods, slashes, or without separators.

The number must begin with a 9 and have a 7 or 8 as the fourth digit.

Note: The wide breadth edition of the US Individual Tax Identification Number (ITIN) data identifier does not include any validators.

Table 34-194  US Individual Tax Identification Number (ITIN) wide breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>9\d{2}\d\d\d\d</td>
<td>Pattern for detecting the ITIN format without separators.</td>
</tr>
<tr>
<td>9\d{2}\\d\d\d\d</td>
<td>Pattern for detecting the ITIN format without separators.</td>
</tr>
<tr>
<td>9\d{2}/\d\d\d\d</td>
<td>Pattern for detecting the ITIN format separated by slashes.</td>
</tr>
<tr>
<td>9\d{2}.\d\d\d\d</td>
<td>Pattern for detecting the ITIN format separated by periods.</td>
</tr>
<tr>
<td>9\d{2}\ \d\d\d\d</td>
<td>Pattern for detecting the ITIN format separated by spaces.</td>
</tr>
<tr>
<td>9\d{2}-\d\d\d\d</td>
<td>Pattern for detecting the ITIN format separated by dashes.</td>
</tr>
</tbody>
</table>

US Individual Tax Identification Number (ITIN) medium breadth

The medium breadth edition of the US Individual Tax Identification Number (ITIN) data identifier implements patterns to detect 9-digit numbers with the pattern DDD-DD-DDDD separated with dashes, spaces, or periods.

The number must begin with a 9 and have a 7 or 8 as the fourth digit.

Table 34-195  US Individual Tax Identification Number (ITIN) medium breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>9\d{2}.\d\d\d\d</td>
<td>Pattern for detecting the ITIN format separated by periods.</td>
</tr>
<tr>
<td>9\d{2}\ \d\d\d\d</td>
<td>Pattern for detecting the ITIN format separated by spaces.</td>
</tr>
</tbody>
</table>
The medium breadth edition of the US Individual Tax Identification Number (ITIN) data identifier implements a single validator to check the surrounding characters.

Table 34-196  US Individual Tax Identification Number (ITIN) medium breadth validator

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number Delimiter</td>
<td>Validates a match by checking the surrounding characters.</td>
</tr>
</tbody>
</table>

US Individual Tax Identification Number (ITIN) narrow breadth

The narrow breadth edition of the US Individual Tax Identification Number (ITIN) data identifier implements patterns to detect 9-digit numbers with the pattern `DDD-DD-DDDD` separated with dashes or spaces.

The number must begin with a 9 and have a 7 or 8 as the fourth digit.

Table 34-197  US Individual Tax Identification Number (ITIN) narrow breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>9\d{2}-{78}\d{-\d{4}</td>
<td>Pattern for detecting the ITIN format separated by dashes.</td>
</tr>
<tr>
<td>9\d{2} {78}\d {-\d{4}</td>
<td>Pattern for detecting the ITIN format separated by spaces.</td>
</tr>
</tbody>
</table>

The narrow breadth edition of the US Individual Tax Identification Number (ITIN) data identifier implements three validators: one to check the surrounding characters, another to ensure that the digits in the ITIN string are not all the same, and a third that requires the presence of a ITIN-related keyword.

Table 34-198  US Individual Tax Identification Number (ITIN) narrow breadth validators

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number Delimiter</td>
<td>Validates a match by checking the surrounding characters.</td>
</tr>
<tr>
<td>Duplicate digits</td>
<td>Ensures that a string of digits are not all the same.</td>
</tr>
</tbody>
</table>
US Individual Tax Identification Number (ITIN) narrow breadth
validators (continued)

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find keywords: ITIN-related</td>
<td>At least one of the following keywords or key phrases must be present for the data to be matched.</td>
</tr>
<tr>
<td>individual taxpayer identification number, itin, i.t.i.n.</td>
<td></td>
</tr>
</tbody>
</table>

**US Individual Tax Identification Number (ITIN) wide breadth**

The wide breadth edition of the US Individual Tax Identification Number (ITIN) data identifier implements patterns to detect 9-digit numbers with the pattern DDD-DD-DDDD separated with dashes, spaces, periods, slashes, or without separators.

The number must begin with a 9 and have a 7 or 8 as the fourth digit.

**Note:** The wide breadth edition of the US Individual Tax Identification Number (ITIN) data identifier does not include any validators.

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>9\d{2}[78]\d\d\d\d</td>
<td>Pattern for detecting the ITIN format without separators.</td>
</tr>
<tr>
<td>9\d{2}\\d{4}</td>
<td>Pattern for detecting the ITIN format without separators.</td>
</tr>
<tr>
<td>9\d{2}/[78]\d/\d\d\d</td>
<td>Pattern for detecting the ITIN format separated by slashes.</td>
</tr>
<tr>
<td>9\d{2}.[78]\d.\d\d\d</td>
<td>Pattern for detecting the ITIN format separated by periods.</td>
</tr>
<tr>
<td>9\d{2}[78]\d \d\d\d</td>
<td>Pattern for detecting the ITIN format separated by spaces.</td>
</tr>
<tr>
<td>9\d{2}-[78]\d-\d\d\d</td>
<td>Pattern for detecting the ITIN format separated by dashes.</td>
</tr>
</tbody>
</table>

**US Individual Tax Identification Number (ITIN) medium breadth**

The medium breadth edition of the US Individual Tax Identification Number (ITIN) data identifier implements patterns to detect 9-digit numbers with the pattern DDD-DD-DDDD separated with dashes, spaces, or periods.

The number must begin with a 9 and have a 7 or 8 as the fourth digit.
Table 34-200  US Individual Tax Identification Number (ITIN) medium breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>9\d{2}.[78]\d\d{4}</td>
<td>Pattern for detecting the ITIN format separated by periods.</td>
</tr>
<tr>
<td>9\d{2} [78]\d \d{4}</td>
<td>Pattern for detecting the ITIN format separated by spaces.</td>
</tr>
<tr>
<td>9\d{2}-[78]\d-\d{4}</td>
<td>Pattern for detecting the ITIN format separated by dashes.</td>
</tr>
</tbody>
</table>

The medium breadth edition of the US Individual Tax Identification Number (ITIN) data identifier implements a single validator to check the surrounding characters.

Table 34-201  US Individual Tax Identification Number (ITIN) medium breadth validator

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number Delimiter</td>
<td>Validates a match by checking the surrounding characters.</td>
</tr>
</tbody>
</table>

US Individual Tax Identification Number (ITIN) narrow breadth

The narrow breadth edition of the US Individual Tax Identification Number (ITIN) data identifier implements patterns to detect 9-digit numbers with the pattern DDD-DD-DDDD separated with dashes or spaces.

The number must begin with a 9 and have a 7 or 8 as the fourth digit.

Table 34-202  US Individual Tax Identification Number (ITIN) narrow breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>9\d{2} [78]\d \d{4}</td>
<td>Pattern for detecting the ITIN format separated by spaces.</td>
</tr>
<tr>
<td>9\d{2}-[78]\d-\d{4}</td>
<td>Pattern for detecting the ITIN format separated by dashes.</td>
</tr>
</tbody>
</table>

The narrow breadth edition of the US Individual Tax Identification Number (ITIN) data identifier implements three validators: one to check the surrounding characters, another to ensure that the digits in the ITIN string are not all the same, and a third that requires the presence of a ITIN-related keyword.
Table 34-203  US Individual Tax Identification Number (ITIN) narrow breadth validators

<table>
<thead>
<tr>
<th>Mandatory validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number Delimiter</td>
<td>Validates a match by checking the surrounding characters.</td>
</tr>
<tr>
<td>Duplicate digits</td>
<td>Ensures that a string of digits are not all the same.</td>
</tr>
<tr>
<td>Find keywords: ITIN-related</td>
<td>At least one of the following keywords or key phrases must be present for the data to be matched.</td>
</tr>
</tbody>
</table>

**US Social Security Number (SSN) data identifier**

**Note:** Starting with Symantec Data Loss Prevention version 12.5, the US Social Security Number (SSN) data identifier is replaced by the Randomized US Social Security Number (SSN) data identifier. Policy templates that use the US SSN data identifier are updated to use the Randomized US SSN data identifier. Symantec recommends that you update your SSN policies to use the Randomized US SSN data identifier. See “Randomized US Social Security Number (SSN) data identifier” on page 759.

The US Individual Tax Identification Number (ITIN) is a personal identification number issued by the Social Security Administration of the United States government. Although primarily used for administering the Social Security program, it is widely used as a personal identification number in many purposes.

The US Social Security Number (SSN) data identifier detects the presence of US Social Security numbers.

This data identifier provides three breadths of validation:

- **Wide**
  See “US Social Security Number (SSN) wide breadth” on page 796.

- **Medium**
  See “US Social Security Number (SSN) medium breadth” on page 797.

- **Narrow**
  See “US Social Security Number (SSN) narrow breadth” on page 798.
US Social Security Number (SSN) wide breadth

The wide breadth edition of the US Social Security Number (SSN) data identifier implements patterns to detect 9-digit numbers with the pattern DDD-DD-DDDD separated with dashes, spaces, periods, slashes, or without separators.

The number must begin with a 9 and have a 7 or 8 as the fourth digit.

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{3}-\d{2}-\d{4}</td>
<td>Matches the standard SSN format, which is any three digits followed by a hyphen, two digits, a hyphen, and any four digits.</td>
</tr>
<tr>
<td>\d{3}\d{2}\d{4}</td>
<td>Matches the SSN format delimited by periods.</td>
</tr>
<tr>
<td>\d{3}\d{2}\d{4}</td>
<td>Matches the SSN format delimited by spaces.</td>
</tr>
<tr>
<td>\d{3}\d{2}\d{4}</td>
<td>Matches the SSN format delimited by backslashes.</td>
</tr>
<tr>
<td>\d{3}\d{2}\d{4}</td>
<td>Matches the SSN format delimited by forward slashes.</td>
</tr>
<tr>
<td>\d{9}</td>
<td>Matches any 9-digit number that is not delimited.</td>
</tr>
</tbody>
</table>

The wide breadth edition of the US Social Security Number (SSN) data identifier implements three validators to ensure that the detected SSN is within validly assigned number ranges, eliminate common test numbers, such as 123456789, and all the same digit.

<table>
<thead>
<tr>
<th>Validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number Delimiter</td>
<td>Validates a match by checking the surrounding characters.</td>
</tr>
<tr>
<td>Advanced SSN</td>
<td>Checks whether SSN contains zeros in any group, the area number (first group) is less than 773 and not 666, the delimiter between the groups is the same, the number does not consist of all the same digits, and the number is not reserved for advertising (123-45-6789, 987-65-432x).</td>
</tr>
<tr>
<td>SSN Area-Group number</td>
<td>For a given area number (first group), not all group numbers (second group) might have been assigned by the SSA. Validator eliminates SSNs with invalid group numbers.</td>
</tr>
</tbody>
</table>
US Social Security Number (SSN) medium breadth

The medium breadth edition of the US Social Security Number (SSN) data identifier implements patterns to detects 9-digit numbers with the pattern DDD-DD-DDDD separated with dashes, spaces, or periods.

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{3}-\d{2}-\d{4}</td>
<td>Matches the standard SSN format, which is any three digits followed by a hyphen, two digits, a hyphen, and any four digits.</td>
</tr>
<tr>
<td>\d{3}.\d{2}.\d{4}</td>
<td>Matches the SSN format delimited by periods.</td>
</tr>
<tr>
<td>\d{3} \d{2} \d{4}</td>
<td>Matches the SSN format delimited by spaces.</td>
</tr>
</tbody>
</table>

The medium breadth edition of the US Social Security Number (SSN) data identifier implements three validators to ensure that the detected SSN is within validly assigned number ranges, is not a common test number (such as 123456789), and is not all the same digit.

<table>
<thead>
<tr>
<th>Validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number Delimiter</td>
<td>Validates a match by checking the surrounding characters.</td>
</tr>
<tr>
<td>Advanced SSN</td>
<td>Checks whether SSN contains zeros in any group, the area number (first group) is less than 773 and not 666, the delimiter between the groups is the same, the number does not consist of all the same digits, and the number is not reserved for advertising (123-45-6789, 987-65-432x).</td>
</tr>
<tr>
<td>SSN Area-Group number</td>
<td>For a given area number (first group), not all group numbers (second group) might have been assigned by the SSA. Validator eliminates SSNs with invalid group numbers.</td>
</tr>
</tbody>
</table>

US Social Security Number (SSN) narrow breadth

The narrow breadth edition of the US Social Security Number (SSN) data identifier implements patterns to detects 9-digit numbers with the pattern DDD-DD-DDDD separated with dashes or spaces or without separators.
Table 34-208  US Social Security Number (SSN) narrow breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{3}-\d{2}-\d{4}</td>
<td>Matches the standard SSN format, which is any three digits followed by a hyphen, two digits, another hyphen, and any four digits.</td>
</tr>
<tr>
<td>\d{3} \d{2} \d{4}</td>
<td>Matches the SSN format delimited by spaces.</td>
</tr>
<tr>
<td>\d{9}</td>
<td>Matches any 9-digit number not delimited.</td>
</tr>
</tbody>
</table>

The narrow breadth edition of the US Social Security Number (SSN) data identifier implements four validators to ensure that the detected SSN is within validly assigned number ranges, is not a common test number (such as 123456789), is not all the same digit, and the message containing the SSN includes a keyword.

Table 34-209  Social Security Number (SSN) narrow breadth validators

<table>
<thead>
<tr>
<th>Mandatory Validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number Delimiter</td>
<td>Validates a match by checking the surrounding characters.</td>
</tr>
<tr>
<td>Advanced SSN</td>
<td>Checks whether SSN contains zeros in any group, the area number (first group) is less than 773 and not 666, the delimiter between the groups is the same, the number does not consist of all the same digits, and the number is not reserved for advertising (123-45-6789, 987-65-432x).</td>
</tr>
<tr>
<td>SSN Area-Group number</td>
<td>For a given area number (first group), not all group numbers (second group) might have been assigned by the SSA. Validator eliminates SSNs with invalid group numbers.</td>
</tr>
<tr>
<td>Find keywords: Social security-related</td>
<td>At least one of the following keywords or key phrases must be present for the data to be matched: social security number, ssn, ss#</td>
</tr>
</tbody>
</table>

US Social Security Number (SSN) wide breadth

The wide breadth edition of the US Social Security Number (SSN) data identifier implements patterns to detect 9-digit numbers with the pattern DDD-DD-DDDD separated with dashes, spaces, periods, slashes, or without separators. The number must begin with a 9 and have a 7 or 8 as the fourth digit.
Table 34-210  Social Security Number (SSN) wide breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{3}-\d{2}-\d{4}</td>
<td>Matches the standard SSN format, which is any three digits followed by a hyphen, two digits, a hyphen, and any four digits.</td>
</tr>
<tr>
<td>\d{3}.\d{2}.\d{4}</td>
<td>Matches the SSN format delimited by periods.</td>
</tr>
<tr>
<td>\d{3} \d{2} \d{4}</td>
<td>Matches the SSN format delimited by spaces.</td>
</tr>
<tr>
<td>\d{3}\d{2}\d{4}</td>
<td>Matches the SSN format delimited by backslashes.</td>
</tr>
<tr>
<td>\d{3}\d{2}\d{4}</td>
<td>Matches the SSN format delimited by forward slashes.</td>
</tr>
<tr>
<td>\d{9}</td>
<td>Matches any 9-digit number that is not delimited.</td>
</tr>
</tbody>
</table>

The wide breadth edition of the US Social Security Number (SSN) data identifier implements three validators to ensure that the detected SSN is within validly assigned number ranges, eliminate common test numbers, such as 123456789, and all the same digit.

Table 34-211  Social Security Number (SSN) wide breadth validators

<table>
<thead>
<tr>
<th>Validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number Delimiter</td>
<td>Validates a match by checking the surrounding characters.</td>
</tr>
<tr>
<td>Advanced SSN</td>
<td>Checks whether SSN contains zeros in any group, the area number (first group) is less than 773 and not 666, the delimiter between the groups is the same, the number does not consist of all the same digits, and the number is not reserved for advertising (123-45-6789, 987-65-432x).</td>
</tr>
<tr>
<td>SSN Area-Group number</td>
<td>For a given area number (first group), not all group numbers (second group) might have been assigned by the SSA. Validator eliminates SSNs with invalid group numbers.</td>
</tr>
</tbody>
</table>

US Social Security Number (SSN) medium breadth

The medium breadth edition of the US Social Security Number (SSN) data identifier implements patterns to detects 9-digit numbers with the pattern DDD-DD-DDDD separated with dashes, spaces, or periods.
Table 34-212  Social Security Number (SSN) medium breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{3}-\d{2}-\d{4}</td>
<td>Matches the standard SSN format, which is any three digits followed by a hyphen, two digits, a hyphen, and any four digits.</td>
</tr>
<tr>
<td>\d{3}.\d{2}.\d{4}</td>
<td>Matches the SSN format delimited by periods.</td>
</tr>
<tr>
<td>\d{3} \d{2} \d{4}</td>
<td>Matches the SSN format delimited by spaces.</td>
</tr>
</tbody>
</table>

The medium breadth edition of the US Social Security Number (SSN) data identifier implements three validators to ensure that the detected SSN is within validly assigned number ranges, is not a common test number (such as 123456789), and is not all the same digit.

Table 34-213  Social Security Number (SSN) medium breadth validators

<table>
<thead>
<tr>
<th>Validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number Delimiter</td>
<td>Validates a match by checking the surrounding characters.</td>
</tr>
<tr>
<td>Advanced SSN</td>
<td>Checks whether SSN contains zeros in any group, the area number (first group) is less than 773 and not 666, the delimiter between the groups is the same, the number does not consist of all the same digits, and the number is not reserved for advertising (123-45-6789, 987-65-432x).</td>
</tr>
<tr>
<td>SSN Area-Group number</td>
<td>For a given area number (first group), not all group numbers (second group) might have been assigned by the SSA. Validator eliminates SSNs with invalid group numbers.</td>
</tr>
</tbody>
</table>

US Social Security Number (SSN) narrow breadth

The narrow breadth edition of the US Social Security Number (SSN) data identifier implements patterns to detects 9-digit numbers with the pattern DDD-DD-DDDDD separated with dashes or spaces or without separators.

Table 34-214  US Social Security Number (SSN) narrow breadth patterns

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d{3}-\d{2}-\d{4}</td>
<td>Matches the standard SSN format, which is any three digits followed by a hyphen, two digits, a hyphen, and any four digits.</td>
</tr>
<tr>
<td>\d{3} \d{2} \d{4}</td>
<td>Matches the SSN format delimited by spaces.</td>
</tr>
<tr>
<td>\d{9}</td>
<td>Matches any 9-digit number not delimited.</td>
</tr>
</tbody>
</table>
The narrow breadth edition of the US Social Security Number (SSN) data identifier implements four validators to ensure that the detected SSN is within validly assigned number ranges, is not a common test number (such as 123456789), is not all the same digit, and the message containing the SSN includes a keyword.

**Table 34-215  Social Security Number (SSN) narrow breadth validators**

<table>
<thead>
<tr>
<th>Mandatory Validator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number Delimiter</td>
<td>Validates a match by checking the surrounding characters.</td>
</tr>
<tr>
<td>Advanced SSN</td>
<td>Checks whether SSN contains zeros in any group, the area number (first group) is less than 773 and not 666, the delimiter between the groups is the same, the number does not consist of all the same digits, and the number is not reserved for advertising (123-45-6789, 987-65-432x).</td>
</tr>
<tr>
<td>SSN Area-Group number</td>
<td>For a given area number (first group), not all group numbers (second group) might have been assigned by the SSA. Validator eliminates SSNs with invalid group numbers.</td>
</tr>
</tbody>
</table>
| Find keywords: Social security-related | At least one of the following keywords or key phrases must be present for the data to be matched:  

  **social security number, ssn, ss#**
Library of policy templates

This chapter includes the following topics:

- Caldicott Report policy template
- Canadian Social Insurance Numbers policy template
- CAN-SPAM Act policy template
- Common Spyware Upload Sites policy template
- Competitor Communications policy template
- Confidential Documents policy template
- Credit Card Numbers policy template
- Customer Data Protection policy template
- Data Protection Act 1998 (UK) policy template
- Data Protection Directives (EU) policy template
- Defense Message System (DMS) GENSER Classification policy template
- Design Documents policy template
- Employee Data Protection policy template
- Encrypted Data policy template
- Export Administration Regulations (EAR) policy template
- FACTA 2003 (Red Flag Rules) policy template
- Financial Information policy template
- Forbidden Websites policy template
- Gambling policy template
- Gramm-Leach-Bliley policy template
- HIPAA and HITECH (including PHI) policy template
- Human Rights Act 1998 policy template
- Illegal Drugs policy template
- Individual Taxpayer Identification Numbers (ITIN) policy template
- International Traffic in Arms Regulations (ITAR) policy template
- Media Files policy template
- Merger and Acquisition Agreements policy template
- NASD Rule 2711 and NYSE Rules 351 and 472 policy template
- NASD Rule 3010 and NYSE Rule 342 policy template
- NERC Security Guidelines for Electric Utilities policy template
- Network Diagrams policy template
- Network Security policy template
- Offensive Language policy template
- Office of Foreign Assets Control (OFAC) policy template
- OMB Memo 06-16 and FIPS 199 Regulations policy template
- Password Files policy template
- Payment Card Industry (PCI) Data Security Standard policy template
- PIPEDA policy template
- Price Information policy template
- Project Data policy template
- Proprietary Media Files policy template
- Publishing Documents policy template
- Racist Language policy template
- Restricted Files policy template
- Restricted Recipients policy template
Caldicott Report policy template

The UK Chief Medical Officer commissioned the Caldicott Report (December, 1997) to improve the way the National Health Service handles and protects patient information. The Caldicott Committee reviewed the confidentiality of data throughout the NHS for purposes other than direct care, medical research, or where there is a statutory requirement for information. Its recommendations are now being put into practice throughout the NHS and in the Health Protection Agency.
The Drug, and Disease, and the Treatment keyword lists are updated with recent keywords based on information from the U.S. Federal Drug Administration (FDA) and other sources.

See “Keep the keyword lists for your HIPAA and Caldicott policies up to date” on page 596.

**Table 35-1**  
Caldicott Report policy template rules

<table>
<thead>
<tr>
<th>Rule</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Patient Data and Drug Keywords** | Compound EDM and Keyword Rule | This compound rule looks for a match among the following EDM data fields in combination with a keyword from the “Prescription Drug Names” dictionary. Both conditions must be satisfied for the rule to trigger an incident.  
  - Account number  
  - Email  
  - ID card number  
  - Last name  
  - Phone  
  - UK NHS (National Health Service) number  
  - UK NIN (National Insurance Number) |
| **Patient Data and Disease Keywords** | Compound EDM and Keyword Rule | This compound rule looks for a match among the following EDM data fields in combination with a keyword from the "Disease Names" dictionary. Both conditions must be satisfied for the rule to trigger an incident.  
  - Account number  
  - Email  
  - ID card number  
  - Last name  
  - Phone  
  - UK NHS (National Health Service) number  
  - UK NIN (National Insurance Number) |
Table 35-1  
Caldicott Report policy template rules (continued)

<table>
<thead>
<tr>
<th>Rule</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| Patient Data and Treatment Keywords | Compound EDM and Keyword Rule | This compound rule looks for a match among the following EDM data fields in combination with a keyword from the "Medical Treatment Keywords" dictionary. Both conditions must be satisfied for the rule to trigger an incident:  
  - Account number  
  - Email  
  - ID card number  
  - Last name  
  - Phone  
  - UK NHS (National Health Service) number  
  - UK NIN (National Insurance Number) |
| UK NHS Number and Drug Keywords | Simple DCM Rule               | This rule looks for a keyword from "UK NIN Keywords" dictionary in combination with a pattern matching the UK NIN data identifier and a keyword from the "Prescription Drug Names" dictionary. |
| UK NHS Number and Disease Keywords | Simple DCM Rule               | This rule looks for a keyword from "UK NIN Keywords" dictionary in combination with a pattern matching the UK NIN data identifier and a keyword from the "Disease Names" dictionary. |
| UK NHS Number and Treatment Keywords | Simple DCM Rule               | This rule looks for a keyword from "UK NIN Keywords" dictionary in combination with a pattern matching the UK NIN data identifier and a keyword from the "Medical Treatment Keywords" dictionary. |

See “Choosing an Exact Data Profile” on page 322.
See “Configuring policies” on page 326.
See "Exporting policy detection as a template" on page 350.

**Canadian Social Insurance Numbers policy template**

This policy detects patterns indicating Canadian social insurance numbers (SINs) at risk of exposure.

DCM Rule  
**Canadian Social Insurance Numbers**

This rule looks for a match to the Canadian Social Insurance Number data identifier and a keyword from the "Canadian Social Ins. No. Words" dictionary.

See “Configuring policies” on page 326.
CAN-SPAM Act policy template

The Controlling the Assault of Non-Solicited Pornography and Marketing Act (CAN-SPAM) establishes requirements for those who send commercial email.

The CAN-SPAM Act template detects activity from an organization's bulk mailer to help ensure compliance with the CAN-SPAM Act requirements.

The detection exception **Exclude emails that contain the mandated keywords** allows messages to pass that have one or more keywords from the user-defined "CAN-SPAM Exception Keywords" dictionary.

### Table 35-2  Detection exception: Exclude emails that contain the mandated keywords

<table>
<thead>
<tr>
<th>Method</th>
<th>Condition</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple exception</td>
<td>Content Matches Keyword (DCM)</td>
<td>Exclude emails that contain the mandated keywords (Keyword Match):</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Match keyword from &quot;[physical postal address]&quot; or &quot;advertisement&quot;.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Look in envelope, subject, body, attachments.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Case insensitive.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Match on whole words only.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> After you define the keywords, you can choose to count all matches and require 2 keywords from the list to be matched.</td>
</tr>
</tbody>
</table>

The detection exception **CAN-SPAM Compliant Emails** excludes from detection document content from the selected IDM index with at least 100% match.

### Table 35-3 Detection exception: CAN-SPAM Compliant Emails

<table>
<thead>
<tr>
<th>Method</th>
<th>Condition</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple exception</td>
<td>Content Matches  Document Profile (IDM)</td>
<td>Exception for CAN-SPAM compliant emails (IDM):</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Exact content match (100%)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Look in the message body and attachments.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Check for existence.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See &quot;Choosing an Indexed Document Profile&quot; on page 323.</td>
</tr>
</tbody>
</table>

If an exception is not met, the detection rule **Monitor Email From Bulk Mailer** looks for a sender's email address that matches one from the "Bulk Mailer Email Address" list, which is user-defined.
Table 35-4  Detection rule: Monitor Email From Bulk Mailer

<table>
<thead>
<tr>
<th>Method</th>
<th>Condition</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple rule</td>
<td>Sender/User Matches Pattern (DCM)</td>
<td>Monitor Email From Bulk Mailer (Sender):</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Match sender pattern(s): [<a href="mailto:bulk-mailer@company.com">bulk-mailer@company.com</a>] (user defined)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Severity: High.</td>
</tr>
</tbody>
</table>

See “Creating a policy from a template” on page 312.
See “Exporting policy detection as a template” on page 350.

Common Spyware Upload Sites policy template

The Common Spyware Upload Sites policy detects access to common spyware upload Web sites.

DCM Rule  
**Forbidden Websites 1**
This is a compound rule that looks for either specified IP addresses or URLs in the “Forbidden Websites 1” dictionary.

DCM Rule  
**Forbidden Websites 2**
This rule looks for a match of a specified URL in the “Forbidden Websites 2” dictionary.

See “Configuring policies” on page 326.
See “Exporting policy detection as a template” on page 350.

Competitor Communications policy template

The Competitor Communications policy detects forbidden communications with competitors.

DCM Rule  
**Competitor List**
This rule looks for keywords (domains) from the "Competitor Domains" dictionary, which is user-defined.

See “Configuring policies” on page 326.
See “Exporting policy detection as a template” on page 350.
# Confidential Documents policy template

This policy detects company-confidential documents at risk of exposure.

## Table 35-5  Rules comprising the Confidential Documents template

<table>
<thead>
<tr>
<th>Rule</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confidential Documents, Indexed</td>
<td>Simple IDM Rule with one condition</td>
<td>This rule looks for content from specific documents registered as confidential; returns a match if 80% or more of the source document is found. If you do not have an Indexed Document Profile configured this rule is dropped.</td>
</tr>
</tbody>
</table>
| Confidential Documents      | Compound DCM Rule: Attachment/File Type and Keyword Match | This rule looks for a combination of keywords from the "Confidential Keywords" list and the following file types:  
  - Microsoft Excel Macro  
  - Microsoft Excel  
  - Microsoft Works Spreadsheet  
  - SYLK Spreadsheet  
  - Corel Quattro Pro  
  - Multiplan Spreadsheet  
  - Comma Separate Values  
  - Applix Spreadsheets  
  - Lotus 1-2-3  
  - Microsoft Word  
  - Adobe PDF  
  - Microsoft PowerPoint |
| Proprietary Documents       | Compound DCM Rule: Attachment/File Type and Keyword Match | This compound rule looks for a combination of keywords from the "Proprietary Keywords" dictionary and the above referenced file types.                                                                 |
| Internal Use Only Documents | Compound DCM Rule: Attachment/File Type and Keyword Match | This compound rule looks for a combination of keywords from the "Internal Use Only Keywords" dictionary and the above referenced file types.                                                               |
| Documents Not For Distribution | Compound DCM Rule: Attachment/File Type and Keyword Match | This compound rule looks for a combination of keywords from the "Not For Distribution Words" dictionary and the above referenced file types.                                                                 |

See “Configuring policies” on page 326.

See “Exporting policy detection as a template” on page 350.
Credit Card Numbers policy template

This policy detects patterns indicating credit card numbers at risk of exposure.

DCM Rule  
**Credit Card Numbers, All**

This rule looks for a match to the credit card number system pattern and a keyword from the "Credit Card Number Keywords" dictionary.

See “Configuring policies” on page 326.
See “Exporting policy detection as a template” on page 350.

Customer Data Protection policy template

This policy detects customer data at risk of exposure.

<table>
<thead>
<tr>
<th>Rule name</th>
<th>Type</th>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username/Password</td>
<td>EDM Rule</td>
<td>This rule looks for usernames and passwords in combination with three or</td>
<td>However, the following combinations are not a violation:</td>
</tr>
<tr>
<td>Combinations</td>
<td></td>
<td>more of the following fields:</td>
<td>■ Phone, email, and last name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ SSN</td>
<td>■ Email, first name, and last name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Phone</td>
<td>■ Phone, first name, and last name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Email</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ First Name</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Last Name</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Bank Card number</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Account Number</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ ABA Routing Number</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Canadian Social Insurance Number</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ UK National Insurance Number</td>
<td></td>
</tr>
</tbody>
</table>
### Table 35-6  EDM conditions for the Customer Data Protection policy template (continued)

<table>
<thead>
<tr>
<th>Rule name</th>
<th>Type</th>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date of Birth</td>
<td>EDM Rule</td>
<td>This rule looks for any three of the following data fields in combination:</td>
<td>However, the following combinations are not a violation:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- SSN</td>
<td>- Phone, email, and first name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Phone</td>
<td>- Phone, email, and last name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Email</td>
<td>- Email, first name, and last name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- First Name</td>
<td>- Phone, first name, and last name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Last Name</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Bank Card number</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Account Number</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- ABA Routing Number</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Canadian Social Insurance Number</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- UK National Insurance Number</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Date of Birth</td>
<td></td>
</tr>
<tr>
<td>Exact SSN or CCN</td>
<td>EDM Rule</td>
<td>This rule looks for an exact social security number or bank card number.</td>
<td></td>
</tr>
<tr>
<td>Customer Directory</td>
<td>EDM Rule</td>
<td>This rule looks for Phone or Email.</td>
<td></td>
</tr>
</tbody>
</table>

### Table 35-7  DCM conditions for the Customer Data Protection policy template

<table>
<thead>
<tr>
<th>Rule name</th>
<th>Type</th>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>US Social Security Number Patterns</td>
<td>Compound DCM</td>
<td>This rule looks for a match to the Randomized US Social Security number data identifier and a keyword from the &quot;US SSN Keywords&quot; dictionary.</td>
<td>See “Randomized US Social Security Number (SSN) data identifier” on page 759.</td>
</tr>
<tr>
<td>Credit Card Numbers, All</td>
<td>Compound DCM</td>
<td>This rule looks for a match to the credit card number system pattern and a keyword from the &quot;Credit Card Number Keywords&quot; dictionary.</td>
<td>See “Credit Card Number data identifier” on page 715.</td>
</tr>
<tr>
<td>ABA Routing Numbers</td>
<td>Compound DCM</td>
<td>This rule looks for a match to the ABA Routing number data identifier and a keyword from the &quot;ABA Routing Number Keywords&quot; dictionary.</td>
<td>See “ABA Routing Number data identifier” on page 702.</td>
</tr>
</tbody>
</table>
See “Exporting policy detection as a template” on page 350.

Data Protection Act 1998 (UK) policy template

The Data Protection Act 1998 (replacement of Data Protection Act 1984) set standards which must be satisfied when obtaining, holding, using, or disposing of personal data in the UK. The Data Protection Act 1998 covers anything with personal identifiable information (such as data about personal health, employment, occupational health, finance, suppliers, and contractors).

Table 35-8 UK Data Protection Act, Personal Data detection rule

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>This EDM rule looks for three of the following columns of data:</td>
</tr>
<tr>
<td>NIN (National Insurance Number)</td>
</tr>
<tr>
<td>Account number</td>
</tr>
<tr>
<td>Pin</td>
</tr>
<tr>
<td>Bank card number</td>
</tr>
<tr>
<td>First name</td>
</tr>
<tr>
<td>Last name</td>
</tr>
<tr>
<td>Drivers license</td>
</tr>
<tr>
<td>Password</td>
</tr>
<tr>
<td>Tax payer ID</td>
</tr>
<tr>
<td>UK NHS number</td>
</tr>
<tr>
<td>Date of birth</td>
</tr>
<tr>
<td>Mother's maiden name</td>
</tr>
<tr>
<td>Email address</td>
</tr>
<tr>
<td>Phone number</td>
</tr>
<tr>
<td>However, the following combinations are not an incident:</td>
</tr>
<tr>
<td>First name, last name, pin</td>
</tr>
<tr>
<td>First name, last name, password</td>
</tr>
<tr>
<td>First name, last name, email</td>
</tr>
<tr>
<td>First name, last name, phone</td>
</tr>
<tr>
<td>First name, last name, mother's maiden name</td>
</tr>
</tbody>
</table>

Table 35-9 Additional detection rules in the Data Protection Act 1998 policy template

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The <strong>UK Electoral Roll Numbers</strong> rule implements the UK Electoral Roll Number data identifier.</td>
</tr>
</tbody>
</table>

See “UK Electoral Roll Number data identifier” on page 772.

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The <strong>UK National Insurance Numbers</strong> rule implements the narrow breadth edition of the UK National Insurance Number data identifier.</td>
</tr>
</tbody>
</table>

See “UK National Insurance Number data identifier” on page 777.
### Table 35-9  Additional detection rules in the Data Protection Act 1998 policy template (continued)

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
</table>
| The **UK Tax ID Numbers** rule implements the narrow edition of the UK Tax ID Number data identifier.  
See “UK Tax ID Number data identifier” on page 785. |
| The **UK Drivers License Numbers** rule implements the narrow breadth edition of the UK Driver's License number data identifier.  
See “UK Drivers License Number data identifier” on page 768. |
| The **UK Passport Numbers** rule implements the narrow breadth edition of the UK Passport Number data identifier.  
See “UK Passport Number data identifier” on page 781. |
| The **UK NHS Numbers** rule implements the narrow breadth edition of the UK National Health Service (NHS) Number data identifier.  
See “UK National Health Service (NHS) Number data identifier” on page 773. |

See “Choosing an Exact Data Profile” on page 322.  
See “Configuring policies” on page 326.  
See “Exporting policy detection as a template” on page 350.

---

### Data Protection Directives (EU) policy template

Directives 95/46/EC of the European Parliament deal with the protection of individuals with regard to the processing and free movement of personal data. This policy detects personal data specific to the EU directives.
### Table 35-10

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EDM Rule</td>
<td><strong>EU Data Protection Directives</strong></td>
</tr>
<tr>
<td></td>
<td>This rule looks for any two of the following data columns:</td>
</tr>
<tr>
<td></td>
<td>■ Last Name</td>
</tr>
<tr>
<td></td>
<td>■ Bank Card number</td>
</tr>
<tr>
<td></td>
<td>■ Drivers license number</td>
</tr>
<tr>
<td></td>
<td>■ Account Number</td>
</tr>
<tr>
<td></td>
<td>■ PIN</td>
</tr>
<tr>
<td></td>
<td>■ Medical account number</td>
</tr>
<tr>
<td></td>
<td>■ Medical ID card number</td>
</tr>
<tr>
<td></td>
<td>■ User name</td>
</tr>
<tr>
<td></td>
<td>■ Password</td>
</tr>
<tr>
<td></td>
<td>■ ABA Routing Number</td>
</tr>
<tr>
<td></td>
<td>■ Email</td>
</tr>
<tr>
<td></td>
<td>■ Phone</td>
</tr>
<tr>
<td></td>
<td>■ Mother's maiden name</td>
</tr>
<tr>
<td></td>
<td>However, the following combinations do not create a match:</td>
</tr>
<tr>
<td></td>
<td>■ Last name, email</td>
</tr>
<tr>
<td></td>
<td>■ Last name, phone</td>
</tr>
<tr>
<td></td>
<td>■ Last name, account number</td>
</tr>
<tr>
<td></td>
<td>■ Last name, username</td>
</tr>
<tr>
<td>EDM Rule</td>
<td><strong>EU Data Protection, Contact Info</strong></td>
</tr>
<tr>
<td></td>
<td>This rule looks for any two of the following data columns:</td>
</tr>
<tr>
<td></td>
<td>■ last name, phone</td>
</tr>
<tr>
<td></td>
<td>■ last name, account number</td>
</tr>
<tr>
<td></td>
<td>■ last name, username</td>
</tr>
<tr>
<td>Exception</td>
<td><strong>Except for email internal to the EU</strong></td>
</tr>
<tr>
<td></td>
<td>This rule is an exception if the recipient is within the EU. This covers</td>
</tr>
<tr>
<td></td>
<td>recipients with any of the country codes from the &quot;EU Country Codes&quot;</td>
</tr>
<tr>
<td></td>
<td>dictionary.</td>
</tr>
</tbody>
</table>

See “Choosing an Exact Data Profile” on page 322.

See “Configuring policies” on page 326.

See “Exporting policy detection as a template” on page 350.
Defense Message System (DMS) GENSER Classification policy template

The Defense Information Systems Agency has established guidelines for Defense Message System (DMS) General Services (GENSER) message classifications, categories, and markings. These standards specify how to mark classified and sensitive documents according to U.S. standards. These standards also provide interoperability with NATO countries and other U.S. allies.

The GENSER policy template enforces GENSER guidelines by detecting information that is classified as confidential. The template contains four simple (single condition) keyword matching (DCM) detection rules. If any rule condition matches, the policy reports an incident.

The detection rule **Top Secret Information** (Keyword Match) looks for any keywords in the "Top Secret Information" dictionary.

**Table 35-11** Detection rule: Top Secret Information (Keyword Match)

<table>
<thead>
<tr>
<th>Method</th>
<th>Condition</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple rule</td>
<td>Content Matches Keyword (DCM)</td>
<td>Top Secret Information (Keyword Match):</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Keyword dictionary: &quot;TOP SECRET/&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Severity: High</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Check for existence</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Look in envelope, subject, body, attachments</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Case sensitive</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Match on whole or partial words</td>
</tr>
</tbody>
</table>

The detection rule **Secret Information** (Keyword Match) looks for any keywords in the "Secret Information" dictionary.

**Table 35-12** Detection rule: Secret Information (Keyword Match)

<table>
<thead>
<tr>
<th>Method</th>
<th>Condition</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple rule</td>
<td>Content Matches Keyword (DCM)</td>
<td>Secret Information (Keyword Match):</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Keyword dictionary: &quot;SECRET/&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Severity: High</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Check for existence</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Look in envelope, subject, body, attachments</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Case sensitive</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Match on whole or partial words</td>
</tr>
</tbody>
</table>
The detection rule **Classified or Restricted Information** (Keyword Match) looks for any keywords in the "Classified or Restricted Information" dictionary.

<table>
<thead>
<tr>
<th>Method</th>
<th>Condition</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple rule</td>
<td>Content Matches Keyword (DCM)</td>
<td><strong>Classified or Restricted Information (Keyword Match):</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Keyword dictionary: &quot;CLASSIFIED//,//RESTRICTED//&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Severity: High</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Check for existence.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Look in envelope, subject, body, attachments.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Case sensitive.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Match on whole or partial words.</td>
</tr>
</tbody>
</table>

The detection rule **Other Sensitive Information** looks for any keywords in the "Other Sensitive Information" dictionary.

<table>
<thead>
<tr>
<th>Method</th>
<th>Condition</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple rule</td>
<td>Content Matches Keyword (DCM)</td>
<td><strong>Other Sensitive Information (Keyword Match):</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Keyword dictionary: FOR OFFICIAL USE ONLY, SENSITIVE BUT UNCLASSIFIED,DOD UNCLASSIFIED CONTROLLED NUCLEAR INFORMATION</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Severity: High</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Check for existence.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Look in envelope, subject, body, attachments.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Case sensitive.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Match on whole words only.</td>
</tr>
</tbody>
</table>

See “Configuring policies” on page 326.

See “Exporting policy detection as a template” on page 350.

**Design Documents policy template**

This policy detects various types of design documents, such as CAD/CAM, at risk of exposure.
IDM Rule  Design Documents, Indexed
This rule looks for content from specific design documents registered as proprietary. It returns a match if the engine detects 80% or more of the source document.

DCM Rule  Design Document Extensions
This rule looks for the specified file name extensions found in the "Design Document Extensions" dictionary.

DCM Rule  Design Documents
This rule looks for the following specified file types:
- cad_draw
- dwg

Note: Both file types and file name extensions are used because the policy does not detect the true file type for all the required documents.

See “Choosing an Indexed Document Profile” on page 323.
See “Configuring policies” on page 326.
See “Exporting policy detection as a template” on page 350.

Employee Data Protection policy template
This policy detects employee data at risk of exposure.
### Table 35-15  EDM rules for Employee Data Protection

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username/Password Combinations</td>
<td>EDM Rule</td>
<td>This rule looks for usernames and passwords in combination with any three of the following data fields.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- SSN</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Phone</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Email</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- First Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Last Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Bank Card Number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Account Number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- ABA Routing Number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Canadian Social Insurance Number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- UK National Insurance Number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Date of Birth</td>
</tr>
<tr>
<td>Employee Directory</td>
<td>EDM Rule</td>
<td>This rule looks for Phone or Email.</td>
</tr>
</tbody>
</table>

### Table 35-16  DCM rules for Employee Data Protection

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>US Social Security Number Patterns</td>
<td>DCM Rule</td>
<td>This rule looks for a match from the Randomized US Social Security Number (SSN) data identifier and a keyword from the &quot;US SSN Keywords&quot; dictionary.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Randomized US Social Security Number (SSN) data identifier” on page 759.</td>
</tr>
<tr>
<td>Credit Card Numbers, All</td>
<td>DCM Rule</td>
<td>This rule looks for a match from the credit card number system pattern and a keyword from the &quot;Credit Card Number Keywords&quot; dictionary.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Credit Card Number data identifier” on page 715.</td>
</tr>
<tr>
<td>ABA Routing Numbers</td>
<td>DCM Rule</td>
<td>This rule looks for a match from the ABA Routing number data identifier and a keyword from the &quot;ABA Routing Number Keywords&quot; dictionary.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “ABA Routing Number data identifier” on page 702.</td>
</tr>
</tbody>
</table>

See “Configuring policies” on page 326.

See “Exporting policy detection as a template” on page 350.
Encrypted Data policy template

This policy detects the use of encryption by a variety of methods including S/MIME, PGP, GPG, and file password protection.

DCM Rule  Password Protected Files
This rule looks for the following file types: encrypted_zip, encrypted_doc, encrypted_xls, or encrypted_ppt.

DCM Rule  PGP Files
This rule looks for the following file type: pgp.

DCM Rule  GPG Files
This rule looks for a keyword from the "GPG Encryption Keywords" dictionary.

DCM Rule  S/MIME
This rule looks for a keyword from the "S/MIME Encryption Keywords" dictionary.

DCM Rule  HushMail Transmissions
This rule looks for a match from a list of recipient URLs.

See “Configuring policies” on page 326.
See “Exporting policy detection as a template” on page 350.

Export Administration Regulations (EAR) policy template

The U.S. Department of Commerce enforces the Export Administration Regulations (EAR). These regulations primarily cover technologies and technical information with commercial and military applicability. These technologies are also known as dual-use technologies, for example, chemicals, satellites, software, computers, and so on.

This Export Administration Regulations (EAR) template detects violations from regulated countries and controlled technologies.

The detection rule Indexed EAR Commerce Control List Items and Recipients looks for a country code in the recipient from the "EAR Country Codes" dictionary and for a specific "SKU" from an Exact Data Profile index (EDM). Both conditions must match to trigger an incident.
Table 35-17 Detection rule: Indexed EAR Commerce Control List Items and Recipients

<table>
<thead>
<tr>
<th>Method</th>
<th>Condition</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compound rule</td>
<td>Content Matches Exact Data (EDM)</td>
<td>See “Choosing an Exact Data Profile” on page 322.</td>
</tr>
<tr>
<td></td>
<td>Content Matches Keyword (DCM)</td>
<td></td>
</tr>
</tbody>
</table>

The detection rule **EAR Commerce Control List and Recipients** looks for a country code in the recipient from the "EAR Country Codes" list and a keyword from the "EAR CCL Keywords" dictionary. Both conditions must match to trigger an incident.

Table 35-18 Detection rule: EAR Commerce Control List and Recipients

<table>
<thead>
<tr>
<th>Method</th>
<th>Condition</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compound rule</td>
<td>Recipient Matches Pattern (DCM)</td>
<td>EAR Commerce Control List and Recipients (Recipient):</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Match: Email address OR URL domain suffixes.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Severity: High.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Check for existence.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ At least 1 recipient(s) must match.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Matches on entire message.</td>
</tr>
<tr>
<td>Content Matches Keyword (DCM)</td>
<td></td>
<td>EAR Commerce Control List and Recipients (Keyword Match):</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Match: EAR CCL Keywords</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Severity: High.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Check for existence.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Look in envelope, subject, body, attachments.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Case insensitive.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Match on whole words only.</td>
</tr>
</tbody>
</table>

See “Configuring policies” on page 326.
See “Exporting policy detection as a template” on page 350.

**FACTA 2003 (Red Flag Rules) policy template**

This policy helps to address sections 114 and 315 (or Red Flag Rules) of the Fair and Accurate Credit Transactions Act (FACTA) of 2003. These rules specify that a financial institution or creditor that offers or maintains covered accounts must develop and implement an identity theft prevention program. FACTA is designed
to detect, prevent, and mitigate identity theft in connection with the opening of a covered account or any existing covered account.

The **Username/Password Combinations** detection rule detects the presence of both a user name and password from a profiled database index.

<table>
<thead>
<tr>
<th>Table 35-19</th>
<th>Username/Password Combinations detection rule</th>
</tr>
</thead>
<tbody>
<tr>
<td>Method</td>
<td>Condition</td>
</tr>
<tr>
<td>Simple rule</td>
<td>Content Matches</td>
</tr>
<tr>
<td></td>
<td>Exact Data (EDM)</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The **Exact SSN or CCN** detection rule detects the presence of either a social security number or a credit card number from a profiled database.

<table>
<thead>
<tr>
<th>Table 35-20</th>
<th>Exact SSN or CCN detection rule</th>
</tr>
</thead>
<tbody>
<tr>
<td>Method</td>
<td>Condition</td>
</tr>
<tr>
<td>Simple rule</td>
<td>Content Matches</td>
</tr>
<tr>
<td></td>
<td>Exact Data (EDM)</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The **Customer Directory** detection rule detects the presence of either an email address or a phone number from a profiled database.

<table>
<thead>
<tr>
<th>Table 35-21</th>
<th>Customer Directory detection rule</th>
</tr>
</thead>
<tbody>
<tr>
<td>Method</td>
<td>Condition</td>
</tr>
<tr>
<td>Simple rule</td>
<td>Content Matches</td>
</tr>
<tr>
<td></td>
<td>Exact Data (EDM)</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The **Three or More Data Columns** detection rule detects exact data containing three or more of data items from a profiled database index.
### Table 35-22 Three or More Data Columns detection rule

<table>
<thead>
<tr>
<th>Method</th>
<th>Condition</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple rule</td>
<td>Content Matches</td>
<td>Detects exact data containing three or more of the following data items:</td>
</tr>
<tr>
<td></td>
<td>Exact Data (EDM)</td>
<td>■ ABA Routing Number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Account Number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Bank Card Number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Birth Date</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Email address</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ First Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Last Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ National Insurance Number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Password</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Phone Number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Social Insurance Number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Social security number (Taxpayer ID)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ User name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>However, the following combinations are not a match:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Phone Number, Email, First Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Phone Number, First Name, Last Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Choosing an Exact Data Profile” on page 322.</td>
</tr>
</tbody>
</table>

The **US Social Security Number Patterns** detection rule implements the narrow breadth edition of the Randomized US Social Security Number (SSN) system data identifier.

See “Randomized US Social Security Number (SSN) data identifier” on page 759.

This data identifier detects nine-digit numbers with the pattern DDD-DD-DDDD separated with dashes or spaces or without separators. The number must be in valid assigned number ranges. This condition eliminates common test numbers, such as 123456789 or all the same digit. It also requires the presence of a Social Security keyword.
### Table 35-23 US Social Security Number Patterns detection rule

<table>
<thead>
<tr>
<th>Method</th>
<th>Condition</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple rule</td>
<td>Content Matches</td>
<td>Data Identifier: Randomized US Social Security Number (SSN) narrow breadth</td>
</tr>
<tr>
<td></td>
<td>Data Identifier (DCM)</td>
<td>See &quot;Randomized US Social Security Number (SSN) data identifier&quot; on page 759.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Severity: High.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Count all matches.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Look in envelope, subject, body, attachments.</td>
</tr>
</tbody>
</table>

The **Credit Card Numbers, All** detection rule implements the narrow breadth edition of the Credit Card Number system Data Identifier.

See “Credit Card Number data identifier” on page 715.

This data identifier detects valid credit card numbers that are separated by spaces, dashes, periods, or without separators. This condition performs Luhn check validation and includes formats for American Express, Diner's Club, Discover, Japan Credit Bureau (JCB), MasterCard, and Visa. It eliminates common test numbers, including those reserved for testing by credit card issuers. It also requires the presence of a credit card keyword.

### Table 35-24 Credit Card Numbers, All detection rule

<table>
<thead>
<tr>
<th>Method</th>
<th>Condition</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple rule</td>
<td>Content Matches</td>
<td>Data Identifier: Credit Card Number narrow breadth</td>
</tr>
<tr>
<td></td>
<td>Data Identifier (DCM)</td>
<td>See &quot;Credit Card Number narrow breadth&quot; on page 723.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Severity: High.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Count all matches.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Look in envelope, subject, body, attachments.</td>
</tr>
</tbody>
</table>

The **ABA Routing Numbers** detection rule implements the narrow breadth edition of the ABA Routing Number system Data Identifier.

See “ABA Routing Number data identifier” on page 702.

This data identifier detects nine-digit numbers. It validates the number using the final check digit. This condition eliminates common test numbers, such as 123456789, number ranges that are reserved for future use, and all the same digit. This condition also requires the presence of an ABA keyword.
Table 35-25  ABA Routing Numbers detection rule

<table>
<thead>
<tr>
<th>Method</th>
<th>Condition</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple rule</td>
<td>Content Matches</td>
<td>Data Identifier: ABA Routing Number narrow breadth</td>
</tr>
<tr>
<td></td>
<td>Data Identifier (DCM)</td>
<td>See “ABA Routing Number narrow breadth” on page 705.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Severity: High.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Count all matches.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Look in envelope, subject, body, attachments.</td>
</tr>
</tbody>
</table>

See “Creating a policy from a template” on page 312.

See “Exporting policy detection as a template” on page 350.

Financial Information policy template

The Financial Information policy detects financial data and information.

IDM Rule         Financial Information, Indexed
This rule looks for content from specific financial information files registered as proprietary; returns a match if 80\% or more of the source document is found.

DCM Rule         Financial Information
This rule looks for the combination of specified file types, keywords from the “Financial Keywords” dictionary, and keywords from the “Confidential/Proprietary Words” dictionary.
The specified file types are as follows:
- excel_macro
- xls
- works_spread
- sylk
- quattro_pro
- mod
- csv
- applix_spread
- 123

See “Configuring policies” on page 326.

See “Exporting policy detection as a template” on page 350.
Forbidden Websites policy template

The Forbidden Websites policy template is designed to detect access to specified web sites.

Note: To process HTTP GET requests appropriately, you may need to configure the Network Prevent for Web server. See “To enable a Forbidden Website policy to process GET requests appropriately” on page 823.

Table 35-26 Forbidden Websites policy template

<table>
<thead>
<tr>
<th>DCM Keyword Rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forbidden Websites</td>
<td>This rule looks for any keywords in the &quot;Forbidden Websites&quot; dictionary, which is user-defined.</td>
</tr>
</tbody>
</table>

To enable a Forbidden Website policy to process GET requests appropriately

1 Configure your web proxy server to forward GET requests to the Network Prevent for Web server.

2 Set the L7.processGets Advanced Server Setting on the Network Prevent for Web server to "true" (which is the default).

3 Reduce the L7.minSizeofGetURL Advanced Server Setting on the Network Prevent for Web server from the default of 100 to a number of bytes (characters) smaller than the length of the shortest web site that the policy specifies

Note: Reducing the minimum size of GETs increases the number of URLs that have to be processed, which increases server traffic load. One approach is to calculate the number of characters in the shortest URL specified in the list of forbidden URLs and set the minimum size to that number. Another approach is to set the minimum URL size to 10 as that should cover all cases.

4 You may need to adjust the "Ignore Requests Smaller Than" setting in the ICAP configuration of the Network Prevent server from the default 4096 bytes. This value stops processing of incoming web pages that contain fewer bytes than the number specified. If a page of a forbidden web site URL might be smaller than that number, the setting should be reduced appropriately.

See “Configuring policies” on page 326.

See “Exporting policy detection as a template” on page 350.
Gambling policy template

This policy detects any reference to gambling.

Table 35-27 Gambling policy template

<table>
<thead>
<tr>
<th>DCM Keyword Rule</th>
<th>DCM Rule</th>
</tr>
</thead>
<tbody>
<tr>
<td>Suspicious Gambling Keywords</td>
<td>This rule looks for five instances of keywords from the &quot;Gambling Keywords, Confirmed&quot; dictionary.</td>
</tr>
<tr>
<td>Less Suspicious Gambling Keywords</td>
<td>This rule looks for ten instances of keywords from the &quot;Gambling Keywords, Suspect&quot; dictionary.</td>
</tr>
</tbody>
</table>

See “Configuring policies” on page 326.
See “Exporting policy detection as a template” on page 350.

Gramm-Leach-Bliley policy template

The Gramm-Leach-Bliley (GLB) Act gives consumers the right to limit some sharing of their information by financial institutions.

The Gramm-Leach-Bliley policy template detects transmittal of customer data.

Table 35-28 Gramm-Leach-Bliley policy template conditions

<table>
<thead>
<tr>
<th>Detection method</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username/Password Combinations</td>
<td>Simple rule: EDM</td>
<td>This rule looks for user names and passwords in combination. See “Choosing an Exact Data Profile” on page 322.</td>
</tr>
<tr>
<td>Exact SSN or CCN</td>
<td>Simple rule: EDM</td>
<td>This rule looks for SSN or Credit Card Number.</td>
</tr>
<tr>
<td>Customer Directory</td>
<td>Simple rule: EDM</td>
<td>This rule looks for Phone or Email.</td>
</tr>
</tbody>
</table>
Table 35-28  Gramm-Leach-Bliley policy template conditions (continued)

<table>
<thead>
<tr>
<th>Detection method</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3 or more critical customer fields</td>
<td>Simple rule: EDM</td>
<td>This rule looks for a match among any three of the following fields:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Account number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Bank card number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Email address</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- First name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Last name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- PIN number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Phone number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Social security number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- ABA Routing Number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Canadian Social Insurance Number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- UK National Insurance Number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Date of Birth</td>
</tr>
<tr>
<td></td>
<td></td>
<td>However, the following combinations are not a match:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Phone, email, and first name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Phone, email, and last name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Email, first name, and last name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Phone, first name, and last name</td>
</tr>
</tbody>
</table>

| ABA Routing Numbers                      | Simple rule: DCM (DI)       | This condition detects nine-digit numbers. It validates the number using the final check digit. This condition eliminates common test numbers, such as 123456789, number ranges that are reserved for future use, and all the same digit. This condition also requires the presence of an ABA-related keyword. |
|                                         |                             | See "ABA Routing Number narrow breadth" on page 705.                                    |

| US Social Security Numbers               | Simple rule: DCM (DI)       | This rule looks for social security numbers. For this rule to match, there must be a number that fits the Randomized US SSN data identifier. There must also be a keyword or phrase that indicates the presence of a US SSN with a keyword from "US SSN Keywords" dictionary. The keyword condition is included to reduce false positives with any numbers that may match the SSN format. |
|                                         |                             | See "Randomized US Social Security Number (SSN) data identifier" on page 759.            |
### Table 35-28  
Gramm-Leach-Bliley policy template conditions *(continued)*

<table>
<thead>
<tr>
<th>Detection method</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| Credit Card Numbers | Simple rule: DCM (DI) | This condition detects valid credit card numbers that are separated by spaces, dashes, periods, or without separators. This condition performs Luhn check validation and includes the following credit card formats:  
- American Express  
- Diner’s Club  
- Discover  
- Japan Credit Bureau (JCB)  
- MasterCard  
- Visa  
This rule eliminates common test numbers, including those reserved for testing by credit card issuers, and also requires the presence of a credit card-related keyword.  
See “Credit Card Number narrow breadth” on page 723. |

See “Configuring policies” on page 326.

See “Exporting policy detection as a template” on page 350.

### HIPAA and HITECH (including PHI) policy template

The HIPAA and HITECH (including PHI) policy strictly enforces the US Health Insurance Portability and Accountability Act (HIPAA). Health Information Technology for Economic and Clinical Health Act (HITECH) is the first national law that mandates breach notification for protected health information (PHI).

This policy template detects data concerning prescription drugs, diseases, and treatments in combination with PHI. Organizations that are not subject to HIPAA can also use this policy to control PHI data.

In Symantec Data Loss Prevention version 12.5, the HIPAA and HITECH (including PHI) policy template is updated with recent Drug, and Disease, and Treatment keyword lists based on information from the U.S. Federal Drug Administration (FDA) and other sources. The policy template is also updated to use the Randomized US Social Security Number (SSN) data identifier, which detects both traditional and randomized SSNs.

See “Keep the keyword lists for your HIPAA and Caldicott policies up to date” on page 596.

See “Updating policies to use the Randomized US SSN data identifier” on page 569.
Table 35-29 describes the TPO exception that is provided by the template. TPOs (Treatment, Payment, or health care Operations) are service providers to health care organizations and have an exception for HIPAA information restrictions. The template requires that you enter the allowed email addresses. If implemented the exception is evaluated before detection rules and the policy does not trigger an incident if the protected information is sent to one of the allowed partners.

Table 35-29  TPO exception

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>TPO Exception</td>
<td>Content Matches Keyword</td>
<td>Simple exception (single condition match).</td>
</tr>
<tr>
<td></td>
<td>(DCM)</td>
<td>Looks for a recipient email address matching one from the &quot;TPO Email Addresses&quot; user-defined keyword dictionary.</td>
</tr>
</tbody>
</table>

The Table 35-30 looks for an exact data match against any single column from a profiled Patient Data database record.

Table 35-30  Patient Data detection rule

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Patient Data</td>
<td>Content Matches Exact Data</td>
<td>Match data from any single field:</td>
</tr>
<tr>
<td></td>
<td>(EDM)</td>
<td>■ Last name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Tax payer ID (SSN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Email address</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Account number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ ID card number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Phone number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Choosing an Exact Data Profile” on page 322.</td>
</tr>
</tbody>
</table>

The Table 35-31 is a compound detection rule that requires a Patient Data exact match and a match from the "Drug Code" data identifier.
Table 35-31  Patient Data and Drug Codes detection rule

<table>
<thead>
<tr>
<th>Name</th>
<th>Condition types</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Patient Data and Drug Codes</td>
<td>Content Matches Exact Data (EDM)</td>
<td>Looks for a match against any single column from a profiled Patient Data database record and a match from the National Drug Code data identifier.</td>
</tr>
<tr>
<td></td>
<td>And</td>
<td>See Table 35-30 on page 827. See “National Drug Code (NDC) data identifier” on page 754.</td>
</tr>
<tr>
<td></td>
<td>Content Matches Data Identifier</td>
<td></td>
</tr>
</tbody>
</table>

The Table 35-32 is a compound detection rule that requires a Patient Data exact match and a keyword match from the "Prescription Drug Names" dictionary.

Table 35-32  Patient Data and Prescription Drug Names detection rule

<table>
<thead>
<tr>
<th>Name</th>
<th>Condition type</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Patient Data and Prescription Drug Names</td>
<td>Content Matches Exact Data (EDM)</td>
<td>Looks for a match against any single column from a profiled Patient Data database record and a keyword match from the Prescription Drug Names dictionary</td>
</tr>
<tr>
<td></td>
<td>AND Content Matches Keyword (DCM)</td>
<td>See Table 35-30 on page 827. See “Updating policies after upgrading to the latest version” on page 355.</td>
</tr>
</tbody>
</table>

Table 35-33 is a compound detection rule that requires a Patient Data exact match and keyword match from the "Medical Treatment Keywords" dictionary.

Table 35-33  Patient Data and Treatment Keywords detection rule

<table>
<thead>
<tr>
<th>Name</th>
<th>Condition type</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Patient Data and Treatment Keywords</td>
<td>Content Matches Exact Data (EDM)</td>
<td>Looks for a match against any single column from a profiled Patient Data database record and a keyword match from the Medical Treatment Keywords dictionary.</td>
</tr>
<tr>
<td></td>
<td>AND Content Matches Keyword (DCM)</td>
<td>See Table 35-30 on page 827. See “Updating policies after upgrading to the latest version” on page 355.</td>
</tr>
</tbody>
</table>

Table 35-34 is a compound detection rule that requires a Patient Data exact match and a keyword match from the "Disease Names" dictionary.
**Table 35-34**  Patient Data and Disease Keywords detection rule

<table>
<thead>
<tr>
<th>Name</th>
<th>Condition type</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Patient Data and Disease Keywords</td>
<td>Content Matches Exact Data (EDM) And Content Matches Keyword (DCM)</td>
<td>Looks for a match against any single column from a profiled Patient Data database record and a keyword match from the Disease Names dictionary. See Table 35-30 on page 827. See “Updating policies after upgrading to the latest version” on page 355.</td>
</tr>
</tbody>
</table>

**Table 35-35** is a compound detection rule that looks for SSNs using the Randomized US Social Security Number (SSN) data identifier and for a keyword from the "Prescription Drug Names" dictionary.

**Table 35-35**  SSN and Drug Keywords detection rule

<table>
<thead>
<tr>
<th>Name</th>
<th>Condition type</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSN and Drug Keywords</td>
<td>Content Matches Data Identifier And Content Matches Keyword</td>
<td>Randomized US Social Security Number (SSN) data identifier (narrow breadth) See “Randomized US Social Security Number (SSN) data identifier” on page 759. Prescription Drug Names keyword dictionary See “Updating policies after upgrading to the latest version” on page 355.</td>
</tr>
</tbody>
</table>

**Table 35-36** is a compound detection rule that looks for SSNs using the Randomized US Social Security Number (SSN) data identifier and for a keyword match from the "Medical Treatment Keywords" dictionary.

**Table 35-36**  SSN and Treatment Keywords detection rule

<table>
<thead>
<tr>
<th>Name</th>
<th>Condition type</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSN and Treatment Keywords</td>
<td>Content Matches Data Identifier And Content Matches Keyword</td>
<td>Randomized US Social Security Number (SSN) data identifier (narrow breadth) See “Randomized US Social Security Number (SSN) data identifier” on page 759. Medical Treatment Keywords keyword dictionary. See “Updating policies after upgrading to the latest version” on page 355.</td>
</tr>
</tbody>
</table>
Table 35-37 is a compound detection rule that looks for SSNs using the Randomized US Social Security Number (SSN) data identifier and for a keyword match from the "Disease Names" dictionary.

### Table 35-37 SSN and Disease Keywords detection rule

<table>
<thead>
<tr>
<th>Name</th>
<th>Condition type</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSN and Disease Keywords</td>
<td>Content Matches Data Identifier And Content Matches Keyword</td>
<td>Randomized US Social Security Number (SSN) data identifier (narrow breadth) See “Randomized US Social Security Number (SSN) data identifier” on page 759. Disease Names keyword dictionary See “Updating policies after upgrading to the latest version” on page 355.</td>
</tr>
</tbody>
</table>

Table 35-38 is a compound detection rule that looks for SSNs using the Randomized US Social Security Number (SSN) data identifier and for a drug code using the Drug Code data identifier.

### Table 35-38 SSN and Drug Code detection rule

<table>
<thead>
<tr>
<th>Name</th>
<th>Condition type</th>
<th>Configuration</th>
</tr>
</thead>
</table>

See “Configuring policies” on page 326.

See “Exporting policy detection as a template” on page 350.

## Human Rights Act 1998 policy template

The Human Rights Act 1998 allows UK citizens to assert their rights under the European Convention on Human Rights in UK courts and tribunals. The Act states that "so far as possible to do so, legislation must be read and given effect in a way which is compatible with convention rights." The Human Rights Act 1998 policy enforces Article 8 by ensuring that the private lives of British citizens stay private.
UK Data Protection Act, Personal Data

This compound rule looks for two data types, last name and electoral roll number, in combination with a keyword from the "UK Personal Data Keywords" dictionary.

UK Electoral Roll Numbers

This rule looks for a single compound condition with four parts:
- A single keyword from the "UK Keywords" dictionary
- A pattern matching that of the UK Electoral Roll Number data identifier
- A single keyword from the "UK Electoral Roll Number Words" dictionary
- A single keyword from the "UK Personal Data Keywords" dictionary

See “Choosing an Exact Data Profile” on page 322.
See “Configuring policies” on page 326.
See “Exporting policy detection as a template” on page 350.

Illegal Drugs policy template

This policy detects conversations about illegal drugs and controlled substances.

Street Drugs

This rule looks for five instances of keywords from the "Street Drug Names" dictionary.

Mass Produced Controlled Substances

This rule looks for five instances of keywords from the "Manufactured Controlled Substances" dictionary.

See “Configuring policies” on page 326.
See “Exporting policy detection as a template” on page 350.

Individual Taxpayer Identification Numbers (ITIN) policy template

An Individual Taxpayer Identification Number (ITIN) is a tax-processing number issued by the US Internal Revenue Service (IRS). The IRS issues ITINs to track individuals who are not eligible to obtain Social Security Numbers (SSNs).
### Table 35-39 ITIN policy template conditions

<table>
<thead>
<tr>
<th>DCM Keyword Rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ITIN</td>
<td>This rule looks for a match to the US ITIN data identifier and a keyword from the &quot;US ITIN Keywords&quot; dictionary.</td>
</tr>
</tbody>
</table>

See “Configuring policies” on page 326.

See “Exporting policy detection as a template” on page 350.

---

### International Traffic in Arms Regulations (ITAR) policy template

The International Traffic in Arms Regulations (ITAR) are enforced by the US Department of State. Exporters of defense services or related technical data are required to register with the federal government and may need export licenses. This policy detects potential violations based on countries and controlled assets designated by the ITAR.

The Indexed ITAR Munition Items and Recipients detection rule looks for a country code in the recipient from the "ITAR Country Codes" dictionary and for a specific "SKU" from an indexed EDM file.

### Table 35-40 Indexed ITAR Munition Items and Recipients detection rule

<table>
<thead>
<tr>
<th>Method</th>
<th>Conditions (both must match)</th>
<th>Configuration</th>
</tr>
</thead>
</table>
| Compound rule   | Recipient Matches Pattern (DCM) | Match recipient email or URL domain from ITAR Country Codes list:  
- Severity: High.  
- Check for existence.  
- At least 1 recipient(s) must match. |
|                 | Content Matches Exact Data (EDM) | See “Choosing an Exact Data Profile” on page 322. |

The ITAR Munitions List and Recipients detection rule looks for both a country code in the recipient from the "ITAR Country Codes" dictionary and a keyword from the "ITAR Munition Names" dictionary.
Table 35-41  ITAR Munitions List and Recipients detection rule

<table>
<thead>
<tr>
<th>Method</th>
<th>Conditions (both must match)</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compound rule</td>
<td>Recipient Matches Pattern (DCM)</td>
<td>Match recipient email or URL domain from ITAR Country Codes list:</td>
</tr>
<tr>
<td></td>
<td>■ Severity: High.</td>
<td>■ Check for existence.</td>
</tr>
<tr>
<td></td>
<td>■ At least 1 recipient pattern must match.</td>
<td>In envelope, subject, body, attachments.</td>
</tr>
<tr>
<td></td>
<td>Content Matches Keyword (DCM)</td>
<td>■ Case insensitive.</td>
</tr>
<tr>
<td></td>
<td>Match any keyword from the ITAR Munitions List:</td>
<td>■ Match on whole words only.</td>
</tr>
<tr>
<td></td>
<td>■ Check for existence.</td>
<td></td>
</tr>
</tbody>
</table>

See “Configuring policies” on page 326.

See “Exporting policy detection as a template” on page 350.

Media Files policy template

The Media Files policy detects various types of video and audio files (including mp3).

DCM Rule  

**Media Files**

This rule looks for the following media file types:

- qt
- riff
- macromedia_dir
- midi
- mp3
- mpeg_movie
- quickdraw
- realaudio
- wav
- video_win
- vrml
Media Files Extensions

This rule looks for file name extensions from the "Media Files Extensions" dictionary.

See “Configuring policies” on page 326.
See “Exporting policy detection as a template” on page 350.

Merger and Acquisition Agreements policy template

The Mergers and Acquisition Agreements policy template detects contracts and official documentation concerning merger and acquisition activity.

You can modify this template with company-specific code words to detect specific deals.

The Merger and Acquisition Agreements template provides a single compound detection rule. All conditions in the rule must match for the rule to trigger an incident.

Table 35-42 Merger and Acquisition Agreements compound detection rule

<table>
<thead>
<tr>
<th>Condition</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contract Specific Keywords</td>
<td>• Match any keyword: merger, agreement, contract, letter of intent, term sheet, plan of reorganization</td>
</tr>
<tr>
<td>(Keyword Match)</td>
<td>• Severity: High.</td>
</tr>
<tr>
<td></td>
<td>• Check for existence.</td>
</tr>
<tr>
<td></td>
<td>• Look in envelope, subject, body, attachments.</td>
</tr>
<tr>
<td></td>
<td>• Case insensitive.</td>
</tr>
<tr>
<td></td>
<td>• Match on whole words only.</td>
</tr>
<tr>
<td>Acquisition Corporate Structure Keywords (Keyword Match)</td>
<td>• Match any keyword: subsidiary, subsidiaries, affiliate, acquiror, merger sub, covenantor, acquired company, acquiring company, surviving corporation, surviving company</td>
</tr>
<tr>
<td></td>
<td>• Severity: High.</td>
</tr>
<tr>
<td></td>
<td>• Check for existence.</td>
</tr>
<tr>
<td></td>
<td>• Look in envelope, subject, body, attachments.</td>
</tr>
<tr>
<td></td>
<td>• Case insensitive.</td>
</tr>
<tr>
<td></td>
<td>• Match on whole words only.</td>
</tr>
</tbody>
</table>
Table 35-42  Merger and Acquisition Agreements compound detection rule (continued)

<table>
<thead>
<tr>
<th>Condition</th>
<th>Configuration</th>
</tr>
</thead>
</table>
  - Severity: High.  
  - Check for existence.  
  - Look in envelope, subject, body, attachments.  
  - Case insensitive.  
  - Match on whole words only. |
| Legal Contract Keywords (Keyword Match) | - Match any keyword: **recitals**, **in witness whereof**, **governing law**, **Indemnify**, **Indemnified**, **indemnity**, **signature page**, **best efforts**, **gross negligence**, **willful misconduct**, **authorized representative**, **severability**, **material breach**  
  - Severity: High.  
  - Check for existence.  
  - Look in envelope, subject, body, attachments.  
  - Case insensitive.  
  - Match on whole words only. |

See “Configuring policies” on page 326.

See “Exporting policy detection as a template” on page 350.

**NASD Rule 2711 and NYSE Rules 351 and 472 policy template**

This policy protects the name(s) of any companies involved in an upcoming stock offering, internal project names for the offering, and the stock ticker symbols for the offering companies.

The NASD Rule 2711 Documents, Indexed detection rule looks for content from specific documents registered as sensitive and known to be subject to NASD Rule 2711 or NYSE Rules 351 and 472. This rule returns a match if 80% or more of the source document is found.
Table 35-43  NASD Rule 2711 Documents, Indexed detection rule

<table>
<thead>
<tr>
<th>Method</th>
<th>Condition</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple rule</td>
<td>Content Matches Document Signature (IDM)</td>
<td>NASD Rule 2711 Documents, Indexed (IDM):</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Detect documents in selected Indexed Document Profile</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Require at least 80% content match.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Severity: High.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Check for existence.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Look in body, attachments.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Choosing an Indexed Document Profile” on page 323.</td>
</tr>
</tbody>
</table>

The NASD Rule 2711 and NYSE Rules 351 and 472 detection rule is a compound rule that contains a sender condition and a keyword condition. The sender condition is based on a user-defined list of email addresses of research analysts at the user’s company (“Analysts’ Email Addresses” dictionary). The keyword condition looks for any upcoming stock offering, internal project names for the offering, and the stock ticker symbols for the offering companies (“NASD 2711 Keywords” dictionary). Like the sender condition, it requires editing by the user.

Table 35-44  NASD Rule 2711 and NYSE Rules 351 and 472 detection rule

<table>
<thead>
<tr>
<th>Method</th>
<th>Condition</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compound rule</td>
<td>Sender/User Matches Pattern (DCM)</td>
<td>NASD Rule 2711 and NYSE Rules 351 and 472 (Sender):</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Match sender pattern(s) [<a href="mailto:research_analyst@company.com">research_analyst@company.com</a>] (user defined)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Severity: High.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Matches on entire message.</td>
</tr>
<tr>
<td></td>
<td>Content Matches Keyword (DCM)</td>
<td>NASD Rule 2711 and NYSE Rules 351 and 472 (Keyword Match):</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Match &quot;[company stock symbol]&quot;, &quot;[name of offering company]&quot;, &quot;[offering name (internal name)]&quot;.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Severity: High.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Check for existence.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Look in envelope, subject, body, attachments.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Case insensitive.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Match on whole words only.</td>
</tr>
</tbody>
</table>

See “Configuring policies” on page 326.

See “Exporting policy detection as a template” on page 350.
NASD Rule 3010 and NYSE Rule 342 policy template

NASD Rule 3010 and NYSE Rule 342 require brokers-dealers to supervise certain brokerage employees' communications. The NASD Rule 3010 and NYSE Rule 342 policy monitors the communications of registered principals who are subject to these regulations.

The Stock Recommendation detection rule looks for a keyword from the "NASD 3010 Stock Keywords" dictionary and the "NASD 3010 Buy/Sell Keywords" dictionary. In addition, this rule requires evidence of a stock recommendation in combination with a buy or sell action.

<table>
<thead>
<tr>
<th>Method</th>
<th>Conditions (all must match)</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compound rule</td>
<td>Content Matches Keyword (DCM)</td>
<td>Match keyword: &quot;recommend&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Severity: High.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Check for existence.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Look in envelope, subject, body, attachments.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Case insensitive.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Match on whole words only.</td>
</tr>
</tbody>
</table>

**Table 35-45** Stock Recommendation detection rule

<table>
<thead>
<tr>
<th>Method</th>
<th>Conditions (all must match)</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Content Matches Keyword (DCM)</td>
<td>Match keyword: &quot;buy&quot; or &quot;sell&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Severity: High.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Check for existence.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Look in envelope, subject, body, attachments.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Case insensitive.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Match on whole words only.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Method</th>
<th>Conditions (all must match)</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Content Matches Keyword (DCM)</td>
<td>Match keyword: &quot;stock, stocks, security, securities, share, shares&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Severity: High.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Check for existence.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Look in envelope, subject, body, attachments.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Case insensitive.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Match on whole words only.</td>
</tr>
</tbody>
</table>

The NASD Rule 3010 and NYSE Rule 342 Keywords detection rule looks for keywords in the "NASD 3010 General Keywords" dictionary, which look for any general stock broker activity, and stock keywords.
### Table 35-46  
NASD Rule 3010 and NYSE Rule 342 Keywords detection rule

<table>
<thead>
<tr>
<th>Method</th>
<th>Conditions (both must match)</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compound rule</td>
<td>Content Matches Keyword (DCM)</td>
<td>Match keyword: &quot;authorize&quot;, &quot;discretion&quot;, &quot;guarantee&quot;, &quot;options&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Severity: High.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Check for existence.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Look in envelope, subject, body, attachments.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Case insensitive.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Match on whole words only.</td>
</tr>
<tr>
<td></td>
<td>Content Matches Keyword (DCM)</td>
<td>Match keyword: &quot;stock, stocks, security, securities, share, shares&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Severity: High.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Check for existence.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Look in envelope, subject, body, attachments.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Case insensitive.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Match on whole words only.</td>
</tr>
</tbody>
</table>

See “Configuring policies” on page 326.

See “Exporting policy detection as a template” on page 350.

### NERC Security Guidelines for Electric Utilities policy template

The North American Electric Reliability Council (NERC) Guideline for Protecting Potentially Sensitive Information describes how to protect and secure data about critical electricity infrastructure.

This policy detects the information outlined in the NERC security guidelines for the electricity sector.

### Table 35-47  
Key Response Personnel detection rule

<table>
<thead>
<tr>
<th>Detection method</th>
<th>Match condition</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple rule</td>
<td>Content Matches Exact Data (EDM)</td>
<td>Match any three of the following data items:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ First name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Last name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Phone</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Email</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Choosing an Exact Data Profile” on page 322.</td>
</tr>
</tbody>
</table>
Table 35-48  Network Infrastructure Maps detection rule

<table>
<thead>
<tr>
<th>Detection method</th>
<th>Match condition</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple rule</td>
<td>Content Matches Indexed Documents (IDM)</td>
<td>This rule requires an exact binary match. See “Choosing an Indexed Document Profile” on page 323.</td>
</tr>
</tbody>
</table>

The Sensitive Keywords and Vulnerability Keywords detection rule looks for any keyword matches from the “Sensitive Keywords” dictionary and the “Vulnerability Keywords” dictionary.

Table 35-49  Sensitive Keywords and Vulnerability Keywords detection rule

<table>
<thead>
<tr>
<th>Detection method</th>
<th>Match conditions</th>
<th>Configuration</th>
</tr>
</thead>
</table>
| Compound rule    | Content Matches Keyword (DCM) | Match any Sensitive Keyword:  
  ■ Severity: High.  
  ■ Check for existence.  
  ■ Look in envelope, subject, body, attachments.  
  ■ Case insensitive.  
  ■ Match on whole words only. |
|                  | Content Matches Keyword (DCM) | Match any Vulnerability Keyword:  
  ■ Severity: High.  
  ■ Check for existence.  
  ■ Look in envelope, subject, body, attachments.  
  ■ Case insensitive.  
  ■ Match on whole words only. |

See “Configuring policies” on page 326.

See “Exporting policy detection as a template” on page 350.

Network Diagrams policy template

The Network Diagrams policy detects computer network diagrams at risk of exposure.

IDM Rule  

Network Diagrams, Indexed  

This rule looks for content from specific network diagrams that are registered as confidential. This rule returns a match if 80% or more of the source document is detected.
Network Security policy template

The Network Security policy detects evidence of hacking tools and attack planning.

DCM Rule  Network Diagrams with IP Addresses  
This rule looks for a Visio file type in combination with an IP address data identifier.

DCM Rule  Network Diagrams with IP Address Keyword  
This rule looks for a Visio file type in combination with phrase variations of "IP address" with a data identifier.

See “Configuring policies” on page 326.
See “Exporting policy detection as a template” on page 350.

Offensive Language policy template

The Offensive Language policy detects the use of offensive language.

DCM Rule  Offensive Language, Explicit  
This rule looks for any single keyword in the "Offensive Language, Explicit" dictionary.

DCM Rule  Offensive Language, General  
This rule looks for any three instances of keywords in the "Offensive Language, General" dictionary.

See “Configuring policies” on page 326.
Office of Foreign Assets Control (OFAC) policy template

The Office of Foreign Assets Control of the U.S. Department of the Treasury administers and enforces economic and trade sanctions. These sanctions are based on US foreign policy and national security goals against certain countries, individuals, and organizations. The Office of Foreign Assets Control (OFAC) policy detects communications involving these targeted groups.

The OFAC policy has two primary parts. The first deals with the Specially Designated Nationals (SDN) list, and the second deals with general OFAC policy restrictions.

The SDN list refers to specific people or organizations that are subject to trade restrictions. The U.S. Treasury Department provides text files with specific names, last known addresses, and known aliases for these individuals and entities. The Treasury Department stipulates that the addresses may not be correct or current, and different locations do not change the restrictions on people and organizations.

In the OFAC policy template, Symantec Data Loss Prevention has scrubbed the list to make it more usable and practical. This includes extracting keywords and key phrases from the list of names and aliases, since names do not always appear in the same format as the list. Also, common names have been removed to reduce false positives. For example, one organization on the SDN list is known as "SARA." Leaving this on the list would generate a high false positive rate. "SARA Properties" is another entry on the list. It is used as a key phrase in the template because the incidence of this phrase is much lower than "SARA" alone. The list of names and organizations is considered in combination with the commonly found countries in the SDN address list. The top 12 countries on the list are considered, after again removing more commonly occurring countries. The template looks for recipients with any of the listed countries as the designated country code. This SDN list minimizes false positives while still detecting transactions or communications with known restricted parties.

The OFAC policy also provides guidance around the restrictions the U.S. Treasury Department has placed on general trade with specific countries. This is distinct from the SDN list, since individuals and organizations are not specified. The list of general sanctions can be found here:
http://www.treasury.gov/offices/enforcement/ofac/programs/index.shtml

The Office of Foreign Assets Control (OFAC) template looks for recipients on the OFAC-listed countries by designated country code.
The OFAC Special Designated Nationals List and Recipients detection rule looks for a recipient with a country code matching entries in the "OFAC SDN Country Codes" specification in combination with a match on a keyword from the "Specially Designated Nationals List" dictionary.

Table 35-50  
OFAC Special Designated Nationals List and Recipients detection rule

<table>
<thead>
<tr>
<th>Method</th>
<th>Condition</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compound rule</td>
<td>Recipient Matches Pattern (DCM)</td>
<td>OFAC Special Designated Nationals List and Recipients (Recipient):</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Match email or URL domain by OFAC SDN Country Code.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Severity: High.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Check for existence.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ At least 1 recipient(s) must match.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Matches on the entire message.</td>
</tr>
<tr>
<td></td>
<td>Content Matches Keyword (DCM)</td>
<td>Specially Designated Nationals List (Keyword Match):</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Match keyword from the Specially Designated Nationals List.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Severity: High.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Check for existence.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Look in envelope, subject, body, attachments.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Case insensitive.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Match on whole words only.</td>
</tr>
</tbody>
</table>

The Communications to OFAC countries detection rule looks for a recipient with a country code matching entries from the "OFAC Country Codes" list.

Table 35-51  
Communications to OFAC countries detection rule

<table>
<thead>
<tr>
<th>Method</th>
<th>Condition</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple rule</td>
<td>Recipient Matches Pattern (DCM)</td>
<td>Communications to OFAC countries (Recipient):</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Match email or URL domain by OFAC Country Code.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Severity: High.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Check for existence.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ At least 1 recipient(s) must match.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Matches on the entire message.</td>
</tr>
</tbody>
</table>

See “Configuring policies” on page 326.

See “Exporting policy detection as a template” on page 350.
OMB Memo 06-16 and FIPS 199 Regulations policy template

This policy detects information classified as confidential according to the guidelines established in the Federal Information Processing Standards (FIPS) Publication 199 from the National Institute of Standards and Technology (NIST). NIST is responsible for establishing standards and guidelines for data security under the Federal Information Security Management Act (FISMA).

This template contains three simple detection rules. If any rule reports a match, the policy triggers an incident.

The High Confidentiality Indicators detection rule looks for any keywords in the "High Confidentiality" dictionary.

Table 35-52  High Confidentiality Indicators detection rule

<table>
<thead>
<tr>
<th>Method</th>
<th>Condition</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple rule</td>
<td>Content Matches Keyword</td>
<td>High Confidentiality Indicators (Keyword Match):</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Match &quot;(confidentiality, high)&quot;, &quot;(confidentiality,high)&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Severity: High.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Check for existence.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Look in envelope, subject, body, attachments.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Case insensitive.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Match on whole words only.</td>
</tr>
</tbody>
</table>

The Moderate Confidentiality Indicators detection rule looks for any keywords in the "Moderate Confidentiality" dictionary.

Table 35-53  Moderate Confidentiality Indicators detection rule

<table>
<thead>
<tr>
<th>Method</th>
<th>Condition</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple rule</td>
<td>Content Matches Keyword</td>
<td>Moderate Confidentiality Indicators (Keyword Match):</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Match &quot;(confidentiality, moderate)&quot;, &quot;(confidentiality,moderate)&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Severity: High.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Check for existence.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Look in envelope, subject, body, attachments.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Case insensitive.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Match on whole words only.</td>
</tr>
</tbody>
</table>

The Low Confidentiality Indicators detection rule looks for any keywords in the "Low Confidentiality" dictionary.
Table 35-54  Low Confidentiality Indicators detection rule

<table>
<thead>
<tr>
<th>Method</th>
<th>Condition</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple rule</td>
<td>Content Matches Keyword</td>
<td>Low Confidentiality Indicators (Keyword Match):</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Match &quot;(confidentiality, low)&quot;, &quot;(confidentiality,low)&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Severity: High.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Check for existence.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Look in envelope, subject, body, attachments.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Case insensitive.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Match on whole words only.</td>
</tr>
</tbody>
</table>

See “Configuring policies” on page 326.
See “Exporting policy detection as a template” on page 350.

Password Files policy template

The Password Files policy detects password file formats, such as SAM, password, and shadow.

DCM Rule  Password Filenames
This rule looks for the file names "passwd" or "shadow."

DCM Rule  /etc/passwd Format
This rule looks for a regular expression pattern with the /etc/passwd format.

DCM Rule  /etc/shadow Format
This rule looks for a regular expression pattern with the /etc/shadow format.

DCM Rule  SAM Passwords
This rule looks for a regular expression pattern with the SAM format.

See “Configuring policies” on page 326.
See “Exporting policy detection as a template” on page 350.
Payment Card Industry (PCI) Data Security Standard policy template

The Payment Card Industry (PCI) data security standards are jointly determined by Visa and MasterCard to protect cardholders by safeguarding personally identifiable information. Visa's Cardholder Information Security Program (CISP) and MasterCard's Site Data Protection (SDP) program both work toward enforcing these standards. The Payment Card Industry (PCI) Data Security Standards policy detects Visa and MasterCard credit card number data.

The Card Numbers, Exact detection rule detects exact credit card numbers profiled from a database or other data source.

<table>
<thead>
<tr>
<th>Method</th>
<th>Condition</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple rule</td>
<td>Content Matches Exact Data (EDM)</td>
<td>This rule detects credit card numbers.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Choosing an Exact Data Profile” on page 322.</td>
</tr>
</tbody>
</table>

The Credit Card Numbers, All detection rule detects credit card numbers using the Credit Card Number system Data Identifier.

<table>
<thead>
<tr>
<th>Method</th>
<th>Condition</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple rule</td>
<td>Content Matches Data Identifier (DCM)</td>
<td>Credit Card Numbers, All (Data Identifiers):</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Data Identifier: Credit Card Number (narrow)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Credit Card Number data identifier” on page 715.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Severity: High.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Count all matches.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Look in envelope, subject, body, attachments.</td>
</tr>
</tbody>
</table>

The Magnetic Stripe Data for Credit Cards detection rule detects raw data from the credit card magnetic stripe using the Credit Card Magnetic Stripe system Data Identifier.
### Magnetic Stripe Data for Credit Cards detection rule

<table>
<thead>
<tr>
<th>Method</th>
<th>Condition</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple rule</td>
<td>Content Matches Data Identifier (DCM)</td>
<td>Magnetic Stripe Data for Credit Cards (Data Identifiers):</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Data Identifier: Credit Card Magnetic Stripe (medium)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Credit Card Number data identifier” on page 715.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Data Severity: High.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Count all matches.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Look in envelope, subject, body, attachments.</td>
</tr>
</tbody>
</table>

See “Configuring policies” on page 326.

See “Exporting policy detection as a template” on page 350.

### PIPEDA policy template

Canada's Personal Information Protection and Electronic Documents Act (PIPEDA) protects personal information in the hands of private sector organizations. This act provides guidelines for the collection, use, and disclosure of personal information.

The PIPEDA policy detects customer data that PIPEDA regulations protect.

The PIPEDA detection rule looks for a match of two data items, with certain data combinations excluded from matching.
### Table 35-58  PIPEDA detection rule

<table>
<thead>
<tr>
<th>Detection method</th>
<th>Description</th>
<th>Excluded combinations</th>
</tr>
</thead>
</table>
| EDM Rule         | The PIPEDA detection rule matches any two of the following data items:  
  - Last name  
  - Bank card  
  - Medical account number  
  - Medical record  
  - Agency number  
  - Account number  
  - PIN  
  - User name  
  - Password  
  - SIN  
  - ABA routing number  
  - Email  
  - Phone  
  - Mother's maiden name  
  See “Choosing an Exact Data Profile” on page 322. |
|                  | However, the following combinations do not create a match:  
  - Last name, email  
  - Last name, phone  
  - Last name, account number  
  - Last name, user name |

The PIPEDA Contact Info detection rule looks for a match of two data items, with certain data combinations excepted from matching.

### Table 35-59  PIPEDA Contact Info detection rule

<table>
<thead>
<tr>
<th>Detection method</th>
<th>Description</th>
</tr>
</thead>
</table>
| EDM Rule         | This rule looks for any two of the following data columns:  
  - Last name  
  - Phone  
  - Account number  
  - User name  
  - Email  
  See “Choosing an Exact Data Profile” on page 322. |
### Table 35-60  
**Canadian Social Insurance Numbers detection rule**

<table>
<thead>
<tr>
<th>Detection method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DCM Rule</td>
<td>This rule implements the narrow breadth edition of the Canadian Social Insurance Number data identifier. See “Canadian Social Insurance Number narrow breadth” on page 711.</td>
</tr>
</tbody>
</table>

### Table 35-61  
**ABA Routing Numbers detection rule**

<table>
<thead>
<tr>
<th>Detection method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DCM Rule</td>
<td>This rule implements the narrow breadth edition of the ABA Routing Number data identifier. See “ABA Routing Number narrow breadth” on page 705.</td>
</tr>
</tbody>
</table>

### Table 35-62  
**Credit Card Numbers, All detection rule**

<table>
<thead>
<tr>
<th>Detection method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DCM Rule</td>
<td>This rule implements the narrow breadth edition of the Credit Card Number data identifier. See “Credit Card Number narrow breadth” on page 723.</td>
</tr>
</tbody>
</table>

See “Configuring policies” on page 326.
See “Exporting policy detection as a template” on page 350.

### Price Information policy template

The Price Information policy detects specific SKU and pricing information at risk of exposure.

<table>
<thead>
<tr>
<th>Detection method</th>
<th>Description</th>
</tr>
</thead>
</table>
| EDM Rule         | **Price Information**  
This rule looks for the combination of user-specified Stock Keeping Unit (SKU) numbers and the price for that SKU number. |

**Note:** This template contains one EDM detection rule. If you do not have an EDM profile configured, or you are using Symantec Data Loss Prevention Standard, this policy template is empty and contains no rule to configure.

See “Configuring policies” on page 326.
Project Data policy template

The Project Data policy detects discussions of sensitive projects.

<table>
<thead>
<tr>
<th>Rule Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| IDM Rule | **Project Documents, Indexed**  
This rule looks for content from specific project data files registered as proprietary. It returns a match if the engine detects 80% or more of the source document. |
| DCM Rule | **Project Activity**  
This rule looks for any keywords in the "Sensitive Project Code Names" dictionary, which is user-defined. |

Proprietary Media Files policy template

The Proprietary Media Files policy detects various types of video and audio files that can be proprietary intellectual property of your organization at risk for exposure.

<table>
<thead>
<tr>
<th>Rule Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| IDM Rule | **Media Files, Indexed**  
This rule looks for content from specific media files registered as proprietary. |
DCM Rule  **Media Files**
This rule looks for the following media file types:
- qt
- riff
- macromedia_dir
- midi
- mp3
- mpeg_movie
- quickdraw
- realaudio
- wav
- video_win
- vrml

DCM Rule  **Media Files Extensions**
This rule looks for file name extensions from the "Media Files Extensions" dictionary.

See “Configuring policies” on page 326.
See “Exporting policy detection as a template” on page 350.

**Publishing Documents policy template**
The Publishing Documents policy detects various types of publishing documents, such as Adobe FrameMaker files, at risk of exposure.

IDM Rule  **Publishing Documents, Indexed**
This rule looks for content from specific publishing documents registered as proprietary. It returns a match if the engine detects 80% or more of the source document.

DCM Rule  **Publishing Documents**
This rule looks for the specified file types:
- qxpress
- frame
- aldus_pagemaker
- publ
DCM Rule  

**Publishing Documents, extensions**

This rule looks for specified file name extensions found in the "Publishing Document Extensions" dictionary.

Note: Both file types and file name extensions are required for this policy because the detection engine does not detect the true file type for all the required documents. As such, the file name extension must be used with the file type.

See “Configuring policies” on page 326.
See “Exporting policy detection as a template” on page 350.

---

**Racist Language policy template**

The Racist Language policy detects the use of racist language.

DCM Rule  

**Racist Language**

This rule looks for any single keyword in the "Racist Language" dictionary.

See “Configuring policies” on page 326.
See “Exporting policy detection as a template” on page 350.

---

**Restricted Files policy template**

The Restricted Files policy detects various file types that are generally inappropriate to send out of the company, such as Microsoft Access and executable files.

DCM Rule  

**MSAccess Files and Executables**

This rule looks for files of the specified types: access, exe, and exe_unix.

See “Configuring policies” on page 326.
See “Exporting policy detection as a template” on page 350.

---

**Restricted Recipients policy template**

The Restricted Recipients policy detects communications with specified recipients, such as former employees.
DCM Rules  

**Restricted Recipients**  
This rule looks for messages to recipients with email addresses in the "Restricted Recipients" dictionary.

See “Configuring policies” on page 326.  
See “Exporting policy detection as a template” on page 350.

## Resumes policy template

The Resumes policy detects active job searches.

**EDM Rule**  

**Resumes, Employee**  
This rule is a compound rule with two conditions; both must match to trigger an incident. This rule contains an EDM condition for first and last names of employees provided by the user. This rule also looks for a specific file type attachment (.doc) that is less than 50 KB and contains at least one keyword from each of the following dictionaries:

- Job Search Keywords, Education
- Job Search Keywords, Work
- Job Search Keywords, General

**DCM Rule**  

**Resumes, All**  
This rule looks for files of a specified type (.doc) that are less than 50 KB and match at least one keyword from each of the following dictionaries:

- Job Search Keywords, Education
- Job Search Keywords, Work
- Job Search Keywords, General

**DCM Rule**  

**Job Search Websites**  
This rule looks for URLs of Web sites that are used in job searches.

See “Configuring policies” on page 326.  
See “Exporting policy detection as a template” on page 350.  
See “About the Exact Data Profile and index” on page 371.
The US Sarbanes-Oxley Act (SOX) imposes requirements on financial accounting, including the preservation of data integrity and the ability to create an audit trail. The Sarbanes-Oxley policy detects sensitive financial data.

The Sarbanes-Oxley Documents, Indexed detection rule looks for content from specific documents registered as being subject to Sarbanes-Oxley Act. This rule returns a match if 80% or more of the source document is found.

<table>
<thead>
<tr>
<th>Method</th>
<th>Condition</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple rule</td>
<td>Content Matches Indexed Document Profile</td>
<td>See “Choosing an Indexed Document Profile” on page 323.</td>
</tr>
</tbody>
</table>

The SEC Fair Disclosure Regulation compound detection rule looks for the following conditions; all must be satisfied for the rule to trigger an incident:

- The SEC Fair Disclosure keywords indicate possible disclosure of advance financial information ("SEC Fair Disclosure Keywords" dictionary).

- An attachment or file type that is a commonly used document or spreadsheet format. The detected file types are Microsoft Word, Excel Macro, Excel, Works Spreadsheet, SYLK Spreadsheet, Corel Quattro Pro, WordPerfect, Lotus 123, Applix Spreadsheets, CSV, Multiplan Spreadsheet, and Adobe PDF.

- The company name keyword list requires editing by the user, which can include any name, alternate name, or abbreviation that might indicate a reference to the company.
### Table 35-64 SEC Fair Disclosure Regulation detection rule

<table>
<thead>
<tr>
<th>Method</th>
<th>Condition</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compound rule</td>
<td>Content Matches Keyword</td>
<td>SEC Fair Disclosure Regulation (Keyword Match):</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Match keyword: <strong>earnings per share, forward guidance</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Severity: High.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Check for existence.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Look in envelope, subject, body, attachments.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Case insensitive.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Match on whole words only.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Match on same component.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The keyword must be in the attachment or file type detected by that condition.</td>
</tr>
<tr>
<td>Message Attachment or File Type Match</td>
<td></td>
<td>SEC Fair Disclosure Regulation (Attachment/File Type):</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- File type detected: excel_macro, xls, works_spread, sylk, quattro_pro, mod, csv, applix_spread, 123, doc, wordperfect, and pdf.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Severity: High.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Match on: Attachments and same component.</td>
</tr>
<tr>
<td>Content Matches Keyword</td>
<td></td>
<td>SEC Fair Disclosure Regulation (Keyword Match):</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Match &quot;[company name]&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Severity: High.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Check for existence.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Look in envelope, subject, body, attachments.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Case insensitive.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Match on whole words only.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Match on same component.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The keyword must be in the attachment or file type detected by that condition.</td>
</tr>
</tbody>
</table>

The Financial Information detection rule looks for a specific file type containing a word from the "Financial Keywords" dictionary and a word from the "Confidential/Proprietary Words" dictionary. The spreadsheet file types detected are Microsoft Excel Macro, Microsoft Excel, Microsoft Works Spreadsheet, SYLK Spreadsheet, Corel Quattro Pro, and more.
### Table 35-65  Financial Information detection rule

<table>
<thead>
<tr>
<th>Method</th>
<th>Condition</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compound rule</td>
<td>Content Matches Indexed</td>
<td>Financial Information (Attachment/File Type):</td>
</tr>
<tr>
<td></td>
<td>Document Profile</td>
<td>• Match file type: excel_macro, xls, works_spread, sylk, quattro_pro, mod,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>csv, applix_spread, Lotus 1-2-3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Severity: High.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Match on attachments, same component.</td>
</tr>
<tr>
<td>Content Matches</td>
<td>Keyword</td>
<td>Financial Information (Keyword Match):</td>
</tr>
<tr>
<td>Keyword</td>
<td></td>
<td>• Match &quot;accounts receivable turnover&quot;, &quot;adjusted gross margin&quot;, &quot;adjusted</td>
</tr>
<tr>
<td></td>
<td></td>
<td>operating expenses&quot;, &quot;adjusted operating margin&quot;, &quot;administrative expenses&quot;,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>....</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Severity: High.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Check for existence.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Look in envelope, subject, body, attachments.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Case insensitive.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Match on whole words only.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Keyword must be detected in the attachment (same component).</td>
</tr>
</tbody>
</table>

See “Configuring policies” on page 326.

See “Exporting policy detection as a template” on page 350.

**SEC Fair Disclosure Regulation policy template**

The US SEC Selective Disclosure and Insider Trading Rules prohibit public companies from selectively divulging material information to analysts and institutional investors before its general release to the public.

The SEC Fair Disclosure Regulation template detects data indicating disclosure of material financial information.
The SEC Fair Disclosure Regulation Documents, Indexed (IDM) detection rule looks for content from specific documents subject to SEC Fair Disclosure regulation. This rule returns a match if 80% or more of the source document content is found.

Table 35-66 SEC Fair Disclosure Regulation Documents, Indexed (IDM) detection rule

<table>
<thead>
<tr>
<th>Method</th>
<th>Condition</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple rule</td>
<td>Content Matches Document Signature (IDM)</td>
<td>SEC Fair Disclosure Regulation Documents, Indexed (IDM):</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Detect documents from the selected Indexed Document Profile. See “Choosing an Indexed Document Profile” on page 323.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Match documents with at least 80% content match.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Severity: High.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Check for existence.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Look in body, attachments.</td>
</tr>
</tbody>
</table>

The SEC Fair Disclosure Regulation detection rule looks for the a keyword match from the "SEC Fair Disclosure Keywords" dictionary, an attachment or file type that is a commonly used document or spreadsheet, and a keyword match from the "Company Name Keywords" dictionary.

All three conditions must be satisfied for the rule to trigger an incident:

- The SEC Fair Disclosure keywords indicate possible disclosure of advance financial information.

- The file types detected are Microsoft Word, Excel Macro, Excel, Works Spreadsheet, SYLK Spreadsheet, Corel Quattro Pro, WordPerfect, Lotus 123, Applix Spreadsheets, CSV, Multiplan Spreadsheet, and Adobe PDF.

- The company name keyword list requires editing by the user, which can include any name, alternate name, or abbreviation that might indicate a reference to the company.
Table 35-67  SEC Fair Disclosure Regulation detection rule

<table>
<thead>
<tr>
<th>Method</th>
<th>Condition</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compound rule</td>
<td>Content Matches Keyword (DCM)</td>
<td>SEC Fair Disclosure Regulation (Keyword Match):</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Match &quot;earnings per share&quot;, &quot;forward guidance&quot;.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Severity: High.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Check for existence.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Look in envelope, subject, body, attachments.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Case insensitive.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Match on whole words only.</td>
</tr>
<tr>
<td>Message Attachment or File Type Match (DCM)</td>
<td>SEC Fair Disclosure Regulation (Attachment/File Type):</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Match file type: excel_macro, xls, works_spread, sylk, quattro_pro, mod, csv, applix_spread, 123, doc, wordperfect, pdf</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Severity: High.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Match on attachments.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Require content match to be in the same component (attachment).</td>
</tr>
<tr>
<td>Content Matches Keyword (DCM)</td>
<td>SEC Fair Disclosure Regulation (Keyword Match):</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Match &quot;[company name]&quot; (user defined)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Severity: High.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Check for existence.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Look in envelope, subject, body, attachments, same component.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Case insensitive.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Match on whole words only.</td>
</tr>
</tbody>
</table>

See “Configuring policies” on page 326.

See “Exporting policy detection as a template” on page 350.

**Sexually Explicit Language policy template**

The Sexually Explicit Language policy detects vulgar, sexually explicit, and pornographic language content.

**DCM Rule  Sexually Explicit Keywords, Confirmed**

This rule looks for any single keyword in the "Sex. Explicit Keywords, Confirmed" dictionary.
Sexually Explicit Keywords, Suspected
This rule looks for any three instances of keywords in the "Sex. Explicit Words, Suspect" dictionary.

Sexually Explicit Keywords, Possible
This rule looks for any three instances of keywords in the "Sex. Explicit Words, Possible" dictionary.

See “Configuring policies” on page 326.
See “Exporting policy detection as a template” on page 350.

Source Code policy template
The Source Code policy template provides match conditions for detecting various types of source code at risk of exposure, including C, Java, Perl, and Visual Basic (VB).

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| Source Code Documents    | IDM                   | This rule looks for specific user-provided source code from a Document Profile.  
Entradas del perfil De Documentos.  
This rule returns a match if it detects 80% or more of the source document.  
This rule is not available if you do not select a profile when creating the policy. |
| Source Code Extensions   | File Name Match       | This rule looks for a match among file name extensions from the "Source Code Extensions" dictionary. |
| Java Source Code         | Regular Expressions   | This compound rule looks for matches on two different regular expression patterns: Java Import Statements and Java Class Files. |
| C Source Code            | Regular Expression    | This rule looks for matches on the C Source Code regular expression pattern. |
| VB Source Code           | Regular Expression    | This rule looks for matches on the VB Source Code regular expression pattern. |
| Perl Source Code         | Regular Expressions   | This compound rule looks for matches on three different Perl-related regular expressions patterns. |
See “Configuring policies” on page 326.
See “Exporting policy detection as a template” on page 350.

State Data Privacy policy template

Many states in the US have adopted statutes mandating data protection and public disclosure of information security breaches in which confidential data of individuals is compromised. The State Data Privacy policy template is designed to address these types of confidential data breaches.

The State Data Privacy policy template provides several individual detection rules and produces an incident if any of these rules are violated. This policy template also provides a configurable exception condition that allows one or more authorized email recipients to receive otherwise confidential data.

Table 35-69 describes the acceptable use condition implemented by the State Data Privacy policy. You must configure the exception for it to apply.

Table 35-69  Email to Affiliates policy exception

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
<th>Configuration details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email to Affiliates (Recipient)</td>
<td>Described identity (DCM)</td>
<td>Email to Affiliates is a policy exception that allows email messages to be sent to affiliates who are legitimately allowed to receive information covered under the State Data Privacy regulations. If there is an exception, in this case an affiliate email address that you have entered, the entire message is discarded and not available for evaluation by detection.</td>
<td>- Simple exception (single condition)&lt;br&gt;- Match email recipient: [affiliate1], [affiliate2].&lt;br&gt;- Edit the “Affiliate Domains” list and enter the email address for each recipient who may make acceptable use of the confidential data.&lt;br&gt;- At least 1 recipient(s) must match for the exception to trigger.&lt;br&gt;- Matches on the entire message.</td>
</tr>
<tr>
<td>Recipient</td>
<td>Recipient Matches Pattern</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The State Data Privacy policy template implements Exact Data Matching (Table 35-70). If you do not select an Exact Data profile when you first create a policy based on this template, the EDM condition is not available for use.

See “Choosing an Exact Data Profile” on page 322.
Table 35-70  State Data Privacy EDM rule

<table>
<thead>
<tr>
<th>Rule name</th>
<th>Condition type</th>
<th>Description</th>
<th>Configuration details</th>
</tr>
</thead>
<tbody>
<tr>
<td>State Data Privacy, Consumer Data</td>
<td>Content matches Exact Data (EDM)</td>
<td>This rule looks for an exact data match on three of the following:</td>
<td>When you are creating the EDM profile, you should validate it against the State Data Privacy template to ensure that the resulting index includes expected fields.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ ABA Routing Number</td>
<td>■ Simple rule (single match condition)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Account Number</td>
<td>■ Severity: High</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Bank Card Number (credit card number)</td>
<td>■ Report incident if 1 match</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Birth Date</td>
<td>■ Look in envelope, body, attachments</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Driver License Number</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ First Name</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Last Name</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Password</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ PIN Number</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Social Security Number</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ State ID Card Number</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Exception conditions: the following combinations do not match:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ First Name, Last Name, PIN</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ First Name, Last Name, Password</td>
<td></td>
</tr>
</tbody>
</table>

Table 35-71 lists and describes the DCM detection rules implemented by the State Data Privacy policy. If any one of these rules is violated the policy produces an incident, unless you have configured the exception condition and the message recipient is an acceptable use affiliate.

Table 35-71  State Data Privacy detection rules

<table>
<thead>
<tr>
<th>Rule name</th>
<th>Condition type</th>
<th>Description</th>
<th>Configuration details</th>
</tr>
</thead>
<tbody>
<tr>
<td>US Social Security Number Patterns</td>
<td>Content Matches Data Identifier (DCM)</td>
<td>The US Social Security Number Patterns rule is designed to detect US social security numbers (SSNs). The Randomized US SSN data identifier detects SSN patterns, both traditional and those issued under the new randomization scheme. See “Randomized US Social Security Number (SSN) data identifier” on page 759.</td>
<td>■ Simple rule (single match condition)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ Severity: High</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ Count all matches.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ Look in envelope, subject, body, attachments.</td>
</tr>
<tr>
<td>Rule name</td>
<td>Condition type</td>
<td>Description</td>
<td>Configuration details</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>----------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| ABA Routing Numbers             | Simple rule (single match condition)                    | The ABA Routing Numbers rule is designed to detect ABA Routing Numbers. The ABA Routing Numbers data identifier detects ABA routing numbers. See “ABA Routing Number narrow breadth” on page 705. | Simple rule (single match condition)  
Severity: High.  
Count all matches.  
Look in envelope, subject, body, attachments |
| Credit Card Numbers, All        | Simple rule (single condition)                          | The Credit Card Numbers rule is designed to match on credit card numbers. To detect credit card numbers, this rule implements the Credit Card Number narrow breadth system data identifier. See "Credit Card Number narrow breadth" on page 723. | Simple rule (single condition)  
Severity: High.  
Count all matches.  
Look in envelope, subject, body, attachments |
| CA Drivers License Numbers      | Simple rule (single condition)                          | The CA Drivers License Numbers rule looks for a match for the CA drivers license number pattern, a match for a data identifier for terms relating to "drivers license," and a keyword from the "California Keywords" dictionary. See "Drivers License Number – CA State data identifier" on page 730. | Simple rule (single condition)  
Severity: High.  
Count all matches.  
Look in envelope, subject, body, attachments |
| NY Drivers License Numbers      | Simple rule (single condition)                          | The NY Drivers License Numbers rule looks for a match for the NY drivers license number pattern, a match for a regular expression for terms relating to "drivers license," and a keyword from the "New York Keywords" dictionary. See “Drivers License Number - NY State data identifier” on page 740. | Simple rule (single condition)  
Severity: High.  
Count all matches.  
Look in envelope, subject, body, attachments |
| FL, MI, and MN Drivers License Numbers | Simple rule (single condition)                  | The FL, MI, and MN Drivers License Numbers rule looks for a match for the stated drivers license number pattern, a match for a regular expression for terms relating to "drivers license," and a keyword from the "Letter/12 Num. DLN State Words" dictionary (namely, Florida, Minnesota, and Michigan). See “Drivers License Number - FL, MI, MN States data identifier” on page 732. | Simple rule (single condition)  
Severity: High.  
Count all matches.  
Look in envelope, subject, body, attachments |
Table 35-71  State Data Privacy detection rules (continued)

<table>
<thead>
<tr>
<th>Rule name</th>
<th>Condition type</th>
<th>Description</th>
<th>Configuration details</th>
</tr>
</thead>
</table>
| IL Drivers License Numbers       | Content Matches Data Identifier (DCM) | The IL Drivers License Numbers detection rule looks for a match for the IL drivers license number pattern, a match for a regular expression for terms relating to "drivers license," and a keyword from the "Illinois Keywords" dictionary.  
See “Drivers License Number - IL State data identifier” on page 735. | ■ Simple rule (single condition)  
■ Severity: High.  
■ Count all matches.  
■ Look in envelope, subject, body, attachments |
| NJ Drivers License Numbers       | Content Matches Data Identifier (DCM) | The NJ Drivers License Numbers detection rule looks for a match for the NJ drivers license number pattern, a match for a regular expression for terms relating to "drivers license," and a keyword from the "New Jersey Keywords" dictionary.  
This condition implements the Driver's License Number- NJ State medium breadth system Data Identifier.  
See “Drivers License Number- NJ State medium breadth” on page 739. | ■ Simple rule (single condition)  
■ Severity: High.  
■ Count all matches.  
■ Look in envelope, subject, body, attachments |

See “Configuring policies” on page 326.  
See “Exporting policy detection as a template” on page 350.

**SWIFT Codes policy template**

The Society for Worldwide Interbank Financial Telecommunication (SWIFT) is a cooperative organization under Belgian law and is owned by its member financial institutions. The SWIFT code (also known as a Bank Identifier Code, BIC, or ISO 9362) has a standard format to identify a bank, location, and the branch involved. These codes are used when transferring money between banks, particularly across international borders.

**DCM Rule**  
**SWIFT Code Regular Expression**

This rule looks for a match to the SWIFT code regular expression and a keyword from the “SWIFT Code Keywords” dictionary.

See “Configuring policies” on page 326.  
See “Exporting policy detection as a template” on page 350.
Symantec DLP Awareness and Avoidance policy template

The Symantec DLP Awareness & Avoidance policy detects any communications that refer to Symantec Data Loss Prevention or data loss prevention systems and possible avoidance of detection. The Symantec DLP Awareness & Avoidance policy is most useful for the deployments that are not widely known among monitored users.

DCM Rule Symantec DLP Awareness
Checks for a keyword match from the “Symantec DLP Awareness” dictionary.

DCM Rule Symantec DLP Avoidance
This rule is a compound rule with two conditions; both must be matched to trigger an incident. This rule looks for a keyword match from the “Symantec DLP Awareness” dictionary and a keyword from the “Symantec DLP Avoidance” dictionary.

See “Configuring policies” on page 326.
See “Exporting policy detection as a template” on page 350.

UK Drivers License Numbers policy template

The UK Drivers License Numbers policy detects UK Drivers License Numbers using the official specification of the UK Government Standards of the UK Cabinet Office.

DCM Rule UK Drivers License Numbers
This rule is a compound rule with the following conditions:
- A single keyword from the "UK Keywords" dictionary
- The pattern matching that of the UK drivers license data identifier
- Different combinations of the phrase "drivers license" using a data identifier

See “Configuring policies” on page 326.
See “Exporting policy detection as a template” on page 350.
UK Electoral Roll Numbers policy template

The UK Electoral Roll Numbers policy detects UK Electoral Roll Numbers using the official specification of the UK Government Standards of the UK Cabinet Office.

DCM Rule  UK Electoral Roll Numbers

This rule is a compound rule with the following conditions:

■ A single keyword from the "UK Keywords" dictionary
■ A pattern matching the UK Electoral Roll Number data identifier
■ A single keyword from the "UK Electoral Roll Number Words" dictionary

See “Configuring policies” on page 326.
See “Exporting policy detection as a template” on page 350.

UK National Health Service (NHS) Number policy template

The UK National Health Service (NHS) Number policy detects the personal identification number issued by the UK's National Health Service (NHS) for administration of medical care.

DCM Rule  UK NHS Numbers

This rule looks for a single compound condition with two parts: either new or old style National Health Service numbers and a single keyword from the "UK NHS Keywords" dictionary.

See “Configuring policies” on page 326.
See “Exporting policy detection as a template” on page 350.

UK National Insurance Numbers policy template

The National Insurance Number is issued to individuals by the UK Department for Work and Pensions and Inland Revenue (DWP/IR) for administering the national insurance system. The UK National Insurance Numbers policy detects these insurance policy numbers.
**UK National Insurance Numbers**

This rule looks for a match to the UK National Insurance number data identifier and a keyword from the dictionary "UK NIN Keywords."

See “Configuring policies” on page 326.

See “Exporting policy detection as a template” on page 350.

---

**UK Passport Numbers policy template**

The UK Passport Numbers policy detects valid UK passports using the official specification of the UK Government Standards of the UK Cabinet Office.

**DCM Rule UK Passport Numbers (Old Type)**

This rule looks for a keyword from the "UK Passport Keywords" dictionary and a pattern matching the regular expression for UK Passport Numbers (Old Type).

**DCM Rule UK Passport Numbers (New Type)**

This rule looks for a keyword from the "UK Passport Keywords" dictionary and a pattern matching the regular expression for UK Passport Numbers (New Type).

See “Configuring policies” on page 326.

See “Exporting policy detection as a template” on page 350.

---

**UK Tax ID Numbers policy template**

The UK Tax ID Numbers policy detects UK Tax ID Numbers using the official specification of the UK Government Standards of the UK Cabinet Office.

**DCM Rule UK Tax ID Numbers**

This rule looks for a match to the UK Tax ID number data identifier and a keyword from the dictionary "UK Tax ID Number Keywords."

See “Configuring policies” on page 326.

See “Exporting policy detection as a template” on page 350.
US Intelligence Control Markings (CAPCO) and DCID 1/7 policy template

The US Intelligence Control Markings (CAPCO) & DCID 1/7 policy detects authorized terms to identify classified information in the US Federal Intelligence community as defined in the Control Markings Register, which is maintained by the Controlled Access Program Coordination Office (CAPCO) of the Community Management Staff (CMS). The register was created in response to the Director of Central Intelligence Directive (DCID) 1/7.

This rule looks for a keyword match on the phrase "TOP SECRET."

Table 35-72  Top Secret Information detection rule

<table>
<thead>
<tr>
<th>Method</th>
<th>Condition</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple rule</td>
<td>Content Matches Keyword (DCM)</td>
<td>Match &quot;TOP SECRET/&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Severity: High.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Check for existence.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Look in envelope, subject, body, attachments.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Case sensitive.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Match on whole or partial words.</td>
</tr>
</tbody>
</table>

This rule looks for a keyword match on the phrase "SECRET."

Table 35-73  Secret Information detection rule

<table>
<thead>
<tr>
<th>Method</th>
<th>Condition</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple rule</td>
<td>Content Matches Keyword (DCM)</td>
<td>Match &quot;SECRET/&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Severity: High.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Check for existence.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Look in envelope, subject, body, attachments.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Case sensitive.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Match on whole or partial words.</td>
</tr>
</tbody>
</table>

This rule looks for a keyword match on the phrases "CLASSIFIED" or "RESTRICTED."
Table 35-74  Classified or Restricted Information (Keyword Match) detection rule

<table>
<thead>
<tr>
<th>Method</th>
<th>Condition</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple rule</td>
<td>Content Matches Keyword (DCM)</td>
<td>Match &quot;CLASSIFIED//,//RESTRICTED//&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Severity: High.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Check for existence.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Look in envelope, subject, body, attachments.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Case sensitive.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Match on whole or partial words.</td>
</tr>
</tbody>
</table>

See “Configuring policies” on page 326.
See “Exporting policy detection as a template” on page 350.

US Social Security Numbers policy template

The US Social Security Numbers policy detects patterns indicating social security numbers at risk of exposure.

Table 35-75  US Social Security Numbers policy template

<table>
<thead>
<tr>
<th>Rule name</th>
<th>Rule type</th>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>US Social Security Number Patterns</td>
<td>DCM Rule</td>
<td>This rule looks for a match to the social security number regular expression and a keyword from the dictionary &quot;US SSN Keywords.&quot;</td>
<td>See “Randomized US Social Security Number (SSN) data identifier” on page 759.</td>
</tr>
</tbody>
</table>

See “Configuring policies” on page 326.
See “Exporting policy detection as a template” on page 350.

Violence and Weapons policy template

The Violence and Weapons policy detects violent language and discussions about weapons.

Table 35-76  Violence and Weapons policy template

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Violence and Weapons</td>
<td>DCM Rule</td>
<td>This rule is a compound rule with two conditions; both must match to trigger an incident. This rule looks for a keyword from the &quot;Violence Keywords&quot; dictionary and a keyword from the &quot;Weapons Keywords&quot; dictionary.</td>
</tr>
</tbody>
</table>
Webmail policy template

The Webmail policy detects the use of a variety of Webmail services, including Yahoo, Google, and Hotmail.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Condition(s)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yahoo</td>
<td>Compound detection rule</td>
<td>Recipient Matches Pattern (DCM)</td>
<td>This condition checks for the URL domain mail.yahoo.com.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Content Matches Keyword (DCM)</td>
<td>This condition checks for the keyword <code>ym/compose</code>.</td>
</tr>
<tr>
<td>Hotmail</td>
<td>Compound detection rule</td>
<td>Recipient Matches Pattern (DCM)</td>
<td>This condition checks for the URL domain hotmail.msn.com.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Content Matches Keyword (DCM)</td>
<td>This condition checks for the keyword <code>compose?&amp;curmbox</code>.</td>
</tr>
<tr>
<td>Go</td>
<td>Compound detection rule</td>
<td>Recipient Matches Pattern (DCM)</td>
<td>This condition checks for the URL gomai.us.go.com.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Content Matches Keyword (DCM)</td>
<td>This condition checks for the keyword <code>compose</code>.</td>
</tr>
<tr>
<td>AOL</td>
<td>Compound detection rule</td>
<td>Recipient Matches Pattern (DCM)</td>
<td>This condition checks for the URL domain aol.com.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Content Matches Keyword (DCM)</td>
<td>This condition checks for the keyword <code>compose</code>.</td>
</tr>
<tr>
<td>Gmail</td>
<td>Compound detection rule</td>
<td>Recipient Matches Pattern (DCM)</td>
<td>This condition checks for the URL domain gmail.google.com.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Content Matches Keyword (DCM)</td>
<td>This condition checks for the keyword <code>gmail</code>.</td>
</tr>
</tbody>
</table>
# Yahoo Message Board Activity policy template

The Yahoo Message Board policy template detects Yahoo message board activity.

The Yahoo Message Board detection rule is a compound method that looks for messages posted to the Yahoo message board you specify. **Table 35-78** describes its configuration details.

**Table 35-78**  Yahoo Message Board detection rule

<table>
<thead>
<tr>
<th>Method</th>
<th>Condition</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compound rule</td>
<td>Content Matches Keyword (DCM)</td>
<td>Yahoo Message Board (Keyword Match):</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Case insensitive.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Match Keyword: post.messages.yahoo.com/bbs.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Match on whole words only.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Check for existence (do not count multiple matches).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Look in envelope, subject, body, attachments.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Match must occur in the same component for both conditions.</td>
</tr>
</tbody>
</table>

AND

<table>
<thead>
<tr>
<th>Content Matches Keyword (DCM)</th>
<th>Yahoo Message Board (Keyword Match):</th>
</tr>
</thead>
<tbody>
<tr>
<td>■ Case insensitive.</td>
<td></td>
</tr>
<tr>
<td>■ Match Keyword: board=&lt;enter board number&gt;.</td>
<td></td>
</tr>
<tr>
<td>■ Match on whole words only.</td>
<td></td>
</tr>
<tr>
<td>■ Check for existence (do not count multiple matches).</td>
<td></td>
</tr>
<tr>
<td>■ Look in envelope, subject, body, attachments.</td>
<td></td>
</tr>
<tr>
<td>■ Match must occur in the same component for both conditions.</td>
<td></td>
</tr>
</tbody>
</table>

The Finance Message Board URL detection rule detects messages posted to the Yahoo Finance message board. **Table 35-79** describes its configuration.
Table 35-79  Finance Message Board URL detection rule

<table>
<thead>
<tr>
<th>Method</th>
<th>Condition</th>
<th>Configuration</th>
</tr>
</thead>
</table>
| Simple rule   | Content Matches Keyword (DCM)    | Finance Message Board URL (Keyword Match):  
  ■ Case insensitive.  
  ■ Match on whole words only.  
  ■ Check for existence (do not count multiple matches).  
  ■ Look in envelope, subject, body, attachments. |

The Board URLs detection rule detects messages posted to the Yahoo or Yahoo Finance message boards by the URL of either.

Table 35-80 describes its configuration details.

Table 35-80  Board URLs detection rule

<table>
<thead>
<tr>
<th>Method</th>
<th>Condition</th>
<th>Configuration</th>
</tr>
</thead>
</table>
| Simple rule   | Recipient Matches Pattern  | Board URLs (Recipient):  
  ■ At least 1 recipient(s) must match.  
  ■ Matches on the entire message (not configurable). |

See “Creating a policy from a template” on page 312.

See “Exporting policy detection as a template” on page 350.

Yahoo and MSN Messengers on Port 80 policy template

The Yahoo and MSN Messengers on Port 80 policy detects Yahoo and MSN Messenger activity over port 80.

The Yahoo IM detection rule looks for keyword matches on both ymsg and shttp.msg.yahoo.com.
### Yahoo IM detection rule

<table>
<thead>
<tr>
<th>Method</th>
<th>Condition</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content Matches Keyword (DCM)</td>
<td>Yahoo IM (Keyword Match):</td>
<td>■ Case insensitive.</td>
</tr>
<tr>
<td>Compounds rule</td>
<td></td>
<td>■ Match keyword: <strong>ymsg</strong>.</td>
</tr>
<tr>
<td>AND</td>
<td></td>
<td>■ Match on whole words only.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Count all matches and report an incident for each match.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Look for matches in the envelope, subject, body, and attachments.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Match must occur in the same component for both conditions in the rule.</td>
</tr>
<tr>
<td>Content Matches Keyword (DCM)</td>
<td>Yahoo IM (Keyword Match):</td>
<td>■ Case insensitive.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Match keyword: <strong>shttp.msg.yahoo.com</strong>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Match on whole words only.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Count all matches and report an incident for each match.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Look for matches in the envelope, subject, body, and attachments.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Match must occur in the same component for both conditions in the rule.</td>
</tr>
</tbody>
</table>

The MSN IM detection rule looks for matches on three keywords in the same message component.
## Table 35-82  MSN IM detection rule

<table>
<thead>
<tr>
<th>Method</th>
<th>Condition</th>
<th>Configuration</th>
</tr>
</thead>
</table>
| Content Matches Keyword (DCM) | MSN IM (Keyword Match): | ■ Case insensitive.  
■ Match keyword: **msg**.  
■ Match on whole words only.  
■ Count all matches and report an incident for each match.  
■ Look for matches in the envelope, subject, body, and attachments.  
■ Match must occur in the same component for all conditions in the rule. |
| AND | MSN IM (Keyword Match): | ■ Case insensitive.  
■ Match keyword: **x-msn**.  
■ Match on whole words only.  
■ Count all matches and report an incident for each match.  
■ Look for matches in the envelope, subject, body, and attachments.  
■ Match must occur in the same component for all conditions in the rule. |
| Compound rule | Content Matches Keyword (DCM) | MSN IM (Keyword Match): | ■ Case insensitive.  
■ Match keyword: **charset=utf-8**.  
■ Match on whole words only.  
■ Count all matches and report an incident for each match.  
■ Look for matches in the envelope, subject, body, and attachments.  
■ Match must occur in the same component for all conditions in the rule. |

See “Creating a policy from a template” on page 312.  
See “Exporting policy detection as a template” on page 350.
Configuring policy response rules

- Chapter 36. Responding to policy violations
- Chapter 37. Configuring and managing response rules
- Chapter 38. Response rule conditions
- Chapter 39. Response rule actions
Chapter 36

Responding to policy violations

This chapter includes the following topics:

- About response rules
- About response rule actions
- Response rules for all detection servers
- Response rules for endpoint detection
- Response rules for Network and Mobile Prevent for Web detection
- Response rules for Network Protect detection
- Response rule for the Classification Server
- About response rule execution types
- About Automated Response rules
- About Smart Response rules
- About response rule conditions
- About response rule action execution priority
- About response rule authoring privileges
- Implementing response rules
- Response rule best practices
About response rules

You can implement one or more response rules in a policy to escalate, resolve, and dismiss incidents when a violation occurs. For example, if a policy is violated, a response rule blocks the transmission of a file containing sensitive content.

See “About response rule actions” on page 875.

You create, modify, and manage response rules separate from the policies that declare them. This decoupling allows response rules to be updated and reused across policies.

See “Implementing response rules” on page 886.

The detection server automatically executes response rules. Or, you can configure Smart Response rules for manual execution by an incident remediator.

See “About response rule execution types” on page 880.

You can implement conditions to control how and when response rules execute.

See “About response rule conditions” on page 882.

You can sequence the order of execution for response rules of the same type.

See “About response rule action execution priority” on page 883.

You must have response rule authoring privileges to create and manage response rules.

See “About response rule authoring privileges” on page 885.

About response rule actions

Response rule actions are the components that take action when a policy violation occurs. Response rule actions are mandatory components of response rules. If you create a response rule, you must define at least one action for the response rule to be valid.

Symantec Data Loss Prevention provides several response rule actions. Many are available for all types of detection servers. Others are available for specific detection servers.

See “Implementing response rules” on page 886.

The detection server where a policy is deployed executes a response rule action any time a policy violation occurs. Or, you can configure a response rule condition to dictate when the response rule action executes.

See “About response rule conditions” on page 882.
For example, anytime a policy is violated, send an email to the user who violated the policy and the manager. Or, if a policy violation severity level is medium, present the user with an on-screen warning. Or, if the severity is high, block a file from being copied to an external device.

Table 36-1  Response rules by server type

<table>
<thead>
<tr>
<th>Server type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All detection servers</td>
<td>See “Response rules for all detection servers” on page 876.</td>
</tr>
<tr>
<td>Endpoint detection servers</td>
<td>See “Response rules for endpoint detection” on page 877.</td>
</tr>
<tr>
<td>Network and Mobile Prevent for Web detection servers</td>
<td>See “Response rules for Network and Mobile Prevent for Web detection” on page 878.</td>
</tr>
<tr>
<td>Network Protect detection servers</td>
<td>See “Response rules for Network Protect detection” on page 879.</td>
</tr>
<tr>
<td>Classification detection server</td>
<td>See “Response rule for the Classification Server” on page 880.</td>
</tr>
</tbody>
</table>

Response rules for all detection servers

Symantec Data Loss Prevention provides several response rule actions for Endpoint Prevent, Endpoint Discover, Network Prevent for Web, Network Prevent for Email, Mobile Prevent for Web, and Network Protect.

Table 36-2  Available response rules for all detection servers

<table>
<thead>
<tr>
<th>Response rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Note</td>
<td>Add a field to the incident record that the remediator can annotate at the Incident Snapshot screen. See “Configuring the Add Note action” on page 906.</td>
</tr>
<tr>
<td>Limit Incident Data Retention</td>
<td>Discard or retain matched data with the incident record. See “Configuring the Limit Incident Data Retention action” on page 906.</td>
</tr>
<tr>
<td>Log to a Syslog Server</td>
<td>Log the incident to a syslog server. See “Configuring the Log to a Syslog Server action” on page 909.</td>
</tr>
<tr>
<td>Send Email Notification</td>
<td>Send an email you compose to recipients you specify. See “Configuring the Send Email Notification action” on page 910.</td>
</tr>
</tbody>
</table>
Table 36-2  
Available response rules for all detection servers (continued)

<table>
<thead>
<tr>
<th>Response rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server FlexResponse</td>
<td>Execute a custom Server FlexResponse action.</td>
</tr>
<tr>
<td></td>
<td>See “Configuring the Server FlexResponse action” on page 912.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This response rule action is available only if you deploy one or</td>
</tr>
<tr>
<td></td>
<td>more custom Server FlexResponse plug-ins to Symantec Data Loss Prevention.</td>
</tr>
<tr>
<td></td>
<td>See “Deploying a Server FlexResponse plug-in” on page 1231.</td>
</tr>
<tr>
<td>Set Attribute</td>
<td>Add a custom value to the incident record.</td>
</tr>
<tr>
<td></td>
<td>See “Configuring the Set Attribute action” on page 913.</td>
</tr>
<tr>
<td>Set Status</td>
<td>Change the incident status to the specified value.</td>
</tr>
<tr>
<td></td>
<td>See “Configuring the Set Status action” on page 914.</td>
</tr>
</tbody>
</table>

See “About response rules” on page 875.
See “Implementing response rules” on page 886.

Response rules for endpoint detection

Symantec Data Loss Prevention provides several response rule actions for Endpoint Prevent and Endpoint Discover.

Table 36-3  
Available Endpoint response rules

<table>
<thead>
<tr>
<th>Response rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Endpoint: FlexResponse</td>
<td>Take custom action using the FlexResponse API.</td>
</tr>
<tr>
<td></td>
<td>See “Configuring the Endpoint: FlexResponse action” on page 919.</td>
</tr>
<tr>
<td>Endpoint Discover: Quarantine File</td>
<td>Quarantine a discovered sensitive file.</td>
</tr>
<tr>
<td></td>
<td>See “Configuring the Endpoint Discover: Quarantine File action” on page 920.</td>
</tr>
<tr>
<td>Endpoint Prevent: Block</td>
<td>Block the transfer of data that violates the policy.</td>
</tr>
<tr>
<td></td>
<td>For example, block the copy of confidential data from an endpoint to a USB</td>
</tr>
<tr>
<td></td>
<td>flash drive.</td>
</tr>
<tr>
<td></td>
<td>See “Configuring the Endpoint Prevent: Block action” on page 922.</td>
</tr>
<tr>
<td>Endpoint Prevent: Notify</td>
<td>Display an on-screen notification to the endpoint user when confidential</td>
</tr>
<tr>
<td></td>
<td>data is transferred.</td>
</tr>
<tr>
<td></td>
<td>See “Configuring the Endpoint Prevent: Notify action” on page 924.</td>
</tr>
</tbody>
</table>
Table 36-3  Available Endpoint response rules (continued)

<table>
<thead>
<tr>
<th>Response rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Endpoint Prevent: User Cancel</td>
<td>Allow the user to cancel the transfer of a confidential file. The override is time sensitive.</td>
</tr>
<tr>
<td></td>
<td>See “Configuring the Endpoint Prevent: User Cancel action” on page 928.</td>
</tr>
</tbody>
</table>

See “About response rules” on page 875.
See “Implementing response rules” on page 886.

Response rules for Network and Mobile Prevent for Web detection

Symantec Data Loss Prevention provides several response rule actions for Network Prevent for Web, Network Prevent for Email, and Mobile Prevent for Web.

Table 36-4  Available Network response rules

<table>
<thead>
<tr>
<th>Response rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Prevent: Block FTP Request</td>
<td>Block FTP transmissions.</td>
</tr>
<tr>
<td></td>
<td>See “Configuring the Network and Mobile Prevent for Web: Block FTP Request action” on page 931.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Only available with Network Prevent for Web.</td>
</tr>
<tr>
<td>Network Prevent: Block HTTP/S</td>
<td>Block Web postings.</td>
</tr>
<tr>
<td></td>
<td>See “Configuring the Network and Mobile Prevent for Web: Block HTTP/S action” on page 931.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Only available with Network Prevent for Web.</td>
</tr>
<tr>
<td>Network Prevent: Block SMTP Message (Network Prevent only)</td>
<td>Block email that causes an incident.</td>
</tr>
<tr>
<td></td>
<td>See “Configuring the Network Prevent: Block SMTP Message action” on page 933.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Only available with Network Prevent for Email.</td>
</tr>
</tbody>
</table>
### Available Network response rules (continued)

<table>
<thead>
<tr>
<th>Response rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Prevent: Modify SMTP Message (Network Prevent only)</td>
<td>Modify sensitive email messages. For example, change the email subject to include information about the violation. See “Configuring the Network Prevent: Modify SMTP Message action” on page 934. <strong>Note:</strong> Only available with Network Prevent for Email.</td>
</tr>
<tr>
<td>Network Prevent: Remove HTTP/S Content</td>
<td>Remove confidential content from Web posts. See “Configuring the Network and Mobile Prevent for Web: Remove HTTP/S Content action” on page 935. <strong>Note:</strong> Only available with Network Prevent for Web.</td>
</tr>
</tbody>
</table>

See “About response rules” on page 875.
See “Implementing response rules” on page 886.

### Response rules for Network Protect detection

Symantec Data Loss Prevention provides several response rule actions for Network Protect (Discover).

<table>
<thead>
<tr>
<th>Response rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Protect: Copy File</td>
<td>Copy sensitive files to a location you specify. See “Configuring the Network Protect: Copy File action” on page 937. <strong>Note:</strong> Only available with Network Protect.</td>
</tr>
<tr>
<td>Network Protect: Quarantine File</td>
<td>Quarantine sensitive files. See “Configuring the Network Protect: Quarantine File action” on page 937. <strong>Note:</strong> Only available with Network Protect.</td>
</tr>
</tbody>
</table>

See “About response rules” on page 875.
See “Implementing response rules” on page 886.
Response rule for the Classification Server

The Classify Enterprise Vault Content response rule uses a Classification Server to automatically classify, archive, or delete Exchange messages with Enterprise Vault for Microsoft Exchange.

**Note:** This response rule is used only with the Symantec Data Classification for Enterprise Vault solution, which is licensed separately from Symantec Data Loss Prevention. You must configure the Enterprise Vault Data Classification Services filter and Classification Server to communicate with one another. See the *Enterprise Vault Data Classification Services Implementation Guide* for more information.

<table>
<thead>
<tr>
<th>Table 36-6 Available Classification response rule</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Response rule</strong></td>
</tr>
<tr>
<td>Classification: Classify Enterprise Vault</td>
</tr>
<tr>
<td>Content</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

See “*About response rules*” on page 875.

See “*Implementing response rules*” on page 886.

About response rule execution types

Symantec Data Loss Prevention provides two types of policy response rules: Automated and Smart.

The detection server that reports a policy violation executes Automated Response rules. Users such as incident mediators execute Smart Response rules on demand from the Enforce Server administration console.

See “*About recommended roles for your organization*” on page 88.
About Automated Response rules

The system executes Automated Response rules when the detection engine reports a policy violation. However, if you implement a response rule condition, the condition must be met for the system to execute the response rule. Conditions let you control the automated execution of response rule actions.

For example, the system can automatically block certain policy violating actions, such as the attempted transfer of high value customer data or sensitive design documents. Or, the system can escalate an incident to a workflow management system for immediate attention. Or, you can set a different severity level for an incident involving 1000 customer records than for one involving only 10 records.

About Smart Response rules

Users execute Smart Response rules on demand in response to policy violations from the Enforce Server administration console Incident Snapshot screen.

You create Smart Response rules for the situations that require human remediation. For example, you might create a Smart response rule to dismiss false positive incidents. An incident remediator can review the incident, identify the match as a false positive, and dismiss it.

See “About response rule actions” on page 875.

See “About configuring Smart Response rules” on page 892.
Only some response rules are available for manual execution.

Table 36-8  Available Smart Response rules for manual execution

<table>
<thead>
<tr>
<th>Smart response rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Note</td>
<td>Add a field to the incident record that the remediator can annotate at the Incident Snapshot screen. See “Configuring the Add Note action” on page 906.</td>
</tr>
<tr>
<td>Log to a Syslog Server</td>
<td>Log the incident to a syslog server for workflow remediation. See “Configuring the Log to a Syslog Server action” on page 909.</td>
</tr>
<tr>
<td>Send Email Notification</td>
<td>Send an email you compose to recipients you specify. See “Configuring the Send Email Notification action” on page 910.</td>
</tr>
<tr>
<td>Server FlexResponse</td>
<td>Execute a custom Server FlexResponse action. See “Configuring the Server FlexResponse action” on page 912. Note: This response rule action is available only if you deploy one or more custom Server FlexResponse plug-ins to Symantec Data Loss Prevention. See “Deploying a Server FlexResponse plug-in” on page 1231.</td>
</tr>
<tr>
<td>Set Status</td>
<td>Set the incident status to the specified value. See “Configuring the Set Status action” on page 914.</td>
</tr>
</tbody>
</table>

See “Implementing response rules” on page 886.

About response rule conditions

Response rule conditions are optional response rule components. Conditions define how and when the system triggers response rule actions. Conditions give you multiple ways to prioritize incoming incidents to focus remediation efforts and take appropriate response.

See “Implementing response rules” on page 886.

Response rule conditions trigger action based on detection match criteria. For example, you can configure a condition to trigger action for high severity incidents, certain types of incidents, or after a specified number of incidents.

See “Configuring response rule conditions” on page 892.

Conditions are not required. If a response rule does not declare a condition, the response rule action always executes each time an incident occurs. If a condition
is declared, it must be met for the action to trigger. If more than one condition is declared, all must be met for the system to take action. 

See “Configuring response rules” on page 891.

Table 36-9  
Available response rule conditions

<table>
<thead>
<tr>
<th>Condition type</th>
<th>Description</th>
</tr>
</thead>
</table>
| Endpoint Location            | Triggers a response action when the endpoint is on or off the corporate network.  
                              | See “Configuring the Endpoint Location response condition” on page 897.                                                                   |
| Endpoint Device              | Triggers a response action when an event occurs on a configured endpoint device.  
                              | See “Configuring the Endpoint Device response condition” on page 898.                                                                   |
| Incident Type                | Triggers a response action when the specified type of detection server reports a match.  
                              | See “Configuring the Incident Type response condition” on page 899.                                                                      |
| Incident Match Count         | Triggers a response action when the volume of policy violations exceeds a threshold or range.  
                              | See “Configuring the Incident Match Count response condition” on page 900.                                                                |
| Protocol or Endpoint Monitoring | Triggers a response action when an incident is detected on a specified network communications protocol (such as HTTP) or endpoint destination (such as CD/DVD).  
                                | See “Configuring the Protocol or Endpoint Monitoring response condition” on page 901.                                                    |
| Severity                     | Triggers a response action when the policy violation is a certain severity level.  
                              | See “Configuring the Severity response condition” on page 903.                                                                         |

**About response rule action execution priority**

A Symantec Data Loss Prevention server executes response rule actions according to a system-defined prioritized order. You cannot modify the order of execution among response rules of different types.

In all cases, when a server executes two or more different response rules for the same policy, the higher priority response action takes precedence.

Consider the following example(s):

- One endpoint response rule lets a user cancel an attempted file copy and another rule blocks the attempt.
The detection server blocks the file copy.

- One network response rule action copies a file and another action quarantines it.
  The detection server quarantines the file.

- One network response rule action modifies the content of an email message and another action blocks the transmission.
  The detection server blocks the email transmission.

You cannot change the priority execution order for different response rule action types. But, you can modify the order of execution for the same type of response rule action with conflicting instructions.

See “Modifying response rule ordering” on page 895.

**Table 36-10** System-defined response rule execution priority

<table>
<thead>
<tr>
<th>Execution priority (from highest to lowest)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Endpoint Prevent: Block</td>
<td>See “Configuring the Endpoint Prevent: Block action” on page 922.</td>
</tr>
<tr>
<td>Endpoint Prevent: Notify</td>
<td>See “Configuring the Endpoint Prevent: Notify action” on page 924.</td>
</tr>
<tr>
<td>Limit Incident Data Retention</td>
<td>See “Configuring the Limit Incident Data Retention action” on page 906.</td>
</tr>
<tr>
<td>Network Prevent: Block SMTP Message</td>
<td>See “Configuring the Network Prevent: Block SMTP Message action” on page 933.</td>
</tr>
<tr>
<td>Network Prevent: Modify SMTP Message</td>
<td>See “Configuring the Network Prevent: Modify SMTP Message action” on page 934.</td>
</tr>
<tr>
<td>Network and Mobile Prevent for Web: Remove HTTP/HTTPS Content</td>
<td>See “Configuring the Network and Mobile Prevent for Web: Remove HTTP/S Content action” on page 935.</td>
</tr>
</tbody>
</table>
### Table 36-10  System-defined response rule execution priority (continued)

<table>
<thead>
<tr>
<th>Execution priority (from highest to lowest)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network and Mobile Prevent for Web: Block HTTP/HTTPS</td>
<td>See “Configuring the Network and Mobile Prevent for Web: Block HTTP/HTTPS action” on page 931.</td>
</tr>
<tr>
<td>Network and Mobile Prevent for Web: Block FTP Request</td>
<td>See “Configuring the Network and Mobile Prevent for Web: Block FTP Request action” on page 931.</td>
</tr>
<tr>
<td>Network Protect: Copy File</td>
<td>See “Configuring the Network Protect: Copy File action” on page 937.</td>
</tr>
<tr>
<td>Classify Content</td>
<td>See “Configuring the Classify Enterprise Vault Content response action” on page 915.</td>
</tr>
<tr>
<td>Set Status</td>
<td>See “Configuring the Set Status action” on page 914.</td>
</tr>
<tr>
<td>Set Attribute</td>
<td>See “Configuring the Set Attribute action” on page 913.</td>
</tr>
<tr>
<td>Add Note</td>
<td>See “Configuring the Add Note action” on page 906.</td>
</tr>
<tr>
<td>Log to a Syslog Server</td>
<td>See “Configuring the Log to a Syslog Server action” on page 909.</td>
</tr>
<tr>
<td>Send Email Notification</td>
<td>See “Configuring the Send Email Notification action” on page 910.</td>
</tr>
<tr>
<td>Server FlexResponse</td>
<td>See “Configuring the Server FlexResponse action” on page 912. <strong>Note:</strong> Server FlexResponse actions that are part of Automated Response rules execute on the Enforce Server, rather than the detection server.</td>
</tr>
</tbody>
</table>

See “Implementing response rules” on page 886.
See “Manage response rules” on page 889.

**About response rule authoring privileges**

To manage and create response rules, you must be assigned to a role with response rule authoring privileges. To add a response rule to a policy, you must have policy authoring privileges.
Implementing response rules

You define response rules independent of policies.

See “About response rules” on page 875.

You must have response rule authoring privileges to create and manage response rules.

See “About response rule authoring privileges” on page 885.

Table 36-11  Workflow for implementing policy response rules

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>See “Manage response rules” on page 889.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The solution pack for your system provides configured response rules. You can use these response rules in your policies as they exist, or you can modify them.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Solution packs” on page 287.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Decide the type of response rule to implement: Smart, Automated, both.</td>
<td>Decide the type of response rules based on your business requirements.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “About response rule execution types” on page 880.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Determine the type of actions you want to implement and any triggering conditions.</td>
<td>See “About response rule conditions” on page 882.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “About response rule actions” on page 875.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Understand the order of precedence among response rule actions of different and the same types.</td>
<td>See “About response rule action execution priority” on page 883.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Modifying response rule ordering” on page 895.</td>
</tr>
</tbody>
</table>
### Table 36-11  Workflow for implementing policy response rules (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| Step 5| Integrate the Enforce Server with an external system (if required for the response rule). | Some response rules may require integration with external systems. These may include:  
- A SIEM system for the Log to a Syslog Server response rule.  
- An SMTP email server for the Send Email Notification response rule  
- An MTA for Network Prevent for Email response rules. |
| Step 6| Add a new response rule.                                                | See “Adding a new response rule” on page 890.                                                                                                                                                             |
| Step 7| Configure response rules.                                               | See “Configuring response rules” on page 891.                                                                                                                                                             |
| Step 8| Configure one or more response rule conditions (optional).              | See “Configuring response rule conditions” on page 892.                                                                                                                                                 |
| Step 9| Configure one or more response rule actions (required).                 | You must define at least one action for a valid response rule.  
See “Configuring response rule actions” on page 893.  
The action executes when a policy violation is reported or when a response rule condition is matched. |
| Step 10| Add response rules to policies.                                        | You must have policy authoring privileges to add response rules to policies.  
See “Adding an automated response rule to a policy” on page 350.                                                                                |

### Response rule best practices

When implementing response rules, consider the following:

- Response rules are not required for policy execution. In general it is best to implement and fine-tune your policy rules and exceptions before you implement response rules. Once you achieve the desired policy detection results, you can then implement and refine response rules.

- Response rules require at least one rule action; a condition is optional. If you do not implement a condition, the action always executes when an incident is
reported. If you configure more than one response rule condition, all conditions must match for the response rule action to trigger. See “About response rule actions” on page 875.

- Response rule conditions are derived from policy rules. Understand the type of rule and exception conditions that the policy implements when you configure response rule conditions. The system evaluates the response rule condition based on how the policy rule counts matches. See “Policy matching conditions” on page 300.

- The system displays only the response rule name for policy authors to select when they add response rules to policies. Be sure to provide a descriptive name that helps policy authors identify the purpose of the response rule. See “Configuring policies” on page 326.

- You cannot combine an Endpoint Prevent: Notify or Endpoint Prevent: Block response rule action with EDM, IDM, or DGM detection methods. If you do, the system displays a warning for the policy that it is misconfigured. See “Manage and add policies” on page 345.

- If you combine multiple response rules in a single policy, make sure that you understand the order of precedence among response rules. See “About response rule action execution priority” on page 883.

- Use Smart Response rules only where it is appropriate for human intervention. See “About configuring Smart Response rules” on page 892.
Configuring and managing response rules

This chapter includes the following topics:

- Manage response rules
- Adding a new response rule
- Configuring response rules
- About configuring Smart Response rules
- Configuring response rule conditions
- Configuring response rule actions
- Modifying response rule ordering
- About removing response rules

Manage response rules

The Manage > Policies > Response Rules screen is the home page for managing response rules, and the starting point for adding new ones.

See “About response rules” on page 875.

You must have response rule authoring privileges to manage and add response rules.

See “About response rule authoring privileges” on page 885.
**Table 37-1**  
Response Rules screen actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Response Rule</td>
<td>Click <strong>Add Response Rule</strong> to define a new response rule. See “Adding a new response rule” on page 890.</td>
</tr>
<tr>
<td>Modify Response Rule Order</td>
<td>Click <strong>Modify Response Rule Order</strong> to modify the response rule order of precedence. See “Modifying response rule ordering” on page 895.</td>
</tr>
<tr>
<td>Edit an existing response rule</td>
<td>Click the response rule to modify it. See “Configuring response rules” on page 891.</td>
</tr>
<tr>
<td>Delete an existing response rule</td>
<td>Click the red X icon next to the far right of the response rule to delete it. You must confirm the operation before deletion occurs. See “About removing response rules” on page 896.</td>
</tr>
<tr>
<td>Refresh the list</td>
<td>Click the refresh arrow icon at the upper right of the Response Rules screen to fetch the latest status of the rule.</td>
</tr>
</tbody>
</table>

**Table 37-2**  
Response Rules screen display

<table>
<thead>
<tr>
<th>Display column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order</td>
<td>The <strong>Order</strong> of precedence when more than one response rule is configured. See “Modifying response rule ordering” on page 895.</td>
</tr>
<tr>
<td>Rule</td>
<td>The <strong>Name</strong> of the response rule. See “Configuring response rules” on page 891.</td>
</tr>
<tr>
<td>Actions</td>
<td>The type of <strong>Action</strong> the response rule can take to respond to an incident (required). See “Configuring response rule actions” on page 893.</td>
</tr>
<tr>
<td>Conditions</td>
<td>The <strong>Condition</strong> that triggers the response rule (if any). See “Configuring response rule conditions” on page 892.</td>
</tr>
</tbody>
</table>

See “Implementing response rules” on page 886.

**Adding a new response rule**


See “About response rules” on page 875.
To add a new response rule

   
   See “Manage response rules” on page 889.

2. At the **New Response Rule** screen, select one of the following options:
   
   - **Automated Response**
     
     The system automatically executes the response action as the server evaluates incidents (default option).
     
     See “About Automated Response rules” on page 881.

   - **Smart Response**
     
     An authorized user executes the response action from the Incident Snapshot screen in the Enforce Server administration console.
     
     See “About Smart Response rules” on page 881.

3. Click **Next** to configure the response rule.
   
   See “Configuring response rules” on page 891.

   See “Implementing response rules” on page 886.

### Configuring response rules


See “About response rules” on page 875.

**To configure a response rule**

1. Add a new response rule, or modify an existing one.
   
   See “Adding a new response rule” on page 890.
   
   See “Manage response rules” on page 889.

2. Enter a response **Rule Name** and **Description**.

3. Optionally, define one or more **Conditions** to dictate when the response rule executes.

   See “Configuring response rule conditions” on page 892.

   If no condition is declared, the response rule action always executes when there is a match (assuming that the detection rule is set the same).

   Skip this step if you selected the **Smart Response** rule option.

   See “About configuring Smart Response rules” on page 892.
4 Select and configure one or more Actions. You must define at least one action.
See “Configuring response rule actions” on page 893.

5 Click Save to save the response rule definition.
See “Manage response rules” on page 889.
See “Implementing response rules” on page 886.

About configuring Smart Response rules

When implementing Smart Response rules, consider the following:

- Smart Response rules are best suited for the incidents that warrant user review to determine if any response action is required.
  If you do not want user involvement in triggering a response rule action, use Automated Response rules instead.

- You cannot configure any triggering conditions with Smart Response rules. Authorized users decide when a detection incident warrants a response.

- You are limited in the actions you can take with Smart Response rules (note, log, email, status).
  If you need to block or modify an action, use Automated Response rules.

See “About Smart Response rules” on page 881.
See “Implementing response rules” on page 886.

Configuring response rule conditions

You can add one or more conditions to a response rule. An incident must meet all response rule conditions before the system executes any response rule actions.

See “About response rule conditions” on page 882.

To configure a response rule condition

1 Configure a response rule at the Configure Response Rule screen.
See “Configuring response rules” on page 891.

2 Click Add Condition to add a new condition.
Conditions are optional and based on detection rule matches. Each type of response rule condition performs a different function.
See “About response rule conditions” on page 882.
3 Choose the condition type from the **Conditions** list.
   
   See Table 36-9 on page 883.
   
   For example, select the condition **Incident Match Count** and **Is Greater Than** and enter **15** in the textbox. This condition triggers the response rule action after 15 policy violation matches.

4 To add another condition, click **Add Condition** and repeat the process.
   
   If all conditions do not match, no action is taken.

5 Click **Save** to save the condition.
   
   Click **Cancel** to not save the condition and return to the previous screen.
   
   Click the **red X** icon beside the condition to delete it from the response rule.
   
   See "Manage response rules" on page 889.

   See “Implementing response rules” on page 886.

### Configuring response rule actions

You must configure at least one action for the response rule to be valid. You can configure multiple response rule actions. Each action is evaluated independently.

See “Implementing response rules” on page 886.

**To define a response rule action**

1 Configure a response rule at the **Configure Response Rule** screen.
   
   See “Configuring response rules” on page 891.

2 Choose an action type from the **Actions** list and click **Add Action**.
   
   For example, add the **All: Add Note** action to the response rule. This action lets the remediator annotate the incident.

3 Configure the action type by specifying the expected parameters for the chosen action type.
   
   See Table 37-3 on page 894.

4 Repeat these steps for each action you want to add.
   
   If you add additional actions, consider the execution order and possible modification of similar types.
   
   See “Modifying response rule ordering” on page 895.

5 Click **Save** to save the response rule.
   
   See “Manage response rules” on page 889.
<table>
<thead>
<tr>
<th>Incident type</th>
<th>Response rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Add Note</td>
<td>See “Configuring the Add Note action” on page 906.</td>
</tr>
<tr>
<td>All</td>
<td>Limit Incident Data Retention</td>
<td>See “Configuring the Limit Incident Data Retention action” on page 906.</td>
</tr>
<tr>
<td>All</td>
<td>Log to a Syslog Server</td>
<td>See “Configuring the Log to a Syslog Server action” on page 909.</td>
</tr>
<tr>
<td>All</td>
<td>Send Email Notification</td>
<td>See “Configuring the Send Email Notification action” on page 910.</td>
</tr>
<tr>
<td>All</td>
<td>Server FlexResponse</td>
<td>See “Configuring the Server FlexResponse action” on page 912.</td>
</tr>
<tr>
<td>All</td>
<td>Set Attribute</td>
<td>See “Configuring the Set Attribute action” on page 913.</td>
</tr>
<tr>
<td>All</td>
<td>Set Status</td>
<td>See “Configuring the Set Status action” on page 914.</td>
</tr>
<tr>
<td>Classification</td>
<td>Classify Enterprise Vault Content</td>
<td>See “Configuring the Classify Enterprise Vault Content response action” on page 915.</td>
</tr>
<tr>
<td>Endpoint</td>
<td>FlexResponse</td>
<td>See “Configuring the Endpoint: FlexResponse action” on page 919.</td>
</tr>
<tr>
<td>Endpoint Discover</td>
<td>Quarantine File</td>
<td>See “Configuring the Endpoint Discover: Quarantine File action” on page 920.</td>
</tr>
<tr>
<td>Endpoint Prevent</td>
<td>Block</td>
<td>See “Configuring the Endpoint Prevent: Block action” on page 922.</td>
</tr>
<tr>
<td>Endpoint Prevent</td>
<td>Notify</td>
<td>See “Configuring the Endpoint Prevent: Notify action” on page 924.</td>
</tr>
<tr>
<td>Network and Mobile Prevent for Web</td>
<td>Block FTP Request</td>
<td>See “Configuring the Network and Mobile Prevent for Web: Block FTP Request action” on page 931.</td>
</tr>
<tr>
<td>Network and Mobile Prevent for Web</td>
<td>Block HTTP/S</td>
<td>See “Configuring the Network and Mobile Prevent for Web: Block HTTP/S action” on page 931.</td>
</tr>
<tr>
<td>Network Prevent for Email</td>
<td>Block SMTP Message</td>
<td>See “Configuring the Network Prevent: Block SMTP Message action” on page 933.</td>
</tr>
<tr>
<td>Network Prevent for Email</td>
<td>Modify SMTP Message</td>
<td>See “Configuring the Network Prevent: Modify SMTP Message action” on page 934.</td>
</tr>
<tr>
<td>Network and Mobile Prevent for Web</td>
<td>Remove HTTP/S Content</td>
<td>See “Configuring the Network and Mobile Prevent for Web: Remove HTTP/S Content action” on page 935.</td>
</tr>
</tbody>
</table>
Modifying response rule ordering

You cannot change the system-defined execution priority for different types of response rule actions. But, you can modify the order of execution for response rule actions of the same type with conflicting instructions.

See “About response rule action execution priority” on page 883.

For example, consider a scenario where you include two response rules in a policy. Each response rule implements a Limit Incident Data Retention action. One action discards all attachments and the other action discards only those attachments that are not violations. In this case, when the policy is violated, the detection server looks to the response rule order priority to determine which action takes precedence. This type of ordering is configurable.

To modify response rule action ordering

   See “Manage response rules” on page 889.

2. Note the Order column and number beside each configured response rule.
   By default the system sorts the list of response rules by the Order column in descending order from highest priority (1) to lowest. Initially the system orders the response rules in the order they are created. You can modify this order.

3. To enable modification mode, click Modify Response Rule Order.
   The Order column now displays a drop-down menu for each response rule.

4. To modify the ordering, for each response rule you want to reorder, select the desired order priority from the drop-down menu.
   For example, for a response rule with order priority of 2, you can modify it to be 1 (highest priority).
   Modifying an order number moves that response rule to its modified position in the list and updates all other response rules.
5  Click **Save** to save the modifications to the response rule ordering.

6  Repeat these steps as necessary to achieve the desired results.

See “Implementing response rules” on page 886.

### About removing response rules

You can delete response rules at the **Manage > Policies > Response Rules** screen.

See “Manage response rules” on page 889.

When deleting a response rule, consider the following:

- A user must have response rule authoring privileges to delete an existing response rule.
- A response rule author cannot delete an existing response rule while another user modifies it.
- A response rule author cannot delete a response rule if a policy declares that response rule. In this case you must remove the response rule from all policies that declare the response rule before you can delete it.
Response rule conditions

This chapter includes the following topics:

- Configuring the Endpoint Location response condition
- Configuring the Endpoint Device response condition
- Configuring the Incident Type response condition
- Configuring the Incident Match Count response condition
- Configuring the Protocol or Endpoint Monitoring response condition
- Configuring the Severity response condition

Configuring the Endpoint Location response condition

The Endpoint Location condition triggers response rule action based on the connection status of the DLP Agent when an endpoint policy is violated.

See “About response rule conditions” on page 882.

**Note:** This condition is specific to endpoint incidents. You should not implement this condition for Network or Discover incidents. If you do the response rule action does not to execute.
To configure the Endpoint Location condition

1. Configure a response rule at the **Configure Response Rule** screen.
   See “Configuring response rules” on page 891.

2. Select the **Endpoint Location** condition from the **Conditions** list.
   See “Configuring response rule conditions” on page 892.

3. Select the endpoint location requirements to trigger actions.
   See Table 38-1 on page 898.

<table>
<thead>
<tr>
<th>Qualifier</th>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is Any Of</td>
<td>Off the corporate network</td>
<td>This combination triggers a response rule action if an incident occurs when the endpoint is off the corporate network.</td>
</tr>
<tr>
<td>Is None Of</td>
<td>Off the corporate network</td>
<td>This combination does not trigger a response rule action if an incident occurs when the endpoint is off the corporate network.</td>
</tr>
<tr>
<td>Is Any Of</td>
<td>On the corporate network</td>
<td>This combination triggers a response rule action if an incident occurs when the endpoint is on the corporate network.</td>
</tr>
<tr>
<td>Is None Of</td>
<td>On the corporate network</td>
<td>This combination does not trigger a response rule action if an incident occurs when the endpoint is on the corporate network.</td>
</tr>
</tbody>
</table>

See “Implementing response rules” on page 886.
See “Manage response rules” on page 889.

### Configuring the Endpoint Device response condition

The Endpoint Device condition triggers response rule action when an incident is detected from one or more configured endpoint devices.

See “About response rule conditions” on page 882.

You configure endpoint devices at the **System > Agents > Endpoint Devices** screen.

See “About endpoint device detection” on page 634.

**Note:** This condition is specific to endpoint incidents. You should not implement this condition for Network or Discover incidents. If you do the response rule action does not to execute.
To configure the Endpoint Device response condition

1 Configure a response rule at the **Configure Response Rule** screen.
   See “Configuring response rules” on page 891.

2 Select the **Endpoint Device** condition from the **Conditions** list.
   See “Configuring response rule conditions” on page 892.

3 Select to detect or except specific endpoint devices.
   See Table 38-2 on page 899.

<table>
<thead>
<tr>
<th>Qualifier</th>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is Any Of</td>
<td>Configured device</td>
<td>Triggers a response rule action when an incident is detected on a configured endpoint device.</td>
</tr>
<tr>
<td>Is None Of</td>
<td>Configured device</td>
<td>Does not trigger (excludes from executing) a response rule action when an incident is detected on a configured endpoint device.</td>
</tr>
</tbody>
</table>

See “Implementing response rules” on page 886.
See “Manage response rules” on page 889.

### Configuring the Incident Type response condition

The Incident Type condition triggers a response rule action based on the type of detection server that reports the incident.

See “About response rule conditions” on page 882.

To configure the Incident Type condition

1 Configure a response rule at the **Configure Response Rule** screen.
   See “Configuring response rules” on page 891.

2 Choose the **Incident Type** condition from the **Conditions** list.
   See “Configuring response rule conditions” on page 892.

3 Select one or more incident types.
   Use the Ctrl key to select multiple types.
   See Table 38-3 on page 900.
### Table 38-3 Incident Type condition parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Server</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is Any Of</td>
<td>Classification</td>
<td>Triggers a response rule action for any incident that the Classification Server detects.</td>
</tr>
<tr>
<td>Is None Of</td>
<td></td>
<td>Does not trigger a response rule action for any incident that the Classification Server detects.</td>
</tr>
<tr>
<td>Is Any Of</td>
<td>Discover</td>
<td>Triggers a response rule action for any incident that Network Discover detects.</td>
</tr>
<tr>
<td>Is None Of</td>
<td></td>
<td>Does not trigger a response rule action for any incident that Network Discover detects.</td>
</tr>
<tr>
<td>Is Any Of</td>
<td>Endpoint</td>
<td>Triggers a response rule action for any incident that Endpoint Prevent detects.</td>
</tr>
<tr>
<td>Is None Of</td>
<td></td>
<td>Does not trigger a response rule action for any incident that Endpoint Prevent detects.</td>
</tr>
<tr>
<td>Is Any Of</td>
<td>Network or Mobile</td>
<td>Triggers a response rule action for any incident that Network Prevent detects.</td>
</tr>
<tr>
<td>Is None Of</td>
<td></td>
<td>Does not trigger a response rule action for any incident that Network Prevent detects.</td>
</tr>
</tbody>
</table>

See “Implementing response rules” on page 886.
See “Manage response rules” on page 889.

### Configuring the Incident Match Count response condition

The Incident Match Count condition triggers a response rule action based on the number of policy violations reported.

See “About response rule conditions” on page 882.
To configure the Incident Match Count condition

1. Configure a response rule at the **Configure Response Rule** screen.
   
   See “Configuring response rules” on page 891.

2. Choose the **Incident Match Count** condition from the **Conditions** list.
   
   See “Configuring response rule conditions” on page 892.

3. In the text field, enter a numeric value that indicates the threshold above which you want the response rule to trigger.

   For example, if you enter 15 the response rule triggers after 15 policy violations have been detected.

   See Table 38-4 on page 901.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is Greater Than</td>
<td>User-specified number</td>
<td>Triggers a response rule action if the threshold number of incidents is eclipsed.</td>
</tr>
<tr>
<td>Is Greater Than or Equals</td>
<td>User-specified number</td>
<td>Triggers a response rule action if the threshold number of incidents is met or eclipsed.</td>
</tr>
<tr>
<td>Is Between</td>
<td>User-specified pair of numbers</td>
<td>Triggers a response rule action when the number of incidents is between the range of numbers specified.</td>
</tr>
<tr>
<td>Is Less Than</td>
<td>User-specified number</td>
<td>Triggers a response rule action if the number of incidents is less than the specified number.</td>
</tr>
<tr>
<td>Is Less Than or Equals</td>
<td>User-specified number</td>
<td>Triggers a response rule action when the number of incidents is equal to or less than the specified number.</td>
</tr>
</tbody>
</table>

See “Implementing response rules” on page 886.

See “Manage response rules” on page 889.

### Configuring the Protocol or Endpoint Monitoring response condition

The Protocol or Endpoint Monitoring condition triggers action based on the protocol or the endpoint destination, device, or application where the policy violation occurred.

See “About response rule conditions” on page 882.
To configure the Protocol or Endpoint Monitoring condition

1. Configure a response rule at the **Configure Response Rule** screen.
   
   See “Configuring response rules” on page 891.

2. Choose the **Protocol or Endpoint Monitoring** condition from the **Conditions** list.
   
   See “Configuring response rule conditions” on page 892.

3. Use the **Ctrl** key to select multiple, or use the **Shift** key to select a range.
   
   See Table 38-5 on page 902.

   The system lists any additional network protocols that you configure at the System > Settings > Protocols screen.

### Table 38-5 Protocol or Endpoint Destination condition options

<table>
<thead>
<tr>
<th>Qualifier</th>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is Any Of</td>
<td>Endpoint Application File Access</td>
<td>Triggers an action if an endpoint application file has been accessed.</td>
</tr>
<tr>
<td>Is None Of</td>
<td>Endpoint Application File Access</td>
<td>Does not trigger action if an endpoint application file has been accessed.</td>
</tr>
<tr>
<td>Is Any Of</td>
<td>Endpoint CD/DVD</td>
<td>Triggers an action if an endpoint CD/DVD has been written to.</td>
</tr>
<tr>
<td>Is None Of</td>
<td>Endpoint CD/DVD</td>
<td>Does not trigger action if an endpoint CD/DVD has been written to.</td>
</tr>
<tr>
<td>Is Any Of</td>
<td>Endpoint Clipboard</td>
<td>Triggers an action if the endpoint clipboard has been copied to.</td>
</tr>
<tr>
<td>Is None Of</td>
<td>Endpoint Clipboard</td>
<td>Does not trigger action if the endpoint clipboard has been copied to.</td>
</tr>
<tr>
<td>Is Any Of</td>
<td>Endpoint Copy to Network Share</td>
<td>Triggers an action if sensitive information is copied to or from a network share.</td>
</tr>
<tr>
<td>Is None Of</td>
<td>Endpoint Copy to Network Share</td>
<td>Does not trigger action if sensitive information is copied to or from a network share.</td>
</tr>
<tr>
<td>Is Any Of</td>
<td>Endpoint Local Drive</td>
<td>Triggers an action if sensitive files are discovered on the local drive.</td>
</tr>
<tr>
<td>Is None Of</td>
<td>Endpoint Local Drive</td>
<td>Does not trigger action if sensitive files are discovered on the local drive.</td>
</tr>
<tr>
<td>Is Any Of</td>
<td>Endpoint Printer/Fax</td>
<td>Triggers an action if an endpoint printer or fax has been sent to.</td>
</tr>
<tr>
<td>Is None Of</td>
<td>Endpoint Printer/Fax</td>
<td>Does not trigger action if an endpoint printer or fax has been sent to.</td>
</tr>
</tbody>
</table>
### Table 38-5
Protocol or Endpoint Destination condition options *(continued)*

<table>
<thead>
<tr>
<th>Qualifier</th>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is Any Of</td>
<td>Endpoint Removable</td>
<td>Triggers an action if sensitive data is copied to a removable storage device.</td>
</tr>
<tr>
<td></td>
<td>Storage Device</td>
<td></td>
</tr>
<tr>
<td>Is None Of</td>
<td></td>
<td>Does not trigger action if sensitive data is copied to a removable storage</td>
</tr>
<tr>
<td></td>
<td></td>
<td>device.</td>
</tr>
<tr>
<td>Is Any Of</td>
<td>FTP</td>
<td>Triggers an action if sensitive data is copied through FTP.</td>
</tr>
<tr>
<td>Is None Of</td>
<td></td>
<td>Does not trigger action if sensitive data is copied through FTP.</td>
</tr>
<tr>
<td>Is Any Of</td>
<td>HTTP</td>
<td>Triggers an action if sensitive data is sent through HTTP.</td>
</tr>
<tr>
<td>Is None Of</td>
<td></td>
<td>Does not trigger action if sensitive data is sent through HTTP.</td>
</tr>
<tr>
<td>Is Any Of</td>
<td>HTTPS</td>
<td>Triggers an action if sensitive data is sent through HTTPS.</td>
</tr>
<tr>
<td>Is None Of</td>
<td></td>
<td>Does not trigger action if sensitive data is sent through HTTPS.</td>
</tr>
<tr>
<td>Is Any Of</td>
<td>IM:AIM</td>
<td>Triggers an action if sensitive data is sent through AIM.</td>
</tr>
<tr>
<td>Is None Of</td>
<td></td>
<td>Does not trigger action if sensitive data is sent through AIM.</td>
</tr>
<tr>
<td>Is Any Of</td>
<td>IM:MSN</td>
<td>Triggers an action if sensitive data is sent through MSN.</td>
</tr>
<tr>
<td>Is None Of</td>
<td></td>
<td>Does not trigger action if sensitive data is sent through MSN.</td>
</tr>
<tr>
<td>Is Any Of</td>
<td>IM:Yahoo</td>
<td>Triggers an action if sensitive data is sent through Yahoo IM.</td>
</tr>
<tr>
<td>Is None Of</td>
<td></td>
<td>Does not trigger action if sensitive data is sent through Yahoo IM.</td>
</tr>
<tr>
<td>Is Any Of</td>
<td>NNTP</td>
<td>Triggers an action if sensitive data is sent through NNTP.</td>
</tr>
<tr>
<td>Is None Of</td>
<td></td>
<td>Does not trigger action if sensitive data is sent through NNTP.</td>
</tr>
<tr>
<td>Is Any Of</td>
<td>SMTP</td>
<td>Triggers an action if sensitive data is sent through SMTP.</td>
</tr>
<tr>
<td>Is None Of</td>
<td></td>
<td>Does not trigger action if sensitive data is sent through SMTP.</td>
</tr>
</tbody>
</table>

See “Implementing response rules” on page 886.

See “Manage response rules” on page 889.

### Configuring the Severity response condition

The Severity condition triggers a response rule action based on the severity of the policy rule violation.
To configure the Severity condition

1. Configure a response rule at the Configure Response Rule screen.
   See “Configuring response rules” on page 891.

2. Select the Severity condition from the Conditions list.
   See “Configuring response rule conditions” on page 892.

3. Select one or more severity levels.
   Use the Ctrl key to select multiple; use the Shift key to select a range.
   See Table 38-6 on page 904.

### Table 38-6 Severity condition matches

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Severity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is Any Of</td>
<td>High</td>
<td>Triggers a response rule action when a detection rule with severity set to high is matched.</td>
</tr>
<tr>
<td>Is None Of</td>
<td>High</td>
<td>Does not trigger a response rule action when a detection rule with severity set to high is matched.</td>
</tr>
<tr>
<td>Is Any Of</td>
<td>Medium</td>
<td>Triggers a response rule action when a detection rule with severity set to medium is matched.</td>
</tr>
<tr>
<td>Is None Of</td>
<td>Medium</td>
<td>Does not trigger a response rule action when a detection rule with severity set to medium is matched.</td>
</tr>
<tr>
<td>Is Any Of</td>
<td>Low</td>
<td>Triggers a response rule action when a detection rule with severity set to low is matched.</td>
</tr>
<tr>
<td>Is None Of</td>
<td>Low</td>
<td>Does not trigger a response rule action when a detection rule with severity set to low is matched.</td>
</tr>
<tr>
<td>Is Any Of</td>
<td>Info</td>
<td>Triggers a response rule action when a detection rule with severity set to info is matched.</td>
</tr>
<tr>
<td>Is None Of</td>
<td>Info</td>
<td>Does not trigger a response rule action when a detection rule with severity set to info is matched.</td>
</tr>
</tbody>
</table>

See “Implementing response rules” on page 886.

See “Manage response rules” on page 889.
This chapter includes the following topics:

- Configuring the Add Note action
- Configuring the Limit Incident Data Retention action
- Configuring the Log to a Syslog Server action
- Configuring the Send Email Notification action
- Configuring the Server FlexResponse action
- Configuring the Set Attribute action
- Configuring the Set Status action
- Configuring the Classify Enterprise Vault Content response action
- Configuring the Endpoint: FlexResponse action
- Configuring the Endpoint Discover: Quarantine File action
- Configuring the Endpoint Prevent: Block action
- Configuring the Endpoint Prevent: Notify action
- Configuring the Endpoint Prevent: User Cancel action
- Configuring the Network and Mobile Prevent for Web: Block FTP Request action
- Configuring the Network and Mobile Prevent for Web: Block HTTP/S action
- Configuring the Network Prevent: Block SMTP Message action
- Configuring the Network Prevent: Modify SMTP Message action
- Configuring the Network and Mobile Prevent for Web: Remove HTTP/S Content action
Configuring the Add Note action

The Add Note response rule action lets an incident responder enter a note about a particular incident. For example, if a policy violation occurs, the system presents the incident responder with a Note dialog that the responder can annotate.

See “About response rule actions” on page 875.

The Add Note response rule action is available for all types of detection servers.

See “Response rules for all detection servers” on page 876.

To configure the Add Note action

1. Configure a response rule at the **Configure Response Rule** screen.
   See “Configuring response rules” on page 891.

2. Add the **All: Add Note** action type from the **Actions** list.
   The system displays a **Note** field. Generally you leave the field blank and allow remediators to add comments when they evaluate incidents. However, you can add comments at this level of configuration as well.
   See “Configuring response rule actions” on page 893.

3. Click **Save** to save the configuration.
   See “Manage response rules” on page 889.
   See “Implementing response rules” on page 886.

Configuring the Limit Incident Data Retention action

The Limit Incident Data Retention response rule action lets you modify the default incident data retention behavior of the detection server.

See “About response rule actions” on page 875.

This response rule is available for all types of detection servers.

See “Response rules for all detection servers” on page 876.
To configure incident data retention

1. Configure a response rule at the Configure Response Rule screen.
   See “Configuring response rules” on page 891.

2. Add the action type All: Limit Incident Data Retention from the Actions list.
   See “Configuring response rule actions” on page 893.

3. Choose to retain Endpoint Incident data by selecting this option.
   By default, the agent discards the original message and any attachments for endpoint incidents.
   See “Retaining data for endpoint incidents” on page 907.

4. Choose to discard Network Incident data by selecting this option.
   By default, the system retains the original message and any attachments for network incidents.
   See “Discarding data for network incidents” on page 908.

5. Click Save to save the response rule configuration.
   See “Manage response rules” on page 889.
   See “Implementing response rules” on page 886.

Retaining data for endpoint incidents

By default, the system discards original messages (including files and attachments) for endpoint incidents. You can implement the Limit Incident Data Retention response rule action to override this default behavior and retain original messages for endpoint incidents.

Note: Limit Incident Data Retention does not apply to Endpoint Print or Clipboard incidents.

See “Configuring the Limit Incident Data Retention action” on page 906.

<table>
<thead>
<tr>
<th>Table 39-1 Retaining data for endpoint incidents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter</td>
</tr>
<tr>
<td>All Endpoint Incidents</td>
</tr>
<tr>
<td>(including Endpoint Discover incidents)</td>
</tr>
</tbody>
</table>
If you combine a server-side detection rule (EDM/IDM/DGM) with a Limit Incident Data Retention response rule action on the endpoint, consider the network bandwidth implications. When an Endpoint Agent sends content to an Endpoint Server for analysis, it sends text or binary data according to detection requirements. If possible, Symantec DLP Agents send text to reduce bandwidth use. When you retain the original messages for endpoint incidents, in every case the system requires agents to send binary data to the Endpoint Server. As such, make sure that your network can handle the increased traffic between Endpoint Agents and Endpoint Servers without degrading performance.

See “Two-tier detection for DLP Agents” on page 309.

Consider the system behavior for any policies that combine an agent-side detection rule (any DCM rule, such as a keyword rule). If you implement the Limit Incident Data Retention response rule action, the increased use bandwidth depends on the number of incidents the detection engine matches. For such policies, the Endpoint Agent does not send all original files to the Endpoint Server, but only those associated with confirmed incidents. If there are not many incidents, the effect is small.

**Discarding data for network incidents**

For network incidents, by default the detection server retains the original message and any attachments that trigger an incident.

You can implement the Limit Incident Data Retention response rule action to override the default behavior and discard original messages and some or all attachments.

See “Configuring the Limit Incident Data Retention action” on page 906.

**Note:** The default data retention behavior for network incidents applies to Network Prevent for Web and Network Prevent for Email incidents. The default behavior does not apply to Network Discover incidents. For Network Discover incidents, the system provides a link in the Incident Snapshot that points to the offending file at its original location. Incident data retention for Network Discover is not configurable.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discard Original Message</td>
<td>Check this option to discard the original message.</td>
</tr>
<tr>
<td></td>
<td>Use this configuration to save disk space when you are only interested in statistical data.</td>
</tr>
</tbody>
</table>
### Table 39-2  Discarding data from network incidents (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discard Attachment</td>
<td>Select <strong>All</strong> to discard all message attachments.</td>
</tr>
<tr>
<td></td>
<td>Select <strong>Attachments with no Violations</strong> to save only relevant message attachments, that is, those that trigger a policy violation.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You must select something other than None for this action option. If you leave None selected and do not check the box next to <strong>Discard Original Message</strong>, the action has no effect. Such a configuration duplicates the default incident data retention behavior for network servers.</td>
</tr>
</tbody>
</table>

### Configuring the Log to a Syslog Server action

The Log to a Syslog Server response rule action logs the incident to a syslog server. These logs can be useful if you use a Security Information and Events Management (SIEM) system.

See “About response rule actions” on page 875.

This response rule action is available for all types of detection servers.

See “Response rules for all detection servers” on page 876.

**Note:** You use this response rule in conjunction with a syslog server. See “Enabling a syslog server” on page 144.

#### To configure the Log to a Syslog Server response rule action

1. Configure a response rule at the **Configure Response Rule** screen. See “Configuring response rules” on page 891.
2. Add the **Log to a Syslog Server** action type from the **Actions** list. See “Configuring response rule actions” on page 893.
3. Enter the **Host** name of the syslog server.
4. Edit the **Port** for the syslog server, if necessary. The default port is **514**.
5. Enter the text of the **Message** to log on the syslog server.
6. Select the **Level** to apply to the log message from the drop-down list. The following options are available:
   - 0 - Kernel panic
1. Needs immediate attention
2. Critical condition
3. Error
4. Warning
5. May need attention
6. Informational
7. Debugging

7. **Save** the response rule.

See “Manage response rules” on page 889.

See “Implementing response rules” on page 886.

### Configuring the Send Email Notification action

The Send Email Notification action sends an email you compose to recipients you specify.

See “About response rule actions” on page 875.

This response rule action is available for all types of detection servers.

See “Response rules for all detection servers” on page 876.

You must integrate the Enforce Server with an SMTP email server to implement this response rule action.

See “Configuring the Enforce Server to send email alerts” on page 146.

**To configure the Send Email Notification response rule action**

1. Configure a response rule at the **Configure Response Rule** screen.
   
   See “Configuring response rules” on page 891.

2. Add the **All: Send Email Notification** action type from the **Actions** list.
   
   See “Configuring response rule actions” on page 893.

3. Configure the recipient(s), sender, format, incident inclusion, and messages per day.
   
   See Table 39-3 on page 911.
4  Configure the **Notification Content** of the email notification: language, subject, body.

   See Table 39-4 on page 911.

5  Click **Save** to save the configuration.

   See “Manage response rules” on page 889.

**Table 39-3**  
Sender and recipient information

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To: Sender</td>
<td>Select this option to send the email notification to the email sender. This recipient only applies to email message violations.</td>
</tr>
<tr>
<td>To: Data Owner</td>
<td>Select this option to send email notification to the data owner that the system identifies by email address in the incident.</td>
</tr>
<tr>
<td></td>
<td>See “Discover incident snapshots” on page 991.</td>
</tr>
<tr>
<td>To: Other Email Address</td>
<td>This option can include any custom attributes designated as email addresses (such as &quot;manager@email&quot;). For example, if you define a custom attribute that is an email address, or retrieve one via a Lookup Plugin, that address will appear in the “To” field for selection, to the right of &quot;To: Sender&quot; and &quot;To: Data Owner.&quot;</td>
</tr>
<tr>
<td></td>
<td>See “Configuring custom attributes” on page 1079.</td>
</tr>
<tr>
<td>Custom To</td>
<td>Enter one or more specific email addresses separated by commas.</td>
</tr>
<tr>
<td>CC</td>
<td>Enter one or more specific email addresses separated by commas for people you want to copy on the notification.</td>
</tr>
<tr>
<td>Custom From</td>
<td>You can specify the sender of the message.</td>
</tr>
<tr>
<td></td>
<td>If this field is blank, the message appears to come from the system email address.</td>
</tr>
<tr>
<td>Notification Format</td>
<td>Select either HTML or plain text format.</td>
</tr>
<tr>
<td>Include Original Message</td>
<td>Select this option to include the message that generated the incident with the notification email.</td>
</tr>
<tr>
<td>Max Per Day</td>
<td>Enter a number to restrict the maximum number of notifications that the system sends in a day.</td>
</tr>
</tbody>
</table>

**Table 39-4**  
Notification content

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language</td>
<td>Select the language for the message from the drop-down menu.</td>
</tr>
</tbody>
</table>
Table 39-4 Notification content (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Language</td>
<td>Click the icon to add multiple language(s) for the message. See &quot;About Endpoint Prevent response rules in different locales&quot; on page 1380.</td>
</tr>
<tr>
<td>Subject</td>
<td>Enter a subject for the message that indicates what the message is about.</td>
</tr>
<tr>
<td>Body</td>
<td>Enter the body of the message.</td>
</tr>
<tr>
<td>Insert Variables</td>
<td>You can add one or more variables to the subject or body of the email message by selecting the desired value(s) from the Insert Variables list. Variables can be used to include the file name, policy name, recipients, and sender in both the subject and the body of the email message. For example, to include the policy and rules violated, you would insert the following variables. A message has violated the following rules in $POLICY$: $RULES$</td>
</tr>
</tbody>
</table>

See "Implementing response rules" on page 886.

Configuring the Server FlexResponse action

The All: Server FlexResponse action enables you to remediate any incident type using a custom, server-side FlexResponse plug-in. You can configure a Server FlexResponse response action for either automated response rules or smart response rules.

The All: Server FlexResponse action is available only if you have licensed Network Protect and you have deployed one or more Server FlexResponse plug-ins to Symantec Data Loss Prevention.

See “Deploying a Server FlexResponse plug-in” on page 1231.

To configure a Server FlexResponse action

1. Log on to the Enforce Server administration console.
3. Click Add Response Rule.
4. Select either Automated Response or Smart Response. Click Next.
5. Enter a name for the rule in the Rule Name field. (For Smart Response rules, this name appears as the label on the button that incident responders select during remediation.)

6. Enter an optional description for the rule in the Description field.

7. In the Actions (executed in the order shown) menu, select the action All: Server FlexResponse.

8. Click Add Action.

9. In the FlexResponse Plugin menu, select a deployed Server FlexResponse plug-in to execute with this Response Rule action.

   The name that appears in this drop-down menu is the value specified in the display-name property from either the configuration properties file or the plug-in metadata class.

   See “Deploying a Server FlexResponse plug-in” on page 1231.

10. Click Save.

11. Repeat this procedure, adding a Response Rule for any additional Server FlexResponse plug-ins that you have deployed.

Configuring the Set Attribute action

The Set Attribute response rule action sets the incident status to the specified value.

See “About response rule actions” on page 875.

This response rule action is available for all detection servers.

See "Response rules for all detection servers" on page 876.

The Set Attribute action is based on custom attributes you define at the System > Incident Data > Attributes screen.

See “About custom attributes” on page 1076.

To configure the Set Attribute action

1. Configure a response rule at the Configure Response Rule screen.

   See “Configuring response rules” on page 891.

2. Add the All: Set Attribute action type from the Actions list.

   See “Configuring response rule actions” on page 893.

3. Select the Attribute from the drop-down list (if more than one custom attribute is defined).
4 Enter an incident status Value for the selected custom attribute.
5 Click Save to save the configuration.
See “Manage response rules” on page 889.
See “Implementing response rules” on page 886.

Configuring the Set Status action

The Set Status response rule action sets the incident status to the specified value.
See “About response rule actions” on page 875.
This response rule is available for all detection servers.
See “Response rules for all detection servers” on page 876.
This response rule action is based on the incident Status Values you configure at
the System > Incident Data > Attributes screen.
See “About incident status attributes” on page 1069.
To configure the Set Status response rule action
1 Configure a response rule at the Configure Response Rule screen.
   See “Configuring response rules” on page 891.
2 Add the All: Set Status action type from the Actions list.
3 See “Configuring response rule actions” on page 893.
4 Select the Status to assign to the incident from the list.
   The following are some example incident statuses you might configure and
   select from:
   ■ New
   ■ Escalated
   ■ Investigation
   ■ Resolved
   ■ Dismissed
5 Click Save to save the configuration.
   See “Manage response rules” on page 889.
See “Implementing response rules” on page 886.
Configuring the Classify Enterprise Vault Content response action

The Classification: Classify Enterprise Vault Content response rule defines the classification result tags that the Classification Server generates for an Exchange message that matches a detection policy. The Classification Server delivers the retention category and classification tag to the Data Classification for Enterprise Vault filter that posted the Exchange message for detection. The classification tag always corresponds to the name of the policy that triggers the response rule action.

Symantec Enterprise Vault for Microsoft Exchange can then use the retention category and classification tag to perform archiving, delete messages, or flag the message for compliance reviews or E-Discovery searches.

See “About implementing detection for Enterprise Vault Classification” on page 620.

To configure the Classify Enterprise Vault Content response rule action

1 Configure a response rule at the Configure Response Rule screen (Manage > Response Rules).
   See “Configuring response rules” on page 891.

2 Add the Classification: Classify Enterprise Vault Content action type from the Actions list.
   See “Configuring response rule actions” on page 893.

3 Configure the parameters to classify the Enterprise Vault message.
   See Table 39-5 on page 915.

4 Click Save to save the configuration.
   See “Manage response rules” on page 889.

Table 39-5 Classification: Classify Enterprise Vault Content parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Archive and classify message</td>
<td>Select this option to indicate that Symantec Enterprise Vault should archive the message that matched the detection rule. If you select this option, also use the Assign retention category menu to specify the retention category that Enterprise Vault assigns.</td>
</tr>
</tbody>
</table>
### Table 39-5

Classification: Classify Enterprise Vault Content parameters *(continued)*

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign retention category</td>
<td>The <strong>Assign retention category</strong> menu lists all of the retention categories that you have configured for use with the Data Classification for Enterprise Vault solution. If you configure the response rule to archive a message, also select the appropriate retention category from this menu. You should configure the retention category names in this menu to match those categories that are available on Enterprise Vault servers. See “Configuring the retention categories that are available for classification” on page 917. If you select <strong>Do not override retention category</strong>, the Classification Server communicates to Enterprise Vault that no retention category has been assigned. Enterprise Vault uses the retention category that is already available with the message and applies it during the archiving process. When you configure a response rule, if you do not select the classification type of response rule, then Enterprise Vault cannot receive any response from the Symantec Enterprise Vault Data Classification Services. Enterprise Vault applies the retention category that is already available on the message. If the associated policy was running in test mode, the incident is created, but Enterprise Vault does not receive any response from the Classification Server. Not even test mode logs on Enterprise Vault are updated.</td>
</tr>
</tbody>
</table>
| Compliance review          | If you configure the response rule to archive the message, you can also select **Prioritize messages for compliance review** to prioritize the message for review. The Discovery Accelerator and Compliance Accelerator products can use this classification tag to filter messages during searches or audits. When you select this option, two additional choices are presented:  
- **Include in review**—Includes the message in subsequent searches and audits.  
- **Exclude from review**—Excludes the message from subsequent searches and audits. See the Discovery Accelerator and Compliance Accelerator documentation for more information about searching and auditing messages in Enterprise Vault. |
Table 39-5  Classification: Classify Enterprise Vault Content parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do not archive message</td>
<td>Choose this option to indicate that Symantec Enterprise Vault should not</td>
</tr>
<tr>
<td></td>
<td>archive the message that matched the detection rule.</td>
</tr>
<tr>
<td></td>
<td>When you select this option, the following choices are presented to specify</td>
</tr>
<tr>
<td></td>
<td>the way in which Enterprise Vault should discard the message:</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Delete message immediately and permanently</strong>—Enterprise Vault should</td>
</tr>
<tr>
<td></td>
<td>delete the message immediately.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Move message to Deleted Items folder</strong>—Enterprise Vault should move</td>
</tr>
<tr>
<td></td>
<td>the message to the Deleted Items folder. The message may be deleted</td>
</tr>
<tr>
<td></td>
<td>at a later time when the folder is emptied.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Leave message in mailbox</strong>—Enterprise Vault should leave the message</td>
</tr>
<tr>
<td></td>
<td>in the mailbox and mark it as “Do not archive.”</td>
</tr>
<tr>
<td></td>
<td>If you select this option but later decide to clear the “Do Not Archive”</td>
</tr>
<tr>
<td></td>
<td>property on messages, you can do so by setting the <strong>ClearDoNotArchive</strong></td>
</tr>
<tr>
<td></td>
<td>and <strong>ClearDoNotJournal</strong> registry values on the Enterprise Vault server.</td>
</tr>
<tr>
<td></td>
<td>See the <strong>EnterpriseVaultRegistryValues</strong> manual for instructions. These</td>
</tr>
<tr>
<td></td>
<td>values permit the Exchange mailbox and Exchange Journaling tasks to</td>
</tr>
<tr>
<td></td>
<td>archive the messages.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When you monitor a Journal mailbox, you may see messages marked</td>
</tr>
<tr>
<td></td>
<td>as “Do not archive” in the journal Inbox and in the Deleted items folder.</td>
</tr>
<tr>
<td></td>
<td>Messages that are marked as &quot;Do not archive&quot; are not automatically</td>
</tr>
<tr>
<td></td>
<td>re-located. You can manually move the messages into the deleted items</td>
</tr>
<tr>
<td></td>
<td>folder.</td>
</tr>
</tbody>
</table>

See “About response rule actions” on page 875.

See “Implementing response rules” on page 886.

Configuring the retention categories that are available for classification

The **Classification: Classify Enterprise Vault Content** response rule defines the classification result tags that a Classification Server generates for an Exchange message that matches a detection policy. If you configure this response rule to perform the **Archive and classify message** action, you also specify the retention category that Enterprise Vault should apply to the archived message. The list of available retention categories that is shown in the Enforce Server administration console is defined using a configuration file, **RetentionCategories.config**.

See “Configuring the Classify Enterprise Vault Content response action” on page 915.
When you first install the Data Classification Services solution, you must create a \texttt{RetentionCategories.config} file to include the retention categories that are available in Enterprise Vault servers. If you change the retention categories that are available in an Enterprise Vault deployment, you should also manually change the available categories that are defined in \texttt{RetentionCategories.config}.

\textbf{Note:} The \texttt{RetentionCategories.config} file supports UTF-8 character encoding without byte order markers (BOM).

To configure the retention categories that are available for classification

1. One each Enterprise Vault server, run the \texttt{ExportRetentionCategories.exe} command-line utility that is installed in the Enterprise Vault program folder. (To display usage instructions, execute the utility without supplying any command-line options). You must open the command-line utility from a user with administrator privileges.

2. Follow the on-screen instructions to generate a file that lists the retention categories available in the Enterprise Vault server. The following retention categories are always excluded from the file:
   - The retention categories for managed folders.
   - For English deployments, any retention category with the name \texttt{<Do not override retention category>} does not apply a new retention category. Instead, a retention category that is already available for the message is applied during the archiving process.

   Keep in mind that hidden retention categories are included in the resulting file.

3. Repeat steps 1 and 2 for each Enterprise Vault server in your deployment.

4. If you generated files for multiple Enterprise Vault servers, use a text editor to merge the contents of each file into a single file.

5. Rename the file that contains all retention categories to \texttt{RetentionCategories.config}.

6. Log on to the Enforce Server computer using Administrator or superuser privileges.
Copy the RetentionCategories.config file that you created to the config subdirectory of the Symantec Data Loss Prevention product installation directory. The default directory is `c:\SymantecDLP\Protect\config`.

Restart the Enforce Server to apply the changes.

See “Server controls” on page 178.

See the Symantec Data Loss Prevention Administration Guide for information about starting and stopping Symantec Data Loss Prevention services.

### Configuring the Endpoint: FlexResponse action

The Endpoint: FlexResponse response rule action lets you implement one or more custom responses you have developed using the FlexResponse API.

See “About Endpoint FlexResponse” on page 1512.

This response rule is available for Endpoint Discover.

**Note:** This feature is not yet available for agents running on Mac endpoints.

See “Response rules for endpoint detection” on page 877.

To configure the Endpoint: FlexResponse response rule action

1. Configure a response rule at the **Configure Response Rule** screen.
   
   See “Configuring response rules” on page 891.

2. Add the **Endpoint: FlexResponse** action type from the **Actions** list.
   
   See “Configuring response rule actions” on page 893.

3. Enter the FlexResponse plug-in **Name** and configure its **Parameters**.
   
   See Table 39-6 on page 919.

4. Click **Save** to save the configuration.
   
   See “Manage response rules” on page 889.

#### Table 39-6  Endpoint: FlexResponse response rule action parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FlexResponse Python Plugin</td>
<td>Enter the script module name with packages separated by a period (.)</td>
</tr>
<tr>
<td>Plugin parameters</td>
<td>Click <strong>Add Parameter</strong> to add one or more parameters to the script.</td>
</tr>
<tr>
<td></td>
<td>Enter the <strong>Key/Value</strong> pair for each parameter.</td>
</tr>
</tbody>
</table>
Table 39-6  
Endpoint: FlexResponse response rule action parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
</table>
| Credentials | You can add credentials for accessing the plugin.  
You can add and store credentials at the **System > Settings > Credentials** screen.  
See “About the credential store” on page 131. |

See “Implementing response rules” on page 886.

### Configuring the Endpoint Discover: Quarantine File action

The Endpoint Discover: Quarantine File response rule action removes a file containing sensitive information from a non-secure location and places it in a secure location.

See “About Endpoint Quarantine” on page 1388.

This response rule action is specific to Endpoint Discover incidents. This response rule is not applicable to two-tiered detection methods requiring a Data Profile.

See “Setting up and configuring Endpoint Discover” on page 1389.

If you use multiple endpoint response rules in a single policy, make sure that you understand the order of precedence for such rules.

See “About response rule action execution priority” on page 883.

**Note:** This feature is not available for agents running on Mac endpoints.

To configure the Endpoint Discover: Quarantine File response rule action

1. Configure a response rule at the **Configure Response Rule** screen.
   
   See “Configuring response rules” on page 891.

2. Add the **Endpoint Discover: Quarantine File** action type from the **Actions** list.
   
   See “Configuring response rule actions” on page 893.

3. Enter the **Quarantine Path** and the **Marker File** settings.
   
   See Table 39-7 on page 921.

4. Click **Save** to save the configuration.
   
   See “Manage response rules” on page 889.
### Table 39-7 Endpoint Discover: Quarantine File response rule action parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Quarantine Path</strong></td>
<td>Enter the path to the secured location where you want files to be placed. The secure location can either be on the local drive of the endpoint, or can be on a remote file share. EFS folders can also be used as the quarantine location.</td>
</tr>
<tr>
<td><strong>Access Mode</strong></td>
<td>If your secure location is on a remote file share, you must select how the Symantec DLP Agent accesses that file share.</td>
</tr>
<tr>
<td></td>
<td>Select one of the following credential access types:</td>
</tr>
<tr>
<td></td>
<td>- Anonymous Access</td>
</tr>
<tr>
<td></td>
<td>- Use Saved Credentials</td>
</tr>
<tr>
<td></td>
<td>In anonymous mode, the Symantec DLP Agent runs as LocalSystem user to move the confidential file. You can use anonymous mode to move files to a secure location on a local drive or to remote share if it allows anonymous access.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> EFS folders cannot accept anonymous users.</td>
</tr>
<tr>
<td></td>
<td>A specified credential lets the Symantec DLP Agent impersonate the specified user to access the secure location. The credentials must be in the following format:</td>
</tr>
<tr>
<td></td>
<td><em>domain\user</em></td>
</tr>
<tr>
<td></td>
<td>You must enter the specified credentials you want to use through the System Credentials page. See “Configuring endpoint credentials” on page 132.</td>
</tr>
<tr>
<td><strong>Marker File</strong></td>
<td>Select the <strong>Leave marker in place of the remediated file</strong> check box to create a placeholder file that replaces the confidential file.</td>
</tr>
<tr>
<td><strong>Marker Text</strong></td>
<td>Specify the text to appear in the marker file. If you selected the option to leave the marker file in place of the remediated file, you can use variables in the marker text.</td>
</tr>
<tr>
<td></td>
<td>To specify the marker text, select the variable from the <strong>Insert Variable</strong> list.</td>
</tr>
<tr>
<td></td>
<td>For example, for Marker Text you might enter:</td>
</tr>
<tr>
<td></td>
<td><strong>A message has violated the following rules in $POLICY$: $RULES</strong></td>
</tr>
<tr>
<td></td>
<td>Or, you might enter:</td>
</tr>
<tr>
<td></td>
<td><strong>$FILE_NAME$ has been moved to $QUARANTINE_PARENT_PATH$</strong></td>
</tr>
</tbody>
</table>

See “About response rule actions” on page 875.

See “Response rules for endpoint detection” on page 877.
Configuring the Endpoint Prevent: Block action

The Endpoint Prevent: Block response rule action blocks the movement of confidential data on the endpoint and optionally displays an on-screen notification to the endpoint user.

See “About response rule actions” on page 875.

This response rule action is specific to Endpoint Prevent incidents. This response rule is not applicable to two-tiered detection methods requiring a Data Profile.

See “Setting up and configuring Endpoint Discover” on page 1389.

If you combine multiple endpoint response rules in a single policy, make sure that you understand the order of precedence for such rules.

See “About response rule action execution priority” on page 883.

---

Note: The block action is not triggered for a copy of sensitive data to a local drive.

To configure the Endpoint Prevent: Block response rule action

1. Configure a response rule at the Configure Response Rule screen.
   See “Configuring response rules” on page 891.
2. Add the Endpoint Prevent: Block action type from the Actions list.
3. See “Configuring response rule actions” on page 893.
4. Enter the Endpoint Notification Content settings.
   See Table 39-8 on page 922.
5. Click Save to save the configuration.
   See “Manage response rules” on page 889.

---

Table 39-8  Endpoint Prevent: Block response rule action parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language</td>
<td>Select the language you want the response rule to execute on. Click Add Language to add more than one language.</td>
</tr>
<tr>
<td></td>
<td>See “About Endpoint Prevent response rules in different locales” on page 1380.</td>
</tr>
<tr>
<td></td>
<td>See “Setting Endpoint Prevent response rules for different locales” on page 1381.</td>
</tr>
</tbody>
</table>
### Table 39-8  Endpoint Prevent: Block response rule action parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Configuration</th>
</tr>
</thead>
</table>
| Display Alert Box with this message | This field is optional for Endpoint Block actions. Select an Endpoint Block action to display an on-screen notification to the endpoint user when the system blocks an attempt to copy confidential data. Enter the notification message in the text box. You can add variables to the message by selecting the appropriate value(s) from the Insert Variable box. Optionally, you can configure the on-screen notification to include user justifications as well as an option for users to enter their own justification. You can also add hyperlinks to refer users to URLs that contain company security information. To add hyperlinks you use standard HTML syntax, tags, and URLs. Tags are case-sensitive. You can include insert hyperlinked text between regular text. For example, you would enter: 

`The $CONTENT_TYPE$ "$CONTENT_NAME$" contains sensitive information. <a href="http://www.company.com">Click here for information</a>. Contact the <a href="mailto:admin@company.com">administrator</a> if you have questions.` |
| Insert Variable | Select the variables to include in the on-screen notification to the endpoint when the system blocks an attempt to copy confidential data. You can select variables based on the following types:  
- Application  
- Content Name  
- Content Type  
- Device Type  
- Policy Names  
- Protocol |
Configuring the Endpoint Prevent: Notify action

The Endpoint Prevent: Notify response rule action displays an on-screen notification to the endpoint user when the user attempts to copy or send a sensitive file. You

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Configuration</th>
</tr>
</thead>
</table>
| Allow user to choose explanation | Select this option to display up to four user justifications in the on-screen notification. When the notification appears on the endpoint, the user is required to choose one of the justifications. (If you select **Allow user to enter text explanation**, the user can enter a justification.) Symantec Data Loss Prevention provides four default justifications, which you can modify or remove as needed.  
Justification:  
■ User Education  
■ Broken Business Process  
■ Manager Approved  
■ False positive  
Each justification entry consists of the following options:  
■ **Check box**  
  This option indicates whether to include the associated justification in the notification. To remove a justification, clear the check box next to it. To include a justification, select the check box next to it.  
■ **Justification**  
  The system label for the justification. This value appears in reports (for ordering and filtering purposes), but the user does not see it. You can select the desired option from the drop-down list.  
■ **Option Presented to End User**  
  The justification text the system displays in the notification. This value appears in reports with the justification label. You can modify the default text as desired.  
To add a new justification, select **New Justification** from the drop-down list. In the **Enter new justification** text box that appears, enter the justification name. When you save the rule, Symantec Data Loss Prevention includes it as an option (in alphabetical order) in all **Justification** drop-down lists.  
**Note:** You should be selective when adding new justifications. Deleting new justifications is not currently supported. |
| Allow user to enter text explanation | Select this option to include a text box into which users can enter their own justification.                                                                                                                     |

See “Response rules for endpoint detection” on page 877.
can provide a reason for the notification as well as options for the endpoint user to give a justification for the action.

See “About response rule actions” on page 875.

This response rule action is available for Endpoint Prevent.

See “How to implement Endpoint Prevent” on page 1378.

Note: The notify action is not triggered for a copy of sensitive data to a local drive.

To configure the Endpoint Prevent: Notify action

1. Configure a response rule at the Configure Response Rule screen.
   
   See “Configuring response rules” on page 891.

   Add the Endpoint Prevent: Notify action type from the Actions list.
   
   See “Configuring response rule actions” on page 893.

2. Configure the action parameters.
   
   See Table 39-9 on page 925.

3. Click Save to save the configuration.
   
   See “Manage response rules” on page 889.

Table 39-9  Endpoint Prevent: Notify response rule action parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language</td>
<td>Select the language you want the response rule to execute on. Click Add Language to add more than one language. See “About Endpoint Prevent response rules in different locales” on page 1380. See “Setting Endpoint Prevent response rules for different locales” on page 1381.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Display Alert Box with this message</td>
<td>This field is required for Endpoint Notify actions. Select this option to display an on-screen notification to the endpoint user. Enter the notification message in the text box. You can add variables to the message by selecting the appropriate value(s) from the Insert Variable box. Optionally, you can configure the on-screen notification to include user justifications as well as the option for users to enter their own justifications. You can also add hyperlinks to refer users to URLs that contain company security information. To add hyperlinks you use standard HTML syntax, tags, and URLs. Tags are case-sensitive. You can include insert hyperlinked text between regular text. For example, you would enter: \texttt{The $CONTENT_TYPE$ &quot;$CONTENT_NAME$&quot; contains sensitive information. &lt;a href=&quot;http://www.company.com&quot;&gt;Click here for information&lt;/a&gt;. Contact the &lt;a href=&quot;mailto:admin@company.com&quot;&gt;administrator&lt;/a&gt; if you have questions.}</td>
</tr>
<tr>
<td>Insert Variable</td>
<td>Select the variables that you want to include in the on-screen notification to the endpoint user. You can select variables based on the following types: Application, Content Name, Content Type, Device Type, Policy Names, Protocol</td>
</tr>
</tbody>
</table>
Table 39-9  Endpoint Prevent: Notify response rule action parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
</table>
| Allow user to choose explanation | Select this option to display up to four user justifications in the on-screen notification. When the notification appears on the endpoint, the user is required to choose one of the justifications. (If you select **Allow user to enter text explanation**, the user can enter a justification.) Symantec Data Loss Prevention provides four default justifications, which you can modify or remove as needed. Available Justifications:  
  ■ Broken Business Process  
  ■ False positive  
  ■ Manager Approved  
  ■ User Education  
  ■ Custom (new justification)  
  Each justification entry consists of the following options:  
  ■ **Check box**  
    This option indicates whether to include the associated justification in the notification. To remove a justification, clear the check box next to it. To include a justification, select the check box next to it.  
  ■ **Justification**  
    The system label for the justification. This value appears in reports (for ordering and filtering purposes), but the user does not see it. You can select the desired option from the drop-down list.  
  ■ **Option Presented to End User**  
    The justification text Symantec Data Loss Prevention displays in the notification. This value appears in reports with the justification label. You can modify the default text as desired.  
To add a new justification, select **New Justification** from the appropriate drop-down list. In the **Enter new justification** text box that appears, type the justification name. When you save the rule, the system includes the new justification as an option (in alphabetical order) in all **Justification** drop-down lists.  
**Note**: You should be selective in adding new justifications. Deleting new justifications is not currently supported.  

<table>
<thead>
<tr>
<th>Allow user to enter text explanation</th>
<th>Select this option to include a text box into which users can enter their own justification.</th>
</tr>
</thead>
</table>

See “**Response rules for endpoint detection**” on page 877.
Configuring the Endpoint Prevent: User Cancel action

The Endpoint Prevent: User Cancel response rule action displays a time-sensitive notification to the user when a policy is violated.

See “About response rule actions” on page 875.

Users have a limited amount of time to decide to ignore the policy violation or not. If the violation is ignored, the data transfer completes and an incident is created. If the violation is not ignored, the data transfer is stopped and an incident is created. If the user does not make a decision in the allotted time, the data transfer is automatically blocked and an incident is created. You can provide a reason for the notification as well as options for the endpoint user to enter a justification for the action.

This response rule action is available for Endpoint Prevent.

See “How to implement Endpoint Prevent” on page 1378.

To configure the Endpoint Prevent: User Cancel action

1 Configure a response rule at the Configure Response Rule screen.
   See “Configuring response rules” on page 891.
   Add the Endpoint Prevent: User Cancel action type from the Actions list.
   See “Configuring response rule actions” on page 893.

2 Configure the Endpoint Prevent: User Cancel parameters.
   See Table 39-10 on page 928.

3 Click Save to save the configuration.
   See “Manage response rules” on page 889.

Table 39-10  Endpoint Prevent: User Cancel parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language</td>
<td>Select the language you want the response rule to execute on. Click <strong>Add Language</strong> to add more than one language.</td>
</tr>
<tr>
<td></td>
<td>See “About Endpoint Prevent response rules in different locales” on page 1380.</td>
</tr>
<tr>
<td></td>
<td>See “Setting Endpoint Prevent response rules for different locales” on page 1381.</td>
</tr>
<tr>
<td>Pre-timeout warning</td>
<td>This field is required to notify users that they have a limited amount of time to respond to the incident.</td>
</tr>
<tr>
<td></td>
<td>Enter the notification message in the text box. You can add variables to the message by selecting the appropriate value(s) from the <strong>Insert Variable</strong> box.</td>
</tr>
</tbody>
</table>
Table 39-10  Endpoint Prevent: User Cancel parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Post-timeout message</td>
<td>This field notifies users that the amount of time to override the policy has expired. The data transfer was blocked.</td>
</tr>
<tr>
<td></td>
<td>Enter the notification message in the text box. You can add variables to the message by selecting the appropriate value(s) from the Insert Variable box.</td>
</tr>
<tr>
<td>Display Alert Box with this message</td>
<td>This field is required for Endpoint User Cancel actions. Select this option to display an on-screen notification to the endpoint user.</td>
</tr>
<tr>
<td></td>
<td>Enter the notification message in the text box. You can add variables to the message by selecting the appropriate value(s) from the Insert Variable box.</td>
</tr>
<tr>
<td></td>
<td>Optionally, you can configure the on-screen notification to include user justifications as well as the option for users to enter their own justifications.</td>
</tr>
<tr>
<td></td>
<td>You can also add hyperlinks to refer users to URLs that contain company security information. To add hyperlinks you use standard HTML syntax, tags, and URLs. Tags are case-sensitive. You can include insert hyperlinked text between regular text. For example, you would enter:</td>
</tr>
<tr>
<td></td>
<td>The $CONTENT_TYPE$ &quot;$CONTENT_NAME&quot; contains sensitive information. &lt;a href=&quot;http://www.company.com&quot;&gt;Click here for information&lt;/a&gt;. Contact the &lt;a href=&quot;mailto:admin@company.com&quot;&gt;administrator&lt;/a&gt; if you have questions.</td>
</tr>
<tr>
<td>Insert Variable</td>
<td>Select the variables that you want to include in the on-screen notification to the endpoint user.</td>
</tr>
<tr>
<td></td>
<td>You can select variables based on the following types:</td>
</tr>
<tr>
<td></td>
<td>■ Application</td>
</tr>
<tr>
<td></td>
<td>■ Content Name</td>
</tr>
<tr>
<td></td>
<td>■ Content Type</td>
</tr>
<tr>
<td></td>
<td>■ Device Type</td>
</tr>
<tr>
<td></td>
<td>■ Policy Name</td>
</tr>
<tr>
<td></td>
<td>■ Protocol</td>
</tr>
<tr>
<td></td>
<td>■ Timeout Counter</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You must use the Timeout Counter variable to display how much time remains before blocking the data transfer.</td>
</tr>
</tbody>
</table>
Table 39-10  Endpoint Prevent: User Cancel parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow user to choose explanation.</td>
<td>Select this option to display up to four user justifications in the on-screen notification. When the notification appears on the endpoint, the user is required to choose one of the justifications. (If you select <em>Allow user to enter text explanation</em>, the user can enter a justification.) Symantec Data Loss Prevention provides four default justifications, which you can modify or remove as needed. Available Justifications:  ■ Broken Business Process  ■ False positive  ■ Manager Approved  ■ User Education  ■ Custom (new justification) Each justification entry consists of the following options:  ■ <strong>Check box</strong>  This option indicates whether to include the associated justification in the notification. To remove a justification, clear the check box next to it. To include a justification, select the check box next to it.  ■ <strong>Justification</strong>  The system label for the justification. This value appears in reports (for ordering and filtering purposes), but the user does not see it. You can select the desired option from the drop-down list.  ■ <strong>Option Presented to End User</strong>  The justification text Symantec Data Loss Prevention displays in the notification. This value appears in reports with the justification label. You can modify the default text as desired. To add a new justification, select <em>New Justification</em> from the appropriate drop-down list. In the <em>Enter new justification</em> text box that appears, type the justification name. When you save the rule, the system includes the new justification as an option (in alphabetical order) in all <em>Justification</em> drop-down lists.  <strong>Note:</strong> You should be selective in adding new justifications. Deleting new justifications is not currently supported.</td>
</tr>
<tr>
<td>Allow user to enter text explanation.</td>
<td>Select this option to include a text box into which users can enter their own justification.</td>
</tr>
</tbody>
</table>

See “Implementing response rules” on page 886.
Configuring the Network and Mobile Prevent for Web: Block FTP Request action

The Network and Mobile Prevent for Web: Block FTP Request response rule action blocks any file transfer by FTP on your network or mobile device.

See “About response rule actions” on page 875.

This response rule is available only for Network Prevent for Web integrated with a proxy server or Mobile Prevent for Web integrated with both a VPN server and a proxy server.

See “Configuring Network Prevent for Web Server” on page 1167.

See “Implementing Mobile Prevent for Web” on page 1542.

To configure the Network and Mobile Prevent for Web: Block FTP Request response rule action

1 Configure a response rule at the Configure Response Rule screen.
   See “Configuring response rules” on page 891.

2 Add the Network and Mobile Prevent for Web: Block FTP Request action type from the Actions list.

   The Block FTP Request response rule action does not require any further configuration. Once the response rule is deployed to a policy, this action blocks any FTP attempt.

   See “Configuring response rule actions” on page 893.

3 Click Save to save the configuration.

   See “Manage response rules” on page 889.

   See “Implementing response rules” on page 886.

Configuring the Network and Mobile Prevent for Web: Block HTTP/S action

The Network and Mobile Prevent for Web: Block HTTP/S response rule action blocks the transmission of Web content that Network Prevent for Web or Mobile Prevent for Web detects. This action also blocks Web-based email messages and attachments.

See “About response rule actions” on page 875.

This response rule action blocks the transmission of Web content using the Internet Content Adaptation Protocol (ICAP). To implement this response rule action you
must integrate the detection server with a Web proxy server. For Mobile Prevent for Web, you must also integrate with a VPN server.

See “Configuring Network Prevent for Web Server” on page 1167.

See "Implementing Mobile Prevent for Web” on page 1542.

To configure the Network Prevent: Block HTTP/S response rule action

1. Integrate Network Prevent for Web or Mobile Prevent for Web with a proxy server and, if necessary, a VPN server.
   
   See “Network Prevent for Web Server—basic configuration” on page 187.

2. Configure a response rule at the **Configure Response Rule** screen.
   
   See “Configuring response rules” on page 891.

3. Add the **Network and Mobile Prevent for Web: Block HTTP/S** action type from the **Actions** list.
   
   See “Configuring response rule actions” on page 893.

4. Edit the **Rejection Message**, as necessary.
   
   The system presents this message to the user's browser when the action blocks content.

   For example, you might include some HTML-coded text to display in a browser.

   **Note:** If the requesting client does not expect an HTML response, the Rejection Message may not be displayed in the client browser. For example, a client expecting an XML response to a Web post may only indicate a Javascript error.

5. Click **Save** to save the configuration of the response rule.

Certain applications may not provide an adequate response to the Network and Mobile Prevent for Web: Block HTTP/S response action. This behavior has been observed with the Yahoo! Mail application when a detection server blocks a file upload. If a user tries to upload an email attachment and the attachment triggers a Network and Mobile Prevent for Web: Block HTTP/S response action, Yahoo! Mail does not respond or display an error message to indicate that the file is blocked. Instead, Yahoo! Mail appears to continue uploading the selected file, but the upload never completes. The user must manually cancel the upload at some point by pressing **Cancel**.

Other applications may also exhibit this behavior, depending on how they handle the block request. In these cases a detection server incident is created and the file upload is blocked even though the application provides no such indication.
See “Implementing response rules” on page 886.

Configuring the Network Prevent: Block SMTP Message action

The Network Prevent: Block SMTP Message response rule action blocks SMTP email messages that cause an incident on the Network Prevent (Email) detection server.

See “About response rule actions” on page 875.

This response rule action is only available with Network Prevent for Email.

See “Response rules for Network and Mobile Prevent for Web detection” on page 878.

You must integrate the Network Prevent for Email detection server with a Mail Transfer Agent (MTA) to implement this response rule action. Refer to the Symantec Data Loss Prevention MTA Integration Guide for Network Prevent (Email) for details.

To configure the Block SMTP Message response rule action

1 Configure a response rule at the Configure Response Rule screen.
   See “Configuring response rules” on page 891.

2 Add the Network Prevent: Block SMTP Message action type from the Actions list.
   See “Configuring response rule actions” on page 893.

3 Configure the Block SMTP Message action parameters.
   See Table 39-11 on page 933.

4 Click Save to save the response rule.
   See “Manage response rules” on page 889.

Table 39-11 Network Prevent: Block SMTP Message parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bounce Message to Sender</td>
<td>Enter the text that you want to appear in the SMTP error that Network Prevent (Email) returns to the MTA. Some MTAs display this text in the message that is bounced to the sender.</td>
</tr>
<tr>
<td></td>
<td>If you leave this field blank, the message does not bounce to the sender but the MTA sends its own message.</td>
</tr>
</tbody>
</table>
Table 39-11  Network Prevent: Block SMTP Message parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Redirect Message to this Address</td>
<td>If you want to redirect blocked messages to a particular address (such as the Symantec Data Loss Prevention administrator), enter that address in this field. If you leave this field blank, the bounced message goes to the sender only.</td>
</tr>
</tbody>
</table>

See “Implementing response rules” on page 886.

Configuring the Network Prevent: Modify SMTP Message action

The Network Prevent: Modify SMTP Message response rule action lets you modify a sensitive email. For example, you can use this action to change an email subject header to include information about the policy violation type.

See “About response rule actions” on page 875.

This response rule action is only available for Network Prevent for Email.

See “Response rules for Network and Mobile Prevent for Web detection” on page 878.

To configure the Network Prevent: Modify SMTP Message action

1. Configure a response rule at the Configure Response Rule screen.
   See “Configuring response rules” on page 891.

2. Add the Network Prevent: Modify SMTP Message action type from the Actions list.
   See “Configuring response rule actions” on page 893.

3. Configure the action parameters.
   See Table 39-12 on page 935.

4. Click Save to save the configuration.
   See “Manage response rules” on page 889.
Table 39-12  Network Prevent: Modify SMTP Message parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject</td>
<td>Select the type of modification to make to the subject of the message from the following options:</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Do not Modify</strong> – No text is changed in the subject.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Prepend</strong> – New text is added to the beginning of the subject.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Append</strong> – New text is added to the end of the subject.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Replace With</strong> – New text completely replaces the old subject text.</td>
</tr>
<tr>
<td></td>
<td>If the subject text is currently modified, specify the new text.</td>
</tr>
<tr>
<td></td>
<td>For example, if you want to prepend &quot;VIOLATION&quot; to the subject of the message, select <strong>Prepend</strong> and enter <strong>VIOLATION</strong> in the text field.</td>
</tr>
<tr>
<td>Headers</td>
<td>Enter a unique name and a value for each header you want to add to the message (up to three).</td>
</tr>
<tr>
<td>Enable Email Quarantine Connect (Requires Symantec Messaging Gateway)</td>
<td>Select this option to enable integration with Symantec Messaging Gateway. When this option is enabled, Symantec Data Loss Prevention adds preconfigured x-headers to the message that inform Symantec Messaging Gateway that the message should be quarantined. For more information, see the <em>Symantec Data Loss Prevention Email Quarantine Connect FlexResponse Implementation Guide</em>.</td>
</tr>
</tbody>
</table>

See "Implementing response rules" on page 886.

### Configuring the Network and Mobile Prevent for Web: Remove HTTP/S Content action

The Network and Mobile Prevent for Web: Remove HTTP/S Content response action removes confidential data that is posted to Web mail sites (such as Gmail), blogs (such as Blogspot), and other sites. This action also removes confidential data that is included in any files that users upload to Web sites or attach to Web mail. This action only applies to HTTP/S POST commands; it does not apply to GET commands.

See “About response rule actions” on page 875.

This response rule action is only available for Network Prevent for Web and Mobile Prevent for Web.

See “Response rules for Network and Mobile Prevent for Web detection” on page 878.

Symantec Data Loss Prevention recognizes Web form fields for selected Web mail, blog, and social networking sites. If Network Prevent for Web or Mobile Prevent for
Web cannot remove confidential data for a Web site it recognizes, it creates a system event and performs a configured fallback option.

**Note:** Symantec Data Loss Prevention removes content for file uploads and, for Network Prevent, Web mail attachments even for those sites that it does not recognize for HTTP content removal.

To configure the Network and Mobile Prevent for Web: Remove HTTP/S Content action

1. Configure a response rule at the **Configure Response Rule** screen.
   
   See “Configuring response rules” on page 891.

2. Add the **Network and Mobile Prevent for Web: Remove HTTP/S Content** action type from the **Actions** list.
   
   See “Configuring response rule actions” on page 893.

3. Configure the action parameters.
   
   See Table 39-13 on page 936.

4. Click **Save** to save the configuration.
   
   See “Manage response rules” on page 889.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Removal Message</strong></td>
<td>The message that appears in content (Web postings, Web mail, or files) from which the system has removed confidential information. Only the recipient sees this message.</td>
</tr>
<tr>
<td><strong>Fallback option</strong></td>
<td>The action to take if Network Prevent for Web or Mobile Prevent for Web cannot remove confidential information that was detected in an HTTP or HTTPS post. The available options are <strong>Block</strong> (the default) and <strong>Allow</strong>.</td>
</tr>
</tbody>
</table>

**Note:** Symantec Data Loss Prevention removes confidential data in file uploads and, for Network Prevent, Web mail attachments, even for sites in which it does not perform content removal. The **Fallback option** is taken only in cases where Symantec Data Loss Prevention detects confidential content in a recognized Web form, but it cannot remove the content.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Rejection Message</strong></td>
<td>The message that Network Prevent or Mobile Prevent returns to a client when it blocks an HTTP or HTTPS post. The client Web application may or may not display the rejection message, depending on how the application handles error messages.</td>
</tr>
</tbody>
</table>

See “Implementing response rules” on page 886.
Configuring the Network Protect: Copy File action

The Network Protect: Copy File response rule action copies a sensitive file to the local file system.

See “About response rule actions” on page 875.

This response rule action is only available for Network Discover that is configured for Network Protect.

See “Response rules for Network and Mobile Prevent for Web detection” on page 878.

To configure the Network Protect: Copy File response rule action

1. Configure a network file share and specify a location to copy files to.
   
   See “Configuring Network Protect for file shares” on page 1258.

2. Configure a response rule at the Configure Response Rule screen.
   
   See “Configuring response rules” on page 891.

3. Select the Network Protect: Copy File action type from the Actions list.
   
   This action does not require you to configure any parameters.
   
   See “Configuring response rule actions” on page 893.

4. Click Save to save the configuration.

   See “Manage response rules” on page 889.

See “Implementing response rules” on page 886.

Configuring the Network Protect: Quarantine File action

The Network Protect: Quarantine File response rule action quarantines a file that the detection server identifies as sensitive or protected.

See “About response rule actions” on page 875.

This response rule action is only available for Network Discover that is configured for Network Protect.

See “Response rules for Network and Mobile Prevent for Web detection” on page 878.
To configure the Network Protect: Quarantine File response rule action

1. Configure a response rule at the Configure Response Rule screen
   See “Configuring response rules” on page 891.

2. Add the Network Protect: Quarantine File action type from the Actions list.
   See “Configuring response rule actions” on page 893.

3. Configure the Network Protect: Quarantine File parameters.
   See Table 39-14 on page 938.

4. Click Save to save the configuration.
   See “Manage response rules” on page 889.

Table 39-14  Network Protect: Quarantine File configuration parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
</table>
| Marker File       | Select this option to create a marker text file to replace the original file. This action notifies the user what happened to the file instead of quarantining or deleting the file without any explanation.  
                     Note: The marker file is the same type and has the same name as the original file, as long as it is a text file. An example of such a file type is Microsoft Word. If the original file is a PDF or image file, the system creates a plain text marker file. The system then gives the file the same name as the original file with .txt appended to the end. For example, if the original file name is accounts.pdf, the marker file name is accounts.pdf.txt. |
| Marker Text       | Specify the text to appear in the marker file. If you selected the option to leave the marker file in place of the remediated file, you can use variables in the marker text.  
                     To specify marker text, select the variable from the Insert Variable list.  
                     For example, for Marker Text you might enter:  
                     A message has violated the following rules in $POLICY$: $RULES  
                     Or, you might enter:  
                     $FILE_NAME$ has been moved to $QUARANTINE_PARENT_PATH$ |

See “Implementing response rules” on page 886.
Remediating and managing incidents

- Chapter 40. Remediating incidents
- Chapter 41. Remediating Network incidents
- Chapter 42. Remediating Endpoint incidents
- Chapter 43. Remediating Mobile incidents
- Chapter 44. Remediating Discover incidents
- Chapter 45. Working with Classification incidents
- Chapter 46. Managing and reporting incidents
- Chapter 47. Archiving incidents
- Chapter 48. Working with incident data
- Chapter 49. Working with user risk
- Chapter 50. Implementing lookup plug-ins
Remediating incidents

This chapter includes the following topics:

■ About incident remediation
■ Remediating incidents
■ Executing Smart response rules
■ Incident remediation action commands
■ Response action variables
■ Monitor and Prevent incident variables
■ Mobile incident variables
■ Discover incident variables

About incident remediation

As incidents occur in your system, individuals in your organization must analyze the incidents, determine why they occurred, identify trends, and remediate the problems.

Symantec Data Loss Prevention provides a rich set of capabilities which can be used to build an effective incident remediation process. Once you are ready to take action, you can use a series of incident commands on the Incident Snapshot and Incident List pages.

Since the Incident Snapshot page displays details about one specific incident, you can select a command to perform an action on the displayed incident.

On the Incident List page, you can perform an action on multiple incidents at one time. You can select more than one incident from the list and then choose the desired command.
Table 40-1 describes the options that are involved in incident remediation:

<table>
<thead>
<tr>
<th>Remediation options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Role-based access control</td>
<td>Access to incident information in the Symantec Data Loss Prevention system can be tightly controlled with role-based access control. Roles control which incidents a particular remediator can take action on, as well as what information within that incident is available to the remediator. For example, access control can be used to ensure that a given remediator can act only on incidents originating within a particular business unit. In addition, it might prevent that business unit's staff from ever seeing high-severity incidents, instead routing those incidents to the security department. See “About role-based access control” on page 84.</td>
</tr>
<tr>
<td>Severity level assignment</td>
<td>Incident severity is a measure of the risk that is associated with a particular incident. For example, an email message containing 50 customer records can be considered more severe than a message containing 50 violations of an acceptable use policy. Symantec Data Loss Prevention lets you specify what constitutes a severe incident by configuring it at the policy rule level. Symantec Data Loss Prevention then uses the severity of the incident to drive subsequent responses to the incident. This process lets you prioritize incidents and devote your manual remediation resources to the areas where they are needed most.</td>
</tr>
<tr>
<td>Custom attribute lookup</td>
<td>Custom attribute lookup is the process of collecting additional information about the incident from data sources outside of Enforce and the incident itself. For example, a corporate LDAP server can be queried for additional information about the message sender, such as the sender's manager name or business unit. See &quot;About using custom attributes&quot; on page 1078. For example, you can use custom attributes as input to subsequent automated responses to automatically notify the sender's manager about the policy violation. See “Setting the values of custom attributes manually” on page 1080.</td>
</tr>
</tbody>
</table>
### Table 40-1  Options involved in incident remediation (continued)

<table>
<thead>
<tr>
<th>Remediation options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automated incident responses</td>
<td>A powerful feature of the Enforce Server is the ability to automatically respond to incidents as they arise. For example, you can configure the system to respond to a serious incident by blocking the offending communication. You can send an email message to the sender's manager. You can send an alert to a security event management system. You can escalate the incident to the security department. On the other hand, an acceptable use incident might be dispensed with by sending an email message to the sender. Then you can mark the incident as closed, requiring no further work. Between these extremes, you can establish a policy that automatically encrypts transmissions of confidential data to a business partner. All of these scenarios can be handled automatically without user intervention. See “Configuring response rule actions” on page 893.</td>
</tr>
</tbody>
</table>
| **Smart Response**                   | Although the automated response is an important part of the remediation process, **SmartResponse** is necessary at times, particularly in the case of more serious incidents. Symantec Data Loss Prevention provides a detailed Incident Snapshot with all of the information necessary to determine the next steps in remediation. You can use **SmartResponse** to manually update incident severity, status, and custom attributes, add comments to the incident. You can move the incident through the remediation workflow to resolve it. See “Configuring response rule actions” on page 893. The following standard **SmartResponse** actions are available:  
  - Add Note  
  - Log to a Syslog Server  
  - Send Email Notification  
  - Set Status  
  See “Configuring the Server FlexResponse action” on page 912. |
| Distribution of aggregated incident reports | You can create and automatically distribute aggregated incident reports to data owners for remediation. |

The Enforce Server handles all of these steps, except for Smart Response. You can handle incidents in an entirely automated way. You can reserve manual intervention (Smart Response) for only the most serious incidents.
Remediating incidents

When you remediate an incident, you can perform the following actions:

■ Set the incident’s status or severity.
■ Apply a Smart Response rule to the incident.
■ Set the incident’s custom attributes.
■ Add comments to the incident record.
■ Remediate incidents by going to an incident list or incident snapshot and selecting actions to perform on one or more incidents.
■ Perform some combination of these actions.

You can import a solution pack during installation. Solution packs prepopulate incident lists and incident snapshots with several remediation options and custom attributes. For complete descriptions of all solution packs (including information about all remediation options and custom attributes they contain), refer to the documentation for each of the solution packs in the solutions packs directory in the documentation.

To remediate incidents

1 Access an incident list or incident snapshot.

   In incident lists, Symantec Data Loss Prevention displays available remediation options in the Incident Actions drop-down menu. The menu becomes active when you select one or more incidents in the list (with the check box). In incident snapshots, Symantec Data Loss Prevention also displays the available remediation options. You can set a Status or Severity from the drop-down menus.

   See “Viewing incidents” on page 1018.

   You can also edit the Attributes and provide related information.

2 Take either of the following actions:

   ■ When you view an incident list, select the incident(s) to be remediated (check the box). You can select incidents individually or select all incidents on the current screen. Then select the wanted action from the Incidents Actions drop-down menu. For example, select Incident Actions > Set Status > Escalated.
You can perform as many actions as needed.

- When you view an incident snapshot, you can set the **Status** and **Severity** from the drop-down menus.

If a Smart Response has been previously set up, you can select a Smart Response rule in the remediation bar.

See “About response rules” on page 875.

For example, if one of the Solution Packs was installed, you can select **Dismiss False Positive** in the remediation bar. When the **Execute Response Rule** screen appears, click **OK**. This Smart Response rule changes the incident status from **New** to **Dismissed** and sets the **Dismissal Reason** attribute to **False Positive**.

You can perform as many remediation actions as needed.

## Executing Smart response rules

When you execute a response rule that sends an email, you can manually compose the contents of the email notification.

**Note:** Sending an email notification to the sender applies to SMTP incidents only. Also, the notification addressees that are based on custom attributes (such as "manager email") work correctly only if populated by the attribute lookup plug-in.

To compose an email notification response

1. Enter optional emails for copies in the **CC** field.
2. Select the language.
3. Compose or edit the subject and body of the email.
4. Insert variables for the fields in the incident. The supported variables appear as links to the right of the editable fields.
   
   For example, if you want to include the policy and rules violated, you might enter:
   
   A message has violated the following rules in $POLICY$:
   $RULES$

5. Click **OK** to send the notification.

See “Adding a new response rule” on page 890.

See “About incident remediation” on page 940.

See “Response action variables” on page 946.
Incident remediation action commands

In an incident list, use the Incident Actions drop-down to select remediation actions. The following incident actions are available for an incident list:

Add Note
- Add a brief note to the selected incident(s). The comment appears on the Incident History tab of the Incident Snapshot page for each selected incident.

Archive
- Select one of the following archive actions to set the archive state for the selected incidents:
  - Archive Incidents—Flags the selected incidents as archived.
  - Restore Incidents—Restores the selected incidents to the non-archived state.
  - Do Not Archive—Prevents the selected incidents from being archived.
  - Allow Archive—Allows the selected incidents to be archived.

See “About incident archiving” on page 1065.

Delete Incidents
- Delete the selected incident(s) from the Symantec Data Loss Prevention system.

Proceed cautiously when deleting incidents. All data that is associated with the incident(s) is removed. This operation cannot be reversed.

Export Selected: CSV
- Export the selected incident(s) to a comma-separated (.csv) file.

Export Selected: XML
- Export the selected incident(s) to an XML file.

Lookup Attributes
- Use the configured lookup plug-ins to look up the configured attributes.

Set Attributes
- Display the Set Attributes page so you can enter or edit the attribute values for the selected incident(s).

Set Data Owner
- Set the following Data Owner attributes:
  - Name
  - Email Address

Set Severity
- Change the severity that is set for the selected incident(s) to one of the options under Set Severity.
Set Status

Change the status of the selected incident(s) to one of the options under Set Status. A system administrator can customize the options that appear on this list on the Incident Attributes page.

See “About incident status attributes” on page 1069.

Run Smart Response

Perform one of the listed responses on the selected incident(s). When you click a response rule, the Execute Response Rule page appears.

These manual response rules are available only if you have permission to remediate.

See “About incident remediation” on page 940.

Response action variables

Response action variables can be used in response rules.

See “Executing Smart response rules” on page 944.

The response action variables are different for Network Monitor and Network Prevent incidents than for Network Discover and Network Protect incidents.

See “Monitor and Prevent incident variables” on page 946.

See “Mobile incident variables” on page 947.

See “Discover incident variables” on page 948.

Monitor and Prevent incident variables

The following Network Monitor and Network Prevent variables are available:

$BLOCKED$

Indication of whether or not Symantec Data Loss Prevention blocked the message (yes or no).

$DATAOWNER_NAME$

The person responsible for remediating the incident. This field must be set manually, or with one of the lookup plug-ins.

Reports can automatically be sent to the data owner for remediation.

$DATAOWNER_EMAIL$

The email address of the person responsible for remediating the incident. This field must be set manually, or with one of the lookup plug-ins.
<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$INCIDENT_ID$</td>
<td>The ID of the incident.</td>
</tr>
<tr>
<td>$INCIDENT_SNAPSHOTS$</td>
<td>The fully qualified URL to the incident snapshot page for the incident.</td>
</tr>
<tr>
<td>$MATCH_COUNT$</td>
<td>The incident match count.</td>
</tr>
<tr>
<td>$POLICY_NAMES$</td>
<td>The name of the policy that was violated.</td>
</tr>
<tr>
<td>$POLICY_RULES$</td>
<td>A comma-separated list of one or more policy rules that were violated.</td>
</tr>
<tr>
<td>$RECIPIENTS$</td>
<td>A comma-separated list of one or more message recipients.</td>
</tr>
<tr>
<td>$SENDER$</td>
<td>The message sender.</td>
</tr>
<tr>
<td>$SEVERITY$</td>
<td>The severity that is assigned to incident.</td>
</tr>
<tr>
<td>$SUBJECT$</td>
<td>The subject of the message.</td>
</tr>
</tbody>
</table>

### Mobile incident variables

The following Mobile Prevent for Web variables are available:

- **$BLOCKED$**: Indication of whether or not Symantec Data Loss Prevention blocked the message (yes or no).
- **$DATAOWNER_NAME$**: The person responsible for remediating the incident. This field must be set manually, or with one of the lookup plug-ins. Reports can automatically be sent to the data owner for remediation.
- **$DATAOWNER_EMAIL$**: The email address of the person responsible for remediating the incident. This field must be set manually, or with one of the lookup plug-ins.
- **$DEVICE_INSTANCE_ID$**: The specific ID of the mobile device that generated the violation.
- **$ENDPOINT_MACHINE$**: The name of the endpoint machine that generated the violation.
- **$FILE_FULL_PATH$**: The full path to the file in which the incident was found.
- **$FILE_NAME$**: The name of the file in which the incident was found.
- **$FILE_PARENT_DIRECTORY_PATH$**: The path to the parent directory of the file in which the incident was found.
- **$INCIDENT_SNAPSHOTS$**: The ID of the incident.
- **$INCIDENT_SNAPSHOTS$**: The fully qualified URL to the incident snapshot page for the incident.
Discover incident variables

The following Network Discover and Network Protect incident variables are available:

$DATAOWNER_NAME$

The person responsible for remediating the incident. This field must be set manually, or with one of the lookup plug-ins.

Reports can automatically be sent to the data owner for remediation.

$DATAOWNER_EMAIL$

The email address of the person responsible for remediating the incident. This field must be set manually, or with one of the lookup plug-ins.

$FILE_NAME$

The name of the file in which the incident was found.

$INCIDENT_ID$

The ID of the incident.

$MATCH_COUNT$

The incident match count.

$FILE_PARENT_DIRECTORY_PATH$

The path to the parent directory of the file in which the incident was found.

$FILE_FULL_PATH$

The full path to the file in which the incident was found.

$POLICY_NAME$

The name of the policy that was violated.

$POLICY_RULES$

A comma-separated list of one or more policy rules that were violated.

$SEVERITY$

The severity that is assigned to incident.

$SUBJECT$

The subject of the message.

$TARGET$

The name of the target in which the incident was found.

$QUARANTINE_PARENT_DIRECTORY_PATH$

The path to the parent directory in which the file was quarantined.
<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$SCAN_DATE$</td>
<td>The date of the scan that found the incident.</td>
</tr>
<tr>
<td>$SEVERITY$</td>
<td>The severity that is assigned to incident.</td>
</tr>
<tr>
<td>$TARGET$</td>
<td>The name of the target in which the incident was found.</td>
</tr>
</tbody>
</table>
Remediating Network incidents

This chapter includes the following topics:

- Network incident list
- Network incident list—Actions
- Network incident list—Columns
- Network incident snapshot
- Network incident snapshot—Heading and navigation
- Network incident snapshot—General information
- Network incident snapshot—Matches
- Network incident snapshot—Attributes
- Network summary report

Network incident list

A network incident list shows multiple network incident records with information about the incident such as: the severity, associated policy, number of matches, and status of the incident. Click a row of the incident list to view more details about a specific incident. Select specific incidents (or groups of incidents) to modify or remediate by clicking the check boxes at the left.

When IPv6 addresses appear in reports, they follow these rules:

- Addresses are normalized in the Source IP and Destination IP fields.
In the **Recipient** (URL) fields, addresses are represented as they have been provided, which is usually a hostname and varies by protocol.

- In the **Sender** fields, representation of addresses varies by protocol.
- Normalized fields are used for IP-based filtering.

When IPv6 addresses appear in incident list filters, they follow these rules:

- Addresses are normalized in the **Source IP** and **Destination IP** fields.
- In the **Recipient** (URL) field, addresses are represented as they have been provided in the **Recipient** (URL), **Domain**, and **Sender** fields.
- Normalized fields are used for IP-based filtering.

When IPv6 addresses appear in incident details, they follow these rules:

- Addresses are normalized in the **Source IP** and **Destination IP** fields.
- In the **Recipient** (URL) field, addresses are represented as they have been provided.
- In the **Sender** field, addresses are represented as they have been provided.
- Links to filtered lists behave like user input.

You can view normalized IPv6 addresses in an incident summary:

- Addresses are summarized by the **Source IP**, **Destination IP**, **Sender**, and **Domain** fields.
- Normalization occurs for fields as it does in the incident details.

You can view non-normalized IPv6 addresses in an incident summary:

- Addresses are summarized by the **Source IP**, **Destination IP**, **Sender**, and **Domain** fields.
- Normalization occurs for fields as it does in the incident details.

---

**Note:** Use caution when you click **Select All**. This action selects all incidents in the report (not only those on the current page). Any incident command you subsequently apply affects all incidents. To select only the incidents on the current page, select the checkbox at top left of the incident list.

Incident information is divided into several columns. Click any column header to sort alpha-numerically by that column's data. To sort in reverse order, click the column header a second time. By default, Symantec Data Loss Prevention sorts incidents by date.
The **Type** column shows the icons that indicate the type of network incident. **Table 41-1** describes the icons.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="#" alt="Icon SMTP" /></td>
<td>SMTP&lt;br&gt;The addition of the second icon indicates a message attachment.</td>
</tr>
<tr>
<td><img src="#" alt="Icon HTTP" /></td>
<td>HTTP&lt;br&gt;Symantec Data Loss Prevention also detects the Yahoo and MSN IM traffic that is tunneled through HTTP.&lt;br&gt;The addition of the second icon indicates an attachment to Web-based email.</td>
</tr>
<tr>
<td><img src="#" alt="Icon HTTPS" /></td>
<td>HTTPS</td>
</tr>
<tr>
<td><img src="#" alt="Icon FTP" /></td>
<td>FTP</td>
</tr>
<tr>
<td><img src="#" alt="Icon NNTP" /></td>
<td>NNTP</td>
</tr>
<tr>
<td><img src="#" alt="Icon IM:MSN" /></td>
<td>IM:MSN</td>
</tr>
<tr>
<td><img src="#" alt="Icon IM:Aim" /></td>
<td>IM:AIM</td>
</tr>
<tr>
<td><img src="#" alt="Icon IM:Yahoo" /></td>
<td>IM:Yahoo</td>
</tr>
<tr>
<td><img src="#" alt="Icon TCP:custom_protocol" /></td>
<td>TCP:custom_protocol</td>
</tr>
</tbody>
</table>

This column also indicates whether the communication was blocked or altered. **Table 41-2** shows the possible values.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No icon.</td>
<td>Blank if the communication was <strong>not</strong> blocked.</td>
</tr>
</tbody>
</table>
Table 41-2 Incident block or altered status *(continued)*

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>Indicates Symantec Data Loss Prevention blocked the communication containing the matched text.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Indicates Symantec Data Loss Prevention removed confidential data from Web postings or Web-based email messages. This icon can also indicate that a file was uploaded to a Web site or attached to a Web-based email message.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Indicates that Symantec Data Loss Prevention added or modified the headers on the message that generated the incident.</td>
</tr>
</tbody>
</table>

Use the following links to learn more about the Network incident list page:

**To learn more about**

| Columns of the incident list table | See “Network incident list—Columns” on page 955. |
| Actions to perform on selected incidents | See “Network incident list—Actions” on page 953. |
| Details of a specific incident | See “Network incident snapshot” on page 956. |
| Viewing a summary of all network incidents | See “Network summary report” on page 961. |
| Common features of all Symantec Data Loss Prevention reports | See “About incident reports” on page 1009. See “Common incident report features” on page 1039. See “Saving custom incident reports” on page 1022. |

**Network incident list—Actions**

You can select one or more incidents and then remediate them using commands in the **Incident Actions** drop-down list. The incident commands are as follows:
<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Note</td>
<td>Select to open a dialog box, type a comment, and then click OK.</td>
</tr>
<tr>
<td>Archive</td>
<td>Select one of the following archive actions to set the archive state for the selected incidents:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Archive Incidents</strong>—Flags the selected incidents as archived.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Restore Incidents</strong>—Restores the selected incidents to the non-archived state.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Do Not Archive</strong>—Prevents the selected incidents from being archived.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Allow Archive</strong>—Allows the selected incidents to be archived.</td>
</tr>
<tr>
<td></td>
<td>See “About incident archiving” on page 1065.</td>
</tr>
<tr>
<td>Delete Incidents</td>
<td>Select to delete specified incidents.</td>
</tr>
<tr>
<td>Export Selected: CSV</td>
<td>Select to save specified incidents in a comma-separated text (.csv) file or XML file, which can be displayed in several common applications, such as Microsoft Excel.</td>
</tr>
<tr>
<td>Export Selected: XML</td>
<td>Use lookup plug-ins to look up incident custom attributes.</td>
</tr>
<tr>
<td>Lookup Attributes</td>
<td>Select to run a Smart Response rule that you or your administrator configured. (To configure a Smart Response rule, navigate to Policy &gt; Response Rules, click Add Response Rule, and select Smart Response.</td>
</tr>
<tr>
<td>Set Attributes</td>
<td>Select to set attributes for the selected incidents.</td>
</tr>
<tr>
<td>Set Data Owner</td>
<td>Set the data owner name or email address. The data owner is the person responsible for remediating the incident. Reports can automatically be sent to the data owner for remediation.</td>
</tr>
<tr>
<td>Set Severity</td>
<td>Select to set severity.</td>
</tr>
</tbody>
</table>
Action                  Description
Set Status              Select to set status.

See “About incident remediation” on page 940.
See “Network incident list” on page 950.

Network incident list—Columns

Incident information is divided into several columns. Click any column header to sort alpha-numerically by that column’s data. To sort in reverse order, click the column header a second time. By default, Symantec Data Loss Prevention lists incidents by date.

The report includes the following columns:

- **Check boxes that let you select incidents to remediate.**
  You can select one or more incidents to which to apply commands from the Incident drop-down menu at the top of the list. Click the checkbox at the top of the column to select all incidents on the current page. (Note that you can also click Select All at far right to select all incidents in the report.)

- **Type**
  The protocol over which the match was detected.
  See “Network incident list” on page 950.

- **Subject/Sender/Recipient(s)**
  Message subject, sender email address or IP address, recipient email address(es), or URL(s).

- **Sent**
  Date and time the message was sent.

- **ID/Policy**
  Symantec Data Loss Prevention incident ID number and the policy against which the incident was logged.

- **Matches**
  Number of matches in the incident.

- **Sev**
  Incident severity as determined by the severity setting of the rule the incident matched.
  The possible values are as follows:
## Network incident snapshot

An incident snapshot provides detailed information about a particular incident. It displays general incident information, matches detected in the intercepted text, and incident attributes. The snapshot also enables you to execute any Smart Response rules that you have configured.

The incident snapshot is divided into three panes, with navigation and Smart Response options. Click on a link to view more help about the incident snapshot:

<table>
<thead>
<tr>
<th>To learn more about</th>
<th>See the section</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navigation and Smart Response options</td>
<td>See &quot;Network incident snapshot—Heading and navigation&quot; on page 957.</td>
</tr>
<tr>
<td>General incident information (left-hand pane)</td>
<td>See &quot;Network incident snapshot—General information&quot; on page 957.</td>
</tr>
</tbody>
</table>
Network incident snapshot—Heading and navigation

The following page navigation tools appear near the top of the incident snapshot:

- **Previous**
  Displays the previous incident in the source report.

- **Next**
  Displays the next incident in the source report.

- ****
  Returns to the source report (where you clicked the link to get to this screen).

- ****
  Updates the snapshot with any new data, such as a new comment in the History section or a modified status.

If you configured any Smart Response rules, Symantec Data Loss Prevention displays the response options for executing the rules at the top of the page. Depending on the number of Smart Response rules, a drop-down menu may also appear.

See “Network incident snapshot” on page 956.

Network incident snapshot—General information

The left section of the snapshot displays general incident information. You can click on many values to view an incident list that is filtered on that value. An icon may appear next to the **Status** drop-down list to indicate whether the request that generated the incident was blocked or altered.

See Table 41-2 on page 952.

The current status and severity of the incident appear to the right of the snapshot heading. To change one of the current values, click on it and choose another value from the drop-down list.

The remaining portion of the general information pane is divided into four tabs.
Information in this section is divided into the following categories (not all of which appear for every incident type):

- Key Info
- History
- Notes
- Correlations
Table 41-3 Incident general information tabs

<table>
<thead>
<tr>
<th>Tab Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| Key Info  | The Key Info tab shows the policy that was violated in the incident. It also shows the total number of matches for the policy, as well as matches per policy rule. Click the policy name to view a list of all incidents that violated the policy. Click view policy to view a read-only version of the policy. This section also lists other policies that the same file violated. To view the snapshot of an incident that is associated with a particular policy, click go to incident next to the policy name. To view a list of all incidents that the file created, click show all. The Key Info tab also includes the following information:  
  - The name of the detection server that recorded the incident.  
  - The date and time the message was sent  
  - The sender email or IP address  
  - The recipient email or IP address(es)  
  - The SMTP heading or the NNTP subject heading  
  - The Is Archived field displays the archived state of the incident, whether or not the incident is archivable, and allows you to toggle the Do Not Archive flag for the incident.  
  - Attachment file name(s). Click to open or save the file. If a response rule tells Symantec Data Loss Prevention to discard the original message, you cannot view the attachment.  
  - The person responsible for remediating the incident (Data Owner Name). This field must be set manually, or with a lookup plug-in. Reports can automatically be sent to the data owner for remediation. If you click on a hyperlinked Data Owner Name, a filtered list of incidents by Data Owner Name is displayed.  
  - The email address of the person responsible for remediating the incident (Data Owner Email Address). This field must be set manually, or with a lookup plug-in. If you click on the hyperlinked Data Owner Email Address, a filtered list of incidents by Data Owner Email Address is displayed. |
Table 41-3  Incident general information tabs (continued)

<table>
<thead>
<tr>
<th>Tab Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>History</td>
<td>View the actions that were performed on the incident. For each action, Symantec Data Loss Prevention displays the action date and time, the actor (a user or server), and the action or the comment. See &quot;Executing Smart response rules&quot; on page 944. See &quot;Manage response rules&quot; on page 889.</td>
</tr>
<tr>
<td>Notes</td>
<td>View any notes that you or others have added to the incident. Click Add Note to add a note.</td>
</tr>
<tr>
<td>Correlations</td>
<td>You can view a list of those incidents that share attributes of the current incident. For example, you can view a list of all incidents that a single account generated. The Correlations tab shows a list of correlations that match single attributes. Click on attribute values to view lists of those incidents that are related to those values. To search for other incidents with the same attributes, click Find Similar. In the Find Similar Incidents dialog box that appears, select the desired search attributes. Then click Find Incidents. Note: The list of correlated incidents does not display related incidents that have been archived.</td>
</tr>
</tbody>
</table>

See “Network incident snapshot” on page 956.
See “About incident archiving” on page 1065.

Network incident snapshot—Matches

Beneath the general information, Symantec Data Loss Prevention displays the message content (if applicable) and the matches that caused the incident. Symantec Data Loss Prevention displays the following types of message content, depending on protocol type:

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Message content</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMTP</td>
<td>Message body</td>
</tr>
<tr>
<td>HTTP</td>
<td>Name value pairs of the HTTP request</td>
</tr>
<tr>
<td>FTP</td>
<td>Nothing shown</td>
</tr>
</tbody>
</table>
Protocol | Message content
---|---
NNTP | Message body
IM (all providers) | IM conversation
TCP | Data that was transmitted through custom protocol

Matches are highlighted in yellow and organized according to the message component (such as header, body, or attachment) in which they were detected. Symantec Data Loss Prevention displays the total relevant matches for each message component. It shows matches by the order in which they appear in the original text. To view the rule that triggered a match, click on the highlighted match.

See “About the Similarity Threshold and Similarity Score” on page 512.

See “Network incident snapshot” on page 956.

Network incident snapshot—Attributes

**Note:** This section appears only if a system administrator has configured custom attributes.

You can view a list of custom attributes and their values, if any have been specified. Click on attribute values to view an incident list that is filtered on that value. To add new values or edit existing ones, click **Edit**. In the **Edit Attributes** dialog box that appears, type the new values and click **Save**.

See “Setting the values of custom attributes manually” on page 1080.

See “Network incident snapshot” on page 956.

Network summary report

The Network summary report provides summary information about the incidents that are found on your network. You can organize the report by one or two summary criteria. A single-summary report is organized by a single summary criterion, such as the policy that is associated with each incident. A double-summary report is organized by two criteria, such as policy and incident status.

To view the primary criteria and the secondary summary criteria available for the current report, click the **Advanced Filters & Summarization** bar. The bar is near the top of the report. The **Summarize By:** listboxes show the primary criteria and the secondary summary criteria. In each listbox, Symantec Data Loss Prevention
displays all out-of-the-box criteria in alphabetical order, followed by any custom criteria that your system administrator has defined. Summary reports take their name from the primary summary criterion (the value of the first listbox). If you rerun a report with new criteria, the report name changes accordingly.

Summary entries are divided into several columns. Click any column header to sort alpha-numerically by that column’s data. To sort in reverse order, click the column header a second time.

Table 41-4  Summary report columns

<table>
<thead>
<tr>
<th>Column name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>summary_criterion</td>
<td>This column is named for the primary summary criterion. It lists primary and (for double summaries) secondary summary items. In a Policy Summary, this column is named Policy and it lists policies. Click on a summary item to view a list of incidents that are associated with that item.</td>
</tr>
<tr>
<td>Total</td>
<td>The total number of incidents that are associated with the summary item. In a Policy Summary, this column gives the total number of incidents that are associated with each policy.</td>
</tr>
<tr>
<td>High</td>
<td>Number of high-severity incidents that are associated with the summary item. (The severity setting of the rule that was matched determines the incident severity.)</td>
</tr>
<tr>
<td>Med</td>
<td>Number of medium-severity incidents that are associated with the summary item.</td>
</tr>
<tr>
<td>Low</td>
<td>Number of low-severity incidents that are associated with the summary item.</td>
</tr>
<tr>
<td>Info</td>
<td>The number of informational incidents that are associated with the summary item.</td>
</tr>
<tr>
<td>Bar Chart</td>
<td>A visual representation of the number of incidents (of all severities) associated with the summary item. The bar is broken into proportional, colored sections to represent the various severities.</td>
</tr>
<tr>
<td>Matches</td>
<td>Total number of matches associated with the summary item.</td>
</tr>
</tbody>
</table>
If any of the severity columns contain totals, you can click on them to view a list of incidents of the chosen severity.

See “Common incident report features” on page 1039.

See “About dashboard reports and executive summaries” on page 1011.

See “About incident reports” on page 1009.

See “Saving custom incident reports” on page 1022.
Remediating Endpoint incidents

This chapter includes the following topics:

- Endpoint incident lists
- Endpoint incident snapshot
- Reporting on Endpoint Prevent response rules
- Endpoint incident destination or protocol-specific information
- Endpoint incident summary reports

Endpoint incident lists

An endpoint incident list shows endpoint incidents that contain basic information such as protocol or destination, severity, associated policy, number of matches, and status. Click on any incident to view a snapshot containing more incident details. You can select specific incidents (or groups of incidents) to modify or remediate.

**Note:** Endpoint reports show only the incidents that were captured by Endpoint Prevent. Incidents that were captured by Endpoint Discover appear in Network Discover reports.

Incident information is divided into several columns. Click any column header to sort alpha-numerically by the data in that column. To sort in reverse order, click the column header a second time. By default, Symantec Data Loss Prevention lists incidents by date.

The report includes the following columns:
Check boxes that let you select incidents to remediate

You can select one or more incidents to which to apply commands from the Incident drop-down menu at the top of the list. Click the checkbox at the top of the column to select all incidents on the current page. (You can click Select All at far right to select all incidents in the report.)

Table 42-1 Type of endpoint incident

<table>
<thead>
<tr>
<th>Graphic</th>
<th>Type of incident</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Graphic" /></td>
<td>CD/DVD burner (for example, Windows Media burner)</td>
</tr>
<tr>
<td><img src="image2.png" alt="Graphic" /></td>
<td>Removable media (for example, a USB flash drive or SD card)</td>
</tr>
<tr>
<td><img src="image3.png" alt="Graphic" /></td>
<td>Fixed drive (for example, the C: drive)</td>
</tr>
<tr>
<td><img src="image4.png" alt="Graphic" /></td>
<td>Endpoint copy to network share</td>
</tr>
<tr>
<td><img src="image5.png" alt="Graphic" /></td>
<td>Email/SMTP</td>
</tr>
<tr>
<td><img src="image6.png" alt="Graphic" /></td>
<td>HTTP</td>
</tr>
<tr>
<td><img src="image7.png" alt="Graphic" /></td>
<td>HTTPS</td>
</tr>
<tr>
<td><img src="image8.png" alt="Graphic" /></td>
<td>FTP</td>
</tr>
<tr>
<td><img src="image9.png" alt="Graphic" /></td>
<td>IM: AIM</td>
</tr>
<tr>
<td><img src="image10.png" alt="Graphic" /></td>
<td>IM: MSN</td>
</tr>
<tr>
<td><img src="image11.png" alt="Graphic" /></td>
<td>IM: Yahoo</td>
</tr>
<tr>
<td><img src="image12.png" alt="Graphic" /></td>
<td>Print/Fax</td>
</tr>
<tr>
<td><img src="image13.png" alt="Graphic" /></td>
<td>Clipboard</td>
</tr>
<tr>
<td><img src="image14.png" alt="Graphic" /></td>
<td>Application File Access</td>
</tr>
</tbody>
</table>
A response column that indicates whether Symantec Data Loss Prevention blocked an attempted violation or notified the end user about the violation of confidential data.

The possible values are as follows:

- Blank if Symantec Data Loss Prevention did not block the violation or notify the end user
- A red icon indicates the violation was blocked by Symantec Data Loss Prevention, by the user, or if the user cancel option time limit expired.
- A notification icon indicates Symantec Data Loss Prevention notified the end user about the violated confidential data policies. The notification icon also appears if the user allowed the violating data transfer. The icon also appears if the user cancel time limit option has expired and the default action is set to allow data transfers.

The other columns of this section appear as follows:

### Table 42-2  Endpoint incident columns

<table>
<thead>
<tr>
<th>Column</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Name/Machine/User/Subject/Recipient</td>
<td>File name, computer, endpoint user (domain and logon name), subject title (if Email/SMT violation), and recipient user that is associated with the incident</td>
</tr>
</tbody>
</table>
| Occurred On Date           | ■ Incident date and time  
                              ■ Reported On Date  
                              ■ Time and date that the incident was reported. If the endpoint is disconnected from the corporate network, incidents are reported when the connection is restored. |
| ID/Policy                  | Symantec Data Loss Prevention incident ID number and the policy against which the incident was logged |
| Matches                    | Number of matches in the incident |
Table 42-2  Endpoint incident columns (continued)

<table>
<thead>
<tr>
<th>Column</th>
<th>Definition</th>
</tr>
</thead>
</table>
| Severity | Incident severity as determined by the severity setting of the rule the incident matched.  
The possible values are as follows:  
■ High  
■ Medium  
■ Low  
■ For information only |
| Status | Current incident status  
The possible values are as follows:  
■ New  
■ In Process  
■ Escalated  
■ False positive  
■ Configuration Errors  
■ Resolved |

You or your administrator can add new status designations on the Attribute Setup page.

See “Endpoint incident snapshot” on page 967.
See “About incident remediation” on page 940.
See “About incident reports” on page 1009.
See “Saving custom incident reports” on page 1022.

Endpoint incident snapshot

An incident snapshot provides detailed information about a particular Endpoint Prevent incident. It displays general incident information, matches detected in the intercepted text, and details about attributes, incident history, and the violated policy. You can also search for similar incidents in the Correlations area.

**Note:** Endpoint Discover incidents are captured in Network Discover reports.

See “Discover incident lists” on page 995.
Current status and severity appear under the snapshot heading. To change one of the current values, click on it and choose another value from the drop-down list. If any action icon is associated, it also appears here.

If you have configured any Smart Response rules, Symantec Data Loss Prevention displays a Remediation bar (under the Status bar). The Remediation bar includes options for executing the rules. Depending on the number of Smart Response rules, a drop-down menu may also appear.

The top left section of the snapshot displays general incident information. You can click most information values to view an incident list that is filtered on that value. Information in this section is divided into the following categories (not all of which appear for every incident type):

<table>
<thead>
<tr>
<th>Table 42-3 Type of incident</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Icon</strong></td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
</tr>
</tbody>
</table>
Table 42-3  Type of incident (continued)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Incident type</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Clipboard icon]</td>
<td>Clipboard</td>
</tr>
<tr>
<td>![Application File Access icon]</td>
<td>Application File Access</td>
</tr>
</tbody>
</table>

The following table contains the other informational sections:

Table 42-4  Incident sections

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>Name of the Endpoint Server that detected the incident for two-tier detection. Or, it is the name of the Endpoint Server that received the incident from the Symantec DLP Agent.</td>
</tr>
<tr>
<td>Agent response</td>
<td>The Endpoint Block, Endpoint Notify, Endpoint Quarantine, Endpoint FlexResponse, or User Cancel action, if any. The possible values are as follows:</td>
</tr>
<tr>
<td></td>
<td>- Blank or no icon if Symantec Data Loss Prevention did not block the copy or notify the end user.</td>
</tr>
<tr>
<td></td>
<td>- A red circle icon indicates Symantec Data Loss Prevention blocked confidential data.</td>
</tr>
<tr>
<td></td>
<td>- A message icon indicates Symantec Data Loss Prevention notified the end user that the data is confidential.</td>
</tr>
<tr>
<td></td>
<td>See Reporting on Endpoint Prevent Response Rules.</td>
</tr>
<tr>
<td>Incident Occurred On</td>
<td>Date and time the incident occurred.</td>
</tr>
<tr>
<td>Incident Reported On</td>
<td>Date and time the Endpoint Server detected the incident.</td>
</tr>
<tr>
<td>Is Archived</td>
<td>Displays the archived state of the incident, whether or not the incident is archivable, and allows you to toggle the Do Not Archive flag for the incident. See “About incident archiving” on page 1065.</td>
</tr>
</tbody>
</table>
### Table 42-4  Incident sections (continued)

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User</td>
<td>Endpoint user name (for example, MYDOMAIN\bsmith).</td>
</tr>
<tr>
<td>User Justification</td>
<td>The justification label precedes by the text that is presented to the end user in the on-screen notification (for example, Manager Approved: “My manager approved the transfer of this data.”) Symantec Data Loss Prevention uses the label for classification and filtering purposes in reports, but the endpoint user never sees it. Click the label to view a list of incidents in which the end user chose this justification.</td>
</tr>
<tr>
<td>Machine Name</td>
<td>Computer on which the incident occurred.</td>
</tr>
<tr>
<td>Machine IP (Corporate)</td>
<td>The IP address of the violating computer if the computer was on the corporate network.</td>
</tr>
<tr>
<td>File name</td>
<td>Name of the file that violated the policy. The file name field appears only for fixed-drive incidents.</td>
</tr>
<tr>
<td>Quarantine Result</td>
<td>If you have Endpoint Discover: Quarantine response rules configured, you may see one of the following quarantine scenarios:</td>
</tr>
<tr>
<td>Quarantine Details</td>
<td>Displays the reason that the quarantine task failed to move the confidential file. For example, the action may fail because the source file is missing, or the credentials to access the secure location are incorrect. The Quarantine Details file also displays information if the status of the quarantined file is unknown because of a Quarantine Result Timeout event.</td>
</tr>
<tr>
<td>Quarantine Location</td>
<td>Displays the file path of the secure location where the file was moved.</td>
</tr>
</tbody>
</table>
Table 42-4 Incident sections (continued)

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Endpoint Location</td>
<td>Indicates whether or not the endpoint was connected to the corporate network at the time the incident occurred.</td>
</tr>
<tr>
<td>Application Name</td>
<td>The name of the application that caused the incident.</td>
</tr>
<tr>
<td>Destination</td>
<td>The destination location or file path for the confidential data, depending on the device or protocol.</td>
</tr>
<tr>
<td>Destination IP</td>
<td>The destination IP address for the confidential data. The Destination IP address appears only for specific network incidents.</td>
</tr>
<tr>
<td>Source</td>
<td>The original file or data for the violation. The source primarily appears in file-transfer incidents.</td>
</tr>
<tr>
<td>Sender</td>
<td>The sender of the confidential data for network violations.</td>
</tr>
<tr>
<td>Recipient</td>
<td>The intended recipient of the confidential data for network violations.</td>
</tr>
<tr>
<td>FTP User Name</td>
<td>The originating user name for violating FTP transfers.</td>
</tr>
<tr>
<td>Attachments</td>
<td>The associated file(s) or attachments sent (for network incidents). If your administrator has configured Symantec Data Loss Prevention to retain endpoint incident data, you can click on a file name to view file contents.</td>
</tr>
<tr>
<td>Data Owner</td>
<td>The specified owner of the confidential data.</td>
</tr>
<tr>
<td>Data Owner Email Address</td>
<td>The email address for the owner of the confidential data.</td>
</tr>
<tr>
<td>Access information</td>
<td>The available ACL information. Only applicable to Endpoint Discover and Endpoint Prevent local drive monitoring. See &quot;Incident snapshot access information section&quot; on page 1044.</td>
</tr>
</tbody>
</table>
Other sections of the incident snapshot are common across all Symantec Data Loss Prevention products. These common sections include:

- **Incident snapshot matches**
  See “Incident snapshot matches section” on page 1044.

- **Incident snapshot policy section**
  See “Incident snapshot policy section” on page 1043.

- **Incident snapshot correlations section**
  See “Incident snapshot correlations tab” on page 1043.

- **Incident snapshot attributes section.** (This section appears only if a system administrator has configured custom attributes.)
  See “Incident snapshot policy section” on page 1043.

- **Incident snapshot history section**
  See “Incident snapshot history tab” on page 1042.

The Endpoint incident snapshot also contains two sections that are not common across other product lines. Those sections are:

- **Destination or protocol-specific information**
  See “Endpoint incident destination or protocol-specific information” on page 974.

- **Reporting on Endpoint Prevent response rules**
  See “Reporting on Endpoint Prevent response rules” on page 972.

### Reporting on Endpoint Prevent response rules

If user activity on the endpoint triggers more than one response rule, Symantec Data Loss Prevention determines which policy to apply based on an established order of precedence. Only the response rule that is associated with the prevailing policy is executed. Symantec Data Loss Prevention creates incidents for all policies that are violated. It indicates (in the relevant incident snapshots) that the response rules were superseded.

See “Endpoint incident snapshot” on page 967.

By default, the following list is the main order of precedence for Endpoint Prevent incidents:

- **Block**
- **User Cancel**
- **Endpoint FlexResponse**
- **Notify**
Note: For Endpoint Discover, Quarantine incidents always take precedence over Endpoint FlexResponse incidents.

Be aware of the following behavior regarding reporting of superseded incidents:

- The snapshot of a superseded Endpoint Block or User Cancel incident still displays the **Blocked** icon, because Symantec Data Loss Prevention did block the content in question. The icon also indicates if the content was blocked because the user elected to block the content. Alternately, the icon indicates that the user cancel time limit was exceeded and the content was blocked.

- The snapshot of a superseded Endpoint Notify incident does **not** include the **Notify** icon. The Notify icon is not included because Symantec Data Loss Prevention did not display the particular on-screen notification that was configured in the policy.

- The snapshot of a superseded Endpoint Quarantine incident displays the **Blocked** icon because the data did not move out of the secured area. The icon also indicates if the content was blocked because the user elected to block the content. Alternately, the icon indicates that the user cancel time limit was exceeded and the content was blocked. The History tab of the incident snapshot always displays information on whether the Endpoint FlexResponse rule was successful.

- The snapshot of a superseded Endpoint FlexResponse incident displays the **Blocked** icon because the data did not move out of the secured area. The icon also indicates if an Endpoint Quarantine response rule was activated.

If you have configured Endpoint Prevent response rules to display on-screen notifications prompting users to justify their actions, the following statements are true:

- Symantec Data Loss Prevention displays the user justification in the snapshots of all the incidents that are generated by the policies that include the executed response rule.

- Symantec Data Loss Prevention displays the justification **Superseded – Yes** in the snapshots of all superseded incidents that do not include the executed response rule.

- If there is no user to enter a justification, for example if a user accesses a remote computer, the justification reads N/A.

See “Network incident snapshot” on page 956.

See “Configuring response rule conditions” on page 892.

See “About incident reports” on page 1009.

See “Manage response rules” on page 889.
Endpoint incident destination or protocol-specific information

Depending on the type of incident, additional information that is associated with the incident snapshot is visible.

Table 42-5  Destination or protocol-specific information

<table>
<thead>
<tr>
<th>Destination or protocol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL</td>
<td>For network incidents, denotes the URL where the incident occurred.</td>
</tr>
<tr>
<td>Source IP and Port</td>
<td>For network incidents, denotes the IP address or port of the endpoint that originated the incident. This information is only shown if the incident is created on this endpoint.</td>
</tr>
<tr>
<td>Destination IP and Port</td>
<td>The IP address of the destination endpoint that is associated with the incident. This information is only shown if the incident is created on this endpoint.</td>
</tr>
<tr>
<td>Sender/Recipient Email</td>
<td>For Email/SMTP and IM incidents, incidents also contain the email addresses of the sender and recipient. The sender or recipient email address are only shown if the incident occurs on them.</td>
</tr>
<tr>
<td>Subject</td>
<td>The subject line of the Email/SMTP message is displayed.</td>
</tr>
<tr>
<td>FTP user name at the FTP Destination</td>
<td>For FTP incidents, the user name at the FTP destination is displayed.</td>
</tr>
<tr>
<td>Server IP</td>
<td>For FTP incidents, the server IP address is shown.</td>
</tr>
<tr>
<td>File Name/Location</td>
<td>For print/fax incidents, the name of the file and the location of the file on the endpoint is displayed.</td>
</tr>
<tr>
<td>Print Job Name</td>
<td>For print/fax incidents, the print job name is the file name of the printing job that generated the incident.</td>
</tr>
</tbody>
</table>
### Endpoint incident summary reports

Endpoint incident summary reports provide information about those Endpoint incidents that has been summarized by specific criteria. You can summarize incidents by one or more types of criteria. A single-summary report is organized by a single summary criterion, such as the policy that is associated with each incident. A double-summary report is organized by two or more criteria, such as policy and incident status.

**Note:** Endpoint reports show only the incidents that are captured by Endpoint Prevent. Incidents from Endpoint Discover appear in Network Discover reports.

To view the primary and the secondary summary criteria available for the report, go to the **Summarize By** link. Click **Edit**. In the **Primary and Secondary** drop-down menus, Symantec Data Loss Prevention displays all of the criteria in alphabetical order, followed by custom criteria your system administrator defined. You can select criteria from the **Primary and Secondary** drop-down menus and then click **Run Now** to create a new summary report. Summary reports take their name from the primary summary criterion. If you rerun a report with new criteria, the report name changes accordingly.

See “About filters and summary options for reports” on page 1046.

Summary entries are divided into several columns. Click any column header to sort alpha-numerically by that column's data. To sort in reverse order, click the column header a second time.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Summary criteria</td>
<td>This column contains the name of whichever summery criteria you selected. If you select a primary and a secondary summary criteria, only the primary criteria is displayed.</td>
</tr>
<tr>
<td>Total</td>
<td>Total number of the incidents that are associated with the summary item. For example, in a Policy Summary this column gives the total number of incidents that are associated with each policy.</td>
</tr>
<tr>
<td>High</td>
<td>Number of high-severity incidents that are associated with the summary item. (The severity setting of the rule that was matched determines the level of severity.)</td>
</tr>
<tr>
<td>Med</td>
<td>Number of medium-severity incidents that are associated with the summary item.</td>
</tr>
<tr>
<td>Low</td>
<td>Number of low-severity incidents that are associated with the summary item.</td>
</tr>
<tr>
<td>Info</td>
<td>Number of the informational incidents that are associated with the summary item.</td>
</tr>
<tr>
<td>Bar Chart</td>
<td>A visual representation of the number of incidents (of all severities) associated with the summary item. The bar is broken into proportional colored sections that represent the various severities.</td>
</tr>
<tr>
<td>Matches</td>
<td>Total number of matches associated with the summary item. If any of the severity columns contain totals, you can click on them to view a list of incidents of the chosen severity.</td>
</tr>
</tbody>
</table>
Remediating Mobile incidents

This chapter includes the following topics:

- Mobile incident reports
- Mobile incident snapshot
- Mobile incident list
- Mobile Prevent incident list—Actions
- Mobile incident list—Columns
- Mobile incident snapshot—Heading and navigation
- Mobile incident snapshot—General information
- Mobile incident snapshot—Matches
- Mobile incident snapshot—Attributes
- Mobile summary report

Mobile incident reports

Use Mobile incident reports to monitor and respond to Mobile incidents. You can save, send, export, or schedule Symantec Data Loss Prevention reports.

In the Enforce Server administration console, on the Incidents menu, click Mobile. This incident report displays all incidents for any target that is a mobile device. You can select the standard reports for all incidents, new incidents, policy summary, status by policy, or high-risk senders.
Summaries and filter options can select which incidents to display.

See “About filters and summary options for reports” on page 1046.

You can create custom reports with combinations of filters and summaries to identify the incidents to remediate.

See “About custom reports and dashboards” on page 1019.

See “Mobile incident list” on page 978.

**Mobile incident snapshot**

An incident snapshot provides detailed information about a particular incident. It displays general incident information, matches detected in the intercepted text, and incident attributes. The snapshot also enables you to execute any Smart Response rules that you have configured.

The incident snapshot is divided into three panes, with navigation and Smart Response options. Click on a link to view more help about the incident snapshot:

**To learn more about**

- **Navigation and Smart Response options**
  See “Mobile incident snapshot—Heading and navigation” on page 983.

- **General incident information (left-hand pane)**
  See “Mobile incident snapshot—General information” on page 983.

- **Matches in incident (middle pane)**
  See “Mobile incident snapshot—Matches” on page 985.

- **Attributes (right-hand pane)**
  See “Mobile incident snapshot—Attributes” on page 986.

**Mobile incident list**

A Mobile incident list shows multiple mobile incident records with information about the incident such as: the severity, associated policy, number of matches, and status of the incident. Click a row of the incident list to view more details about a specific incident. Select specific incidents (or groups of incidents) to modify or remediate by clicking the check boxes at the left.
Note: Use caution when you click Select All. This action selects all incidents in the report (not only those on the current page). Any incident command you subsequently apply affects all incidents. To select only the incidents on the current page, select the checkbox at top left of the incident list.

Incident information is divided into several columns. Click any column header to sort alpha-numerically by that column’s data. To sort in reverse order, click the column header a second time. By default, Symantec Data Loss Prevention sorts incidents by date.

The Type column shows the icons that indicate the type of mobile incident. Table 43-1 describes the icons.

Table 43-1  Type of Mobile Prevent incident

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![HTTP icon]</td>
<td>HTTP</td>
</tr>
<tr>
<td>![HTTPS icon]</td>
<td>HTTPS</td>
</tr>
<tr>
<td>![FTP icon]</td>
<td>FTP</td>
</tr>
</tbody>
</table>

This column also indicates whether the communication was blocked or altered. Table 43-2 shows the possible values.

Table 43-2  Mobile Prevent block or altered status

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![No icon]</td>
<td>Blank if the communication was not blocked.</td>
</tr>
<tr>
<td>![Red Circle]</td>
<td>Indicates Symantec Data Loss Prevention blocked the communication containing the matched text.</td>
</tr>
<tr>
<td>![Red Circle with Gear]</td>
<td>Indicates Symantec Data Loss Prevention removed confidential data from Web postings or Web-based email messages. This icon can also indicate that a file was uploaded to a Web site or attached to a Web-based email message.</td>
</tr>
<tr>
<td>![Blue Pencil]</td>
<td>Indicates that Symantec Data Loss Prevention has added or modified the headers on the message that generated the incident.</td>
</tr>
</tbody>
</table>
Use the following links to learn more about the Mobile incident list page:

<table>
<thead>
<tr>
<th>To learn more about</th>
<th>See this section</th>
</tr>
</thead>
<tbody>
<tr>
<td>Columns of the incident list table</td>
<td>See “Mobile incident list—Columns” on page 981.</td>
</tr>
<tr>
<td>Actions to perform on selected incidents</td>
<td>See “Mobile Prevent incident list—Actions” on page 980.</td>
</tr>
<tr>
<td>Details of a specific incident</td>
<td>See “Mobile incident snapshot” on page 978.</td>
</tr>
<tr>
<td>Viewing a summary of all mobile incidents</td>
<td>See “Mobile summary report” on page 986.</td>
</tr>
<tr>
<td>Features that are common to all Symantec Data Loss Prevention reports</td>
<td>See “About incident reports” on page 1009.</td>
</tr>
<tr>
<td></td>
<td>See “Common incident report features” on page 1039.</td>
</tr>
<tr>
<td></td>
<td>See “Saving custom incident reports” on page 1022.</td>
</tr>
</tbody>
</table>

**Mobile Prevent incident list—Actions**

You can select one or more incidents and then remediate them using commands in the **Incident Actions** drop-down list.

**Note:** No remediation actions are available in Mobile Email Monitor.

The incident commands are as follows:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Note</td>
<td>Select to open a dialog box, type a comment, and then click <strong>OK</strong>.</td>
</tr>
</tbody>
</table>
Select one of the following archive actions to set the archive state for the selected incidents:

- **Archive Incidents**—Flags the selected incidents as archived.
- **Restore Incidents**—Restores the selected incidents to the non-archived state.
- **Do Not Archive**—Prevents the selected incidents from being archived.
- **Allow Archive**—Allows the selected incidents to be archived.

See “About incident archiving” on page 1065.

**Delete Incidents**
Select to delete specified incidents.

**Export Selected: CSV**
Select to save specified incidents in a comma-separated text (.csv) file or XML file, which can be displayed in common applications, such as Microsoft Excel.

**Export Selected: XML**

**Lookup Attributes**
Use lookup plug-ins to look up incident custom attributes.

**Set Attributes**
Select to set attributes for the selected incidents.

**Set Severity**
Select to set severity.

**Set Status**
Select to set status.

See “About incident remediation” on page 940.

See “Mobile incident snapshot” on page 978.

---

**Mobile incident list—Columns**

Incident information is divided into several columns. Click any column header to sort alpha-numerically by that column’s data. To sort in reverse order, click the column header a second time. By default, Symantec Data Loss Prevention lists incidents by date.

The report includes the following columns:

- Checkboxes that let you select incidents to remediate.
You can select one or more incidents to which to apply commands from the Incident drop-down menu at the top of the list. Click the checkbox at the top of the column to select all incidents on the current page. You can also click Select All at far right to select all incidents in the report.

---

Note: No remediation actions are available for Mobile Email Monitor.

---

- **Type**
  The protocol over which the match was detected.

- **Subject/Sender/Recipient(s)**
  Message subject, sender email address or IP address, recipient email address(es), or URL(s).

- **Sent**
  Date and time the message was sent.

- **ID/Policy**
  Symantec Data Loss Prevention incident ID number and the policy against which the incident was logged.

- **Matches**
  Number of matches in the incident.

- **Severity**
  Incident severity as determined by the severity setting of the rule the incident matched.
  The possible values are as follows:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🟢🟢🟢</td>
<td>High</td>
</tr>
<tr>
<td>🟢🟢</td>
<td>Medium</td>
</tr>
<tr>
<td>🟢</td>
<td>Low</td>
</tr>
<tr>
<td></td>
<td>For information only</td>
</tr>
</tbody>
</table>

- **Status**
  Current incident status.
  The possible values are as follows:

  - **New**
You or your administrator can add new status designations on the Attribute Setup page.

Mobile incident snapshot—Heading and navigation

The following page navigation tools appear near the top of the incident snapshot:

- **Previous**: Displays the previous incident in the source report.
- **Next**: Displays the next incident in the source report.
- ****: Returns to the source report (where you clicked the link to get to this screen).
- ****: Updates the snapshot with any new data, such as a new comment in the History section or a modified status.

See “Mobile incident snapshot” on page 978.

Mobile incident snapshot—General information

The left section of the snapshot displays general incident information. You can click on many values to view an incident list that is filtered on that value. An icon may appear next to the **Status** drop-down list to indicate whether the request that generated the incident was blocked or altered.

See Table 41-2 on page 952.

The current status and severity of the incident appear to the right of the snapshot heading. To change one of the current values, click on it and choose another value from the drop-down list.

The remaining portion of the general information pane is divided into four tabs:

- **Key Info**
Information in this section is divided into the following categories (not all of which appear for every incident type):

Table 43-3  Incident general information tabs

<table>
<thead>
<tr>
<th>Tab Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Key Info</strong></td>
<td>The Key Info tab shows the policy that was violated in the incident. It also shows the total number of matches for the policy, as well as matches per policy rule. Click the policy name to view a list of all incidents that violated the policy. Click view policy to view a read-only version of the policy. This section also lists other policies that the same file violated. To view the snapshot of an incident that is associated with a particular policy, click go to incident next to the policy name. To view a list of all incidents that the file created, click show all. The Key Info tab also includes the following information: The name of the detection server that recorded the incident. The date and time the message was sent. The sender email or IP address. The recipient email or IP address(es). The SMTP heading or the NNTP subject heading. Attachment file name(s). Click to open or save the file. If a response rule tells Symantec Data Loss Prevention to discard the original message, you cannot view the attachment. The person responsible for remediating the incident (Data Owner Name). This field must be set manually. Reports can automatically be sent to the data owner for remediation. If you click on a hyperlinked Data Owner Name, a filtered list of incidents by Data Owner Name is displayed. The email address of the person responsible for remediating the incident (Data Owner Email Address). This field must be set manually. If you click on the hyperlinked Data Owner Email Address, a filtered list of incidents by Data Owner Email Address is displayed.</td>
</tr>
</tbody>
</table>


Table 43-3  Incident general information tabs (continued)

<table>
<thead>
<tr>
<th>Tab Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| **History** | View the actions that were performed on the incident. For each action, Symantec Data Loss Prevention displays the action date and time, the actor (a user or server), and the action or the comment.  
See “Executing Smart response rules” on page 944.  
See “Manage response rules” on page 889. |
| **Notes** | View any notes that you or others have added to the incident. Click Add Note to add a note. |
| **Correlations** | You can view a list of those incidents that share attributes of the current incident. For example, you can view a list of all incidents that a single account generated. Symantec Data Loss Prevention shows a list of correlations that match single attributes. Click on attribute values to view lists of those incidents that are related to those values.  
To search for other incidents with the same attributes, click Find Similar. In the Find Similar Incidents dialog box that appears, select the desired search attributes. Then click Find Incidents. |

See “Mobile incident snapshot” on page 978.

Mobile incident snapshot—Matches

Beneath the general information, Symantec Data Loss Prevention displays the message content (if applicable) and the matches that caused the incident. Symantec Data Loss Prevention displays the following types of message content, depending on protocol type:

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Message content</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTTP/S</td>
<td>Name value pairs of the HTTP/S request</td>
</tr>
<tr>
<td>FTP</td>
<td>Nothing shown</td>
</tr>
</tbody>
</table>

Matches are highlighted in yellow and organized according to the message component (such as header, body, or attachment) in which they were detected. Symantec Data Loss Prevention displays the total relevant matches for each message component. It shows matches by the order in which they appear in the original text. To view the rule that triggered a match, click on the highlighted match.
Mobile incident snapshot—Attributes

Note: This section appears only if a system administrator has configured custom attributes.

You can view a list of custom attributes and their values, if any have been specified. Click on attribute values to view an incident list that is filtered on that value. To add new values or edit existing ones, click Edit. In the Edit Attributes dialog box that appears, type the new values and click Save.

Mobile summary report

The Mobile summary report provides summary information about the incidents that are generated on your mobile devices. You can organize the report by one or two summary criteria. A single-summary report is organized by a single summary criterion, such as the policy that is associated with each incident. A double-summary report is organized by two criteria, such as policy and incident status.

To view the primary criteria and the secondary summary criteria available for the current report, click the Advanced Filters and Summarization bar. The bar is near the top of the report. The Summarize By: listboxes show the primary criteria and the secondary summary criteria. In each listbox, Symantec Data Loss Prevention displays all detection criteria in alphabetical order, followed by any custom criteria that your system administrator has defined. Summary reports take their name from the primary summary criterion (the value of the first listbox). If you rerun a report with new criteria, the report name changes accordingly.

Summary entries are divided into several columns. Click any column header to sort alpha-numerically by that column's data. To sort in reverse order, click the column header a second time.
Table 43-4  Summary report columns

<table>
<thead>
<tr>
<th>Column name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>summary_criterion</td>
<td>This column is named for the primary summary criterion. It lists primary and (for double summaries) secondary summary items. In a Policy Summary, this column is named Policy and it lists policies. Click on a summary item to view a list of incidents that are associated with that item.</td>
</tr>
<tr>
<td>Total</td>
<td>The total number of incidents that are associated with the summary item. In a Policy Summary, this column gives the total number of incidents that are associated with each policy.</td>
</tr>
<tr>
<td>High</td>
<td>Number of high-severity incidents that are associated with the summary item. (The severity setting of the rule that was matched determines the incident severity.)</td>
</tr>
<tr>
<td>Med</td>
<td>Number of medium-severity incidents that are associated with the summary item.</td>
</tr>
<tr>
<td>Low</td>
<td>Number of low-severity incidents that are associated with the summary item.</td>
</tr>
<tr>
<td>Info</td>
<td>The number of informational incidents that are associated with the summary item.</td>
</tr>
<tr>
<td>Bar Chart</td>
<td>A visual representation of the number of incidents (of all severities) associated with the summary item. The bar is broken into proportional, colored sections to represent the various severities.</td>
</tr>
<tr>
<td>Matches</td>
<td>Total number of matches associated with the summary item.</td>
</tr>
</tbody>
</table>

If any of the severity columns contain totals, you can click on them to view a list of incidents of the chosen severity.

See “Common incident report features” on page 1039.

See “About dashboard reports and executive summaries” on page 1011.

See “About incident reports” on page 1009.

See “Saving custom incident reports” on page 1022.
Remediating Discover incidents

This chapter includes the following topics:

- About reports for Network Discover
- About incident reports for Network Discover
- Discover incident reports
- Discover incident snapshots
- Working around the issues with go to links in the Firefox browser
- Discover incident lists
- Network Discover incident actions
- Network Discover incident entries
- Discover summary reports

About reports for Network Discover

Symantec Data Loss Prevention has reports for incidents, Network Discover targets, scan details, and scan history.

The Network Discover incident reports contain details about the confidential data that is exposed.

See “About incident reports for Network Discover” on page 989.

For information about Network Discover targets and scan history, go to Manage > Discover Scanning > Discover Targets, then select one of the Discover targets from the list. For information about Network Discover scan details, go to Manage.
> Discover Scanning > Scan History, then select one of the Discover scans from the list.

See “Managing Network Discover target scans” on page 1209.

Table 44-1 lists the Network Discover reports.

Table 44-1  Network Discover Reports

<table>
<thead>
<tr>
<th>Report</th>
<th>Navigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Discover Targets</td>
<td>This report is on the Enforce Server administration console, Manage menu, Discover Scanning &gt; Discover Targets.</td>
</tr>
<tr>
<td></td>
<td>See “About the Network Discover scan target list” on page 1210.</td>
</tr>
<tr>
<td>Scan Status</td>
<td>This report is on the Enforce Server administration console, Manage menu, Discover Scanning &gt; Discover Servers.</td>
</tr>
<tr>
<td></td>
<td>See “Viewing Network Discover server status” on page 1219.</td>
</tr>
<tr>
<td>Scan History (single target)</td>
<td>This report is from the Enforce Server administration console, Manage menu, Discover Scanning &gt; Discover Targets. Click the link in the Scan Status column to see the history of a particular scan target.</td>
</tr>
<tr>
<td></td>
<td>See “About Network Discover scan histories” on page 1213.</td>
</tr>
<tr>
<td>Scan History (all targets)</td>
<td>This report is from the Enforce Server administration console, Manage menu, Discover Scanning &gt; Scan History.</td>
</tr>
<tr>
<td></td>
<td>See “About Network Discover scan histories” on page 1213.</td>
</tr>
<tr>
<td>Scan Details</td>
<td>This report is from the Enforce Server administration console, Manage menu, Discover Scanning &gt; Scan History. Click the link in the Scan Status column to see the scan details.</td>
</tr>
<tr>
<td></td>
<td>See “About Network Discover scan details” on page 1215.</td>
</tr>
</tbody>
</table>

About incident reports for Network Discover

Use incident reports to track and respond to Network Discover incidents. You can save, send, export, or schedule Symantec Data Loss Prevention reports.

See “About Symantec Data Loss Prevention reports” on page 1006.

In the Enforce Server administration console, on the Incidents menu, click Discover

This incident report displays all incidents for all Discover targets. You can select the standard reports for all incidents, new incidents, target summary, policy by target, status by target, or top shares at risk.

Summaries and filter options can select which incidents to display.
You can create custom reports with combinations of filters and summaries to identify the incidents to remediate.

For example you can create the following reports:

- A summary report of the number of incidents in each remediation category. Select the summary Protect Status.

- A report of all the incidents that were remediated with copy or quarantine. Select the filter Protect Status with values of File Copied and File Quarantined.

- A report of the Network Discover incidents that have not been seen before (to identify these incidents and notify the data owners to remediate them). Select the filter Seen Before?. Set a value of No.

- A report of the Network Discover incidents that are still present (to know which incidents to escalate for remediation). Select the filter Seen Before?. Set a value of Yes.

- A report using the summary filters, such as months since first detected. Select the summary Months Since First Detected.

### Discover incident reports

Use Network Discover incident reports to monitor and respond to Network Discover incidents. You can save, send, export, or schedule Symantec Data Loss Prevention reports.

In the Enforce Server administration console, on the Incidents menu, click Discover. This incident report displays all incidents for all Discover targets. You can select the standard reports for all incidents, new incidents, target summary, policy by target, status by target, or top shares at risk.

Summaries and filter options can select which incidents to display.

See “Incident report filter and summary options” on page 1040.

You can create custom reports with combinations of filters and summaries to identify the incidents to remediate.

See “About custom reports and dashboards” on page 1019.

Network Discover has the following types of reports:

- Incident list
  See “Discover incident lists” on page 995.
Discover incident snapshots

An incident snapshot provides detailed information about a particular incident. It displays general incident information, matches detected in the intercepted text, and details about policy, attributes, and incident history. You can also search for similar incidents in the Correlations area.

Current status and severity appear under the snapshot heading. To change one of the current values, click it and choose another value from the drop-down list.

Use the icons at the top right to print the report, or send it as email. To send reports, you or your administrator must first enable report distribution in system settings.

See “Configuring the Enforce Server to send email alerts” on page 146.

If any Smart Response rules are set up, Symantec Data Loss Prevention displays a remediation bar that includes buttons for executing the rules. Depending on the number of Smart Response rules, a drop-down menu may also appear.

See “About incident remediation” on page 940.

Incident data is divided into the following sections:

- **Key Info** tab
  - **Policy Matches**
    See “Incident snapshot policy section” on page 1043.
  - **Incident Details**
    The following details are included:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>Name of the Discover Server that detected the incident.</td>
</tr>
<tr>
<td>Remediation</td>
<td>The latest remediation status of the file that generated the incident.</td>
</tr>
<tr>
<td>Detection Status</td>
<td>The latest remediation status of the file that generated the incident.</td>
</tr>
<tr>
<td>Target</td>
<td>Network Discover target name.</td>
</tr>
<tr>
<td>Scan</td>
<td>The date and time of the scan that registered the incident.</td>
</tr>
<tr>
<td>Detection Date</td>
<td>The date and time that the incident was detected.</td>
</tr>
<tr>
<td>Seen Before</td>
<td>No, if this incident was not previously detected. Yes, if this incident was previously detected.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Subject</td>
<td>Email subject for integrated Exchange scans.</td>
</tr>
<tr>
<td>Sender</td>
<td>Email sender for integrated Exchange scans.</td>
</tr>
<tr>
<td>Recipient</td>
<td>Email recipient for integrated Exchange scans.</td>
</tr>
<tr>
<td>File Location</td>
<td>Location of the file, repository, or item. Click <strong>go to file</strong> to view the item or file, or <strong>go to directory</strong> to view the directory. If you view an Endpoint Discover incident, you do not see the <strong>go to file</strong> or <strong>go to directory</strong> links. In the Firefox browser, these links do not work without additional setup. See &quot;Working around the issues with go to links in the Firefox browser&quot; on page 994.</td>
</tr>
<tr>
<td>Is Archived</td>
<td>Displays the archived state of the incident, whether or not the incident is archivable, and lets you toggle the <strong>Do Not Archive</strong> flag for the incident. See “About incident archiving” on page 1065.</td>
</tr>
<tr>
<td>URL</td>
<td>For SharePoint, this URL is the item on the SharePoint server. Click this URL to go to the item on the SharePoint server.</td>
</tr>
<tr>
<td>Document Name</td>
<td>File or item name(s)</td>
</tr>
<tr>
<td>File Owner</td>
<td>Creator of the file or item.</td>
</tr>
<tr>
<td></td>
<td>For SharePoint and Exchange incident snapshots the File Owner is listed as unknown because it is not applicable to these target types.</td>
</tr>
<tr>
<td>Extraction Date</td>
<td>Date custom target adapter was run (Applies to custom targets only.)</td>
</tr>
<tr>
<td>Scanned Machine</td>
<td>Host name of the scanned computer. For SharePoint this name is the web application name.</td>
</tr>
<tr>
<td>Notes Database</td>
<td>Name of the Lotus Notes database (Applies to Lotus Notes only.)</td>
</tr>
<tr>
<td>File Created</td>
<td>The date and time that the file or item was created.</td>
</tr>
<tr>
<td>Last Modified</td>
<td>Date and time of last change to the file or item.</td>
</tr>
<tr>
<td>Last Accessed</td>
<td>Date and time of last user access to the file or item. For SharePoint, this date is not valid.</td>
</tr>
</tbody>
</table>
Data Owner Name  The person responsible for remediating the incident. This field must be set manually, or with a lookup plug-in.

Reports can automatically be sent to the data owner for remediation.

If you click on the hyperlinked **Data Owner Name**, a filtered list of incidents by Data Owner Name is displayed.

Data Owner Email Address  The email address of the person responsible for remediating the incident. This field must be set manually, or with a lookup plug-in.

If you click on the hyperlinked **Data Owner Email Address**, a filtered list of incidents by Data Owner Email Address is displayed.

- **Access Information**
  See “Incident snapshot access information section” on page 1044.
  For SharePoint incident snapshots, the permission levels show the permissions from SharePoint, for example **Contribute** or **Design**. The list in the incident snapshot shows only the first 50 entries. All the ACL entries can be exported to a CSV file. The permissions are comma-separated. Users or groups having Limited Access permission levels are not recorded or shown.

- **Message Body**
  For a SharePoint list item, the message body shows the name and value pairs in the list.

- **Matches** and file content
  See “Incident snapshot matches section” on page 1044.

- **Attributes**
  See “Incident snapshot attributes section” on page 1043.

- **History** tab
  See “Incident snapshot history tab” on page 1042.

- **Notes** tab
  The notes tab displays any notes for this incident.

- **Correlations** tab
  See “Incident snapshot correlations tab” on page 1043.

See “Discover incident reports” on page 990.
Working around the issues with go to links in the Firefox browser

In the Firefox browser, when you view file system incidents, the go to file and go to directory links next to the File Location field do not work.

To go to the file or directory, take one of the following actions:

Right-click the go to file and go to directory link and select Copy Link Location. Open a new browser window (or tab) and paste the URL into the address bar. Press Enter. You must do this copy and paste each time you want to use these links.

Modify Firefox user preferences on the computer on which you use Firefox (not on the Enforce Server host).

To modify Firefox user preferences

1. Go to the Firefox user preferences directory.
   
   For Windows 7, Vista, this directory is
   
   C:\Users\user_name\AppData\Roaming\Mozilla\Firefox\Profiles\xxxxxxx.default, where user_name is your user name and xxxxxxxx is a random string of characters.
   
   For Windows XP, or 2000, this directory is C:\Documents and Settings\user_name\Application Data\Mozilla\Firefox\Profiles\xxxxxxx.default, where user_name is your user name and xxxxxxxx is a random string of characters.
   
2. Look for the user.js file. If it does not exist, create it using a text editor. If it does exist, open it. (Note that you can create or rename the file with a .txt file extension, to edit it with a text editor.)

3. Add the following lines:

   user_pref("capability.policy.policynames", "localfilelinks");
   user_pref("capability.policy.localfilelinks.sites", "enforce_url");
   user_pref("capability.policy.localfilelinks.checkloaduri.enabled", "allAccess");

   where enforce_url is the Enforce Server URL as it appears in your browser address bar, up to but not including the first slash (for example, https://enforce.server.name).

4. Save the file (renaming it with a .js file extension, if you changed it for editing purposes), and restart Firefox.
Discover incident lists

A Network Discover incident list shows the incidents that are reported during Network Discover scans (including the incidents from Endpoint Discover). Individual incident records contain information such as severity, associated policy, number of matches, and status.

See “Network Discover incident entries” on page 996.

You can click on any incident to view a snapshot containing more details.

You can select specific incidents (or a group of incidents) to modify or remediate.

See “Network Discover incident actions” on page 995.

See “Discover incident reports” on page 990.

Network Discover incident actions

You can select one or more incidents and then remediate them using commands in the Incident Actions drop-down list.

The incident commands are as follows:

- **Add Note**
  Select to open a dialog box, type a comment, and then click OK.

- **Archive**
  Select one of the following archive actions to set the archive state for the selected incidents:

  - **Archive Incidents**—Flags the selected incidents as archived.
  
  - **Restore Incidents**—Restores the selected incidents to the non-archived state.
  
  - **Do Not Archive**—Prevents the selected incidents from being archived.

  - **Allow Archive**—Allows the selected incidents to be archived.

  See “About incident archiving” on page 1065.

- **Delete Incidents**
  Select to delete specified incidents.

- **Set Attributes**
  Select to set attributes for the selected incidents.

- **Export Selected: CSV**
  Select to save specified incidents in a comma-separated text (.csv) file, which can be displayed in several common applications, such as Microsoft Excel.
■ Export Selected: XML
Select to save specified incidents in an XML file, which can be displayed in several common applications.

■ Lookup Attributes
Use the lookup plug-ins to look up incident custom attributes.

■ Set Data Owner
Set the data owner name or email address. The data owner is the person responsible for remediating the incident. Reports can automatically be sent to the data owner for remediation.

■ Set Severity
Select to set severity.

■ Set Status
Select to set status.

■ Run Smart Response
Select to run a Smart Response rule you or your administrator configured.

See “Discover incident lists” on page 995.

Network Discover incident entries

Incident information is divided into several columns.

Click any column header to sort alpha-numerically by that column's data. To sort in reverse order, click the column header a second time.

The report includes the following columns:

■ Check boxes that let you select incidents to remediate.
You can select one or more incidents to which to apply commands from the Incident Actions drop-down menu.
Click the checkbox at the top of the column to select all incidents on the current page.
You can click Select All at far right to select all incidents in the report.
Note: Use caution when you use Select All. This option selects all incidents in the report (not only those on the current page), and any incident command you subsequently apply affects all incidents. You may want to configure the maximum-incident-batch-size property to limit the number of incidents that a Server FlexResponse plug-in processes at one time.

See “Adding a Server FlexResponse plug-in to the plug-ins properties file” on page 1232.

- Type
  Type of target in which the match was detected.
  An icon represents each target type.
  This column also displays a remediation icon, if any response rule applied.
  The possible values are as follows:

  Blank if no response rule applied
  Copied
  Quarantined
  Remediation Error

When you use a Server FlexResponse action for an Automated or Smart response rule, one of the following icons may appear:

  This incident was successfully remediated using a Server FlexResponse action.
  The Server FlexResponse action is in process.
  The Server FlexResponse action has an error.

These same icons may appear for other incident types as well, and you can execute Server FlexResponse actions on those incidents. See “Configuring the Server FlexResponse action” on page 912.

- Location/Target/Scan
  Repository or file location, target name, and date and time of most recent scan

- File Owner
  Username of file owner (for example, MYDOMAIN\Administrator)

- ID/Policy
Symantec Data Loss Prevention incident number and the policy against which the incident was logged

- **Matches**
  Number of matches in the incident

- **Severity**
  Incident severity as determined by the severity setting of the rule the incident matched
  The possible values are as follows:

  - High
  - Medium
  - Low
  - For information only

- **Status**
  Current incident status
  The possible values are as follows:

  - New
  - In Process
  - Escalated
  - False Positive
  - Configuration Errors
  - Resolved
  The following icon may be displayed near the status if this incident was seen before:

  ![Icon](image)
  This icon is displayed if this incident has an earlier connected incident.

You or your administrator can add new status designations on the attribute setup page.

See “Configuring custom attributes” on page 1079.

See “Discover incident lists” on page 995.
Discover summary reports

Discover Summary Reports provide summary information about the incidents that are found during Discover scans.

If you are running Endpoint Discover, the Discover Summary Reports also include Endpoint Discover incidents.

You can filter or summarize the options in the reports.

See "Incident report filter and summary options" on page 1040.

You can extract the report information in selected formats.

You can click highlighted elements, such as the entries in the Totals column, to drill down into details.

Icons provide navigation through long reports.

See "Page navigation in incident reports" on page 1039.

See "Discover incident reports" on page 990.
Working with Classification incidents

This chapter includes the following topics:

- Classification incident list
- Classification incident snapshot

Classification incident list

The Classification incident list applies only to deployments where the Symantec Data Classification for Enterprise Vault solution is deployed. This solution uses Symantec Data Loss Prevention to classify email messages and forward them to Symantec Enterprise Vault for archiving or other actions. The solution is licensed separately from Symantec Data Loss Prevention. Classification incidents display in the Classification incident list only when a message violates a policy that is configured with the Enable Classification Test Mode option enabled. Classification test mode is used only to verify policy matches. During normal production operations, Classification test mode should be disabled.

See “About implementing detection for Enterprise Vault Classification” on page 620. Table 45-1 describes the columns that display in the Classification incident list.

<table>
<thead>
<tr>
<th>Table 45-1 Classification incident list columns</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column</td>
</tr>
<tr>
<td>Type</td>
</tr>
<tr>
<td>Column</td>
</tr>
<tr>
<td>------------------------</td>
</tr>
<tr>
<td>Subject/Sender/Recipient(s)</td>
</tr>
<tr>
<td>Sent</td>
</tr>
<tr>
<td>ID/Policy</td>
</tr>
<tr>
<td>Matches</td>
</tr>
<tr>
<td>Severity</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Status</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

**Classification incident snapshot**

A Classification incident snapshot provides detailed information about a particular incident. It displays general incident information, matches detected in the intercepted text, and details about attributes, incident history, and the violated policy. You can also search for similar incidents in the Correlations area.
Classification test mode is used only to verify policy matches. During normal production operations, Classification test mode should be disabled.

See “Classification incident list” on page 1000.

Current status and severity appear under the snapshot heading. To change one of the current values, click on it and choose another value from the drop-down list. If any action icon is associated, it also appears here.

Table 45-2 describes the incident the information that is presented in the snapshot.

<table>
<thead>
<tr>
<th>Tab Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Key Info** | The Key Info tab shows the policy that was violated in the incident. It also shows the total number of matches for the policy, as well as matches per policy rule. Click the policy name to view a list of all incidents that violated the policy. Click view policy to view a read-only version of the policy. This section also lists other policies that the same file violated. To view the snapshot of an incident that is associated with a particular policy, click go to incident next to the policy name. To view a list of all incidents that the file created, click show all. The Key Info tab also includes the following information:  
- The name of the detection server that recorded the incident.  
- The date and time the message was sent  
- The sender email or IP address  
- The recipient email or IP address(es)  
- The SMTP heading or the NNTP subject heading  
- The Is Archived field displays the archived state of the incident and whether or not the incident is archivable. It also lets you toggle the Do Not Archive flag for the incident.  
- Attachment file name(s). Click to open or save the file. If a response rule tells Symantec Data Loss Prevention to discard the original message, you cannot view the attachment. |
<p>| <strong>History</strong> | View the actions that were performed on the incident. For each action, Symantec Data Loss Prevention displays the action date and time, the actor (a user or server), and the action or the comment. |</p>
<table>
<thead>
<tr>
<th>Tab Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notes</td>
<td>View any notes that you or others have added to the incident. Click <strong>Add Note</strong> to add a note.</td>
</tr>
<tr>
<td>Correlations</td>
<td>You can view a list of those incidents that share attributes of the current incident. For example, you can view a list of all incidents that a single account generated. The <strong>Correlations</strong> tab shows a list of correlations that match single attributes. Click on attribute values to view lists of those incidents that are related to those values. To search for other incidents with the same attributes, click <strong>Find Similar</strong>. In the <strong>Find Similar Incidents</strong> dialog box that appears, select the desired search attributes. Then click <strong>Find Incidents</strong>. <strong>Note:</strong> The list of correlated incidents does not display related incidents that have been archived.</td>
</tr>
</tbody>
</table>

Beneath the general information, Symantec Data Loss Prevention displays the message content (if applicable) and the matches that caused the incident.

Matches are highlighted in yellow and organized according to the message component (such as header, body, or attachment) in which they were detected. Symantec Data Loss Prevention displays the total relevant matches for each message component. It shows matches by the order in which they appear in the original text. To view the rule that triggered a match, click on the highlighted match.
Managing and reporting incidents

This chapter includes the following topics:

- About Symantec Data Loss Prevention reports
- About strategies for using reports
- Setting report preferences
- About incident reports
- About dashboard reports and executive summaries
- Viewing dashboards
- Creating dashboard reports
- Configuring dashboard reports
- Choosing reports to include in a dashboard
- About summary reports
- Viewing summary reports
- Creating summary reports
- Viewing incidents
- About custom reports and dashboards
- Using IT Analytics to manage incidents
- Filtering reports
- Saving custom incident reports
- Scheduling custom incident reports
- Delivery schedule options for incident and system reports
- Delivery schedule options for dashboard reports
- Using the date widget to schedule reports
- Editing custom dashboards and reports
- Exporting incident reports
- Exported fields for Network Monitor
- Exported fields for Network Discover
- Exported fields for Mobile Prevent for Web
- Exported fields for Endpoint Discover
- Deleting incidents
- Deleting custom dashboards and reports
- Common incident report features
- Page navigation in incident reports
- Incident report filter and summary options
- Sending incident reports by email
- Printing incident reports
- Incident snapshot history tab
- Incident snapshot attributes section
- Incident snapshot correlations tab
- Incident snapshot policy section
- Incident snapshot matches section
- Incident snapshot access information section
- Customizing incident snapshot pages
- About filters and summary options for reports
- General filters for reports
Use incident reports to track and respond to incidents. Symantec Data Loss Prevention reports an incident when it detects data that matches the detection parameters of a policy rule.

Such data may include specific file content, an email sender or recipient, attachment file properties, or many other types of information.

Each piece of data that matches detection parameters is called a match, and a single incident may include any number of individual matches.

You can set an incident archive flag on an incident to indicate that the incident has been archived. By default, archived incidents do not appear in incident reports, but you can include them in incident reports by setting Advanced Filters on the report. Including archived incidents in a report may slow down reporting activities. See “About incident archiving” on page 1065.

Symantec Data Loss Prevention tracks incidents for all detection servers. These servers include Network Discover Server, Network Monitor Server, Network Prevent for Email Server, Network Prevent for Web Server, Mobile Prevent for Web Server, and Endpoint Server.

You can specify the reports Symantec Data Loss Prevention displays in the navigation panel.

See “Setting report preferences” on page 1008.

Symantec Data Loss Prevention provides the following types of incident reports:

- Incident lists show the individual incident records that contain information such as severity, associated policy, number of matches, and status. You can click on any incident to see a snapshot containing more details. And you can select specific incidents or groups of incidents to modify or remediate.

- Summaries provide summary information about the incidents on your system. They are organized with either one or two summary criteria. A single-summary report is organized with a single summary criterion, such as the policy that is associated with each incident. A double-summary report is organized with two criteria, such as policy and incident status. By default, archived incidents do not appear in the counts that display in summary reports, but you can set Advanced Filters to include them.
Filters to include the archived incidents. (See “About incident archiving” on page 1065.)

- Dashboards combine information from several reports. They include graphs and incident totals representing the contents of various incident lists and summaries. Graphs can sometimes contain lists of high-severity incidents or lists of summary groups. You can click on report portlets (the individual tiles that contain report data) to drill down to the detailed versions of the reports.

Symantec Data Loss Prevention ships with executive summaries for Network, Endpoint, Mobile, and Discover incidents.

Executive summaries are very similar to dashboards. The difference between them is that you can customize a dashboard, but you cannot customize an executive summary.

You can create and save customized versions of all reports (except executive summaries) for continued use.

See “About custom reports and dashboards” on page 1019.

Symantec Data Loss Prevention displays reports in separate sections on the Incident Reports screen as follows:

- The Saved Reports section contains any shared reports that are associated with your current role. This section appears only if you or other users in your current role have created saved reports.
  See “About custom reports and dashboards” on page 1019.

- The Network section contains Symantec-provided incident lists, summaries, and dashboards for network incidents.

- The Mobile section contains Symantec-provided incident lists, summaries, and dashboards for mobile incidents.

- The Endpoint section contains Symantec-provided incident lists, summaries, and dashboards for endpoint incidents. Endpoint reports include the incidents that Endpoint captures, such as Endpoint Block and Endpoint Notify incidents. Incidents that Endpoint Discover captures appear in Discover reports.

- The Discover section contains Symantec-provided incident lists, summaries, and dashboards for Network Discover and Endpoint Discover incidents.

- The Users section contains the user list and user risk summary, which displays users and their associated Email and Endpoint incidents.

**About strategies for using reports**

Many companies configure their Symantec Data Loss Prevention reporting to accommodate the following primary roles:
An executive responsible for overall risk reduction who monitors risk trends and develops high-level initiatives to respond to those trends. The executive monitors dashboards and summary reports (to get a general picture of data loss trends in the organization). The executive also develops programs and initiatives to reduce risk, and communicates this information to policy authors and incident responders. The executive often monitors reports through email or some other exported report format.

Symantec Data Loss Prevention dashboards and summary reports let you monitor risk trends in your organization. These reports provide a high-level overview of incidents. Executives and managers can quickly evaluate risk trends and advise policy authors and incident responders how to address these trends. You can view existing summary reports and dashboards and create customized versions of these reports.

See “About dashboard reports and executive summaries” on page 1011. See “About summary reports” on page 1016.

An incident responder, such as an InfoSec Analyst or InfoSec Manager, who monitors and responds to particular incidents. The responder monitors incident reports and snapshots to respond to the incidents that are associated with a particular policy group, organizational department, or geographic location. The responder may also author policies to reduce risk. These policies can originate either at the direction of a risk reduction manager or based on their own experience tracking incidents.

See “About incident remediation” on page 940.

### Setting report preferences

You can specify the reports that Symantec Data Loss Prevention displays in the navigation panel for each of the report types.

**To set reporting preferences**

1. In the Enforce Server administration console, on the Incidents menu, click **All Reports**.
2. On the All Reports screen, click **Edit Preferences**.

The Edit Report Preferences screen lists any saved reports (for all your assigned roles).

The screen also lists Network, Endpoint, Mobile, and Discover reports.
3 To display a report in the list, check the Show Report box for that report. To remove a report from the list, clear Show Report for that report.

The selected list of reports displays in a left navigation panel for each of the types of reports.

For example, to see the list of Network reports, on the Incidents menu, click Network.

4 After changing your preferences, click Save.

See “About custom reports and dashboards” on page 1019.

About incident reports

Use incident reports to track and respond to incidents on your network. Symantec Data Loss Prevention reports an incident when it detects data that matches a detection rule in an active policy. Such data may include specific file content, an email sender or recipient, attachment file properties, or many other types of information. Each piece of data that matches a detection rule is called a match, and a single incident may include any number of individual matches.

Note: You can configure which reports appear in navigation panel. To do so, go to All Reports and then click on Edit Preferences.

Symantec Data Loss Prevention provides the following types of incident reports:

- **Incident lists**
  These show individual incident records containing information such as severity, associated policy, number of matches, and status. You can click on any incident to view a snapshot containing more details. You can select specific incidents or groups of incidents to modify or remediate.

- **Summaries**
  These show incident totals organized by a specific incident attribute such as status or associated policy. For example, a Policy Summary includes rows for all policies that have associated incidents. Each row includes a policy name, the total number of associated incidents, and incident totals by severity. You can click on any severity total to view the list of relevant incidents.

- **Double summaries**
  These show incident totals organized by two incident attributes. For example, a policy trend summary shows the total incidents by policy and by week. Similar to the policy summary, each entry includes a policy name, the total number of associated incidents, and incident totals by severity. In addition, each entry includes a separate line for each week, showing the week's incident totals and incidents by severity.
### Dashboards and executive summaries

These are quick-reference dashboards that combine information from several reports. They include graphs and incident totals representing the contents of various incident lists, summaries, and double summaries. Graphs are sometimes beside lists of high-severity incidents or lists of summary groups. You can click on constituent report names to drill down to the reports that are represented on the dashboard.

Symantec Data Loss Prevention ships with executive summaries for Network, Endpoint, and Discover reports, and these are not customizable. You can create dashboards yourself, and customize them as desired.

### Custom

Lists the shared reports that are associated with your current role. (Such reports appear only if you or other users in your current role have created them.)

### Network

Lists the network incident reports.

### Endpoint

Lists the Endpoint incident reports. Endpoint reports include incidents such as Endpoint Block and Endpoint Notify incidents.

Incidents from Endpoint Discover are included in Discover reports.

### Discover

Lists Network Discover and Endpoint Discover incident reports.

The folder risk report displays file share folders ranked by prioritized risk. The risk score is based on the relevant information from the Symantec Data Loss Prevention incidents plus the information from the VML Management Server.

See the *Symantec Data Loss Prevention Data Insight Implementation Guide*.

### Mobile

Lists Mobile Prevent for Web incident reports.

### Users

The User List lists the data users in your organization. The User Risk Summary lists all users with their associated Email and Endpoint incidents.

See “About custom reports and dashboards” on page 1019.

See “Common incident report features” on page 1039.

See “Network incident snapshot” on page 956.

See “Discover incident snapshots” on page 991.

See “Endpoint incident snapshot” on page 967.

See “Mobile incident snapshot” on page 978.

See “Network incident list” on page 950.

See “Discover incident lists” on page 995.
About dashboard reports and executive summaries

Dashboards and executive summaries are the quick-reference report screens that present summary information from several incident reports.

Symantec Data Loss Prevention ships with one executive summary each for Network, Endpoint, Mobile, and Discover incident reports.

See “About incident reports” on page 1009.

Dashboards and executive summaries have two columns of reports. The left column displays a pie chart or graph and an incident totals bar. The right column displays the same types of information as in the left column. The right column also displays either a list of the most significant incidents or a list of summary items with associated incident totals. The most significant incidents are ranked using severity and match count. You can click on a report to see the full report it represents.

Dashboards consist of up to six portlets, each providing a quick summary of a report you specify.

Symantec Data Loss Prevention includes three executive summaries (which are similar to dashboards): Executive Summary-Network, Executive Summary-Endpoint, Executive Summary-Mobile, and Executive Summary-Discover. (Dashboards and executive summaries share the same format, but executive summaries are not customizable.)

You can create customized dashboards for users with specific security responsibilities. If you choose to share a dashboard, the dashboard is accessible to all users in the role under which you create it. (Note that the Administrator user cannot create shared dashboards.)

Dashboards have two columns of report portlets (tiles that contain report data). Portlets in the left column display a pie chart or graph and the totals bar. Portlets in the right column display the same types of information as those in the left. However, they also display either a list of the most significant incidents or a list of summary criteria and associated incidents. The incidents are ranked using severity and match count. The summary criteria highlights any high-severity incident totals. You can choose up to three reports to include in the left column and up to three reports to include in the right column.

To create custom dashboards, click Incident Reports at the top of the navigation panel and, in the Incident Reports screen that appears, click Create Dashboard. The Administrator can create only private dashboards, but other users can decide whether to share a new dashboard or keep it private.
See “About custom reports and dashboards” on page 1019.

To edit the contents of any custom dashboard, go to the desired dashboard and click Customize near the top of the screen.

See “Configuring dashboard reports” on page 1014.

To display a custom dashboard at logon, specify it as the default logon report.

See “Setting report preferences” on page 1008.

### Viewing dashboards

This procedure shows you how to view a dashboard.

**To view a dashboard**

1. In the Enforce Server administration console, on the Incidents menu, click Incident Reports. Under Reports, click the name of a dashboard.

   Dashboards consist of up to six portlets that each provide a summary of a particular report.

   For example, the Executive Summary-Network dashboard consists of portlets for the Network Policy Summary, High Risk Senders, Protocol Summary, Top Recipient Domains, Status by Week, and Incidents - All.

2. To see the entire report for a portlet, click the portlet.

   Symantec Data Loss Prevention displays the appropriate incident list or summary report.

3. Browse through the incident list or summary report.

   See “Viewing incidents” on page 1018.

   See “About summary reports” on page 1016.

### Creating dashboard reports

You can create custom dashboards and reports.

If you are logged on as a user other than the administrator, Symantec Data Loss Prevention lets you choose whether to share your dashboard or keep it private.
To create a dashboard

1. In the Enforce Server administration console, on the Incidents menu, click Incident Reports.

2. On the Incident Reports screen that appears, click Create Dashboard. The Configure Dashboard screen appears.

3. Choose whether to share your dashboard or keep it private.

   If you choose to share a dashboard, the dashboard is accessible to all users assigned the role under which you create it.

   If you are logged on as Administrator, you do not see this choice.

   **Note:** Symantec Data Loss Prevention automatically designates all dashboards that the administrator creates as private.

   Click Next.

4. In the General section, for Name, type a name for the dashboard.

5. For Description, type an optional description for the dashboard.

6. In the Delivery Schedule section, you can regenerate and send the dashboard report to specified email accounts.

   If SMTP is not set up on your Enforce Server, you do not see the Delivery Schedule section.

   If you have configured your system to send alerts and reports, you can set a time to regenerate and send the dashboard report to specified email accounts.

   See “Configuring the Enforce Server to send email alerts” on page 146.

   If you have not configured Symantec Data Loss Prevention to send reports, skip to the next step.

   To set a schedule, locate the Delivery Schedule section and select an option from the Schedule drop-down list. (You can alternatively select No Schedule.)

   For example, select Send Weekly On.

   Enter the data that is required for your Schedule choice. Required information includes one or more email addresses (separated by commas). It may also include calendar date, time of day, day of the week, day of the month, or last date to send.

   See “Delivery schedule options for dashboard reports” on page 1027.
7 For the **Left Column**, you can choose what to display in a pie chart or graph. For the **Right Column**, you can also display a table of the information.  
See “Choosing reports to include in a dashboard” on page 1015.

Select a report from as many as three of the Left Column (Chart Only) drop-down lists. Then select a report from as many as three of the Right Column (Chart and Table) drop-down lists.

8 Click **Save**.

9 You can edit the dashboard later from the **Edit Report Preferences** screen.

To display a custom dashboard at logon, specify it as the default logon report on the **Edit Report Preferences** screen.

See “Editing custom dashboards and reports” on page 1029.

### Configuring dashboard reports

You can create the custom dashboards that are tailored for users with specific roles. Dashboards consist of up to six portlets, each providing a quick summary of a report you specify.

If you choose to share a dashboard, the dashboard is accessible to all users assigned the role under which you create it.

---

**Note:** The Administrator user cannot create shared dashboards.

---

**To configure a custom dashboard**

1. In the **General** section, for **Name**, type a name for the dashboard.
2. For **Description**, type an optional description for the dashboard.
In the **Delivery Schedule** section, you can regenerate and send the dashboard report to specified email accounts.

If SMTP is not set up on your Enforce Server, you do not see the **Delivery Schedule** section.

If you have configured your system to send alerts and reports, you can set a time to regenerate and send the dashboard report to specified email accounts.

See “Configuring the Enforce Server to send email alerts” on page 146.

If you have not configured Symantec Data Loss Prevention to send reports, skip to the next step.

To set a schedule, locate the **Delivery Schedule** section and select an option from the **Schedule** drop-down list. (You can alternatively select **No Schedule**.)

For example, select **Send Weekly On**.

Enter the data that is required for your **Schedule** choice. Required information includes one or more email addresses (separated by commas). It may also include calendar date, time of day, day of the week, day of the month, or last date to send.

See “Delivery schedule options for dashboard reports” on page 1027.

For the **Left Column**, you can choose what to display in a pie chart or graph. For the **Right Column**, you can also display a table of the information.

See “Choosing reports to include in a dashboard” on page 1015.

Select a report from as many as three of the Left Column (Chart Only) drop-down lists. Then select a report from as many as three of the Right Column (Chart and Table) drop-down lists.

Click **Save**.

You can edit the dashboard later from the **Edit Report Preferences** screen.

To display a custom dashboard at logon, specify it as the default logon report on the **Edit Report Preferences** screen.

See “Editing custom dashboards and reports” on page 1029.

### Choosing reports to include in a dashboard

Dashboards have two columns of report portlets.

Portlets in the left column display a pie chart or graph.

Portlets in the right column display the same information as those in the left. They also display either a list of the most significant incidents or a summary. Incidents
are ranked with severity and match count. You can display a list of summary criteria and associated incidents that highlight any high-severity incident totals.

You can choose up to three reports to include in the left column, and up to three reports to include in the right column.

To choose reports to include

1. Choose a report from as many as three of the **Left Column (Chart Only)** drop-down lists.
2. Choose a report from as many as three of the **Right Column (Chart and Table)** drop-down lists.
3. After you configure the dashboard, click **Save**.

See “Configuring dashboard reports” on page 1014.

### About summary reports

Symantec Data Loss Prevention provides two types of summary reports: single summaries and double summaries.

Single summaries show incident totals organized by a specific incident attribute such as status or associated policy. For example, a policy summary includes a row for each policy that has associated incidents. Each row includes a policy name, the total number of associated incidents, and incident totals by severity.

Double summaries show incident totals organized by two incident attributes. For example, a policy trend summary shows the total incidents which are organized with policy and week. As in a policy summary, each entry includes a policy name, the total number of associated incidents, and incident totals by severity. In addition, each entry includes a separate line for each week, showing the week’s incident totals and incidents by severity.

See “Summary options for incident reports” on page 1051.

You can create custom summary reports from any incident list.

### Viewing summary reports

This procedure shows you how to view a summary report.
To view a summary report

1 In the Enforce Server administration console, on the **Incidents** menu, select one of the types of reports.

For example, select **Network**, and then click **Policy Summary**.

The report consists of summary entries (rows) that are divided into several columns. The first column is named for the primary summary criterion. It lists primary and (for double summaries) secondary summary items. For example, in a **Policy Summary** this column is named **Policy** and it lists policies. Each entry includes a column for total number of associated incidents. It also includes columns showing the number of incidents of High, Medium, Low, and Informational severity. Finally, it includes a bar chart that represents the number of incidents by severity.

2 Optionally, you can sort the report alpha-numerically by a particular column’s data. To do so, click the wanted column heading. To sort in reverse order, click the column heading a second time.

3 To identify areas of potential risk, click the High column heading to display summary entries by number of high-severity incidents.

4 Click an entry to see a list of associated incidents. In any of the severity columns, you can click the total to see a list of incidents of the chosen severity.

See “Viewing incidents” on page 1018.

---

**Creating summary reports**

This procedure shows you how to create a summary report.

**To create a summary report from an incident list**

1 In the Enforce Server administration console, on the **Incidents** menu, select one of the types of reports, and then click an incident list.

For example, select **Discover**, and then the report **Incidents-All Scans**.

2 Click the **Advanced Filters & Summarization** bar (near the top of the report).

In **Summarize By** for the primary listbox and secondary listbox that appear, Symantec Data Loss Prevention displays all Symantec-provided criteria in alphabetical order. The criteria precedes any custom criteria the administrator has defined.

See “Summary options for incident reports” on page 1051.
3 Select a criterion from the primary listbox, and an optional criterion from the secondary listbox. For example, select **Policy Group** and then **Policy**. (Note that options in the secondary listbox appear only after you choose an option from the primary listbox.)

4 To create the summary report, click **Apply**.

Summary reports take their name from the primary summary criterion. If you rerun a report with new criteria, the report name changes accordingly.

5 Save the report.

See “Saving custom incident reports” on page 1022.

### Viewing incidents

Symantec Data Loss Prevention incident lists display the individual incident records with information about the incidents. You can click on any incident to see a snapshot containing more details. You can select specific incidents or groups of incidents to modify or remediate.

Symantec Data Loss Prevention provides incident lists for Network, Endpoint, and Discover incidents.

#### To view incidents

1 In the Enforce Server administration console, on the **Incidents** menu, select one of the types of reports.

   For example, select **Discover**. In the left navigation panel, click **Incidents-All Scans**.

   The incident list displays the individual incident records that contain information such as severity, associated policy, number of matches, and status.

2 Optionally, use report filters to narrow down the incident list.

   See “Filtering reports” on page 1021.

3 To view more details of a particular incident, click the incident.

   The incident snapshot appears, displaying general incident information, matches detected in the intercepted text, and details about policy, attributes, and incident history.

   You can also search for similar incidents from the **Correlations** tab.

4 Optionally, click through the incident snapshot to view more information about the incident.

   The following list describes the ways you can access more information through the snapshot:
You can find information about the policy that detected the incident. On the Key Info tab, the Policy Matches section displays the policy name. Click on the policy name to see a list of incidents that are associated with that policy. Click view policy to see a read-only version of the policy. This section also lists other violated policies with the same file or message. When multiple policies are listed, you can see the snapshot of an incident that is associated with a particular policy. Click go to incident next to the policy name. To see a list of all incidents that the file or message created, click show all.

You can view lists of the incidents that share various attributes with the current incident. The Correlations tab shows a list of correlations that match single attributes. Click on attribute values to see the lists of incidents that are related to those values. For example, the current network incident is triggered from a message from a particular email account. You can bring up a list of all incidents that this account created.

For most network incidents, you can access any attachments that are associated with the network message. To do so, locate the Attachments field in the Incident Details section of the snapshot and click the attachment file name.

For a detailed description of incident snapshots and the actions you can perform through them, see the online Help.

When you finish viewing incidents, you can exit the incident snapshot or incident list, or you can choose one or more incidents to remediate.

See “Remediating incidents” on page 943.

About custom reports and dashboards

You can filter and summarize reports, and then save them for continued use. When saving a customized report, you can configure Symantec Data Loss Prevention to send the report according to a specific schedule.

Symantec Data Loss Prevention displays the titles of customized reports under Incidents > Incident Reports.

The Incident Reports screen displays all out-of-the-box and custom reports available to your assigned role(s). The list includes shared custom reports and the dashboards that you or anyone else in your current role created. Several standard reports are available with Symantec Data Loss Prevention.

Symantec Data Loss Prevention displays each report’s name, associated product, and description. For custom reports, Symantec Data Loss Prevention indicates
whether the report is shared or private and displays the report generation and delivery schedule.

You can modify existing reports and save them as custom reports, and you can also create custom dashboards. Custom reports and dashboards are listed in the Saved Reports section of the navigation panel.

You can click any report on the list to re-run it with current data.

You can view and run custom reports for reports created by users who have any of the roles that are assigned to you. You can only edit or delete the custom reports that are associated with the current role. The only custom reports visible to the Administrator are the reports that the Administrator user created.

A set of tables lists all the options available for filtering and summarizing reports.

See “About summary reports” on page 1016.

See “Summary options for incident reports” on page 1051.

See “General filters for reports” on page 1047.

See “Advanced filter options for reports” on page 1056.

**Create Dashboard**  Lets you create a custom dashboard that displays summary data from several reports you specify. For users other than the Administrator, this option leads to the Configure Dashboard screen, where you specify whether the dashboard is private or shared. All Administrator dashboards are private.

See “Creating dashboard reports” on page 1012.

**Edit Preferences**  Lets you specify the report that displays at logon, as well as the reports that should appear in the navigation panel.

See “Editing custom dashboards and reports” on page 1029.

Saved (custom) reports associated with your role appear near the top of the screen.

The following options are available for your current role’s custom reports:

- Click this icon next to a report to display the save report or configure dashboard screen. You can change the name, description, or schedule, or (for dashboards only) change the reports to include.

See “Saving custom incident reports” on page 1022.

See “Configuring dashboard reports” on page 1014.
Click this icon next to a report to display the screen to change the scheduling of this report. If this icon does not display, then this report is not currently scheduled.

See “Saving custom incident reports” on page 1022.

Click this icon next to a report to delete that report. A dialog prompts you to confirm the deletion. When you delete a report, you cannot retrieve it. Make sure that no other role members need the report before you delete it.

Using IT Analytics to manage incidents

IT Analytics Solution is a Business Intelligence (BI) application that complements and expands upon the reporting that is offered by Symantec Data Loss Prevention. It provides multi-dimensional analysis and robust graphical reporting features to Symantec Management Platform. This functionality lets you create on-the-fly ad-hoc reports without advanced knowledge of databases or third-party reporting tools. IT Analytics provides this powerful on-the-fly ad-hoc reporting with pivot tables, precompiled aggregations for fast answers to typically long-running queries, and easy export to .PDF, Excel, .CSV and .TIF files.

The IT Analytics Solution is supported for Symantec Data Loss Prevention version 10.5 and later.

For more information, see the Data Loss Prevention Pack for Altiris IT Analytics Solution 7.1 SP2 from Symantec User Guide, available at the following URL: http://www.symantec.com/business/support/index?page=content&id=DOC5526&key=56005

Filtering reports

You can filter an incident list or summary report.

To filter an incident list

1 In the Enforce Server administration console, on the Incidents menu, select one of the types of reports.

For example, select Network, and then click Policy Summary.

2 In the Filter area, current filters are displayed, as well as options for adding and running other filters.
3 Modify the default filters as wanted. For example, from the Status filter drop-down lists, select Equals and New.

For Network, Mobile, and Endpoint reports, the default filters are Date and Status. For Discover reports, default filters are Status, Scan, and Target ID.

4 To add a new filter, select filter options from the drop-down lists. Click Advanced Filters & Summarization for additional options. Click Add Filter on the right, for additional filter options.

Select the filter type and parameters from left to right as if writing a sentence. For example, from the advanced filters, Add Filter options, select Policy and Is Any Of, and then select one or more policies to view in the report. Hold down Ctrl or Shift to select more than one item in the listbox.

5 Click Apply to update the report.

6 Save the report.

See “Saving custom incident reports” on page 1022.

Saving custom incident reports

After you summarize or filter a report, you can save it for continued use. When you save a customized report, Symantec Data Loss Prevention displays the report title under Saved Reports in the Incident Reports section. If a user chooses to share the report, Symantec Data Loss Prevention displays the report link only for users who belong to the same role as the user who created the report.

See “About custom reports and dashboards” on page 1019.

You can edit the report later on the Edit Preferences screen.

See “Editing custom dashboards and reports” on page 1029.

Optionally, you can schedule the report to be run automatically on a regular basis.

See “Scheduling custom incident reports” on page 1023.

To save a custom report

1 Set up a customized filter or summary report.

See “About custom reports and dashboards” on page 1019.

Click Save > Save As.

2 Enter a unique report name and describe the report. The report name can include up to 50 characters.
In the **Sharing** section, users other than the administrator can share a custom report.

**Note:** This section does not appear for the administrator.

The **Sharing** section lets you specify whether to keep the report private or share it with other role members. Role members are other users who are assigned to the same role. To share the report, select **Share Report**. All role members now have access to this report, and all can edit or delete the report. If your account is deleted from the system, shared reports remain in the system. Shared reports are associated with the role, not with any specific user account. If you do not share a report, you are the only user who can access it. If your account is deleted from the system, your private reports are deleted as well. If you log on with a different role, the report is visible on the **Incident Reports** screen, but not accessible to you.

Click **Save**.

**Scheduling custom incident reports**

Optionally, you can schedule a saved report to be run automatically on a regular basis.

You can also schedule the report to be emailed to specified addresses or to the data owners on a regular schedule.

See the *Symantec Data Loss Prevention Data Insight Implementation Guide*. 
To schedule a custom report

1. Click **Send > Schedule Distribution**.
   
   If SMTP is not set up on your Enforce Server, you are not able to select the **Send** menu item to send the report.
   
   See “Configuring the Enforce Server to send email alerts” on page 146.

2. Specify the **Delivery Details**:

   **To:**
   
   Select whether the report is sent to specified email addresses or to the data owners.

   **Manual - Sent to specified e-mail addresses**
   
   Enter the specific email addresses manually in the text box.

   **Auto - Send to incident data owners**
   
   To send the report to the data owners, the **Send report data with emails** setting must be enabled for this option to appear.
   
   See “Configuring the Enforce Server to send email alerts” on page 146.
   
   If you select to have the report sent to the incident data owners, then the email address in the incident attribute **Data Owner Email Address** is the address where the report is sent.

   This **Data Owner Email Address** must be set manually, or with a lookup plug-in.
   
   See the Symantec Data Loss Prevention Data Insight Implementation Guide.

   A maximum of 10000 incidents can be distributed per data owner.

   **CC:**
   
   Enter the email addresses manually in the text box.

   **Subject:**
   
   Use the default subject or modify it.

   **Body:**
   
   Enter the body of the email.

   Response action variables can also be entered in the body.

   See “Response action variables” on page 946.
3 In the Schedule Delivery section, specify the delivery schedule.

See “Delivery schedule options for incident and system reports” on page 1025.

4 In the Change Incident Status / Attributes section, you can implement workflow.

The Auto - Send to incident data owners option must be set for this section to appear.

See “Configuring the Enforce Server to send email alerts” on page 146.

5 After sending the report, you can change an incident's status to any of the valid values. Select a status value from the drop-down list.

6 You can also enter new values for any custom attributes.

These attributes must be already set up.

See “About incident status attributes” on page 1069.

7 Select one of the custom attributes from the drop-down list.

8 Click Add.

9 In the text box, enter the new value for this custom attribute.

After sending the report, the selected custom attributes set the new values for those incidents that were sent in the report.

10 Click Next.

11 Enter the name and description of the saved report.

12 Click Save.

Delivery schedule options for incident and system reports

The Schedule Delivery section lets you set up a schedule for the report.

---

Note: If your Enforce Server is not configured to send email, or you are not allowed to send reports, the Schedule Delivery section does not appear.

---

When you make a selection from the list, additional fields appear.

To remove scheduling of a report that was previously scheduled, click the Remove option.

The following table describes the additional fields available for each option on the list.
Specify the following delivery details:

- **Send To**
  Specify Manual to specify the email addresses.
  Specify Auto for automatic sending to data owners.
- **To**
  Enter one or more email addresses. Separate them with commas.
- **CC**
  Enter one or more email addresses. Separate them with commas.
- **Subject**
  Provide a subject for the email.
- **Body**
  Enter the body of the email. Use variables for items such as the policy name.
  See “Response action variables” on page 946.

**One time**
Select One time to schedule the report to be run once at a future time, and then specify the following details for that report:

- **Time**
  Select the time you want to generate the report.
- **Send Date**
  Enter the date you want to generate the report, or click the date widget and select a date.

**Daily**
Select Daily to schedule the report to be run every day, and then specify the following details for that report:

- **Time**
  Select the time you want to generate the report.
- **Until**
  Enter the date you want to stop generating daily reports, click the date widget and select a date, or select Indefinitely.

**Weekly**
Select Weekly to schedule the report to be run every week, and then specify the following details for that report:

- **Time**
  Select the time you want to generate the report.
- **Days of Week**
  Click to check one or more check boxes to indicate the day(s) of the week you want to generate the report.
- **Until**
  Enter the date you want to stop generating weekly reports, click the date widget and select a date, or select Indefinitely.
Monthly

Select Monthly on to schedule the report to be run every month, and then specify the following details for that report:

- **Time**
  Select the time you want to generate the report.

- **Day of Month**
  Enter the date on which you want to generate the report each month.

- **Until**
  Enter the date you want to stop generating monthly reports, click the date widget and select a date, or select Indefinitely.

See “Saving custom incident reports” on page 1022.

See “Working with saved system reports” on page 138.

Delivery schedule options for dashboard reports

The Delivery Schedule section lets you set up a schedule for the report.

---

**Note:** If your Enforce Server is not configured to send email, or you are not allowed to send reports, the Delivery Schedule section does not appear.

---

When you make a selection from the Schedule drop-down list, additional fields appear.

The following table describes the additional fields available for each option on the list:

<table>
<thead>
<tr>
<th>No Schedule</th>
<th>Select No Schedule to save the report without a schedule.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Once</td>
<td>Select Once to schedule the report to be run once at a future time, and then specify the following details for that report:</td>
</tr>
<tr>
<td></td>
<td>■ On</td>
</tr>
<tr>
<td></td>
<td>Enter the date you want to generate the report, or click the date widget and select a date.</td>
</tr>
<tr>
<td></td>
<td>■ At</td>
</tr>
<tr>
<td></td>
<td>Select the time you want to generate the report.</td>
</tr>
<tr>
<td></td>
<td>■ Send To</td>
</tr>
<tr>
<td></td>
<td>Enter one or more email addresses. Separate them with commas.</td>
</tr>
</tbody>
</table>
Select **Send Every Day** to schedule the report to be run every day, and then specify the following details for that report:

- **At**
  Select the time you want to generate the report.

- **Until**
  Enter the date you want to stop generating daily reports, click the date widget and select a date, or select **Indefinitely**.

- **Send To**
  Enter one or more email addresses. Separate them with commas.

Select **Send Weekly** on to schedule the report to be run every week, and then specify the following details for that report:

- **Day**
  Click to check one or more check boxes to indicate the day(s) of the week you want to generate the report.

- **At**
  Select the time you want to generate the report.

- **Until**
  Enter the date you want to stop generating weekly reports, click the date widget and select a date, or select **Indefinitely**.

- **Send To**
  Enter one or more email addresses. Separate them with commas.

Select **Send Monthly** on to schedule the report to be run every month, and then specify the following details for that report:

- **Day of each month**
  Enter the date on which you want to generate the report each month.

- **At**
  Select the time you want to generate the report.

- **Until**
  Enter the date you want to stop generating monthly reports, click the date widget and select a date, or select **Indefinitely**.

- **Send To**
  Enter one or more email addresses. Separate them with commas.

See “**Configuring dashboard reports**” on page 1014.
Using the date widget to schedule reports

The date widget specifies dates for reports. The date widget enters the date for you. You can click Today to enter the current date.

To use the date widget

1. Click the date widget.
2. Click the left arrow or the right arrow on either side of the month to change the month.
3. Click the left arrow or the right arrow on either side of the year to change the year.
4. Click the desired date on the calendar.

Editing custom dashboards and reports

You can edit any custom report or dashboard that you create.

To edit a custom dashboard or report

1. In the Enforce Server administration console, on the Incidents menu, select Incident Reports.
   The Incident Reports dashboard appears and displays Saved Reports near the top.
2. Click the edit icon next to the report or dashboard to edit.
   The Save Report screen or the Save Dashboard screen appears. You can edit the name, description, and schedule of any custom report or dashboard, and you can select different component reports for a custom dashboard.
   See “Saving custom incident reports” on page 1022.
3. When you finish editing, click Save.

Exporting incident reports

A report can be exported to a comma-separated text (.csv) file or to an XML file. You can set up a CSV delimiter other than a comma. You can specify which fields are exported to XML. These options must be set in your profile before you export a report.

See “Editing a user profile” on page 60.
To export a report

1. Click **Incidents**, and select a type of report.
2. Navigate to the report that you want to export. Filter or summarize the incidents in the report, as desired.
   
   See “Common incident report features” on page 1039.
3. Check the boxes on the left side of the incidents to select the incidents to export.
4. In the **Export** drop-down, select **Export All: CSV** or **Export All: XML**

   **Note:** The XML schema files for exported reports are located in the C:\SymantecDLP\Protect\tomcat\lib\incidentapi-2011-schema.jar file.

   See the **Reporting API Developers Guide** for a description of individual XML elements.

5. Click **Open** or **Save**. If you selected **Save**, a **Save As** dialog box opens, and you can specify the location and the file name.

   See “Exported fields for Network Monitor” on page 1030.

   See “Exported fields for Endpoint Discover” on page 1033.

   See “Exported fields for Network Discover” on page 1031.

   See “Exported fields for Mobile Prevent for Web” on page 1032.

   See “Printing incident reports” on page 1042.

   See “Sending incident reports by email” on page 1041.

### Exported fields for Network Monitor

The following fields are exported for Network Monitor:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td>Incident type (for example <strong>SMTP</strong>, <strong>HTTP</strong>, or <strong>FTP</strong>).</td>
</tr>
<tr>
<td><strong>Message Status</strong></td>
<td>Status of this incident message.</td>
</tr>
<tr>
<td><strong>Severity</strong></td>
<td>Severity of this incident (<strong>High</strong>, <strong>Medium</strong>, or <strong>Low</strong>).</td>
</tr>
<tr>
<td><strong>Sent</strong></td>
<td>Date and time the message was sent.</td>
</tr>
<tr>
<td><strong>ID</strong></td>
<td>Unique identifier for this incident.</td>
</tr>
</tbody>
</table>
### Exported fields for Network Discover

The following fields are exported for Network Discover:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Policy</td>
<td>Name of the policy that triggered this incident.</td>
</tr>
<tr>
<td>Matches</td>
<td>The number of times that this item matches the detection parameters of a policy rule.</td>
</tr>
<tr>
<td>Subject</td>
<td>Subject of the message.</td>
</tr>
<tr>
<td>Recipient(s)</td>
<td>Recipient of the message.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of this incident (New, Escalated, Dismissed, or Closed).</td>
</tr>
<tr>
<td>Has Attachment</td>
<td>Indicates if this message has an attachment.</td>
</tr>
<tr>
<td>Data Owner Name</td>
<td>The person responsible for remediating the incident. This field must be set manually, or with one of the lookup plug-ins. Reports can automatically be sent to the data owner for remediation.</td>
</tr>
<tr>
<td>Data Owner Email</td>
<td>The email address of the person responsible for remediating the incident. This field must be set manually, or with one of the lookup plug-ins.</td>
</tr>
</tbody>
</table>

Custom attributes are also exported.
The number of times that this item matches the detection parameters of a policy rule.

Location (path) of this item.

Status of this incident (New, Escalated, Dismissed, or Closed).

Name of the scan target.

Date and time when the file was scanned.

Owner of the file.

Date and time when the item was last modified.

Date and time when the item was created.

Date and time when the item was last accessed.

The person responsible for remediating the incident. This field must be set manually, or with one of the lookup plug-ins.

The email address of the person responsible for remediating the incident. This field must be set manually, or with one of the lookup plug-ins.

Custom attributes are also exported.

Exported fields for Mobile Prevent for Web

The following fields are exported for Mobile Prevent for Web:

Type Incident type (for example HTTP/S or FTP).

Message Status Status of this incident message.

Severity Severity of this incident (High, Medium, or Low).

Sent Date and time the message was sent.

ID Unique identifier for this incident.

Policy Name of the policy that triggered this incident.
The number of times that this item matches the detection parameters of a policy rule.

**Subject**
Subject of the message.

**Recipient(s)**
Recipient of the message.

**Status**
Status of this incident (New, Escalated, Dismissed, or Closed).

**Has Attachment**
Indicates if this message has an attachment.

**Data Owner Name**
The person responsible for remediating the incident. This field must be set manually, or with one of the lookup plug-ins.

Reports can automatically be sent to the data owner for remediation.

**Data Owner Email**
The email address of the person responsible for remediating the incident.

This field must be set manually, or with one of the lookup plug-ins.

---

### Exported fields for Endpoint Discover

The following fields are exported for Endpoint Discover:

**Type**
Target type (for example Removable Storage).

**Severity**
Severity of this incident (High, Medium, or Low).

**Occurred On**
Date that an incident was detected.

**ID**
Unique identifier for this incident.

**Policy**
Name of the policy that triggered this incident.

**Matches**
The number of times that this item matches the detection parameters of a policy rule.

**Status**
Status of this incident (New, Escalated, Dismissed, or Closed).

**File Name**
Name of the file that violated the policy.

**File Path**
Path of the file.

**Note:** The file location appears only for fixed drive incidents.

**Machine**
Computer on which the incident occurred.

**User**
Endpoint user name.
Deleting incidents

Incident reporting performance often deteriorates when the number of incidents in your system exceeds one million (1,000,000). Symantec recommends keeping your incident count below this threshold by deleting incidents to maintain good system performance.

Incident deletion is permanent: you can delete incidents, but you cannot recover the incidents that you have deleted. Symantec Data Loss Prevention offers options for deleting only certain parts of the data that triggered the incident.

After you have marked incidents for deletion, you can view, configure, run, and troubleshoot the incident deletion process from the Enforce Server administration console.

For information about deleting archived incidents, See “Deleting archived incidents” on page 1068.

To delete an incident

1. On the Incident Report screen, select the incident or incidents you want to delete, then click Incident Actions > Delete Incidents.
2. On the Delete Incidents screen, select from the following deletion options:

   - **Delete incident completely**: Permanently deletes the incident(s) and all associated data (for example, any emails and attachments). Note that you cannot recover the incidents that have been deleted.
Retains the actual incident(s) but discards the Symantec Data Loss Prevention copy of the data that triggered the incident(s). You have the option of deleting only certain parts of the associated data. The rest of the data is preserved.

Delete Original Message

Deletes the message content (for example, the email message or HTML post). This option applies only to Network incidents.

Delete Attachments/Files

This option refers to files (for Endpoint and Discover incidents) or email or posting attachments (for Network incidents). The options are:

- **All**, which deletes all attachments. Choose this option to delete all files (for Endpoint and Discover incidents) or email attachments (for Network incidents). Attachments and files are added to the incident deletion queue after their associated incidents have been deleted.

- **Attachments/Files with no violations**. This option deletes only those attachments in which Symantec Data Loss Prevention found no matches. Choose this option when you have incidents with individual files taken from a compressed file (Endpoint and Discover incidents) or several email attachments (Network incidents).

3 Click **Cancel** or **Delete**.

**Delete** marks the incident for deletion and adds it to the incident deletion queue. You cannot recover an incident after it has been marked for deletion. Symantec Data Loss Prevention permanently deletes the incidents in the incident deletion queue when it runs the incident deletion job.

**About the incident deletion process**

You can view, configure, run, and troubleshoot the incident deletion process on the **Incident Deletion** screen of the Enforce Server administration console: **System > Incident Data > Incident Deletion**. This screen shows you the number of incidents in the incident deletion queue, the deletion schedule, and a history of deletion jobs.

The incident deletion queue includes all incidents marked for deletion by all your Symantec Data Loss Prevention users. In addition to viewing the number of incidents marked for deletion, you can start and stop a deletion job manually from the incident deletion queue.

You can view detailed information about your deletion jobs in the deletion jobs history section, including the number of incidents and attachments or files deleted, the job start and end time, the job duration, whether or not the job was stopped.
manually, and the job status (Completed, Failed, or In Progress). In the case of failed deletion jobs, you can click the Failed link to see the error message and problem statement. This information may be useful to your Oracle database administrator in troubleshooting the job failure. If this information is insufficient to resolve your deletion job issues, you can export information from any job to a CSV file and send it to Symantec Data Loss Prevention Support for additional help.

By default, the incident deletion job runs nightly at 11:59 P.M. in the Enforce Server’s local time zone. When the job runs, it also creates an event on the System > Server > Events screen. This event is created whether or not any incidents are actually deleted.

Configuring the incident deletion job schedule

The default incident deletion job schedule is daily at 11:59 P.M. in the Enforce Server’s local time zone. You can configure the deletion job schedule to run at any other scheduled time. Symantec suggests running your incident deletion at a time when your system is idle or not in heavy use.

To configure the incident deletion job schedule

1. Click the Schedule Deletion Job calendar icon.
2. In the Schedule Incident Deletion dialog box, specify one of the following options:
   - **No Regular Schedule**: Select this option to turn off the deletion job schedule.
   - **Once**: Specify a day and time for a single incident deletion job.
   - **Daily**: Specify a daily time for incident deletion jobs.
   - **Weekly**: Specify a day and time for incident deletion jobs. To accommodate differences between months, the day value must be between 1 and 28.
   - **Monthly**: Specify a day of the month and time for incident deletion jobs.
3. Click Submit.

**Note:** The incident deletion job schedule is reset to the default value during the upgrade process. If you are using a custom incident deletion job schedule, reconfigure the schedule after the upgrade process is complete.
Starting and stopping incident deletion jobs

If there are incidents pending deletion, you can start an incident deletion job manually from the incident deletion queue. You can also stop any incident deletion job that is currently running.

To start and stop incident deletions job manually

1. Click Start Deletion to start an incident deletion job manually.
2. When an incident deletion job is running, the progress bar will show you how many incidents have been deleted.
3. Click Stop Deletion to stop an incident deletion job.

The progress bar refreshes every 30 seconds by default. If you are deleting a large number of incidents (over 500,000), the refresh process may degrade the performance of the deletion job. You can adjust the refresh rate in the manager.properties file.

To configure the progress bar refresh rate

1. Open the manager.properties file:
   - On Windows systems:
     \SymantecDLP\Protect\config\manager.properties
   - On Linux systems:
     /opt/SymantecDLP/Protect/config/manager.properties
2. Set a new value in milliseconds for the com.vontu.incident.deletion.progress.refreshRate property. For example, to set the refresh rate to two minutes (120 seconds):
   
   com.vontu.incident.deletion.progress.refreshRate=120000
3. Save and close the manager.properties file, then restart the Vontu Manager service.

See “About Data Lost Prevention services” on page 76.

Working with the deletion jobs history

The deletion jobs history section shows you your previously run incident deletion jobs, including:

- The number of incidents deleted.
- The number of attachments and files deleted.
- The deletion job start and end time.
- The deletion job duration.
- Whether or not the deletion job was stopped manually.
- The deletion job status.

If a deletion job failed, a link will appear in the status column. Click the link to see the error message and problem statement. This information may be useful to your Oracle database administrator for troubleshooting a failed deletion job.

If you are having trouble troubleshooting incident deletion job issues, you can export detailed deletion job information to send to Symantec Data Loss Prevention Support.

To view and export failed deletion job information

1. In the Deletion jobs history list, click the Failed link for the failed job you want to view.
   
   The error message and problem statement that appear may be useful to your Oracle database administrator for troubleshooting your incident deletion job issues. If you need additional help, continue to step 2.

2. To export information for a failed deletion job, select the job in the Deletion jobs history list, then click Export.

3. Save the ZIP file to send to Symantec Data Loss Prevention Support for analysis. The data contained in the ZIP file is intended for use by Symantec Data Loss Prevention Support only, and will not be helpful for your in-house troubleshooting efforts.

Deleting custom dashboards and reports

You can delete any custom report or dashboard that you create.

To delete a custom dashboard or report

1. In the Enforce Server administration console, on the Incidents menu, select Incident Reports.
   
   The Incident Reports dashboard appears and displays Saved Reports near the top.

2. Click the delete icon next to the report or dashboard to delete it.

3. Click OK to confirm.

4. Symantec Data Loss Prevention deletes the report, and removes it from the Incident Reports screen.
Common incident report features

The following options are common to incident report lists:

- Icons to perform the following tasks for a report:
  - **Save**
    
    You can save the current report as a custom saved report.
    
    See “Saving custom incident reports” on page 1022.
  - **Send**
    
    You can email the report or schedule the report distribution.
    
    See “Saving custom incident reports” on page 1022.
  - **Export**
    
    You can export the current report as CSV or XML.
    
    See “Exporting incident reports” on page 1029.
  - **Delete Report**
    
    If this report is not a saved report, then the **Delete Report** option does not appear.

- Report filters and summary options
  
  See “Incident report filter and summary options” on page 1040.

- Page navigation icons
  
  See “Page navigation in incident reports” on page 1039.

The following summary reports are available for the types of incidents:

- **Network**
  
  See “Network summary report” on page 961.

- **Endpoint**
  
  See “Endpoint incident summary reports” on page 975.

- **Discover**
  
  See “Discover summary reports” on page 999.

- **Mobile**
  
  See “Mobile summary report” on page 986.

Page navigation in incident reports

All reports except executive summaries include page navigation options. Symantec Data Loss Prevention displays the number of currently visible incidents out of total report incidents (for example, 1-19 of 19 or 1-50 of 315).

Reports with more than 50 incidents have the following options:
Incident report filter and summary options

Filters are separated into commonly used filters, and advanced filters and summarizations.

The common filters include the following options:

**Status**
Select **Equals, Is Any Of, or Is None Of**. Then select status values. Hold down **Ctrl** and click to select more than one separate status value. Hold down **Shift** and click to select a range.

**Date**
Use the drop-down menu to select a date range, such as **Last Week** or **Last Month**. The default is **All Dates**.

**Network and Endpoint reports**

**Severity**
Check the boxes to select the severity values.

**Scan**
For Discover reports, select the scan to report. You can select the most recent scan, the initial scan, or a scan in progress. **All Scans** is the default.
Target ID

For Discover reports, select the name of the target to report. All Targets is the default.

Click the Advanced Filters & Summarization bar to expand the section with filter and summary options.

Click Add Filter to add an advanced filter.

Select a primary and optional secondary option for summarization. A single-summary report is organized with a single summary criterion, such as the policy that is associated with each incident. A double-summary report is organized with two criteria, such as policy and incident status.

**Note:** If you select a condition in which you enter the content to be matched in the text field, your entire entry must match exactly. For example, if you enter "apples and oranges", that exact text must appear in the specified component for it to be considered a match. The sentence "Bring me the apples and the oranges" is not considered a match.

For a complete list of the report filter and summary options, see the Symantec Data Loss Prevention Administration Guide.

See “Common incident report features” on page 1039.

### Sending incident reports by email

You can send a copy of the current report to any email address.

To send reports, your system administrator must configure an SMTP server. The Administrator must specify a report distribution option on the System > Settings page. You must also specify an email address for your user account.

See “Configuring the Enforce Server to send email alerts” on page 146.

**To send a report**

1. Click Incidents, and select a type of report.

2. Navigate to the report that you want to export. Filter or summarize the incidents in the report, as desired.

   See “Common incident report features” on page 1039.

3. Click Send in the upper right corner.

   Alternatively, you can use the Send menu (above the filters).

   See “Saving custom incident reports” on page 1022.
4 In the **Send Report** dialog box, specify the following options:

- **To** Enter one or more email addresses (comma-separated).
- **Subject** Enter a subject for the message.
- **Message** Enter the message.

5 Click **Send** or **Cancel**.

See “Printing incident reports” on page 1042.

See “Exporting incident reports” on page 1029.

---

**Printing incident reports**

You can print a report to any available printer.

**To print a report**

1 Click **Incidents**, and select a type of report.

2 Navigate to the report that you want to export. Filter or summarize the incidents in the report, as desired.

   See “Common incident report features” on page 1039.

3 Click **Print** in the upper right corner.

4 An image of the report appears in a browser window.

5 The printer selection dialog box appears, and you can select a printer.

See “Sending incident reports by email” on page 1041.

See “Exporting incident reports” on page 1029.

---

**Incident snapshot history tab**

You can view the actions that were performed on the incident. For each action, the History tab displays the action date and time, the actor (a user or server), and the action or the comment. Click **Add Comment** to add a comment.

See “Discover incident snapshots” on page 991.

See “Network incident snapshot” on page 956.

See “Endpoint incident snapshot” on page 967.

See “Mobile incident snapshot” on page 978.
Incident snapshot attributes section

You can view a list of custom attributes and their values, if any have been specified. Click on attribute values to view an incident list that is filtered on that value. To add new values or edit existing ones, click Edit. In the Edit Attributes dialog box that appears, type the new values and click Save. Archived incidents are not displayed in the filtered list.

**Note:** This section appears only if a system administrator has configured custom attributes.

- See “Discover incident snapshots” on page 991.
- See “Endpoint incident snapshot” on page 967.
- See “Network incident snapshot” on page 956.
- See “Mobile incident snapshot” on page 978.

Incident snapshot correlations tab

You can view lists of the incidents that share various attributes of the current incident.

For example, if the copying of a file triggered the current incident, you can bring up a list of all the incidents that are related to the copying of this file. The Correlations tab shows a list of correlations that are matched to single attributes. Click on attribute values to view lists of the incidents that are related to those values.

To search for other incidents with the same attributes, click Find Similar. In the Find Similar Incidents dialog box that appears, select the desired search attributes. Then click Find Incidents. Archived incidents are not displayed when you search for similar incidents.

- See “Discover incident snapshots” on page 991.
- See “Endpoint incident snapshot” on page 967.
- See “Network incident snapshot” on page 956.
- See “Mobile incident snapshot” on page 978.

Incident snapshot policy section

The Policy area shows the policy that was violated in the incident and indicates if the policy blocked a move or notified the user. It also shows the total number of matches for the policy, as well as matches per policy rule. Click the policy name to
view a list of all incidents that violated the policy. Click view policy to view a read-only version of the policy.

You see the icons that describe the following information:

- Symantec Data Loss Prevention blocked a copy of the sensitive information.
- Symantec Data Loss Prevention notified the user about the copy of confidential data.

This section also lists other policies that are violated from the same file. To view the snapshot of an incident that is associated with a particular policy, click the Go to Incident link next to the policy name. To view a list of all incidents that are related to the file, click show all.

See "Discover incident snapshots" on page 991.
See "Endpoint incident snapshot" on page 967.
See “Network incident snapshot” on page 956.
See “Mobile incident snapshot” on page 978.

**Incident snapshot matches section**

In the **Matches** section, Symantec Data Loss Prevention displays the content (if applicable) and the matches that caused the incident.

Matches are highlighted in yellow. This section shows the match total and displays the matches in the order in which they appear in the original content. To view the rule that triggered a match, click on the highlighted match.

See "Discover incident snapshots" on page 991.
See “Endpoint incident snapshot” on page 967.
See “Network incident snapshot” on page 956.
See “Mobile incident snapshot” on page 978.
See “About the Similarity Threshold and Similarity Score” on page 512.

**Incident snapshot access information section**

The **Access Information** section of an incident snapshot shows the Access Control Lists for that object.

Access Control Lists (ACL) are lists of the permissions that are attached to an object or piece of data. The list contains information about all users who have read and write permissions for the file. Use the list to view which users have access to the file as well as which actions each user can perform. The permissions for each user
or group are not set through Symantec Data Loss Prevention. Administrators set the permissions for each file using other types of programs on the endpoint. Permissions are generally set at the time that the file is created.

For example, User 1 has permission to access the file Example1.doc. User 1 can view and edit the file. User 2 also has access to the file Example1.doc. However, User 2 can only view the file. User 2 does not have permission to make changes to the file. In the ACL, both User 1 and User 2 are listed with the permissions that have been granted to them.

Table 46-1 shows the combinations.

Table 46-1  Access control list example

<table>
<thead>
<tr>
<th>Name</th>
<th>Permission</th>
</tr>
</thead>
<tbody>
<tr>
<td>User 1</td>
<td>GRANT READ</td>
</tr>
<tr>
<td>User 1</td>
<td>GRANT WRITE</td>
</tr>
<tr>
<td>User 2</td>
<td>GRANT READ</td>
</tr>
</tbody>
</table>

The ACL contains a new line for each permission granted. The ACL only contains one line for User 2 because User 2 only has one permission, to read the file. User 2 cannot make any changes to the file. User 1 has two permissions: reading the file and editing it.

You can view ACL information only on Discover and Endpoint local drive incident snapshots. You cannot view ACL information on any other type of incidents.

The Access Information section appears on the Key Info tab of the incident snapshot.

See “Discover incident snapshots” on page 991.

See “Endpoint incident snapshot” on page 967.

See “Network incident snapshot” on page 956.

See “Mobile incident snapshot” on page 978.

Customizing incident snapshot pages

You can customize the appearance of the incident snapshot page.
To customize the appearance of the incident snapshot page

1. From an incident snapshot, click **Customize Layout** (in the upper-right corner).
2. Select the information to appear on each of the tabs in the incident snapshots.
   - **Tab 1** always contains the **Key Info**, and cannot be changed.
3. For each of the areas on the incident snapshot screen, select the information that appears.
4. Click **Save**.

**About filters and summary options for reports**

You can set a number of filters and summaries for Symantec Data Loss Prevention incident reports.

These filters let you see the incidents and incident data in different ways.

The set of filters apply separately to Network, Endpoint, Mobile, and Storage events.

**Figure 46-1** shows the locations of the options to filter and summarize reports.

![Filter and summary options](image-url)
The filters and summary options are in the following sections:

**General filters**
- The general filter options are the most commonly used. They are always visible in the incident list report. See “General filters for reports” on page 1047.

**Advanced filters**
- The advanced filters provide many additional filter options. You must click the Advanced Filters & Summarization bar, and then click Add Filter to view these filter options. See “Advanced filter options for reports” on page 1056.

**Summary options**
- The summary options provide ways to summarize the incidents in the list. You must click the Advanced Filters & Summarization bar to view these summary options. See “Summary options for incident reports” on page 1051.

Symantec Data Loss Prevention contains many standard reports. You can also create custom reports or save report summary and filter options for reuse. See “About Symantec Data Loss Prevention reports” on page 1006.

### General filters for reports

General filters for reports include a set of a few common filters.

Most of these filters are applicable for all the products. Network Discover contains some general filters that relate to scans of storage. For example, you can filter the incidents that are in a particular scan. These filters are not applicable to Network Prevent or Endpoint Prevent.

**Table 46-2** lists the general filter options for report status values.

You can also create custom status values. See “About incident status attributes” on page 1069.

These status filters are available for Network, Endpoint, Mobile, and Discover incidents.
Table 46-2  General filters for status values

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equals</td>
<td>The status is equal to the field that is selected in the next drop-down.</td>
</tr>
<tr>
<td>Is Any Of</td>
<td>The status can be any of the fields that are selected in the next drop-down.</td>
</tr>
<tr>
<td>Is None Of</td>
<td>The status is none of the fields that are selected in the next drop-down.</td>
</tr>
</tbody>
</table>

Table 46-3 lists the general filter options by date.

These date filters are available for Network, Mobile, and Endpoint incidents.

Table 46-3  General filters by date

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Dates</td>
<td>All of the dates that contain incidents.</td>
</tr>
<tr>
<td>Current Month to Date</td>
<td>All of the incidents that were reported for the current month up to today's date.</td>
</tr>
<tr>
<td>Current Quarter to Date</td>
<td>All of the incidents that were reported for the current quarter up to today's date.</td>
</tr>
<tr>
<td>Current Week to Date</td>
<td>All of the incidents that were reported for the current week.</td>
</tr>
<tr>
<td>Current Year to Date</td>
<td>All of the incidents that have been reported for the current year up to today's date.</td>
</tr>
<tr>
<td>Custom</td>
<td>A custom time frame. Select the dates that you want to view from the calendar menu.</td>
</tr>
<tr>
<td>Last 7 Days</td>
<td>All of the incidents that were reported in the previous seven days.</td>
</tr>
<tr>
<td>Last 30 Days</td>
<td>All of the incidents that were reported in the previous 30 days.</td>
</tr>
<tr>
<td>Last Month</td>
<td>All of the incidents that were reported during the previous calendar month.</td>
</tr>
<tr>
<td>Last Week</td>
<td>All of the incidents that were reported during the previous calendar week.</td>
</tr>
<tr>
<td>Last Quarter</td>
<td>All of the incidents that were reported during the previous quarter.</td>
</tr>
<tr>
<td>Last Year</td>
<td>All of the incidents that were reported during the last calendar year.</td>
</tr>
</tbody>
</table>
Table 46-3  General filters by date (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Today</td>
<td>All of the incidents that were reported today.</td>
</tr>
<tr>
<td>Yesterday</td>
<td>All of the incidents that were reported yesterday.</td>
</tr>
</tbody>
</table>

Table 46-4 lists the general filter options by severity. Check the box to select the severities to include in the filter.

These severity filters are available for Network, Endpoint, Mobile, and Discover incidents.

Table 46-4  General filters for severity values

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>High</td>
<td>Lists only the high-severity incidents. Displays how many high-severity incidents are in the incident list.</td>
</tr>
<tr>
<td>Info</td>
<td>Lists only the incidents that are informational only. Informational incidents are not assigned any other severity. Displays how many informational incidents are in the incident list.</td>
</tr>
<tr>
<td>Low</td>
<td>Lists only the low-severity incidents. Displays how many low-severity incidents are in the incident list.</td>
</tr>
<tr>
<td>Medium</td>
<td>Lists only the medium-severity incidents. Displays how many medium-severity incidents are in the incident list.</td>
</tr>
</tbody>
</table>

Table 46-5 lists the general filter options for Network Discover scans. This filter is only available for Discover incidents.

Table 46-5  General filters for scans

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Scans</td>
<td>All of the incidents that have been reported in all of the scans that have been run.</td>
</tr>
<tr>
<td>Initial Scan</td>
<td>All of the incidents that were reported in the initial scan.</td>
</tr>
<tr>
<td>In Process</td>
<td>All of the incidents that have been reported in the scans that are currently in progress.</td>
</tr>
<tr>
<td>Last Completed Scan</td>
<td>All of the incidents that were reported in the last complete scan.</td>
</tr>
</tbody>
</table>
You can filter Discover incidents by **Target ID**. This filter is only available for Discover incidents.

Select the target, or select **All Targets**. Shift-click to select multiple fields.

Table 46-6 lists the general filter options by detection date for Discover incidents.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Dates</td>
<td>All of the dates that contain incidents.</td>
</tr>
<tr>
<td><strong>Current Month to Date</strong></td>
<td>All of the incidents that were reported for the current month up to today's date.</td>
</tr>
<tr>
<td><strong>Current Quarter to Date</strong></td>
<td>All of the incidents that were reported for the current quarter up to today's date.</td>
</tr>
<tr>
<td><strong>Current Week to Date</strong></td>
<td>All of the incidents that were reported for the current week.</td>
</tr>
<tr>
<td><strong>Current Year to Date</strong></td>
<td>All of the incidents that have been reported for the current year up to today's date.</td>
</tr>
<tr>
<td>Custom</td>
<td>A custom time frame. Select the dates that you want to view from the calendar menu.</td>
</tr>
<tr>
<td><strong>Custom Since</strong></td>
<td>The Symantec DLP Agents that have connected to the Endpoint Server from a specific date to the present date. Select the date where you want the filter to begin.</td>
</tr>
<tr>
<td><strong>Custom Before</strong></td>
<td>The Symantec DLP Agents that have connected to an Endpoint Server before a specific date. Select the final date for the filter.</td>
</tr>
<tr>
<td><strong>Last 7 Days</strong></td>
<td>All of the incidents that were reported in the previous seven days.</td>
</tr>
<tr>
<td><strong>Last 30 Days</strong></td>
<td>All of the incidents that were reported in the previous 30 days.</td>
</tr>
<tr>
<td><strong>Last Month</strong></td>
<td>All of the incidents that were reported during the previous calendar month.</td>
</tr>
<tr>
<td><strong>Last Week</strong></td>
<td>All of the incidents that were reported during the previous calendar week.</td>
</tr>
<tr>
<td><strong>Last Quarter</strong></td>
<td>All of the incidents that were reported during the previous quarter.</td>
</tr>
<tr>
<td><strong>Last Year</strong></td>
<td>All of the incidents that were reported during the last calendar year.</td>
</tr>
<tr>
<td><strong>Today</strong></td>
<td>All of the incidents that were reported today.</td>
</tr>
<tr>
<td><strong>Yesterday</strong></td>
<td>All of the incidents that were reported yesterday.</td>
</tr>
</tbody>
</table>
Summary options for incident reports

Incident report summaries provide options for a summary of the information that is contained within the incidents. For example, you can summarize incidents by the status or the policy.

**Note:** Archived incidents are not included in report summaries unless the Advanced filter option for the Is Archived filter is set to Show Archived and non-Archived incidents.

See “About incident archiving” on page 1065.

Table 46-7 lists the summary options for incident reports.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Applicable products</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent Configuration</td>
<td>Summarize the agents and incidents by the associated agent configuration entity. If you have more than one agent configuration entity configured, you can summarize or filter by a specific entity drop down menu. If the default agent configuration entity is the only entity configured, you will not see the drop down menu.</td>
<td>Endpoint</td>
</tr>
<tr>
<td>Agent Response</td>
<td>Summarize incidents by how the agent has responded to the incident.</td>
<td>Endpoint</td>
</tr>
<tr>
<td>Content Root</td>
<td>Summarize the incidents by the content root path.</td>
<td>Discover</td>
</tr>
<tr>
<td>Data Owner Email Address</td>
<td>The email address of the person responsible for remediating the incident. This field must be set manually, or with a lookup plug-in.</td>
<td>Network, Endpoint, Discover</td>
</tr>
</tbody>
</table>
### Table 46-7  Summary filters (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Applicable products</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Data Owner Name</strong></td>
<td>The person responsible for remediating the incident. This field must be set manually, or with a lookup plug-in. Reports can automatically be sent to the data owner for remediation.</td>
<td>Network, Endpoint, Discover, Mobile</td>
</tr>
<tr>
<td><strong>Destination IP</strong></td>
<td>Summarize the incidents by the destination IP address.</td>
<td>Network, Endpoint</td>
</tr>
<tr>
<td><strong>Detection Month</strong></td>
<td>Summarize the incidents by the month in which they were detected.</td>
<td>Discover</td>
</tr>
<tr>
<td><strong>Detection Quarter</strong></td>
<td>Summarize the incidents by the calendar quarter in which they were detected.</td>
<td>Discover</td>
</tr>
<tr>
<td><strong>Detection Week</strong></td>
<td>Summarize the incidents by the week in which they were detected.</td>
<td>Discover</td>
</tr>
<tr>
<td><strong>Detection Year</strong></td>
<td>Summarize the incidents by the year in which they were detected.</td>
<td>Discover</td>
</tr>
<tr>
<td><strong>Device Instance ID</strong></td>
<td>Summarize the incidents by the specific device that created the violation.</td>
<td>Endpoint</td>
</tr>
<tr>
<td><strong>Domain</strong></td>
<td>Summarize the incidents by the domain name.</td>
<td>Network</td>
</tr>
<tr>
<td><strong>Email</strong></td>
<td>Summarize the incidents by the email associated with the violation.</td>
<td>Mobile</td>
</tr>
<tr>
<td><strong>Endpoint Location</strong></td>
<td>Summarize the incidents by the location of the endpoint. The location can be one of the following:</td>
<td>Endpoint</td>
</tr>
<tr>
<td></td>
<td>■ On the Corporate Network</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Off the Corporate Network</td>
<td></td>
</tr>
<tr>
<td><strong>File Name</strong></td>
<td>Summarize the incidents by the file name that is associated with the incident.</td>
<td>Endpoint</td>
</tr>
</tbody>
</table>
### Table 46-7  Summary filters (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Applicable products</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Owner</td>
<td>Summarize the incidents by the owner of the file.</td>
<td>Discover</td>
</tr>
<tr>
<td>Investigating State</td>
<td>Summarize the agents by the current status.</td>
<td>Endpoint</td>
</tr>
<tr>
<td>Location</td>
<td>Summarize the incidents by their location.</td>
<td>Discover</td>
</tr>
<tr>
<td>Log Level</td>
<td>Summarize the agents by their configured log levels.</td>
<td>Endpoint</td>
</tr>
<tr>
<td>Machine IP (Corporate)</td>
<td>Summarize the incidents by the IP address of a machine on the corporate network.</td>
<td>Endpoint</td>
</tr>
<tr>
<td>Machine Name</td>
<td>Summarize the incident by the computer name on which the incidents were created.</td>
<td>Endpoint</td>
</tr>
<tr>
<td>Month</td>
<td>Summarize the incidents by the month in which they were created.</td>
<td>Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Endpoint Mobile</td>
</tr>
<tr>
<td>Months Since First Detected</td>
<td>Summarize the incidents by how many months have passed since the incident was first detected.</td>
<td>Discover</td>
</tr>
<tr>
<td>Network Prevention Action</td>
<td>Summarize the incidents by the action from Network Prevent.</td>
<td>Network</td>
</tr>
<tr>
<td>No primary summary selected</td>
<td>Placeholder selection to denote that no primary summary has been selected.</td>
<td>Network Endpoint</td>
</tr>
<tr>
<td>No secondary summary selected</td>
<td>Placeholder selection to denote that no summary has been selected.</td>
<td>Network Endpoint</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Discover</td>
</tr>
</tbody>
</table>
Table 46-7  Summary filters (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Applicable products</th>
</tr>
</thead>
<tbody>
<tr>
<td>Policy</td>
<td>Summarize the incidents by the policy from which they were created.</td>
<td>Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Endpoint</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Discover</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Mobile</td>
</tr>
<tr>
<td>Policy Group</td>
<td>Summarize the incidents by the policy group to which they belong.</td>
<td>Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Discover</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Mobile</td>
</tr>
<tr>
<td>Policy rule</td>
<td>Summarize the incidents by the policy rule which generated the violation.</td>
<td>Mobile</td>
</tr>
<tr>
<td>Protect Status</td>
<td>Summarize the incidents by the Network status of the incidents.</td>
<td>Discover</td>
</tr>
<tr>
<td>Protocol</td>
<td>Summarize the incidents by the protocol that generated the incident.</td>
<td>Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Mobile</td>
</tr>
<tr>
<td>Protocol or Endpoint</td>
<td>Summarize the incidents by the protocol or the endpoint destination where the incidents were created.</td>
<td>Endpoint</td>
</tr>
<tr>
<td>Destination</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remediation Detection</td>
<td>Summarize the incidents by their remediation detection status.</td>
<td>Discover</td>
</tr>
<tr>
<td>Status</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quarantine Failure</td>
<td>Summarize the incidents by the reason that the quarantine response action failed.</td>
<td>Endpoint</td>
</tr>
<tr>
<td>Reason</td>
<td></td>
<td>Discover</td>
</tr>
<tr>
<td>Quarter</td>
<td>Summarize the incidents by the quarter in which they were created.</td>
<td>Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Endpoint</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Mobile</td>
</tr>
<tr>
<td>Quarters Since First</td>
<td>Summarize the incidents by how many quarters have passed since the incident was first detected.</td>
<td>Discover</td>
</tr>
<tr>
<td>Detected</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Recipient</td>
<td>Summarize the incidents by the recipient.</td>
<td>Discover</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
<td>Applicable products</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Scan</td>
<td>Summarize the incidents by which scan was used to find the incidents.</td>
<td>Discover</td>
</tr>
<tr>
<td>Scanned Machine</td>
<td>Summarize the incidents by the computers that have been scanned.</td>
<td>Discover</td>
</tr>
<tr>
<td>Sender</td>
<td>Summarize the incidents by the sender.</td>
<td>Network Endpoint</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Discover</td>
</tr>
<tr>
<td>Server</td>
<td>Summarize the incidents by the server on which they were created.</td>
<td>Network Endpoint</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Mobile</td>
</tr>
<tr>
<td>Source IP</td>
<td>Summarize the incidents by the source IP address from which they were created.</td>
<td>Network Endpoint</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Mobile</td>
</tr>
<tr>
<td>Source File</td>
<td>Summarize the incidents by the source file that violated the policy.</td>
<td>Endpoint</td>
</tr>
<tr>
<td>Status</td>
<td>Summarize the incidents by the incident status.</td>
<td>Network Endpoint</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Discover</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Mobile</td>
</tr>
<tr>
<td>Subject</td>
<td>Summarize the incidents by the subject.</td>
<td>Discover</td>
</tr>
<tr>
<td>Mobile Prevent Action</td>
<td>Summarize the incidents by the response rule action that was taken.</td>
<td>Mobile</td>
</tr>
<tr>
<td>Target ID</td>
<td>Summarize the incidents by the target scan ID.</td>
<td>Discover</td>
</tr>
<tr>
<td>Target Type</td>
<td>Summarize the incidents by the type of target on which the incident was generated.</td>
<td>Discover</td>
</tr>
<tr>
<td>User Justification</td>
<td>Summarize the incidents by the justification that was input by the user.</td>
<td>Endpoint</td>
</tr>
</tbody>
</table>
### Advanced filter options for reports

Advanced report filters let you filter incidents related to specific actions or text strings. For example, you can filter the incidents that relate to a specific keyword. Or, you can filter out the incidents that relate to a certain action. These filters combine a set of chooser fields or text boxes to create the advanced filter.

Table 46-8, Table 46-9, and Table 46-10 list the advanced filter options for reports.

#### Table 46-7  Summary filters *(continued)*

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Applicable products</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Name</td>
<td>Summarize the incidents by the user who generated the incident.</td>
<td>Endpoint</td>
</tr>
<tr>
<td>Week</td>
<td>Summarize the incidents by the week in which they were created.</td>
<td>Network Endpoint Mobile</td>
</tr>
<tr>
<td>Weeks Since First Detected</td>
<td>Summarize the incidents by how many weeks have passed since the incident was first detected.</td>
<td>Discover</td>
</tr>
<tr>
<td>Year</td>
<td>Summarize the incidents by the year in which they were created.</td>
<td>Network Endpoint Mobile</td>
</tr>
<tr>
<td>Years Since First Detected</td>
<td>Summarize the incident by how many years have passed since the incident was first detected.</td>
<td>Discover</td>
</tr>
</tbody>
</table>

#### Table 46-8  Advanced filters, first field

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Applicable products</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent Configuration</td>
<td>Summarize the agents and incidents by the associated agent configuration entity. If you have more than one agent configuration entity configured, you can summarize or filter by a specific entity drop down menu. If the default agent configuration entity is the only entity configured, you will not see the drop down menu.</td>
<td>Endpoint</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
<td>Applicable products</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Agent Configuration Status</td>
<td>Summarize the agent by the status of the configuration entity. ▪ Current Configuration The configuration on the agent is the same as the configuration on the Endpoint Server. ▪ Outdated Configuration The configuration on the agent is different than the configuration on the Endpoint Server. ▪ Unknown/deleted Configuration The agents either cannot report which configuration is installed, or the configuration on the agent has been deleted from the Endpoint Server.</td>
<td>Endpoint</td>
</tr>
<tr>
<td>Agent Response</td>
<td>Filter incidents by how the agent has responded to the incident.</td>
<td>Endpoint</td>
</tr>
<tr>
<td>Application Name</td>
<td>Filter the incidents by the name of the application where the incident was generated.</td>
<td>Endpoint</td>
</tr>
<tr>
<td>Application Window Title</td>
<td>Filter the incidents by a string in the title of the window where the incident was generated.</td>
<td>Endpoint</td>
</tr>
<tr>
<td>Attachment File Name</td>
<td>Filter incidents by the file name of the attachment that is associated with the incident.</td>
<td>Network Mobile</td>
</tr>
<tr>
<td>Attachment File Size</td>
<td>Filter incidents by the size of the attachment that is associated with the incident.</td>
<td>Network Mobile</td>
</tr>
<tr>
<td>Content Root</td>
<td>Filter the incidents by the content root path.</td>
<td>Discover</td>
</tr>
<tr>
<td>Data Owner Email Address</td>
<td>The email address of the person responsible for remediating the incident. This field must be set manually, or with a lookup plug-in.</td>
<td>Network Endpoint Discover Mobile</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
<td>Applicable products</td>
</tr>
<tr>
<td>--------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>Data Owner Name</td>
<td>The person responsible for remediating the incident. This field must be set manually, or with a lookup plug-in. Reports can automatically be sent to the data owner for remediation.</td>
<td>Network, Endpoint, Discover, Mobile</td>
</tr>
<tr>
<td>Destination IP</td>
<td>Filter the incidents by the destination IP address for the message that generated the incident.</td>
<td>Network, Endpoint, Mobile</td>
</tr>
<tr>
<td>Detection Date</td>
<td>Filter the incidents by the date that the incident was detected.</td>
<td>Discover</td>
</tr>
<tr>
<td>Device Instance ID</td>
<td>Summarize the incidents by the specific device that created the violation.</td>
<td>Endpoint</td>
</tr>
<tr>
<td>Document Name</td>
<td>Filter the incidents by the name of the violating document.</td>
<td>Discover</td>
</tr>
<tr>
<td>Domain</td>
<td>Filter the incidents by the domain name that is associated with the incident.</td>
<td>Network</td>
</tr>
<tr>
<td>Email</td>
<td>Filter the incidents by the email address to which they are associated.</td>
<td>Mobile</td>
</tr>
<tr>
<td>Endpoint Location</td>
<td>Filter the incidents by the endpoint location. The location can be one of the following:</td>
<td>Endpoint</td>
</tr>
<tr>
<td></td>
<td>- On the Corporate Network</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Off the Corporate Network</td>
<td></td>
</tr>
<tr>
<td>File Last Modified Date</td>
<td>Filter the incidents by the last date when the file was modified.</td>
<td>Endpoint, Discover</td>
</tr>
<tr>
<td>File Location</td>
<td>Filter the incidents by the location of the violating file.</td>
<td>Endpoint</td>
</tr>
<tr>
<td>File Name</td>
<td>Filter the incidents by the name of the violating file. No wildcards, but you can specify a partial match, for example .pdf.</td>
<td>Endpoint, Discover</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
<td>Applicable products</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>File Owner</td>
<td>Filter the incidents by the owner of the violating files.</td>
<td>Discover</td>
</tr>
<tr>
<td>File Size</td>
<td>Filter the incidents by the size of the violating file.</td>
<td>Endpoint</td>
</tr>
<tr>
<td>Incident History Issuer</td>
<td>Filter the incidents by the user responsible for issuing the history of the incident.</td>
<td>Network Endpoint Discover Mobile</td>
</tr>
<tr>
<td>Incident ID</td>
<td>Filter the incidents by the ID of the incidents.</td>
<td>Network Endpoint Discover Mobile</td>
</tr>
<tr>
<td>Incident Match Count</td>
<td>Filter the incidents by the number of incident matches.</td>
<td>Network Endpoint Discover Mobile</td>
</tr>
<tr>
<td>Incident Notes</td>
<td>Filter the incidents by a string in the incident notes.</td>
<td>Network Endpoint Discover Mobile</td>
</tr>
<tr>
<td>Incident Reported On</td>
<td>Filter the incidents by the date that the incident was reported.</td>
<td>Endpoint</td>
</tr>
<tr>
<td>Investigating State</td>
<td>Filter the agents by the investigation state. You can select one of the following:</td>
<td>Discover Endpoint</td>
</tr>
<tr>
<td></td>
<td>■ Investigating</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Not Investigating</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
<td>Applicable products</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------</td>
</tr>
</tbody>
</table>
| Is Archived                   | Filters archived incidents. You can select one of the following:  
  - Show Archived and non-Archived Incidents  
  - Show Archived  
  See “About incident archiving” on page 1065.                                                                                                             | Network  
  Endpoint  
  Discover  
  Mobile  
  Classification |
| Is Archive Allowed            | Filters the incidents based on the state of the Is Archived Allowed flag. Select the Is Any Of operator from the second field, then select either the Allow Archive or Do Not Archive option from the third field.  
  See “About incident archiving” on page 1065.                                                                                                             | Network  
  Endpoint  
  Discover  
  Mobile  
  Classification |
| Last Connection Time          | Filter agents according to the last time each agent connected to the Endpoint Server.                                                                                                                       | Endpoint |
| Location                      | Filter the incidents by their location. Location can include the server where the incidents were generated.                                                                                                  | Discover |
| Machine IP (Corporate)        | Filter the incidents by the IP address of the computer on which the incidents were created.                                                                                                               | Endpoint |
| Machine Name                  | Filter the incidents by the computer name on which the incidents were created.                                                                                                                            | Endpoint |
| Minimum Similarity Score      | Filter the incidents by how similar the violations are to each other.                                                                                                                                       | Mobile |
| Network Prevent Action        | Filter the incidents by the action from Network Prevent.                                                                                                                                                   | Network |
| Policy                        | Filter the incidents by the policy from which they were created.                                                                                                                                            | Network  
  Endpoint  
  Discover  
  Mobile |
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Applicable products</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Policy Group</strong></td>
<td>Filter the incidents by the policy group to which they belong.</td>
<td>Network, Endpoint, Discover, Mobile</td>
</tr>
<tr>
<td><strong>Policy Rule</strong></td>
<td>Filter the incidents by the policy rule that generated the incidents.</td>
<td>Network, Endpoint, Discover, Mobile</td>
</tr>
<tr>
<td><strong>Protect Status</strong></td>
<td>Filter the incidents by the Network Protect status of the incidents.</td>
<td>Discover</td>
</tr>
<tr>
<td><strong>Protocol</strong></td>
<td>Filter the incidents by the protocol to which they belong.</td>
<td>Network, Mobile</td>
</tr>
<tr>
<td><strong>Protocol or Endpoint Destination</strong></td>
<td>Filter the incidents by the protocol or the endpoint destination that generated the incident.</td>
<td>Endpoint</td>
</tr>
<tr>
<td><strong>Read ACL: File</strong></td>
<td>Filter the incidents by the File access control list.</td>
<td>Endpoint, Discover</td>
</tr>
<tr>
<td><strong>Read ACL: Share</strong></td>
<td>Filter the incidents by the Share access control list.</td>
<td>Discover</td>
</tr>
<tr>
<td><strong>Recipient</strong></td>
<td>Filter the incidents by the name of the recipient of the message that generated the incident.</td>
<td>Network, Endpoint, Discover</td>
</tr>
<tr>
<td><strong>Remediation Detection Status</strong></td>
<td>Filter the incidents by their remediation detection status.</td>
<td>Discover</td>
</tr>
<tr>
<td><strong>Scanned Machine</strong></td>
<td>Filter the incidents by the computers that have been scanned.</td>
<td>Discover</td>
</tr>
<tr>
<td><strong>Seen Before</strong></td>
<td>Filter the incidents on whether an earlier connected incident exists.</td>
<td>Discover, but not for SQL Database incidents (where <strong>Seen Before</strong> is always false)</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
<td>Applicable products</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Sender</td>
<td>Filter the incidents by the sender.</td>
<td>Network Endpoint Discover</td>
</tr>
<tr>
<td>Server</td>
<td>Filter the incidents by the server on which they were created.</td>
<td>Network Endpoint Discover</td>
</tr>
<tr>
<td>SharePoint ACL: Permission Level</td>
<td>Filter the incidents on the permission level of the SharePoint access control list.</td>
<td>Discover</td>
</tr>
<tr>
<td>SharePoint ACL: User/Group</td>
<td>Filter the incidents on the user or group in the SharePoint access control list.</td>
<td>Discover</td>
</tr>
<tr>
<td>Source IP</td>
<td>Filter the incidents by the source IP address from which they were created.</td>
<td>Network Mobile</td>
</tr>
<tr>
<td>Subject</td>
<td>Filter incidents by the subject line of the message that generated the incident.</td>
<td>Network Discover</td>
</tr>
<tr>
<td>Superseded</td>
<td>Filter the incidents by the incident responses have been superseded by other responses.</td>
<td>Discover Endpoint</td>
</tr>
<tr>
<td>Mobile Prevent Action</td>
<td>Filter the incidents by the response rule action that was taken.</td>
<td>Mobile</td>
</tr>
<tr>
<td>Target Type</td>
<td>Filter the incidents by the type of target that is associated with the incidents.</td>
<td>Discover</td>
</tr>
<tr>
<td>Time Since First Detected</td>
<td>Filter the incidents by how much time has passed since the incident was first detected.</td>
<td>Discover, but not for SQL Database incidents</td>
</tr>
<tr>
<td>URL</td>
<td>Filter the incidents by the URL where the violations occurred.</td>
<td>Discover</td>
</tr>
<tr>
<td>User Justification</td>
<td>Filter the incidents by the justification that was input by the user.</td>
<td>Endpoint</td>
</tr>
</tbody>
</table>
Table 46-8  Advanced filters, first field (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Applicable products</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Name</td>
<td>Filter the incidents by the user who generated the incident.</td>
<td>Endpoint</td>
</tr>
</tbody>
</table>

The second field in the advanced filters lets you select the match type in the filter.

Table 46-9  Advanced filters, second field

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contains Any Of</td>
<td>Lets you modify the filter to include any words in the text string, or lets you choose from a list in the third field.</td>
</tr>
<tr>
<td>Contains Ignore Case</td>
<td>Lets you modify the filter to ignore a specific text string.</td>
</tr>
<tr>
<td>Does Not Contain Ignore Case</td>
<td>Lets you modify the filter to filter out the ignored text string.</td>
</tr>
<tr>
<td>Does Not Match Exactly</td>
<td>Lets you modify the filter to match on any combination of the text string.</td>
</tr>
<tr>
<td>Ends with Ignore Case</td>
<td>Lets you modify the filter so that only the incidents that end with the ignored text string appear.</td>
</tr>
<tr>
<td>Is Any Of</td>
<td>Lets you modify the filter so that the results include any of the text string, or lets you choose from a list in the third field.</td>
</tr>
<tr>
<td>Is Between</td>
<td>Lets you modify the filter so that the numerical results are between a range of specified numbers.</td>
</tr>
<tr>
<td>Is Greater Than</td>
<td>Lets you modify the filter so that the numerical results are greater than a specified number.</td>
</tr>
<tr>
<td>Is Less Than</td>
<td>Lets you modify the filter so that the numerical results are less than a specified number.</td>
</tr>
<tr>
<td>Is None Of</td>
<td>Lets you modify the filter so that the results do not include any of the text string, or lets you choose from a list in the third field.</td>
</tr>
<tr>
<td>Is Unassigned</td>
<td>Lets you modify the filter to match incidents for which the value specified in the first field are unassigned.</td>
</tr>
<tr>
<td>Matches Exactly</td>
<td>Lets you modify the filter to match exactly the text string.</td>
</tr>
<tr>
<td>Matches Exactly Ignore Case</td>
<td>Lets you modify the filter so that the filter must match the ignored text string exactly.</td>
</tr>
</tbody>
</table>
Table 46-9  Advanced filters, second field (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Starts with Ignore Case</strong></td>
<td>Lets you modify the filter so that only the incidents that start with the ignored text string appear.</td>
</tr>
</tbody>
</table>

The third field in the advanced filters lets you select from a list of items, or provides an empty box to enter a string.

This third field varies depending on the selections in the first and second fields.

For a list of items, use Shift-click to select multiple items.

For strings, wildcards are not allowed, but you can enter a partial string.

For example, you can enter `.pdf` to select any PDF file.

If you do not know what text to enter, use the summary options to view the list of possible text values. You can also see a summary of how many incidents are in each category.

See “Summary options for incident reports” on page 1051.

Table 46-10 lists some of the options in the third field.

Table 46-10  Advanced filters, third field

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Blocked</strong></td>
<td>The user was blocked from performing the action that cause the incident.</td>
</tr>
<tr>
<td><strong>Content Removed</strong></td>
<td>The content in violation was removed.</td>
</tr>
<tr>
<td><strong>No Remediation</strong></td>
<td>No incident remediation has occurred for this incident.</td>
</tr>
<tr>
<td><strong>None</strong></td>
<td>No action was taken regarding the violation that caused the incident.</td>
</tr>
<tr>
<td><strong>Protect File Copied</strong></td>
<td>The file in violation was copied to another location.</td>
</tr>
<tr>
<td><strong>Protect File Quarantined</strong></td>
<td>The file in violation was quarantined to another location.</td>
</tr>
<tr>
<td><strong>User Notified</strong></td>
<td>The user was notified that a violation had occurred.</td>
</tr>
</tbody>
</table>
Archiving incidents

This chapter includes the following topics:

- About incident archiving
- Archiving incidents
- Restoring archived incidents
- Preventing incidents from being archived
- Deleting archived incidents

About incident archiving

Incident archiving lets you flag specified incidents as "archived." Because these archived incidents are excluded from normal incident reporting, you can improve the reporting performance of your Symantec Data Loss Prevention deployment by archiving any incidents that are no longer relevant. The archived incidents remain in the database; they are not moved to another table, database, or other type of offline storage.

You can set filters on incident reports in the Enforce Server administration console to display only archived incidents or to display both archived and non-archived incidents. Using these reports, you can flag one or more incidents as archived by using the Archive options that are available when you select one or more incidents and click the Incident Actions button. The Archive options are:

- Archive Incidents—Flags the selected incidents as archived.
- Restore Incidents—Restores the selected incidents to the non-archived state.
- Do Not Archive—Prevents the selected incidents from being archived.
- Allow Archive—Allows the selected incidents to be archived.
The archive state of an incident displays in the incident snapshot screen in the Enforce Server administration console. The History tab of the incident snapshot includes an entry for each time the Do Not Archive or Allow Archive flags are set for the incident.

See “Filtering reports” on page 1021.

Access to archiving functionality is controlled by roles. You can set the following user privileges on a role to control access:

- **Archive Incidents**—Grants permission for a user to archive incidents.
- **Restore Archive Incidents**—Grants permission for a user to restore archived incidents.
- **Remediate Incidents**—Grants permission for a user to set the Do Not Archive or Allow Archive flags.

See “About role-based access control” on page 84.

See “Archiving incidents” on page 1066.

See “Restoring archived incidents” on page 1066.

See “Preventing incidents from being archived” on page 1067.

---

**Archiving incidents**

To archive incidents

1. Open the Enforce Server administration console and navigate to an incident report.
2. Select the incidents you want to archive, either by selecting the incidents manually or by setting filters or advanced filters to return the set of incidents that you want to archive.
3. Click the Incident Actions button and select Archive > Archive Incidents. The selected incidents are archived.

**Restoring archived incidents**

To restore archived incidents

1. Open the Enforce Server administration console and navigate to an incident report.
2. Select the Advanced Filters & Summarization link.
3. Click the Add filter button.
4. Select Is Archived in the first drop-down list.
5. Select Show Archived from the second drop-down list.
6. Select the incidents you want to restore, either by selecting incidents manually or by setting filters or advanced filters to return the set of incidents you want to restore.

The selected incidents are restored.

## Preventing incidents from being archived

You can prevent incidents from being archived using either an incident report or an incident snapshot.

### To prevent incidents from being archived using an incident report

1. Open the Enforce Server administration console and navigate to an incident report.
2. Select the incidents you want to prevent from being archived. You can select incidents manually or by setting filters or advanced filters to return the set of incidents you want to prevent from being archived.
3. Click the Incident Actions button and select Archive > Do Not Archive.

The selected incidents are prevented from being archived.

**Note:** You can allow incidents to be archived that you have prevented from being archived by selecting the incidents and then selecting Archive > Allow Archive from the Incident Actions button.

### To prevent an incident from being archived using the incident snapshot

1. Open the Enforce Server administration console and navigate to an incident report.
2. Click on an incident to open the incident snapshot.
3. On the Key Info tab, in the Incident Details section, click Do Not Archive.

**Note:** You can allow an incident to be archived that you have prevented from being archived by opening the incident snapshot and then clicking Allow Archive in the Incident Details section.
Deleting archived incidents

To delete archived incidents

1. Open the Enforce Server administration console and navigate to an incident report.
2. Click the Advanced Filters & Summarization link.
3. Click Add filter.
4. Select Is Archived in the first drop-down list.
5. Select Show Archived from the second drop-down list.
6. Select the incidents you want to delete. You can select the incidents manually or you can set filters or advanced filters that return the set of incidents you want to delete.
7. Click the Incident Actions button and select Delete incidents.
8. Select one of the following delete options:
   - Delete incident completely: Permanently deletes the incident(s) and all associated data (for example, any emails and attachments). Note that you cannot recover the incidents that have been deleted.
   - Retain incident, but delete message data: Retains the actual incident(s) but discards the Symantec Data Loss Prevention copy of the data that triggered the incident(s). You have the option of deleting only certain parts of the associated data. The rest of the data is preserved.
   - Delete Original Message: Deletes the message content (for example, the email message or HTML post). This option applies only to Network incidents.
   - Delete Attachments/Files: This option refers to files (for Endpoint and Discover incidents) or email or posting attachments (for Network incidents). The options are All, which deletes all attachments, and Attachments with no violations. For example, choose this option to delete files (for Endpoint and Discover incidents) or email attachments (for Network incidents).
     - This option deletes only those attachments in which Symantec Data Loss Prevention found no matches. For example, choose this option when you have incidents with individual files taken from a compressed file (Endpoint and Discover incidents) or several email attachments (Network incidents).
9. Click the Delete button.
Working with incident data

This chapter includes the following topics:

- About incident status attributes
- Configuring status attributes and values
- Configuring status groups
- Export web archive
- Export web archive—Create Archive
- Export web archive—All Recent Events
- About custom attributes
- About using custom attributes
- How custom attributes are populated
- Configuring custom attributes
- Setting the values of custom attributes manually

About incident status attributes

Incident status attributes are specified and configured from the Attributes screen (System > Incident Data > Attributes).

Any status attribute listed on this screen can be assigned to any given incident by selecting it from the incident snapshot Status drop-down menu.

The system attributes page contains the following attributes to assist in incident remediation:

- Status Values
The **Status Values** section lists the current incident status attributes that can be assigned to a given incident. Use this section to create new status attributes, modify them, and change the order that each attribute appears in drop-down menus.

See “Configuring status attributes and values” on page 1071.

**Status Groups**

The **Status Groups** section lists the current incident status groups and their composition. Use this section to create new status groups, modify them, and change the group order they appear in drop-down menus.

See “Configuring status groups” on page 1072.

**Custom Attributes** on the **Custom Attributes** tab

The **Custom Attributes** tab provides a list of all of the currently defined custom incident attributes. Custom attributes provide information about the incident or associated with the incident. For example, the email address of the person who caused the incident, that person’s manager, why the incident was dismissed, and so on. Use this tab to add, configure, delete, and order custom incident attributes.

See “About custom attributes” on page 1076.

The process for handling incidents goes through several stages from discovery to resolution. Each stage is identified by a different status attribute such as "New," "Investigation," "Escalated," and "Resolved." This lets you track the progress of the incident through the workflow, and filter lists and reports by incident status.

The solution pack you installed when you installed Symantec Data Loss Prevention provides an initial default set of status attributes and status attribute groups. You can create new status attributes, or modify existing ones. The status attribute values and status groups you use should be based on the workflow your organization uses to process incidents. For example, you might assign all new incidents a status of "New." Later, you might change the status to "Assigned," "Investigation," or "Escalated." Eventually, most incidents will be marked as "Resolved" or as "Dismissed."

For list and report filtering, you can also create status groups.

Based on the preferences of your organization and the commonly used terminology in your industry, you can:

- Customize the names of the status attributes and add new status attributes.
- Customize the names of the status groups and add new status groups.
- Set the order in which status attributes appear on the **Status** drop-down list of an incident.
- Specify the default status attribute that is automatically assigned to new incidents.
Configuring status attributes and values

As incidents are processed from discovery to resolution, each stage can be marked with a different status. The status lets you track the progress of the incident through your workflow. Based on the preferences of your organization and the commonly used terminology in your industry, you can define the different statuses that you want to use for workflow tracking.

The Status Values section lists the available incident status attributes that can be assigned to a given incident. The order in which status attributes appear in this list determines the order they appear in drop-down menus used to set the status of an incident. You can perform the following actions from the Status Values section:

<table>
<thead>
<tr>
<th>Action</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a new incident status attribute.</td>
<td>Click the Add button.</td>
</tr>
<tr>
<td>Delete an incident status attribute.</td>
<td>Click the attribute’s red X and then confirm your decision.</td>
</tr>
<tr>
<td>Change an incident status attribute.</td>
<td>Click on the attribute you want to change, enter a new name, and click Save.</td>
</tr>
<tr>
<td>Make an incident status attribute the default.</td>
<td>Click [set as default] for an attribute to make it the default status for all new incidents.</td>
</tr>
<tr>
<td>Change an incident status attribute's order in drop-down menus.</td>
<td>• Click [up] to move an attribute up in the order.</td>
</tr>
<tr>
<td></td>
<td>• Click [down] to move an attribute down in the order.</td>
</tr>
</tbody>
</table>

To create a new incident status attribute

1. Go to the Attributes screen (System > Incident Data > Attributes) screen. Click the Status tab.
2. Click the Add button in the Status Values section.
3. Enter a name for the new status attribute.

4. Click Save.

See “Configuring status groups” on page 1072.

See “About incident status attributes” on page 1069.

Configuring status groups

Incident status attributes can be assigned to status groups that match the workflow of your organization. For example, an Open status group might include the status attributes of New, Investigation, and Escalated. You can then filter incident lists and reports based on their status group. For example, you can list all incidents with status attributes that belong to the Open status group.

System > Incident Data > Attributes brings you to Status Groups.

For your convenience, you can group incident statuses to match the workflow of your organization. You use Status Groups to add or modify the name of a status group, and specify which status values to include in the group.

The Status Groups section lists the available incident status groups that can be used to filter incidents. For each group, the status attributes included in the group are listed. You can perform the following actions from the Status Values section:

<table>
<thead>
<tr>
<th>Action</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a new incident status group.</td>
<td>Click the Add Status Group button.</td>
</tr>
<tr>
<td>Delete an incident status group.</td>
<td>Click the group's red X and then confirm your decision.</td>
</tr>
<tr>
<td>Change the name or incident status attributes of a group.</td>
<td>Click on the group you want to change. Click the pencil icon. Change the name, check or uncheck attributes, and click Save.</td>
</tr>
<tr>
<td>Change a status group's order in drop-down menus.</td>
<td>Click [up] to move a group up in the order. Click [down] to move a group down in the order.</td>
</tr>
</tbody>
</table>

To define a new status group

1. Go to the Attributes screen (System > Incident Data > Attributes) screen. Click the Status tab.
2. Click the Add Status Group button in the Status Groups section.
3. Enter a name for the new status group.
4 Click the check boxes for the status attributes that you want to include in this group.

Status attributes are defined with the Add button in the Status Values section.

See “Configuring status attributes and values” on page 1071.

5 Click Save.

See “Configuring status attributes and values” on page 1071.

See “About incident status attributes” on page 1069.

Export web archive

Use this screen to save an incident list report as an archive of HTML pages. An archive allows personnel without direct access to Symantec Data Loss Prevention to study incident data, drilling down into individual incidents as needed.

When you export incidents as a Web Archive, the archive is placed in directory \SymantecDLP\Protect\archive\webarchive.

Note: You cannot archive summary reports or dashboards.

When exporting incidents, please note the following considerations:

- An archive cannot be summarized like a normal report.
- An archive contains no filters, so it may be difficult to locate a specific incident in an archive containing a large number of incidents.
- Exporting an archive of incidents does not remove the incidents from the administration console.
- You can export only one archive at a time.

Export Web Archive is a user privilege that must be assigned to a role. You can export web archives only if your role provides access to this feature. Since role access also determines what information is contained in incident reports, it also applies to archiving those incident reports. The information that is contained in the archive you create is the same information contained in the original incident report.

See “About configuring roles and users” on page 88.

The Export web archive screen is divided into two sections:

See “Export web archive—Create Archive” on page 1074.

See “Export web archive—All Recent Events” on page 1076.
Export web archive—Create Archive

In the **Create Archive** section, complete the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Archive Name</td>
<td>Specify a name for the archive you are creating using normal Windows naming conventions.</td>
</tr>
</tbody>
</table>
Report to Export

From the drop-down list, select the report that you want to archive. Any reports you created are available along with default report options.

The **Network** options are as follows:

- **Incidents - Week, Current**—Network incidents from the current week.
- **Incidents - All**—All network incidents.
- **Incidents - New**—Network incidents with status of New.

The **Endpoint** options are as follows:

- **Incidents - Week, Current**—Endpoint incidents from the current week.
- **Incidents - All**—All endpoints incidents.
- **Incidents - New**—Only endpoint incidents with status of New.

The **Discover** options are as follows:

- **Incidents - Last Scan**—Discover incidents from the last completed scan. (Incidents from a currently active scan are not included.)
- **Incidents - Scan in Process**—Discover incidents from the current scan.
- **Incidents - All Scans**—All Discover incidents.
- **Incidents - New**—Discover incidents with status of New.

The **Mobile** options are as follows:

- **Incidents - Week, Current**—Network incidents from the current week.
- **Incidents - All**—All network incidents.
- **Incidents - New**—Network incidents with status of New.

The **Classification** options are as follows:

- **Events - All**

After you complete the fields, click **Create** to compile the archive.

See "Export web archive" on page 1073.
Export web archive—All Recent Events

The All Recent Events section displays a list of events related to this archive. (The list appears only after you click Create to create the archive.) Event entries show the following information:

- The event type (Error, Warning, or System Information).
- The event date and time
- A brief description of the event

To see the details of any event, click on the event entry in the list. To see the full Events Report for this archive, click show all.

See “Export web archive” on page 1073.

About custom attributes

"Custom attributes" are incident data fields that provide a way to capture and store supplemental incident information. The additional data that is contained in custom attributes can be:

- Used to drive workflow.
- Execute incident response actions.
- Used in report metrics.
- Enable Incident Response Teams to act faster on incidents.
- Enable increased remediation and report automation.

You create the custom attributes that you need for these purposes. Custom attributes provide information about an incident or associated with an incident; for example, the email address of the person who caused the incident, that person's manager, why the incident was dismissed, and so on.

The Custom Attributes tab of the Attributes screen (System > Incident Data > Attributes) is used for working with custom attributes. The Attributes screen contains the following tabs:

- **Status.** The Status tab provides a list of all of the currently defined incident status attributes and status attribute groups. Use this tab to add, configure, delete, and order incident status attributes and incident status groups. See “About incident status attributes” on page 1069.

- **Custom Attributes.** The Custom Attributes tab provides a list of all of the currently defined custom incident attributes. Use this tab to add, configure, delete, and order custom incident attributes.
The solution pack you loaded when you installed Symantec Data Loss Prevention provides an initial default set of custom attributes. The Custom Attributes tab provides a list of all of the currently defined custom attributes that may be applied to any incident. This tab is for creating, modifying, and deleting custom attributes for your installation as a whole. Applying any of these custom attributes, or attribute values, to an individual incident is done from the incident snapshot, or by using a lookup plug-in.

On the **Custom Attributes** tab, you can perform the following functions:

<table>
<thead>
<tr>
<th>Action</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a new custom attribute.</td>
<td>Click the <strong>Add</strong> button.</td>
</tr>
<tr>
<td>Delete a custom attribute.</td>
<td>Click the attribute's red &quot;X&quot; and then confirm your decision. Note that you cannot delete a custom attribute that is currently assigned to one or more incidents. You must assign a different attribute to the affected incident(s) before you can delete the custom attribute successfully.</td>
</tr>
<tr>
<td>Change the name, email status, or attribute group of an attribute.</td>
<td>Click on the attribute you want to change, change its parameters, and Click <strong>Save</strong>.</td>
</tr>
<tr>
<td>Change the attributes order in drop-down menus.</td>
<td>1 Click [up] to move an attribute up in the order. 2 Click [down] to move an attribute down in the order.</td>
</tr>
</tbody>
</table>
| Reload Lookup Plugins | Click **Reload Lookup Plug-ins** to reload any custom attribute plug-ins that have been unloaded by the system. Reloading look-up plugins affects all incidents. You may need to reload lookup plug-ins if any of the following are true:  
  - A plug-in was problematic and the system unloaded it, but now the problem is fixed.  
  - The network was down or disconnected for some reason, but it is functioning properly now.  
  - A plug-in stores data in a cache, and you want to update the cache manually. |

See “About incident status attributes” on page 1069.

See “Configuring custom attributes” on page 1079.
About using custom attributes

When an incident is created, the Enforce Server retrieves data regarding that incident. Some of that data is in the form of "attributes." See the Symantec Data Loss Prevention Administration Guide for more information about incident attributes.

"Custom attributes" are a particular kind of attribute that is used to capture and store supplemental data. This data is related to the incident such as the name of a relevant manager or department. You create the custom attributes that you need.

The additional data that is contained in custom attributes can be used for:

- Enabling a workflow
- Executing incident response actions
- Including in report metrics
- Enabling incident response teams to act faster on incidents
- Enabling increased remediation and report automation

How custom attributes are populated

For each incident, custom attributes can be populated (their values can be set in the incident data) in the following ways:

- Automatically when the incident is detected by means of a lookup plug-in, as described in this guide
- Automatically when the incident is detected by means of an automated response rule
- Automatically when a user executes a Smart Response Rule
- Manually (through data entry) by specific users after detection

Custom attributes can also be re-populated automatically by clicking on the Lookup option in the Attribute section of the Incident Snapshot screen. This action replaces the existing values that are stored in the custom attribute fields with the values returned by the new lookup.

Note: If the new lookup returns null or empty values for any custom attribute fields, those empty values overwrite the existing values.
Configuring custom attributes

Use the Configure Custom Attribute screen to add or modify a custom attribute.

Custom attributes can be grouped into attribute groups, similar to how statuses are grouped into status groups, to organize the information in a useful way. Examples of common attribute groups include Employee Information, Manager Information, and Remediation Information. All custom attributes are available for all incidents.

To create custom attributes and add them to a group

1. On the Enforce Server, click System > Incident Data > Attributes > Custom Attributes. Note that a number of custom attributes were defined and loaded for you by the Solution Pack that you selected during installation. All existing custom attributes are listed in the Custom Attributes window.

2. To create a new custom attribute, click the Add option.

3. Type a name for the custom attribute in the Name box. If appropriate, check the Is Email Address box.

   The name you give to a custom attribute does not matter. But a custom attribute you create must be structured the same as the corresponding external data source. For example, suppose an external source stores department information as separate geographic location and department name. In this case, you must create corresponding location and department name custom attributes. You cannot create a single department ID custom attribute combining both the location and the department name.

4. Select an attribute group from the Attribute Group drop-down list. If necessary, create a new attribute group. Select Create New Attribute Group from the drop-down list, and type the new group name in the text box that appears.

5. Click the Save option.

6. Generate a new incident, or view an existing incident, and verify that it contains the new custom attribute.

Once you define your custom attributes, they become available to every incident. Each incident receives its own set of custom attributes (though some name-value pairs may be empty depending on circumstances). The custom attribute values for an incident can be populated and changed independently of other incidents.

You can edit the custom attribute values if you have been assigned to a role that includes edit access for custom attributes. If you want to update a group of incidents, you can select those incidents on the incident list page. You can then select the Set Attributes command from the Incident Actions menu. You can select Lookup Attributes, to look up the values of custom attributes. Note that the Set Attributes...
command and **Attributes** section on the **Incident Snapshot** page are available only if at least one custom attribute is defined.

See “Configuring custom attributes” on page 1079.

See “About incident status attributes” on page 1069.

See “Configuring status groups” on page 1072.

See “Configuring status attributes and values” on page 1071.

---

**Setting the values of custom attributes manually**

You can manually specify incident remediation status or workflow progress with values in custom attributes.

---

**Note:** To auto-populate custom attribute values, use one or more lookup plugins. See “About lookup plug-ins” on page 1092.

---

**To set the value of custom attributes**

1. Display an incident snapshot.
2. Click the **Edit** option in the **Attributes** section of the incident snapshot.
3. To set a value for a custom attribute, enter the value in the appropriate attributes field.
4. When you are finished setting values, click **Save**.
Working with user risk

This chapter includes the following topics:

- About user risk
- About user data sources
- Viewing the user list
- Viewing user details
- Working with the user risk summary

About user risk

The user risk summary gives you insight into the behavior of specific individuals in your organization by associating users with email and endpoint incidents. This information helps you focus your data loss prevention efforts on those users posing the highest risk to the security of your data.

The Table 49-1 table provides and overview of the steps for creating and working with user risk summary reports.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create custom user attributes</td>
<td>You can create custom attributes for filtering and working with user risk summary reports. For example, you can create an attribute named Employment Status to track the employment status of each of your users. You can then import that information in a file that is exported from your enterprise resource planning system, such as PeopleSoft. See “Defining custom attributes for user data” on page 1084.</td>
</tr>
</tbody>
</table>
### Table 49-1  User Risk Summary workflow (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Import user data</td>
<td>You can import user data from an Active Directory connection or from a CSV file. Incidents are associated with specific users by email address and login credentials. You can also upload files with your custom attributes, such as information from your enterprise resource planning system. Symantec Data Loss Prevention provides a CSV template file that you can use to format any data you want to upload. See &quot;Bringing in user data&quot; on page 1084.</td>
</tr>
<tr>
<td>3</td>
<td>View the User List</td>
<td>The User List is a list of all users in your system, including their email address, domain, and login name. See &quot;Viewing the user list&quot; on page 1090. You can view details for specific users in the user snapshot. See &quot;Viewing user details&quot; on page 1090.</td>
</tr>
<tr>
<td>4</td>
<td>View the User Risk Summary</td>
<td>The User Risk Summary displays your users and their associated Endpoint and Network incidents. Use the User Risk Summary to drill into your user-centric incident data to help you find the highest-risk users. You can sort and filter this list by policies, custom attributes, incident status, incident severity, number of incidents, date, incident type, and user name. See &quot;Working with the user risk summary&quot; on page 1091.</td>
</tr>
<tr>
<td>5</td>
<td>Export user risk summary or user snapshot data.</td>
<td>You can export data from the user risk summary and user snapshots to a CSV file. See &quot;Working with the user risk summary&quot; on page 1091. See &quot;Viewing user details&quot; on page 1090.</td>
</tr>
</tbody>
</table>

Using the information that is provided in the user risk summary, you can see who the high-risk users are and determine the appropriate course of action to take. Such actions might include:

- Determining whether or not a user poses an active threat to your data security.
- Applying additional policies to monitor a user’s behavior more closely.
- Applying additional response rules to block actions or send alerts.
- Escalating a user’s behavior to their manager or other responsible party.

To work with user risk data, a Symantec Data Loss Prevention user must have the **User Reporting** privilege. Be aware that users with this privilege are automatically able to view and access all incidents and incident types in Symantec Data Loss...
Prevention. The user risk summary is intended for use by high-level remediators or information security officers. This privilege is not part of any predefined role. See “Configuring roles” on page 91.

About user data sources

You can bring in data about your users in CSV file format or through an Active Directory connection.

User data is information about people in your organization who may have access to data that you want to keep secure. To track user risk, you must provide the user’s first and last name, their email address (to track Network incidents) and login information (to track Endpoint incidents). You can also provide additional standard directory attribute information, such as the user’s address and phone number, as well as custom attributes such as the user’s employment status.

The Table 49-2 table lists the required and optional standard user data attributes:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Required or optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FIRST_NAME</td>
<td>Required</td>
<td>The user's given name.</td>
</tr>
<tr>
<td>LAST_NAME</td>
<td>Required</td>
<td>The user's surname.</td>
</tr>
<tr>
<td>EMAIL</td>
<td>Required if no login information is included</td>
<td>The user's email address.</td>
</tr>
<tr>
<td>LOGIN</td>
<td>Required if no email address is included</td>
<td>The user's login information, in DOMAIN\LOGIN format</td>
</tr>
<tr>
<td>TELEPHONE_NUMBER</td>
<td>Optional</td>
<td>The user's telephone number.</td>
</tr>
<tr>
<td>EMPLOYEE_ID</td>
<td>Optional</td>
<td>The user's employee identification number.</td>
</tr>
<tr>
<td>TITLE</td>
<td>Optional</td>
<td>The user's job title.</td>
</tr>
<tr>
<td>DEPARTMENT</td>
<td>Optional</td>
<td>The user's job department.</td>
</tr>
<tr>
<td>STREET_ADDRESS</td>
<td>Optional</td>
<td>The user's street address.</td>
</tr>
<tr>
<td>STATE_OR_PROVINCE</td>
<td>Optional</td>
<td>The state or province in which the user resides.</td>
</tr>
<tr>
<td>COUNTRY</td>
<td>Optional</td>
<td>The country in which the user resides.</td>
</tr>
<tr>
<td>POSTAL_CODE</td>
<td>Optional</td>
<td>The postal code for the user's address.</td>
</tr>
</tbody>
</table>
Defining custom attributes for user data

You can create custom attributes to improve relevance while filtering and working with user risk summary reports. Useful custom attributes might include employment status, the name of the user's manager, the user's job function, and other information that might be stored in your enterprise resource planning system or additional user data source.

You must create custom attributes before entering any user data. Each custom attribute is assigned a unique identification number as it is created. You must add these custom attribute identification numbers to your data file before you import it to Symantec Data Loss Prevention.

To define custom attributes for user data

1. In the Enforce Server administration console, go to System > Users > Attributes.
2. Click Add. The User Attribute dialog box appears.
3. Enter the custom attribute in the Name field. The custom attribute can be a maximum of 60 characters.
4. Click Submit.

To view and edit user custom attributes

1. In the Enforce Server administration console, go to System > Users > Attributes.
2. The custom attributes appear in the User Custom Attributes list. You can take these actions:
   - To filter the User Custom Attributes list, click Filters, then use the text fields for ID or Attribute Name to enter a filter value.
   - To edit a custom attribute, click the attribute name or click the edit icon in the Actions column, then edit the attribute in the User Attribute dialog box.
   - To delete a custom attribute, click the delete icon in the Actions column.

Bringing in user data

You can bring in user data from a file or an Active Directory connection.
After you have added your user data sources, you can schedule Symantec Data Loss Prevention to regularly import data from those data sources to ensure that your user data is always up to date. You can also import a user data source manually.

See “Importing a user data source” on page 1088.

Adding a file-based user data source

You can bring in user data from a .csv file. For your convenience, Symantec Data Loss Prevention provides an annotated .csv template that you can use to ensure that your data is formatted correctly. The template includes all the standard user attributes, as well as formatting examples and instructions for adding custom attributes. The template also includes headers for any custom attributes that you have defined at the time you download the template.

To create a user data file from a template

1. In the Enforce Server administration console, go to System > Users > Data Sources.
2. On the Data Sources page, click Download CSV Template on the right-hand side of the page.
3. Open the template file and provide the information for the standard user-data attributes.
   See “About user data sources” on page 1083.
4. The template file includes column headers for any custom attributes you have defined.
   To add custom attributes manually, create a new column for each attribute, then populate the rows as appropriate.
   You must enter the column headers in this format: ID[Attribute Name]. For example, 1[Employment Status].
   See “Defining custom attributes for user data” on page 1084.
5. Save the file (in .csv format) to a location on your Enforce Server.
To add a file-based user data source

1. In the Enforce Server administration console, go to **System > Users > Data Sources**.

2. On the **DataSource Management** page, click **Add > CSV User Source**. The **Add CSV User Source** dialog box appears.

3. In the **Add CSV User Source** dialog box, enter the following information:
   - **Name**: Specify a name for the data source.
   - **FilePath**: Specify the path to the user data file. This file must be on the Enforce Server.
   - **Delimited by**: Specify the delimiter for the file. Valid delimiters are comma, pipe, semicolon, and tab.
   - **Encoded by**: Specify the character encoding format.
   - **Error Threshold Percentage**: Specify the percentage of user records that can be invalid before the file is rejected and the import process fails. Records with duplicate email addresses or logins count against the error threshold.

4. Click **Submit**.

**Adding an Active Directory user data source**

You can use an existing Active Directory connection to bring in user data. To add custom attributes for users that are added from an Active Directory source, create and import a data user file that includes the users’ first and last names, email or login information, and the custom attributes you want to use. Symantec Data Loss Prevention automatically associates the file-based user data with the existing user records brought in from your Active Directory source.

Symantec Data Loss Prevention uses this Active Directory filter to retrieve user data (line breaks added for readability):

```plaintext
(&
  (objectClass=user)
  (objectCategory=person)
  (sAMAccountType=805306368)
  (!
    (!
      (&
        (sAMAccountType=805306368)
        (sAMAccountName=-*)
      )
    )

```
Your Active Directory credentials must have permission to access the following user attributes:

- **FIRST_NAME**: givenName
- **LAST_NAME**: sn
- **EMAIL**: mail
- **LOGIN_NAME**: sAMAccountName
- **TELEPHONE**: telephoneNumber
- **TITLE**: title
- **COUNTRY**: co
- **DEPARTMENT**: department
- **EMPLOYEE_ID**: employeeId
- **STREET_ADDRESS**: streetAddress
- **LOCALITY_NAME**: l
- **POSTAL_CODE**: postalCode
- **STATE_OR_PROVINCE**: st
- **OBJECT_DISINGUISHED_NAME**: distinguishedName

Your Active Directory credentials must also have permission to access the RootDSE record. Symantec Data Loss Prevention reads these attributes from RootDSE:

- **namingContexts**
- **defaultNamingContext**
- **rootDomainNamingContext**
- **configurationNamingContext**
- **schemaNamingContext**
- **isGlobalCatalogReady**
- **highestCommittedUSN**

See “Configuring directory server connections” on page 127.

See “Defining custom attributes for user data” on page 1084.

See “Adding a file-based user data source” on page 1085.
To add an Active Directory user data source

1. In the Enforce Server administration console, go to System > Users > Data Sources.


3. In the Add > AD User Source dialog box, enter the following information:
   - Name: Specify a name for the data source.
   - Directory Connection: Select an existing Active Directory connection.
   - Advanced Options > AD Custom Filter: Specify an optional filter for your Active Directory user data source, such as a workgroup. For example:
     
     ```
     (&(region=North America)(!systemAccount=true))
     ```

4. Click Submit.

Note: Best practices suggest that you should refer to directory connection objects with baseDNs in the user section of your directory tree. For example:

```
ou=Users,dc=corp,dc=company,dc=com
```

Importing a user data source

After you have added your user data sources, you can schedule Symantec Data Loss Prevention to regularly import data from those data sources to ensure that your user data is always up to date. You can also import a user data source manually.

Records with duplicate logins or email addresses are excluded from user data source imports. The number of records excluded from the import is displayed at the end of the import process, and the duplicate information appears in the logs.

To view details for a user data source import, click the Status link.

To schedule import of a user data source.

1. In the Enforce Server administration console, go to System > Users > Data Sources.

2. On the Data Source Management page, click the Schedule icon for your desired data source.

3. Choose one of these options for scheduling:
   - Once: Specify a single day and time for user data import.
   - Daily: Specify a time for daily import of the user data source.
- **Weekly**: Specify a day and time for weekly import of the user data source.
- **Monthly**: Specify a day and time for monthly import of the user data source.

4. Click **Submit**.

**To import a data source manually**

1. In the Enforce Server administration console, go to **System > Users > Data Sources**.

2. On the **Data Source Management** page, select the data source you want to import.

3. Click **Import**.

**To view data source import details**

1. In the Enforce Server administration console, go to **System > Users > Data Sources**.

2. On the **Data Source Management** page, click the **Status** link for your desired data source.

   The **Import Details** dialog box appears.

3. The **Import Details** dialog box displays the following information for all imports:
   - **Name**: the name of the imported data source.
   - **Status**: Done, Completed with Errors, Failed.
   - **Queued at**: the time that the data source import was entered in the import queue.
   - **Started at**: the start time of the data source import.
   - **Completed at**: the completion time of the data source import.

   For successful imports and imports completed with errors, the **Import Details** dialog box displays the following additional information:
   - **Added records**: the number of added user records
   - **Updated records**: the number of updated user records
   - **Skipped errored records**: the number of records skipped because of errors in the user data source
   - **Skipped duplicate records**: the number of records skipped because of duplicate user data

   For failed imports, the **Import Details** dialog box displays the following additional information:
Viewing the user list

The user list displays all users that you have entered in Symantec Data Loss Prevention. In the user list, you can view the names, email addresses, and domain and login information for each user. You can sort the list first or last name, and you can search the list by name, email address, domain, or login. Clicking on an individual user's name takes you to the user detail view.

See “Viewing user details” on page 1090.

The user list does not display incident data, only user data.

To view the user list

1 In the Enforce Server administration console, go to Incidents > Users > User List.

2 To sort the user list by first or last name, click one of the sort icons in the appropriate column.

3 To search the user list, enter your search term in the search field at the upper-right corner of the list. You can search on the user's first and last name, login, and email address. Only one search term is handled at a time.

Viewing user details

The user snapshot shows all user information and incidents for a specific user. You reach the user detail view by clicking a user's name on the user list. You can also export the user snapshot to a CSV file.

See “Viewing the user list” on page 1090.

To view user details

1 In the Enforce Server administration console, go to Incidents > Users > User List.

2 Click the name of the user for whom you want to view details.

3 On the User page, you can view a list of incidents, as well as user information, standard attributes, and custom attributes.

4 To export the user snapshot to a CSV file, click Export.
Working with the user risk summary

The user risk summary displays all users who have incidents associated with them. You can sort and filter the user risk summary to gain insight into the user risk in your organization. For example, you can view incidents that are associated with specific policies, or with custom attributes that you have entered, such as job function or employment status. If you want to return to a particular view of the user risk summary, you can save the URL and bookmark it in your web browser. You can also export data from the user risk summary to a CSV file.

To view the user risk summary

1. In the Enforce Server administration console, go to Incidents > Users > User Risk Summary.
2. To sort the list, click one of the sort icons in one of the columns.
3. To filter the list, select your filter values using the buttons above the user risk summary list:

<table>
<thead>
<tr>
<th>Filter</th>
<th>Default value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Policies</td>
<td>All</td>
<td>Select a policy or policies by expanding the policy group and checking the appropriate box or boxes.</td>
</tr>
<tr>
<td>Attributes</td>
<td>None (0)</td>
<td>Enter up to two custom attributes to filter the list. Select the attribute from the drop-down list, then specify an include or exclude condition and enter your desired values. To add a second attribute filter, click Add Attribute Filter.</td>
</tr>
<tr>
<td>Status</td>
<td>All</td>
<td>Filter the list by incident status.</td>
</tr>
<tr>
<td>Date</td>
<td>Last 7 Days</td>
<td>Filter the list by date or date range.</td>
</tr>
<tr>
<td>Type</td>
<td>All</td>
<td>Filter the list by incident type, such as Email/SMTP, Printer/Fax, or HTTP.</td>
</tr>
<tr>
<td>Severity</td>
<td>All</td>
<td>Filter the list by incident severity. You must select at least one severity level.</td>
</tr>
</tbody>
</table>

4. After you have selected your filter values, click Apply.
5. To save a particular filter configuration, click Get Link and copy the provided URL to your web browser bookmarks.
6. To export data from the user risk summary to a CSV file, click Export. You can export the current page or all pages in the user risk summary.
Implementing lookup plug-ins

This chapter includes the following topics:

- About lookup plug-ins
- Implementing and testing lookup plug-ins
- Configuring the CSV Lookup Plug-In
- Configuring LDAP Lookup Plug-Ins
- Configuring Script Lookup Plug-Ins
- Configuring migrated Custom (Legacy) Lookup Plug-Ins

About lookup plug-ins

A lookup plug-in lets you connect the Enforce Server to an external system to retrieve supplemental data related to an incident. The data is stored as attributes. Lookup plug-ins let you add additional context to incidents to facilitate remediation workflow. For example, consider an email message that triggers an incident. A lookup plug-in can be used to retrieve and display the name and the email address of the sender's manager from a directory server based on the email sender's address.

Lookup plug-ins use incident attributes and custom attributes in coordination with each other. The system generates incident attributes when a policy rule is violated. You define custom attributes for custom incident data. Continuing the example, on detection of the incident, the system generates the incident attribute "sender-email" and populates it with the email address of the sender. The lookup plug-in uses this key-value pair to look up the values for custom attributes "Manager Name" and
"Manager Email" from an LDAP server. The plug-in populates the custom attributes and displays them in the Incident Snapshot.

See “About custom attributes” on page 1076.
See “About using custom attributes” on page 1078.
See “How custom attributes are populated” on page 1078.

Types of lookup plug-ins

Symantec Data Loss Prevention provides several types of lookup plug-ins, including CSV, LDAP, Script, Data Insight, and Custom (Legacy). The following table describes each type of lookup plug-in in more detail.

See “About lookup plug-ins” on page 1092.

Table 50-1 Types of lookup plug-ins

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSV</td>
<td>The CSV Lookup Plug-in lets you retrieve incident data from a comma-separated values (CSV) file uploaded to the Enforce Server. You can configure one CSV Lookup Plug-in per Enforce Server instance.</td>
</tr>
<tr>
<td></td>
<td>See “About the CSV Lookup Plug-In ” on page 1094.</td>
</tr>
<tr>
<td>LDAP</td>
<td>The LDAP Lookup Plug-in lets you retrieve incident data from a directory server, such as Microsoft Active Directory, Novell LDAP, Oracle Directory Server (formerly Sun ONE), or IBM LDAP. You can configure multiple instances of the LDAP Lookup Plug-in.</td>
</tr>
<tr>
<td></td>
<td>See “About LDAP Lookup Plug-Ins” on page 1094.</td>
</tr>
<tr>
<td>Script</td>
<td>The Script Lookup Plug-in lets you write a script to retrieve incident data from any external resource. For example, you can use a Script Lookup Plug-in to retrieve incident data from external resources such as proxy log files or DNS systems. You can configure multiple instances of the Script Lookup Plug-in.</td>
</tr>
<tr>
<td></td>
<td>See “About Script Lookup Plug-Ins” on page 1094.</td>
</tr>
<tr>
<td>Data Insight</td>
<td>The Data Insight Lookup Plug-in lets you retrieve incident data from Symantec Data Insight so that you can locate and manage data at risk. You can configure one Data Insight Lookup Plug-in per Enforce Server instance.</td>
</tr>
<tr>
<td>Custom (Legacy)</td>
<td>The Custom (Legacy) Lookup Plug-in lets you use Java code to retrieve incident data from any external resource.</td>
</tr>
<tr>
<td></td>
<td>See “About Custom (Legacy) Lookup Plug-Ins” on page 1095.</td>
</tr>
</tbody>
</table>

Note: As the name indicates, the Custom (Legacy) Lookup Plug-in is reserved for legacy Java plug-ins. For new custom plug-in development, you must use one of the other types of lookup plug-ins.
About the CSV Lookup Plug-In

The CSV Lookup Plug-In extracts data from a comma-separated values (CSV) file stored on the Enforce Server. The plug-in uses data from the CSV file to populate custom attributes for an incident at the time the incident is generated.

The CSV Lookup Plug-In receives a group of lookup parameters that contain data about an incident from the Enforce Server. One or more of the lookup parameters in the group is mapped to column heads in a CSV file. For example, the `sender-email` lookup parameter might be mapped to the `Email` column in the CSV file. The value in the lookup parameter is used as a key to find a matching value in the corresponding CSV column. When a match is found, the CSV row that contains the matching value provides the data that is returned to the Enforce Server. The Enforce Server uses the data in that row to populate the custom attributes for that incident. For example, if the `sender-email` lookup parameter contains the value `mary.smith@mycompany.com`, the plug-in searches the `Email` column for a row that contains `mary.smith@mycompany.com`. That row is then used to provide the data to populate the custom attributes for the incident.

The CSV Lookup Plug-In uses an in-memory database to process large files.

See “Configuring the CSV Lookup Plug-In” on page 1112.

About LDAP Lookup Plug-Ins

The LDAP Lookup Plug-In pulls data from a live LDAP system (such as Microsoft Active Directory, Novell LDAP, Oracle LDAP, or IBM LDAP). It then uses that data to populate custom attributes for an incident at the time the incident is generated.

The LDAP Lookup Plug-In receives a group of lookup parameters that contain data about an incident from the Enforce Server. These lookup parameters are then used in LDAP queries to pull data out of an existing LDAP directory. For example, the value of the `sender-email` lookup parameter might be compared to the values in the `email` attribute of the directory. If the `sender-email` lookup parameter contains `mary.smith@mycompany.com`, a query can be constructed to search for a record whose `email` attribute contains `mary.smith@mycompany.com`. Data in the record that the search returns is inserted into the custom attributes for the incident.

See “Configuring LDAP Lookup Plug-Ins” on page 1122.

About Script Lookup Plug-Ins

You can write one or more Script Lookup Plug-ins to query data repositories for attribute values. For example, you can write a script that queries a DNS server for information about a sender that is involved in an incident. A Script Lookup Plug-In
can use the output from such scripts to populate custom attributes in incident records.

Unlike the CSV or LDAP Lookup Plug-ins, the Script Lookup Plug-In does not use in-line attribute maps to specify how to look up parameter keys. Instead, you write this functionality into each script as needed.

To implement a Script Lookup Plug-In, you can use any scripting language that reads standard input (stdin) and writes standard output (stdout). The examples in the user interface and in this documentation use Python version 2.6.

See “Configuring advanced plug-in properties” on page 1111.

**About the Data Insight lookup plug-in**

The Symantec Data Insight lookup plug-in retrieves data from a Symantec Data Insight Management Server and uses it to populate attributes for a Network Discover incident at the time the incident is generated. The Data Insight lookup plug-in connects Symantec Data Loss Prevention with Symantec Data Insight to retrieve attribute values. Data Insight can be used to provide granular context to incidents, including up-to-date data owner information. The values for incident attributes are viewed and populated at the **Incident Snapshot** screen.

The Data Insight lookup plug-in requires a Data Insight license separate from Symantec Data Loss Prevention licensing. If your system is not licensed for Data Insight, the Data Insight lookup plug-in is not available. If you are licensed for Data Insight, refer to the **Symantec Data Loss Prevention Data Insight Implementation Guide** for details on integrating with Data Insight.

**About Custom (Legacy) Lookup Plug-Ins**

You can use a Custom (Legacy) Lookup Plug-In to migrate legacy Custom Java Lookup Plug-Ins to the Enforce Server administration console. Because Custom Java Lookup Plug-Ins are no longer the preferred way to create new plug-ins, the information presented here is provided to support organizations using legacy plug-ins but upgrading to Data Loss Prevention version 12. As an alternative to migrating legacy Custom Java Lookup Plug-Ins, consider rewriting such plug-ins using a Script Lookup Plug-In or one of the other supported lookup plug-ins, such as CSV or LDAP.

See “Types of lookup plug-ins” on page 1093.

---

**Note:** Custom (Legacy) Lookup Plug-Ins should only be used for migrating legacy lookup plug-ins implemented using the Java Lookup API. Support for new Custom Java Lookup Plug-Ins are not supported.
About lookup parameters

When an incident is created, the Enforce Server generates incident attributes and populates them with data it captures from the incident. You use one or more incident attributes as lookup parameter keys to retrieve external data and populate custom attributes with values that have been retrieved from the external system. You choose which lookup parameters to use for your lookup plug-ins at the **Lookup Parameters** screen. At least one lookup parameter must be present in the external data source for the lookup to be performed.

While some attributes are created for all incident types, others are specific to the incident type. For example, the incident attribute **sender-email** is specific to SMTP incidents. Attributes specific to Endpoint and Discover incidents are prefaced by an identifier, such as **discover-name** and **endpoint-machine-name**. For administrative convenience, lookup parameters are organized into groups. An incident exposes all of the lookup parameters in each lookup parameter group that is enabled. On lookup, some of the name-value pairs in that group may be valueless depending on the type of incident. For example, the attribute value of the **sender-email** parameter is null for Discover incidents (**sender-email=null**).

Lookup plug-ins do not change the system-defined values of lookup parameters. The plug-in only uses these parameters as keys to perform the lookup and populate custom attributes. For example, if a lookup plug-in uses the **subject** lookup parameter, the value of this attribute is not changed by a value for this attribute in the external data source; the Enforce Server ignores the value after the lookup is made. There are two exceptions, however: **data-owner-name** and **data-owner-email**. These system-defined incident attributes function like custom attributes and their values are populated by retrieved values.

When you map the keys to your data source, the plug-in searches the keys in order until it finds the first matching value. When a matching value is located, the plug-in stops searching for the keys. The plug-in uses the data in the row that contains the first matching value to populate the relevant custom attributes. Therefore, key values are not used in combination, but rather the first value that is found is the key. Because the plug-in stops searching after it finds the first matching value, the order in which you list the keys in your attribute mapping is significant. Refer to the individual attribute mapping topics and examples for nuances among the lookup plug-in attribute mapping syntax.

To perform a lookup, you must map at least one lookup parameter key to a field in your external data source. Each lookup parameter group that you enable is a separate database query for the Enforce Server to perform. All database queries are executed for each incident before lookup. To avoid the performance impact of
unnecessary database queries, you should only enable attribute groups that your
lookup plug-ins require.

Because the plug-in stops searching after it finds the first matching lookup parameter
key-value pair, the order in which you list the keys in your attribute map is significant.
Refer to the attribute mapping examples for the specific type of plug-in you are
implementing.

See “Selecting lookup parameters” on page 1102.

About plug-in deployment

A lookup plug-in is deployed by enabling it through the user interface. Each lookup
plug-in must be enabled, even if there is only one. If multiple plug-ins are enabled,
you chain them together and specify their order of execution.

The selected lookup parameter keys apply globally to all deployed lookup plug-ins.
If plug-ins are reloaded, all deployed plug-ins are reloaded.

You can only deploy one CSV Lookup Plug-in and one Data Insight Lookup Plug-in
per Enforce Server instance.

See “Enabling lookup plug-ins” on page 1107.

About plug-in chaining

When you create a lookup plug-in, you map the lookup parameter keys and custom
attributes to fields in the external data source. All deployed lookup plug-ins receive
a reference to the same attribute map. This allows plug-ins to be chained together
and executed in sequence.

In a lookup plug-in chain, the first plug-in uses the lookup parameters that are
passed to it by the Enforce Server to look up attribute values. The second plug-in
uses data that is passed to it by the first plug-in including the lookup parameters
and any variables created by the previous lookup. This continues in sequence or
all plug-ins in the chain.

A plug-in chain is useful when information must be pulled from different sources to
populate custom attributes for an incident. A chain is also useful when there are
differences or dependencies between the “keys” needed to unlock the correct data.

For example, consider the following plug-in chain:

1. A Script Lookup Plug-in performs a DNS lookup using one or more parameters.
2. A CSV Lookup Plug-in uses the result of the script look up to retrieve incident
data from a CSV file that is an extract from an asset management system.
3. An LDAP Lookup Plug-in uses the result of the CSV lookup to obtain data from a corporate LDAP directory.

See “Chaining lookup plug-ins” on page 1108.

See “Chaining multiple Script Lookup Plug-Ins” on page 1134.

About upgrading lookup plug-ins

Prior to Symantec Data Loss Prevention version 11.6, lookup plug-ins were implemented manually using property files; there was no user interface for configuring lookup plug-ins. The lookup plug-in user interface was introduced in version 11.6.

If you are upgrading to version 12.0 or later, existing lookup plug-ins are automatically upgraded to the new framework and added to the user interface for configuration and deployment. In addition, the plug-in state will be preserved after the upgrade, that is, if a plug-in was enabled before the upgrade it should be turned on in the user interface after the upgrade.

If the upgrade of a lookup plug-in does not succeed, the system displays the following error message:

INFO: IN PROCESS: Errors detected in lookup plugin configuration.
Your lookup plugins may require manual configuration after the upgrade.

In this case, check the plug-in at the System > Lookup Plugins screen and manually configure it following the instructions provided with this documentation. Refer to the Symantec Data Loss Prevention Release Notes for known issues related to the upgrade of lookup plug-ins.

Implementing and testing lookup plug-ins

The following table describes the workflow for implementing and testing lookup plug-ins. Linked sections explain these steps in more detail.

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Decide what external data you want to extract and load into incidents as custom attributes. See “About using custom attributes” on page 1078.</td>
</tr>
<tr>
<td>2</td>
<td>Identify the sources from which custom attribute data is to be obtained and the appropriate lookup plug-in for retrieving this information. See “Types of lookup plug-ins” on page 1093.</td>
</tr>
</tbody>
</table>
**Implementing and testing lookup plug-ins**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Create a custom attribute for each individual piece of external data that you want to include in incident snapshots and reports. See “Configuring custom attributes” on page 1079.</td>
</tr>
<tr>
<td>4</td>
<td>Determine which lookup parameter groups include the specific lookup parameters you need to extract the relevant data from the external sources. See “About lookup parameters” on page 1096.</td>
</tr>
<tr>
<td>5</td>
<td>Configure the plug-in to extract data from the external data source and populate the custom attributes. See “Configuring the CSV Lookup Plug-In” on page 1112. See “Configuring LDAP Lookup Plug-Ins” on page 1122. See “Configuring Script Lookup Plug-Ins” on page 1127. See “Configuring migrated Custom (Legacy) Lookup Plug-Ins” on page 1138.</td>
</tr>
<tr>
<td>6</td>
<td>Enable the plug-in on the Enforce Server. See “Enabling lookup plug-ins” on page 1107.</td>
</tr>
<tr>
<td>7</td>
<td>Set the execution order for multiple plug-ins. See “Chaining lookup plug-ins” on page 1108.</td>
</tr>
<tr>
<td>8</td>
<td>Verify privileges. The end user must have <strong>Lookup Attribute</strong> privileges to use a lookup plug-in to look up attribute values. See “Configuring roles” on page 91.</td>
</tr>
<tr>
<td>9</td>
<td>Generate an incident. The incident must be of the type that exposes one or more incident attributes that you have designated as parameter keys. See “Configuring policies” on page 326.</td>
</tr>
<tr>
<td>10</td>
<td>View the incident details. For the incident you generated, go to the <strong>Incident Snapshot</strong> screen. In the <strong>Attributes</strong> section, you should see the custom attributes you created. Note that they are unpopulated (have no value). If you do not see the custom attributes, verify the privileges and that the custom attributes were created.</td>
</tr>
</tbody>
</table>
Implementing and testing lookup plug-ins

If the lookup plug-in is properly implemented, you see the **Lookup** button available in the **Attributes** section of the **Incident Snapshot**. Once you click **Lookup** you see that the value for each custom attribute is populated. After the initial lookup, the connection is maintained and subsequent incidents will have their custom attributes automatically populated by that lookup plug-in; the remediator does not need to click **Lookup** for subsequent incidents. If necessary you can reload the plug-ins.

See “Troubleshooting lookup plug-ins” on page 1109.

See “Reloading lookup plug-ins” on page 1108.

Managing and configuring lookup plug-ins

The **System > Incident Data > Lookup Plugins** screen is the home page for creating, configuring, and managing lookup plug-ins. Lookup plug-ins are used for remediation to retrieve incident-related data from an external data source and populate incident attributes.

See “About lookup plug-ins” on page 1092.

You create and configure lookup plug-ins at the **Lookup Plugins List Page**.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>New Plugin</strong></td>
<td>Select this option to create a new plug-in.</td>
</tr>
<tr>
<td></td>
<td>See “Creating new lookup plug-ins” on page 1102.</td>
</tr>
<tr>
<td><strong>Modify Plugin Chain</strong></td>
<td>Select this option to enable (deploy) plug-ins and to set the order of lookup for multiple plug-ins.</td>
</tr>
<tr>
<td></td>
<td>See “Enabling lookup plug-ins” on page 1107.</td>
</tr>
<tr>
<td><strong>Lookup Parameters</strong></td>
<td>Select this option to choose which lookup parameter groups to use as keys to populate attribute fields from external data sources.</td>
</tr>
<tr>
<td></td>
<td>See “Selecting lookup parameters” on page 1102.</td>
</tr>
<tr>
<td><strong>Reload Plugins</strong></td>
<td>Select this option to refresh the system after making changes to enabled plug-ins or if the external data is updated. This action automatically performs the enabled lookups in order and populates the incidents as they are created.</td>
</tr>
<tr>
<td></td>
<td>See “Reloading lookup plug-ins” on page 1108.</td>
</tr>
</tbody>
</table>
For each configured lookup plug-in, the system displays the following information at the Lookup Plugins List Page. You use this information to manage lookup plug-ins.

Table 50-4 Managing lookup plug-ins

<table>
<thead>
<tr>
<th>Display field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Execution Sequence</td>
<td>This field displays the order in which the system executes lookup plug-ins. See &quot;Enabling lookup plug-ins&quot; on page 1107.</td>
</tr>
<tr>
<td>Name</td>
<td>This field displays the user-defined name of each lookup plug-in. Click the Name link to edit that plug-in. See &quot;Creating new lookup plug-ins&quot; on page 1102.</td>
</tr>
<tr>
<td>Type</td>
<td>The field displays the type of lookup plug-in. You can configure one CSV and one Data Insight Lookup Plug-in per Enforce Server instance. You can configure multiple instances of the LDAP, Script, and Custom (Legacy) lookup plug-ins. See &quot;Types of lookup plug-ins&quot; on page 1093.</td>
</tr>
<tr>
<td>Description</td>
<td>This field displays the user-defined description of each lookup plug-in. See &quot;Implementing and testing lookup plug-ins&quot; on page 1098.</td>
</tr>
<tr>
<td>Status</td>
<td>The field displays the state of each lookup plug-in, either On (green) or Off (red). To edit the state of a plug-in, click Modify Plugin Chain. See &quot;Enabling lookup plug-ins&quot; on page 1107.</td>
</tr>
</tbody>
</table>

For each configured lookup plug-in, you can perform the following management functions at the Lookup Plugins List Page.

Table 50-5 Sorting and grouping lookup plug-ins

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit</td>
<td>Click the pencil icon in the Actions column to edit the plug-in.</td>
</tr>
<tr>
<td>Delete</td>
<td>Click the X icon in the Actions column to delete the plug-in. You must confirm or cancel the action to execute it.</td>
</tr>
<tr>
<td>Sort</td>
<td>Sort the selected display column in ascending or descending order.</td>
</tr>
<tr>
<td>Group</td>
<td>Group the plug-ins according to the selected display column. For example, where you have multiple plug-ins, it may be useful to group them by Type or by Status.</td>
</tr>
</tbody>
</table>
Creating new lookup plug-ins

You must have Server Administration privileges to create and configure lookup plug-ins.

See “Configuring roles” on page 91.

To create new lookup plug-in

1. Navigate to System > Incident Data > Lookup Plugins in the Enforce Server administration console.
2. Click New Plugin at the Lookup Plugins List Page screen.
3. Select the type of lookup plug-in you want to create and configure it.
   
   **CSV**
   
   See “Configuring the CSV Lookup Plug-In” on page 1112.

   **LDAP**
   
   See “Configuring LDAP Lookup Plug-Ins” on page 1122.

   **Script**
   
   See “Configuring Script Lookup Plug-Ins” on page 1127.

   **Data Insight**
   
   **Custom (Legacy)**
   
   See “Configuring migrated Custom (Legacy) Lookup Plug-Ins” on page 1138.

4. Click Save to apply the lookup plug-in configuration.
   
   The system displays a success (green) message if the plug-in was successfully saved or an error (red) message if the plug-in is misconfigured and could not be saved.

   See “Troubleshooting lookup plug-ins” on page 1109.

5. Click Modify Plugin Chain and enable the lookup plug-in and chain multiple plug-ins.
   
   See “Enabling lookup plug-ins” on page 1107.
   
   See “Chaining lookup plug-ins” on page 1108.

Selecting lookup parameters

The System > Lookup Plugins > Edit Lookup Plugin Parameters page lists the Lookup Parameter Keys that you select to trigger the look up of attribute values.
Lookup parameter keys are organized into attribute groups. Selections made at this screen apply to all lookup plug-ins deployed on the Enforce Server.

To perform a lookup, you must map at least one lookup parameter key to a field in your external data source. Each lookup parameter group that you enable is a separate database query for the Enforce Server to perform. All database queries are executed for each incident before lookup. To avoid the performance impact of unnecessary database queries, you should only enable attribute groups that your lookup plug-ins require.

Because the plug-in stops searching after it finds the first matching lookup parameter key-value pair, the order in which you list the keys in your attribute map is significant. Refer to the attribute mapping examples for the specific type of plug-in you are implementing for details.

See “About lookup parameters” on page 1096.

To enable one or more lookup parameter keys
1. Navigate to **System > Lookup Plugins** in the Enforce Server administration console.
2. Click **Lookup Parameters** at the **Lookup Plugins List Page**.
3. Select (check) one or more attribute groups at the **Edit Lookup Plugin Parameters** page.
   - Click **View Properties** to view all of the keys for that attribute group.
   - Attachment Table 50-6
   - Incident Table 50-7
   - Message Table 50-8
   - Policy Table 50-9
   - Recipient Table 50-10
   - Sender Table 50-11
   - Server Table 50-12
   - Monitor Table 50-13
   - Status Table 50-14
   - ACL Table 50-15
4. **Save** the configuration.
   - Verify the success message indicating that all enabled plug-ins were reloaded.
Table 50-6  Attachment lookup parameters

<table>
<thead>
<tr>
<th>Lookup parameter key</th>
<th>Description and comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>attachment-nameX</td>
<td>Name of the attached file, where X is the unique index to distinguish between multiple attachments, for example: attachment-name1, attachment-size1; attachment-name2, attachment-size2; etc.</td>
</tr>
<tr>
<td>attachment-sizeX</td>
<td>Original size of the attached file, where X is the unique index to distinguish between multiple attachments. See above example.</td>
</tr>
</tbody>
</table>

Table 50-7  Incident lookup parameters

<table>
<thead>
<tr>
<th>Lookup parameter key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>date-detected</td>
<td>Date and time when the incident was detected, for example: date-detected=Tue May 15 15:08:23 PDT 2012.</td>
</tr>
<tr>
<td>incident-id</td>
<td>The incident ID assigned by Enforce Server. The same ID can be seen in the incident report. For example: incident-id=35.</td>
</tr>
<tr>
<td>protocol</td>
<td>The name of the network protocol that was used to transfer the violating message, such as SMTP and HTTP. For example: protocol=Email/SMTP.</td>
</tr>
<tr>
<td>data-owner-name</td>
<td>The person responsible for remediating the incident. This attribute is not populated by the system. Instead, it is set manually in the Incident Details section of the Incident Snapshot screen, or automatically using a lookup plug-in. Reports based on this attribute can automatically be sent to the data owner for remediation.</td>
</tr>
<tr>
<td>data-owner-email</td>
<td>The email address of the person responsible for remediating the incident. This attribute is not populated by the system. Instead, it is set manually in the Incident Details section of the Incident Snapshot screen, or automatically using a lookup plug-in.</td>
</tr>
</tbody>
</table>

Table 50-8  Message lookup parameters

<table>
<thead>
<tr>
<th>Lookup parameter key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>date-sent</td>
<td>Date and time when the message was sent if it is an email. For example: date-sent=Mon Aug 15 11:46:55 PDT 2011.</td>
</tr>
<tr>
<td>subject</td>
<td>Subject of the message if it is an email incident.</td>
</tr>
<tr>
<td>file-create-date</td>
<td>Date that the file was created in its current location, whether it was originally created there, or copied from another location. Retrieved from the operating system.</td>
</tr>
</tbody>
</table>
### Table 50-8 Message lookup parameters (continued)

<table>
<thead>
<tr>
<th>Lookup parameter key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>file-access-date</td>
<td>Date that the file was examined.</td>
</tr>
<tr>
<td>file-created-by</td>
<td>User who placed the file on the endpoint.</td>
</tr>
<tr>
<td>file-modified-by</td>
<td>Fully-qualified user credential for the computer where the violating copy action took place.</td>
</tr>
<tr>
<td>file-owner</td>
<td>The name of the user or the computer where the violating file is located.</td>
</tr>
<tr>
<td>discover-content-root-path</td>
<td>Root of path of the file which caused a Discover incident.</td>
</tr>
<tr>
<td>discover-location</td>
<td>Full path of the file that caused a Discover incident.</td>
</tr>
<tr>
<td>discover-name</td>
<td>The name of the violating file.</td>
</tr>
<tr>
<td>discover-extraction-date</td>
<td>Date a subfile was extracted from an encapsulated file during Discover scanning.</td>
</tr>
<tr>
<td>discover-server</td>
<td>The name of repository to be scanned.</td>
</tr>
<tr>
<td>discover-notes-database</td>
<td>Specific attribute for Discover scan of Lotus Notes repository.</td>
</tr>
<tr>
<td>discover-notes-url</td>
<td>Specific attribute for Discover scan of Lotus Notes repository.</td>
</tr>
<tr>
<td>endpoint-volume-name</td>
<td>The name of the local drive where an endpoint incident occurred.</td>
</tr>
<tr>
<td>endpoint-dos-volume-name</td>
<td>The Windows name of the local drive where an endpoint incident occurred.</td>
</tr>
<tr>
<td>endpoint-application-name</td>
<td>Name of application most recently used to open (or create) the violating file.</td>
</tr>
<tr>
<td>endpoint-application-path</td>
<td>Path of the application that was used to create or open the violating file.</td>
</tr>
<tr>
<td>endpoint-file-name</td>
<td>The name of the violating file.</td>
</tr>
<tr>
<td>endpoint-file-path</td>
<td>Location the file was copied to.</td>
</tr>
</tbody>
</table>

### Table 50-9 Policy lookup parameter

<table>
<thead>
<tr>
<th>Lookup parameter key</th>
<th>Description and comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>policy-name</td>
<td>The name of the policy that was violated, for example: policy-name=Keyword Policy.</td>
</tr>
</tbody>
</table>
### Table 50-10  Recipient lookup parameters

<table>
<thead>
<tr>
<th>Lookup parameter key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>recipient-emailX</td>
<td>The email address of the recipient, where X is the unique index to distinguish between multiple recipients; for example: recipient-email1, recipient-ip1, recipient-url1, recipient-email2, recipient-ip2, recipient-url2; etc.</td>
</tr>
<tr>
<td>recipient-ipX</td>
<td>The IP address of the recipient, where X is the unique index to distinguish between multiple recipients. See above example.</td>
</tr>
<tr>
<td>recipient-urlX</td>
<td>The URL of the recipient, where X is the unique index to distinguish between multiple recipients. See above example.</td>
</tr>
</tbody>
</table>

### Table 50-11  Sender lookup parameters

<table>
<thead>
<tr>
<th>Lookup parameter key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sender-email</td>
<td>The email address of the sender for Network Prevent for Email (SMTP) incidents.</td>
</tr>
<tr>
<td>sender-ip</td>
<td>The IP address of the sender for Endpoint and Network incidents on protocols other than SMTP.</td>
</tr>
<tr>
<td>sender-port</td>
<td>The port of the sender for Network incidents on protocols other than SMTP.</td>
</tr>
<tr>
<td>endpoint-user-name</td>
<td>The user who was logged on to the endpoint when the violation occurred.</td>
</tr>
<tr>
<td>endpoint-machine-name</td>
<td>Name of the endpoint where the violating file resides.</td>
</tr>
</tbody>
</table>

### Table 50-12  Server lookup parameters

<table>
<thead>
<tr>
<th>Lookup parameter key</th>
<th>Description and comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>server-name</td>
<td>The name of the detection server that reported the incident. This name is user-defined and entered when the detection server is deployed. For example: server-name=My Network Monitor.</td>
</tr>
</tbody>
</table>

### Table 50-13  Monitor lookup parameters

<table>
<thead>
<tr>
<th>Lookup parameter key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>monitor-name</td>
<td>The name of the detection server that reported the incident. This name is user-defined and entered when the detection server is deployed. For example: server-name=My Network Monitor.</td>
</tr>
<tr>
<td>monitor-host</td>
<td>The IP address of the detection server that reported the incident. For example: monitor-host=127.0.0.1</td>
</tr>
</tbody>
</table>
Table 50-13  Monitor lookup parameters (continued)

<table>
<thead>
<tr>
<th>Lookup parameter key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>monitor-id</td>
<td>The system-defined numeric identifier of the detection server. For example: monitor-id=1.</td>
</tr>
</tbody>
</table>

Table 50-14  Status lookup parameter

<table>
<thead>
<tr>
<th>Lookup parameter key</th>
<th>Description and comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>incident-status</td>
<td>Current status of the incident. For example: incident-status=incident.status.New.</td>
</tr>
</tbody>
</table>

Table 50-15  ACL lookup parameters

<table>
<thead>
<tr>
<th>Lookup parameter key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>acl-principalX</td>
<td>A string that indicates the user or group to whom the ACL applies.</td>
</tr>
<tr>
<td>acl-typeX</td>
<td>A string that indicates whether the ACL applies to the file or to the share.</td>
</tr>
<tr>
<td>acl-grant-or-denyX</td>
<td>A string that indicates whether the ACL grants or denies the permission.</td>
</tr>
<tr>
<td>acl-permissionX</td>
<td>A string that indicates whether the ACL denotes read or write access.</td>
</tr>
</tbody>
</table>

Enabling lookup plug-ins

To enable a lookup plug-in you have to change its status from **Off**, which is the initial status of a plug-in after it is configured, to **On**. The **System > Incident Data > Lookup Plugins > Modify Plugin Chain** is where you enable lookup plug-ins.

See “About plug-in deployment” on page 1097.

To enable a lookup plug-in

1. Navigate to **System > Incident Data > Lookup Plugins** in the Enforce Server administration console.
2. Click **Modify Plugin Chain** at the **Lookup Plugins List Page**.
3. In the **Dedicated Actions** field, select (check) the **On** option.
4. Click **Save** to apply the configuration.

If the plug-in cannot be loaded the system will report an error and the plug-in state will remain **Off**. In this case, check the latest Tomcat log file for the error. See “Troubleshooting lookup plug-ins” on page 1109.
Chaining lookup plug-ins

The System > Incident Data > Lookup Plugins > Modify Lookup Plugin Execution Chain is where you enable lookup plug-ins and specify the execution order when multiple lookup plug-ins are deployed.

See “Enabling lookup plug-ins” on page 1107.

If you enable multiple lookup plug-ins you must specify their order of execution. When plug-ins are chained together, input from a previous plug-in is used as attributes by subsequent lookup plug-ins.

See “About plug-in deployment” on page 1097.

To chain multiple lookup plug-ins

1. Navigate to System > Incident Data > Lookup Plugins in the Enforce Server administration console.
2. Click Modify Plugin Chain at the Lookup Plugins List Page.
3. In the Execution Sequence field, select the execution order from the drop-down menu.
4. Click Save to apply the chaining configuration.

Reloading lookup plug-ins

If you have changed the configuration of a lookup plug-in, or the external data has changed, you need to reload the lookup plug-ins. Reloading plug-ins refreshes the system and automatically performs the enabled lookups in order and populates the incident attributes as incidents are detected.

In addition to reloading plug-ins if changes are made, you may need to reload lookup plug-ins if any of the following are true:

- A plug-in was problematic and the system unloaded it, but now the problem is fixed.
- The network was down or disconnected for some reason, but it is functioning properly now.
- A plug-in stores data in a cache, and you want to update the cache manually.
To reload lookup plug-ins

1. Navigate to **System > Incident Data > Lookup Plugins** in the Enforce Server administration console.
2. Click **Reload Plugins** to reload all enabled plug-ins.

Note: Administrators can also reload lookup plug-ins from the **Custom Attributes** tab of the **System > Incident Data > Attributes** screen.

Troubleshooting lookup plug-ins

Symantec Data Loss Prevention provides logging and error messages specific to lookup plug-ins. The most common errors involve the failure of a plug-in to load due to one or more misconfigurations. If a lookup plug-in fails to load, the exception is logged as a warning at the system events screen and in the Tomcat log. In addition, the attribute map and plug-in execution chain is logged in the Tomcat log.

To troubleshoot lookup plug-in errors

1. Navigate to the **System > Servers > Overview** screen and look for any warnings in the **Recent Error and Warning Events** table at the bottom of the page.
2. On the Enforce Server host, open the log file \SymantecDLP\protect\Enforce\logs\tomcat\localhost.<date>.log.
   - Table 50-16
4. Configure detailed logging for lookup plug-ins if the plug-in fails but errors are not logged.
   - See “Configuring detailed logging for lookup plug-ins” on page 1110.
5. Refer to the troubleshooting topics for specific plug-ins.
   - See “Testing and troubleshooting the CSV Lookup Plug-In” on page 1118.
   - See “Testing and troubleshooting LDAP Lookup Plug-ins” on page 1125.
   - See “Script Lookup Plug-In tutorial” on page 1134.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
</table>
| Lookup plug-in fails to load  | If the plug-in failed to load, search for a message in the log file similar to the following:  
SEVERE  
[com.vontu.enforce.workflow.attributes.AttributeLookupLoader]  
Error loading plugin [<Plugin_Name>]  
Note the “Cause” section that follows this type of error message. Any such entries will explain why the plug-in failed to load.                                                                                                                                 |
| Attributes are not populated by the lookup | If the plug-in loads but attributes are not populated, look in the log for the attribute map. Verify that values are being populated, including for the lookup parameters that you enabled. To do this, search for a lookup parameter key that you have enabled, such as sender-email. |

**Configuring detailed logging for lookup plug-ins**

The system provides detailed logging configuration for lookup plug-ins. You can configure the logging levels for lookup plug-ins in the **System > Logs > Configuration** tab. Configuring the logs for lookup plug-ins provides more detailed log messages in the Tomcat localhost log.

See “Troubleshooting lookup plug-ins” on page 1109.

To configure and collect the logs for lookup plug-ins

1. Navigate to the **System > Servers > Logs** screen.
2. Select the **Configuration** tab.
3. For the **Enforce Server**, select the **Custom Attribute Lookup Logging** entry from the **Diagnostic Logging Setting** drop-down menu.
4. Click **Configure Logs**.
5. In the **Collection** tab, select the following **Debug** and **Trace Logs** for the Enforce Server.
6. Click **Collect Logs**.
7. At the bottom of the page, click **Download** to download the logs. Use the **Refresh** button to refresh the page. The logs are packaged in a ZIP file.
8. Open the ZIP file or save it to the file system and extract it.
9. Navigate to directory `\SymantecDLPLogs.zip\Enforce\logs\tomcat`.
10. Open the file `localhost.<date>.log` using a text editor. Open the file with the most recent date.
Search for the name of the lookup plug-in. You should see several messages.

If necessary, verify the lookup plug-in logging properties in file \Protect\config\ManagerLogging.properties.

```
com.vontu.logging.ServletLogHandler.level=FINEST
com.vontu.enforce.workflow.attributes.CustomAttributeLookup.level=FINEST
com.vontu.lookup.level=FINEST
```

### Configuring advanced plug-in properties

The file SymantecDLP\protect\config\Plugins.properties contains several advanced properties for configuring lookup plug-ins. Generally these properties do not need to be modified unless necessary according to the following descriptions.

<table>
<thead>
<tr>
<th>Property</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AttributeLookup.output.parameters</td>
<td><code>data-owner-name, data-owner-email</code></td>
<td>The Attribute Lookup Output Parameters property is a comma-separated list that specifies which parameters can be modified by lookup plug-ins. Generally, the values for lookup parameter keys are set by the system when an incident is created. Because these parameters are used to look up custom attribute values, they are not modified by the looked up values if they are different from the system-defined values. However, this property lets you modify the output of the <strong>Data Owner Name</strong> and <strong>Data Owner Email</strong> attributes based on retrieved values. These parameters are specified in lookup plug-in configurations and scripts using the same syntax as custom attributes. Both attributes are enabled by selecting the <strong>Incident</strong> attribute group. You can disable this feature by removing one or both of the entries. If removed, the output for either parameter is not changed by a looked up value.</td>
</tr>
</tbody>
</table>
To avoid a system freeze due to unanticipated lookup problems, the Enforce Server limits the amount of time given to each lookup plug-in. This timeout is configured in the `com.vontu.api.incident.attributes.AttributeLookup.timeout` property in the Plug-ins.properties file.

If a lookup exceeds the 60-second default timeout, the incident attribute framework unloads the associated plug-in. If there is a runaway lookup the Enforce Server cannot execute that particular lookup for any subsequent incidents. If the plug-in times out frequently, you can extend the timeout by modifying the period (in milliseconds).

**Note:** Note that increasing this value may result in slower incident processing times because of slow attribute lookups.

### Property: AttributeLookup.timeout

<table>
<thead>
<tr>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>60000</td>
<td>To avoid a system freeze due to unanticipated lookup problems, the Enforce Server limits the amount of time given to each lookup plug-in. This timeout is configured in the <code>com.vontu.api.incident.attributes.AttributeLookup.timeout</code> property in the Plug-ins.properties file. If a lookup exceeds the 60-second default timeout, the incident attribute framework unloads the associated plug-in. If there is a runaway lookup the Enforce Server cannot execute that particular lookup for any subsequent incidents. If the plug-in times out frequently, you can extend the timeout by modifying the period (in milliseconds). <strong>Note:</strong> Note that increasing this value may result in slower incident processing times because of slow attribute lookups.</td>
</tr>
</tbody>
</table>

### Property: AttributeLookup.auto

<table>
<thead>
<tr>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>true</td>
<td>The automatic lookup property specifies whether the lookup should be triggered automatically when a new incident is detected. This property automatically populates incident attributes using the deployed lookup plug-ins after the initial lookup is executed. You can disable auto-lookup by changing the property value to <code>false</code>. If this property is disabled, remediators must click <strong>Lookup</strong> for every incident. After setting the <code>AttributeLookup.auto</code> property to <code>false</code>, make sure you restart the Vontu Incident Persister service. If you do not restart the service the custom attributes will continue to be automatically populated.</td>
</tr>
</tbody>
</table>

### Property: AttributeLookup.reload

<table>
<thead>
<tr>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>false</td>
<td>The automatic plug-in reload property specifies whether all plug-ins should be automatically reloaded each day at 3:00 A.M. Change to <code>true</code> to enable.</td>
</tr>
</tbody>
</table>

## Configuring the CSV Lookup Plug-In

You can only configure one CSV Lookup Plug-In per Enforce Server instance.

See “About the CSV Lookup Plug-In” on page 1094.
<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create custom attributes.</td>
<td>Define the custom attributes for the information you want to look up. See “Setting the values of custom attributes manually” on page 1080.</td>
</tr>
<tr>
<td>2</td>
<td>Create the CSV data source file.</td>
<td>The CSV file that contains the data to be used to populate custom attributes for incident remediation. See “Requirements for creating the CSV file” on page 1114.</td>
</tr>
<tr>
<td>3</td>
<td>Create a new CSV plug-in.</td>
<td>See “Creating new lookup plug-ins” on page 1102.</td>
</tr>
<tr>
<td>4</td>
<td>Name and describe the plug-in.</td>
<td>The name string limited to 100 characters. It is recommended that you enter a description for the lookup plug-in.</td>
</tr>
<tr>
<td>5</td>
<td>Specify the file path.</td>
<td>Provide the path to the CSV file. The CSV file must be local to the Enforce Server. See “Specifying the CSV file path” on page 1115.</td>
</tr>
<tr>
<td>6</td>
<td>Choose the File Delimiter.</td>
<td>Specify the delimiter that is used in the CSV file. The pipe delimiter [|] is recommended. See “Choosing the CSV file delimiter” on page 1115.</td>
</tr>
<tr>
<td>7</td>
<td>Choose the File Encoding.</td>
<td>For example: UTF-8 See “Selecting the CSV file character set” on page 1116.</td>
</tr>
<tr>
<td>8</td>
<td>Map the attributes.</td>
<td>Map the system and the custom attributes to the CSV file column heads and define the keys to use to extract custom attribute data. Keys map to column heads, not custom attributes. The syntax is as follows: attr.attribute_name=column_head keys=column_head_first:column_head_next:column_head_3rd See “Mapping attributes and parameter keys to CSV fields” on page 1116.</td>
</tr>
<tr>
<td>9</td>
<td>Save the plug-in.</td>
<td>Verify that the correct save message for the plug-in is displayed.</td>
</tr>
<tr>
<td>9</td>
<td>Select the Lookup Parameter Keys.</td>
<td>Define the keys which are used to extract custom attribute data. See “Selecting lookup parameters” on page 1102.</td>
</tr>
<tr>
<td>10</td>
<td>Enable the lookup plug-in.</td>
<td>The CSV Lookup Plug-In must be enabled on the Enforce Server. See “Enabling lookup plug-ins” on page 1107.</td>
</tr>
<tr>
<td>11</td>
<td>Troubleshoot the plug-in.</td>
<td>See “Testing and troubleshooting the CSV Lookup Plug-In” on page 1118.</td>
</tr>
</tbody>
</table>
Table 50-18 Configuring the CSV Lookup Plug-In (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>11</td>
<td>Test the lookup plug-in.</td>
<td></td>
</tr>
</tbody>
</table>

Requirements for creating the CSV file

The CSV Lookup Plug-In requires a CSV file that is stored on the Enforce Server. When creating a CSV file, keep in mind the following requirements:

- The first data row of the CSV file must contain column headers.
- Column header fields cannot be blank.
- Make sure that there are no white spaces at the end of the column header fields.
- Make sure that all rows have the same number of columns.
- Each row of the file must be on a single, non-breaking line.
- One or more columns in the file are used as key-fields for data lookups. You specify in the attribute mapping which column heads are to be used as key fields. You also specify the key field search order. Common key fields typically include email address, Domain\UserName (for Endpoint incidents), and user name (for Storage incidents).
- The data values in the key field columns must be unique. If multiple columns are used as key fields (for example, EMP_EMAIL and USER_NAME), the combination of values in each row must be unique.
- Fields in data rows (other than the column header row) can be empty, but at least one key field in each row should contain data.
- The same type of delimiter must be used for all values in the column header and data rows.
- If the CSV file is read-only, make sure that the CSV file has a new line at the end of the file. The system will attempt to add a new line to the file on execution of the plug-in, but if the file is read-only the system cannot do this and the plug-in will not load.
- For Discover scan incidents, the file-owner lookup parameter does not include a domain. To use file-owner as the key, the CSV file column that corresponds to file-owner should be in the format owner. The format DOMAIN\owner does not result in a successful lookup. This restriction only applies to Discover incidents, other kinds of incidents can include a domain.

For example, the column-header row and a data-row of a pipe-delimited CSV file might look like:
If more than 10% of the rows in the CSV file violate any of these requirements, the Plugin does not load.

- For accuracy in the lookup, the CSV file needs to be kept up to date.

See “About the CSV Lookup Plug-In” on page 1094.

Specifying the CSV file path

To configure the CSV Lookup Plug-In you must specify the **CSV File Path** property for the location of the CSV file. The CSV file must be stored locally on the Enforce Server.

You can enter either an absolute file path or a relative file path. For example:

- `../../../../symantecDLP_csv_lookup_file/senders2.csv`
- `C:/SymantecDLP_csv_lookup_file/senders2.csv`

On Windows you can use either forward or backward slashes. For example:

- `C:/SymantecDLP/Protect/plugins/employees.csv`
- `C:\SymantecDLP\Protect\plugins\employees.csv`

On Linux you can only use forward slashes.

The system validates the file path when you save the configuration. If the system cannot locate the file it reports an error and does not let you save the configuration. Make sure that the CSV file is not open and is stored locally to the Enforce Server.

Choosing the CSV file delimiter

Use the **Delimiter** property to specify the CSV file delimiter.

The following delimiters are supported:

- Comma
- Pipe
- Tab
- Semicolon

The recommended practice is to use the pipe character ("|") as the delimiter. Use of the comma delimiter is discouraged because commas are often included in data fields as part of the data. For example, a street address might contain a comma.
Selecting the CSV file character set

You must specify the character set for the CSV file. The default is UTF-8.
All supported character sets are listed in the drop-down menu.

Mapping attributes and parameter keys to CSV fields

To configure the CSV Lookup Plug-In, you enter the execution code in the **Attribute Mapping** field. This code maps the lookup parameter keys and custom attributes to column headers in the CSV file. One or more attribute=column pairs is used to map the incident attributes to the column heads. The `keys` property in the attribute map identifies which columns to use for the lookup.

Here is an example CSV file attribute mapping:

```
attr.Store-ID=store-id
attr.Store\ Address=store_address
attr.incident-id=incident-id-key
attr.sender-email=sender-email-key
keys=sender-email-key:incident-id-key
```

With this example in mind, adhere to the following syntactical rules when mapping the attributes to CSV file data.

**Table 50-19**  
Attribute mapping syntax for CSV files

<table>
<thead>
<tr>
<th>Example and syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>attr.Store-ID=store-id</code></td>
<td>Attributes map to column header names in attribute-column pairs. Here, <code>Store-ID</code> is a custom attribute and <code>store-id</code> is a column header name in the CSV file.</td>
</tr>
<tr>
<td><code>attr.attribute_name=column_head</code></td>
<td>Spaces are allowed before and after the = sign (except for the LDAP Lookup Plugin). Blank spaces in attribute and column names must be preceded by a backslash. Here, the custom attribute is named <code>Store Address</code>.</td>
</tr>
<tr>
<td>Example and syntax</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------</td>
</tr>
<tr>
<td><code>attr.Store-ID=store-id</code>&lt;br&gt;<code>attr.Store\ Address=store_address</code>&lt;br&gt;<code>attr.attribute_name=column_head</code>&lt;br&gt;<code>attr.attribute_name=column_head</code></td>
<td>Each attribute-column pair is entered on a separate line.</td>
</tr>
<tr>
<td><code>attr.Store\ Address=STORE_ADDRESS</code></td>
<td>All syntax is case sensitive. The identifier <code>attr.</code> must be lower case. Incident attributes must match the system-definition string precisely.</td>
</tr>
<tr>
<td><code>attr.incident-id=incident-id-key</code>&lt;br&gt;<code>attr.sender-email=sender-email-key</code>&lt;br&gt;<code>attr.attribute_name=column_head</code></td>
<td>System attributes are mapped to column header names. The column name does not have to match the system attribute, nor does it require the word “key”.</td>
</tr>
<tr>
<td><code>keys=sender-email-key:incident-id-key</code>&lt;br&gt;<code>keys=&lt;column_name_1st&gt;:column_name_2nd</code></td>
<td>Keys map the column name headers to the incident attribute keys you want to use to look up the attribute values. The keys map to the column header names, not to the incident attribute names. The order of appearance determines priority. Once the first incident is located in the CSV file, the other attributes are populated.</td>
</tr>
</tbody>
</table>

**CSV attribute mapping example**

Consider another mapping example for the CSV Lookup Plug-In:

```
attr.sender-email = Email
attr.endpoint-user-name = Username
attr.file-owner = File-owner
attr.sender-ip = IP

attr.First\ Name = FIRST_NAME
attr.Last\ Name = LAST_NAME
attr.Business\ Unit = Org
attr.Manager\ Email = Mgr_email
attr.Employee\ ID = EMPLOYEE_NUMBER
attr.Phone\ Number = Phone
attr.Manager\ Last\ Name = Mgr_lastname
```
attr.Manager\ First\ Name = Mgr_firstname
attr.Employee\ Email = Emp_email

keys = Email:Username:File-owner:IP

Note the following about this example:

- The first four lines map lookup parameters to column headers.
- The remaining nine lines map custom attributes to column headers.
- A backslash is prepended before each instance of a white-space character in an attribute or column name. In this example, attr.Employee\ Email = Emp_email maps the Employee Email custom attribute to the emp_email column head.
- The keys property identifies and sequences the keys that are used to extract custom attribute data. Each key is separated with a colon. The order in which you list the keys determines the search sequence. In this example (keys = Email:Username:File-owner:IP), the plug-in first searches the Email column for a value that matches the lookup parameter value of the sender-email which has been passed to the plug-in. If no matching value is found, the plug-in then searches the Username column for a value that matches the endpoint-user-name lookup parameter. If no matching value is found in that column, it then goes on to search the next key (File-owner), and so on.
- The plug-in stops searching after it finds the first matching parameter key-value pair. As a result, the order in which you list the keys column heads is significant.

Testing and troubleshooting the CSV Lookup Plug-In

If the plug-in does not load, or if the plug-in loads but fails to populate the custom attributes with looked up values, troubleshoot as follows:

To test and troubleshoot the CSV Lookup Plug-In

1. Verify that the CSV file conforms to the requirements. If more than 10% of the rows in the CSV file violates any of the CSV file requirements, the lookup plug-in does not load.

   See “Requirements for creating the CSV file” on page 1114.

2. Verify that the delimiter you selected is the one used in the CSV file. Note that the system defaults to comma, whereas the recommendation is pipe.

   See “Choosing the CSV file delimiter” on page 1115.

3. Check the attribute mapping. There is no system-provided validation for the attribute map. Make sure that your attribute map adheres to the syntax.
Common syntactical errors include:

- Every entry in the attribute mapping field is case sensitive.
- Spaces in attribute and column names must be identified by a backslash.
- For every attribute=column pair, the data to the right of the equals sign (=) must be a column head name.
- Keys are column header names, not incident attributes.

4 If the plug-in fails to load, or the plug-in fails to return looked up values, check the file \SymantecDLP\Protect\logs\tomcat\localhost.<latest-date>.log.

- Check that the database and table are created and that the CSV file is loaded into the table. To verify, look for lines similar to the following:

```
INFO [com.vontu.lookup.csv.CsvLookup]
creating database
create table using SQL
importing data from file into table LOOKUP having columns
```

**Note:** To process large files, the CSV Lookup Plug-In uses an in-memory database (Apache Derby). Only one instance of Derby can be running per Enforce Server. If a previous instance is running, the CSV Lookup Plug-In does not load. If the database and table are not created, restart the Vontu Manager service and reload the plug-in.

5 If the plug-in fails to return looked up values, check the file \SymantecDLP\Protect\logs\tomcat\localhost.<latest-date>.log.

Look for a warning message indicating that "SQL query did not return any results." In this case, make sure that the attribute mapping matches the CSV column heads and reload the plug-in if changes were made.

See “Troubleshooting lookup plug-ins” on page 1109.

**CSV Lookup Plug-In tutorial**

This tutorial provides instructions for implementing a simple CSV Lookup Plug-In. The purpose of this tutorial is to introduce you to the lookup plug-in feature from a hands-on approach. If you have experience generating incidents, creating custom attributes, and implementing lookup plug-ins this tutorial may be too basic.

See “About the CSV Lookup Plug-In” on page 1094.
To implement a simple CSV Lookup Plug-In

1. Create the following custom attributes at System > Attributes > Custom Attributes:
   - Manager
   - Department
   - Email Address

2. Create a pipe delimited CSV file containing the following data.

   SENDER|MGR|DEPT|EMAIL
   emp@company.com|Merle Manager|Engineering|rmanager@company.com

3. Save the CSV file to the same volume drive where the Enforce Server is installed.
   For example:
   C:\SymantecDLP\Protect\plugins\lookup\csv_lookup_file.csv.

4. Create a basic keyword policy.
   See “Configuring policies” on page 326.

5. Generate an email incident.
   To trigger the lookup for this example, the incident should be an SMTP incident with the sender of the email being the address emp@company.com. Change the value of sender in the CSV to match the actual value of the email sender.


7. Configure the lookup plug-in as follows:
   - Name: CSV Lookup Plug-in
   - Description: Look up manager of email sender from CSV file.
   - CSV File Path: C:\SymantecDLP\Protect\plugins\lookup\csv_lookup_file.csv
   - Delimiter: Pipe [|]
   - File Encoding: UTF-8
   - Attribute Mapping
     Map the system-defined attributes, custom attributes, and lookup parameter keys on separate lines as follows:
attr.sender-email=SENDER
attr.Manager=MGR
attr.Department=DEPT
attr.Email\ Address=EMAIL
keys=SENDER

attr.sender-email = SENDER  This is a lookup parameter key from the Sender group. It is mapped to the corresponding column header in the CSV file.
attr.Manager = MGR  This is a custom attribute defined in Step 1. It is mapped to the corresponding column header in the CSV file.
attr.Department = DEPT  This is a custom attribute defined in Step 1. It is mapped to the corresponding column header in the CSV file.
attr.Email\ Address = EMAIL  This is a space delimited custom attribute defines in Step 1. It is mapped to the corresponding column head in the CSV file.
keys = SENDER  This line declares one key to perform the lookup. The lookup ceases once the first key is located, and the attribute values are populated.

8  Save the plug-in configuration.
9  Select System > Lookup Plugins > Lookup Parameters and select the following lookup parameter key group:

Sender  This group contains the sender-email key.

10  Select System > Lookup Plugins > Modify Plugin Chain and enable the plug-in.
11  Open the Incident Snapshot for the incident generated in the Step 4.
12  Verify that the unpopulated custom attributes you created in Step 1 appear in the Attributes pane to the right of the screen.
    If they do not, complete Step 1.
13  Verify that the "Lookup" button appears in the Attributes pane above the custom attributes.
    If it does not, verify that the Lookup Attributes privilege is granted to the user.
    Click Reload Plugin after making any changes.
14 Click the **Lookup** button.

The custom attributes should be populated with values looked up and retrieved from the CSV file.

15 Troubleshoot the plug-in as necessary.

See “Testing and troubleshooting the CSV Lookup Plug-In” on page 1118.

## Configuring LDAP Lookup Plug-Ins

To configure one or more LDAP Lookup Plug-ins, complete these tasks.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create custom attributes.</td>
<td>See “Configuring custom attributes” on page 1079.</td>
</tr>
<tr>
<td>2</td>
<td>Configure a connection to the LDAP server.</td>
<td>A functioning connection to an LDAP server must be available. See “Requirements for LDAP server connections” on page 1123. The connection to the LDAP server can be configured from the link in the LDAP Lookup Plug-In. See “Configuring directory server connections” on page 127.</td>
</tr>
<tr>
<td>3</td>
<td>Create a new LDAP Lookup Plug-In.</td>
<td>See “Creating new lookup plug-ins” on page 1102.</td>
</tr>
</tbody>
</table>
| 4    | Map the attributes. | Map the attributes to the corresponding LDAP directory fields. The syntax is as follows:

```plaintext
attr.CustomAttributeName = search_base:
  (search_filter=$variable$):
ldapAttribute
```

See “Mapping attributes to LDAP data” on page 1123. See “Attribute mapping examples for LDAP” on page 1124. |
| 5    | Save and enable the plug-in. | The LDAP Lookup Plug-In must be enabled on the Enforce Server. See “Enabling lookup plug-ins” on page 1107. |
| 6    | Test and troubleshoot the LDAP Lookup Plug-In. | See “Troubleshooting lookup plug-ins” on page 1109. |
Requirements for LDAP server connections

The following conditions must be met for Symantec Data Loss Prevention to establish a connection with an LDAP directory:

- The LDAP directory must be running on a host that is accessible to the Enforce Server.
- There must be an LDAP account that the Symantec Data Loss Prevention can use. This account must have read-only access. You must know the user name and password of the account.
- You must know the Fully Qualified Domain Name (FQN) of the LDAP server (the IP address cannot be used).
- You must know the port on the LDAP server which the Enforce Server uses to communicate with the LDAP server. The default is 389.

You can use an LDAP lookup tool such as Softerra LDAP Browser to confirm that you have the correct credentials to connect to the LDAP server. Also confirm that you have the right fields defined to populate your custom attributes.

See “About LDAP Lookup Plug-Ins” on page 1094.

Mapping attributes to LDAP data

You map system and custom attributes to LDAP data in the **Attribute Mapping** field. Each mapping is entered on a separate line. The order in which these mapping entries appear does not matter.

The attribute mapping syntax for LDAP Lookup Plug-ins is as follows:

```
attr.CustomAttributeName = search_base:
  (search_filter=$variable$):
    ldapAttribute
```

The following table describes this syntax in more detail.

<table>
<thead>
<tr>
<th>Table 50-21</th>
<th>LDAP mapping syntax details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Element</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>CustomAttributeName</td>
<td>The name of the custom attribute as it is defined in the Enforce Server. <strong>Note:</strong> If the name of the attribute contains white-space characters, you must precede each instance of the white space with a backslash. A white-space character is a space or a tab. For example, you need to enter the Business Unit custom attribute as: <code>attr.Business\ Unit</code></td>
</tr>
</tbody>
</table>

See “Configuring custom attributes” on page 1079.
Table 50-21  LDAP mapping syntax details (continued)

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>search_base</td>
<td>Identifies the LDAP directory.</td>
</tr>
<tr>
<td>search_filter</td>
<td>The name of the LDAP attribute (field) that corresponds to the lookup parameter (or other variable) passed to the plug-in from the Enforce Server.</td>
</tr>
<tr>
<td>variable</td>
<td>The name of the lookup parameter that contains the value to be used as a key to locate the correct data in the LDAP directory. In cases where multiple plug-ins are chained together, the parameter might be a variable that is passed to the LDAP Lookup Plug-In by a previous plug-in.</td>
</tr>
<tr>
<td>ldapAttribute</td>
<td>The LDAP attribute whose data value is returned to the Enforce Server. This value is used to populate the custom attribute that is specified in the first element of the entry.</td>
</tr>
</tbody>
</table>

See “About LDAP Lookup Plug-Ins” on page 1094.

Attribute mapping examples for LDAP

The following mappings provide additional attribute mapping examples for LDAP Lookup Plug-ins.

The following example attribute mapping searches the hr.corp LDAP directory for a record with an attribute for mail whose value matches the value of the sender-email lookup parameter. It returns to the Enforce Server the value of the givenName attribute for that record.

```
attr.FirstName = dc=corp,dc=hr:(mail=$sender-email$):givenName
```

In the following attribute mapping example, a separate line is entered for each custom attribute that is to be populated. In addition, note the use of the TempDeptCode temporary variable. The department code is needed to obtain the department name from the LDAP hierarchy. But only the department name needs to be stored as a custom attribute. The TempDeptCode variable is created for this purpose.

```
attr.FirstName = cn=users:(mail=$sender-email$):firstName
attr.LastName = cn=users:(mail=$sender-email$):lastName
attr.TempDeptCode = cn=users:(mail=$sender-email$):deptCode
attr.Department = cn=departments:(deptCode=$TempDeptCode$):name
attr.Manager = cn=users:(mail=$sender-email$):manager
```
Testing and troubleshooting LDAP Lookup Plug-ins

Complete these steps to troubleshoot LDAP Lookup Plug-In implementations.

See “About LDAP Lookup Plug-Ins” on page 1094.

To troubleshoot an LDAP Lookup plug-in

1. If the plug-in does not save correctly, verify the configuration.
   Before using the LDAP Lookup Plug-In you should test the connection to the LDAP server. You can use a lookup tool such as the Softerra LDAP Browser to help confirm that you have the correct fields defined.
   See “Configuring directory server connections” on page 127.

2. Make sure that the plug-in is enabled.

3. Make sure that you created the Custom Attribute definitions.
   In particular, check the attribute mapping. The attribute names must be identical.

4. If you made changes, or edited the lookup parameter keys, reload the plug-in.
   See “Reloading lookup plug-ins” on page 1108.

5. Select Incidents > All Incidents for the detection server you are using to detect the incident.

6. Select (check) several incidents and select Lookup Attributes from the Incident Actions drop-down menu. (This action looks up attribute values for all incidents for that form of detection.

7. Check the Incident Snapshot screen for an incident. Verify that the Lookup Custom Attributes are filled with entries retrieved from the LDAP lookup.

8. If the correct values are not populated, or there is no value in a custom attribute you have defined, make sure that there are no connection errors are recorded in the Incident History tab.

9. Check the Tomcat log file.
   See “Troubleshooting lookup plug-ins” on page 1109.

LDAP Lookup Plug-In tutorial

This tutorial provides steps for implementing a simple LDAP Lookup Plug-In.
To implement an LDAP Lookup Plug-In

1. Create the following custom attributes at System > Attributes > Custom Attributes:
   - LDAP givenName
   - LDAP telephoneNumber

2. Create a directory connection for the Active Directory server at System > Settings > Directory Connections.
   For example:
   - Hostname: enforce.dlp.company.com
   - Port: 389
   - Base DN: dc=enforce,dc=dlp,dc=com
   - Encryption: None
   - Authentication: Authenticated
   - username: userName
   - password: password

3. Test the connection. The system indicates if the connection is successful.

4. Create a new LDAP plug-in at System > Lookup Plugins > New Plugin > LDAP.
   - Name: LDAP Lookup Plug-in
   - Description: Description for the LDAP Plug-in.

5. Select the directory connection created in Step 2.

6. Map the attributes to LDAP metadata.

   attr.LDAP\ givenName = cn=users:((givenName=$endpoint-user-name$)(mail=$sender-email$)(streetAddress=$discoverserver$))\:givenName
   attr.LDAP\ telephoneNumber = cn=users:((givenName=$endpoint-user-name$)(mail=$sender-email$)(streetAddress=$discoverserver$))\:telephoneNumber

7. Save the plug-in. Verify that the correct save message for the plug-in is displayed.

8. Enable the following keys at the System > Lookup Plugins > Lookup Parameters page.
   - Incident
Create an incident that generates one of the lookup parameters. For example, an email incident exposes the sender-email attribute. There must be some corresponding information in the Active Directory server.

Open the **Incident Snapshot** for the incident.

Click the **Lookup** button and verify the custom attributes created in the Step 1 are populated in the right panel.

---

**Configuring Script Lookup Plug-Ins**

Complete these steps to implement one or more Script Lookup Plug-Ins to look up external information.

See “Writing scripts for Script Lookup Plug-Ins” on page 1128.

**Table 50-22**  
Configuring a Script Lookup Plug-In

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create custom attributes.</td>
<td>See “Configuring custom attributes” on page 1079.</td>
</tr>
<tr>
<td>2</td>
<td>Create the script.</td>
<td>See “Writing scripts for Script Lookup Plug-Ins” on page 1128.</td>
</tr>
<tr>
<td>3</td>
<td>Define the <strong>Lookup Parameter Keys</strong>.</td>
<td>Select the keys to use to extract custom attribute data. See “Selecting lookup parameters” on page 1102.</td>
</tr>
<tr>
<td>4</td>
<td>Create a new <strong>Script Plugin</strong>.</td>
<td>See “Creating new lookup plug-ins” on page 1102.</td>
</tr>
<tr>
<td>5</td>
<td>Enter the <strong>Script Command</strong>.</td>
<td>This value is the local path to the script engine executable on the Enforce Server host. See “Specifying the Script Command” on page 1129.</td>
</tr>
<tr>
<td>6</td>
<td>Specify the <strong>Arguments</strong>.</td>
<td>This value is the path to the Python script file to use for attribute lookup and any command line arguments. Begin the script path with the -u argument to improve lookup performance. See “Specifying the Arguments” on page 1130.</td>
</tr>
<tr>
<td>7</td>
<td>Enable the <strong>stdin</strong> and <strong>stdout</strong> options.</td>
<td>Enable both options to help prevent script injection attacks. See “Enabling the stdin and stdout options” on page 1130.</td>
</tr>
</tbody>
</table>
Table 50-22  Configuring a Script Lookup Plug-In  (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| 8    | Optionally, enable protocol filtering. | You can specify the incident types by protocol for passing attribute values to lookup scripts.  
See “Enabling incident protocol filtering for scripts” on page 1131. |
| 9    | Optionally, enable and encrypt credentials. | You can encrypt and pass credentials required by the script to connect to external systems.  
See “Enabling and encrypting script credentials” on page 1132. |
| 9    | Save the plugin.            | Verify that the correct save message for the plugin is displayed.           
See “Creating new lookup plug-ins” on page 1102. |
| 10   | Enable the lookup plugin.    | You can chain scripts together and chain scripts with other lookup plugins. |
| 11   | Test the lookup plugin.      | Test the lookup plugin.                                                    
See “Troubleshooting lookup plug-ins” on page 1109. |

**Writing scripts for Script Lookup Plug-Ins**

If you are using the Script Lookup Plug-In, you must write a script to extract data and populate the custom attributes of each incident. The Script Lookup Plug-In passes attributes to scripts as key-value pairs. In return, scripts must output a set of key-value pairs to standard out (stdout). The plugin uses these key-value pairs to populate custom attributes.

When writing scripts for use with the Script Lookup Plug-In, adhere to the following syntax requirements and calling conventions, including how a script plugin passes arguments to scripts and the required format for script output.

Table 50-23  Script plugin calling conventions

<table>
<thead>
<tr>
<th>Convention</th>
<th>Syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td>attribute_name=attribute_value</td>
<td>The Script Lookup Plug-In passes attributes to scripts as command-line parameters in the form key=value.</td>
</tr>
</tbody>
</table>
### Table 50-23  Script plugin calling conventions (continued)

<table>
<thead>
<tr>
<th>Convention</th>
<th>Syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output</td>
<td>stdout</td>
<td>To work with the plugin and populate attributes, scripts must output a set of key-value pairs to standard out (stdout). Newline characters must separate output key-value pairs. For example: host-name=mycomputer.company.corp username=DOMAIN\bsmith</td>
</tr>
<tr>
<td>exit code</td>
<td>0</td>
<td>Scripts must exit with an exit code of '0.' If scripts exit with any other code, the Enforce Server assumes that an error has occurred in script execution and terminates the attribute lookup.</td>
</tr>
<tr>
<td>error handling</td>
<td>stderr to a file</td>
<td>Scripts cannot print out error or debug information. Redirect stderr to a file. In Python this would be: \n\n<code>fsock = open(&quot;C:\error.log&quot;, &quot;a&quot;) sys.stderr = fsock</code></td>
</tr>
</tbody>
</table>

See “Example script” on page 1136.

### Specifying the Script Command

The **Script Command** field specifies the path to the script engine for executing the script. These instructions are specific to Python.

**To specify the script command**

1. Download and install version 2.6 of Python on the Enforce Server host, if you have not already done so.

2. Enter the local path to the `python.exe` executable file. For example:
   - **Windows**: `c:\python26\python.exe`
   - **Linux**: `/usr/local/bin/python`

3. Enter the **Arguments**. See “Specifying the Arguments” on page 1130.
Specifying the Arguments

The Arguments field specifies the path to the script and any additional command line arguments. These instructions are specific to Python.

To specify the Arguments

1. After writing a script, copy it to the Enforce Server host, or to a file share that is accessible by the Enforce Server.
2. Make sure that permissions are set correctly on the directory and the script file.
   Both the directory and file must be readable and executable by the protect user.
3. Enter the -u argument in the Argument field.
   This command forces stdin, stdout, and stderr to be totally unbuffered, which improves lookup performance.
4. Enter the fully qualified path to the script file.
   For example:
   - Windows: -u,c:\python26\scripts\ip-lookup.py
   - Linux: -u,/opt/python26/scripts/ip-lookup.py

   Note: The system does not validate the file location.

5. Save the plugin configuration.

Enabling the stdin and stdout options

When you configure a Script Lookup Plug-In you can choose to Enable stdin and Enable stdout. If these options are enabled, the system checks the script input and output for unsafe characters such as command delimiters and logical operators that could be exploited by a UNIX or Windows shell.

Because you are running the script on the host where the Enforcer Server is installed, you should enable both options, unless you are certain that your script is safe. If enabled, the logs will indicate invalid and unescaped characters.

See Table 50-24 on page 1131.
### Invalid characters for attribute names

<table>
<thead>
<tr>
<th>Invalid character</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Empty string</td>
<td>Empty strings are not allowed.</td>
</tr>
<tr>
<td>@</td>
<td>Attributes containing these characters will be ignored during processing if the <code>stdin</code> and <code>stdout</code> options are enabled.</td>
</tr>
<tr>
<td>.</td>
<td></td>
</tr>
<tr>
<td>+</td>
<td></td>
</tr>
<tr>
<td>=</td>
<td></td>
</tr>
<tr>
<td>:</td>
<td></td>
</tr>
<tr>
<td>/</td>
<td></td>
</tr>
<tr>
<td>\</td>
<td></td>
</tr>
<tr>
<td>)</td>
<td></td>
</tr>
<tr>
<td>(</td>
<td></td>
</tr>
<tr>
<td>-</td>
<td></td>
</tr>
<tr>
<td>+</td>
<td></td>
</tr>
<tr>
<td>–</td>
<td></td>
</tr>
<tr>
<td>$</td>
<td>Attributes containing the $ and % characters are allowed if these characters are properly escaped by a backslash.</td>
</tr>
<tr>
<td>%</td>
<td></td>
</tr>
</tbody>
</table>

### Enabling incident protocol filtering for scripts

Optionally, you can specify the incident types (by protocol) for passing attribute values to look up scripts. If you do not enable protocol filtering, your Script Lookup Plug-In will apply to all incidents.

For example, you can limit the passing of attribute values to those incidents that are detected over HTTP. When you filter by protocol, Enforce Server still captures the incidents that are detected over other protocols. But it does not use the Script Lookup Plug-In to populate those incidents with attribute values.
To enable protocol filtering

1 Navigate to the System > Lookup Plugins > Edit Script Lookup Plugin screen in the Enforce Server administration console.

   See “Configuring Script Lookup Plug-Ins” on page 1127.

2 At the Script Lookup Plugin screen, select (check) the Enable protocol filtering option.

   This action displays all the protocols that are available for filtering. Note that protocols are detection server-specific.

   Note: Network and Mobile protocols are configured at the System > Settings > Protocols screen. Endpoint protocols are configured at the System > Agents > Agent Configuration screen. Discover protocols are configured at the Policies > Discover Scanning > Discover Targets. And, once an incident is generated, the protocol value for the incident is displayed at the top of the Incident Snapshot screen.

3 Specify the protocols you want to include in the lookup.

   If you enable protocol filtering, you must select at least one protocol on which to filter.

4 Save the plug-in configuration.

Enabling and encrypting script credentials

If your script is connecting to an external system that requires credentials, you can enable credentials for your script. If you enable credentials through the user interface option, you must encrypt them. Symantec Data Loss Prevention provides the Credential Utility, which lets you encrypt credentials and use them to authenticate to an external data source.

When the Enforce Server invokes the Script Lookup Plug-In, the plug-in decrypts any credentials at runtime and passes them to the script as attributes. The credentials are then available for use within the script. The Credential Utility uses the same platform encryption keys that are used to protect user accounts and incident information within the Symantec Data Loss Prevention system.

See Table 50-25 on page 1133.

If you choose to use credentials in clear text, you must hard code them into your script. In this case, the Enforce Server passes the values you exported to the clear-text credential file. These values are passed in the following format: key=value.
Table 50-25  Enabling and encrypting credentials

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create a text file that contains the credentials that are needed by the script to access the appropriate external systems.</td>
<td>The format of this file is <code>key=value</code>, where <code>key</code> is the name of the credential. For example: <code>username=msantos password=esperanza9</code></td>
</tr>
<tr>
<td>2</td>
<td>Save this credential file to the file system local to the Enforce Server.</td>
<td>The file needs to be saved to the Enforce Server temporarily. For example: <code>C:\temp\MyCredentials.txt</code></td>
</tr>
<tr>
<td>3</td>
<td>On the Enforce Server, open a shell or command prompt and change directories to <code>\SymantecDLP_home\Protect\bin</code>.</td>
<td>This directory on the Enforce Server contains the Credential Generator Utility.</td>
</tr>
<tr>
<td>4</td>
<td>Issue a command to generate an encrypted credential file.</td>
<td>The command syntax is as follows: <code>CredentialGenerator.bat in=cleartext-filepath out-encrypted-filepath</code> For example on Windows you would issue the following: <code>CredentialGenerator.bat C:\temp\MyCredentials.txt C:\temp\MyCredentialsEncrypted.txt</code>. You can open this file in a text editor to verify that it is encrypted.</td>
</tr>
<tr>
<td>5</td>
<td>Select <strong>Enable Credentials</strong>.</td>
<td>At the <strong>System &gt; Lookup Plugins &gt; Edit Script Lookup Plugin</strong> page, select (check) the <strong>Enable Credentials</strong> option.</td>
</tr>
<tr>
<td>6</td>
<td>Enter the <strong>Credentials File Path</strong>.</td>
<td>Enter the fully qualified path to the encrypted credentials file. For example: <code>C:\temp\MyCredentialsEncrypted.txt</code>.</td>
</tr>
<tr>
<td>7</td>
<td>Save the plug-in.</td>
<td>You can now use the encrypted credentials to authenticate to an external system.</td>
</tr>
<tr>
<td>8</td>
<td>Secure the clear-text credentials file.</td>
<td>If you want to save the clear-text credentials file, move it to a secure location. It can be useful to save the file if you plan to update and re-encrypt it later. If you do not want to save the file, delete it now.</td>
</tr>
<tr>
<td>9</td>
<td>Reload the lookup plug-in.</td>
<td>See “Managing and configuring lookup plug-ins” on page 1100.</td>
</tr>
</tbody>
</table>
Chaining multiple Script Lookup Plug-Ins

All lookup plug-ins receive a reference to the same attribute map. This reference enables you to chain lookup plug-ins. Whether plug-in chaining is necessary to populate your custom attributes varies according to circumstances. Consider the following example scenarios.

Getting the right key for Network email incidents is usually straightforward. The email address of the message sender is automatically captured as the `sender-email` lookup parameter. That lookup parameter can be used as a key to unlock the information about the sender that is stored in an external source. In this instance, it is not necessary to chain multiple plug-ins.

For Web or FTP incidents, a plug-in chain might be necessary. The lookup parameter that is captured for these kinds of incidents is the IP addresses of the originating hosts. But IP addresses usually are not static identifiers like email addresses. Therefore, you may need to do successive lookups to get to a static identifier that can be used as an information key.

You can write a script to pass the `sender-ip` lookup parameter to a DNS server to get the host name. You can then write another script to pass that host name to an asset management system. From the asset management system you can obtain the user name or email of the person using that computer. That user name or email can then be used as the “key” to unlock the rest of the data. This plug-in chain would have three links:

1. The Script Lookup Plug-In that uses the IP address to return the host name.
2. The Script Lookup Plug-In that uses the host name to return the user name or email.
3. The CSV Lookup Plug-In that uses the user name or email to return the rest of the custom attribute data.

In this example, you must create a new `Host_Name` temporary variable to store the host name information. This temporary variable and its value are then available to the second script and subsequent plugins.

Script Lookup Plug-In tutorial

Complete the following tutorial to implement a Script Lookup Plug-In. This tutorial assumes basic hands-on familiarity with implementing lookup plugins. To obtain this familiarity, complete the "CSV Lookup Plug-In tutorial."

See “CSV Lookup Plug-In tutorial” on page 1119.
To implement a Script Lookup Plug-In

1. Download and install Python 2.6 on the system where the Enforce Server is installed.
   *For example: C:\python26.*

2. Copy the "Example script" provided in this chapter to a text file and save it to a directory on the Enforce Server host as Script-Plug-In.py.
   *For example: C:\python26\scripts\Script-Plug-In.py.*
   *See “Example script” on page 1136.*

3. Open this script in a Python IDE such as the Wing IDE (available at http://www.wingware.com/).

4. Review the comments in this script and run it.
   *Comment out line 18.*
   *Run the script. It returns "Script-attribute=script value".*
   *Uncomment line 18 so it is not processed.*

5. Create the following custom attribute: Script-attribute.

   *See “Creating new lookup plug-ins” on page 1102.*

7. Configure the Script Lookup Plug-In.
   *Use the following parameters:*  
   *Script Command: C:\python26\python.exe*  
   *Arguments: -u,C:\python26\scripts\Script-Plugin.py*

8. Save the plugin and ensure that the plugin loads successfully as indicated by the system message.

9. Enable the following lookup parameters: Incident, Message, and Sender.

10. Generate an incident that passes the date-sent attribute.

11. Go to the Incident Snapshot for the new incident and click Lookup.

12. Verify that the Script-attribute custom attribute is populated with the value of script value.
If the custom attribute is not populated, check the log file
C:\SymantecDLP\Protect\logs\tomcat\localhost.<latest_date>.log.

If Script-attribute=null check the script. Review the comments in the
provided script and ensure that there is no space between the attribute=value
pair.

See “Troubleshooting lookup plug-ins” on page 1109.

Explore enabling optional properties for the Script Lookup Plug-In, including
stdin/stdout, protocol filtering, and credentials.

See “Enabling the stdin and stdout options” on page 1130.

See “Enabling incident protocol filtering for scripts” on page 1131.

See “Chaining multiple Script Lookup Plug-Ins” on page 1134.

Example script

The following script is provided as an example for the Script Lookup Plug-In. It is
written in Python 2.6. The purpose of this script is to provide a basic working example
for writing scripts in Python that can be used for Script Lookup Plugins.

This script contains the date-sent lookup parameter key and returns the "script
value" for the custom attribute Script-attribute.

See “Script Lookup Plug-In tutorial” on page 1134.

Note: Because Python is strict about indentation requirements, if you copy/paste
this example script you will likely need to reformat it so that it appears exactly as
displayed here.
import sys, os, traceback
import commands

def main(args):
    try:
        attributeMap = parseInput(args)
        # This is the lookup parameter key.
        # Comment-out this line for testing the script standalone.
        dateSent = attributeMap['date-sent']

        # "Script-attribute" is the custom attribute.
        # "script value" is the return value.
        # You cannot have a space between the custom attribute and the
        # attribute value. For example, "Script-attribute = script value"
        # Does not work for Script Lookup Plugins.
        print "Script-attribute=script value"
        return
    except:
        error()
        print "something went wrong!"
        return "something went wrong!"

def parseInput(args):
    # Input data is a list of key value pairs separated by carriage return
    # Create a python dictionary to create the attribute map
    attributeMap = {}
    delimiter = "="
    for item in args:
        if delimiter in item:
            tuple = item.split(delimiter)
            attributeMap[tuple[0]] = tuple[1]
    return attributeMap

def error():
    # "SCRIPT PROCESSING ERROR"
    if(debugMode):
Configuring migrated Custom (Legacy) Lookup Plug-Ins

These steps presume that you have existing Custom Java Lookup Plug-Ins deployed to a pre-12.0 version of Symantec Data Loss Prevention and that you have upgraded the system to Symantec Data Loss Prevention version 12.0 or later. In this case a Custom Java Lookup Plug-In will be migrated to a Custom (Legacy) Lookup Plug-In and will appear in the user interface for verification and testing.

See “About Custom (Legacy) Lookup Plug-Ins” on page 1095.
### Implementing Custom (Legacy) Lookup Plugins

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create custom attributes.</td>
<td>Create the custom attributes that your Custom (Legacy) Lookup Plugin will retrieve the values for. See “About using custom attributes” on page 1078.</td>
</tr>
<tr>
<td>2</td>
<td>Edit the Custom (Legacy) Plugin.</td>
<td>Successful upgrade should import the Custom (Legacy) Lookup Plugin to the user interface where you can enable it. You can update the name and description if necessary. See “Creating new lookup plug-ins” on page 1102.</td>
</tr>
<tr>
<td>3</td>
<td>Verify the Plugin Class.</td>
<td>After upgrade, the class name should be populated from the Plugins.properties file.</td>
</tr>
<tr>
<td>4</td>
<td>Verify the Required JARs.</td>
<td>After upgrade, the JAR files previously copied to the Enforce Server should appear in this field.</td>
</tr>
<tr>
<td>5</td>
<td>Enable the plug-in.</td>
<td>Turn the plug-in On. See “Enabling lookup plug-ins” on page 1107.</td>
</tr>
<tr>
<td>6</td>
<td>Enable parameter lookup keys.</td>
<td>Select the keys to trigger attribute lookup. See “Selecting lookup parameters” on page 1102.</td>
</tr>
<tr>
<td>7</td>
<td>Create a policy and generate an incident of the type expected by the plug-in.</td>
<td>For example, create a keyword policy and generate an SMTP network incident that passes the sender-name attribute.</td>
</tr>
<tr>
<td>8</td>
<td>Verify that the custom attributes are updated.</td>
<td>Check the Incident Snapshot for the populated attributes. See “Troubleshooting lookup plug-ins” on page 1109.</td>
</tr>
</tbody>
</table>
Monitoring and preventing data loss in the network

- Chapter 51. Implementing Network Monitor
- Chapter 52. Implementing Network Prevent for Email
- Chapter 53. Implementing Network Prevent for Web
Implementing Network Monitor

This chapter includes the following topics:

- Implementing Network Monitor
- About IPv6 support for Network Monitor
- Choosing a network packet capture method
- About packet capture software installation and configuration
- Configuring the Network Monitor Server
- Enabling GET processing with Network Monitor
- Creating a policy for Network Monitor
- Testing Network Monitor

Implementing Network Monitor

Network Monitor captures and analyzes traffic on your network, detecting confidential data, and significant traffic metadata over protocols you specify. For example, SMTP, FTP, HTTP, and various IM protocols. You can configure a Network Monitor Server to monitor custom protocols and to use a variety of filters (per protocol) to filter out low-risk traffic.

To monitor network traffic, a Network Monitor Server requires:

- A network Switch Port Analyzer (SPAN) or network tap to acquire traffic on the target network.
A card on the Network Monitor Server host to capture the network traffic that is acquired from the SPAN or tap. Either a network interface card (NIC) or high-speed packet capture adapter (Endace or Napatech) can be used. (Note that in addition to this traffic-capturing card, a separate NIC is required for communication between the Network Monitor Server and the Enforce Server. WinPcap is required for this purpose.)

Packet capture software. When you use a NIC for packet capture, packet capture software must be installed on the Network Monitor Server host. When you use a high-speed packet capture adapter card (Endace or Napatech), the card must use the correct driver.

See “Choosing a network packet capture method” on page 1144.

To implement packet capture and set up a Network Monitor, perform the following high-level tasks:

1. Install and set up the network tap or SPAN that captures network traffic.

2. Choose a method of capturing network traffic.

   See “Choosing a network packet capture method” on page 1144.

3. Install the necessary NIC or high-speed packet capture adapter (Endace or Napatech) on the Network Monitor as described by the card documentation. Also use the appropriate Symantec Data Loss Prevention Installation Guide (Windows or Linux). This NIC or high-speed packet capture adapter (Endace or Napatech) must operate in promiscuous mode so that all inbound and outbound traffic is relayed through this port.

   See the Symantec Data Loss Prevention System Requirements and Compatibility Guide for information about supported NICs and high-speed packet capture adapters.
4 On a Windows platform, install WinPcap if it is not already installed. See “Installing WinPcap on a Windows platform” on page 1146.

5 If necessary, update the driver for the high-speed packet capture adapter. See “Updating the Endace card driver” on page 1146. See “Installing and updating the Napatech network adapter and driver software” on page 1146.

6 Disable checksum offloading for the NIC that is used to monitor network traffic. For Linux platforms, use the following commands to disable checksum offloading for both receiving and transmitted data on the eth0 interface:

   ```
   ethtool -K eth0 tx off
   ethtool -K eth0 rx off
   ```

   To see the current status of checksum offloading, use the `ethtool -k eth0` command.

   **Note:** Certain checksum algorithms work by modifying network packets and adding empty checksums. Empty checksums can cause network capture drivers to drop the packets, in which case they are not evaluated by Network Monitor.

7 Use a protocol analyzer such as Wireshark to validate traffic on the tap or SPAN that feeds into your NIC or high-speed packet capture adapter (Endace or Napatech).

8 Configure the Network Monitor Server. See “Configuring the Network Monitor Server” on page 1147.

9 Create and deploy a test policy for Network Monitor. See “Creating a policy for Network Monitor” on page 1150.

10 Test the system by generating an incident against your test policy. See “Testing Network Monitor” on page 1151.

---

**About IPv6 support for Network Monitor**

Symantec Data Loss Prevention supports monitoring of pure IPv4 networks, dual-stack (IPv4 and IPv6) networks, or pure IPv6 networks. The Enforce Server administration console supports input and reporting of both IPv4 and IPv6 addresses for Network Monitor. Support for monitoring IPv6 networks is limited to...
implementations of Network Monitor and does not include support for other Symantec Data Loss Prevention products.

Here is an overview of specific support for IPv6 in Symantec Data Loss Prevention:

- Installation of a Network Monitor Server that is capable of monitoring IPv6 networks or dual-stack networks is the same as installation of a Network Monitor Server that monitors an IPv4 network.
- The hardware and operating system requirements are the same as for IPv4 Network Monitor. See the Symantec Data Loss Prevention System Requirements Guide for more information on third-party hardware and software compatibility.
- IP address data types can hold either IPv4 or IPv6 addresses.
- Network incidents can include IPv6 addresses.
- Network protocol definitions can include IPv6 addresses.

Symantec Data Loss Prevention IPv6 support is limited to monitoring. The Enforce Server administration console must still be deployed on an IPv4 network; there is no support for command and control functionality over IPv6.

This release does not include support for:

- Deployment of Symantec Data Loss Prevention over IPv6 networks
- Support of other Symantec Data Loss Prevention servers on IPv6 networks
- Use of IPv6 system-defined data identifiers
- Use of IP fragmentation over IPv6
- Configuring or communicating with detection servers over IPv6
- Deployment of IPv6 endpoints
- Deployment of Symantec Encryption Server on IPv6
- Deployment of the Oracle database on an IPv6 connection

See Configure a protocol in online Help for more information about specific implementation details of IPv6 support.

Choosing a network packet capture method

You can use three different methods to capture the network traffic that is acquired by a SPAN or tap:

- NIC on a Windows platform. Windows platforms using a NIC for packet capture require a WinPcap library on the Network Monitor Server host. If WinPcap is not already on the Network Monitor Server host, you must install it. See the
Symantec Data Loss Prevention System Requirements and Compatibility Guide for information about the supported version of the WinPcap library. See “Installing WinPcap on a Windows platform” on page 1146.

- NIC on a Linux platform. Linux platforms using a NIC use native Linux packet capture which requires PACKET_MMAP support in the kernel. Support for PACKET_MMAP is included by default in supported Linux kernels.

- High-speed packet capture adapter on either Windows or Linux platforms. An Endace DAG network measurement card can be used on Linux 64-bit platforms to provide network packet capture in high-traffic environments. Alternatively, a Napatech network adapter can be used to provide network packet capture. See the Symantec Data Loss Prevention System Requirements and Compatibility Guide for information about supported high-speed packet capture adapters and drivers.

Table 51-1  Packet capture alternatives

<table>
<thead>
<tr>
<th>Packet capture type</th>
<th>Platform</th>
<th>Software</th>
</tr>
</thead>
<tbody>
<tr>
<td>NIC</td>
<td>Windows</td>
<td>WinPcap</td>
</tr>
<tr>
<td></td>
<td>Linux</td>
<td>Native</td>
</tr>
<tr>
<td>High-speed packet capture adapter</td>
<td>Windows 64-bit</td>
<td>Napatech</td>
</tr>
<tr>
<td></td>
<td>Linux 64-bit</td>
<td>Endace</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Napatech</td>
</tr>
</tbody>
</table>

About packet capture software installation and configuration

Consider the following requirements when installing and configuring packet capture software:

- On Windows platforms, packet capture requires the WinPcap software which may need to be installed if it is not already present.

- On Linux platforms, PACKET_MMAP performs packet capture. PACKET_MMAP is a standard Linux component and should not need to be installed or modified. However, you also require apr-util, apr, expat, and other third-party packages to run a Network Monitor Server on Linux. See the Symantec Data Loss Prevention System Requirements and Compatibility Guide for more information.
If you use a high-speed packet capture adapter (Endace or Napatech), you will need to install or update the adapter driver software.

See “Installing WinPcap on a Windows platform” on page 1146.

See “Updating the Endace card driver” on page 1146.

See “Installing and updating the Napatech network adapter and driver software” on page 1146.

Installing WinPcap on a Windows platform

If WinPcap software is not already present on a Windows platform, you must install it. See the Symantec Data Loss Prevention System Requirements and Compatibility Guide for information about the supported version of the WinPcap library. Additional details can be found in the Symantec Data Loss Prevention Installation Guide.

See “About managing Symantec Data Loss Prevention servers” on page 177.

To install WinPcap on the Network Monitor detection server:

1. Copy the WinPcap files to a local drive.
2. Run the WinPcap executable and follow the installation instructions.
3. Reset the Windows registry settings by running `pcapstart.reg` and follow the instructions that are displayed.

Updating the Endace card driver

If you upgrade a Network Monitor Server to the current version, you may need to update the Endace card driver. See the Symantec Data Loss Prevention System Requirements and Compatibility Guide for information about supported Endace cards and drivers.

Updating an Endace Driver

1. Install the new driver as described by Endace documentation.
2. Reconfigure the Network Monitor to use the new driver.

See “Configuring the Network Monitor Server” on page 1147.

Installing and updating the Napatech network adapter and driver software

This topic provides instructions for installing the Napatech high-speed packet capture adapter. Refer to the Symantec Data Loss Prevention System Requirements and Compatibility Guide for information about the supported Napatech card and driver versions.
### Table 51-2 Installing and updating the Napatech network adapter

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Install the supported Napatech high-speed packet capture adapter.</td>
<td>Refer to the <em>Symantec Data Loss Prevention System Requirements and Compatibility Guide</em> for the supported Napatech card version.</td>
</tr>
<tr>
<td>2</td>
<td>Install the Napatech driver.</td>
<td>For supported versions of the Napatech driver, see the <em>Symantec Data Loss Prevention System Requirements and Compatibility Guide</em>.</td>
</tr>
</tbody>
</table>
| 3    | Verify Napatech installation. | For Windows:  
- Make sure that the Napatech library file `CommonLib.dll` is present in directory `\<windows_installation_drive>\Windows\System32\`.  
For Linux:  
- The Napatech driver has to be compiled from source as a part of installing Napatech software package (see step 2 above).  
- The Napatech driver has to be loaded using the script `/opt/napatech/bin/load_driver.sh` once for each computer bootstrap before capturing packets. Note for RHEL Linux, edit the file `/etc/rc.d/rc.local` to append `/opt/napatech/bin/load_driver.sh` and restart the system.  
- Verify that the Napatech library file `libntcommoninterface.so` is present in directory `/<nt_installation_directory>/lib/`. |
| 4    | Configure the Network Monitor detection server. | Deploy a Network Monitor detection server and configure the Advanced Server settings:  
- Enable Napatech packet capture by setting the following flag to `true`: `PacketCapture.IS_NAPATECH_ENABLED`.  
- Update the value to the path to the Napatech driver tools directory by entering the path in the field for the following entry: `PacketCapture.NAPATECH_TOOLS_PATH`.  
  - For example, on Windows Napatech tools binaries are included as part of the Napatech software package: `/ntcap_package_windows_<version>/tools/nt_tools_windows_<version>.zip/Tools/Win/\<architecture>\`.  
  - For Linux, Napatech tools are compiled from source as part of Napatech software package installation process: `/<nt_installation_directory>/bin/`  
See "Advanced server settings" on page 203. |

### Configuring the Network Monitor Server

You configure the Network Monitor Server by selecting the network interface (NIC, Napatech, or Endace card) to use for traffic capture. You must also select which protocols to monitor.
To configure a Network Monitor Server

1. In the Enforce Server administration console, go to System > Servers > Overview and click the Network Monitor Server. The Server Detail screen appears.
   
   If you do not use a high-speed packet capture adapter (Endace or Napatech) for traffic capture, skip to step 6.

2. If you use a high-speed packet capture adapter (Endace or Napatech), click Server Settings.

3. For Endace cards, enter the appropriate values in the following fields:

   - PacketCapture.ENDACE_BIN_PATH
     Type the path to the Endace \bin directory.
     By default, this directory is located at endace_home\dag-version\bin. Note that you cannot use variables (such as %ENDACE_HOME%) in any of the fields that are listed here.

   - PacketCapture.ENDACE_LIB_PATH
     Type the path to the Endace \lib directory

   - PacketCapture.ENDACE_XILINX_PATH
     Type the path to the Endace \xilinx directory.

   - PacketCapture.IS_ENDACE_ENABLED
     Change the value to true.

4. For Napatech cards, enter the appropriate values in the following fields:

   - PacketCapture.IS_NAPATECH_ENABLED
     Change the value to true.

   - PacketCapture.NAPATECH_TOOLS_PATH
     Type the path to the Napatech \tools directory.

5. Stop and restart the Network Monitor Server. Symantec Data Loss Prevention displays the Endace card in the Network Interfaces field of the Configure Server screen for the Network Monitor Server.

6. Go to System > Servers > Overview and again click on the Network Monitor Server.

7. On the Server Detail screen, click Configure. You can verify or modify settings in the general section at top and on the Packet Capture tab, as described in subsequent steps.
8 Leave the **Source Folder Override** field blank to accept the default directory for buffering network streams before the Network Monitor Server processes them. (This setting is the recommended setting.) To specify a custom buffer directory, type the full path to the directory.

9 Leave the **Archive Folder** field blank.

10 Select one or more **Network Interfaces** (NICs, Napatech cards, or Endace cards) through which the Network Monitor Server should capture traffic.

11 In the **Protocol** section, select one or more protocols to monitor. For example, select the check boxes for SMTP, HTTP, and FTP. For a protocol to appear in this section, it must already be configured on the global Protocols screen in the Enforce Server.

See the online Help associated with the **Configure Server** screen.

Symantec Data Loss Prevention has standard settings for each protocol in the list. To modify a protocol's settings, click the **Pencil** icon next to the appropriate protocol. For details on modifying protocol settings, see the online Help.

12 Click **Save**.

13 Stop and restart the Network Monitor Server. Click **Recycle** next to the **Status** entry in the Server Detail screen.

After selecting a network interface and choosing protocols, you may want to create a test policy to test your deployment.

See “**Testing Network Monitor**” on page 1151.

See “**Enabling GET processing with Network Monitor**” on page 1149.

See “**Creating a policy for Network Monitor**” on page 1150.

---

### Enabling GET processing with Network Monitor

By default, Network Monitor does not process HTTP GET commands. GET processing is disabled because it involves high traffic volume, and because sensitive data is rarely lost in GET commands. If you require GET processing and the Network Monitor Server can handle the increased load, follow this procedure to configure Network Monitor to process GET commands.

**Note:** Network Monitor only inspects GET requests, it does not inspect HTTP GET responses.
To enable GET processing

1. Ensure that the `L7.processGets` advanced server setting on the Network Monitor Server is `true` (which is the default).

2. Change the `PacketCapture.DISCARD_HTTP_GET` advanced server setting on the Network Monitor Server from the default setting of `true` to `false`.

3. Reduce the size of the `L7.minSizeofGetURL` advanced server setting on the Network Monitor Server from the default of 100. Reduce it to a number of bytes smaller than the length of the shortest URL from which you want to process GET commands. A minimum URL size of 10 should cover all cases. Note, however, that reducing the minimum size of GETs increases the number of requests that have to be processed, which increases the server's traffic load.

---

**Note:** Network Monitor only inspects HTTP GET requests; it does not inspect HTTP GET responses.

See “Enabling GET processing for Network Prevent for Web” on page 1174.

---

## Creating a policy for Network Monitor

For Network Monitor, you can create the policies that include any of the standard response rules. To set up a response rule action, go to Manage > Policies > Response Rules and click Add Response Rules.

See “Workflow for implementing policies” on page 293.

### To create a test policy for Network Monitor

1. In the Enforce Server administration console, create a response rule that includes one of the actions that applies to Network Monitor. For example, create a response rule that includes the All: Set Status action.

   See “Configuring response rules” on page 891.

2. Create a policy that incorporates the response rule you configured in the previous step.

   For example, create a policy called Test Policy as follows:

   - Include a **Content Matches Keyword** detection rule that matches on the keyword `test_dlp_secret_keyword`.
   - Include an **All: Set Status** response rule.
   - Associate it with the Default policy group.

   See “Adding a new policy or policy template” on page 325.
Testing Network Monitor

You can test Network Monitor by sending an email that violates your test policy.

To test your system

1. Access an email account that routes messages through the MTA.
2. Send an email that contains confidential data. For example, send an email that contains the keyword test_dlp_secret_keyword.
3. In the Enforce Server administration console, go to Incidents > Network and click Incidents - New. Look for the resulting incident. For example, search for an incident entry that includes the appropriate timestamp and policy name.
4. Click on the relevant incident entry to see the complete incident snapshot.

See “About Symantec Data Loss Prevention reports” on page 1006.

See “Configuring the Network Monitor Server” on page 1147.

See “Creating a policy for Network Monitor” on page 1150.
Implementing Network Prevent for Email

This chapter includes the following topics:

- Implementing Network Prevent for Email
- About Mail Transfer Agent (MTA) integration
- Configuring Network Prevent for Email Server for reflecting or forwarding mode
- Specifying one or more upstream mail transfer agents (MTAs)
- Creating a policy for Network Prevent for Email
- About policy violation data headers
- Enabling policy violation data headers
- Testing Network Prevent for Email

Implementing Network Prevent for Email

Network Prevent for Email monitors and analyzes outbound email traffic in-line and (optionally) blocks, redirects, or modifies email messages as specified in your policies. Network Prevent for Email integrates with industry-standard mail transfer agents (MTAs) and hosted email services to let you monitor and stop data loss incidents over SMTP. Policies that are deployed on the Network Prevent for Email Server direct the Prevent-integrated MTA or hosted email server. The Prevent-integrated mail server blocks, reroutes, and alters email messages based on specific content or other message attributes.
Note: Review the *Symantec Data Loss Prevention MTA Integration Guide for Network Prevent for Email* to determine your preferred integration architecture before you continue with the implementation.

Figure 52-1 shows an integration of Network Prevent for Email Server with a next-hop MTA that you manage in the network. As an alternative, you can integrate Network Prevent for Email Server with a hosted email server that resides outside the firewall.

First, you need to know the high-level steps that are required for implementing Network Prevent for Email. You can check the cross-referenced sections for more details.
To implement Network Prevent for Email

1. Choose an integration architecture and configure your Mail Transfer Agent (MTA) to work with the Network Prevent for Email Server.
   
   See “About Mail Transfer Agent (MTA) integration” on page 1154.

2. Configure the Network Prevent for Email Server to work within your chosen integration architecture.
   
   See “Configuring Network Prevent for Email Server for reflecting or forwarding mode” on page 1155.

3. If you plan to encrypt or quarantine email messages, configure the necessary third-party encryption server(s) or archiving servers. For details, see your product’s documentation.

4. Create and deploy a policy for Network Prevent for Email.
   
   See “Creating a policy for Network Prevent for Email” on page 1161.

5. Test the system by generating an incident against your test policy.
   
   See “Testing Network Prevent for Email” on page 1164.

About Mail Transfer Agent (MTA) integration

Choose an integration architecture and configure your Mail Transfer Agent (MTA) to work with the Network Prevent for Email Server.

Review the Symantec Data Loss Prevention MTA Integration Guide for Network Prevent for Email. Familiarize yourself with the compatible integration architectures.

The Network Prevent for Email Server can operate with your MTA in either reflecting or forwarding modes:

- Reflecting mode. In reflecting mode, the Network Prevent for Email Server receives messages from an MTA. It analyzes them, and then returns them to the same MTA (with instructions to block the messages or process them downstream). In essence, the server returns messages to the same IP address from which they arrived.

- Forwarding mode. In forwarding mode, the Network Prevent for Email Server receives messages from an upstream MTA. It analyzes them, and then sends them on to a downstream MTA or hosted email service provider. You can specify a list of IP addresses or hostnames for the next-hop mail server in the Network Prevent for Email Server configuration.

You can also configure a single Network Prevent for Email Server to work with multiple MTAs.
Configuring Network Prevent for Email Server for reflecting or forwarding mode

Use the following instructions to configure Network Prevent for Email Server to operate either in reflecting or forwarding mode.

To configure the Network Prevent for Email Server

1. Log on to the Enforce Server administration console for the Symantec Data Loss Prevention system you want to configure.
2. Select System > Servers > Overview to display the list of configured servers.
3. Click the name of the Network Prevent for Email Server that you want to configure.
4. Click Configure.
5. Deselect Trial Mode to enable blocking of email messages that are found to violate Symantec Data Loss Prevention policies.
Configure reflecting mode or forwarding mode by modifying the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Next Hop Configuration</strong></td>
<td>Select <strong>Reflect</strong> to operate Network Prevent for Email Server in reflecting mode. Select <strong>Forward</strong> to operate in forwarding mode. Note: If you select <strong>Forward</strong> you must also select <strong>Enable MX Lookup</strong> or <strong>Disable MX Lookup</strong> to configure the method used to determine the next-hop MTA.</td>
</tr>
<tr>
<td><strong>Enable MX Lookup</strong></td>
<td>This option applies only to forwarding mode configurations. Select <strong>Enable MX Lookup</strong> to perform a DNS query on a domain name to obtain the mail exchange (MX) records for the server. Network Prevent for Email Server uses the returned MX records to select the address of the next hop mail server. If you select <strong>Enable MX Lookup</strong>, also add one or more domain names in the <strong>Enter Domains</strong> text box. For example: companyname.com</td>
</tr>
</tbody>
</table>

Network Prevent for Email Server performs MX record queries for the domain names that you specify. **Note**: You must include at least one valid entry in the **Enter Domains** text box to successfully configure forwarding mode behavior.
Field | Description
--- | ---
Disable MX Lookup | This field applies only to forwarding mode configurations.

Select Disable MX Lookup if you want to specify the exact hostname or IP address of one or more next-hop MTAs. Network Prevent for Email Server uses the hostnames or addresses that you specify and does not perform an MX record lookup.

If you select Disable MX Lookup, also add one or more hostnames or IP addresses for next-hop MTAs in the Enter Hostnames text box. You can specify multiple entries by placing each entry on a separate line. For example:

smtp1.companyname.com
smtp2.companyname.com
smtp3.companyname.com

Network Prevent for Email Server always tries to proxy to the first MTA that you specify in the list. If that MTA is not available, Network Prevent for Email Server tries the next available entry in the list.

Note: You must include at least one valid entry in the Enter Hostnames text box to successfully configure forwarding mode behavior.

7 Click Save.
Click **Server Settings** to verify or configure these advanced settings:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RequestProcessor.ServerSocketPort</td>
<td>Ensure that this value matches the number of the SMTP Listener port to which the upstream MTA sends email messages. The default is 10025. Note: Many Linux systems restrict ports below 1024 to root access. Network Prevent for Email cannot bind to these restricted ports. If the computer receives mail for inspection on a restricted port (for example, port 25), reconfigure the computer to route traffic from the restricted port to the non-restricted Network Prevent for Email port (port 10025 by default). See &quot;Configuring Linux IP tables to reroute traffic from a restricted port&quot; on page 1159.</td>
</tr>
<tr>
<td>RequestProcessor.MTAResubmitPort</td>
<td>Ensure that this value matches the number of the SMTP Listener port on the upstream MTA to which the Network Prevent for Email Server returns mail. The default is 10026.</td>
</tr>
<tr>
<td>RequestProcessor.AddDefaultHeader</td>
<td>By default, Network Prevent for Email Server uses a header to identify all email messages that it has processed. The header and value are specified in the RequestProcessor.DefaultPassHeader field. Change the value of this field to false if you do not want to add a header to each message.</td>
</tr>
</tbody>
</table>
This field specifies the header and value that Network Prevent for Email Server adds to each email message that it processes. The default header and value is `X-CFilter-Loop: Reflected`. Change the value of this field if you want to add a different header to each processed message.

If you do not want to add a header to each email message, set the `AddDefaultPassHeader` field to False.

---

**Note:** Always configure both `RequestProcessor.ServerSocketPort` and `RequestProcessor.MTAResubmitPort`, whether you implement reflecting or forwarding mode. With forwarding mode, `RequestProcessor.ServerSocketPort` specifies the SMTP Listener port on the detection server to which the upstream MTA sends email messages. `RequestProcessor.MTAResubmitPort` is the SMTP Listener port on the downstream MTA to which the detection server sends email messages.

9. Click **Save**.

10. Click **Done**.

11. If your email delivery system uses TLS communication in forwarding mode, each next-hop mail server in the proxy chain must support TLS and must authenticate itself to the previous hop. This means that Network Prevent for Email Server must authenticate itself to the upstream MTA, and the next-hop MTA must authenticate itself to Network Prevent for Email Server. Proper authentication requires that each mail server stores the public key certificate for the next hop mail server in its local keystore file.

See “Specifying one or more upstream mail transfer agents (MTAs)” on page 1160.

See “Creating a policy for Network Prevent for Email” on page 1161.

See “Testing Network Prevent for Email” on page 1164.

**Configuring Linux IP tables to reroute traffic from a restricted port**

Many Linux systems restrict ports below 1024 to root access. Network Prevent for Email cannot bind to these restricted ports.
If the computer receives mail for inspection on a restricted port (for example, port 25), use the `iptables` command to route that traffic to a non-restricted port, such as the Network Prevent for Email default port 10025. Then ensure that Network Prevent for Email listens on the non-restricted port to inspect email.

Use the following instructions to configure a Linux system to route from port 25 to port 10025. If you use a different restricted port or Network Prevent for Email port, enter the correct values in the `iptables` commands.

**To configure route traffic from port 25 to port 10025**

1. Configure Network Prevent for Email to use the default port 10025 if necessary.
   
   See “Configuring Network Prevent for Email Server for reflecting or forwarding mode” on page 1155.

2. In a terminal window on the Network Prevent for Email computer, enter the following commands to reroute traffic from port 25 to port 10025:

   ```bash
   iptables -N Vontu-INPUT
   iptables -A Vontu-INPUT -s 0/0 -p tcp --dport 25 -j ACCEPT
   iptables -I INPUT 1 -s 0/0 -p tcp -j Vontu-INPUT
   iptables -t nat -I PREROUTING -p tcp --destination-port 25 -j REDIRECT --to-ports=10025
   iptables-save > /etc/sysconfig/iptables
   ```

   **Note:** If you only want to test local IP routing between the ports with Telnet, use the command:

   ```bash
   iptables -t nat -I OUTPUT -o lo -p tcp --destination-port 25 -j REDIRECT --to-ports=10025
   ```

   If later you decide to delete the IP tables entry, use the command:

   ```bash
   iptables -t nat -D OUTPUT -o lo -p tcp --destination-port 25 -j REDIRECT --to-ports=10025
   ```

**Specifying one or more upstream mail transfer agents (MTAs)**

By default, Network Prevent for Email Server can accept connections to the ESMTP service port from any system on the network. You can restrict Network Prevent for Email Server ESMTP communication to a designated set of mail transfer agents (MTAs) for security reasons. Create a “whitelist” of authorized systems. If you whitelist one or more systems, other systems that are not on the whitelist cannot connect to the Network Prevent for Email Server ESMTP service port.
Note that an MTA whitelist might be affected by the RequestProcessor.BindAddress setting. By default, the RequestProcessor.BindAddress setting is 0.0.0.0, and the listener binds to all available addresses. If RequestProcessor.BindAddress instructs the listener to bind to a specific IP, a white listed MTA must also be able to reach the listener address.

To create a whitelist of systems allowed to communicate with the Network Prevent for Email Server:

1. Go to System > Servers > Overview and click on the wanted Network Prevent for Email Server.
2. On the Server Detail screen that appears, click Server Settings.
   
   By default, RequestProcessor.AllowHosts is set to any, meaning that all other systems on the network can communicate with this Network Prevent for Email Server.
4. You can limit the systems that are allowed to connect with this Network Prevent for Email Server. Delete any and enter the IP addresses or FQDN of the systems you want to authorize. Separate multiple addresses with commas. For example: "123.14.251.31,smtp_1.corp.mycompany.com,123.14.223.111." Separate addresses only with commas; do not include spaces.
5. Click Save.

Changes to this setting do not take effect until you restart the server.

Creating a policy for Network Prevent for Email

You can create the policies that include any of the standard response rules. For example, Add Comment, Limit Incident Data Retention, Log to a Syslog Server, Send Email Notification, and Set Status.

See “Workflow for implementing policies” on page 293.

You can also incorporate the following rules, which are specific to Network Prevent for Email:

- **Network: Block SMTP Message**
  
  Blocks the email messages that contain confidential data or significant metadata (as defined in your policies). You can configure Symantec Data Loss Prevention to bounce the message or redirect the message to a specified address. The redirect feature is typically used to reroute messages to the address of a mailbox or mail list. Administrators and managers use the mailbox or list to
review and release messages. Such mailboxes are outside the Symantec Data Loss Prevention system.

- **Network: Modify SMTP Message**
  
  Modifies the email messages that contain confidential data or significant metadata (as defined in your policies). You can use this action to modify the message subject or add specific RFC 5322 message headers to trigger further downstream processing. For example, message encryption, message quarantine, or message archiving.

For details on setting up any response rule action, open the online Help. Go to **Manage > Policies > Response Rules** and click **Add Response Rule**.

For details on using the **Network: Modify SMTP Message** action to trigger downstream processes (such as message encryption), see the *Symantec Data Loss Prevention MTA Integration Guide for Network Prevent*.

Even if you do not incorporate response rules into your policy, Network Prevent for Email captures incidents as long as your policies contain detection rules. This feature can be useful if you want to review the types of incidents Symantec Data Loss Prevention captures and to then refine your policies.

**To create a test policy for Network Prevent for Email**

1. In the Enforce Server administration console, create a response rule that includes one of the actions specific to Network Prevent for Email. For example, create a response rule that includes the **Network: Block SMTP Message** action.

   See “Configuring response rules” on page 891.

2. Create a policy that incorporates the response rule you configured in the previous step.

   For example, create a policy called Test Policy as follows:

   - Include a **Content Matches Keyword** detection rule that matches on the keyword secret.
   - Include a **Network: Block SMTP Message** response rule.
   - Associate it with the Default policy group.

   See “Configuring policies” on page 326.

See “About policy violation data headers” on page 1163.
About policy violation data headers

A message might violate more than one policy. You can add special headers to the outgoing messages that report the number and severity of policies the message violates. Three different kinds of violation-data headers are available:

- Number of violated policies—a header can be added reporting the total number of different policies that the message violates.
- Highest severity—a header can be added reporting the single highest severity level among all policies that the message violates (High, Medium, Low, or Info).
- Cumulative severity score—a header can be added reporting a total severity score which is the numeric sum of all policy violations. For this purpose, severity levels are assigned numeric values: High=4, Medium=3, Low=2, and Info=1. Thus, a message that violates both a Low (2) and Medium (3) severity policy has a total severity score of 5.

You can use headers to trigger downstream responses that are based on the number of violations or the severity of violations. For example:

- Messages that violate a single policy can be routed to one quarantine mailbox. Messages that violate multiple policies can be routed to a second mailbox. Messages that violate over a specified number of policies can be routed to a third mailbox.
- Messages that violate multiple policies can be handled differently according to the severity level of the most serious violation.
- Messages that violate multiple policies can be handled differently according to the total severity score of the message.

See "Enabling policy violation data headers" on page 1163.

Enabling policy violation data headers

Three multiple-policy headers can be used in combination.

To enable policy violation message headers:

1. Go to System > Servers > Overview and click on the wanted Network Prevent for Email Server.

2. On the Server Detail screen that appears, click Server Settings.

3. Scroll down to one of the three following RequestProcessor settings. By default, the value for these settings is false.

4. Change the value to true.

5. Click Save.
Changes to these settings do not take effect until you restart the server.

Three RequestProcessor advanced settings enable different kinds of multiple-policy-violation message headers:

- **RequestProcessor.TagPolicyCount.**
  When the setting is set to true, Network Prevent adds a header reporting the total number of policies that the message violates. For example, if the message violates 3 policies a header reading: “X-DLP-Policy-Count: 3” is added.

- **RequestProcessor.TagHighestSeverity.**
  When the setting is set to true, Network Prevent adds a header reporting the highest severity among the violated policies. For example, if a message violates three policies, one with a severity of “Medium” and two with a severity of “Low” a header reading: “X-DLP-Max-Severity: MEDIUM” is added.

- **RequestProcessor.TagScore.**
  When the setting is set to true, Network Prevent adds a header reporting the total cumulative score of all the violated policies. Scores are calculated using the formula: High=4, Medium=3, Low=2, and Info=1. For example, if a message violates three policies, one with a severity of “medium” and two with a severity of “low” a header reading: “X-DLP-Score: 7” is added.

Setting a value to “true” causes the corresponding header to be automatically added to every outgoing message that is processed. This occurs even if the message violates only a single policy.

See “About policy violation data headers” on page 1163.

**Testing Network Prevent for Email**

You can test Network Prevent for Email by sending an email that violates your test policy.

**To test your system**

1. Access an email account that routes messages through an MTA that is integrated with your Network Prevent for Email Server.
2. Send an email that contains confidential data. For example, send an email that contains the word Secret.
3. In the Enforce Server administration console, go to Incident > Network and click Incidents - All. Look for the resulting incident. For example, search for an incident entry that includes the appropriate timestamp and policy name.
4. Click on the relevant incident entry to see the complete incident snapshot.

See “About Symantec Data Loss Prevention reports” on page 1006.
Implementing Network Prevent for Web

This chapter includes the following topics:

■ Implementing Network Prevent for Web
■ Configuring Network Prevent for Web Server
■ About proxy server configuration
■ Specifying one or more proxy servers
■ Enabling GET processing for Network Prevent for Web
■ Creating policies for Network Prevent for Web
■ Testing Network Prevent for Web
■ Troubleshooting information for Network Prevent for Web Server

Implementing Network Prevent for Web

The Network Prevent for Web Server integrates with an HTTP, HTTPS, or FTP proxy server using ICAP for in-line active Web request management. If it detects confidential data in Web content, it causes the proxy to reject requests or remove HTML content as specified in your policies.
First, you need to know the high-level steps that are required for implementing Network Prevent for Web. You can check the cross-referenced sections for more details.

**To implement Network Prevent for Web**

1. Make sure the Network Prevent for Web Server is configured to communicate with your HTTP proxy server. Optionally, configure the detection server to filter traffic as wanted.

   See “Configuring Network Prevent for Web Server” on page 1167.

2. Configure your HTTP proxy server to work with the Network Prevent for Web Server.

   See “About proxy server configuration” on page 1170.


   See “Creating policies for Network Prevent for Web” on page 1175.
4 Test the system by generating an incident against your test policy.

See “Testing Network Prevent for Web” on page 1176.

5 If required, troubleshoot the implementation.


Licensing Network Prevent

There are different deployment scenarios for Network Prevent. You can deploy Network Prevent as a standalone product, or you can deploy it in conjunction with Mobile Prevent for Web.

Depending on the license that you purchase, the user interface of Symantec Data Loss Prevention changes. What you see on your screen may differ slightly from what is described in the Symantec Data Loss Prevention documentation. The documentation assumes that you are deploying Mobile Prevent and Network Prevent together.

For example, you create a response rule to block sensitive information from transferring over an HTTP protocol. If you have deployed Network Prevent as a standalone product, the Block HTTP/HTTPS response rule action appears under the heading Network Prevent. If you have Mobile Prevent and Network Prevent deployed together, the response rule action appears under the heading Network and Mobile Prevent for Web.

See “Implementing Mobile Prevent for Web” on page 1542.

Configuring Network Prevent for Web Server

You can use a number of configuration options for Network Prevent for Web Server. For example, you can configure the server to:

- Ignore small HTTP requests or responses.
- Ignore requests to, or responses, from a particular host or domain (such as the domain of a business subsidiary).
- Ignore user search engine queries.
To modify your Network Prevent for Web server configuration

1. Go to System > Servers > Overview and click the Network Prevent for Web Server.

2. On the Server Detail screen that appears, click Configure.

   You can verify or modify settings on the ICAP tab as described in subsequent steps. The tab is divided into several sections: Request Filtering, Response Filtering, and Connection.

3. Verify or change the Trial Mode setting. Trial Mode lets you test prevention without blocking requests in real time. If you select Trial Mode, Symantec Data Loss Prevention detects incidents and indicates that it has blocked an HTTP communication, but it does not block the communication.

4. Verify or modify the filter options for requests from HTTP clients (user agents). The options in the Request Filtering section are as follows:

   - **Ignore Requests Smaller Than**
     Specifies the minimum body size of HTTP requests to inspect. (The default is 4096 bytes.) For example, search-strings typed in to search engines such as Yahoo or Google are usually short. By adjusting this value, you can exclude those searches from inspection.

   - **Ignore Requests without Attachments**
     Causes the server to inspect only the requests that contain attachments. This option can be useful if you are mainly concerned with requests intended to post sensitive files.

   - **Ignore Requests to Hosts or Domains**
     Causes the server to ignore requests to the hosts or domains you specify. This option can be useful if you expect a lot of HTTP traffic between the domains of your corporate headquarters and branch offices. You can type one or more host or domain names (for example, www.company.com), each on its own line.

   - **Ignore Requests from User Agents**
     Causes the server to ignore requests from user agents (HTTP clients) you specify. This option can be useful if your organization uses a program or language (such as Java) that makes frequent HTTP requests. You can type one or more user agent values, each on its own line.
5 Verify or modify the filter options for responses from Web servers. The options in the **Response Filtering** section are as follows:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ignore Responses Smaller Than</strong></td>
<td>Specifies the minimum size of the body of HTTP responses that are inspected by this server. (Default is 4096 bytes.)</td>
</tr>
<tr>
<td><strong>Inspect Content Type</strong></td>
<td>Specifies the MIME content types that Symantec Data Loss Prevention should monitor in responses. By default, this field contains content-type values for Microsoft Office, PDF, and plain text formats. To add others, type one MIME content type per line. For example, type <code>application/word2013</code> to have Symantec Data Loss Prevention analyze Microsoft Word 2013 files. Note that it is generally more efficient to specify MIME content types at the Web proxy level.</td>
</tr>
<tr>
<td><strong>Ignore Responses from Hosts or Domains</strong></td>
<td>Causes the server to ignore responses from the hosts or domains you specify. You can type one or more host or domain names (for example, <a href="http://www.company.com">www.company.com</a>), each on its own line.</td>
</tr>
<tr>
<td><strong>Ignore Responses to User Agents</strong></td>
<td>Causes the server to ignore responses to user agents (HTTP clients) you specify. You can type one or more user agent values, each on its own line.</td>
</tr>
</tbody>
</table>
6 Verify or modify settings for the ICAP connection between the HTTP proxy server and the Web Prevent Server. The Connection options are as follows:

- **TCP Port**: Specifies the TCP port number over which this server listens for ICAP requests. This number must match the value that is configured on the HTTP proxy that sends ICAP requests to this server. The recommended value is 1344.

- **Maximum Number of Requests**: Specifies the maximum number of simultaneous ICAP request connections from the HTTP proxy or proxies. The default is 25.

- **Maximum Number of Responses**: Specifies the maximum number of simultaneous ICAP response connections from the HTTP proxy or proxies. The default is 25.

- **Connection Backlog**: Specifies the number of waiting connections allowed. A waiting connection is a user waiting for an HTTP response from the browser. The minimum value is 1. If the HTTP proxy gets too many requests (or responses), the proxy handles them according to your proxy configuration. You can configure the HTTP proxy to block any requests (or responses) greater than this number.

7 Click **Save** to exit the Configure Server screen and then click **Done** to exit the Server Detail screen.

### About proxy server configuration

You must configure at least one HTTP proxy server to forward Web requests or responses to the Mobile Prevent for Web Server. The HTTP proxy acts as an ICAP client to the Network Prevent for Web Server. Symantec Data Loss Prevention supports both the request modification (REQMOD) and response modification (RESPMOD) modes of ICAP. If you want to analyze requests as well as responses, use one Network Prevent for Web Server to analyze requests. Use a second Network Prevent for Web Server to analyze responses.
Note that most proxy servers provide methods of filtering what is forwarded to the Network Prevent for Web Server in both REQMOD mode and RESPROMD modes. Consult the proxy server's documentation for details.

See “Specifying one or more proxy servers” on page 1173.

See “Proxy server compatibility with Network Prevent for Web” on page 1171.

See “Configuring request and response mode services” on page 1172.

Proxy server compatibility with Network Prevent for Web

Network Prevent for Web Servers use the ICAP protocol and can operate with the following proxies:

<table>
<thead>
<tr>
<th>Proxy</th>
<th>Supported protocols</th>
<th>Configuration information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blue Coat ProxySG version 4.2.1, 5.2.4.8, 5.5.2.1, 5.5.3.1, 6.2.12.1, and 6.5.x for Network Prevent for Web</td>
<td>HTTP, HTTPS, FTP over HTTP, or FTP proxy</td>
<td>Blue Coat product documentation</td>
</tr>
<tr>
<td>Blue Coat ProxySG version 5.5.3.1 for Mobile Prevent</td>
<td>HTTP, HTTPS, FTP over HTTP, or FTP proxy</td>
<td>Blue Coat product documentation</td>
</tr>
<tr>
<td>Cisco IronPort S-Series version 6.0, 7.1.2</td>
<td>HTTP, HTTPS, FTP over HTTP</td>
<td>Cisco IronPort product documentation</td>
</tr>
<tr>
<td>Microsoft TMG 2010 (without service pack, or with SP1 or SP2) on Microsoft Windows 2008 R2 SP1 Enterprise or Standard Edition</td>
<td>HTTP, HTTPS, limited FTP over HTTP/S</td>
<td>See the <em>Symantec Data Loss Prevention Integration Guide for Microsoft Threat Management Gateway</em></td>
</tr>
<tr>
<td>Secure Computing Secure Web (Webwasher) versions 6.9.x, 7.2, and 7.4</td>
<td>HTTP, HTTPS, FTP over HTTP, or FTP proxy</td>
<td>Secure Web documentation (particularly the chapter that describes setting up Secure Web with a DLP Solution)</td>
</tr>
<tr>
<td>Squid Web Proxy version 3.0 Stable 18 through 3.1.11, 3.3.5 (Linux only)</td>
<td>HTTP</td>
<td>See the <em>Symantec Data Loss Prevention Integration Guide for Squid Web Proxy</em></td>
</tr>
<tr>
<td>Symantec Web Gateway versions 5.0 and 5.0.2.8</td>
<td>HTTP, HTTPS</td>
<td>See the <em>Symantec Web Gateway 5.0 Implementation Guide</em></td>
</tr>
</tbody>
</table>
Table 53-1  Network Prevent for Web supported proxy servers  (continued)

<table>
<thead>
<tr>
<th>Proxy</th>
<th>Supported protocols</th>
<th>Configuration information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Websense Appliance V5000 and V10000, with Websense Web Security version 7.6.0</td>
<td>HTTP, HTTPS</td>
<td>Does not support redaction. Only supports &quot;Block HTTP/HTTPS&quot;. RESPMOD is not supported. Websense blocks the traffic only when the size of the Symantec Data Loss Prevention rejection message (in the response rule) is larger than 512 bytes. If the rejection message is less than 512 bytes, an incident is generated but the network traffic is not blocked.</td>
</tr>
</tbody>
</table>

See “Specifying one or more proxy servers” on page 1173. See “About proxy server configuration” on page 1170.

Configuring request and response mode services

For details on configuring the proxy server, refer to your proxy server product documentation, or contact your proxy server administrator.

To configure a proxy server:

1. REQMOD. On your proxy server, create an ICAP REQMOD service that forwards requests to the Mobile Prevent for Web Server. If your proxy server supports different protocols, configure it to handle the wanted protocols.
   For REQMOD mode, an ICAP service on the proxy server should look like:
   \[icap://ip_address|FQDN[:port]/reqmod\]

2. RESPMOD. On your proxy server, create an ICAP RESPMOD service that forwards responses to the Mobile Prevent for Web Server. If your proxy server supports different protocols, configure it to handle the wanted protocols.
   For RESPMOD mode, an ICAP service on the proxy server should look like:
   \[icap://ip_address|FQDN[:port]/respmod\]

Where:
- \[ip_address|FQDN\] identifies the Mobile Prevent for Web Server using either an IP address or fully qualified domain name.
Port is the port number to which Mobile Prevent for Web Server listens. Specifying the port number is optional when the default ICAP port (1344) is used.

/regmod is required for correct functionality in REQMOD mode.

/respmod is required for correct functionality in RESPMOD mode.

Examples:

icap://10.66.194.45/reqmod
icap://10.66.194.45:1344/reqmod
icap://netmonitor1.company.com/reqmod
icap://10.66.194.45/respmod
icap://10.66.194.45:1344/respmod
icap://netmonitor1.company.com/respmod

Note that the port that is specified in the ICAP service definition on the proxy must match the port on which Mobile Prevent for Web Server listens.

See “Proxy server compatibility with Network Prevent for Web” on page 1171.

See “About proxy server configuration” on page 1170.

Specifying one or more proxy servers

By default, Network Prevent for Web Server can accept connections to the ICAP service port from any system on the network. For security reasons, you can limit ICAP connections to only those systems that you designate (or “whitelist”). Once you whitelist one or more systems, systems not on the whitelist cannot connect to the Network Prevent for Web Server ICAP service port.

Note that a proxy server whitelist can be affected by the Icap.BindAddress setting. By default, the Icap.BindAddress settings is 0.0.0.0, and the listener binds to all available addresses. If Icap.BindAddress instructs the listener to bind to a specific IP, a white listed proxy must also be able to reach the listener address.

To create a whitelist of systems allowed to make a connection to the Network Prevent for Web server ICAP service port:

1. Go to System > Servers > Overview and click on the wanted Network Prevent for Web Server.
2. On the Server Detail screen that appears, click Server Settings.
3. Scroll down to the Icap.AllowHosts setting.

By default, Icap.AllowHosts is set to any, meaning that all other systems on the network can communicate with this Network Prevent for Web Server.
4 You can limit the systems that are allowed to connect with this Network Prevent for Web Server. Delete any and enter the IP addresses or Fully-Qualified Domain Name (FQDN) of the systems you want to authorize. Separate multiple addresses with commas. For example: 123.14.251.31,webcache.corp.mycompany.com,123.14.223.111. Use only commas to separate multiple entries; do not include spaces.

5 Click Save.

Changes to this setting do not take effect until you restart the server.

See “Proxy server compatibility with Network Prevent for Web” on page 1171.

See “About proxy server configuration” on page 1170.

Enabling GET processing for Network Prevent for Web

By default, Network Prevent for Web does not process HTTP GET commands because of the high traffic volume. Follow this procedure to enable the server to process GET commands.

To enable GET processing with Network Prevent for Web

1 Configure the Web proxy server to forward GET requests to the Network Prevent for Web Server as described in your proxy server documentation.

2 Ensure that the L7.processGets advanced server setting on the Network Prevent for Web Server must be “true” (which is the default).

3 Reduce the size of the L7.minSizeofGetURL Advanced setting on the Network Prevent for Web Server. Reduce from the default of 100 to a number of bytes smaller than the length of the shortest Web site URL from which you want to process GET commands. A minimum URL size to 10 should cover all cases. Note, however, that reducing the minimum size of GETs increases the number of requests that have to be processed, which increases the server traffic load.

4 Adjust the Ignore Requests Smaller Than setting in the ICAP section of the Network Prevent for Web Server Detail page. Reduce it from the default of 4096 bytes to a lower value that would enable the request to undergo DLP inspection. Note, however, that lowering the value increases the server traffic load.

See “Enabling GET processing with Network Monitor” on page 1149.
Creating policies for Network Prevent for Web

You can create the policies that include any of the standard response rules. For example, Add Comment, Limit Incident Data Retention, Log to a Syslog Server, Send Email Notification, and Set Status.

See “About Symantec Data Loss Prevention reports” on page 1006.

You can also incorporate the rules that are specific to Network Prevent for Web Server as follows:

- **Network Prevent: Block HTTP/HTTPS**
  Blocks posts that contain confidential data (as defined in your policies). This includes Web postings, Web-based email messages, and files that are uploaded to Web sites or attached to Web-based email messages.

  __Note:__ Certain applications may not provide an adequate response to the **Network Prevent: Block HTTP/HTTPS** response action. This behavior has been observed with the Yahoo! Mail application when a detection server blocks a file upload. If a user tries to upload an email attachment and the attachment triggers a **Network Prevent: Block HTTP/HTTPS** response action, Yahoo! Mail does not respond or display an error message to indicate that the file is blocked. Instead, Yahoo! Mail appears to continue uploading the selected file, but the upload never completes. The user must manually cancel the upload at some point by pressing **Cancel**.

  Other applications may also exhibit this behavior, depending on how they handle the block request. In these cases a detection server incident is created and the file upload is blocked even though the application provides no such indication.

- **Network Prevent: Remove HTTP/HTTPS Content**
  Removes confidential data from posts that contain confidential data (as defined in your policies). This includes Web-based email messages and files that are uploaded to Web sites or attached to Web-based email messages. Note that the Remove HTTP/HTTPS Content action works only on requests.

- **Network Prevent: Block FTP Request**
  Blocks FTP transfers that contain confidential data (as defined in your policies).

  For details on setting up any response rule action, open the online Help. Go to **Manage > Policies > Response Rules** and click **Add Response Rule**.

  Even if you do not incorporate response rules into your policy, Network Prevent for Web captures incidents as long as your policies contain detection rules. You can set up such policies to monitor Web and FTP activity on your network before implementing the policies that block or remove content.
If you have configured your proxy to forward both HTTP/HTTPS requests and responses, your policies work on both. For example, policies are applied to both an upload to a Web site and a download from a Web site.

To create a test policy for Network Prevent for Web

1. In the Enforce Server administration console, create a response rule that includes one of the actions specific to Network Prevent for Web. For example, create a response rule that includes the **Network Prevent: Block HTTP/HTTPS** action.

   See “Configuring response rules” on page 891.

2. Create a policy that incorporates the response rule you configured in the previous step.

   For example, create a policy called Test Policy as follows:

   - Include a **Content Matches Keyword** detection rule that matches on the keyword secret.
   - Include a **Network Prevent: Block HTTP/HTTPS** response rule.
   - Associate it with the Default policy group.

   See “Configuring policies” on page 326.

Testing Network Prevent for Web

You can test Network Prevent for Web by sending a Web email that violates your test policy.

To test your system

1. Open a browser that accesses the Internet through your HTTP proxy server.

2. In the browser, access a test Web email account and send an email with an attachment containing confidential data. For example, access an account in Hotmail and send an email with an attachment containing the word *Secret* and paragraphs of other text.

3. In the Enforce Server administration console, go to **Incidents > Network** and click **Incidents - All**. Look for the resulting incident. For example, search for an incident entry that includes the appropriate timestamp and policy name.

4. Click on the relevant incident entry to see the complete incident snapshot.

   See “About strategies for using reports” on page 1007.
## Troubleshooting information for Network Prevent for Web Server

The following table describes a common problem when using Network Prevent for Web Server and suggests a possible solution.

### Table 53-2 Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incidents appear in Network reports, but Symantec Data Loss Prevention does not perform the action specified in the relevant response rule.</td>
<td>This is expected behavior when the Network Prevent for Web Server is running in trial mode (the default setting). If you do not want to run in trial mode, change the setting. See &quot;Configuring Network Prevent for Web Server&quot; on page 1167.</td>
</tr>
</tbody>
</table>
Discovering where confidential data is stored

- Chapter 54. About Network Discover
- Chapter 55. Setting up and configuring Network Discover
- Chapter 56. Network Discover scan target configuration options
- Chapter 57. Managing Network Discover target scans
- Chapter 58. Using Server FlexResponse plug-ins to remediate incidents
- Chapter 59. Setting up scans of file shares
- Chapter 60. Setting up scans of Lotus Notes databases
- Chapter 61. Setting up scans of SQL databases
- Chapter 62. Setting up scans of SharePoint servers
- Chapter 63. Setting up scans of Exchange servers
- Chapter 64. About Network Discover scanners
- Chapter 65. Setting up scanning of file systems
- Chapter 66. Setting up scanning of Web servers
- Chapter 67. Setting up scanning of Documentum repositories
- Chapter 68. Setting up scanning of Livelink repositories
- Chapter 69. Setting up Web Services for custom scan targets
About Network Discover

This chapter includes the following topics:

- About Network Discover
- How Network Discover works

About Network Discover

Network Discover locates the exposed confidential data by scanning a broad range of enterprise data repositories. These data repositories include file servers, databases, Microsoft SharePoint, Lotus Notes, Documentum, Livelink, Microsoft Exchange, Web servers, and other data repositories.

Network Discover can scan the following data sources:

- Network file shares (CIFS, NFS, or DFS)
  See “Setting up server scans of file systems” on page 1241.
- Local file systems on Windows desktops and laptops
  Local file systems on Windows, Linux, AIX, and Solaris servers
  See “Setting up remote scanning of file systems” on page 1315.
- Lotus Notes Databases
  See “Setting up server scans of Lotus Notes databases” on page 1261.
- SQL Databases
  See “Setting up server scans of SQL databases” on page 1267.
- SharePoint 2007 and 2010 servers
  See “Setting up server scans of SharePoint servers” on page 1274.
- Microsoft Exchange Servers
  See “Setting up server scans of 2007 repositories using the Exchange Web Store connector” on page 1287.
See “Setting up server scans of Exchange 2007 SP2 and 2010 repositories using Exchange Web Services” on page 1295.

- Documentum
  See “Setting up remote scanning of Documentum repositories” on page 1339.

- Livelink
  See “Setting up remote scanning of Livelink repositories” on page 1348.

- Web servers (Web sites and Web-based applications)
  See “Setting up remote scanning of Web servers” on page 1327.

- Web services
  Web services expose a custom integration point. You can write custom code to scan any repository. The custom code crawls the repository and feeds the content to a Network Discover Server for scanning. Custom applications and repositories can be scanned with Web services.
  See “Setting up Web Services for custom scan targets” on page 1356.

- Custom
  Custom applications can be written that extract content and metadata from a repository and feed them to Network Discover. The recommended Network Discover interface for custom integration is Web services.

Endpoint Discover can scan file systems on Windows desktop or laptop computers. Endpoint Discover includes an agent on the Windows desktop or laptop computer that scans the local file system.

During incident remediation, Symantec Data Insight helps organizations solve the problem of identifying data owners and responsible parties for information due to incomplete or inaccurate metadata or tracking information.

With Symantec Data Insight, users can monitor file access to automatically identify the data user of a file based on the access history. The usage information then automatically feeds into the incident detail of files that violate Symantec Data Loss Prevention policies. This method enables users to identify sensitive data along with the responsible users to enable more efficient remediation and data management.

See the Symantec Data Loss Prevention Data Insight Implementation Guide.

The FlexResponse Platform enables the creation of comprehensive custom remediation actions for the files that are discovered using Symantec Data Loss Prevention Network Discover. FlexResponse supports Symantec and third-party file security solutions including Enterprise Digital Rights Management and encryption. FlexResponse is an extension of the Network Protect product, and the Network Protect product is required for FlexResponse functionality.
See the Symantec Data Loss Prevention FlexResponse Developers Guide, or contact Symantec Data Loss Prevention Professional Services for a list of available plug-ins.

During incident remediation, you can use the installed FlexResponse plug-ins to remediate incidents.

See “Using Server FlexResponse custom plug-ins to remediate incidents” on page 1230.

How Network Discover works

The Network Discover Server locates a wide range of exposed confidential data. It communicates with the Enforce Server to obtain information about policies and scan targets. It sends information about the exposed confidential data that it finds to the Enforce Server for reporting and remediation.

Figure 54-1 shows the Network Discover Server securely inside the corporate LAN.

The Network Discover Server is connected to the Enforce Server and each server performs the tasks that are related to locating exposed confidential data.

Multiple Network Discover Servers can be set up to spread out the work.

See “Adding a detection server” on page 194.

The Network Discover Server scans the selected targets, reads the files or repositories, and detects whether confidential information is present.

The Enforce Server contains the user interface where the following tasks are done:

- Setting up target scans.
- Selecting target repositories.
- Defining filters for the scans.
- Scheduling scans.

See “Adding a new Network Discover target” on page 1187.

The Enforce Server also manages the scans running on the Network Discover Servers and displays the status of the scans in the user interface.

See "Managing Network Discover target scans" on page 1209.

After a scan is complete, you can display the reports of the exposed confidential data on the Enforce Server.

See “About reports for Network Discover” on page 988.
Figure 54-1  Network Discover

About Network Discover

How Network Discover works
Setting up and configuring Network Discover

This chapter includes the following topics:

- Setting up and configuring Network Discover
- Modifying the Network Discover Server configuration
- About Linux Network Discover Servers
- Adding a new Network Discover target
- Editing an existing Network Discover target

Setting up and configuring Network Discover

Setting up a Network Discover scan target involves several steps. Each of these steps is necessary to correctly implement Network Discover target scanning.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Modify the Network Discover Server configuration, if needed.</td>
<td>See “Modifying the Network Discover Server configuration” on page 1185.</td>
</tr>
<tr>
<td>2</td>
<td>Create a policy group.</td>
<td>Go to System &gt; Servers &gt; Policy Groups. On the Policy Group List screen that appears, click Add Policy Group. See “Creating and modifying policy groups” on page 348.</td>
</tr>
</tbody>
</table>
Table 55-1  Setting up and Configuring Network Discover (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Create a policy.</td>
<td>Go to Manage &gt; Policies &gt; Policy List on the Enforce Server. Select Add a blank policy. Add a rule to the policy. See “Configuring policies” on page 326.</td>
</tr>
<tr>
<td>5</td>
<td>Create a Network Discover Target.</td>
<td>Go to Manage &gt; Discover Scanning &gt; Discover Targets on the Enforce Server. Click New Target, and use the pull-down menu to select the specific target type. See “Adding a new Network Discover target” on page 1187.</td>
</tr>
<tr>
<td>6</td>
<td>Set options for the target.</td>
<td>See “Network Discover scan target configuration options” on page 1191.</td>
</tr>
<tr>
<td>7</td>
<td>Set up reports.</td>
<td>See “About Symantec Data Loss Prevention reports” on page 1006.</td>
</tr>
</tbody>
</table>

Modifying the Network Discover Server configuration

After you have installed your Network Discover Servers and registered them with the Enforce Server, you can modify the Network Discover Server configuration.

If your Network Discover Server is installed on a Linux system, note the differences from a Network Discover Server on a Windows system.

See “About Linux Network Discover Servers” on page 1187.

The Network Discover Server can be installed on a virtual machine. For the supported virtual machines types, see the Symantec Data Loss Prevention System Requirements and Compatibility Guide.

If you have configured incremental scanning, the incremental scan index is automatically distributed to all Discover Servers, including any new Discover Servers.
See “About incremental scans” on page 1223.

To modify a Network Discover Server configuration

1 In the Enforce Server administration console, go to System > Servers > Overview. Then click the server to modify.

   The appropriate Server Detail screen appears and displays general server information, configuration information, deployed indexes, and recent server events.

2 Click Configure.

   The Configure Server screen appears and displays configuration options for the server type.

3 Modify the server configuration.

   The following configuration options are on the General tab:

   ■ Name
      The name of the detection server (used for displays in the Enforce Server administration console). Changing this setting for an existing detection server affects your filter options in Symantec Data Loss Prevention reports. Network Discover Servers are detection servers.

   ■ Host
      The detection server host name or IP address on which the detection server listens for connections to the Enforce Server. You might need to modify this setting when you replace a Network Discover Server host computer.

   ■ Port
      The detection server uses the port number to accept connections from the Enforce Server. This value must be greater than 1024. It must also match the value of the listenPort property in the detection server’s Communication.properties file. This file is located in SymantecDLP\Protect\config. If you change this setting, restart the detection server after modifying the listenPort value in the Communication.properties file. You should not need to change this setting after a successful installation.

   See “Server controls” on page 178.
The configuration for parallel scanning is on the **Discover** tab. Enter the number of parallel scans to run on this Network Discover Server. The default is 1.

The maximum count can be increased at any time. After it is increased, then any queued scans that are eligible to run on this Network Discover Server are started.

The count can be decreased only if the Network Discover Server has no running scans. Before you reduce the count, pause or stop all scans on the Network Discover Server.

Parallel scans of server and scanner target types are supported. Parallel scanning of Endpoint file systems is not supported.

See “Configuring parallel scanning of Network Discover targets” on page 1226.

When you finish modifying a server configuration, click **Save** to exit the **Configure Server** screen and then click **Done** to exit the Server Detail screen.

To view the active scans on this Network Discover Server, go to **Policies > Discover Scanning > Discover Servers**.

See “Managing Network Discover target scans” on page 1209.

**About Linux Network Discover Servers**

If your Network Discover Server is installed on a Linux system, note the following differences from a Network Discover Server on a Windows system:

- The date **Last Accessed** of a file cannot be reset after it is scanned.
- The **Owner** and date **Last Accessed** of the violating file cannot be retrieved. The Access Control Lists (ACLs) are retrieved correctly.
- You cannot scan Microsoft Outlook Personal Folders (.pst) files.
- SFTP scanning is not supported.
- A Network Discover Server on Linux uses jCIFS which is limited to a single-thread. Scans may be slower than on a Windows Network Discover Server.

See “Setting up and configuring Network Discover” on page 1184.

**Adding a new Network Discover target**

Before adding a Network Discover target, you must complete the Network Discover Server setup.

See “Setting up and configuring Network Discover” on page 1184.
To add a Network Discover target

1  In the Enforce Server administration console, go to Manage > Discover Scanning > Discover Targets.

2  Click New Target, and use the pull-down menu to select the specific target type.

3  On the General tab, enter the name of this Network Discover target. This name displays for management of scans.

   See “Managing Network Discover target scans” on page 1209.

4  Enter the remaining required parameters. Enter the policy group. Enter the Network Discover Server.

   See “Configuring the required fields for Network Discover targets” on page 1193.
5 Continue the addition of a new target, with the entries specific to that target type.

| Network file servers and shares (CIFS, NFS, DFS) | See “Setting up server scans of file systems” on page 1241. |
| Lotus Notes databases | See “Setting up server scans of Lotus Notes databases” on page 1261. |
| SQL databases | See “Setting up server scans of SQL databases” on page 1267. |
| Local file systems on Windows desktops and laptops | See “Setting up remote scanning of file systems” on page 1315. |
| Local file systems on Windows, Linux, AIX, and Solaris servers | See “Setting up remote scanning of file systems” on page 1315. |
| Microsoft Exchange | See “Setting up server scans of 2007 repositories using the Exchange Web Store connector” on page 1287. |
| | See “Setting up server scans of Exchange 2007 SP2 and 2010 repositories using Exchange Web Services” on page 1295. |
| SharePoint | See “Setting up server scans of SharePoint servers” on page 1274. |
| Documentum | See “Setting up remote scanning of Documentum repositories” on page 1339. |
| Livelink | See “Setting up remote scanning of Livelink repositories” on page 1348. |
| Web servers (Web sites and Web-based applications) | See “Setting up remote scanning of Web servers” on page 1327. |

6 Configure optional Network Discover target parameters.

See “Network Discover scan target configuration options” on page 1191.

**Editing an existing Network Discover target**

To set various configuration options, edit the configuration of a Network Discover target.

You can also add a new Network Discover target, and set options at that time.
See “Adding a new Network Discover target” on page 1187.

To edit a Network Discover target

1. In the Enforce Server administration console, go to Manage > Discover Scanning > Discover Targets.

2. Click one of the scan targets from the list to open the target for editing.

3. Edit the desired option.

See “Network Discover scan target configuration options” on page 1191.
Network Discover scan target configuration options

This chapter includes the following topics:

- Network Discover scan target configuration options
- Configuring the required fields for Network Discover targets
- Scheduling Network Discover scans
- Providing the password authentication for Network Discover scanned content
- Encrypting passwords in configuration files
- Setting up Network Discover filters to include or exclude items from the scan
- Filtering Discover targets by item size
- Filtering Discover targets by date last accessed or modified
- Optimizing resources with Network Discover scan throttling
- Creating an inventory of the locations of unprotected sensitive data

Network Discover scan target configuration options

Use the General, Scanned Content, Filters, and Advanced tabs to configure a Network Discover scan target.

The General tab is available for all types of targets.

The Scanned Content, Filters, and Advanced tabs are only available for some types of targets.

See “Editing an existing Network Discover target” on page 1189.
For the additional configuration information that is specific to one type of target, refer to the section for that target type.

Note that all filters are combined with “and” if a value is provided. Consider all filter values when adding or modifying scan filters, to avoid unintentionally including or excluding everything from the scan.

For configuration when adding or editing a target, select from the following options:

<table>
<thead>
<tr>
<th>Optional tasks</th>
<th>Tab in scan target</th>
<th>Description of task</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure required fields.</td>
<td>General</td>
<td>See “Configuring the required fields for Network Discover targets” on page 1193.</td>
</tr>
<tr>
<td>These required fields should be set when a new target is added.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Schedule Network Discover scans.</td>
<td>General</td>
<td>See “Scheduling Network Discover scans” on page 1194.</td>
</tr>
<tr>
<td>Configure incremental scans.</td>
<td>General</td>
<td>See “Scanning new or modified items with incremental scans” on page 1224.</td>
</tr>
<tr>
<td>Provide authentication, and set up credentials.</td>
<td>Scanned</td>
<td>See “Providing the password authentication for Network Discover scanned content” on page 1196.</td>
</tr>
<tr>
<td>Include, or exclude, repositories from a scan.</td>
<td>Filters</td>
<td>See “Setting up Network Discover filters to include or exclude items from the scan” on page 1198.</td>
</tr>
<tr>
<td>Filter targets by file size.</td>
<td>Filters</td>
<td>See “Filtering Discover targets by item size” on page 1201.</td>
</tr>
<tr>
<td>Filter targets by date last accessed or modified.</td>
<td>Filters</td>
<td>See “Filtering Discover targets by date last accessed or modified” on page 1202.</td>
</tr>
<tr>
<td>Optimize your resources with scan throttling.</td>
<td>Advanced</td>
<td>See “Optimizing resources with Network Discover scan throttling” on page 1204.</td>
</tr>
<tr>
<td>Create an inventory of the locations of unprotected sensitive data.</td>
<td>Advanced</td>
<td>See “Creating an inventory of the locations of unprotected sensitive data” on page 1206.</td>
</tr>
</tbody>
</table>
Optional tasks | Tab in scan target | Description of task
--- | --- | ---
Specify options for automatically tracking remediation status for network file system incidents. | Advanced | See “Configuring and running scans of file systems” on page 1254.
Move or quarantine files in network file shares with Network Protect. | Protect | See “Configuring Network Protect for file shares” on page 1258.

### Configuring the required fields for Network Discover targets

For a new target, enter the name of the target, the policy group, and the Discover Server where the scans can run.

These required fields should be set when a new target is added.

**To enter the required fields for a target**

1. In the Enforce Server administration console, go to **Manage > Discover Scanning > Discover Targets**.
2. Click **New Target**, and use the pull-down menu to select the specific target type.
3. On the **General** tab, enter the **Name** of this Discover target.

   Enter a unique name for the target, or edit the existing name, up to 255 characters.
4. Select the **Policy Group**.

   If no other policy group has been selected, the Default Policy group is used. To apply a policy group, select the policy group to use for this target. You can assign multiple policy groups to a target.

   The administrator defines policy groups on the **Policy Group List** page. If the policy group you want to use does not appear on the list, contact your Symantec Data Loss Prevention administrator.
5 Select the Discover Server (or multiple Discover Servers) where you want to allow the scan to run.

If you select more than one server, Symantec Data Loss Prevention automatically selects one of the servers when the scan starts.

Only the detection servers that were configured as Discover Servers appear on the list. If there is only one Discover Server on your network, the name of that server is automatically specified. You should configure your Discover Servers before you configure targets. You must specify at least one server before you can run a scan for this target.

6 On the Scanned Content tab, you must enter the item to be scanned. Refer to the documentation about each type of target for additional information about this entry.

   See “About Network Discover” on page 1180.

7 You can configure other options for this target.

   See “Network Discover scan target configuration options” on page 1191.

Scheduling Network Discover scans

Network Discover scans can be set up to run on a regular schedule, for example during nights or weekends. Scans can also be set to pause during specified times, for example when resources are normally busy with other tasks.

For file shares, Lotus Notes, or SQL databases, the scan schedule can be completely specified with the Scan Schedule parameters.

For the scanner targets (such as SharePoint or Exchange), the scan must also be scheduled from the computer where the scanner is installed. You must manually manage the scan schedule between the Discover target and the scanner application. The scanners are installed, configured, and run outside of the Enforce Server and Network Discover Server. For example, the scanner can be scheduled to run automatically using the host’s native scheduling. You can create a UNIX cron job, or add the scanner to the Windows scheduler. The scanner should be scheduled to run before the scheduled Network Discover scan, so that the Network Discover scan has information to consume.

If you select a specific time for starting or pausing a scan, the time zone of the Enforce Server is used.

You can configure other options for this target.

See “Network Discover scan target configuration options” on page 1191.
To set up a scan schedule

1. In the Enforce Server administration console, go to Manage > Discover Scanning > Discover Targets.
2. Click the name of the scan that you want to schedule.
3. Click the General tab.
4. Select the item Submit Scan Job on Schedule.
   
   When you select this check box to set up a schedule for scanning the specified target, the Schedule drop-down list becomes available. After you select an option from the Schedule drop-down list, additional fields appear.

5. Select one of the following additional fields:

   - No Regular Schedule: Save the target without a schedule.
   - Scan Once: Run the scan one time, at the specified time and date.
   - Scan Daily: Scan the target daily, at the specified start time. Check Until to stop the daily scan after a certain date.
   - Scan Weekly: Scan the target every week. Check Until to stop the weekly scan after a certain date.
   - Scan Monthly: Scan the target every month. Check Until to stop the monthly scan after a certain date.

6. Click Save.

To pause a scan during specified times

1. In the Enforce Server administration console, go to Manage > Discover Scanning > Discover Targets.
2. Click the name of the scan that you want to pause during specified times.
3. Click the General tab.
4. Select the item Pause Scan between these times.
Select the pause options.

This option automatically pauses scans during the specified time interval. You can override a target's pause window by going to the Discover Targets screen and clicking the start icon for the target entry. The pause window remains intact, and any future scans that run up against the scan window pause as specified. You can also restart a paused scan by clicking the continue icon in the target entry.

**Note:** If the target configuration is modified while it is paused, then the modified configuration does not apply to items that were already scanned. When a scan is paused and restarted, the scan is restarted from a checkpoint that is created when the scan is paused. The modified configuration is used for the items that are scanned from that checkpoint.

Click **Save**.

### Providing the password authentication for Network Discover scanned content

On the **Scanned Content** tab, enter the configuration options for authentication. Avoid special characters in the authentication credentials. Authentication credentials must not contain any of the following characters, or the scan fails:

- Pipe character
- Ampersand character
- Quotation marks (single or double)

**To provide password authentication for scanned content**

1. In the Enforce Server administration console, go to **Manage > Discover Scanning > Discover Targets**.
2. Click the name of the scan to provide the password authentication.
3. Click the **Scanned Content** tab.
4. You can enter authentication information in several ways:
   - Use a stored credential.
     - If a stored credential is available, select a named credential from the drop-down in **Use Saved Credentials**.
   - A global scan credential can be provided for all shares in this target.
Enter the user name and password in **Use These Credentials**.

- Separate authentication credentials can be provided for each share in a list.
  A separate credential supersedes the global scan credential, if one was provided.
  Click **Add** or **Edit** to provide credentials for each share in a list.
  In the **Add** box, enter the share and credentials with the following syntax:
    
    \[
    \text{path}, [\text{username, password}][, [\text{depth}][, \text{remediation-username, remediation-password}]]
    \]
  
  For omitted items, provide a null entry with consecutive commas.

5 The format of the credentials depends on the type of scan. For the specific format and examples of credentials for each target type, see the topic for that target type.

See “About Network Discover” on page 1180.

6 You can set other options on the **Scanned Content** tab.

See “Network Discover scan target configuration options” on page 1191.

Remediation credentials can be set on the **Protect** tab.

See “Configuring Network Protect for file shares” on page 1258.

### Encrypting passwords in configuration files

Encrypt passwords in the configuration files with the utility **EncryptPassword.exe**.

**To encrypt passwords in configuration files**

1 Navigate to the bin directory of the scanner installation on the scanner computer.

   See “Scanner installation directory structure” on page 1309.

2 Run the utility **EncryptPassword.exe**.

   This utility encrypts the password that is provided in the scanner configuration files.

3 When the utility requires you to enter a password, enter a password.

4 Click the encrypt option.

5 Place the encrypted password into the Password= setting in the Vontus\_scanner\_typeScanner.cfg file.

See “Configuration options for Web server scanners” on page 1332.

See “Configuration options for Documentum scanners” on page 1344.
Setting up Network Discover filters to include or exclude items from the scan

Exclude and include filters reduce the number of items or repositories to scan.

Use the Include Filters field to specify the items that Symantec Data Loss Prevention should process. If you leave the Include Filters field empty, Symantec Data Loss Prevention performs matching on all items in the selected target. If you enter any values in the field, Symantec Data Loss Prevention scans only those items that match your filter.

Use the Exclude Filters field to specify the items that Symantec Data Loss Prevention should not process. If you leave the Exclude Filters field empty, Symantec Data Loss Prevention performs matching on all items in the selected target. If you enter any values in the field, Symantec Data Loss Prevention scans only those items that do not match your filter.

To optimize scanning, you can break up scans using include and exclude filters. For example, you can exclude binary items. Binary items are less likely to contain policy violations.

See “About Network Discover scan optimization” on page 1220.

Note that all filters are combined with “and” if a value is provided. Consider all filter values (for example size and date) when adding or modifying scan filters. Avoid unintentionally including everything, or excluding everything from the scan.

See “Network Discover scan target configuration options” on page 1191.

To set up include filters or exclude filters:

1. In the Enforce Server administration console, go to Manage > Discover Scanning > Discover Targets.

2. Click the name of the scan where you want to add include filters or exclude filters.

3. Click the Filters tab.
Enter file names or paths into the include filters and the exclude filters to select a subset of items that Symantec Data Loss Prevention should process. Delimit entries with a comma, but no spaces. The path filter is case-sensitive.

When both include filters and exclude filters are present, exclude filters take precedence.

The include filter and exclude filter file names are relative to the file system root. Specify full paths or subdirectories, as needed. Some wildcards are allowed.

Table 56-1 shows the syntax for the filters.

If the exclude filter entry exceeds the 1024-character limit, you can create an exclude file with the file names to be excluded.

Click Save.

To create an exclude file:

1 Create a directory named excludeFiles in the Symantec Data Loss Prevention configuration directory, for example \SymantecDLP\Protect\config\excludeFiles\.

   For a configuration with multiple Discover servers, a copy of this directory and file must be present on each Discover server.

2 In this directory create one text file for each set of items to exclude.

   For example, you can create one file for each UNIX system to be scanned. Name the files hostname.txt, where hostname is the name of the system to be scanned, as provided in the target configuration. The host name in this text file must match exactly the name that is in the Network Discover target.

3 In each file, list the paths (each path on a separate line) that you want to exclude from the scan.

   The paths can be files, directories, symbolic links, or mounted directories. The paths must each begin with a delimiter of “/” or “\” followed by the share name, directory name, and file name. For example, a valid path is \excludeshare\excludedir\excludefile.

Table 56-1 shows the syntax for filters.

<table>
<thead>
<tr>
<th>Wildcard</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>* (asterisk)</td>
<td>Use this wildcard to match any sequence of characters, including null.</td>
</tr>
</tbody>
</table>
Table 56-1  Syntax for the include filters and exclude filters (continued)

<table>
<thead>
<tr>
<th>Wildcard</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>? (question mark)</td>
<td>Use this wildcard to match any one character in the place where it appears.</td>
</tr>
<tr>
<td>, (comma)</td>
<td>Represents a logical OR. Delimit entries with a comma, but do not use any spaces.</td>
</tr>
<tr>
<td>The forward slash (/) and</td>
<td>These characters are equivalent. They usually represent directory separators, although on Linux the backslash is a valid character in a file name.</td>
</tr>
<tr>
<td>backslash () characters</td>
<td></td>
</tr>
<tr>
<td>White space at the beginning and end of the pattern</td>
<td>White space is ignored at the beginning and end of the pattern. Do not use spaces before or after the commas that delimit entries.</td>
</tr>
<tr>
<td>Escape characters</td>
<td>The matching process does not support escape characters, so there is no way to match a question mark, a comma, or an asterisk explicitly. In general, special characters in filter items are not supported.</td>
</tr>
</tbody>
</table>

Table 56-2 shows the example filters.

Table 56-2  Example filters using wildcards

<table>
<thead>
<tr>
<th>Example filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>.txt,</em>.doc</td>
<td>This example of an include filter matches only files or documents with the .txt or .doc extensions, ignoring everything else.</td>
</tr>
<tr>
<td>*.?</td>
<td>This example of an include filter matches only files or documents with a single-character extension. This example matches files such as hello.1 and hello.2, but not hello.doc or hello.html.</td>
</tr>
<tr>
<td><em>/documentation/</em>,<em>/specs/</em></td>
<td>This example of an include filter only matches on specific subdirectories of a file share or local drive called documentation and specs.</td>
</tr>
</tbody>
</table>

Syntax and examples for SQL Database scanning are in the SQL Database section. See “Configuring and running SQL database scans” on page 1268.
Syntax and examples for SharePoint scanning are in the SharePoint section.
See “Configuring and running SharePoint server scans” on page 1278.
Syntax and examples for Endpoint Discover scanning are in the Endpoint section.
See “Setting up and configuring Endpoint Discover” on page 1389.
See “Using environment variables in Endpoint Discover scans” on page 1395.

Filtering Discover targets by item size

Use size filters to exclude items from the matching process that are based on their size.
Size filters are only available for files on file shares, Endpoint files, Lotus Notes documents, SharePoint items, and Exchange items.
You can configure other options for this target.
See “Network Discover scan target configuration options” on page 1191.

To exclude items based on item size

1 In the Enforce Server administration console, go to Manage > Discover Scanning > Discover Targets.
2 Click the name of the scan that you want to filter based on item size.
3 Click the Filters tab.
4 Enter optional values under the item size filters.
   Symantec Data Loss Prevention includes only the items that match your specified size filters. If you leave this field empty, Symantec Data Loss Prevention performs matching on items of all sizes.
   Note that all filters are combined with “and” if a value is provided. Consider all filter values (for example include, exclude, and date) when adding or modifying scan filters. Avoid unintentionally including everything, or excluding everything from the scan.
5 To exclude items smaller than a particular size, enter a number in the field next to Ignore Smaller Than. Then select the appropriate unit of measure (Bytes, KB, or MB) from the drop-down list next to it.
6 To exclude items larger than a particular size, enter a number in the field next to Ignore Larger Than. Then select the appropriate unit of measure (Bytes, KB, or MB) from the drop-down list next to it.
7 Click Save to save all updates to this target.
Filtering Discover targets by date last accessed or modified

Specify date filters to exclude items from the matching process based on their dates. Only the items that match the specified date filters are included.

Date Filters are available for files on file shares, Endpoint files, Lotus Notes documents, and Microsoft SharePoint and Exchange documents.

Incremental scanning and differential scanning are available for some Network Discover target types.

See “Scanning new or modified items with incremental scans” on page 1224.

See “Scanning new or modified items with differential scans” on page 1225.

You can configure other options for this target.

See “Network Discover scan target configuration options” on page 1191.

Note that all filters are combined with “and” if a value is provided. Consider all filter values (for example include, exclude, and size) when adding or modifying scan filters. Avoid unintentionally including everything, or excluding everything from the scan.

To exclude items based on the date last accessed or modified

1. In the Enforce Server administration console, go to Manage > Discover Scanning > Discover Targets.

2. Click the Filters tab.

3. Enter optional values under File Date Filters.
4 Select **Only Scan files added or modified since the last full scan** for a differential scan.

See “Scanning new or modified items with differential scans” on page 1225.

This option scans only the items that have been added or modified (whichever is newer) since the last full scan.

If you do not select this option, Symantec Data Loss Prevention uses no date filter. It performs matching on items of all dates in the specified target.

The first scan has to be a full scan. A full scan occurs if you select this option before Symantec Data Loss Prevention scans this target for the first time.

When you select this option, you can also select the option **Make next scan a full scan**. When you select this option, the date filters for **Only scan files added or modified** and for **Only scan files last accessed** are disabled. The next scan is a full scan (if no previous full scans have completed). Subsequent scans cover only those items that have been added or modified since the full scan. After Symantec Data Loss Prevention performs the full scan, this check box is automatically deselected.

This option is not available for the target for a file system (file share). Use incremental scanning, instead.

See “About incremental scans” on page 1223.

See “About the difference between incremental scans and differential scans” on page 1222.

5 Select **Only scan files added or modified** to include files based on the added or modified date.

Symantec Data Loss Prevention only scans items after the specified **After** date, before the specified **Before** date, or between the dates you specify.

Note that if the **After** date is later than the **Before** date, then no items are scanned. If the **Before** date and the **After** date are the same, then no items are scanned. No items are scanned because the assumed time of the **Before** parameter is at zero hours, and **After** is at 24 hours.

When you select this option, you can also select from the following options:

- **After**
  
  To include the items that are created or modified (whichever is newer) after a particular date, type the date. You can also click the date widget and select a date.

- **Before**
To include the items that are created or modified (whichever is older) before a particular date, type the date. You can also click the date widget and select a date.

6 Select **Only scan files last accessed** to include files based on the last accessed date.

Symantec Data Loss Prevention only scans items after the specified **After** date, before the specified **Before** date, or between the dates you specify.

The last-accessed feature is only supported for Windows Network Discover Server scanning of CIFS shares.

Note that if the **After** date is later than the **Before** date, then no items are scanned. If the **Before** date and **After** date are the same, then no items are scanned. No items are scanned because the assumed time of the **Before** parameter is at zero hours, and **After** is at 24 hours.

When you select this option, you can also select from the following options:

- **After**
  To include the items that are accessed after a particular date, enter the date. You can also click the date widget and select a date.

- **Before**
  To include the items that are accessed before a particular date, enter the date. You can also click the date widget and select a date.

---

**Note:** The default mount process uses the CIFS client. If the default mount does not work, the mount task can use the java-based CIFS client by setting filesystemcrawler.use.jcifs=true in the properties file `Crawler.properties`.

7 Click **Save** to save all updates to this target.

### Optimizing resources with Network Discover scan throttling

You can set throttling options on the **Advanced** tab of the target for the following scan targets:

- File shares
- Endpoint files
- Lotus Notes documents
- SQL Databases
For the scanners, throttling must be set by editing the configuration file on the scanner computer.

**Note:** Use of item throttling significantly reduces the scan rate. Expect the scan rate to reduce to half the original scan rate or less.

You can also set other options to optimize scans.

See “About Network Discover scan optimization” on page 1220.

**To set scan throttling for file shares, Lotus Notes documents, or SQL Databases**

1. In the Enforce Server administration console, go to **Manage > Discover Scanning > Discover Targets**.
2. Click the scan target name to open the target for editing.
3. On the **Advanced** tab, set the throttling options.
4. Enter the maximum number of files or rows to be processed per minute, or the maximum number of bytes to be processed per minute.

   If you select both options, then the scan rate is slower than both options.

   **File Throttling**
   - Specify the maximum number of files, documents (in Lotus Notes), or rows (in SQL Databases) to be processed per minute.

   **Byte Throttling**
   - Specify the maximum number of bytes to be processed per minute.
   - Specify the unit of measurement from the drop-down list. The options are bytes, KB (kilobytes), or MB (megabytes).
To set item throttling for the scanners

1. Locate the scanner configuration file (`scanner-type.cfg`) on the computer where the scanner was installed.

2. In the scanner configuration file, modify the `ImportPoliteness` parameter and the `BatchSize` parameter.

   When you set item throttling, the scanner fetches `BatchSize` items to local storage and then waits for `ImportPoliteness` milliseconds between processing each item fetched.

   Byte throttling is not supported for any of the scanners.

3. To achieve item throttling from the repository, make the `BatchSize` parameter a small value. Then the `ImportPoliteness` value has more effect. Setting `BatchSize=1` achieves the most throttling in fetching the documents.

   For example, if you set `BatchSize=25`, and `ImportPoliteness=5000` (5 seconds), the scanner downloads the 25 documents. Then it pauses 5 seconds between processing each document.

Creating an inventory of the locations of unprotected sensitive data

To audit whether confidential data exists on a target, without scanning all of it, use Inventory Mode scanning. Inventory Mode is useful when the existence of incidents is important, not the number of them in each location.

Running a scan in Inventory Mode can also improve the performance of scanning large numbers of computers or large amounts of data. Setting incident thresholds can improve the performance of scanning by skipping to the next content root to scan, rather than scanning everything. A content root is one line (a file share, Domino server, or SQL database) specified on the `Scanned Content` tab.

You can set a maximum number of incidents for a scan item. The scan item can be a file share or a physical computer.

After the incident threshold has been reached, the scanning of this content root is stopped, and scanning proceeds to the next content root. Because the process is asynchronous, a few more incidents may be created than specified in the incident threshold.

Inventory Mode scanning is supported for the following server-based scan targets:

- File shares
  For file shares, you can also specify whether to count incidents by content root, or by computer. The content root is one file share on the list that is specified on
the Scanned Content tab. The selection is specified in the field Count Incidents By.

- Lotus Notes databases
  The incident threshold is counted per content root (Domino server from the list on the Scanned Content tab).

- SQL databases
  The incident threshold is counted per content root (SQL database from the list on the Scanned Content tab).

Inventory Mode can be set with the incident threshold parameter. You can set it when you add a new target, or when you edit an existing target.

After you locate the sensitive data, you can set other options to run the complete scans that target those locations.

See “Network Discover scan target configuration options” on page 1191.

To create an inventory of sensitive data

1. In the Enforce Server administration console, go to Manage > Discover Scanning > Discover Targets.

2. Click the scan target name to open the target for editing.

3. On the Advanced tab, you can optimize scanning with Inventory Mode scanning.

4. Set the Incident Threshold.

   Enter the number of incidents to produce before moving on to the next content root (specified on the Scanned Content tab).

5. Set the Count Incidents By option.

   For file shares you can also choose the following methods to count the incidents:

   - **Content root** (the default)
     The content root is one file share from the list on the Scanned Content tab.

     After the incident threshold is reached, the scan moves to the next file share.

   - **Machine**
     Select this option to count by computer (from the specified shares on a computer).

     When the incident threshold is reached, the scan moves to the next content root on the list to scan. If that content root is on the same physical computer as the previous item, it is skipped.

     Note that the computer name must be literally the same, for the content root to be skipped. For example, \\localhost\myfiles and
Network Discover scan target configuration options
Creating an inventory of the locations of unprotected sensitive data

\127.0.0.1\myfiles are treated as different computers, even though they are logically the same.
Managing Network Discover target scans

This chapter includes the following topics:

- Managing Network Discover target scans
- Managing Network Discover Targets
- Managing Network Discover scan histories
- Managing Network Discover Servers
- About Network Discover scan optimization
- About the difference between incremental scans and differential scans
- About incremental scans
- Scanning new or modified items with incremental scans
- About managing incremental scans
- Scanning new or modified items with differential scans
- Configuring parallel scanning of Network Discover targets

Managing Network Discover target scans

Management tasks for your Network Discover target scans fall into four broad categories: managing Network Discover targets, managing Network Discover scan histories, managing Network Discover servers, and optimizing scans.

See “Managing Network Discover Targets” on page 1210.

See “Managing Network Discover scan histories” on page 1212.
Managing Network Discover Targets

To manage your Discover scan targets, you can:

- Start, stop, and pause target scans.
- Monitor status as target scans run.
- Select targets to view details about them.
- Edit or delete targets.
- Manage multiple targets.
- Sort and filter targets for easier target management.
- Specify the number of targets to display.

See “About the Network Discover scan target list” on page 1210.
See “Working with Network Discover scan targets” on page 1211.
See “Removing Network Discover scan targets” on page 1212.

About the Network Discover scan target list

You can manage your Network Discover scan targets on the Discover Targets screen. The toolbar above the target list includes a drop-down menu for creating new scan targets; buttons for starting, stopping, and pausing scans; and an icon for filtering the items in the list. You can apply actions to multiple targets.

You can click most column headers to sort the list by the data in that column.

You can select the number of entries to display in the Discover Target list using the drop-down menu above the Actions column.

See “Managing Network Discover target scans” on page 1209.

Table 57-1 lists the columns for each target scan.

<table>
<thead>
<tr>
<th>Target Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Name</td>
<td>Name of the target scan.</td>
</tr>
<tr>
<td>Target Type</td>
<td>Type of target for the scan (such as File System or SharePoint).</td>
</tr>
</tbody>
</table>
Table 57-1  Discover Targets (continued)

<table>
<thead>
<tr>
<th>Target Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Policy Groups</td>
<td>Lists the policy groups to which the target is assigned.</td>
</tr>
<tr>
<td>Servers</td>
<td>Lists the servers assigned to this target.</td>
</tr>
<tr>
<td>Last Modified</td>
<td>Specifies the date and time that the target was last modified.</td>
</tr>
<tr>
<td>Scan Status</td>
<td>Displays the status of the scan. Click the link in this column to view a filtered scan history page for this target.</td>
</tr>
<tr>
<td>Next Scan</td>
<td>Displays the next scheduled scan for the target, if applicable.</td>
</tr>
</tbody>
</table>
| Actions            | Click the Edit Target icon to edit the target definition.  
|                    | Click the Delete icon to delete the target. |

To filter the Discover Target list

1  In the Enforce Server administration console, go to Manage > Discover Scanning > Discover Targets.

2  Click Filter. A text field or drop-down list appears in each column header in the Discover Target list.

3  Apply one of these filters to the list:
   - **Target Name**: Type the name of the target into the text field.
   - **Target Type**: Select the target type from the drop-down list.
   - **Policy Groups**: Type the name of the policy group into the text field.
   - **Servers**: Type the name of the server into the text field.
   - **Last Modified**: Select a range from the drop-down list.
   - **Scan Status**: Select a scan status from the drop-down list.
   - **Next Scan**: Select a range from the drop-down list.

4  To clear a filter, clear the value from the relevant text field or drop-down list, or click Filter.

Working with Network Discover scan targets

You can perform the following tasks with your scan targets:
To start, stop, and pause Network Discover scans

1. In the Enforce Server administration console, go to Manage > Discover Scanning > Discover Targets.
2. Select the scan target or targets you want to start, stop, or pause.
3. Click the Start, Stop, or Pause button on the target list toolbar.

To edit a Network Discover scan target

1. In the Enforce Server administration console, go to Manage > Discover Scanning > Discover Targets.
2. Click the Edit Target button for the target you want to edit.
3. Make your desired changes on the Edit Target page.
   See “Network Discover scan target configuration options” on page 1191.

Removing Network Discover scan targets

Check the scans that are running or queued before removing a scan target.
See “Managing Network Discover target scans” on page 1209.

To remove scan targets, perform these actions:
- Remove the scan target from the Enforce Server.
- Uninstall the scanner from the computer where it is installed, if applicable.

To remove a scan target

1. In the Enforce Server administration console, go to Manage > Discover Scanning > Discover Targets.
2. Click Delete icon for the target you want to remove.

Managing Network Discover scan histories

To manage your Network Discover scan histories, you can:
- View statistics about running or completed scans.
- Download scan history information in comma-separated value (CSV) format.
- View scan details.
- View incident reports.
- Delete scan histories.
- Manage multiple scan histories.
- Sort and filter scan histories for easier management.
- Specify the number of scan histories to display.

See “About Network Discover scan histories” on page 1213.
See “Working with Network Discover scan histories” on page 1214.
See “Deleting Network Discover scans” on page 1215.
See “About Network Discover scan details” on page 1215.
See “Working with Network Discover scan details” on page 1218.

About Network Discover scan histories

You can manage your Network Discover scan histories on the Scan History screen. To view a scan history list for all Discover targets, in the Enforce Server administrative console, go to Manage > Discover Scanning > Scan History.

You can click any column header to sort the list alpha-numerically by the data in that column.

You can select the number of entries to display in the Discover Target list using the drop-down menu above the Actions column.

For more details about a scan, click the link in the Scan Status column to display the Scan Detail screen.

See “About Network Discover scan details” on page 1215.
See “Managing Network Discover target scans” on page 1209.

Table 57-2 lists the fields that are displayed for each scan.

<table>
<thead>
<tr>
<th>Scan History</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Name</td>
<td>Name of the target scan.</td>
</tr>
<tr>
<td>Target Type</td>
<td>Type of target for the scan (such as File System or SharePoint).</td>
</tr>
<tr>
<td>Scan Started</td>
<td>Date and time the scan started.</td>
</tr>
<tr>
<td>Scan Status</td>
<td>Current status of the scan: Running, Paused, Completed, Stopped.</td>
</tr>
<tr>
<td>Scan Type</td>
<td>Scan type: Incremental, Differential, or Full.</td>
</tr>
</tbody>
</table>
Table 57-2  Scan History *(continued)*

<table>
<thead>
<tr>
<th>Scan History</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident Count</td>
<td>Number of incidents found in the scan.</td>
</tr>
<tr>
<td>Run Time</td>
<td>Elapsed time of the scan in dd:hh:mm:ss format.</td>
</tr>
<tr>
<td>Bytes/Items Scanned</td>
<td>Number of bytes scanned in the target, as well as the number of items scanned.</td>
</tr>
<tr>
<td>Errors</td>
<td>Number of errors during the scan.</td>
</tr>
<tr>
<td>Actions</td>
<td>Click the View Incidents icon to view an incident summary report for the scan.</td>
</tr>
<tr>
<td></td>
<td>See “About incident reports for Network Discover” on page 989.</td>
</tr>
<tr>
<td></td>
<td>See “Discover incident reports” on page 990.</td>
</tr>
<tr>
<td></td>
<td>Click the Delete icon to delete the scan. Make sure to first delete differential scans before you delete the base scan.</td>
</tr>
<tr>
<td></td>
<td>See “Deleting Network Discover scans” on page 1215.</td>
</tr>
</tbody>
</table>

To filter the Scan History list

1. In the Enforce Server administration console, go to **Manage > Discover Scanning > Scan History**.

2. Click **Filter**. A text field or drop-down list appears in the column header in the **Scan History** list.

3. Apply one of these filters to the list:
   - **Target Name**: Type the name of the target into the text field.
   - **Target Type**: Select the target type from the drop-down list.
   - **Scan Started**: Select a range from the drop-down list.
   - **Scan Status**: Select a scan status from the drop-down list.
   - **Scan Type**: Select a scan type from the drop-down list.

4. To clear a filter, clear the value from the relevant text field or drop-down list, or click **Filter**.

**Working with Network Discover scan histories**

You can perform the following tasks with your scan histories:
To export Network Discover scan histories

1. In the Enforce Server administration console, go to **Manage > Discover Scanning > Scan History**.
2. Select the scan or scans you want to export.
3. Click **Export**. The File Download dialog box appears.
4. Click **Open** to view the exported data, or click **Save** to save the file.
5. To cancel the export operation, click **Cancel**.

To view incidents for a specific scan

1. In the Enforce Server administration console, go to **Manage > Discover Scanning > Scan History**.
2. Click the **View Incidents** icon for the scan you want to view. The Discover Incidents screen appears.

Deleting Network Discover scans

You can delete specific scans from your scan history.

To delete a scan

1. In the Enforce Server administration console, go to **Manage > Discover Scanning > Scan History**.
2. Delete any differential scans before you delete the base full scan for that target. This step is not necessary for incremental scans.
3. Select the scan to be deleted, then click the delete icon in the **Actions** column.
   - To delete multiple scans, mark the checkboxes for the scans you want to delete, then click **Delete** on the toolbar.

About Network Discover scan details

You can view detailed information about each Network Discover scan, including general scan information, scan statistics, recent errors, and scan activity. You can also download reports in CSV format for scan statistics, recent errors, and scan activity.

To view scan details, go to **Manage > Discover Scanning > Scan History**. Select the scan, then click the link in the **Status** column.

See "Managing Network Discover target scans" on page 1209.

Table 57-3 shows the General section which displays information about the scan.
Table 57-3  General Scan Detail

<table>
<thead>
<tr>
<th>Description</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Target Type</strong></td>
<td>The type and icon of the target that was scanned.</td>
</tr>
<tr>
<td><strong>Target Name</strong></td>
<td>Name of the target.</td>
</tr>
<tr>
<td><strong>Status</strong></td>
<td>Status of the scan.</td>
</tr>
<tr>
<td></td>
<td>If the scan is running, the name of the Network Discover Server where this scan is running is displayed.</td>
</tr>
<tr>
<td><strong>Scan Type</strong></td>
<td>Scan type, such as incremental or full.</td>
</tr>
<tr>
<td><strong>Start Time</strong></td>
<td>The date and time the scan began.</td>
</tr>
<tr>
<td><strong>End Time</strong></td>
<td>The date and time the scan finished.</td>
</tr>
</tbody>
</table>

Table 57-4 shows the Scan Statistics section, which provides detailed information about the scan.

Table 57-4  Scan Statistics

<table>
<thead>
<tr>
<th>Description</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Processed</strong></td>
<td>Number of items that have been scanned. If the scan is still running, this field provides a benchmark of scan progress.</td>
</tr>
<tr>
<td><strong>Run Time</strong> (dd:hh:mm:ss)</td>
<td>Amount of time that the scan took to complete. If the scan is still running, the amount of time that it has been running. The total does not include any time during which the scan was paused.</td>
</tr>
<tr>
<td><strong>Items Scanned</strong></td>
<td>Number of items scanned.</td>
</tr>
<tr>
<td><strong>Bytes Scanned</strong></td>
<td>Number of bytes scanned.</td>
</tr>
<tr>
<td><strong>Errors</strong></td>
<td>Number of errors that occurred during the scan. A list of the errors is available in the Recent Scan Errors section.</td>
</tr>
</tbody>
</table>
Table 57-4  Scan Statistics (continued)

<table>
<thead>
<tr>
<th>Scan Statistics</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Detected Incident Count</td>
<td>Total number of incidents that were detected during the current scan.</td>
</tr>
<tr>
<td>Current Incident Count</td>
<td>Number of incidents that were detected during the current scan, less any deleted incidents. You can click this number to see an incident list for this scan.</td>
</tr>
</tbody>
</table>

The Recent Scan Errors section is a listing of the errors that occurred during the scan.

If a scan has many errors, the Scan Detail screen does not display them all. To see a complete list of errors that occurred during the scan, click Download Full Error Report.

Table 57-5 shows the information in the Recent Scan Errors report, which provides information about each error.

Table 57-5  Recent Scan Errors

<table>
<thead>
<tr>
<th>Recent Scan Error Details</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>The date and time of the error during the scan.</td>
</tr>
<tr>
<td>Path</td>
<td>The directory path to the location of the file with the error during the scan.</td>
</tr>
<tr>
<td>Error</td>
<td>The error message.</td>
</tr>
</tbody>
</table>

Recent Scan Activity displays the most recent log entries of the notable events that occurred during the scan.

If a scan has many activity messages, the Scan Detail screen does not display them all. To see a complete list of scan activity messages, click Download Full Activity Report.

Table 57-6 shows the Recent Scan Activity report, which provides information about each activity.
Table 57-6  Recent Scan Activity

<table>
<thead>
<tr>
<th>Recent Scan Activity Details</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date/Time</td>
<td>The date and time when the logged event occurred.</td>
</tr>
<tr>
<td>Level</td>
<td>The severity of the event.</td>
</tr>
<tr>
<td>Message</td>
<td>The message that was logged about the event.</td>
</tr>
</tbody>
</table>

Table 57-7 explains the options on the Scan Detail screen.

Table 57-7  Options on the Scan Detail screen

<table>
<thead>
<tr>
<th>Scan Detail options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Download Full Statistics Report</td>
<td>Download a report with all scan statistics in CSV format.</td>
</tr>
<tr>
<td>Download Full Error Report</td>
<td>Download a report with all scan errors in CSV format.</td>
</tr>
<tr>
<td>Download Full Activity Report</td>
<td>Download a report with all scan activity in CSV format.</td>
</tr>
</tbody>
</table>

Working with Network Discover scan details

You can perform the following tasks with scan details:

To view scan details:
1. In the Enforce Server administration console, click Manage > Discover Scanning > Scan History.
2. On the Scan History page, click the link in the Scan Status column for the scan for which you want to view details.

To export scan details to a CSV file:
1. In the Enforce Server administration console, go to Manage > Discover Scanning > Scan History.
2. On the Scan History page, click the link in the Scan Status column for the scan for which you want to view details.
3. On the Scan Details page, click one of the following buttons:
Managing Network Discover Servers

You can view the status and scan details of Network Discover scans for each Discover server.

See “Viewing Network Discover server status” on page 1219.

Viewing Network Discover server status

The Discover Servers screen lists the detection servers for Network Discover or Endpoint Discover that are configured on your network. This screen shows details about the scans on each detection server.

To view your Discover servers, in the Enforce Server administration console, go to Manage > Discover Scanning > Discover Servers.

See “Managing Network Discover target scans” on page 1209.

Table 57-8 lists the information for each server.

<table>
<thead>
<tr>
<th>Server Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Name</td>
<td>The name of the server. In parentheses is the type of detection server, either Discover or Endpoint.</td>
</tr>
<tr>
<td>Running Scans</td>
<td>A list of the scans that are currently running on this server.</td>
</tr>
<tr>
<td>Queued Scans</td>
<td>A list of the scans that are queued to run on this server.</td>
</tr>
<tr>
<td>Scheduled Scans</td>
<td>A list of scans that are scheduled to run in the future on this server.</td>
</tr>
<tr>
<td>Paused Scans</td>
<td>A list of the paused scans on this server.</td>
</tr>
</tbody>
</table>

To view scan details from a Network Discover server

1  In the Enforce Server administration console, go to Manage > Discover Scanning > Discover Servers

2  On the Discover Servers page, click the name of the scan for which you want to view details.

See “About Network Discover scan details” on page 1215.
About Network Discover scan optimization

Network Discover Target scans can take hours or days to complete, depending on the type of scan and the amount and format of the data to be scanned, as well as hardware and network speed. To optimize your scans of large amounts of information for better performance, follow the suggestions in this section.

To help optimize your Network Discover scans, consider using some of the following methods:

- Begin by scanning only the file shares or repositories that are the most accessed and most widely available (for example, guest or public access). Start small, and confirm the accuracy of your scans before increasing the volume of information in a scan. After you have achieved satisfactory performance with your initial scans, add scanning for the business units that handle your confidential data.

- Install multiple Network Discover Servers on the network.

- Break large scans into multiple smaller scans. Create separate scan targets and use filters to break up the set to scan.
  You can break up scans with include, exclude, size, and date filters.
  See “Setting up Endpoint Discover filters to include or exclude items from the scan” on page 1395.
  See “Filtering Discover targets by item size” on page 1201.
  See “Filtering Discover targets by date last accessed or modified” on page 1202.

- Scan non-binary files first. Binary files are less likely to contain policy violations. For example, you can set the Exclude Filter to the following list to scan non-binary files:

  
  *.*.exe,*.lib,*.bin,*.dll,*.cab,*.dat
  
  *.*.au,*.avi,*.mid,*.mov,*.mp,*.mp3,*.mp4,*.mpeg,*.wav,*.wma

  To scan the rest of the files, use this filter as the Include Filter of a different scan target.
  See “Setting up Endpoint Discover filters to include or exclude items from the scan” on page 1395.

- For File System targets, you can configure incremental scans to check only those files that have not yet been scanned.
  See “Scanning new or modified items with incremental scans” on page 1224.
  See “About the difference between incremental scans and differential scans” on page 1222.
■ Scan new or recently modified items in one scan target, and older ones in a second scan target. Use the date filter to break up scans by date values, by files older than, or files newer than. See “Filtering Discover targets by date last accessed or modified” on page 1202.

■ After the initial scan, run differential scans to check only those items that were added or modified since the last complete scan. See “Scanning new or modified items with differential scans” on page 1225. See “About the difference between incremental scans and differential scans” on page 1222.

■ Scan small files in one scan target and large files in another. Scanning many small files carries more overhead than fewer large files. Use the size filter to break up scans by size. See “Filtering Discover targets by item size” on page 1201.

■ Scan compressed files in a separate scan target. Use the Include Filter to scan compressed files. For example, use the following list:

  *.zip,* .gzip

  To scan the rest of the files, use this filter as the Exclude Filter of a different scan target. See “Setting up Endpoint Discover filters to include or exclude items from the scan” on page 1395.

■ Scan database or spreadsheet files in a separate scan target. Use the SQL Database target to scan database files. See “Configuring and running SQL database scans” on page 1268. Use the Include filter to scan spreadsheet files:

  *.xls

  Set up a separate scan target and use the Exclude Filter to scan everything else. See “Setting up Endpoint Discover filters to include or exclude items from the scan” on page 1395.

■ Exclude the folders internal to applications. For example, in the scan of a DFS share, exclude the internal DfsrPrivate folder. In the scan of a share on a NetApp filer, exclude the .snapshot folder. See “Excluding internal DFS folders” on page 1253. See “Configuring and running scans of file systems” on page 1254.
About the difference between incremental scans and differential scans

Incremental and differential scans let you optimize scan performance by scanning only new or modified items. Incremental scans resume from whatever point they left off, whether or not the first scan was a full scan. Differential scans only scan items added or modified after the last full scan: you must run at least one full scan on your scan target before you can use differential scanning.

See “About incremental scans” on page 1223.

See “Scanning new or modified items with incremental scans” on page 1224.

See “Scanning new or modified items with differential scans” on page 1225.

Table 57-9 compares incremental scans and differential scans.

<table>
<thead>
<tr>
<th>Incremental scans</th>
<th>Differential scans</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incremental scans are supported for the following targets:</td>
<td>Differential scans are supported for the following targets:</td>
</tr>
<tr>
<td>■ Server &gt; File System</td>
<td>■ Server &gt; Lotus Notes</td>
</tr>
<tr>
<td>■ Server &gt; SharePoint</td>
<td>■ Server &gt; Exchange</td>
</tr>
<tr>
<td>■ Endpoint &gt; File System</td>
<td>■ Endpoint &gt; File System</td>
</tr>
</tbody>
</table>
Table 57-9 Differences between incremental scans and differential scans (continued)

<table>
<thead>
<tr>
<th>Incremental scans</th>
<th>Differential scans</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partial scans retain the information about the items that have been scanned. If files, shares, or other items are missed because they are inaccessible, the next incremental scan automatically covers the missed items.</td>
<td>Differential scans begin with a full scan of the Discover target. This full scan is called the base scan. Partial scans cannot be used as a base scan.</td>
</tr>
<tr>
<td>Subsequent runs scan all items that have not previously been scanned, including new or modified items.</td>
<td>Subsequent runs scan all items that have been added or modified since the date of the most recent full (base) scan completed. The system considers the start date of the base scan for differential scanning.</td>
</tr>
<tr>
<td>An incremental scan index keeps track of which items have already been scanned.</td>
<td>The most recent complete base scan serves as the comparison for which items to scan, based on the date of the base scan.</td>
</tr>
</tbody>
</table>

**About incremental scans**

Incremental scans let you optimize scan performance by scanning only new or modified items. Incremental scans resume from whatever point they left off, whether or not the first scan was a full scan.

See “About Network Discover scan optimization” on page 1220.

Incremental scanning is only supported for some targets types.

See “About the difference between incremental scans and differential scans” on page 1222.

Incremental scans retain the information about the items that have been scanned. Some files may be skipped during a scan, for example, because they are locked or in use. A scan may not complete because the data cannot be accessed, such as when a server or device is offline. These missed files are scanned during subsequent scans of this target.

An incremental scan index keeps track of which items have been scanned previously. This index is synchronized between multiple Discover Servers.
Scanning new or modified items with incremental scans

An incremental scan lets you resume a Network Discover scan from where you left off. An incremental scan only scans the items that have not been scanned previously.

See “About the difference between incremental scans and differential scans” on page 1222.

To set up an incremental scan

1. Go to Manage > Discover Scanning > Discover Targets.
2. Click the drop-down New Target, and select the File System or SharePoint target type, or select one of the file system or SharePoint scan targets in the list to edit it.
3. Click the General tab.
4. Under Scan Type, select Scan only new or modified items (incremental scan). This option is the default for new targets.
   
   If you have changed the policy or other definitions in an existing scan, you may want to set up the next scan as a full scan to ensure complete policy coverage. Select the following option:
   
   Scan all items for the next scan. Subsequent scans will be incremental.
   
   If you always want to scan all items in this target, select the following option:
   
   Always scan all items (full scan)

5. Complete the other steps to set up or modify a Discover target and run the scan.
   
   See “Configuring the required fields for Network Discover targets” on page 1193.
   
   See “Network Discover scan target configuration options” on page 1191.
   
   See “Setting up server scans of file systems” on page 1241.

6. To manage incremental scanning and diagnose issues, refer to the following topic:
   
   See “About managing incremental scans” on page 1225.
About managing incremental scans

Note the following when running incremental scans:

- If your installation has multiple Discover Servers, the incremental scan index is automatically synchronized to all the other Discover Servers for that target.

- When you change the incremental scan setting from **Scan only new or modified items (incremental scan)** to **Scan all items for the next scan. Subsequent scans will be incremental**, then the incremental scan index for that target is cleared before the scan starts. Subsequent scans are incremental.

- To scan all items, set **Always scan all items (full scan)** for the Discover target.

- If the setting **Always scan all items (full scan)** is selected, then any previous index entries for that target are cleared before the scan starts. The index is not repopulated during the scan.

  If you want to scan all items and then continue incremental scanning, select the option **Scan all items for the next scan. Subsequent scans will be incremental**.

- When a Discover target is deleted, the incremental scan index is not automatically removed.

Scanning new or modified items with differential scans

To save resources, differential scans only scan the items that have been added or modified since the last full scan.

For information about how a target that is configured for differential scanning is upgraded during a version upgrade, see the *Symantec Data Loss Prevention Upgrade Guide*.

See “About the difference between incremental scans and differential scans” on page 1222.

To set up a differential scan

1. Go to **Manage > Discover Scanning > Discover Targets**.

2. Click the drop-down **New Target**, and select the target type, or select one of the scan targets in the list to edit it.

3. Click the **Filters** tab.

4. Select the date option for a differential scan.

   See “Filtering Discover targets by date last accessed or modified” on page 1202.
5 Run a full scan. The initial scan must be a full scan.
6 After the initial scan has completed, the next scan only scans the items that are added or modified since the last full scan.

Configuring parallel scanning of Network Discover targets

Multiple scans of different targets can be run simultaneously on the same Network Discover Server.

Parallel scans of server and scanner target types are supported. Parallel scanning of Endpoint file systems is not supported. Parallel scanning of the same CIFS server or share with different credentials, and from the same Network Discover Server is not supported.

The scan can be controlled (paused, resumed, or stopped) independent of other scans that are on the Network Discover Server. The state of each scan is maintained and reported separately.

When a scan is started and multiple Network Discover Servers are selected, one is selected for this scan. The scan is assigned to run on the server with the fewest number of scans that are running. The server is chosen from the server set specified in the target.

After a scan starts, it continues to run on the same server until the scan completes, is aborted, or paused. On resumption the scan may be assigned to run on a different server.

Automated load balancing is not supported. If a Network Discover Server completes running all its scans, scans from other servers do not migrate to the unloaded server. However, a scan can be migrated manually, by pausing and restarting the scan.

To run multiple scanner targets on the same Network Discover Server, separate ports must be configured for each scanner. The default port for a new scanner is a value not already used by any scan targets.

See “Troubleshooting scanners” on page 1307.

To configure parallel scanning

1 In the Enforce Server administration console, go to System > Servers > Overview.
2 Select a Network Discover Server to configure, and click the server name.
3 Click the Configure option at the top.
4 Then select the Discover tab.
5 Set the maximum number of parallel scans to run on this Network Discover Server.

The default value for Maximum Parallel Scans is 1. The maximum count can be increased at any time. After it is increased, then any queued scans that are eligible to run on the Network Discover Server are started. The count can be decreased only if the Network Discover Server has no running scans. Before you reduce the count, pause or stop all scans on the Network Discover Server.

6 Click Save.

7 Click Done.

8 You can view the scans that are actively running, queued, scheduled, or paused on each Network Discover Server. In the Enforce Server administration console, go to Manage > Discover Scanning > Discover Servers.

See "Managing Network Discover target scans" on page 1209.
Using Server FlexResponse plug-ins to remediate incidents

This chapter includes the following topics:

- About the Server FlexResponse platform
- Using Server FlexResponse custom plug-ins to remediate incidents
- Deploying a Server FlexResponse plug-in
- Locating incidents for manual remediation
- Using the action of a Server FlexResponse plug-in to remediate an incident manually
- Verifying the results of an incident response action
- Troubleshooting a Server FlexResponse plug-in

About the Server FlexResponse platform

The Server FlexResponse application programming interface (API) provides a flexible platform for incident remediation. It enables Symantec Data Loss Prevention users to protect data by automatically or manually invoking custom Server FlexResponse actions.

Symantec provides a set of Server FlexResponse plug-ins that perform various remediations such as quarantining sensitive data, copying files, and applying digital rights protection or encryption. Independent developers can also write Server FlexResponse plug-ins to perform custom incident remediation using this API and
the Java programming language. The Server FlexResponse API enables developers to build a plug-in that can be used to implement incident responses for use in Automated and Smart Response rules.

The following are example Network Protect actions that you can implement by developing a Server FlexResponse plug-in:

- Change Access Control Lists (ACL) on files. For example, you can remove guest access to selected files.
- Apply Digital Rights Management (DRM). For example, you can apply digital rights to documents so external parties are restricted in their access to sensitive material. These digital rights can include “do not forward” or “do not print.”
- Encrypt files.
- Migrate files to SharePoint. The custom protect action can move files from shares to a SharePoint repository, and then apply DRM and ACLs.
- Perform workflow and automation of remediation responses.
- Use the Symantec Workflow business process automation workflow.

The following steps are involved in building, deploying, and using a Server FlexResponse plug-in:

- Developing a plug-in using the Java API. This stage involves designing and coding the plug-in and remediation action.
- Configuring plug-in parameters by creating the configuration properties file for your plug-in.
  See “Creating a properties file to configure a Server FlexResponse plug-in” on page 1233.
- Adding your plug-ins to the plug-ins configuration properties file.
  See “Adding a Server FlexResponse plug-in to the plug-ins properties file” on page 1232.
- Deploying your custom plug-in on the Enforce Server.
  See “Deploying a Server FlexResponse plug-in” on page 1231.
- Loading the plug-in, including the plug-in metadata.
- Creating response rules for incident Smart Response actions.
- Using the plug-in action to remediate an incident.
  See “Using the action of a Server FlexResponse plug-in to remediate an incident manually” on page 1237.
- Verifying the results of the Server FlexResponse plug-in action.
  See “Verifying the results of an incident response action” on page 1238.
Note: Server FlexResponse plug-ins that were created for Symantec Data Loss Prevention versions 10 and 11 are compatible with Symantec Data Loss Prevention version 12.

The sections that follow describe how to deploy and configure pre-made FlexResponse plug-ins, as well as how to use custom plug-in actions in Symantec Data Loss Prevention policies. You can obtain some Server FlexResponse plug-ins directly from Symantec. You can also develop your own custom plug-ins using the Server FlexResponse API. For information about developing plug-ins using the Java API, see the Symantec Data Loss Prevention Server FlexResponse Platform Developers Guide.

Using Server FlexResponse custom plug-ins to remediate incidents

You can use Server FlexResponse plug-in actions to automatically or manually remediate Network Discover incidents.

To develop a custom remediation action, see the Symantec Data Loss Prevention Server FlexResponse Platform Developers Guide.

To automatically or manually remediate incidents with a custom Server FlexResponse plug-in, you must perform the following steps:

Table 58-1

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Deploy a Server FlexResponse plug-in to the Enforce Server computer.</td>
<td>Each Server FlexResponse plug-in must be deployed to the Enforce Server computer before you can use the plug-in actions in Symantec Data Loss Prevention policies. See “Deploying a Server FlexResponse plug-in” on page 1231.</td>
</tr>
<tr>
<td>2</td>
<td>Create a response rule that uses a custom Server FlexResponse incident response action.</td>
<td>See “Configuring the Server FlexResponse action” on page 912.</td>
</tr>
</tbody>
</table>
Table 58-1 (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>(Optional) Use the Server FlexResponse plug-in to manually remediate incidents.</td>
<td>If you are using a Server FlexResponse plug-in action in a smart response rule, you must manually locate an incident and execute the FlexResponse action. See “Locating incidents for manual remediation” on page 1236. See “Using the action of a Server FlexResponse plug-in to remediate an incident manually” on page 1237. This step is not necessary if you configure an automated response rule to execute a Server FlexResponse action. With automated response rules, the creation of an incident that triggers the automated response rule also executes the configured FlexResponse action.</td>
</tr>
<tr>
<td>4</td>
<td>Verify the results.</td>
<td>See “Verifying the results of an incident response action” on page 1238.</td>
</tr>
</tbody>
</table>

Deploying a Server FlexResponse plug-in

Enable a plug-in for the Server FlexResponse API.

To deploy a Server FlexResponse plug-in

1. Copy the completed Server FlexResponse plug-in JAR file to the plug-ins directory:

   SymantecDLP\Protect\plugins\n
2. Configure the plug-in with a properties file.

   See “Creating a properties file to configure a Server FlexResponse plug-in” on page 1233.

3. Copy the properties file for each plug-in into the directory where you placed your JAR file:

   SymantecDLP\Protect\plugins\n
4. In the file SymantecDLP\Protect\config\Plugins.properties, add the plug-in to the list, and enter the properties for your plug-in.

   See “Adding a Server FlexResponse plug-in to the plug-ins properties file” on page 1232.
5 Make sure that the Symantec Data Loss Prevention protect user has read and execute access to both the plug-in JAR file and the plug-in properties file.

6 To load the plug-in, stop the Vontu Incident Persister and Vontu Manager services, and then restart them.

Adding a Server FlexResponse plug-in to the plug-ins properties file

Add a Server FlexResponse plug-in to the Plugins.properties file. Also, modify any parameters that are necessary for the plug-in.

To add a Server FlexResponse plug-in to the properties file

1 Edit the Plugins.properties file.
   
   General values are in this file for all plug-ins, plus a list of all the plug-ins that are implemented.

   See Table 58-2 on page 1233.

   This file is in the following directory:

   SymantecDLP\Protect\config

2 Locate the following line in the file, which specifies the JAR files of the plug-ins to construct at load time:

   # Incident Response Action configuration parameters.

   com.symantec.dlpx.flexresponse.Plugin.plugins = plugin1.jar,plugin2.jar

   Remove the comment mark from the beginning of the line, if necessary, and replace plugin1.jar,plugin2.jar with the names of the plug-in JAR files you want to deploy. Separate multiple JAR files with commas.

3 Edit any additional parameters in this file.

   Table 58-2 describes the additional properties for the Server FlexResponse API in the Plugins.properties file.

4 Stop the Vontu Incident Persister and Vontu Manager services, and then restart them. This loads the new plug-in and the other parameters in this file.

   If you later change the Plugins.properties file, you must restart both the Vontu Incident Persister and Vontu Manager services to apply the change.

   In Table 58-2 plugin-id is a unique identifier of the plugin within this properties file, for example test1.
### Parameters in the Plugins.properties file

<table>
<thead>
<tr>
<th>Property name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>protect.plugins.directory</td>
<td>The directory under which all Symantec Data Loss Prevention plug-ins are installed.</td>
</tr>
<tr>
<td>com.symantec.dlpx.flexresponse.Plugin.plugins</td>
<td>A comma-separated list of JAR files (or JAR titles) to be loaded in the Server FlexResponse plug-in container. Each plug-in in this list will correspond to a response rule action in the Enforce Server administration console. The container in which your JAR file is deployed includes all of the public JRE classes provided by the JVM installed with Symantec Data Loss Prevention. The container also includes all of the FlexResponse API classes described in this document (classes in the com.symantec.dlpx package hierarchy). Your FlexResponse plug-in code may have dependencies on other JAR files that are not provided by the plug-in container. Place any external JAR files that you require in the <code>\plugins</code> directory of the Enforce Server where the FlexResponse plug-in is deployed. Then reference the JAR in this property.</td>
</tr>
<tr>
<td>com.vontu.enforce.incidentresponseaction.IncidentResponseActionInvocationService.maximum-incident-batch-size</td>
<td>The maximum number of incidents that can be selected from the incident list report for one Server FlexResponse Smart Response rule invocation. The default is 100. In this release, the maximum value of this parameter cannot exceed 1000.</td>
</tr>
<tr>
<td>com.vontu.enforce.incidentresponseaction.IncidentResponseActionInvocationService.keep-alive-time</td>
<td>Do not change the value of this parameter. This parameter is reserved for development and debugging. Use the <code>timeout</code> property in the individual plug-in properties file to set the timeout for the execution threads for your plug-in.</td>
</tr>
<tr>
<td>com.vontu.enforce.incidentresponseaction.IncidentResponseActionInvocationService.serial-timeout</td>
<td>The execution thread timeout for the serial thread executor (global). See the <code>is-serialized</code> property in the individual plug-in property file for details.</td>
</tr>
</tbody>
</table>

### Creating a properties file to configure a Server FlexResponse plug-in

Specific information and parameters for each Server FlexResponse plug-in are in the `plug-in-name.properties` file. Each plug-in must have a separate properties file.
An individual plug-in properties file is not necessary if the plug-in satisfies the following conditions:

- Does not need custom properties.
- Provides the display name and the plug-in identifier in the implementation of the plug-in metadata class.
- Does not need a stored credential.

To configure a Server FlexResponse plug-in

1. Create a text file that contains the properties for each Server FlexResponse plug-in.

   Each JAR file has an optional associated properties file with the same base name as the JAR file. These files are located in the SymantecDLP\Protect\plugins directory.

   For example, if you have a plugin1.jar file, you should create a plugin1.properties file.

2. In this file, enter the keys and values of all the parameters for the plug-in:

   ```
   display-name=plugin 1
   plugin-identifier=IncidentResponseAction1
   ```

   To update the properties, you must stop the Vontu Manager and Vontu Incident Persister services, and then restart them to load in the new values.

   See Table 58-3 on page 1235.

3. Make sure that the Symantec Data Loss Prevention protect user has read and execute access to the plug-in properties file.

   Table 58-3 describes the properties in the plug-in-name.properties file.
### Parameters in the custom plug-in properties file

<table>
<thead>
<tr>
<th>Property name</th>
<th>Description</th>
</tr>
</thead>
</table>
| **display-name** | The name of this plug-in.  
This name is displayed in the **choose a plugin** drop-down menu when you select an **All: Server FlexResponse** action in a Smart Response rule or an automated response rule.  
A best practice is to define this property in the plug-in properties file.  
If you change the value of this name in the properties file after the plug-in is loaded, you must restart the Vontu Incident Persister and Vontu Manager services to load in the new name.  
Alternatively, this value can be specified in the metadata class.  
This value is mandatory and it must be specified in at least one place, either in the configuration properties file, or the plug-in metadata class.  
For international environments, this display name can be in the local language. |
| **plugin-identifier** | The identifier for this plug-in. This identifier should be unique for all Server FlexResponse plug-ins on this Enforce Server.  
A best practice is to define this property in the plug-in properties file.  
Alternatively, this value can be specified in the metadata class.  
This value is mandatory and it must be specified in at least one place, either in the configuration properties file, or the plug-in metadata class.  
If any response rule is assigned to this Server FlexResponse plug-in, do not change this identifier in your properties file. |
| **credential-reference.credential** | Specifies a reference to a named credential to authenticate access, for example to an inventory database. The value of this property must refer to a named credential that was defined on the Enforce Server. The credential-reference in the property name provides a method to differentiate between multiple credentials in the properties file.  
Example:  
inventory-credential.credential=InventoryDB1 |
| **custom name** | These optional custom parameters are required to pass information to your plug-in. These parameters are passed to each invocation of the plug-in and can optionally be made available at the time this plug-in is constructed.  
Example:  
test1.value.1  
test1.value.2 |
### Table 58-3 Parameters in the custom plug-in properties file (continued)

<table>
<thead>
<tr>
<th>Property name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>timeout</strong></td>
<td>Optional parameter with the timeout in milliseconds for the execution threads for this plug-in. The default is 60000 (one minute). If the timeout value is reached, the user interface shows the Server FlexResponse plug-in status as failed, and the incident history is updated with a timeout message. If you change the value of this property in the properties file after the plug-in is loaded, you must stop the Vontu Incident Persister and Vontu Manager services, and then restart them.</td>
</tr>
<tr>
<td><strong>maximum-thread-count</strong></td>
<td>Optional parameter with the number of parallel threads available for execution of this plug-in. This parameter is ignored if <strong>is-serialized</strong> is set. The default is 2. If you change the value of this property in the properties file after the plug-in is loaded, you must stop the Vontu Incident Persister and Vontu Manager services, and then restart them.</td>
</tr>
<tr>
<td><strong>is-serialized</strong></td>
<td>The value of this parameter can be true or false. Set this optional parameter to true if this plug-in execution must be serialized (one thread at a time). All serialized plug-ins share a single execution thread. If this parameter is set, then <strong>timeout</strong> and <strong>maximum-thread-count</strong> are ignored. The default is false. If you change the value of this property in the properties file after the plug-in is loaded, you must stop the Vontu Incident Persister and Vontu Manager services, and then restart them.</td>
</tr>
</tbody>
</table>

### Locating incidents for manual remediation

To manually execute the plug-in action configured in a Smart Response Rule, use the reports on the Enforce Server to select incidents for remediation.

**To locate incidents for manual remediation**

1. Log on to the Enforce Server administration console.
2. Click **Incidents > Discover**.
3. Select an incident (or multiple incidents) for remediation. You can use the standard reports or report filters to narrow the list of incidents.
4. You can select either a group of incidents, or one incident for remediation:
- From the list of incidents, check the box to the left of each incident to select that incident for remediation. You can select multiple incidents.

- From the list of incidents, select all incidents on this page by clicking the check box on the left of the report header.

- From the list of incidents, select all incidents in the report by clicking the Select All option on the upper-right side of the report.

- Click one incident to display the Incident Detail, and select that one incident for possible remediation.

After you have selected the incidents for remediation, you can manually remediate them.

See “Using the action of a Server FlexResponse plug-in to remediate an incident manually” on page 1237.

### Using the action of a Server FlexResponse plug-in to remediate an incident manually

After you have selected an incident, or group of incidents to remediate, you can invoke the action of a Smart Response rule. This action uses your custom Server FlexResponse plug-in to remediate the incidents manually.

**To remediate a single incident**

1. Be familiar with the response rules that are available to manually remediate an incident.

   Click **Policies > Response Rules**.

   The **Conditions** column indicates which rules can be executed manually.

2. Select a single incident, and display the **Incident Detail**.

   See “Locating incidents for manual remediation” on page 1236.

3. In the **Incident Detail** screen above the incident number, your remediation options display. These options show the names of your response rules.

4. Click a Server FlexResponse plug-in remediation button to perform the remediation action.
Verifying the results of an incident response action

You can verify that a remediation action has been completed by using the History tab of an incident.

To verify the results of an incident response action for a single incident

1 Log on to the Enforce Server administration console.

2 Click Incidents > Discover.

   Look for the green success or red failure icons in the incident report.

3 For additional information about the results, click one incident to display the Incident Detail.
4. Click the History tab.

5. View the remediation messages from your plug-in. A message that your plug-in was invoked, and another message with the success or failure should display. Other messages may also display, with the status result or remediation result.

**To verify the results of an incident response action for a group of incidents**

1. Log on to the Enforce Server administration console.

2. Click Incidents > Discover.

3. Use report filters and summaries to display the protect or prevent status of the incidents.

See “Viewing incidents” on page 1018.

Custom reports can also be created to show the protect or prevent status, or the values of custom attributes.

See “About custom reports and dashboards” on page 1019.

---

**Troubleshooting a Server FlexResponse plug-in**

Table 58-4 has troubleshooting issues and suggestions for diagnosing Server FlexResponse problems.

<table>
<thead>
<tr>
<th>Issue</th>
<th>Suggestions</th>
</tr>
</thead>
<tbody>
<tr>
<td>During creation of a Smart Response Rule, the drop-down menu does not display the action <strong>All: Server FlexResponse</strong>.</td>
<td>This issue happens because your plug-in did not load.</td>
</tr>
<tr>
<td>During creation of an automated Response Rule, the drop-down menu does not display the action <strong>All: Server FlexResponse</strong>.</td>
<td>At the end of the file Plugins.properties, enter the name of your plug-in JAR file on the list of plug-ins. Make sure that this line is not commented out.</td>
</tr>
<tr>
<td>If you have multiple plug-ins, your plug-in name does not display in the <strong>All: Server FlexResponse</strong> drop-down menu.</td>
<td>Restart both the Vontu Incident Persister and Vontu Manager services to load your plug-in.</td>
</tr>
<tr>
<td></td>
<td>Your plug-in properties file and plug-in code may not match appropriately. Look at the Tomcat log for errors.</td>
</tr>
<tr>
<td></td>
<td>The log file is localhost.date.log. This log file is in SymantecDLP\Protect\logs\tomcat.</td>
</tr>
<tr>
<td></td>
<td>To verify that your plug-in is loaded, look for Enforce system event (2122). This event lists all the plug-ins that are loaded.</td>
</tr>
</tbody>
</table>
### Table 58-4 Troubleshooting suggestions (continued)

<table>
<thead>
<tr>
<th>Issue</th>
<th>Suggestions</th>
</tr>
</thead>
</table>
| Your plug-in does not execute successfully. | Check the incident snapshot history for messages from your plug-in and the plug-in framework.  
For Smart Responses, look at the Tomcat log for errors. This log is in SymantecDLP\Protect\logs\tomcat. The log file is localhost.date.log.  
For automated responses, look at the VontuIncidentPersistler.log debug log file. |
Setting up server scans of file systems

Network Discover scans network file servers and shared resources ("shares") such as disk drives or directories to discover confidential data. Network Discover supports CIFS-compliant file servers, and file shares using CIFS, NFS, DFS, or any other client. Network Discover can also scan Microsoft Outlook Personal Folders (.pst files) on network file shares.

To set up scanning of file systems, complete the following process:
### Table 59-1 Setting up a network file system scan

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Verify that your network file system is on the list of supported targets.</td>
<td>See &quot;Supported file system targets&quot; on page 1242.</td>
</tr>
<tr>
<td>2</td>
<td>Optional: Run a Content Root Enumeration scan to automatically discover file system content roots within your domain.</td>
<td>See &quot;Automatically discovering servers and shares before configuring a file system target&quot; on page 1243.</td>
</tr>
<tr>
<td>3</td>
<td>Go to Manage &gt; Discover Scanning &gt; Discover Targets to create a new target for a file system and to configure scanning of file systems.</td>
<td>See &quot;Configuring and running scans of file systems&quot; on page 1254.</td>
</tr>
<tr>
<td>4</td>
<td>Set any additional scan target configuration options. For scanning of Microsoft Outlook Personal Folders, verify that the option is set.</td>
<td>See &quot;Network Discover scan target configuration options&quot; on page 1191.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See &quot;Configuring scans of Microsoft Outlook Personal Folders (.pst files)&quot; on page 1253.</td>
</tr>
<tr>
<td>5</td>
<td>To automatically move or quarantine files, configure Network Protect.</td>
<td>See “Configuring Network Protect for file shares” on page 1258.</td>
</tr>
<tr>
<td>6</td>
<td>Start the file system scan. Go to Manage &gt; Discover Scanning &gt; Discover Targets.</td>
<td>Select the scan target from the target list, then click the Start icon.</td>
</tr>
<tr>
<td>7</td>
<td>Verify that the scan is running successfully.</td>
<td>See &quot;About the Network Discover scan target list&quot; on page 1210.</td>
</tr>
</tbody>
</table>

### Supported file system targets

The File System target supports scanning of the following network file systems.

**Supported file servers:**
- CIFS Servers only

**Supported file shares:**
- CIFS on Windows Server 2008 and 2012
- NFS on Red Hat Enterprise Linux 5.x and 6.x
- DFS scanning on Windows 2008 and 2012.

**Note:** DFS is not supported with Network Protect.
In addition, the File System target supports scanning of the following file types:

  
  The Network Discover Server scanning this target must be running a Windows operating system, and Outlook 2007 or later must be installed on that system. See “Configuring scans of Microsoft Outlook Personal Folders (.pst files)” on page 1253.

- File systems on UNIX systems, even if they are not exposed as CIFS or NFS shares.
  
  Use the SFTP protocol to provide a method similar to the scans of file shares. You can also scan the local file system on a Linux Network Discover Server by listing the path name in the content root. For example, you can enter `/home/myfiles`.

## Automatically discovering servers and shares before configuring a file system target

Auto-discovery of servers and shares (Content Root Enumeration) enables you to locate servers and shares within a domain and filter them by IP range or server name. Share discovery works only for CIFS-compliant file servers, including those with DFS file shares. Content Root Enumeration scans produce a list of servers and shares that you can use directly in file system targets for Discover scanning, or export to a CSV file. A Content Root Enumeration scan does not scan the content of the servers and shares it discovers, but it enables you to find servers and shares in your domain and configure automated scanning of them.

Content Root Enumeration scans require an LDAP directory server connection. Also, the Enforce Server must have access to all servers and shares you wish to scan.

See “Configuring directory server connections” on page 127.

See “Configuring and running scans of file systems” on page 1254.

## Working with Content Root Enumeration scans

Follow these procedures to create, start, and stop Content Root Enumeration scans, and to view discovered content roots.
To create a Content Root Enumeration scan

1. Configure your LDAP directory server connection. Ensure that your directory credentials have read and list privileges for all computer objects you wish to scan.

   See “Configuring directory server connections” on page 127.

2. In the Enforce Server administration console, go to Manage > Discover Scanning > Content Root Enumeration.

3. Click Add Scan. The Content Root Enumeration Scan Configuration page appears.

4. In the General section, enter a name for your scan in the Name field.

5. Select a directory connection.

6. Specify your Enumerate shares preference:
   - To list servers and file shares, click Yes.
   - To list only servers, click No, only enumerate servers.

7. In the Filters section, select at least one filter for your scan:
   - IP Range: Specify an IP range to scan for content roots.
   - Server Names: Specify one or more server name filters. Use the drop-down menu to refine your filter.

8. Click Save.

To start or stop a Content Root Enumeration scan

1. In the Enforce Server administration console, go to Manage > Discover Scanning > Content Root Enumeration.

2. Select the scan or scans you want to start or stop.

3. Do one of the following:
   - To start a scan, click Start.
   - To stop a running scan, click Stop.
To view discovered content roots

1. In the Enforce Server administration console, go to Manage > Discover Scanning > Content Root Enumeration.

2. Click the link in the Content Roots column of your desired scan to see a list of content roots.

3. To export the list of content roots in .csv format, click Export to CSV in the Content Roots dialog box.

You can use the exported .csv file to populate a Discover File System target. See “Configuring and running scans of file systems” on page 1254.

Configuration options for Content Root Enumeration scans

You can find configuration options for Content Root Enumeration scans in the Manager.properties file in the configuration directory:

- \SymantecDLP\Protect\config on Microsoft Windows platforms,
- /opt/SymantecDLP/Protect/config on Linux platforms. These default settings should perform well in most cases.

<table>
<thead>
<tr>
<th>Configuration property</th>
<th>Default value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>content_root Enumeration.scanResultThreshold</td>
<td>10000</td>
<td>The maximum number of content roots to be discovered in a Content Root Enumeration scan. If the number of content roots in the scan exceeds the result threshold, Symantec Data Loss Prevention displays an error. This threshold prevents your Content Root Enumeration scans from returning an excessive number of content roots for use in a Discover File System target.</td>
</tr>
</tbody>
</table>
Table 59-2  
(continued)

<table>
<thead>
<tr>
<th>Configuration property</th>
<th>Default value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>content_root Enumeration maximumParallelScanCount</td>
<td>5</td>
<td>The maximum number of Content Root Enumeration scans that Symantec Data Loss Prevention can run in parallel. If the maximum parallel scan count is reached, additional scans are queued.</td>
</tr>
</tbody>
</table>
| content_root Enumeration scan log location                         | Windows: \SymantecDLP\Protect\logs  
Linux: /opt/SymantecDLP/Protect/logs | The location of the Content Root Enumeration scan detail log files.                                                                        |
| content_root Enumeration scan log limit                            | 5000000       | The maximum size, in bytes, of each scan detail log file.                                                                                  |
| content_root Enumeration scan log count                            | 15            | The maximum number of scan detail log files in use at any given time.                                                                        |
| content_root Enumeration scan log append                           | true          | The Boolean value that specifies whether or not Symantec Data Loss Prevention appends log results to the end of each scan detail log file.     |
| content_root Enumeration scan log encoding                         | UTF-8         | The character set Symantec Data Loss Prevention uses when writing to the scan detail log file.                                              |
Troubleshooting Content Root Enumeration scans

You can view both scan warnings and log files for Content Root Enumeration scans. These warnings and logs can be useful for troubleshooting your Content Root Enumeration scans.

Content Root Enumeration scan warnings are non-terminal errors, such as connection timeouts or DNS issues, that occur during the scan. If such errors occur during a Content Root Enumeration scan, a link appears in the Alerts column on the Manage > Discover Scanning > Content Root Enumeration page for that scan. You can view these warnings by following this procedure:

To view Content Root Enumeration scan warnings
1. In the Enforce Server administration console, go to Manage > Discover Scanning > Content Root Enumeration.
2. Click the link in the Alerts column for the scan warnings you want to view. The ScanWarnings dialog box appears.
3. To export the list of scan warnings to a .csv file, click Export to CSV in the ScanWarnings dialog box.

Log files are available in the logs directory: \SymantecDLP\Protect\logs on Microsoft Windows platforms, /opt/SymantecDLP/Protect/logs on Linux platforms. Content Root Enumeration logs are named using this format: ContentRootEnumerationScanDetail-scan name0.log. Content Root Enumeration log files list every discovered content root, as well as all warnings and errors occurring during the scan.

Automatically discovering open file shares

Symantec Data Loss Prevention can automatically discover open shares on a specified CIFS server. You specify the UNC path or SMB URL and Symantec Data Loss Prevention automatically finds and scans open file shares on that server.

See “To set up a new file system target” on page 1254.

You can automatically discover administrative shares corresponding to logical drives such as C$ or D$.

To discover administrative shares automatically
1. In the Enforce Server administration console, go to Manage > Discover Scanning > Discover Targets.
2. Create or select a File System Server target.
3. On the Advanced tab of the Edit File System Target page, select Scan Administrative Shares.
About automatically tracking incident remediation status

You can configure Network Discover to automatically track the remediation status of file system target incidents.

During the first Network Discover scan for a given file system target, incident metadata (resource name, policies violated, and so on) is added to a new Discover incident remediation tracking catalog. If during a subsequent scan an incident stored in the catalog does not appear in the scan results, Network Discover marks the incident as remediated with one of the following status indicators:

- **Item modified.** The item has been modified and no longer violates a policy. In the case where both the item and policy have changed, the incident will be remediated as **Item modified**. This option is off by default.

- **Policy modified.** The policy that the incident violated has changed. In the case where both the item and policy have changed, the incident will be remediated as **Item modified**. This option is off by default.

- **Item no longer exists.** The item has been moved, deleted, or renamed. This option is on by default.

To prevent incidents from being automatically remediated in error, Network Discover will not mark an incident as remediated if it is excluded from a scan due to:

- Incremental scanning
- Date filtering
- Size filtering
- Include or Exclude filters

The incident remediation catalog is contained in an Apache Derby database running under the **BoxMonitor** process. The master catalog is stored on the Enforce Server, and each detection server has its own local version of the catalog. The catalogs are synchronized to ensure that the Enforce Server and all Network Discover detection servers track incident remediation status correctly.

You can set your incident remediation tracking preferences on the Advanced tab of your file system target.

See “Configuring and running scans of file systems” on page 1254.

You can configure options for automated incident remediation tracking, such as the location of the catalog files, expiration period of temporary files, and so on.

See “Configuration options for Automated Incident Remediation Tracking” on page 1249.
You can view the latest remediation status of an incident in the incident snapshot. See “Discover incident snapshots” on page 991.

You can also filter and summarize Network Discover reports by incident remediation status. See “About filters and summary options for reports” on page 1046.

Troubleshooting automated incident remediation tracking

Automated incident remediation tracking does not work if you have enabled incident thresholding. If you have enabled automated incident remediation tracking for a file system target but do not see any tracking information, ensure that you have disabled incident thresholding. See “Creating an inventory of the locations of unprotected sensitive data” on page 1206.

You can view a log file for the incident remediation catalog on the detection server at this location:

SymantecDLP/Protect/logs/debug/DetectionServerDatabase%g.log, where %g is an integer starting at 0. Logs for incidents tracked with this feature are sent to the FileReader%.log and IncidentPersist%.log.

You can set the incident remediation catalog log level in the SymantecDLP/Protect/config/DetectionServerDatabaseLogging.properties file:

<table>
<thead>
<tr>
<th>Log Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FINE</td>
<td>The Detection Server database heartbeats are logged at the FINE level.</td>
</tr>
<tr>
<td>INFO</td>
<td>Database start and stop messages are logged at the INFO level.</td>
</tr>
<tr>
<td>SEVERE</td>
<td>All unexpected database behavior throws an exception and appears in the log at the SEVERE level.</td>
</tr>
</tbody>
</table>

Configuration options for Automated Incident Remediation Tracking

You can set the following configuration options for Automated Incident Remediation Tracking in the SymantecDLP/Protect/config/protect.properties file. If you
have a multi-tier installation, there will be separate files for the Enforce Server and Network Discover Server.

Table 59-4

<table>
<thead>
<tr>
<th>Property</th>
<th>Default value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.vontu.discover.detectionserver.remediation.detection.comm.maxfiles</td>
<td>15000</td>
<td>The maximum number of files stored in the Network Discover Server remediation tracking catalog directory before synchronization with the master catalog on the Enforce Server. If the number of catalog files exceeds this limit, Network Discover creates no new catalog entries until at least one file is synchronized.</td>
</tr>
<tr>
<td>com.vontu.discover.enforce.remediation.detection.comm.maxfiles</td>
<td>15000</td>
<td>The maximum number of files stored in the Enforce Server remediation tracking master catalog directory before synchronization with the local catalog on the Network Discover Server. If the number of catalog files exceeds this limit, Network Discover creates no new master catalog entries until at least one file is synchronized.</td>
</tr>
<tr>
<td>Property</td>
<td>Default value</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>---------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>com.vontu.discover.detectionserver.remediation.detection.catallogfolder.checkperiod</td>
<td>10000</td>
<td>The frequency, in milliseconds, with which the Network Discover Server checks the remediation tracking catalog directory for the number of catalog files queued for synchronization with the master catalog on the Enforce Server.</td>
</tr>
<tr>
<td>com.vontu.discover.enforce.remediation.detection.catallogfolder.checkperiod</td>
<td>10000</td>
<td>The frequency, in milliseconds, with which the Enforce Server checks the remediation tracking master catalog directory for the number of catalog files queued for synchronization with the catalog on the Network Discover Server.</td>
</tr>
<tr>
<td>com.vontu.discover.detectionserver.remediation.detection.catallogtempfile.expirationhours</td>
<td>24</td>
<td>The expiration period, in hours, of temporary files in the remediation tracking catalog directory.</td>
</tr>
<tr>
<td>com.vontu.discover.enforce.remediation.detection.catallogtempfile.expirationhours</td>
<td>24</td>
<td>The expiration period, in hours, of temporary files in the remediation tracking master catalog directory.</td>
</tr>
<tr>
<td>Property</td>
<td>Default value</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>com.vontu.discover.detectionserver.remediation.detection.catalog.folder</td>
<td>C:/SymantecDLP/Protect/scan/catalog</td>
<td>The directory containing the Network Discover Server remediation tracking catalog files.</td>
</tr>
<tr>
<td>com.vontu.discover.enforce.remediation.detection.catalog.folder</td>
<td>C:/SymantecDLP/Protect/scan/catalog</td>
<td>The directory containing the Enforce Server remediation tracking master catalog files.</td>
</tr>
<tr>
<td>com.vontu.discover.detectionserver.remediation.detection.threadpoolsize</td>
<td>5</td>
<td>The size of the threadpool used for automated incident remediation tracking on the Network Discover Server.</td>
</tr>
<tr>
<td>com.vontu.discover.enforce.remediation.detection.threadpoolsize</td>
<td>5</td>
<td>The size of the threadpool used for automated incident remediation tracking on the Enforce Server.</td>
</tr>
<tr>
<td>com.vontu.detectionserver.database.home</td>
<td>C:/SymantecDLP/Protect/scan/catalog</td>
<td>The directory containing the Network Discover Server remediation tracking database.</td>
</tr>
<tr>
<td>com.vontu.detectionserver.database.port</td>
<td>1527</td>
<td>The port used by the Network Discover Server remediation tracking database.</td>
</tr>
<tr>
<td>com.vontu.manager.incidents.dir</td>
<td>./incidents</td>
<td>The directory containing offline incidents on the Enforce Server.</td>
</tr>
</tbody>
</table>
Excluding internal DFS folders

By default, DFS file share scans include the dynamic internal DFS folders. Because these folders do not contain your organization’s confidential information you can safely exclude them from your scans.

To exclude DFS internal folders

1. In the Enforce Server administration console, go to Manage > Discover Scanning > Discover Targets.
2. Click the name of the scan where you want to add the exclude filter for the DFS internal folders.
3. Click the Scanned Content tab.
4. In the Exclude Filters field, type /DfsrPrivate/*.
5. Click Save.

Configuring scans of Microsoft Outlook Personal Folders (.pst files)

You can scan Microsoft Outlook Personal Folders (.pst files) on file shares. The scan supports Microsoft Outlook Personal Folders (.pst files) that were created with Outlook 1997-2002, 2003, 2007, and 2010.

See “Configuring and running scans of file systems” on page 1254.

The following notes pertain to scanning .pst files:

- The Network Discover Server scanning this target must be running a 64-bit Windows operating system, and Outlook 2010 or 2013 64-bit clients must be installed on that system.
- Outlook must be the default email client on the Network Discover Server scanning this target.
- Network Protect is not supported for .pst files, even if the files are on CIFS shares.
- After the initial base scan, incremental scanning scans the entire .pst file if the last modified date changes.
- The date filter and size filter apply to the entire .pst file, not to individual emails or other items within the file.
- The .pst files cannot be scanned in parallel. If the scans that run in parallel start scanning .pst files, then the scans are serialized.
To configure scanning of Microsoft Outlook Personal Folders
1  In the Enforce Server administration console, go to Manage > Discover Scanning > Discover Targets.
2  Set up scanning of the file share containing the Microsoft Outlook Personal Folders.
   See “Configuring and running scans of file systems” on page 1254.
3  On the Advanced tab, check the box Scan PST files. (The box is checked by default.)

Configuring and running scans of file systems
Before you run a scan, you must set up a target using the following procedure.

To set up a new file system target
1  In the Enforce Server administration console, go to Manage > Discover Scanning > Discover Targets.
2  Click New Target, and use the pull-down menu to select the specific target type.
3  On the General tab, type the Name of this Discover target.
   Type a unique name for the target, up to 255 characters.
4  Select the Policy Group.
   If no other policy group has been selected, the Default Policy group is used.
   To apply a policy group, select the policy group to use for this target. You can assign multiple policy groups to a target.
   You can define policy groups on the Policy Group List page.
5  Select the Discover Server (or multiple Discover Servers) where you want to run the scan.
   If you select more than one server, Symantec Data Loss Prevention automatically selects one of the servers when the scan starts.
   Only the detection servers that were configured as Discover Servers appear on the list. If there is only one Discover Server on your network, the name of that server is automatically specified. You should configure your Discover Servers before you configure targets. You must specify at least one server before you can run a scan for this target.
6  Under Scan Type, select Scan only new or modified items (incremental scan). This option is the default for new targets.
If you have changed the policy or other definitions in an existing scan, you can set up the next scan as a full scan. Select the following option:

- **Scan all items for the next scan. Subsequent scans will be incremental.**

If you always want to scan all items in this target, select the following option:

- **Always scan all items (full scan)**

7 Specify scheduling options.

Choose **Submit Scan Job on Schedule** to set up a schedule for scanning the specified target. Select an option from the schedule drop-down list to display additional fields. Choose **Pause Scan between these times** to automatically pause scans during the specified time interval. You can override the pause window of a scan target by going to the Discover Targets screen and clicking the start icon for the target entry. The pause window remains intact, and any future scans that run up against the window can pause as specified. You can also restart a paused scan by clicking the continue icon for the target entry.

8 On the **Scanned Content** tab, select or type the credentials.

The credentials you provide must have both Read permission and Write Attributes permission on the scan target. Write Attributes permission is required to update the "last accessed" date.

You can specify a default user name to use for access to all file systems.

The password must not contain the quotation mark character. If any of your passwords contain a quotation mark character, those file systems are not mounted for scanning.

If you need to use quotation mark characters in passwords, you can use JCIFS. The default mount process uses the CIFS client. If the default mount does not work, the mount task can use the Java-based CIFS client by setting

```
filesystemcrawler.use.jcifs=true
```

in the properties file

```
Crawler.properties
```

9 Under **Content Roots**, enter the item to be scanned.

Select one of the following methods of entering file systems:

- **Scan Content Roots from an uploaded file**
  Create and save a plain text file (.txt or .csv) listing the servers you want to scan. Then click **Browse** to locate the list and **Upload File** to import it. Create a file using an ASCII text editor and type one file server or share per line. Do not include a user name and password. By default, Symantec Data Loss Prevention interprets these as Server Message Block (SMB) paths. If you want to specify NFS paths, include **nfs** in the paths.
Specify content roots

Select Add Content Roots > By Direct Entry to use a line editor to specify the servers or shares you want to scan. Information that is entered here takes precedence over the default values and applies only to the path specified.

\server\share
\server.company.com
smb://server.company.com
\10.66.23.34

Select Add Content Roots > From a Content Root Enumeration scan to import content roots from a Content Root Enumeration scan. Select the scan to import in the Import Content Root Enumeration scan results dialog box.

If your content root list includes a large number of content roots, you can filter the list to include only those content roots that are relevant to your Discover Target scan. In the Content Roots section, click Filters, then enter your filter text. For example, to see only shares on a server named my_company, enter \my_company in the Filters text field.

To delete content roots from your target, select the content roots from the list and click Delete.

10 On the Filters tab, specify include and exclude filters, size filters, and date filters.

Use Include Filters and Exclude Filters to specify the files that Symantec Data Loss Prevention should process or skip. Note that you must specify absolute paths. If the field is empty, Symantec Data Loss Prevention performs matching on all files in the file share. If you enter any values for the Include Filters, Symantec Data Loss Prevention scans only those files or documents that match your filter. Delimit entries with a comma, but do not use any spaces. When both Include Filters and Exclude Filters are present, Exclude Filters take precedence.

See “Setting up Endpoint Discover filters to include or exclude items from the scan” on page 1395.

When scanning DFS shares, exclude the internal DFS folder.
See “Excluding internal DFS folders” on page 1253. When scanning shares on a NetApp filer with the Snapshot application, exclude the .snapshot folder. This folder is usually at the base of the file system or network share; for example, \myshare\.snapshot.

- Specify size filters.
  The size filters let you exclude files from the matching process based on their size. Symantec Data Loss Prevention includes only the files that match your specified size filters. If you leave these fields empty, Symantec Data Loss Prevention performs matching on files or documents of all sizes.

- Specify date filters.
  The date filters let you include files from the matching process based on their dates. Any files that match the specified date filters are scanned.

11 On the Advanced tab, specify your Remediation Detection preferences to automatically detect incident remediation status:

- **Item Modified**: Automatically detect if an incident has been remediated by modifying the offending file.
- **Policy Modified**: Automatically detect if an incident has been remediated by a change in your policy.
- **Item No Longer Exists**: Automatically detect if an incident has been remediated by deletion or removal.

See “About automatically tracking incident remediation status” on page 1248.

12 On the Advanced tab, select options to optimize scanning.

See “Optimizing file system target scanning” on page 1257.

### Optimizing file system target scanning

To optimize scans of your **File System** scan target, you can configure throttling options, set an incident threshold for scanning (**Inventory Scanning**), omit or select Outlook .pst files, and enable or disable scans of administrative shares.

**To throttle a file system target scan**

1. Go to the **Advanced** tab of your target definition.
2. In the **File Throttling** field, type the maximum number of files to be processed per minute.
3. In the **Byte Throttling** field, type the maximum amount of data to be processed per minute. Select bytes, kilobytes (KB), or megabytes (MB) from the drop-down list.
To set an incident threshold

1. Go to the Advanced tab of your target definition.
2. In the Incident Threshold field type the maximum number of incidents to be created from a single file share (Content Root) or server (Machine).
3. Select Count Incidents By: Content Root or Machine.

A Content Root is one file share on the list from the Scanned Content tab. When the incident threshold is reached, the scan moves to the next file share.

A Machine is a physical computer. When the incident threshold is reached, the scan moves to the next item on the list to scan. If that item is on the same physical computer as the previous item, it is skipped. The physical computer name must be exactly identical in the list of items to scan for Network Discover to recognize that it is the same computer. For example, `\\localhost\myfiles` and `\127.0.0.1\myfiles` are treated as different computers, even though they are logically the same.

If you use autodiscovery to scan open shares on a specified file server, the content root and machine are the same thing.

To scan administrative shares

1. Go to the Advanced tab of your target definition.
2. In the Administrative Shares Scanning section, select Scan Administrative Shares.

You can also set up scanning of Outlook .pst files.

See “Configuring scans of Microsoft Outlook Personal Folders (.pst files)” on page 1253.

Configuring Network Protect for file shares

Use Network Protect to automatically copy or quarantine to a secure location the confidential files that are found on public shares.

Network Protect is only available for server-based scanning of CIFS shares. Network Protect is not supported for .pst files.

With Network Protect enabled, a tab appears on the Add File System Target page that contains the Network Protect remediation options. To use Network Protect, you must have both a policy and a response rule configured in the Enforce Server administration console. Also, the scan credentials (user name and password) must be present on the Scanned Content tab for this target.

The following procedure provides an overview of the process.
To set up Network Protect for file shares

   See “About response rules” on page 875.

2. Select Automated Response.

3. Click Next.

4. For the Action, select either Network Protect: Copy File or Network Protect: Quarantine File.

   For the Quarantine File action, you can optionally leave a marker file in place of the file that was removed by checking the Marker File check box. Type the marker text in the Marker Text box. The marker file is a text file. The marker text can contain substitution variables. Click inside the Marker Text box to see a list of insertion variables.

   If the original file was of some other file type, the original file is moved to the quarantine area. The marker file has the original file name plus a .txt extension. The default file extensions that are retained are listed in the properties file ProtectRemediation.properties. The retained file extensions include txt, doc, xls, ppt, java, c, cpp, h, and js. For example, a file that is named myfile.pdf would have a marker file name of myfile.pdf.txt.

   You can create a new subdirectory for the quarantined files from each scan (the default). You can change the default and append the scan information to the file name (versioning) in one quarantine directory. Edit the properties file ProtectRemediation.properties to change the default.

5. Click Save.

6. Add a new policy, or edit an existing policy.
   See “Configuring policies” on page 326.

7. Click the Response tab.

8. In the pull-down menu, select one of the response rules that you previously created.

9. Click Add Response Rule.
   This response rule then specifies the automated response when this policy triggers an incident during the scanning of a file.

   Several response rules with different conditions can exist for a policy.

10. Create a new file system Network Discover target, or edit an existing target.
    See “Configuring and running scans of file systems” on page 1254.
11 With Network Protect enabled in the license, a Protect tab appears on the File System target page that contains the Network Protect remediation options.

Under Allowed Protect Remediation, choose whether the file should be copied or quarantined (moved) to protect the information.

This selection must match the Action selection from the response rule.

Also, a response rule with that action (copy or quarantine) should exist within one of the policies that are selected for this file system target.

12 Under Copy/Quarantine Share, specify the share where files are quarantined or copied.

Optionally, you can select a named credential from the credential store in the Use Saved Credentials drop-down menu.

13 Under Protect Credential, specify the write-access credential for the location of the file that was scanned.

To move the files for quarantine during remediation, the Network Discover target definition must have write access for both the quarantine location and the original file location. Specify the path (location) where the files are copied or quarantined. Type the write-access user name and password for that location.

Normally, scanned shares require only read-access credentials (for example, if the Copy option was selected).

Specify the share write-access credential, if it is different from the read-access credential.

Optionally, you can select a named credential from the credential store in the Use Saved Credentials drop-down menu.
Setting up scans of Lotus Notes databases

This chapter includes the following topics:

- Setting up server scans of Lotus Notes databases
- Supported Lotus Notes targets
- Configuring and running Lotus Notes scans
- Configuring Lotus Notes DIIOP mode configuration scan options

Setting up server scans of Lotus Notes databases

You can configure scans of Lotus Notes repositories. Symantec Data Loss Prevention supports DIIOP mode scanning only.

See “Configuring and running Lotus Notes scans” on page 1262.

To set up scanning of Lotus Notes databases, complete the following process:

Table 60-1  Setting up a Lotus Notes database scan

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Verify that your Lotus Notes database is on the list of supported targets.</td>
<td>See “Supported Lotus Notes targets” on page 1262.</td>
</tr>
<tr>
<td>2</td>
<td>Configure the scan for Lotus Notes DIIOP mode.</td>
<td>See “Configuring Lotus Notes DIIOP mode configuration scan options” on page 1265.</td>
</tr>
<tr>
<td>3</td>
<td>Click Manage &gt; Discover Scanning &gt; Discover Targets to create a Lotus Notes target and to configure scans of Lotus Notes databases.</td>
<td>See “Configuring and running Lotus Notes scans” on page 1262.</td>
</tr>
</tbody>
</table>
### Table 60-1 Setting up a Lotus Notes database scan (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Set any additional scan options for the Lotus Notes target.</td>
<td>See “Network Discover scan target configuration options” on page 1191.</td>
</tr>
<tr>
<td>5</td>
<td>Start the Lotus Notes database scan. Select the scan target from the list, then click the Start icon.</td>
<td>Click Manage &gt; Discover Scanning &gt; Discover Targets.</td>
</tr>
<tr>
<td>6</td>
<td>Verify that the scan is running successfully.</td>
<td>See “Managing Network Discover target scans” on page 1209.</td>
</tr>
</tbody>
</table>

### Supported Lotus Notes targets

The Lotus Notes target supports scanning of the following versions:

- Lotus Notes 7.0
- Lotus Notes 8.0
- Lotus Notes 8.5.x

The files `Notes.jar` and `NCSO.jar` are in the Lotus Notes client installation directory. The manifest version number of these files depend on the Domino server version.

- Version 7 has a manifest version in the JAR file of 1.4.2
- Version 8 has a manifest version in the JAR file of 1.5.0

### Configuring and running Lotus Notes scans

Before you run a scan, you must set up a target.

**To set up a new target for the scan of Lotus Notes databases**

1. Specify the content root for a Lotus Notes scan as either one Domino server, or a list of Domino servers.

   Specify the databases to scan as follows:

   - **Individual**
     
     Click Add to specify the servers you want to scan. Server credential information that is entered here takes precedence over the default values and applies only to the server specified.

     `[hostname,username,password]`
For a native mode configuration, you can use the name "local" in the list of Domino servers. Specifying "local" includes the local databases visible to the client only to be scanned. For example, instead of the URI enter the following text:

```
local
```

- **Upload Servers List**

  Create and save a plain text file (.txt) with the servers you want to scan. The server credential cannot be specified in this text file. The user name and password from the **Scanned Content** tab of the **Add Lotus Notes Target** page are used.

  Example of the first few Domino servers in the list:

  ```
dominoserver1.company.com
dominoserver2.company.com
dominoserver3.company.com
```

2. **On the Filters tab, select path filters.**

   Use the Include Filters and Exclude Filters fields to specify the Lotus Notes database names that Symantec Data Loss Prevention should target. The filters match the full path of the database URI. If the field is empty, Symantec Data Loss Prevention scans all databases in all specified Domino Servers. Delimit entries with commas. If a database URI matches both an include and an exclude filter, the exclude filter takes precedence, and the database is not scanned.

   See “**Setting up Endpoint Discover filters to include or exclude items from the scan**” on page 1395.

3. **On the Filters tab, select date filters.**

   Specify the date filters to exclude Lotus Notes documents from the scan based on their dates. Only the documents that match the specified date filters are included.

4. **On the Filters tab, select a Differential scan (optional).**

   Select **Only Scan files added or modified since the last full scan** to have Symantec Data Loss Prevention scan only the items or the documents that have been added or modified since the last full scan. The first scan has to be a full (initial base) scan. A full scan occurs if you select this option before Symantec Data Loss Prevention scans this target for the first time.
5 On the **Filters** tab, select a Differential scan (optional).

Select **Only Scan files added or modified since the last full scan** to have Symantec Data Loss Prevention scan the documents that have been added or modified since the last scan. If you select this option before Symantec Data Loss Prevention scans this target for the first time, the first scan runs as a full scan.

6 On the **General** tab, select scheduling options.

Choose **Submit Scan Job on Schedule** to set up a schedule for scanning the specified target. Select an option from the Schedule drop-down list to display additional fields. Choose **Pause Scan between these times** to automatically pause scans during the specified time interval. You can override a target’s pause window by going to the Discover Targets screen and clicking the start icon for the target entry. The pause window remains intact, and any future scans that run up against the window can pause as specified. You can also restart a paused scan by clicking the continue icon for the target entry.

7 Select Size Filters.

Specify the size filters to exclude documents from the target based on their size. Symantec Data Loss Prevention includes only the documents that match your specified size filters. If you leave this field empty, Symantec Data Loss Prevention includes all documents.

8 Enter Credentials (default and overriding).

You can specify a default user name and password to access all Domino servers that are specified in the target. Credentials can be overridden for a server by editing a single entry in the list of Domino servers. Credentials for a single entry are possible only if the list is created with individually entered server names. Credentials for a single entry are not possible in an uploaded text file that contains the list of servers.

9 Select the Advanced tab for options to optimize scanning. On the **Advanced** tab, you can configure throttling options or Inventory Mode for scanning.

- **Throttling Options**
  Enter the maximum number of documents to be processed per minute or the maximum number of bytes to be processed per minute. For bytes, specify the unit of measurement from the drop-down list. The options are bytes, KB (kilobytes), or MB (megabytes).

- **Inventory Scanning**
  Enter the number of incidents to produce before moving on to the next Domino server that is specified in the **Scanned Content** tab. To audit whether confidential data exists on a target, without scanning all of it, set up Inventory Mode for scanning. Setting incident thresholds can improve...
the performance of scanning by skipping to the next server to scan, rather than scanning everything.
See “Creating an inventory of the locations of unprotected sensitive data” on page 1206.

Configuring Lotus Notes DIIOP mode configuration scan options

In the file Crawler.properties, when lotusnotescrawler.use.diiop is set to true, DIIOP (CORBA) is used to scan a Domino server. The scanner connects directly to the Domino server with HTTP and DIIOP.

To configure a Lotus Notes DIIOP mode configuration for scanning

1. Copy the Lotus Notes Java library files Notes.jar and NCSO.jar to the SymantecDLP/Protect/plugins directory.

   They can be found in the installation directories of a Lotus Notes client, and a Lotus Domino server with the Domino Designer installed.

   The Notes.jar file is in the following Lotus Notes client default installation directories:

   - Lotus Notes 8
     
     C:\Program Files\IBM\lotus\notes\jvm\lib\ext\Notes.jar

   - Lotus Notes 7
     
     C:\Program Files\lotus\notes\jvm\lib\ext\Notes.jar

   - Lotus Notes 6.5
     
     C:\Program Files\lotus\notes\Notes.jar

   Use the version of the JAR file corresponding to the version of the Lotus Notes client.

   See “Supported Lotus Notes targets” on page 1262.

   The NCSO.jar file is in the following Lotus Domino server default installation directories, when the Domino Designer is installed:

   - Lotus Notes 8
     
     C:\Program Files\IBM\lotus\Notes\Data\domino\java\NCSO.jar
■ Lotus Notes 7

C:\Program Files\lotus\notes\data\domino\java\NCSO.jar

■ Lotus Notes 6.5

C:\Program Files\lotus\notes\data\domino\java\NCSO.jar

2 In the file Crawler.properties, set the following property:

lotusnotescrawler.use.diiop = true

3 Start the HTTP service on the Domino server.

4 Start the DIIOP service on the Domino server.

5 On the Domino server, set the Allow HTTP connections to browse databases setting to true.

6 When creating targets, enter the credentials of a user who has an Internet password.
Setting up scans of SQL databases

This chapter includes the following topics:

- Setting up server scans of SQL databases
- Supported SQL database targets
- Configuring and running SQL database scans
- Installing the JDBC driver for SQL database targets
- SQL database scan configuration properties

Setting up server scans of SQL databases

You can configure scanning of Oracle, SQL Server, or DB2 databases.

See “Configuring and running SQL database scans” on page 1268.

To set up scanning of SQL databases, complete the following process:

**Table 61-1** Setting up an SQL database scan

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Verify that your SQL database is on the list of supported targets.</td>
<td>See “Supported SQL database targets” on page 1268.</td>
</tr>
<tr>
<td>2</td>
<td>Click Manage &gt; Discover Scanning &gt; Discover Targets to create an SQL database target and to configure scans of SQL databases.</td>
<td>See “Configuring and running SQL database scans” on page 1268.</td>
</tr>
</tbody>
</table>
Table 61-1 Setting up an SQL database scan (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Set any additional scan options for the SQL database target.</td>
<td>See “Network Discover scan target configuration options” on page 1191.</td>
</tr>
<tr>
<td>4</td>
<td>Install the JDBC driver for the SQL database, if needed.</td>
<td>See “Installing the JDBC driver for SQL database targets” on page 1271.</td>
</tr>
<tr>
<td>5</td>
<td>Start the SQL database scan.</td>
<td>Select the scan target from the target list, then click the Start icon.</td>
</tr>
<tr>
<td></td>
<td>Click <strong>Manage &gt; Discover Scanning &gt; Discover Targets</strong>.</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Verify that the scan is running successfully.</td>
<td>See “Managing Network Discover target scans” on page 1209.</td>
</tr>
</tbody>
</table>

Supported SQL database targets

The following SQL Databases were tested with Network Discover Target scans:

- Oracle 10g (the *vendor_name* is `oracle`)
- SQL Server 2005 (the *vendor_name* is `sqlserver`)
- DB2 9 (the *vendor_name* is `db2`)

Contact Symantec Data Loss Prevention support for information about scanning any other SQL databases.

Configuring and running SQL database scans

You can configure and run scans on SQL databases to identify which databases contain confidential data, or to locate the inappropriate presence of confidential data.

Scanning of SQL databases occurs for a specific set of column data types. The SQL Database scan extracts data of the following Java Database Connectivity (JDBC) types: `CLOB`, `BLOB`, `BIGINT`, `CHAR`, `LONGVARCHAR`, `VARCHAR`, `TINYINT`, `SMALLINT`, `INTEGER`, `REAL`, `DOUBLE`, `FLOAT`, `DECIMAL`, `NUMERIC`, `DATE`, `TIME`, and `TIMESTAMP`. The mapping between these column types and those of a specific database depends on the implementation of the JDBC driver for the scan.
To set up a scan for an SQL Database

1. Select one of the following methods for entering the databases:
   - Upload a file with the list of databases
     - Create and save a plain text file (.txt) with the servers you want to scan. Click **Browse** to locate the list and **Upload** to import it. The user name and password that is specified on the **Scanned Content** tab of the **Add SQL Database Target** page is used.
     - Enter the databases using the following syntax. The vendor name can be `oracle`, `db2`, or `sqlserver`. The data source is the subname of the JDBC connection string for that driver and database. The documentation for the JDBC driver describes this subname. You can optionally enter the maximum rows to scan per table in the database.
       
       \[
       \text{vendor\_name}:\text{datasource}[, \text{maximum-rows-to-scan}]
       \]
       
       For example:
       
       \[
       \text{oracle}:@/\text{oracleserver.company.com}:1521/mydatabase
       \]
       
       \[
       \text{db2}://\text{db2server.company.com}:50000/mydatabase,300
       \]
       
       For some SQL Servers, you must also specify the SQL instance name, as in the following example:
       
       \[
       \text{sqlserver}://\text{sqlserver.company.com}:1433/mydatabase;
       \text{instance=myinstance}
       \]
   - Manually enter the databases into the user interface
     - Click the **Add** option to use a line editor to specify the databases you want to scan. SQL Database information that is entered here takes precedence over the default values and applies only to the database specified. You can optionally enter the maximum rows to scan per table in the database. Use the following syntax:
2 On the Filters tab, enter the optional Include and Exclude filters.

Use the Include Filters and Exclude Filters to specify SQL databases and the tables that Symantec Data Loss Prevention should process or skip.

When both Include Filters and Exclude Filters are used, the Exclude Filters take precedence. Any table that matches the Include Filters is scanned, unless it also matches the Exclude Filters, in which case it is not scanned.

If the Include Filters field is empty, Symantec Data Loss Prevention performs matching on all tables. These tables are returned from the table query of the target SQL databases. If you enter any values in the field, Symantec Data Loss Prevention scans only those databases and tables that match your filter.

The syntax is a pattern for the database, a vertical bar, and a pattern for the table name. Multiple patterns can be separated with commas. Standard pattern matching applies. For example, “?” matches a single character.

Because the table name matching is not case-sensitive for many databases, upper case conversion occurs. The table name in the pattern and the table name it is matched against are converted to upper case before the match.

The following example would match the employee table in all databases.

*|employee

The following example would match all tables in all Oracle databases.

oracle:*|*

For SQL Server 2005 and DB2, the default table query returns table names in the format schema_name.table_name. Include Filters and Exclude Filters for SQL Server and DB2 should match this format.

See the following examples:

sqlserver:*|HRschema.employee
sqlserver:*|*.employee
3 On the **General** tab, select scheduling options.

Choose **Submit Scan Job on Schedule** to set up a schedule for scanning the specified target. Select an option from the Schedule drop-down list to display additional fields. Choose **Pause Scan between these times** to automatically pause scans during the specified time interval. You can override a target’s pause window by going to the Discover Targets screen and clicking the start icon for the target entry. The pause window remains intact, and any future scans that run up against the window can pause as specified. You can also restart a paused scan by clicking the continue icon in the target entry.

4 Select the **Advanced** tab for options to optimize scanning. On the **Advanced** tab, you can configure throttling options or Inventory Mode for scanning.

- **Throttling Options**
  Enter the maximum number of rows to be processed per minute or the maximum number of bytes to be processed per minute. If you select both options, then the scan rate is slower than both options. The scan rate is slower than the specified number of rows per minute and the specified number of bytes per minute. For bytes, specify the unit of measurement from the drop-down list. The options are bytes, KB (kilobytes), or MB (megabytes).

- **Inventory Scanning**
  Enter the number of incidents to produce before moving on to the next item to scan. The next item is the next database from the list in the **Scanned Content** tab. To audit whether confidential data exists on a target, without scanning all of it, set up Inventory Mode for scanning. Setting incident thresholds can improve the performance of scanning by skipping to the next item to scan, rather than scanning everything.

  See “Creating an inventory of the locations of unprotected sensitive data” on page 1206.

### Installing the JDBC driver for SQL database targets

A JDBC driver must be installed for each database type to be scanned.

**To install the JDBC driver**

1 Obtain the relevant JDBC driver.

   - The Oracle driver is already installed with the Network Discover Server, in the default SQL drivers directory `Protect/lib/jdbc`. The JDBC driver is Oracle JDBC driver version 10.2.0.3.0.

   - For Microsoft SQL Server, the open source driver jTDS, can be obtained from Source Forge at [http://jtds.sourceforge.net/](http://jtds.sourceforge.net/).
The jTDS JDBC driver version 1.2.2 was tested with Network Discover.

- For DB2, the IBM driver JAR files are in the IBM DB2 distribution, under the java folder. They can be obtained from IBM at http://www.ibm.com/db2. The IBM JDBC driver version 1.4.2 was tested with Network Discover.

2 Copy the driver files to the default SQL drivers directory Protect/lib/jdbc.

3 Change the permissions of the JDBC driver files so that the Protect user has at least read permission.

4 The sqldatabasecrawler.properties file may also need to be modified to specify the correct JAR names for the selected drivers.

See “SQL database scan configuration properties” on page 1272.

SQL database scan configuration properties

The following configuration properties can be edited in the sqldatabasecrawler.properties configuration file on the Network Discover Server:

- **driver_class.vendor_name**
  Specifies the class name of the JDBC driver to use. The JAR file for this driver must be included in the directory that is named in sqldrivers.dir and must be named as driver_jar.vendor_name.
  Example:

  ```
  driver_class.sqlserver = net.sourceforge.jtds.jdbc.Driver
  ```

- **driver_subprotocol.vendor_name**
  Specifies the subprotocol portion of the JDBC connection string.
  Example:

  ```
  driver_subprotocol.sqlserver = jtds:sqlserver
  ```

- **driver_jar.vendor_name**
  Specifies the list of JAR files that the driver requires. The JAR files are stored in the directory that is named in sqldrivers.dir.
  See “Installing the JDBC driver for SQL database targets” on page 1271.
  Examples:

  ```
  driver_jar.sqlserver = jtds-1.2.2.jar
driver_jar.db2 = db2jcc.jar, db2jcc_license_cu.jar
  ```

- **driver_table_query.vendor_name**
Specifies the query to execute to return a list of tables to scan. Typically, the query should return all user tables in the database. Note that the database account that issues this query needs appropriate rights to be granted to it by the database administrator.

You must use an account to scan that can make the `driver_table_query` in `sqldatabasecrawler.properties` and return results. You can test the scan configuration by using `sqlplus` to log on as the scan user, and to run the query. If you get results, you have the permissions to complete the scan. If you do not get results, then you either have to change the query, or change the privileges for the scan user.

Example:

```sql
driver_table_query.sqlserver = SELECT table_schema + '.' + table_name FROM information_schema.tables
```

- `driver_row_selector.vendor_name`
  Specifies the format of the query to use to select the rows from the table. This vendor name varies, depending on the database. Examples are included in the `sqldatabasecrawler.properties` configuration file for the most common databases.

  The following substitution variables are used in the query:

  0=TABLENAME
  1=COLUMNS
  2=ROWNUM

  Example:

  ```sql
driver_row_selector.sqlserver = SELECT TOP {2} {1} FROM {0}
```

- `quote_table_names.vendor_name`
  Specifies whether table names are quoted before the row selection query is created. Enabling this feature allows tables with numeric names to be scanned. For example, `Payroll.1` becomes “Payroll”.“1” when the name is quoted.

  Example:

  ```sql
quote_table_names.sqlserver=true
```

- `sqldrivers.dir`
  Specifies the location of the directory in which the JDBC driver JAR files are placed.
Setting up scans of SharePoint servers

This chapter includes the following topics:

- Setting up server scans of SharePoint servers
- About scans of SharePoint servers
- Supported SharePoint server targets
- Access privileges for SharePoint scans
- About Alternate Access Mapping Collections
- Configuring and running SharePoint server scans
- Installing the SharePoint solution on the Web Front Ends in a farm
- Setting up SharePoint scans to use Kerberos authentication
- Troubleshooting SharePoint scans

Setting up server scans of SharePoint servers

To set up scanning of SharePoint servers, complete the following process:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Verify that your SharePoint server is on the list of supported targets.</td>
<td>See &quot;Supported SharePoint server targets&quot; on page 1277.</td>
</tr>
</tbody>
</table>
Table 62-1 Setting up a SharePoint server scan (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Verify that you have sufficient permissions to install the SharePoint solution on the Web Front Ends in a Farm. Also verify that the scan user has the permissions to run the scan of the SharePoint server.</td>
<td>See “Access privileges for SharePoint scans” on page 1277. See “Installing the SharePoint solution on the Web Front Ends in a farm” on page 1281. See “Configuring and running SharePoint server scans” on page 1278.</td>
</tr>
<tr>
<td>3</td>
<td>Install the SharePoint solution on the Web Front Ends in a Farm.</td>
<td>See “Installing the SharePoint solution on the Web Front Ends in a farm” on page 1281.</td>
</tr>
<tr>
<td>4</td>
<td>Click Manage &gt; Discover Scanning &gt; Discover Targets to create a SharePoint target and to configure scans of SharePoint servers.</td>
<td>See “Configuring and running SharePoint server scans” on page 1278.</td>
</tr>
<tr>
<td>5</td>
<td>Set any additional scan options for the SharePoint target.</td>
<td>See “Network Discover scan target configuration options” on page 1191.</td>
</tr>
<tr>
<td>6</td>
<td>Start the SharePoint server scan.</td>
<td>Click Manage &gt; Discover Scanning &gt; Discover Targets. Select the scan target from the target list, then click the Start icon.</td>
</tr>
<tr>
<td>7</td>
<td>Verify that the scan is running successfully.</td>
<td>See “Managing Network Discover target scans” on page 1209.</td>
</tr>
</tbody>
</table>

About scans of SharePoint servers

The Network Discover Server locates a wide range of exposed confidential data on SharePoint servers. It communicates with the Enforce Server to obtain information about policies and scan targets. It sends information about the exposed confidential data that it finds to the Enforce Server for reporting and remediation.

The following types of SharePoint items are scanned:

- Wiki pages
- Blogs
- Calendar entries
- Tasks
- Project tasks
- Discussion entries
- Contact lists
- Announcements
- Links
- Surveys
- Issue tracking
- Custom lists
- Documents in the document library

**Note:** Only the latest version of a document is scanned.

The communication between the Discover Server and the SharePoint Web Front End (WFE) is SOAP-based.

Communication is secure when the SharePoint Web sites are configured to use SSL.

For HTTPS, validation of the server SSL certificate is not the default. To enable validation of the server SSL certificate, turn on the advanced setting `Discover.ValidateSSLCertificates`. Then import the server SSL certificate to the Discover Server.

See “Advanced server settings” on page 203.

See “Importing SSL certificates to Enforce or Discover servers” on page 197.

If the specified SharePoint site is configured to be on a port that is not the default (80), ensure that the SharePoint server allows the Discover Server to communicate on the required port.

The SharePoint solution uses Windows SharePoint Services (WSS) application programming interfaces. User access to the content is based on the rights for the specified user in SharePoint. Enter the user credentials to specify this user when you configure a SharePoint scan.

See “Configuring and running SharePoint server scans” on page 1278.
Supported SharePoint server targets

The following SharePoint server targets are supported:

- Microsoft Office SharePoint Server 2007, on Windows Server 2003, 32-bit or 64-bit, or Windows Server 2008 R1, 32-bit or 64-bit
- Microsoft Office SharePoint Server 2010, on Windows Server 2008 R2, 64-bit
- Microsoft Office SharePoint Server 2013, on Windows Server 2008 R2, 64-bit
- Microsoft Office SharePoint Online 2010
- Microsoft Office SharePoint Online 2013

Access privileges for SharePoint scans

To perform the SharePoint scan, the user accounts should have sufficient rights to access and browse the SharePoint site content. The user account must also have permission to invoke Web services and permission to obtain the access control list (ACL).

These rights correspond to the lower-level SharePoint permissions “Browse Directories,” “Use Remote Interfaces,” and “Enumerate Permissions.” Refer to the Microsoft SharePoint documentation for more information on SharePoint permissions and permission levels. If the user account does not have the “Enumerate Permissions” right, then the ACL is not obtained for the SharePoint content.

The following permission levels in SharePoint already have these permissions defined:

- Full Control (includes Browse Directories, Use Remote Interfaces, and Enumerate permissions)
About Alternate Access Mapping Collections

SharePoint requires all URLs used to access a web application to be defined in Central Administration as internal or public, and the Symantec SharePoint solution expects the user to provide one of those defined URLs as a scan target. Use SharePoint's Alternate Access Mapping Collection to define the web application URLs you use for scanning. For information about configuring Alternate Access Mapping Collections, see http://technet.microsoft.com/en-us/library/cc288609%28office.12%29.aspx.

Configuring and running SharePoint server scans

Before you run a scan, you must set up a target using the following procedure.

The SharePoint solution must be installed on the Web Front End in a farm.

See “Installing the SharePoint solution on the Web Front Ends in a farm” on page 1281.

To set up a new target for the scan of a SharePoint server

1. Click Manage > Discover Scanning > Discover Targets > New Target > Server > SharePoint.
2. On the General tab, enter the name of this scan target.
3. Select the policy groups that contain the policies for this target scan.
4. Select the Discover Servers where this target scan can run.
5. Select Scheduling options.
   Choose Submit Scan Job on Schedule to set up a schedule for scanning the specified target. Select an option from the schedule drop-down list to display additional fields.
   Choose Pause Scan between these times to automatically pause scans during the specified time interval. You can override a target’s pause window by going to the Discover Targets screen and clicking the start icon for the target entry. The pause window remains intact, and any future scans that run up against the window can pause as specified. You can also restart a paused scan by clicking the continue icon for the target entry.

See “Scheduling Network Discover scans” on page 1194.
6 On the **Scanned Content** tab, enter the credentials for this scan.

You can specify a default user name for access to all SharePoint sites, except those specified using the **Add** editor.

If you specify SharePoint sites with the **Add** editor, you can specify separate credentials for each site.

The user accounts should have "Browse Directories" permissions in SharePoint to perform the scan. To retrieve permissions, the user account needs the "Enumerate Permissions" SharePoint permission level.

See “Access privileges for SharePoint scans” on page 1277.

7 Specify the SharePoint sites to scan.

For each site, enter a target URL to the SharePoint Web application or site collection or site to be scanned. All the items in its child sites and sub sites are scanned.

For a Web application, specify for example: `http://www.sharepoint.com:2020`

For a site collection, specify for example:
`http://www.sharepoint.com:2020/Sites/collection`

For a site or sub-site, specify for example:
`http://www.sharepoint.com:2020/Sites/mysharepoint/sub/mysite`

For the SharePoint site, use the public URL instead of the internal URL.

The Following syntax applies for the URL and credentials on each line.

```
URL, [username, password]
```

Select one of the following methods of entering the location for the SharePoint server:

- **Uploaded file**
  Select **Scan Sites From an Uploaded File**. Create and save a plain text file (`.txt`) listing the servers you want to scan. Create the file using an ASCII text editor and enter one URL per line. Then click **Browse** to locate the file with the list. Click **Upload Now** to import it.

- **Individual entries**
  Select **Scan Sites**. Click **Add** to use a line editor to specify the servers you want to scan. Server information that is entered here takes precedence over the default values and applies only to the path specified.
8 Under **Scan Type**, select **Scan only new or modified items (incremental scan)**. This option is the default for new targets.

If you have changed the policy or other definitions in an existing scan, you can set up the next scan as a full scan. Select the following option:

**Scan all items for the next scan. Subsequent scans will be incremental.**

If you always want to scan all items in this target, select the following option:

**Always scan all items (full scan)**

9 On the **Filters** tab, select path filters.

Use the **Include Filter** and **Exclude Filter** to specify the items that Symantec Data Loss Prevention should process or skip. If the field is empty, Symantec Data Loss Prevention performs matching on all items. If you enter any values for the Include Filter, Symantec Data Loss Prevention scans only those items that match your filter. Delimit entries with a comma, but do not use any spaces.

You can provide filters using regular expressions, or paths relative to the location of the SharePoint site. Filters can include a site collection, site, sub site, folder, file name, or file extension. Path filters are not applied on attachments of an item, such as a `.doc` attachment to a list item.

All path filters are case-sensitive.

For the **Include Filter**, regular expression matching is applied to files, but not to folders.

For the **Exclude Filter**, regular expression matching is applied to both files and folders.

Only the path until the first "?" or "*" is considered when a folder or file is matched.

When all the specified path filters are relative, the matching folder is skipped, and the scan statistics do not include the items in the skipped folders.

See “Setting up Endpoint Discover filters to include or exclude items from the scan” on page 1395.

10 On the **Filters** tab, select date filters.

The date filters let you include items from the matching process based on their dates. Any items that match the specified date filters are scanned.

See “Filtering Discover targets by date last accessed or modified” on page 1202.
11 On the Filters tab, select size filters.

The size filters let you exclude items from the matching process based on their size. Symantec Data Loss Prevention includes only the items that match your specified size filters. If you leave this field empty, Symantec Data Loss Prevention performs matching on items or documents of all sizes.

See “Filtering Discover targets by item size” on page 1201.

12 Select the Advanced tab for options to optimize scanning. On the Advanced tab, you can configure throttling options and set Inventory Mode for scanning.

- **Throttling Options**
  Specify the maximum number of items to be processed per minute, or specify the maximum number of bytes to be processed per minute. For bytes, specify the unit of measurement from the drop-down list. The options are bytes, KB (kilobytes), or MB (megabytes).

  **Note:** Byte throttling is only applied after the fetch of each item. Therefore, actual network traffic may not exactly match the byte throttling that is set.

- **Inventory Scanning**
  Enter the number of incidents to produce before moving on to the next site to scan (a URL from the Scanned Content tab). To audit whether confidential data exists on a target, without scanning all of it, set up Inventory Mode for scanning. Setting incident thresholds can improve the performance of scanning by skipping to the next site to scan, rather than scanning everything.

  After the incident threshold has been reached, the scanning of this site is stopped, and scanning proceeds to the next site. Because the process is asynchronous, a few more incidents may be created than specified in the incident threshold.

### Installing the SharePoint solution on the Web Front Ends in a farm

To scan a SharePoint target using Network Discover, you must install the Symantec SharePoint solution on the Web Front Ends in a farm.

The SharePoint target running on Network Discover communicates with the SharePoint solution and fetches content after the target is authenticated with SharePoint. You can configure the application to use SSL if secure data transfer is required between the Network Discover and SharePoint servers.
Specific permissions are required for the SharePoint solution installation process. See “Access privileges for SharePoint scans” on page 1277.

The Symantec SharePoint solution is versioned, and is not backward-compatible. If you are upgrading from Symantec Data Loss Prevention version 11.5 or earlier, you must upgrade your SharePoint solution. Table 62-2 lists the SharePoint Solution version that is compatible with your version of Symantec Data Loss Prevention.

**Table 62-2  Symantec SharePoint Solution version compatibility**

<table>
<thead>
<tr>
<th>Symantec SharePoint Solution version</th>
<th>Compatible Symantec Data Loss Prevention versions</th>
</tr>
</thead>
<tbody>
<tr>
<td>No version number</td>
<td>11.0 through 11.5</td>
</tr>
<tr>
<td>11.5.1</td>
<td>11.5.1</td>
</tr>
<tr>
<td>11.6</td>
<td>11.6, 11.6.1, 11.6.2</td>
</tr>
<tr>
<td>12.0</td>
<td>12.0, 12.0.1</td>
</tr>
<tr>
<td>12.5</td>
<td>12.5</td>
</tr>
</tbody>
</table>

To install the Symantec SharePoint solution

1. Copy the SharePoint solution installer `Symantec_DLP_Solution_12.5.exe` to a temporary directory on the SharePoint Web Front End. This file is located in the `DLP_Home\Symantec_DLP_12.5_Win\Third_Party\SharePoint` or `DLP_Home\Symantec_DLP_12.5_Lin\Third_Party\SharePoint` directory, where `DLP_Home` is the name of the directory in which you unzipped the Symantec Data Loss Prevention software.

2. Start the Windows SharePoint Services Administration service on the SharePoint server. On the SharePoint server, click **Start > All Programs > Administrative Tools > SharePoint Central Administration**.

3. Double-click the `Symantec_DLP_Solution_12.5.exe` file. The Symantec Data Loss Prevention solution installation program starts.

4. Click **Next**, and the installation program performs a number of preliminary checks.

   If one of these checks fail, correct the problem and restart the installation program.

   Click **Next**.

5. Accept the Symantec License Agreement, and click **Next**.
6 The installation program copies the files and deploys the solution to all Web Applications in the SharePoint farm.

7 After installation, verify that the SharePoint solution has been correctly deployed to the server or server farm.

8 Connect to SharePoint Central Administration. On the SharePoint server, go to Start > All Programs > Administrative Tools > SharePoint Central Administration.

9 For SharePoint 2007, click the Operations tab. In the Global Configuration section, select Solution management.

10 For SharePoint 2010, click System Settings. Then select Manage Farm Solutions.

11 Verify the deployment. If the solution is installed correctly, the list includes symantec_dlp_solution.wsp.

12 If the solution must be removed, use the SharePoint retract and undeploy features.

**Setting up SharePoint scans to use Kerberos authentication**

A SharePoint scan can optionally use Kerberos authentication.

SharePoint must already be set up to work with Kerberos authentication.

The Discover Server must then be configured to communicate with the Key Distribution Center (KDC) and the SharePoint server.

To configure the Discover Server for Kerberos authentication

1 Create a file named krb5.conf which contains the realm and the KDC information. On Windows, this file is usually named krb5.ini. A sample file is in the folder C:\SymantecDLP\Protect\config (in a Windows default Symantec Data Loss Prevention installation).

   See "Creating the configuration file for Active Directory integration" on page 106.

2 Copy this file to the Discover Server into the folder C:/SymantecDLP/jre/lib/security/ (in a Windows default Symantec Data Loss Prevention installation).
3  Update the default realm and directory server parameters (realms) in this file.

[libdefaults]
default_realm = ENG.COMPANY.COM

[realms]
ENG.COMPANY.COM = {
kdc = engADserver.emg.company.com
}
MARK.COMPANY.COM = {
kdc = markADserver.emg.company.com
}

See “Creating the configuration file for Active Directory integration” on page 106.

4  On the Discover Server, update the Protect.properties file in the folder
\C:\SymantecDLP\Protect\config (in a Windows default Symantec Data Loss Prevention installation). Update the property that points to the updated krb5.ini file.

# Kerberos Configuration Information
java.security.krb5.conf=C:/SymantecDLP/jre/lib/security/krb5.ini

Troubleshooting SharePoint scans

Table 62-3 provides suggestions for troubleshooting issues with SharePoint scans.

<table>
<thead>
<tr>
<th>Issue</th>
<th>Recommended steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>If an internal SharePoint URL is specified, only the default site</td>
<td>Specify the public URL for the SharePoint site. All the site collections are scanned.</td>
</tr>
<tr>
<td>collection is scanned.</td>
<td></td>
</tr>
<tr>
<td>No site collections, or only the default site collection, are</td>
<td>Specify the site collection/site/web application URL with a fully qualified domain name.</td>
</tr>
<tr>
<td>scanned when the Discover Server and SharePoint site are in different domains.</td>
<td>To validate the access from the Discover Server, try to access the SharePoint URL from a browser. If a short name does not work, try to use the fully qualified domain name.</td>
</tr>
<tr>
<td></td>
<td>Only the default site collection is scanned if the web application URL does not contain fully qualified domain name.</td>
</tr>
</tbody>
</table>
Table 62-3  Troubleshooting SharePoint scans (continued)

<table>
<thead>
<tr>
<th>Issue</th>
<th>Recommended steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>The bytes reported as scanned does not match the number of bytes in the content.</td>
<td>To improve performance, the scan statistics do not include items in the folders that are skipped (filtered out). Dynamic content, such as .aspx files, can change size. You can set the Advanced Server setting Discover.countAllFilteredItems to get more accurate scan statistics. See “Advanced server settings” on page 203.</td>
</tr>
</tbody>
</table>
Setting up scans of Exchange servers

This chapter includes the following topics:

- Setting up server scans of 2007 repositories using the Exchange Web Store connector
- About scans of Exchange 2007 servers
- Supported Exchange Server Web Store connector targets
- Providing access rights to scan all mailboxes and public folders
- Configuring Exchange 2007 server scans
- Example configurations and use cases for Exchange 2007 scans
- Troubleshooting Exchange 2007 scans
- Setting up server scans of Exchange 2007 SP2 and 2010 repositories using Exchange Web Services
- About scans of Exchange 2007 SP2 and 2010 servers
- Supported Exchange Server Web Services connector targets
- Configuring Exchange 2007 SP2 and 2010 Server scans
- Example configurations and use cases for Exchange 2007 SP2 and 2010 scans
- Troubleshooting Exchange 2007 SP2 and 2010 scans
Setting up server scans of 2007 repositories using the Exchange Web Store connector

You can scan Exchange 2007 SP2 and earlier servers using the Exchange Web Store connector. To set up scanning of Exchange 2007 servers using the Exchange Web Store connector, complete the following process:

Table 63-1 Setting up an Exchange server scan

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Verify that your Exchange server provides Outlook Web Access and enable WebDAV.</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>If you need secure access between the Discover Server and your Exchange server or LDAP server, set up HTTPS and LDAPS.</td>
<td>See “Configuring Exchange 2007 server scans” on page 1289.</td>
</tr>
<tr>
<td>3</td>
<td>If you want to scan all mailboxes and public folders, make sure to grant access rights for the specific user. The user also needs access to the domain controller.</td>
<td>See “Providing access rights to scan all mailboxes and public folders” on page 1289.</td>
</tr>
<tr>
<td>4</td>
<td>Go to Manage &gt; Discover Scanning &gt; Discover Targets to create an Exchange target and to configure scans of Exchange servers.</td>
<td>See “Configuring Exchange 2007 server scans” on page 1289.</td>
</tr>
<tr>
<td>5</td>
<td>Set any additional scan options for the Exchange target.</td>
<td>See “Network Discover scan target configuration options” on page 1191.</td>
</tr>
<tr>
<td>6</td>
<td>Start the Exchange server scan.</td>
<td>Go to Manage &gt; Discover Scanning &gt; Discover Targets. Select the scan target from the target list, then click the Start icon.</td>
</tr>
<tr>
<td>7</td>
<td>Verify that the scan is running successfully.</td>
<td>See &quot;Managing Network Discover target scans&quot; on page 1209.</td>
</tr>
</tbody>
</table>

About scans of Exchange 2007 servers

The Network Discover Server locates a range of exposed confidential data on Exchange servers, including email messages, calendar items, contacts, journal, and flagged items.

Communication is secure when the Exchange server is configured to use SSL (HTTPS). Communication with the LDAP server is secure when it is configured to use LDAPS.
For HTTPS, validation of the server SSL certificate is not the default. To enable validation of the server SSL certificate, turn on the advanced setting `Discover.ValidateSSLCertificates`. Then import the server SSL certificate to the Discover Server.

See “Advanced server settings” on page 203.

See “Importing SSL certificates to Enforce or Discover servers” on page 197.

Figure 63-1  Exchange scan configuration

**Supported Exchange Server Web Store connector targets**

The Exchange Web Store connector supports the following Exchange Server targets:

- Microsoft Exchange Server 2007 SP2 or earlier
  For Exchange 2007 SP2 servers, you can either use the Exchange Web Store connector or Exchange Web Services connector.

To use the Exchange Web Store connector, Outlook Web Access must be configured, and WebDAV must be enabled.

The Exchange scan includes email message text and email file attachments from the user’s mailbox.

You can scan the data objects that are stored within Public Folders, such as:
Providing access rights to scan all mailboxes and public folders

If you want to scan all mailboxes and public folders, make sure to grant access rights for the specific user.

Basic, NTML, and form-based authentication is supported. Kerberos is also supported, if it is installed.

For Exchange 2007, set up access rights to all mailboxes and public folders

1  In the Exchange console, run the following to enable access to all mailboxes:

   Get-Mailbox | Add-MailboxPermission -User specific_user
   -Accessright Fullaccess -InheritanceType All

2  The access to public folders should be enabled by default. Verify the access.

3  Restart the Microsoft Exchange Information Store service to propagate the changes immediately.

   Note: The changes propagate automatically, but may take 15 minutes or longer.

Configuring Exchange 2007 server scans

Before you run a scan, you must set up a target using the following procedure.

If you want secure access from the Discover Server to the Exchange server, then set up the Exchange server for HTTPS. If you want secure access from the Discover...
Server to the Domain Server, then set up the Domain Server for LDAPS. Use the same procedure for the Enforce Server, and for each Discover Server that scans an Exchange Server.

See “Importing SSL certificates to Enforce or Discover servers” on page 197.

---

**Note:** The "eml" string is special for Exchange server scanning because the files in Exchange have an .eml extension. Review your policies, such as file matching, and avoid using "eml" in the matching for Exchange scans. Also avoid this string in the include or exclude filters of the Exchange scans.

---

To set up a new target for the scan of an Exchange server

2. On the General tab, enter the name of this scan target.
3. Select the policy groups that contain the policies for this target scan.
4. Select the Network Discover Servers where this target scan can run.
5. Select Scheduling options.
   - Choose **Submit Scan Job on Schedule** to set up a schedule for scanning the specified target. Select an option from the schedule drop-down list to display additional fields.
   - Choose **Pause Scan between these times** to automatically pause scans during the specified time interval. You can override a target's pause window by going to the Discover Targets screen and clicking the start icon for the target entry. The pause window remains intact, and any future scans that run up against the window can pause as specified. You can also restart a paused scan by clicking the continue icon for the target entry.
   
   See “Scheduling Network Discover scans” on page 1194.
6. On the Scanned Content tab, enter the credentials for this scan.
   - All Exchange user names must include the domain name, for example:

     \`\`\`\`\n     DOMAIN_NAME\user_name
     \`\`\`\`
   
   You can specify a default user name for access to the Exchange site.

   See “Providing the password authentication for Network Discover scanned content” on page 1196.
7. Enter a target URL for the Exchange server to be scanned.
Select one of the following methods of entering the items to scan on the Exchange server:

- **All users on Directory Server**
  
  To use this option, select a Directory Server connection you have already specified, or click the Create new Directory Connection link to configure a new directory connection. See “Configuring directory server connections” on page 127.

- **Directory groups and users**
  
  If directory user groups are available, then select the groups to include in this target. To use this option, directory groups must be established. If no directory groups are set up, click the link Create new User Group to jump to the page to configure the directory user groups. See “Configuring User Groups” on page 654.

- **Specify User Mailboxes to include in this Target**
  
  Enter specific mailboxes. Alphanumeric characters and the following special characters are allowed in mailbox names:

  ```
  ! # $ ' - ^ _ ` { }
  ```

  You can combine this option with directory groups and users. No directory groups are needed for the user mailboxes option.

- **Public folders**
  
  Select this option to scan all public folders on the Exchange server. The user of the credentials that are specified must have access to these public folders. You can select this option in addition to All users on a Directory Server or Directory groups and users.
8 On the **Filters** tab, select path filters.

Use the Include Filter and Exclude Filter to specify the items that Symantec Data Loss Prevention should process or skip. If the field is empty, Symantec Data Loss Prevention performs matching on all items. If you enter any values for the Include Filter, Symantec Data Loss Prevention scans only those items that match your filter. Delimit entries with a comma, but do not use any spaces.

You can provide filters using regular expressions, or paths relative to the location of the Exchange site. Filters can include a folder name or file name. All path filters are case-sensitive.

Exchange may append an email identifier to the end of the path. To match the filter, add a wildcard to the end. For example to filter for “sample public folder item” use the following filter:

```
*/folder/*/*sample public folder item*
```

You can provide filters using regular expressions, or paths relative to the location of the Exchange site. Filters can include a site collection, site, sub site, folder, file name, or file extension. All path filters are case-sensitive.

For the Include Filter, regular expression matching is applied to files, but not to folders.

For the Exclude Filter, regular expression matching is applied to both files and folders.

Only the path until the first "?" or "*" is considered when a folder or file is matched.

When all the specified path filters are relative, the matching folder is skipped, and the scan statistics do not include the items in the skipped folders.

See “Setting up Endpoint Discover filters to include or exclude items from the scan” on page 1395.

9 On the **Filters** tab, select size filters.

The size filters let you exclude items from the matching process based on their size. Symantec Data Loss Prevention includes only the items that match your specified size filters. If you leave this field empty, Symantec Data Loss Prevention performs matching on items of all sizes.

See “Filtering Discover targets by item size” on page 1201.
10 On the Filters tab, select a Differential scan (optional).

Select **Only Scan files added or modified since the last full scan** to have Symantec Data Loss Prevention scan only the items or the documents that have been added or modified since the last full scan. The first scan has to be a full (initial base) scan. A full scan occurs if you select this option before Symantec Data Loss Prevention scans this target for the first time.

11 Select Date Filters.

The date filters let you include items from the matching process based on their dates. Any items that match the specified date filters are scanned.

See “Filtering Discover targets by date last accessed or modified” on page 1202.

12 Select the Advanced tab for options to optimize scanning. On the Advanced tab, you can configure throttling options and set Inventory Mode for scanning.

- **Throttling Options**
  Specify the maximum number of items to be processed per minute, or specify the maximum number of bytes to be processed per minute. For bytes, specify the unit of measurement from the drop-down list. The options are bytes, KB (kilobytes), or MB (megabytes).

- **Inventory Scanning**
  Enter the number of incidents to produce before completing this scan. To audit whether confidential data exists on a target, without scanning all of it, set up Inventory Mode for scanning.
  After the incident threshold has been reached, the scanning is stopped. Because the process is asynchronous, a few more incidents may be created than specified in the incident threshold.

### Example configurations and use cases for Exchange 2007 scans

Table 63-2 lists the options to select on the **Scanned Content** tab during the configuration of an Exchange target.
<table>
<thead>
<tr>
<th>Use case</th>
<th>Description</th>
</tr>
</thead>
</table>
| Scan all user mailboxes and public folders.       | Select the following options in the user interface:  
  - **All users on Directory Server**  
  - **Public folders**  
    
  The credentials must include a user who has access to the mailboxes, and also access to the domain controller (to retrieve the list of users).  
    
  See “Providing access rights to scan all mailboxes and public folders” on page 1289.                                                                 |
| Scan all user mailboxes (but not public folders). | Select the option **All users on Directory Server** in the user interface.  
    
  The credentials must include a user who has access to the mailboxes, and also access to the domain controller (to retrieve the list of users).  
    
  See “Providing access rights to scan all mailboxes and public folders” on page 1289.                                                                 |
| Scan all public folders.                          | Select the **Public folders** option in the user interface.  
    
  The credentials must include a user who has access to the public folders.                                                                                                                                 |
| Scan all user mailboxes belonging to a specified group. | Select the **Directory groups and users** option in the user interface.  
    
  Then select the Directory Group from the groups in the list. All user mailboxes in the group are scanned.  
    
  The credentials must include a user who has access to the mailboxes, and also access to the domain controller (to retrieve the list of users).  
    
  See “Providing access rights to scan all mailboxes and public folders” on page 1289.                                                                 |
| Scan an individual user mailbox.                  | Select the **Directory groups and users** option in the user interface.  
    
  Then enter the individual user mailbox name.  
    
  The credentials must include access for the specified user mailbox.                                                                                                                                 |
| Scan the user mailboxes that are not on the default store for Exchange. | On the Exchange server, the user mailboxes may be in a different store than the default.  
    
  Specify the Exchange URL containing the path to the alternate store, credentials with access to the mailboxes, and the mailboxes to scan using any of the methods in this table.                                                                                          |
| Scan the public folders that are not on the default store for Exchange. | On the Exchange server, the public folders may be in a different store than the default.  
    
  Specify the Exchange URL containing the path to the public folders and credentials with access to the public folders.  
    
  Select the **Public folders** option in the user interface.                                                                                                                                 |
Troubleshooting Exchange 2007 scans

Table 63-3 provides suggestions for troubleshooting issues with Exchange scans.

<table>
<thead>
<tr>
<th>Issue</th>
<th>Recommended steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>A mailbox is created, but never logged on. The mailbox is not scanned.</td>
<td>Log on to the mailbox. Then the mailbox is scanned.</td>
</tr>
<tr>
<td>In the Exchange logs, the user that scanned the Exchange server is reported as &quot;Last Logged on By&quot; in the user activity.</td>
<td>This log entry indicates the last user to use the mailbox, which may be the user that scanned it.</td>
</tr>
<tr>
<td>The bytes reported as scanned do not match the number of bytes in the content.</td>
<td>To improve performance, the scan statistics do not include items in the folders that are skipped (filtered out). You can set Discover.countAllFilteredItems in Server Detail &gt; Advanced Server Settings to get more accurate scan statistics. See “Advanced server settings” on page 203.</td>
</tr>
<tr>
<td>The connection to the Exchange server times out, and no items are scanned.</td>
<td>The default value for the timeout of the connection to the Exchange server is five minutes (300000 milliseconds). To increase the value, add and set the property in the configuration file crawler.properties. For example, to set the timeout to 10 minutes, add or modify the following line: crawler.exchange.serverTimeout = 600000</td>
</tr>
<tr>
<td>All items trigger incidents if the file type detection rule is set to detect Outlook Express items in the policy for an Exchange scan.</td>
<td>Remove Outlook Express from the file type detection rule.</td>
</tr>
</tbody>
</table>

Setting up server scans of Exchange 2007 SP2 and 2010 repositories using Exchange Web Services

You can crawl Exchange 2007 SP2 (and later) and 2010 Servers using Exchange Web Services.
Table 63-4  Setting up an Exchange server scan

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Verify that Exchange Web Services and the Autodiscover Service are enabled on your Exchange server and are accessible from the Network Discover server.</td>
<td>For information about Exchange Web Services and the Autodiscover service, see your Microsoft Exchange documentation.</td>
</tr>
<tr>
<td>2</td>
<td>If you need secure access between the Discover Server and Exchange Web Services or your Active Directory server, set up HTTPS and LDAPS.</td>
<td>By default, Symantec Data Loss Prevention only allows HTTPS connections to the Active Directory server and Exchange Web Services. To allow HTTP connections, set the Discover.Exchange.UseSecureHttpConnections setting in ServerDetail&gt;AdvancedServerSettings to false. See “Advanced server settings” on page 203.</td>
</tr>
<tr>
<td>3</td>
<td>Ensure that your Exchange user credentials can impersonate any mailbox you want to scan.</td>
<td>For information about enabling impersonation for your user credentials, see your Microsoft Exchange documentation.</td>
</tr>
<tr>
<td>4</td>
<td>Go to Manage &gt; Discover Scanning &gt; Discover Targets to create an Exchange target and to configure scans of Exchange servers.</td>
<td>See “Configuring Exchange 2007 SP2 and 2010 Server scans” on page 1298.</td>
</tr>
<tr>
<td>5</td>
<td>Set any additional scan options for the Exchange target.</td>
<td>See “Network Discover scan target configuration options” on page 1191.</td>
</tr>
<tr>
<td>6</td>
<td>Start the Exchange server scan.</td>
<td>Go to Manage &gt; Discover Scanning &gt; Discover Targets. Select the scan target from the target list, then click the Start icon.</td>
</tr>
<tr>
<td>7</td>
<td>Verify that the scan is running successfully.</td>
<td>See “Managing Network Discover target scans” on page 1209.</td>
</tr>
</tbody>
</table>

### About scans of Exchange 2007 SP2 and 2010 servers

You can scan Exchange 2007 SP2 (and later) and 2010 servers using the Exchange Web Services connector. For Exchange 2007 SP2 servers, you can either use the Exchange Web Store connector or the Exchange Web Services connector. The Exchange Web Services connector does not require an agent on the Exchange server, and it does not search every Exchange server. Using the Exchange Autodiscover feature, it fetches Exchange server and mailbox information from Active Directory, and pulls data directly from the appropriate Exchange servers.

The Network Discover Server locates a range of exposed confidential data on Exchange servers, including email messages, calendar items, contacts, journal, and flagged items.

Communication is secure when the Exchange server is configured to use SSL (HTTPS). Communication with the Active Directory server is secure when it is configured to use LDAPS.

For HTTPS, validation of the server SSL certificate is not the default. To enable validation of the server SSL certificate, turn on the advanced setting Discover.ValidateSSLCertificates. Then import the server SSL certificate to the Discover Server.

By default, Network Discover uses secure connections to the Exchange and Active Directory servers. You can disable secure access to Exchange and Active Directory by setting the Discover.Exchange.UseSecureHttpConnections setting in Server Detail > Advanced Server Settings to false.

See “Advanced server settings” on page 203.

See “Importing SSL certificates to Enforce or Discover servers” on page 197.

---

Note: Network Discover does not support scans of Exchange targets using Dynamic Distribution Groups.

---

Supported Exchange Server Web Services connector targets

The Exchange Web Services connector supports the following Exchange Server targets:

- Microsoft Exchange Server 2007 SP2 or later
  For Exchange 2007 SP2 servers, you can either use the Exchange Web Services connector or the Exchange Web Store connector.

- Microsoft Exchange Server 2010

To use the Exchange Web Services connector, Exchange Web Services and the Autodiscover Service must be enabled on your Exchange server and are accessible to the Network Discover server.

You can scan the data objects that are stored within Public Folders, such as:
The Exchange scan also targets mail stored in Exchange 2010 Personal Archives.

### Configuring Exchange 2007 SP2 and 2010 Server scans

Before you run a scan, you must set up a target using the following procedure.

**To set up a new target for the scan of an Exchange server using Exchange Web Services**

2. On the General tab, enter the name of this scan target.
3. Select the policy groups that contain the policies for this target scan.
4. Select the Network Discover Servers where this target scan can run.
5. Select Scheduling options.

   Choose **Submit Scan Job on Schedule** to set up a schedule for scanning the specified target. Select an option from the schedule drop-down list to display additional fields.

   Choose **Pause Scan between these times** to automatically pause scans during the specified time interval. You can override a target's pause window by going to the Discover Targets screen and clicking the start icon for the target entry. The pause window remains intact, and any future scans that run up against the window can pause as specified. You can also restart a paused scan by clicking the continue icon for the target entry.

See “Scheduling Network Discover scans” on page 1194.
6 On the **Scanned Content** tab, enter the credentials for this scan.

All Exchange user names must include the domain name, for example:

```
DOMAIN_NAME\user_name
```

Ensure that the user credentials you provide can impersonate all mailboxes you want to scan. For information about configuring Exchange Impersonation, see [http://msdn.microsoft.com/en-us/library/bb204095%28v=exchg.80%29.aspx](http://msdn.microsoft.com/en-us/library/bb204095%28v=exchg.80%29.aspx).

See “Providing the password authentication for Network Discover scanned content” on page 1196.

7 Enter a target URL for the Microsoft Active Directory server. For example, `ldaps://dc.domain.com:636`.

---

**Note:** Only one Active Directory server can be specified per Discover target.

---

8 Select **Public folders** to scan all public folders on the Exchange server. The user of the credentials that are specified must have access to these public folders.

---

**Note:** In mixed Exchange environments where both Exchange 2007 and 2010 servers are deployed, Network Discover only scans the public folders from the version specified by the credentials you entered in the Exchange Network Discover target. To scan public folders across both versions 2007 and 2010 in mixed environments, create a separate Network Discover target for each version.

You can select this option in addition to **All users on a Directory Server** or **Directory groups and users**.

9 Select **Mailboxes** to scan user mailboxes on your Exchange servers. Select one of the following methods of entering the items to scan on the Exchange server:

- **All users on Directory Server**
  - If a directory server is available, then select the **Directory Server** from the drop-down list.
  - To use this option, select the Directory Server connection you have already specified, or click the **Create new Directory Connection** link to configure another directory connection.
  - See “Configuring directory server connections” on page 127.

- **Directory groups and users**
If directory user groups are available, then select the groups to include in this target.
To use this option, directory groups must be established. If no directory groups are set up, click the link Create new User Group to jump to the page to configure the directory user groups.
See “Configuring User Groups” on page 654.

- **Specify User Mailboxes to include in this Target**
  Enter specific mailboxes. Alphanumeric characters and the following special characters are allowed in mailbox names:

  ! # $ ' - ^ _ ` { }

  You can combine this option with directory groups and users. No directory groups are needed for the user mailboxes option.

- **Personal Archives**
  Select this option to scan Exchange 2010 Personal Archive mailboxes for the users you have specified.
10 On the **Filters** tab, select path filters.

Use **Include Filters** and **Exclude Filters** to specify the items that Symantec Data Loss Prevention should process or skip. If the field is empty, Symantec Data Loss Prevention performs matching on all items. If you enter any values for the Include Filter, Symantec Data Loss Prevention scans only those items that match your filter. Delimit entries with a comma, but do not use any spaces.

You can provide filters using regular expressions, or paths relative to the location of the Exchange site. Filters can include a folder name or file name. All path filters are case-sensitive.

Exchange may append an email identifier to the end of the path. To match the filter, add a wildcard to the end. For example to filter for “sample public folder item” use the following filter:

`*/folder/*/*sample public folder item*`

You can provide filters using regular expressions, or paths relative to the location of the Exchange site. Filters can include a site collection, site, sub site, folder, file name, or file extension. All path filters are case-sensitive.

For **Include Filters**, regular expression matching is applied to files, but not to folders.

For **Exclude Filters**, regular expression matching is applied to both files and folders.

Only the path until the first "?" or "*" is considered when a folder or file is matched.

When all the specified path filters are relative, the matching folder is skipped, and the scan statistics do not include the items in the skipped folders.

See “Setting up Endpoint Discover filters to include or exclude items from the scan” on page 1395.

11 On the **Filters** tab, select size filters.

The size filters let you exclude items from the matching process based on their size. Symantec Data Loss Prevention includes only the items that match your specified size filters. If you leave this field empty, Symantec Data Loss Prevention performs matching on items of all sizes.

See “Filtering Discover targets by item size” on page 1201.
On the **Filters** tab, select a differential scan (optional).

Select **Only Scan files added or modified since the last full scan** to have Symantec Data Loss Prevention scan only the items or the documents that have been added or modified since the last full scan. The first scan has to be a full (initial base) scan. A full scan occurs if you select this option before Symantec Data Loss Prevention scans this target for the first time.

Select **Date Filters**.

The date filters let you include items from the matching process based on their dates. Any items that match the specified date filters are scanned.

See “Filtering Discover targets by date last accessed or modified” on page 1202.

Select the **Advanced** tab for options to optimize scanning. On the **Advanced** tab, you can configure throttling options and set Inventory Mode for scanning.

- **Throttling Options**
  
  You can use throttling to limit the bandwidth consumed by your scan, or to limit the load on your Exchange server. Specify the maximum number of items to be processed per minute, or specify the maximum number of bytes to be processed per minute. For bytes, specify the unit of measurement from the drop-down list. The options are bytes, KB (kilobytes), or MB (megabytes).

- **Inventory Scanning**
  
  Enter the number of incidents to produce before completing this scan. To audit whether confidential data exists on a target, without scanning all of it, set up inventory mode for scanning.

  After the incident threshold has been reached, the scanning is stopped. Because the process is asynchronous, a few more incidents may be created than specified in the incident threshold.

Example configurations and use cases for Exchange 2007 SP2 and 2010 scans

Table 63-5 lists the options to select on the **Scanned Content** tab during the configuration of an Exchange target.

Ensure that the user credentials you provide can impersonate all mailboxes you want to scan. For information about configuring Exchange Impersonation, see http://msdn.microsoft.com/en-us/library/bb204095%28v=exchg.80%29.aspx.
### Table 63-5  
Exchange 2007 SP2 and 2010 scan use cases

<table>
<thead>
<tr>
<th>Use case</th>
<th>Description</th>
</tr>
</thead>
</table>
| Scan all user mailboxes and public folders.  | Select the following options in the user interface:  
  ■ Public folders  
  ■ Mailboxes > All users on Directory Server  
  The credentials must have permission to impersonate all mailboxes you want to scan. |
| Scan all user mailboxes (but not public folders). | Select Mailboxes > All users on Directory Server in the user interface.  
  The credentials must have permission to impersonate all mailboxes you want to scan. |
| Scan all public folders.                     | Select Public folders in the user interface.                                                                                                  |
| Scan specific groups or users.               | Select Mailboxes > Directory groups and users in the user interface.  
  To scan a Directory Group, select the Directory Group from the groups in the list. All user mailboxes in the group are scanned. You can click Create new User Group to create a new Directory Group.  
  To scan for specific users, enter a comma-separated list of user mailbox names.  
  The credentials must have permission to impersonate all mailboxes you want to scan. |
| Scan an Exchange 2010 Personal Archive.      | Select Mailboxes > All users on Directory Server > Personal Archives or Mailboxes > Directory groups and users > Personal Archives in the user interface. If necessary, specify which mailboxes to scan. Network Discover scans the Personal Archives associated with the specified mailboxes. |

### Troubleshooting Exchange 2007 SP2 and 2010 scans

If you experience problems with Exchange 2007 SP2 and 2010 scans, you can look for more information here:

- FileReader0.log: This file logs all SOAP requests and responses between Network Discover and Exchange Web Services.
  
  To configure the file reader log to list SOAP requests, edit the FileReaderLogging.properties file as follows:

```java
java.util.logging.FileHandler.level = FINEST
org.apache.cxf.interceptor.LoggingInInterceptor.level = FINEST
net.entropysofteci.exchangewebservices.schema.SchemaHelper.level = WARNING
net.entropysofteci.exchangewebservices.schema.PropertyManagersReader.level = WARNING
org.apache.commons.beanutils.converters.level = WARNING
net.entropysofteci.exchangewebservices.AutodiscoverHelper.level = FINEST
net.entropysofteci.exchangewebservices.ExchangeWebServicesHelper= FINEST
net.entropysofteci.exchangewebservices.level = FINE
```
See “Operational log files” on page 244.

Note: Only the `java.util.logging.FileHandler.level = FINEST` line is present. You must add the others as specified in the above example.

- Exchange logs: You might find useful troubleshooting information in the logs created by your Microsoft Exchange Server.
About Network Discover scanners

This chapter includes the following topics:

- Setting up scanning of Microsoft Exchange Servers
- How Network Discover scanners work
- Troubleshooting scanners
- Scanner processes
- Scanner installation directory structure
- Scanner configuration files
- Scanner controller configuration options

Setting up scanning of Microsoft Exchange Servers

The Exchange Scanner is a stand-alone utility that lets you extract data from Microsoft Exchange and send the data to Network Discover for content processing.

The Exchange scanner accesses client mailboxes on the Exchange server using a connected Outlook client.

The Exchange scanner lets you specify which MAPI profile should be used to extract data from the Exchange structure. The Exchange scanner uses Profiles to connect to the Exchange Server through the MAPI interface. It then posts the files to Discover.

You can use the Exchange Scanner to perform the following tasks:

- Scan public folders using a specific account to find the confidential data.
Scan all the mailboxes using an Administrator account that can access all the mailboxes.

Scan a particular user's mailbox using the Administrator account.

Scan a single user's mailbox, with the user name and password known.

To set up scanning of Microsoft Exchange Servers, complete the following process:

<table>
<thead>
<tr>
<th>Table 64-1</th>
<th>Setting up an Exchange scanner</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step</td>
<td>Action</td>
</tr>
<tr>
<td>1</td>
<td>Verify that your Exchange server is either version 2003 or 2007.</td>
</tr>
<tr>
<td>2</td>
<td>Install the Exchange scanner on any computer that has Microsoft Outlook 2003 or 2007 installed and a valid Outlook profile configured.</td>
</tr>
<tr>
<td>3</td>
<td>Configure the ProfileName, and the setting for DNMailbox.</td>
</tr>
<tr>
<td>4</td>
<td>Perform any manual configurations by editing the configuration files and properties files.</td>
</tr>
<tr>
<td>6</td>
<td>Start the Exchange scan. Start the scanner on the scanner computer, and also start the scan on the Enforce Server.</td>
</tr>
<tr>
<td>7</td>
<td>Verify that the scan is running successfully.</td>
</tr>
</tbody>
</table>

How Network Discover scanners work

Scanners are the standalone applications that collect content and metadata from a repository and send them to Network Discover for processing.

For example, in a two-tier configuration you might have an Enforce Server and a Network Discover Server that is connected to a Documentum server with a scanner installed.

You can perform the following tasks on the computers in this configuration:

- On the Enforce Server, define the scan target (in this example, Documentum).
On the Documentum server, install the Documentum scanner, configure the scanner to post content to the Network Discover Server, and start (or stop) a scanner.

On the Enforce Server, start or stop a target scan (with the Start icon), and view the incident reports.

The scanner system communicates with the Network Discover Server using the HTTP protocol.

When the scanner runs, it performs the following tasks:

- Natively connects to the repository, and crawls the repository to read the content and metadata.
- Extracts the text and some metadata.
- Posts this extracted information to the Network Discover Server.
- Network Discover consumes the text and metadata and applies detection.

See “About Network Discover” on page 1180.

**Troubleshooting scanners**

After a scan is started, it extracts content and metadata from the repository. Then it passes this content to the Scan Controller and the Network Discover Server.

See “How Network Discover scanners work” on page 1306.

If a scanner does not seem to be processing items, use the following suggestions:

<table>
<thead>
<tr>
<th>Issue</th>
<th>Suggestions</th>
</tr>
</thead>
</table>
| Scanner does not seem to be running. | Verify that the scanner was installed properly.  
                                      On the system where the scanner is installed, make sure that the scanner processes are running.  
                                      See “Scanner processes” on page 1309. |
| Incidents do not appear in the reports. | Verify that the scan target is set up properly. Scanners can only send content to a target of the same type. Multiple scanners of the same type can feed content to a Network Discover scan of that type.  
                                      Check that the scan is not stalled. |
Table 64-2  Scanner troubleshooting suggestions (continued)

<table>
<thead>
<tr>
<th>Issue</th>
<th>Suggestions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The scan does not seem to start.</td>
<td>Look in the outgoing folder.</td>
</tr>
<tr>
<td></td>
<td>See “Scanner installation directory structure” on page 1309.</td>
</tr>
<tr>
<td></td>
<td>If a given scanner cannot send content to Network Discover, that content queues up in the outgoing folder.</td>
</tr>
<tr>
<td></td>
<td>Items that appear and disappear from this folder indicate normal progress.</td>
</tr>
<tr>
<td>The scan appears stalled.</td>
<td>If a given scanner cannot send content to Network Discover, the scanner content queues up on the scanner system. The scanner system must have access to the Network Discover Server. System warnings such as low disk space or down services should be in place on both systems before installation.</td>
</tr>
<tr>
<td></td>
<td>To verify received content on the Network Discover Server, view the scan statistics page of the scan. To view scan statistics, click on the running scan in the target scan list.</td>
</tr>
<tr>
<td></td>
<td>Verify that scan information moves through the scan process by checking the logs and temporary directories.</td>
</tr>
<tr>
<td></td>
<td>See “Scanner installation directory structure” on page 1309.</td>
</tr>
<tr>
<td></td>
<td>If the scan appears stalled, check the following locations on the scanner computer to diagnose the problem:</td>
</tr>
<tr>
<td>■ The /logs folder</td>
<td>The /scanner_typeScanner/logs folder has the scanner start, stop, and connection status to Network Discover. Similar information is in the Console Window. Check the log files to verify that a scanner is running successfully.</td>
</tr>
<tr>
<td>■ The /failed folder</td>
<td>Items that appear in the /failed folder indicate a mismatch of the scanner types, between the New Target and the scanner. For example if an Exchange scanner is specified in the New Target, but the scanner is SharePoint, then items appear in the /failed folder.</td>
</tr>
<tr>
<td>■ The /outgoing folder</td>
<td>Items that appear and disappear from this folder indicate normal progress. If items linger in this folder and are not consumed (do not disappear), a problem in extracting text and metadata is indicated.</td>
</tr>
<tr>
<td></td>
<td>If a given scanner cannot send content to Network Discover, that content queues up in the outgoing folder.</td>
</tr>
<tr>
<td>■ The /scanner_typeScanner/scanner directory</td>
<td>The scanner connection status to the repository, repository crawling information, and fetched data.</td>
</tr>
</tbody>
</table>
Scanner processes

Table 64-3 provides the information about Network Discover scanner processes on a Windows operating system.

Table 64-3  Discover processes

<table>
<thead>
<tr>
<th>Processes</th>
<th>Executable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ScannerController</td>
<td>scanner_typeScanner_Console.exe or scanner_typeScanner_Service.exe</td>
<td>Process that configures and controls the connector, sends content to the Network Discover Server, and sends end-of-scan message to Network Discover.</td>
</tr>
<tr>
<td>Connector</td>
<td>scanner_typeScanner.exe</td>
<td>Process that extracts documents and metadata from the repository.</td>
</tr>
<tr>
<td>ImportModule</td>
<td>ImportSlave.exe</td>
<td>Process that extracts text and metadata from the documents that the connector downloaded.</td>
</tr>
<tr>
<td>KeyView</td>
<td>KVoop.exe</td>
<td>The KeyView process does the text extraction and metadata extraction from known document types.</td>
</tr>
<tr>
<td>Binslave</td>
<td>BinSlave.exe</td>
<td>Process that attempts to extract text from unknown document types.</td>
</tr>
</tbody>
</table>

Scanner installation directory structure

Table 64-4 describes the directory structure for Network Discover scanner configuration files.
### Table 64-4  Installation directory structure

<table>
<thead>
<tr>
<th>Path</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/scanner_typeScanner</td>
<td></td>
</tr>
<tr>
<td>......../bin</td>
<td>Files to run the scanner, start, and stop it.</td>
</tr>
<tr>
<td>........../Clean.exe</td>
<td>Cleans all temp files and logs under the /scanner directory.</td>
</tr>
<tr>
<td>........../EncryptPassword.exe</td>
<td>Can be used to encrypt the user names and passwords that are put in the scanner_typeScanner.cfg file.</td>
</tr>
<tr>
<td>........../scanner_typeScanner_Console.exe</td>
<td>Launches the scanner as a console application (with a window). Type CTRL+C to stop the scanner.</td>
</tr>
<tr>
<td>........../scanner_typeScanner_Service.exe</td>
<td>Launches the scanner as an application without a window. Typically, this launch is only used when the scanner is registered and run as a Windows or UNIX service.</td>
</tr>
<tr>
<td>....../config</td>
<td>Configuration files are in this directory.</td>
</tr>
<tr>
<td>........../ScannerController.properties</td>
<td>Configuration file for the ScannerController.</td>
</tr>
<tr>
<td>........../ScannerControllerLogging.properties</td>
<td>Properties file for the Scanner logging.</td>
</tr>
<tr>
<td>........../scanner_typeScanner.cfg</td>
<td>The configuration file for the connector. This file is copied to the /scanner directory before the child process is launched.</td>
</tr>
<tr>
<td>....../logs</td>
<td>Contains the log files for the ScannerController process.</td>
</tr>
<tr>
<td>....../outgoing</td>
<td>XML files that contain content and metadata are queued in this folder before they are sent to the Network Discover Server.</td>
</tr>
<tr>
<td>....../scanner</td>
<td>Binaries, the log files, and the temp files are under this directory.</td>
</tr>
</tbody>
</table>
Table 64-4  Installation directory structure (continued)

<table>
<thead>
<tr>
<th>Path</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>........../outgoing</td>
<td>Some connectors (for example Exchange and SharePoint2003) cannot be configured to write the .idx files to the ../outgoing folder. Instead, they write them to ./scanner/outgoing folder and the ScannerController moves them to the ../outgoing directory so that they can be sent to the Network Discover Server.</td>
</tr>
<tr>
<td>........../failed</td>
<td>If the Network Discover Server cannot parse the XML and returns a 500 error code, the ScannerController moves the offending XML document to the ../failed folder.</td>
</tr>
</tbody>
</table>

Scanner configuration files

Configuration options can be edited after installation and before you start a scan by editing the following files on the scanner system.

<table>
<thead>
<tr>
<th>File name</th>
<th>Configuration Tasks</th>
</tr>
</thead>
</table>
| ScannerController.properties | In the ScannerController.properties file, you can configure the following options:  
  ■ Define Network Discover Server connection information.  
  ■ Provide content compression to reduce network load.  
  ■ Turn on and off incremental scanning. Additional configuration may be required in the Vontusscanner_typeScanner.cfg file.  
  
See “Scanner controller configuration options” on page 1312. |
Scanner controller configuration options

Initial scanner configuration occurs during installation. Following installation, you can modify or specify additional scan settings.

**Table 64-5** provides an explanation of commonly modified parameters in the **ScannerController.properties** file.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>discover.host</td>
<td>localhost</td>
<td>The host name or IP address of the Network Discover Server the scanner routes content to. Before you configure this value, the Network Discover Server should be added to the Enforce Server, and access to it from the scanner verified.</td>
</tr>
<tr>
<td>discover.port</td>
<td>8090</td>
<td>The Network Discover port to which the scanner routes data.</td>
</tr>
<tr>
<td>discover.compress</td>
<td>true</td>
<td>Specify whether or not to compress content before routing it to the Network Discover Server. Compression reduces network load, but consumes extra CPU on the scanner computer and on the Network Discover Server.</td>
</tr>
</tbody>
</table>
Table 64-5  Commonly modified parameters in ScannerController.properties
(continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>discover.retry.interval</td>
<td>1000</td>
<td>Milliseconds the scanner should wait before it retries to connect to the Network Discover Server after a disconnect or previous failure.</td>
</tr>
<tr>
<td>scanner.send.endofscanmarker</td>
<td>true</td>
<td>If this parameter is set to false, the scanner runs until it is stopped manually in the Enforce Server console. The scan restarts from the beginning after it reaches the end of the scan list.</td>
</tr>
<tr>
<td>scanner.incremental</td>
<td>false</td>
<td>When true, the scanner only scans documents with created or modified dates after the last complete scan. When false, all files are scanned each time the scan is run.</td>
</tr>
</tbody>
</table>
| dre.fake.port          | disabled | Used only by certain scanners to prevent content from being misdirected to an incorrect process. Must also be modified with values for DREHost and ACIPort in the scanner_typeScanner.cfg file.  
  The dre.fake.port specifies the port that the ScannerController binds to. It makes sure that the connector does not attempt to send content to some other process. |
| queue.folder.path      | disabled | Used only for certain scanners to bridge a difference in location between where .idx files are written and where they are expected. This parameter is for the Exchange and SharePoint 2003 scanners. |
Setting up scanning of file systems

This chapter includes the following topics:

- Setting up remote scanning of file systems
- Supported file system scanner targets
- Installing file system scanners
- Starting file system scans
- Installing file system scanners silently from the command line
- Configuration options for file system scanners
- Example configuration for scanning the C drive on a Windows computer
- Example configuration for scanning the /usr directory on UNIX
- Example configuration for scanning with include filters
- Example configuration for scanning with exclude filters
- Example configuration for scanning with include and exclude filters
- Example configuration for scanning with date filtering
- Example configuration for scanning with file size filtering
- Example configuration for scanning that skips symbolic links on UNIX systems
Setting up remote scanning of file systems

Scanning the file systems that are not file shares or servers is accomplished with a multiple computer installation. On the computer with the file system, scanning software sends data to the Network Discover Server for processing.

See “How Network Discover scanners work” on page 1306.

For file shares, use the server file system target.

See “Setting up server scans of file systems” on page 1241.

To set up scanning of file systems, complete the following process:

Table 65-1 Setting up a file system scanner

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Verify that your file system is on the list of supported targets. The file system scanner can scan local file systems on remote Windows, Linux, AIX, and Solaris servers.</td>
<td>See “Supported file system scanner targets” on page 1316.</td>
</tr>
<tr>
<td>2</td>
<td>On the server that contains the file system, install the file system scanner. The setup for scanning file systems requires installation of the scanner software on the computer where the file system is located. On Linux, AIX, and Solaris, the root user must install the scanner.</td>
<td>See “Installing file system scanners” on page 1316. See “Installing file system scanners silently from the command line” on page 1320.</td>
</tr>
<tr>
<td>3</td>
<td>Perform any manual configurations by editing the configuration files and properties files.</td>
<td>See “Configuration options for file system scanners” on page 1321.</td>
</tr>
<tr>
<td>5</td>
<td>Start the file system scan. Start the scanner on the scanner computer, and also start the scan on the Enforce Server.</td>
<td>See “Starting file system scans” on page 1319.</td>
</tr>
<tr>
<td>6</td>
<td>Verify that the scan is running successfully.</td>
<td>See “Troubleshooting scanners” on page 1307.</td>
</tr>
</tbody>
</table>
Supported file system scanner targets

The following remote Windows systems can be scanned:

- Windows Server 2008
- Windows Server 2012

The following Linux file systems can be scanned:

- Red Hat Enterprise Linux 5.x
- Red Hat Enterprise Linux 6.x

The following AIX file systems can be scanned:

- AIX 5.3
- AIX 6.1

AIX requires the following C run time libraries, as well as Java 1.5 and Java 7 JRE:

- \texttt{xlC.aix50.rte (v8.0.0.0+)}
- \texttt{xlC.rte (v8.0.0.0+)}

The following 32-bit Solaris file systems can be scanned (64-bit systems are not supported):

- Solaris 9 (SPARC platform)
- Solaris 10 (SPARC platform)

Solaris requires the following patch levels for the scanner:

- Solaris 9, 115697-01

File systems on UNIX systems can also be scanned using the SFTP protocol. This protocol provides a method similar to share-based file scanning, instead of using the File System Scanner. Contact Symantec Professional Services for details.

Installing file system scanners

The File System Scanner must be installed on the computer with the file system you want to scan.

On Linux, AIX, and Solaris, the root user must install the scanner.

If a user other than the one who installed the scanner wants to run it, permissions must be changed. On Linux, AIX, and Solaris, appropriate permissions must be given to the directories and files.
To install the file system scanner

1  On the computer with the file system to scan, download or copy (as binary) the relevant installation file to a temporary directory. The file is located in the DLP_Home\Symantec_DLP_12_Win\Scanners or DLP_Home/Symantec_DLP_12_Lin/Scanners directory, where DLP_Home is the name of the directory in which you unzipped the Symantec Data Loss Prevention software.

The file is one of the following file names:

- SymantecDLPScanners_windows_x32_12.5.exe
- SymantecDLPScanners_Aix_12.5.sh
- SymantecDLPScanners_Unix_x32_12.5.sh (for 32-bit Linux systems)
- SymantecDLPScanners_Unix_x64_12.5.sh (for 64-bit Linux systems)

Note: You can install either the 32-bit or 64-bit scanner on 64-bit Linux systems. We recommend the 64-bit version.

- SymantecDLPScanners_Solaris_12.5.sh

2  Start the scanner installation program.

Use the -c flag to install a scanner with a console command (rather than with a GUI).

Windows GUI:

SymantecDLPScanners_windows_x32_12.5.exe

32-bit Linux GUI:

./SymantecDLPScanners_Unix_x32_12.5.sh

32-bit Linux console:

./SymantecDLPScanners_Unix_x32_12.5.sh -c

3  If applicable, confirm the version of the scanner you want to install (32-bit or 64-bit).

4  Confirm the license agreement.

5  Select File System Scanner.

6  Select the installation Destination Directory (the directory where you want the SymantecDLP File System Scanner installed).
7 For Windows, select the Start Menu Folder (shortcut in the Start menu). The default is SymantecDLP FileSystem Scanner.

8 Enter the following connection information for the Network Discover Server:
   - Discover Host (IP or host name of the Network Discover Server)
   - Discover Port

9 Configure the File System Scanner by entering the following information:
   - Scan Directory
     List of directories to scan. Delimit with a comma (no space).
   - Path Include Filter
     Only the paths that include all the string(s) specified here are scanned. Delimit with a comma (no space).
   - Path Exclude Filter
     Everything but the directories that contain the string(s) specified here are scanned. Delimit entries with a comma, but do not use any spaces.
     Note that the Include Filter and Exclude Filter file names are relative to the file system root. Specify full paths or subdirectories, as needed.

10 The scanner installs.

11 Select the Startup Mode.

   While you initially test or verify that the scanner runs successfully, do not select either of these options, but start the scanner manually.

   You can select one (or none) of the following options:
   - Install as a service on a Windows system.
   - Start after installation.

12 The File Scanner installation is complete on the scanner computer.

13 Perform any manual configurations by editing the configuration files and properties files.

   See “Configuration options for file system scanners” on page 1321.

   See “Scanner installation directory structure” on page 1309.

   See “Scanner configuration files” on page 1311.

14 On the Enforce Server, create a New Target for the scanner File System type.

15 Start the scan on both the scanner computer and the Enforce Server.

   See “Starting file system scans” on page 1319.
Starting file system scans

Make sure that the scanner is installed and configured on the target computer, and a new target is added on the Enforce Server.

See “Installing file system scanners” on page 1316.

Then, you can start the scan.

The procedures are different for each of the following scenarios:

- One scanner per target (first procedure).
- Multiple scanners for one target (second procedure).

To start a file system scan with one scanner for one target

1. Log on to the Enforce Server.
   - Go to Manage > Discover Scanning > Discover Targets to navigate to the list of targets.

2. Select the scan target from the target list, then click the Start icon.

3. On the scanner computer, start the File System scanner.
   - On UNIX, enter the following command:

   `/opt/FileSystemScanner/bin/FileSystemScanner_Console`

4. The scanner starts the process of scanning data.
   - See “How Network Discover scanners work” on page 1306.

5. If the scan does not progress normally, you can troubleshoot it.
   - See “Troubleshooting scanners” on page 1307.

6. Stop and restart the scanner whenever you make changes to the configuration file. To stop the scanner, type the control-C character in the console window.
To start a file system scan with multiple scanners for one target

1 On each of the scanner computers, start the File System scanner on that computer.


   On UNIX, enter the following command:

   /opt/FileSystemScanner/bin/FileSystemScanner_Console

   Make sure that each of the scanners has started, and has posted information.
   Check the outgoing folder on each of the computers.

   See “Scanner installation directory structure” on page 1309.

2 Log on to the Enforce Server.

   Go to Manage > Discover Scanning > Discover Targets to navigate to the list of targets.

3 Select the scan target from the target list, then click the Start icon.

4 The scanner starts the process of scanning data.

   See “How Network Discover scanners work” on page 1306.

5 If the scan does not progress normally, you can troubleshoot it.

   See “Troubleshooting scanners” on page 1307.

6 Stop and restart the scanner whenever you make changes to the configuration file. To stop the scanner, type the control-C character in the console window.

Installing file system scanners silently from the command line

To automate installation, you can preconfigure a text file varfile with your installation choices, and then launch the installation from a command line.

Another method of installing a scanner is with an interactive installation.

See “Installing file system scanners” on page 1316.
To automate file scanner installation

1. Create a text file, for example `FileSystemScanner.varfile`.
2. Enter your specific parameters, and save the file to the same location as the relevant shell script for your scanner installation.

```
sys.programGroup.allUsers$Boolean=true
discover.host=test-server.test.lab
discover.port=8090
sys.service.selected.417$Boolean=true
job.0.excludeFilters=
sys.languageId=en
sys.programGroup.linkDir=/usr/local/bin
installService$Boolean=false
sys.installationDir=/opt/FileSystemScanner
sys.programGroup.enabled$Boolean=true
job.0.includeFilters=
job.0.directory=/home/text_files/text_scan/text
sys.service.startupType.417=auto
startAfterInstall$Boolean=false
```

3. To run the installation with the `varfile`, type the following command (for Linux):

```
# ./FileSystemScanner_Unix_11.6.sh
-varfile FileSystemScanner.varfile -q
```

The parameter `-q` performs a silent installation.

### Configuration options for file system scanners

Table 65-2 provides a description of the primary parameters in the `VontuFileSystemScanner.cfg` file.

<table>
<thead>
<tr>
<th>Type</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scanned Content</td>
<td>DirectoryPathCSVs</td>
<td>Comma-separated list of directories to scan.</td>
</tr>
<tr>
<td>Scanned Content</td>
<td>DirectoryCantHaveCSVs</td>
<td>Exclude filters of the paths. Delimit entries with a comma, but do not use any spaces.</td>
</tr>
</tbody>
</table>
Table 65-2 Parameters in the VontuFileSystemScanner.cfg file (continued)

<table>
<thead>
<tr>
<th>Type</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scanned Content</td>
<td>DirectoryMustHaveCSVs</td>
<td>Include filters of the paths. Delimit entries with a comma, but do not use any spaces.</td>
</tr>
<tr>
<td>Scanned Content</td>
<td>DirectoryAfterDate</td>
<td>Date filter (in days relative to today).</td>
</tr>
<tr>
<td>Scanned Content</td>
<td>DirectoryBeforeDate</td>
<td>Date filter (in days relative to today).</td>
</tr>
</tbody>
</table>
| Scanned Content| DirectoryFileMatch         | For scanning files without an extension on Solaris or Linux systems, set this parameter to the following value:  
                        | DirectoryFileMatch=*                                                      |
| Scanned Content| ImportPreImportMinLength   | Minimum size of files.                                                     |
| Scanned Content| ImportPreImportMaxLength   | Maximum size of files.                                                     |
| Throttling     | ImportPoliteness           | Specify the amount of time (in milliseconds) that the import module should wait between documents. |
| Throttling     | PollingMaxNumber           | The number of files that are aggregated before they are imported into each XML file that is sent to Network Discover.  
                        | See “Optimizing resources with Network Discover scan throttling” on page 1204. |

Example configuration for scanning the C drive on a Windows computer

Scan the C drive on a Windows computer.  
This configuration is in the file VontuFileSystemScanner.cfg.  
See “Configuration options for file system scanners” on page 1321.
Example configuration for scanning the /usr directory on UNIX

Scan the /usr directory on a UNIX computer.
This configuration is in the file `VontuFileSystemScanner.cfg`.
See “Configuration options for file system scanners” on page 1321.

```plaintext
DirectoryPathCSVs=/usr
DirectoryMustHaveCSVs=
DirectoryCantHaveCSVs=
```

Example configuration for scanning with include filters

Scan selected files and directories using the include filters.
This configuration is in the file `VontuFileSystemScanner.cfg`.
See “Configuration options for file system scanners” on page 1321.
Include only the files that have `temp` in the path under the directory `C:\Windows`.

```plaintext
DirectoryPathCSVs=C:\Windows
DirectoryMustHaveCSVs=*/temp/*
DirectoryCantHaveCSVs=
```

Include only the files that end with extension `tmp` or the directory name has `xml` in the path.

```plaintext
DirectoryPathCSVs=C:\Windows
DirectoryMustHaveCSVs=*/xml/*,*.tmp
DirectoryCantHaveCSVs=
```

Include only the files that end with the extension `txt` under the UNIX directory `/home/data`.

```plaintext
DirectoryPathCSVs=/home/data
DirectoryMustHaveCSVs=*.txt
DirectoryCantHaveCSVs=
```
Example configuration for scanning with exclude filters

Scan selected files and directories using the exclude filters.

This configuration is in the file VontuFileSystemScanner.cfg.

See “Configuration options for file system scanners” on page 1321.

Exclude all the files with extension .exe in the directory C:\Windows.

DirectoryPathCSVs=C:\Windows
DirectoryMustHaveCSVs=
DirectoryCantHaveCSVs=*.exe

Exclude all files that end with extension tmp or if the directory name contains bin under the UNIX directory /home/data.

DirectoryPathCSVs=/home/data
DirectoryMustHaveCSVs=
DirectoryCantHaveCSVs=*/bin/*,*.tmp

Example configuration for scanning with include and exclude filters

Scan selected files and directories using both the include and exclude filters.

This configuration is in the file VontuFileSystemScanner.cfg.

See “Configuration options for file system scanners” on page 1321.

Scan all directories with temp in the path or ending with pdf. Exclude files under the bin directory or ending with tmp under the directory C:\data.

DirectoryPathCSVs=C:\data
DirectoryMustHaveCSVs=*/temp/*,*.pdf
DirectoryCantHaveCSVs=*/bin/*,*.tmp

Example configuration for scanning with date filtering

The parameters DirectoryBeforeDate and DirectoryAfterDate let you specify a date range within which documents must be modified for the scanner to process them.
Use the parameter **DirectoryAfterDate** to enter a number of days relative to the current date after which the page must be modified. A negative number specifies a date in the past.

User the parameter **DirectoryBeforeDate** to enter a number of days relative to the current date before which the page must be modified.

In the examples, both **DirectoryBeforeDate** and **DirectoryAfterDate** are required.

This configuration is in the file `VontuFileSystemScanner.cfg`.

See “Configuration options for file system scanners” on page 1321.

Scan all the **pdf** files that have been modified in the last six months.

```
DirectoryMustHaveCSVs=*.pdf
DirectoryAfterDate=-180
DirectoryBeforeDate=0
```

Scan all files that have been modified between 60 days and 360 days in the past.

```
DirectoryAfterDate=-360
DirectoryBeforeDate=-60
```

Example configuration for scanning with file size filtering

Scan files using file size filtering to limit what is scanned.

This configuration is in the file `VontuFileSystemScanner.cfg`.

See “Configuration options for file system scanners” on page 1321.

Scan all the files in the size range of 3000 bytes to 4000 bytes. Do not import any files that fall outside the size range.

```
ImportPreImportMinLength=3000
ImportPreImportMaxLength=4000
ImportEmptyFiles=false
```

Scan all **doc** files greater than 4 KB.

```
DirectoryMustHaveCSVs=*.doc
ImportPreImportMinLength=4096
ImportEmptyFiles=false
```
Example configuration for scanning that skips symbolic links on UNIX systems

Scan a UNIX system, but skip all the symbolic links.

Specify a file which contains all the files that the scanner should scan. Only those files are scanned during the run. Place this file outside the scanner installation directory. In the example, this file is named /opt/test/filenames.txt.

This configuration is in the file VontuFileSystemScanner.cfg.

See “Configuration options for file system scanners” on page 1321.

Make sure that the DirectoryPathCSVs and related parameters are commented out. Also, make sure that the parameter PollingMethod is present only once in the configuration file.

PollingMethod=1
FilePollFilename=/opt/test/filenames.txt
Setting up remote scanning of Web servers

The Web server scanner can retrieve Web site documents.

The Web server scanner uses crawlers to find Web pages and to process the Web pages for content and links to other Web sites. After a crawler has finished retrieving documents from the Web site, the Web server scanner imports the content that the crawler has retrieved into index file format (IDX). The scanner then posts the IDX
files to Network Discover for content processing. The Web server scanner can retrieve content from various document types, including Web documents, Word, Excel, and PDF files.

The Web server scanner crawls Web pages for links and content. The crawler processes the page content and either accepts or rejects the page for retrieval. If the page is accepted, the crawler looks for links from the page, filters the links and queues the accepted links for the crawler process. If the page is rejected, the crawler looks for links only if you have configured it to follow links on rejected pages. The links are filtered before they are added to the crawler queue. The crawler then retrieves the page content of accepted pages. The crawler requests the next link in its queue, and the process repeats.

To set up scanning of Web servers, complete the following process:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The Web server scanner can scan Web sites. It has been tested with IIS and Apache Web servers.</td>
<td>See “Supported Web server (scanner) targets” on page 1328.</td>
</tr>
<tr>
<td>2</td>
<td>On the server with read access to the Web site, install the Web server scanner.</td>
<td>See “Installing Web server scanners” on page 1329.</td>
</tr>
<tr>
<td>3</td>
<td>Perform any manual configurations by editing the configuration files and properties files.</td>
<td>See “Configuration options for Web server scanners” on page 1332.</td>
</tr>
<tr>
<td>5</td>
<td>Start the file system scan. Start the scanner on the scanner computer, and also start the scan on the Enforce Server.</td>
<td>See “Starting Web server scans” on page 1331.</td>
</tr>
<tr>
<td>6</td>
<td>Verify that the scan is running successfully.</td>
<td>See “Troubleshooting scanners” on page 1307.</td>
</tr>
</tbody>
</table>

**Supported Web server (scanner) targets**

The Web server scanner supports scanning of a static HTTP Web site.
Installing Web server scanners

The Web server scanner must be installed on the computer that has access to the Web sites that you want to scan.

To install the Web server scanner

1 On the computer with the file system to scan, download or copy (as binary) the relevant installation file to a temporary directory. The file is located in the $DLP_{Home}$\Symantec_DLP_12_Win\Scanners or $DLP_{Home}$/Symantec_DLP_12_Lin/Scanners directory, where $DLP_{Home}$ is the name of the directory in which you unzipped the Symantec Data Loss Prevention software.

The file is one of the following file names:

- SymantecDLPScanners_windows_x32_12.5.exe
- SymantecDLPScanners_Unix_12.5_x32.sh (for 32-bit Linux systems)

2 Start the scanner installation program.

Use the -c flag to install a scanner with a console command (rather than with a GUI).

Windows GUI:

SymantecDLPScanners_windows_x32_12.5.exe

Linux GUI:

./SymantecDLPScanners_Unix_x32_12.5.sh

Linux console:

./SymantecDLPScanners_Unix_12.5.sh -c

3 Confirm the version of the scanner you want to install (32-bit or 64-bit).

4 Confirm the license agreement.

5 Select Web Server Scanner.

6 Select the installation Destination Directory (the directory where you want the Web server scanner installed).

Click Next.

7 Select the Start Menu Folder (shortcut in the Start menu). The default is Symantec DLP WebServer Scanner.

Click Next.
8 Enter the following connection information for the Network Discover Server:
   ■ Discover Host (IP or host name of the Network Discover Server)
   ■ Discover Port

Click Next.

9 Configure the Web server scanner by entering the following information:
   ■ Start URL
      Enter the URL where the scan starts.
   ■ Include Filter
      Only the paths that include all the strings specified here are scanned. Delimit entries with a comma, but do not use any spaces. Wildcards are supported.
   ■ Path Exclude Filter
      Everything but the paths that contain the strings specified here are scanned. Delimit entries with a comma, but do not use any spaces. Wildcards are supported.

Click Next.

10 The scanner installs.

11 Select the Startup Mode.
   While you initially test or verify that the scanner runs successfully, do not select either of these options, but start the scanner manually.
   You can select one (or none) of the following options:
      ■ Install as a service on a Windows system.
      ■ Start after installation.

Click Next.

Click Finish.

12 The Web server scanner installation is complete on the scanner computer.

13 Perform any manual configurations by editing the configuration files and properties files.
   See “Configuration options for Web server scanners” on page 1332.
   See “Scanner installation directory structure” on page 1309.
   See “Scanner configuration files” on page 1311.

14 On the Enforce Server, create a New Target for the scanner Web server type.

15 Start the scan on both the scanner computer and the Enforce Server.
   See “Starting Web server scans” on page 1331.
Starting Web server scans

Make sure that the scanner is installed and configured on the target computer, and a new target is added on the Enforce Server.

See "Installing Web server scanners" on page 1329.

Then, you can start the scan.

The procedures are different for each of the following scenarios:

- One scanner per target (first procedure).
- Multiple scanners for one target (second procedure).

To start a Web server scan with one scanner for one target

1. Log on to the Enforce Server.

   Go to Manage > Discover Scanning > Discover Targets to navigate to the list of targets.

2. Select the scan target from the target list, then click the Start icon.

3. On the scanner computer, start the Web server scanner.

   Click Start > Vontu WebServer Scanner > Vontu WebServer Scanner Console.

4. The scanner starts the process of scanning data.

   See "How Network Discover scanners work" on page 1306.

5. If the scan does not progress normally, you can troubleshoot it.

   See "Troubleshooting scanners" on page 1307.

6. Stop and restart the scanner whenever you make changes to the configuration file. To stop the scanner, type the control-C character in the console window.

To start a Web server scan with multiple scanners for one target

1. On each of the scanner computers, start the Web server scanner.

   Click Start > Vontu WebServer Scanner > Vontu WebServer Scanner Console.

   Make sure that each of the scanners has started, and has posted information.
   Check the outgoing folder on each of the computers.

   See “Scanner installation directory structure” on page 1309.

2. Log on to the Enforce Server.

   Go to Manage > Discover Scanning > Discover Targets to navigate to the list of targets.
3 Select the scan target from the target list, then click the Start icon.
4 The scanner starts the process of scanning data.
   See “How Network Discover scanners work” on page 1306.
5 If the scan does not progress normally, you can troubleshoot it.
   See “Troubleshooting scanners” on page 1307.
6 Stop and restart the scanner whenever you make changes to the configuration file. To stop the scanner, type the control-C character in the console window.

Configuration options for Web server scanners

Table 66-2 provides an explanation of the VontuWebServerScanner.cfg file.

Table 66-2 Parameters in the VontuWebServerScanner.cfg file

<table>
<thead>
<tr>
<th>Type</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scanned Content</td>
<td>URL</td>
<td>A valid URL at which the crawler starts. If you want more than one page to be retrieved, the starting Web page must contain links to other Web pages. You must include the initial http:// in the configuration parameter.</td>
</tr>
<tr>
<td>Scanned Content</td>
<td>NavDirAllowCSVs</td>
<td>The list with include filters for paths. This list contains the strings that the URL of a page must contain for the scanner to process the page. Use the parameter NavDirCheck to specify how and when the scanner checks for these strings. Use * for wildcard. Delimit entries with a comma, but do not use any spaces.</td>
</tr>
<tr>
<td>Scanned Content</td>
<td>NavDirDisallowCSVs</td>
<td>The list with exclude filters for paths. This list contains the strings that the URL of a page must not contain for the scanner to process the page. Use the parameter NavDirCheck to specify how and when the scanner checks for these strings. Use * for wildcard. Delimit entries with a comma, but do not use any spaces.</td>
</tr>
</tbody>
</table>
Table 66-2  Parameters in the VontuWebServerScanner.cfg file (continued)

<table>
<thead>
<tr>
<th>Type</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scanned Content</td>
<td>NavDirCheck</td>
<td>A bitwise mask number that is used to determine where and how the scanner checks for the <code>NavDirAllowCSVs</code> strings and <code>NavDirDisallowCSVs</code> strings. If the URL of a page does not contain one of the <code>NavDirAllowCSVs</code> strings or does contain one of the <code>NavDirDisallowCSVs</code> strings, the scanner does not process the page. See “Example of URL filtering for a Web site scan” on page 1336.</td>
</tr>
<tr>
<td>Scanned Content</td>
<td>Extensions</td>
<td>Enter file extensions to restrict the document types the scanner can crawler. To enter multiple extensions, separate them with commas. Use * for wildcard. No spaces before or after commas. Example to only fetch the documents that have .doc or .html as extensions: Extensions=<em>.doc,</em>.html*</td>
</tr>
<tr>
<td>Scanned Content</td>
<td>MaxLinksPerPage</td>
<td>The maximum number of links a page can have. Pages with many links are often navigation pages and this parameter can be used to filter them out.</td>
</tr>
<tr>
<td>Scanned Content</td>
<td>StayOnSite</td>
<td>You can configure the crawler to stay on the Web site on which it starts, or allow it to follow links to external Web sites in domains different from the starting Web site. By default, the crawler stays on the starting Web site domain.</td>
</tr>
<tr>
<td>Scanned Content</td>
<td>AfterDate</td>
<td>Number of days after which a page must be modified before it is saved. Enter the number of days relative to the current date. A negative number specifies a date in the past.</td>
</tr>
<tr>
<td>Scanned Content</td>
<td>BeforeDate</td>
<td>Number of days before which a page must be modified before it is saved. Enter the number of days relative to the current date. A negative number specifies a date in the past.</td>
</tr>
</tbody>
</table>
Table 66-2 Parameters in the VontuWebServerScanner.cfg file (continued)

<table>
<thead>
<tr>
<th>Type</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authentication</td>
<td>LoginMethod</td>
<td>The authentication method for the site. The value must be AUTHENTICATE, FORMPOST, or FORMGET. See “Example configuration for a Web site scan with basic authentication” on page 1335. See “Example configuration for a Web site scan with form-based authentication” on page 1336.</td>
</tr>
<tr>
<td>Authentication</td>
<td>LoginURL</td>
<td>The page that contains the logon form.</td>
</tr>
<tr>
<td>Authentication</td>
<td>LoginUserValue</td>
<td>The user name to use for authentication (plain text or encrypted).</td>
</tr>
<tr>
<td>Authentication</td>
<td>LoginPassValue</td>
<td>The password to use for authentication. Encrypt this password. See “Encrypting passwords in configuration files” on page 1197.</td>
</tr>
<tr>
<td>Authentication</td>
<td>LoginUserField</td>
<td>The name of the user name form field (for FORMPOST or FORMGET logon methods).</td>
</tr>
<tr>
<td>Authentication</td>
<td>LoginPassField</td>
<td>The name of the password form field (for FORMPOST or FORMGET logon methods). Encrypt this password. See “Encrypting passwords in configuration files” on page 1197.</td>
</tr>
<tr>
<td>Proxies</td>
<td>ProxyHost</td>
<td>The host name or IP address of the proxy server.</td>
</tr>
<tr>
<td>Proxies</td>
<td>ProxyPort</td>
<td>The port number of the proxy server.</td>
</tr>
<tr>
<td>Proxies</td>
<td>ProxyUsername</td>
<td>The user name (plain text or encrypted) for the proxy server.</td>
</tr>
<tr>
<td>Proxies</td>
<td>ProxyPassword</td>
<td>The password for the proxy server. Encrypt this password. See “Encrypting passwords in configuration files” on page 1197.</td>
</tr>
<tr>
<td>Throttling</td>
<td>PageDelay</td>
<td>Number of seconds between downloading a page and requesting the next page.</td>
</tr>
</tbody>
</table>
Example configuration for a Web site scan with no authentication

Scan a Web site with no authentication.

This configuration is in the file `VontuWebServerScanner.cfg`.

See “Configuration options for Web server scanners” on page 1332.

```plaintext
//##########################################################
//# Jobs
//##########################################################
URL=http://www.cnn.com
```

Example configuration for a Web site scan with basic authentication

Scan a Web site that is protected with standard authentication.

This configuration is in the file `VontuWebServerScanner.cfg`.

See “Configuration options for Web server scanners” on page 1332.

```plaintext
//##########################################################
//# Jobs
//##########################################################
URL=http://site.domain.com
LoginURL=http://domain.server.com/login.html
LoginMethod=AUTHENTICATE
LoginUserValue=some_user
LoginPassValue=9sfT8y8vw
```
Example configuration for a Web site scan with form-based authentication

Scan a Web site that is protected with form-based authentication.

This configuration is in the file VontuWebServerScanner.cfg.

See “Configuration options for Web server scanners” on page 1332.

```
//##########################################################
//# Jobs
//##########################################################
URL= http://wiki.symantec.corp/dashboard.action
LoginMethod=FORMPOST
LoginURL=http://wiki.symantec.corp/login.action
LoginUserField=os_username
LoginUserValue=some_user
LoginPassField=os_password
LoginPassValue=9sfIy8vw
```

Example configuration for a Web site scan with NTLM

Scan a Web site that is protected with NTLM.

Make sure the NTLMUsername is in the format of Domain\username.

This configuration is in the file VontuWebServerScanner.cfg.

See “Configuration options for Web server scanners” on page 1332.

```
//##########################################################
//# Jobs
//##########################################################
URL=http://some_site
NTLMUsername=Some_Domain\some_domain_user
NTLMPassword=9sfIy8vw
```

Example of URL filtering for a Web site scan

Use the parameter NavDirCheck to determine where and how the scanner checks for the NavDirAllowCSVs strings and NavDirDisallowCSVs strings.
Create the \texttt{NavDirCheck} number by adding together some of the following numbers:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL</td>
<td>1</td>
<td>You must enter 1 to enable the scanner to check whether the URL of a page contains any of the strings that are specified in the parameter \texttt{NavDirAllowCSVs} or \texttt{NavDirDisallowCSVs}.</td>
</tr>
<tr>
<td>Case insensitive</td>
<td>64</td>
<td>If you add 64 to the URL value, the scanner checks the URL of a page for a match for the strings that are specified in the parameter \texttt{NavDirAllowCSVs} or \texttt{NavDirDisallowCSVs}. This match is not case-sensitive.</td>
</tr>
<tr>
<td>Before download</td>
<td>128</td>
<td>If you add 128 to the URL value, the scanner checks whether the URL has any \texttt{NavDirAllowCSVs} or \texttt{NavDirDisallowCSVs} strings before the page is downloaded.</td>
</tr>
<tr>
<td>Valid site structure</td>
<td>512</td>
<td>If you add 512 to the URL value, the scanner rechecks the \texttt{NavDirAllowCSVs} and \texttt{NavDirDisallowCSVs} values for the site to ensure that the site is still valid before it updates it. If you do not include this setting, then changes to these values are never checked. If the site is not valid, it is not downloaded.</td>
</tr>
</tbody>
</table>

In the following example, the scanner checks the URLs for matches for the strings "archive" or "test." This match is not case-sensitive, and part of a word or a whole word is matched. If the URL contains one of these strings, the page is not processed.

\texttt{NavDirDisallowCSVs=archive*,test*}
\texttt{NavDirCheck=65}

In the following example, the scanner checks the URLs for matches for the strings "news" or "home." This match is not case-sensitive, and part of a word or a whole word is matched. If the URL does not contain one of these strings, the page is not processed.

\texttt{NavDirAllowCSVs=news*,home*}
\texttt{NavDirCheck=65}

**Example of date filtering for a Web site scan**

The following example retrieves the documents that were modified 365 days before the current date and 7 days after the current date.
AfterDate=-365
BeforeDate=7
Setting up scanning of Documentum repositories

This chapter includes the following topics:

- Setting up remote scanning of Documentum repositories
- Supported Documentum (scanner) targets
- Installing Documentum scanners
- Starting Documentum scans
- Configuration options for Documentum scanners
- Example configuration for scanning all documents in a Documentum repository

Setting up remote scanning of Documentum repositories

The Documentum scanner scans Documentum repositories.

To set up scanning of Documentum repositories, complete the following process:

Table 67-1 Setting up a Documentum scanner

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Verify that your Documentum repository is on the list of supported targets.</td>
<td>See “Supported Documentum (scanner) targets” on page 1340.</td>
</tr>
</tbody>
</table>
### Table 67-1  Setting up a Documentum scanner (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>The Documentum scanner can be installed on any computer that has network connectivity to the computer that hosts the Documentum Document Broker.</td>
<td>See “Installing Documentum scanners” on page 1340.</td>
</tr>
<tr>
<td>3</td>
<td>Perform any manual configurations by editing the configuration files and properties files.</td>
<td>See “Configuration options for Documentum scanners” on page 1344.</td>
</tr>
<tr>
<td>5</td>
<td>Start the Documentum scan.</td>
<td>See “Starting Documentum scans” on page 1343.</td>
</tr>
<tr>
<td>6</td>
<td>Verify that the scan is running successfully.</td>
<td>See “Troubleshooting scanners” on page 1307.</td>
</tr>
</tbody>
</table>

### Supported Documentum (scanner) targets

The Documentum scanner supports scanning a Documentum Content Server 5.3.x or 6.6.x repository.

### Installing Documentum scanners

The Documentum scanner can be installed on any computer that has network connectivity to the computer that hosts the Documentum Document Broker.
To install and deploy the Documentum scanner

1. On the computer that has network connectivity to the computer that hosts the Documentum Document Broker, download the installation file. Download or copy (as binary) the `SymantecDLPScanners_windows_x32_12.5.exe` file to a temporary directory. The file is located in the `DLP_Home\Symantec_DLP_12_Win\Scanners` where `DLP_Home` is the name of the directory in which you unzipped the Symantec Data Loss Prevention software.

2. Start the scanner installation program on this computer.

   `SymantecDLPScanners_windows_x32_12.5.exe`

   **Note:** This scanner should only be installed on 32-bit Windows servers.

3. Confirm the version of the scanner you want to install (32-bit).

4. Confirm the license agreement.

5. Select **Documentum Scanner**.

6. Select the installation Destination Directory, the folder where you want the Documentum Scanner to be installed.

   The default is `c:\Program Files\DocumentumScanner\`.

   Click **Next**.

7. Select the Start Menu Folder (shortcut in the **Start** menu).

   The default is **SymantecDLP Documentum Scanner**.

   Click **Next**.

8. Enter the following connection information for the Network Discover Server:
   - Discover Host (IP or host name of the Network Discover Server)
   - Discover Port

9. Click **Next**.
10 Enter the following Documentum configuration values for the scanner:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Doc Broker Host</td>
<td>The name of the server where the repository for the DocBase is stored.</td>
</tr>
<tr>
<td>Doc Base</td>
<td>The name of the repository you want the Documentum scanner to retrieve.</td>
</tr>
<tr>
<td>User Name</td>
<td>Specify an account with full access rights to the Documentum files you want to scan.</td>
</tr>
<tr>
<td>Password</td>
<td>Password for the account. This password is plain text in the configuration file.</td>
</tr>
<tr>
<td>WebTop Host</td>
<td>The host name of the Web interface to the Documentum content repository.</td>
</tr>
<tr>
<td>WebTop Port</td>
<td>The port number for the Web interface.</td>
</tr>
</tbody>
</table>

11 Click **Next**.

12 The scanner installs.

13 Select the Startup Mode.

While you initially test or verify that the scanner runs successfully, do not select either of these options, but start the scanner manually.

You can select one (or none) of the following options:

- Install as a service on a Windows system.
- Start after installation.

The default is to start the scanner manually.

14 The Documentum scanner installation is complete on the scanner computer.

15 Perform any manual configurations by editing the configuration files and properties files.

- See “Configuration options for Documentum scanners” on page 1344.
- See “Scanner installation directory structure” on page 1309.
- See “Scanner configuration files” on page 1311.

16 After installing the Documentum scanner, copy the dmc140.dll file from your Documentum installation bin directory, to the \DocumentumScanner\scanner folder in the scanner installation directory.

- See “Scanner installation directory structure” on page 1309.
On the Enforce Server, create a New Target for the scanner Documentum type.

Start the scan on both the scanner computer and the Enforce Server.

See “Starting Documentum scans” on page 1343.

Starting Documentum scans

Make sure that the scanner is installed and configured on the target computer, and a new target is added on the Enforce Server.

See “Installing Documentum scanners” on page 1340.

Then, you can start the scan.

The procedures are different for each of the following scenarios:

- One scanner per target (first procedure).
- Multiple scanners for one target (second procedure).

To start a Documentum scan with one scanner for one target

1 Log on to the Enforce Server.

   Go to Manage > Discover Scanning > Discover Targets to navigate to the list of targets.

2 Select the scan target from the target list, then click the Start icon.

3 On the scanner computer, start the Documentum scanner.

   Click Start > Vontu Documentum Scanner > Vontu Documentum Scanner Console.

4 The scanner starts the process of scanning data.

   See “How Network Discover scanners work” on page 1306.

5 If the scan does not progress normally, you can troubleshoot it.

   See “Troubleshooting scanners” on page 1307.

6 Stop and restart the scanner whenever you make changes to the configuration file. To stop the scanner, type the control-C character in the console window.
To start a Documentum scan with multiple scanners for one target

1. On each of the scanner computers, start the Documentum scanner.
   - Click Start > Vontu Documentum Scanner > Vontu Documentum Scanner Console.
   - Make sure that each of the scanners has started, and has posted information.
   - Check the outgoing folder on each of the computers.
   - See “Scanner installation directory structure” on page 1309.

2. Log on to the Enforce Server.
   - Go to Manage > Discover Scanning > Discover Targets to navigate to the list of targets.

3. Select the scan target from the target list, then click the Start icon.

4. The scanner starts the process of scanning data.
   - See “How Network Discover scanners work” on page 1306.

5. If the scan does not progress normally, you can troubleshoot it.
   - See “Troubleshooting scanners” on page 1307.

6. Stop and restart the scanner whenever you make changes to the configuration file. To stop the scanner, type the control-C character in the console window.

### Configuration options for Documentum scanners

Table 67-2 provides an explanation of the VontuDocumentumScanner.cfg file.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DocBase</td>
<td>The name of the repository you want Documentum to retrieve.</td>
</tr>
<tr>
<td>UserName</td>
<td>Specify an account with access rights to the Documentum files you want to scan.</td>
</tr>
<tr>
<td>Password</td>
<td>Password for the account that is specified in UserName. Encrypt this password. See “Encrypting passwords in configuration files” on page 1197.</td>
</tr>
</tbody>
</table>
### Table 67-2 Parameters in the VontuDocumentumScanner.cfg file (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
</table>
| ExtensionCSVs                    | List of file types to scan (Include Filter), for example:  

```
ExtensionCSVs=*.doc,*.htm,*.ppt,*.xls
```

Delimit with a comma (no space). |
| ImportRefReplaceWithCSVs         | Comma-separated list of one or two values that are used to construct the URL of the scanned documents.  

```
first_value,second_value
```

If the Documentum interface client is a Windows desktop or desktop client, then the first-value is concatenated to the left of the document-id. The second string is concatenated to the right, for example:  

```
first_valueocument_idsecond_value
```

If the Documentum Webtop (Web-based) interface is your client interface, only one value is necessary; for example:  

```
ImportRefReplaceWithCSVs=
```

```
http://documentum-server.mycompany.com:8080/webtop/component/drl?objectId=  
```
| AfterDate                        | A maximum age for documents to be scanned. For example, if you set AfterDate to five days, only documents that are no more than five days old are scanned. AfterDate looks at the last modified date.  

You can enter one of the following values:  

- N hours  
- N days  
- N weeks  
- N months  

The Documentum scanner does not support automatic incremental scanning, but you can manually perform incremental scans, by setting the AfterDate and BeforeDate parameters. |
Table 67-2  Parameters in the VontuDocumentumScanner.cfg file (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
</table>
| BeforeDate | An age parameter (in days, weeks, or months) for documents to be scanned. If you set BeforeDate to five days, only documents that are no more than five days old are scanned. AfterDate looks at the last modified date. You can enter one of the following values: 
N hours 
N days 
N weeks 
N months |
| FolderCSVs | The repository folders from which to fetch documents. All entries must begin with a slash but cannot consist of a slash alone. Leave the entry blank to specify all folders. Cabinets are treated as folders. For example: 
FolderCSVs=/support,/clients,/marketing,/finance |

Table 67-3 shows the host parameter in the dmcl.ini file.

[DOCBROKER_PRIMARY]
host = documentum-server.mycompany.com

During installation of the Symantec Data Loss Prevention scanner, the host parameter is set in the dmcl.ini file. If the Documentum Document Broker (server) later changes, this file must be edited to point to the new server.

Table 67-3  dmcl.ini file

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>host</td>
<td>The computer that hosts the Documentum Document Broker (server).</td>
</tr>
</tbody>
</table>

Example configuration for scanning all documents in a Documentum repository

Scan all documents in the repository.
The configuration is in the file VontuDocumentumScanner.cfg.
See “Configuration options for Documentum scanners” on page 1344.

[JOBS]
NUMBER=1
0=Job0
[Job0]
DocBase=Vontu_1
UserName=Administrator
Password=mypassword
ImportRefReplaceWithCSVs=
    http://documentum-server.mycompany.com:8080/webtop/component/drl?objectId=
LogFile = Job0.log
Setting up scanning of Livelink repositories

This chapter includes the following topics:

- Setting up remote scanning of Livelink repositories
- Supported Livelink scanner targets
- Creating an ODBC data source for SQL Server
- Installing Livelink scanners
- Starting Livelink scans
- Configuration options for Livelink scanners
- Example configuration for scanning a Livelink database

Setting up remote scanning of Livelink repositories

The Livelink scanner can scan a Livelink database.

To set up scanning of Livelink repositories, complete the following process:

Table 68-1  Setting up a Livelink scanner

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Verify that your Livelink repository is on the list of supported targets.</td>
<td>See “Supported Livelink scanner targets” on page 1349.</td>
</tr>
</tbody>
</table>
### Supported Livelink scanner targets

The Livelink scanner supports scanning of Livelink Server 9.x targets.

### Creating an ODBC data source for SQL Server

This procedure assumes that the Livelink database is an SQL Server database. If you have an Oracle Livelink database contact Symantec Data Loss Prevention support for specific instructions.

**To create an ODBC data source for SQL Server**

1. Go to **Control Panel > Administrative Tools > Data Sources (ODBC)**.
2. Click the **System DSN** tab.
3. Click **Add**.
4. Select **SQL Server**.
5. Give it a name (for example, “Livelink”). This name is referenced in the `VontuLiveLinkScanner.cfg` file.
6. Click **Next**.

---

**Table 68-1 Setting up a Livelink scanner (continued)**

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Perform any manual configurations by editing the configuration files and properties files.</td>
<td>See “Configuration options for Livelink scanners” on page 1354.</td>
</tr>
<tr>
<td>5</td>
<td>Start the Livelink scan. Start the scanner on the scanner computer, and also start the scan on the Enforce Server.</td>
<td>See “Starting Livelink scans” on page 1352.</td>
</tr>
<tr>
<td>6</td>
<td>Verify that the scan is running successfully.</td>
<td>See “Troubleshooting scanners” on page 1307.</td>
</tr>
</tbody>
</table>
7 Select **With SQL Server authentication using a login ID and password entered by the user.**

8 Check the option for **Connect to SQL Server** to obtain default settings for additional configuration options and enter the SQL Server credentials.

9 Click **Next**. Accept the defaults.

10 Click **Next**. Accept the defaults.

11 Click **Finish**.

## Installing Livelink scanners

Install the Livelink scanner on a computer that has access to the Livelink database.

### To install a Livelink scanner

1. Create an ODBC data source for SQL Server.
   
   See “Creating an ODBC data source for SQL Server” on page 1349.

2. On the computer that has access to the Livelink database, download the installation file. Download or copy (as binary) the `SymantecDLPScanners_windows_x32_12.5.exe` file to a temporary directory. The file is located in the `DLP_Home\Symantec_DLP_12_Win\Scanners` where `DLP_Home` is the name of the directory in which you unzipped the Symantec Data Loss Prevention software.

3. Start the scanner installation program on this computer.

   `SymantecDLPScanners_windows_x32_12.5.exe`

---

**Note:** This scanner should only be installed on 32-bit Windows servers.

4. Confirm the version of the scanner you want to install (32-bit).
5. Confirm the license agreement.
6. Select **Livelink Scanner**.
7. Select the installation **Destination Directory**, the folder where you want the Livelink Scanner to be installed.

   The **default is** `c:\Program Files\LivelinkScanner\`

   Click **Next**.
8 Select the Start Menu Folder (shortcut in the Start menu).
   The default is SymantecDLP Livelink Scanner.
   Click Next.

9 Enter the following connection information for the Network Discover Server:
   ■ Discover Host (IP or host name of the Network Discover Server)
   ■ Discover Port
   Click Next.

10 Enter the following Livelink configuration values for the scanner:

   LiveLink Host       The host name or IP address of the Livelink server.
   LiveLink Port       The HTTP port of the Livelink server.
   LiveLink User Name  The user name to use when you scan.
   LiveLink Password   The password to use when you scan.
                         Encrypt this password.
                         See "Encrypting passwords in configuration files" on page 1197.
   LiveLink Connection Name The Livelink API connection name. This name is the
                              dbconnection in the opentext.ini file on the Livelink
                              server.
   LiveLink API Port   This port should be 2099 unless it has been changed in the
                              opentext.ini file on the Livelink server. The default is
                              2099.
   ODBC DSN            The name of the ODBC data source on the computer running
                        the Livelink scanner.
   SQL User Name       User name to use to connect to the ODBC data source.
   SQL Password        Password to use to connect to the ODBC data source.
                         Encrypt this password.
                         See "Encrypting passwords in configuration files" on page 1197.

   Click Next.

11 The scanner installs.

12 Select the Startup Mode.

   While you initially test or verify that the scanner runs successfully, do not select
   either of these options, but start the scanner manually.
You can select one (or none) of the following options:

- Install as a service on a Windows system.
- Start after installation.

The default is to start the scanner manually.

13 The Livelink scanner installation is complete on the scanner computer.

14 Perform any manual configurations by editing the configuration files and properties files.

See “Configuration options for Livelink scanners” on page 1354.

See “Scanner installation directory structure” on page 1309.

See “Scanner configuration files” on page 1311.

15 Copy the following files from the Livelink installation to the `\LivelinkScanner\scanner` folder:

- LAPI_ATTRIBUTES.dll
- LAPI_BASE.dll
- LAPI_DOCUMENTS.dll
- LAPI_USERS.dll
- LLKERNEL.dll

16 Create an ODBC data source for the database instance that Livelink uses. This data source is referenced in the `VontuLivelinkScanner.cfg` file.

See “Creating an ODBC data source for SQL Server” on page 1349.

17 On the Enforce Server, create a New Target for the scanner Livelink type.

18 Start the scan on both the scanner computer and the Enforce Server.

See “Starting Livelink scans” on page 1352.

---

**Starting Livelink scans**

Make sure that the scanner is installed and configured on the target computer, and a new target is added on the Enforce Server.

See "Installing Livelink scanners" on page 1350.

Then, you can start the scan.

The procedures are different for each of the following scenarios:

- One scanner per target (first procedure).
Multiple scanners for one target (second procedure).

To start a Livelink scan with one scanner for one target

1. Log on to the Enforce Server.
   Go to Manage > Discover Scanning > Discover Targets to navigate to the list of targets.
2. Select the scan target from the target list, then click the Start icon.
3. On the scanner computer, start the Livelink scanner.
   Click Start > Vontu Livelink Scanner > Vontu Livelink Scanner Console.
4. The scanner starts the process of scanning data.
   See “How Network Discover scanners work” on page 1306.
5. If the scan does not progress normally, you can troubleshoot it.
   See “Troubleshooting scanners” on page 1307.
6. Stop and restart the scanner whenever you make changes to the configuration file. To stop the scanner, type the control-C character in the console window.

To start a Livelink scan with multiple scanners for one target

1. On each of the scanner computers, start the Livelink scanner.
   Click Start > Vontu Livelink Scanner > Vontu Livelink Scanner Console.
   Make sure that each of the scanners has started, and has posted information.
   Check the outgoing folder on each of the computers.
   See “Scanner installation directory structure” on page 1309.
2. Log on to the Enforce Server.
   Go to Manage > Discover Scanning > Discover Targets to navigate to the list of targets.
3. Select the scan target from the target list, then click the Start icon.
4. The scanner starts the process of scanning data.
   See “How Network Discover scanners work” on page 1306.
5. If the scan does not progress normally, you can troubleshoot it.
   See “Troubleshooting scanners” on page 1307.
6. Stop and restart the scanner whenever you make changes to the configuration file. To stop the scanner, type the control-C character in the console window.
## Configuration options for Livelink scanners

Table 68-2 provides an explanation of the VontuLiveLinkScanner.cfg file.

### Table 68-2 Parameters in the VontuLiveLinkScanner.cfg file

<table>
<thead>
<tr>
<th>Type</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connectivity</td>
<td>OpenTextServer</td>
<td>The host name or IP address of the Livelink server.</td>
</tr>
<tr>
<td>Connectivity</td>
<td>OpenTextPort</td>
<td>The HTTP port of the Livelink server.</td>
</tr>
<tr>
<td>Connectivity</td>
<td>OpenTextUsername</td>
<td>The user name to use when you scan.</td>
</tr>
<tr>
<td>Connectivity</td>
<td>OpenTextPassword</td>
<td>The password to use when you scan. Encrypt this password. See “Encrypting passwords in configuration files” on page 1197.</td>
</tr>
<tr>
<td>Connectivity</td>
<td>LLConnection</td>
<td>The Livelink API connection name. This parameter is the name of the dbconnection in the opentext.ini file on the Livelink server.</td>
</tr>
<tr>
<td>Connectivity</td>
<td>LLApiPort</td>
<td>This value should be 2099 unless it has been changed in the opentext.ini file on the Livelink server.</td>
</tr>
<tr>
<td>Connectivity</td>
<td>DSN</td>
<td>The name of the ODBC data source on the computer that runs the Livelink scanner.</td>
</tr>
<tr>
<td>Connectivity</td>
<td>SQLUserName</td>
<td>User name to use to connect to the ODBC data source.</td>
</tr>
<tr>
<td>Connectivity</td>
<td>SQLPassWord</td>
<td>Password to use to connect to the ODBC data source. Encrypt this password. See “Encrypting passwords in configuration files” on page 1197.</td>
</tr>
<tr>
<td>Throttling</td>
<td>BatchSize</td>
<td>The number of files that are aggregated before they are imported into each XML file that is sent to Network Discover. See “Optimizing resources with Network Discover scan throttling” on page 1204.</td>
</tr>
</tbody>
</table>
Example configuration for scanning a Livelink database

Scan everything in the Livelink database.

The configuration is in the file VontuLiveLinkScanner.cfg.

See “Configuration options for Livelink scanners” on page 1354.

```plaintext
//##########################################################
//# Jobs
//##########################################################

[JOBS]
Number=1
0=Job0

[Job0]
OpenTextServer=mydatabase-livelink.test.lab
OpenTextPort=80
OpenTextUsername=Admin
OpenTextPassword=livelink
LLConnection=LivelinkDB
LLApiPort=2099
DSN=livelink
SQLUserName=lldbuser
SQLPassWord=livelink
```
Setting up Web Services for custom scan targets

This chapter includes the following topics:

- Setting up Web Services for custom scan targets
- About setting up the Web Services Definition Language (WSDL)
- Example of a Web Services Java client
- Sample Java code for the Web Services example

Setting up Web Services for custom scan targets

The Web Services target type enables customers to write custom scanners. These custom scanners send content and metadata to Network Discover as Simple Object Access Protocol (SOAP) requests. The Network Discover Server becomes a Web Service host.

See “About setting up the Web Services Definition Language (WSDL)” on page 1357.

An example of a Java SOAP client is available.

See “Example of a Web Services Java client” on page 1357.

To set up custom Web Services for Network Discover, complete the following process:

Table 69-1  Setting up a custom scan target

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Add a Web Services target type.</td>
<td>See “Adding a new Network Discover target” on page 1187.</td>
</tr>
</tbody>
</table>
Table 69-1  Setting up a custom scan target (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| 2    | Start the scan.                                                       | Select the scan target from the target list, then click the Start icon.  
   |                                                          | See “Managing Network Discover target scans” on page 1209.                                                                              |
| 3    | Save and modify the WSDL, and create a client (such as a Java client), or SOAP request. | See “About setting up the Web Services Definition Language (WSDL)” on page 1357.  
   |                                                          | An example Java client is available.  
   |                                                          | See “Example of a Web Services Java client” on page 1357.                                                                                |
| 4    | Run the client, and verify the results.                               | See “Example of a Web Services Java client” on page 1357.                                                                                |

About setting up the Web Services Definition Language (WSDL)

The concrete Web Service Definition Language (WSDL) can be downloaded from the following URL when a Web Services target is running. The following port is the default. Enter the location of your Network Discover Server and port number.

http://discover_server:8090/?wsdl

See the online Help for a Web Services sample WSDL and for a Web Services sample SOAP request.

Example of a Web Services Java client

The following procedure and code provide an example of Web Services. This example sends content and metadata of all the files in a folder to the Network Discover Server.
To create and run a Web Services Java client

1. Log into the Enforce Server and create a Network Discover Web Services target type.

   See “Adding a new Network Discover target” on page 1187.

   Use the default settings. Note the scanner port number; the default is 8090.

2. Start the scan.

3. Browse to the following URL:

   http://discover_server:8090/?wsdl

   Save the page as a WSDL file named DiscoverSOAPTarget.wsdl in a folder (for example sample_folder).

   Edit the URL to replace port number 8090 if the scanner port number is different in step 1.

4. Install the Java Development Kit (JDK), if it is not available on your system.

5. Set the Java home to the folder where you installed the JDK.

   JAVA_HOME=jdk_install_dir

6. Install Apache CXF, an open source service framework.

   See http://cxf.apache.org/

7. Transform the WSDL to Java code.

   apache-cxf-install-dir\bin\wsdl2java
   -client sample_folder\DiscoverSOAPTarget.wsdl

   Java source files are automatically created under packages com.vontu.discover and com.vontu.wsdl.discoversoapTarget.

8. Edit a file named DiscoverSOAPClient.java in the sample_folder and insert the Java code. Place the new code at the beginning of this file. Change the constants as needed.

   See “Sample Java code for the Web Services example” on page 1359.

9. Compile the Java code with the following command:

   javac DiscoverSOAPClient.java
Run the program using the following command:

```
java DiscoverSOAPClient
```

On the Enforce Server, verify that the expected number of items are reported for the Network Discover target that is created in step 1.

Sample Java code for the Web Services example

Enter the following source code at the beginning of the file named `DiscoverSOAPClient.java`.

See “Example of a Web Services Java client” on page 1357.

```java
import javax.xml.datatype.DatatypeFactory;
import javax.xml.namespace.QName;
import java.io.ByteArrayOutputStream;
import java.io.File;
import java.io.FileInputStream;
import java.net.URL;
import java.util.Date;
import com.vontu.discover.ComponentContentType;
import com.vontu.discover.ComponentType;
import com.vontu.discover.DocumentType;
import com.vontu.discover.ProcessDocumentsType;
import com.vontu.wsdl.discoversoaptarget.DiscoverSOAPTargetPortType;
import com.vontu.wsdl.discoversoaptarget.DiscoverSOAPTargetService;
import com.sun.org.apache.xerces.internal.impl.dv.util.Base64;

public class DiscoverSOAPClient
{

    private static final QName SERVICE_NAME = new QName(
        "http://www.vontu.com/wsdl/DiscoverSOAPTarget.wsdl",
        "DiscoverSOAPTarget_Service");
    private static final String OWNER = "DiscoverSOAPClient";
    private static final String BODY = "This is the body";
    private static final String TYPE = "Text";
    private static final String ENCODING = "base64";

    //Change this value according to your needs
    private static final String TEST_FOLDER_NAME = "c:\\temp\\data";
```
private static final String WSDL_PATH = "http://localhost:8090/?wsdl";

public static void main(String[] args) {
    try {
        URL wsdl = new URL(WSDL_PATH);
        File folder = new File(TEST_FOLDER_NAME);
        DiscoverSOAPTargetService service = new DiscoverSOAPTargetService(wsdl, SERVICE_NAME);
        DiscoverSOAPTargetPortType client = service.getDiscoverPort();
        for (File file : folder.listFiles()) {
            if (file.isDirectory()) {
                // only files in the test folder are sent to Discover
                continue;
            }
            System.out.println(file);
            ProcessDocumentsType processDocumentsType = new ProcessDocumentsType();
            DocumentType documentType = new DocumentType();
            processDocumentsType.getDocument().add(documentType);
            documentType.setOwner(OWNER);
            documentType.setURI(file.toString());
            GregorianCalendar time = new GregorianCalendar();
            time.setTime(new Date(file.lastModified()));
            documentType.setLastModifiedDate(DatatypeFactory.newInstance().newXMLGregorianCalendar(time));
            // create a component
            ComponentType body = new ComponentType();
            documentType.setComponent(body);
            body.setName(file.getName());
            // add body
            ComponentContentType bodyContent =
new ComponentContentType();
body.setComponentContent(bodyContent);
bodyContent.setType(TYPE);
bodyContent.setContent(BODY);

ComponentType attachment = new ComponentType();
body.getComponent().add(attachment);
attachment.setName(file.getName());

//add some content to the component
ComponentContentType attachmentContent =
    new ComponentContentType();
attachment.setComponentContent(attachmentContent);
attachmentContent.setType(ENCODING);

ByteArrayOutputStream bytes =
    new ByteArrayOutputStream();
FileInputStream in = new FileInputStream(file);
byte[] buf = new byte[1024];

for(;;)
{
    int len = in.read(buf);
    if(len == -1)
    {
        break;
    }
    bytes.write(buf,0,len);
}

attachmentContent.setContent(
    Base64.encode(bytes.toByteArray()));

//make the SOAP call
client.processDocuments(processDocumentsType);

}catch(Exception e)
{
    
}
}
Discovering and preventing data loss on endpoints

- Chapter 70. Overview of Symantec Data Loss Prevention for endpoints
- Chapter 71. Using Endpoint Prevent
- Chapter 72. Using Endpoint Discover
- Chapter 73. Working with agent configurations
- Chapter 74. Working with Agent Groups
- Chapter 75. Managing Symantec DLP Agents
- Chapter 76. Using application monitoring
- Chapter 77. Working with Endpoint FlexResponse
- Chapter 78. Using Endpoint tools
Overview of Symantec Data Loss Prevention for endpoints

This chapter includes the following topics:

- About discovering and preventing data loss on endpoints
- About policies for endpoints

About discovering and preventing data loss on endpoints

Endpoint Discover and Endpoint Prevent are deployed using Symantec Data Loss Prevention agents and Endpoint Servers.

See “About Endpoint Prevent” on page 54. See “About Endpoint Discover” on page 54.

Endpoint Prevent and Endpoint Discover both apply Data Loss Prevention policies to protect your sensitive or at-risk data. Sensitive or at-risk data can include credit card numbers or names, addresses, and identification numbers. You can configure both of these products to recognize and protect the files that contain sensitive data.

See “How Endpoint Prevent works” on page 1367.

Endpoint Prevent stops sensitive data from moving off endpoints and supported virtual desktops. For example, Endpoint Prevent stops a file that contains credit card numbers from being transferred to eSATA, USB, or FireWire connected media. Endpoint Prevent stops sensitive the files from being transferred to network shares.
Also, Endpoint Prevent monitors and prevents data from being transferred over applications.

Endpoint Discover examines the local fixed drives of an endpoint and locates every file that contains the information that matches a policy. Endpoint Discover scans the endpoints to find the information that you have defined as at risk or sensitive.

See “How Endpoint Discover works” on page 1383.

You can configure agent settings, group agents, set response rules, check agent health, and troubleshoot agents.

### Table 70-1 Endpoint features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Additional information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent configuration</td>
<td>You can set detection types and detection locations. You can specify file filters and bandwidth limits. You set the agent configuration to best suite your implementation and data security requirements.</td>
<td>See “About agent configurations” on page 1405.</td>
</tr>
<tr>
<td>Agent groups</td>
<td>You use agent groups to send agent configurations to groups of agents.</td>
<td>See “About agent groups” on page 1443.</td>
</tr>
<tr>
<td>Agent health and management</td>
<td>You can review DLP Agent health and complete troubleshooting and management tasks.</td>
<td>See “About Symantec DLP Agent administration” on page 1457.</td>
</tr>
<tr>
<td>Application monitoring</td>
<td>You can configure this feature to monitor applications for CD/DVD burning, IM, email, or HTTP/S clients.</td>
<td>See “About monitoring applications” on page 1503.</td>
</tr>
<tr>
<td>FlexResponse</td>
<td>You can create response rules that automatically remediate incidents.</td>
<td>See “About Endpoint FlexResponse” on page 1512.</td>
</tr>
<tr>
<td>Endpoint tools</td>
<td>You use Endpoint tools to complete various maintenance tasks on the endpoint, like shutting down watchdog services, inspecting the agent database, and restarting Mac agents.</td>
<td>See “About Endpoint tools” on page 1523.</td>
</tr>
</tbody>
</table>
About policies for endpoints

Symantec Data Loss Prevention uses a two-tiered detection architecture to analyze activity on endpoints. Detection occurs either directly on DLP Agents or on the Endpoint Servers as required. Endpoint Servers can perform all types of detection, such as Exact Data Matching (EDM), Indexed Document Matching (IDM), and Directory Group Matching (DGM). Agents can perform Described Content Matching (DCM) and Indexed Document Matching (IDM). Symantec Data Loss Prevention can detect locally on keywords, regular expressions, and data identifiers. It must send input content to the Endpoint Server to detect on exact data fingerprints or indexed document fingerprints.

Note: Agents running on Mac endpoints can perform DCM detection.

Two-tiered detection has implications for the kinds of detection rules and response rules you can combine in a policy and use on endpoints. It also has implications for the optimization of system usage and performance of Symantec Data Loss Prevention on endpoints. As you create the policies that apply to endpoints, the following guidelines are recommended.

Do not create a policy that combines a server-side detection rule with an Endpoint Prevent response rule. For example, do not combine an EDM or DGM rule with an Endpoint Block or Endpoint Notify response rule. If a server-side detection rule triggers an Endpoint Prevent response rule, Symantec Data Loss Prevention cannot execute the Endpoint Prevent response rule, and the system displays an error message.

See “Author policies to limit the potential effect of two-tier detection” on page 364.

When creating an endpoint policy that includes a server-side detection rule, combine that detection rule with an agent-side detection rule in one compound rule. This practice helps Symantec Data Loss Prevention perform detection on the endpoint without sending the content to the Endpoint Server. Symantec Data Loss Prevention saves network bandwidth and improves performance by performing detection on the endpoint.

For example, you can couple an EDM detection rule with a keyword detection rule in one compound rule. In a compound rule, all conditions must be met before Symantec Data Loss Prevention registers a match. Conversely, if one condition is not met, Symantec Data Loss Prevention determines there is no match without having to check the second condition. For example, to register a match the content must meet the first condition AND all other conditions in the same rule. When you set up the compound rule in this way, the DLP Agent checks the input content against the agent-side rule first. If there is no match, Symantec Data Loss Prevention does not need to send the content to the Endpoint Server. However, if you create
a compound rule that involves a DCM or an EDM policy, the content is still sent to the Endpoint Server.

Before you combine a server-side detection rule (for example, an EDM rule) with an All: Limit Incident Data Retention response rule that retains original files for endpoint incidents, consider the bandwidth implications of retaining original files. When it sends data to an Endpoint Server for analysis, the DLP Agent sends either text data or binary data according to policy requirements. Whenever possible, DLP Agents send text to cut down on bandwidth use. By default, Symantec Data Loss Prevention discards original files for endpoint incidents. If a response rule retains original files for endpoint incidents, DLP Agents must send binary data to the Endpoint Server. In this case, make sure that your network can handle the increased traffic between DLP Agents and Endpoint Servers without degrading performance.

Combine agent-side detection rules (for example, DCM) with an Endpoint Prevent response rule in the same policy. Symantec Data Loss Prevention can execute an Endpoint Prevent response rule only when a DLP Agent detection rule triggers the response.

Table 70-2 lists detection and response rules that cannot be combined.

Table 70-2  Incompatible detection rules and response rules

<table>
<thead>
<tr>
<th>Do not combine these server-based detection rules...</th>
<th>...with these Endpoint Prevent response rules.</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Content Matches Exact Data (EDM)</td>
<td>• Endpoint: Block</td>
</tr>
<tr>
<td>• Sender/User Matches Directory (profiled DGM)</td>
<td>• Endpoint: Notify</td>
</tr>
<tr>
<td>• Recipient Matches Directory (profiled DGM)</td>
<td>• Endpoint: User Cancel</td>
</tr>
</tbody>
</table>

See “Workflow for implementing policies” on page 293.
Using Endpoint Prevent

This chapter includes the following topics:

■ How Endpoint Prevent works
■ About Endpoint Prevent monitoring
■ About policy creation for Endpoint Prevent
■ How to implement Endpoint Prevent

How Endpoint Prevent works

Endpoint Prevent policies detect and block confidential information moving from endpoints or virtual desktops in your organization. The Endpoint Server either pushes policies to Symantec DLP Agents or applies policies directly to files that are sent from the Symantec DLP Agents. Depending on the type of policy that you create, the policy is applied either by the Symantec DLP Agents directly or by the Endpoint Server. When Symantec DLP Agents or Endpoint Servers detect an activity that violates a policy rule, an incident is generated. You can review and remediate the incidents that display in the endpoint incident list.

**Note:** Policy groups that are assigned to an Endpoint Server apply equally to all connected agents.

Endpoint Prevent can detect violations at the endpoint in a variety of ways including:

■ Application monitoring
■ CD/DVD events
■ Clipboard events
■ eSATA events (writing to eSATA removable drives)
Network events (HTTP/HTTPS, instant messaging, email, FTP)
- Network share events (copying sensitive files to or from a network share)
- Print/fax events
- USB events (flash cards, SD cards)
See “About Endpoint Prevent monitoring” on page 1368.
See “About the DLP Agent store” on page 1414.
See “Workflow for implementing policies” on page 293.

About Endpoint Prevent monitoring

Endpoint Prevent can perform many different types of monitoring. The following table provides references to the types of monitoring you can select.

<table>
<thead>
<tr>
<th>Type of Monitoring</th>
</tr>
</thead>
<tbody>
<tr>
<td>About removable storage monitoring</td>
</tr>
<tr>
<td>About endpoint network monitoring</td>
</tr>
<tr>
<td>About CD/DVD monitoring</td>
</tr>
<tr>
<td>About print/fax monitoring</td>
</tr>
<tr>
<td>About network share monitoring</td>
</tr>
<tr>
<td>About clipboard monitoring</td>
</tr>
<tr>
<td>About application monitoring</td>
</tr>
<tr>
<td>About virtual desktop support with Endpoint Prevent</td>
</tr>
</tbody>
</table>

Endpoint Prevent monitors the activity on endpoints regardless if they are connected to an Endpoint Server. If an endpoint is disconnected from the network and cannot connect to an Endpoint Server, Endpoint Prevent continues to monitor the endpoint. All incidents are stored in the Agent Store until the endpoint is re-connected to the Endpoint Server. If the Agent Store exceeds the specified size limit, older files are ejected until the size limit is no longer exceeded. Endpoint Prevent does not stop monitoring the endpoint if the Agent Store exceeds the specified size limit.

See “About the DLP Agent store” on page 1414.
About removable storage monitoring

Endpoint Prevent lets you block data transferring from your hard drive to a removable media device. Removable media includes the following devices:

- Compact flash card
- eSATA removable drives
- FireWire connected device
- SD card
- USB flash drive

When the Symantec DLP Agent detects that an incident has occurred, the data is not transferred. An incident is created and sent to the Endpoint Server. When an incident occurs, the Symantec DLP Agent displays a pop-up notification to the user that informs the user that the incident has occurred. The notification also requires a justification for the file transfer. This justification appears in the incident snapshot.

See “Setting report preferences” on page 1008.

For example, User 1 copies a Microsoft Word file that contains medical records from an endpoint to a USB flash drive. The Symantec DLP Agent blocks this file from being transferred to the flash drive. When the file is blocked, a pop-up notification appears on the user’s screen, stating that the file transfer is in incident of a specific policy. The pop-up notification also contains a justification component that allows the users to justify moving the file to the flash drive. The justification that the user enters into the pop-up window is visible on the incident snapshot for this incident.

See “About Endpoint Prevent monitoring” on page 1368.

About endpoint network monitoring

Endpoint Prevent lets you monitor or block various types of network events. These events include the following:

- HTTP/HTTPS
- Email/SMTP
- FTP
- IM

Endpoint Prevent lets you block network violations regardless of whether the endpoint is connected to the corporate network or not. For example, a user takes a laptop out of the office and accesses a wireless Internet connection in a coffee shop. The Symantec DLP Agent can still detect, remove, or block any file, text, or
email from transferring over the unsecured network. Incidents that are generated when the endpoint is not connected to the Endpoint Server are stored in a temporary database. The incidents remain in the database until the connection is re-established. After the connection to the Endpoint Server is re-established, the incidents are sent to the Endpoint Server.

Symantec DLP Agents can monitor HTTP or HTTPS Web pages and applications. For example, it can monitor and prevent sensitive information from transferring through Microsoft Internet Explorer, Mozilla Firefox, or any other HTTP application. HTTPS monitoring lets you monitor or prevent any files from being transferred through an encrypted HTTPS site accessible through Internet Explorer or Firefox Web browsers. HTTP and HTTPS prevention also allow blocking of email messages and attachments from being transferred through Web email applications. Incidents include destination IP, URL, and message information.

Endpoint Prevent monitors the most common email applications, Microsoft Outlook, and Lotus Notes. It can monitor and prevent any information transferring from these applications regardless of the email protocol. Attachments as well as content in the subject, body, and footer of the message are analyzed. Incidents include information about the sender, recipient, and the email message.

FTP monitoring prevents files from transferring to an outside file repository over the FTP protocol. For example, a user attempts to send a file that violates a policy to a remote file repository using the FTP application Mozilla Filezilla. Endpoint Prevent prevents the file from transferring to the FTP location. An incident is created for the violation and appears in the Endpoint reporting section of the Enforce Server. The incident snapshot contains information about which users attempted to send the file through FTP. It displays the violating file as well as the IP address of the destination FTP server.

Instant messaging applications such as AIM, MSN, and Yahoo Messenger are monitored. IM monitoring analyzes outgoing messages both on an individual message basis as well as on a session basis. For example, if a user opens a chat session with another person through IM, Endpoint Prevent analyzes each message that the user sends for sensitive information. Each of these messages is analyzed individually. At the same time, Endpoint Prevent analyzes the entire conversation for the sensitive information that may not be apparent from the individual messages. IM messages and files can also be blocked. An IM incident contains information regarding sender, recipient, and the content of the session.

**Note:** Some network types do not match on the file name monitoring condition. These network events do not contain file names and so cannot match on this condition. The network monitoring types that cannot match the file name condition include HTTP/HTTPS, IM message body and text, and Outlook message body and text.
All incidents are reported under the Endpoint Prevent in the Reports section.

See “About Endpoint Prevent monitoring” on page 1368.

About CD/DVD monitoring

CD/DVD monitoring is compatible with all major CD/DVD burning applications that run on Windows Server 2003, XP, Vista, and Windows 7 32- and 64-bit operating systems.

Endpoint CD/DVD monitoring is designed to monitor specific file types. Performance filters are available in the agent configuration section. Use them to specify the file types that Endpoint Prevent monitors. You can also control the effect of the monitoring on the CD/DVD burning application.

To enable CD/DVD protection, you must select the CD/DVD toggle in the Agent Monitoring tab of the Endpoint Server configuration page. You can also create a policy for the files that are copied to a CD/DVD burner. Create a Protocol or Endpoint Destination rule with the CD/DVD as the destination. You must specify the content criteria for the policy. Policies can be created using AND/OR Boolean conditions. Specify the content criteria only using the AND condition in the policy builder.

For example, you want to create a policy that prevents files with the keyword Farallon from being burned to a DVD. Your DVD burning application is Roxio 9. Create a blank policy with a protocol or a device type rule. Select the CD/DVD device type and also match a Content Matches Keyword rule. Enter Farallon as the keyword. Finish creating the rule with an Endpoint Block response rule. After you save the policy, the Symantec DLP Agent blocks any file that contains the keyword Farallon from being burned to a DVD.

By selecting the CD/DVD device type, you have specified that the policy affects only files burned to a CD/DVD. Endpoint hard drives and USB connected media are not affected. By combining the device type and keyword match rules, you guarantee that Symantec DLP Agents block only files with the specified keyword. The agents do not block all of the files that are sent to the CD/DVD application. If you create the CD/DVD block rule without the conjoined keyword rule, the policy blocks every file that is sent to the burning application. Or, it would block the files that contain the keyword at the endpoint hard drive and USB connected media as well.

Note: Depending on the CD/DVD burning application you use, a file that contains confidential information is blocked or redacted. The redacted file contains no sensitive data. If the redacted file is written to the disk, that specific CD or DVD cannot be reused.
About print/fax monitoring

Endpoint Prevent lets you monitor and prevent sensitive information from being either printed or faxed. In Microsoft Windows, the mechanism for printing and faxing information is identical; therefore, the Endpoint Prevent mechanism is also identical. Endpoint Prevent can monitor print jobs started from within an application or using the native Print utility in Windows Explorer.

Endpoint Prevent analyzes each page of a file as it is sent to the printer or the fax machine. This means that the initial pages of the file may be printed or faxed if a violation is found in the middle of the file. For example, a user sends a 10-page document to a printer. If Endpoint Prevent finds a violation on page three it stops the print job. Pages one and two print but pages three through ten do not. Endpoint Prevent sends an incident to the Endpoint Server containing file information and the matching text.

Note: Endpoint Prevent does not monitor the text in the cover page of a fax.

The incident snapshot contains information regarding which endpoint sent the violating file, the violating file, and the printer name and the printer type. The printer type is a locally connected printer, a shared printer, or a network printer, or the user selected the Print to file option.

See “Setting report preferences” on page 1008.

See “About Endpoint Prevent monitoring” on page 1368.

About network share monitoring

Network share monitoring prevents users from moving sensitive files between a network share and an endpoint and from an endpoint to a network share. Any endpoint response rule is applicable to network share monitoring.

The Copy to Local Drive feature prevents users from moving sensitive data from a network drive to a local drive using Windows Explorer. For example, you have a local drive labeled c: drive and a remote network share labeled g: drive. You can create a policy that prevents users from moving sensitive data from the g: drive to the c: drive.
The Copy to Share feature prevents users from moving sensitive data from a local drive to a network share drive. You can create a policy that blocks sensitive data from being copied from the c: drive to the g: drive.

Endpoint Prevent prevents the sensitive data that transfers through Windows Explorer as well as through third-party applications, file browsers, and command line interfaces that use any of the following Windows network redirector services:

- LAN Manager (LanMan)
- Remote Desktop Protocol (RDP)
- Web Distributed Authoring and Versioning (WebDAV)

The Copy to Share feature monitors network shares like Windows shares, DFS, NAS, UNIX shares that are configured through Samba, Microsoft Remote Desktop shares, and WebDav shares that are accessed through a default WebDAV redirector.

This feature does not monitor types of network share access that do not use the RdpDr redirector services. These services include FTP transfers, third-party applications, save-as operations, command line utilities, or copy and paste applications. These other types of network file share access are monitored by using the Local Drive endpoint channel detection feature of Symantec Data Loss Prevention.

See “Configuring file filters” on page 1412.

See “About Endpoint Prevent monitoring” on page 1368.

### About clipboard monitoring

Endpoint Prevent stops users from copying and pasting sensitive data from one application to another by the Windows Clipboard. Endpoint Prevent does not prevent users from copying and pasting sensitive within the same application.

For example, if a user copies sensitive information from a Word document and pastes it in an IM message, Endpoint Prevent blocks the transfer. The blocking occurs because copy and paste functions use the Windows Clipboard. The user receives a pop-up notification that states the reason why the transfer was blocked. In the Endpoint Report, the incident snapshot contains an incident and the text of the information pasted into the email message. Incidents are created at the time of the cut or copy action, not at the paste action.

See “Setting report preferences” on page 1008.

See “About Endpoint Prevent monitoring” on page 1368.
About application monitoring

Application monitoring, which is available on the System > Agents > Application Monitoring screen, lets you monitor third-party applications for IM, email, or HTTP/S clients. By default, Symantec Data Loss Prevention only monitors applications such as AIM, Microsoft Outlook, or Mozilla Firefox. Examples of third-party applications include Skype, Mozilla Thunderbird, or Google Chrome. You can add applications using the Application Monitoring page.

Additionally, you can configure global changes to default applications. You can set Symantec Data Loss Prevention to monitor blacklist or whitelist items, CD/DVD applications, applications that use Clipboard functions, and applications that upload content to the Internet.

See “About monitoring applications” on page 1503.

About virtual desktop support with Endpoint Prevent

Endpoint Prevent can monitor virtual desktops and prevent remote users from copying sensitive data that is accessible through a virtual desktop. A Symantec DLP Agent can be installed in each virtual desktop. By running a DLP Agent in the virtual host, you can prevent a user from copying confidential data that is accessible from the hosted virtual desktop to a remote computer or device that may not be secure. You can configure Symantec DLP Agent to monitor storage volumes, print and fax requests, clipboards, and network activity on the virtual desktop.

Endpoint Prevent can monitor virtual desktops hosted by any of the following virtualization software:

- Microsoft Hyper-V virtualization server
- Microsoft Remote Desktop Services
- VMware View virtualization server

Endpoint Prevent can also be used to monitor virtual Windows desktops and Windows applications that are hosted through Citrix XenDesktop and Citrix XenApp/Application servers. Symantec supports deploying the Symantec DLP Agent software directly on Citrix XenApp/Application servers or Citrix XenDesktop virtual machines to prevent clients from extracting confidential data from Citrix published applications or desktops to the client computer. Symantec Data Loss Prevention provides this functionality by monitoring volumes, print/fax requests, clipboards, and network activity on the Citrix server to detect when confidential data would be sent to a client computer. A Symantec DLP Agent does not need to be installed on each individual Citrix client to support this functionality. A single Symantec DLP Agent monitors all of the Citrix clients. All Citrix clients that are...
protected by the agent monitor need to have a valid Endpoint Prevent license. The license is required whether a Symantec DLP Agent is installed on the client or not.

---

**Note:** All incidents that are generated on Citrix drives by the Symantec DLP Agent software appear as Removable Storage Device incidents. In the Enforce Server administration console, you cannot deselect the Removable Storage event for Citrix drives because this event is always monitored by agents that are deployed to Citrix servers.

---

See “How Endpoint Prevent works” on page 1367.

---

**About policy creation for Endpoint Prevent**

Endpoint Prevent policies execute DCM and VML conditions locally on the endpoint. An Endpoint Prevent policy contains a response rule that creates a real-time user interaction. The user interaction either blocks a file transfer or notifies the user of a policy violation. These notifications are then attached to the incident.

Endpoint policies also differ as to where the detection occurs. Detection for IDM, EDM, and DGM policies is performed on the Endpoint Server. Detection for DCM policies is performed directly by the Symantec DLP Agent.

The response rules Block, Notify, and User Cancel are performed only by the Symantec DLP Agent.

Because detection for IDM, EDM, and DGM policies is performed on the Endpoint Server, the detection takes more time and uses more bandwidth. Extra time and bandwidth are required because file contents are sent to the Endpoint Server for detection. When an agent performs detection for a DCM policy, it sends only incidents to the Endpoint Server.

See “About policies for endpoints” on page 1365.

See “Workflow for implementing policies” on page 293.

---

**About monitoring policies with response rules for Endpoint Servers**

Endpoint-specific response rules include Endpoint Block, Endpoint Notify, Endpoint Quarantine, and User Cancel. Endpoint Block stops the movement of data that violate policies. Endpoint Notify educates the user about the violation that has occurred, but does not block or stop movement of the data. Endpoint Quarantine moves a file with sensitive information from the local drive to a secure location. Endpoint Quarantine is only applicable for Endpoint Discover. User Cancel lets the endpoint user decide whether or not to allow the data to transfer. All rules create a pop-up display window that contains information about the violated policy. Each
rule requests that the user provide a justification for the action. Endpoint Block and Endpoint Notify, and User Cancel are applicable to all Endpoint Prevent detection policies that are performed on the endpoint. For example, HTTP/HTTPS, Email/STMP, FTP, CD/DVD, eSATA, Print/Fax, and USB monitoring all use Endpoint Block or Endpoint Notify rules.

The Endpoint Notify and Block and User Cancel response rules are not applicable to:

- Violations that are found through Endpoint Discover
- Violations on local drive monitoring

See “Workflow for implementing policies” on page 293.

**About Endpoint Block**

You can create a policy to restrict any data from transferring from the endpoint. For example, you want to stop any text, email, or file that contains the keyword *Farallon* from transferring from the computer. You can create a keyword match policy with the word *Farallon* as the violation keyword.

See “Workflow for implementing policies” on page 293.

You want to ensure that this policy is used across all endpoints. In the response rules section, select **Endpoint Block** as the response rule. This response rule is only applicable to the endpoint. If a file is transferred from the hard drive to a CD/DVD drive, a pop-up notification appears on that specific endpoint. The notification states that the action is in violation of the *Farallon* keyword policy.

The Endpoint Block response rule prevents the file from being moved. However, you also want to have a record of why the violation occurred. In the response rule, you can create a series of justifications. These justifications allow the endpoint user who committed the violation to explain why the violation occurred. These justifications can include user education, a manager-approved file move, or others.

**About Endpoint Notify**

You can create a policy and a response rule that educates endpoint users by using the Endpoint Notify response rule. The Endpoint Notify response rule displays a pop-up message describing the violation and educates the endpoint user on the appropriate policy.

For example, an endpoint user sends an email that contains the word *Farallon* in the body of the email. Endpoint Notify generates an incident that is sent to the Endpoint Server and displays a pop-up notification on the endpoint. The notification states the policy that was violated and that the endpoint action is now monitored. The endpoint user enters a reason for the violation, accepts the notification, and
the email proceeds normally. Endpoint Notify does not prevent data movement, it only notifies users of policy violations. The endpoint user’s justification for the violation becomes part of the incident report that is sent to the Enforce Server.

Not all policy groups and policies are applicable with Endpoint response rules. If you try to create a policy with incompatible rules and responses, you will receive an error message. The error states that the policy is incompatible with the Endpoint response rules.

Response rules can distinguish between those incidents that are created on the corporate network and those created off of the corporate network. This condition lets you specify whether the rule operates at all times or only when the endpoint is connected or disconnected from the corporate network.

About Endpoint User Cancel

You can create a response rule that lets endpoint users decide whether or not to allow sensitive data to transfer from their computers. You can use the User Cancel response rule to educate your endpoint users on proper business policies. For example, if an endpoint user sends sensitive information through email and receives the User Cancel popup notification, they can cancel the data transfer. They are now educated on your company's policies. Additionally, if there is a legitimate need for the endpoint user to transfer sensitive data, they can allow the action. If they allow the action, the data is transferred normally.

In both cases, the Symantec DLP Agent generates an incident that is sent to the Enforce Server.

Endpoint users are only allowed a specific amount of time to decide whether or not to override the policy. If the specified amount of time is exceeded, the policy automatically blocks the data transfer and generates an incident. By default, the time is limited to 60 seconds. That option is applied to all violations of that policy that occur in the following 10 seconds.

If multiple violations of the same policy are blocked, the endpoint user must only enter the justification once. The justification appears in the incident snapshot of the incident. The incident snapshot also contains the action that was taken. The incident snapshot contains one of the following actions:

- User Notified, Action: Allowed
- User notified, Action: Canceled
- User Notified, Action: Timeout Canceled
- User Notified, Action: Timeout Allowed
How to implement Endpoint Prevent

Endpoint Prevent monitors each endpoint for the data that is moved from one place to another. If Endpoint Prevent detects a violation, it blocks the data from being transferred. Endpoint Prevent notifies the user of the violation and can require a justification from the user. Implementing Endpoint Prevent requires that you complete the following processes in order.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>For more information</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Add an Endpoint Server.</td>
<td>See “Adding a detection server” on page 194.</td>
</tr>
<tr>
<td>2</td>
<td>Create endpoint agent configurations.</td>
<td>See “About agent configurations” on page 1405.</td>
</tr>
<tr>
<td>3</td>
<td>Set the endpoint location. This is an optional step.</td>
<td>See “Setting the endpoint location” on page 1378.</td>
</tr>
<tr>
<td>4</td>
<td>Install the Symantec DLP Agent.</td>
<td>For installation details, see the appropriate Symantec Data Loss Prevention Installation Guide.</td>
</tr>
<tr>
<td>5</td>
<td>Create an endpoint policy.</td>
<td>See “About policy creation for Endpoint Prevent” on page 1375.</td>
</tr>
<tr>
<td>6</td>
<td>Create endpoint response rules.</td>
<td>See “Response rules for endpoint detection” on page 877.</td>
</tr>
<tr>
<td>7</td>
<td>Configure reports.</td>
<td>See “About Symantec Data Loss Prevention reports” on page 1006.</td>
</tr>
</tbody>
</table>

See “Introducing synchronized Directory Group Matching (DGM)” on page 653.

Setting the endpoint location

The endpoint location is used to define how Symantec Data Loss Prevention determines whether or not the endpoint is connected to the corporate network. You can specify if you want the Endpoint Server to automatically detect if the endpoint
is on the corporate network. You can also enter domain names or IP addresses to use to manually determine if the endpoint is connected to the network.

Using the automatic method to determine endpoint location, Symantec Data Loss Prevention identifies the computer as on or off the corporate network based on the DLP Agent connection to the Endpoint Server.

The automatic endpoint location method is explained in the following list:

- **On the corporate network:**
  If the DLP Agent is connected to the Endpoint Server, Symantec Data Loss Prevention identifies the agent as on the corporate network. The DLP Agent connection to the Endpoint Server is transient, which means that the agent disconnects from the Endpoint Server after a prescribed period of time. During the transient connection period, Symantec Data Loss Prevention considers the agent as on the corporate network.

- **Off the corporate network:**
  This status means that the DLP Agent is disconnected from the Endpoint Server. The DLP agent may become disconnected ungracefully from the Endpoint Server. For example, an ungraceful disconnection occurs when the network interface that connects the agent to the Endpoint Server becomes disconnected. If the DLP Agent is disconnected ungracefully, Symantec Data Loss Prevention identifies the endpoint as off the corporate network.

See “About agent status” on page 1463.

---

**Note:** 12.0.x and earlier agents display connection status based on their constant connection to an Endpoint Server. If they become disconnected from the corporate network, **Disconnected** displays on the **Summary Reports for 12.0.x and Earlier Agents** screen. See “Using the Summary Reports for 12.0.x and Earlier Agents screen” on page 1473.

Using the manual method to determine endpoint location means that you must first input a range of domain names or IP addresses. Symantec Data Loss Prevention then uses this information to determine if the endpoint is connected to the corporate network. If a range of domain names is configured, the DLP Agent performs a reverse DNS lookup on the host IP address. It then matches the retrieved DNS host names with the configured domain names in the list. If a range of IP addresses is configured, the DLP Agent matches the host IP address against the list of configured IP addresses. Each individual host IP address must be on the corporate network for the endpoint to be considered connected to the corporate network.

Domain names must not contain wildcard characters and should be simple suffixes; for example, symantec.com.
IP addresses may contain wildcard characters in place of a single block. For example, 192.168.*.*.

See “About Endpoint Prevent monitoring” on page 1368.

To set the Endpoint Location setting

1. Go to System > Agents > Endpoint Location. The current endpoint location settings are displayed. By default, the endpoint location determination is set to Automatic.

2. Click Configure.

3. Select an item to configure how the Enforce Server determines endpoint location.
   - Select Automatically to let the Endpoint Server determine whether an agent is on or off the corporate network.

   **Note:** You must use automatic endpoint location to identify Mac endpoint locations. Manual endpoint location is not supported for DLP Agents running on Mac endpoints.

   - Select Manually and enter a list of domain names or IP addresses in the correct field. Enter only one domain name or IP address per line.

4. Click Save.

   The changes take effect after the agent reconnects to the Endpoint Server.

See “How to implement Endpoint Prevent” on page 1378.

See “Endpoint Server—basic configuration” on page 191.

About Endpoint Prevent response rules in different locales

You can create different endpoint response rule notifications that are specific to the locale of an endpoint. A locale refers to the system locale setting in the operating system of the endpoint.

For example, you create response rule notifications in English, French, or Japanese. If a user's locale is specified as Japanese, the Japanese-language version of the notification appears on the user's screen. If a different user with a French locale violates the same policy, the French-language version of the notification appears.

The Enforce Server lets you specify multiple user notifications. However, the first language that is specified is the default language. You cannot delete the default language response notification. You can add or delete any notification or language that is not specified as the default language. At installation, the default language is
set to whichever language is set as the Enforce Server language. If the language you want is unsupported, the Enforce Server tries to display the English-language notification.

For example, you have a Japanese-locale endpoint and a Vietnamese-locale endpoint. The Vietnamese locale is not a supported locale. If a violation occurs on the Japanese-locale computer, the Enforce Server displays the Japanese notification. If no Japanese notification is available, the Enforce Server displays the default-language notification. If the Vietnamese-locale computer violates a policy, the Enforce Server displays the English notification because no Vietnamese notification is possible. If the English notification is unavailable, the Enforce Server displays the default-language notification.

If the first language you add is not supported on the endpoint, that language cannot be considered the default language. The endpoint must contain the specific language details to consider a language as the default language. Although the text of the notification appears in the unsupported language, the notification window buttons and title bar appear in the default locale of the Enforce Server.

If you want to define an unsupported language as the default language, you must select Other as the first language. This Other label removes all other languages in the list. Use the Endpoint configuration options to modify the text of the pop-up window labels. You cannot specify other language responses if you select the Other option. The Other setting displays that language notification on every endpoint, regardless of the system locale of the endpoints.

See “Advanced agent settings” on page 1414.

Note: All English locales default to the English (United States) setting. All French locales default to the French setting. For example, the French (France) setting supports all types of French such as French (Canada) and French (France).

See “Setting Endpoint Prevent response rules for different locales” on page 1381.

Setting Endpoint Prevent response rules for different locales

You can set different response rules for different locales. The first locale that you designate becomes your default locale. You cannot delete this locale, although you can delete additional locals.

See “About Endpoint Prevent response rules in different locales” on page 1380.
Setting a localized response rule

1. Go to **Manage > Policies > Response Rules**.
   
   See “Configuring response rules” on page 891.

2. Create the response rule normally.

3. Click the **Add Language** link.

4. Select the language that you want to use.
   
   If you want to specify an unsupported language as the default language, select **Other**.

5. Enter text in the display fields and the justification fields using the designated language.

6. Click **Save**.
Using Endpoint Discover

This chapter includes the following topics:

- How Endpoint Discover works
- About Endpoint Discover scanning
- Preparing to set up Endpoint Discover
- Setting up and configuring Endpoint Discover
- Creating an Endpoint Discover scan
- Managing Endpoint Discover target scans

How Endpoint Discover works

Endpoint Discover lets you examine a local drive in your organization for any data that is a potential risk. Endpoint Discover notifies you when it finds a file that violates your policies and it identifies where the file is located on the endpoint system. Endpoint Discover can scan any local drive that is connected to the endpoint. It cannot scan CD/DVD drives or removable media devices such as eSATA drives, USB flash drives, or SD cards.

See “About Endpoint Discover scanning” on page 1383.

About Endpoint Discover scanning

Endpoint Discover scans the local drive of endpoints to find any currently existing files that violate your policies. Endpoint Discover scans all local drives on your endpoints. For example, if your computer has two physical local drives installed, Endpoint Discover scans both local drives for any files that violate your policies. Endpoint Discover does not scan those drives that are mounted through a network or removable media such as eSATA drives, flash drives, or SD cards.
The DLP Agent can only perform DCM scans locally for Endpoint Discover. For all other types of scans, the DLP Agent sends the text of the files to the Endpoint Server for analysis. Because the agent sends the files to the Endpoint Server, EDM detection must be done on the Endpoint Server, along with IDM if two-tier detection is enabled. See “Two-tier detection for DLP Agents” on page 309.

For example, you set up an Endpoint Discover scan to examine all of the local drives of all of your endpoints. The policy that is associated with the scan contains a DCM keyword condition as well as an EDM condition configured to match on credit card numbers. During the Endpoint Discover scan, the system automatically analyzes each file on the local drive for the keywords. If a policy matches a keyword, the content is sent to the Endpoint Server for EDM analysis.

To start or stop a scan that is configured for a single Endpoint Server, the DLP Agent must be connected to the Endpoint Server. If the DLP Agent is not connected to the Endpoint Server, the scan starts when it reconnects to the Endpoint Server. A scan is only complete when all of the endpoints have completed the scan. If one endpoint is disconnected from the Endpoint Server, the scan cannot complete until that endpoint reconnects or the scan times out. If an endpoint is disconnected after a scan has started, the endpoint continues the scan after it reconnects to the Endpoint Server. If the endpoint remains disconnected and exceeds a configured timeout period, the scan reports a timeout status.

An Endpoint Discover scan can be configured to include multiple Endpoint Servers. This feature lets you create one Endpoint Discover scan that includes a primary Endpoint Server and any backup Endpoint Servers that might be configured. Scans that include backup Endpoint Servers allow DLP Agents to be scanned if they connect to a backup Endpoint Server during an active scan. The ability to scan a DLP Agent when it connects to a backup Endpoint Server improves the ability of a scan to successfully complete. It also improves the performance of Endpoint Discover in a load-balanced environment.

All incidents are stored in the Agent Store until the computer is reconnected to the Endpoint Server. If the Agent Store exceeds the specified size limit, the scan waits until the Agent Store size is reduced. The scan waits until the endpoint reconnects to the Endpoint Server and the Agent Store is cleared.

See “About the DLP Agent store” on page 1414.

By default, the DLP Agent scans most of the files on the endpoint while the computer is active. Any file that requires a large amount of bandwidth to scan is not scanned until the endpoint is idle. By waiting until the endpoint is idle, the DLP Agent uses less CPU bandwidth while users are active on the computer. You can configure how the DLP Agent defines the endpoint as idle. You can configure the DLP Agent so that it does not scan the endpoint at all while the computer is active.
About targeted Endpoint Discover scans

You can use targeted Endpoint Discover scans to do the following:

- Define an Endpoint Discover scan that uses multiple Endpoint Servers to target endpoints.
- Define an Endpoint Discover scan that targets individual endpoints.
- Define an Endpoint Discover scan that uses filters to scan groups of endpoints, specific locations on endpoints, files of a specific size, and so on.

When the Endpoint Server begins the scan, the scan information is distributed to all of the associated DLP Agents. The DLP Agents analyze the scan with the scan filters.

**Note:** You cannot create Endpoint Discover scans that target Mac endpoints. However, you can create exclusion filters to scan specific files and locations on Mac endpoints. See “Using filters to scan Windows and Mac operating systems” on page 1399.

If a DLP Agent is excluded from the scan it sends a “Not participating” status to the Endpoint Server.

There can be only one Endpoint Discover scan running on an Endpoint Server at a time. If you exclude DLP Agents based on the scan filters, those DLP Agents cannot be scanned until the first scan is complete.

See “Creating an Endpoint Discover scan” on page 1389.

Preparing to set up Endpoint Discover

Before you begin setting up and configuring Endpoint Discover scans, you must complete prerequisite steps.

Table 72-1 lists the steps you must complete.
Table 72-1  Endpoint Discover prerequisite steps

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>More information</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Add an Endpoint Prevent Server if one is not already present or modify an existing one.</td>
<td>An Endpoint Prevent Server provides monitor, prevent, and scanning features for DLP Agents. See “Endpoint Server—basic configuration” on page 191.</td>
</tr>
<tr>
<td>2</td>
<td>Create a policy group.</td>
<td>See “Creating a policy group for Endpoint Discover” on page 1386.</td>
</tr>
<tr>
<td>3</td>
<td>Create a policy.</td>
<td>See “Creating a policy for Endpoint Discover” on page 1387.</td>
</tr>
<tr>
<td>4</td>
<td>Add a rule.</td>
<td>See “Adding a rule for Endpoint Discover” on page 1387.</td>
</tr>
</tbody>
</table>

See “Setting up and configuring Endpoint Discover” on page 1389.

Creating a policy group for Endpoint Discover

Creating a policy group for Endpoint Discover is exactly like creating a policy group for Network Discover. Instead of deploying these policy groups on different nodes in your system, the policy groups are deployed through the Symantec DLP Agents. After you have created the policy group, you can assign specific policies to the policy group.

To create a policy group

1  Go to **Administration > Settings > Policy Groups**.

2  On the **Policy Group List** screen that appears, click **Add Policy Group**.

3  Enter a policy-group name (of up to 256 characters) and a description. Choose an informative name because other users must access it when choosing which policy group(s) to associate with roles, policies, and Endpoint Discover targets.

4  Choose the detection server to assign to this policy group. This is an optional step.

   You can assign the policy group to all detection servers or to individual servers. Note that Symantec Data Loss Prevention automatically assigns all policy groups to all Endpoint Discover servers.

5  Click **Save**.

See “Setting up and configuring Endpoint Discover” on page 1389.
Creating a policy for Endpoint Discover

Symantec Data Loss Prevention uses two-tiered detection methods for Endpoint detection. Detection for Endpoint Discover occurs on the Endpoint Server and on the agent. The DLP Agent sends files to the Endpoint Server for analysis when two-tier detection is enabled. EDM and DGM policies are all performed on the Endpoint Server. The DLP Agent sends the opened files from the endpoint to the Endpoint Server for analysis.

See “About policies for endpoints” on page 1365.

You can set the status of the policy as either Active or Suspend. By default, policies are set to Active status. If you select Suspend, the policy is not applied to the DLP Agents.

The following instructions apply to creating a blank policy. You can also create policies based on pre-existing templates. The following instructions use sample data and specific instructions to illustrate how to create a policy.

To create a policy for Endpoint Discover

2. Click Add Policy, and click Next.
3. Select Add a blank policy.
4. Enter a name to identity the policy in the Name field.
5. Enter details about the policy in the Description field of the new policy.
6. Select the policy group you want associated with this policy from the drop-down menu.

After you create the policy, you must add rules to the policy.

See “Adding a rule for Endpoint Discover” on page 1387.

See “Setting up and configuring Endpoint Discover” on page 1389.

Adding a rule for Endpoint Discover

After you have created a policy for Endpoint Discover, you must add rules to the policy. You can add one or more rules to the policy. You must add at least one rule to the policy.

See “Creating a policy for Endpoint Discover” on page 1387.

To add a rule to a policy

1. Under the Detection tab, click Add Rule to add a rule for the policy.
2. Select the Content Matches Exact Data from radio option.
3 Select the policy you want to use in the drop-down menu. This procedure links the previously created list to the rule.

4 Click **Next**.

See “Setting up and configuring Endpoint Discover” on page 1389.

**About Endpoint Quarantine**

You can create an automated response rule that allows Endpoint Discover to remove files from a local drive and place them in a secure location. If an Endpoint Discover scan finds a file containing sensitive data, the file is quarantined and removed from the non-secure location. The secure location can be either on the local drive or it can be a secure location on the corporate network. You can create marker files that replace the confidential data. The marker files alert endpoint users that the file contained confidential information and was quarantined. You can include variables in the marker text that describe aspects of the incident such as the file name, the violated policy, and the location of the secure folder.

---

**Note:** Endpoint quarantine is not available for DLP Agents running on Mac endpoints.

Endpoint quarantine response rules are only applicable to Endpoint Discover running scans on Windows endpoints.

The quarantine location can be either a secured folder on the local drive or a folder on a remote file share that is accessible by the endpoint through the corporate network. You can choose if you want to enable credentials on the secure location or allow any anonymous user to access the location.

---

**Note:** Encrypting File Service (EFS) folders cannot support anonymous access.

Not all policy groups and policies are applicable with Endpoint response rules. If you try to create a policy with incompatible rules and responses, you receive an error message. The error states that the policy is incompatible with the Endpoint response rules.

See “About policies for endpoints” on page 1365.

See “How to implement Endpoint Prevent” on page 1378.

See “Configuring the Endpoint Discover: Quarantine File action” on page 920.
Setting up and configuring Endpoint Discover

To implement Endpoint Discover, you must follow a specific set of tasks. These tasks are similar to Network Discover, but not identical.

Complete the following configuration tasks:

Table 72-2  Implementing Endpoint Discover

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>More information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Create an Endpoint Discover target.</td>
<td>See “Creating an Endpoint Discover scan” on page 1389.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Install the Symantec DLP Agent.</td>
<td>For installation details, see the appropriate Symantec Data Loss Prevention Installation Guide.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Configure reports.</td>
<td>See “About Symantec Data Loss Prevention reports” on page 1006.</td>
</tr>
</tbody>
</table>

See “Preparing to set up Endpoint Discover” on page 1385.

Creating an Endpoint Discover scan

To create an Endpoint Discover scan, you set up an Endpoint Discover target. Later you configure the target meet your scanning requirements. When you configure scan settings you can set the scan to use multiple Endpoint Servers. You also configure Endpoint Discover targets to scan specific endpoints.

The Endpoint Discover target can also be configured to scan specific locations on endpoints. The scan can use filters to target local drives, folders, or endpoints to find policy violations. This filtering is called Targeted Endpoint Discover scanning. For example, the fixed drive or the My Documents folder in Windows can be configured as a target. Endpoint Discover can scan any fixed drive that is associated with the endpoint. Endpoint Discover cannot scan removable drives. You can also specify filters to determine which endpoints you monitor. Any endpoints that the Targeted Endpoint Discover scan excludes display as Not Participating.

Table 72-3  Steps to configure scan settings for an Endpoint Discover scan target

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
<th>More information</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Configure a new Endpoint Discover target by clicking Manage &gt; Discover Scanning &gt; Discover Targets to</td>
<td>See “Creating a new Endpoint Discover target” on page 1390.</td>
</tr>
</tbody>
</table>
Table 72-3  Steps to configure scan settings for an Endpoint Discover scan target (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
<th>More information</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Add location, date, and file type filters to the Endpoint Discover target. You enter this information on the Filter tab on the Manage &gt; Discover Scanning &gt; Discover Targets screen.</td>
<td>See “About Endpoint Discover target filters” on page 1392.</td>
</tr>
<tr>
<td>3</td>
<td>Configure the scan idle timeout and max scan duration settings. You set this information on the Advanced tab on the Manage &gt; Discover Scanning &gt; Discover Targets screen.</td>
<td>See “Configuring Endpoint Discover scan timeout settings” on page 1400.</td>
</tr>
</tbody>
</table>

**Note:** You cannot schedule Endpoint Discover targeted scans. Each scan must be started manually. You must also manually stop the scan, allow it to complete, or allow it to timeout. You cannot pause an Endpoint Discover scan.

**Creating a new Endpoint Discover target**

For a new Endpoint Discover target, enter the name of the target, the policy group, and the Endpoint Server where the scans can run.

These required fields should be set when a new target is added.

**To enter the required fields for a target**

1. In the Enforce Server administration console, go to Manage > Discover Scanning > Discover Targets.
2. Click New Target, and select File System under Endpoint.
3 Complete the following items on the **General** tab.

**Name**
Enter a name for this Endpoint Discover target.

**Policy Group**
Select the Endpoint Discover policy group you created.

See “Creating a policy group for Endpoint Discover” on page 1386.

If no other policy group has been selected, the Default Policy group is used. You can assign multiple policy groups to a target.

The administrator defines policy groups on the **Policy Group List** page. If the policy group you want to use does not appear on the list, contact your Symantec Data Loss Prevention administrator.

**Servers**
Select the Endpoint Server (or multiple Endpoint Servers) where you want to allow the scan to run.

Only the detection servers that were configured as Endpoint Servers appear on the list. You should configure your Endpoint Servers before you configure targets. You must specify at least one server before you can run a scan for this target.

See “Selecting multiple servers for an Endpoint Discover scan” on page 1392.

4 Configure items on the **Filters** tab.

You can configure the following:

- Add filters to specify items to include or exclude from a scan.
  See “About Endpoint Discover target filters” on page 1392.

- Specify maximum or minimum file sizes to scan.
  See “Filtering Discover targets by item size” on page 1201.

- Enable incremental and differential scan features.
  See “Scanning new or modified items with incremental scans” on page 1224.
  See “Scanning new or modified items with differential scans” on page 1225.

- Specify files to scan base on their last accessed or modified date.
  See “Filtering Discover targets by date last accessed or modified” on page 1202.

5 Configure settings on the **Advanced** tab.

6 See “Configuring Endpoint Discover scan timeout settings” on page 1400.

7 Click **Save** to save all updates to the target.
Selecting multiple servers for an Endpoint Discover scan

You can add more than one Endpoint Server to an Endpoint Discover scan. Adding multiple servers helps improve scan performance.

If a DLP Agent loses its connection to the primary Endpoint Server during an Endpoint Discover scan, the agent can continue the scan by establishing a connection to a backup Endpoint Server using a failover or load balancer scenario. A user adds all failover Endpoint Servers installed behind a load balancer when creating or editing the Endpoint Discover scan target.

Connecting to additional servers also improves Endpoint Discover scan performance in load-balanced environments.

---

**Note:** Each time there are policy changes, the Enforce Server sends data to all Endpoint Servers associated with the Endpoint Discover scan, which potentially creates bandwidth issues.

About Endpoint Discover target filters

Endpoint Discover target filters affect how Endpoint Discover interacts with your endpoints. Endpoint Discover target filters let you specify the following:

- The type of files you want to scan.
- The areas within the target you want to scan.
- The subset of endpoints you want to scan.
- The size of the files you want to scan.

Endpoint Discover targets are dedicated to a specific local system. Unlike Network Discover, endpoint targets do not need defined root systems or network shares.

See “Creating an Endpoint Discover scan” on page 1389.

See “Using include and exclude filters” on page 1392.

See “Setting up Endpoint Discover filters to include or exclude items from the scan” on page 1395.

Using include and exclude filters

Exclude and include filters let you reduce the number of items or repositories to scan.

---

**Note:** You cannot use exclude and include filters to target specific Mac endpoints. See “Using filters to scan Windows and Mac operating systems” on page 1399.
Use the **Include Filters** field to specify the items that Symantec Data Loss Prevention should process. If you leave the **Include Filters** field empty, Symantec Data Loss Prevention performs matching on all items in the selected target. If you enter any values in the field, Symantec Data Loss Prevention scans only those items that match your filter.

Use the **Exclude Filters** field to specify the items that Symantec Data Loss Prevention should not process. If you leave the **Exclude Filters** field empty, Symantec Data Loss Prevention performs matching on all items in the selected target. If you enter any values in the field, Symantec Data Loss Prevention scans only those items that do not match your filter.

*Table 72-4* lists the items you can include or exclude by using filters.

**Table 72-4** Items that can be filtered

<table>
<thead>
<tr>
<th>Item to filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Files</td>
<td>You can enter file extensions in the <strong>Include Filters</strong> and <strong>Exclude Filters</strong> to include or exclude file types, respectively.</td>
</tr>
<tr>
<td>File folders</td>
<td>You can enter folder names in the <strong>Include Filters</strong> and <strong>Exclude Filters</strong> to include or exclude folders, respectively.</td>
</tr>
<tr>
<td>IP addresses</td>
<td>Endpoint Discover uses a common syntax to describe IP address ranges. This format is similar to the standard Classless Inter-Domain Routing (CIDR) format. The Endpoint Discover IP address range filter format includes a main network address, a following “/” character, and the number of mask bits. For example, the IP address range description 192.64.110.0/24 has a mask bit count of 24. This means that all IP addresses from 192.64.110.0 – 192.64.110.255 match the filter. Likewise, 128.0.0.0/8 represents the IP address range 128.0.0.0 – 128.255.255.255.</td>
</tr>
<tr>
<td>Computer names</td>
<td>You can enter the host name, FQDN name, or NetBIOS name. You can use the wildcard (*) character.</td>
</tr>
<tr>
<td>WINS names</td>
<td>You can enter a WINS name to include or exclude endpoints.</td>
</tr>
</tbody>
</table>

*Table 72-5* table lists the syntax you can use when you add filters.
<table>
<thead>
<tr>
<th>Syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>* (asterisk)</td>
<td>Use this wildcard to match zero or more characters. A <em>.</em> pattern added at the end of the path has the same behavior as a <em>. For instance a filter like <code>C:\ep_test\data\edar*</code> or <code>C:\ep_test\data\edar.*</code> have the same meaning. If <em>.</em> separates a directory path, then Symantec Data Loss Prevention expects a file or folder with a period (.) that matches the pattern. For example, <code>C:\ep_test\da*.ta\edar</code> would match <code>c:\ep_test\da.ta\edar</code> or <code>c:\ep_test\da123.ta\edar</code>, but it does not match <code>c:\ep_test\data\edar</code>. The <em>.txt,</em>.doc pattern of an include filter matches only files or documents with the .txt or .doc extensions and ignores everything else. A <em>.? pattern of an include filter only matches files or documents with a single-character extension. This example matches files such as <code>hello.1</code> and <code>hello.2</code>, but not <code>hello.doc</code> or <code>hello.html</code>. A <em>/documentation/</em>,</em>/specs/</em> pattern filters to match on specific subdirectories of a file share. This example filter pattern only matches the files that are contained in the two subdirectories that are called documentation and specs.</td>
</tr>
<tr>
<td>? (question mark)</td>
<td>Use this wildcard to match one character in the place where it appears.</td>
</tr>
<tr>
<td>, (comma)</td>
<td>Represents a logical OR. Delimit entries with a comma.</td>
</tr>
<tr>
<td>The forward slash (/) and backslash (/) characters</td>
<td>These characters are equivalent. They usually represent directory separators, although on Linux and Mac the backslash is a valid character in a file name. Escape characters</td>
</tr>
</tbody>
</table>

Endpoint Discover does not include the following items in a scan:

- Mounted drives on Windows such as USB drives
- Windows network shares

See “Setting up Endpoint Discover filters to include or exclude items from the scan” on page 1395.
Setting up Endpoint Discover filters to include or exclude items from the scan

You use include and exclude filters to include or exclude files and locations from an Endpoint Discover scan.

To set up include filters or exclude filters:

1. In the Enforce Server administration console, go to Manage > Discover Scanning > Discover Targets.
2. Click the name of the scan where you want to add include filters or exclude filters.
3. Click the Filters tab.

By default, the Exclude field displays the following filters:

$Windows$/*,/Applications/*,/System/*,.Spotlight*,*.mp3,*.wma,*.wav, *.vox,*.aac,*.3gp,*.dat,*.avi,*.mpeg,*.wmv,*.mov,*.mp4,*.dylib,*.jar,*.dll,*.exe, $ProgramFiles$/*,/opt/*,/sbin/*,/bin/*,/usr/bin/*

4. Enter file names or paths in the Include Filters field and the Exclude Filters field to select a subset of items that Symantec Data Loss Prevention should process. Delimit entries with a comma, but no spaces. The path filter is case-sensitive.

Use * (asterisk) at the end of a path to include or exclude all content in the specified folder. For example, if you enter C:/Users/*, /Users/* in the Include Filter field, all contents in the C:Users folder on Windows endpoints and the /Users/ folder on Mac endpoints are scanned.

When both include filters and exclude filters are present, exclude filters take precedence.

The include filter and exclude filter file names are relative to the file system root. Specify full paths or subdirectories, as needed. Some wildcards are allowed.

5. Click Save.

See “Creating an Endpoint Discover scan” on page 1389.

See “Using include and exclude filters” on page 1392.

Using environment variables in Endpoint Discover scans

You can use environment variables to include or exclude file locations regardless of the supported Windows OS version, user profile, or platform of the endpoint. For example, you may want to create an Endpoint Discover target that only scans the
Program Files folder on all endpoints or the Documents folder on all user profiles on all endpoints.

**Note:** Environment variables are not supported on DLP Agents running on Mac endpoints. See "Using filters to scan Windows and Mac operating systems" on page 1399.

Table 72-6 lists the environment variable types you can use.

**Table 72-6** Environment variable types

<table>
<thead>
<tr>
<th>Variable type</th>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system defined variable</td>
<td>%</td>
<td>You use this variable type to scan paths specific to the endpoint operating system. For example, you would use %TEMP% to scan the TEMP folder on all targeted endpoints.</td>
</tr>
<tr>
<td>Symantec Data Loss Prevention defined variable</td>
<td>$</td>
<td>You use this variable to scan all user profile paths on a single endpoint. For example, you would use $Documents$ to scan the Documents folder in all user profiles present on the targeted endpoints.</td>
</tr>
</tbody>
</table>

Variables that include or exclude user profile paths (whether Symantec Data Loss Prevention or operating system defined) are resolved to all the user profiles present on the endpoint. For example, if two user profiles exist on an endpoint, and you specify $Documents$ in the include filter, Symantec Data Loss Prevention scans C:\Users\User1\Documents\ and C:\Users\User2\Documents.

Table 72-7 lists the Symantec Data Loss Prevention defined variables.

**Table 72-7** Environment variables

<table>
<thead>
<tr>
<th>Symantec Data Loss Prevention defined variable</th>
<th>Default resolved path</th>
</tr>
</thead>
<tbody>
<tr>
<td>$CommonAdminTools$</td>
<td>%ALLUSERSPROFILE%\Microsoft\Windows\Start Menu\ Programs\ Administrative Tools</td>
</tr>
<tr>
<td>$CommonOEMLinks$</td>
<td>%ALLUSERSPROFILE%\OEM Links</td>
</tr>
<tr>
<td>$CommonPrograms$</td>
<td>%ALLUSERSPROFILE%\Microsoft\Windows\Start Menu\ Programs</td>
</tr>
<tr>
<td>$CommonStartMenu$</td>
<td>%ALLUSERSPROFILE%\Microsoft\Windows\Start Menu</td>
</tr>
<tr>
<td>$CommonStartup$</td>
<td>%ALLUSERSPROFILE%\Microsoft\Windows\Start Menu\ Programs\StartUp</td>
</tr>
<tr>
<td>$CommonTemplates$</td>
<td>%ALLUSERSPROFILE%\Microsoft\Windows\ Templates</td>
</tr>
<tr>
<td>$Cookies$</td>
<td>%APPDATA%\Microsoft\Windows\Cookies</td>
</tr>
<tr>
<td>Symantec Data Loss Prevention defined variable</td>
<td>Default resolved path</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>$Desktop$</td>
<td>%USERPROFILE%\Desktop</td>
</tr>
<tr>
<td>$Documents$</td>
<td>%USERPROFILE%\Documents</td>
</tr>
<tr>
<td>$Favorites$</td>
<td>%USERPROFILE%\Favorites</td>
</tr>
<tr>
<td>$Fonts$</td>
<td>%WINDIR%\Fonts</td>
</tr>
<tr>
<td>$History$</td>
<td>%LOCALAPPDATA%\Microsoft\Windows\History</td>
</tr>
<tr>
<td>$InternetCache$</td>
<td>%LOCALAPPDATA%\Microsoft\Windows\Temporary Internet Files</td>
</tr>
<tr>
<td>$LocalAppData$</td>
<td>%LOCALAPPDATA% (or %USERPROFILE%\AppData\Local)</td>
</tr>
<tr>
<td>$LocalizedResourcesDir$</td>
<td>%WINDIR%\Resources\0409</td>
</tr>
<tr>
<td>$Music$</td>
<td>%USERPROFILE%\Music</td>
</tr>
<tr>
<td>$NetHood$</td>
<td>%APPDATA%\Microsoft\Windows\Network Shortcuts</td>
</tr>
<tr>
<td>$Pictures$</td>
<td>%USERPROFILE%\Pictures</td>
</tr>
<tr>
<td>$PrintHood$</td>
<td>%APPDATA%\Microsoft\Windows\Printer Shortcuts</td>
</tr>
<tr>
<td>$ProgramData$</td>
<td>%ProgramData% (or %SystemDrive%\ProgramData)</td>
</tr>
<tr>
<td>$ProgramFiles$</td>
<td>%ProgramFiles% (or %SystemDrive%\Program Files)</td>
</tr>
<tr>
<td>$ProgramFilesCommon$</td>
<td>%ProgramFiles%\Common Files</td>
</tr>
<tr>
<td>$ProgramFilesCommonX64$</td>
<td>%ProgramFiles%\Common Files</td>
</tr>
<tr>
<td>$ProgramFilesCommonX86$</td>
<td>%ProgramFiles%\Common Files</td>
</tr>
<tr>
<td>$ProgramFilesX64$</td>
<td>%ProgramFilesX64% (or %SystemDrive%\Program Files)</td>
</tr>
<tr>
<td>$ProgramFilesX86$</td>
<td>%ProgramFilesX86% (or %SystemDrive%\Program Files)</td>
</tr>
<tr>
<td>$Programs$</td>
<td>%APPDATA%\Microsoft\Windows\Start Menu\Programs</td>
</tr>
<tr>
<td>$Public$</td>
<td>%PUBLIC% (or %SystemDrive%\Users\Public)</td>
</tr>
<tr>
<td>$PublicDesktop$</td>
<td>%PUBLIC%\Desktop</td>
</tr>
<tr>
<td>$PublicDocuments$</td>
<td>%PUBLIC%\Documents</td>
</tr>
<tr>
<td>$PublicDownloads$</td>
<td>%PUBLIC%\Downloads</td>
</tr>
</tbody>
</table>
### Table 72-7  Environment variables (continued)

<table>
<thead>
<tr>
<th>Symantec Data Loss Prevention defined variable</th>
<th>Default resolved path</th>
</tr>
</thead>
<tbody>
<tr>
<td>$PublicGameTasks$</td>
<td>%ALLUSERSPROFILE%\Microsoft\Windows\GameExplorer</td>
</tr>
<tr>
<td>$PublicMusic$</td>
<td>%PUBLIC%\Music</td>
</tr>
<tr>
<td>$PublicPictures$</td>
<td>%PUBLIC%\Pictures</td>
</tr>
<tr>
<td>$PublicVideos$</td>
<td>%PUBLIC%\Videos</td>
</tr>
<tr>
<td>$Recent$</td>
<td>%APPDATA%\Microsoft\Windows\Recent</td>
</tr>
<tr>
<td>$ResourceDir$</td>
<td>%WINDIR%\Resources</td>
</tr>
<tr>
<td>$RoamingAppData$</td>
<td>%USERPROFILE%\AppData\Roaming</td>
</tr>
<tr>
<td>$SampleMusic$</td>
<td>%PUBLIC%\Music\Sample Music</td>
</tr>
<tr>
<td>$SamplePictures$</td>
<td>%PUBLIC%\Pictures\Sample Pictures</td>
</tr>
<tr>
<td>$SamplePlaylists$</td>
<td>%PUBLIC%\Music\Sample Playlists</td>
</tr>
<tr>
<td>$SampleVideos$</td>
<td>%PUBLIC%\Videos\Sample Videos</td>
</tr>
<tr>
<td>$SendTo$</td>
<td>%APPDATA%\Microsoft\Windows\SendTo</td>
</tr>
<tr>
<td>$StartMenu$</td>
<td>%APPDATA%\Microsoft\Windows\Start Menu</td>
</tr>
<tr>
<td>$Startup$</td>
<td>%USERSPROFILE%\Microsoft\Windows\Start Menu\Programs\StartUp</td>
</tr>
<tr>
<td>$System$</td>
<td>%WINDIR%\system32</td>
</tr>
<tr>
<td>$SystemX86$</td>
<td>%WINDIR%\system32</td>
</tr>
<tr>
<td>$Templates$</td>
<td>%APPDATA%\Microsoft\Windows\Templates</td>
</tr>
<tr>
<td>$UserProfiles$</td>
<td>%SystemDrive%\Users</td>
</tr>
<tr>
<td>$Videos$</td>
<td>%USERPROFILE%\Videos</td>
</tr>
<tr>
<td>$Windows$</td>
<td>%WINDIR%</td>
</tr>
</tbody>
</table>

See "Include filter examples" on page 1398.

**Include filter examples**

The following section provides an Endpoint Discover include filter example that uses environment variables.
See “Using environment variables in Endpoint Discover scans” on page 1395.

Table 72-8 Include filter example

<table>
<thead>
<tr>
<th>Filter string</th>
<th>Explanation</th>
</tr>
</thead>
</table>
| *.doc, $Documents$, >*.company.com, >192.168.32.0/8, >EDT* | The Endpoint Discover scan monitors:  
  ■ All .doc documents on all fixed drives that are associated with the scan.  
  ■ All files in the \My Documents\ file path.  
  ■ All endpoints in the .company.com domain.  
  ■ All computers on the 192.168.32.0/8 network.  
  ■ Any endpoints with the WINS name EDT. |

Using filters to scan Windows and Mac operating systems

If you plan to run Endpoint Discover scans on both Windows and Mac endpoints using the same Endpoint Discover scan target, consider exclude and include filter limitations. You can use both filter types to scan Windows endpoints. You can use exclude filters to scan Mac endpoints. However, using exclude and include filters together is not fully supported on Mac endpoints.

The following list provides scan scenarios for Mac endpoints:

- If an include filter is used, Symantec Data Loss Prevention does not scan Mac endpoints.
- If an exclude filter is used, Symantec Data Loss Prevention scans Mac endpoints.
- If an include and exclude filter are both used, Symantec Data Loss Prevention does not scan Mac endpoints.

File path and file type filters are fully supported on both Windows and Mac endpoints. See “Setting up Endpoint Discover filters to include or exclude items from the scan” on page 1395.

The following table illustrates a number of scenarios of how exclude and include filters affect scans on mixed operating system endpoints.

Table 72-9 Multiple operating system scan scenarios

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Include filter</th>
<th>Exclude filter</th>
<th>Windows</th>
<th>Mac</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan all endpoints with the IP range 192.64.110.0/24.</td>
<td>&gt;192.64.110.0/24</td>
<td>None</td>
<td>The endpoint is scanned if it matches the IP filter, otherwise it is not scanned.</td>
<td>The endpoint is not scanned.</td>
</tr>
</tbody>
</table>
## Multiple operating system scan scenarios (continued)

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Include filter</th>
<th>Exclude filter</th>
<th>Windows</th>
<th>Mac</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan endpoints in the *.company.com domain, and exclude computers in *.test.company.com domain.</td>
<td>&gt;*.company.com</td>
<td>&gt;*.test.company.com</td>
<td>The endpoint is scanned if it is in the test.company.com domain. Endpoints in the .test.company.com domain are not scanned.</td>
<td>The endpoint is not scanned.</td>
</tr>
<tr>
<td>Scan all endpoints other than those starting with L_CMP*.</td>
<td>None</td>
<td>&gt;L_CMP*</td>
<td>All endpoints are scanned except for those with names that start with L_CMP.</td>
<td>All endpoints are scanned.</td>
</tr>
<tr>
<td>Scan *.txt and *.doc files on IP address 10.216.122.22.</td>
<td>&gt;10.216.122.22.*.txt,.doc</td>
<td>None</td>
<td>Scans *.txt and *.doc files if the IP address is 10.216.122.22. All other endpoints are not scanned.</td>
<td>The endpoint is not scanned.</td>
</tr>
</tbody>
</table>

### Configuring Endpoint Discover scan timeout settings

An Endpoint Discover scan might not complete if one or more endpoints are disconnected and cannot report to the Endpoint Server. The **Scan Idle Timeout** setting can be configured to stop the Endpoint Discover scan if no endpoints report scan status to the Enforce Server for a specified period of time.

You can configure the **Max Scan Duration** to define the maximum time duration for an Endpoint Discover scan to run. When an Endpoint Discover scan exceeds the **Max Scan Duration**, the Endpoint Discover scan stops and displays timeout status.

The Endpoint Discover scan history reports the **Timeout** scan status. To access the scan history, select **Manage > Scan History** from the Enforce Server administration console.
Configuring the Scan Idle Timeout setting
1. Locate Scan Idle Timeout from the Advanced settings tab from the Manage > Discover Scanning > Discover Targets screen.
2. Enter the amount of time and select Minutes or Hours.
   The value you enter should exceed the polling interval value (ServerCommunicator.CONNECT_POLLING_INTERVAL_SECONDS.int).
   See “Advanced agent settings” on page 1414.

   Note: To disable Scan Idle Timeout, select Indefinite for the duration of time.

3. Click Save to save the settings.

Configuring the Max Scan Duration setting
1. Locate Max Scan Duration from the Advanced settings tab.
2. Enter the amount of time and select Minutes, Hours, or Days.

   Note: To disable Max Scan Duration, select Indefinite for the duration of time.

3. Click Save to save the settings.

Managing Endpoint Discover target scans
After you create and run an Endpoint Discover scan, you can perform a number of management tasks. These tasks can include the following:

- Manage Endpoint Discover in-progress scans. See “About managing Endpoint Discover scans” on page 1401.
- Remediating Endpoint Discover incidents. See “About remediating Endpoint Discover incidents” on page 1402.
- Enabling rules results caching (RRC). See “About rules results caching (RRC)” on page 1403.
- Create endpoint reports. See “About Endpoint reports” on page 1403.

About managing Endpoint Discover scans
To manage your Endpoint Discover scan targets, you can perform the following:

- Start, stop, and pause target scans.
Monitor status as target scans run.
Select targets to view details.
Edit or delete targets.
Manage multiple targets.
Sort and filter targets for easier target management.
Specify the number of targets to display.
Review scan history
See “Managing Network Discover scan histories” on page 1212.
Manage servers
See “Managing Network Discover Servers” on page 1219.
Review scan status
Completed
Timeout
Stopped
Running
See “Scanning new or modified items with differential scans” on page 1225.
Information about responding to scans
See “About remediating Endpoint Discover incidents” on page 1402.
Information about interpreting scan results and status
See “About incident reports for Network Discover” on page 989.

About remediating Endpoint Discover incidents
Incidents that are created for Endpoint Discover violations display under the Discover tab of the Incidents section. Incidents are marked with an Endpoint-specific icon. You can manually remediate Endpoint Discover incidents using Smart Response rules, use quarantine response rules, or create a custom response using the Endpoint FlexResponse API. See the Symantec Data Loss Prevention Endpoint FlexResponse Plug-in Developers Guide.
See “Endpoint incident lists” on page 964.
You can use the following features to remediate Endpoint Discover incidents:
Smart Response rules
See “About Automated Response rules” on page 881.
Quarantine response rules
About rules results caching (RRC)

Rules results caching (RRC) is a form of pre-detection on the DLP Agent. By caching information about any content that does not match a rule, the DLP Agent can ignore that content. RRC speeds detection because it allows the DLP Agent to only perform detection on new or recently changed content.

Only Described Content Matching (DMC) rule results can be cached in the DLP Agent. Other types of detection, Exact Data Matching (EDM), File Properties Type (FPT), and Indexed Data Matching (IDM) are not applicable to RRC. Additionally, RRC is not applicable to protocol or to group detection rules.

See “About Endpoint Quarantine” on page 1388.

- Endpoint FlexResponse
  See “About Endpoint FlexResponse” on page 1512.

See “About Endpoint reports” on page 1403.

About Endpoint reports

Use incident reports to track and remediate incidents on your endpoints. Symantec Data Loss Prevention reports an incident when it detects data that matches the detection parameters of a policy rule. Such data may include specific file content, an email sender or recipient, attachment file properties, or many other types of information. Each piece of data that matches detection parameters is called a match, and a single incident may include any number of individual matches.

Reporting for Endpoint Discover is found under the Discover Reporting section. Endpoint Discover incidents are marked to distinguish them from other types of Discover incidents.

Reporting for Endpoint Prevent is found in the Reports tab of the Enforce Server.

You can view the following reports:

- Exec. Summary - Endpoint
- Incidents - All
If an incident is created that includes user justifications, those justifications are included in the report in the Incident snapshot section. For example, if a violation occurs that requires the user to enter the response User error, the incident report includes the text SPECIAL: User typed response: "User error".

If the user selects a pre-generated justification, the justification appears in the report. Justifications appear in the detailed report under the header Justifications.

Justifications and notifications are not compatible with Endpoint Discover, therefore no justifications appear in Endpoint Discover reports.

You can also create customized reports for Endpoint Discover and Prevent. However, if the user is not on the network at the time the justification is entered, the justification section of the incident snapshot remains empty.

See “About Symantec Data Loss Prevention reports” on page 1006.

See “How to implement Endpoint Prevent” on page 1378.

See “Setting up and configuring Endpoint Discover” on page 1389.
This chapter includes the following topics:

- About agent configurations
- Adding agent configurations
- Applying agent configurations to an agent group
- Configuring the agent connection status
- Enabling the communication channel for 12.0.x and earlier agents

About agent configurations

The Agent Configuration page on the Enforce Server administration console lets you configure agent settings.

Each configuration contains configuration options for your agents. These configuration options determine the detection types that occur on endpoints. You can also specify filters and resource consumption limits. You can create as many different agent configurations as you want. However, you cannot delete the default agent configuration. Symantec Data Loss Prevention endpoint protection must contain at least one agent configuration. You can modify the default configuration as many times as you want.

Agent groups can only use one configuration at a time. However you can associate one agent configuration to multiple agent groups. You can also clone agent configurations.

See “Adding agent configurations” on page 1406.

See “About cloning agent configurations” on page 1406.
About cloning agent configurations

You can clone agent configurations. Cloned configurations are identical to the configurations from which they were cloned. Clone agent configurations when you want to keep most of the entity details the same, but need to make small changes. Click the clone icon next to the edit icon to clone a configuration. When you clone a configuration, you see an editable version of that cloned configuration. You must rename the cloned configuration so that you can distinguish between the original and the clone.

The agent configuration page contains information about all of the available agent configurations.

You can also click **Add Configuration** to create new agent configurations.

See “Adding agent configurations” on page 1406.

**Adding agent configurations**

You can add or edit agent configurations by going to **System > Agents > Agent Configuration** and clicking the **Add Configuration** button.

Create or edit an agent configuration by modifying the following tabs:

- Agent Monitoring
- Agent Configuration
- Advanced Agent Settings

**Agent Monitoring** tab.

Use this tab to select which aspects of the endpoint items you want to monitor. The **Agent Monitoring** tab is divided into three sections.

- **Enable Monitoring** section. Select the endpoint applications and destinations (channels) to monitor.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Destinations</td>
<td>Select the destinations to be monitored. Destinations are the physical media or periphery devices that are attached to the endpoint, such as CD/DVD drives, USB-connected devices, printers, and so on.</td>
</tr>
<tr>
<td>Email</td>
<td>Select email applications to be monitored.</td>
</tr>
</tbody>
</table>
### Field Description

**Web**
Select web applications to be monitored. HTTPS monitoring is only supported for Firefox and Internet Explorer browsers.

**Instant Messaging**
Select instant messaging applications to be monitored.

**Applications**
Select to add application file access monitoring.

**Network Shares**
Select to monitor network shares. You can monitor the files that are transferred to or from your local drive and a network share.

- **Filter by File Properties** section. Create and edit monitoring filters. Using this option lets you optimize performance and reduce false positives. Based on the filters you set, the Symantec DLP Agent monitors or ignores data based on protocol, destination, file size, file type, or file path. Existing filters are listed in this section. The filters run in the order they appear in the list as determined by the Order column.

**Note:** When you filter by file path, the drive letter is ignored and the specified path for every local drive on the agent is filtered. For example, entering `c:\temp` causes `c:\temp` and `d:\temp` to be filtered on an agent with two local drives.

- To create a new filter, click **Add Monitoring Filter**.
- To modify an existing filter, click on the filter in the list.
- To delete an existing filter, click on that filter's red "X."
- To change the order in which a filter is applied, click the filter number in the Order column. Then select the execution order for that filter in the drop-down list. Changes are only applied after you click **Save** at the top of the screen.
- Choose either **Monitor** or **Ignore** to specify what to do with the files that do not match any of the filters in the Filter by Network Properties section. See “Configuring file filters” on page 1412.

- Create network-related filters that make the agent monitor or ignore network traffic based on IP address or domain. Enter the IP addresses, HTTP domains, and HTTPS domains that you want to filter on in the appropriate box. For filtering IP addresses, use the following rules:
  - Enter any IP-based filters that you want to use. If you leave this field blank, Symantec Data Loss Prevention inspects all packets. The format of the IP protocol filters (found in the protocol definitions and protocol filter definitions) is:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web</td>
<td>Select web applications to be monitored. HTTPS monitoring is only supported for Firefox and Internet Explorer browsers.</td>
</tr>
<tr>
<td>Instant Messaging</td>
<td>Select instant messaging applications to be monitored.</td>
</tr>
<tr>
<td>Applications</td>
<td>Select to add application file access monitoring. See “About monitoring applications” on page 1503.</td>
</tr>
<tr>
<td>Network Shares</td>
<td>Select to monitor network shares. You can monitor the files that are transferred to or from your local drive and a network share.</td>
</tr>
</tbody>
</table>
Each stream is evaluated in order against the filter entries until an entry matches the IP parameters of the stream.

A minus sign (-) at the start of the entry indicates that the stream is dropped. A plus sign (+) at the start of the entry indicates that the stream is kept.

A subnet network description of * means that any packet matches this entry. A subnet bitmask size of 32 means that the entry must match the exact network address. For example, a filter of +,10.67.0.0/16,*;-,*,* matches all streams going to network 10.67.x.x but does not match any other traffic.

**Note:** The more specific you are when you define the recognition characteristics, the more specific your results. For example, if you define only one specific IP address, only incidents involved that IP address are captured. If you do not define any IP addresses, or if you define a wide range of IP addresses, you achieve broader results. Include at least one plus sign (+) clause and one minus sign (-) clause to be explicit about what is included and what is excluded.

The Domain filters need to be applied separately for HTTP and HTTPS. To add filters for any website that supports HTTP and HTTPS, add individual filters for HTTP and HTTPS in the respective text boxes. The IP address filter works with all other network protocols.

For filtering HTTP/HTTPS domain names, use the following rules:
You can use filters to include (inspect) or exclude (ignore) messages from specific senders. You can also use filters to include or exclude specific recipients. The specific filter syntax depends on the protocol.

The following is an example of domain filters

Domain Filter := <Domain Filter Entry> [,<Domain Filter Entry>]
Domain Filter Entry := {*|{-|+}<metadata value>}

You can use the following symbols:

- You can use the wildcard symbol (*) in the domain entry.
- A minus sign (-) at the start of the entry indicates that the URL is ignored.
- A plus sign (+) at the start of the entry indicates that the URL is inspected.
- If you add an asterisk (*) to the end of the filter expression, any URL domain not explicitly matching any of the filter masks is ignored.

These filters are executed is from left to right until the first match occurs or the agent reaches the end of the filter entries.

For example, if the filter is:

-sales.symantec.com, +*symantec.com, *

HTTP requests to sales.symantec.com are ignored, and all of the requests that are sent to any other symantec.com domain are inspected. The last asterisk in the filter filters out all other domains like www.xyz.com.

**Note:** If you leave the HTTP/HTTPS filter empty, all the URLs are inspected.

The filters that you specify with this screen only apply to the individual Endpoint Server where these filters are configured. If you have more than one Endpoint Server, you must individually configure the file filters for each server.

**Agent Configuration** tab.

The **Agent Configuration** tab is divided into the following sections:

- **Server Communication** section.
  Set the maximum amount of bandwidth (in megabits or kilobits per second) that a DLP Agent can use to upload data to and download data from the Endpoint Server during connection time.
  See “About the DLP Agent store” on page 1414.
  The default setting of the consumption throttle is 5 Mbps. To change the bandwidth throttle, select either Mbps or Kbps and then enter a number in the box for the maximum per second. If you leave a field empty, no throttling is applied for that direction of communication traffic.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Agents</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Agent Throttle</td>
<td>Maximum rate at which the DLP Agent uploads incidents, status, events to the Endpoint Server.</td>
<td>Throttle setting applies to all DLP Agent versions.</td>
</tr>
<tr>
<td>To Agent Throttle</td>
<td>Maximum rate at which the DLP Agent downloads policy and agent configuration updates from the Endpoint Server.</td>
<td>Throttle setting only applies to 12.5 and later DLP Agent versions.</td>
</tr>
</tbody>
</table>

- **Resource Consumption on the Endpoint Host** section.
  Use this section to set the maximum disk space for the **Agent Store Size**. The DLP Agent uses the Agent Store to temporarily store incidents and other data on each endpoint host.  
  See “About the DLP Agent store” on page 1414.  
  You can specify a percentage of the hard drive, or a storage limit. Click the appropriate radio button to choose either a percentage of disk space or a storage limit.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>% of Total Disk Space limit</td>
<td>For percentage enter the amount in the corresponding box. The default percentage is 5% of total disk space.</td>
</tr>
<tr>
<td>Absolute disk space size limit</td>
<td>Select the radio button for this option, enter the particular size in the field, and choose the unit of measurement from the drop-down list (Bytes, KB, MB, or GB).</td>
</tr>
</tbody>
</table>

- **Resource Consumption for Endpoint Discover Scans** section.
  Use this section to manage resources when Discover scans endpoints:

  Note: The long-term average CPU usage and minimum battery life remaining features are not currently supported for agents running on Mac endpoints.
Field                                      Description

Long-Term Average CPU Usage                Specify the maximum average percent of CPU resources that can be used for Discover scans over a length of time. If the Symantec DLP Agent exceeds this maximum CPU limit, Endpoint Discover detection terminates, but Endpoint Protect detection continues as normal. The default is 20%.

                Note: Any changes you make to the CPU resources threshold should take effect immediately. If you make a change during a scan, the change takes effect after the agent resumes scanning.

Minimum Battery Life Remaining             Specify a minimum amount of the battery that is needed to run your agents. If battery power falls under this minimum, Endpoint Discover detection stops, but Endpoint Protect detection functions normally. The default is 30%.

File Recovery Area Location section. Specify file recovery parameters. File recovery location is where copies of the sensitive data that the DLP Agent blocked from transfer are stored. These copies are kept until recovered by the user, or automatically deleted after a period of time.

Field                                      Description

File Recovery Area Location                 Specify the path to the file recovery directory. The default is %TMP\RecoveredFiles.

Time To Expiration                          Specify the amount of time before files are automatically deleted from the file recovery folder. The default is 48 hours.

See “About Symantec Data Loss Prevention administration” on page 55.
See “Server configuration—basic” on page 180.
See “Server controls” on page 178.

Advanced Agent Settings tab.

You can also specify advanced settings for the agents. These settings affect how the Symantec DLP Agents process information, detect violations, and perform on endpoints.

Note: Contact Symantec Support before changing any of the advanced settings.

See “Advanced agent settings” on page 1414.
Note: If you modify an existing agent configuration, clicking the Save button applies the changes to all of the agent groups associated with the configuration. If you create a new configuration, the configuration is saved and you can apply it on the Agent Groups screen.

See “About agent configurations” on page 1405.

See “Applying agent configurations to an agent group” on page 1441.

Configuring file filters

You can configure DLP Agents to monitor specific file types, applications, protocols, or locations. Configuring these items lets you potentially improve monitor performance. You configure the DLP Agent by going to System > Agents > Agent Configuration. You then select an agent configuration you want to configure then click Add Monitoring Filter.

The Configure Server - File Filter filters page is divided into the following three sections:

- Filter Action
- Endpoint Channel
- File Attributes

The Filter Action section lets you select whether you want the filter to monitor the following attributes or not. You can include files to be monitored or exclude files from the relevant protocol or destination.

You can select one of the following choices:

- Monitor
- Ignore (do not monitor)

The Endpoint Channel section lets you select the destinations, protocols, or applications that you want to filter. You must select at least one option. Select the items that you want the Endpoint Server to monitor.

You can select the following options:

- Removable Storage
- CD/DVD
- Local drive
- Application File Access
- Email Attachment
HTTP/HTTPS Attachment

IM File transfer

FTP transfer

The Application File Access option lets you monitor any applications that appear on the Application Monitoring page.

See “About monitoring applications” on page 1503.

The File Attributes section is where you specify the filters that you want to apply. Information you enter in this section applies to local drive and application file access monitoring. Select Local Drive or Application File Access to edit the File Path on Destination field.

You can specify the following filter attributes:

- **Size**
  You can specify a minimum, maximum, or baseline size of the files you want to scan.

- **Type**
  Specify the exact file types that you want to filter. This section is pre-loaded with common file types. If you specify any additional file types, enter each file type on a separate line.

- **File Path on Destination**
  Specify the file-system path(s) to analyze. Enter one path per line. If you specify any paths to include, Symantec Data Loss Prevention monitors only files in those paths. If you leave this field blank, Symantec Data Loss Prevention monitors all files except the files that you may have specified elsewhere. This filter applies to both local drive monitoring and application file access. You can use environment variables to include or exclude file locations regardless of the user profile or platform of the endpoint. For example, if you enter: *%TEMP%

  $PublicDownloads$

Symantec Data Loss Prevention scans the Downloads folder on all user profiles and the Temp folder.

See “Using environment variables in Endpoint Discover scans” on page 1395.

Endpoint monitor filters always run in the order that they appear. If you want to rearrange the run order of the filters, contact Symantec Support. Rearranging the endpoint monitor filter order may cause agents to stop monitoring sensitive information.

See “About agent configurations” on page 1405.
About the DLP Agent store

When the DLP Agent is not connected to the Endpoint Server, the DLP Agent temporarily stores incidents, two-tier detection requests, and response actions locally on the endpoint host. The DLP Agent stores incident and detection metadata, and response action data and metadata, in a small encrypted database that is installed with the DLP Agent. The DLP Agent stores incident data and content for two-tier detection requests on the endpoint host file system. This data is encrypted and the encryption key is stored in the agent database.

The **Agent Store Size** parameter limits the amount of data that the DLP Agent stores on the endpoint host. The default agent store size is 5% of total disk space. Alternatively, you can set an absolute storage limit. The **Agent Store Size** limit applies to all data stored on the endpoint host, including data stored in the agent database and data stored on the host file system.

If the **Agent Store Size** limit is exceeded, the DLP Agent deletes data from the endpoint host according to a set priority until the **Agent Store Size** limit is no longer exceeded. If the DLP Agent must delete incidents, the order of eviction is as follows:

1) Two-tier detection request data (oldest first)
2) Endpoint Discover incidents (oldest first)
3) Endpoint Prevent incidents (oldest first)

See “Adding agent configurations” on page 1406.

Advanced agent settings

The following settings affect only the Symantec DLP Agent. These settings should not be modified without the assistance of Symantec Support. If you want to make modifications to this screen, please contact Symantec Support before making any changes.

**Table 73-1** provides a list of agent settings, along with the default value and description of each setting.

---

**Note:** If you change advanced agent settings and the agents connect to Endpoint Servers in a load-balanced environment, you must apply the same changes to all Endpoint Servers in the load-balanced environment.
<table>
<thead>
<tr>
<th>Name of Setting</th>
<th>Default values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AgentManagement.DISABLE_ENABLE_TASK_TIMEOUT_SECONDS.int</td>
<td>300</td>
<td>The amount of time, in seconds, the Disable or Enable agent troubleshooting task waits before it sends the Agent Requires Restart system event.</td>
</tr>
</tbody>
</table>
| AgentTamperProtection.ENABLE_AGENT_TAMPER_PROTECTION.int                      | 7              | This setting enables tamper protection on the Symantec Data Loss Prevention Endpoint agent.  
A setting of 0 disables all tamper protection.  
A setting of 1 prevents the agent and the watchdog files from being deleted or modified.  
A setting of 2 prevents the agent and the watchdog services from being stopped.  
A setting of 3 prevents the agent and the watchdog files and services from being deleted, modified or stopped.  
A setting of 4 prevents the agent and the watchdog services from being deleted from the operating-system registry.  
A setting of 7 enables file, service, and registry protection.             |
<p>| AgentThreadPool.IDLE_TIME_IN_SECONDS.int                                      | 60             | The maximum time a thread can be inactive before it is removed from the thread pool. Threads are also known as agent tasks.                                                                                   |
| AgentThreadPool.MAX_CAPACITY.int                                              | 20             | The maximum number of threads in the thread pool. The threads can be either active or inactive.                                                                                                           |</p>
<table>
<thead>
<tr>
<th>Name of Setting</th>
<th>Default values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AgentThreadPool.MIN_CAPACITY.int</td>
<td>2</td>
<td>The minimum number of threads that are allowed in the thread pool. The thread pool must always contain this number of threads. The threads can be either active or inactive.</td>
</tr>
<tr>
<td>AggregatorCommunicator.ENABLE_ENDPOINT_DATAFLOW_CACHING.int</td>
<td>1</td>
<td>If enabled (1), this setting prevents agent from downloading data, like policies and configuration files, that have already been downloaded. Enter 0 to disable this setting.</td>
</tr>
<tr>
<td>ApplicationConnector.KEY_LENGTH.int</td>
<td>64</td>
<td>The length of the key, in bytes, that is used to obfuscate communication between the agent and the application hooks.</td>
</tr>
<tr>
<td>ApplicationConnector.MAX_CONNECTIONS.int</td>
<td>255</td>
<td>The maximum number of application hooks (per type of hook) that can simultaneously connect to the agent.</td>
</tr>
<tr>
<td>ApplicationConnector.TEMPORARY_DIRECTORY.str</td>
<td>%TMP%</td>
<td>The temporary location where application hooks store obfuscated content.</td>
</tr>
<tr>
<td>AttributeResolver.ATTRIBUTE_REFRESH_INTERVAL_IN_DAY.int</td>
<td>7</td>
<td>The number of days the agent waits to refresh Active Directory attribute information. If the agent finds the information that is older than the number of days indicated, then contacts contacts the Active Directory server. If value is set to 0, the agent does not contact AD server to retrieve attribute information.</td>
</tr>
<tr>
<td>ClipboardViewer.SLEEP_TIME_IN_MS.int</td>
<td>10</td>
<td>The time delay, in milliseconds, before the agent fetches contents from the endpoint clipboard.</td>
</tr>
</tbody>
</table>
Table 73-1  Agent advanced settings (continued)

<table>
<thead>
<tr>
<th>Name of Setting</th>
<th>Default values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CommLayer.MAX_FRAME_SIZE_KILOBYTES.int</td>
<td>8</td>
<td>The maximum size of each outbound frame. This is the maximum number of kilobytes per frame read from the applications. Changes to this setting apply to all new connections. Changes do not affect existing connections.</td>
</tr>
<tr>
<td>CommLayer.NO_TRAFFIC_TIMEOUT_SECONDS.int</td>
<td>300 seconds (5 minutes)</td>
<td>The application level heartbeat interval. To detect idle dead connections the agent uses an application level heartbeat message. Data Loss Prevention closes the connection for which a heartbeat has not been received in the specified timeout interval. The agent does not send heartbeats and relies on the TCP keepalive instead. A 0 value indicates that the heartbeat should be disabled. This value is also used as an application handshake timeout value. Changes to this setting apply to existing and new connections. You can enter a value between 60 and 86400 seconds.</td>
</tr>
<tr>
<td>ComponentLoaderSettings.MAX_COMPONENT_SHUTDOWN_TIME.int</td>
<td>60000</td>
<td>The maximum amount of time, in milliseconds, that the agent waits for a component to shut down.</td>
</tr>
<tr>
<td>ComponentLoaderSettings.PROCESS_PRIORITY.str</td>
<td>NORMAL</td>
<td>The priority level that dictates what priority the DLP Agent runs on the endpoint. You can also enter NORMAL and ABOVE_NORMAL.</td>
</tr>
<tr>
<td>Name of Setting</td>
<td>Default values</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td>CrashDump.ENABLE_CRASH_DUMP_COLLECTION.int</td>
<td>1</td>
<td>The setting that allows the system to create a dump file when the Symantec DLP Agent crashes. Setting this value to 1 enables the crash dump file to be created. Enter 0 to disable the file.</td>
</tr>
<tr>
<td>CrashDump.MAX_DAYS_TO_KEEP_DUMP.int</td>
<td>2</td>
<td>The maximum time, in days, that the crash dump file is stored.</td>
</tr>
<tr>
<td>CrashDump.MAX_NUMBER_OF_FILES_IN_DUMP_FOLDER.int</td>
<td>3</td>
<td>The maximum number of files to keep in the crash dump folder.</td>
</tr>
<tr>
<td>Detection.CHUNK_OVERLAP.int</td>
<td>45</td>
<td>The number of characters each chunk borrows from the end of the previous chunk.</td>
</tr>
<tr>
<td>Detection.CHUNK_SIZE.int</td>
<td>65536</td>
<td>The text chunk size in bytes.</td>
</tr>
<tr>
<td>Detection.DAR_KVOOP_PRIORITY.str</td>
<td>BELOW_NORMAL</td>
<td>The priority of the external kvoop process while it extracts text for Endpoint Discover scans.</td>
</tr>
<tr>
<td>Detection.ENABLE_METADATA.str</td>
<td>off</td>
<td>Allows detection on file metadata when a user attempts to transfer or print a file. If the setting is turned on, you can detect metadata for Microsoft Office and PDF files. For Microsoft Office files, OLE metadata is supported, which includes the fields Title, Subject, Author, and Keywords. For PDF files, only Document Information Dictionary metadata is supported, which includes fields such as Author, Title, Subject, Creation, and Update dates. Extensible Metadata Platform (XMP) content is not detected. Enabling this option can cause false positives.</td>
</tr>
<tr>
<td>Detection.FILE_HEADER_KB_TO_READ</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Name of Setting</td>
<td>Default values</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Detection.FILTER_TIMEOUT.int</td>
<td>420000</td>
<td>The time limit, in milliseconds, for filtering text.</td>
</tr>
<tr>
<td>Detection.LOCAL_DRIVE_KVOOP_PRIORITY.str</td>
<td>BELOW_NORMAL</td>
<td>The priority of the external kvoop process while it extracts text for local drive events.</td>
</tr>
<tr>
<td>Detection.MARKUP_AS_TEXT.str</td>
<td>off</td>
<td>Stops the detection on any text that has XML or HTML tags associated with it.</td>
</tr>
<tr>
<td>Detection.MAX_DETECTION_TIME.int</td>
<td>900000</td>
<td>The maximum amount of time to complete endpoint detection in milliseconds.</td>
</tr>
<tr>
<td>Detection.MAX_FILTER_FILE_SIZE.int</td>
<td>31457280</td>
<td>Maximum file size for text filtering in bytes.</td>
</tr>
<tr>
<td>Detection.MAX_IDM_FILE_SIZE</td>
<td>31457280</td>
<td>Maximum file size for IDM content extraction.</td>
</tr>
<tr>
<td>Detection.MAX_NUM_MATCHES.int</td>
<td>300</td>
<td>Maximum number of matches for a given matcher.</td>
</tr>
<tr>
<td>Detection.MAX_QUEUE_SIZE.int</td>
<td>10000</td>
<td>The maximum number of items that simultaneously wait for detection.</td>
</tr>
<tr>
<td>Detection.MIN_EXTRACTED_CHARS_FOR_TEXT_IDM_MATCH</td>
<td>30</td>
<td>Minimum size of the normalized content before the cracked content will be indexed, otherwise an exact match will be performed against the raw (binary) content. Must match the min_normalized_size parameter in the Indexer.properties file.</td>
</tr>
<tr>
<td>Detection.NEWLINE_ELIMINATION.str</td>
<td>on</td>
<td>Sets whether newlines are eliminated before detection.</td>
</tr>
</tbody>
</table>
**Table 73-1  Agent advanced settings (continued)**

<table>
<thead>
<tr>
<th>Name of Setting</th>
<th>Default values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Detection.RULESRESULTSCACHE_ENABLED.str</td>
<td>on</td>
<td>Rules results caching (RRC) is a way to cache the results of content on a Symantec DLP Agent that does not violate a policy.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “About rules results caching (RRC)” on page 1403.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>By default, RRC is set to on. If you do not want to use RRC, set this parameter to off.</td>
</tr>
<tr>
<td>Detection.RULESRESULTSCACHE_FAST_CACHE_SIZE.int</td>
<td>1024</td>
<td>The size of the rules results caching first-level database, the Level 1 database. Rules results caching sends new entries of recorded, non-violating files to the Level 1 database. After the Level 1 database is full, entries are flushed to the Level 2 database to maintain the space of the Level 1 database.</td>
</tr>
<tr>
<td>Detection.SHORT_DAR_DETECTION_TIME.int</td>
<td>2000</td>
<td>The amount of time, in milliseconds, taken to detect on a file before the file is considered too large.</td>
</tr>
<tr>
<td>Detection.TRACKED.CHANGES.str</td>
<td>off</td>
<td>Allows the detection of content that has changed over time (Track Changes content) in Microsoft Office documents. Using this option might reduce the accuracy rate for IDM and data identifiers.</td>
</tr>
</tbody>
</table>
Table 73-1  
Agent advanced settings (continued)

<table>
<thead>
<tr>
<th>Name of Setting</th>
<th>Default values</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Detection.TWO_TIER_IDM_ENABLED.str** | See description | Enables two-tier detection for IDM for the DLP Agent. Set to "off" to use exact match IDM on the endpoint. Set to "on" to use two-tier detection.  
For new installations the default is set to "off" so that by default the DLP Agent uses exact match IDM on the endpoint.  
For upgrades the default is set to "on" so that there is no change in functionality for existing IDM policies deployed to the endpoint.  
See "Using agent IDM after upgrade to version 12.5" on page 494. |
| **Detection.UNICODE_NORMALIZATION.str** | on | Transforms the specific characters to UNICODE before detection. This transformation is necessary for matching policies containing data in many Asian languages. |
| **Discover.CRAWLER_THREAD_PRIORITY.str** | BELOW_NORMAL | The priority of the Discover threads while drives are scanned. |
| **Discover.POST_SCAN_REPORT_INTERVAL.int** | 60000 | The interval of time, in milliseconds, between two Endpoint Discover status reports. Occurs after the agent has reached end of scan but before the overall scan is finished or aborted.  
This setting only applies to 12.0.x and earlier agents. |
<table>
<thead>
<tr>
<th>Name of Setting</th>
<th>Default values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discover.SCAN_ONLY_WHEN_IDLE.int</td>
<td>2</td>
<td>Sets whether the agent performs an Endpoint Discover scan while the endpoint user is idle.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If set to 1, the agent only performs Endpoint Discover scanning while the endpoint user is idle.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If set to 2, the agent only scans small files while the endpoint is active and larger files while the endpoint user is idle. Files taking longer than Detection.SHORT_DAR_DETECTION_TIME seconds are considered large.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If set to 0, the scan runs regardless of user activity.</td>
</tr>
<tr>
<td>Discover.SECONDS_UNTIL_IDLE.int</td>
<td>120</td>
<td>If the agent does not detect any user activity in this amount of time, in seconds, the user is considered to be idle. Very small amounts of time, less than 60 seconds, may not be precisely adhered to.</td>
</tr>
<tr>
<td>Discover.STANDARD_REPORT_INTERVAL.int</td>
<td>60000</td>
<td>The interval of time between two Endpoint Discover scan status reports, in milliseconds.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>To create a transient connection between the agent and Endpoint Server, enter an interval greater than the EndpointCommunications.IDLE_TIMEOUT_IN SECONDS.int value.</td>
</tr>
<tr>
<td>Name of Setting</td>
<td>Default values</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------------</td>
<td>----------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>EndpointCommunications.HEARTBEAT_INTERVAL_IN_SECONDS.int</td>
<td>270</td>
<td>Time interval in seconds between heartbeat messages. The Endpoint Server sends heartbeat messages to detect dead connections to individual agents when no other traffic is being sent or received. The Endpoint Server measures the time between when the last data traffic was sent to or received by the agent until the current time. Data traffic is defined as any bytes sent or received by the Endpoint Server, including heartbeat message bytes. When the specified duration is exceeded, the Endpoint Server sends a heartbeat message to the agent. If the value of the setting in the agent configuration changes, the new value is applied immediately to any connections that are open to agents for which the configuration applies, and to any subsequent connections. <strong>Note:</strong> Application-defined heartbeat messages are treated by network appliances as actual traffic and, unlike TCP keepalives, are never ignored. Heartbeat messages do not count as normal messages for the purpose of determining whether the connection is idle. Sending or receiving a heartbeat message does not reset the idle timer. Enter a value between 0 and 1000000000. Enter 0 to disable the agent heartbeat.</td>
</tr>
<tr>
<td>Name of Setting</td>
<td>Default values</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>----------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Endpoint_Communications.IDLE_TIMEOUT_IN_SECONDS.int</td>
<td>30</td>
<td>The maximum time to keep an idle connection open. The connection is closed when the specified number of seconds has passed. This timeout only applies during the normal operation phase of a connection. This occurs after the SSL handshake and application handshake phases. Enter a value between 0 and 1000000000. Enter 0 to prevent idle connections from closing.</td>
</tr>
<tr>
<td>FileService.MAX_CACHE_SIZE.int</td>
<td>250</td>
<td>The maximum number of recently opened file paths that have been recorded for each endpoint process.</td>
</tr>
<tr>
<td>FileSystem.DRIVER_FILE_OPEN_REQUEST_TIMEOUT.int</td>
<td>10</td>
<td>Lets you configure the timeout value, in seconds, for a file open request that is sent from a driver to the agent. This setting is helpful in case the file system connector is slow in responding to the driver. If the connection is slow, the system performs badly. Each file open request is postponed by the driver waiting for the agent to respond. You cannot leave this setting blank and a value of 0 is not allowed.</td>
</tr>
<tr>
<td>FileSystem.ENABLE_FILE_RESTORATION.int</td>
<td>1</td>
<td>This setting provides the ability to turn on or turn off file restoration. File restoration is the ability to restore the original file in case it is overwritten with a newer file containing confidential data. File restoration is enabled by default. Enter 0 to disable this setting.</td>
</tr>
<tr>
<td>Name of Setting</td>
<td>Default values</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>----------------</td>
<td>-------------</td>
</tr>
<tr>
<td>FileSystem.ENABLE_VEP_FILE_ELIMINATION.int</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>Name of Setting</td>
<td>Default values</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>----------------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>When the setting is enabled, the system does not create a .vep file. Instead it runs detection on the original file and resolves any sharing violations for \texttt{EDPA.exe} and \texttt{KVOOP.exe}, when needed.</td>
</tr>
</tbody>
</table>

**Note:** Enable this setting if your environment does not contain any of the following:

- Data retention policies
- Two-tier detection policies
- Endpoint Discover or Endpoint Prevent encryption software

You can use the following values:

- 0 creates a .vep file for all channels.
- 1 runs detection on the original file. A .vep file is created for scanned files that are moved to removable drives.
- 2 runs detection on files moving through the application file access channel. A .vep file is created for all scanned files.
- 3 runs detection on files moving through the application file access and removable channels. A .vep file is created for all other scanned files.
- 4 runs detection on files moving through network shares. A .vep file is created for all other scanned files.
- 5 runs detection on files moving through network shares and removable drives. A .vep file is created for all...
Table 73-1  Agent advanced settings (continued)

<table>
<thead>
<tr>
<th>Name of Setting</th>
<th>Default values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FileSystem.IGNORE_STORAGE_BUS_TYPE.int</td>
<td>None</td>
<td>This setting controls whether storage devices are ignored or not. Enter None to monitor all storage devices. Enter All to ignore all removable devices.</td>
</tr>
<tr>
<td>FileSystem.MAX_BACKLOG</td>
<td>20</td>
<td>The maximum number of snapshot files that are created when removable storage is monitored.</td>
</tr>
<tr>
<td>FileSystem.MONITOR_APPLICATION_CHILD_PROCESS_FILE_ACCESS.INT</td>
<td>1</td>
<td>This setting allows the user to enable or disable the Application File Access feature that monitors child processes. Enter 1 to enable or enter 0 to disable.</td>
</tr>
<tr>
<td>FileSystem.NUM_OF_LISTENER_THREADS</td>
<td>1</td>
<td>The number of listener threads that listen to file system driver requests. You can enter any positive integer value.</td>
</tr>
<tr>
<td>FileSystem.NUM_TIMES_TO_OVERWRITE_FILE.int</td>
<td>2</td>
<td>This setting indicates how many times a file is overwritten with a secure pattern before it is deleted during prevention. A value of 0 indicates that the file cannot be overwritten.</td>
</tr>
<tr>
<td>Name of Setting</td>
<td>Default values</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>FileSystem.THREAD_POOL_MAX_CAPACITY</td>
<td>20</td>
<td>The maximum number of threads that the filesystem threadpool can use to serve file system requests.</td>
</tr>
<tr>
<td>FileSystem.USE_CDDVD_DEFAULT_EXCLUDE_PATHS.int</td>
<td>1</td>
<td>This setting allows user to exclude any file that is opened by a CD/DVD application from the following directories:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Installed directory of the application; for example, if the application is Roxio, then c:\program files\roxio</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ System directories; for example, %windir%\system32</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Program Files\Common Files</td>
</tr>
<tr>
<td></td>
<td></td>
<td>It is enabled by default.</td>
</tr>
<tr>
<td>FlexResponse.MAX_INCIDENT_FILE_SIZE.int</td>
<td>31457280</td>
<td>Reserved for future use.</td>
</tr>
<tr>
<td>FlexResponse.PLUGIN_HOST_LOG_MAXFILE_SIZE.long</td>
<td>5120000</td>
<td>The maximum size of a plug-in log file. The default number is in bytes.</td>
</tr>
<tr>
<td>FlexResponse.PLUGIN_HOST_LOG_MAX_NUMBER_OF_FILES.long</td>
<td>1</td>
<td>The maximum number of plug-in log files that can be kept.</td>
</tr>
<tr>
<td>FlexResponse.PLUGIN_HOST_MESSAGE_TIMEOUT.long</td>
<td>180000</td>
<td>The amount of time that the plug-in host can process messages. The default time is in milliseconds.</td>
</tr>
<tr>
<td>FlexResponse.PLUGIN_HOST_STARTUP_TIMEOUT.long</td>
<td>30000</td>
<td>The amount of time that the plug-in host can take to start up. The default time is in milliseconds. If the plug-in host does not start in the specified amount of time, the plug-in host sends a fail event to the log.</td>
</tr>
<tr>
<td>FlexResponse.PLUGIN_QUEUE_LIMIT</td>
<td>100</td>
<td>The number of FlexResponse plugin invocation requests placed in queue.</td>
</tr>
<tr>
<td>Name of Setting</td>
<td>Default values</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------------</td>
<td>----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>GroupResolution.DAYS_DATA_STALING.int</td>
<td>7</td>
<td>The amount of time, in days, that the agent retains Active Directory (AD) user group information. Information that is older than this limit causes the agent to contact the AD server.</td>
</tr>
<tr>
<td>Hooking.APPLICATION_LOAD_TIMEOUT.int</td>
<td>300000</td>
<td>Specifies the time, in milliseconds, that the agent tries to hook into an application if that application takes a long time to load.</td>
</tr>
<tr>
<td>Hooking.EXPLORER_APPLICATION_HOOKING.int</td>
<td>1</td>
<td>Allows the DLP Agent to monitor when a user performs a right-click print through Windows Explorer. To turn off right-click print monitoring, change this setting to 0.</td>
</tr>
<tr>
<td>Hooking.EXPLORER_HOOKING.int</td>
<td>3</td>
<td>Allows the DLP Agent to monitor Microsoft Windows Explorer traffic.</td>
</tr>
</tbody>
</table>
| Hooking.USE_LOADLIBRARYW_FROM_IMAGE.int                                       | 0              | The method to find the LoadLibraryW function address. You can specify a value of either 0 or 1.  
0 uses the GetProcAddress API to find the library.  
1 reads the exports table of kernel32.dll to find the library. |
| IE8_HTTPS.Monitor.int                                                         | 1              | Sets Internet Explorer 8 HTTPS monitoring for Symantec DLP Agents. Internet Explorer 8 HTTPS monitoring for the Symantec DLP Agent is automatic. Monitoring is turned on by default. To turn off Internet Explorer 8 monitoring, change this setting to 0. |
### Table 73-1  
**Agent advanced settings (continued)**

<table>
<thead>
<tr>
<th>Name of Setting</th>
<th>Default values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IncidentHandler.CACHE_SIZE_THRESHOLD.int</td>
<td>30</td>
<td>The percentage of used endpoint database cache space that triggers Endpoint Discover to pause.</td>
</tr>
<tr>
<td>IncidentHandler.MAX_BACKOFF.int</td>
<td>3600000</td>
<td>Maximum time, in milliseconds, to wait before it retries to send an incident to the server if the first attempt fails.</td>
</tr>
<tr>
<td>IncidentHandler.MAX_INCIDENT_FILE_SIZE</td>
<td>31457280</td>
<td>Size, in bytes, of the largest file to be sent from the agent as part of an incident.</td>
</tr>
<tr>
<td>IncidentHandler.MAX_TTD_FILE_SIZE</td>
<td>31457280</td>
<td>Size, in bytes, of the largest file to be sent from agent for two-tier detection.</td>
</tr>
<tr>
<td>IncidentHandler.MIN_BACKOFF.int</td>
<td>30000</td>
<td>Minimum time, in milliseconds, to wait before the agent re-sends an incident to the Endpoint Server after the first attempt fails.</td>
</tr>
<tr>
<td>IncidentHandler.PERSISTER_MAX_DAR_ENTRIES.int</td>
<td>5</td>
<td>The maximum number of persisted Endpoint Discover incidents that are kept in queue.</td>
</tr>
<tr>
<td>IncidentHandler.PERSISTER_MAX_ENTRIES.int</td>
<td>25</td>
<td>The maximum limit of incidents in the Agent Store before the agent starts evicting incidents.</td>
</tr>
<tr>
<td>IncidentHandler.SENDER_CHUNK_SIZE.int</td>
<td>65536</td>
<td>Size, in bytes, of chunks to read from the database as it sends files.</td>
</tr>
<tr>
<td>Logging.OperationLogFileSize.long</td>
<td>5120000</td>
<td>The size of the operational log file. This setting specifies how large, in bytes, each operational log can be. Logs that exceed this setting are not retained.</td>
</tr>
<tr>
<td>Name of Setting</td>
<td>Default values</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Logging.OperationLogMaxFiles.int</td>
<td>30</td>
<td>The maximum number of operation logs, per scan, that are retained at any one time. If this number is exceeded, operational log files are purged from the folder until the limit is reached. Log files are purged according to the date that they were created. The oldest log files are purged first. This setting is not applicable to the entire directory.</td>
</tr>
<tr>
<td>Logging.OperationLogTTL.int</td>
<td>90</td>
<td>The number of days that operational logs are kept in the directory. If the operational log is not accessed or modified in the specified number of days, the file is deleted.</td>
</tr>
<tr>
<td>MonitorSystemUsers.CLIPBOARD.int</td>
<td>0</td>
<td>Enables system user monitoring for Clipboard feature. Set to inactive by default. Set to 1 to enable.</td>
</tr>
<tr>
<td>MonitorSystemUsers.LOCAL_DRIVE.int</td>
<td>0</td>
<td>Enables system user monitoring for the local drive feature. Set to inactive by default. Set to 1 to enable.</td>
</tr>
<tr>
<td>MonitorSystemUsers.NETWORK.int</td>
<td>0</td>
<td>Enables system user monitoring for network protocols in the driver (HTTP, FTP). Set to inactive by default. Set to 1 to enable.</td>
</tr>
<tr>
<td>MonitorSystemUsers.PRINT_FAX.int</td>
<td>0</td>
<td>Enables system user monitoring for print/fax feature. By default, this feature is set to inactive. Set to 1 to enable.</td>
</tr>
<tr>
<td>NetworkMonitor.ENABLE_HTTP_GET_MONITORING.int</td>
<td>0</td>
<td>Enables HTTP/HTTPS GET request monitoring. By default, this setting is disabled. Set to 1 to enable.</td>
</tr>
<tr>
<td>Name of Setting</td>
<td>Default values</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------------</td>
<td>----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>NetworkMonitor.HTTP_DETECTION_TIMEOUT.int</td>
<td>120</td>
<td>The length of time, in seconds, that the agent waits during a scan of HTTP and HTTPS data.</td>
</tr>
<tr>
<td>NetworkMonitor.IM_DETECTION_SESSION_TIMEOUT.int</td>
<td>120</td>
<td>The duration, in seconds, of the detection session window for all instant messaging clients.</td>
</tr>
<tr>
<td>PluginInstaller.TAMPERPROOFING_IGNORE_PROCESS_TIMEOUT.int</td>
<td>15000</td>
<td>Lets you specify a time, in milliseconds, to ignore any short-lived processes that do not load plug-ins. If the process ends before this time limit is reached, the plug-in installer does not start.</td>
</tr>
<tr>
<td>PostProcessor.ENABLE_FLEXRESPONSE.int</td>
<td>0</td>
<td>Lets you enable or disable Endpoint FlexResponse capability. By default, Endpoint FlexResponse is turned off. Change the setting to 1 to enable Endpoint FlexResponse.</td>
</tr>
<tr>
<td>PostProcessor.FILE_SYSTEM_USER_RESPONSE_TIMEOUT.int</td>
<td>60</td>
<td>The amount of time, in seconds, that endpoint users have to select a response action to the User Cancel pop-up notification. This setting only applies to events that are generated by attempting to transfer files that violate a policy.</td>
</tr>
<tr>
<td>PostProcessor.NETWORK_USER_RESPONSE_TIMEOUT.int</td>
<td>60</td>
<td>The amount of time, in seconds, that endpoint users have to select a response action to the User Cancel pop-up notification. This setting applies to HTTP, FTP, and IM events only.</td>
</tr>
<tr>
<td>PostProcessor.NOTIFY_ON_FIXED_DRIVE.int</td>
<td>0</td>
<td>Enables the response notifications for fixed-drive incidents. The default is set to disable notifications. Set to 1 to enable.</td>
</tr>
<tr>
<td>Name of Setting</td>
<td>Default values</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------------------------------</td>
<td>----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>PostProcessor.NOTIFY_WITH_CANCEL_DEFAULT_ACTION</td>
<td>1</td>
<td>The default action to take if an endpoint user does not select the action from the User Cancel pop-up notification within the specified time. Enter 1 to block the action or enter 0 to allow the action.</td>
</tr>
<tr>
<td>PostProcessor.OTHER_USER_RESPONSE_TIMEOUT</td>
<td>60</td>
<td>The amount of time, in seconds, that endpoint users have to select a response action to the User Cancel pop-up notification. This setting only applies to Clipboard, Print, Email, and HTTPS events.</td>
</tr>
<tr>
<td>Quarantine.MAX_QUEUE_SIZE.int</td>
<td>100</td>
<td>The maximum number of quarantine requests that can be in the queue at any one time. Requests that exceed this number are dropped and are not quarantined.</td>
</tr>
<tr>
<td>ResponseCache.AFAC_TIMEOUT</td>
<td>10000</td>
<td>The amount of time that an application file access incident is cached. Duplicate incidents that occur during this time period are not generated and do not trigger response rule messages.</td>
</tr>
<tr>
<td>ResponseCache.CD_TIMEOUT.int</td>
<td>2000</td>
<td>The amount of time, in milliseconds, that a CD/DVD incident is cached. Duplicate incidents within this time period are not generated or cause Prevent pop-up notifications.</td>
</tr>
<tr>
<td>ResponseCache.FTP_TIMEOUT.int</td>
<td>10000</td>
<td>The amount of time, in milliseconds, that an FTP incident is cached. Duplicate incidents within this time period are not generated or cause Prevent pop-up notifications.</td>
</tr>
</tbody>
</table>

Table 73-1   Agent advanced settings (continued)
<table>
<thead>
<tr>
<th>Name of Setting</th>
<th>Default values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ResponseCache.HTTP_TIMEOUT.int</td>
<td>2000</td>
<td>The amount of time, in milliseconds, that an HTTP/HTTPS incident is cached. Duplicate incidents within this time period are not generated or cause Prevent pop-up notifications.</td>
</tr>
<tr>
<td>ResponseCache.MAX_SIZE.int</td>
<td>100</td>
<td>The maximum number of incidents that are cached at any time.</td>
</tr>
<tr>
<td>ServerCommunication.CONNECTION_INTERVAL_SECONDS.int</td>
<td>86400</td>
<td>This setting only applies to 12.0.x and earlier agents.</td>
</tr>
<tr>
<td>ServerCommunication.CONNECTION_RETRY_ATTEMPTS.int</td>
<td>10</td>
<td>This setting only applies to 12.0.x and earlier agents.</td>
</tr>
<tr>
<td>ServerCommunication.CONNECTION_RETRY_INTERVAL_SECONDS.int</td>
<td>10</td>
<td>This setting only applies to 12.0.x and earlier agents.</td>
</tr>
<tr>
<td>ServerCommunication.CONNECT_WHEN_IP_CHANGES.int</td>
<td>1</td>
<td>This setting only applies to 12.0.x and earlier agents.</td>
</tr>
<tr>
<td>ServerCommunicator.CONNECT_BACKOFF_DURATION_MULTIPLIER.int</td>
<td>2</td>
<td>The factor by which each the last backoff period is multiplied.</td>
</tr>
<tr>
<td>ServerCommunicator.CONNECT_POLLING_INTERVAL_SECONDS.int</td>
<td>900</td>
<td>The amount of time, in seconds, that the agent waits before it initiates connections. The minimum value you enter depends on the minimum time difference between when the Enforce Server and Endpoint Server communicate. Entering 10 is the minimum value you can enter to maintain a persistent connection. You can enter a value between 60 and 86400 seconds to maintain a non persistent connection.</td>
</tr>
<tr>
<td>Name of Setting</td>
<td>Default values</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>----------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ServerCommunicator.INITIAL_CONNECT_BACKOFF_DURATION_SECONDS.int</td>
<td>30</td>
<td>The duration of time, in seconds, that the agent should backoff after the first backoff error. Enter a value less than the ServerCommunicator.MAX_CONNECT_BACKOFF_DURATION_SECONDS.int value.</td>
</tr>
<tr>
<td>ServerCommunicator.MAX_CONNECT_BACKOFF_DURATION_SECONDS.int</td>
<td>1800</td>
<td>The maximum duration of time, in seconds, that an agent should spend in back off before it fails over to the next server. You can enter a value between 60 and 86400 seconds.</td>
</tr>
<tr>
<td>ServerRedundancy.FAILOVER_INTERVAL.long</td>
<td>3600</td>
<td>Interval of time, in seconds, an agent spends trying to connect to an Endpoint Server before it tries to failover to a new Endpoint Server.</td>
</tr>
<tr>
<td>ServerRedundancy.MAX_TIME_BETWEEN_CONNECTION_ATTEMPTS.long</td>
<td>600</td>
<td>The maximum amount of time, in seconds, the agent waits between connection retries to the same Endpoint Server.</td>
</tr>
<tr>
<td>Transport.ALLOW_EXPIRED_CERTIFICATES.int</td>
<td>1</td>
<td>Controls whether or not expired certificates are accepted. This setting applied to all new agent connections.</td>
</tr>
<tr>
<td>Transport.AUTO_FLUSH_LIMIT_KILOBYTES.int</td>
<td>16</td>
<td>The maximum amount of outbound data, in kilobytes, to enqueue for a connection before auto-flushing. Enter a value less than the Transport.MAX_OUTBOUND_KILOBYTES_TO_BUFFER.int value.</td>
</tr>
<tr>
<td>Name of Setting</td>
<td>Default values</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------------------------</td>
<td>----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Transport.DNS_HOST_CACHE_TIMEOUT_SECONDS.int</td>
<td>86,400</td>
<td>The timeout in seconds for DNS host cache. Name resolves are kept in memory for this number of seconds. Set to zero to completely disable caching, or set to -1 to save all cached entries. This setting applies to all new agent connections. You can enter a value between -1 and 604800 seconds.</td>
</tr>
<tr>
<td>Transport.MAX_CONNECT_WAIT_SECONDS.int</td>
<td>30</td>
<td>The time in seconds to wait for the connect call to succeed. This setting applies to all new agent connections. You can enter a value between 1 and 300 seconds.</td>
</tr>
<tr>
<td>Transport.MAX_INBOUND_KILOBYTES_TO_BUFFER.int</td>
<td>100</td>
<td>The maximum of inbound data, in kilobytes, to enqueue for a connection. You can enter a value between 16 and 2048.</td>
</tr>
<tr>
<td>Transport.MAX_OUTBOUND_KILOBYTES_TO_BUFFER.int</td>
<td>100</td>
<td>The maximum amount of outbound data, in kilobytes, to queue for a connection. You can enter a value between 16 and 2048. Enter a value greater than the CommLayer.MAX_FRAME_SIZE_KILOBYTES.int value.</td>
</tr>
</tbody>
</table>
Table 73-1  Agent advanced settings (continued)

<table>
<thead>
<tr>
<th>Name of Setting</th>
<th>Default values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transport.MAX_SSL_SESSION_LIFETIME_SECONDS.int</td>
<td>86,400</td>
<td>The time duration in seconds for which agent re-uses an SSL session ID. When the duration equal to the configured value elapses, the SSL session ID is discarded by the agent and a new SSL session is established on the subsequent connection with the Endpoint Server. This setting applies to new agent connections. Enter 0 to disable SSL re-use.</td>
</tr>
<tr>
<td>Transport.VERIFY_SERVER_HOSTNAME</td>
<td>0</td>
<td>When enabled, the Enforce Server verifies the server distinguished or common name mentioned in the server certificate during the SSL handshake process. This setting applies to new connections. Enter 1 to enable and 0 to disable.</td>
</tr>
<tr>
<td>UI.BUTTON_OK.str</td>
<td>OK</td>
<td>Controls the text on the <strong>OK</strong> button on the user-facing notification message. Change this setting if you use a locale that is not supported. The default language is English.</td>
</tr>
<tr>
<td>UI.BUTTON_OKTOALL.str</td>
<td>OK To All</td>
<td>Controls the text on the <strong>OK To All</strong> button on the user-facing notification message. Change this setting if you use a locale that is not supported. The default language is English.</td>
</tr>
<tr>
<td>UI.CONSECUTIVE_TRANSACTION_TIME.str</td>
<td>10</td>
<td>Maximum time, in seconds, between two file operations to be considered as a single transaction.</td>
</tr>
<tr>
<td>Name of Setting</td>
<td>Default values</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>----------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>UI.MONITOR_MSG_TITLE.str</td>
<td></td>
<td>The message title for a notification pop-up message.</td>
</tr>
<tr>
<td>UI.MONITOR_TITLEBAR.str</td>
<td>Warning</td>
<td>Controls the static title message in the title bar for the Endpoint Notify notification pop-up message. Change this setting if you use a locale that is not supported. The default setting is Warning.</td>
</tr>
<tr>
<td>UI.NOTIFY_CANCEL_MSG_TITLE</td>
<td>Blank</td>
<td>Enter text here to customize the User Cancel response rule message title.</td>
</tr>
<tr>
<td>UI.NOTIFY_CANCEL_TITLEBAR</td>
<td>Blank</td>
<td>Enter text here to customize the User Cancel response rule dialog title.</td>
</tr>
<tr>
<td>UI.NO_SCAN.int</td>
<td>0</td>
<td>If any number other than zero, the scan dialog does not display.</td>
</tr>
<tr>
<td>UI.NWC_EVENT_LIMIT_FS.int</td>
<td>5</td>
<td>The maximum number of events that can be queued before a default action for further incidents is accepted. This setting applies to File System events only.</td>
</tr>
<tr>
<td>UI.NWC_EVENT_LIMIT_NW.int</td>
<td>2</td>
<td>The maximum number of events that can be queued before a default action for further incidents is accepted. This setting applies to Network events only.</td>
</tr>
<tr>
<td>UI.POPUP_QUEUE_LIMIT.int</td>
<td>100</td>
<td>The limit of pop-up notifications that a user sees in a single session. These pop-up notifications require a user justification for the validation. If the limit is exceeded, any pop-up notifications past the limit automatically contain a Not Applicable (N/A) justification.</td>
</tr>
</tbody>
</table>
### Table 73-1  
**Agent advanced settings (continued)**

<table>
<thead>
<tr>
<th>Name of Setting</th>
<th>Default values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UI.PREVENT_MSG_TITLE.str</td>
<td></td>
<td>Message title for a block pop-up message.</td>
</tr>
<tr>
<td>UI.PREVENT_TIMEOUT.int</td>
<td>300</td>
<td>Timeout value, in seconds, before the incident is generated. If this limit is exceeded, the incident is created regardless of what the user chooses from the pop-up window.</td>
</tr>
<tr>
<td>UI.PREVENT_TITLEBAR.str</td>
<td>Blocked</td>
<td>Controls the static title message in the title bar for the Endpoint block notification pop-up dialog box.</td>
</tr>
<tr>
<td>UI.PREVENT_WINPOSITION.int</td>
<td>0</td>
<td>Start position of the Prevent dialog window.</td>
</tr>
<tr>
<td>UI.QUARANTINE_PROMPT.str</td>
<td>The file is quarantined at:</td>
<td>Controls the text that specifies where the quarantined data is located.</td>
</tr>
<tr>
<td>UI.SCAN_BAR.str</td>
<td>(blank)</td>
<td>This setting lets you change the text in the body of the scan window. This text is static and appears regardless of the locale of the endpoint.</td>
</tr>
<tr>
<td>UI.SCAN_DELAY.int</td>
<td>0</td>
<td>The amount of time, in seconds, that occurs before the scan dialog window is displayed.</td>
</tr>
<tr>
<td>UI.SCAN_EMAIL.int</td>
<td>0</td>
<td>This setting activates the toggle for email scanning. If this setting is set to 0, users cannot select email monitoring.</td>
</tr>
<tr>
<td>UI.SCAN_FTP.int</td>
<td>0</td>
<td>This setting activates the toggle for FTP scanning. If this setting is set to 0, users cannot select FTP monitoring.</td>
</tr>
<tr>
<td>Name of Setting</td>
<td>Default values</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>UI.SCAN_HTTP.int</td>
<td>0</td>
<td>This setting activates the toggle for HTTP monitoring. If this setting is set to 0, users cannot select HTTP monitoring.</td>
</tr>
<tr>
<td>UI.SCAN_IM.int</td>
<td>0</td>
<td>This setting activates the toggle for instant message (IM) scanning. If this setting is set to 0, users cannot select IM monitoring.</td>
</tr>
<tr>
<td>UI.SCAN_PRINTFAX.int</td>
<td>0</td>
<td>This setting activates the toggle for Print/Fax scanning. If this setting is set to 0, users cannot select Print/Fax monitoring.</td>
</tr>
<tr>
<td>UI.SCAN_REMOVABLEMEDIA.int</td>
<td>1</td>
<td>This setting activates the toggle for removable media scanning. If this setting is set to 0, users do not have the option of selecting removable media monitoring.</td>
</tr>
<tr>
<td>UI.SCAN_SHOWTIME.int</td>
<td>2</td>
<td>Minimum time, in seconds, for the scan dialog to remain on the screen.</td>
</tr>
<tr>
<td>UI.SCAN_TITLE.str</td>
<td>(blank)</td>
<td>This setting lets you enter the title of the scan window that appears for the user. This title is a static message that appears regardless of the locale of the endpoint.</td>
</tr>
<tr>
<td>UI.USERINPUT_PROMPT.str</td>
<td>Others:</td>
<td>Controls the prompt that appears in the block and notify pop-up messages at the user input field. Change this prompt if you use a locale that is not supported. The default setting is in English.</td>
</tr>
<tr>
<td>UninstallPassword.RETRY_LIMIT.int</td>
<td>3</td>
<td>Defines the number of times a user can attempt to uninstall the DLP agent without entering the correct uninstall password.</td>
</tr>
</tbody>
</table>
Applying agent configurations to an agent group

You can apply any agent configuration to any agent group. Use the **Apply Configuration** page to assign agent configurations to your agent groups.

See “About agent configurations” on page 1405.

Applying an agent configuration to an agent group

1. Go to the **System > Agents > Agent Configuration** screen.
2. Click the **Apply Configuration** button

   The **Agent Groups** screen displays. When this screen displays, you assign the agent configuration to an agent group to finish applying the agent configuration.

   See “Updating outdated agent configurations” on page 1453.

   See “Adding agent configurations” on page 1406.

   See “Endpoint Server—basic configuration” on page 191.

Configuring the agent connection status

You can set the connection period for agents to specify how long they report. Settings you make on this screen apply to all registered Endpoint Servers. The default setting is 18 hours.

---

**Note:** The setting you enter should be 5 minutes greater than the agent polling interval (ServerCommunicator.CONNECT_POLLING_INTERVAL_SECONDS.int). See “Advanced agent settings” on page 1414.

---

To configure the agent connection status

1. Go to **System > Settings > General**
2. Click **Configure**.
3. Locate the **Agent Connection Status Configuration** area.
4. Enter hours and minutes to specify how much time passes before an agent displays as not reporting.
5. Save your changes.
Enabling the communication channel for 12.0.x and earlier agents

You enable communication between the Endpoint Server and 12.0.x and earlier agents by enabling the communication channel. If you have 12.0.x and earlier agents already installed, and you upgrade Symantec Data Loss Prevention to the latest version, the communication channel for 12.0.x and earlier agents is automatically enabled.

To enable the communication channel for 12.0.x and earlier agents

1. Go to System > Settings > General
2. Click Configure.
3. Select the Enable item under the Communication Channel for 12.0.x and Earlier Agents section.
4. Save your changes.
Working with Agent Groups

This chapter includes the following topics:

- About agent groups
- Developing a strategy for deploying Agent Groups
- Overview of the agent group deployment process
- Migrating pre-12.5 Endpoint deployments to agent groups
- Creating and managing agent attributes
- Viewing and managing agent groups
- Viewing group conflicts
- Changing groups

About agent groups

Agent Groups enable you to group and configure agents according to user-specific or machine-specific characteristics, such as country, location, or department name. These characteristics are called agent attributes. You can use attributes to create groups and assign specific configurations to the groups based on your business needs. Agent Groups can be used to deploy and manage a large number of agents. You can also use Agent Groups to temporarily exempt certain agents, based on attributes, from policies that affect other configurations, for testing purposes.

One Endpoint Server can support multiple Agent Groups. An Endpoint Server can dynamically discover to which agent group a particular agent belongs, based on agent group definitions and agent attributes, and assign the configuration to an agent belonging to the appropriate agent group. Assigning one agent configuration per Endpoint Server is also supported by having a group for the Endpoint Server.
With Agent Groups, attributes of logged-in users and endpoint computers can be used to create group conditions. Symantec Data Loss Prevention provides six predefined attributes. You can create other user-defined attributes based on Active Directory attributes. For example, you can create a group condition based on a location attribute, such as all users (agents) located in New York, and a department attribute, such as all users who are part of the Human Resources department. For that group you can deploy a configuration in which removable storage is monitored. In this example, the Agent Group definition has two conditions: location(s) and department name(s).

Agent groups simplify the management of agent configuration exceptions by allowing a logical grouping of endpoint agents based on conditions. For example, if you have Instant Messenger monitoring enabled for US employees, except for those US employees in the state of Texas, you can have a group named "United States Texas," and disable IM monitoring for that group. Every new agent that is added in the "United States Texas" group automatically gets a configuration with IM monitoring disabled.

You can roll out configuration changes in stages using Agent Groups. In addition, you can create groups for exceptions to monitor particular computers or sets of computers differently. For example, you can create an Executive Staff group for cases when the executive staff is not subject to configurations that apply to the rest of the organization.

The ability to change an agent group action is useful when you need to troubleshoot problems in Symantec Data Loss Prevention. For example, you can create a temporary group that disables certain monitoring and configurations for employees (printing with a specific application, for example) to get around a security issue, then change the employees back to the old group when the printing problem is resolved.

See “Developing a strategy for deploying Agent Groups” on page 1444.

Developing a strategy for deploying Agent Groups

Before you begin implementing Agent Groups, think about the agent configurations that you need in your environment. Here's a high-level checklist of planning tasks:

1. Identify the unique agent configurations that you need in your environment. Think about all of your agents and how you want them grouped.

2. Document who (which agents) gets which configurations.

3. Document the Active Directory attributes that you use to create the groups.

4. Design the groups so that no user belongs to more than one group. In other words, design groups so that there are no overlapping groups.
Overview of the agent group deployment process

Defining and managing user-attribute-based groups involves several tasks and steps, from defining the attributes, creating groups, assigning configurations to deploy the groups, and resolving group conflicts. Table 74-1 provides an overview of the process of deploying agent groups, with cross references to more detailed procedures.

Table 74-1  Implementing your Agent Group Strategy

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>For more information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Define attributes to use for creating groups.</td>
<td>See “Creating and managing agent attributes” on page 1446.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Verify that the attribute definitions are correct using the attribute verification tool.</td>
<td>See “Verifying attribute queries with the Attribute Query Resolver tool” on page 1449.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Push attributes to the agents. The agent receives agent attribute queries and the attribute result set is generated and saved on the agent.</td>
<td>See “Applying a new attribute or changed attribute to agents” on page 1450.</td>
</tr>
<tr>
<td>Step 4</td>
<td>View the attribute values that are reported by the agents to verify that they return the expected attribute values.</td>
<td></td>
</tr>
<tr>
<td>Step 5</td>
<td>Create the groups you want using the defined attributes.</td>
<td>See “Creating a new agent group” on page 1453.</td>
</tr>
<tr>
<td>Step 6</td>
<td>Assign an agent configuration to the group.</td>
<td>See “Assigning configurations to deploy groups” on page 1454.</td>
</tr>
<tr>
<td>Step 7</td>
<td>Verify that assignments are correct by confirming that each group contains the expected number of agents.</td>
<td>See “Viewing and managing agent groups” on page 1451.</td>
</tr>
</tbody>
</table>
Table 74-1 Implementing your Agent Group Strategy (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>For more information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 8</td>
<td>Periodically check if there are any agent group conflicts. If there are conflicts, resolve them.</td>
<td>See “Viewing group conflicts” on page 1455.</td>
</tr>
</tbody>
</table>

See “Migrating pre-12.5 Endpoint deployments to agent groups” on page 1446.

Migrating pre-12.5 Endpoint deployments to agent groups

Agent Groups is backward-compatible with pre-Symantec Data Loss Prevention 12.5 one server per one-agent configurations. When upgrading from previous releases, the upgrade process automatically creates agent groups for each individual existing Endpoint Server and assigns the configuration associated with that server to the corresponding group during upgrade. The pre-12.5 agents continue to get the same configuration that their Endpoint Server had before upgrade. The upgrade process creates a Default Group, and assigns a Default Configuration.

**Note:** Default Groups are available for freshly installed Symantec Data Loss Prevention 12.5 endpoints as well, but an administrator can create a new group for the Endpoint Server.

For example, an administrator can add a new Endpoint Server for the Asia - Pacific - Japan region. Since this is a new deployment, and the configuration management strategy is not yet decided, the administrator is not ready to create various agent groups for APJ region. In this case, the administrator can create an endpoint group for the newly added Endpoint Server and assign one configuration that is specific to the APJ region. This enables the administrator to have one unique configuration for all endpoints from the APJ region that are connected to the newly added Endpoint Server for APJ region. Specific groups addressing business needs for this region can be defined later.

See “Creating and managing agent attributes” on page 1446.

Creating and managing agent attributes

To navigate to the Agent Attributes screen from the System > Agents > Agent Groups screen, click the Manage Agent Attributes link.
Agent Groups are defined using agent attributes. On the Agent Attributes screen, you can see a list of predefined and user-defined attributes. Notice that if the list contains only predefined attributes, the Export, Apply Changes, and Undo Changes buttons are not disabled; these actions can only be taken on user-defined attributes.

From this screen you can use the buttons to
- Create new attributes - See “Creating a new agent attribute” on page 1448.
- Export attributes - See “Verifying attribute queries with the Attribute Query Resolver tool” on page 1449.
- Apply attribute changes. Note that attribute’s values are not fetched from Active Directory until you click Apply - See “Applying a new attribute or changed attribute to agents” on page 1450.
- Undo attributes changes - See “Undoing changes to agent attributes” on page 1451.

Use the Filters button to filter the list of attributes by any of the headings.

There are two types of agent attributes, predefined and user-defined. Predefined attributes cannot be deleted or modified. Symantec Data Loss Prevention provides six predefined attributes:

**Table 74-2**  
Predefined attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent Host Domain</td>
<td>Domain to which the agent host computer is joined</td>
</tr>
<tr>
<td>Logged in User Domain</td>
<td>Current logged-in user domain</td>
</tr>
<tr>
<td>Agent Host Name</td>
<td>Computer name of endpoint where the agent is installed</td>
</tr>
<tr>
<td>Agent Host Type</td>
<td>Operating system architecture; for example x86 or x64</td>
</tr>
<tr>
<td>Agent Host Version</td>
<td>Operating system; for example, Mac OS, Windows 7</td>
</tr>
<tr>
<td>Logged in User</td>
<td>Current logged-in user</td>
</tr>
</tbody>
</table>

User-defined attributes are created by the administrator for the purpose of creating groups. You can create user-defined attributes based on Active Directory (AD) attributes. User-defined attributes can be deleted or modified.
Creating a new agent attribute

You can create a logical grouping of endpoint agents based on conditions based on user-defined agent attributes. For user-defined attributes, the agent executes an Active Directory query that can resolve the attribute values. When an agent starts up, queries are executed and the attribute results are cached.

To create user-defined attributes, follow these steps:

1. Choose **Agent Groups** from the **System > Agents** menu. Then, click the **Manage Agent Attributes** link.
2. On the **Agent Attributes** screen, click **New** to begin the attribute creation process.
   
   A **Configure Agent Attribute** screen appears.
3. Add the name of the attribute. Names can contain 1 to 100 characters.
4. Add a description of attribute. Descriptions must contain only alpha and numeric characters.
5. Select a domain, either User Domain or Machine Domain.
   
   There are two types of attributes for user-defined agent groups:
   
   - User Domain - Attributes related to the logged-in user; for example, the domain attribute "department."
   - Computer domain - Attributes related to the computer; for example, computer attribute "location."
6. Add a search filter. You can select from existing applied attributes to define a search filter.
   
   See “Defining a search filter for creating user-defined attributes” on page 1449.
7. Specify an Active Directory attribute.
   
   Only Active Directory attributes are supported for user-defined agent group attributes.
8. Click **Save**. Clicking **Save** saves your attribute but does not apply it.
9. Test the attribute and fix any issues you find in testing.
   
   To test, export the attribute(s) from the **Attribute List** screen and review the attribute.
Then, use the Attribute Query Resolver test tool that runs on the Windows host where the endpoint is installed, to test the attribute.

See “Verifying attribute queries with the Attribute Query Resolver tool” on page 1449.

10. **Apply** the tested attributes. Agents start reporting attribute values as soon as the agents resolves the attributes on Active Directory.

11. Verify that agents are reporting attribute values. Go to the **System > Agents > Overview > Agent List** screen and verify that the agents are reporting attribute values. You can select a particular agent entry and see the **Preview Pane**. The **Preview Pane** lists all predefined and user-defined attributes and their values, conflicts, and alerts.

See “Using the Agent List screen” on page 1460.

See “Defining a search filter for creating user-defined attributes” on page 1449.

### Defining a search filter for creating user-defined attributes

You can use both Predefined and applied user-defined attributes. The typical syntax for a search filter is

```
(&(objectCategory=Person)
(objectClass=User)(uid=$LoggedinUser$))
```

The value embedded in dollar ($$) signs represents the agent attribute that you can choose when you click the **Select from existing attributes** drop down on the **Configure Agent Attribute** screen.

See “Verifying attribute queries with the Attribute Query Resolver tool” on page 1449.

### Verifying attribute queries with the Attribute Query Resolver tool

You can verify if the attribute definitions are correct with the Attribute Query Resolver tool. First, export the attributes to an XML file:

1. Go to the **System > Agents > Agent Groups > Agent Attributes** screen.
2. Click **Export** to export the attributes data to an XML file.
3. Click **Save File** in the **Opening agent-attributes.xml** dialog.
4. Click **OK** to complete the export task.

Next, use this XML file to test your attributes with the Attribute Query Resolver tool.

**Note:** You must have administrator privileges to run this tool.
1. Copy `AttributeQueryResolver.exe` and `aqp.dll` from the agent distributable tools folder on the endpoint into the same folder.

2. Run the command (for example)

   ```
c:\AttributeQueryResolver.exe -aq=agent-attributes.xml
   ```

3. Attributes with errors display in the output with blank values. For example, if the attribute **User Email** had an error, it displays as **User Email**= with no value. Errors can occur if a user provides an incorrect search filter, if a specified attribute does not exist in Active Directory, or if Active Directory is not reachable.

   You can go to the `AttributeQueryResolver.log` log file to view details for the attribute errors. In this attribute error log, files with no errors display an
   
   **Error code : 0** (no errors). Attributes with errors display an error code and error description. For example, the User Email attribute with a blank attribute in the output (indicating an error) displays an error message that reads:

   ```
   ```

   If you provide an invalid XML file as a parameter to the Attribute Query Resolver tool, or if you do not have appropriate rights to run the tool, the following SEVERE error is logged:

   ```
   AttributeQueryResolver | SEVERE | Query store is not open.
   ```

   If the attribute definitions are correct, you can deploy the attributes to agents. If there are errors, edit the attributes reporting errors, export the attributes, and run them through the Attribute Query Resolver tool. Repeat this process until there are no errors.

   See “Applying a new attribute or changed attribute to agents” on page 1450.

**Applying a new attribute or changed attribute to agents**

Newly created agent attributes appear on the **Agent Attributes** screen labeled as **New**. After you edit an agent attribute, the attribute is in a **Modified** state. In both cases, you must apply the attributes to the agents before they can take effect. To apply the changes to the agents:

1. Click **Apply Changes** on the **Agent Attributes** page.

2. Verify the changes that appear on the **Apply Changes** pop-up and click **Apply Changes**. If you see any discrepancies, click **Cancel** and go back to previous screens to correct your errors.

3. Review the updated **Agent Attributes** screen. The **Status** of your recently applied agent attributes should now read **Up-to-date**.
Undoing changes to agent attributes

After you have modified certain attributes and tested them with the Attribute Query Resolver tool, you may find issues with the modified attributes. You can undo changes to go back to the original state of the attributes. To undo changes, follow these steps:

1. Click **Undo Changes**.
2. In the **Undo Changes** dialog, review the list of changed attributes.
3. Click **Undo Changes** to reverse the most recent changes you made.

See “Editing user-defined agent attributes” on page 1451.

Editing user-defined agent attributes

You can edit user-defined agent attributes from the **System > Agent > >Agent Groups > Agent Attributes** screen:

1. Click the attribute in the **Name** column. User-defined attributes are all of the **Type User Defined**.
2. Edit the attribute fields on the **System > Agents > Agent Groups > Edit Agent Attribute** screen.
3. Click **Save**.

**Note:** You cannot edit Predefined agent attributes.

See “Viewing and managing agent groups” on page 1451.

Viewing and managing agent groups

You can use agent groups to enable logical grouping of your endpoint computers based on conditions. Agent groups can be based on

- Agent attributes
- Endpoint Server names
- Endpoint host names

Agents are evaluated and included in particular groups based on a priority ordering of conditions. The conditions are, from highest priority to lowest:
1. An agent host name that is in the "Always include" list in the agent group definition.

2. An agent that connects to an Endpoint Server group, when a corresponding Endpoint Server group exists.

3. An agent group with a user-defined attribute, where the agent satisfies its group condition.

For example, if an agent can belong to both the "Endpoint host name group" and the "Agent attribute" based group, since the Endpoint host name group has highest priority among all three types of groups, the agent belongs to Endpoint host name group.

Check agent group status and manage agent groups from the System > Agents > Agent Groups screen. To view agent group conflicts, click View Agent Group Conflicts on the right-hand side of the screen.

Information about agent groups is divided into several columns on this page. You can click any column header to sort entries alphanumerically in that column. Click the column header again to sort in reverse order.

Use these buttons to perform the following actions:

- **New** - Create a new agent group.
- **Delete** - Delete the selected agent groups.
- **Enable** - Enable the selected agent groups.
- **Disable** - Disable the selected agent groups.
- **Assign Configuration** - Assign a configuration to created or updated agent groups.
- **Update Configuration** - Update a configuration for the selected agent groups.
- **Filters** - Reorganize this list of agent groups for easier viewing.

See "About agent groups" on page 1443.

See "Overview of the agent group deployment process" on page 1445.

See “Agent group conditions” on page 1452.

### Agent group conditions

An agent group definition can have multiple conditions. In addition, the following operators are supported for group conditions:

- Implicit AND conditions
- OR is supported for a condition by specifying multiple values for the condition
Creating a new agent group

To create an agent group:

1. Go to the System > Agents > Agent Groups screen.
2. Click New to create a new group. This action takes you to the Create New Agent Group screen.
3. Enter the name of the group in the Name field. The name is a required field and must contain from 1 to 100 characters.
4. Add an optional description.
5. Click a button to define the group condition as either User Attributes or Endpoint Server.
6. Select attributes for the condition from the Select Agent Attributes list and assign values to match, to create the condition.
7. Add agent host names to the Always include these agents box if you have agents that you want to always include in this group.
8. Click Save when you are done, or Cancel to start over.
9. Assign the configuration to deploy the group. See “Assigning configurations to deploy groups” on page 1454.

Note: Assigning a configuration to the group activates the group.

See “Overview of the agent group deployment process” on page 1445.
See “Assigning configurations to deploy groups” on page 1454.

Updating outdated agent configurations

When an agent configuration is updated, but before the changes have been applied to an agent group, the agent group has an outdated configuration. Outdated agent configurations appear in the System > Agents > Agent Groups list with their name flagged with a red exclamation mark. To update an outdated group configuration:
1. Choose an agent group to update the configuration on the System > Agents > Agent Groups screen.

2. Click the check box for the agent group with the outdated configuration you want to update.

3. Click Update Configurations.

4. Verify the name and status for the group in the Update Configurations dialog and click OK.

5. Verify that each configuration for the group has been updated by assuring that there is no longer a red exclamation mark following the names of the agent configurations.

**Note:** If an agent is offline, it does not receive an updated configuration until the agent comes online again.

See “Verify that group assignments are correct” on page 1454.

### Assigning configurations to deploy groups

To deploy created or updated groups, you need to assign configurations to the groups. To assign a configuration to a group or set of groups:

1. Select the groups on the System > Agents > Agent Groups screen by clicking the check boxes to the left of each group.

2. Click Assign Configuration in the action bar.

3. Choose a configuration from the Assign Configuration dialog.

4. Click OK in the Assign Configuration dialog box.

5. When the Agent Groups page refreshes, the Assigned Configuration names are displayed for the groups.

See “Updating outdated agent configurations” on page 1453.

### Verify that group assignments are correct

Confirm that you have the expected number of agents in each of the groups:

1. Go to System > Agents > Overview > Summary Reports.

2. Click Advanced Filters & Summarization and choose Summarize By: Agent Groups.

3. Verify that you have the expected number of agents reporting in each of the groups.
Viewing group conflicts

As the Endpoint administrator, you determine the correct agent group for each endpoint computer based on the attribute values that the agent on the endpoint reports to the Endpoint Server. You can avoid group conflicts by carefully planning your implementation. You should also periodically check to see if there are group conflicts.

You can see conflicts on the View Conflicts screen by clicking View Agent Group Conflicts link on the System > Agents > Agent Groups screen. On the View Conflicts screen, under the Conflicting Groups heading, you see the names of the conflicting groups.

If a particular agent can qualify to be a part of more than one group, a conflict arises. For simple conflicts, where group 2 is a subset of group 1, Symantec Data Loss Prevention automatically resolves the conflict in favor of the subset group 2. For example, if you have these two groups:

1. Group US={Country=US}
2. Group Texas={Country=US & State=Texas}

the conflict between group "US" and group "Texas" is resolved to group "Texas" because group "Texas" is a subset of group "US."

No automatic group conflict resolution mechanism exists for non-subset groups that are in conflict. For example, if you have a group called US_HR in which the Country=US and the Department=HR, and a Group US_VP in which the Country=US and the Designation=VP, agents that belong to VPs in the HR department will result in a conflict. Since Department=HR is not a subset of Designation=VP (or vice versa), the conflict cannot be resolved and the agents with conflicts are placed in a warning state and continue to belong to whatever group they belonged to before the conflict arose. For these more complex conflicts, Symantec Data Loss Prevention reports conflicts and you must edit the group definitions to resolve the group conflicts.

See “Changing groups” on page 1455.

Changing groups

You can change groups for agents to have a different configuration on the System > Agents > Agent Groups > Agent List screen. The ability to change an agent configuration from one group to another is useful in many situations, especially when you need to troubleshoot a problem with Symantec Data Loss Prevention.
For example, say that your employees in the group Trading Group Texas have problems printing with the stock trading application. This issue causes a major problem for your business, as traders are not able to work without the ability to print. You can move the agents in Trading Group Texas to a temporary group, called Troubleshoot Trading Group, with print monitoring disabled, until you can troubleshoot the agent endpoints and fix the issue. After the problem is solved, you can change the group back to Trading Group Texas to enable print monitoring.

To change groups for agent configurations:

1. Click the checkboxes for the agent entries that you want to move.
2. Click **Change Group**.
3. Choose a new group from the **System > Agents > Agent List > Agent Group** menu.
4. Click **OK**.

See “About Symantec DLP Agent administration” on page 1457.
Managing Symantec DLP Agents

This chapter includes the following topics:

- About Symantec DLP Agent administration
- About Endpoint Agent logs

About Symantec DLP Agent administration

After you have installed Symantec DLP Agents, you can administer them from the Enforce Server. The Enforce Server provides an interface which can be used to:

- View Symantec DLP Agent information.
- View the status of your deployed Symantec DLP Agents.
- View events for Symantec DLP Agents.
- Generate reports for your deployed Symantec DLP Agents.
- Troubleshoot your deployed Symantec DLP Agents.

To view and manage your Symantec DLP Agents, log on to your Symantec Data Loss Prevention Enforce Server; then, click **System > Agents**.

See “Agent Overview screen” on page 1457.

See “Agent events” on page 1490.

Agent Overview screen

The **Agent Overview** screen provides a summarized view of all deployed DLP Agents. You can use this screen to view the DLP Agent health status and to begin troubleshooting any agents which might report an alert. The DLP Agents are grouped
by status and then they are categorized by alert type. Alert types with the highest number of affected agents are listed first and alert types with the fewest number of affected agents are listed last.

Figure 75-1     Agent Health Dashboard

You can begin troubleshooting an alert by clicking a status icon or by clicking on a link to the left of an alert type. After you click a status icon or link the Agent List screen displays. See “Using the Agent List screen” on page 1460.

The DLP Agents are grouped into the following statuses:

Table 75-1     DLP Agent statuses

<table>
<thead>
<tr>
<th>DLP Agent status</th>
<th>Status description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>An <strong>OK</strong> status indicates that the DLP Agents in this state are operating under normal conditions. This status indicates:</td>
</tr>
<tr>
<td></td>
<td>▪ Services and the file-system drivers for the DLP Agent are running</td>
</tr>
<tr>
<td></td>
<td>▪ The DLP Agent cache is created and available</td>
</tr>
<tr>
<td></td>
<td>▪ The DLP Agent is reporting to the Endpoint Server as expected</td>
</tr>
</tbody>
</table>
Table 75-1  DLP Agent statuses (continued)

<table>
<thead>
<tr>
<th>DLP Agent status</th>
<th>Status description</th>
</tr>
</thead>
</table>
| Warning          | A Warning status indicates that the DLP Agents in this state have experienced conditions which may require attention. Warning agent alerts generally include the following:  
- Downlevel DLP Agent version  
- Active Directory group resolution failure  
- A plug-in error has occurred  
- The DLP Agent needs to be restarted  
The following section provides a comprehensive list of Warning statuses. See “Troubleshooting agent alerts” on page 1493. |
| Critical         | A Critical status indicates that the DLP Agents in this state have experienced conditions that require immediate attention:  
- A driver is not running  
- The DLP Agent version is not compatible with the Endpoint Server  
- Active Directory permissions conflict with Symantec Data Loss Prevention permissions.  
- The DLP Agent cannot report to the Endpoint Server  
The following section provides a comprehensive list of Critical statuses. See “Troubleshooting agent alerts” on page 1493. |

The Agent Overview screen lets you quickly access agent summary reports, agent configurations, and agent groups.

Table 75-2  Agent management features

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
</table>
| Agent Summary Reports | Agent summary reports let you summarize agent information and create reports. See “Using the Summary Reports screen” on page 1467.  
See “Using the Summary Reports for 12.0.x and Earlier Agents screen” on page 1473. |
| Agent Configurations | You can configure agent settings on the Agent Configurations screen. See “About agent configurations” on page 1405. |
Table 75-2  Agent management features (continued)

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent Groups</td>
<td>You can view existing agent groups and resolve agent group conflicts.</td>
</tr>
<tr>
<td></td>
<td>See “About agent groups” on page 1443.</td>
</tr>
<tr>
<td></td>
<td>See “Viewing group conflicts” on page 1455.</td>
</tr>
</tbody>
</table>

See “Using the Agent List screen” on page 1460.
See “Agent events” on page 1490.

Using the Agent List screen

You access the Agents List screen by clicking an agent status or alert type link on the System > Agents > Overview screen. The Agents List screen helps you manage agents by displaying agent details and status. You can also use this screen to modify agents.

See “About agent status” on page 1463.

You use the Summary Reports for 12.0.x and Earlier Agents screen to manage and troubleshoot 12.0.x and earlier agents. See “12.0.x and earlier agent actions” on page 1485.

You can use the Agents List screen to perform agent management tasks.

Note: Use the Filters feature to execute or remove filters you select. See “Agent filtering” on page 1466.
<table>
<thead>
<tr>
<th>Agent management task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Troubleshoot</strong></td>
<td>This menu lets you perform the following troubleshooting tasks:</td>
</tr>
<tr>
<td><strong>Enable</strong></td>
<td>Enables the disabled agents. Enabling an agent enables monitoring on that endpoint. Enabled agents can log events on the Endpoint Server.</td>
</tr>
<tr>
<td><strong>Disable</strong></td>
<td>Stops monitoring and any active scans on agents.</td>
</tr>
<tr>
<td><strong>Set Log Level</strong></td>
<td>Sets the logging level for the specified agent. Symantec Technical Support uses agent logs for troubleshooting purposes. <strong>Note:</strong> It is recommended to contact Symantec Technical Support before you change the log level for an agent. See “About Endpoint Agent logs” on page 1500.</td>
</tr>
<tr>
<td><strong>Reset Log Level</strong></td>
<td>Resets the logging level for the specified agent to the default INFO level. Symantec Technical Support uses agent logs for troubleshooting purposes. See “About Endpoint Agent logs” on page 1500.</td>
</tr>
<tr>
<td><strong>Set Under Investigation</strong></td>
<td>Set if you believe there is some sort of issue with the agent. You can set this status regardless of whether the agent is running, disabled, or shut down. An additional icon, a flag, appears next to the main status icon of the agent.</td>
</tr>
<tr>
<td><strong>Remove Under Investigation</strong></td>
<td>Removes the <strong>Set Under Investigation</strong> status from the selected agents. <strong>Note:</strong> These troubleshooting tasks are also available on the 12.0.x and earlier Summary Reports screen. When you click on an agent on the Agent List screen, detailed information displays in the preview pane. This pane provides additional detail on the agent reporting status.</td>
</tr>
<tr>
<td>Agent management task</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Deletes the agent. When you delete an agent, you remove that agent and all associated events from the Endpoint Server. It is no longer visible in the Enforce Server administration console. Deleting an agent from the Endpoint Server does not mean that it has been uninstalled from the endpoint.</td>
</tr>
<tr>
<td><strong>Change Server</strong></td>
<td>Lets you change the Endpoint Server to which the agent connects. You can specify the primary Endpoint Server as well as secondary Endpoint Servers in case the primary server fails and the agent must switch connections. See “Changing the Endpoint Prevent Server” on page 1490.</td>
</tr>
<tr>
<td><strong>Change Group</strong></td>
<td>Lets you assign the selected agent to an agent group that you select. See “Agent task confirmation screen” on page 1487.</td>
</tr>
<tr>
<td><strong>Restart</strong></td>
<td>Restarts the selected agent.</td>
</tr>
<tr>
<td><strong>Shut Down</strong></td>
<td>Shuts down the selected agent. <strong>Note:</strong> For version 12.5 agents, the Agent Shutdown by service tool event no longer displays on the Agent Events screen (Systems &gt; Agents &gt; Events). However, this event displays for 12.0.x and earlier agents. See “Agent events” on page 1490.</td>
</tr>
</tbody>
</table>
Table 75-3  Agent management tasks (continued)

<table>
<thead>
<tr>
<th>Agent management task</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Pull Logs**         | Lets you pull agent logs and operational logs for the agent. You can pull either the agent logs, or the operational logs, or both sets of logs. Pulling agent logs is a two-step process:  
  ■ Click the **Pull Logs** button to download the agent logs from the endpoint to the Endpoint Server.  
  ■ Download the agent logs from the Endpoint Server through the Enforce Server. You complete this action on the **System > Servers > Logs > Collection** screen.  
  See “Collecting server logs and configuration files” on page 257.  
  When the logs are pulled from the endpoint, they are stored on the Endpoint Server in an unencrypted format. After you collect the logs from the Endpoint Server, the logs are deleted from the Endpoint Server and are stored only on the Enforce Server. You can only collect logs from one endpoint at a time. |

See “Agent Overview screen” on page 1457.  
See “About filters and summary options for reports” on page 1046.  
See “Agent events” on page 1490.  
See “Using the Summary Reports screen” on page 1467.

**About agent status**

The Agent List screen displays current agent information. You can use this information to review agent status, last update time, agent operating system, and version. Table 75-4 provides a list of agent statuses and details.
### Table 75-4  Agent status

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Displays the current agent status. Agent status includes the following:</td>
</tr>
<tr>
<td></td>
<td>■ <strong>OK</strong></td>
</tr>
<tr>
<td></td>
<td>Indicates the agent service and file-system driver are running, that the cache is created and available, and that the connection functions as expected.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Warning</strong></td>
</tr>
<tr>
<td></td>
<td>Indicates the agent may need attention. For example, Symantec Data Loss Prevention assigns this status when the endpoint data share nears its storage limit.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Critical</strong></td>
</tr>
<tr>
<td></td>
<td>Indicates that the agent is experiencing transitory connection problems. The agent may have been down for a period of time. Policy and configuration may be out of date. The agent may not be compatible with the Enforce Server.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Investigating</strong></td>
</tr>
<tr>
<td></td>
<td>Indicates that the agent in question is under investigation. Agents may be under investigation for a number of reasons. These reasons include sending too many false positive incidents, and being unable to connect to the Endpoint Server.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Not Investigating</strong></td>
</tr>
<tr>
<td></td>
<td>You select this item to remove an agent from investigation.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>LogLevelChanged</strong></td>
</tr>
<tr>
<td></td>
<td>Indicates that the log level for the agent has been changed or reset. See “About Endpoint Agent logs” on page 1500.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Default Log Level</strong></td>
</tr>
<tr>
<td></td>
<td>You select this item to change the log level. See “About Endpoint Agent logs” on page 1500.</td>
</tr>
<tr>
<td>Alerts</td>
<td>Displays the number of Warning and Critical alerts that occur on an agent. To see a list of alerts for a particular agent, click on the relevant agent entry to display the Events screen. See “Agent events” on page 1490.</td>
</tr>
<tr>
<td>Machine Name</td>
<td>Displays the endpoint name.</td>
</tr>
<tr>
<td>Agent Group</td>
<td>Displays the agent group name.</td>
</tr>
</tbody>
</table>
Table 75-4  Agent status  *(continued)*

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent Configuration</td>
<td>Displays the current agent configuration used:</td>
</tr>
<tr>
<td>■ Other Configurations (Not Current)</td>
<td>Indicates that a custom configuration is applied.</td>
</tr>
<tr>
<td>■ Current Configuration</td>
<td>Indicates that the latest configuration is applied.</td>
</tr>
<tr>
<td>■ Outdated Configuration</td>
<td>Indicates that the configuration is obsolete.</td>
</tr>
<tr>
<td>■ Unknown/Deleted Configuration</td>
<td>Indicates that the configuration was deleted. Agents display this configuration status until they receive an updated configuration from an Endpoint Server.</td>
</tr>
<tr>
<td>■ Default Configuration</td>
<td>Indicates that the default configuration is applied. The default configuration is applied during install.</td>
</tr>
<tr>
<td>Connection Status</td>
<td>Displays the current agent connection status.</td>
</tr>
<tr>
<td></td>
<td>Agent connection status includes the following:</td>
</tr>
<tr>
<td>■ Unknown</td>
<td>Agents with unknown status.</td>
</tr>
<tr>
<td>■ Reporting</td>
<td>DLP Agents that are currently connected to the corporate network.</td>
</tr>
<tr>
<td>■ Not Reporting</td>
<td>DLP Agents that are not currently connected to the corporate network.</td>
</tr>
<tr>
<td></td>
<td>See “Setting the endpoint location” on page 1378.</td>
</tr>
<tr>
<td>Last Update Time</td>
<td>Displays the date and time on the Enforce Server when the agent was last updated.</td>
</tr>
<tr>
<td>OS</td>
<td>Displays the agent operating system.</td>
</tr>
<tr>
<td>Platform</td>
<td>Displays the agent processor type.</td>
</tr>
<tr>
<td>Endpoint Server</td>
<td>Lists the Endpoint Server to which the agent is registered.</td>
</tr>
<tr>
<td>IP Address</td>
<td>Displays the endpoint IP address.</td>
</tr>
<tr>
<td>Version</td>
<td>Displays the endpoint version.</td>
</tr>
</tbody>
</table>

See “Agent Overview screen” on page 1457.

See “About filters and summary options for reports” on page 1046.
Agent filtering
You can filter what agents display on the Agent List screen by clicking Filters. After you are done selecting filter criteria, click the check box.

Note: You filter 12.0.x and earlier agents on the Summary Reports for 12.0.x and Earlier Agents screen. See “Using the Summary Reports for 12.0.x and Earlier Agents screen” on page 1473.

Click a column header to sort entries alpha-numerically. Click the column header a second time to sort in reverse order. By default, Symantec Data Loss Prevention lists agents by the endpoint name. Select items in the column headers to only display agents containing the selected data.

You can filter the agents that display by a number of criteria including agent configuration, server name, and agent IP address. Additionally, you can filter the agent events by specific sets of criteria relating to the Symantec DLP Agent. Summarizing and filtering the agents lets you view agents by specific criteria, and in the order that you want. For example, you can display the agents that have the Default Configuration associated and then display the agents that were updated in the last 7 days. You can click a column to the agents by the date they were last updated.

Note: Click Select all to select all agents that meet the filter criteria regardless of what agents currently display on the grid. This selection is useful when agents flow across more than one page. Click the box at the top left of the grid to select all agents that display on the grid.

You can filter the agents that display in the grid by using the following items:

Table 75-5 Filtering agents

<table>
<thead>
<tr>
<th>Item to filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alert Category</td>
<td>Lets you filter on each of the agent alert categories.</td>
</tr>
<tr>
<td>Status</td>
<td>Select an agent alert status.</td>
</tr>
<tr>
<td>Machine Name</td>
<td>Enter the name of an endpoint you want to display. The alphanumeric value you enter displays all endpoints that contain the value string. For example, to display endpoints with 123 anywhere in the name, enter 123.</td>
</tr>
<tr>
<td>Agent Group</td>
<td>Select an agent group to display all the agents that are contained in the group.</td>
</tr>
</tbody>
</table>
Table 75-5 Filtering agents (continued)

<table>
<thead>
<tr>
<th>Item to filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent Configuration</td>
<td>Select an agent configuration.</td>
</tr>
<tr>
<td>Connection Status</td>
<td>Select a connection status.</td>
</tr>
<tr>
<td>Last Update Time</td>
<td>Select an update time. This value represents the last time the Enforce Server received data from agent.</td>
</tr>
<tr>
<td>OS</td>
<td>Enter the name of the OS you want to display. The alphanumeric value you enter displays all endpoints that contain the value string. For example, to display endpoints with Mac anywhere in the name, enter Mac.</td>
</tr>
<tr>
<td>Platform</td>
<td>Select 32bit or 64bit.</td>
</tr>
<tr>
<td>Endpoint Server</td>
<td>Click the Endpoint Server name to display the agent associated with that server. You can also select Deleted to display agents currently reporting to deleted Endpoint Servers.</td>
</tr>
<tr>
<td>IP Address</td>
<td>Enter an IP address associated with an agent.</td>
</tr>
<tr>
<td>Version</td>
<td>Enter the agent version you want to display.</td>
</tr>
</tbody>
</table>

See “Using the Agent List screen” on page 1460.

Using the Summary Reports screen

You use the Summary Reports screen (System > Agents > Overview > Summary > Reports) to summarize agent information and create reports.

Note: You complete agent management tasks on the Agent List screen. See “Using the Agent List screen” on page 1460.

You can select which DLP Agents display in a report by filtering the agent events by specific sets of criteria. For example, you can summarize the agents by the associated agent configuration and then filter those configurations by the most recently updated agents.

You can generate a filtered report by specifying a number of criteria, including agent configuration, server name, and agent IP address. Summary reports take their name from the summary criterion. If you rerun a report with new criteria, the report name changes accordingly.
To create a DLP Agent summary report:

1. Click **Advanced Filters and Summarization**.
2. Select an item in the **Summarize By** list to select on which criteria you want to summarize.
   
   See Table 75-6 on page 1468.

   You can summarize by the following items:
   
   - Agent Configuration
   - Agent Group
   - Agent IP
   - Agent Status
   - Agent Version
   - Alerts
   - Connection Status
   - Endpoint Server
   - Investigating State
   - Last Connection Time
   - OS
   - Platform
   - State Category
   - State Sub Category

3. Click **Add filter** if you want to add additional filters. Table 75-6 lists advanced filters.
4. Click **Apply** to generate the report using the specified filters.
5. Click **Save > Save As** to save the report you created.
6. Click **Send** to email the report.
7. Click **Export > All: CSV** to download a CSV file of the report.

Table 75-6  Advanced filters and summarization

<table>
<thead>
<tr>
<th>Primary filter</th>
<th>Available conditions</th>
<th>Secondary filter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent Configuration</td>
<td>■ Is Any Of</td>
<td><strong>Agent Configuration</strong>: Select the DLP Agent Configuration that you want to include or exclude from the report.</td>
</tr>
<tr>
<td></td>
<td>■ Is None Of</td>
<td></td>
</tr>
</tbody>
</table>

Managing Symantec DLP Agents | 1468

About Symantec DLP Agent administration
<table>
<thead>
<tr>
<th>Primary filter</th>
<th>Available conditions</th>
<th>Secondary filter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent Configuration</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Status</td>
<td>■ Is Any Of</td>
<td>■ Current Configuration: The number of agents that are running the most current version of the agent configuration.</td>
</tr>
<tr>
<td></td>
<td>■ Is None Of</td>
<td>■ Outdated Configuration: The number of agents that are running an older version of the agent configuration.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Unknown/deleted Configuration: The number of agents that are running an unknown version of the agent configuration.</td>
</tr>
<tr>
<td>Agent Group</td>
<td>■ Is Any Of</td>
<td>Select an agent group from the list.</td>
</tr>
<tr>
<td></td>
<td>■ Is None Of</td>
<td></td>
</tr>
<tr>
<td>Agent Group Status</td>
<td>■ Is Any Of</td>
<td>■ Deleted: The agent groups that have been deleted.</td>
</tr>
<tr>
<td></td>
<td>■ Is None Of</td>
<td>■ Disabled: The agent groups that have been disabled.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Enabled: The agent groups currently in use.</td>
</tr>
<tr>
<td>Agent IP</td>
<td>■ Contains Ignore Case</td>
<td>Agent IP: Enter the IP address you want to filter.</td>
</tr>
<tr>
<td></td>
<td>■ Does Not Contain Ignore Case</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Matches Exactly</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Does Not Match Exactly</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Matches Exactly Ignore Case</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Starts With</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Ends with</td>
<td></td>
</tr>
<tr>
<td>Agent Status</td>
<td>■ Is Any Of</td>
<td>■ Critical: Filter DLP Agents which report a Critical status.</td>
</tr>
<tr>
<td></td>
<td>■ Is None Of</td>
<td>■ OK: Filter DLP Agents which report an OK status.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Warning: Filter DLP Agents which report a Warning status.</td>
</tr>
<tr>
<td>Primary filter</td>
<td>Available conditions</td>
<td>Secondary filter</td>
</tr>
<tr>
<td>---------------</td>
<td>----------------------</td>
<td>------------------</td>
</tr>
</tbody>
</table>
| Agent Version | ■ Contains Ignore Case  
■ Does Not Contain Ignore Case  
■ Matches Exactly  
■ Does Not Match Exactly  
■ Matches Exactly Ignore Case  
■ Starts With  
■ Ends With | **Agent Version:** Enter the DLP Agent version number which you want filtered. |
| Alerts       | ■ Is Any Of  
■ Is None Of | **Alerts:** Enter the DLP Agent alert you want filtered. |
| Connection Status | ■ Is Any Of  
■ Is None Of |  
■ **Not Reporting:** Filter DLP Agents that are not currently connected to the corporate network.  
■ **Reporting:** Filter DLP Agents that are currently connected to the corporate network.  
■ **Unknown:** Filter DLP Agents that have an unknown connection status. |
| Endpoint Server | ■ Is Any Of  
■ Is None Of | **Endpoint Prevent Server:** Select the Endpoint Prevent Server you want to filter. The DLP Agents that report to this server are filtered.  
Selecting **Deleted** displays all endpoints that report to deleted Endpoint Servers. |
| Investigating State | ■ Is Any Of  
■ Is None Of |  
■ **Investigating**  
■ **Not Investigating** |
| Log Level | ■ Is Any Of  
■ Is None Of |  
■ **Custom:** Select all DLP Agents with log levels set to a value other than the INFO level.  
■ **Default:** Select all DLP Agents with log levels set to the default INFO level. |
<table>
<thead>
<tr>
<th>Primary filter</th>
<th>Available conditions</th>
<th>Secondary filter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Machine Name</td>
<td>■ Contains Ignore Case&lt;br&gt;■ Does Not Contain Ignore Case&lt;br&gt;■ Matches Exactly&lt;br&gt;■ Does Not Match Exactly&lt;br&gt;■ Matches Exactly Ignore Case&lt;br&gt;■ Starts with&lt;br&gt;■ End with</td>
<td><strong>Machine name:</strong> Enter the computer name that you want to use as a filter.</td>
</tr>
<tr>
<td>OS</td>
<td>■ Contains Ignore Case&lt;br&gt;■ Does Not Contain Ignore Case&lt;br&gt;■ Matches Exactly&lt;br&gt;■ Does Not Match Exactly&lt;br&gt;■ Matches Exactly Ignore Case&lt;br&gt;■ Starts with&lt;br&gt;■ End with</td>
<td><strong>OS:</strong> Enter the operating system name that you want to use as a filter.</td>
</tr>
<tr>
<td>Platform</td>
<td>■ Is Any Of&lt;br&gt;■ Is None Of</td>
<td>■ 32-bit&lt;br&gt;■ 64-bit</td>
</tr>
<tr>
<td>State Category</td>
<td>■ Is Any Of&lt;br&gt;■ Is None Of</td>
<td>■ AD User Group Resolution&lt;br&gt;■ Agent Configuration Change Status&lt;br&gt;■ Agent Group Change Status&lt;br&gt;■ Agent Monitoring Status&lt;br&gt;■ AIM Plugin Status&lt;br&gt;■ Crash Dump Status&lt;br&gt;■ File System Drive&lt;br&gt;■ Lotus Notes Plugin Status&lt;br&gt;■ Outlook Plugin Status&lt;br&gt;■ Reporting Status&lt;br&gt;■ Software Compatibility</td>
</tr>
</tbody>
</table>
Table 75-6  Advanced filters and summarization (continued)

<table>
<thead>
<tr>
<th>Primary filter</th>
<th>Available conditions</th>
<th>Secondary filter</th>
</tr>
</thead>
<tbody>
<tr>
<td>State Sub Category</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AD User Group Resolution</td>
<td>Filter DLP Agent by successful or failed Active Directory Group resolution.</td>
<td></td>
</tr>
<tr>
<td>Agent Configuration Change Status</td>
<td>Filter DLP Agent by date the agent configuration was last updated.</td>
<td></td>
</tr>
<tr>
<td>Agent Group Change Status</td>
<td>Filter DLP Agent by date the agent group was last updated.</td>
<td></td>
</tr>
<tr>
<td>Agent Monitoring Status</td>
<td>Filter DLP Agents by their monitored status.</td>
<td></td>
</tr>
<tr>
<td>AIM Plugin Status</td>
<td>Filter DLP Agents which have AOL Instant Messenger plug-ins that have failed installation, been repaired, or tampered with.</td>
<td></td>
</tr>
<tr>
<td>Crash Dump Status</td>
<td>Filter DLP Agents that have crash dumps available or DLP Agents that do not have a crash dump.</td>
<td></td>
</tr>
<tr>
<td>File System Driver</td>
<td>Filter DLP Agents using the status of the file system drivers on the agents.</td>
<td></td>
</tr>
<tr>
<td>Lotus Notes Plugin Status</td>
<td>Filter DLP Agents which have Lotus Notes plug-ins that have failed installation, been repaired, or tampered with.</td>
<td></td>
</tr>
<tr>
<td>Outlook Plugin Status</td>
<td>Filter DLP Agents which have Microsoft Outlook plug-ins that have failed installation, been repaired, or tampered with.</td>
<td></td>
</tr>
<tr>
<td>Reporting Status</td>
<td>Filter DLP Agents that are either reporting or not.</td>
<td></td>
</tr>
<tr>
<td>Software Compatability</td>
<td>Filter DLP Agents according to their compatability with Endpoint Servers.</td>
<td></td>
</tr>
</tbody>
</table>
Summary reports take their name from the summary criterion. If you rerun a report with new criteria, the report name changes accordingly.

Table 75-7 describes the columns that display in the summary report you create.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Summary criterion</td>
<td>Identifies the items on which the report summarizes.</td>
</tr>
<tr>
<td>Total</td>
<td>Lists the total number of agents that are associated with the summary criteria.</td>
</tr>
<tr>
<td>Connection Status</td>
<td>Lists the number of agents currently connected to the network.</td>
</tr>
<tr>
<td>Health Status</td>
<td>Lists the number of agents that are marked with an <strong>OK</strong>, <strong>Warning</strong>, or <strong>Critical</strong> health status.</td>
</tr>
<tr>
<td>Configuration Status</td>
<td>Lists the number of agents that are running a current, outdated, or unknown version of the agent configuration.</td>
</tr>
</tbody>
</table>

See “Agent Overview screen” on page 1457.

See “Using the Agent List screen” on page 1460.

See “About agent configurations” on page 1405.

See “Agent events” on page 1490.

**Using the Summary Reports for 12.0.x and Earlier Agents screen**

The *Summary Reports for 12.0.x and Earlier Agents* screen provides an overview of the state of your DLP Agents and lets you administer the agents. The statuses are described by individual icons displayed next to each agent. You can also perform agent tasks on any selected agents. Use the check boxes to select the agents that you want to modify.

You can filter the agent events by specific sets of criteria relating to the Symantec DLP Agent. Summarizing and filtering the agents lets you view the agent data in the order that you want. For example, you can summarize the agents by the associated agent configuration and then filter those configurations by the most recently updated agents.
To create a filtered DLP Agent summary report:

1. Click **Advanced Filters and Summarization**.
2. Select the criteria that you want to filter for by selecting your criteria from the pull-down menus.
   
   See Table 75-8 on page 1474.
3. If you want to add additional filters, click **Add filter**.
4. After you have completed configuring the filters that you want to use for your report, click **Apply** to generate the report.

Table 75-8  Advanced filters for DLP Agent summary reports

<table>
<thead>
<tr>
<th>Primary filter</th>
<th>Available conditions</th>
<th>Secondary filter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent Configuration</td>
<td>■ Is Any Of</td>
<td>Agent Configuration: Select the DLP Agent Configuration that you want to include or exclude from the report.</td>
</tr>
<tr>
<td></td>
<td>■ Is None Of</td>
<td></td>
</tr>
<tr>
<td>Agent Configuration Status</td>
<td>■ Is Any Of</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Is None Of</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Current Configuration: The number of agents that are running the most current version of the agent configuration.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Outdated Configuration: The number of agents that are running an older version of the agent configuration.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Unknown/delete Configuration: The number of agents that are running an unknown version of the agent configuration.</td>
<td></td>
</tr>
</tbody>
</table>
Table 75-8  Advanced filters for DLP Agent summary reports *(continued)*

<table>
<thead>
<tr>
<th>Primary filter</th>
<th>Available conditions</th>
<th>Secondary filter</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Agent IP</strong></td>
<td></td>
<td><strong>IP address</strong>: Enter the IP address or multiple IP addresses to filter.</td>
</tr>
<tr>
<td></td>
<td>Contains Ignore Case</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Does Not Contain Ignore Case</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Matches Exactly</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Does Not Match Exactly</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Matches Exactly Ignore Case</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Starts With</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Ends with</td>
<td></td>
</tr>
<tr>
<td><strong>Agent Status</strong></td>
<td>Is Any Of</td>
<td><strong>Disabled</strong>: Filter DLP Agents which report a Disabled status.</td>
</tr>
<tr>
<td></td>
<td>Is None Of</td>
<td><strong>Down</strong>: Filter DLP Agents which report a Down status.</td>
</tr>
<tr>
<td><strong>Agent Version</strong></td>
<td>Contains Ignore Case</td>
<td><strong>Healthy</strong>: Filter DLP Agents which report a Healthy (OK) status.</td>
</tr>
<tr>
<td></td>
<td>Does Not Contain Ignore Case</td>
<td><strong>Shut Down</strong>: Filter DLP Agents which report a shutdown status.</td>
</tr>
<tr>
<td></td>
<td>Matches Exactly</td>
<td><strong>Warning</strong>: Filter DLP Agents which report a Warning status.</td>
</tr>
<tr>
<td></td>
<td>Does Not Match Exactly</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Matches Exactly Ignore Case</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Starts With</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Ends With</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Version: Enter the DLP Agent version number which you want filtered.</td>
<td></td>
</tr>
</tbody>
</table>
Table 75-8  Advanced filters for DLP Agent summary reports (continued)

<table>
<thead>
<tr>
<th>Primary filter</th>
<th>Available conditions</th>
<th>Secondary filter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
<td></td>
<td>You can select one the following categories to add to your filter:</td>
</tr>
<tr>
<td></td>
<td>■ Is Any Of</td>
<td>■ AD User Group Resolution</td>
</tr>
<tr>
<td></td>
<td>■ Is None Of</td>
<td>■ Agent Configuration Change Status</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Agent Group Attribute Discovery Status</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Agent Group Change Status</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Agent Group Conflict Status</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Agent Logger Status</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Agent Monitoring Status</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Agent Service Status</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Agent Store</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Agent Troubleshooting Status</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ AIM Plugin Status</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Configuration Update</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Connection Status</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Crash Dump Status</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Detection</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ File System Driver</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Firefox Plugin Status</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Lotus Notes Plugin Status</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Outlook Plugin Status</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Software Compatibility</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Software Update</td>
</tr>
</tbody>
</table>
Table 75-8  Advanced filters for DLP Agent summary reports *(continued)*

<table>
<thead>
<tr>
<th>Primary filter</th>
<th>Available conditions</th>
<th>Secondary filter</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Connection Status</strong></td>
<td>• Is Any Of</td>
<td>• <strong>Off the Corporate Network</strong>: Filter DLP Agents that are not currently connected to the corporate network.</td>
</tr>
<tr>
<td></td>
<td>• Is None Of</td>
<td></td>
</tr>
<tr>
<td><strong>Endpoint Server</strong></td>
<td>• Is Any Of</td>
<td><strong>Endpoint Prevent Server</strong>: Select the Endpoint Prevent Server you want to filter. The DLP Agents that report to this server will be filtered.</td>
</tr>
<tr>
<td></td>
<td>• Is None Of</td>
<td></td>
</tr>
<tr>
<td><strong>Investigating State</strong></td>
<td>• Is Any Of</td>
<td>• <strong>Investigating</strong></td>
</tr>
<tr>
<td></td>
<td>• Is None Of</td>
<td>• <strong>Not Investigating</strong></td>
</tr>
<tr>
<td>Primary filter</td>
<td>Available conditions</td>
<td>Secondary filter</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Last Connection Time</td>
<td>You can filter DLP Agents by their last connection time using the following points in time:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Today</td>
<td>■ <strong>Custom</strong>: Select a date range to filter DLP Agents which have not connected to the Endpoint Prevent Server during the specified date range.</td>
</tr>
<tr>
<td></td>
<td>■ Yesterday</td>
<td>■ <strong>Custom Since</strong>: Select a date to filter DLP Agents which have not connected to the Endpoint Prevent Server after the specified date.</td>
</tr>
<tr>
<td></td>
<td>■ Current Week to Date</td>
<td>■ <strong>Custom Before</strong>: Select a date to filter DLP Agents which last connected to the Endpoint Prevent Server before the specified date.</td>
</tr>
<tr>
<td></td>
<td>■ Current Month to Date</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Current Quarter to Date</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Current Year to Date</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Last 7 Days</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Last 30 Days</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Last Week</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Last Month</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Last Quarter</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Last Year</td>
<td></td>
</tr>
</tbody>
</table>
Table 75-8  Advanced filters for DLP Agent summary reports (continued)

<table>
<thead>
<tr>
<th>Primary filter</th>
<th>Available conditions</th>
<th>Secondary filter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log Level</td>
<td>■ Is Any Of</td>
<td>■ Custom: Select all DLP Agents with log levels set to a higher level than the INFO level.</td>
</tr>
<tr>
<td></td>
<td>■ Is None Of</td>
<td>■ Default: Select all DLP Agents with log levels set to the default INFO level.</td>
</tr>
<tr>
<td>Machine Name</td>
<td>■ Contains Ignore Case</td>
<td>Machine name: Enter the computer name that you want to use as a filter.</td>
</tr>
<tr>
<td></td>
<td>■ Does Not Contain Ignore Case</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Matches Exactly</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Does Not Match Exactly</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Matches Exactly Ignore Case</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Starts with</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ End with</td>
<td></td>
</tr>
</tbody>
</table>
Table 75-8  Advanced filters for DLP Agent summary reports *(continued)*

<table>
<thead>
<tr>
<th>Primary filter</th>
<th>Available conditions</th>
<th>Secondary filter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sub Category</td>
<td>■ Is Any Of</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Is None Of</td>
<td></td>
</tr>
</tbody>
</table>
Table 75-8  Advanced filters for DLP Agent summary reports (*continued*)

<table>
<thead>
<tr>
<th>Primary filter</th>
<th>Available conditions</th>
<th>Secondary filter</th>
</tr>
</thead>
<tbody>
<tr>
<td>AD User Group Resolution: Filter DLP Agent by successful or failed Active Directory Group resolution.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Agent Logger Status: Filter DLP Agents which have an updated log level status.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Agent Monitoring Status: Filter DLP Agents by their monitored status.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Agent Service Status: Filter DLP Agents by the state of the agent.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Agent Store: Filter DLP Agents by the state of the Agent Store.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Agent Troubleshooting Status: Filter DLP Agents based on the state of the last attempted task that was executed for the Agent.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AIM Plugin Status: Filter DLP Agents which have AOL Instant Messenger plug-ins that have failed installation, been repaired, or tampered with.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Configuration Update: Filter DLP Agents that have encountered an error or have successfully updated the agent configuration.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Connection Status: Filter DLP Agents that have encountered authentication failures, have an active connection, have a closed</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Table 75-8  Advanced filters for DLP Agent summary reports (continued)

<table>
<thead>
<tr>
<th>Primary filter</th>
<th>Available conditions</th>
<th>Secondary filter</th>
</tr>
</thead>
<tbody>
<tr>
<td>connection, or lost</td>
<td>connection to the Endpoint Prevent Server.</td>
<td></td>
</tr>
<tr>
<td>Crash Dump Status:</td>
<td>Filter DLP Agents that have crash dumps available or DLP Agents that do not have a crash dump.</td>
<td></td>
</tr>
<tr>
<td>Detection:</td>
<td>Filter DLP Agents that have a full detection queue, have experienced a detection timeout, or have had files removed from the Agent Store.</td>
<td></td>
</tr>
<tr>
<td>FileSystemDriver:</td>
<td>Filter DLP Agents using the status of the file system drivers on the agents.</td>
<td></td>
</tr>
<tr>
<td>Firefox Plugin Status:</td>
<td>Filter DLP Agents which have Firefox plug-ins that have failed installation, been repaired, or tampered with.</td>
<td></td>
</tr>
<tr>
<td>LotusNotesPlugin Status:</td>
<td>Filter DLP Agents which have Lotus Notes plug-ins that have failed installation, been repaired, or tampered with.</td>
<td></td>
</tr>
<tr>
<td>Outlook Plugin Status:</td>
<td>Filter DLP Agents which have Microsoft Outlook plug-ins that have failed installation, been repaired, or tampered with.</td>
<td></td>
</tr>
<tr>
<td>Software Compatibility:</td>
<td>Filter DLP Agents by their compatibility with the Endpoint Prevent Server.</td>
<td></td>
</tr>
</tbody>
</table>
You can generate a summarized report by specifying a number of criteria including agent configuration, server name, and agent IP address. View the summary criteria available by clicking the Advanced Filters and Summarization link and then clicking the Summarize By drop-down menu. The administration console displays all criteria in alphabetical order. Select the criteria you want from the summarize field and then click Apply. Summary reports take their name from the summary criterion. If you rerun a report with new criteria, the report name changes accordingly.

To create a summarized DLP Agent summary report:

1. Click Advanced Filters and Summarization.
2. Locate the Summarize By pull-down menu; then, select the type of summarized report you want to view.
3. Click Apply to create the report.

Note: Summary reports take their name from the summary criterion. If you rerun a report with new criteria, the report name changes accordingly.
### Table 75-9  Summary Reports screen details

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Summary criterion</td>
<td>Lists the summary items. The available summary criteria are the following:</td>
</tr>
<tr>
<td></td>
<td>■ Agent Configuration</td>
</tr>
<tr>
<td></td>
<td>■ Agent Configuration Status</td>
</tr>
<tr>
<td></td>
<td>■ Agent IP</td>
</tr>
<tr>
<td></td>
<td>■ Agent Status</td>
</tr>
<tr>
<td></td>
<td>■ Agent Version</td>
</tr>
<tr>
<td></td>
<td>■ Category</td>
</tr>
<tr>
<td></td>
<td>■ Connection Status</td>
</tr>
<tr>
<td></td>
<td>■ Endpoint Server</td>
</tr>
<tr>
<td></td>
<td>■ Investigating State</td>
</tr>
<tr>
<td></td>
<td>■ Last Connection Time</td>
</tr>
<tr>
<td></td>
<td>■ Log Level</td>
</tr>
<tr>
<td></td>
<td>■ Machine Name</td>
</tr>
<tr>
<td></td>
<td>■ Sub Category</td>
</tr>
<tr>
<td>Total</td>
<td>The total number of agents that are associated with the summary criteria.</td>
</tr>
<tr>
<td>Connected</td>
<td>The number of agents currently connected to the network.</td>
</tr>
<tr>
<td>Disconnected</td>
<td>The number of agents currently disconnected from the network.</td>
</tr>
<tr>
<td>Healthy</td>
<td>The number of agents that are marked with a <strong>Healthy</strong> status.</td>
</tr>
<tr>
<td>Warning</td>
<td>The number of agents that are marked with a <strong>Warning</strong> status.</td>
</tr>
<tr>
<td>Down</td>
<td>The number of agents that are marked with a <strong>Down</strong> status.</td>
</tr>
<tr>
<td>Disabled</td>
<td>The number of disabled agents.</td>
</tr>
<tr>
<td>Shut Down</td>
<td>The number of agents that have been shut down.</td>
</tr>
<tr>
<td>On Current Configuration</td>
<td>The number of agents that are running the most current version of the agent configuration.</td>
</tr>
</tbody>
</table>
### Table 75-9  Summary Reports screen details *(continued)*

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outdated</td>
<td>The number of agents that are running an older version of the agent configuration.</td>
</tr>
<tr>
<td>On Unknown</td>
<td>The number of agents that are running an unknown version of the agent configuration.</td>
</tr>
</tbody>
</table>

See “Agent Overview screen” on page 1457.
See “Using the Agent List screen” on page 1460.
See “Using the Summary Reports screen” on page 1467.
See “About agent configurations” on page 1405.
See “Agent events” on page 1490.

### 12.0.x and earlier agent actions

The following table describes the available agent actions that you can take on 12.0.x and earlier agents. Use the **Action** button to execute actions.

#### Table 75-10  Legacy agent overview actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Endpoint Server</td>
<td>Lets you change the Endpoint Server to which the agent connects. You can specify the primary Endpoint Server as well as secondary Endpoint Servers in case the primary server fails and the agent must switch connections.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the agent. When you delete an agent, you remove that agent and all associated events from the Endpoint Server. It is no longer visible in the Enforce Server administration console. Deleting an agent from the Endpoint Server does not mean that it has been uninstalled from the endpoint.</td>
</tr>
<tr>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Disable</td>
<td>Disables the agent. Disabling the agent does not delete the agent from the Endpoint Server. Disabling an agent disables all monitoring on that endpoint. The associated events are still visible on the Endpoint Server. Unlike deleted agents, disabled agents can be re-enabled.</td>
</tr>
<tr>
<td>Enable</td>
<td>Enables disabled agents. Enabled agents automatically reconnect with the Endpoint Server and obtain the most current policies. Enabling an agent enables monitoring on that endpoint. Enabled agents can log events on the Endpoint Server. <strong>Note:</strong> Any updates to the associated policies are not sent to the agent until the agent is enabled and restarted.</td>
</tr>
</tbody>
</table>
| Pull Logs | Lets you pull service logs and operational logs for the agent. You can pull either the service logs, or the operational logs, or both sets of logs.  
Pulling agent logs is a two-step process:  
- Pull the agent logs from the endpoint to the Endpoint Server  
- Collect the agent logs from the Endpoint Server through the Enforce Server  
When the logs are pulled from the endpoint, they are stored on the Endpoint Server in an unencrypted format. After you collect the logs from the Endpoint Server, the logs are deleted from the Endpoint Server and are stored only on the Enforce Server. You can only collect logs from one endpoint at a time.  
Access the logs from the Enforce Server Logs page. Go to: **System > Servers > Logs > Collection.**  
See “Collecting server logs and configuration files” on page 257.
### Table 75-10 Legacy agent overview actions (continued)

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove Under Investigation</td>
<td>Removes the Under Investigation designation from the selected agents.</td>
</tr>
<tr>
<td>Reset Log Level</td>
<td>Resets the logging level for the specified agent to the default <strong>INFO</strong> level. Symantec Technical Support uses agent logs for troubleshooting purposes. See “About Endpoint Agent logs” on page 1500.</td>
</tr>
<tr>
<td>Restart</td>
<td>Restarts the specified agent.</td>
</tr>
<tr>
<td>Set Log Level</td>
<td>Sets the logging level for the specified agent. Symantec Technical Support uses agent logs for troubleshooting purposes. <strong>Note:</strong> It is recommended to contact Symantec Technical Support before you change the log level for an agent. See “About Endpoint Agent logs” on page 1500.</td>
</tr>
<tr>
<td>Set Under Investigation</td>
<td>Sets an Under Investigation status on the selected agent. Specify agents as Under Investigation if you believe there is some sort of issue with the agent. You can set the Under Investigation status regardless of whether the agent is running, disabled, or shut down. An additional icon, a flag, appears next to the main status icon of the agent.</td>
</tr>
<tr>
<td>Shut Down</td>
<td>Shuts down the selected agent.</td>
</tr>
</tbody>
</table>

You can view the most current information regarding the agent actions in a knowledge base article. Log on to the DLP Knowledgebase at: [https://kb-vontu.altiris.com](https://kb-vontu.altiris.com) and search for the article "About Symantec DLP Agent troubleshooting tasks." Or search for the article number: 54083.

**Agent task confirmation screen**

Depending on the agent task you selected, you may see one of the following confirmation pages. Some of the confirmation pages request that you enter more information to complete the task. Other confirmation pages only require you to
confirm the task. The following table describes the different agent overview task confirmation pages:

Table 75-11  
Agent task confirmation pages

<table>
<thead>
<tr>
<th>Task</th>
<th>Page details</th>
</tr>
</thead>
</table>
| Delete                | Confirm that you want to delete the Symantec DLP Agent.  
                          | Click **OK** to confirm the deletion.                                                                                                      |
| Change Endpoint Server| Enter the IP address or host name and port number to change the Endpoint Servers your DLP Agents report to.  
                          | See “Changing the Endpoint Prevent Server” on page 1490.                                                                                   |
| Change Group          | Select an agent group to where you want to move the selected agent.  
                          | The agent is moved to the selected group after the agent connects to the Endpoint Server.                                                     |
| Restart               | Click **OK** to confirm that you want to restart the Symantec DLP Agent.                                                                     |
| Shut Down             | Confirm that you want to shut down the selected agents. You must select one of the following options:  
                          | ■ Shut down the DLP Agent and do not restart Agent if the endpoint computer restarts.  
                          | The Symantec DLP Agent remains shut down if the endpoint computer restarts.                                                                |
                          | ■ Shut down the DLP Agent and restart Agent if the endpoint computer restarts.  
                          | The Symantec DLP Agent is shut down but automatically restarts when the endpoint computer restarts.                                       |
                          | After the agent shuts down, you cannot restart it from the Enforce Server administration console.                                      |
                          | Select the shutdown option and then click **OK**.                                                                                           |
### Table 75-11  
Agent task confirmation pages (continued)

<table>
<thead>
<tr>
<th>Task</th>
<th>Page details</th>
</tr>
</thead>
</table>
| Pull Logs             | Select the type of agent logs that you want, then click **OK**. You can select one of the following types of logs:  
                        - Service Logs  
                        - Operational Logs  
                        You must select at least one type of log.                                                                                   |
| Disable               | Confirm that you want to disable the Symantec DLP Agent. Disabling the agent does not delete it.  
                        Click **OK** to confirm.  
                        **Note:** After you disable an agent, configuration updates and Endpoint Discover requests from the Endpoint Server are not received. |
| Enable                | Confirm that you want to enable the Symantec DLP Agent.  
                        Click **OK** to confirm.  
                        **Note:** After you enable the agent, restart it. Restarting the agent ensures that you have the latest policy, configuration updates, and Endpoint Discover requests. |
| Remove Under Investigation | No confirmation page for this task.                                                                                                          |
| Reset Log Level       | Reset the logging level for a Symantec Data Loss Prevention agent to the default **INFO** level. Symantec Technical Support uses agent logs for troubleshooting purposes. |
| Set Log Level         | Set the logging level for a Symantec Data Loss Prevention agent. Symantec Technical Support uses agent logs for troubleshooting purposes.  
                        **Note:** It is recommended to contact Symantec Technical Support before you change the log level for an agent. |
| Set Under Investigation | No confirmation page for this task.                                                                                                          |
Changing the Endpoint Prevent Server

The **Change Endpoint Server** task lets you change which Endpoint Prevent Servers your DLP Agents report to. While performing this task, you can also define alternate Endpoint Prevent Servers that the DLP Agents can connect to. The ability to define alternate Endpoint Prevent Servers enables:

- Redundancy in cases where the primary Endpoint Prevent Server goes offline.
- DLP Agents to connect to other Endpoint Prevent Servers when the endpoint is located in another geographic location or is moved to another policy group.
- DLP Agents to connect to alternate Endpoint Prevent Servers if the maximum number of DLP Agents are already connected to the primary Endpoint Prevent Server.

To change the Endpoint Prevent Servers that the DLP Agent reports to:

1. Enter the IP address or host name for the primary Endpoint Prevent Server.
2. Enter the port number for the primary Endpoint Prevent Server.

   **Note:** Port values must be between 1 and 65535.

3. If you want to add an alternate Endpoint Prevent Server, click the plus sign (+) to add another entry.
4. Enter the IP address or the host name for the alternate Endpoint Prevent Server.
5. Enter the port number for the alternate Endpoint Prevent Server.

   **Note:** Port values must be between 1 and 65535.

6. If you want to add an additional alternate Endpoint Prevent Server, repeat step 3.
7. If you have added too many Endpoint Prevent Server entries, you can delete an entry by clicking the minus sign (-) next to the entry.
8. If you are finished adding or changing the Endpoint Prevent Servers, click **OK** to submit your changes.

**Agent events**

The **Agent Events** screen (**Systems > Agents > Events**) lists the events that have occurred on agents. These events can include changes in the database file,
connection, file-system driver, and service. You can filter and summarize the event list and click on individual event entries to see more details.

Event information is divided into several columns. Click any column header to sort entries alpha-numerically in that column. To sort in reverse order, click the column header a second time. By default, Symantec Data Loss Prevention lists events in order of the time they occurred.

Table 75-12  Agent Management Event screen

<table>
<thead>
<tr>
<th>Entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Displays the event type, which includes the following possible values:</td>
</tr>
<tr>
<td></td>
<td>■ Severe</td>
</tr>
<tr>
<td></td>
<td>■ Agent Information</td>
</tr>
<tr>
<td></td>
<td>■ OK</td>
</tr>
<tr>
<td>Time</td>
<td>Displays the event date and time.</td>
</tr>
<tr>
<td>Machine Name</td>
<td>Displays the endpoint IP address or host name.</td>
</tr>
<tr>
<td>Category</td>
<td>Lists the event category, such as Agent Service Status, Connection Status,</td>
</tr>
<tr>
<td></td>
<td>File-System Driver, or data store.</td>
</tr>
<tr>
<td>Sub-Category</td>
<td>Displays the event sub-category, such as Connection Active or Connection</td>
</tr>
<tr>
<td></td>
<td>Closed.</td>
</tr>
</tbody>
</table>

You can click any event to display the agent event detail screen for that event. See “Agent Event Detail screen” on page 1492.

You can filter the information that displays on the Events screen using a number of criteria, including date, computer name, and event type. Additionally, you can filter the agent events by specific sets of criteria relating to the Symantec DLP Agent. Summarizing and filtering the events lets you view the agent data in the order that you want. For example, you can summarize the agents by computer name and then filter by the most recently updated agents.

See “About filters and summary options for reports” on page 1046.

See “Troubleshooting agent alerts” on page 1493.

**Summarizing agent events**

After you select and apply filtering and sorting criteria on the Events screen (System > Agents > Events), the Events screen displays a summary that matches your selections.
You can click each column to sort agents. Click a number to display agents that fit the criteria.

The far left column displays the sort option you selected in the **Summarize By** list.

### Table 75-13  Agent event summary

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Machine Name</td>
<td>Displays the computer names.</td>
</tr>
<tr>
<td>Total</td>
<td>Lists the number of connected agents.</td>
</tr>
<tr>
<td>Severe</td>
<td>Lists the number of agents with a warning status.</td>
</tr>
<tr>
<td>Warning</td>
<td>Lists the number of agents with a warning status.</td>
</tr>
<tr>
<td>Info</td>
<td>Lists the number of events associated with the agent. Click this number to display more information about the event or events.</td>
</tr>
</tbody>
</table>

### Agent Event Detail screen

The **Agent Event Detail** screen displays all of the information available for the selected event. This screen is not editable.

### Table 75-14  Agent Event Detail screen

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Type</td>
<td>Indicates the general type of event that has occurred. The types possible events include:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Severe</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Indicates an error that requires immediate attention.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Warning</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Indicates a problem that is not severe enough to generate an error.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Info</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Lists agent information.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Time</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Provides the time the event occurred.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Machine Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Provides the endpoint name.</td>
</tr>
</tbody>
</table>
Table 75-14  Agent Event Detail screen (continued)

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message</td>
<td></td>
<td>Provides details about the event.</td>
</tr>
</tbody>
</table>
|         |       | ■ Summary  
|         |       |   A brief description of the event. |
|         |       | ■ Detail  
|         |       |   More description about the event. |
|         |       | ■ Category  
|         |       |   An event category such as Data Share, Connection Status, File-System Driver, or Agent Service Status. |
|         |       | ■ Sub-Category  
|         |       |   The event sub-category such as Connection Active or Lost Connection. |
|         |       | ■ Extended Value  
|         |       |   Any additional information about the event. For example, if a file has been evicted from the data share, the file’s metadata appears in this field. |

See “Agent events” on page 1490.

Troubleshooting agent alerts

The following section provides information on resolving agent alerts. You review agent alerts on the Agent Overview screen.

See “Agent Overview screen” on page 1457.

- Warning  
  See Table 75-15 on page 1494.

- Critical  
  See Table 75-16 on page 1496.

Table 75-15 lists agent alert details and provides information to troubleshoot and resolve agent issues that occur on Mac endpoints.
### Table 75-15 Troubleshooting agents with Warning agent alert

<table>
<thead>
<tr>
<th>Agent alert</th>
<th>Cause</th>
<th>Fix</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DLP Outlook plug-in tampered with</strong></td>
<td>The Outlook plug-in was modified, disabled, or deleted.</td>
<td>To fix the issue:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Restart Outlook.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Verify that the Outlook plug-in Outlook2k3 Addin is enabled in Outlook.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Run Outlook for at least 15 seconds, then restart Outlook.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Confirm that the Outlook plug-in Outlook2k3 Addin is enabled.</td>
</tr>
<tr>
<td><strong>DLP Outlook plug-in installation failed</strong></td>
<td>The Outlook plug-in installation failed.</td>
<td>Run the AgentInstaller.msi manually to repair the agent installation.</td>
</tr>
<tr>
<td><strong>DLP Lotus Notes plug-in tampered with</strong></td>
<td>The Lotus Notes plug-in was modified.</td>
<td>To fix the issue:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Restart Lotus Notes.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Uninstall the agent.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Restart the endpoint and install the agent.</td>
</tr>
<tr>
<td><strong>DLP Lotus Notes plug-in installation failed</strong></td>
<td>The Lotus Notes plug-in installation failed.</td>
<td>Run the AgentInstaller.msi manually to repair the agent installation.</td>
</tr>
<tr>
<td><strong>DLP AIM plug-in tampered with</strong></td>
<td>The AIM plug-in was modified or the plug-in installation failed.</td>
<td>To fix the issue:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Restart AIM.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Uninstall the agent.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Restart the endpoint and install the agent.</td>
</tr>
<tr>
<td><strong>DLP AIM plug-in installation failed</strong></td>
<td>The AIM plug-in installation failed.</td>
<td>Run the AgentInstaller.msi manually to repair the agent installation.</td>
</tr>
<tr>
<td><strong>Active Directory user group resolution failed</strong></td>
<td>Active Directory permissions conflict with Symantec Data Loss Prevention permissions. Also, Active Directory may be missing attributes.</td>
<td>Verify that the credentials that are passed to the agent have necessary permissions to extract logged-in user information from Active Directory.</td>
</tr>
</tbody>
</table>
### Table 75-15 Troubleshooting agents with Warning agent alert (continued)

<table>
<thead>
<tr>
<th>Agent alert</th>
<th>Cause</th>
<th>Fix</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Agent is disabled by enforce user</strong></td>
<td>The agent was disabled by the administrator who executed the Disable troubleshooting task on the Agent List screen.</td>
<td>Start the Windows agent using the <strong>Agent List</strong> screen. You can also start the agent by using the <code>sc</code> command. See “Using the Agent List screen” on page 1460. For Mac agents, you must use the agent_start tool to start the agent. See “Starting DLP Agents that run on Mac endpoints” on page 1531.</td>
</tr>
<tr>
<td><strong>Agent requires restart</strong></td>
<td>The administrator can either disable or enable data loss monitoring on endpoints by executing the Disable or Enable troubleshooting task on the Agent List screen. Monitoring is enabled by default after the agent installation. However, when the administrator executes the Enable or Disable tasks and the agent is busy, the agent status may not update, so the agent remains in a Warning state.</td>
<td>Restart the agent on the <strong>Agent List</strong> screen. See “Using the Agent List screen” on page 1460.</td>
</tr>
</tbody>
</table>
| **Agent crash dump available on endpoint for analysis** | If the agent crashes, the Enforce Server displays the **Warning** agent alert type. In this scenario, a log file is created that Symantec Support can use to troubleshoot why the agent crashed. Agent crashes can be caused by the following:  
  - Temporary environment issues  
  - Unknown agent issues If the agent crashes often, contact Symantec support and provide the crash dump files available at the path `/AgentInstallDirectory/_MemDumpFiles/` on the endpoint. | To fix the issue:  
  - Shut down the agent on the **Agent List** screen. See “Using the Agent List screen” on page 1460.  
  - Collect the crash dump files (*_dmp*) from the path `/AgentInstallDirectory/_MemDumpFiles/` on the respective endpoint.  
  - Delete the crash dump files.  
  - Restart the agent on the **Agent List** screen. |
### Table 75-15  Troubleshooting agents with Warning agent alert (continued)

<table>
<thead>
<tr>
<th>Agent alert</th>
<th>Cause</th>
<th>Fix</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Agent version is older than Enforce Server version</strong></td>
<td>The agent is one version older than the Endpoint Server version to which it connects. For example, if the Endpoint Server is version 12.0 and the agent is 11.x, a <strong>Warning</strong> agent alert type displays. The features available in the Enforce and Endpoint Server are not available for these agents. Symantec Data Loss Prevention identifies these agents with a Warning alert because these agents do not provide current Symantec Data Loss Prevention features.</td>
<td>Upgrade the agent to the latest version.</td>
</tr>
<tr>
<td><strong>Agent group attribute discovery failure</strong></td>
<td>This alert occurs if the agent cannot collect required data from Active Directory, which prevents the Enforce Server from moving the agent into an agent group. The agent cannot collect data if there is an issue with Active Directory permissions or if required attributes are missing from Active Directory.</td>
<td>To fix the issue:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Verify Active Directory attribute query syntax.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Use AttributeQueryResolver.exe to test Active Directory queries that are defined in the Enforce Server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “About agent groups” on page 1443.</td>
</tr>
<tr>
<td><strong>Agent group conflicts</strong></td>
<td>The Endpoint Server automatically assigns the agent to an Agent Group depending on the endpoint attributes set during the Agent Group setup. If the endpoint meets multiple Agent Group conditions, the Warning alert is thrown.</td>
<td>To fix the issue:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Review Agent Group settings.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “About agent groups” on page 1443.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Re-create the agent group and use attributes that satisfy the conditions of the agent.</td>
</tr>
</tbody>
</table>

### Table 75-16  Troubleshooting agents with Critical agent alert

<table>
<thead>
<tr>
<th>Agent alert</th>
<th>Cause</th>
<th>Fix</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Agent is not reporting</strong></td>
<td>The agent has not reported to an Endpoint Server within the specified period of time. If the agent does not report after 18 hours, then Symantec Data Loss Prevention identifies the agent as not-reporting. Not-reporting agents do not receive the latest policies and configuration information, so they are marked with a Critical agent alert.</td>
<td>To fix the issue:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Verify that the endpoint where the agent is installed exists. If it does not exist, you can delete the agent from the Enforce Server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Using the Agent List screen” on page 1460.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Verify that the agent is running on the endpoint.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Verify the network connection between the Endpoint Server and the endpoint.</td>
</tr>
</tbody>
</table>
### Table 75-16 Troubleshooting agents with Critical agent alert (continued)

<table>
<thead>
<tr>
<th>Agent alert</th>
<th>Cause</th>
<th>Fix</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Agent version is not supported</strong></td>
<td>The agent is two versions older than the Endpoint Server version to which it connects. For example, if the Endpoint Server is version 12.0 and the agent is 10.x, a <strong>Critical</strong> agent alert displays. The features available in Enforce and Endpoint Server are not available for these agents. Symantec Data Loss Prevention identifies these agents with a Critical alert because these agents do not provide current Symantec Data Loss Prevention features and may not operate as designed.</td>
<td>Upgrade the agent to the latest version.</td>
</tr>
</tbody>
</table>
| **File system driver is down**     | The agent service cannot communicate with the Symantec Data Loss Prevention driver installed on the endpoint. Communication may not occur for the following reasons:  
  ■ The file system drivers have been deleted.  
  ■ Symantec Data Loss Prevention identifies the driver as invalid. This sometimes occurs when the driver has been modified.  
  ■ Communication between Symantec Data Loss Prevention and the agent driver is broken due to attack. | To fix the issue:  
  ■ Restart the endpoint.  
  ■ Reinstall the agent. |

### About Symantec DLP Agent removal

You may need to uninstall the Symantec DLP Agent from your endpoints. You can uninstall Symantec DLP Agents in the following ways:

- **Table 75-17** Removing the Symantec DLP Agent
  - Removing a DLP Agent from a Windows endpoint
  - Removing DLP Agents from Windows endpoints using system management software
  - [Unresolved xref](#)
  - Removing a DLP Agent from a Mac endpoint
Removing DLP Agents from Windows endpoints using system management software

Follow this procedure if you elected to hide the Symantec Data Loss Prevention service from the Add or Remove Programs list (ARP) during installation. Because the Symantec DLP Agent does not appear in the ARP, you cannot use the ARP list for the uninstallation process. You must use the MSI command to remove the Symantec DLP Agent. Only use the MSI command uninstallation if you have hidden the Symantec DLP Agent from the ARP during installation.

To remove the agent with the MSI command

1. Open the command prompt window.
2. Enter the string:
   
   `msiexec /x AgentInstall.msi`

   You can add several different options to this command prompt.
3. Click OK.

   The Symantec DLP Agent uninstalls.

To remove the agent manually if the agent does not appear in the ARP

1. Open the command prompt window.
2. Enter the following command where `guid` is the product code. You can locate the GUID from the Windows registry or in the `uninstall_agent.bat` file.

   `msiexec /x {guid}

   You can add several other options to this command prompt:
Enter any optional commands to the end of the command:

msiexec /x AgentInstall.msi

4 Click OK.

You can add options to the uninstall command such as SilentMode or Logname. SilentMode allows the Symantec DLP Agent to uninstall without displaying a user interface on the desktop. The installation takes place in the background of the workstation and is not visible to the user. Logname Lets you set any log file you want. However, this option is only available if you have the original installer present. If you do not have the original installer, you must use the product code.

The code for a silent install is:

/QN:silentmode

The code for Logname is:

/L*V _logname

msi.exe has several other options. For further options, see your MSI guide.

See “About Symantec DLP Agent removal” on page 1497.

Removing DLP Agents from a Windows 7 endpoint

If you uninstall the agents from an endpoint that runs Windows 7, you must run the command prompt in Elevated Command Prompt mode. This step is required because of the nature of the Windows operating system. You cannot install the agent using the install_agent.bat script without first using the Elevated Command Prompt mode.

To initiate the Elevated Command Prompt mode on Windows 7

1 Click the Start menu.

2 In the Search programs and files field, type command prompt.

The Command Prompt program appears in the results list.

3 Hold the Shift key and right-click the Command Prompt entry in the results list. Select either Run as Administrator or Run as different user.

4 If you selected Run as different user, enter the credentials for a user that has administrator privileges.

5 The command prompt starts in Elevated Command Prompt mode. Install the Symantec DLP Agents on the endpoint using this command prompt.
Removing a DLP Agent from a Windows endpoint

You can uninstall Symantec DLP Agents manually. Manual uninstallation is only possible if you configured the Symantec DLP Agent to appear in the endpoint Add or Remove Programs list during deployment.

Note: You uninstall Windows 7/8/8.1 agents in Elevated Command Prompt mode.

To uninstall the agent manually

1. Go to Start > Control Panel and double-click Add or Remove Programs.
2. Select Agent Install.
3. Click Remove.

Removing a DLP Agent from a Mac endpoint

You can uninstall the Mac DLP Agent by running the uninstaller tool from the default agent installation location: /Library/Manufacturer/Endpoint Agent.

To uninstall the DLP Agent from Mac endpoints

1. Open the Terminal app.
2. Run this command:
   ```
   $sudo ./uninstall_agent
   ```

   Note: You can review uninstall logs on the Terminal application by running this command: sudo ./uninstall_agent -prompt=no -log=console. By default, logs are saved to the uninstall_agent.log file.

About Endpoint Agent logs

Endpoint Agent logs contain service and operational data for every Endpoint Agent. Each Endpoint agent has multiple components that are logged. The amount of information that is logged can be configured by setting the log level for each Endpoint Agent component. After the log level for an Endpoint Agent component has been configured, the log can be collected and sent to Symantec Technical Support. Symantec Technical Support can use the log to troubleshoot a problem or to improve performance for a Symantec Data Loss Prevention Endpoint installation.
Setting the log levels for an Endpoint Agent

You can configure the amount of data that is logged for an agent by specifying the log level for each agent component. Symantec Technical Support can use this data to troubleshoot or improve performance for a Symantec Data Loss Prevention Endpoint installation.

See “About Endpoint Agent logs” on page 1500.

Note: Symantec recommends that you contact Support before changing a log level for an agent.

To set the log levels for an agent

1. From the Enforce Server administration console, navigate to **System > Agents > Overview**.
2. Click an agent status.
3. Select an agent.
4. Select **Troubleshoot > Set Log Level** for current DLP Agents. Select **Actions > Set Log Level** for DLP Agents older than Symantec Data Loss Prevention version 12.5.
5. Select a log level from the **Log level** pull-down list.
6. If you want to change the log level for all of the components for this agent, select **All Agent Logger Components**.
7. If you change the log level for specific components of this agent, enter each component name into the provided field. When entering multiple component names, use a comma to separate each component name. Component names cannot exceed 255 characters.
8. Click **OK** to save your changes.

The **Agent List** screen displays an icon next to the agent to indicate the log level change. For DLP Agents older than Symantec Data Loss Prevention version 12.5, the **Legacy Summary Reports** screen displays an icon next to the agent to indicate the log level change.

It is recommended that you reset the agent log levels to the default settings after troubleshooting completes. Only general information about the agent is logged after the log levels are reset.
To reset the log levels for all the components of an Endpoint Agent to the default logging level

1. From the Enforce Server administration console, navigate to **System > Agents > Overview**.

2. Click an agent status.

3. Select an agent.

4. Select **Troubleshoot > Reset Log Level** for current DLP Agents or **Actions > Reset Log Level** for DLP Agents older than Symantec Data Loss Prevention version 12.5.

   The **Agents Overview** screen displays an icon next to the agent to indicate the updated log level.
Using application monitoring

This chapter includes the following topics:

■ About monitoring applications
■ About adding applications
■ Adding an application
■ About Application File Access monitoring
■ Implementing Application File Access monitoring

About monitoring applications

Symantec Data Loss Prevention enables you to monitor applications for CD/DVD burning, IM, email, or HTTP/S clients. By default, Symantec Data Loss Prevention monitors applications such as Apple iTunes, Microsoft Outlook, or Mozilla Firefox. You use the Application Monitoring screen (System > Agents > Application Monitoring) to review and change application monitoring settings.

You can use monitor settings to control how and if the DLP Agent monitors the following activities:

■ Data moving across the network
■ Data being printed or faxed
■ Data moving to and from an endpoint Clipboard
■ Data moving to applications
■ Data being written to a CD or DVD
Data moving between USB, network share, and local disks and an application

You can add applications your company uses that are not listed on the Application Monitoring page. For example, if your company uses Skype, you can add the application to the Application Monitoring page. After you add Skype, Symantec Data Loss Prevention monitors the files sent by the client over the network.

---

**Note:** You can remove any application that you add, but you cannot remove a system-provided application.

---

See “Adding an application” on page 1506.

See “Implementing Application File Access monitoring” on page 1510.

### Changing application monitoring settings

You can configure global changes to the applications that display by default on the Application Monitoring screen. You can associate blacklist or whitelist metadata to network monitoring, CD/DVD applications, and the applications that use print/fax or Clipboard functions. You can also specify if you do not want Symantec Data Loss Prevention to monitor applications for network, print/fax, Clipboard, or file system activities. For example, you may want to exclude Clipboard activities on Microsoft Outlook. You would edit the settings for Microsoft Outlook to exclude Clipboard activity on the Application Information screen.

**To change application monitoring settings:**

1. Locate and click the application for which you want to change settings.
2. On the Application Information screen, make changes to the following items:

   - **Network Access**: Monitors data moved over the network. The network includes HTTP and FTP.
   - **Print/Fax**: Monitors data that is printed or faxed.
   - **Send to Clipboard**: Monitors data that resides on the endpoint Clipboard.
   - **Filesystem Activity**: Monitors data moving between USB, network share, and local disks and an application.
3 If you selected Filesystem Activity, you can select one of the following options:

- **Monitor Application File Access**
  - Select Application File Access to monitor the files that the application opens or reads.
  - See “About Application File Access monitoring” on page 1509.

- **Monitor writing to CD/DVD**
  - Select CD/DVD to monitor the files that the application writes to a CD/DVD drive.

4 Select an item to define how Symantec Data Loss Prevention monitors files that are moved using applications.

- **File Read**
  - Select the File Read option. File Read is the recommended selection because it provides better performance.
  - When this option is selected, the file contents are monitored when the application reads the file.

- **File Open**
  - Select the File Open option only if the application hangs or crashes.
  - When this option is selected, the application does not open a file if it contains sensitive information. However, Symantec Data Loss Prevention scans the file regardless of whether the application reads the content, which decreases performance.

5 Save your changes.

See “About monitoring applications” on page 1503.

### About adding applications

You can use the **Application Information** screen to add applications to monitoring policies. By default, DLP Agents monitor Clipboard, print, network (HTTP and FTP), and file system (removable disc, local drive, and network share) activity on all applications. You add applications when you want DLP Agents to monitor files that applications open or read. You can also add applications when you want to prevent Symantec Data Loss Prevention from monitoring the application.

The following table lists the types of applications you can add:

<table>
<thead>
<tr>
<th>Table 76-1</th>
<th>Application types you can add</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Application type</strong></td>
<td><strong>Example</strong></td>
</tr>
<tr>
<td>CD/DVD</td>
<td>Roxio</td>
</tr>
</tbody>
</table>
Table 76-1  Application types you can add (continued)

<table>
<thead>
<tr>
<th>Application type</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internet browsers</td>
<td>Google Chrome</td>
</tr>
<tr>
<td>IM</td>
<td>Skype</td>
</tr>
<tr>
<td>SMTP</td>
<td>Mozilla Thunderbird</td>
</tr>
</tbody>
</table>

See “Adding an application” on page 1506.
See “Using the GetApplInfo tool” on page 1508.

Adding an application

You can add applications to be monitored that are not already listed on the Application Monitoring screen.

See “About adding applications” on page 1505.

Adding an application

1  Go to System > Agents > Application Monitoring.

2  Click Add Application to display the Application Information page.
3 Enter information.

In addition to the **Name** field, you must enter information in at least one of either the **Binary Name**, **Internal Name**, or **Original Filename** fields.

See “Using the GetAppInfo tool” on page 1508.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the application name. You must enter information in this field.</td>
</tr>
<tr>
<td>Binary Name</td>
<td>Enter the binary file name. Include an escape character () between the application name and the file extension. For example, if you want to add Firefox, you enter <code>firefox.exe</code>.</td>
</tr>
<tr>
<td>Internal Name</td>
<td>Enter the application name.</td>
</tr>
<tr>
<td>Original Filename</td>
<td>Enter the application file name. Include an escape character () between the application name and the file extension. For example, if you plan to add Firefox, you enter <code>firefox.exe</code>.</td>
</tr>
<tr>
<td>Publisher Name</td>
<td>Enter a publisher name. This field is optional.</td>
</tr>
</tbody>
</table>

If you enter the Publisher Name, you can choose to select the **Verify publisher name** option. This option ensures that the publisher name of the application is correct. Using the **Verify publisher name** option may affect performance as it increases system resources.

Additionally, you can add details about the publisher name for the application. The publisher name details the maker of the software. Adding the publisher name lets Symantec Data Loss Prevention verify the application even if the binary name has been changed. Primarily, the publisher name is used for identifying Symantec processes. However, you can add the publisher name for any of your applications. Adding the publisher name is optional.

4 Under the **Application Monitoring Configuration** section, select one or more of the following monitoring options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Access</td>
<td>Monitors the data moved over the network. The network includes HTTP and FTP.</td>
</tr>
<tr>
<td>Print/Fax</td>
<td>Monitors data that is printed or faxed.</td>
</tr>
<tr>
<td>Send to Clipboard</td>
<td>Monitors data that resides on the endpoint Clipboard.</td>
</tr>
<tr>
<td>Filesystem Activity</td>
<td>Monitors data moving between USB, network share, and local disks and an application.</td>
</tr>
</tbody>
</table>
If you selected **Filesystem Activity**, you can select one of the following options:

1. **Monitor Application File Access** to monitor the files that the application opens or reads.
   - See "About Application File Access monitoring" on page 1509.
2. **Monitor writing to CD/DVD** to monitor the files that the application writes to or reads from a CD/DVD drive.

Select an item to define how Symantec Data Loss Prevention monitors files that are moved using applications.

- **File Read**: Select the **File Read** option. **File Read** is the recommended selection because it provides better performance.
  - When this option is selected, the file contents are monitored when the application reads the file.

- **File Open**: Select the **File Open** option only if the application hangs or crashes.
  - When this option is selected, the application does not open a file if it contains sensitive information. However, Symantec Data Loss Prevention scans the file regardless of whether the application reads the content, which decreases performance.

Save your changes.

See “About monitoring applications” on page 1503.

**Using the GetAppInfo tool**

You can use the `GetAppInfo.exe` tool to generate application information. You use this tool when you add applications and use the Application Monitoring feature. The Application Monitoring feature monitors data that users move to applications.

Locate this application in the `SymantecDLPWinAgentTools_12.5.zip` in the `DLP\Symantec_DLP_12_Win\12.5_Win\Endpoint\x86` or `\x64` directory.

To use the `GetAppInfo` tool:

1. Launch `GetAppInfo.exe`.
2. Enter the path to the application or click **Browse** and navigate to it.
3. Click **Get Info**.
   - The tool displays the following application information:
   - **Comments**
4 Retain the application information the tool displays. You use the application information when you add an application on the Application Monitoring screen.

See “Adding an application” on page 1506.

See “About Application File Access monitoring” on page 1509.

About Application File Access monitoring

When you enable the Application File Access feature, the DLP Agent monitors data leaving applications on endpoints. You enable this feature by adding the protocol that is labeled Protocol or Endpoint Monitoring protocol and setting response rules in a policy. You then enable the Application File Access feature in the agent configuration.

Note: You cannot use the Application File Access feature to monitor inline data transfers using browsers (HTTPS) or instant messenger.

You can enable default applications on the Application Monitoring screen. You can also set Symantec Data Loss Prevention to monitor the applications not found on the Application Monitoring screen by adding them.

If a user transfers a file containing sensitive information, a notification displays on the endpoint. Depending on your policies and Endpoint Prevent response, access to the file will be denied. You can review Application File Access incidents on the Incidents > Endpoint screen.

See “Implementing Application File Access monitoring” on page 1510.
Implementing Application File Access monitoring

You complete a number of steps to implement the Application File Access feature. Refer to See Table 76-2 on page 1510. for steps to complete the process.

Enabling the feature potentially affects application performance on endpoints. You can use environment variables in path filters to specify file locations to monitor, which helps application performance.

See “Using environment variables in Endpoint Discover scans” on page 1395.

Table 76-2  Implementing Application File Access

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create a new policy or update an existing policy.</td>
<td>You enable the Protocol or Endpoint Monitoring protocol, then select options to configure Application File Access. See “Configuring policy rules” on page 330.</td>
</tr>
<tr>
<td>2</td>
<td>Set response rules for the policy.</td>
<td>See “Manage response rules” on page 889.</td>
</tr>
<tr>
<td>3</td>
<td>Add the policy to an Endpoint Discover target or confirm that an existing policy is added to a target.</td>
<td>See “Network Discover scan target configuration options” on page 1191.</td>
</tr>
<tr>
<td>4</td>
<td>Enable the Application File Access feature in the endpoint configuration.</td>
<td>Use environment, file, and folder filters to optimize file monitoring performance. The Application File Access feature monitors every file that an application opens or reads, which can reduce application performance and create false positives. You can use environment variables to specify locations where sensitive data is potentially located. See “Adding agent configurations” on page 1406. See “Configuring file filters” on page 1412.</td>
</tr>
</tbody>
</table>
### Implementing Application File Access (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>Add an application to the Application Monitoring screen.</td>
<td>Many applications are listed in the Application Monitoring screen. If you add an application, you must enable the Monitor Application File Access feature and select an activity to monitor, either Read or Open. See “Adding an application” on page 1506.</td>
</tr>
</tbody>
</table>
Working with Endpoint FlexResponse

This chapter includes the following topics:

- About Endpoint FlexResponse
- Deploying Endpoint FlexResponse
- About deploying Endpoint FlexResponse plug-ins on endpoints
- Deploying Endpoint FlexResponse plug-ins using a silent installation process
- About the Endpoint FlexResponse utility
- Deploying an Endpoint FlexResponse plug-in using the Endpoint FlexResponse utility
- Enabling Endpoint FlexResponse on the Enforce Server
- Uninstalling an Endpoint FlexResponse plug-in using the Endpoint FlexResponse utility
- Retrieving an Endpoint FlexResponse plug-in from a specific endpoint
- Retrieving a list of Endpoint FlexResponse plug-ins from an endpoint

About Endpoint FlexResponse

Symantec Data Loss Prevention provides a set of response rule actions that you can specify to remediate an incident. These provided actions include logging, sending an email, blocking an end-user action, notifying a user, and other responses. You can also use Endpoint FlexResponse plug-ins to provide additional response actions. These plug-ins contain custom instructions for remediation actions that are
executed on endpoints. Endpoint FlexResponse rules are only applicable to Automated Response rules. You cannot create Endpoint FlexResponse rule actions for Smart Response rules.

Symantec Data Loss Prevention customers can contact Symantec or Symantec partners to obtain Endpoint FlexResponse plug-ins. In addition, developers with a knowledge of the Python programming language can create custom Endpoint FlexResponse plug-in scripts using a Symantec-provided API. These custom remediation actions can include encryption, applying Digital Rights Management (DRM), or redacting confidential information.

You use the Endpoint FlexResponse utility to deploy Endpoint FlexResponse plug-ins on endpoints in your Symantec Data Loss Prevention deployment where you require Endpoint FlexResponse actions. You can deploy the plug-ins manually using the Endpoint FlexResponse utility, or you can use system management software (SMS) to distribute the utility and deploy the plug-ins. After you deploy an Endpoint FlexResponse plug-in on an endpoint, you use the Enforce Server administration console to add an **Endpoint: FlexResponse** action to a response rule, and then you add the response rule to an active policy.

**Figure 77-1** shows the sequence of activities that result in an Endpoint FlexResponse action.

**Figure 77-1** Endpoint FlexResponse plug-in process
You can use Endpoint FlexResponse rules on the following types of endpoint destinations and protocols:

- **Endpoint Discover**

  Note: Endpoint FlexResponse is currently unavailable for Endpoint Discover scans that run on Mac agents.

- Local drive monitoring
- Removable storage devices
- SMTP
- HTTP(S)

## Deploying Endpoint FlexResponse

Follow the steps provided here to deploy Endpoint FlexResponse plug-ins.

<table>
<thead>
<tr>
<th>Table 77-1 Deploying Endpoint FlexResponse</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step</strong></td>
</tr>
<tr>
<td>Step 1</td>
</tr>
<tr>
<td>Step 2</td>
</tr>
<tr>
<td>Step 3</td>
</tr>
<tr>
<td>Step 5</td>
</tr>
</tbody>
</table>
About deploying Endpoint FlexResponse plug-ins on endpoints

You must install Symantec DLP Agents on the endpoints before deploying Endpoint FlexResponse plug-ins. The Agents must be connected to an active Endpoint Server.

See the Symantec Data Loss Prevention Installation Guide for information on how to install the agents.

You must deploy Endpoint FlexResponse plug-ins on each endpoint where you require Endpoint FlexResponse actions. You can use a manual installation or a silent installation method to deploy the plug-in. Silent installation methods involve using systems management software (SMS), to distribute and install software on all of your endpoints. You may need to create SMS scripts to access the installation folder.

This section assumes that you have created or otherwise obtained an Endpoint FlexResponse plug-in that is packaged as a ZIP file.

Deploying an Endpoint FlexResponse plug-in on endpoints requires the following steps:

Step 1 Copy the Endpoint FlexResponse utility to your endpoints.

See “About the Endpoint FlexResponse utility” on page 1516.

Step 2 Copy any third-party Python modules that your plug-in requires to your endpoints.


Step 4 Deploy the Endpoint FlexResponse plug-in using the Endpoint FlexResponse utility. (flrinst.exe). Use one of the following options:

- Deploy your plug-in manually on a single endpoint. This option is most useful when you are developing or testing an Endpoint FlexResponse plug-in.
  See “Deploying an Endpoint FlexResponse plug-in using the Endpoint FlexResponse utility” on page 1518.

- Deploy your plug-in using a silent installation process and SMS software. This option is most useful when you are deploying a production-ready Endpoint FlexResponse plug-in.
  See “Deploying Endpoint FlexResponse plug-ins using a silent installation process” on page 1516.
Create response rules that use **Endpoint: FlexResponse** actions that reference the plug-in, and add these rules to an active policy.

See "Implementing policy detection" in the Symantec Data Loss Prevention System Administration Guide.

### Deploying Endpoint FlexResponse plug-ins using a silent installation process

You can use system management software (SMS) to deploy Endpoint FlexResponse plug-ins on multiple endpoints. Although the details of creating installation scripts for SMS software are beyond the scope of this document, note the following requirements:

- You must install Symantec DLP Agents on the endpoints before deploying Endpoint FlexResponse plug-ins. The Agents must be connected to an active Endpoint Server.
- You must install the Endpoint FlexResponse utility (flrinst.exe) on each endpoint where you will deploy Endpoint FlexResponse plug-ins.
- You must make the Endpoint FlexResponse package (.zip file) available to each endpoint. You can copy the package to each endpoint, or you can make the package available on a network drive that is accessible by all endpoints.
- To deploy your plug-in, use the command-line options of the Endpoint FlexResponse utility when creating your installation scripts. See Table 77-3 on page 1517.
- Remove the Endpoint FlexResponse utility after deploying your plug-in. If you leave the utility installed on the endpoints, a malicious user could use the utility to uninstall or alter your Endpoint FlexResponse plug-in.

See “About the Endpoint FlexResponse utility” on page 1516.

See your individual SMS application documentation for more information on how to deploy using SMS.

The Endpoint FlexResponse utility is only available through Symantec and Symantec partners. It is not included with the Symantec Data Loss Prevention distribution.

### About the Endpoint FlexResponse utility

You use the Endpoint FlexResponse utility to manage Endpoint FlexResponse plug-ins. The Endpoint FlexResponse utility is not part of the default Symantec Data
Loss Prevention download and is only available through Symantec or Symantec partners.

Before you run the utility, package your Python scripts into a single ZIP file.

Table 77-2 Endpoint FlexResponse utility actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deploy (Install) plug-ins</td>
<td>Use the install option to deploy plug-ins on an endpoint.</td>
</tr>
<tr>
<td>Uninstall plug-ins</td>
<td>Use the uninstall option to uninstall plug-ins from an endpoint.</td>
</tr>
<tr>
<td>Retrieve deployed plug-ins</td>
<td>Use the retrieve option to retrieve a specific plug-in that has already been deployed on an endpoint.</td>
</tr>
<tr>
<td>See a list of deployed plug-ins</td>
<td>Use the list option to retrieve a list of all plug-ins that are deployed on a specific endpoint. The list contains the names of the deployed plug-ins.</td>
</tr>
</tbody>
</table>

The Endpoint FlexResponse utility must be run from the folder where the Symantec DLP Agent is deployed. The location of this folder is configurable. By default, the directory is located at:

```
c:\Program Files\Manufacturer\Endpoint Agent\n```

The name of the utility is flrinst.exe. The utility uses the following syntax:

```
flrinst.exe -op=install|uninstall|retrieve|list -package=<package_name> -p=<Tools_password>
```

Table 77-3 Endpoint FlexResponse Utility options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-op=install</td>
<td>uninstall</td>
</tr>
<tr>
<td>install—deploys a plug-in</td>
<td>uninstall—removes a plug-in</td>
</tr>
<tr>
<td>list—displays a list of deployed plug-ins</td>
<td></td>
</tr>
<tr>
<td>retrieve—retrieves a plug-in and saves it as an editable text file. The text file is contained in a ZIP file that is saved in the directory where the utility was run.</td>
<td></td>
</tr>
</tbody>
</table>
Table 77-3  Endpoint FlexResponse Utility options (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-package=&lt;package_name&gt;</td>
<td>When you specify the -op=install option, specifies the path to the package (a ZIP file) that contains the Endpoint FlexResponse plug-in. The package name is case sensitive. When you specify either the -op=retrieve or -op=uninstall option, specifies the name of the package.</td>
</tr>
<tr>
<td>-p=&lt;tools_password&gt;</td>
<td>Specify the Tools password that has been configured for your Symantec Data Loss Prevention deployment. If a Tools password has not been configured, use the default password, &quot;VontuStop&quot;. <strong>Note:</strong> As of Symantec Data Loss Prevention version 11.1.1, the password is no longer optional.</td>
</tr>
</tbody>
</table>

If you have created a Tools password for your Symantec Data Loss Prevention deployment, pass this password to the Endpoint FlexResponse utility with the -p option. This password is required to install and uninstall a plug-in. You configure a Tools password during Symantec Data Loss Prevention installation. For more information, see the *Symantec Data Loss Prevention Administration Guide*.

If you have not configured a Tools password, an end user can retrieve and modify previously-installed plug-ins using the default password, VontuStop. Symantec recommends that you configure a Tools password to prevent such tampering. Alternately, you can set your SMS application to remove the Endpoint FlexResponse Utility after you have used it. Removing the utility prevents any unauthorized modification or uninstallation of your plug-ins.

**Deploying an Endpoint FlexResponse plug-in using the Endpoint FlexResponse utility**

You use the Endpoint FlexResponse utility to deploy Endpoint FlexResponse plug-ins. The plug-ins must be in a .zip package format.
To deploy an Endpoint FlexResponse plug-in

1. On an endpoint, open a command window and navigate to the Symantec DLP Agent installation tools directory. The default location of this directory is c:\Program Files\Manufacturer\Endpoint Agent\

2. Enter the following command:

```
flrinst.exe -op=install
    -package=<path_to_plug-in>
    -p=<myToolsPassword>
```

Where:

- `<myToolsPassword>` is the Tools password for your Symantec Data Loss Prevention deployment. If you have not specified a Tools password, use the default password: VontuStop.
- `<path_to_plug-in name>` is the full path to the plug-in .zip file.

For example:

```
flrinst -op=install -package=c:\installs\myFlexResponse_plugin.zip
        -p=myToolsPassword
```

See “Deploying Endpoint FlexResponse” on page 1514.

See “About the Endpoint FlexResponse utility” on page 1516.

Enabling Endpoint FlexResponse on the Enforce Server

Before you can use Endpoint FlexResponse plug-ins in your response rules, you must enable Endpoint FlexResponse functionality through the Enforce Server. By default, Endpoint FlexResponse functionality is not enabled. You enable Endpoint FlexResponse functionality through the Advanced Agent Settings.

To enable Endpoint FlexResponse functionality

1. Open the Enforce Server administration console and navigate to: System > Agents > Agent Configuration and open the Agent configuration that is currently applied to the Endpoint Server that is connected to the Agents where you are deploying the Endpoint FlexResponse plug-in.

2. Click the Advanced Agents Settings tab.

3. Find the PostProcessor.ENABLE_FLEXRESPONSE.int setting.
4 Change the setting to 1.
5 Click Save and Apply.

See “Adding a new response rule” on page 890.
See “Deploying Endpoint FlexResponse” on page 1514.
See “About deploying Endpoint FlexResponse plug-ins on endpoints” on page 1515.

Uninstalling an Endpoint FlexResponse plug-in using the Endpoint FlexResponse utility

To uninstall an Endpoint FlexResponse plug-in from an endpoint

1 On an endpoint, open a command window and navigate to the Symantec DLP Agent installation directory. The default location of this directory is: `c:\Program Files\Manufacturer\Endpoint Agent`.

2 Enter the following command:

```
flrinst.exe -op=uninstall
-package=<Plug-in name>
-p=<myToolsPassword>
```

Where:
- `<Plug-in name>` is the name of the plug-in package `.zip` file.
- `<myToolsPassword>` is the Tools password for your Symantec Data Loss Prevention deployment. If you have not specified a Tools password, use the default password: VontuStop.

For example:

```
flrinst -op=uninstall -package=myFlexResponse_plugin.zip
-p=myToolsPassword
```

Retrieving an Endpoint FlexResponse plug-in from a specific endpoint

Use the following procedure to retrieve a specific plug-in from an endpoint. You can only use the retrieve function on a single endpoint at a time. The plug-in appears in the Symantec DLP Agent installation directory as a `.zip` file. The plug-in script is a plain-text file that has a `.py` extension and is located inside a `.zip` file.
You can edit the plug-in by editing the .py file. If you make edits, you must re-package the ZIP file and re-deploy the plug-in to the endpoint before the edits take effect. Modified plug-ins only affect the individual endpoints where they were modified.

To retrieve an Endpoint FlexResponse plug-in from a specific endpoint

1. On the endpoint, open a command prompt window and navigate to the Symantec DLP Agent installation directory:

   The default location of this directory is `c:\Program Files\Manufacturer\Endpoint Agent\`

2. Enter the following command:

   `flrinst -op=retrieve -package=<Plug-in name> -p=<myToolsPassword>`

   Where:

   - `<myToolsPassword>` is the tools password for your Symantec Data Loss Prevention deployment. If you have not specified a Tools password, use the default password: VontuStop.
   - `<plug-in name>` is the name of the plug-in .zip file.

   For example:

   `flrinst -op=retrieve -package=myFlexResponse_plugin.zip -p=myToolsPassword`

Retrieving a list of Endpoint FlexResponse plug-ins from an endpoint

Use the following procedure to retrieve a list of plug-ins that have been deployed on a specific endpoint. You can only use the list function on individual endpoints. You cannot use the list function on a set of endpoints.

The list of plug-ins contains only the name of the plug-in package. The list does not contain any type of description about the plug-ins. Symantec recommends that you use descriptive names for your plug-ins so that you can recognize them within the list.
To retrieve the list of Endpoint FlexResponse plug-ins from an endpoint

1. On an endpoint, open a command window and navigate to the Symantec DLP Agent installation tools directory. The default location of this directory is `c:\Program Files\Manufacturer\Endpoint Agent\`.

2. Enter the following command:

   ```
   flrinst.exe -op=list -p=<myToolsPassword>
   ```

   Where: `<myToolsPassword>` is the Tools password for your Symantec Data Loss Prevention deployment. If you have not specified a Tools password, use the default password: `VontuStop`.

   For example:

   ```
   flrinst -op=list -p=myToolsPassword
   ```

   The list of deployed Endpoint FlexResponse plug-ins displays in the command window.
Using Endpoint tools

This chapter includes the following topics:

- About Endpoint tools

About Endpoint tools

Symantec Data Loss Prevention provides a number of tools to help you work with Symantec DLP Agents. See the Acquiring Symantec Data Loss Prevention Software document for information on obtaining the files that contain these tools.

Move these tools to a secure directory. These Endpoint tools work with the keystore file that is found in the Agent Install directory. The tools and the keystore file must be in the same folder to function properly. Each tool requires a password to operate. A universal tools password is generated during your installation.

The following list contains some of the tasks that you can complete using endpoint tools:

Table 78-1  Endpoint tools task list

<table>
<thead>
<tr>
<th>Task</th>
<th>Tool name and location</th>
<th>Additional information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shut down the agent and the watchdog services</td>
<td>service_shutdown</td>
<td>Shutting down the agent and the watchdog services</td>
</tr>
<tr>
<td></td>
<td>Available for Windows agents in the Symantec_DLP_12.5_Agent_Win-IN.zip file.</td>
<td></td>
</tr>
<tr>
<td>Task</td>
<td>Tool name and location</td>
<td>Additional information</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Inspect database files that are accessed by the agent</td>
<td>vonu_sqlite3</td>
<td>Inspecting the database files accessed by the agent</td>
</tr>
<tr>
<td></td>
<td>Available for Windows agents in the Symantec_DLP_12.5_Agent_Win-IN.zip file.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Available for Mac agents in the Symantec_DLP_12.5_Agent_Mac-IN.zip file.</td>
<td></td>
</tr>
<tr>
<td>View extended log files</td>
<td>logdump</td>
<td>Viewing extended log files</td>
</tr>
<tr>
<td></td>
<td>Available for Windows agents in the Symantec_DLP_12.5_Agent_Win-IN.zip file.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Available for Mac agents in the Symantec_DLP_12.5_Agent_Mac-IN.zip file.</td>
<td></td>
</tr>
<tr>
<td>Generate uninstallation passwords for your agents</td>
<td>UninstallPwdKeyGenerator</td>
<td>Creating passwords with the password generation tool</td>
</tr>
<tr>
<td></td>
<td>Available for Windows agents in the Symantec_DLP_12.5_Agent_Win-IN.zip file.</td>
<td></td>
</tr>
<tr>
<td>Generate third-party application information</td>
<td>GetAppInfo</td>
<td>Using the GetAppInfo tool</td>
</tr>
<tr>
<td></td>
<td>Available for Windows agents in the Symantec_DLP_12.5_Agent_Win-IN.zip file.</td>
<td></td>
</tr>
<tr>
<td>Start DLP Agents that are installed on Mac endpoints</td>
<td>start_agent</td>
<td>Starting DLP Agents that run on Mac endpoints</td>
</tr>
<tr>
<td></td>
<td>Available for Mac agents in the AgentInstaller_Mac64.zip file.</td>
<td>This file is created after you complete the agent installation package process.</td>
</tr>
<tr>
<td></td>
<td>See &quot;Generating agent installation packages&quot; in the Symantec Data Loss Prevention Installation guide for more information.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You must unzip this file to a Mac endpoint. You cannot use the tool if it is unzipped to a Windows endpoint.</td>
<td></td>
</tr>
</tbody>
</table>
Using Endpoint tools with Windows 7/8/8.1

If you use Endpoint tools on a computer that runs Windows 7/8/8.1, run the command prompt in the Elevated Command Prompt mode. This procedure is required because of the nature of the Windows operating system. You cannot run the Endpoint tools without using the Elevated Command Prompt mode.

To initiate the Elevated Command Prompt mode on Windows 7
1. Click the Start menu.
2. In the Search programs and files field, enter command prompt. The Command Prompt program appears in the results list.
3. Hold the Shift key and right-click the Command Prompt entry in the results list. Select either Run as Administrator or Run as different user.
4. If you selected Run as different user, enter the credentials for a user that has administrator privileges.

To initiate the Elevated Command Prompt mode on Windows 8/8.1
1. Display the Command Prompt.
   - In Desktop mode, right-click on the Windows icon and select Command Prompt (Admin), then click the Start menu.
   - In Metro mode, enter cmd in the Search programs and files field.
2. Hold the Shift key and right-click Command Prompt in the results list.
3. Select Run as Administrator.

Shutting down the agent and the watchdog services

The Service_Shutdown.exe tool shuts down the Symantec DLP Agent and watchdog services. As a tamper-proofing measure, it is not possible for a user to individually stop either the Symantec DLP Agent or watchdog service. This tool enables an administrator to stop both Symantec Data Loss Prevention services at the same time.
To run the Service_Shutdown.exe tool

- From the installation directory, run the following command:

```bash
service_shutdown [-p=password]
```

where the installation directory is the directory where you installed Symantec Data Loss Prevention and [-p=password] is the password you previously specified. If you do not enter a password, you are prompted to input a password. The default password is `VontuStop`.

You must run the Service_Shutdown.exe tool from the same directory as the Symantec DLP Agent keystore file.

See “About Endpoint tools” on page 1523.

Inspecting the database files accessed by the agent

The `vontu_sqlite3` tool enables you to inspect the database files that the Symantec DLP Agent uses. It provides an SQL interface to query database files and update database files. Without this tool, you cannot view the contents of a database file because it is encrypted. Use this tool when you want to investigate or make changes to the Symantec Data Loss Prevention files.

**Note:** You can use this tool to view DLP Agent log files on Mac endpoints. You must have root or sudo access to make changes to the agent database.

To run the `vontu_sqlite3.exe` tool

1. Run one of the following scripts from the Symantec Data Loss Prevention Agent installation directory:
   - For Windows agents run the following command:
     ```bash
     vontu_sqlite3 -db=database_file [-p=password]
     ```
     where `database_file` is your database file and `password` is your specified tools password.
     The Symantec Data Loss Prevention database files for Windows agents are located in the Symantec DLP Agent installation directory and end in the `.ead` extension. After you run the command, you are prompted for your password.
   - For Mac agents run the following command:
     ```bash
     sudo ./vontu_sqlite3 -db=database_file [-p=password]
     ```
where database_file is your database file and password is your specified tools password.

You run this command using the Terminal application. The vontu_sqlite3 tool is located at /Library/Manufacturer/Endpoint Agent/.

2 Enter the default password VontuStop unless you have already created a unique password.

You are provided with a shell to enter SQL statements to view or update the database.

Refer to http://www.sqlite.org/sqlite.html for complete documentation about what commands are available in this shell.

See “About Endpoint tools” on page 1523.

Viewing extended log files

The logdump.exe tool lets you view the extended log files for Symantec Data Loss Prevention Agents. Extended log files are hidden for security reasons. Generally, you only need to view log files with Symantec Data Loss Prevention support personnel. Without this tool, you cannot view any Symantec Data Loss Prevention Agent log files.

Note: You can use this tool to view DLP Agent log files on Mac endpoints. You must have root or sudo access to make changes to the agent database.

To run the log dump tool

1 Run one of the following scripts from the Symantec Data Loss Prevention Agent installation directory:

   ■ On Windows agents:

   logdump -log=log_file [-p=password]

   where log_file is the log file you want to view and password is the specified tools password. All Symantec Data Loss Prevention extended log files are present in the Symantec Data Loss Prevention Agent installation directory. The files have names of the form edpa_extfile_number.log. After you run this command, you can see the de-obfuscated log.

   Note: When using Windows PowerShell to run logdump.exe, quotes are required around the log file. For example, run:

   logdump "-log=log_file" [-p=password]
- **On Mac agents:**

  ```bash
  sudo ./logdump -log=log_file [-p=password]
  ```

  where `log_file` is the log file you want to view and `password` is the specified tools password.

  All Symantec Data Loss Prevention extended log files are present in the Symantec Data Loss Prevention Agent installation directory. The files have names of the form `edpa_extfile_number.log`. After you run this command, you can see the de-obfuscated log.

2. **(Optional) Print the contents of another log from this view.**

   **To print the contents of another log**

   1. From the command window, run:

      ```bash
      logdump -log=log_file -p=password > deobfuscated_log_file_name
      ```

   2. Enter the password again to print the log.

   See “About Endpoint tools” on page 1523.

---

**About the Device ID utility**

Symantec Data Loss Prevention provides the `DeviceID.exe` utility to assist you with configuring endpoint devices for detection.

See “About endpoint device detection” on page 634.

The `DeviceID` utility scans the computer for all connected devices and reports the Device Instance ID string for each device that is detectable.

See “Using the Device ID utility” on page 1529.

<table>
<thead>
<tr>
<th>Table 78-2</th>
<th>Device ID utility example output</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Result</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Volume</td>
<td>The volume or mount point that the <code>DeviceID.exe</code> tool found. For example: Volume: E: \</td>
</tr>
<tr>
<td>Dev ID</td>
<td>The Device Instance ID for each device. For example: <code>USBSTOR\DISK&amp;VEN_UPD&amp;PROD_USB_FLASH_DRIVE&amp;REV_1100\5F73HF00Y9DB00DXJ</code></td>
</tr>
</tbody>
</table>
Table 78-2  Device ID utility example output (continued)

<table>
<thead>
<tr>
<th>Result</th>
<th>Description</th>
</tr>
</thead>
</table>
| Regex  | The regular expression to detect that device instance.  
For example:  
USBSTOR\DISK&VEN_UFD&PROD_USB_FLASH_DRIVE&REV_1100\5F73HF00Y9DB0G0DXJ |

Using the Device ID utility

Use the Device ID utility to extract Device Instance ID strings and to determine what devices the system can recognize for detection.

See “About the Device ID utility” on page 1528.

See “About endpoint device detection” on page 634.

To use the Device ID utility

1. Obtain the DeviceID.exe utility.

This utility is available with the Endpoint Sever utilities package.

See “About Endpoint tools” on page 1523.

2. Copy the DeviceID.exe utility to a computer where you want to determine Device IDs.

3. Install the devices you want to examine onto the computer where you copied the DeviceID.exe utility.

For example, plug in one or more USB devices, connect a hard drive, etc.

4. Run the DeviceID.exe utility from the command line.

For example, if you copied the DeviceID.exe utility to the C:\temp directory, issue the follow command:

C:\temp>DeviceID

To output the results to a file, issue the following command:

C:\TEMP>DeviceID > deviceids.txt

The file appears in the C:\temp directory and contains the output from the DeviceID process.

5. View the results of the DeviceID process.

The command prompt displays the results for each volume or mount point.

See Table 78-2 on page 1528.
6 Use the DeviceID utility to evaluate the proposed regex string against a device that's currently connected.

See Table 78-3 on page 1530.

7 Use the regular expression patterns to configure endpoint devices for detection.

See “Creating and modifying endpoint device configurations” on page 641.

<table>
<thead>
<tr>
<th>Command parameters</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>DeviceID.exe [-m]</td>
<td>DeviceID.exe -m E:\USBSTOR\DISK&amp;VEN_UFD&amp;PROD_USB_FLASH_DRIVE&amp;REV_1100.*</td>
</tr>
<tr>
<td>[Volume] [Regex]</td>
<td>Note: The regex string needs to be inside quotation marks.</td>
</tr>
</tbody>
</table>

Returns Match! or Not match!

Creating passwords with the password generation tool

Use the uninstallation password generator tool to create a unique password key.

The name of the uninstallation password generator tool is UninstallPwdKeyGenerator.

The uninstallation password prevents unauthorized users from removing the Symantec DLP Agent. The UninstallPwdKeyGenerator tool works with the PGPSdk.dll file to create unique passwords. The tool and the file must be located in the same tools directory to function. The UninstallPwdKeyGenerator tool and the PGPSdk.dll file are located in the Administrator tool directory by default.

Note: The UninstallPwdKeyGenerator tool only works in Microsoft Windows environments. You cannot use this tool with any other operating system.

To create an uninstallation password

1 From a command window, navigate to the Symantec Data Loss Prevention keystore directory.

2 Enter the following command:

   UninstallPwdKeyGenerator.exe -xp=<uninstall_password>

   where <uninstall_password> is the password that you want to use. Choose a unique password key.
A password key is generated. Enter this key in the command line when you install the agent.

### Starting DLP Agents that run on Mac endpoints

You can use the start_agent tool to start DLP Agents that run on Mac endpoints. You use the tool if the agents have been shut down using the shutdown task on the **Agent List** screen.

This tool is available in the `AgentInstaller_Mac64.zip` file. This file is created after you complete the agent installation package process.

See "Generating agent installation packages" in the *Symantec Data Loss Prevention Installation guide* for more information.

---

**Note:** You must unzip this file to a Mac endpoint. You cannot use the tool if it is unzipped to a Windows endpoint.

---

**To start agents using the start_agent tool:**

1. From the Symantec Data Loss Prevention Agent installation directory, run the following command:

   ```
   start_agent
   ```

   where the installation directory is the directory where you installed Symantec Data Loss Prevention.

2. Go to the **Agent List** screen and confirm that the agent is running.

See “Using the Agent List screen” on page 1460.

See “About Endpoint tools” on page 1523.
Monitoring and preventing data loss on mobile devices

- Chapter 79. Introducing Symantec Data Loss Prevention Mobile Prevent for Web
- Chapter 80. Implementing Mobile Prevent for Web
Introducing Symantec Data Loss Prevention Mobile Prevent for Web

This chapter includes the following topics:

- How Mobile Prevent for Web works
- About deploying Mobile Prevent for Web
- About digital certificates for Mobile Prevent for Web
- About the VPN server and VPN On Demand
- About Microsoft Exchange ActiveSync and Mobile Prevent for Web
- About mobile device management

How Mobile Prevent for Web works

Mobile Prevent for Web connects to your corporate network through Wi-Fi access or through cellular 3G connectivity. Network traffic for Webmail, third-party applications such as Yahoo and Facebook, and corporate email applications including Microsoft Exchange ActiveSync, is sent through the HTTP/S protocol. Corporate email can be sent through Microsoft ActiveSync as either HTTP or HTTPS protocol information. Microsoft ActiveSync receives the information from the corporate proxy server after it has gone through detection; then, sends the message to the corporate Exchange Server. Messages that are sent through applications such as Facebook or Dropbox can be blocked from the message, depending on your policies.
See “About deploying Mobile Prevent for Web” on page 1535.

Mobile devices must connect to the corporate network through a virtual private network (VPN) to send corporate messages or access the corporate network. The Mobile Prevent for Web solution requires that mobile devices use the VPN On Demand feature to create a constant, protected VPN connection. If you are not connected to the corporate network, Mobile Prevent for Web cannot detect any policy violations.

See “About the VPN server and VPN On Demand” on page 1538.

VPN configuration can be specified in a configuration profile by your mobile device management (MDM) solution. The MDM solution applies a configuration profile to each mobile device that you want to connect to your corporate network.

See “About mobile device management” on page 1541.

See the Symantec Data Loss Prevention System Requirements and Compatibility Guide for details about requirements for Mobile Prevent for Web.

The following graphic illustrates the connections necessary to enable Mobile Prevent for Web:
About deploying Mobile Prevent for Web

The Mobile Prevent for Web Server interacts with the Enforce Server and the corporate proxy server to monitor and prevent incidents on mobile devices.

The following diagram describes how the Mobile Prevent for Web solution fits into your corporate infrastructure:
In this deployment, mobile devices connect to the corporate network through your VPN server. The VPN server assigns each mobile device an IP address. This address lets the device access the internal corporate network. After the device is assigned a unique IP address, all HTTP, HTTPS, and FTP traffic is monitored by the Mobile Prevent for Web Server. Each device must be connected to the corporate network through the VPN. If the VPN connection to the corporate network is lost, Mobile Prevent for Web cannot detect any violations.
iPads and iPhones use a native feature called VPN On Demand to create a secure VPN connection automatically without user intervention. VPN On Demand requires certificate-based authentication to create the connection to the VPN Server.

After the VPN connection is established, traffic is sent through the proxy server and analyzed by Mobile Prevent for Web Server. Traffic between the proxy server and the Mobile Prevent for Web Server is done over the ICAP protocol. If no violations are discovered, the traffic is sent to its destination either internally or externally. If violations are discovered, an incident is created and response actions are implemented. Incidents are recorded on the Enforce Server.

When a mobile device sends an email through Microsoft Exchange ActiveSync, the HTTP/HTTPS packets are sent to the ActiveSync server. The packets are then sent to the Exchange Server. Any corporate email should go through Microsoft Exchange ActiveSync. Mobile Prevent for Web does not support the SMTP protocol.

Note: Mobile Prevent for Web does not support response mode (RESPMOD).

About digital certificates for Mobile Prevent for Web

Mobile Prevent for Web requires digital certificates to ensure the validity of the user, enable certificate-based authentication to the VPN server, and allow SSL interception by the proxy server.

See “About authenticating users” on page 85.

You can use an MDM solution to deploy the certificates to multiple mobile devices as part of the mobile device profile.

See “About mobile device management” on page 1541.

See “Configuring the VPN profile” on page 1547.

The following table describes the four certificates that you must create for Mobile Prevent for Web:

<table>
<thead>
<tr>
<th>Certificate</th>
<th>Where installed</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Certificate Authority (CA) root certificate</td>
<td>mobile devices, VPN Server, proxy server</td>
<td>The base CA. All other certificates are signed by the root CA or its subordinate CA. If a device trusts the root CA, then it trusts all valid certificates that are signed by the root CA or the subordinate CA.</td>
</tr>
</tbody>
</table>
Table 79-1  Digital certificates for Mobile Prevent for Web (continued)

<table>
<thead>
<tr>
<th>Certificate</th>
<th>Where installed</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User certificate</td>
<td>mobile devices</td>
<td>Identifies individual users. Users must have this certificate to gain access to the corporate subnetwork. The certificate is sent to the VPN server for authentication. This certificate is required to establish the VPN tunnel to the corporate network.</td>
</tr>
<tr>
<td>Subordinate certificate authority</td>
<td>Proxy server</td>
<td>The subordinate CA certificate grants the proxy server the permission to issue server identity certificates for HTTPS servers. This certificate is needed for SSL interception. After the mobile device has connected to the corporate subnetwork, the proxy server intercepts the traffic. The proxy server then acts as a go-between for the HTTPS server and the mobile device. The proxy server acts as a subordinate CA and verifies the certificate from the HTTPS server and issues a new certificate for the HTTPS server.</td>
</tr>
<tr>
<td>Device certificate</td>
<td>VPN Server</td>
<td>Establishes that the identity of the VPN server host name is valid before the mobile device can connect to it. The certificate ensures that the mobile device does not connect to an unauthorized VPN server.</td>
</tr>
</tbody>
</table>

About the VPN server and VPN On Demand

Your mobile device connects to the VPN server to gain access to your corporate network.

The VPN server assigns an IP address to each mobile device that connects to it. These IP addresses form a VPN subnetwork. The VPN subnetwork lets your mobile devices access the corporate network and the corporate proxy server. You can specify a range of IP addresses that your VPN server can assign to other devices. All of the IP addresses that the VPN server assigns to your mobile devices are within this range. If a range of addresses were not specified for your VPN server, the network could randomly assign IP addresses to your mobile devices. A specific range of IP addresses lets Symantec Data Loss Prevention identify which IP addresses are assigned to mobile devices and which addresses are not connected. Using a range of IP addresses assists in identifying which mobile device generated an incident.
On the Mobile Prevent for Web side, VPN On Demand ensures that the VPN connection is not interrupted. Apple mobile devices use VPN On Demand to dynamically create a VPN session. VPN on Demand starts the VPN session when connecting to a specific list of configured domains (for example .com, .net, or .org). Certificate-based authentication is required to configure the VPN On Demand feature. By configuring how VPN On Demand automatically enables VPN on an iOS mobile device, you can ensure that all traffic goes through your corporate network. You need a Web proxy that is deployed in transparent mode to route traffic from the mobile devices in your corporate network to Symantec Data Loss Prevention. The network traffic is routed uses the ICAP service.

You can use a mobile device management (MDM) solution to apply the network and VPN configuration.

**About Microsoft Exchange ActiveSync and Mobile Prevent for Web**

Microsoft Exchange ActiveSync is a way that you can send corporate emails from a mobile device. ActiveSync can send email either to recipients internal to the corporate network or outside of the corporate network. ActiveSync sends corporate email through an HTTP or HTTPS protocol. Any sensitive information transferring internally or externally that violates your policies is blocked.

The following diagram illustrates how corporate messages are sent through ActiveSync:

---

Note: The following diagram also applies to iPhones.
In this example, messages are sent from the iPad email client, which is configured with ActiveSync, through the VPN-connected corporate network. The message is sent as an HTTP/S request. The message is received in the ActiveSync Server and sent on to the Microsoft Exchange Server. The Exchange Server sends the message to the MTA server as an SMTP message. The MTA server sends the corporate message on to the recipient.

You can disable ActiveSync monitoring by filtering.

**Note:** Mobile Prevent for Web does not support blocking or redacting contacts and calendar traffic.

See “Ignoring Microsoft Exchange ActiveSync monitoring” on page 1540.

**Ignoring Microsoft Exchange ActiveSync monitoring**

If you do not want to monitor corporate email messages going through ActiveSync, use the following procedure:
Ignoring Microsoft Exchange ActiveSync monitoring

1. On the Enforce Server administration console, go to the Server Settings for the Mobile Prevent for Web Server.

2. In the Request Filtering section, add the host name of the ActiveSync Server to the Ignore Requests to Hosts or Domains field.

3. Click Save.

See “About Microsoft Exchange ActiveSync and Mobile Prevent for Web” on page 1539.

About mobile device management

Use a mobile device management (MDM) solution to manage and apply a wide variety of configuration settings to multiple mobile devices. You can load user profiles where corporate mail settings, VPN settings, security certificates, and proxy server settings are preconfigured onto the mobile devices. To access the Mobile Prevent for Web Server, you must use an MDM solution to apply the VPN server configuration profile. The VPN server configuration profile sets the conditions for VPN On Demand to route all network traffic through the VPN and into your corporate network. Only network traffic flowing in your corporate network can be monitored for violations.

See “Configuring the VPN profile” on page 1547.
Implementing Mobile Prevent for Web

This chapter includes the following topics:

- Implementing Mobile Prevent for Web

Implementing Mobile Prevent for Web

The Mobile Prevent for Web Server integrates with a VPN server, an MDM solution, and a Web proxy server using ICAP. If it detects confidential data in Web content, the proxy will reject requests or remove HTML content as specified in your Mobile Prevent for Web policies.

First, you need to know the high-level steps that are required for implementing Mobile Prevent for Web. You can check the cross-referenced sections for more details. The following procedure assumes that you are implementing Mobile Prevent for Web as a standalone product.

See “About deploying Mobile Prevent for Web” on page 1535.

**Note:** These procedures assume that you already have your VPN and proxy servers running in your environment.

<table>
<thead>
<tr>
<th>Table 80-1</th>
<th>Implementing Mobile Prevent for Web</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step</td>
<td>Procedure</td>
</tr>
<tr>
<td>Step 1</td>
<td>Add a new Mobile Prevent for Web Server.</td>
</tr>
</tbody>
</table>
Configuring the Mobile Prevent for Web Server

You can use a number of configuration options for Mobile Prevent for Web Server. For example, you can configure the server to:

- Ignore small HTTP/S requests or responses.
- Ignore requests to or responses from a particular host or domain (such as the domain of a business subsidiary).
- Ignore user search engine queries.

See “Adding a detection server” on page 194.

---

Table 80-1  Implementing Mobile Prevent for Web (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Procedure</th>
<th>For more information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Configure your Mobile Prevent for Web Server.</td>
<td>See “Configuring the Mobile Prevent for Web Server” on page 1543.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Configure your VPN Server with the IP address range that you want to assign to the corporate mobile devices for the Mobile Prevent for Web sub-network</td>
<td>See the documentation for your VPN Server.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Configure your VPN profile with the MDM application.</td>
<td>See “Configuring the VPN profile” on page 1547.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Define ICAP services on proxy to route traffic to Mobile Prevent for Web.</td>
<td>See “About proxy server configuration” on page 1170.</td>
</tr>
<tr>
<td>Step 6</td>
<td>Create and deploy a policy for Mobile Prevent for Web.</td>
<td>See “Creating policies for Mobile Prevent for Web” on page 1551.</td>
</tr>
<tr>
<td>Step 7</td>
<td>Test the system by generating an incident against your test policy.</td>
<td>See “Testing Mobile Prevent for Web” on page 1554.</td>
</tr>
<tr>
<td>Step 8</td>
<td>If required, troubleshoot the implementation.</td>
<td></td>
</tr>
</tbody>
</table>

See the Symantec Data Loss Prevention System Requirements and Compatibility Guide for more details on configuring Mobile Prevent for Web to work within your organization.
To modify your Mobile Prevent for Web Server configuration

1. Go to System > Servers > Overview and click the Mobile Prevent for Web Server.

2. On the Server Detail screen that appears, click Configure.

    You can verify or modify settings on the ICAP tab as described in subsequent steps. The tab is divided into several sections: Request Filtering, Response Filtering, and Connection.

3. Verify or change the Trial Mode setting.

4. Verify or modify the filter options for requests from HTTP clients (user agents).

   The options in the Request Filtering section are as follows:

   **Ignore Requests Smaller Than**
   
   Specifies the minimum body size of HTTP requests to inspect. (The default is 4096 bytes.) For example, search-strings typed in to search engines such as Yahoo or Google are usually short. By adjusting this value, you can exclude those searches from inspection.

   **Ignore Requests without Attachments**
   
   Causes the server to inspect only the requests that contain attachments. This option can be useful if you are mainly concerned with requests intended to post sensitive files.

   **Ignore Requests to Hosts or Domains**
   
   Causes the server to ignore requests to the hosts or domains you specify. This option can be useful if you expect a lot of HTTP traffic between the domains of your corporate headquarters and branch offices. You can type one or more host or domain names (for example, www.company.com), each on its own line.

   **Ignore Requests from User Agents**
   
   Causes the server to ignore requests from user agents (HTTP clients) you specify. This option can be useful if your organization uses a program or language (such as Java) that makes frequent HTTP requests. You can type one or more user agent values (for example, java/6.0.29), each on its own line.
Note: The Response Filtering options are not supported for Mobile Prevent.

Verify or modify the filter options for responses from Web servers. The options in the Response Filtering section are as follows:

**Ignore Responses Smaller Than**
Specifies the minimum size of the body of HTTP responses that are inspected by this server. (Default is 4096 bytes.)

**Inspect Content Type**
Specifies the MIME content types that Symantec Data Loss Prevention should monitor in responses. By default, this field contains content-type values for Microsoft Office, PDF, and plain text formats. To add others, type one MIME content type per line. For example, type `application/wordperfect5.1` to have Symantec Data Loss Prevention analyze WordPerfect 5.1 files.

Note that it is generally more efficient to specify MIME content types at the Web proxy level.

**Ignore Responses from Hosts or Domains**
Causes the server to ignore responses from the hosts or domains you specify. You can type one or more host or domain names (for example, www.company.com), each on its own line.

**Ignore Responses to User Agents**
Causes the server to ignore responses to user agents (HTTP clients) you specify. You can type one or more user agent values (for example, `java/1.4.2_xx`), each on its own line.
6 Verify or modify settings for the ICAP connection between the HTTP proxy server and the Mobile Prevent for Web Server. The **Connection** options are as follows:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>TCP Port</strong></td>
<td>Specifies the TCP port number over which this server listens for ICAP requests. This number must match the value that is configured on the HTTP proxy that sends ICAP requests to this server. The recommended value is 1344.</td>
</tr>
<tr>
<td><strong>Maximum Number of Requests</strong></td>
<td>Specifies the maximum number of simultaneous ICAP request connections from the HTTP proxy or proxies. The default is 25.</td>
</tr>
<tr>
<td><strong>Maximum Number of Responses</strong></td>
<td>Specifies the maximum number of simultaneous ICAP response connections from the HTTP proxy or proxies. The default is 25.</td>
</tr>
<tr>
<td><strong>Connection Backlog</strong></td>
<td>Specifies the number of waiting connections allowed. A waiting connection is a user waiting for an HTTP response from the browser. The minimum value is 1. If the HTTP proxy gets too many requests (or responses), the proxy handles them according to your proxy configuration. You can configure the HTTP proxy to block any requests (or responses) greater than this number.</td>
</tr>
</tbody>
</table>

7 In the **Mobile IP Ranges** fields, enter the range of IP addresses that your VPN server is configured to assign to mobile devices. The IP addresses are used to identify the incidents that were triggered from mobile devices as Mobile incidents.

The IP addresses you enter into this range do not dynamically affect the VPN Server. This range is only to identify your mobile devices in the administration console. You must enter the exact same range of IP addresses when you configure the VPN Server to assign the addresses.

8 Click **Save** to exit the **Configure Server** screen and then click **Done** to exit the **Server Detail** screen.
Configuring the VPN profile

You must configure the VPN profile before mobile devices can connect to the corporate network. The VPN profile combines security certificates, the VPN server configuration settings, VPN On Demand settings, and any network configuration settings. Normally, the VPN profile is set and applied through your MDM solution. Along with the VPN profile, you can configure other aspects of your mobile device such as Microsoft Exchange ActiveSync, firewall properties, or LDAP settings.

See “About mobile device management” on page 1541.

The following table describes the minimum VPN profile settings that you must make to enable Mobile Prevent. Depending on your MDM solution, the name of the setting may differ.

Table 80-2 Basic VPN profile settings

<table>
<thead>
<tr>
<th>Type of setting</th>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VPN Configuration settings</td>
<td>Connection Name</td>
<td>The name of the connection type. Usually, this is a unique name so that you can identify it later.</td>
</tr>
<tr>
<td></td>
<td>Connection Type</td>
<td>Select the connection type for your VPN server. For example, IPSec (Cisco).</td>
</tr>
<tr>
<td></td>
<td>Server Name</td>
<td>Enter the host name or IP address for your VPN server.</td>
</tr>
<tr>
<td></td>
<td>User Name</td>
<td>The user name for the mobile device that connects to the VPN server. For example, &lt;firstname_lastname&gt; where the first name and the last name of the user is specified.</td>
</tr>
<tr>
<td></td>
<td>Machine Authentication</td>
<td>Select the certificate option. To enable Mobile Prevent for Web, you must use certificates for your company and your Certificate Authority.</td>
</tr>
<tr>
<td></td>
<td>Identity Certificate</td>
<td>Select the certificate of the user you want to add.</td>
</tr>
</tbody>
</table>
### Table 80-2 Basic VPN profile settings (continued)

<table>
<thead>
<tr>
<th>Type of setting</th>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable VPN On Demand</td>
<td></td>
<td>You must enable VPN On Demand. After you have enabled VPN On Demand, you can add the specific domain suffixes that you want. All domain suffixes should be enabled with the On Demand Action <strong>Always Establish</strong>. For example, the domain suffixes .com, .net, .org, and .gov are added as <strong>Always Establish</strong>. Any time a domain name with one of those suffixes is called, the VPN tunnel must be established before the connection can complete.</td>
</tr>
<tr>
<td>Credential Settings</td>
<td></td>
<td></td>
</tr>
<tr>
<td>My Company</td>
<td></td>
<td>The certificate for your company. This is the root certificate for the Certificate Authority (CA).</td>
</tr>
<tr>
<td>Our Company</td>
<td></td>
<td>This is the certificate for the proxy server.</td>
</tr>
<tr>
<td>User Credential</td>
<td></td>
<td>This is the individual user certificate to access the proxy server.</td>
</tr>
<tr>
<td>Wi-Fi Settings</td>
<td></td>
<td>Use Wi-Fi settings if you want to mandate specific Wi-Fi networks wherein your mobile device will only work with specific networks. If you specify unique Wi-Fi settings, your mobile device cannot connect to any other Wi-Fi network.</td>
</tr>
</tbody>
</table>

### About proxy server configuration for Mobile Prevent for Web

You must configure at least one HTTP/S proxy server to forward Web requests to Mobile Prevent for Web. The HTTP proxy acts as an ICAP client to the Mobile Prevent for Web Server. Mobile Prevent for Web supports only the request modification (REQMOD) mode of ICAP. Do not configure your HTTP proxy for the response modification (RESPMOD) mode.

**Note:** The proxy server must be deployed in transparent mode. Consult the proxy server documentation for details.

See “Specifying one or more proxy servers” on page 1173.
See “Proxy server compatibility with Mobile Prevent for Web” on page 1549.
Proxy server compatibility with Mobile Prevent for Web

Mobile Prevent for Web Servers can operate with the following Web proxies:

Table 80-3 Mobile Prevent for Web supported proxy servers

<table>
<thead>
<tr>
<th>Proxy</th>
<th>Supported protocols</th>
<th>Configuration information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blue Coat ProxySG</td>
<td>HTTP, HTTPS, FTP over HTTP, or FTP proxy</td>
<td>Blue Coat product documentation</td>
</tr>
</tbody>
</table>

See “Specifying one or more proxy servers” on page 1173.
See “About proxy server configuration” on page 1170.

Configuring the request mode service

For details on configuring the proxy server, refer to your proxy server product documentation, or contact your proxy server administrator.

To configure a proxy server:

- REQMOD. On your proxy server, create an ICAP REQMOD service that forwards requests to Mobile Prevent. If your proxy server supports different protocols, configure it to handle the desired protocols.

  For REQMOD mode, an ICAP service on the proxy server should look like:

  `icap://ip_address|FQDN[:port]/reqmod`

Where:

- `ip_address|FQDN` identifies the Mobile Prevent for Web Server using either an IP address or fully qualified domain name.
- `Port` is the port number to which the Mobile Prevent for Web Server listens. Specifying the port number is optional when the default ICAP port (1344) is used.
- `/reqmod` is required for correct functionality in REQMOD mode.

Examples:

`icap://10.66.194.45/reqmod`
`icap://10.66.194.45:1344/reqmod`
`icap://netmonitor1.company.com/reqmod`
Note: The port that is specified in the ICAP service definition on the proxy must match the port where Mobile Prevent for Web Server listens.

See “About proxy server configuration” on page 1170.

Specifying one or more proxy servers

By default, Mobile Prevent for Web Server can accept connections to the ICAP service port from any system on the network. For security reasons, you can limit ICAP connections to only those systems that you designate (or “whitelist”). Once you whitelist one or more systems, systems not on the whitelist cannot connect to the Mobile Prevent for Web Server ICAP service port.

Note: A proxy server whitelist can be affected by the Icap.BindAddress setting. By default, the Icap.BindAddress setting is 0.0.0.0, and the listener binds to all available addresses. If the Icap.BindAddress instructs the listener to bind to a specific IP, a whitelisted proxy must also be able to reach the listener address.

To create a whitelist of systems allowed to make a connection to the Mobile Prevent for Web Server ICAP service port:

1. In the Enforce Server administration console, go to System > Servers > Overview and click the desired Mobile Prevent for Web Server.
2. On the Server Detail screen that appears, click Server Settings.
3. Scroll down to the Icap.AllowHosts setting.
   By default, Icap.AllowHosts is set to any, meaning that all other systems on the network can communicate with this Mobile Prevent for Web Server.
4. You can limit the systems that are allowed to connect with this Mobile Prevent for Web Server. Delete any and enter the IP addresses or Fully-Qualified Domain Name (FQDN) of the systems you want to authorize.
   Separate multiple addresses with commas. For example: 123.14.251.31,webcache.corp.mycompany.com,123.14.223.111. Use only commas to separate multiple entries; do not include spaces.
5. Click Save.

Changes to this setting do not take effect until you restart the Mobile Prevent for Web Server.

See “Proxy server compatibility with Mobile Prevent for Web” on page 1549.
See “About proxy server configuration for Mobile Prevent for Web” on page 1548.
Enabling GET processing for Mobile Prevent for Web

By default, Mobile Prevent for Web does not process HTTP GET commands because of the high traffic volume. Follow this procedure to enable the server to process GET commands:

To enable GET processing with Mobile Prevent for Web

1. Configure the Web proxy server to forward GET requests to the Mobile Prevent for Web Server as described in your proxy server documentation.

2. Ensure that the L7.processGets Advanced Server setting on the Mobile Prevent for Web Server must be “true” (which is the default).

3. Reduce the size of the L7.minSizeofGetURL Advanced setting on the Mobile Prevent for Web Server. Reduce from the default of 100 to a number of bytes smaller than the length of the shortest Web site URL from which you want to process GET commands. A minimum URL size to 10 should cover all cases. Note, however, that reducing the minimum size of GETs increases the number of requests that have to be processed, which increases the server traffic load.

4. Adjust the Ignore Requests Smaller Than setting in the ICAP section of the Mobile Prevent for Web Server Detail page. Reduce it from the default of 4096 bytes to a lower value that would enable the request to undergo DLP inspection. Note, however, that lowering the value increases the server traffic load.

Creating policies for Mobile Prevent for Web

You can create the policies that include most standard response rules. The response rules include Add Note, Limit Incident Data Retention, Log to a Syslog Server, Set Attribute, and Set Status.

See “About Symantec Data Loss Prevention reports” on page 1006.

You can also incorporate the response rules that are specific to Mobile Prevent for Web as follows:

- **Mobile Prevent for Web: Block HTTP/HTTPS**
  Blocks the posts that contain confidential data (as defined in your policies). This includes Web postings, Web-based email messages, and files that are uploaded to Web sites or attached to Web-based email messages.
Note: Certain applications may not provide an adequate response to the Mobile Prevent for Web: Block HTTP/HTTPS response action. This behavior has been observed with the Yahoo! Mail application when a detection server blocks a file upload. If a user tries to upload an email attachment and the attachment triggers a Mobile Prevent for Web: Block HTTP/HTTPS response action, Yahoo! Mail does not respond or display an error message to indicate that the file is blocked. Instead, Yahoo! Mail appears to continue uploading the selected file, but the upload never completes. The user must manually cancel the upload at some point by pressing Cancel.

Other applications may also exhibit this behavior, depending on how they handle the block request. In these cases a detection server incident is created and the file upload is blocked even though the application provides no such indication.

- **Mobile Prevent for Web: Remove HTTP/HTTPS Content**
  Removes confidential data from posts that contain confidential data (as defined in your policies). This includes Web-based email messages and files that are uploaded to Web sites. Note that the Remove HTTP/HTTPS Content action works only on requests.

- **Mobile Prevent for Web: Block FTP Request**
  Blocks FTP transfers that contain confidential data (as defined in your policies).

For details on setting up any response rule action, open the online Help.

Go to Manage > Policies > Response Rules and click Add Response Rule.

Even if you do not incorporate response rules into your policy, Mobile Prevent captures incidents as long as your policies contain detection rules. You can set up such policies to monitor Web and FTP activity on your mobile device before implementing the policies that block or remove content.

If you have configured your proxy to forward both HTTP/HTTPS requests and responses, your policies work on both. For example, policies are applied to both an upload to a Web site and a download from a Web site.

**To create a test policy for Mobile Prevent for Web**

1. In the Enforce Server administration console, create a response rule that includes one of the actions specific to Mobile Prevent. For example, create a response rule that includes the Mobile Prevent for Web: Block HTTP/HTTPS action.

   See “Configuring response rules” on page 891.

2. Create a policy that incorporates the response rule you configured in the previous step.
For example, create a policy called Test Policy as follows:

- Include a **Content Matches Keyword** detection rule that matches on the keyword "secret."
- Include a **Mobile Prevent for Web**: **Block HTTP/HTTPS** response rule.
- Associate it with the Default policy group.

See “Configuring policies” on page 326.

### Configuring Mobile Prevent for Web for secure banking

To enable mobile device users to send their own banking information, you can configure the proxy server to allow such traffic to bypass detection servers. Bypassing the detection servers allows mobile device users to access and use their own personal credit card and online banking information for legitimate purposes. If the proxy server is not configured to allow personal banking information to bypass detection, users might create incidents by submitting personal banking information. Symantec Data Loss Prevention users with relevant role-based privileges can potentially view the incident snapshots that contain confidential banking information of users within your organization.

Configure the proxy server to redirect network traffic directly to banking Web sites. This solution can also be used to allow network traffic to other secure Web sites. By redirecting the traffic to these specific Web sites, mobile device users can access these sites without generating false policy violations. The information that they send to these sites is not viewable by others in your organization.

**Note:** The following procedure is an example of how to configure a Blue Coat proxy server to redirect network traffic. For more information on configuring a proxy server, see the documentation that comes with the proxy server.

#### Configuring the proxy server to redirect network traffic

1. Log in to the proxy server using an administrator account.
2. Open **Visual Policy Manager (VPM)**.
3. Select **SSL Intercept Layer policy**.
4. Add a rule for the destination host. For this example, enter the host name of the banking Web site that users are allowed to access.
5. Under **Action**, select **Disable SSL interception**.
6. Click **Apply** to save the changes.
Testing Mobile Prevent for Web

You can test Mobile Prevent for Web by sending an email that violates your test policy.

To test your system

1. Connect your mobile device to the Internet and connect to your corporate VPN.
2. Open your corporate email client and send an email with an attachment containing confidential data. For example, access your Microsoft Outlook client and send an email with an attachment containing the word _secret_ and paragraphs of other text.
3. In the Enforce Server administration console, go to Incidents > Mobile and click Incidents - All. Look for the resulting incident. For example, search for an incident entry that includes the appropriate timestamp and policy name.
4. Click the relevant incident entry to see the complete incident snapshot.

See “About strategies for using reports” on page 1007.
Monitoring data loss from corporate emails downloaded to mobile devices

- Chapter 81. Introducing Symantec Data Loss Prevention Mobile Email Monitor
- Chapter 82. Implementing Symantec Data Loss Prevention Mobile Email Monitor
Introducing Symantec Data Loss Prevention Mobile Email Monitor

This chapter includes the following topics:

- About Mobile Email Monitor
- How Mobile Email Monitor works
- Using Mobile Email Monitor with Mobile Prevent for Web

About Mobile Email Monitor

More and more employees bring their own devices to work. With these personal devices, employees also bring the ability to download confidential corporate information. Mobile Email Monitor provides you with the ability to monitor your company's confidential information when it is sent from your corporate network to these personal devices; for example, to the native email client on iPads, iPhones, and other supported mobile devices.

While Mobile Email Monitor doesn't block this data, it does give you insight into what confidential data is downloaded. Mobile Email Monitor provides the data to the Enforce Server. With the Enforce Server administration console, you can create reports that continuously create a record of sensitive information that is downloaded to mobile devices. If the devices are lost or stolen, you can identify what downloaded emails left your corporation with these devices.

You can use the information that Mobile Email Monitor provides you about downloaded content to define mobile security policies for your corporation. Mobile Email Monitor can support your company's Bring Your Own Device (BYOD) policy
because it does not require installation of any applications or components on personal mobile devices. In addition, Mobile Email Monitor does not inspect information generated by personal applications installed on mobile devices.

See “How Mobile Email Monitor works” on page 1557.

How Mobile Email Monitor works

Mobile Email Monitor inspects corporate emails that are sent to mobile devices through Microsoft Exchange Active Sync, using a reverse proxy. Unlike Symantec Data Loss Prevention Mobile Prevent for Web, Mobile Email Monitor does not require a VPN.

See the Symantec Data Loss Prevention System Requirements and Compatibility Guide for more details about requirements for Mobile Email Monitor.

Figure 81-1 gives a graphical overview of how an email travels to a mobile device when you are using Mobile Email Monitor.

Table 81-1 provides more detail about how an email destined for download to a mobile device is monitored.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>An email is downloaded from the Exchange ActiveSync Server, using either the HTTP or HTTPS protocol, through a corporate reverse Web proxy using ICAP.</td>
</tr>
<tr>
<td>Step 2</td>
<td>A reverse Web proxy server intercepts the email and diverts it to Mobile Email Monitor for detection using ICAP.</td>
</tr>
</tbody>
</table>
Table 81-1  Monitoring an email destined for a mobile device (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 3</td>
<td>Mobile Email Monitor scans the email according to policies you have set up using the Enforce Server administration console.</td>
</tr>
<tr>
<td>Step 4</td>
<td>If the email violates a policy, an incident is logged in the Enforce Server.</td>
</tr>
<tr>
<td>Step 5</td>
<td>After inspection by Symantec Data Loss Prevention the email (ICAP response) is sent back to the Web proxy.</td>
</tr>
<tr>
<td>Step 6</td>
<td>The Proxy server then sends the email to the recipient mobile email client.</td>
</tr>
</tbody>
</table>

See “Using Mobile Email Monitor with Mobile Prevent for Web” on page 1558.

Using Mobile Email Monitor with Mobile Prevent for Web

You can deploy Mobile Email Monitor as a standalone product or as an additional server in your existing Symantec Data Loss Prevention environment. License keys for both the Mobile Email Monitor Server and the Mobile Prevent for Web Server are included in the Symantec Data Loss Prevention for Mobile product.

See “Symantec Data Loss Prevention Mobile Email Monitor set up overview” on page 1559.
Implementing Symantec Data Loss Prevention Mobile Email Monitor

This chapter includes the following topics:

- Symantec Data Loss Prevention Mobile Email Monitor set up overview
- Adding and configuring the Mobile Email Monitor Server
- About proxy server configuration
- Specifying one or more proxy servers
- Configuring the response mode service
- About digital certificates for Mobile Email Monitor
- Setting up native email clients for monitoring
- Creating policies for Mobile Email Monitor
- Testing Symantec Data Loss Prevention Mobile Email Monitor
- Troubleshooting Mobile Email Monitor Server

**Symantec Data Loss Prevention Mobile Email Monitor set up overview**

Table 82-1 outlines the steps that are required for implementing Symantec Data Loss Prevention Mobile Email Monitor. The table contains cross-references to topics in this chapter, as well as to topics in the *Symantec Data Loss Prevention*...
You must have a deployed Symantec Data Loss Prevention Enforce Server and have a working Microsoft Exchange ActiveSync Server up and running in your datacenter before implementing Mobile Email Monitor according to the steps in the table.

### Table 82-1 Implementing Mobile Email Monitor

<table>
<thead>
<tr>
<th>Step</th>
<th>Procedure</th>
<th>For more information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Add and configure a new Mobile Email Monitor Server.</td>
<td>See “Adding and configuring the Mobile Email Monitor Server” on page 1560. See “Adding a detection server” on page 194.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Configure a proxy server.</td>
<td>See “About proxy server configuration” on page 1562. See the proxy server product documentation for more details.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Specify one or more proxy servers and define ICAP services on the proxy to route traffic to the Mobile Email Monitor Server.</td>
<td>See “Specifying one or more proxy servers” on page 1562. See the Symantec Data Loss Prevention Administration Guide for more information.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Configure the response mode service.</td>
<td>See “Configuring the response mode service” on page 1563.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Set up a digital certificate for communication with the proxy server.</td>
<td>See “About digital certificates for Mobile Email Monitor” on page 1564.</td>
</tr>
<tr>
<td>Step 6</td>
<td>Configure native mobile email accounts to point to the proxy server.</td>
<td>See “Setting up native email clients for monitoring” on page 1564. See the documentation for your native mobile email clients.</td>
</tr>
<tr>
<td>Step 7</td>
<td>Create and deploy a policy for Mobile Email Monitor.</td>
<td>See “Creating policies for Mobile Email Monitor” on page 1564. See the Symantec Data Loss Prevention Administration Guide for more information.</td>
</tr>
<tr>
<td>Step 8</td>
<td>Test the system by generating an incident against your test policy.</td>
<td>See “Testing Symantec Data Loss Prevention Mobile Email Monitor” on page 1565.</td>
</tr>
</tbody>
</table>

See “Adding and configuring the Mobile Email Monitor Server” on page 1560.

## Adding and configuring the Mobile Email Monitor Server

Here are some configuration options for the Mobile Email Monitor Server.
- Ignore small HTTP/S responses.
- Ignore responses from a particular host or domain (such as the domain of a business subsidiary).

**To modify your Mobile Email Monitor Server configuration**

1. Go to **System > Servers > Overview** and click the name of a Mobile Email Monitor Server.
2. On the **Server Detail** screen that appears, click **Configure**.
   
   You can verify or modify settings on the **ICAP** tab as described in subsequent steps. The tab is divided into sections: **Response Filtering** and **Connection**.

3. Verify or modify the filter options for responses from email servers. The options in the **Response Filtering** section are as follows:

   - **Ignore Responses Smaller Than**
     
     Specifies the minimum size of the body of HTTP responses inspected by this server. (The default is 4096 bytes.)

   - **Inspect Content Type**
     
     Specifies the MIME content types that Symantec Data Loss Prevention should monitor in responses. By default, this field contains content-type values for Microsoft Office, PDF, and plain-text formats. To add others, type one MIME content type per line. For example, type `application/wordperfect5.1` to have Symantec Data Loss Prevention analyze WordPerfect 5.1 files.

     Note that it is generally more efficient to specify MIME content types at the Web proxy level.

   - **Ignore Responses from Hosts or Domains**
     
     Causes the server to ignore responses from the hosts or domains you specify. You can type one or more host or domain names (for example, www.company.com), each on its own line.

   - **Ignore Responses to User Agents**
     
     Causes the server to ignore responses to user agents (HTTP clients) you specify. You can type one or more user agent values (for example, java/1.4.2_xx), each on its own line.
4 Verify or modify settings for the ICAP connection between the HTTP proxy server and the Mobile Email Monitor Server. The Connection options are as follows:

<table>
<thead>
<tr>
<th>Option</th>
<th>Default/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCP Port</td>
<td>The default is 1344.</td>
</tr>
<tr>
<td>Maximum Number of Responses</td>
<td>Specifies the maximum number of simultaneous ICAP response connections from the HTTP proxy or proxies. The default is 16.</td>
</tr>
<tr>
<td>Connection Backlog</td>
<td>Specifies the number of waiting connections allowed. A waiting connection is a user waiting for an HTTP response. The default value is 16; the minimum value is 1.</td>
</tr>
</tbody>
</table>

5 Click Save to exit the Configure Server screen and then click Done to exit the Server Detail screen.

See “About proxy server configuration” on page 1562.

About proxy server configuration

See Symantec Data Loss Prevention System Requirements and Compatibility Guide for information on proxy servers tested to operate with Mobile Email Monitor. See the proxy product documentation for more details on setting up the proxy.

You must configure at least one HTTP/S proxy server to relay email responses to Mobile Email Monitor. The HTTP proxy acts as an ICAP client to the Mobile Email Monitor Server. The proxy should be configured in response modification (RESPMOD) mode to relay email messages for inspection. Mobile Email Monitor supports only the response modification (RESPMOD) mode of ICAP. Do not configure your HTTP proxy for the request modification (REQMOD) mode.

See “Specifying one or more proxy servers” on page 1562.

Specifying one or more proxy servers

By default, Mobile Email Monitor Server can accept connections to the ICAP service port from any system on the network. For security reasons, you can limit ICAP connections to only those systems that you designate (or “white list”). Once you white list one or more systems, systems not on the whitelist cannot connect to the Mobile Email Monitor ICAP service port.
Note: The Icap.BindAddress setting can affect a proxy server whitelist. By default, the Icap.BindAddress setting is 0.0.0.0, and the listener binds to all available addresses. If the Icap.BindAddress instructs the listener to bind to a specific IP, a whitelisted proxy must also be able to reach the listener address.

To create a whitelist of systems allowed to make a connection to the Mobile Email Monitor Server ICAP service port:

1. In the Enforce Server administration console, go to System > Servers > Overview and click the desired Mobile Email Monitor Server.
2. On the Server Detail screen that appears, click Server Settings.
3. Scroll down to the Icap.AllowHosts setting.
   By default, Icap.AllowHosts is set to any, meaning that all other systems on the network can communicate with this Mobile Email Monitor Server.
4. You can limit the systems that are allowed to connect with Mobile Email Monitor. Delete any and enter the IP addresses or Fully-Qualified Domain Name (FQDN) of the systems you want to authorize.
   Separate multiple addresses with commas. For example: 123.14.251.31,webcache.corp.mycompany.com,123.14.223.111. Use only commas to separate multiple entries; do not include spaces.
5. Click Save.

Changes to this setting do not take effect until you restart the Mobile Email Monitor Server.

See the Symantec Data Loss Prevention System Requirements and Compatibility Guide for more details about supported proxy servers for Mobile Email Monitor.

See “Configuring the response mode service” on page 1563.

Configuring the response mode service

For details on configuring the proxy server, refer to your proxy server product documentation, or contact your proxy server administrator.

To configure a proxy server:

◆ On your proxy server, create an ICAP RESPMOD service that forwards responses to Mobile Email Monitor. If your proxy server supports different protocols, configure it to handle the desired protocols.

For RESPMOD mode, an ICAP service on the proxy server should look like:

icap://ip_address[:port]/respmod
Where:

- `ip_address|FQDN` identifies the Mobile Email Monitor Server using either an IP address or fully-qualified domain name.

- `Port` is the port number where Mobile Email Monitor listens. `FQDN` specifying the port number is optional when the default ICAP port (1344) is used.

- `/respmod` is required for correct functionality in RESPMOD mode.

Examples:

```
icap://10.66.194.45/respmod
icap://10.66.194.45:1344/respmod
icap://netmonitor1.company.com/respmod
```

---

**Note:** The port that is specified in the ICAP service definition on the proxy must match the port where Mobile Email Monitor Server listens.

See “About digital certificates for Mobile Email Monitor” on page 1564.

---

**About digital certificates for Mobile Email Monitor**

The proxy server requires a digital certificate to communicate with mobile devices and the Exchange Server. See your proxy product documentation for more information.

See “Setting up native email clients for monitoring” on page 1564.

---

**Setting up native email clients for monitoring**

Native email accounts from your user's devices should point to the reverse proxy that routes email to Mobile Email Monitor for Symantec Data Loss Prevention inspection. See the documentation for your native email clients for more information on setting up the email clients so that they point to the proxy.

See “Creating policies for Mobile Email Monitor” on page 1564.

See “How Mobile Email Monitor works” on page 1557.

---

**Creating policies for Mobile Email Monitor**

Mobile Email Monitor only monitors email traffic to mobile devices, so no Prevent response rules will function with Mobile Email Monitor. You can create policies that include some standard rules. Mobile Email Monitor only monitors incidents, so you
don't need response rules, as long as your policies contain detection rules. You can set up detection policies to monitor the emails downloaded to mobile devices.

**To create a test policy for Mobile Email Monitor**

- Create a policy that incorporates a standard test detection rule.

  For example, create a policy called Test Policy as follows:

  - Include a **Content Matches Keyword** detection rule that matches on the keyword "secret."
  - Associate it with the Default policy group.

  See “Testing Symantec Data Loss Prevention Mobile Email Monitor” on page 1565.

---

**Testing Symantec Data Loss Prevention Mobile Email Monitor**

You can test Mobile Email Monitor by sending an email that violates your test policy.

### To test your system

1. Send an email with an attachment containing the word *secret* and paragraphs of other text to your Microsoft Outlook email account.

2. Download the email using your mobile device.

3. In the Enforce Server administration console, go to **Incidents > Mobile Email Monitor** and click **Incidents - All**. Look for the resulting incident. For example, search for an incident entry that includes the appropriate timestamp and policy name.

4. Click the relevant incident entry to see the complete incident snapshot.

---

| Note: Incident representation is OS dependent and thus will vary depending on the OS and device you are using. |
| See “Troubleshooting Mobile Email Monitor Server” on page 1565. |

---

**Troubleshooting Mobile Email Monitor Server**

_Troubleshooting Mobile Email Monitor Server_ describes common problems you may encounter when you are using Mobile Email Monitor and suggests possible solutions.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Explanation or Possible Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incidents do not appear in Symantec Data Loss Prevention Mobile reports.</td>
<td>The <strong>Ignore Responses Smaller Than</strong> parameter can cause emails smaller than the set parameter size to be ignored. To enable monitoring of smaller emails, set the parameter to a lower value.</td>
</tr>
<tr>
<td>An email preview feature can cause a single policy violation in an email to generate duplicate incidents.</td>
<td>If the email preview contains data that triggers a policy, Mobile Email Monitor will count the preview data as one incident and the same data in the body as another incident, for a total of two incidents.</td>
</tr>
</tbody>
</table>
Symbols
1066

A
about
incident details 978
reports 977
VPN server 1538
access control lists (ACL)
incident snapshots 1044
Active Directory 1447
attribute 1448
attributes 1444
AddDefaultHeader field 1158
AddDefaultPassHeader field 1159
administration
introduction to 55
administration console
about 56
logging on and off 57
Administrator account
about 58
email account 60
password, changing 59
password, resetting 103
AdminPasswordReset utility 103
Advanced Process Control 177
advanced server settings 1148
Agent 1516
agent attribute
creating a new 1448
agent attributes 1450
managing 1446
user-defined 1451
Agent configuration
about 1405
adding 1406
applying 1441
agent events
about 1490
agent event detail screen 1492
agent group
conditions 1452
Agent Groups 1443
deployment process 1445
deployment strategy 1444
migration of existing Endpoint Servers 1446
agent groups
assigning configurations to deploy 1454
creating a new 1453
updating outdated 1453
viewing and managing 1451
Agent Host Domain 1447
Agent Host Name 1447
Agent Host Type 1447
Agent Host Version 1447
agent overview
summary screen 1457
alerts. See system alerts
AllowHosts field 1161, 1173, 1550, 1563
application monitoring 1374
about 1503
adding an application 1506
archive
incidents 1065
archived incidents
deleting 1068
restoring 1066
archiving
incidents 1065–1066
Attribute Query Resolver tool 1449
attribute values 1449
attributes 956, 961, 978, 986, 1078
applying 1450
types 1448
user-defined 1447
authentication credentials 131
Authority Information Access field 118

B
banking
Mobile Prevent for Web 1553
best practice
evaluate per-fold accuracy rates 538
reject training if accuracy rate above 5% 538
best practices
allocate low memory for endpoint policies 537
collect as many example documents as possible 536
create documents staging area 537
do not use VML to detect graphics or PII 534
narrowly define the category 535
perform negative testing 528
policies 357, 359–365
profiled DGM 665
seed the negative training set with generic content 536
tune profile before deploying into production 540
undeploy unused profiles 540
use documents archives 537
use to detect unstructured, text-based content 533
VML, summary of 532
BindAddress field 1161, 1173, 1550, 1563
blocking requests 1175, 1551
Blue Coat ProxySG 1171, 1549
BoxMonitor process 245

C
CA certificates
importing 197
CD/DVD
about 1371
Certificate authentication
adding CA certificates for 114
configuring 110
configuring revocation checks for 118, 120
enabling or disabling 112
mapping CN values for 117
troubleshooting 124
Certificate Revocation Lists Distribution Point. See CRLDP revocation checks
checksum offloading 1143
classification
incident list 1000
incident snapshot 1001
classification events 621
Classification Server
configuring 192
configuring retention categories for 917
Classification test mode 1000–1001
Classifying Enterprise Vault content
Enabling test mode when 621
clipboard 1373
code numbers
system events 150
Common name (CN) values 117
custom attributes 961, 986, 1076, 1078
credential store
adding authentication 132
deleting credentials 133
editing credentials 133
endpoint credentials 132
managing 133
credentials 131
CRLDP revocation checks
configuring a proxy for 121
support for 118
dashboards 1011
deleting 1038
editing 1029
viewing 1012
data classification
introduction 620
Data classification services
incident list 1000
incident snapshot 1001
Data Identifiers
cloning, manually 565
modifying 551
Data Identifiers
about 541
best practices 579
breadths, about 547
Data identifiers (continued)
configuration, about 570
cross-component matching 548
custom, about 572
data normalizers, about 578
extending 546
optional validators, about 547
pattern language limitations, about 573
patterns 547
system-defined 542, 545
validators, about 548
data identifiers
adding 550
breadths, list of 554
Content Matches data identifier condition 552
editing validator input 566
implementing custom script validators 579
implementing, custom 570
implementing, patterns 574
managing 550
normalizers, list of 555
optional validators, configuration 559
optional validators, acceptable characters 560
selecting validators 577
data loss prevention. See Symantec Data Loss Prevention
DBPasswordChanger utility
example of using 279
introducing 275, 279
locating 279
prerequisites for using 279
running 279
debug log files 243–244, 258
delete
archived incidents 1068
deploying
SMS 1516
using silent installation 1516
using the Endpoint FlexResponse utility 1518
detection
best practice 618
crackable CAD formats 690
crackable database file formats 690
crackable email formats 689
crackable encapsulation formats 691
crackable graphics formats 690
crackable other formats 691
crackable presentation formats 686
crackable spreadsheet formats 687
detection (continued)
crackable text and markup formats 688
crackable word-processing file formats 685
Custom File Type Signature 617
file name 611, 614
file name examples 615
file name syntax 615
file properties 609
file size 611, 613
file type 609, 612
file type, custom 610, 617
Message Attachment or File Name Match 614
Message Attachment or File Size Match 613
Message Attachment or File Type Match 612
mobile 627, 629
network 626, 628
Protocol Monitoring, mobile 629
Protocol Monitoring, network 628
word processing formats 684
detection servers 277
about 177
adding 194
configuration 180
controls 178
errors and warning list 200
kinds of 48
logging 251
removing 196
Server Detail screen 201
server settings 203
settings, advanced 193
single-tier 194
status of 198
System Overview screen 198
directory servers (LDAP)
configuring connections 127
connecting to 126
Directory Group Matching (DGM)
implementing synchronized 656
Recipient based on a Profiled Directory condition 664
Sender/User based on a Profiled Directory condition 663
synchronized 653
Directory Group Matching (DGM), profiled
profiled 661
profiled conditions 663
profiled create exact data source file 380
two-tier detection 661
Directory Group Matching (DGM), profiled (continued) workflow 662
Directory Group Matching (DGM), synchronized
Recipient matches User Group based on a Directory Server Group 658
scheduling indexing 129
Sender/User matches User Group based on a Directory Server Group 657
DLP agent
health 1457
DLP Agent summary reports 1467
Legacy DLP Agents 1473
document upload
max size per 537
documents
supported types 537
Documentum targets 1339

E
ECU. See Environment Check Utility
eculogs.zip file
contents of 278
ECUoutput.txt file 278
email
blocking 1161
quarantining 1163
Endace cards 1145
configuring Network Monitor to use 1148
drivers for 1146
installing drivers for 1146
Endpoint
Quarantine response rule 1388
user cancel response rule 1377
endpoint
agent advanced settings 1414
Agent log levels 1501
Agent logs 1500
incidnet summary screen 975
incompatible detection and response rules 1366
policies for 1365
response rules in different locales 1380
setting response rules in different locales 1381
setting the endpoint location 1378
summary reports 975
Endpoint Discover
adding a rule 1387
configuring targets 1390
creating a policy 1387
creating a policy group 1386
Endpoint Discover (continued)
Endpoint Discover target 1389
how it works 1383
implementing 1389
introducing 54
Max Scan Duration 1400
reports 1403
Scan Idle Timeout 1400
scan timeout settings 1400
scanning 1383
target filters 1392
targeted scans 1385
Endpoint Discover scans
excluding items or repositories 1395
including items or repositories 1395
Endpoint FlexResponse
about 1512
deploying 1514
deploying plug-ins 1515
deploying plug-ins using the Endpoint FlexResponse utility 1518
enabling on Enforce Servers 1519
uninstalling using the FlexResponse utility 1520
Endpoint FlexResponse utility 1516
options 1517
password 1518
endpoint incident
destination or protocol specific information 974
lists 964
snapshot 967
endpoint location
setting 1378
Endpoint Prevent
application monitoring 1374
block response rule 1375–1376
CD/DVD monitors 1371
Citrix XenApp 1374
Citrix XenDesktop 1374
clipboard monitor 1373
creating policies 1375
how it works 1367
implementing 1378
introducing 54
Microsoft Hyper-V 1374
monitoring 1368
network monitors 1369
network share monitoring 1372
notify response rule 1375–1376
print/fax monitor 1372
Exact Data Matching (EDM) (continued)
example 367
exceptions 375
field mapping 374
functionality 368
index file 371
index updates 374
manage profiles 394
match counting 413
policy condition 375
preparing for indexing 381
Remote EDM Indexer utility 433
remote indexing 432
SQL Preindexer utility 433
two-tier detection 377
workflow 378

Exact Data Matching (EDM), configure
Exact Data Profile 385
Remote EDM Indexer 383
uploading the exact data source to Enforce 383

Exact Data Matching (EDM), profile
mapping fields 389
schedule profile indexing 392

Exchange targets 1287
exporting agent attributes 1449

F
filtering requests 1168, 1544
Firefox browser 994
flrinst.exe utility
about 1516
deploying plug-ins 1518
retrieving plug-in list 1521
retrieving plug-ins 1520
uninstalling plug-ins 1520

Forms-based log on
disabling 125
forwarding mode 1154–1155

G
GET commands 1149, 1174, 1551
group conflicts
viewing 1455
group exceptions, type
Recipient Matches Pattern 648
group rules, type
Recipient Matches Pattern 648
incident reports (continued)
   sending by email 1041
   setting advanced filters 1056
   setting general filters 1047
   setting preferences 1008
   summaries 1011, 1016, 1046
   summary options 1040, 1051
   viewing incidents 1018
   viewing summary reports 1016
incident snapshot
classification 1001
incident snapshots
   ACL information 1044
   correlations tab 1043
   custom attributes section 1043
   history tab 1042
   matches section 1044
   Network Discover 991
   policy section 1043
incident summaries
   Network Discover 999
Incident Update privilege 95
incidents 950, 955–957, 960–961, 978, 981, 983, 985–986
   archiving 1065–1066
   attributes, status 1069
   custom attributes 1076
   custom attributes, and 1079
   deleting 1034
   preventing archiving 1067
   remediating 953, 980
   restoring archived 1066
incremental scanning 1222–1224
Indexed Document Matching
   scheduling indexing 492
Indexed Document Matching (IDM)
   adding document profiles 479
   configuring document profiles 479
   configuring the match condition 497
   excluding content using whitelisting 476
   filtering by file name 489
   filtering by file size 491
   implementing 475
   managing document profiles 477
   preparing the document source for indexing 475
Indexed Document Matching
   DocSource.rdx 467
   EndpointDocSource.rdx 467
Indexed Document Matching (IDM)
  best practice 501, 503–506
  document data source 466
  Document Profile 465
  exact file contents matching 471
  exact file matching 470
  exception conditions 474
  IDM match condition 473
  Overview 462
  partial file contents matching 471
  Platforms 464
  remote indexing options 467
  whitelisting 474
installation log files 243
installing
  plug-ins 1516
internationalization. See languages and character sets
Internet Content Adaptation Protocol. See ICAP
iptables command 1159–1160

L
Language Pack Utility 71
language packs
  about 68
  Language Pack Utility 71
languages and character sets
  character sets, using 67
  choosing a non-English language 70
  language packs, about 68
  language packs, working with 71
legacy agent overview
  actions 1485
Legacy DLP Agent summary reports
  1473
licenses 173
Linux systems 1159
listing plugins 1516
Livellink targets 1348
localization. See languages and character sets
Lock Manager service 277
log files 243
logdump.exe tool 1527
logdump.exe utility 276
Logged in User 1447
Logged in User Domain 1447
logging
  distance and confidence 531
  number of features modeled 531
logging (continued)
  per-fold evaluation rates 531
logging on and off 57
logs
  review 149
lookup parameters
  parameter groups 1096
lookup plug-ins. See about
  automatic lookup 1111
  automatic reload 1111
  chaining 1108
  chaining multiple plug-ins 1097
  CSV attribute mapping 1116
  CSV data file requirements 1114
  CSV file delimiter 1115
  CSV file location 1115
  CSV key mapping 1116
  CSV, character set 1116
  CSV, how it works 1094
  custom 1138
  custom (legacy) 1095
  data owner email output 1111
  data owner output 1111
  deployment 1097
  enabling 1107
  implementing, workflow for 1098
  LDAP attribute mapping 1123
  LDAP configuration 1122
  LDAP server connection 1123
  LDAP, how it works 1094
  lookup parameters 1102
  reloading 1108
  script chaining 1134
  timeout 1111
  types 1093
lookup plug-ins, script
  enabling credentials 1132
  encrypting credentials 1132
lookup plugin
  LDAP testing 1125
  script protocol filtering 1131
lookup plugins
  script configuring 1127
  script writing 1128
  script, how it works 1094
  scripting languages 1094
Lotus Notes targets 1261
mail transfer agents. See MTAs
manager process 245
manager-certauth.security 123
manager-certauth.security file 121
matches 960, 985
Microsoft Exchange targets 1305
Microsoft TMG 1171
MIME types 188, 1169, 1545, 1561
minSizeofGetURL field 1174, 1551
Mobile Email Monitor 1562
  configuring proxy servers 1563
  configuring the response mode service 1563
  creating policies for 1564
  introducing 53
  testing 1565
  troubleshooting 1565
Mobile Email Monitor Server
  adding 1560
  configuring 1560
Mobile Prevent
  introducing 53
Mobile Prevent for Web
  banking 1553
  configuring 1173, 1550
  creating policies for 1551
  Deployment scenarios 1535
  implementing 1542
  testing 1554
  troubleshooting 1177
Mobile Prevent for Web Server
  configuring 1543
monitorSettings directory 277
monitorSettings folder 278
MTAResubmitPort field 1158
MTAs 51, 186, 1152, 1154, 1157
  configuring 1160
MX records 185, 1156
Network Discover (continued)
  editing targets 1189
  how Discover works 1182
  how scanners work 1306
  incident lists 995
  incident reports 988–990
  incident snapshots 991
  incident summaries 999
  introducing 51, 1180
  logging 248
  quarantine files 1258
  reports 988
  setting up 1184
Network Discover scans
  auditing targets 1206
  authentication 1196
  deleting 1215
  differential scans 1225
  encrypting passwords 1197
  excluding items or repositories 1198
  filtering by item size 1201
  filtering by last-accessed date 1202
  filtering by modified date 1202
  including items or repositories 1198
  inventory scans 1206
  list of targets 1210
  managing 1209
  monitoring 1209
  optimizing 1204, 1220
  parallel 1226
  removing targets 1212
  reporting 1209
  reporting scan details 1215
  reporting scan history 1213
  scheduling 1194
  status 1219
  throttling 1204
Network Discover Server
  configuration, basic 190
  configuring 1185
  configuring parallel scans 1226
  Linux 1187
Network Discover targets 1315
  custom 1356
  DB2 databases 1267
  Documentum 1339
  Domino servers 1261
  Exchange 1287, 1305
  file shares 1241

N
Napatech 1145
Napatech cards
  configuring Network Monitor to use 1148
network connections
  checking 277
Network Discover
  adding new targets 1187
  configuring 1184
  configuring targets 1191, 1193
Network Discover targets  
Livelink 1348  
Lotus Notes 1261  
Oracle databases 1267  
removing 1212  
SharePoint 1274  
SQL databases 1267  
SQL server 2005 1267  
UNIX file systems 1315  
Web servers 1327  
Web services 1356  
Web sites 1327  
Windows remote server file systems 1315

network interface card. See NIC

Network Monitor
 configuring 1147  
creating policies for 1150  
implementing 1141, 1143  
introducing 51  
logging 250  
requirements for 1141  
testing 1150–1151  
using Endace cards with 1147

Network Monitor Server
 configuring 181

Network Prevent (Email)
bouncing messages 933

Network Prevent for Email
 blocking email 1161  
configuring 1155  
creating policies for 1161  
enabling policy violation headers 1163  
implementing 1152, 1154  
integrating MTAs with 1154  
introducing 51  
logging 250  
routing restricted ports to 1159  
testing 1164

Network Prevent for Email Server
 configuring 184

Network Prevent for Web
 configuring 1167  
creating policies for 1175  
implementing 1165, 1167  
introducing 51  
testing 1176

Network Prevent for Web Server
 configuring 187

Network Protect
 introducing 52  
quarantine files 1258

Network Protect server
 configuration, basic 190  
network share monitoring 1372  
network taps 1141, 1144  
new_oracle_password parameter 279  
Next MTA field 1157  
NIC 1142, 1145  
Notification service 277

O

OCSP revocation checks
 configuring 123  
configuring a proxy for 121  
disabling 123  
support for 118

Online Certificate Status Protocol. See OCSP revocation checks

operational log files 243

Oracle database 277

NLS_LANGUAGE setting 70
NLS_TERRITORY setting 70

P

packet capture software 1142, 1144  
installing 1145

PACKET_MMAP software 1145

Password authentication
 disabling 125  
enabling or disabling 112

Password Renewal window 63

password_file parameter 279

passwords 279

See also DBPasswordChanger utility

Administrator 59, 103  
changing 60, 63, 279  
encrypting for Network Discover scans 1197  
resetting 103

pcapstart.reg file 1146

plug-ins  
 deploying on the endpoint 1515

Plugins.properties file 1232

policies
 about 283
 add 325
 adding response rules 350
policies  (continued)
components 285
configuration 326
create 345
Data Profiles 291
deployment 288
manage 345
privileges, administration 290
privileges, authoring 290
privileges, response rules 290
removing 351
solution pack 287
policies, about
implementation 293
User Groups 292
policy conditions
Content Matches data identifier 552
policy detection
endpoint 632
endpoint application 634
endpoint events 298
endpoint protocol 632
file contents 297
file properties 297
identifiable file format types 669
identities 298
international languages 604
introduction 296
languages 298
mobile 297
network 297
rule severity 289
similarity score 528
technologies 298
using VML as an exception 533
Vector Machine Learning (VML) 509
policy detection template, configuration
Yahoo Message Board 869
policy detection templates, configuration  (continued)
Employee Data Protection 815
Encrypted Data 817
EU Data Protection Directives 811
Export Administration Regulations (EAR) 817
FACTA 2003 (Red Flag Rules) 818
Financial Information 822
Forbidden Websites 823
Gambling 824
Gramm-Leach-Bliley 824
Human Rights Act 1998 830
Illegal Drugs 831
Individual Taxpayer Identification Numbers (ITIN) 831
International Traffic in Arms Regulations (ITAR) 832
Media Files 833
Merger and Acquisition Agreements 834
NASD Rule 2711 and NYSE Rules 351 and 472 835
NASD Rule 3010 and NYSE Rule 342 837
NERC Security Guidelines for Electric Utilities 838
Network Diagrams 839
Network Security 840
Offensive Language 840
Office of Foreign Assets Control (OFAC) 841
OMB Memo 06-16 and FIPS 199 Regulations 843
Password Files 844
Payment Card Industry (PCI) Data Security Standards 845
PIPEDA 846
Price Information 848
Project Data 849
Proprietary Media Files 849
Publishing Documents 850
Racist Language 851
Restricted Files 851
Restricted Recipients 851
Resumes 852
Sarbanes-Oxley 853
SEC Fair Disclosure Regulation 855
Sexually Explicit Language 857
Source Code 858
SWIFT Codes 862
Symantec DLP Awareness and Avoidance 863
UK Data Protection Act 1998 810
UK Drivers License Numbers 863
Design Documents 814
Design Documents (continued)
policy detection templates, configuration (continued)
  UK Electoral Roll Numbers 864
  UK National Health Service (NHS) Number 864
  UK National Insurance Numbers 864
  UK Passport Numbers 865
  UK Tax ID Numbers 865
  US Intelligence Control Markings (CAPCO) and DCID 1/7 866
  US Social Security Numbers 867
  Violence and Weapons 867
  Webmail 868

policy detection, endpoint destination 633

policy detection, about
  keyword matching 584

policy detection, classification
  Enabling test mode when 621

policy detection, conditions
  Content Matches Keyword 591
  Content Matches Regular Expression 600
  Endpoint Device Class or ID 638
  Endpoint Location 637
  Protocol or Endpoint Monitoring 635
  Recipient matches User Group based on a Directory Server Group 658
  Sender/User Matches Pattern 645
  Sender/User matches User Group based on a Directory Server Group 657

policy detection, configuration
  select message components to match on 336

policy detection, described identities
  about 643
  Sender/User Matches Pattern 645

policy detection, endpoint
  devices, about 634
  devices, add 639
  devices, adding 641
  devices, configuring 641
  devices, manage 639
  Endpoint Device Class or ID 638
  Endpoint Location 637
  locations, about 634
  Protocol or Endpoint Monitoring 635

policy detection, international
  data identifiers 606
  find keywords 606

policy detection, keyword matching (continued)
  wildcards, about support for 584

policy detection, keyword matching, configuration
  Content Matches Keyword 591

policy detection, keyword proximity
  about 586

policy detection, regular expressions
  Content Matches Regular Expression 600
  implementing 598
  writing 598

policy exceptions
  add 337
  compound 342
  configure 340

policy exceptions, configure
  match counting 334

policy groups
  about 287
  create 348
  default policy group 287
  deployment 288
  managing 347
  modify 348
  removing 351

policy match condition
  Message/Email Properties and Attributes 623

policy match conditions
  compound 308
  content 301
  content based on index 301
  cross-component matching 305
  endpoint 304
  exceptions 307
  file properties 302
  identities and groups 304
  message components 305
  network and mobile 303
  server execution logic 308
  simple 308
  subject matching 621
  two-tier detection 309
  types 300

policy rules
  compound 342

policy rules, conditions
  configure 330

policy rules, configuration
  rule severity 333
policy rules, configure
  match counting 334
policy rules, detection
  add 328
policy rules, group
  add 328
policy templates
  add 325
  Confidential Documents 807
  create policy from 312
  Customer and Employee Data Protection 317
  export 292, 350
  HIPAA and HITECH (including PHI) 826
  import 292, 349
  State Data Privacy 859
  system-defined 286
  UK and International Regulatory
    Enforcement 317
  US Regulatory Enforcement 315
policy templates, configure
  Exact Data Profile, select 322
  Indexed Document Profile, select 323
policy templates, international
  about 605
policy templates, type
  Confidential or Classified Data Protection 319
  Network Security Enforcement 320
  Yahoo and MSN Messengers on Port 80 870
policy templates, types
  Acceptable Use Enforcement 320
policy testing
  attachment 528
  test corpus 528
policy violation headers 1163
  enabling 1163
print/fax 1372
processGets field 1174, 1551
product suite. See Symantec Data Loss Prevention
profile tuning
  how to 528
  similarity threshold 528
properties
  default similarity threshold 529
properties
  minimum number of documents per training
    set 529
  minimum number of features to keep 529
  significance of features threshold 529
proxy servers 1165, 1542
  compatibility with 1171, 1549
  configuring 1170, 1172–1173, 1548–1550, 1562
Q
quarantine files 1258
R
reflecting mode 1154–1155
remediation 940
  commands 945
  email response variables 946
Remote EDM Indexer utility
  command-line options for 445
  creating EDM profile with 436
  installation, Linux 449
  installation, windows 448
  installing 435
  introducing 275
  requirements for using 434
  running 434, 436, 442
  troubleshooting 447
  uninstalling, Linux 449
  uninstalling, windows 448
Reporting API 1030
Reporting API privileges 95
reports 961, 977, 986, 1006
  dashboards 1011
  incidents 1009
  list of options 1039
  summaries 1016
  system events 135
REQMOD 1170, 1172, 1548–1549
RequestProcessor settings 1163
RequestProcessor fields 1158, 1161, 1164
RESPMOD 1170, 1172, 1548–1563
response filtering 1169, 1545, 1561
response rules 954
  about 875
  add 889
  best practices 887
  composing email responses 944
  configure 891
  manage 889
  modify ordering 895
response rules, about
  actions 875
  authoring privileges 885
response rules, about (continued)
automated 881
conditions 882
execution 880
execution priority for actions 883
implementation 886
removing 896
Smart 881
Smart, configure 892
response rules, actions
Add Note 906
Classify Enterprise Vault Content 915
configure 893
discarding network incident data 908
Endpoint Discover: Quarantine File 920
Endpoint Prevent Block 922
Endpoint Prevent Notify, configuration 924
Endpoint Prevent User Cancel, configurations 928
Endpoint: FlexResponse 919
Limit Incident Data Retention 906
Log to a Syslog Server 909
Mobile Prevent Block FTP Request 931
Mobile Prevent Block HTTP/S 931
Network Prevent Block FTP Request 931
Network Prevent Block HTTP/S 931
Network Prevent: Block SMTP Message 933
Network Prevent: Modify SMTP Message 934
Network Prevent: Remove HTTP/HTTPS Content 935
Network Protect Copy File 937
Network Protect Quarantine File, configuration 937
retaining endpoint incident data 907
Send Email Notification 910
Set Attribute 913
Set Status 914
response rules, adding
Automated 890
Smart 890
response rules, conditions
configure 892
endpoint device 898
endpoint location 897
incident match count 900
incident type 899
protocol or endpoint monitoring 901
severity 903
response rules, type
Endpoint Prevent Block 1376
Endpoint Prevent Notify 1376
Endpoint Prevent User Cancel 1377
Endpoint Quarantine 1388
response rules, types
all detection servers 876
classification 880
discarding network incident data 908
endpoint 877
network 878
network protect 879
restore
archived incidents 1066
restricted ports 1158–1159
Retention categories 917
Revocation checks
configuring 120
support for 118
roles
add 103
adding 91
configuring 91
manage 103
roles, about
configuring 88
recommended 88
role-based access control 84
solution pack, included with 90
RRC. See rules results caching
rules results caching 1403

S
scans
differential scans 1222
incremental scans 1222–1224
Secure Computing Secure Web 1171
Server Detail screen 201
server configuration 180
Server FlexResponse
configuring 912, 1232–1233
configuring a response rule action with 912
configuring custom properties for 1233
deploying a plug-in for 1233
overview of 1228
remediating with 1230, 1237–1238
troubleshooting 1239
Using a smart response action with 1237
servers (DLP). See detection servers and Enforce Server
ServerSocketPort field 1158
Service_Shutdown.exe tool 1525
Service_Shutdown.exe utility 276
services 277
SharePoint targets 1274
Single-Tier Server 194
sizing, profiles
  memory allocation 537
  significance threshold 537
sizing, training sets
  minimum 50 536
  recommended 250 536
SMTP 1161
snapshots 961, 986
SOAP messages 247
SPAN 1141, 1144
SQL 276
SQL Preindexer utility
  command-line options for 443
  introducing 275
  troubleshooting 446
Squid Web Proxy 1171
SSL certificates
  importing 197
sslkeytool utility
  introducing 275
status attributes 1069
status groups
  adding 1072
  configuring 1072
  deleting 1072
status values
  adding 1071
  configuring 1071
  deleting 1071
summary reports 961, 986
Switch Port Analyzer. See SPAN
Symantec Data Loss Prevention
  administration of 55
  initial system setup 58
  product suite 47
Symantec Data Loss Prevention servers. See
detection servers and Enforce Server
Symantec DLP Agent
  administration 1457
  advanced settings 1414
  agent store 1414
  removing 1497
  removing manually 1500
  (continued)
  removing on Windows Vista 1499
  removing with system management software
    (SMS) 1498
Symantec DLP services
  starting 80–82
  stopping 80–83
Symantec Web Gateway 1171
syslog servers 144
system accounts 277
system alerts
  about 146
  adding 147
  configuring server 146
  modifying 147
system events 134
  code numbers 150
  event details 139
  notification methods 135
  reports 135
  reports, filtering 136
  reports, saved 138
  responses 142
  syslog servers 144
  thresholds, configuring 140
  types (severities) of 140
System Overview screen 198
  detection server, adding 194
  errors and warning list 200
  server status 198
system reports
  scheduling 1025
system setup, initial 58
system upgrades 174

T
TagHighestSeverity field 1164
TagPolicyCount field 1164
TagScore field 1164
telnet command 1160
Test mode 621
TLS proxies 184, 1159
Tomcat
  adding certificates to 114
  changing trust store password for 115
tools password 1518
training
  cross-fold 538
  k-fold evaluation process 538
<table>
<thead>
<tr>
<th>Term</th>
<th>Page Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>training set</td>
<td>negative 535</td>
</tr>
<tr>
<td>trial mode</td>
<td>184, 1155, 1168, 1544, 1561</td>
</tr>
<tr>
<td>troubleshooting</td>
<td>debug log files 531</td>
</tr>
<tr>
<td></td>
<td>property configuration 529</td>
</tr>
<tr>
<td></td>
<td>training set quality 538</td>
</tr>
<tr>
<td>Vector Machine Learning (VML) (continued)</td>
<td>adjusting memory allocation 520</td>
</tr>
<tr>
<td></td>
<td>configuring VML exceptions 526</td>
</tr>
<tr>
<td></td>
<td>configuring VML rules 525</td>
</tr>
<tr>
<td></td>
<td>creating new VML profiles 515</td>
</tr>
<tr>
<td></td>
<td>Current Profile tab 515</td>
</tr>
<tr>
<td></td>
<td>editing profile name, description 524</td>
</tr>
<tr>
<td></td>
<td>implementation process 513</td>
</tr>
<tr>
<td></td>
<td>manage training sets 521</td>
</tr>
<tr>
<td></td>
<td>manage VML profiles 522</td>
</tr>
<tr>
<td></td>
<td>rejecting training 511</td>
</tr>
<tr>
<td></td>
<td>similarity score 512</td>
</tr>
<tr>
<td></td>
<td>similarity threshold 512</td>
</tr>
<tr>
<td></td>
<td>Temporary Workspace tab 515</td>
</tr>
<tr>
<td></td>
<td>training content 510</td>
</tr>
<tr>
<td></td>
<td>training the profile 518</td>
</tr>
<tr>
<td></td>
<td>uploading contents for training 516</td>
</tr>
<tr>
<td></td>
<td>violated policies 1163</td>
</tr>
<tr>
<td>Vontu services</td>
<td>starting 77–82</td>
</tr>
<tr>
<td></td>
<td>stopping 77–83</td>
</tr>
<tr>
<td>vontu_sqlite3.exe tool</td>
<td>1526</td>
</tr>
<tr>
<td>vontu_sqlite3.exe utility</td>
<td>276</td>
</tr>
<tr>
<td>VPN</td>
<td>about 1538</td>
</tr>
<tr>
<td>Web archives</td>
<td>1073</td>
</tr>
<tr>
<td>Web Services</td>
<td>95</td>
</tr>
<tr>
<td>Websense V-Series</td>
<td>1172</td>
</tr>
<tr>
<td>Webwasher</td>
<td>1171</td>
</tr>
<tr>
<td>WinPcap software</td>
<td>1145</td>
</tr>
<tr>
<td></td>
<td>installing 1146</td>
</tr>
<tr>
<td>XCFilter-Loop: Reflected header</td>
<td>1159</td>
</tr>
<tr>
<td>X-DLP-Max-Severity header</td>
<td>1164</td>
</tr>
<tr>
<td>X-DLP-Policy-Count header</td>
<td>1164</td>
</tr>
<tr>
<td>X-DLP-Score header</td>
<td>1164</td>
</tr>
<tr>
<td>XML schemas</td>
<td>1030</td>
</tr>
</tbody>
</table>

U
uninstalling 1520
upgrades, system 174
user agents 1168, 1544
User Groups
  creation 654
user risk 1081
  user data sources 1083
  adding 1084
  adding from a file 1085
  adding from Active Directory 1086
  defining custom attributes 1084
  user details 1090
  user list 1090
  user risk summary 1091
users
  add 104
  manage 104
users, about
  configuring 88
users, accounts
  adding 99
  configuring 99
users, authentication
  Active Directory 105
  configuring Enforce for Active Directory
    authentication 109
  integrating Enforce with Active Directory 106
  verifying the Active Directory connection 108
users, passwords
  configuring strong or rotating 102
utilities
  introducing 274–275
V
Vector Machine Learning (VML)
  about 509
  accepting training 511
  adjust similarity threshold 527